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Confirm that the delivered product is what you have ordered. Read this manual to make sure of correct operation. 

• Be certain to read this manual carefully before performing installation, wiring, or maintenance work, or operating 
the HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F/-5T, HG1G/1P.

• The HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F/-5T, HG1G/1P has been manufactured with careful regard to quality. 
However, if you intend to use this product in applications where failure of this equipment may result in damage to 
property or injury, ensure that it used in conjunction with appropriate fail-safe backup equipment.

• In this manual, safety precautions are categorized in order of importance to Warning and Caution:

SAFETY PRECAUTIONS

Warning notices are used to emphasize that improper operation may cause severe 
personal injury or death.

Caution notices are used where inattention might cause personal injury or damage to 
equipment.

 

• When using the HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F/-5T, HG1G/1P in applications which require high level of 
safety, add a failsafe or backup functionality, and verify an adequate level of safety using the product specifications.

• Turn off the power to the HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F/-5T, HG1G/1P before installation, removal, 
wiring, maintenance, and inspection of the HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F/-5T, HG1G/1P. Failure to 
turn power off may cause electrical shock or fire hazard.

• Special expertise is required to install, wire, configure, and operate the HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F/-5T, 
HG1G/1P. People without such expertise must not use the HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F/-5T, HG1G/1P.

• The HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F/-5T, HG1G/1P uses an LCD (liquid crystal display) as a display 
device. The liquid inside the LCD is harmful to the skin. If the LCD is broken and the liquid attaches to your skin 
or clothes, wash the liquid off using soap, and consult a doctor immediately.

• Emergency and interlocking circuits must be configured outside of the HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F/-5T, 
HG1G/1P.

• Do not use touch switches and the function keys for an emergency circuit or an interlocking circuit. If the HG5G/
4G/3G/2G-V, HG4G/3G, HG2G-5F/-5T, HG1G/1P fails, equipment connected to the HG5G/4G/3G/2G-V, HG4G/3G, 
HG2G-5F/-5T, HG1G/1P will no longer be protected, and serious injury to operators and equipment damage may 
be caused.

• For the emergency stop switch and the enabling switch on the HG1P, note the following points:
- Connect the emergency stop switch to function as either a category 0 or category 1 stop in accordance with 

IEC/EN60204-1.
- Perform regular checks to confirm that the emergency stop switch and enabling switch work properly. It is 

extremely dangerous if the enabling switch no longer returns to position 1 due to a foreign object becoming 
lodged in the switch.

- Do not, under any circumstances, hold the enabling switch in position 2 with tape, string, or deform the 
rubber cover. The function of the enabling switch will be lost, and the enabling switch may not work in an 
emergency.

- Place your finger firmly on the enabling switch.
• Stop using the HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F/-5T, HG1G/1P if it is accidentally dropped or exposed to 

significant shock, check the HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F/-5T, HG1G/1P for damage, and confirm that 
its various functions work safely and correctly.

• For the HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F/-5T, HG1G/1P, connect the FG wire to grounding resistance of 
100 Ω or less. Otherwise there is a risk of electric shock or mistaken operation.

• The screen will not be visible if the backlight of the HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F/-5T, HG1G/1P burns 
out, the touch panel and the function keys will remain functional. Incorrect touch panel operation or incorrect 
function key operation will occur when operating the touch panel when the backlight appears to be off but is 
actually burnt out. Because such erroneous operations could result in damage, the touch panel and the function 
key should not be used after the backlight has burned out.

• When more than one button is pressed at the same time, due to the detection characteristics of an analog type 
touch panel, only the center of the pressed area is sensed and the unit assumes that only one button is pressed. 
Therefore, do not operate the HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F/-5T, HG1G/1P by pressing more than one 
button simultaneously.
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• Use the HG1P optional cable for proper wiring.
• The D-sub connector on the end of the HG1P optional cable is not water- or dust-proof. If protection against 

water and dust is required, the user must replace the D-sub connector with a water-proof connector.
• Prevent the HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F/-5T, HG1G/1P from falling while moving or transporting, 

otherwise damage or malfunction of the HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F/-5T, HG1G/1P will result.
• Use the product within the environmental limits given in the catalog and manual. Use of the product in high-

temperature or high-humidity environments, or in locations where it is exposed to condensation, corrosive gas 
or large shock loads can create the risk of electrocution and fire.

• The HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F/-5T, HG1G/1P is designed for use in pollution degree 2. Use the 
HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F/-5T, HG1G/1P in environments of pollution degree 2. (based on the 
IEC60664-1 rating)

• Install the HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F/-5T, HG1G/1P according to the instructions. Improper 
installation will result in falling, failure, electrical shock, fire hazard, or malfunction of the HG5G/4G/3G/2G-V, 
HG4G/3G, HG2G-5F/-5T, HG1G/1P.

• Prevent metal fragments or wire chips from dropping inside the HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F/-5T, 
HG1G/1P housing. Ingress of such fragments and chips may cause fire hazard, damage, and malfunction.

• Use a power supply of the rated value. Using a wrong power supply may cause fire hazard.
• The HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F/-5T, HG1G uses “PS2 of EN61131” as DC power supply. (based on 

the IEC/EN61131 rating)
• Use wire of a proper size to meet the voltage and current requirements, and tighten the terminal screws of the 

HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F/-5T, HG1G to the specified tightening torque.
• When exporting the HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F/-5T, HG1G/1P to Europe, use an EN60127 

(IEC60127) approved fuse on the power line outside the HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F/-5T, HG1G/1P.
• When exporting the HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F/-5T, HG1G/1P to Europe, use an EU-approved circuit 

protector.
• Make sure of safety before starting and stopping the HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F/-5T, HG1G/1P. Incorrect 

operation of the HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F/-5T, HG1G/1P may cause mechanical damage or accidents.
• Use the HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F/-5T, HG1G/1P in a local area network if you download, upload 

or monitor the project data via the Ethernet port.
• The touch panel of the HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F/-5T, HG1G/1P is made of glass, and will break if 

exposed to excessive shock. Take due care when handling it.
• Do not push hard or scratch the touch panel and protection sheet with a hard object such as a tool, because 

they are damaged easily.
• At temperatures over the rated operating temperature, the clock accuracy is affected. Adjust the clock before 

use.
• Do not install the HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F/-5T, HG1G/1P in areas subjected to strong ultraviolet 

rays, since ultraviolet rays may impair the quality of the LCD.
• Do not attempt to disassemble, repair or modify the HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F/-5T, HG1G/1P. This 

can create the risk of fire or electrocution.
• When disposing of the HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F/-5T, HG1G/1P, do so as an industrial waste.
• Be sure to confirm that the SD Memory Card Access lamp is not lit prior to turning the power off to the HG5G/

4G/3G/2G-V, HG4G/3G, HG2G-5F or pulling out the SD memory card. Refer to this manual for details.
• Do not switch off the power or pull out the SD Memory Card or the USB flash drive while it is being accessed, as 

this may result in destruction of the stored data. If the data on the SD Memory Card or the USB flash drive is 
corrupted, format the SD Memory Card or the USB flash drive.
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Preface
This manual describes MICRO/I operator interfaces (HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F/-5T, HG1G/1P) and 
WindO/I-NV4 general configuration software. The information includes drawing tools, setup procedures, and how to 
configure all MICRO/I operator interfaces.
This manual explains the operation and handling of the MICRO/I HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F/-5T, HG1G/
1P. Please read it carefully and ensure that you fully understand the functions and performance of the MICRO/I 
HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F/-5T, HG1G/1P and the WindO/I-NV4 configuration software.

Read the following materials as necessary for your particular application. 

References Content

WindO/I-NV4 User's Manual 
(This document)

Describes the hardware specifications of the HG5G/4G/3G/2G-V, HG4G/3G, 
HG2G-5F/-5T, HG1G/1P.

WindO/I-NV4 External Device Setup 
Manual (PDF)

Describes the connection procedures and available device addresses for various 
communication including the Device Link Communication, O/I Link 
communication, and DM Link communication.

WindO/I-NV4 Help
Describes the operating procedures. The user is allowed to view all manuals via 
Help.

Character Table (PDF)

A list of fonts can be used with the HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F/-5T, 
HG1G/1P and WindO/I-NV4. For restrictions on using the HG5G/4G/3G/2G-V, 
HG4G/3G, HG2G-5F/-5T, HG1G/1P, refer to Chapter 2 “1.2 Available Text” on 
page 2-6.
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Symbols Used in this Manual

This manual uses the following symbols to facilitate explanation.

Symbols

…… Information that requires special attention. Failure to operate the product in accordance 
with the information provided can lead to serious injury or damage.

…… Information relating to requests or material to reference in the use of a function

…… Useful information relating to a function

 …… Indicates the chapter and page of related reference information.

OK …… Screen buttons are indicated by bold text or by using the actual graphic icon.

SHIFT, …… Keyboard keys are indicated by the keyboard inscription in capital letters or enclosed in 
square brackets.

**** …… Controls are indicated by bold text.

A
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Abbreviations, Generic Terms, and Terminology Used in this Manual
Item Description

HG5G-V The name is short for MICRO/I HG5G-VFXT22MF-B.

HG4G-V The name is short for MICRO/I HG4G-VCXT22MF-B.

HG4G The name is short for MICRO/I HG4G-CJT22*F-B.

HG3G-V The name is short for MICRO/I HG3G-V*XT22MF-*.

HG3G The name is short for MICRO/I HG3G-*JT22*F-*.

HG2G-V The name is short for MICRO/I HG2G-V5FT22TF-*.

HG2G-5F The name is short for MICRO/I HG2G-5FT22TF-*.

HG2G-5T The name is short for MICRO/I HG2G-5T*22TF-*.

HG1G The name is short for MICRO/I HG1G-4VT22TF-*.

HG1P The name is short for MICRO/I HG1P-ST32*.

HG5G/4G/3G/2G-V The format used to refer to HG5G-V, HG4G-V, HG3G-V and HG2G-V.

HG5G/4G/3G-V The format used to refer to HG5G-V, HG4G-V and HG3G-V.

HG4G/3G The format used to refer to HG4G and HG3G. HG4G-V and HG3G-V is not included.

HG2G-5F/-5T The format used to refer to HG2G-5F and HG2G-5T.

HG1G/1P The format used to refer to HG1G and HG1P.

MICRO/I Generic term used to refer to the HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F/-5T, HG1G/1P.

External Device
Generic term used to refer to a PLC or micro computer that is connected to and 
communicates with the MICRO/I.

Device Address
Memory that is capable of storing values in unit of bits or words loaded on the MICRO/I 
and external device.

System Area
Device address area that is pre-allocated for exchanging screen management, error 
information, and clock data between the MICRO/I and an external device.

Device Link Communication
A communication method that performs communication with the external device 
according to the setting of the screen and without a program.

DM Link Communication
A communication method that reads to or writes from the MICRO/I device address from 
a computer or microcomputer board.

User Communication
A communication method which performs communication with external devices such as 
barcode readers and inverters.

External Device Communication Generic term used to refer to Device Link Communication and DM Link Communication.

Sub Host Communication
A communication method that performs communication with external device according 
to the set device address list and without a program.

BACnet Communication
A communication method for building management systems such as air conditioning, 
lighting and crime prevention.

O/I Link
A connection format that enables connections of up to 16 units of MICRO/I with high-
speed communication of 115,200bps.

O/I Link Master The MICRO/I unit that is directly connected to external device on the O/I Link network.

O/I Link Slave
The MICRO/I units that are not directly connected to external device on the O/I Link 
network.

WindO/I-NV4 Integrated configuration software application for creating projects of the MICRO/I.

Project
Data including image data required for operating the MICRO/I, which is created with 
WindO/I-NV4.

Manager
WindO/I-NV4 provides tools to manage pictures, text and script etc. With the Managers, 
you can create and manage them in your project.

Setup Generic term used to refer to the common settings in the project.

Project Settings Basic settings of operation in the Setup settings.

Alarm Log A function where the MICRO/I collects log data of alarms.

Data Log A function where the MICRO/I collects value of device addresses.

Script A script is an executable list of commands created by a simple programming language.
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Text Group
A group of 32 texts maximum that is in order to dynamically switch the character 
displayed on the MICRO/I according to the value of the device address.

Windows Font
Text fonts that can be displayed on the Windows OS on which the WindO/I-NV4 is 
running.

Stroke Font
A glyph's outline is defined by the vertices of individual strokes and stroke's profile. 
Scalable fonts scale easily without jagged edges.
Under font settings, “Stroke” is a stroke-based font.

Maintenance Communication Communications between the WindO/I-NV4 and MICRO/I using a dedicated protocol.

Device Monitor
A special Popup Screen on the MICRO/I on which value of the device address can be 
displayed or changed.

Pass-Through A function that enables maintenance of the external device via the MICRO/I.

System Screen
Pre-allocated screen dedicated for performing initial setting of the MICRO/I, 
self-diagnosis, and clearing the log data etc.

External Memory Device The generic term for an SD memory card and a USB flash drive.

NV Metafile A graphic data file that integrates drawings created on the WindO/I-NV4 edit screen.

Window
Screens that are loaded on to the Base Screen, including Popup Screen and Device 
Monitor.

Internal Device
The generic term for internal device addressing on the MICRO/I such as internal relays, 
registers, etc.

Keep Device

The generic term for internal device not initialized at the start of operation. Even after 
the power is turned off, the values are retained by the battery.
• HMI Keep Registers (LKR)
• HMI Keep Relays (LK)

Drawings Define as as non functional content (i.e. shape, picture, text).

Parts Define as functional content (i.e. button, pilot lamp, commands, etc.)

Object Define as combination of Drawings and Parts placed on WindO/I-NV4 edit screen.

Touch Switch A part that operates a function by pressing parts that have been placed on the screen.

Standard Keypad
Keypad that is displayed when operating Numerical and Character Input parts when 
Standard is selected under Type in the Keypad menu for Numerical and Character 
Input parts.

Movie File List
It is a list of movie files that have been registered in the Multimedia Function settings. 
You cannot change the order when you play files.

Item Description
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1

System
 Com

position

  

There are two types of system compositions used in operating the MICRO/I: One that is configured for the operation, 
and the other that is used for creating projects required for performing operations. In creating projects, use the 
WindO/I-NV4, the dedicated configuration software application for the MICRO/I.

● MICRO/I
The MICRO/I is equipped with a high-brightness, color LCD with fast screen drawing speed, quick-response touch 
switches, and high-speed communications to provide a comfortable man-machine interface. It is designed to allow 
easy data read/write from/to external device's, and does not burden the operator with issues relating to 
communications software.

1.1 System Composition for the RUN operation

The MICRO/I can be operated in the following system configuration. Devices that can be connected vary depending 
on your MICRO/I model. Refer to the specifications of the model for the details.

Chapter 1 System Composition

1 System Composition

130

MICRO/I

WindO/I-NV4 External Device
Periodically reads

values of device addresses

Writes changed
values of device addresses

Download

Data reception

Data
transmission

Print
Writing data

Reading
data

MICRO/I
Web Browser Terminal
(Computer, PDA, etc.)

Printer External device
(User Communication)

External Memory Device

External Device

USB flash driveSD memory card

Read

Write

Monitor

Operation
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1.2 System Composition for Creating Screens

It is necessary to create and download a project to the MICRO/I for operating it. Use the WindO/I-NV4 to create a 
project. The project you have created can be downloaded to the MICRO/I by directly connecting it to the computer, or 
the project data can be downloaded to external memory device, and then it can be copied from external memory 
device to the MICRO/I equipped with the memory card interface or the USB interface.

Upload

Copy

Copy

130

Download

Install

External Memory Device

MICRO/I

Computer

WindO/I-NV4

USB flash driveSD memory card

Upload

Download
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2 About the WindO/I-NV4

1

System
 Com

position

    

WindO/I-NV4 is software that is exclusively designed for operation with the MICRO/I, for specifying settings and 
creating screens. The set of data made up of settings and created screens is called a project.
Using WindO/I-NV4, you create a project and then download it to the MICRO/I, to build the interface necessary for 
operation.

2 About the WindO/I-NV4

Download

Upload

Download

Upload

Download

Upload

WindO/I-NV4 MICRO/I

External Memory Device

USB flash driveSD memory card
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The MICRO/I includes multiple modes, so you switch between modes as and when necessary. These modes are called 
operating modes. The functions and the operations and conditions for switching are as follows.

3 Operating Modes

Mode Functions
Conditions required for 
switching to the mode

Run Mode
This is the mode at the time of executing project 
data. The created screen is displayed.

• Turn ON the power to the MICRO/I.
• Press [Run] on the Top Page in System 

Mode or on the Main Menu.
• The download of the project data is 

completed.

System Mode
Perform initial settings, clock settings, self-diagnosis, 
etc. for the MICRO/I.

• Press down for 3 seconds or more at the 
top-left corner of the screen to display the 
Maintenance Screen, and then press 
System Mode.

• Using the screen switching button, multi-
buttons, screen switch or multi commands, 
switch to the System Mode.

• All data is cleared using WindO/I-NV4.
• Write the System Area 1 Display screen 

number (address number+0) to FFFFh.

Monitor Mode

Monitor Mode is used for monitoring values of 
device addresses using WindO/I-NV4.
In this mode, the words "Monitor Mode" flashes at 
the bottom-left of the MICRO/I screen.

On the WindO/I-NV4 Online tab, in the 
Monitor group, click Start Monitor.

Offline Mode

MICRO/I stops communicating with the external 
devices. It takes you to a Main Menu with many 
internal settings to choose from including Initial 
Setting, Clock Setting and System Information etc.
In this mode, the message "Offline Mode" blinks on 
the bottom-left of the MICRO/I screen.

• Press Offline on the Top Page in System 
Mode or on the Main Menu.

• While monitoring in WindO/I-NV4, on the 
Online tab, in the Monitors group, click 
Go offline.

Data Transfer 
Mode

Transferring data between a computer and the 
MICRO/I.

• Download project data.
• Upload project data.

When switched to System Mode, operation of the MICRO/I stops.

• To display the Maintenance Screen, the Enable Maintenance check box from the System Settings tab 
of the Project Settings dialog box must be checked.

• For details about Maintenance Mode, refer to Chapter 34 “1 Maintenance Screen” on page 34-1.
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4 Flow from Screen Creation and to Run Operation

1

System
 Com

position

  

The following flowchart describes the sequence of step from the screen creation for the MICRO/I to the Run 
operation.

4 Flow from Screen Creation and to Run Operation

1 Launch the WindO/I-NV4

2 Creating a Project and Screen

Modifying the project

6 Troubleshooting

8 Maintenance

4 Downloading the project

3 Saving the project

5 Debug

7 RUN

( refer to Chapter 2 “2.1 Starting WindO/I-NV4” on page 2-38)

Creating a new project ( refer to Chapter 4 “1.1 Creating New Project Data” on page 4-1)
         ↓
• Creating new screens ( refer to Chapter 5 “2.1 Creating Screens” on page 5-2)

( refer to Chapter 24 “2 Downloading” on 
page 24-12)

(refer to Chapter 25 “Monitor Function” on 
page 25-1)

( refer to Chapter 36 “Troubleshooting” on 
page 36-1)

(refer to Chapter 28 “Maintenance” on page 
28-1)

( refer to Chapter 4 “1.3 Saving Project 
Data” on page 4-5)

(refer to Chapter 26 “Simulator Function” 
on page 26-1)
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1 Launch WindO/I-NV4

Launch WindO/I-NV4.

2 Creating a Project and Screen

Create a project and performing various settings.
Create display screens.

3 Saving the project

Save the project data at any time after the configuration settings are done.

4 Downloading the project

Connect the computer to the MICRO/I using a USB cable or Ethernet cable and download the created project data to 
the internal memory of the MICRO/I.

5 Debug

Using Monitor function and Simulator function, you can correct created project data while confirming actual actions.

6 Troubleshooting

If there is a module or communication-related problem with the MICRO/I, or a problem with the screen, an 
appropriate message is displayed at the top of the screen.
In addition, error information is saved to a special data register. By referring to this information and repeatedly 
correcting the project, downloading, and debugging, the project can be completed.

7 RUN

Starting communication with the external device and execute various functions according to the project settings.

8 Maintenance

The Web Server function allows the user to remotely monitor or operate the state of the O/Is from the web
browser. In addition, the saved data in the MICRO/I and files in External Memory Device can be uploaded to the 
computer.
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This chapter describes the minimum system requirements for WindO/I-NV4, how to start and exit it, and the 
configuration of its screens and menus.

  

1.1 Available Data

● Data types
Data type is the format of the data related to the minimum and maximum values of data that can be processed by a 
part and handling of negative and real numbers.
Data types and data ranges that can be used on the MICRO/I and WindO/I-NV4 are listed below.

● Data handling
Data stored in device addresses is handled as described below.

Chapter 2 WindO/I-NV4 Features & Basic Operations

1 WindO/I-NV4 Specifications

Data type Required word count Processable data range

UBIN16(W) 1 0 to 65535

BIN16(I) 1 -32768 to 32767

UBIN32(D) 2 0 to 4294967295

BIN32(L) 2 -2147483648 to 2147483647

BCD4(B) 1 -999 to 9999

BCD8(EB) 2 -9999999 to 99999999

Float32(F) 2 -3.4x1038 to -1.18x10-38, 0 , 1.18x10-38 to 3.4x1038

Bit - 0, 1

String(S) -
String data. It handles from the beginning to the NULL(00h) character as a 

character string.

Data type Data handling

UBIN16(W) Data is handled as an unsigned 16-bit integer.

BIN16(I)
Data is handled as an signed 16-bit integer.
If the sign bit (bit 15) is 1, the value is two’s complement.

UBIN32(D)
Handled as an unsigned 32-bit integer with the starting address 
number as the lower word.

BIN32(L)
Handled as a signed 32-bit integer with the starting address 
number as the lower word.
If the sign bit (bit 31) is 1, the value is two’s complement.

BCD4(B)

Data is handled as a four digit (16-bit) binary-coded decimal value.
Each four bits from bit 0 to bit 11 is handled as the absolute value 
for the 1st to 3rd digit.
Bit 12 to bit 15 is handled as the minus sign (-) when its value is F 
(Hex) and it is handled as the absolute value for the 4th digit when 
0 to 9 (Hex).

bit bit
15 01 word

bit bit
15 01 word

Sign bit

bit
31

bit
0Upper word Lower word

bit
0

bit
31 Lower wordUpper word

Sign bit

bit bit
15 01 word

Sign

1st2nd3rd

Absolute value
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BCD8(EB)

Data is handled as an eight digit (32-bit) binary-coded decimal 
value.
Each four bits from bit 0 to bit 27 is handled as the absolute value 
for the 1st to 7th digit.
Bit 28 to bit 31 is handled as the minus sign (-) when its value is F 
(Hex) and it is handled as the absolute value for the 8th digit when 
0 to 9 (Hex).

Float32(F)

Data is handled as a 32-bit floating-point real number. The number of significant digits is 6 digits. The 
floating-point type data format conforms to the IEEE (The Institute of Electrical and Electronics Engineers) 
standard for the single precision storage format as explained next.

Single precision floating-point values in IEEE 754 (32 bits)
Single precision floating-point values in IEEE 754 are expressed with a total of 32 bits (2 words) using 1 bit for 
the sign s, 8 bits for the exponent e, and 23 bits for the significand f. The sign bit indicates the sign of the 
expressed value (positive or negative). The exponent is an 8 bit signed integer with a value from -128 to 127.

Example:

If all bits are 0, the value is “0”.

Data type Data handling

bit
0

bit
31

Absolute value

Lower wordUpper word

Sign

1st2nd3rd4th5th6th7th

s e (exponent) [bit 30 to 23]

bit
31

bit
23

f (significand) [bit 22 to 0]

Represents after the decimal of 1.xxx+127

Sign bit (0: positive, 1: negative)

bit
22

bit
0

bit
30

s e f
0 0 1 1 1 1 1 0 1 1 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

1 . 1 × 2 - 2

The internal representation of Float32(F) is described here, but the data for Float32(F) (floating-point real 
numbers) is handled with a special bit configuration, so do not directly access the bits.

Data type Data handling

Float32(F)

The entered text are stored in the upper byte and the lower byte according to the Storage Method of 
String Data setting of WindO/I-NV4. 

Select the from Upper byte in the Storage Method of String Data

Select the from Lower byte in the Storage Method of String Data

For details, refer to Chapter 10 “2.6 String Data Storage Method” on page 10-55.
The Storage Method of String Data is configured on the System tab in the Project Settings dialog 
box.

1st
character

Upper byte

2nd
character

Lower byte

3rd
character

Upper byte

n-2-th
character

Upper byte

n-1-th
character

Lower byte

n-th
character

Upper byte

NULL
(00ｈ)

Lower byte

1 word

String Data

1st
character

Upper byte

2nd
character

Lower byte

4th
character

Upper byte

n-2-th
character

Upper byte

n-1-th
character

Lower byte

n-th
character

Upper byte

NULL
(00ｈ)

Lower byte

1 word

String Data
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Example: Data handling

Data type Storing 0FFF (Hex) in LDR0 Storing FFFF (Hex) in LDR0

UBIN16(W)

0FFF (Hex) is handled as 4095 (Dec). FFFF (Hex) is handled as 65535 (Dec).

BIN16(I)

0FFF (Hex) is handled as 4095 (Dec). Sign bit is 1, so FFFF (Hex) is two’s complement, 
handled as -1 (Dec).

Data type Storing FFFF (Hex) in LDR0, 0FFF (Hex) in LDR1 Storing FFFF (Hex) in LDR0, FFFF (Hex) in LDR1

UBIN32(D)

0FFFFFFF (Hex) is handled as 268435455 (Dec). FFFFFFFF (Hex) is handled as 4294967295 (Dec).

BIN32(L)

The sign bit is 0, so the positive number 0FFFFFFF 
(Hex) is handled as 268435455 (Dec).

Sign bit is 1, so two’s complement of the negative 
number FFFFFFFF (Hex), handled as -1 (Dec).

Data type Storing 1234 (Hex) in LDR0 Storing F765 (Hex) in LDR0

BCD4(B)
The sign is 1 (Hex), so the binary-coded decimal 

value of the positive number 234 (Hex), 
handled as 1234 (Dec).

The sign is F (Hex), so the binary-coded decimal 
value of the negative number 765 (Hex), 

handled as -765 (Dec).

Data type
Storing 5678 (Hex) in LDR0, 1234 (Hex) in 

LDR1
Storing 4321 (Hex) in LDR0, F765 (Hex) in 

LDR1

BCD8(EB)
The sign is 1 (Hex), so the binary-coded decimal 

value of the positive number 2345678 (Hex), 
handled as 2345678 (Dec).

The sign is F (Hex), so the binary-coded decimal 
value of the negative number 7654321 (Hex), 

handled as -7654321 (Dec).

Data type Storing 0000 (Hex) in LDR0, BFA0 (Hex) in LDR1

Float32(F)

bit bit
15 0

0FFF (Hex)

LDR0

0000111111111111

bit bit
15 0

FFFF (Hex)

LDR0

1111111111111111

bit bit
15 0

0FFF (Hex)

LDR0

1111111111110000

+

bit bit
15 0

FFFF (Hex)

LDR0

1111111111111111

−

bit
31

bit
0LDR1 LDR0

00001111111111111111111111111111

0FFFFFFF (Hex)

bit
31

bit
0LDR1 LDR0

1111111111111111111111111111

FFFFFFFF (Hex)

1111

bit
31

bit
0LDR1 LDR0

00001111111111111111111111111111

0FFFFFFF (Hex)+

bit
31

bit
0LDR1 LDR0

11111111111111111111111111111111

FFFFFFFF (Hex)−

bit bit
15 0

234 (Hex)

LDR0

+

0001001000110100

bit bit
15 0

765 (Hex)

LDR0

−

1111011101100101

bit
0

bit
31

2345678 (Hex)

LDR0LDR1

+

00010010001101000101011001111000

bit
0

bit
31

7654321 (Hex)

LDR0LDR1

−

00010010001101000101011001111111

bit bit
22 0

bit
31

bit
23

Exponent

LDR0LDR1

Sign Significand

10111111101000000000000000000000

0000 (Hex)BFA0 (Hex)

1 0100000000000000000000001111111

2-2 = 0.2520+21+22+23+24+25+26 = 127
Negative

−1.25×2127-127 = −1.25
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Data type Storing "MICRO/I" in LDR50

String(S)

Select from Upper byte in Storage Method of String Data

Select from Lower byte in Storage Method of String Data

In the data types UBIN32(D), BIN32(L), BCD8(EB), and Float32(F), two words (upper word and lower 
word) are used for a single value. The MICRO/I and external devices communicate data in device 
addresses in one word units, so when the upper word and lower word are sent in separate packets, the 
value may have already changed when the data for both words is received, which may cause an 
unexpected result.

M
(4d)Stored value

LDR50

Upper byte

I
(49)

Lower byte

C
(43)

LDR51

Upper byte

R
(52)

Lower byte

O
(4f)

LDR52

Upper byte

I
(49)

Lower byte

LDR53

Upper byteLower byte

00h (No change)

I
(49)Stored value

LDR50

Upper byte

M
(4d)

Lower byte

R
(52)

LDR51

Upper byte

C
(43)

Lower byte

I
(49)

LDR52

Upper byte

O
(4f)

Lower byte

LDR53

Upper byteLower byte

00h(No change)
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● Indirect Read and Indirect Write Settings
The indirect specification of a device address means to add a value (indirect value) to the address number of the set 
device address and use that address number as the actual read source or write destination. You can change the read 
source or write destination address number just by changing this indirect value.

Indirect read

Add the indirect value to the address number of the device address set as the read source and read the value of the 
indirectly specified device address.
Example: To read an indirectly specified value of device address into LDR200

When the device set as the read source is LDR10 and the indirect value’s device address is D21, if 4 
(indirect value: 4) is set in D21, the device address of the value actually read is LDR14.

Indirect write

Add the indirect value to the address number of the device address set as the write destination and write a value to 
the indirectly specified device address.
Example: To write the value in LDR20 to an indirectly specified device address

When the device set as the write destination is LDR100 and the indirect value’s device address is D20, if 3 
(indirect value: 3) is set in D20, the device address of the value actually written is LDR103.

Parts you can indirectly read and indirectly write

Device address set as read source

Device address with actually read value

Device address for Indirect value
200LDR11
300LDR12

100LDR10

500LDR14

4D21

500LDR200

4 words
Indirect value

Read

LDR13 400

200LDR101
300LDR102

100LDR100

1000LDR103
3D20

1000LDR20

3 words
Indirect value

Device address set as write source

Device address with actually written value

Device address for Indirect value

Write

Part Indirect read Indirect write

Word Button YES YES

Multi-Button YES YES

Numerical Input YES YES

Character Input YES YES

Numerical Display YES NO

Word Write Command YES YES

Script Command YES YES

Multi-Command YES YES

• Enter the value for indirect values as the data type UBIN16(W). Indirect values can be set in the range of 
0 to 32767. When an indirect write is executed with an out-of-range indirect value, “Device range error” 
is displayed. Similarly, when an indirect read is executed, the previous value before the indirect value 
changed is retained for a data display part, and “Device range error” is displayed for a part that is not a 
data display part.

• For reading device address indirectly, decide the read source address number after the indirect value changes 
and after the screen changes, and then read the value of device address. For the device address of an 
external device, communication may take some time as the value is read from the external device, so when 
transferring or calculating the data that was read, repeatedly execute the corresponding part.
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1.2 Available Text

● Font

Supported Languages

The MICRO/I can display multiple fonts by installing them. In addition to the fonts installed on the MICRO/I, all 
Windows fonts displayed on your computer can be used on the display.

In addition, the MICRO/I has a function that switches between two or more text groups dynamically. With this 
function, the registration text of buttons can be switched to different languages according to the conditions.
For details, refer to Chapter 19 “Text Group” on page 19-1.

Font Description

Fonts installed in the MICRO/I

Fonts to be pre-loaded on the MICRO/I.
Japanese, European, Chinese, Korean, Taiwanese, Central European, Baltic and Cyrillic 
fonts can be installed on the MICRO/I.
The installed fonts installed can be changed as needed using WindO/I-NV4, which 
helps save and efficiently operate the user capacity.

Windows Font

All fonts used on the computer can be displayed on the MICRO/I.
The Windows fonts allow you to display expressive characters on the MICRO/I screen 
as needed.
Windows fonts are downloaded as part of the project data.

External device
MICRO/I

目標達成

D100 : 1

D100 : 2

D100 : 3

Text ID: 1 目標達成

Group 1: English Group 2: Chinese Group 3: Japanese

Goal reached

Goal reached
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Installed Fonts in the MICRO/I

Font Name Code System Language

Standard 
Fonts

Japanese
JIS 8-bit code 
JIS level-1 and 
level-2 kanji sets

Japanese

English ISO 8859-1 (Latin1)
Icelandic, Irish, Italian, English, Dutch, Swedish, Spanish, Danish, 
German, Norwegian, Portuguese, Finnish, Faeroese, French

Stroke ISO 8859-1 (Latin1)
Icelandic, Irish, Italian, English, Dutch, Swedish, Spanish, Danish, 
German, Norwegian, Portuguese, Finnish, Faeroese, French

7-seg ISO 8859-1 (Latin1)
Displays number 0 to 9, alphabet character A to F, and symbols 
such as asterisk, plus, minus, and period only

Optional 
Fonts

Japanese large 
font
(first standard)

JIS level-1 kanji set
* Install this font to achieve a sharper display of enlarged JIS 
level-1 kanji set.
Refer to “High-quality Fonts” on page 2-10.

Japanese large 
font
(second standard)

JIS level-2 kanji set
* Install this font to achieve a sharper display of enlarged JIS 
level-2 kanji set.
Refer to “High-quality Fonts” on page 2-10.

Chinese GB2312 Chinese

Korean KSC5601 Korean

Taiwanese BIG5 Taiwanese

European large 
font

ISO 8859-1 (Latin1)
* Install this font to achieve a sharper display of enlarged 
European fonts.
Refer to “High-quality Fonts” on page 2-10.

Central European ANSI1250 Czech, Hungarian, Polish, Slovak, Slovene

Baltic ANSI1257 Estonian, Latvian, Lithuanian, Greenlandic, Lappish

Cyrillic ANSI1251 Bulgarian, Belarusian, Ukrainian, Serbian 2, Macedonian, Russian

The MICRO/I displays the single-byte parts of Chinese, Taiwanese, and Korean with ISO 8859-1, and 
supports Hangul characters only in the double-byte part of Korean.
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Available Fonts for Parts

*1 To use a MICRO/I-installed font, the font should be downloaded from the WindO/I-NV4 in advance. Depending on parts and 
part setting, to the use of Stroke, European Outline, or 7-seg under “Font” may not be possible. For details, refer to the 
section on Parts.

*2 Windows font can be used for fixed text only. Only the MICRO/I-installed font can be used for the read device data code for 
the Message Display.

*3 Windows font can be used only when the “Use Text Manager” is selected.

Parts Description MICRO/I-installed Font*1 Windows Font

Buttons

Bit Button YES YES

Word Button YES YES

Goto Screen Button YES YES

Print Button YES YES

Key Button YES YES

Keypad YES YES

Selector Switch YES YES*3

Lamps
Pilot Lamp YES YES

Multi-State Lamp YES YES

Data Displays

Numerical Input YES YES

Character Input YES NO

Message Display YES YES*2*3

Message Switching Display YES YES*3

Alarm List Display YES YES*3

Alarm Log Display YES YES*3

Numerical Display YES YES

Calendar YES NO

Charts
Bar Chart YES YES*3

Line Chart YES YES*3
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Font Size

Example: When downloading Japanese large font (level-1 kanji set), Chinese, and European large fonts: 

Font Name Code System Size

Optional Fonts

Japanese large font (first standard) JIS level-1 kanji set 476KB

Japanese large font (second standard) JIS level-2 kanji set 423KB

Chinese GB2312 237KB

Korean KSC5601 108KB

Taiwanese BIG5 421KB

European large font ISO 8859-1 (Latin1) 101KB

Central European ANSI1250 5.25KB

Baltic ANSI1257 5.25KB

Cyrillic ANSI1251 5.25KB

The download size of font data is adjusted in multiples of 64KB.
The download size of font data is 64KB when the font size is 0KB or 64KB and smaller.

Font Size

Japanese large font (first standard) 476KB

Chinese 237KB

European large font 101KB

Total size of the font data: 814KB

Download size of font data: 832KB (814KB is adjusted in multiples of 64KB.)
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● High-quality Fonts
The high-quality fonts are the Japanese large fonts (first standard/second standard), and European fonts.
If you download high-quality fonts and select Use large font on the System tab in the Project Setting dialog box, the 
MICRO/I can replace some of the optional fonts with the high-quality fonts.
Scaled text with a background color is replaced and displayed with these fonts for a more attractive look.

High-quality European Font Display (Size 8x16)
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High-quality Japanese Font Display (Size 8x16)
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High-quality Japanese Font Display (Size 16x16)
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• When the high-quality fonts have not been downloaded into the operator interface, the Standard fonts 
are used even if “Use large font” is selected.

• When the Character Input part display font size is 8x16, high-quality fonts are not displayed even if “Use 
large font” is selected.
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● Windows Font
Selecting Windows Font for the Font property gives you access to all of the fonts installed on your computer for use 
on Drawing Objects and Parts. This allows you to display fonts and languages that are not installed on the MICRO/I.

Windows Font Settings

Windows Font settings are made in the Font Settings dialog box.

1 Click the Change button in the Windows Font group on the properties dialog box for Drawing Objects, Parts, or on 
the Text Manager.

2 Set each item and click the OK button.

■ Font
Select the font to use.

■ Font style
Select italic, bold, or other style.

■ Size
Select the size of the text.

■ Sample
Shows a preview using the specified font.

■ Script
Select the character set code.

• The right end of the text may have missing dots if Font style is set to Italic. You can remedy this by 
adding an extra space at the end of the line.

• An alternate font will be used if the Project Data uses a font that does not exist on the computer. This 
means that text will appear differently if the Project Data is opened on another computer.

• The same font may also appear differently for different OS versions.
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Using Windows Fonts

This section describes how to use Windows Fonts.

To register and use a Windows Font in Text Manager

1 Select the Use Text Manager check box on the Properties dialog box for Draw Objects and Parts.

• The Use Text Manager check box may appear in different locations depending on the part. This table shows 
where to find this property:

• The Alarm List Display and Alarm Log Display parts are designed to use the text registered in the Text Manager so 
the Use Text Manager check box is not shown.

2 Specify the Text ID for the Windows Font set in Text Manager.

Selecting Windows Font for the Font property for Draw Objects and Parts automatically disables these 
properties:

• Style: The style set under Windows Font will be used.

• Magnification: The width by height magnification will be set to 1 x 1. Note, Magnification can be 
selected on the Message Display, Message Switching Display, and Alarm List Display 
parts, but will not be reflected on the actual text displayed. To use scrolling on these 
parts, adjust the display area for text using the Magnification property.

Applicable 
draw object

Text

Applicable 
parts

Buttons
Bit Button, Word Button, Goto Screen Button, Print Button, Key Button, Keypad, Selector 
Switch

Lamps Pilot Lamp, Multi-State Lamp
Data Displays Message Display, Message Switching Display, Alarm List Display, Alarm Log Display
Charts Bar Chart, Line Chart

Part Location

Text Properties of Text dialog box

Bit Button, Word Button, Goto Screen Button, Print Button, Key Button, 
Pilot Lamp, Multi-State Lamp

Registration Text tab

Selector Switch, Message Display General tab

Message Switching Display Message tab

Bar Chart, Line Chart Label tab

• Using the Text ID for the Windows Font set in Text Manager disables these settings in the Properties 
dialog box:

- Align Text: Multiple lines of texrot are shown aligned center-left when Center is selected. Text 
is shown with right-indented left-aligned when Right is selected.
With right-indented left-aligned formatting, the line containing the most number of 
characters is aligned on the right end while the other lines are aligned to the left 
end of that line.

- Vertical Writing: Horizontal writing is used.

• The maximum number for the unit in the Numerical Input and Numerical Display parts is 4 characters. 
The fifth character and any characters beyond that will appear outside the part.

• In the Message Display, variable text “\@” appears as is.
• With the Alarm List Display and Alarm Log Display, line spacing is not automatically adjusted based on 

the size of the text. Adjust it using the Line Spacing property on the Format tab.
• If text containing a carriage return is used for a label on a Bar or Line Chart, or for an Alarm List Display 

or Alarm Log Display part, it will appear truncated after the carriage return if a non-Windows Font is 
used. The entire text, including the carriage return, is shown when using a Windows Font.

• When printing Alarm Logs, Text IDs set to a Windows Font will be printed using a font that exists on the MICRO/I.

Aligns text to left end of line with most characters

Aligns text to right end of line with most characters
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To select a font in the Properties dialog box

Select Windows for Font on the Properties dialog box for a Draw Object or Part.
The Font property may appear in different locations depending on the part. This table shows where to find this 
property:

Applicable 
draw object

Text

Applicable 
parts

Buttons Bit Button, Word Button, Goto Screen Button, Print Button, Key Button, Keypad

Lamps Pilot Lamp, Multi-State Lamp

Part Location

Text Properties of Text dialog box

Bit Button, Word Button, Goto Screen Button, Print Button, Key Button, Pilot 
Lamp, Multi-State Lamp

Registration Text tab

Keypad Properties of Keypad dialog box

Numerical Input, Numerical Display View tab
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● Character Code Table

Using the Character Code Table

Example: Finding the character code for the character “a” in the table.

The upper four bits of the code are hexadecimal 6.
The lower four bits of the code are hexadecimal 1.
Therefore, the character code for "a" is as follows.

Upper 4 bits of the code (hexadecimal)

Lower 4 bits of the code (hexadecimal)

Upper 4 bits

Lower 4 bits

"a " :  6 1

For other fonts and two-byte characters, refer to the table of the relevant code system.
Japanese (two-byte characters): JIS first standard/second standard, Chinese: GB2312, Taiwanese: BIG5, 
Korean (Hangul character): KSC5601
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European Font (ISO 8859-1)

Central European Font (ANSI 1250)
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Baltic Font (ANSI 1257)

Cyrillic Font (ANSI 1251)
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Japanese Font (JIS X0201)

Control Codes

Refer to the following table when using control codes in User Communications.
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1.3 Available Number of Colors

The available number of colors that can be used on the WindO/I-NV4 are listed below.

1.4 Available Image Files

The image file formats that can be displayed on the MICRO/I are as follows.

● About Picture Manager
Picture Manager is an application for managing pictures used for part diagrams and drawings. 
• When saving, deleting, or reducing pictures, the following operations are displayed in Picture Manager.

- On the View tab, in the Workspace group, click  (Picture Manager).
- Double click Picture Manager in the Project window.

• To set up the Picture from the Drawings, click on the editing screen where the Picture is positioned to display 
Picture Manager.

• If setting a graphic for a positioned object, display Picture Manager from the Properties dialog box.

*1 Color LCD models
*2 Monochrome LCD models

Model Target Number of colors

HG5G/4G/3G/2G-V, HG4G/3G, 

HG2G-5F/-5T*1, HG1G/1P

Picture Manager 65536 colors

Drawing objects and Properties sheet 256 colors

HG2G-5T*2
Picture Manager Monochrome (16 shades)

Drawing objects and Properties sheet Monochrome (16 shades)

File format Description

JPEG
Supports JPEG files that conform to the JPEG standard (ISO/IEC 10918-1, ITU-T Recommendation 
T.81) that adopt baseline DCT coding. The JFIF extension specification is not supported.

Bitmap
Supports monochrome bitmaps, 16-color bitmaps, 256-color bitmaps, and 24-bit bitmaps in which 
data is stored from the bottom up. Run-length encoding is only supported for 256-color bitmaps.

• The MICRO/I cannot handle image files that are larger than the size of the screen. Images that exceed 
the screen size are not displayed.

• The Numerical Input, Character Input, Message Display, Message Switching Display, Numerical Display, 
Calendar, and Meter cannot correctly display pictures that use a transparent color.

• IDEC recommends using bitmap image files when display speed is a priority. JPEG image files take more 
time to display on the MICRO/I than bitmap image files.
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● Saving pictures in Picture Manager
This section describes how to save drawing objects in Picture Manager. Saved pictures can be used for part diagrams 
and drawings.

Saving image files

1 Click Import in Picture Manager.

The Open dialog box is displayed.

2 Specify the image file, and then click Open.

When managing pictures by category, create a new category, and select it. To create a category, click 

Configure, and then click  (New Category) on the Category dialog box. For details, refer to “Category 
Dialog Box” on page 2-31.

Click Options to Apply Dithering or Color Exchange. For details, refer to “Open Dialog Box” on page 2-
30.
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The picture is saved in Picture Manager. The name of the image file becomes the picture name.

(Picture name)

• Even when the image is saved to a different category, if a picture of the same name is already saved in 
that category, a confirmation message to overwrite the file is displayed.
- Click Yes to overwrite the image.

After overwriting, the image is saved in the list of the selected category, and the previous image is 
deleted from the list.

Example: The picture "Picture00" is saved in the category "Pic_Lib."
If the picture "Picture00.bmp" is saved to the category "NewBook1," the new image 
"Picture00" is saved to "NewBook1," and the image named "Picture00" that was previously 
in "Pic_Lib" is deleted.

- Click No to stop saving the picture.

• If a picture is imported that is larger than the screen size, it will be automatically shrunk.
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Selecting pictures from Symbol Factory

1 Click Symbol Factory in Picture Manager.
Symbol Factory is displayed.

2 Select a category of pictures from Categories.
A list showing pictures in the category selected from Symbols is displayed.

When managing pictures by category, create a new category, and select it. To create a category, click 

Configure, and then click  (New Category) on the Category dialog box. For details, refer to “Category 
Dialog Box” on page 2-31.

(Categories tab)

(Symbol Options)

By using the settings in (Symbol Options), you can modify fill color and background color, and to flip or 
rotate shapes. For details, refer to “Symbol Options” on page 2-33.
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3 Select a picture from (Categories tab) to display it in Preview.
The size of the picture displayed in Preview is equal the size of the registered picture.

4 Right-click the picture displayed in Preview, then click Copy.

The Picture Name Setting dialog box is displayed.

5 Enter the name of the graphic in Picture Name.

The maximum number is 256 characters.

The size of the picture displayed in Preview can be changed.
1. Right-click the picture displayed in Preview, then click Set Preview Size.

The Set Preview Size dialog box is displayed.
2. Specify the width and the height, and click OK.

Preview shows the picture with the specified size.
For details, refer to “ Set Preview Size Dialog Box” on page 2-35.

You can also display the Picture Name Settings dialog box by double-clicking a picture displayed in Preview.

You cannot use the following characters in the picture name.
   \  / : , ; * ? " < > |

(Options)

Configures the image processing in Options. For details, refer to “Picture Name Setting Dialog Box” on 
page 2-36.
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6 Click OK.
The picture is saved in Picture Manager.

Saving drawing objects drawn on the editing screen

Drawing objects drawn on the editing screen are saved as pictures, in NMF (NV Metafile) format in Picture Manager.

1 Select and right-click the drawing object, then click Copy to Picture Manager.

The Picture Name Setting dialog box is displayed.

If a picture contains transparency or Transparent Color is selected as to for the imported picture, the 
transparency range is displayed in magenta (R: 255, G: 4, B: 255).

Grouped drawing objects can be saved to Picture Manager as a single picture.
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2 Enter the name of the drawing object in Picture Name.

The maximum number is 256 characters.

3 Click OK.
The drawing object is saved in Picture Manager.

You cannot use the following characters in the picture name.
   \  / : , ; * ? " < > |

(Options)

Configures the image processing in Options. For details, refer to “Picture Name Setting Dialog Box” on 
page 2-36.

If a picture contains transparency or a picture is imported with the option of enabling the transparency, the 
transparency range is displayed in magenta (R: 255, G: 4, B: 255).
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● Saving pictures as image files
To use a picture saved in Picture Manager on another computer, save the picture as an image file.

1 Select a picture to export, and then click Export.

The Browse For Folder dialog box is displayed.

2 Select the folder to save, and then click OK.

• To select multiple pictures, press and hold SHIFT or CTRL while you click the specific items.
• To save as an image file in NMF (NV Metafile) format, select and right-click the drawing object drawn on 

the editing screen, then click Export as NV Metafile.
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● Picture Manager
Pictures used in pictures of part diagrams and drawings are managed using Picture Manager.

■  (Rename picture)
Renames the picture selected in the picture list. The maximum number is 256 characters.

■  (Delete)
Deletes the picture selected in the picture list. Pictures that are used in project or parts cannot be deleted.

■  (Reduce)
Deletes all the pictures not used in the project from the pictures saved in the picture list.

■  (Check All)
Selects all of the check boxes for the pictures registered to the picture list.

■  (Reset)
Clears all of the check boxes for the pictures registered to the picture list.

■  (Save Picture Files in External Memory Device)
Saves the image files for the pictures selected with the check boxes to external memory device.
Click this button to display the Select Drive dialog box.

■ (Category)
The name of the category is displayed.
Selects a category to save to when saving pictures.
When selecting a picture, select the category in which the arranged picture is saved.

The only default category is "Pic_Lib." To add a category, click Configure, and then click  (New Category) in the 
Category dialog box.

■ Configure
Opens the Category dialog box. You can add or change the category to save. For details, refer to “Category Dialog 
Box” on page 2-31.

(Picture List)

(Image)

(Picture Name)

(Check box)

You cannot use the following characters in the picture name.
   \  / : , ; * ? " < > |



WindO/I-NV4 User’s Manual 2-29

1 WindO/I-NV4 Specifications

2

W
indO

/I-N
V4 Features &

 Basic O
perations

■ (Picture list)
The saved pictures are displayed as a list of images.

■ Import
Save pictures in Picture Manager. Click this button to display the Open dialog box. For details, refer to “Saving image 
files” on page 2-21.
Supported file formats are as follows. When selecting images that are in WMF or ICO file format, the image is 
converted to a bitmap before saving.
• BMP (bitmap file)
• WMF (Windows Metafile)
• JPEG
• ICO (icon files)
• NMF (NV Metafile)

■ Export
Saves a picture selected in the picture list in BMP (bitmap), JPEG, or NMF (NV Metafile) file format, according to file 
type. Click this button to display the Browse For Folder dialog box. For details, refer to “Saving pictures as image files” 
on page 2-27.
Saved graphics can be saved using Import.

■ Symbol Factory
Display the Symbol Factory images. You can select an image provided by Symbol Factory on your project data. For 
details, refer to “Symbol Factory” on page 2-32.

■ Select
Closes Picture Manager and sets the picture selected in the picture list.

■ Close
Closes Picture Manager.

(Image): An image of the picture is displayed. If a picture contains transparency or a picture is imported 
with the option of enabling the transparency, the transparency range is displayed in magenta 
(R: 255, G: 4, B: 255).

(Picture Name): The name of the picture is displayed.
(Check box): Select this check box to save the picture data to external memory device and use it.

Click  (Write Picture Files to External Memory Device) to save the image files for the pictures 
selected with the check boxes to external memory device.

When the picture data is saved to external memory device, the amount of project data can be decreased, 
which allows you to save the internal memory on the MICRO/I. However, the display update rate of the 
pictures will become slower. To give priority to the display update rate, clear the check boxes.

If you place the cursor near an (Image) or (Picture Name), the size of the picture (width) x (height) and the 
file size (kilobytes) is displayed in a popup.
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Open Dialog Box

By clicking Options, you have the option to set the Apply Dithering and Color Exchange for the image to be 
registered in the Picture Manager.

■ Apply Dithering
Selects this check box to perform dithering (error diffusion method) on images.
This function enables some images with tonal gradations and photo-like pictures to be rendered more beautifully 
when they are saved. 

■ Color Exchange
Selects this check box to convert the color of the picture.

From: Specifies color before conversion. Click this button to display the Color Settings dialog box. Specify the color, 
and then click OK.

to: Selects the color after conversion (color: 256 colors, monochrome: 16 shades). Click this button to display the 
Color Palette. Select a color from the Color Palette. Transparent Color can also be selected.

If a color conversion to transparent is done when the monitor used for WindO/I-NV4 is a 16-bit color or 
256-color display, even colors other than the color specified in From may appear transparent. However, on 
the MICRO/I they will appear normally.
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Category Dialog Box

Manage the categories where pictures are registered.

■  (New Category)
Creates a new category in the Category List.
The default category name is "NewBookn" (n: Number).

■  (Delete Category)
Deletes a category from the Category List.

■  (Rename Category)
Changes the name of the category selected in the Category List. The maximum number is 256 characters.

■ (Category List)
The name of the category is displayed.

(Category List)

You cannot use the following characters in the category name.
   \  / : , ; * ? " < > |
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Symbol Factory

Symbol Factory is an English-version library tool that offers 5,000 images.

■ Categories 
The images supplied by Symbol Factory are divided into categories. Selects categories of pictures saved in Picture 
Manager.

■ (Categories tab)
Opens a tab for a category name selected from Categories, and shows a list of pictures. Selects a picture saved in 
Picture Manager.

■ Preview
Display a picture selected from (Categories tab) according to (Symbol Options) setting.

■ (Symbol Options)
Modify the fill and background color and flip or rotate shapes. For details, refer to “Symbol Options” on page 2-33.

(Categories tab)

(Symbol Options)

For details, see online help for Symbol Factory.



WindO/I-NV4 User’s Manual 2-33

1 WindO/I-NV4 Specifications

2

W
indO

/I-N
V4 Features &

 Basic O
perations

Symbol Options

Modify the fill color and background color, and to flip or rotate a picture selected in (Categories tab).

■ Fill Color

■ Orientation

(Symbol Options)

Fill Color Mode: Select from the following picture color conversion methods.

Original: The color of the image is not changed.

Shaded: The image filled with different shades of the color selected in Fill Color (for a 3D 
effect).

Solid: The image is filled uniformly in the color selected in Fill Color.

Hollow: All color is deleted.

Fill Color: Selects the color used for Shaded or Solid modes. Click this button to display the Color Settings 
dialog box. Select a color from the Color Palette.
This option can only be set when Shaded or Solid are selected as the Fill Color Mode.

Defaults: Returns all settings in Fill Color to their default.

Shaded Solid HollowOriginal

Flip: Select from the following flipping methods.

None: The image is not flipped.

Horizontal: The image is flipped horizontally.

Vertical: The image is flipped vertically.

Both: The image is flipped both horizontally and vertically.

Horizontal Vertical BothNone
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■ Export Options

■ Options

Rotation: Select from the following rotation methods.

0: The image is not rotated.

90: The image is rotated 90° counterclockwise.

180: The image is rotated 180° counterclockwise.

270: The image is rotated 270° counterclockwise.

90 180 270None

Background Color: Selects the background color of the image when saving an image in Picture Manager or exporting 
an image using Export from the right-click menu. Click this button to display the Color Settings 
dialog box. Select a color from the Color Palette.

Defaults: Returns the background color configured to the picture to default.

When exporting an image in the following formats by clicking Export from the right-click menu, this setting 
is not applied. 
GIF, PNG, SVG, VML, WMF, XAML

Retain above Settings for Other Categories: Select this check box to keep (Symbol Options) settings.

Default All: Returns the settings in Fill Color, Orientation and Export Options to 
their default.

Help: Displays the Symbol Factory Help.
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Set Preview Size Dialog Box

Configures the size of picture selected from (Categories tab).

■ (Width)
Enters the width of the picture in pixels.

■ (Height)
Enters the height of the picture in pixels.

■ (Setting Method)
Selects the setting method of the picture size from the following.

■ Apply these settings globally to all categories
Select this check box to apply the specified size to all pictures.
If this check box is not selected, applies to the picture selected in (Categories tab). 

■ Defaults
Returns the size configured to the picture to default.

■ Help
Displays the Symbol Factory Help.

(Width)

(Height)

(Setting Method)

I want to set both the height and the width: Change the width and the height of a picture 
individually. Enters the width and the height of the 
picture.

I want to set just the width(height is automatically adjusted). : Lock aspect ratio and change the size of a picture. 
Enters the width of the picture only. 

I want to set just the height(width is automatically adjusted). : Lock aspect ratio and change the size of a picture. 
Enters the height of the picture only.
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Picture Name Setting Dialog Box

Specifies a name for images saved in Picture Manager.

■ (Image)
An image of the picture is displayed.

■ Picture Name
Enter a name for the picture. The maximum number is 256 characters.

■ Apply Dithering
Select this check box to perform dithering (error diffusion method) on images.
This function enables some images with tonal gradations and photo-like pictures to be rendered more beautifully 
when they are saved. 

■ Color Exchange
Select this check box to convert the color of the picture.

(Image)

You cannot use the following characters in the picture name.
   \  / : , ; * ? " < > |

From: Specifies color before conversion. Click this button to display the Color Settings dialog box. Specify the color, 
and then click OK.

to: Selects the color after conversion (color: 256 colors, monochrome: 16 shades). Click this button to display the 
Color Palette. Select a color from the Color Palette. Transparent Color can also be selected.

To make the background color of the picture saved from Symbol Factory transparent, set From and 
Background Color in (Symbol Options) to R: 254, G: 254, B: 254.
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1.5 Available Sound Files

The sound file formats that can be played on the MICRO/I are as follows.

1.6 Available Movie Files

Movie files that meet the following specifications can be played with the MICRO/I:

The MICRO/I may not be able to play the formats above correctly depending on the minimum system requirements.
In this situation, shrink the size of the file by lowering the frame rate or the resolution of the file or by lowering the bit 
rate of the audio. If audio is unnecessary, set to a file without sound.
Movie files is only supported by models that are equipped with a video interface.

Item Description

File format Wave files (.wav)

Data format PCM

Sampling rate 8000, 11025, 12000, 16000, 24000, 22050, 32000, 44100 Hz

Quantization 
bit rate

16-bit

Audio type Mono or stereo

File size Max. 512 KB

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

Item Description

File format
HG5G/4G/3G-V: AVI file (.avi)

HG4G/3G: MP4 file (.mp4)

Movie
HG5G/4G/3G-V: Motion JPEG

HG4G/3G: MPEG-4 Simple Profile

Audio
HG5G/4G/3G-V: PMC (Sampling rate 8000, 11025, 12000, 16000, 24000, 22050, 32000, 44100 Hz)

HG4G/3G: AAC-LC (Bit rate 32 kbps or less recommended)

Frame rate 30 fps or less (15 fps or less recommended)

Resolution 720 x 480 dots or less (640 x 480 dots or less recommended)

File size 64 Mbyte or less (32 Mbyte or less recommended)

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P
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2.1 Starting WindO/I-NV4

■ Windows 10
Click Start, click All Apps, click Automation Organizer V2, and then click WindOI-NV4.

■ Windows 8
On the Start screen tiles, click WindOI-NV4.

■ Windows 7, Windows Vista
Click Start, click Programs, click Automation Organizer V2, click WindOI-NV4, and then click WindOI-NV4.

■ Windows XP
Click Start, click All Programs, click Automation Organizer V2, click WindOI-NV4, and then click WindOI-
NV4.

WindO/I-NV4 starts.

2 Starting and Exiting WindO/I-NV4

You can also start WindO/I-NV4 by double-clicking WindO/I-NV4 icon on the desktop.
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● Automation Organizer Updater Dialog Box
Automation Organizer Updater dialog box is a feature that keeps WindO/I-NV4 up to date.
If a new version of Automation Organizer is released, the Automation Organizer Updater dialog box is displayed when 
WindO/I-NV4 starts.

■ Available Updates

■ Description
This area shows the details of the latest changes in the software.

■ Preference
The Update Preference dialog box is displayed when this button is clicked.
To update information when WindO/I-NV4 starts, check this check box.
The Automation Organizer Updater dialog box will be displayed when there is an update.

■ Close
Closes the Automation Organizer Updater dialog box and start WindO/I-NV4.

In order to display the Automation Organizer Updater, your computer must be connected to the Internet.

Date Shows the date the software was released.
Information Shows the software's title and version.

Click on this link to connect to IDEC's download site.
The software can be updated by downloading and running the latest version.
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● Project Recovery Dialog Box
The Project Recovery dialog box is a feature to restore edited project data if your computer crashes while you were 
editing. With this feature, you can return crashed the project to its last-saved state and restore project data that was 
being edited. The Project Recovery dialog box is displayed if there is crashed project data when WindO/I-NV4 starts.

■ (Recovery data list)
This list shows recoverable data for a crashed project.

■ Recover
Select the recovery data from the list and click this button to open the project data. The recovery data is deleted 
when the project data is saved.

■ Delete
Deletes the selected recovery data.

■ Delete All
Deletes all recovery data.

■ Close
Closes the Project Recovery dialog box.
Recovery data is not deleted. The Project Recovery dialog box will be displayed again the next time WindO/I-NV4 
starts.

2.2 Exiting WindO/I-NV4

Click  and then click Exit WindO/I-NV4.

WindO/I-NV4 ends.

(Recovery data list)

Project Name: Shows the project name.

Last Save Time: Shows the date and time when the data was last saved.

If WindO/I-NV4 crashes in a state where you edit a screen and perform Save Screens after saving the 
project data, the screen is not saved in the project data. Select the recovery data with the Project Recovery 
dialog box and recover the project data.
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This section describes the names and functions that make up WindO/I-NV4.

■ Title bar
The title bar shows the name of the project being edited and the name of this software, “WindO/I-NV4”.

■ Application menu
The application menu displays commands for handling project data such as commands for creating new project data, 
opening project data, and saving project data. For details, refer to “3.1 Application Menu Command List” on page 2-
42.

■ Quick access toolbar
The quick access toolbar is an area where you can locate commands that you use frequently. You can customize this 
toolbar by adding or deleting buttons. For details, refer to “3.2 Quick Access Toolbar” on page 2-43.

■ Ribbon
The ribbon shows commands for creating project data and transferring data to the MICRO/I. Common commands are 
separated into their own tabs, so you can quickly execute. For details, refer to “3.3 Ribbon Command List” on page 2-
46.

■ Workspace
The workspace is the area where the Project window, the Object List window, the Screen List window, the Part 
List window, and the Toolbox window are located. You can change the position and method for displaying windows 
in the workspace. For details, refer to “3.4 Windows Displayed in the Workspace” on page 2-54.

■ Editing window
The editing window is the area for editing Base Screens and Popup Screens.

■ Right click menu
The right click menu is a popup menu that is displayed when right clicking the mouse on drawing objects and parts in 
a list. It displays context sensitive commands.

■ Status bar
The status bar shows information such as the type number, communication driver, project data size, and cursor 
position. You can change the items displayed on the status bar. For details, refer to “3.5 Status Bar” on page 2-57.

■ Information Window
When the following operations are executed and an error is found in the project, displays a list of the error messages.
Download, Starting the Simulator, Changing Communication Drivers, Changing Product Series

3 Configuration & Functions

Ribbon

Title bar

Workspace

Editing window

Right click menu

Status bar

Quick access toolbar

Application menu

Information Window
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3.1 Application Menu Command List

Commands that can be executed from the application button are listed below.

Command Description

New
Creates project data by configuring settings displayed in dialog boxes step by 
step.

Open Opens project data that has already been created.

Save Saves the project data being edited.

Save As Saves the project data being edited with a new name.

Print Outputs the project data being edited to a printer or Word file.

Close Closes the project data being edited.

Recent Projects Shows the list of recently used project data, up to a maximum of ten items.

WindO/I-NV4 Options Customizes WindO/I-NV4 and configures the work environment.

Exit WindO/I-NV4 Exits WindO/I-NV4.
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3.2 Quick Access Toolbar

● Quick access toolbar buttons and menus
Click on a quick access toolbar button or click on ▼ to the right of a button and then click on the displayed command 
to execute that command.

● Customizing the quick access toolbar

If you click the  (Customize Quick Access Toolbar) button, the Customize Quick Access Toolbar menu is displayed.

You can change the quick access toolbar to any desired settings.

■ Changing the buttons displayed on the quick access toolbar
Check only the buttons you wish to display on the quick access toolbar.

■ More Commands
You can add or delete quick access toolbar commands.

1 Click the  button on the quick access toolbar and then click More Commands.

The Customize on the WindO/I-NV4 Options dialog box is displayed.

Quick access toolbar
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2 Add or delete commands.

To add a command
1 Select the command to add in Choose commands from.
2 Click on the command to add from the list and then click the Add>> button.

The command is added.

To delete a command
Click the command to delete and then click the Remove button.
The command is deleted.

■ Show below the Ribbon
You can change the position of the quick access toolbar to be located below the ribbon.

Click the  button on the quick access toolbar and then click Show below the Ribbon.

• If you right click a command on the quick access toolbar and click Remove from Quick Access 
Toolbar, that quick access toolbar command can be deleted.

• To change the order of the commands, drag and drop a command.
• To return to the quick access toolbar to its default settings, click the Reset button.
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The quick access toolbar moves below the ribbon.

To return the quick access toolbar to its original position, click the  button and then click Show above the Ribbon.

■ Minimize the Ribbon
You can change the format of the ribbon to be displayed only as tabs.

Click the  button on the quick access toolbar and then click Minimize the Ribbon.

The ribbon is displayed as only tabs.

Click on a tab to display its commands.

To return the ribbon to its original state, click the  button and then click on the Maximize the Ribbon.

You can also change the quick access toolbar display position to be below the ribbon with the following 
methods.
• Right click the quick access toolbar or the ribbon and then click Show below the Ribbon.
• Select the Show Quick Access Toolbar below the Ribbon check box on the Customize on the 

WindO/I-NV4 Options dialog box.

You can also return the quick access toolbar to its original position with the following methods.
• Right click the quick access toolbar or the ribbon and then click Show above the Ribbon.
• Select the Show Quick Access Toolbar below the Ribbon check box on the Customize on the 

WindO/I-NV4 Options dialog box.

You can also change the ribbon to be displayed as only tabs with the following methods.
• Right click the quick access toolbar or the ribbon and then click Minimize the Ribbon when switching to 

the tab only display, or click Maximize the Ribbon when returning to the original state.
• Double click a tab.
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3.3 Ribbon Command List

● Home
Home is where basic operations are performed such as creating a new screen, editing, and downloading project data.

■ Clipboard

■ Screens

■ Drawings

Command Description

Paste Pastes the contents of the clipboard.

Cut Cuts the selected object from the editing window and copies it to the clipboard.

Copy Copies the selected object to the clipboard.

Duplicate Duplicates the selected object.

Command Description

New
Base Screen Adds a new Base Screen.

Popup Screen Adds a new Popup Screen.

Open
Base Screen Opens a Base Screen that has already been created.

Popup Screen Opens a Popup Screen that has already been created.

Open Previous Screen Opens a screen number before the currently selected screen.

Open Next Screen Opens a screen number after the currently selected screen.

Delete Deletes the selected screen.

Reuse Copies another project’s screens.

Command Description

Shapes

Line Draws a line.

Polyline Draws a polyline.

Polygon Draws a polygon.

Rectangle Draws a rectangle.

Circle/Ellipse Draws a circle or ellipse.

Arc Draws an arc.

Pie Draws a pie.

Equilateral Polygons
Draws equilateral polygons (equilateral triangle, equilateral diamond, equilateral 
pentagon, equilateral hexagon, equilateral octagon).

Fill
Fills the region with the same color as the fill start point with the specified color 
and pattern.

Picture Inserts a picture.

Text Inserts text.
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■ Parts

*1 HG5G/4G/3G-V, HG4G/3G only

Command Description

Buttons

Bit Button Inserts a Bit Button.

Word Button Inserts a Word Button.

Goto Screen Button Inserts a Goto Screen Button.

Print Button Inserts a Print Button.

Key Button Inserts a Key Button.

Multi-Button Inserts a Multi-Button.

Keypad Inserts a Keypad.

Selector Switch Inserts a Selector Switch.

Potentiometer Inserts a Potentiometer.

Lamps
Pilot Lamp Inserts a Pilot Lamp.

Multi-State Lamp Inserts a Multi-State Lamp.

Data Displays

Numerical Input Inserts a Numerical Input.

Character Input Inserts a Character Input.

Picture Display Inserts a Picture Display.

Video Display*1 Inserts a Video Display.

Message Display Inserts a Message Display.

Message Switching Display Inserts a Message Switching Display.

Alarm List Display Inserts an Alarm List Display.

Alarm Log Display Inserts an Alarm Log Display.

Numerical Display Inserts a Numerical Display.

Calendar Inserts a Calendar.

Charts

Bar Chart Inserts a Bar Chart.

Line Chart Inserts a Line Chart.

Pie Chart Inserts a Pie Chart.

Meter Inserts a Meter.

Commands

Bit Write Command Inserts a Bit Write Command.

Word Write Command Inserts a Word Write Command.

Goto Screen Command Inserts a Goto Screen Command.

Print Command Inserts a Print Command.

Script Command Inserts a Script Command.

Multi-Command Inserts a Multi-Command.

Timer Inserts a Timer.
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■ Editing

■ Project

Command Description

Arrange

Bring to Front Moves the selected object to the front.

Send to Back Moves the selected object to the back.

Group Groups multiple objects.

Ungroup Cancels the group.

Align

Align Left Aligns selected objects to the left.

Align Center Aligns selected objects to the center.

Align Right Aligns selected objects to the right.

Align Top Aligns selected objects to the top.

Align Middle Aligns selected objects to the middle.

Align Bottom Aligns selected objects to the bottom.

Make Horizontal 
Spacing Equal

Aligns selected objects to be equally spaced horizontally.

Make Vertical Spacing 
Equal

Aligns selected objects to be equally spaced vertically.

Rotate

Rotate Right 90° Rotates selected drawing objects 90° to the right.

Rotate Left 90° Rotates selected drawing objects 90° to the left.

Flip Vertical Flips selected drawing objects vertically.

Flip Horizontal Flips selected drawing objects horizontally.

Replace
Automatically replaces a specified device address with a separate device 
address.

Select Selects objects in the editing window.

AutoResize
Automatically changes the text size to the object’s size and display region.
A specific value is added to the device address number of the object 
when pasting and duplicating parts.

Increment Bit Number
Enables or disables the increment bit number function.
A specific value is added to the bit number of the object when pasting 
and duplicating parts.

Command Description

Download

Project Data Downloads project data to the MICRO/I.

Files to External Memory 
Device

Stops the MICRO/I and then downloads files to the external memory 
device inserted in the MICRO/I. The MICRO/I resumes running when files 
have finished downloading.

Files to External Memory 
Device while running

Downloads files to the external memory device inserted in the MICRO/I 
without stopping it.

Upload

Project Data Uploads project data from the MICRO/I.

Stored Data in External 
Memory Device

Uploads data from the External Memory Device folder for the currently 
running project.

Compare
Compare Projects

Compares the screen data and scripts in an existing project with the 
project data currently being edited and displays the results of that 
comparison.

Re-verify Updates the comparison results to the most latest state.

Target Info.
Displays version information for the MICRO/I system software and project 
information.

Comm.Setup
Configures the communication target and communication conditions 
between the target and the MICRO/I or between the computer and the 
MICRO/I.



WindO/I-NV4 User’s Manual 2-49

3 Configuration & Functions

2

W
indO

/I-N
V4 Features &

 Basic O
perations

● Configuration
Configuration is where you configure the system settings for the MICRO/I that will use the project data being edited.

■ System Setup

■ Protect

■ Editor

■ Manager

*1 HG5G/4G/3G-V, HG4G/3G only

Command Description

Project Configures MICRO/I operations and functions.

Alarm Log Configures the alarm log.

Data Log Configures the data log.

Operation Log Configures the operation log.

Data Storage Area Changes the allocation of the data storage area.

Recipe Configures recipes.

Preventive Maintenance Configures the preventative maintenance function.

E-mail Configures the e-mail function.

File Transfer Settings Configures the file transfer function (FTP client function).

Sound*1 Configures the sound function.

Multimedia Function*1 Configures the multimedia function.

Global Script Configures one global script.

Command Description

User Accounts Configures security function, user accounts, and passwords.

Command Description

Web Page Editor Shows the Web Page Editor. Creates a Custom Web Page.

Command Description

Picture Manager Shows the Picture Manager. Manages the registered images for project use.

Text Manager
Shows the Text Manager. Manages registered text which can be used for Text, Part objects, 
title of Popup Screen, messages with Alarm List Display and Alarm Log Display.

Script Manager Shows the Script Manager. Manages registered scripts for project use.

Protocol Manager Shows the Protocol Manager. Manages protocols created.

E-mail Address Book Shows the E-mail Address Book. Manages e-mail addresses.

FTP Server Manager Shows the FTP Server Manager. Manages FTP serveres.
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● Online
Online is where you download created project data and files to the MICRO/I, where you upload data from the 
MICRO/I, and where you perform monitoring.

■ Transfer

■ MICRO/I

■ Monitors

Command Description

Download

Project Data Downloads project data to the MICRO/I.

Files to External Memory 
Device

Stops the MICRO/I and then downloads files to the external memory device inserted 
in the MICRO/I. The MICRO/I resumes running when files have finished downloading.

Files to External Memory 
Device while running

Downloads files to the external memory device inserted in the MICRO/I without 
stopping it.

Upload

Project Data Uploads project data from the MICRO/I.

Stored Data in External 
Memory Device

Uploads data from the External Memory Device folder for the currently running 
project.

Command Description

Target Info. Displays version information for the MICRO/I system software and project information.

Clear

All Clears all of the data stored in the internal memory on the MICRO/I.

Alarm Log Data Clears all of the alarm log data stored in the internal memory on the MICRO/I.

Data Log Data Clears all of the data log data stored in the internal memory on the MICRO/I.

Operation Log Data Clears all of the operation log data stored in the internal memory on the MICRO/I.

Values from All Device 
Addresses

Clears the values from all device addresses.

Stored Data in External 
Memory Device

Clears data saved to the external memory device inserted in the MICRO/I.

Format Formats the external memory device inserted in the MICRO/I.

Command Description

Start/Stop Monitor
Starts or stops monitoring the MICRO/I with WindO/I-NV4. An external device is required when 
configuring it.

Go Offline/Online
Switch the MICRO/I to Offline Mode or Online Mode. Under Offline Mode, you can change values 
of device addresses with WindO/I-NV4 and check the operation of project data on the MICRO/I.

Screens Shows or hides the Screen Monitor window.

Object List
Displays a value of device address in a popup and emphasizes the object that is satisfying the 
trigger condition in the object list or script editor.

Custom Shows or hides the Custom Monitor window.

Batch Shows or hides the Batch Monitor window.

External Devices Shows or hides the External Device Monitor window during 1:N communication.

Back Returns to the Base Screen that was displayed immediately before the screen was changed.

Forward
Advances to the Base Screen that was displayed immediately before the screen was changed 
with the Back command.

Go to 
Screen

First Screen Switches to the Base Screen with the smallest screen number in the project data.

Previous 
Screen

Switches to the Base Screen with a screen number one smaller than the Base Screen currently 
displayed. If the screen numbers are not consecutive numbers, this command switches to the 
closest number.

Screen Number Switches to the Base Screen with a specified number.

Next Screen
Switches to the Base Screen with a screen number one larger than the Base Screen currently 
displayed. If the screen numbers are not consecutive numbers, this command switches to the 
closest number.

Last Screen Switches to the Base Screen with the largest screen number in the project data.

Open Current Screens Opens a monitored screen in the editing window.
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■ Communication

● View
View is where you can switch the workspace display and display the Tag Editor, Screen Diagram, and various 
managers.
You can configure the items displayed in the editing window.

■ Workspace

■ Show/Hide

Command Description

Setup
Configures the communication target and communication conditions between the 
target and the MICRO/I or between the computer and the MICRO/I.

Command Description

Project Window
Shows the Project window. This window displays the saved screens and project 
related information.

Screen List
Shows the Screen List window. The window displays the screens saved in the 
project as thumbnails.

Object List
Shows the Object List window. This window displays all of the graphics and parts 
placed in an editing screen.

Part List Shows the Part List window. This window displays the list of part images.

Tag Editor
Shows the Tag Editor. This window displays the list of registered device address, tag 
name, and comments.

Comparison Result
Shows the Comparison Result window. This window displays the results of that 
comparison of projects.

Screen Diagram

Shows the Screen Diagram. This window displays the Overlapping Screen 
information, and the screen numbers and titles of the screens linked by the Goto 
Screen Button, the Goto Screen Command, the Numerical Input, the Character 
Input, the Alarm List Display and the Alarm Log Display.

Toolbox Shows the Toolbox window. This window displays Parts and Drawings.

Information
Shows the Information window. This window displays various information such as 
error message.

Command Description

Part Name Shows or hides drawing object names and part names.

Device Address Shows or hides device addresses and tag names.

Trigger Condition Shows or hides trigger conditions.

Commands Shows or hides the dotted frame for commands.

Popup Screen
Shows or hides a Popup Screen’s number, display frame, and the part name of the 
part calling that Popup Screen.

Overlay Screens Shows or hides the configured overlay screens.

Top Layer Shows or hides drawing objects and parts placed on the top layer.

Security Group
Display Shows or hides the display security group set for parts.

Input Shows or hides the input security group set for parts.

Gridlines Shows or hides the gridlines in the editing window.
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■ Screens

■ Zoom

■ Window

● Format
Format is where you change the style of drawing objects, arrange objects, and change their size.

■ Shape Style

■ Text Style

Command Description

Focus Order Changes the order to move the focus with Numerical Input and Character Input.

State

Reset Returns the displayed images to the default images.

ON/OFF State Switches between the ON image and the OFF image for buttons and lamps.

Previous State Changes the image for the displayed part to the previous state.

State Number
Changes the image for the displayed part to the image for the part with the 
specified number.

Next State Changes the image for the displayed part to the next state.

Text Group Changes the displayed text to the text of the specified text group.

Active User Displays only the parts that correspond to the specified user.

Command Description

Zoom Changes the magnification of the editing window.

Command Description

Close All Closes all editing windows.

Command Description

1 dot Sets the line width to one dot.

2 dots Sets the line width to two dots.

3 dots Sets the line width to three dots.

5 dots Sets the line width to five dots.

Solid Sets the line to solid.

Dot Sets the line to dotted.

Dash Sets the line to dashes.

Long Dash Sets the line to long dashes.

Long Dash Dot Sets the line to long dash dot.

Long Dash Dot Dot Sets the line to long dash dot dot.

Pattern Changes the pattern.

Foreground Color Changes the pattern’s foreground color.

Background Color Changes the pattern’s background color.

Command Description

Regular Sets the text style to regular.

Bold Sets the text style to bold.

Shadow Gives the text a shadow.

Text Color Changes the text color.

Text Background Color Displays the text as if it were highlighted with a highlighter.

Shadow Color Changes the color of the shadow added to text given a shadow.
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■ Arrange

■ Size

Command Description

X-coordinate Changes the X-coordinate of the selected object.

Y-coordinate Changes the Y-coordinate of the selected object.

Bring to Front Moves selected object to the front.

Send to Back Moves selected object to the back.

Group Groups selected objects so they can be handled as a single object.

Ungroup Restores a grouped object to its individual objects.

Rotate Right 90° Rotates selected objects right 90°.

Rotate Left 90° Rotates selected objects left 90°.

Flip Vertical Vertically flips selected objects.

Flip Horizontal Horizontally flips selected objects.

Align Left Aligns selected objects to the left.

Align Center Aligns selected objects to the center.

Align Right Aligns selected objects to the right.

Align Top Aligns selected objects to the top.

Align Middle Aligns selected objects to the middle.

Align Bottom Aligns selected objects to the bottom.

Make Horizontal Spacing 
Equal

Arranges selected objects to be equally spaced horizontally.

Make Vertical Spacing 
Equal

Arranges selected objects to be equally spaced vertically.

Command Description

Width Changes the width of the selected object.

Height Changes the height of the selected object.

Make Same Width Makes the selected objects a uniform width.

Make Same Height Makes the selected objects a uniform height.
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3.4 Windows Displayed in the Workspace

● Changing the position of windows

Disabling docking

You can change the display position of the window by dragging and dropping the title bar of the window or its tab to 
disable docking. Windows that are not docked are called floating windows.
• If you drag the title bar of the workspace window, you can move all the docked windows together.

• If you drag the tab of a workspace window, you can move just the selected window.

Docking windows

You can dock a floating window to WindO/I-NV4’s left, right, top, or bottom frame or a separate window.

1 Drag the window’s title bar or tab.

The  (Docking) icon is displayed.

Title bar

Drag and drop

Tab

Drag and drop
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2 Drop the title bar or tab on the  (Docking) icon to dock that window to WindO/I-NV4’s left, right, top, or bottom 
frame or a separate window.

• If the workspace window is dropped on the  icon, it is docked to WindO/I-NV4’s left, right, top, or bottom 

frame.

• If a floating window is dropped on the  (Docking) icon, it is docked to WindO/I-NV4’s left, right, top, or bottom 

frame or a docked window.

When the mouse cursor gets close to a  (Docking) icon while dragging the title bar or tab, the location 
to dock the window is displayed.

Window docking 
location
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• If you put the mouse cursor on another window while dragging a floating windows title bar, the  (Docking) icon 

is displayed. Drop the title bar on the  (Docking) icon to dock the floating window to that window. Change the 
displayed window with the tabs.

● Changing the display method of windows

Auto Hide

If the workspace window is docked, you can change the widow to automatically hide and show only its tabs.

Click the  (Auto Hide) icon to change the window to show only its tabs.

The window is displayed when you bring the mouse cursor close to the tabs.

Auto Hide icon Tabs

Mouse cursor

• Click  (Auto Hide) to secure the window in place.

• Click  (Close) to close the window.
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3.5 Status Bar

● Status bar items

■ Mode
This section of the status bar shows WindO/I-NV4’s current mode.

■ Type Number
This section of the status bar shows the MICRO/I type set in the project data being edited.

■ Communication Driver
This section of the status bar shows the communication driver set in the project data being edited.

■ Data Size
This section of the status bar shows the download data file size for the project data being edited.
When you save the project, the display is updated with the latest information.

■ Position
This section of the status bar shows the X- and Y-coordinates of the mouse cursor in the editing window.

■ Text Group
This section of the status bar shows the current text group. The text displayed in the editing window changes 
according to the displayed text group.

To change the text group, click ▼ and select the text group.

■ Active User
This section of the status bar shows the active user. You can hide or show objects in the editing window according to 
the security group of the displayed user.

To change the active user, click ▼ and select the user.

Mode

Type Number Communication Driver

Data Size

Position

Text Group

Active User

Snap to Grid

Grid Settings

Preview

Zoom

Zoom Slider

Zoom Out button
Zoom In button
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■ Snap to Grid

Click  to align objects to the grid.

■ Grid Settings
You can change the style and spacing of the grid displayed in the editing window.

Click  to display the Grid Settings dialog box. Configure the items and click the OK button.

Type: Selects the type of grid.
Touch Panel: Aligns the grid to the touch panels.
Other: Aligns the grid to the specified spacing.

Enter the spacing for the grid in Horizontal and Vertical.
Style: Select the grid style with Dot or Line.
Color: Select the grid color (color: 256 colors, monochrome: 16 shades).

Click this button to open the color palette. Select the color with the color palette.
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■ Preview
You can preview an edited screen.

Click  to open the preview window.

Click the  button to switch between the OFF image and ON image for buttons and lamps.

You can save the image displayed in the preview window as a bitmap image file by clicking the Copy button.

■ Zoom
Zoom shows the magnification of the editing window.
You can zoom in and zoom out by specifying the magnification.

1 Click Zoom on the status bar.
The Zoom dialog box is displayed.

2 Specifying the zoom magnification (50% to 400%) and click OK.

● Customizing the status bar
You can change the commands displayed on the status bar.
Right click the status bar and check only the commands you wish to display on the status bar.

The preview display and the actual screen displayed on the MICRO/I may differ.
For example, the image for overlay screens in the preview display is always shown in front. However, when 
drawing objects and parts overlap on the actual screen, parts are always shown in front irregardless of the 
order of overlay screens.

You can also specify the zoom magnification by dragging the zoom slider or clicking the  button and 

the  button.
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4.1 Configuring the Work Environment

You can configure WindO/I-NV4 settings such as mode and options when editing screens, the path when selecting 
files, and the path for automatic backups. The settings configured here are saved even when you exit WindO/I-NV4.
The procedure for configuring the work environment is shown below.

1 Click  and then click WindO/I-NV4 Options.

The WindO/I-NV4 Options dialog box is displayed.

2 Change the settings on each tab as desired.

4 Customizing WindO/I-NV4
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● General tab

■ Properties
Select whether or not to display the Properties dialog box for parts in the Advanced mode.

■ Editing

■ Bit Number Symbol
Select the separator for address numbers and bit numbers. When manually entering device address, you can enter 
either separator, but they will be displayed using the symbol selected here.

Basic: Displays the Properties dialog box in Basic mode to use only basic functions.

Advanced: Displays the Properties dialog box in Advanced mode so that all functions can be used.

You can also change the mode by clicking on the Advanced button and the Basic button in the Properties 
dialog box for parts.

Enable Increment Address Number: When copying or duplicating parts, select this 
check box to add a specified value (-999 to 999) 
to address number of the device address set for 
the original part before pasting it to the screen.

Enable Text Auto Resizing: Select this box to automatically change the text 
size according to a change in part size.

Enable Input Method Editor (IME) when entering Device Address: Select this box to enter characters other than 
alphanumeric characters using the input method 
editor (IME) in text boxes for entering device 
addresses.

You cannot enter full-width characters in text boxes that only accept alphanumeric input, even if the IME is 
enabled.
Select this box to use full-width characters in tag names in the device address settings.

Dot (WindLDR Format): Separates the address number and bit number with a dot.
Example: D100.00

Dash (WindO/I-NV4 Format): Separates the address number and bit number with a dash.
Example: D100-0
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■ Workspace

■ Compatibility

■ Error Check

● Save tab

■ Save Project

Workspace Setup: Displays the Workspace Setup dialog box. You can configure items displayed in 
the workspace window. For details, refer to “4.2 Customizing the Workspace” 
on page 2-66

Use Compatible functions from previous version: Select this box to enable functions from previous versions. For 
details, refer to Chapter 4 “3.17 Compatible Tab” on page 4-76.

Use HG1B Compatible functions: Select this box to enable previous functions (HG1B). For details, 
refer to Chapter 4 “3.17 Compatible Tab” on page 4-76.

Verify that a string is invalid E-mail format: When setting the E-mail address, place a check mark in the check 
box to check the string format used for the E-mail address. The 
check target is as follows: 
• Sender E-mail Address in the E-mail tab on the Project 

Settings dialog box
• E-mail Address on the E-mail Address dialog box
• Import was executed on the E-mail Address Book dialog box.

Default file location: Specify the default save location of the project data.
Click Browse to display the Browse For Folder dialog box. 



WindO/I-NV4 User’s Manual 2-63

4 Customizing WindO/I-NV4

2

W
indO

/I-N
V4 Features &

 Basic O
perations

■ AutoSave

Save the following information every: Specify the interval (5 to 60 minutes) for creating an AutoRecover file or Backup 
from a project being edited.
This option can only be set when AutoRecover file or Backup is selected.

AutoRecover file: A project being edited is automatically saved as often as you 
want. The saved AutoRecover file is used to recover the project 
if a power failure or otherwise occurs that forces WindO/I-NV4 
to quit. The AutoRecover file is automatically deleted when the 
project is manually saved or WindO/I-NV4 exits. When the 
AutoRecover file exists, the Project Recovery dialog box is 
displayed when WindO/I-NV4 starts. For details, refer to 
“Project Recovery Dialog Box” on page 2-40.

Backup: A backup copy of a project being edited is created as often as 
you want. The file name of the backup is as follows:
Project Name_Backup Date.pn4
Backup date format: YYYYMMDDhhmmss
(YYYY: year, MM: month, DD: day, hh: hour, mm: minute, ss: 
second)
Example: Project Name is "TEST01" at 4:56:07 on January 

23, 2016
TEST01_20160123045607.pn4

If the project file has not been changed, a backup will not be 
created when the interval specified in Backup elapses.

Backup file location:
Specify the save location of the backup file.
Click Browse to display the Browse For Folder dialog 
box.
This option can only be set when Backup is selected.

Display Warning Message when the number of files exceeds:
Select the maximum number of backup files from the 
following.
100, 500, 1000
When the specified number of files has been exceeded, a 
warning message is displayed when WindO/I-NV4 starts.
This option can only be set when Backup is selected.
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● Customize tab

■ Choose commands from
Select the category of command to add. A list of commands for selected category is displayed.

■ Show Quick Access Toolbar below the Ribbon
To change the position of the quick access toolbar to be located below the ribbon, select this check box.

■ Add>>
Add a command to the Customizing the quick access toolbar list.

■ Remove
Delete a command from the Customizing the quick access toolbar list.

■ Customize Quick Access Toolbar
Shows the list of commands displayed on the quick access toolbar.

■ Reset
Returns the settings of the quick access toolbar to their default.

To change the order of the commands, drag and drop a command.

For details about the quick access toolbar, refer to “3.2 Quick Access Toolbar” on page 2-43.
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● Resources Tab

■ Get updates

■ Go to IDEC

■ About WindO/I-NV4

Check for Updates: This function will check for any updates.
If a new version of Automation Organizer is released, the Automation Organizer Updater 
dialog box is displayed.
For details, refer to “Automation Organizer Updater Dialog Box” on page 2-39.

Go online: Shows the IDEC web page for free updates, manuals, and online services.

About: Shows the About WindO/I-NV4 dialog box and displays the version of WindO/I-NV4.

In order to display the Automation Organizer Updater, your computer must be connected to the Internet.
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4.2 Customizing the Workspace

You can change the windows that are displayed in the workspace with the Workspace Setup dialog box.

● Screen List tab
This tab changes the Screen List window display.

■ Zoom
Select the zoom magnification for the thumbnails displayed in the Screen List window from the following.
100, 125, 150, 175, 200, 250, 300, 350, 400

● Object List tab
This tab changes the items displayed in the Object List window.

■ List Items
Shows the list of items that can be displayed in the Object List window.

■ Add
Adds an item to Display Items.
Select an item in List Items and click this button to add it to Display Items.

■ Delete
Deletes an item from Display Items.
Select an item in Display Items and click this button.

■ Display Items
Shows the list of items that are displayed in the Object List window.

■ Up
Shifts the selected item upward in the Display Items list.

■ Down
Shifts the selected item downward in the Display Items list.
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● Parts List tab
This tab changes the items displayed in the Part List window.

■ Show Image Name
Select this box to display the image name for parts in the Part List window.
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This section describes common settings when creating project data.

5.1 Device Address Settings

Device addresses are memory on the MICRO/I and external devices that can store values in bit or word units.
By setting device addresses to parts and functions, you can control the screen display and operation of parts.
Device addresses are specified by combining the device type and address number in the following formats.

The device address can be directly entered or it can be set with the Tag Editor.

● Direct entry
Enter a device address with the keyboard following the basic format.
To enter the bit (0 to 15) for a word device, enter the address number, the bit number separator “.” or “-”, and the bit. 
You can enter the address with either separator, but it is displayed according to the Bit Number Symbol setting. Bit 
Number Symbol is set on the General tab of the WindO/I-NV4 Options dialog box.

● Specifying a device address with the Tag Editor
To display the Tag Editor, click  to the right of the text box for setting the device address. Use this Tag Editor to set 
the device address. 
The Tag Editor for the Allen-Bradley and Emerson drivers is different from other drivers. For details, refer to the 
WindO/I-NV4 External Device Setup Manual.

■ Target
Select the device that includes the device address that will be set from MICRO/I or External Device (External 
Device ID): (External Device Name).
You can configure the External Device ID and the external device name in the Communications Driver Network 
tab on the Project Settings dialog box. For details, refer to Chapter 4 “3.4 Communication Driver Network Tab” on 
page 4-50.

■ Device Type
Select the device type.
The list only shows device types that can be used. 

■ Address Number
Specify the address number. The range that can be set differs according to the device type selected.

5 WindO/I-NV4 Common Operations and Settings

 Bit numberDevice type Address number .Dot (WindLDR Format):

 Bit numberDevice type Address number -Dash (WindO/I-NV4 Format):

Address number and bit number separator

(Toolbar)

(Address number list)
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■ Bit Number
Specifies the bit number in a word device (0 to 15). This option can only be configured when a word device is selected 
for Device Type.

■ Show
Select from the following and display the device addresses on the (Address list).

■ (Toolbar)

■ (Address number list)
Displays a list of device addresses that match the specified condition.

All: Displays all of the device addresses that can be used with the device selected in Target.

Used: Displays only the device addresses that are used in the active project data.

Unused: Displays only the device addresses that are not used in the active project data.

 (Cut): Cuts the selected tag name or comment from (Address number list) and copies it to the 
clipboard.

 (Copy): Copies the selected tag name or comment to the clipboard.

 (Paste): Pastes the contents of the clipboard.

 (Delete): Deletes the selected tag name or comment.

 (Import): Shows the Open dialog box.
Select a file with exported tag names and comments (CSV file), and then click Open to 
collectively overwrite (Address number list) with the tag names and comments in the 
selected file.

 (Export): Displays the Export dialog box.
Select the location to save the file, enter a file name, and then click Save to save the tag 
names and comments of (Address number list) as a CSV file.

 (Cross Reference): Shows the Cross Reference dialog box. For details, refer to “Cross Reference Dialog Box” on 
page 2-70.

 (Refresh): Updates the Use column on the Tag Editor.

 (Add New Tag): Adds the Allen-Bradley tag data. 
This is valid only if the Logix Native Tag(Ethernet) driver of Allen-Bradley is selected 
and the external device is selected from the Target. For details, refer to the WindO/I-NV4 
External Device Setup Manual.

 (Edit Tag): Edits the registered Allen-Bradley tag data. 
This is valid only if the Logix Native Tag(Ethernet) driver of Allen-Bradley is selected 
and the external device is selected from the Target. For details, refer to the WindO/I-NV4 
External Device Setup Manual.

Device Address: Displays the device addresses of the selected Device Type.

Tag Name: Displays the tag name of the address number.

Comment: Displays the comment of the address number.

Used: Displays how many times each address number has used.

The device addresses of the MICRO/I and external devices are collectively managed in Tag Editor. Tag Editor 
can be displayed with the following procedures.

• On the View tab, in the Workspace group, click  (Tag Editor).
• Double click Tag Editor in the Project window.
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Cross Reference Dialog Box

On the Tag Editor, select the device address, and then click  (Cross Reference) to show the screen type, screen 
number, and part number where that device address is used.

Enter the device address in Device Address and click  (Reflesh) to see the updated data.
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5.2 Setting Conditional Expressions

Specify conditional expressions with Condition on the Trigger Condition tab.
Conditional expressions are specified by combining data and operators using the following basic format.

Directly enter the conditional expression or specify it with the Trigger Conditions Settings dialog box.

● Direct entry
Enter the conditional expression with the keyboard.
• There is no limit on data or operators. However, the maximum number is 1500 characters.

• To enter a device address for data, always enclose it with “[” and “]”.
    Example: [LDR 100] == 10
• To flip bits, enter “~” before the data.
• Parentheses “(” and “)” can be used.

• Operator priority is the same as scripts. For details, refer to Chapter 20 “6.3 About the Priority of the Operator” on 
page 20-59.

● Configuring conditional expressions with the Trigger Condition Settings Dialog Box
You can easily configure a basic conditional expression using the Trigger Condition Settings dialog box.
• Up to a maximum of five items of data can be used.

• To flip the bits in data, select the Not check box.
• Operator priority is the same as scripts. For details, refer to Chapter 20 “6.3 About the Priority of the Operator” on 

page 20-59.

1 Click the Condition  button to display the Trigger Condition Settings dialog box.

2 Click Value or Device Address and enter a value or device address.

To flip the bits in data, select the Not check box.

3 Select the operator.

4 Click the next Value or Device Address and enter a value or device address.

To flip the bits in data, select the Not check box.

5 Repeat steps 3 and 4 for the necessary number of conditions.

OperatorData Data

... (within 480 characters)

OperatorData Data

OperatorData Data
to

Operator Data Operator Data Operator Data Operator Data

OperatorData Data Operator OperatorData Data )()(

OperatorData Data

OperatorData Data
to

Operator Data Operator Data Operator Data

If you display the Trigger Condition Settings dialog box after directly entering a conditional expression, that 
expression will be reflected in the dialog box. However, if you entered an expression that cannot be 
reflected, the portion of the expression that could not be reflected is deleted when you click the OK button 
and close the Trigger Condition Settings dialog box.
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● Data and operations that can be configured
Data
You can specify these types and values of data for conditional expressions.

Operators
Specify the type of arithmetic operation to execute on the data. (In the table below,  indicates the operator’s left-
hand number,  indicates the right-hand number.)

*1 1 if satisfied, 0 if not satisfied.

Item Description

Value
Set a constant number as data.
The range that can be set differs according to the selected data type.
For details, refer to “Data types” on page 2-1.

Device Address Set a device address for a bit device or a word device that stores the value to be handled as data.

Operator Details

Supported 
device

Bit 
device

Word 
device

Arithmetic 
operators

+ Addition Adds  and . NO YES

- Subtraction Subtracts  from . NO YES

* Multiplication Multiplies  and . NO YES

/ Division Divides  by . NO YES

% Modulo Calculates the remainder after dividing  by . NO YES

Relational 
operators*1

== Equal to Compares if  is equal to . YES YES

!= Not equal to Compares if  is not equal to . YES YES

>= Greater than 
or equal to Compares if  is equal or greater than . NO YES

<= Less than or 
equal to Compares if  is equal or less than . NO YES

> Greater than Compares if  is greater than . NO YES

< Less than Compares if  is less than . NO YES

Bitwise 
operators

& Bitwise AND Calculates the logical product (AND) of each bit in  and . YES YES

| Bitwise OR Calculates the logical sum (OR) of each bit in  and . YES YES

^ Bitwise XOR 
(exclusive OR)

Calculates the exclusive logical sum (XOR) of each bit of  and 
.

YES YES

~ Bitwise NOT
Flips the logic of each bits of .
For word device and fixed values, 0 will be 65535 and 65535 will be 0.
For bit device, 0 will be 1, and 1 will be 0.

YES YES

<< Left shift Shifts each bit of  to left for  bit(s). YES YES

>> Right shift Shifts each bit of  to right for  bit(s). YES YES

Logical 
operators*1

&& Logical AND Calculates the logical product (AND) of a conditional expression 
and a conditional expression. YES YES

|| Logical OR Calculates the logical sum (OR) of a conditional expression and a 
conditional expression. YES YES

• You cannot select logical operators in the Trigger Condition Settings dialog box.
• You cannot mix bit devices and word devices in a conditional expression when using other than logical 

operators.

As a basic rule, conditional expressions are calculated in order from the left, but when multiple arithmetic 
operations are combined, they are calculated according to the operator priority.
For [D 10] == [D 11] + [D 12] * 2 + [D 13], the expression is calculated in the following order.

For the operator priority, refer to Chapter 20 “6.3 About the Priority of the Operator” on page 20-59.

D10 == D11 + D12 2 +* D13

1

2

3

4
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● Setting and operation examples

Settings

Action
Direct entry

Trigger Condition Settings 
dialog box

[M 0] == [M 1]
The condition is satisfied if the values of 
M0 and M1 are equal.

[M 0] == [M 1] & [M 2]
The condition is satisfied if the result of 
the AND operation on M1 and M2 is 
equal to M0.

[M 0] == ~[M 1]
The condition is satisfied if the result of 
flipping the bits in M1 is equal to M0.

1234 == [D 0]
The condition is satisfied if the value of 
D0 equals 1234.

100 <= [D 0] + [D 1] + [D 2] + [D 3]
The condition is satisfied if the result of 
adding the values of D0 through D3 is 
100 or greater.

0 != [D 0] % 10

The condition is satisfied if the value of 
the remainder after D0 is divided by 10 
does not equal 0 (the value of D10 
cannot be entirely divided by 10).

[D 0] == ~[D 1] & ~[D 2] & [D 3] &[D 4]

The condition is satisfied if the logical 
AND operation on the flipped bits of D1, 
the flipped bits of D2, the value of D3, 
and the value of D4 is equal to D0.

[D 10] + [D 11] == [D 12] + [D 13]

The condition is satisfied if the result of 
adding the values of D12 and D13 is 
equal to the result of adding the values 
D10 and D11.

[D 10] == [D 11] + [D 12] * 2 + [D 13]

The condition is satisfied if the result of 
adding the values of D11, D12 
multiplied by two, and D13 is equal to 
the value of D10.

100 <= [D 0] + [D 1] + [D 2] + [D 3] + 
[D 4] + [D 5] + [D 6] + [D 7]

(This expression cannot be 
configured in the Trigger 
Condition Settings dialog box 
because it has over 6 items of 
data.)

The condition is satisfied if the result of 
adding the values of D0 through D7 is 
100 or greater.

1 == ([M 0] && [M 1]) || ([M 2] && [M 3])

(This expression cannot be 
configured on the Trigger 
Condition Settings dialog box 
because it uses logical operators 
and it contains parentheses
 “(” and “)”.)

The condition is satisfied if the logical OR 
operation on the result of the logical AND 
operation on M0 and M1 and the result 
of the logical AND operation on M2 and 
M3 is equal to 1.

[LDR 10] + [LDR 11] == [LDR 12] *
([LDR 13] + [LDR 14])

(This expression cannot be 
configured on the Trigger 
Condition Settings dialog box 
because it mixes bitwise 
operators and logical operators 
or it contains parentheses 
“(” and “)”.)

The condition is satisfied if the result of 
multiplying the value of LDR12 by the 
result of adding the values of LDR13 
and LDR14 is equal to the result of 
adding the values of LDR10 and LDR11.

Data
M0

Op.
==

Data
M1

Data
M0

Op.
==

Data
M1

Op.
&

Data
M2

Data
M0

Op.
&

Data
M1
Not

Data
1234

Op.
==

Data
D0

Data
100

Op.
<=

Data
D0

Op.
+

Data
D1

Op.
+

Data
D2

Op.
+

Data
D3

Data
0

Op.
!=

Data
D0

Op.
%

Data
10

Data
D0

Op.
==

Data
D1
Not

Op.
&

Data
D2
Not

Op.
&

Data
D3

Op.
&

Data
D4

Data
D10

Op.
+

Data
D11

Op.
==

Data
D12

Op.
+

Data
D13

Data
D10

Op.
==

Data
D11

Op.
+

Data
D12

Op.
*

Data
2

Op.
+

Data
D13



5 WindO/I-NV4 Common Operations and Settings

2-74 WindO/I-NV4 User’s Manual



WindO/I-NV4 User’s Manual 3-1

3

Com
m

unication
1

This chapter describes the communication between the MICRO/I and the external device.

  

1.1 Overview

Device Link Communication refers to the communication protocol used for communication with the MICRO/I, via the 

CPU Unit*1 or PLC Link Unit*1 Programming Port of the external device connected to the MICRO/I.
The MICRO/I continuously reads the values of the external device addresses on the currently displayed screen, and 
external devices (such as relays and registers) on the screens are updated with the latest data at all times.
When a button is pressed or a command is executed in the MICRO/I screen, the value is written to the external device 
address.

*1 Unit names vary based on the manufacturer of the external device. 

Chapter 3 Communication

1 Device Link Communication

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

MICRO/I

1234

External device

Device Link Communicationn

0 1

Read

Write

D0:

M0:

1234
Numerical Display
Reference Device Address: D0

Bit Button
Destination Device Address: M0

For details regarding the Device Link Communication, refer to Chapter 1 "Device Link Communication" and 
Chapter 2 "Connection to External Devices" in the WindO/I-NV4 External Device Setup Manual.
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● Connection Types
There are two basic types of connections. 1:1 Communication, where an external device is connected to a 
MICRO/I; and 1:N Communication, where multiple external devices are connected to a MICRO/I. 

■ 1:1 Communication
The MICRO/I is connected to a single external device.

■ 1:N Communication
The MICRO/I is connected to multiple external devices.

1.2 Device Link Communication Settings

The external devices connected to the MICRO/I are selected on the Select Communication Driver dialog box, or the 
Communication Driver tab on the Project Settings dialog box.
• When creating new project data by following displayed dialog boxes and configuring settings step by step, by 

clicking , and then clicking New, the Select Communication Driver dialog box is displayed. For details, refer 
to Chapter 4 “Create new project data by using the interactive quick start” on page 4-1.

• Click Communication Driver on the status bar to display the Communication Driver tab on the Project 
Settings dialog box tab on the Project Settings dialog box. For details, refer to Chapter 4 “Changing Communication 
Drivers” on page 4-21.

Specify Manufacturer and Communication Driver for each CPU Unit*1 or each PLC Link Unit*1 of the external 
device. For details regarding the correspondence model, refer to the WindO/I-NV4 External Device Setup Manual.

*1 Unit names vary based on the manufacturer of the external device.

MICRO/I External device

Read

Write

Device Link Communication

MICRO/I

Station No.1

Station No.2

Station No.3

External device
Read

Write

Read

Write

Read

Write

Device Link Communication
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2.1 Overview

O/I Link Communication is a protocol for communication between Master and Slave, where a MICRO/I connected to 
the external device is configured as a Master and multiple MICRO/I (Slaves) communicate with the external device via 
the Master.
The Master MICRO/I unit communicates with the external device by means of Device Link Communication. The 
Master MICRO/I is called an O/I Link Master and a slave MICRO/I connected to the O/I Link Master is called an O/I 
Link Slave. A maximum of 15 O/I Link Slaves can be connected to an O/I Link Master.

2.2 O/I Link Communication Settings

These settings are configured under the O/I Link tab on the Project Settings dialog box. The Project Settings dialog 
box can also be accessed using the following methods.
• Click Project on the Configuration tab.
• Double click Project Settings in the Project window.
The O/I Link Communication Settings can only be configured when O/I Link Master or O/I Link Slave is selected 
in Function under Interface Settings on the Communication Interface tab. For details, refer to Chapter 4 “3.5 
O/I Link Tab” on page 4-53.

2 O/I Link Communication

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

Read Write

5678

MICRO/I
O/I Link Slave

(Slave 1)

MICRO/I
O/I Link Slave

(Slave 2)

MICRO/I
O/I Link Slave

(Slave 15)

MICRO/I
O/I Link Master

External device

0 1

Read

Write

D1: 

M1:

5678

O/I Link Communication

Device Link Communication

Numerical Display
Reference Device Address: D1

Bit Button
Destination Device Address: M1

Read Write Read Write

O/I Link Communication can only be used for the External Device Communication 1. The 
communication driver of O/I Link Slave should match the O/I Link Master's. 
For details regarding the O/I Link Communication, refer to Chapter 3 "O/I Link Communication" in the 
WindO/I-NV4 External Device Setup Manual.

• Use the runtime system version 4.01 or later when connecting the HG5G/4G/3G/2G-V, HG4G/3G, HG2G-
5F/-5S/-S, HG1G/1P via O/I Link Communication. 

• The HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F/-5T, HG1G/1P and the HG4F/3F/2F/2S/1F use a different 
protocol for the O/I Link Communication. To communicate them via the O/I Link Communication, select 
the Use the same O/I Link Communication as the HG4F/3F/2F/2S/1F check box on the 
Compatible tab of the Project Settings dialog box.



3 DM Link Communication

3-4 WindO/I-NV4 User’s Manual

  

3.1 Overview

DM Link Communication reads and writes value to external devices using the MICRO/I's dedicated DM Link memory. 
The device type of dedicated DM Link memory is DM.
This method uses a dedicated IDEC protocol, so a communication program is required in the external device.

● Communication Methods
Over the serial interface, when one external device is communicating with one MICRO/I using this communication 
method it is called DM Link 1:1 communication, and when one external device is communicating with multiple MICRO/I 
units, it is called DM Link 1:N communication. When external devices and the MICRO/I are communicating using DM 

Link communication over the Ethernet interface (UDP protocol), it is called DM Link Ethernet (UDP) communication*1.

■ DM Link 1:1 Communication

The external device is connected to a single MICRO/I by using a serial interface.

The Event Transmission function from the MICRO/I can be used with DM Link 1:1 Communication.
The Event Transmission function is a function that works as follows. When value in the dedicated DM Link memory of 
the MICRO/I is changed, the data is transmitted from the MICRO/I to the external device.

*1 HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F only

3 DM Link Communication

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

MICRO/I

999

5678

External device

DM Link Communication

Read

Write

DM0: 999

DM1: 1234 5678

DM0

DM1

DM2

DM8190

DM8191

Dedicated DM Link memory

Numerical Display
Destination Device Address: DM0

Numerical Display
Reference Device Address: DM1

For details regarding the DM Link Communication, refer to Chapter 4 "DM Link Communication" in the 
WindO/I-NV4 External Device Setup Manual.

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

MICRO/I

Dedicated DM 
Link memory

External device DM Link 1:1 Communication

Read

Write

MICRO/I

Event transmission
Dedicated DM 
Link memory

External device

DM0: 0

DM1: 0

DM2: 0

100

150

200

DM0: 100

DM1: 150

DM2: 200

DM Link 1:1 Communication
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■ DM Link 1:N Communication

The external device is connected to multiple MICRO/I by using a serial interface.

■ DM Link Ethernet (UDP) Communication

The external device is connected to multiple MICRO/I by using the Ethernet interface (UDP protocol).

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

Station No.1

Station No.2

Station No.3

MICRO/I

Dedicated DM 
Link memory

Dedicated DM 
Link memory

Dedicated DM 
Link memory

External device
Read

Write

Read

Write

Read

Write

DM Link 1:N Communication

The Event Transmission function cannot be used with DM Link 1:N Communication.

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

Write

Read

DM Link Ethernet (UDP) Communication

External Devices
(Computer, PLC or board computer)

HUB

MICRO/I

Delicated DM
Link memory

• The Event Transmission function cannot be used with DM Link Ethernet (UDP) communication.
• In DM Link Ethernet (UDP) Communication, when a Response is returned from the MICRO/I to a 

command source, the Response can also be returned to specified addresses (IP Address, Port Number) at 
the same time. For details, refer to Chapter 4 “DM Link Communication” in the WindO/I-NV4 External 
Device Setup Manual.
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3.2 DM Link Communication Settings

DM Link Communication settings are selected on the Select Communication Driver dialog box, or the 
Communication Driver tab on the Project Settings dialog box.
• When creating new project data by following displayed dialog boxes and configuring settings step by step, by 

clicking , and then clicking New, the Select Communication Driver dialog box is displayed. For details, refer 
to Chapter 4 “Create new project data by using the interactive quick start” on page 4-1.

• Click Communication Driver on the status bar to display the Communication Driver tab on the Project 
Settings dialog box. For details, refer to Chapter 4 “Changing Communication Drivers” on page 4-21.

Select IDEC System in Manufacturer, and then select DM Link (1:1), DM Link (1:N) or DM Link Ethernet 
(UDP)*1 in Communication Driver.

*1 HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F only
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4.1 Overview

In this case, there is no communication with an external device, so the MICRO/I operates as a standalone unit.
It is only possible to operate the MICRO/I with relays and registers.

4.2 No External Devices Settings

No external devices settings are selected on the Select Communication Driver dialog box, or the Communication 
Driver tab on the Project Settings dialog box.
• When creating new project data by following displayed dialog boxes and configuring settings step by step, by 

clicking , and then clicking New, the Select Communication Driver dialog box is displayed. For details, refer 
to Chapter 4 “Create new project data by using the interactive quick start” on page 4-1.

• Click Communication Driver on the status bar to display the Communication Driver tab on the Project 
Settings dialog box. For details, refer to Chapter 4 “Changing Communication Drivers” on page 4-21.

Select No External Devices in Manufacturer.

4 No External Devices

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

MICRO/I

Internal device No external device
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5.1 Overview

User Communication allows you to develop a communication protocol to transmit and receive data from an external 
device, such as a barcode reader. 

User Communication is supported up to three interfaces of the MICRO/I, either serial, Ethernet, or USB interfaces.

5 User Communication

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

External device

MICRO/I

Data receptionData transmission

User communication

External device

Device Link Communicaton

When the serial interface connecting external devices is RS485, a maximum of 31 external devices can be 
connected. However, carefully check the specifications including the command settings and error 
processing and verify whether or not multiple external devices is possible and if so how many number of 
external devices may be supported.

• Flow Control setting is None.
• The maximum size of sent data and the maximum size of received data is 1,500 bytes.
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5.2 User Communication Settings Procedure

This section describes the procedure for setting user communication.

● Create a new user communication protocol, and then configure it to a communication interface

Using Transmission Command and Receive Command

1 On the Configuration tab, in the System Setup group, click Project.

The Project Settings dialog box is displayed.

2 Click the Communication Interface tab on the Project Settings dialog box.

3 Select the interface for user communication under Interface Configuration, and then select the user 
communication in Function under Interface Settings.

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

To use the commands for inching function with HG1P, refer to “Using Inching Function” on page 3-21.
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4 Specify the items for Interface Settings.
The settings vary based on the interface.

■ Serial Interface
• HG5G/4G/3G/2G-V, HG4G/3G, HG2G-F

 For details, refer to Chapter 4 “When COM1, COM2, COM2(RS232C), or COM2(RS422/485) is selected under 
Interface Configuration” on page 4-38.

• HG2G-5T, HG1G/1P*1

 For details, refer to Chapter 4 “When SERIAL1(RS232C), SERIAL1(RS422/485), COM(RS232C), or 
COM(RS422/485) is selected under Interface Configuration” on page 4-39.

■ Ethernet Interface
 For details, refer to Chapter 4 “When Protocol1 to Protocol7 is selected for Ethernet under Interface 

Configuration” on page 4-42.

■ USB Interface
 For details, refer to Chapter 4 “When USB2(USB-A) is selected under Interface Configuration” on page 4-44.

5 Click the User Communication tab.

*1 This is applicable for models with a serial interface (RS422/485) only.
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6 Enter the name of the user communication protocol that will be set in Protocol Name.

The maximum number for protocol name is 40 characters.

7 Set the time out (0 to 255) in Receiving Character Time Out (x100 msec).

For details on the Receiving Character Time Out (x100 msec), refer to “Receiving Character Time Out (x100 
msec)” on page 3-32.

You cannot use the following characters in the protocol name.
   \ / : , ; * ? " < > |
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8 Set Transmission (TXD) command.
Click Add under Command List.

The Command Settings dialog box is displayed.

9 Select TXD in Type.

Specify the transmitted data to the external device connected to the MICRO/I and the conditions for transmitting 
data.
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10 Select the condition to transmit data in Trigger Type under Trigger Condition from the following.

■ Rising-edge
Data is transmitted when the value of device address changes from 0 to 1.
Specify the bit device or the bit number of the word device as the condition.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.

■ Falling-edge
Data is transmitted when the value of device address changes from 1 to 0.
Specify the bit device or the bit number of the word device as the condition.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.

■ Satisfy the condition
Data is transmitted when condition changes from not satisfied to satisfied.
Specify the conditional expression in Condition and select the data type handled by the conditional expression in 
Data Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expressions configuration 
procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-71.
For details on data types, refer to Chapter 2 “1.1 Available Data” on page 2-1.

■ Fixed Period
Data is transmitted at a fixed time interval.
Set the time interval between data transmissions as 1 to 3600 (seconds) in Period (sec).

11 Specify the bit device or the bit number of the word device for reporting that data transmission was successfully 
completed in Completed Device Address under Detail.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.

12 Specify the destination word device for the transmitted data size and error information in Status Device Address 
under Detail.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.

13 Specify the wait time (0 to 255) from when the trigger condition is satisfied to when the data is transmitted in 
Transmission Wait (x100 msec) under Detail.

14 Enter a comment for transmission command in Comment under Detail.

The maximum number is 40 characters.
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15 Set data for transmission command.
Click Add under Data List.

The Data Settings dialog box is displayed.

16 Select data type in Type.

Data setting items are displayed.
For details on transmission command, refer to “Transmission (TXD) Command” on page 3-49.

17 Set the data, and then click OK.

The data configured in Data List on the Command Settings dialog box is displayed.
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18 Repeat steps 15 through 17 to set all the data for the transmission command.

19 Click OK.

The transmission command configured in Command List and Data List on Project Settings dialog box is displayed.

• The data is displayed in Data List in the order they were set. To change the order of data, select data, 
and then click Up or Down to shift it.

• Click Expand Data List to hide Type, Trigger Condition and Detail, the number of the data displayed 
in Data List will increase.
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20 Specify Receive (RXD) command.
Click Add under Command List.

The Command Settings dialog box is displayed.

21 Select RXD in Type.

Define the data configuration for received data from the external device.
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22 Select the condition for being ready to receive data in Trigger Type under Trigger Condition from the following.

■ Always Enabled
The device is always ready to receive data. 

■ While ON
Ready to receive data when the value of device address is 1.
Specify the bit device or the bit number of the word device as the condition.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.

■ While OFF
Ready to receive data when the value of device address is 0.
Specify the bit device or the bit number of the word device as the condition.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.

■ While satisfying the condition
Ready to receive data while a condition is satisfied.
Specify the conditional expression in Condition and select the type of data handled by the conditional expression in 
Data Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expressions configuration 
procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-71.
For details on data types, refer to Chapter 2 “1.1 Available Data” on page 2-1.

23 Specify the bit device or the bit number of the word device for reporting that data receiving was successfully 
completed in Completed Device Address under Detail.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.
If the value of Completed Device Address automatically is not set to 0 after it is set to 1, select the Not Clear 
Completed Device Address automatically check box.

24 Specify the destination word device for the received data size and error information in Status Device Address under 
Detail.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.

25 Enter a comment for receive command in Comment under Detail.

The maximum number is 40 characters.
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26 Set data for receive command.
Click Add under Data List.

The Data Settings dialog box is displayed.

27 Select data type in Type.

Data setting items are displayed.
For details on receive command, refer to “Receive (RXD) Command” on page 3-62.

28 Specify the data, and then click OK.

The data configured in Data List on the Command Settings dialog box is displayed.
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29 Repeat steps 26 through 28 to specify all the data for the receive command.

30 Click OK.

The receive command configured in Command List and Data List on Project Settings dialog box is displayed.

To add a transmission command, repeat steps 8 through 19. To add a receive command, repeat steps 20 through 29.

• The data are displayed in Data List in the order they were set. To change the order of data, select data, 
and then click Up or Down to shift it.

• Click Expand Data List to hide Type, Trigger Condition and Detail, the number of the data displayed 
in Data List will increase.
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31 Configure all commands, click OK.

This concludes configuring user communication to use Transmission (TXD) and Receive (RXD) commands.

To set the created user communication protocol to another user communication or to use it in another 
project, click Copy to Protocol Manager to register it in Protocol Manager. For details on the Protocol 
Manager, refer to “5.3 Protocol Manager” on page 3-32.
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Using Inching Function

1 On the Configuration tab, in the System Setup group, click Project.

The Project Settings dialog box is displayed.

2 Click the Communication Interface Tab in the Project Settings dialog box.

3 Select the interface for user communication under Interface Configuration, and then select the User 
Communication 1*1 in Function under Interface Settings.

*1 Inching function can be configured only for User Communication 1.

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P
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4 Specify the items for Interface Settings.
The settings vary based on the interface.

■ Serial Interface*1

 For details, refer to Chapter 4 “When SERIAL1(RS232C), SERIAL1(RS422/485), COM(RS232C), or 
COM(RS422/485) is selected under Interface Configuration” on page 4-39.

■ Ethernet Interface*2

 For details, refer to Chapter 4 “When Protocol1 to Protocol7 is selected for Ethernet under Interface 
Configuration” on page 4-42.

5 Click the User Communication tab.

6 Enter the name of the user communication protocol that will be set in Protocol Name.

The maximum number for protocol name is 40 characters.

*1 This is applicable for models with a serial interface (RS422/485) only.
*2 This is applicable for models with an ethernet interface only.

You cannot use the following characters in the protocol name.
   \ / : , ; * ? " < > |
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7 Double click the cell under Inching Function and select Enable.

8 Specifies the Execution Interval (x10 msec) as 40 to 1000 (20 ms increments).

9 Select the Inching check box.

10 Configure the transmission command for the Inching Function.
Click Add under Command List.

The Command Settings dialog box is displayed.

The items displayed in Command List can be changed with the TXD, RXD and Inching check boxes. 
Commands in Command List are displayed in the order they were created, but commands for inching 
function  are always displayed above the transmission and receive commands in the list.
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11 Select Inching in Type.

Specify the transmitted data for the inching function to the external device connected to the MICRO/I and the 
conditions for transmitting data.

12 With Function Key under Trigger Condition, select the function key (F1 to F12) to which the command will be 
assigned.

The function key is the switch on both sides of the screen of the HG1P.

13 Select the condition to transmit data in Trigger Type under Trigger Condition from the following.

■ Always Enabled
Data is always transmitted at the specified execution interval while a function key is pressed.

■ While satisfying the condition
Data is transmitted at the specified execution interval while a condition is satisfied.
Specify the conditional expression in Condition and select the data type handled by the conditional expression in 
Data Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expressions configuration 
procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-71.
For details on data types, refer to Chapter 2 “1.1 Available Data” on page 2-1.

14 Specify the bit device or the bit number of the word device for reporting that data transmission was successfully 
completed in Completed Device Address under Detail.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.

15 Specify the destination word device for the transmitted data size and error information in Status Device Address 
under Detail.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.
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16 Enter a comment of the command for the inching function in Comment under Detail.

The maximum number is 40 characters.

17 Set the command data for the inching function.
Click Add under Data List.

The Data Settings dialog box is displayed.

18 Select data type in Type.

Data setting items are displayed.
For details on transmission command, refer to “Transmission (TXD) Command” on page 3-49.
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19 Set the data, and then click OK.

The data configured in Data List on the Command Settings dialog box is displayed.

20 Repeat steps 17 through 19 to set all the command data for the inching function.

21 Click OK.

The command for the inching function configured in Command List and Data List on Project Settings dialog box is 
displayed.

To add a command for inching function, repeat steps 10 through 20.
To add a transmission command, repeat steps 8 through 19 of “Using Transmission Command and Receive 
Command”.

To add a receive command, repeat steps 20 through 29 of “Using Transmission Command and Receive Command”.

• The data are displayed in Data List in the order they were set. To change the order of data, select data, 
and then click Up or Down to shift it.

• Click Expand Data List to hide Type, Trigger Condition and Detail, the number of the data displayed 
in Data List will increase.
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22 Configure all commands, click OK.

This concludes configuring user communication.

To set the created user communication protocol to another user communication or to use it in another 
project, click Copy to Protocol Manager to register it in Protocol Manager. For details on the Protocol 
Manager, refer to “5.3 Protocol Manager” on page 3-32.
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● Configuring registered user communication protocol to another user communication
Configure an user communication protocol registered in Protocol Manager to another user communication.

1 On the Configuration tab, in the System Setup group, click Project.

The Project Settings dialog box is displayed.

2 In the User Communication tab on the Project Settings dialog box, select the user communication to set from the 
protocol list, and then click Open Protocol Manager.

Protocol Manager is displayed.

3 Select a user communication protocol in (Protocol List), and click OK.

(Protocol List)
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The user communication protocol selected in Protocol Manager is configured to the user communication specified on 
the Project Settings dialog box.
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● Using registered user communication protocol on another project
To use the user communication protocol registered in Protocol Manager on another project, save it as a file, and then 
import it to a project.

Saving registered user communication protocol as a file

1 On the Configuration tab, in the Manager group, click Protocol Manager.

Protocol Manager is displayed.

2 Select the user communication protocol in (Protocol List), and then click Export.

The Save As dialog box is displayed.

3 Specify the save location, and then click Save.

The name of the saved file will be the name of the protocol. 

(Protocol List)



WindO/I-NV4 User’s Manual 3-31

5 User Communication

3

Com
m

unication

Importing user communication protocol

1 On the Configuration tab, in the Manager group, click Protocol Manager.

Protocol Manager is displayed.

2 On Protocol Manager, click Import.

The Open dialog box is displayed.

3 Specify the user communication protocol file, and then click Open.

The user communication protocol is registered in Protocol Manager. The name of the user communication protocol file 
is set as the name of the protocol.
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5.3 Protocol Manager

User communication protocols to use in user communication can be created and registered protocols can be edited.

■ (Protocol List)
Displays the registered user communication protocol.

(Protocol List)

(Type)

No.: Displays the number for managing the user communication protocol.

Protocol Name: Enter the name of the user communication protocol. The maximum number for protocol name is 40 
characters.

You cannot use the following characters in the protocol name.
   \ / : , ; * ? " < > |

Receiving Character Time Out (x100 msec)

Specify the time out value (0 to 255) from when 1 frame of data has been received to when the next frame of 
data starts to be received. A frame refers to a data string from the beginning to the end of a command. If the 
Receiving Character Time Out is set to 0, it is not monitored. These setting items are used only with receive 
command.

Example: The received data (1 frame) is 2 bytes, While ON is selected as Trigger Type in Trigger Condition 
and LM100 is set to Device Address, LM101 is set to Completed Device Address, and LDR110 is 
set to Status Device Address
The data of second byte starts to be received before exceeding the Receiving Character Time Out 
duration after the data of first byte is received, and the values of the Completed Device Address and 
Status Device Address when receiving of the data has been successfully completed are as follows.

• The value of the Completed Device Address LM101 changes to 1.
When the Not Clear Completed Device Address automatically check box is not selected, when 
the value of the Trigger Condition device address LM100 changes from 0 to 1, the value of the 
Completed Device Address LM101 changes to 0. 
When the Not Clear Completed Device Address automatically check box is selected, the value 
of Completed Device Address LM101 remains 1, so set 0 if necessary.

:
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• The value of the Receiving Character Time Out (address number+0, bit 15) of the Status Device 
Address LDR110 remains 0.

When the Receiving Character Time Out duration exceeds until the data of second byte starts to be 
received after the data of first byte is received, the value of the Receiving Character Time Out (address 
number+0, bit 15) of the Status Device Address LDR110 changes to 1 and the Completed Device 
Address LM101 remains 0. In addition, when the value of the Trigger Condition device address LM100 
changes from 0 to 1, the value of LDR110 (address number +0, bit 15) changes to 0.

Inching Function*1: Displays whether or not the inching function is used. Double clicking the cell switches between 
Enable and Disable. This can only be set for the User Communication 1.
By using the inching function, data is transmitted at the specified execution interval.

Value of Receiving Character Time Out 
(address number+0, bit 15) 

of Status Device Address LDR110

Value of Completed Device Address 
LM101

Receive command

Value of Device Address LM100 when 
Trigger Condition is While ON

1

0

1

0

1

0

Receiving Character Time Out duration

First byte of receive data Second byte of receive data

Value of Receiving Character Time Out  
(address number+0, bit 15) 

of Status Device Address LDR110

Value of Completed Device Address 
LM101

Receive command

1

0

1

0

1

0

Receiving Character Time Out duration

First byte of receive data Second byte of receive data

Value of Device Address LM100 when 
Trigger Condition is While ON

Inching refers to the inching operation of the drive section. It is a general term for drive operations that 
repeatedly start and stop in small increments for each operation, such as starting and stopping the drive 
section when a push button or switch is pushed and released.

Execution Interval (x10 msec)*1: Specifies the interval to send the commands for inching function as 40 to 1000 (20 
ms increments).
This option can only be set when Enable is selected in Inching Function.

The command cannot be sent at the specified execution interval if the following conditions occur:
• The transmission processing for a command cannot be completed within the time set by Execution 

Interval.
⇒ Set Execution Interval to a time longer than it takes to send the command.

• The inching function was used at the same time as user communication transmission or receive 
processing.

⇒Do not use transmission commands, receive commands and commands for inching function at one 
time.

One frame is transmitted with no character spacing.



5 User Communication

3-34 WindO/I-NV4 User’s Manual

■ Command List
The command settings for the user communication protocol selected in the (Protocol List) are displayed.

*1 HG1P only

Add Protocol: Adds a user communication protocol to the (Protocol List).

Copy Protocol: Copies the selected user communication protocol in the (Protocol List).
Click this button to add a copy of the selected user communication protocol to the end of the 
(Protocol List).

Import: Imports a saved user communication protocol file. Click this button to display the Open dialog box. 
For details, refer to “Importing user communication protocol” on page 3-31.

Export: Export and saves a user communication protocol selected in the (Protocol List) as a file.
Click this button to display the Save As dialog box. For details, refer to “Saving registered user 
communication protocol as a file” on page 3-30.
Saved user communication protocols can be imported using Import.

Delete Protocol: Deletes a user communication protocol selected in the (Protocol List).

(Type)*1: Changes the items displayed in the list according to the type of command.

TXD, RXD: Select this check box to display transmission and receive commands.

Inching: Select this check box to display commands for the inching function.

User communication protocol commands are displayed in the order they were created, but commands for 
inching function  are always displayed above the transmission and receive commands in the list.

No.: Shows the number for managing command settings. Double clicking the cell displays the Command 
Settings dialog box.

Type: Shows the type of command. Double clicking the cell displays the Command Settings dialog box.

Key: Shows the function keys (F1 to F12) assigned to the command. Double clicking the cell displays the 
Command Settings dialog box.
This option is only displayed when the Inching check box is selected.

Trigger Type: Shows the trigger type for data transmission or being ready to receive data. Double clicking the cell 
displays the Command Settings dialog box.

Condition: Shows the condition of trigger type for data transmission or being ready to receive data. Double 
clicking the cell displays the Command Settings dialog box. The displayed content varies based on 
Trigger Type.

Always Enabled: Trigger conditions are not necessary, so nothing is displayed.

Rising-edge, Falling-edge, While ON, or While OFF:
Shows the bit device or the bit of the word device as the condition.

While satisfying the condition or Satisfy the condition:

Shows the conditional expression.

Fixed Period: Shows the period.

Completed: Shows the device address for reporting when transmission or receiving of data is successfully 
completed. Double clicking the cell displays the Command Settings dialog box.

Status: Shows the destination device address for the transmitted or received data size and error 
information. Double clicking the cell displays the Command Settings dialog box.

Comment: Shows the command comment. Double clicking the cell displays the Command Settings dialog box.

Size: Shows the command data size in bytes. The maximum is displayed if there is data that has the 
Variable check box selected on the Data Settings dialog box. Double clicking the cell displays the 
Command Settings dialog box.



WindO/I-NV4 User’s Manual 3-35

5 User Communication

3

Com
m

unication

■ Data List
Displays the list of command data selected in the Command List. 

■ Expand/Contract Command List
Shows or hides the Data List. By hiding Data List, the number of commands displayed in Command List will 
increase.

Add: Adds a command to the Command List. A maximum of 255 commands may be added.
Click this button, displays the Command Settings dialog box. For details, refer to “Command 
Settings Dialog Box” on page 3-36.

Edit: Edits the command selected in the Command List.
Click this button, displays the Command Settings dialog box. For details, refer to “Command 
Settings Dialog Box” on page 3-36.

Copy: Copies the command selected in the Command List.
Click this button to add a copy of the selected command to the end of the Command List. Inching 
function commands are added above the transmission and receive commands.

Up: Shifts the selected command upward in the list.

Down: Shifts the selected command downward in the list.

Delete: Deletes the selected command from the Command List.

Adding, copying, and shifting up and down happen within the range of the same type of command. There 
are two types of commands: TXD, RXD and Inching.

No.: Displays the number for managing the data. Double clicking the cell displays the Data Settings 
dialog box. For details, refer to “Data Settings Dialog Box” on page 3-48.

Data: Displays the data settings. Double clicking the cell displays the Data Settings dialog box. For details, 
refer to “Data Settings Dialog Box” on page 3-48.

Add: Add: Adds a data to Data List.
Click this button, displays the Data Settings dialog box. For details, refer to “Data Settings Dialog 
Box” on page 3-48.

Edit: Changes the selected data in Data List.
Click this button, displays the Data Settings dialog box. For details, refer to “Data Settings Dialog 
Box” on page 3-48.

Copy: Copies the selected data in Data List.
Click this button to add a copy of the selected data to the end of the Data List.

Up: Shifts the selected data upward in the list.

Down: Shifts the selected data downward in the list.

Delete: Deletes the selected data from Data List.
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● Command Settings Dialog Box
Specify the command details for user communication protocol.
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■ Type
Select the type of communication command from the following items.

TXD: A command for data transmission from the MICRO/I to an external device.

Processing of transmission command is as follows.

Example: When Trigger Type in Trigger Condition is Rising-edge, Device Address is LM100 and 
Completed Device Address is LM101
When the value of the Trigger Condition device address LM100 changes to 1, data is 
transmitted by user communication from the MICRO/I to the external device. When data 
transmission is successfully completed, the value of the Completed Device Address LM101 
changes to 1.

RXD: A command for analyzing and processing data received by the MICRO/I from an external device.

Processing of receive command is as follows.

Example: When Trigger Type in Trigger Condition is While ON, Device Address is LM100 and 
Completed Device Address is LM101
When the value of the Trigger Condition device address LM100 changes to 1, data can be 
received (ready to receive) by user communication, so when data is transmitted from the 
external device, the MICRO/I starts to receive the data. When data receiving is successfully 
completed, the value of the Completed Device Address LM101 changes to 1.

Transmission 
dataTransmission

1
(31h)

2
(32h)

3
(33h)

4
(34h)

External deviceMICRO/I

Value of Device Address LM100 when 
Trigger Condition is

Rising-edge

1

0

Value of Completed Device Address 
LM101

1

0

Transmission data

State in which user 
communication is 

not operating

State in which data can be
 transmitted by user communication

State in which user 
communication is 

not operating

Complete 
transmission

Start 
transmission

Receive dataReceive
1

(31h)
2

(32h)
3

(33h)
4

(34h)

External device
MICRO/I

Value of Device Address LM100 when 
Trigger Condition is

While ON

1

0

Value of Completed Device Address 
LM101

1

0

Receive data

Data transmission from 
external device

State in which user 
communication is 

not operating

State in which data can be
 received by user communication

State in which user 
communication is 

not operating

Complete 
receiving

Start 
receiving
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Inching: Commands that send data from the MICRO/I to the external device and execute inching operations of the 
driving part.
This option can only be set when Enable is selected in Inching Function on the Project Settings dialog 
box.

Processing of the command for the inching function is as follows:

Example: Function Key in Trigger Condition is F7, Trigger Type is While satisfying the 
condition, Condition is LSD31==5 and Completed Device Address is LM301
When the value of the Condition LSD31 is 5 and the Function Key F7 is pressed, data is 
transmitted by user communication from the MICRO/I to the external device. 
When data transmission is successfully completed, the value of the Completed Device Address 
LM301 changes to 1.

Data of Inching functionTransmission
SOH
(01h)

CR
(0Dh)

1
(31h)

SOH
(01h)

0
(30h)

2
(32h)

K
(4Bh)

HG1P

External device

Driving part

MICRO/I

Condition for While satisfying 
the condition in Trigger Condition 

is LSD31==5

1

0

Value of Completed Device Address 
LM301

Satisfied

Not satisfied

State of the function key 
"F7"

ON

OFF

Data of Inching function

State in which user 
communication is 

not operating

State in which user 
communication is 

not operating

State in which data can be
 transmitted by user communication

Complete 
transmission

Start 
transmission
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■ Trigger Condition
Set the trigger conditions for transmission or receiving of data.

TXD is selected as Type:

RXD is selected as Type:

Trigger Type: A condition for data transmission is selected from the following.
Rising-edge: Data is transmitted when the value of device address changes from 0 to 1.

Falling-edge: Data is transmitted when the value of device address changes from 1 to 0.

Satisfy the condition:
Data is transmitted when the condition changes from not satisfied to satisfied.

Fixed Period: Data is transmitted at a fixed time interval.

Data Type: Select the data type handled by the conditional expression.
Can only be set if Satisfy the condition is selected as Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Device Address: Specifies the bit device or the bit number of the word device to serve as condition. You can only 
specify the internal device.
Can only be set if Rising-edge or Falling-edge is selected as Trigger Type.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 
2 “5.1 Device Address Settings” on page 2-68.

Condition: Sets the condition formula.
Can only be set if Satisfy the condition is selected as Trigger Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expressions 
configuration procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-71.

Period (sec): Specify the period for command execution from 1 to 3600 (seconds).
This is enabled only when Fixed Period is selected in Trigger Type.

Trigger Type: Selects the condition to be ready to receive data from the following.
Always Enabled: The MICRO/I is always ready to receive data.

While ON: Ready to receive data when the value of device address is 1.

Value of Device Address
1

0

Action Execution Execution Execution

1

0

Value of Device Address

Action Execution Execution

Action Execution

Condition
Satisfied

Not satisfied

Execution Execution

Fixed time interval Fixed time interval Fixed time interval

Action ExecutionExecutionExecution

Action Always Enabled

Value of Device Address

1

0

Enabled Enabled EnabledAction
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Inching is selected as Type:

While OFF: Ready to receive data when the value of device address is 0.

While satisfying the condition:
Ready to receive data while the condition is satisfied.

Data Type: Select the data type handled by the conditional expression.
Can only be set if While satisfying the condition is selected as Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Device Address: Specifies the bit device or the bit number of the word device to serve as condition. You can only specify 
the internal device.
Can only be set if While ON or While OFF is selected as Trigger Type.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 
2 “5.1 Device Address Settings” on page 2-68.

Condition: Sets the condition formula.
Can only be set if While satisfying the condition is selected as Trigger Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expressions 
configuration procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-71.

Function Key: Select the function key (F1 to F12) assigned to the command.
Trigger Type: A condition for data transmission is selected from the following.

Always Enabled: Data is always transmitted at a configured execution interval while a function key is 
pressed.

While satisfying the condition:
Data is transmitted at a configured execution interval while a condition is satisfied.

Data Type: Select the data type handled by the conditional expression.
Can only be set if Satisfy the condition is selected as Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Condition: Sets the condition formula.
Can only be set if Satisfy the condition is selected as Trigger Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expressions 
configuration procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-71.

1

0

Enabled EnabledEnabled

Value of Device Address

Action

Enabled Enabled Enabled

Condition
Satisfied

Not satisfied

Action

Action Always Enabled

Execution Execution Execution

Satisfied

Not satisfied

Execution Interval Execution Interval Execution Interval

Condition

Action
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■ Detail

Completed Device Address:

Specify the bit device or the bit number of the word device for reporting that data transmission or receiving was 
successfully completed. You can only specify an internal device.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.

Example: When Trigger Type in Trigger Condition is While ON, Device Address is LM100 and Completed 
Device Address is LM101

When data receiving is successfully completed, the value of the Completed Device Address LM101 
changes to 1. When the value of the Trigger Condition device address LM100 changes from 0 to 1, the 
value of the Completed Device Address LM101 changes to 0.

Not Clear Completed Device Address automatically:

Select this check box when the value of the Completed Device Address is not set to 0 automatically after it 
changes to 1. This can be configured when RXD is selected as Type.

Example: When Trigger Type in Trigger Condition is While ON, Device Address is LM100 and Completed 
Device Address is LM101

When the Not Clear Completed Device Address automatically check box is not selected:
When data receiving is successfully completed, the value of the Completed Device Address LM101 
changes to 1. When the first data of the next frame is received, the value of the Completed Device 
Address LM101 changes to 0.

When the Not Clear Completed Device Address automatically check box is selected:
When data receiving is successfully completed, the value of the Completed Device Address LM101 is set 
to 1. Even after the first data of the next frame is received, the value of the Completed Device Address 
LM101 does not change to 0.

Value of Completed Device Address 
LM101

Receive command

Value of Device Address LM100 when 
Trigger Condition is

While ON

1

0

1

0

Receive data 1 frame

Value of Completed Device Address 
LM101

Receive command

Value of Device Address LM100 when 
Trigger Condition is

While ON

1

0

1

0

Receive data 1 frame Receive data 1 frame

1

0

1

0

Receive data 1 frame Receive data 1 frame

Value of Completed Device Address 
LM101

Receive command

Value of Device Address LM100 when 
Trigger Condition is

While ON
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TXD or Inching is selected as Type:

Status Device Address:

Specify the destination word device for the transmitted or received data size and error information. Error 
information and command data size is stored at the beginning of the configured device address. When data 
transmission or receiving has not successfully completed, the value of each bit changes to 1. The bits of the Status 
Device Address changes to 0 when the trigger condition is satisfied and they are not changed to 0 automatically. 
When Always Enabled is selected in Trigger Condition of receive command, the value of the Status Device 
Address is kept as long as a Clear command is not executed.
You can only specify an internal device.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.

Example: When LDR110 is configured as Status Device Address

Address 
number Bit Function Cause Solution

+0

0 BCC Error

• The Calculation Start Position and Calculation 
End Position are not stored in 1 frame.

• The Calculation End Position is set before 
Calculation Start Position.

Change the Calculation 
Start Position and 
Calculation End Position 
settings.

• When Calculation Type is Modbus ASCII 
(LCR), the data size from Calculation Start 
Position to Calculation End Position is odd 
bytes.

• The ASCII data contains data other than ASCII 
(30h to 39h, 41h to 46h) data.

Change the Calculation 
Start Position and 
Calculation End Position 
settings and the 
transmission data.

1, 2 Reserved

3
Registering Constant 
Data Error

When data type is Registering Constant 
(Character) or Registering Constant 
(Hexadecimal), the value of the Index Device 
Address does not match the Index No. of the 
registered Registering Constant.

Change the data stored in 
the Index Device Address.

4 Reserved

5
Use Reference Device 
Data Error

When data type is Device Address and the 
Use Reference Device Address check box is 
selected, the device address in which the value 
of the Reference Device Address is stored as 
offset has exceeded the valid range.

Change the value stored in 
the Reference Device 
Address.

6
Device Data Variable 
Specification Error

When data type is Device Address, the 
Variable check box is selected and Device 
Address is selected, the value of device 
address is negative or exceeds the setting 
(number of bytes x number of words).

Change the value of device 
address to a positive value 
or to a value that does not 
exceed the setting (number 
of bytes x number of 
words).

7
Transmission 
Command Abandon 
Error

When transmitting command after the Trigger
Condition is satisfied, the command with the 
same Command No. was transmitting or 
transmission (transmission is not completed).

Increase the time interval 
for starting transmission.

8
Inching Transmission 
Command Abandon 
Error

The processing to send the inching function 
command did not complete within the time set 
by Execution Interval (transmission is not 
completed)

Increase the Execution 
Interval for inching.

9 to 15 Reserved

LDR110
LDR111

Error information and time out information
Transmitted or received data size (bytes)

(Starting address number) +0
+1
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RXD is selected as Type:

Address 
number Function Description

+1 Transmission Data Size (bytes) Stores the size of transmission data.

When the Error Information bit changes to 1, data is not transmitted, and the Transmission Completed 
Device Address does not change to 1.

Address 
number Bit Function Cause Solution

+0

0 BCC error

The BCC that calculated the receive data did not match 
the BCC that is appended to the receive data.

Check the transmission data 
from the external device.

• The Calculation Start Position and Calculation End 
Position are not stored in 1 frame.

• The Calculation End Position is set before Calculation 
Start Position.

Change the Calculation 
Start Position and 
Calculation End Position 
settings.

• When Calculation Type is Modbus ASCII (LCR), the 
data size from Calculation Start Position to 
Calculation End Position is odd bytes.

• The ASCII data contains data other than ASCII (30h 
to 39h, 41h to 46h) data.

Change the Calculation Start 
Position and Calculation End 
Position settings and the 
transmission data from the 
external device.

1
Received Data 
Size Error

The received data size of the data does not match that 
of the specified receive command.

Check the transmission data 
from the external device.

2
Registering 
Constant Data 
Error

The Constant (Character) or Constant 
(Hexadecimal) set up with the receive command 
does not match the receive data.

Check the transmission data 
from the external device.

3
Registering 
Constant Error

No data matches the registered setting of the 
Registering Constant data.

Check the transmission data 
from the external device.

4
Device Data 
Conversion Error

• When data type is Device Address and 
Conversion Type is ASCII to Hexadecimal, a 
code other than 0 to 9 or A to F receives as data.

• When data type is Device Address and 
Conversion Type is ASCII to Decimal, a code 
other than 0 to 9 receives as data. Or the converted 
data exceeds 65535.

Check the transmission data 
from the external device.

5
Device Data 
Reference 
Device Error

When data type is Device Address and the Use 
Reference Device Address check box is selected, the 
device address in which the value of the Reference 
Device Address is stored as offset has exceeded the valid 
range. Or the number of words setting of the device 
address is beyond the range of device address for which 
data is stored.

Change the value of the 
Reference Device Address 
or the change the number 
of words.

6
Terminal Code of 
Receive Data 
Miscompare Error

In the receive command whose trigger condition is 
being satisfied, the start code matches while the 
terminal code does not match.

Check the transmission data 
from the external device.

7
Device Storing 
Error

During the reception process of multiple received 
commands, the total number of words of the next 
device address to be stored exceeds 800 words.
•The stored device addresses that Type is Device 
Address.

•Index device address whose Type is Registering 
Constant (Character) or Registering Constant 
(Hexadecimal).

Change settings so that the 
total number of device 
addresses used for storage 
at one time does not 
exceed 800 words.
Change settings so that the 
trigger conditions for 
several receive commands 
are not satisfied, to reduce 
the number of receive 
commands that are 
processed. 

8 to 13 Reserved
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+0

14
Receiving Time 
Out

1 frame of data is not received even when the preset 
Receiving Time Out duration has passed after the 
Trigger Condition is satisfied. 

Check the transmission data 
from the external device.

15
Receiving 
Character Time 
Out

While 1 frame of data is being received, even after the 
time out period—the specified time interval between 
receiving data (from when 1 frame of data has been 
received to when the next frame of data starts to be 
received)—has elapsed, the next frame of data does 
not start to be received.

Check the transmission data 
from the external device.

Address 
number Function Description

+1 Receive Data Size (bytes) Stores the size of receive data.

Address 
number Bit Function Cause Solution

After the Receiving Character Time Out duration has elapsed, the receive data is analyzed. When the Error 
Information bit changes to 1, data is not received, and the Receiving Completed Device Address does not change to 1.

Transmission Wait (x100 msec):

Specify the wait time (0 to 255) from when the trigger condition is satisfied to when the data is transmitted. This 
can be configured only when TXD is selected as Type on the Command Settings dialog box.
After the Transmission Wait duration has elapsed from when the trigger condition is satisfied, transmission starts.

Example: When Trigger Type in Trigger Condition is Rising-edge and Device Address is LM100

Receiving Time Out (x100 msec):

Set the time out (0 to 255) from when the trigger condition is satisfied to when 1 frame of data has been received. 
A frame refers to a data string from the beginning to the end of a command. If the Receiving Character Time Out 
is set to 0, it is not monitored. 
This can be configured only when RXD is selected as Type, and While ON, While OFF, or While satisfying 
the condition is selected in Trigger Type.

When 1 frame of data could not be received, even though the Receiving Time Out duration has elapsed from 
when the trigger condition is satisfied, the value of the Receiving Time Out of the Status Device Address (address 
number+0, bit 14) changes to 1. When the Receiving Time Out duration elapses, the value of the Completed 
Device Address does not change to 1, and the receive data is not processed.
When the trigger condition again changes from not satisfied to satisfied, the value of the Receiving Time Out of 
the Status Device Address (address number+0, bit 14) changes to 0. When the value of this bit is not 0, the 
Receiving Time Out cannot be detected.

Transmission command

Value of Device Address LM100
when Trigger Condition is 

Rising-edge

1

0

Transmission data 1 frame

Transmission 
Wait duration

Transmission data 1 frame

Transmission 
Wait duration

Value of Device Address when 
Trigger Condition is 

While ON

1

0

1

0

Receiving Time Out duration

Value of the Receiving Time Out 
(address number+0, bit14) 

of the Status Device Address
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Example: When Trigger Type in Trigger Condition is While ON, Device Address is LM100, Status Device 
Address is LDR110, Completed Device Address is LM101 and the Not Clear Completed Device 
Address automatically check box is not selected
When Status Device Address is LDR110, error information and time out information is stored in each 
bit of LDR110.

When receiving of 1 frame of data is completed before the Receiving Time Out duration has elapsed 
from when the trigger condition is satisfied, the value of the Receiving Time Out of the Status Device 
Address LDR110 (address number+0, bit 14) remains 0.

When receiving of 1 frame of data could not be completed by the time the Receiving Time Out duration 
elapses from when the trigger condition is satisfied, the value of the Receiving Time Out of the Status 
Device Address LDR110 (address number+0, bit 14) changes to 1.

Comment： Enter a comment for a command. The maximum number is 40 characters.

Receive command

Value of Device Address LM100 when 
Trigger Condition is While ON

1

0

1

0
Value of Completed Device Address LM101

1

0

Receive data 1 frame

Receiving Time Out duration

Receive data 1 frame

Value of Receiving Time Out  
(address number+0, bit 14) 

of Status Device Address LDR110

1

0

0

1

0

1

Receive command

Value of Device Address LM100 when 
Trigger Condition is While ON

Value of Completed Device Address LM101

Receive data 1 frame

Receiving Time Out duration

Value of Receiving Time Out 
(address number+0, bit 14) 

of Status Device Address LDR110

1

0

0

1

0

1

Receive command

Value of Device Address LM100 when 
Trigger Condition is While ON

Value of Completed Device Address LM101

Receive data 1 frame

Receiving Time Out duration

Value of Receiving Time Out 
(address number+0, bit 14) 

of Status Device Address LDR110
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■ Data List
Shows a list of command data. Double clicking the line displays the Data Settings dialog box.
For details, refer to “Data Settings Dialog Box” on page 3-48. The maximum data size that can be configured is 1500 
bytes per command.
The content displayed in lists varies based on the type of command.

Constant (Character): Displays the specified data enclosed in " ". 
"Data"
Example: "1234"

Constant (Hexadecimal): Displays the specified data with each byte value enclosed in ' '. 
'Data of the first byte' 'Data of the second byte' 'Data of the third byte' 'Data of the 
forth byte'
Example: '31' '32' '33' '34'

Device Address: Displays the specified data enclosed by < >, in the following order. 
<Device Address  Conversion Type  Number of bytes  Variable  Words  Storage Method of data>

Device Address: Displays the device address enclosed by [ ]
When the Use Reference Device Address check box is 
selected, displays as OFFSET([Device Address], [Reference 
Device Address]) 

Number of bytes: Displays the number of bytes of the transmitted or 
received data.

Conversion Type: Display the conversion methods for values of device 
addresses as follows.
HEX-A: When Hexadecimal to ASCII is selected
DEC-A: When Decimal to ASCII is selected
N: When No conversion is selected

Variable: When the Variable check box is selected, variables are 
displayed as follows.
V00: When NULL(00h) is selected for transmission 
command
V [Device Address]: When Device Address is selected for 
transmission command
V: In the case of receive command

Words: Displays the number of word devices for transmitting or 
receiving data.

Storage Method of data: Displays the handling method for value of read device 
address as follows.
U: When from Upper byte is selected
L: When from Lower byte is selected

Example: <OFFSET([LDR0100], [LDR0300]) N 2V[LDR0200] 2 U>

Registering Constant (Character):

Displays the specified data enclosed in << >>. 
<<Index No. of No. 1: Data of No. 1 Index No. of No. 2: Data of No. 2 ... Index No. of 
No. N: Data of No. N Index Device Address>> (N = 1 to 100)

Data: Displays the data enclosed by " "

Index Device Address: Displays the device address enclosed by [ ]

Example: <<1:"123" 2 :"456" 3 :"789" [LDR0100]>>

Registering Constant (Hexadecimal):

Displays the specified data enclosed in << >>. 
<<Index No. of No. 1: Data of No. 1 Index No. of No. 2: Data of No. 2 ... Index No. of 
No. N: Data of No. N Index Device Address>> (N = 1 to 100)

Data: Displays the data enclosed by ' '

Index Device Address: Displays the device address enclosed by [ ]

Example: <<1:'313233' 2:'343536' 3 :'373839' [LDR0100]>>
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■ Command Size (byte)
Displays the data size of a configured command.
The calculation method for command size varies based on the type selected in Type on the Command Settings dialog 
box.

■ Start Code, Terminal Code
Display the start code and the terminal code in hexadecimal notation.

■ Expand/Contract Data List
Shows or hides the Type, Trigger Condition and Detail. By hiding Type, Trigger Condition and Detail, the 
number of the data displayed in Data List will increase.

BCC: Displays the specified data enclosed in BCC ( ). 
BCC(Calculation Start Position   Calculation End Position   Calculation Type    
Conversion Type   Number of bytes)

Calculation Start Position:

Displays the data position where the BCC calculation 
starts.

Calculation End Position:

Displays the data position where the BCC calculation ends.

Calculation Type: Display the methods to calculate the data between the 
Calculation Start Position and Calculation End Position as 
follows.
XOR: When XOR is selected
ADD: When ADD is selected
ADD2: When ADD (2's Complement) is selected

Conversion Type: Display the conversion methods for values of device 
addresses as follows. 
HEX-A: When Hexadecimal to ASCII is selected
N: When No conversion is selected

Number of bytes: Displays the number of bytes of the transmitted or 
received data.

Example: BCC(2 1 XOR N 2)

Skip: Displays the specified data enclosed in Skip( ). 
Skip(Number of bytes)
Example: Skip(2)

Add: Adds a data to Data List.
Click this button, displays the Data Settings dialog box. For details, refer to “Data 
Settings Dialog Box” on page 3-48.

Edit: Changes the selected data in Data List.
Click this button, displays the Data Settings dialog box. For details, refer to “Data 
Settings Dialog Box” on page 3-48.

Copy: Copies the selected data in Data List.
Click this button to add a copy of the selected data to the end of Data List.

Up: Shifts the selected data upward in the list.

Down: Shifts the selected data downward in the list.

Delete: Deletes the selected data from Data List.

TXD: Number of bytes for Constant Data + Number of bytes for a data of Registering Constant + Number of 
bytes of BCC + Number of bytes of Device Address x Words of Device Address

RXD: Number of bytes for Constant Data + Number of bytes for a data of Registering Constant + Number of 
bytes of BCC + Number of bytes of Skip + Number of bytes of Device Address x Words of Device Address
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● Data Settings Dialog Box
Specify the transmitted or received data by a command.

■ Type
Selects data types from the following items.
Constant (Character), Constant (Hexadecimal), Device Address, Registering Constant (Character), 
Registering Constant (Hexadecimal), BCC, Skip
Skip can only be configured when RXD is selected as Type on the Command Settings dialog box.

Setting item varies based on the selection in Type on the Command Settings dialog box.
When TXD or Inching is selected, refer to “Transmission (TXD) Command” on page 3-49.
When RXD is selected, refer to “Receive (RXD) Command” on page 3-62.
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● Transmission (TXD) Command

Constant (Character)

The character data is sent without being converted. 
This can be configured only when TXD or Inching is selected as Type on the Command Settings dialog box, and 
Constant (Character) is selected under Type on the Data Settings dialog box.

■ Data
Enter character data to be transmitted (1 to 1,500 bytes). The size of a single-byte character is one byte and that of 
a double-byte character is two bytes.

Example: Constant (Character) for transmission command data

When the trigger condition is satisfied, the character data is transmitted in the following order.

Item Setting

Data 1234

1234 1
(31h)

Transmission data
Data

2
(32h)

3
(33h)

4
(34h)

Order of transmission

No 
conversion
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Constant (Hexadecimal)

The hexadecimal data is sent without being converted.
Use this setting to send a control code of ASCII data (00h to 1Fh).
This can be configured only when TXD or Inching is selected as Type on the Command Settings dialog box, and 
Constant (Hexadecimal) is selected under Type on the Data Settings dialog box.

■ Data
Enter hexadecimal data to be transmitted (1 to 1,500 bytes).

Example: Constant (Hexadecimal) for transmission command data

When the trigger condition is satisfied, 1234h is transmitted in the order 12h and 34h.

Item Setting

Data 1234

1234h
No 

conversion

12h

Transmission data
Data

34h

Order of transmission
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Device Address

The value of device address is either not converted or converted to ASCII and then sent as data with the specified size.
This can be configured only when TXD or Inching is selected as Type on the Command Settings dialog box, and 
Device Address is selected under Type on the Data Settings dialog box.

■ Conversion Type:
Select the conversion rule for the value of device address from the following.

■ Device Address
Specify the source word device for transmitted data. You can only specify an internal device.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.

■ Use Reference Device Address
To change the source word device for transmitted data according to values of device address, select this check box 
and specify a device address. You can only specify an internal device.
For details, refer to Chapter 2 “Indirect Read and Indirect Write Settings” on page 2-5.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.

■ Storage Method of data
Select the handling method for the value of read device address. This can be configured only when No conversion is 
selected under Conversion Type.

■ Number of bytes
Specify the number of bytes of transmitted data. The number of bytes that can be specified varies based on the 
setting under Conversion Type.

Hexadecimal to ASCII: Considers the value of device address as binary-coded hexadecimal number and converts it 
to ASCII data.

Decimal to ASCII: Considers the value of device address as binary-coded decimal number and converts it to 
ASCII data.

No conversion: No conversion is performed.

from Upper byte: Value of device addresses are read from the upper byte.
from Lower byte: Value of device addresses are read from the lower byte.

Hexadecimal to ASCII: 1 to 4
Decimal to ASCII: 1 to 5
No conversion: 1 to 2
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■ Words
Specify the number of word devices (1 to 99) of transmitted data.

■ Variable
Select this check box to change the transmitted data size according to conditions. This can be configured only when 
No conversion is selected under Conversion Type. When the check box is not selected, the amount of data 
(bytes) transmitted is data (bytes) for Number of bytes x Words.

Examples: Device address for transmission command data

Example 1

When the trigger condition is satisfied, the value of device address is read and data is transmitted in the following order.

Example 2

When the trigger condition is satisfied, the value of device address is read and data is transmitted in the following order.

NULL(00h): Send the data from the start data of the value of device address up to 00 (hexadecimal). Data 00 
will not be sent. This setting is effective for sending only the character data section of character 
data having 00 (hexadecimal) as the last data.

Device Address: Specify a word device to which a number of bytes is applied for transmitted data.

Click  to display the Tag Editor. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-68.
When the value of device address exceeds Number of bytes x Words, or when it is negative, the 
Device Data Variable Specification Error (address number+0, bit 6) of the Status Device Address 
changes to 1, and transmission does not occur.

Item Setting

Conversion Type No conversion

Device Address LDR100

Use Reference Device Address OFF

Storage Method of data from Upper byte

Number of bytes 1

Words 3

Variable OFF

Item Setting

Conversion Type No conversion

Device Address LDR100

Use Reference Device Address OFF

Storage Method of data from Lower byte

Number of bytes 2

Words 3

Variable OFF

1234hLDR100:
5678hLDR101:
9ABChLDR102:

No conversion

12h

Upper Lower
Value of Device Address

34h

56h 78h

9Ah BCh

from Upper byte 
1 byte

Transmission data

12h 56h 9Ah

Order of transmission

Words: 3

LDR100:
LDR101:

Transmission data

34h 12h 78h

9ABChLDR102:

9Ah BCh

56h BCh 9Ah

Order of transmission

1234h
5678h

12h 34h

56h 78h

No conversion

Upper Lower
Value of Device Address

from Lower byte 
2 bytes

Words: 3
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Example 3

When the trigger condition is satisfied, the value of device address is read, and data is converted to ASCII and 
transmitted in the following order.

Example 4

When the trigger condition is satisfied, the value of device address is read, and data is converted to ASCII and 
transmitted in the following order.

Example 5

When the trigger condition is satisfied, the value of device address is read and data is transmitted in the following 
order.

Item Setting

Conversion Type Hexadecimal to ASCII

Device Address LDR100

Use Reference Device Address OFF

Number of bytes 2

Words 2

Variable OFF

Item Setting

Conversion Type Decimal to ASCII

Device Address LDR100

Use Reference Device Address OFF

Number of bytes 2

Words 2

Variable OFF

Item Setting

Conversion Type No conversion

Device Address LDR100

Use Reference Device Address OFF

Storage Method of data from Upper byte

Number of bytes 2

Words 2

Variable ON, NULL(00h)

1234hLDR100:
5678hLDR101:

Hexadecimal to ASCII

1
(31h)

Value of Device Address
4

(34h)

5
(35h)

2
(32h)

6
(36h)

3
(33h)

7
(37h)

8
(38h)

2 bytes

Transmission data

3
(33h)

4
(34h)

7
(37h)

8
(38h)

Order of transmission

Words: 2

1234LDR100:
5678LDR101:

1
(31h)

4
(34h)

5
(35h)

2
(32h)

6
(36h)

3
(33h)

7
(37h)

8
(38h)

3
(33h)

4
(34h)

7
(37h)

8
(38h)

Decimal to ASCII

Value of Device Address
Transmission data

Order of transmission

2 bytes
Words: 2

1234hLDR100:
0056hLDR101:

No conversion

12h

Upper Lower
Value of Device Address

34h

56h00h
from Upper byte 

2 bytes

Transmission data

12h 34h

Order of transmission

Words: 2
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Example 6

When the trigger condition is satisfied, the value of device address is read and data is transmitted in the following 
order.
When the LDR200 value is 3

Example 7

When the trigger condition is satisfied, the value of device address is read and data is transmitted in the following 
order.
When the LDR200 value is 2

Item Setting

Conversion Type No conversion

Device Address LDR100

Use Reference Device Address OFF

Storage Method of data from Lower byte

Number of bytes 2

Words 2

Variable ON, Device Address: LDR200

Item Setting

Conversion Type No conversion

Device Address LDR100

Use Reference Device Address ON, Device Address: LDR200

Storage Method of data from Upper byte

Words 2

Variable OFF

LDR100:
LDR101:

No conversion

Transmission data

34h 12h 78h

Order of transmission

1234h
5678h

12h 34h

56h 78h

Upper Lower
Value of Device Address

from Lower byte 
2 bytes

Words: 2

LDR200=3

1234hLDR100:
5678hLDR101:
2537hLDR102:
4619hLDR103:

No conversion

25h

Upper Lower

Value of Device Address

37h

46h 19h

LDR200=2

Words: 2

Transmission data

25h 37h 46h 19h

Order of transmission

from Upper byte 
2 bytes
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Registering Constant (Character)

From the registered character data, character data according to the value of device address is read and transmitted.
This can be configured only when TXD or Inching is selected as Type on the Command Settings dialog box, and 
Registering Constant (Character) is selected under Type on the Data Settings dialog box.

■ Number of Registering Constants
Specify the number of data of the registered character data (1 to 100).

■ Registering Constants

■ Index
Specify the Index No. (0 to 65535) of the character data.

■ Data
Enter the character data (1 to 1500 bytes) to be registered. The size of a single-byte character is one byte and that of 
a double-byte character is two bytes.
The character data of different size or the same data with a different number cannot be registered.

■ Set
Register the Index and Data settings to the list. When a number that is already registered is selected, it is 
overwritten with the new setting.

■ Insert
Insert a character data setting to the selected number in the list.
Click this button to insert the Index and Data setting. The settings at the insertion point shift down 1 line. Settings 
cannot be inserted when all numbers are already set.

■ Delete
Delete the selected settings from the list.

■ Index Device Address
Specify the source word device to serve as the Index No. You can only specify an internal device.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.

No.: Shows the ID No. (1 to 100) of the character data.

Index: Shows the Index No. of the character data.

Data: Shows the character data.
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Example: Transmission command for Registering Constant (Character) data

When the trigger condition is satisfied, the data of the Index No. according to the value of device address is 
transmitted.
When the LDR100 value is 2

Item Setting

Number of Registering Constants 3

Registering Constants

Index No. 1: 123

Index No. 2: 456

Index No. 3: 789

Index Device Address LDR100

1231:
4562:
7893: Index Device Address

LDR100=2

DataIndex No.

Number of 
Registering 

Constants: 3

Transmission data

4
(34h)

5
(35h)

6
(36h)

Order of transmission
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Registering Constant (Hexadecimal)

From the registered hexadecimal data, the hexadecimal data according to the value of device address is read and 
transmitted.
This can be configured only when TXD or Inching is selected as Type on the Command Settings dialog box, and 
Registering Constant (Hexadecimal) is selected under Type on the Data Settings dialog box.

■ Number of Registering Constants
Specify the number of data of the registered hexadecimal data (1 to 100).

■ Registering Constants

■ Index
Specify the Index No. (0 to 65535) of the hexadecimal data.

■ Data
Enter the hexadecimal data (1 to 1500 bytes) to be registered.
The data of different size or the same data with a different number cannot be registered.

■ Set
Register the Index and Data settings to the list. When a number that is already registered is selected, it is 
overwritten with the new setting.

■ Insert
Insert a hexadecimal data setting to the selected number in the list.
Click this button to insert the Index and Data setting. The settings at the insertion point shift down one line. Settings 
cannot be inserted when all numbers are already set.

■ Delete
Delete the selected settings from the list.

■ Index Device Address
Specify the source word device to serve as the Index No. You can only specify an internal device.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.

No.: Shows the ID No. (1 to 100) of the hexadecimal data.

Index: Shows the Index No. of the hexadecimal data.

Data: Shows the hexadecimal data.
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Example: Transmission command for Registering Constant (Hexadecimal) data 

When the trigger condition is satisfied, the data of the Index No. according to the value of device address is 
transmitted.
When the LDR100 value is 3

Item Setting

Number of Registering Constants 3

Registering Constants

Index No. 1: 1234

Index No. 2: 5678

Index No. 3: 2537

Index Device Address LDR100

1234h1:
5678h2:
2537h3:

Index Device Address
LDR100=3

DataIndex No.

Number of 
Registering 

Constants: 3

Transmission data

25h 37h

Order of transmission
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BCC (Block Check Code)

A BCC for the transmission data is automatically calculated and appended to the transmission data at an arbitrary 
position and transmitted.
This can be configured only when TXD or Inching is selected as Type on the Command Settings dialog box, and 
BCC is selected under Type on the Data Settings dialog box.

■ Calculation Start Position
Specify the position of transmission data at which BCC calculation starts (1 to 15). The position is counted backwards, 
with the first position of the transmission data taken as 1.

■ Calculation End Position
Specify the position of transmission data at which BCC calculation ends (0 to 15). The position is counted forwards, 
with the data position before the BCC taken as 0.

■ Calculation Type
Select the method to calculate the data between the Calculation Start Position and Calculation End Position.

1
(31h)

4
(34h)

5
(35h)

2
(32h)

STX
(02h)

3
(33h)

BCC CR
(0Dh)

(1) (2) (3) (4) (5) (6)Calculation Start Position:

Transmission data:

1
(31h)

4
(34h)

5
(35h)

2
(32h)

STX
(02h)

3
(33h)

BCC CR
(0Dh)

(5) (4) (3) (2) (1) (0)Calculation End Position:

Transmission data:

XOR: Calculates the data with exclusive logical add.

ADD: Calculates the data using addition.

ADD (2's Complement): Calculates the data using addition, inverts the bit and adds one.

Modbus ASCII (LCR): Calculation is performed according to the following procedure. Conversion Type: 
Hexadecimal to ASCII, Number of bytes: 2

1. Convert the ASCII characters between Calculation Start Position and Calculation End 
Position into 1-byte hexadecimal data for each set of two characters.
Example: 37h, 35h→75h

2. Calculate the sum of the data obtained in step 1.

3. Invert the bit of the result of step 2 and add one. (2’s complement)

4. Convert the lower one byte data of the result of step 3 into ASCII characters.
Example: 75h→37h, 35h
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■ Conversion Type
After calculating the data using the specified calculation type, select the type of conversion for the data from the 
following.

■ Number of bytes
After converting according to the specifed conversion type, select 1 or 2 for the number of bytes for transmission 
data.

Example: BCC for transmission command data
This example describes the case of transmitting the BCC calculation result from the following transmission data as 
BCC data.

• Calculation Start Position and Calculation End Position
When Calculation Start Position is 2 and Calculation End Position is 1: Calculates the range 1234.

• Calculation Type

• Conversion Type
When the BCC calculation result is 0004h, the converted data is as follows.

Modbus RTU (CRC): CRC-16 (Generating polynomial:x16+x15+x2+1) is calculated according to the following 
procedure. Conversion Type: No conversion, Number of bytes: 2

1. Obtain an exclusive OR (XOR) of 1 byte data at Calculation Start Position and FFFFh.

2. If the least significant bit of the result of step 1 is 0, shift to the right by one bit. If the 
bit is 1, shift to the right by 1 bit and obtain XOR of the result and the value (A001h).

3. Repeat step 2 to shift 8 times.

4. Obtain XOR of the next one byte of data and the result of step 3.

5. Repeat steps 2 through 4 until the data at Calculation End Position is processed.

6. Send the result of step 5 in the order of the lower byte and upper byte.
Example: 1234h→34h, 12h

Hexadecimal to ASCII： Considers the data as binary-coded hexadecimal number and converts it to ASCII data.

No conversion: No conversion is performed.

XOR: 31h^32h^33h^34h^=04h

ADD: 31h+32h+33h+34h=CAh

ADD (2's Complement): Inverts the bit of CAh+1=36h

Modbus ASCII (LCR): 100h-(12h+34h) = BAh

Modbus RTU (CRC): BA30h → BAh, 30h

1
(31h)

4
(34h)

5
(35h)

2
(32h)

STX
(02h)

3
(33h)

BCC CR
(0Dh)

1
(31h)

4
(34h)

5
(35h)

2
(32h)

STX
(02h)

3
(33h)

BCC CR
(0Dh)

(1) (2) (3) (4) (5) (6)Calculation Start Position:

(5) (4) (3) (2) (1) (0)Calculation End Position:

Data used for BCC calculation

0004h

Hexadecimal to ASCII

0
(30h)

Data
4

(34h)

0004h

No conversion

00h
Data

04h
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• Bytes and BCC data
When the converted data is 3034h, the data appended to the transmission data is as follows.

• When Calculation Type is Modbus ASCII (LCR)
When the BCC calculation result is 4241h after Hexadecimal to ASCII conversion the resulting two bytes of 
data is appended to the transmission data. 

• When Calculation Type is Modbus RTU (CRC)
When the BCC calculation result is BA30h with no conversion the two bytes of data is appended to the 
transmission data.

0
(30h)

4
(34h)

1 byte

BCC data(Second byte)  (First byte)
Converted data

4
(34h)

0
(30h)

4
(34h)

BCC data

0
(30h)

4
(34h)

2 bytes

Converted data
(Second byte)  (First byte)

B
(42h)

A
(41h)

B
(42h)

A
(41h)

BCC data

4241h

Hexadecimal to ASCII

Data 

2 bytes

Converted data
(Second byte)  (First byte)

BAh 30h BAh 30hBA30h

No conversion

BCC dataData 

2 bytes

Converted data
(Second byte)  (First byte)
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● Receive (RXD) Command

Constant (Character)

The received data is considered as character data and compared with the data specified without being converted.
This can be configured only when RXD is selected as Type on the Command Settings dialog box, and Constant 
(Character) is selected under Type on the Data Settings dialog box.

■ Data
Enter character data designated to be received (1 to 1,500 bytes). The size of a single-byte character is one byte and 
that of a double-byte character is two bytes.

Example: Constant (Character) for receive command data

When the trigger condition is satisfied, the received data is compared with the following data.

When a Constant (Character) is set at the beginning of a command, the first one byte is recognized as the 
start code. When a Constant (Character) is set at the end of a command, the last one byte is recognized as 
the terminal code.
For details, refer to “Start Code and Terminal Code” on page 3-78.

Item Setting

Data 1234

1234 1
(31h)

Data used for comparison with received data
Specified data

2
(32h)

3
(33h)

4
(34h)

Order of reception

No 
conversion
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Constant (Hexadecimal)

The received data is considered as hexadecimal data and compared with the data specified without being converted.
Use this setting to receive a control code of ASCII data (00h to 1Fh).
This can be configured only when RXD is selected as Type on the Command Settings dialog box, and Constant 
(Hexadecimal) is selected under Type on the Data Settings dialog box.

■ Data
Enter hexadecimal data designated to be received (1 to 1,500 bytes).

Example: Constant (Hexadecimal) for receive command data

When the trigger condition is satisfied, the received data is compared with the following data.

When a Constant (Character) is set at the beginning of a command, the first one byte is recognized as the 
start code. When a Constant (Character) is set at the end of a command, the last one byte is recognized as 
the terminal code.
For details, refer to “Start Code and Terminal Code” on page 3-78.

Item Setting

Data 1234

1234h
No conversion

12h

Data used for comparison with received data
Specified data

34h

Order of reception
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Device Address

From the received data, data of the specified size is unconverted, or converted to binary format, and stored in the 
device.
This can be configured only when RXD is selected as Type on the Command Settings dialog box, and Device 
Address is selected under Type on the Data Settings dialog box.

■ Conversion Type
Select conversion processing for the received data from the following.

■ Device Address
Specify the word device for storing the received data. You can only specify an internal device.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.

■ Use Reference Device Address
To change the word device for storing the received data according to values of device addresses, select this check box 
and specify a device address. You can only specify an internal device.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.

■ Storage Method of data
Select the handling method for received data. This can be configured only when No conversion is selected under 
Conversion Type.

■ Number of bytes
Specify the received data size to be stored per word. The number of bytes to be specified varies based on 
Conversion Type.

■ Words
Specify the number of word devices (1 to 250) for storing the received data.

ASCII to Hexadecimal: Considers the received data as a hexadecimal number and converts it to binary data.

ASCII to Decimal: Considers the received data as a decimal number and converts it to binary data.

No conversion: No conversion is performed.

from Upper byte: Values of device addresses are stored from the upper byte.

from Lower byte: Values of device addresses are stored from the lower byte.

ASCII to Hexadecimal: 1 to 4

ASCII to Decimal: 1 to 5

No conversion: 1 to 2
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■ Variable
Select this check box to store data up to either Constant (Character) data, or Constant (Hexadecimal) data from 
the beginning of the received data in a device. Stores data of the size specified under Words.
When the stored data is smaller than the size specified under Words, the values of all remaining devices will stored 0.

When the check box is not selected, the amount of data (bytes) stored is Number of bytes x Number of words.

Examples: Device address for receive command data

Example 1

When the trigger condition is satisfied, the received data is stored in device addresses in the following order.

Example 2

When the trigger condition is satisfied, the received data is stored in device addresses in the following order.

3231hLDR100:
3433hLDR101:
0000hLDR102:

1
(31h)

Value of Device Address
2

(32h)

3
(33h)

4
(34h)

Number of specified words: 3Number of words for stored data: 2

The stored data is smaller than the size specified for Words.

No 
conversion

Stored data

Insufficient by 1 word
0 is stored.

When the Variable check box is selected, observe the following points.
• When data is set expect for the end of a command, set Constant (Character) data or Constant 

(Hexadecimal) data following Device Address data.
• When there is no data stored in the device address, all of the values of device addresses specified under 

Words will be 0.
• The maximum amount of the received data stored in the device address is Number of bytes x Number of 

words. 

Item Setting

Conversion Type No conversion

Device Address LDR100

Use Reference Device Address OFF

Storage Method of data from Upper byte

Number of bytes 1

Words 3

Variable OFF

Item Setting

Conversion Type No conversion

Device Address LDR100

Use Reference Device Address OFF

Storage Method of data from Lower byte

Number of bytes 2

Words 2

Variable OFF

3100hLDR100:
3200hLDR101:
3300hLDR102:

No conversion

1
(31h)

Upper Lower
Value of Device Address

0
(00h)

2
(32h)

0
(00h)

3
(33h)

0
(00h)

Received data

1
(31h)

2
(32h)

3
(33h)

Order of reception

Words: 3from Upper byte 
1 byte

from Lower byte 
2 bytes

3231hLDR100:
3433hLDR101:

No conversion

2
(32h)

Upper Lower
Value of Device Address

1
(31h)

4
(34h)

3
(33h)

Received data

1
(31h)

2
(32h)

3
(33h)

4
(34h)

Order of reception

Words: 2
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Example 3

When the trigger condition is satisfied, the received data is stored in device addresses in the following order.

Example 4

When the trigger condition is satisfied, the received data is stored in device addresses in the following order.

Example 5

When the trigger condition is satisfied, the received data is stored in device addresses in the following order.
Data from the beginning of the received data to Constant (Hexadecimal) data is stored in the device address. 
Constant (Hexadecimal) data is not stored.

Item Setting

Conversion Type ASCII to Hexadecimal

Device Address LDR100

Use Reference Device Address OFF

Number of bytes 2

Words 2

Variable OFF

Item Setting

Conversion Type ASCII to Decimal

Device Address LDR100

Use Reference Device Address OFF

Number of bytes 2

Words 2

Variable OFF

Item Setting

Conversion Type No conversion

Device Address LDR100

Use Reference Device Address OFF

Storage Method of data from Upper byte

Number of bytes 1

Words 3

Variable ON

0012hLDR100:
0034hLDR101:

ASCII to Hexadecimal

2
(32h)

Value of Device Address
1

(31h)

4
(34h)

3
(33h)

Received data

1
(31h)

2
(32h)

3
(33h)

4
(34h)

Order of reception

Words: 2
2 bytes

12LDR100:
34

(DEC)
(DEC)LDR101:

ASCII to Decimal

2
(32h)

Value of Device Address
1

(31h)

4
(34h)

3
(33h)

1
(31h)

2
(32h)

3
(33h)

4
(34h)

Order of reception

Words: 2

Received data

2 bytes

3100hLDR100:
3300hLDR101:
0000hLDR102:

1
(31h)

Value of Device Address

The stored data is smaller than the 
size specified for Words.

0 is stored.

NUL
(00h)

3
(33h)

NUL
(00h)

1
(31h)

3
(33h)

ETX
(03h)

Order of reception

Words: 3

Received data

Upper Lower

from Upper byte 
1 byte

Constant (Hexadecimal) data

Constant (Character) data
0 is stored.

Stored data
No 

conversion

Insufficient by 1 word
0 is stored.
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Example 6

When the trigger condition is satisfied, the received data is stored in device addresses in the following order.
Data from the beginning of the received data to Constant (Hexadecimal) data is stored in the device address. 
Constant (Hexadecimal) data is not stored.

Example 7

When the trigger condition is satisfied, the received data is stored in device addresses in the following order.
Data from the beginning of the received data to Constant (Hexadecimal) data is stored in the device address. 
Constant (Hexadecimal) data is not stored.

Item Setting

Conversion Type No conversion

Device Address LDR100

Use Reference Device Address OFF

Storage Method of data from Lower byte

Number of bytes 2

Words 3

Variable ON

Item Setting

Conversion Type ASCII to Hexadecimal

Device Address LDR100

Use Reference Device Address OFF

Number of bytes 1

Words 3

Variable ON

3231hLDR100:
0033hLDR101:
0000hLDR102:

1
(31h)

Value of Device Address
2

(32h)

3
(33h)

NUL
(00h)

1
(31h)

2
(32h)

3
(33h)

ETX
(03h)

Order of reception

Words: 3

Received data

Upper Lower

from Lower byte 
2 bytes

Constant (Hexadecimal) dataStored data
No 

conversion

Constant (Character) data
0 is stored.

The stored data is smaller than the 
size specified for Words.

Insufficient by 1 word
0 is stored.

0001hLDR100:
0003hLDR101:
0000hLDR102:

ASCII to Hexadecimal
Value of Device Address

1
(31h)

3
(33h)

3
(33h)

1
(31h)

ETX
(03h)

Order of reception

Words: 3

The stored data is smaller than the 
size specified for Words.

1 byte

Received data
Constant (Hexadecimal) dataStored data

Insufficient by 1 word
0 is stored.
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Example 8

When the trigger condition is satisfied, the received data is stored in device addresses in the following order.
Data from the beginning of the received data to Constant (Hexadecimal) data is stored in the device address. 
Constant (Hexadecimal) data is not stored.

Example 9

When the trigger condition is satisfied, the received data is stored in device addresses in the following order.
When the LDR200 value is 2

Item Setting

Conversion Type ASCII to Decimal

Device Address LDR100

Use Reference Device Address OFF

Number of bytes 2

Words 3

Variable ON

Item Setting

Conversion Type No conversion

Device Address LDR100

Use Reference Device Address ON, Device Address: LDR200

Storage Method of data from Upper byte

Words 2

Variable OFF

LDR100:
LDR101:
LDR102:

2
(32h)

Value of Device Address
1

(31h)

3
(33h)

NUL
(00h)

1
(31h)

2
(32h)

3
(33h)

ETX
(03h)

Words: 3
12
3

(DEC)
(DEC)

0

ASCII to Decimal

(DEC)

2 bytes

Received data
Constant (Hexadecimal) dataStored data

Order of reception

Constant (Character) data
0 is stored.

The stored data is smaller than the 
size specified for Words.

Insufficient by 1 word
0 is stored.

0000hLDR100:
0000hLDR101:
3132hLDR102:
3334hLDR103:

No conversion

1
(31h)

Upper  Lower

Value of Device Address

2
(32h)

3
(33h)

4
(34h)

Received data

1
(31h)

2
(32h)

3
(33h)

4
(34h)

Order of reception

LDR200=2

Words: 2Bytes: 2
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Registering Constant (Character)

The received data is compared with the registered character data and the number of the matching character data is 
stored in the device address.
This can be configured only when RXD is selected as Type on the Command Settings dialog box, and Registering 
Constant (Character) is selected under Type on the Data Settings dialog box.

■ Number of Registering Constants
Specify the number of data of the registered character data (1 to 100).

■ Registering Constants

■ Index
Specify the Index No. (0 to 65535) of the character data.

■ Data
Enter the character data (1 to 1500 bytes) to be registered. The size of a single-byte character is one byte and that of 
a double-byte character is two bytes.
The character data of different size or the same data with a different number cannot be registered.

■ Set
Register the Index and Data settings to the list. When a number that is already registered is selected, it is 
overwritten with the new setting.

■ Insert
Insert a character data setting to the selected number in the list.
Click this button to insert the Index and Data setting. The settings at the insertion point shift down 1 line. Settings 
cannot be inserted when all numbers are already set.

■ Delete
Delete the selected settings from the list.

■ Index Device Address
Specify the word device for storing the Index No. of the character data matching the received data. You can only 
specify an internal device.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.

No.: Shows the ID No. (1 to 100) of the character data.

Index: Shows the Index No. of the character data.

Data: Shows the character data.
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Example: Registering Constant (Character) for receive command data

When the trigger condition is satisfied, the received data is compared with the registered data, and the value of the 
Index No. 2 of the matching data is stored in Index Device Address LDR100.

Item Setting

Number of Registering Constants 3

Registering Constants

Index No. 1: 123

Index No. 2: 456

Index No. 3: 789

Index Device Address LDR100

Received data

Compare

4
(34h)

5
(35h)

6
(36h)

Order of reception

2LDR100:
Value of the Index Device Address1231:

4562:
7893:

DataIndex No.

Number of 
Registering 

Constants: 3

(DEC)
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Registering Constant (Hexadecimal)

The received data is compared with the registered hexadecimal data and the number of the matching hexadecimal 
data is stored in the device address.
This can be configured only when RXD is selected as Type on the Command Settings dialog box, and Registering 
Constant (Hexadecimal) is selected under Type on the Data Settings dialog box.

■ Number of Registering Constants
Specify the number of data of the registered hexadecimal data (1 to 100).

■ Registering Constants

■ Index
Specify the Index No. (0 to 65535) of the hexadecimal data.

■ Data
Enter the hexadecimal data (1 to 1500 bytes) to be registered.
The hexadecimal data of different size or the same data with a different number cannot be registered.

■ Set
Register the Index and Data settings to the list. When a number that is already registered is selected, it is 
overwritten with the new setting.

■ Insert
Insert a hexadecimal data setting to the selected number in the list.
Click this button to insert the Index and Data setting. The settings at the insertion point shift down 1 line. Settings 
cannot be inserted when all numbers are already set.

■ Delete
Delete the selected settings from the list.

■ Index Device Address
Specify the word device for storing the Index No. of the hexadecimal data matching the received data. You can only 
specify an internal device.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.

No.: Shows the ID No. (1 to 100) of the hexadecimal data.

Index: Shows the Index No. of the hexadecimal data.

Data: Shows the hexadecimal data.
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Example: Registering Constant (Hexadecimal) for receive command data

When the trigger condition is satisfied, the received data is compared with the registered hexadecimal data, and the 
value of the Index No. 2 of the matching data is stored in Index Device Address LDR100.
When the LDR100 value is 3

Example of applying Registering Constant
When the same device address is specified for the Index Device Address for Registering Constant (Character) 
data or Registering Constant (Hexadecimal) data and for Use Reference Device Address for Device 
Address data, the data storage destination for each unit of received data can be changed.

When the following commands are received

• The first 1 byte is taken as the start code. Constant (Hexadecimal) data is not stored.

• The received data is compared with the registered data, and the value of the Index No. 2 (Dec) of the matching 
data is stored in Index Device Address LDR100.

Item Setting

Number of Registering Constants 3

Registering Constants

Index No. 1: 1234

Index No. 2: 5678

Index No. 3: 2537

Index Device Address LDR100

Received data

Compare

25h 37h

Order of reception

3LDR100:
Value of the Index Device Address1234h

5678h
2537h

1:
2:
3:

DataIndex No.

Number of 
Registering 

Constants: 3

(DEC)

Data type Item Setting

Constant (Hexadecimal) Data 02

Registering Constant (Character)

Number of Registering Constants 2

Registering Constant
Index No. 1: AA

Index No. 2: BB

Index Device Address LDR100

Device Address

Conversion Type No conversion

Device Address LDR100

Use Reference Device Address ON, Device Address: LDR200

Storage Method for Data from Upper byte

Bytes 2

Words 2

Variable OFF

Constant (Hexadecimal) Data 0D

STX
(02h)

B
(42h)

B
(42h)

1
(31h)

2
(32h)

CR
(0Dh)

STX
(02h)

Received data

Compare

B
(42h)

B
(42h)

Order of reception

2LDR100:
Value of the Index Device AddressAA

BB
1:
2:

DataIndex No.
Number of 
Registering 

Constants: 2
(DEC)
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• Since the Indirect Device Address LDR100 of Device Address of the receive command data is 2 (Dec), the data is 
stored in the device address LDR202, which is offset by +2.

• The last 1 byte is taken as the terminal code. Constant (Hexadecimal) data is not stored.

0000hLDR200:
0000hLDR201:
3132hLDR202:

Value of Device Address

LDR100=2

CR
(0Dh)
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BCC (Block Check Code)

The BCC comparison data is automatically calculated from the receive data and compared with the BCC part of the 
receive data.
This can be configured only when RXD is selected as Type on the Command Settings dialog box, and BCC is selected 
under Type on the Data Settings dialog box.

■ Calculation Start Position
Specify the position (1 to 15) in the receive data where BCC calculation starts. The position is counted backwards, 
with the first position of the receive data taken as 1.

■ Calculation End Position
Specify the position (0 to 15) in the receive data where BCC calculation ends. The position is counted forwards, with 
the data position before the BCC taken as 0.

■ Calculation Type
Select the method to calculate the data between the Calculation Start Position and Calculation End Position.

1
(31h)

4
(34h)

5
(35h)

2
(32h)

STX
(02h)

3
(33h)

BCC CR
(0Dh)

(1) (2) (3) (4) (5) (6)Calculation Start Position:

Receive data:

1
(31h)

4
(34h)

5
(35h)

2
(32h)

STX
(02h)

3
(33h)

BCC CR
(0Dh)

(5) (4) (3) (2) (1) (0)Calculation End Position:

Receive data:

XOR: Calculates the data with exclusive logical add.

ADD: Calculates the data using addition.

ADD (2's Complement): Calculates the data using addition, inverts the bit and adds one.

Modbus ASCII (LCR): Calculation is performed according to the following procedure. Conversion Type:
Hexadecimal to ASCII, Number of bytes: 2

1. Convert the ASCII characters between Calculation Start Position and Calculation End 
Position into 1-byte hexadecimal data for each set of two characters. 
Example: 37h, 35h → 75h

2. Calculate the sum of the data obtained in step 1.

3. Invert the bit of the result of step 2 and add one. (2’s complement)

4. Convert the lower one byte data of the result of step 3 into ASCII characters.
Example: 75h → 37h, 35h
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After calculating the data using the specified calculation type, select the type of conversion for the data from the 
following.

■ Number of bytes
After converting according to the specified conversion type, select 1 or 2 for the number of bytes for comparison 
data.

Example: BCC for receive command data
This example describes the case of comparing the BCC calculation result for the following receive data with the BCC 
part of the receive data.

• Calculation Start Position and Calculation End Position
When Calculation Start Position is 2 and Calculation End Position is 1: Calculates the range 1234.

• Calculation Type

• Conversion Type
When the BCC calculation result is 0004h, the converted data is as follows.

Modbus RTU (CRC): CRC-16 (Generating polynomial:x16+x15+x2+1) is calculated according to the following 
procedure. Conversion Type: No conversion, Number of bytes: 2

1. Obtain an exclusive OR (XOR) of 1 byte data at Calculation Start Position and FFFFh.

2. If the least significant bit of the result of step 1 is 0, shift to the right by one bit. If the 
bit is 1, shift to the right by 1 bit and obtain XOR of the result and the value (A001h).

3. Repeat step 2 to shift 8 times.

4. Obtain XOR of the next one byte of data and the result of step 3.

5. Repeat steps 2 through 4 until the data at Calculation End Position is processed.

6. Compare the result of step 5 in the order of the lower byte and upper byte.
Example: 1234h → 34h, 12h

Hexadecimal to ASCII: Considers the data as binary-coded hexadecimal number and converts it to ASCII data.

No conversion: No conversion is performed.

XOR: 31h^32h^33h^34h^=04h

ADD: 31h+32h+33h+34h=CAh

ADD (2's Complement): Inverts the bit of CAh+1=36h

Modbus ASCII (LCR): BA→42h, 41h

Modbus RTU (CRC): BA30h→BAh, 30h

1
(31h)

4
(34h)

5
(35h)

2
(32h)

STX
(02h)

3
(33h)

BCC CR
(0Dh)

1
(31h)

4
(34h)

5
(35h)

2
(32h)

STX
(02h)

3
(33h)

BCC CR
(0Dh)

(1) (2) (3) (4) (5) (6)Calculation Start Position:

(5) (4) (3) (2) (1) (0)Calculation End Position:

Data used for BCC calculation

0004h

Hexadecimal to ASCII

0
(30h)

Data
4

(34h)

0004h

No conversion

00h
Data

04h
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• Number of bytes and comparison data
When the converted data is 3034h, the data used for comparison with the BCC part of the receive data is as 
follows.

• BCC data comparison
The comparison data is compared with the BCC part of the receive data.
In the following receive data, when the comparison data is the 1-byte 34h, there is a match since the BCC part data 
is 34h.
When there is no match, the BCC Error (address number+0, bit 0) of the Status Device changes to 1.

• When the calculation type is Modbus ASCII (LCR)
When the BCC calculation result is 4241h after Hexadecimal to ASCII conversion the resulting two bytes of 
data is used for comparison with the BCC part of the receive data.

• When the calculation type is Modbus RTU (CRC)
When the BCC calculation result is BA30h with no conversion the two bytes of data is used for comparison with 
the BCC part of the receive data.

0
(30h)

4
(34h)

Comparison data

4
(34h)

Bytes: 1

Converted data
(Second byte)  (First byte)

0
(30h)

4
(34h)

0
(30h)

4
(34h)

Comparison data

Bytes: 2

Converted data
(Second byte)  (First byte)

1
(31h)

4
(34h)

5
(35h)

2
(32h)

STX
(02h)

3
(33h)

BCC
(34h)

CR
(0Dh)

Comparison data

Match

Receive data BCC part

4
(34h)

B
(42h)

A
(41h)

B
(42h)

A
(41h)

Comparison data

4241h

Hexadecimal to ASCII

Data

Bytes: 2

Converted data
(Second byte) (First byte)

BAh 30h BAh 30hBA30h
No conversion

Comparison data
Data

Bytes: 2

Converted data
(Second byte) (First byte)
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Skip

The data with the specified number of bytes in the receive data will be ignored.
This can be configured only when RXD is selected as Type on the Command Settings dialog box, and Skip is 
selected under Type on the Data Settings dialog box.

■ Number of bytes
Specify the number of bytes (1 to 249) of receive data to be ignored.

Example: Skip for receive command data 

In the received four byte data (1 (31h), 2 (32h), 3 (33h), 4 (34h)), only the data for 3 (33h) and 4 (34h) is received 
and the two bytes of 1 (31h) and 2 (32h) are discarded.

Item Setting

Number of bytes 2

Enabled data

4
(34h)

3
(33h)

2 bytes
(Ignored)

Received data

1
(31h)

2
(32h)

3
(33h)

4
(34h)

Order of reception
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● Start Code and Terminal Code
A start code starts data reception and a terminal code judges the terminal of data reception. A start code and a 
terminal code can be configured for either Constant (Character) or Constant (Hexadecimal) settings for receive 
command. The first 1 byte of the constant is recognized as the start code and the last 1 byte as the terminal code.

Code 00h to 7Fh can be set when Data Length under Interface Settings is 7 bits, and 00h to FFh when the data length 
is 8 bits. Data Length is configured under the Communication Interface tab on the Project Settings dialog box.
The procedure for terminal of data reception varies whether or not the receive data contains a start code and a 
terminal code, and whether the Variable check box for Device Address for receive command data is selected.
In the following description, With Variable indicates that the Variable check box for Device Address for receive 
command data is selected and Without Variable indicates that the Variable check box is not selected. Also, when 
there are multiple Device Address set for receive command data, and at least 1 command has the Variable check 
box selected, this corresponds to With Variable.

Start code Terminal 
code Variable Description of the procedure for terminal of data reception

Set Set
Set

Not set

Reception is started with the start code and terminated with the terminal code.

When the terminal code is followed by BCC, the data including the number of bytes of 
BCC is received.

Set Not set

Set

Reception is started with the start code and the data is received according to the 
maximum command length.

Reception is terminated when the Receiving Character Time Out occurs.

Not set

Reception is started with the start code and the data is received according to the length of 
the command.

'02' '31' '32' '33' <[LDR0100] N 2 2 U>Receive data:

Constant
(Hexadecimal)

'34' '35' '0d'

Constant
(Hexadecimal)Device AddressCommand settings:

Start code 02h Terminal code 0dh

'02' '31' '32' '33' <[LDR0100] N 2 2 U>Receive data: '34' '35' '0d'
Device Address

Receive

Constant
(Hexadecimal)

Constant
(Hexadecimal)Command settings:

Start code 02h Terminal code 0dh

'02' '31' '32' '33' <[LDR0100] N 2 2 U>Receive data: '34' '35' '0d' BCC(1 0 XOR N 1)
BCCDevice Address

Receive

Constant
(Hexadecimal)

Constant
(Hexadecimal)Command settings:

Start code 02h Terminal code 0dh

'02' '31' '32' <[LDR0100] N 2V 2 U>Receive data:

Constant
(Hexadecimal)

<<1:”AB” 2:”CD” [LDR0200]>>
Registering Constant (Hexadecimal)Device Address With Variable

Maximum command length

Receive

Command settings:

Start code 02h Terminal code: None

'02' '31' '32' <[LDR0100] N 2V 2 U>Receive data:

Constant
(Hexadecimal)

'03' <<1:”AB” 2:”CD” [LDR0200]>>

Constant
(Hexadecimal)

Registering Constant
(Hexadecimal)

Device Address
With Variable

Receive

Command settings:

Start code 02h Terminal code: NoneReceiving character 
time out occurs.

'02' '31' '32' <[LDR0100] N 2 2 U>Receive data:

Constant
(Hexadecimal)

<<1:”AB” 2:”CD” [LDR0200]>>

Registering
Constant (Hexadecimal)Device Address Without Variable

Command length

Receive

Command settings:

Start code 02h Terminal code: None
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Not set Set
Set

Not set

Reception is started from the beginning and terminated with the terminal code.

Not set Not set

Set

Reception is started from the beginning and the data is received according to the 
maximum command length.

Reception is terminated when the Receiving Character Time Out occurs.

Not set

Reception is started from the beginning and terminated when the data is received 
according to the length of the command.

Start code Terminal 
code Variable Description of the procedure for terminal of data reception

<[LDR0100] N 2 2 U>Receive data: <<1:”AB” 2:”CD” [LDR0200]>>

Registering
Constant (Hexadecimal) Device Address

'34' '35' '0d'

Constant
(Hexadecimal)

Receive

Command settings:

Start code: None Terminal code 0dh

Skip(2) <[LDR0100] N 2V 2 U>Receive data:

Skip

“123” 
Device Address With Variable

Maximum command length

Receive

Command settings:
Constant 

(Character)

Start code: None Terminal code: None

Skip(2) <[LDR0100] N 2V 2 U>Receive data:

Skip

“123” 

Constant 
(Character) Device Address With Variable

Receive

Command settings:

Start code: None Terminal code: None

Receiving character time out occurs.

<[LDR0100] N 2 2 U>Receive data: <<1:”AB” 2:”CD” [LDR0200]>>
Registering Constant (Hexadecimal)Device Address Without Variable

Command length

Receive

BCC(1 0 XOR N 1)
BCCCommand settings:

Start code: None Terminal code: None

• When trigger conditions are satisfied for two or more receive commands for which both start code and 
terminal code are set, all commands are analyzed and processed for receive processing. Since 
commands with and without errors may be mixed depending on the results of data reception analysis of 
each command, take extra caution regarding error handling.

• While the trigger condition is satisfied for a receive command for which either a start code or terminal 
code is not set, only this command is processed for data reception when the trigger condition of another 
command is being satisfied. When two or more commands exist for which either start code or terminal 
code is not set, the command with the biggest number for managing the protocol is processed.

• When a start code of the receive command for which a start code is set cannot be received, all of the 
receive data is ignored and abandoned. No error occurs.

• When start code is received with a receive command for which start code and terminal code are set, the 
data reception is completed after the maximum number of bytes received in case of continuous 
reception of data that does not match the terminal code of all receive command in which the trigger 
conditions is satisfied.
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5.4 Example of User Communication Settings

This section describes examples of user communication settings and command operations.

● Example 1
This section describes an example of user communication protocol settings for creating the following commands and 
command operations.
• Transmission command for transmitting data using Constant (Hexadecimal), Constant (Character), Device Address, 

Constant (Hexadecimal) command settings when the trigger condition device address changes to 1 
• Receive command for receiving, processing, and storing data in device addresses, using Constant (Hexadecimal), 

Constant (Character), Device Address, Constant (Hexadecimal) command settings, for data transmitted from an 
external device, when the trigger condition device address is 1

■ Settings in the User Communication tab on the Project Settings dialog box

Transmission command: Command Settings dialog box settings

Operation for transmission command

1 Write a value of 100 (Dec) to LDR100 of transmission command data Device Address.

2 Change the trigger condition LM100 from 0 to 1 to start command transmission.

After the transmission wait duration (five seconds), the transmission data is sent. The transmission data is as follows.

• When data transmission is successfully completed, the Completed Device Address LM101 changes to 1.
• When the value of each bit of address number+0 for Status Device Address LDR110 is 0, transmission is completed 

without an error.

Item Setting

Protocol Name Sample 1

Receiving Character Time Out 30 (×100 msec)

Item Setting

Type TXD

Trigger Condition Rising-edge, Device Address: LM100

Completed Device Address LM101

Status Device Address LDR110

Transmission Wait 50 (×100 msec)

Comment TXD command

Command
Data Settings dialog box settings

Constant 
(Hexadecimal)

'05'

Constant 
(Character)

"D"

Device Address
Conversion Type: Decimal to ASCII, 
Number of bytes: 4, Words: 1
Device Address: LDR100

Constant 
(Hexadecimal)

'0D'

D
(44h)

0
(30h)

0
(30h)

0
(30h)

EQN
(05h)

1
(31h)

CR
(0Dh)

Transmission data:

Constant
(Hexadecimal)

Constant 
(Character) Device Address

Command settings:

Constant
(Hexadecimal)
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Receive command: Command Settings dialog box settings

Operation for receive command

1 When data transmission of the transmission command is completed, the value of LM101 changes to 1, and since the 
same device address is specified for the trigger condition user communication becomes ready for receiving.

2 Data is transmitted from the external device and the transmitted data is received and processed.

The receive data is as follows.

Since a value of 100 is written to LDR100 at the time of transmission, the data is stored in device address LDR220, 
which corresponds to an offset of +100 from LDR120.

• When data reception is successfully completed, the Completed Device Address LM102 changes to 1.
• When the value of each bit of address+0 of Status Device Address LDR130 is 0, reception is completed without an 

error.

Item Setting

Type RXD

Trigger Condition While ON, Device Address: LM101

Completed Device Address LM102

Not Clear Completed Device Address 
automatically

No

Status Device Address LDR130

Receiving Time Out 0 (No Receive Time Out)

Comment RXD command

Command
Data Settings dialog box settings

Constant 
(Hexadecimal)

'02'

Constant 
(Character)

"D"

Device Address
Conversion Type: ASCII to Hexadecimal, 
Number of bytes: 4, Words: 1
Device Address: LDR120, Reference Device Address: LDR100

Constant 
(Hexadecimal)

'0D'

D
(44h)

3
(33h)

4
(34h)

1
(31h)

STX
(02h)

2
(32h)

CR
(0Dh)

Receive data:

Constant
(Hexadecimal)

Constant 
(Character) Device Address

Command settings:

Constant
(Hexadecimal)

0000LDR120:
0000LDR121:

1234hLDR220:

Value of Device Address

LDR230=100
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● Example 2
This section describes an example of user communication protocol settings for creating the following commands and 
command operations.
• Transmission command for transmitting data using Constant (Hexadecimal), Registering Constant (Character), 

Device Address, BCC, Constant (Hexadecimal) command settings when the trigger condition device address 
changes to 1

• Receive command for receiving, processing, and storing data in device addresses, using Constant (Hexadecimal), 
Registering Constant (Character), Skip, Device Address, BCC, Constant (Hexadecimal) command settings, for data 
transmitted from an external device, when the trigger condition device address is 1

■ Settings in the User Communication tab on the Project Settings dialog box

Transmission command: Command Settings dialog box settings

Operation for transmission command

1 Write a value of 10 (Dec) to LDR200 for Registering Constant (Character) for transmission command data.
AB is selected.

2 Write a value of 3132h to LDR210 and 3334h to LDR211 for Device Address for transmission command data.

3 Change the value of the trigger condition LM200 from 0 to 1 to send the command.
The transmission data is as follows.

• When data transmission is successfully completed, the Completed Device Address LM201 changes to 1.
• When the value of each bit of address number+0 for Status Device Address LDR220 is 0, transmission is completed 

without an error.

Item Setting

Protocol Name Sample 2

Receiving Character Time Out 30 (×100 msec)

Item Setting

Type TXD

Trigger Condition Rising-edge, LM200

Completed Device Address LM201

Status Device Address LDR220

Transmission Wait 0 (×100 msec)

Comment TXD command

Command
Data Settings dialog box settings

Constant 
(Hexadecimal) '05'

Registering 
Constant 
(Character)

10: "AB", 20: "CD", Index Device Address: LDR200

Device Address No conversion, from Upper byte, Number of bytes: 2, 
Words: 2, Device Address: LDR210

BCC Start Calculation Position: 1, End Calculation Position: 0, 
XOR, Hexadecimal to ASCII, 2 bytes

Constant 
(Hexadecimal) '0D''0A'

AB10:
CD20: Index Device Address

LDR200=10

DataIndex No.

Number of Registering Constants: 2

Transmission data

A
(41h)

B
(42h)

Order of transmission

3
(33h)

4
(34h)

1
(31h)

EQN
(05h)

2
(32h)

CR
(0Dh)

LF
(0Ah)

A
(41h)

B
(42h)

0
(30h)

2
(32h)

BCC

Transmission data:

Constant
(Hexadecimal)

Registering 
Constant (Character) Device Address

Command settings:

Constant
(Hexadecimal)
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Receive command: Command Settings dialog box settings

Operation for receive command

1 Change the trigger condition LM202 from 0 to 1 to be ready for receiving user communication.

2 Data is transmitted from the external device and the transmitted data is received and processed.
The receive data is as follows.

• The receive data is compared with the character data, and the value of the matching Index No. (10 (Dec)) is stored 
in Index Device Address LDR230.

• The 2 bytes (specified with Skip) of the receive command data 43h and 44h are ignored.
• Since the Reference Device Address LDR 230 of Device Address of the receive command data is 10 (Dec), the 

data is stored in the device address LDR250 and LDR251, which is offset by +10.

• [STX] ABCD1234 is calculated with BCC of receive command data and compared with 3032h.
- When Calculation Start Position is 1 and Calculation End Position is 0: Calculates the range STX ABCD1234.

Item Setting
Type RXD
Trigger Condition While ON, Device Address: LM202
Completed Device Address LM203
Not Clear Completed Device 
Address automatically

No

Status Device Address LDR260
Receiving Time Out 0 (No Receive Time Out)
Comment RXD command

Command
Data Settings dialog box 
settings

Constant 
(Hexadecimal) '02'

Registering 
Constant 
(Character)

10: "AB", 20: "CD", Index Device Address: LDR230

Skip 2 bytes

Device Address
Conversion Type: No conversion, from Upper byte, 
Number of bytes: 2, Words: 2
Device Address: LDR240, Reference Device Address: LDR230

BCC Calculation Start Position: 1 Calculation End Position: 0, XOR
Hexadecimal to ASCII, 2 bytes

Constant 
(Hexadecimal) '0D''0A'

3
(33h)

4
(34h)

1
(31h)

STX
(02h)

2
(32h)

A
(41h)

B
(42h)

C
(43h)

D
(44h)

Skip

CR
(0Dh)

LF
(0Ah)

0
(30h)

2
(32h)

BCC
Constant

(Hexadecimal) Device Address
Constant

(Hexadecimal)
Command settings:

Registering 
Constant (Character)

Receive data:

Received data

Compare

A
(41h)

B
(42h)

Order of reception

10LDR230:

Value of the Index Device Address

AB10:
CD20:

DataIndex No.
Number of

 Registering
 Constants: 2

(DEC)

0000hLDR240:
0000hLDR241:

3132hLDR250:

Value of Device Address

LDR230=10

(1) (2) (3) (4) (5) (6) (7) (8) (9)Calculation Start Position:

(5) (4) (3)(8) (7) (6) (2) (1) (0)Calculation End Position:

3
(33h)

4
(34h)

1
(31h)

STX
(02h)

2
(32h)

A
(41h)

B
(42h)

C
(43h)

D
(44h)

CR
(0Dh)

LF
(0Ah)

0
(30h)

2
(32h)

Data used for BCC calculation
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- The BCC calculation type is XOR.
02h^41h^42h^43h^44h^31h^32h^33h^34h^=02h

- When the BCC calculation result is 0002h, the converted data will be 3032h.

- When the converted data is 3032h, the data for comparison with the BCC part of the receive data will be 
3032h.

- The comparison data is compared with the BCC part of the receive data.
In the following receive data, when the comparison data is the 2-byte 3032h, there is a match since the BCC part 
data is 3032h.
When there is no match, the BCC Error (address number+0, bit 0) of Status Device Address changes to 1.

• When data reception is successfully completed, the Completed Device Address LM203 changes to 1.
• When the value of each bit of address number+0 for Status Device Address LDR250 is 0, transmission is completed 

without an error.

0002h

Hexadecimal to ASCII

0
(30h)

Data
2

(32h)

0
(30h)

2
(32h)

Comparison data

0
(30h)

2
(32h)

Bytes: 2

Converted data
(Second byte)  (First byte)

Comparison data

Match

Receive data BCC part

3
(33h)

4
(34h)

1
(31h)

STX
(02h)

2
(32h)

A
(41h)

B
(42h)

C
(43h)

D
(44h)

CR
(0Dh)

LF
(0Ah)

0
(30h)

2
(32h)

0
(30h)

2
(32h)
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● Example 3
This section describes an example of user communication protocol settings for creating the following commands and 
command operations.
Transmission command for transmitting data using Constant (Hexadecimal), Constant (Character), Constant 
(Hexadecimal), BCC, Constant (Hexadecimal) command settings when the value of the trigger condition device 
address is 1

■ Settings in the User Communication tab on the Project Settings dialog box

Transmission command: Command Settings dialog box settings

Operation for transmission command

1 When the value of Trigger Condition LSD31 is 5, press the Function Key F7 and command is transmitted in one 
hundred milliseconds intervals. 

The transmission data is as follows.

• When data transmission is successfully completed, the Completed Device Address LM301 changes to 1.
• When the value of each bit of address number+0 for Status Device Address LDR330 is 0, transmission is completed 

without an error.

Item Setting

Protocol Name Sample 3

Receiving Character Time Out - (Cannot be configured)

Inching Function Enable

Execution Interval 10 (x10 msec)

Item Setting

Type Inching

Function Key F7

Trigger Condition While satisfying the condition, LSD31==5

Completed Device Address LM301

Status Device Address LDR330

Transmission Wait - (Cannot be configured)

Comment TXD Inching command

Command
Data Settings dialog box settings

Constant 
(Hexadecimal)

'01'

Constant 
(Character)

"K"

Constant 
(Hexadecimal)

'31''01'

BCC Calculation Start Position: 1, Calculation End Position: 0, 
XOR, Hexadecimal to ASCII, 2 bytes

Constant 
(Hexadecimal)

'0D'

SOH
(01h)

CR
(0Dh)

Transmission data:

Constant
(Hexadecimal)

Command settings:

Constant
(Hexadecimal)

1
(31h)

SOH
(01h)

Constant
(Hexadecimal)

0
(30h)

2
(32h)

BCC

K
(4Bh)

Constant 
(Character) 
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5.5 Connection Diagram for User Communication

When connecting an external device to the MICRO/I via user communication, refer to the following connection diagram.

■ Serial interface 1 (RS232C)

■ Serial interface 1 (RS422/485)

■ Serial Interface 2
HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F (Terminal)
Refer to the above “Serial interface 1 (RS232C)” and “Serial interface 1 (RS422/485)” about the connection diagram 
of the Serial Interface 2 on the HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F.

Cover FG
Pin No. Name

3 SD
2 RD
7 RS
8 CS

-FG
Pin No.Name

-RD
-SD
-SG

5 SG

Shield Wire

HG5G/4G/3G/2G-V, 
HG4G/3G, HG2G-5F (Connector)External Device (RS232C)

1 SD
Pin No. Name

2 RD
3 RS
4 CS
5 SG

-FG
Pin No.Name

-RD
-SD
-SG

Shield Wire

HG5G/4G/3G/2G-V, 
HG4G/3G, HG2G-5F/-5T, HG1G (Terminal)External Device (RS232C)

Cover FG
Pin No. Name

1
RDB(RD-)6
SDA(SD+)4
SDB(SD-)9

Pin No.Name -
SDA -
SDB -
RDA -
RDB -
SG 5 SG

RDA(RD+)

Shield Wire

HG5G/4G/3G/2G-V, 
HG4G/3G, HG2G-5F (Connector)

External Device (RS422/485)

8 RDA(RD+)
Pin No. Name

9 RDB(RD-)
6 SDA(SD+)
7 SDB(SD-)
5 SG

-FG
Pin No.Name

-SDA
-SDB
-RDA
-RDB
-SG

Shield Wire
HG5G/4G/3G/2G-V, 
HG4G/3G, HG2G-5F/-5T, HG1G (Terminal)

External Device (RS422/485)

1 FG
Pin No. Name

3
RDB-/TPI-2
SDA+/TPO+5
SDB-/TPO-4

Pin No.Name
-SDA
-SDB
-RDA
-RDB
-SG 6 SG

RDA+/TPI+

Shield Wire
HG1P (Connector)

External Device (RS422/485)

There is no pin number corresponding to TERM. When you need a terminating resistor, read the Chapter 1 
"3 Important Points Regarding Wiring" in the WindO/I-NV4 External Device Setup Manual.
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6.1 Overview

Sub Host Communication is a function for communicating with an external device using the MICRO/I's HMI Link 
Registers (LLR).
The external device addresses are allocated to HMI Link Registers (LLR). When MICRO/I receives a request to read 
from or write to HMI Link Registers (LLR), it reads from or writes to the allocated external device addresses, and the 
execution results are stored in HMI Link Registers (LLR).

6.2 Supported Protocols and Communication Driver

The Sub Host communication can be used with the following protocols and communication drivers:

6 Sub Host Communication

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

Read Write

5678

External device

0 1 D1:
M1:

5678

MICRO/I

Sub Host Communication

Numerical Display
Display Device Address: LLR0

Bit Button
Destination Device Address: LLR1

1

5678

LLR0

LLR1

HMI Link Register

Allocates M1

Allocates D1

External Device Address

Protocol Communication Driver

MICROSmart
Manufacturer: IDEC
Communication driver: OpenNet,MICROSmart,SmartAXIS Pro/Lite(RS232C/485)

Modbus RTU Master
Manufacturer: Modbus
Communication driver: Modbus RTU Master

For the device addresses that can be used by each protocol, communication cable connection, and usable 
device addresses, refer to “5.5 Connection Diagram for User Communication” on page 3-86 and Chapter 2 
"Connection to a PLC" in the WindO/I-NV4 External Device Setup Manual.
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6.3 HMI Link Register (LLR) Assignment

This section describes how to allocate and the operation of HMI Link Registers (LLR) in Sub Host Communication.

● Example of HMI Link Register (LLR) Settings
Use the Device Link Communication between the external device and the MICRO/I's serial interface (COM1), and use 
the Sub Host communication between the external device and the MICRO/I's serial interface (COM2).
Allocate the following external device addresses to the HMI Link Registers (LLR).

■ Settings in the Communication Interface tab on the Project Settings dialog box

■ Settings in the Sub Host Communication tab on the Project Settings dialog box

Example: HMI Link Registers (LLR) are configured for the following parts

Interface Function

COM1 External Device Communication 1

COM2 Sub Host Communication

Item Settings

Protocol MICROSmart

Allocate Device Address HMI Link 
Register (LLR)

LLR0 0:D0100

LLR1 0:M0002

LLR2 1:D100-1

LLR3 2:D101

Display Device Address for Numerical Display LLR0
Destination Device Address for Numerical Input LLR3
Destination Device Address for Bit Button LLR1
Trigger Device Address for Pilot Lamp LLR2

2222

1234

External device

External device
(External Device ID: 0)

External device
(External Device ID: 1)

External device
(External Device ID: 2)

0 1

D100:

M2:

0 1

D100-1:

1234

D101: 2222

MICRO/I

1234

1

1

2222

LLR0

LLR1

LLR2

LLR3

HMI Link Register (LLR)

Numerical Display
Display Device Address: LLR0

Numerical Input
Destination Device Address: LLR3

Bit Button
Destination Device Address: LLR1

Pilot Lamp
Trigger Device Address: 
LLR2

Read

OFF image ON image

WriteRead Write Read Write

COM1

COM2

Don't use the frequent write operation for HMI Link Register (LLR) which is caused by a script and a word 
command. It may make the reading data operation too much slow.
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6.4 Sub Host Communication Configuration Procedure

This section describes the configuration procedure for Sub Host Communication.

● Setting Sub Host Communication for a communication interface

1 On the Configuration tab, in the System Setup group, click Project.

The Project Settings dialog box appears.

2 Click the Communication Interface tab.

3 Select the interface for Sub Host Communication under Interface Configuration, and then select the Sub Host 
Communication in Function under Interface Settings.

The Sub Host Communication tab is displayed.

*1 HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F only
*2 HG1G/1P only
*3 HG2G-5T only

Serial Interface (COM1*1, COM2*1, COM*2, or SERIAL1*3) can be used for Sub Host Communication. Two or 
more interfaces cannot be used at the same time.
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4 Configure the Interface Settings.

■ HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F
For details, refer to Chapter 4 “When COM1, COM2, COM2(RS232C), or COM2(RS422/485) is selected under Interface 
Configuration” on page 4-38.

■ HG2G-5T, HG1G/1P*1

For details, refer to Chapter 4 “When SERIAL1(RS232C), SERIAL1(RS422/485), COM(RS232C), or COM(RS422/485) is 
selected under Interface Configuration” on page 4-39.

5 Click the Sub Host Communication tab.

6 Selects the protocol as MICROSmart or Modbus RTU Master in the Protocol.

*1 This is applicable for models with a serial interface (RS422/485) only.
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7 Allocate the external device addresses to the HMI Link Registers (LLR) used with Address Number in Settings.

For details, refer to Chapter 4 “3.7 Sub Host Communication Tab” on page 4-58.

8 Click OK.

This concludes configuring Sub Host Communication for communication interfaces.
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6.5 Error Information

This setting is for monitoring all error information and for controlling Sub Host Communication.

● Monitor the error information of all Slave Numbers
The error information of all external devices communicated with using Sub Host Communication can be monitored.
This option is configured on the Sub Host Communication tab in the Project Settings dialog box. Select the 
Monitor the error information of all Slave Numbers check box, and then specifies a word device to write the 
error information.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.

Bit Function Descriptions

0 Reserved ―

1 Initialize

Clear all error information of Sub Host Communication.
Write 1 to clear all error information, and this bit changes to 0 after clear.
Error information of each slave number of the device addresses configured 
with the Monitor the error information of each Slave Number check 
box is also cleared.

2 Finish 1st reading
This bit changes to 1 after all device addresses allocated to HMI Link 
Registers (LLR) are read.

3 Reserved ―

4 Current Error
This bit changes to 1 while a communication error occurs in any device 
address allocated to HMI Link Registers (LLR). The bit changes to 0 after the 
communication error recovers.

5 Reserved ―

6 Error Log for Reading

This bit changes to 1 when the reading error has occurred in any device 
address allocated to HMI Link Registers (LLR). This bit keeps 1 even if the 
reading error recovers.
Writes 1 to the Bit 1 (Initialize) to make this bit 0.

7 Error Log for Writing

This bit changes to 1 when the writing error has occurred in any device 
address allocated to HMI Link Registers (LLR). This bit keeps 1 even if the 
writing error recovers.
Writes 1 to the Bit 1 (Initialize) to make this bit 0.

8 to 15 Reserved ―

Bit

Function

Read/Write R R R R R/W

Re
se

rv
ed

Er
ro

r 
Lo

g 
fo

r 
W

rit
in

g

Er
ro

r L
og

 fo
r R

ea
di

ng

Re
se

rv
ed

Cu
rr

en
t 

Er
ro

r

Re
se

rv
ed

Fi
ni

sh
 1

st
 r

ea
di

ng

In
iti

al
iz

e

Re
se

rv
ed
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● Monitor the error information of each Slave Number
The error information of external devices communicated with using Sub Host Communication can be monitored per 
external device.
This option is configured on the Sub Host Communication tab in the Project Settings dialog box. Select the 
Monitor the error information of each Slave Number check box, and then specifies a word device to write the 
error information. 256 word devices from top device set in this option are used. Each device is assigned to each slave 
number of PLC.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.

● Keep running with skipping the Slave Number of communication error
When this option is selected, skip the slave number error has occurred and connect with next slave number. This 
option is configured on the Sub Host Communication tab in the Project Settings dialog box. Select the Keep 
running with skipping the Slave Number of communication error check box.
When this option is not selected, retry communication with same slave number until recover from the error.

Bit Function Descriptions

0 Connection

Specifies the communication with the external devices of the relevant slave 
number.
When this bit is 1, MICRO/I connects with each external device. When this bit 
is 0, MICRO/I does not connect the external device.
Default value is 1 when the device addresses of the relevant slave number 
are registered to HMI Link Registers (LLR).

1 Reserved ―

2 Finish 1st reading
This bit changes to 1 after all device addresses allocated to HMI Link 
Registers (LLR) of the relevant slave number are read.

3 Reserved ―

4 Current Error
This bit changes to 1 while the communication error occurs in the device 
addresses allocated to the HMI Link Registers (LLR) of the relevant slave 
number. This bit changes to 0 after the communication error recovers.

5 Reserved ―

6 Error Log for Reading

This bit changes to 1 when the reading error has occurred in any device 
address allocated to the HMI Link Registers (LLR) of the relevant slave 
number. This bit keeps 1 even if the reading error recovers. 
Writes 1 to the Bit 1 (Initialize) of the Monitor the error information of 
all Slave Numbers check box to make this bit 0. 

7 Error Log for Writing

This bit changes to 1 when the writing error has occurred in any device 
address allocated to the HMI Link Registers (LLR) of the relevant slave 
number. This bit keeps 1 even if the writing error recovers.
Writes 1 to the Bit 1 (Initialize) of the Monitor the error information of 
all Slave Numbers check box to make this bit 0.

8 to 15 Reserved ―

Bit
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7.1 Overview

BACnet communication stands for "Building Automation and Control Networking Protocol". In building equipment, it is 
an open protocol that has been standardized for interoperability between systems built by different manufacturers, 
and a communication standard for building networks.
Previous air conditioning, lighting, security, and fire protection systems were connected using methods unique to the 
building equipment and systems manufacturers. However, conforming to BACnet allows equipment and systems to be 
connected and monitored using a common method.
A device connected by BACnet, and a device compatible with BACnet/IP is called a BACnet device.

7 BACnet Communication

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

BACnet

Lighting
equipment

Mfgr. B

HVAC
equipment

Mfgr. A

Security
equipment

Mfgr. C

Fire protection
equipment

Mfgr. D

Administration server

BACnet Devices
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7.2 BACnet Specifications

*1 Device Object is not included.
*2 The transmission cycle is set for all objects.
*3 The properties of objects created in internal memory are synchronized with specified device addresses.
*4 Supported objects are Analog Input Object, Analog Output Object, and Analog Value Object.

Item Details

Interface Ethernet Interface

Applicable Standards ANSI/ASHRAE135-2012

Standard 
Specifications

Protocol BACnet/IP

Profile B-ASC

Object Type
Device Object, Analog Input Object, Analog Output Object, Analog 
Value Object, Binary Input Object, Binary Output Object, Binary 
Value Object

Number of Objects 256 maximum*1

BIBBs
DS-RP-B, DS-WP-B, DS-RPM-B, DS-WPM-B, DS-COV-B, DS-COVU-B, 
DM-DDB-B, DM-DOB-B, DM-DCC-B

BBMD None-BBMD Device

Virtual Device Not supported

Foreign Device Supported

Subscribed COV 
Function

Number of Requests That 
Can Be Accepted

256 requests maximum

Unsubscribed COV 
Function

Transmission Unit Every object

Transmission Cycle 1 to 65,535 msec*2

Foreign Device 
Function

Registration Method Registration as needed by registration trigger device

Lifetime 0 to 65,535 sec

Device Binding Function
 Synchronization between properties and device addresses*3

 Data type conversion of Present _Value*4

 Coefficient conversion of Present _Value*4
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7.3 About BACnet

■ Applicable Standards
• ANSI/ASHRAE135-2012

■ Profile
BACnet/IP in the MICRO/I supports the following profile.
• B-ASC

■ Objects
Information, such as input and output values handled by BACnet devices that support BACnet/IP, are managed in 
units called objects. Objects are separated into a number of different types, depend on the content of the object, and 
these are called object types. The object types supported by BACnet/IP in the MICRO/I are as follows.

The MICRO/I  can set objects for each object type. This information can be written to and read from BACnet devices 
on the same BACnet/IP network. Regardless of the object type, the maximum number of objects that can be set is 
256 in total.
For details on objects, refer to “7.8 Objects” on page 3-124.

■ Properties
Properties are the detailed information and attributes of each object. 
For details on the properties of each object type, refer to “7.8 Objects” on page 3-124.

■ Services
Services are interfaces used to exchange information between BACnet devices. Services are classified into the client 
side that initiates services and the server side that executes services.
The Services supported by BACnet/IP in the MICRO/I are as follows.

*1 The MICRO/I initiates services for other BACnet devices.
*2 The MICRO/I executes services that are initiated from other BACnet devices.

Object Type

Name Abbreviation Identifier

Basic input and output

Analog Input Object AI 0

Analog Output Object AO 1

Analog Value Object AV 2

Binary Input Object BI 3

Binary Output Object BO 4

Binary Value Object BV 5

BACnet device attributes Device Object DV 8

Services Initiate*1 Execute*2

ReadProperty NO YES

ReadPropertyMultiple NO YES

WriteProperty NO YES

WritePropertyMultiple NO YES

SubscribeCOV NO YES

ConfirmedCOVNotification YES NO

UnconfirmedCOVNotification YES NO

Who-Is NO YES

I-Am YES NO

Who-Has NO YES

I-Have YES NO

DeviceCommunicationControl NO YES

For details on services, refer to the ANSI/ASHRAE 135-2012 (ISSN 1041-2336) standard or "BACnet Building 
Automation Data Communication Protocol", a book published by the Institute of Electrical Installation 
Engineers of Japan.
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■ BIBB
BACnet interoperability building blocks (BIBB) are groupings of multiple services for each function that will be 
implemented. BIBBs are classified into the client side that uses the function and the server side that provides the 
function. '-A' is appended to the end of the client-side BIBBs, and '-B' is appended to the end of the server-side BIBBs. 
BACnet devices define the functions they support using BIBBs.

The BIBB supported by BACnet/IP in the MICRO/I are as follows.

BIBB Category BIBB Services

Data Sharing

DS-RP-B Data Sharing Read Property B ReadProperty

DS-WP-B Data Sharing Write Property B ReadPropertyMultiple

DS-RPM-B Data Sharing Read Property Multiple B WriteProperty

DS-WPM-B Data Sharing Write Property Multiple B WritePropertyMultiple

DS-COV-B Data Sharing COV B
SubscribeCOV
ConfirmedCOVNotification
UnconfirmedCOVNotification

DS-COVU-B Data Sharing COV Unsubscribed B UnconfirmedCOVNotification

Device & Network 
Management

DM-DDB-B
Device Management Dynamic Device Binding B
(Who-Is, I-Am)

Who-Is
I-Am

DM-DOB-B
Device Management Dynamic Object Binding B
(Who-Has, I-Have)

Who-Has
I-Have

DM-DCC-B
Device Management Device Communication 
Control B

DeviceCommunicationControl

For details on BIBBs, refer to "BACnet Building Automation Data Communication Protocol", a book published 
by the Institute of Electrical Installation Engineers of Japan.
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7.4 Function

The MICRO/I provides the following functions as a single BACnet device.
• Object and Device Address Binding function
• Read Property function
• Write Property function
• Subscribed COV function
• Unsubscribed COV function
• Foreign Device function

● Object and Device Address Binding Function
A portion of the properties held by objects created in the MICRO/I can be allocated to device addresses, such as data 
registers, and those device addresses can be written to and read.
For example, the analog input value of the MICRO/I can be stored in a data register (#D0000) allocated as 
Present_Value of the Analog Input object, and that analog input value can be read by BACnet devices. The analog 
output value of the MICRO/I can also be changed from BACnet devices by allocating the data register (#D0004) that 
stores the analog output value as Present_Value of the Analog Output object.
The types and numbers of objects can be freely set. The initial values of properties are also set with WindO/I-NV4.

BACnet objects

Initial values of properties
(Set with WindO/I-NV4)

MICRO/I starts running

Device addresses Physical I/Os

BACnet device

Analog
Input object

Present_Value: 
10.0

Analog
Output object

Present_Value: 
20.0

XXXX object

YYYY object

#D0000: 1000
Coefficient: 0.01

External
analog input: 

10 V
Mutually
reflected

External
analog output: 

20 mA#D0004: 1000
Coefficient: 0.02

CH0: 10 V

CH2: 20 mA

MICRO/I Analog I/O module

Read property

Write property

• The processing to mutually reflect properties and device addresses is performed with no relationship to 
the processing for parts on the MICRO/I screen. Because device addresses allocated to objects will be 
written and read during execution of the processing for parts on the screen, create it so that no 
problems will occur when device addresses are referenced or refreshed.

• If a device address changes at an interval which is shorter than the cycle at which changes are reflected 
to the property of an object, those changes may not be reflected to the property. To reflect those 
changes to the property, keep the values of device addresses for 1 second.
For example, the changes may not be reflected to the property when #M0000, which has been allocated 
to Present_Value of a Binary Input object, is turned on for only 10 msec. To reflect those changes to the 
property, ensure that #M0000 stays 1 for 1 second.
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● Read Property Function
In the Read Property function, the MICRO/I returns the value of a property when there is a read property request 
from a BACnet device. This function is implemented using DS-RP-B (Data Sharing Read Property B) and DS-RPM-B 
(Data Sharing Read Property Multiple B).
The below diagram shows a BACnet device reading the analog input value of the MICRO/I that has been associated 
with the Analog Input object.

● Write Property Function
In the Write Property function, the MICRO/I writes a value to the property of an object when there is a write property 
request from a BACnet device. This function is implemented using DS-WP-B (Data Sharing Write Property B) and DS-
WPM-B (Data Sharing Read Property Multiple B).
The below diagram shows a BACnet device changing the analog output value of the MICRO/I that has been 
associated with the Analog Output object.

BACnet objects

BACnet device

Device addresses Physical input

Analog Input
object

Present_Value:
10.0

#D0000: 1000
Coefficient: 0.01

External
analog input:

10 V

Reflected

CH0: 10 VRead value:
10.0

MICRO/I Analog input module

Read from BACnet device Write value of data register

BACnet objects

BACnet device

Device addresses Physical input

Analog
Output object

Present_Value:
20.0

#D0000: 1000
Coefficient: 0.02

External
analog output:

20 mA

Reflected

CH0: 20 mAWrite value:
20.0

MICRO/I Analog output module

Write from BACnet device Read out to data register
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● Subscribed COV (COV) function
In the COV (Change Of Value) function, the MICRO/I monitors an object for which a report request has been received 
from a BACnet device. Then when Present_Value or Status_Flags has changed, the MICRO/I notifies the BACnet 
device of the change.

The properties of objects that correspond to the COV function and the timing of when to provide notification of 
changes are given as follows.

*1 For example, the following diagram shows when a report request is received from a BACnet device and AI-10 (Analog Input 
object, instance number 10) has the status in the following table.

Object Properties Timing to Provide Notification of Change

Analog Input
Analog Output
Analog Value

Present_Value
Status_Flags

Notification of change is provided when (1) or (2) as follows.

(1)
When Present_Value has changed to a value greater than or equal to the value 
set for COV_Increment (starting point is from when the previous COV 

notification was sent)*1

(2) When any of the bits in Status_Flags have changed

Binary Input
Binary Output
Binary Value

Present_Value
Status_Flags

Notification of change is provided when (1) or (2) as follows.

(1) When Present_Value has changed

(2) When any of the bits in Status_Flags have changed

Notification may not be provided for changes in values that are faster than the synchronization cycle of 
objects and device addresses.

AI-10 Properties Value

Present_Value 10.0

COV_Increment 3.0

BACnet device MICRO/I

Report request

COV notification
transmission

(To report requester) 
Present_Value of AI-10 
has changed to 15.0.

COV notification
transmission

Present_Value of AI-10
has changed to 18.5.

Present_Value of AI-10: 10.0
COV_Increment: 3.0

Present_Value of AI-10 has changed to 15.0
(Change in Present_Value (5.0) > COV_Increment (3.0))

This change corresponds to timing to provide notification of change (1).
Change in Present_Value = Present value - Value when report request 
was received = 15.0 - 10.0 = 5.0
Because COV_Increment = 3.0, 
change in present value ≥ COV_Increment has been satisfied.

Present_Value of AI-10 has changed to 17.5
(Change in Present_Value (2.5) > COV_Increment (3.0))

Change in Present_Value = Present value - Value when previous 
COV notification was transmitted = 17.5 - 15.0 = 2.5
Change in Present_Value < COV_Increment, and the condition 
for timing to provide notification of change (1) is not satisfied.
Therefore, COV notification is not sent.

Present_Value of AI-10 has changed to 18.5
(Change in Present_Value (3.5) > COV_Increment (3.0))

This change corresponds to timing to provide notification of change (1).
Change in Present_Value = Present value - Value when previous 
COV notification was transmitted = 18.5 - 15.0 = 3.5
Because COV_Increment = 3.0, 
Change in Present Value ≥ COV_Increment has been satisfied.
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The MICRO/I implements the COV function by sending the Confirmed COV Notification service/Unconfirmed COV 
Notification service to the report requesting BACnet device according to the parameters contained in the report 
request when that report request (Subscribe COV service) was transmitted from the BACnet device.

The key parameters contained in the report request are as follows.

The following diagram shows when the MICRO/I has received a report request transmitted from a BACnet device like 
that in the following table.

Parameters Description

Monitored Object Identifier Type and ID of object for which to enable the COV function.

Issue Confirmed Notifications

Selects whether or not to confirm messages that will be sent from the MICRO/I to 
the BACnet device.
•With confirmation (ConfirmedCOVNotification)
•Without confirmation (UnconfirmedCOVNotification)

Lifetime
The time to enable the COV function in 1 sec increments.
If 0 or omitted, the COV function is enabled with no time limit.

Report Request Parameters Description

Monitored Object Identifier Analog Input object (instant number: 10)

Issue Confirmed Notifications With confirmation (ConfirmedCOVNotification)

Lifetime 360 sec

BACnet device MICRO/I

Report request

360 sec
(Lifetime)

(To report requester) 
Present_Value of AI-10
has changed to 15.0.
Status_Flags is { }.

Present_Value of AI-10: 10.0
COV_Increment: 3.0
Status_Flags: { }

Present_Value of AI-10 has changed to 15.0
(Change in Present_Value (5.0) > COV_Increment (3.0))

Status_Flags of AI-10 has changed

Present_Value of AI-10 has changed

Status_Flags of AI-10
has changed to {FAULT}.

The maximum number of COVs that can be registered is 256.
For details on the parameters in a response request, refer to "BACnet Building Automation Data 
Communication Protocol", a book published by the Institute of Electrical Installation Engineers of Japan.
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● Unsubscribed COV (COVU) function
In the COVU (Change Of Value Unsubscribed) function, the MICRO/I spontaneously provides notification that 
Present_Value or Status_Flags of a specific object has changed to all BACnet devices connected to the same network.

The properties of objects that correspond to the COVU function and the timing of when to provide notification of 
changes are given as follows.

The MICRO/I implements the COVU function by sending the Unconfirmed COV Notification service to BACnet devices.

For example, when BACnet/IP is started with AI-10 (Analog Input object, instant number 10) having the status in the 
following table, notification is provided on the status of the properties at the set cycle (Unsubscribed COV frequency).

*1 Refer to “BACnet/IP Settings” on page 3-108.

Object Properties Timing to Provide Notification of Change

Analog Input
Analog Output
Analog Value

Present_Value
Status_Flags

Notification of the status is provided at the interval of the Unsubscribed COV frequency*1.
Notification of change is also provided when (1) or (2) as follows.

(1)
When Present_Value has changed to a value greater than or equal to the value set 
for COV_Increment (starting point is from when the previous COV notification was 
sent)

(2) When any of the bits in Status_Flags have changed

Binary Input
Binary Output
Binary Value

Present_Value
Status_Flags

Notification of change is provided when (1) or (2) as follows.

(1) When Present_Value has changed

(2) When any of the bits in Status_Flags have changed

AI-10 Properties Value

Present_Value 10.0

COV_Increment 3.0

Status_Flags { }

BACnet
device (2)

BACnet
device (1)

MICRO/I

Unsubscribed COV frequency

Present_Value of AI-10 is 10.0.
Status_Flags is { }.

Present_Value of AI-10: 10.0
Status_Flags: { }

Present_Value of AI-10: 15.0
Status_Flags: {FAULT}

Present_Value of AI-10 has changed to 15.
Status_Flags is {FAULT}.

COV notification transmission

Present_Value of AI-10 is 10.0.
Status_Flags is { }.

COV notification transmission

Present_Value of AI-10 is 15.0.
Status_Flags is {FAULT}.

COV notification transmission

COV notification transmission

• When using the COVU function, the values of properties can be regularly sent to BACnet devices, 
regardless of any change in the value of the properties.

• The COVU function can be set for each object.
• Only one Unsubscribed COV Frequency can be set for the MICRO/I. Different frequencies cannot be set 

for each object.
• If the Unsubscribed COV Frequency is set to 0, the COV function is stopped, and notification is provided 

only when there is a change in the target property.
• When the Unsubscribed COV frequency is changed by a device  address, the change will be applied after 

the service is next initiated.
• Notification may not be provided for changes in values that are faster than the synchronization cycle of 

objects and device addresses.
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● Foreign device function
When the BACnet/IP network is built with multiple IP subnets, install one BBMD (BACnet Broadcast Management 
Device) on each IP subnet. A BBMD is a device that transfers broadcast communications of BACnet devices to 
different IP subnets. BACnet devices perform broadcast communications with BACnet devices on different IP subnets 
via BBMDs. The Foreign Device function is used for performing broadcast communications with BACnet devices on 
different IP subnets even when there is no BBMD on the IP subnet of the MICRO/I. Broadcast communications can be 
performed with a BACnet device on the BACnet/IP network by registering the MICRO/I as a foreign device for a 
specified BBMD.

BBMD

Bridge

In
te

rn
et

IP subnet 1

BACnet/IP network

BBMD

Bridge

BACnet
device

BACnet
device

BACnet
device

BACnet
device

10.3.1.1
255.255.255.0

10.3.1.8
255.255.255.0

10.3.1.2
255.255.255.0

10.3.1.3
255.255.255.0

IP subnet 2

MICRO/I

Bridge

192.168.1.11
255.255.255.0

192.168.1.6
255.255.255.0

IP subnet 3
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7.5 BACnet/IP Operation

BACnet/IP is enabled and disabled according to the value of HMI Special Internal Relay LSM70 (BACnet 
Communication Bit).

Properties with allocated device addresses work by referencing those device addresses.
When BACnet/IP is enabled and properties or the values of device addresses that are associated with properties are 
changed, they operate with the values after the change.

BACnet/IP
Properties with Allocated Device Addresses 
and the Values of Those Device Addresses

Enabled Bound

Disabled Not bound

When the status of the BACnet communication is stopped by error (the value of HMI Special Data Registers 
LSD260-3 is 1) and restarts the BACnet communication, set 0 to the value of HMI Special Internal Relay 
LSM70, and then set 1 to the value of HMI Special Internal Relay LSM70 after the status of the BACnet 
communication is stopped (the value of HMI Special Data Registers LSD260-0 is 1). 
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7.6 BACnet/IP Settings Procedure

This section describes the procedure for setting BACnet/IP.

1 On the Configuration tab, in the System Setup group, click Project.

The Project Settings dialog box is displayed.

2 Click the BACnet/IP Settings tab, select the Use BACnet/IP check box and click Settings.

The BACnet Settings dialog box is displayed.

3 Configures a basic settings of BACnet/IP.

For details, refer to “BACnet/IP Settings” on page 3-108.
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4 Adds a new object.
Click New.

The New Object dialog box is displayed.

5 Select the object type of the object to register, and assign it an instance number.

6 Click OK.

The new object is added to the object list.
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7 Click the registered object ID in the object list.
The properties are displayed.

8 Configure the properties.

For details, refer to “Object List” on page 3-110.

9 Repeat steps 4 through 8 to set all the objects.

10 click OK.

This concludes configuring BACnet/IP.

The maximum number of objects that can be registered is 256.
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7.7 BACnet Settings Dialog Box

This section describes items on the BACnet Settings dialog box.

● BACnet/IP Settings

■ Basic Settings

*1 For Present_Value, refer to “7.8 Objects” on page 3-124 and “Present_Value” on page 3-132.
*2 For Status_Flags, refer to “7.8 Objects” on page 3-124 and “Status_Flags” on page 3-145.

Device ID: The assigned ID used to identify BACnet devices on the BACnet/IP network. Configures the 
device ID in the range from 1 to 4,194,302.

Fixed Value: Use a constant value. (Default: 4194301)

Data Register: Uses a value of device address.
This option uses 2 words of address numbers starting from the specified 
data register.

Port Number: Configures the port number for performing BACnet Communication. Configures the port number 
in the range from 0 to 65,535.

Fixed Value: Use a constant value. (Default: 47808)

Data Register: Uses a value of device address.

Turn ON BACnet Communication bit (LSM70) automatically:

Configures whether or not to set 1 to the HMI Special Internal Relay LSM70 (BACnet 
Communication Bit) in the END processing of the first scan when starting operation.

LSM70 Status BACnet/IP Present_Value*1 and 
Device Address Value

Overridden Flag in 

Status_Flags*2

1 Enabled Bound FALSE
0 Disabled Not bound —

When the following operations are performed, the value of the HMI Special Internal Relay LSM70 (BACnet 
Communication Bit) changes to 0.
• Downloads the project data.
• Turns off the MICRO/I.
• Switches to System Mode.
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■ COV Settings

■ Foreign Device Settings

Device Communication Control Password:

Configures the password to request when the Device Communication Control service is received 
from a BACnet device. The maximum number is 20 characters. When the Device Communication 
Control service is received, the MICRO/I does not initiate a service or provide a response for the 
specified period of time.

Unsubscribed COV Frequency (sec):

Configures the cycle to regularly provide notifications of property values with the COVU function 
as 1 to 65,535 (seconds). If 0 is set, the COVU function is stopped, and notification is provided 
only when there is a change in the target property.

Fixed Value: Use a constant value. (Default: 60 sec)

Data Register: Uses a value of device address.

• Only one Unsubscribed COV frequency can be set for the MICRO/I, and different frequencies cannot be 
set per object.

• Whether or not to use the COVU function can be selected per object. The COVU function can also be 
enabled and disabled by specifying a data register and changing its value.

• When changing the value of the data register, the Unsubscribed COV frequency after it has been changed 
will be applied after the service is next initiated.

Enable Foreign Device: Configures whether or not to use the Foreign Device function.Using the Foreign Device 
function, the MICRO/I registers itself as a Foreign Device on the configure BBMD.

BBMD IP Address: To join a BACnet/IP network when there is no BBMD on the IP subnet of the MICRO/I, 
configures the IP address of the BBMD on the other IP subnet. 

Fixed Value: Use a constant value.

Data Register: Uses a value of device address.
This option uses 4 words of address numbers starting from the specified 
data register.
Example: Configures 192.168.2.5 to the IP address of the BBMD.
The address number of Top Device Address+0 = 192
The address number of Top Device Address+1 = 168
The address number of Top Device Address+2 = 2
The address number of Top Device Address+3 = 5

BBMD Port Number: To join a BACnet/IP network when there is no BBMD on the IP subnet of the MICRO/I, 
configures the port number of BBMD on other IP subnet from 1 to 65,535.

Fixed Value: Use a constant value. (Default: 47808)

Data Register: Uses a value of device address.

Lifetime (sec): Configures the interval of time to register the MICRO/I with the BBMD as a Foreign 
Device in the range from 0 to 65,535 (seconds). (Default: 360 sec)
When (Lifetime + 30) sec has elapsed from registration, the registered content will be 
deleted from the BBMD.

Registration Trigger Device: The device address used to register the MICRO/I with the BBMD configure with BBMD 
IP Address above as a Foreign Device. When the value of the Registration Trigger 
Device is changed from 0 to 1, the MICRO/I is registered with the BBMD. To 
continuously register the MICRO/I with the BBMD, use the Registration Trigger 
Device to re-register the MICRO/I before (Lifetime + 30) sec elapses.
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● Object List
Select an object node to display the list of registered objects.
For example, select Analog Input to display the list of Analog Input objects, and select the object list node to display 
the list of all objects. The properties can also be changed when the list is displayed.

■ (Property settings)
This area displays the properties of the object ID selected in the object list.
A portion of the properties can be edited.

■ Send Unsubscribed COV
Configures whether or not to send Unsubscribed COV.

■ Save current settings as default
Saves the settings of the properties as the default values of the object.

(Property settings)

Enable: When the value of the HMI Special Internal Relay LSM70 (BACnet Communication Bit) is 1, the 
COVU function is always enabled and the Unconfirmed COV Notification service is sent.

Disable: The COVU function is always disabled and the Unconfirmed COV Notification service is not sent.

Control by device: Toggles between enabled and disabled with the value of device address. Specify the bit device 
or the bit number of the word device to use as the condition to switch between enabled and 
disabled.
It is enabled when the value of device address changes from 0 to 1, and it is disabled when the 
value of device address changes from 1 to 0.
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■ New
Adds a new object.
Click New to display the New Object dialog box. Configures the object type and instance number (0 to 4,194,302). 
Ensures that objects of the same object type do not have the same instance number.

■ Delete
Deletes the object under the node selected in the object list.

■ Export
Exports the settings of the following objects as a CSV file.
Analog Input, Analog Output, Analog Value, Binary Input, Binary Output, Binary Value

■ Import
Imports a CSV file that was export and automatically creates objects.
Objects cannot be imported if the format of the CSV file is invalid or if the maximum number of objects has been 
reached.
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● Present_Value Settings
This section describes how to configure Present_Value. Present_Value is a Float32(F) numeric value.

Analog Input Object

Use these settings to configure fixed values and device addresses for Present_Value of the Analog Input object.

■ Device Control
Selects whether to set a fixed value for Present_Value or to allocate device addresses.

Configures a fixed value to Present_Value
Select Disable in the Device Control of Present_Value, enter a constant value for Initial Value.

Enable: Specifies the Present_Value as a constant.

Disable: Specifies the Present_Value as a value of word device.
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Allocate device addresses to Present_Value
Select Enable in the Device Control of Present_Value, and then click a button displayed in Device to display the 
Present_Value Settings dialog box. Configure the parameters in the Present_Value Settings dialog box.

■ Device for Present_Value
Configures the device address to store Present_Value.
According to Conversion type, 1 or 2 continuous words of address number are used starting from the specified 
address number of Device Address. 

■ Conversion type
Configures the data type of the device address to which Present_Value (float) is allocated. For details, refer to 
Present_Value in “Analog Input Object” on page 3-136.

■ Coefficient
Configures Present_Value as the product of the value stored in the device address multiplied by the coefficient.

Present_Value  =  Value stored in the device address × Coefficient

Example:

The coefficient is multiplied as a Float32(F) value. The conversion order is as follows.

Device Addresses → Present_Value
(1) The value of the device addresses is converted to a Float32(F) value.
(2) The coefficient is multiplied by the conversion result in (1).

Device for Present_Value Conversion type Storage Destination

Present_Value for writing
UBIN16(W), BIN16(I) The address number of Top Device Address+0

UBIN32(D), BIN32(L), Float32(F)
The address number of Top Device Address+0, 
The address number of Top Device Address+1

Specify the Top Device Address so that the address number of device address is not exceeded.

Device Address Data Type Value Coefficient Present_Value

#D0000 UBIN16(W) 1000 0.01 10.0

#D0000, #D0001 Float32(F) 2.5 0.5 1.25
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Analog Output Object

Use these settings to configure devices for Present_Value of the Analog Output object.

■ Device Control
Device Control of Present_Value is Enable. A constant value cannot be configured for Present_Value of the 
Analog Output object.
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Allocate device addresses to Present_Value
Configure the parameters in the Present_Value Settings dialog box.

■ Device for Present_Value
Configures the device address to store Present_Value.
According to Conversion type, 1 or 2 continuous words of address number are used starting from the specified 
address number of Device Address.

■ Conversion type
Configures the data type of the device addresses to which Present_Value (float) is allocated. For details, refer to 
Present_Value in “Analog Output Object” on page 3-137.

■ Coefficient
The product of Present_Value multiplied by 1/coefficient multiplied is stored in the device addresses.

Value of device addresses = Present_Value × (1/coefficient)

Example:

The coefficient is multiplied as a Float32(F) value. The conversion order is as follows.

Present_Value → Device Addresses
(1) Present_Value is multiplied by (1/coefficient).
(2) The data type of the result of (1) (Float32(F)) is converted.

Device for Present_Value Conversion type Storage Destination

Present_Value for reading

UBIN16(W), BIN16(I) The address number of Top Device Address+0

UBIN32(D), BIN32(L), Float32(F)
The address number of Top Device Address+0, 
The address number of Top Device Address+1

Specify the Top Device Address so that the address number of device address is not exceeded.

Present_Value Coefficient Device Addresses Data Type Value

10.0 0.01 #D0000 UBIN16(W) 1000

1.25 0.5 #D0000, #D0001 Float32(F) 2.5
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Analog Value Object

Use these settings to configure device addresses for Present_Value of the Analog Value object.

■ Device Control
Device Control of Present_Value is Enable. A constant value cannot be configured for Present_Value of the 
Analog Value object.
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Allocate device addresses to Present_Value
Configure the parameters in the Present_Value Settings dialog box.

■ Device for Present_Value
Configures the device address for reading Present_Value and the device address for writing Present_Value.

The device address for reading Present_Value and writing Present_Value are automatically assigned according to the 
configured device address and Conversion type. Starting from the specified address number of Device Address, 2 or 4 
continuous words of address number are used. 

■ Top device for priority and trigger
Use this device address when writing the value of the device addresses to Present_Value. For details, refer to 
Present_Value in “Analog Value Object” on page 3-138.
Device for priority and Device for write trigger are automatically assigned when the device address is set. Starting 
from the specified address number of Device Address, 2 continuous words of address number are used. 

*1 Specify the priority between 1 and 16. If the priority is out of range, nothing is executed even when the value of Device for 
write trigger changes from 0 to 1.

Device for Present_Value Conversion type Storage Destination

Present_Value for reading

UBIN16(W), BIN16(I) The address number of Top Device Address+0

UBIN32(D), BIN32(L), Float32(F)
The address number of Top Device Address+0, 
The address number of Top Device Address+1

Present_Value for writing

UBIN16(W), BIN16(I) The address number of Top Device Address+1

UBIN32(D), BIN32(L), Float32(F)
The address number of Top Device Address+2, 
The address number of Top Device Address+3

Specify the Top Device Address so that the address number of device address is not exceeded.

MICRO/I Storage Destination Description

Device for 
priority

The address number of 
Top Device Address+0

Bit 15:
0: the value of the Present_Value for writing.
1: NULL(00h).

Bits 14 to 5: Disabled

Bits 4 to 0: Priority*1

Device for 
write trigger

The address number of 
Top Device Address+1

When the value changes from 0 to 1, writes a value to Priority_Array of index 
number indicated by the priority (bit 4 to 0 of Device for priority). The value to 
be written varies based on the value of bit 15 of Device for priority.

Specify the Top Device Address so that the address number of device address is not exceeded.
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■ Conversion type
Configures the data type of the device address to which Present_Value is allocated. For details, refer to Present_Value 
in “Analog Value Object” on page 3-138.

■ Coefficient
The product of Present_Value multiplied by 1/coefficient is stored in the device addresses allocated as Present_Value 
for reading.

Present_Value for reading = Present_Value × (1/coefficient)

When the device for write trigger is changed from 0 to 1, the product of multiplying the value of the device addresses 
allocated as Present_Value for writing by the coefficient is set as Present_Value.

Present_Value = Present_Value for writing × Coefficient

The coefficient is multiplied as a float-type value. The conversion order is as follows.

Present_Value → Device Addresses
(1) Present_Value is multiplied by (1/coefficient).
(2) The data type of the result of (1) (Float32(F)) is converted.

Device Addresses → Present_Value
(1) The value of the device addresses is converted to a Float32(F) value.
(2) The coefficient is multiplied by the conversion result in (1).

Present_Value Coefficient Conversion Type

Device Addresses Allocated as 
Present_Value for Reading or Writing

Device Addresses Value

10.0 0.01 UBIN16(W) #D0000 1000

1.25 0.5 Float32(F) #D0000, #D0001 2.5
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Binary Input Object

Use these settings to configure fixed values and device addresses for Present_Value of the Binary Input object.

■ Device Control
Selects whether to set a fixed value for Present_Value or to allocate device addresses.

Configures a fixed value to Present_Value
Select Disable in the Device Control of Present_Value, and then select INACTIVE or ACTIVE for Initial Value.

Enable: Specifies the Present_Value as a constant.

Disable: Specifies the Present_Value as a value of word device.
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Allocate device addresses to Present_Value
Select Enable in the Device Control of Present_Value, and then click a button displayed in Device to display the 
Present_Value Settings dialog box. Configure the parameters in the Present_Value Settings dialog box.

■ Device for Present_Value
Configures the device address to store Present_Value.



WindO/I-NV4 User’s Manual 3-121

7 BACnet Communication

3

Com
m

unication

Binary Output Object

Use these settings to configure device addresses for Present_Value of the Binary Output object.

■ Device Control
Device Control of Present_Value is Enable. A constant value cannot be configured for Present_Value of the 
Binary Output object.

Allocate device addresses to Present_Value
Configure the parameters in the Present_Value Settings dialog box.

■ Device for Present_Value
Configures the device address to store Present_Value.
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Binary Value Object

Use these settings to configure device addresses for Present_Value of the Binary Value object.

■ Device Control
Device Control of Present_Value is Enable. A constant value cannot be configured for Present_Value of the 
Binary Value object.
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Allocate device addresses to Present_Value
Configure the parameters in the Present_Value Settings dialog box.

■ Device for Present_Value
Configures the device address for reading Present_Value and the device for writing Present_Value.

The devices for reading Present_Value and writing Present_Value are automatically assigned according to the set 
device address. Starting from the specified address number of Device Address, 2 bits of address number are used.

■ Top device for priority and trigger
Use this device address when writing the value of the device addresses to Present_Value. For details, refer to 
Present_Value in “Binary Value Object” on page 3-143.
Device for priority and Device for write trigger are automatically assigned when the device address is set. Starting 
from the specified address number of Device Address, 2 continuous words of address number are used. 

*1 Specify the priority between 1 and 16. If the priority is out of range, If the value of Device for write trigger changes from 0 
to 1, then nothing is executed.

Device for Present_Value Storage Destination

Present_Value for reading The address number of Top Device Address+0

Present_Value for writing The address number of Top Device Address+1

Specify the Top Device Address so that the address number of device address is not exceeded.

MICRO/I Storage Destination Description

Device for 
priority

The address number of 
Top Device Address+0

Bit 15:
0: the value of the Present_Value for writing.
1: NULL(00h).

Bits 14 to 5: Disabled

Bits 4 to 0: Priority*1

Device for 
write trigger

The address number of 
Top Device Address+1

When the value changes from 0 to 1, writes a value to Priority_Array of index 
number indicated by the priority (bit 4 to 0 of Device for priority). The value to 
be written varies based on the value of bit 15 of Device for priority.

Specify the Top Device Address so that the address number of device address is not exceeded.
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7.8 Objects

The MICRO/I holds objects registered with WindO/I-NV4 in internal memory. Part of the properties of the object can 
be allocated to the device address, and the value of the device address can be written and read. BACnet devices can 
read and write the properties of objects on the MICRO/I using services.
Properties of objects on the MICRO/I and values of device addresses allocated to properties are continually 
synchronized.
For how to register objects using WindO/I-NV4, refer to “7.6 BACnet/IP Settings Procedure” on page 3-105. The 
maximum number of objects that can be registered is 256.
The following diagram shows two concepts.
(1) The BACnet device reads the analog input value of the Analog Input object.
(2) The BACnet device writes the analog output value of the Analog Output object.

BACnet objects

BACnet client

Initial values of properties
(Set with WindO/I-NV4)

MICRO/I starts running

∙ Data Sharing 
Read Property

∙ Data Sharing 
Read Property 
Multiple

∙ Data Sharing 
Write Property

∙ Data Sharing 
Write Property 
Multiple

Device addresses Physical I/Os

Analog
Input object

Present_Value:
10.0

Analog
Output object

Present_Value:
20.0

XXXX object

YYYY object

D0000: 1000
Coefficient: 0.01

External
analog input:

10 V
Mutually
reflected

External
analog output:

20 mAD0004: 1000
Coefficient: 0.02

CH0: 10 V

CH2: 20 mA

MICRO/I Analog I/O module

(1) (1)

(2) (2) (2)

(1)

For details on properties held by objects, refer to "BACnet Building Automation Data Communication 
Protocol", a book published by the Institute of Electrical Installation Engineers of Japan.
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● Analog Input Object
This object manages a Float32(F) numeric value. The MICRO/I can make arbitrary numeric values available to BACnet 
devices. For example, use this object when handling analog values input with the analog input module, the measured 
room temperature, and other analog values.

Properties List

(1): Read and write from BACnet devices
(2): Read and write from device addresses when properties are allocated to device addresses

R: Read-only, W: Write-only, R/W: Read and write, -: Not Read and write

*1 Character encoding is ISO 10646 (UTF-8), and the maximum size is 64 bytes.
*2 Cannot be displayed on WindO/I-NV4.

Property Identifier Data Type of Property (1) (2) Comments

Object_Identifier BACnetObjectIdentifier R - Set a fixed value with WindO/I-NV4.

Object_Name Character string*1 R - Set a fixed value with WindO/I-NV4.

Object_Type BACnetObjectType R - Set a fixed value with WindO/I-NV4.

Present_Value Real number R W Refer to “Present_Value” on page 3-132.

Description Character string*1 R - Set a fixed value with WindO/I-NV4.

Device_Type Character string*1 R - Set a fixed value with WindO/I-NV4.

Status_Flags BACnetStatus_Flags R R Refer to “Status_Flags” on page 3-145.

Event_State BACnetEventState R - Normal (fixed).

Reliability BACnetReliability R R/W
Indicates whether or not the value of 
Present_Value is reliable.

Out_Of_Service Logical value R/W R/W Refer to “Out_Of_Service” on page 3-146.

Units BACnetEngineeringUnits R/W - Set the initial value with WindO/I-NV4.

Resolution Real number R - Set a fixed value with WindO/I-NV4.

COV_Increment Real number R/W - Refer to “COV_Increment” on page 3-145.

Property_List*2 BACnetARRAY[N] of type 
BACnetPropertyIdentifier

R - Cannot be edited with WindO/I-NV4.
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● Analog Output Object
This object manages a Float32(F) numeric value. The MICRO/I can receive arbitrary numeric values from BACnet 
devices. For example, this object is used when receiving analog values such as those values that are output with the 
analog output module and temperature set points used as operating parameters from BACnet devices.

Properties List

(1): Read and write from BACnet devices
(2): Read and write from device addresses when properties are allocated to device addresses

R: Read-only, W: Write-only, R/W: Read and write, -: Not Read and write

*1 Character encoding is ISO 10646 (UTF-8), and the maximum size is 64 bytes.
*2 Cannot be displayed on WindO/I-NV4.

Property Identifier Data Type of Property (1) (2) Comments

Object_Identifier BACnetObjectIdentifier R - Set a fixed value with WindO/I-NV4.

Object_Name Character string*1 R - Set a fixed value with WindO/I-NV4.

Object_Type BACnetObjectType R - Set a fixed value with WindO/I-NV4.

Present_Value Real number R R Refer to “Present_Value” on page 3-132.

Description Character string*1 R - Set a fixed value with WindO/I-NV4.

Device_Type Character string*1 R - Set a fixed value with WindO/I-NV4.

Status_Flags BACnetStatus_Flags R R Refer to “Status_Flags” on page 3-145.

Event_State BACnetEventState R - Normal (fixed).

Reliability BACnetReliability R R/W
Indicates whether or not the value of 
Present_Value is reliable.

Out_Of_Service Logical value R/W R/W Refer to “Out_Of_Service” on page 3-146.

Units BACnetEngineeringUnits R/W - Set the initial value with WindO/I-NV4.

Resolution Real number R - Set a fixed value with WindO/I-NV4.

Priority_Array BACnetPriority_Array R/W - Refer to “Priority_Array” on page 3-145.

Relinquish_Default Real number R/W - Refer to “Relinquish_Default” on page 3-145.

COV_Increment Real number R/W - Refer to “COV_Increment” on page 3-145.

Property_List*2 BACnetARRAY[N] of type 
BACnetPropertyIdentifier

R - Cannot be edited with WindO/I-NV4.
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● Analog Value Object
This object can be used in the same manner as the Analog Input object and Analog Output object.

Properties List

(1): Read and write from BACnet devices
(2): Read and write from device addresses when properties are allocated to device addresses

R: Read-only, W: Write-only, R/W: Read and write, -: Not Read and write

*1 Character encoding is ISO 10646 (UTF-8), and the maximum size is 64 bytes.
*2 Cannot be displayed on WindO/I-NV4.

Property Identifier Data Type of Property (1) (2) Comments

Object_Identifier BACnetObjectIdentifier R - Set a fixed value with WindO/I-NV4.

Object_Name Character string*1 R - Set a fixed value with WindO/I-NV4.

Object_Type BACnetObjectType R - Set a fixed value with WindO/I-NV4.

Present_Value Real number R R Refer to “Present_Value” on page 3-132.

Description Character string*1 R - Set a fixed value with WindO/I-NV4.

Status_Flags BACnetStatus_Flags R R Refer to “Status_Flags” on page 3-145.

Event_State BACnetEventState R - Normal (fixed).

Reliability BACnetReliability R R/W
Indicates whether or not Present_Value is 
reliable.

Out_Of_Service Logical value R/W R/W Refer to “Out_Of_Service” on page 3-146.

Units BACnetEngineeringUnits R/W - Set the initial value with WindO/I-NV4.

Priority_Array BACnetPriority_Array R/W R/W Refer to “Priority_Array” on page 3-145.

Relinquish_Default Real number R/W - Refer to “Relinquish_Default” on page 3-145.

COV_Increment Real number R/W - Refer to “COV_Increment” on page 3-145.

Resolution Real number R - Set a fixed value with WindO/I-NV4.

Property_List*2 BACnetARRAY[N] of type 
BACnetPropertyIdentifier

R - Cannot be edited with WindO/I-NV4.
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● Binary Input Object
This object manages a binary value (on/off). Use this object when the MICRO/I makes binary values available to 
BACnet devices.

Properties List

(1): Read and write from BACnet devices
(2): Read and write from device addresses when properties are allocated to device addresses

R: Read-only, W: Write-only, R/W: Read and write, -: Not Read and write

*1 Character encoding is ISO 10646 (UTF-8), and the maximum size is 64 bytes.
*2 Cannot be displayed on WindO/I-NV4.

Property Identifier Data Type of Property (1) (2) Comments

Object_Identifier BACnetObjectIdentifier R - Set a fixed value with WindO/I-NV4.

Object_Name Character string*1 R - Set a fixed value with WindO/I-NV4.

Object_Type BACnetObjectType R - Set a fixed value with WindO/I-NV4.

Present_Value BACnetBinaryPV R W Refer to “Present_Value” on page 3-132.

Description Character string*1 R - Set a fixed value with WindO/I-NV4.

Device_Type Character string*1 R - Set a fixed value with WindO/I-NV4.

Status_Flags BACnetStatus_Flags R R Refer to “Status_Flags” on page 3-145.

Event_State BACnetEventState R - Normal (fixed).

Reliability BACnetReliability R R/W
Indicates whether or not the value of 
Present_Value is reliable.

Out_Of_Service Logical value R/W R/W Refer to “Out_Of_Service” on page 3-146.

Polarity BACnetPolarity R/W - Refer to “Polarity” on page 3-145.

Property_List*2 BACnetARRAY[N] of type 
BACnetPropertyIdentifier

R - Cannot be edited with WindO/I-NV4.
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● Binary Output Object
This object manages a binary value (on/off). Use this object when the MICRO/I receives binary values from BACnet 
devices.

Properties List

(1): Read and write from BACnet devices
(2): Read and write from device addresses when properties are allocated to device addresses

R: Read-only, W: Write-only, R/W: Read and write, -: Not Read and write

*1 Character encoding is ISO 10646 (UTF-8), and the maximum size is 64 bytes.
*2 Cannot be displayed on WindO/I-NV4.

Property Identifier Data Type of Property (1) (2) Comments

Object_Identifier BACnetObjectIdentifier R - Set a fixed value with WindO/I-NV4.

Object_Name Character string*1 R - Set a fixed value with WindO/I-NV4.

Object_Type BACnetObjectType R - Set a fixed value with WindO/I-NV4.

Present_Value BACnetBinaryPV R R Refer to “Present_Value” on page 3-132.

Description Character string*1 R - Set a fixed value with WindO/I-NV4.

Device_Type Character string*1 R - Set a fixed value with WindO/I-NV4.

Status_Flags BACnetStatus_Flags R R Refer to “Status_Flags” on page 3-145.

Event_State BACnetEventState R - Normal (fixed).

Reliability BACnetReliability R R/W
Indicates whether or not the value of 
Present_Value is reliable.

Out_Of_Service Logical value R/W R/W Refer to “Out_Of_Service” on page 3-146.

Polarity BACnetPolarity R/W - Refer to “Polarity” on page 3-145.

Priority_Array BACnetPriority_Array R/W - Refer to “Priority_Array” on page 3-145.

Relinquish_Default BACnetBinaryPV R/W - Refer to “Relinquish_Default” on page 3-145.

Property_List*2 BACnetARRAY[N] of type 
BACnetPropertyIdentifier

R - Cannot be edited with WindO/I-NV4.
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● Binary Value Object
This object can be used in the same manner as the Binary Input object and Binary Output object.

Properties List

(1): Read and write from BACnet devices
(2): Read and write from device addresses when properties are allocated to device addresses

R: Read-only, W: Write-only, R/W: Read and write, -: Not Read and write

*1 Character encoding is ISO 10646 (UTF-8), and the maximum size is 64 bytes.
*2 Cannot be displayed on WindO/I-NV4.

Property Identifier Data Type of Property (1) (2) Comments

Object_Identifier BACnetObjectIdentifier R - Set a fixed value with WindO/I-NV4.

Object_Name Character string*1 R - Set a fixed value with WindO/I-NV4.

Object_Type BACnetObjectType R - Set a fixed value with WindO/I-NV4.

Present_Value BACnetBinaryPV R R Refer to “Present_Value” on page 3-132.

Description Character string*1 R - Set a fixed value with WindO/I-NV4.

Status_Flags BACnetStatus_Flags R R Refer to “Status_Flags” on page 3-145.

Event_State BACnetEventState R - Normal (fixed).

Reliability BACnetReliability R R/W
Indicates whether or not the value of 
Present_Value is reliable.

Out_Of_Service Logical value R/W R/W Refer to “Out_Of_Service” on page 3-146.

Priority_Array BACnetPriority_Array R/W R/W Refer to “Priority_Array” on page 3-145.

Relinquish_Default BACnetBinaryPV R/W - Refer to “Relinquish_Default” on page 3-145.

Property_List*2 BACnetARRAY[N] of type 
BACnetPropertyIdentifier

R - Cannot be edited with WindO/I-NV4.
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● Device Object
Use this object when the MICRO/I makes basic information available to BACnet devices.

Properties List

(1): Read and write from BACnet devices
(2): Read and write from device addresses when properties are allocated to device addresses

R: Read-only, W: Write-only, R/W: Read and write, -: Not Read and write

*1 Character encoding is ISO 10646 (UTF-8), and the maximum size is 64 bytes.
*2 Cannot be displayed on WindO/I-NV4.

Property Identifier Data Type of Property (1) (2) Comments

Object_Identifier BACnetObjectIdentifier R - Cannot be edited with WindO/I-NV4.

Object_Name Character string*1 R - Set a fixed value with WindO/I-NV4.

Object_Type BACnetObjectType R - Cannot be edited with WindO/I-NV4.

System_Status BACnetDeviceStatus R - Cannot be edited with WindO/I-NV4.

Vendor_Name Character string*1 R - Cannot be edited with WindO/I-NV4.

Vendor_Identifier 16-bit unsigned integer R - Cannot be edited with WindO/I-NV4.

Model_Name Character string*1 R - Set a fixed value with WindO/I-NV4.

Firmware_Revision Character string*1 R - Cannot be edited with WindO/I-NV4.

Application_Software_Version Character string*1 R - Set a fixed value with WindO/I-NV4.

Location Character string*1 R/W - Set the initial value with WindO/I-NV4.

Description Character string*1 R/W - Set the initial value with WindO/I-NV4.

Protocol_Version Unsigned integer R - Cannot be edited with WindO/I-NV4.

Protocol_Revision Unsigned integer R - Cannot be edited with WindO/I-NV4.

Protocol_Services_Supported BACnetServicesSupported R - Cannot be edited with WindO/I-NV4.

Protocol_Object_Types_Supported BACnetObjectType Supported R - Cannot be edited with WindO/I-NV4.

Object_List
BACnetARRAY[N] of type 
BACnetObjectIdentifier

R - Cannot be edited with WindO/I-NV4.

Max_APDU_Length_Accepted Unsigned integer R - Cannot be edited with WindO/I-NV4.

Segmentation_Supported BACnetSegmentation R - Cannot be edited with WindO/I-NV4.

Local_Time Time R - Cannot be edited with WindO/I-NV4.

Local_Date Date R - Cannot be edited with WindO/I-NV4.

APDU_Timeout Unsigned integer R - Cannot be edited with WindO/I-NV4.

Number_of_APDU_Retries Unsigned integer R - Cannot be edited with WindO/I-NV4.

Device_Address_Binding
BACnetLIST of type 
BACnetAddressBiding

R - Cannot be edited with WindO/I-NV4.

Database_Revision Unsigned integer R - Cannot be edited with WindO/I-NV4.

Property_List*2 BACnetARRAY[N] of type 
BACnetPropertyIdentifier

R - Cannot be edited with WindO/I-NV4.

Profile_Name Character string*1 R - Set a fixed value with WindO/I-NV4.
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7.9 Key Properties

● Present_Value
This property represents the current value. This property handles input and output values associated with objects.

Priority Mechanism

Objects*1 with Present_Value that can be written from BACnet devices use a priority mechanism with Priority_Array in 
which write instructions are ranked and the value of Present_Value is determined. In this case, values cannot be 
directly written to Present_Value. To write a value to Present_Value, the value is first stored in Priority_Array 
(“Present_Value Settings” on page 3-112) at the index number indicated by Priority (“Priority_Array” on page 3-
145). Then the value stored in Priority_Array with the smallest index number out of all non-NULL(00h) values is used 
as the value of Present_Value.

*1 Analog Output, Analog Value, Binary Output, Binary Value objects
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Writing the Value of a Device Address as Present_Value or Writing Present_Value from a BACnet Device

The items used in the above diagram are described in the following table.

Writing from a Device Address

Item Description

Present_Value for reading This device address stores Present_Value read from the BACnet device.

Present_Value for writing This device address stores the value to be written to the BACnet device as Present_Value.

Device for priority
This device address stores the index number in the array (Priority_Array) where the priority 
value is stored.

Device for write trigger
When this device address is 1, the value stored in the Present_Value for writing is stored in 
Priority_Array at the index number stored in device address for priority.

Present_Value Prevent_Value held by the BACnet object in the MICRO/I.

Priority_Array Refer to “Priority_Array” on page 3-145.

Read value Current Present_Value.

Write value Present_Value to be written from the BACnet device.

(1) When bit 15 of Device for priority is 0 and the value of Device for write trigger changes from 0 to 1, writes 
the value of Present_Value for writing to the Priority_Array at the index number stored in the bit 4 to 0 of 
Device for priority.

(2) Device for write trigger is automatically reset to 0.

(3) The value stored in Priority_Array with the smallest index number out of all non-NULL(00h) values is used as the 
value of Present_Value. (The value of Priority_Array at the index number is used as Present_Value until it is reset 
to NULL(00h).)

MICRO/IBACnet device

BACnet objects Device addresses

Present_Value

Priority_Array

1

Present_Value 
for reading

Read value

Write value

Priority

Present_Value 
for writing

Device for priority

Device for
write trigger

2

3

∙∙
∙

16

(1)

(2)(4)

(3), (5)

When bit 15 of Device for priority is 1 and the value of Device for write trigger changes from 0 to 1, 
NULL(00h) is written to Priority_Array at the index number stored in Device for priority. 
For details about the bit assignments of the Device for priority, refer to “Analog Value Object” in “Top device 
for priority and trigger” on page 3-117.
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Writing from the BACnet Device

Writing the Value of a Device Address to Present_Value
Example: When #D0000 is allocated to the Present_Value device, #D0010 is allocated to the top device for priority 

and trigger, and Float32(F) is allocated to the conversion type, the device addresses are allocated as 
follows: #D0000 is the Present_Value for reading, #D0002 is the Present_Value for writing, #D0010 is the 
Device for priority, and #D0011 is the Device for write trigger.

(4) The BACnet device writes the value of Present_Value to Priority_Array at the index number indicated by the 
specified priority.

(5) The value stored in the Priority_Array property with the smallest index number out of all non-NULL(00h) values is 
used as the value of Present_Value. (The value of Priority_Array at the index number is used as Present_Value 
until it is reset to NULL(00h).)

If all values stored in Priority_Array are NULL(00h), “Relinquish_Default” on page 3-145 is used as 
Present_Value.

(1) If the value of the Device for priority (#D0010) is 1 when the value of the Device for write trigger (#D0011) is 1, 
writes the value (15.0) of the Present_Value for writing (#D0002) to the element 1 of Priority_Array. After the 
write has completed, the value of the Device for write trigger (#D0011) is reset to 0.

(2) Priority_Array with the smallest index number out of all non-NULL(00h) values is element 1 (15.0), so 15.0 is used 
as the value of Present_Value.

(3) Present_Value (15.0) is read from the BACnet device.

BACnet objects Device addressesBACnet device

Analog Value
object

Present_Value:
15.0

#D0000: XXXX

#D0002: 15.0

#D0010: 1

#D0011: 1

Reflected

Read value:
15.0

MICRO/I

∙∙
∙

Priority_Array
15.01

NULL(00h)2
10.03

16

(1)
(2)

(3) Present_Value 
for reading

Present_Value 
for writing

Device for priority

Device for write trigger
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Writing a Value to Present_Value from the BACnet Device
Example: When #D0000 is allocated to the Present_Value device, #D0010 is allocated to the top device for priority 

and trigger, and Float32(F) is allocated to the conversion type, the device addresses are allocated as 
follows: #D0000 is the Present_Value for reading, #D0002 is the Present_Value for writing, #D0010 is the 
Device for priority, and #D0011 is the Device for write trigger.

(1) The BACnet device writes the write value (20.0) to Priority_Array at the index number indicated by the specified 
priority (3).

(2) Priority_Array with the smallest index number out of all non-NULL(00h) values is element 3 (20.0), so 20.0 is used 
as the value of Present_Value.

(3) Present_Value (20.0) is written to the Present_Value for reading (#D0000).

BACnet objects Device addressesBACnet device

Analog Value
object

Present_Value:
20.0

#D0000: 20.0

#D0002: XXXX

#D0010: XXXX

#D0011: XXXX

Reflected

Read value:
20.0

Priority:
3

MICRO/I

∙∙
∙

Priority_Array
NULL(00h)1
NULL(00h)2

20.03

16

(1)

(2)

(3) Present_Value 
for reading

Present_Value 
for writing

Device for priority

Device for write trigger
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Analog Input Object

Present_Value of the Analog Input object can be set to a fixed value or allocated device addresses and set to the 
value of those device address. Present_Value is a Float32(F) numeric value. When device addresses are allocated to 
Present_Value, Present_Value is set to the product of those device addresses multiplied by the coefficient.
The following diagram illustrates the concept when device addresses are allocated to Present_Value of the Analog 
Input object and the BACnet device reads out the analog input value.

When writing the value of device addresses as Present_Value, Present_Value changes in the following manner.

Data Type Value of Device Addresses Present_Value of BACnet Device

UBIN16(W)

Value within range of each data type Value of Device Addresses
BIN16(I)

UBIN32(D)

BIN32(L)

Float32(F)

±0 ±0.0

Denormalized number
Value of Device Addresses

Normalized number

±∞ (±infinity)
Present_Value does not change

Non-number

BACnet objects

BACnet device

Device addresses Physical input

Analog Input
object

Present_Value:
10.0

#D0000: 1000
Coefficient: 0.01

External
analog input:

10 V

Reflected

CH0: 10 VRead value:
10.0

MICRO/I Analog input module

Read from BACnet device Write value of data register
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Analog Output Object

Present_Value of the Analog Output object can be allocated device addresses and set to the value of those device 
addresses. Present_Value is a Float32(F) numeric value. When device addresses are allocated to Present_Value, the 
product of Present_Value multiplied by 1/coefficient is stored in the device addresses.
The following diagram illustrates the concept when device addresses are allocated to Present_Value of the Analog 
Output object and the BACnet device writes the analog output value.

When reading out Present_Value to device addresses, you must be aware of the data type. Depending on the data 
type of the device addresses, the value is stored in the device addresses as follows. Set the data type according to the 
value of Present_Value. The data type of Present_Value is set in “Conversion type” on page 3-115 of the “Analog 
Output Object”.

BACnet objectsBACnet device Device addresses Physical output

Analog Output
object

Present_Value:
20.0

Priority_Array

#D0000: 1000
Coefficient: 0.02

External
analog output:

20 mA

Reflected

CH0: 20 mA

Write value: 
20.0

Priority:
2

MICRO/I Digital output module

Write from BACnet device Read out to data register

Present_Value of the Analog Output object cannot be changed from the MICRO/I.

Data Type Present_Value of BACnet Device Value of Device Addresses

UBIN16(W)
Value within range of 0 to 65,535 Present_Value

Value outside range of 0 to 65,535 0

BIN16(I)
Value within range of -32,768 to 32,767 Present_Value

Value outside range of -32,768 to 32,767 0

UBIN32(D)
Value within range of 0 to 4,294,967,295 Present_Value

Value outside range of 0 to 4,294,967,295 0

BIN32(L)
Value within range of -2,147,483,648 to 2,147,483,647 Present_Value

Value outside range of -2,147,483,648 to 2,147,483,647 0

Float32(F) — Present_Value
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Analog Value Object

Present_Value of the Analog Value object can be used as Present_Value of both the Analog Input and Analog Output 
objects. Present_Value is a Float32(F) numeric value.
The following diagram illustrates the concept when device addresses are allocated to Present_Value of the Analog 
Value object and the temperature of an office air conditioner is temporarily lowered from the base temperature 
(27.0°C) to 26.5°C.

Example: When #D0000 is allocated to the Present_Value device, #D0010 is allocated to the top device for priority 
and trigger, and Float32(F) is allocated to the conversion type, the device addresses are allocated as 
follows: #D0000 is the Present_Value for reading, #D0002 is the Present_Value for writing, #D0010 is the 
Device for priority, and #D0011 is the Device for write trigger.

Writing the Value of a Device Address to Present_Value

(1) When the value of the Device for write trigger (#D0011) is 1, writes the value of the Present_Value for writing 
(#D0002) to the Priority_Array at the index number stored in the Device for priority (#D0010).

(2) The Device for write trigger (#D0011) is automatically reset to 0.

(3) Priority_Array with the smallest index number out of all non-NULL(00h) values is element 1 (26.5), so 26.5 is used 
as the value of Present_Value.

BACnet objects Device addressesBACnet device

Analog Value
object

Present_Value:
 26.5

#D0000: XXXX

#D0002: 26.5

D0010: 1

D0011: 1

Reflected

Read value:
26.5

MICRO/I
∙∙

∙

Priority_Array
26.51

NULL(00h)2
27.03

16

(1)
(2)

(3) Present_Value 
for reading

Present_Value 
for writing

Device for priority

Device for write trigger
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Writing a Value to Present_Value from the BACnet Device

(1) The BACnet device writes the write value (26.5) to Priority_Array at the index number indicated by the specified 
priority (1).

(2) Priority_Array with the smallest index number out of all non-NULL(00h) values is element 1 (26.5), so 26.5 is used 
as the value of Present_Value.

(3) Present_Value (26.5) is written to the Present_Value for reading (#D0000).

BACnet objects Device addressesBACnet device

Analog Value
object

Present_Value:
26.5

#D0000: 26.5

#D0002: XXXX

#D0010: XXXX

#D0011: XXXX

Reflected

Write value:
26.5

Priority:
1

MICRO/I

∙∙
∙

Priority_Array
26.51

NULL(00h)2
27.03

16

(1)

(2)

(3) Present_Value 
for reading

Present_Value 
for writing

Device for priority

Device for write trigger

Element 1 (26.5) of Priority_Array is used as the value of Present_Value until it is reset to NULL(00h). When 
element 1 is reset to NULL(00h), element 3 (27.0) is used as the value of Present_Value.
For how to write NULL(00h), refer to "Analog Value Object" in “Top device for priority and trigger” on page 
3-117.



7 BACnet Communication

3-140 WindO/I-NV4 User’s Manual

Depending on the data type of the allocated device addresses, Present_Value is stored in the device addresses as 
follows. Set the data type according to the value of Present_Value. The data type of Present_Value is set in 
“Conversion type” on page 3-118 of the "Analog Value Object".

Additionally, when writing the value of device addresses to Present_Value, Present_Value changes in the following 
manner.

Data Type Present_Value of BACnet Device × (1/Coefficient) Value of Device Addresses

UBIN16(W)
Value within range of 0 to 65,535 Present_Value

Value outside range of 0 to 65,535 0

BIN16(I)
Value within range of -32,768 to 32,767 Present_Value

Value outside range of -32768 to 32,767 0

UBIN32(D)
Value within range of 0 to 4,294,967,295 Present_Value

Value outside range of 0 to 4,294,967,295 0

BIN32(L)
Value within range of -2,147,483,648 to 2,147,483,647 Present_Value

Value outside range of -2,147,483,648 to 2,147,483,647 0

Float32(F) — Present_Value

Data Type Value of Device Addresses Present_Value of BACnet Device

UBIN16(W)

Value within range of each data type Value of device addresses × Coefficient
BIN16(I)

UBIN32(D)

BIN32(L)

Float32(F)

±0 ±0.0

Denormalized number
Value of device addresses × Coefficient

Normalized number

±∞ (±infinity)
Present_Value does not change

Non-number
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Binary Input Object

Present_Value of the Binary Input object can be set to a fixed value or allocated to a bit device address and set to the 
value of that bit device.

The following diagram illustrates the concept when an external input is allocated to Present_Value of the Binary Input 
object and the BACnet device reads out the state of the external input.

The following table shows Present_Value, Polarity, and the physical state of the input.

Present_Value Polarity Physical State of Input

INACTIVE NORMAL OFF or INACTIVE

ACTIVE NORMAL ON or ACTIVE

INACTIVE REVERSE ON or ACTIVE

ACTIVE REVERSE OFF or INACTIVE

BACnet objects

BACnet device

Device addresses Physical input

Binary Input
object

Present_Value:
1

#I0030: 1

DC Input:
24 V

Reflected

IN 0: ONRead value:
1

MICRO/I Digital input module

Read from BACnet device Write value of device address
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Binary Output Object

Present_Value of the Binary Output object can be allocated to a bit device and set to the value of that bit device. 

The following diagram illustrates the concept when a device address is allocated to Present_Value of the Binary 
Output object and the BACnet device writes the state of the external output.

The following table shows Present_Value, Polarity, and the physical state of the output.

Present_Value Polarity Physical State of Output

INACTIVE NORMAL OFF or INACTIVE

ACTIVE NORMAL ON or ACTIVE

INACTIVE REVERSE ON or ACTIVE

ACTIVE REVERSE OFF or INACTIVE

BACnet objectsBACnet device Device addresses Physical output

Binary Output
object

Present_Value:
0

Priority_Array

#Q0030: 0

External output:
OFF

Reflected

OUT 0: OFF

Write value:
0

Priority:
2

MICRO/I Digital output module

Write from BACnet device Read out to device address
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Binary Value Object

Present_Value of the Binary Value object can be used as Present_Value of both the Binary Input and Binary Output 
objects. 

The following diagram illustrates the concept when an internal relay is allocated to Present_Value of the Binary Value 
object and the office lights are temporarily turned on from off.

Example: When #M0000 is allocated to the Present_Value device and #D0010 is allocated to the top device for 
priority and trigger, the device address are allocated as follows: #M0000 is the Present_Value for reading, 
#M0001 is the Present_Value for writing, #D0010 is the Device for priority, and #D0011 is the Device for 
write trigger.

Writing the Value of a Device Address to Present_Value

(1) When the value of the Device for write trigger (#D0011) is 1, writes the value of the Present_Value for writing 
(#M0001) to the Priority_Array at the index number stored in the Device for priority (#D0010).

(2) The value of the Device for write trigger (#D0011) is automatically reset to 0.

(3) Priority_Array with the smallest index number out of all non-NULL(00h) values is element 1 (1), so 1 is used as the 
value of Present_Value.

BACnet objects Device addressesBACnet device

Binary Value
object

Present_Value:
1

#M0000: XXXX

#M0001: 1

#D0010: 1

#D0011: 1

Reflected

Read value:
1

MICRO/I
∙∙

∙

Priority_Array
11

NULL(00h)2
03

16

(1)
(2)

(3) Present_Value 
for reading

Present_Value 
for writing

Device for priority

Device for write trigger
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Writing a Value to Present_Value from the BACnet Device

(1) The BACnet device writes the write value (1) to Priority_Array at the index number indicated by the specified 
priority (1).

(2) Priority_Array with the smallest index number out of all non-NULL(00h) values is element 1 (1), so 1 is used as the 
value of Present_Value.

(3) Present_Value (1) is written to the Present_Value for reading (#M0000).

BACnet objects Device addressesBACnet device

Binary Value
object

Present_Value:
1

#M0000: 1

#M0001: XXXX

#D0010: XXXX

#D0011: XXXX

Reflected

Write value:
1

Priority:
1

MICRO/I

∙∙
∙

Priority_Array
11

NULL(00h)2
03

16

(1)

(2)

(3) Present_Value 
for reading

Present_Value 
for writing

Device for priority

Device for write trigger

Element 1 (1) of Priority_Array is used as the value of Present_Value until it is reset to NULL(00h). When 
element 1 is reset to NULL(00h), element 3 (0) is used as the value of Present_Value.
For how to write NULL(00h), refer to "Binary Value Object" in “Top device for priority and trigger” on page 3-
123.
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Status_Flags

This property represents the current status of the object (in alarm, fault, out of service, etc.).

The allocation of flags in the device address is as follows.

COV_Increment

This property represents the minimum amount of change in Present_Value.
COV notifications are sent when the value of Present_Value for the COV notification that was last sent changes to a 
value that is greater than or equal to the value set with COV_Increment. COV_Increment cannot be read out to device 
address. Set the initial value with WindO/I-NV4.

Priority_Array

Priority_Array is a read-only property representing the array that stores the priority values.
Of the 16 elements in the array (element 1 to element 16), the value stored in Priority_Array with the smallest index 
number out of all non-NULL(00h) values is used as the value of Present_Value. If all values stored in Priority_Array 
are NULL(00h), Relinquish_Default is used as Present_Value.

Relinquish_Default

Relinquish_Default is the default value used as Present_Value when all values stored in Priority_Array are NULL(00h).

Polarity

This property represents the relationship between the physical state of the input/output and the logical state 
indicated by Present_Value in the Binary Input and Binary Output objects.

*1 Always FALSE on the MICRO/I.

Status_Flags Value Logical Value Condition

IN_ALARM*1
0 FALSE When obtaining a value where Event State is Normal.

1 TRUE Other than above

FAULT
0 FALSE Other than below

1 TRUE When Reliability is present and the no-fault-detected value is not obtained

OVERRIDDEN*1
0 FALSE Other than below

1 TRUE Present_Value and Reliability did not follow the change in physical input

OUT_OF_SERVICE
0 FALSE When Out_Of_Service is TRUE

1 TRUE When Out_Of_Service is FALSE

Bit Flag Value

Bits 15 to 8 Reserved Undefined

Bit 7 IN_ALARM 0 (fixed)

Bit 6 FAULT 0 or 1

Bit 5 OVERRIDDEN 0 (fixed)

Bit 4 OUT_OF_SERVICE 0 or 1

Bits 3 to 0 Reserved Undefined

Polarity
Physical State of Input/

Output
Present_Value Physical State of Device

NORMAL OFF or INACTIVE INACTIVE Not running

NORMAL ON or ACTIVE ACTIVE Running

REVERSE ON or ACTIVE INACTIVE Not running

REVERSE OFF or INACTIVE ACTIVE Running
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Out_Of_Service

Out_Of_Service is the property that represents whether or not Present_Value and the physical input/output have 
been unbound.

Out_Of_Service can be read out to an internal relay, and the status of an internal relay can be written as 
Out_Of_Service.

Reliability

This property represents the reliability of the object property.

The following table shows the definition of Reliability for each object type.
YES: Valid, NO: Invalid

Reliability can be read out to a device address, and the value of a device address can be written as Reliability.

Properties Value Logical Value Condition

Out_Of_Service
0 FALSE In service (Present_Value and the physical input/output are bound.)

1 TRUE Out of service (Present_Value and the physical input/output are unbound.)

Out_Of_Service = TRUE is used for simulations.

Definition Value
Analog 
Input

Analog 
Output

Analog 
Value

Binary 
Input

Binary 
Output

Binary 
Value

no-fault-detected 0 YES YES YES YES YES YES

no-sensor 1 YES NO NO YES NO NO

over-range 2 YES NO YES NO NO NO

under-range 3 YES NO YES NO NO NO

open-loop 4 YES YES NO YES YES NO

shorted-loop 5 YES YES NO YES YES NO

no-output 6 NO YES NO NO YES NO

unreliable-other 7 YES YES YES YES YES YES

process-error 8 NO NO NO NO NO NO

multi-state-fault 9 NO NO NO NO NO NO

configuration-error 10 NO NO NO NO NO NO

-- enumeration value 
11 is reserved for a 
future addendum

11 YES YES NO YES YES YES

communication-failure 12 YES YES YES YES YES YES

member-fault 13 NO NO NO NO NO NO

monitored-object-fault 14 NO NO NO NO NO NO

tripped 15 NO NO NO NO NO NO
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System_Status

Indicates the physical status and logical status of the MICRO/I.

System_Status of the MICRO/I is fixed as OPERATIONAL.

Firmware_Revision

This property is set with the System Software Version of the MICRO/I.

Application_Software_Version

Set information about the application, such as the modification date of the created project data, as a fixed string with 
WindO/I-NV4.

Protocol_Services_Supported

This property represents the types of services that are supported by the MICRO/I.

Protocol_Object_Types_Supported

This property represents the types of objects that are supported by the MICRO/I.

Object_List

This property represents the list of created objects.

Parameter Value

OPERATIONAL 0

OPERATIONAL_READ_ONLY 1

DOWNLOAD_REQUIRED 2

DOWNLOAD_IN_PROGRESS 3

NON_OPERATIONAL 4

BACKUP_IN_PROGRESS 5
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4

Project Settings

The settings and screen data required to run the MICRO/I are contained in a data structure called a Project. You must 
create a project using WindO/I-NV4 before creating the screens and configuring the settings for the MICRO/I. This 
chapter describes the various settings required to create a project.

  

1.1 Creating New Project Data

● Create new project data by using the interactive quick start
You can create project data by following displayed dialog boxes and configuring settings step by step.

1 Click , then click New.

A Select Product Series dialog box is displayed.

Chapter 4 Project Settings

1 Creating and Manipulating WindO/I-NV4 Project Data

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P
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2 Select Product Series, Type Number, and Installation, and then click Next.

The Select Communication Driver dialog box is displayed.

■ Product Series
Select the MICRO/I type.

■ Type Number
A list of model numbers associated with the selected MICRO/I is displayed. Select the model number to use.

■ Installation
Select the MICRO/I installation direction from the following options. The supported display orientation varies based on 
the model.

HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F: Horizontal, Vertical (Counter Clockwise), Vertical (Clockwise)

HG2G-5T, HG1G: Horizontal, Vertical (Counter Clockwise), Vertical (Clockwise), 
Horizontal (Rotate 180°)

HG1P: Horizontal
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3 Select Manufacturer and Communication Driver and then click OK.

■ Manufacturer
Select the manufacturer name of the external device used.

■ Communication Driver
Shows the communication driver list for the select manufacturer. Select the communication driver to use.

■ Expression of Device Address Format
Select the format for the device address.

This option can only be configured when Allen-Bradley is selected for Manufacturer.

This concludes creating project data.
Next you will create a screen. For details, refer to Chapter 5 “3.1 Properties of Base Screen Dialog Box” on page 5-14.

Allen-Bradley: Enter device addresses in the Allen-Bradley format.
Example: B 10:123/5

WindO/I-NV4: Enter device addresses in the WindO/I-NV4 format.
Example: B 1012305

You can return to the Select Communication Driver dialog box and change its setting by clicking 
Previous.
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1.2 Opening Project Data

● Opening project data
You can open project data that has already been created.

1 Click , then click Open.

The Open dialog box is displayed.

2 Select the file and click Open.

Next you will open a screen. For details, refer to Chapter 5 “2.2 Opening Screens” on page 5-3.

If a password has been configured for the project data, the Enter Password screen will be displayed.
The password to enter varies based on the check box setting of the Use Password to open a Project 
found under the Options tab in the Security dialog box.
When this check box is checked, enter the password for Use Password to open a Project.
When this check box is unchecked, enter the password for the user account assigned to the Administrator 
security group.
For details, refer to Chapter 23 “User Accounts and the Security Function” on page 23-1.

Project data can also be opened by the following methods.

Click  and then click project data on the Recent Projects list
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1.3 Saving Project Data

● Saving project data
You can save the project data being edited.

Click  and then click Save.

When new project data is created and you have never save it, the Save As dialog box is displayed.
Enter the project name and then click Save.
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● Saving project data with a different name
You can save the project data being edited with a different name.

1 Click , then click Save As.

The Save As dialog box is displayed.

2 Enter the project name and click Save.

• You cannot use the following characters in the project name.
   . \ / : * ? “ < > |

• You cannot create project data in read-only folders or in WindO/I-NV4’s working folders (temporary 
folders that start with “~”).
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1.4 Printing Project Data

You can print the settings for the project data being edited and its screen images.

1 Click  and then click Print and Print Settings.

The Print Settings dialog box is displayed.

2 Select the check boxes of the items to print in (Print Items), and configure the items as necessary.

When an item is selected, the settings are displayed in (Detailed Settings) to the right.

3 Select Output to and click Print.

■ Printer
The data is printed on the printer connected to the computer.
The Windows Print dialog is displayed. For details, refer to Windows help.

■ Word Document
The data is output to a Word file.
The Save As dialog box is displayed. Specify the save location and file name, and then click Save.

If the print settings have been completed, click , and then press Print and Print to immediately start 

printing.

(Print Items) (Detailed Settings)

The data cannot be output to a Word file if Microsoft Office is not installed on the computer.



1 Creating and Manipulating WindO/I-NV4 Project Data

4-8 WindO/I-NV4 User’s Manual

● Print Settings Dialog Box
The items to print and details for those items are configured in the Print Settings dialog box.

■ (Print Items)
Select the check boxes of the items to print.

*1 This is applicable for models with an audio interface only.
*2 This is applicable for models with a video interface only.

(Print Items) (Detailed Settings)

Cover Page: Select the cover page items, enter the information to print, and those items will be 
printed. For details, refer to “Cover Page” on page 4-10.

Project Settings: Select the project setting items and those settings will be printed. For details, refer 
to “Project Settings” on page 4-11.

Alarm Log Settings: Select the print target for the alarm log settings and those settings will be printed. 
For details, refer to “Alarm Log Settings” on page 4-12.

Data Log Settings: Select the print target for the data log settings and those settings will be printed. 
For details, refer to “Data Log Settings” on page 4-12.

Operation Log Settings: Target Events to record in the operation log settings will be printed.

Recipe Settings: Settings in the recipe settings will be printed.

Preventive Maintenance Settings: Prints the Settings in the Preventive Maintenance.

E-mail Settings: Select the print target for the e-mail settings and those settings will be printed. For 
details, refer to “E-mail Settings” on page 4-13.

File Transfer: Settings in the file transfer settings will be printed.

FTP Server Manager: Settings in the FTP Server Manager will be printed.

Sound Settings*1: Prints the (Settings) in Sound Settings will be printed.

Multimedia Settings*2: Prints the Movie File List, Use Event Recording and Input Signal in the 
Multimedia Settings.

User Accounts: Number, User Name, Security Group and the settings on the Option tab of the 
user accounts will be printed.

Security Settings: Number, Group Name, and the Operations that are permitted in the security 
settings and the privileges for the Custom Web Pages will be printed.
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■ (Advanced Setting)
This area is used to configure the details of the items selected in (Print Items). The configured items will be printed 
according to the print format.
When an item is selected in (Print Items), the settings are displayed in (Advanced Setting).

■ Output to
Select the output destination when printing.

■ Print Preview
Displays the Print Preview dialog box. An image of the layout to print on paper will be displayed in the preview. The 
layout can be configured while checking the preview. For details, refer to “Print Preview Dialog Box” on page 4-16.

■ Print
If Printer is selected for Output to, the Windows Print dialog box is displayed. For details, refer to Windows help.
If Word Document is selected for Output to, the Save As dialog box is displayed. Specify the save location and file 
name, and then click Save.

Global Script: Settings in Global Script will be printed.

Script Manager: Select the print target for the Script Manager and those settings will be printed. For 
details, refer to “Script Manager” on page 4-13.

Text Manager: Select the (Text Messages List) for the Text Group and those settings will be 
printed. For details, refer to “Text Manager” on page 4-14.

Tag Editor: Prints the device addresses used in the project, the tag names and the comments.

Screens: Items such as the screen settings, list of laid out objects, and an image of the 
screen will be printed. For details, refer to “Screen” on page 4-15.

Printer: The data is printed on the printer connected to the computer.

Word Document: The data is output to a Word file.

The data cannot be output to a Word file if Microsoft Office is not installed on the computer.

The print preview will not work properly if Internet Explorer 8 or higher is not installed on the computer.
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Cover Page

■ Screen Info
Select the check boxes of the items to print about the project data information.

■ Programmer Info
Select the check boxes of the items to print about the programmer of the project data.

■ Supplementary Info
Select the check boxes of the items to print about the programmer of the project data.

Title: Enter the title of the project data. The maximum length is 90 characters on 3 lines.

Created on: Select the creation date of the project data.

Delivered on: Select the delivery date of the project data.

Control No.: Enter the control number of the project data. The maximum length is 60 characters.

Version No.: Enter the version number. The maximum length is 60 characters.

Company: Enter the name of the company. The maximum length is 60 characters on 2 lines.

Address: Enter the address of the company. The maximum length is 120 characters on 4 lines.

Department: Enter the department in the company. The maximum length is 60 characters on 2 lines.

Name: Enter the name of the programmer. The maximum length is 60 characters.

Phone: Enter the telephone number of the company. The maximum length is 60 characters.

Fax: Enter the fax number of the company. The maximum length is 60 characters.

Comment: Enter a comment for the project data.
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Project Settings

■ Print Content
Select the check boxes of the project settings to print.

System: The settings on the System tab will be printed.

Communication Interface: Interface and Function that have been configured and the corresponding 
Interface Settings will be printed.

Communication Driver: The function of the configured external device and its Manufacturer and 
Communication Driver will be printed.

Communication Driver Network: Settings will be printed. The settings of external devices for which External 
Device Communication is set to N/A will not be printed.

User Communication: Protocol Name will be printed. Settings for which Protocol Name is set to N/A 
will not be printed.

Autorun: The Enable USB Autorun and Open Popup Screen when USB Flash Drive is 
inserted settings will be printed.

Web Server: All settings on the Web Server tab will be printed.

FTP Server: All settings on the FTP Server tab will be printed.

Expansion Module: All settings on the Expansion Module tab will be printed.

External Memory Device: All settings on the External Memory Device tab will be printed.

E-mail: All settings on the E-mail tab will be printed.

Sub Host Communication: All settings on the Sub Host Communication tab will be printed.

O/I Link: If Function is set to O/I Link Master, then Slave Settings will be printed.
If Function is set to O/I Link Slave, then O/I Link Station will be printed.

Font/Kanji Dictionary Data: The settings of the Optional Fonts to be downloaded and the Use Kanji 
dictionary data will be printed.

Printer: All settings on the Printer tab will be printed.

BACnet/IP Settings: Prints the settings on the BACnet/IP Settings tab.
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Alarm Log Settings

■ Print Content
Select the print target to print from Basic or Advanced.

Data Log Settings

■ Print Content
Select the print target to print from Basic or Advanced.

Basic: Settings on the Channel tab will be printed.
The settings of numbers that do not use the alarm function will not be printed.

Advanced: Prints the Basic print content, the Storage Method and the Monitoring Period on the General tab, 
and the contents of the External Memory Device tab, the Printing tab and the Options tab.

Basic: Settings will be printed.
Channel numbers for which Log function is Disable will not be printed.

Advanced: The Basic print content, Channel Name and Condition of Writing to Data Storage Area on the 
General tab, the External Memory Device tab, and the output data of the data sampled for each 
channel will be printed.
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E-mail Settings

■ Print Content
Select the print target to print from Basic or Advanced.

Script Manager

■ Print Content
Select the print target to print from Basic or Advanced.

Basic: Settings will be printed.
Numbers for which E-mail Function is Disable will not be printed.

Advanced: Only content that differs from the default content will be printed for the Basic print content and E-
mail Function, Trigger Condition, and E-mail content for each number. Numbers for which E-
mail Function is Disable will not be printed.

Basic: Prints the Script List.

Advanced: Prints the Basic print content and the Script ID, the Script Name, the Data Type, the contents of 
the registered script.
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Text Manager

■ Print Content

Please select the group numbers to print: Select the check boxes of the Text Group to print the Text Message List. 
Up to 6 groups can be printed at once.

Group No.: Displays the number of the Text Group.

Group Name: Displays the Text Group Name.
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Screen

■ Print Range

■ Print Content
Select the print target to print from Basic or Advanced.

■ Screen Image

Screen Type: Select the screens to print from the following items.
All, Base Screen, Popup Screen

Screen List: This list shows screens that have already been created. Select the check boxes of the 
screens to print.

Print Object List: Select this check box to print the object list.
Select the items of data that will be output when printing the object list. Select the check 
boxes of the items to output.
Name, Type, Text ID, Text, Device Address, Trigger Type/Trigger Condition, 
Trigger Type(visible)/Trigger Condition(visible)

State: Changes the state of the parts for printing. Select the state from the following items.
OFF, ON, ON, OFF (Both)

Invert white and black: Select this to print the screen by inverting the colors so white is black and black is white.

Display Object No.: Select this check box to display and print object numbers.

Show Part Name: Select this to print the screen by displaying part names.

Show Device Address: Select this to print the screen by displaying device addresses.
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● Print Preview Dialog Box
Displays the Print Preview dialog box. An image of the layout to print on paper will be displayed in the preview. The 
layout can be configured while checking the preview. This is a Windows dialog box.

■ (Print Document)
The Windows Print dialog box is displayed. The opened project data will be printed. For details, refer to Windows 
help.

■ (Portrait)
Sets the paper orientation to portrait.

■ (Landscape)
Sets the paper orientation to landscape.

■ (Page Setup)
Displays the Page Setup dialog box. Use this dialog box to set up the page layout, such as the page size, orientation, 
and headers and footers.

■ (Turn Headers and Footers On or Off)
Sets whether or not to print headers and footers when printing. Each click of the button switches between show and 
hide.

■ (View Full Width)
Use this button to display one page of the print at its full width in the print preview dialog box.

■ (View Full Page)
Use this button to display one entire page of the print in the print preview dialog box.

■ (Show Multiple Pages)
Selects the number of pages to display in the preview from the following options.
1 Page View, 2 Page View, 3 Page View, 6 Page View, 12 Page View

■ (Change Print Size)
Selects the print size on the paper from the following options.
30%, 50%, 60%, 70%, 80%, 85%, 90%, 95%, 100%, 125%, 150%, 200%, Custom

(Current Page)

(Print Preview)
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■ (Print Preview)
Displays a preview of the content that will be printed.

■ (Current Page)
Indicates the current page number in (Current Page)/(Total Pages) format. You can also enter a page number to 
display it.

■ (First Page) 
Displays the first page.

■ (Previous Page) 
Displays the previous page.

■ (Next Page) 
Displays the next page.

■ (Last Page)
Displays the last page.

Drag  /  to adjust the margins.
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1.5 Comparing Project Data

Compares project data during editing with the screens and scripts of saved projects. 

1 On the Home tab, in the Project group, click Compare.

The Open dialog box is displayed.

2 Select a file to compare with, then click Open.

The Comparison Result window is displayed.

Comparison results are displayed using colored text.

Blue: Complete match

Red: Different content

Green: Only saved in the open project

Gray: Only saved in the comparison project

To compare with the comparison project data again, click the arrow to the right of Compare from the 
Project group of the Home tab, then click Recompare.
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1.6 Changing Project Settings

● Changing Product Series
This section describes how to change the product series set in the project data being edited.

1 Click Change Product Series on the status bar.

The Change Product Series dialog box is displayed.

2 Select Product Series, Model, and Installation, and then click OK.

The Save As dialog box is displayed.

3 Specify the save location and file name, and then click Save.
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4 When the data is finished being converted, click Close.

• Color settings (color data) are not converted.
• If the Popup Screen size is larger than the Base Screen size after the Product Series is changed, the 

Popup Screen size is changed to the same size as the Base Screen.
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● Changing Communication Drivers
This section describes how to change the communication driver set in the project data being edited.

1 With Communication Driver on the status bar, click one of External Device Communication 1 to External 
Device Communication 4.

The Communication Driver tab on the Project Settings dialog box is displayed.

2 Change the settings on each tab as necessary.

3 Click the Communication Driver Network tab, change the settings as necessary and then click OK.

The confirmation message is displayed.
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4 Check the message and click Yes.

If there are no device addresses that correspond to the external device addresses used in the current 
project data after changing the communication driver, the items set with those device addresses are blank.
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1.7 Closing Project Data

You can close the project data being edited.

Click  and then click Close.

If the project data being edited has not been saved, a confirmation message for saving the project data is 
displayed.

• Click Yes to save the project data and close it.
• Click No to close the project data without saving changes.
• Click Cancel to return to the editing screen without saving the project data.
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The Project Settings dialog box is used to configure MICRO/I operations and functions for the project overall.
This section describes the configuration procedure for project settings.

1 On the Configuration tab, in the System Setup group, click Project.
The Project Settings dialog box is displayed.

2 Change the settings on each tab as necessary.

2 Project Settings Configuration Procedure

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P
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This section describes items and buttons on the Project Settings dialog box.

3.1 System Tab

The System tab is used to configure MICRO/I operations for the project data overall.

■ Screen Number Format
Selects the type of data to use for the System Area 1 Display screen number (address number+0) as BCD or BIN.

■ Start Time (sec)
Specifies the time from when the MICRO/I power is turned on until communications start with the external device 
(0 to 9999 seconds).

3 Project Settings Dialog Box

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

Default Screen: Specifies the screen number of the base screen to display first when the MICRO/I is turned on (0 to 
3000). When 0 is specified, the MICRO/I is in the screen waiting state. Write a screen number to 
System Area 1 Display screen number (address number+0) or specify the default screen number 
from 1 to 3000.
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■ Backlight
These options configure the backlight control function.

■ Enable Touch Sound
Select this check box to play a sound when the screen is pressed.

■ Enable Maintenance
Select this check box to display the maintenance screen during operation. The methods for displaying the 
maintenance screen are as follows.
Press the upper-left corner of the MICRO/I screen for three seconds or more.
If the base screen is switched before three seconds have elapsed, the load operation for the maintenance screen will 
be canceled. Please press the screen again.

*1 HG5G/4G/3G-V, HG4G/3G only

Auto OFF: Select this check box to turn off the backlight when the MICRO/I is unused for an extended 
period of time. To turn on the backlight, touch the screen or write 1 to System Area 1 Backlight 
auto off bit (address number+1, bit 5) or System Area 1 Backlight bit (address number+1, bit 0).

Time (min): Specifies the time (1 to 9999) from when the MICRO/I is last used to when the 
backlight is turned off.

Halve the Brightness: Select this check box to lower the backlight brightness when the MICRO/I is unused for an 
extended period of time. To return to the backlight to its original brightness, touch the screen 
or write 1 to System Area 1 Backlight bit (address number+1, bit 0).

Time (min): Specifies the time (1 to 9999) from when the MICRO/I is last used to when the 
backlight brightness is lowered.

Light ON with Screen Changing:
When the backlight is turned off or when the backlight brightness has been lowered with the 
backlight control function, select this check box to turn on the backlight or restore the 
backlight brightness when the screen is switched.
This option can only be configured when the Auto OFF check box or the Halve the 
Brightness check is selected.

(Touch sound)*1: These options select the touch sound.
These options can only be configured when Enable Touch Sound is selected.

Beep Sound:Plays a beep (electronic sound).

Sound File: Plays a sound file.

Sound ID: Configures the sound file to play as the touch sound.

Click  to display the Sound Settings dialog box. For the 
sound file configuration procedure, refer to Chapter 21 “To play 
a sound file as a touch sound instead of a beep.” on page 21-3.

Control by Device Address: When Beep Sound is selected, select this check box to control the touch sound with 
a value of device address. When Sound File is selected, the touch sound cannot be 
controlled with a value of device address, even if this check box is selected.
This option can only be configured when Enable Touch Sound is selected.

(Device Address): Specifies the word device that controls the touch sound.

Click  to display the Tag Editor. For the device address 
configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.
The control over a touch sound with a value of device address 
is as follows.
0: Do not play the touch sound.
1: Play the touch sound.
2: Play a shortened touch sound.

Press and hold 
3 or more seconds

MICRO/I
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■ Use Large Font
Select this check box to display text on the MICRO/I in high-quality fonts. The Japanese or European font is 
replaced with the high-quality fonts depending on the magnification.
To use high-quality fonts, the fonts must be downloaded to the MICRO/I at the same time as the project. To 
download fonts, specify the high-quality fonts under Optional Fonts to be downloaded in the Font Settings tab.
For details on high-quality fonts, refer to Chapter 2 “High-quality Fonts” on page 2-10.

■ Enable Two-point Push
Select this check box to enable two-point push for touch switches. When two-point push is enabled, the bottom 
switch and the switch above it operate in order.
On an analog touch panel, this function operates two overlapping switches when the two are pressed. This is not a 
function to simultaneously operate two touch switches when they are both pressed.

■ Enable Low Battery Warning*2

Select this check box to display a warning message when the backup battery is dead.
This option also displays a warning message when it is time to replace the battery.

■ Show script error
Select this check box to display an error message on the screen when a script error occurs.

■ System Language
Selects the display language for the Maintenance screen, System Mode screens, Device Monitor, and Adjust 
Brightness screen as English or Japanese.
For details, refer to Chapter 34 “1 Maintenance Screen” on page 34-1.

■ Use System Area
The System Area is an area of predetermined device addresses to control the screen and communicate error 
information and time information between the MICRO/I and the external device. Select this check box to use the 
System Area. For details, refer to “System Area” on page 4-30.

■ Flashing Cycle
Selects the cycle when flashing (displaying a drawing object by switching it on and off at a fixed interval) drawings 
and parts as 1.0 sec or 0.5 sec.

*2 HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F/-5T, HG1G only

Script error information is saved to the HMI Special Data Registers (LSD52 and LSD53). For details, refer to 
Chapter 20 “1.4 Script Error” on page 20-4.

Device Address: Specifies the word device to use as the System Area. The System Area is allocated starting from the 
configured device address.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 
2 “5.1 Device Address Settings” on page 2-68.

Use System Area 3, 4: Select this check box to use System Area 3 and 4.

Clear Keypad bit in System Area automatically: Select this check box to automatically set the System Area 2 
numerical input setting and character input setting bits to 0 after 
they have been set to 1.
The System Area 2 bits cleared by this function are as follows.
Numerical input setting complete (address number+3, bit 0)
Numerical input setting cancel (address number+3, bit 1)
Character input setting complete (address number+3, bit 5)
Character input setting complete (address number+3, bit 6)
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■ Watch Dog
Select this check box to monitor on the external device side whether or not the MICRO/I and the external device are 
communicating by writing a set value (00FF (Hex)) at a fixed interval.

■ Disable Switch
Select this check box to enable and disable touch switches with a value of device address.
Touch switches are enabled when the value of device address is 1. They are disabled when the device value is 0.

■ Use Device Cache
Select this check box to execute processing by reading all the values of the external device addresses configured for a 
screen when switching the base screen or when displaying a popup screen.

■ Start Part with synchronous
Select this check box to operate commands and HMI Special Internal Relays LSM1, LSM2, LSM3, and LSM5 after 
reading all the values of the external device addresses configured on the screen.
When this check box is cleared, all processing is immediately executed when the screen is displayed.

■ Start from 0 in Always Entry Mode of Numerical Input
Select this check box to display 0 when a Numerical Input that has the Always Entry Mode check box selected on 
the General tab is displayed on the screen. When this check box is cleared, the value of device address is displayed.
This option is reflected for all Numerical Inputs configured in the project.

■ Storage Method of String Data
Selects the handling method for text entered with the Character Input and values of device addresses read by the 
Message Display.

Device Address: Specifies the word device to write the value.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 
2 “5.1 Device Address Settings” on page 2-68.

Time (sec): Specifies the interval to write the value (1 to 65535).

Device Address: Specifies the bit device or the bit number of the word device that is read to enable or disable touch 
switches.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 
2 “5.1 Device Address Settings” on page 2-68.

from Upper byte: Values of device addresses are read from and written to the upper order byte.
Example: When the text ABCDE is entered with the Character Input and written to the 

destination device address LDR100

from Lower byte: Values of device addresses are read from and written to the lower order byte.
Example: When the text ABCDE is entered with the Character Input and written to the 

destination device address LDR100

Device address
Stored value

Upper byte Lower byte
LDR100 'A' = 41 (Hex) 'B' = 42 (Hex)
LDR101 'C' = 43 (Hex) 'D' = 44 (Hex)
LDR102 'E' = 45 (Hex) 0

NULL termina�ng character

Device address
Stored value

Upper byte Lower byte
LDR100 'B' = 42 (Hex) 'A' = 41 (Hex)
LDR101 'D' = 44 (Hex) 'C' = 43 (Hex)
LDR102 0 'E' = 45 (Hex)

NULL termina�ng character

When handling strings, 0 is written to the device address as the NULL terminating character and treated as 
the end of the string.
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■ Storage Method of 32-bit Numerical Data for Internal Devices
Selects the handling method for values of internal devices when UBIN32(D), BIN32(L), BCD8(EB), or Float32(F) 
is selected for Data Type from the following. The initial value is set according to the communication driver that was 
selected when the project was created. When the bit devices in control devices are handled as words, this setting is 
always the from Lower word.

■ Use Large Password Screen*3

Select this check box to display the Password Screen at a large size.

*3 HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F only

from Upper word: Values of internal devices are read from and written to the upper order word.
Example: When Data Type for the Numerical Input is UBIN32(D) and the numerical 

value 12345678 (Hex) was entered and written to destination device address 
LDR100

from Lower word: Values of internal devices are read from and written to the lower order word.
Example: When Data Type for the Numerical Input is UBIN32(D) and the numerical 

value 12345678 (Hex) was entered and written to destination device address 
LDR100

Device address Stored value
LDR100 1234 (Hex) Upper word
LDR101 5678 (Hex) Lower word

Device address Stored value
LDR100 5678 (Hex) Upper word
LDR101 1234 (Hex) Lower word
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● System Area

Overview

The area of predetermined device addresses to control the screen and communicate error information and time 
information between the MICRO/I and the external device is called the System Area.
The System Area on the MICRO/I is as follows.

To use System Area 1 and 2, select the Use System Area check box on the Project Settings dialog box. To use 
System Area 3 and 4, select the Use System Area 3, 4 check box.
Specify the word device to use as the System Area in Device Address to allocate the System Area starting at the 
configured device address.
Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.
Example: When Device Address is configured as LDR100

System Area 1

This area configures the MICRO/I display, beep, and clearing bits.

System Area Number of word addresses User Access

System Area 1 2 Read and write

System Area 2 2 Write

System Area 3 4 Read

System Area 4 4 Write

LDR100
LDR101
LDR102
LDR103
LDR104
LDR105
LDR106
LDR107
LDR108
LDR109
LDR110
LDR111

System Area 1
(The address number of Top Device Address)

+1

+2

+3

+4

+5

+6

+7

+8

+9

+10

+11

System Area 2

System Area 3

System Area 4

Address 
number Bit Function Description

+0 0 to 15 Display screen number

This bit stores the number of the screen being displayed. Write a value to 
this bit to change the screen to that number. Immediately after the power 
is turned on, the value configured by Default Screen in the Project 
Settings dialog box is stored here.
If the screen number does not exist in the project data, an error message 
(No screen data) is displayed. However, when 0 is written to this bit, the 
screen is not switched and no error message is displayed.

+1

0 Backlight

This bit stores the illumination state of the backlight. Write a value to this 
bit to change the state.

0: Off
Turns the backlight off.

1: On
Turns the backlight on.

1 Flash display (1 sec. cycle)

This bit stores the screen flash state (1 sec. cycle). Write a value to this 
bit to change the state. This bit is 0 immediately after the power is turned 
on.

0: Do not flash
Stop flashing the screen and turn it on.

1: Flash
Flashes the screen in one second intervals.
When the Flash display (1 sec. cycle) (address number+1, bit 1) and 
the Flash display (0.5 sec. cycle) (address number+1, bit 2) are both 
1, the screen flashes at one second intervals.
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System Area 2

This area stores MICRO/I states and error information. These bits are 0 immediately after the power is turned on.

+1

2 Flash display 
(0.5 sec. cycle)

This bit stores the screen flash state (0.5 sec. cycle). Write a value to this 
bit to change the state. This bit is 0 immediately after the power is turned 
on.

0: Do not flash
Stop flashing the screen and turn it on.

1: Flash
Flashes the screen in 0.5 second intervals.
When the Flash display (1 sec. cycle) (address number+1, bit 1) and 
the Flash display (0.5 sec. cycle) (address number+1, bit 2) are both 
1, the screen flashes at one second intervals.

3 to 4 Reserved

5 Backlight auto off

This bit stores whether or not the function to automatically turn off the 
backlight is enabled when the Auto OFF check box is selected under 
Backlight in the Project Settings dialog box. Write a value to this bit 
to change the state. This bit is 0 immediately after the power is turned 
on.

0: Enabled
Automatically turns off the backlight when the MICRO/I is unused 
for an extended period of time.

1: Disabled
Does not automatically turn off the backlight when the 
MICRO/I is unused for an extended period of time. The backlight 
turns on if the value changes to 1 when the backlight is off.

6 Beep

This bit stores the beep state. Write a value to this bit to change the 
state. This bit is 0 immediately after the power is turned on.

0: Stop
Stops continuous beeping.

1: Beep
Starts continuous beeping.

7 Screen display

This bit stores the screen display state. Write a value to this bit to change 
the state.

0: Hide
Hides the screen when the backlight is on.

1: Show
Displays the screen.

8 Reserved

9 Clear error
Write 1 to this bit to clear the error information bit (System Area 2, 
address number+2). This bit automatically changes to 0 when processing 
is finished.

10 Numerical input setting 
clear

Write 1 to this bit to clear the Numerical input setting complete bit 
(System Area 2 address number+3, bit 0) and the Numerical input setting 
cancel bit (System Area 2 address number+3, bit 1). This bit 
automatically changes to 0 when processing is finished.

11 Character input setting 
clear

Write 1 to this bit to clear the Character input setting complete bit 
(System Area 2 address number+3, bit 5) and the Character input setting 
cancel bit (System Area 2 address number+3, bit 6). This bit 
automatically changes to 0 when processing is finished.

12 to 15 Reserved

Address 
number Bit Function Description

Address 
number Bit Function Description

+2

0 to 2 Reserved

3 Communication error
This bit changes to 1 when a communication error occurs in external 
device communication. To clear this bit, write 1 to the Clear error bit 
(System Area 1 address number+1, bit 9).

4 Reserved
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*1 HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F only

+2

5 Processing error

This bit changes to 1 when executing the following arithmetic operations. 
To clear this bit, write 1 to the Clear error bit (System Area 1 address 
number+1, bit 9).
• There is data which cannot be handled with the specified data type; 

BCD4(B), BCD8(EB), or Float32(E).
• A value is divided by 0.
• The setting of Origin, Minimum, or Maximum for the Bar Chart or Line 

Chart are invalid, or the Minimum and Maximum are the same values.
• The setting of Minimum, Maximum, or ranges for the Meter are invalid, 

or the Minimum and Maximum are the same values.

6 Device range error

This bit changes to 1 when writing a value to a device address that falls 
outside its range or when exceeding the restrictions on the number of 
configured device addresses. To clear this bit, write 1 to the Clear error bit 
(System Area 1 address number+1, bit 9).

7 Clock IC error*1
This bit changes to 1 when the MICRO/I internal clock stops. To clear this 
bit, write 1 to the Clear error bit (System Area 1 address number+1, bit 
9).

8
Memory card access 
error*1

This bit changes to 1 when an error occurs when the SD memory card 
inserted in the MICRO/I is accessed. To clear this bit, write 1 to the Clear 
error bit (System Area 1 address number+1, bit 9).

9 Printer timeout error*1
This bit changes to 1 when a printing error occurs when data is output to 
the printer connected to the MICRO/I. To clear this bit, write 1 to the 
Clear error bit (System Area 1 address number+1, bit 9).

10 Script error

This bit changes to 1 when an error occurs during script execution. Error 
details are stored in HMI Special Data Registers LSD52 and LSD53. For 
details, refer to Chapter 20 “1.4 Script Error” on page 20-4. To clear this 
bit, write 1 to the Clear error bit (System Area 1 address number+1, bit 
9).

11 USB flash drive access 
error

This bit changes to 1 when an error occurs when accessing an inserted 
USB flash drive.

12 Replace battery error
This bit changes to 1 when it is time to replace the backup battery. To 
clear this bit, write 1 to the Clear error bit (System Area 1 address 
number+1, bit 9).

13 Replace battery error (low 
battery)

This bit changes to 1 when the backup battery is low. To clear this bit, 
write 1 to the Clear error bit (System Area 1 address number+1, bit 9).

14 Backup data error

This bit changes to 1 when the backup battery is dead or low and the 
data sampled by the log functions and values in the HMI Keep Registers 
and HMI Keep Relays disappears. To clear this bit, write 1 to the Clear 
error bit (System Area 1 address number+1, bit 9).

15 Reserved

+3

0 Numerical input setting 
complete

This bit changes to 1 when finished entering a numerical value with the 
Numerical Input. This bit changes to 0 when entering a numerical value 
or when entering a numerical value has been canceled. Write 1 to 
numerical input setting clear (address number+1, bit 10) to clear this bit.

1 Numerical input setting 
cancel

This bit changes to 1 when entering a numerical value with the Numerical 
Input was canceled. This bit changes to 0 when entering a numerical 
value or when entering a numerical value has been completed. Write 1 to 
numerical input setting clear (address number+1, bit 10) to clear this bit.

Address 
number Bit Function Description
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System Area 3

This area is for changing the MICRO/I internal clock data.

Address 
number Bit Function Description

+3

2 Backlight auto off running

The value of this bit changes to 1 when Auto OFF is configured and the 
backlight was turned off by this function. To configure Auto OFF, select 
the Auto OFF check box under Backlight in the Project Settings 
dialog box. This bit automatically changes to 0 when the backlight turns 
on.

3
Sending output to a 
printer

This bit changes to 1 when sending output to the printer. This bit 
automatically changes to 0 when finished sending output.

4 Transferring recipe This bit changes to 1 when transferring recipe data. This bit automatically 
changes to 0 when the transfer is finished.

5
Character input setting 
complete

This bit changes to 1 when finished entering text with the Character 
Input. This bit changes to 0 when entering text or when entering text has 
been canceled. Write 1 to character input setting clear (address 
number+1, bit 11) to clear this bit.

6
Character input setting 
cancel

This bit changes to 1 when entering text with the Character Input is 
canceled. This bit changes to 0 when entering text or when entering text 
has been completed. Write 1 to character input setting clear (address 
number+1, bit 11) to clear this bit.

7 to 15 Reserved

Address 
number Bit Function Description

+4
0 to 7 Clock data Month Enter Month (01 to 12) as a 2 digit BCD.

8 to 15 Clock data Year Enter Year (00 to 99) as a 2 digit BCD.

+5
0 to 7 Clock data Hour Enter Hour (00 to 23) as a 2 digit BCD.

8 to 15 Clock data Day Enter Day (01 to 31) as a 2 digit BCD.

+6
0 to 7 Clock data Second Enter Second (00 to 59) as a 2 digit BCD.

8 to 15 Clock data Minute Enter Minute (00 to 59) as a 2 digit BCD.

+7
0 to 14 Reserved Enter 0 in the reserved area.

15 Update Write 1 to this bit to write the entered data (address number+4 to 
+6, bits 0 to 15) to the MICRO/I internal clock data.

When the value of the update bit (address number+7, bit 15) becomes 1, the clock data is updated as a 
whole.
Year, month, day, hour, minute, and second cannot be set individually.
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System Area 4

This area reads the MICRO/I internal clock data in one minute intervals.

Address 
number Bit Function Description

+8
0 to 7 Clock data Month These bits store the current Month (01 to 12) value as a 2 digit BCD.

8 to 15 Clock data Year These bits store the current Year (00 to 99) value as a 2 digit BCD.

+9
0 to 7 Clock data Hour These bits store the current Hour (00 to 23) value as a 2 digit BCD.

8 to 15 Clock data Day These bits store the current Day (01 to 31) value as a 2 digit BCD.

+10
0 to 7 Reserved

8 to 15 Clock data Minute These bits store the current MICRO/I clock data Minute (00 to 59).

+11
0 to 3 Clock data Day of Week

These bits store the current Day of Week value as a 2 digit BCD. The 
relationship between the day of the week and the value is as follows.
00: Sunday
01: Monday
02: Tuesday
03: Wednesday
04: Thursday
05: Friday
06: Saturday

4 to 15 Reserved
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3.2 Communication Interface Tab

The Communication Interface tab is used to configure the functions used by the MICRO/I communication 
interfaces.

■ Interface Configuration
Interface Configuration lists the communication interfaces and functions to use. Select the appropriate Interface  
(COM1, COM2, etc.) to switch Interface Settings to the items that can be configured for that communication 
interface.
The items displayed in Interface vary based on the model. The supported functions for each communication 
interface are as follows.

HG5G/4G/3G/2G-V

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

Name  Interface

Function

External Device 
Communication 

1 to 4

O/I Link
Master

O/I Link
Slave

User 
Communication

1 to 3

Sub Host
Communication

Printer
Maintenance

Communication

COM1
Serial Interface
(RS232C or 
RS422/485)

YES YES YES YES YES NO NO

COM2
(RS232C)

Serial Interface
(RS232C) YES NO NO YES YES NO NO

COM2
(RS422/485)

Serial Interface
(RS422/485) YES YES YES YES YES NO NO

Ethernet Ethernet Interface YES NO NO YES NO NO YES

USB2
(USB-A)

USB Interface
(Type A) NO NO NO YES NO NO NO

USB1
(USB-B)

USB Interface
(Mini-B) NO NO NO NO NO YES YES
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HG4G/3G, HG2G-5F

HG2G-5T

HG1G/1P

*1 HG1G only

Name  Interface

Function

External Device 
Communication 

1 to 4

O/I Link
Master

O/I Link
Slave

User 
Communication

1 to 3

Sub Host
Communication

Printer
Maintenance

Communication

COM1
Serial Interface
(RS232C or 
RS422/485)

YES YES YES YES YES NO NO

COM2
Serial Interface
(RS232C or 
RS422/485)

YES YES YES YES YES NO NO

Ethernet Ethernet Interface YES NO NO YES NO NO YES

USB2
(USB-A)

USB Interface
(Type A) NO NO NO YES NO NO NO

USB1
(USB-B)

USB Interface
(Mini-B) NO NO NO NO NO YES YES

Name Interface

Function

External Device 
Communication 

1 to 4

O/I Link
Master

O/I Link
Slave

User 
Communication

1 to 3

Sub Host
Communication

Maintenance
Communication

SERIAL1(RS232C) Serial Interface
(RS232C) YES NO NO YES YES NO

SERIAL1(RS422/485) Serial Interface
(RS422/485) YES YES YES YES YES NO

Ethernet Ethernet Interface YES NO NO YES NO YES

USB2(USB-A) USB Interface
(Type A) NO NO NO YES NO NO

USB(USB-B) USB Interface
(Mini-B) NO NO NO NO NO YES

Name Interface

Function

External Device 
Communication 

1 to 4

O/I Link
Master

O/I Link
Slave

User 
Communication

1 to 3

Sub Host
Communication

Maintenance
Communication

COM(RS232C)*1 Serial Interface
(RS232C) YES NO NO YES YES NO

COM(RS422/485) Serial Interface
(RS422/485) YES YES YES YES YES NO

Ethernet Ethernet Interface YES NO NO YES NO YES

USB2(USB-A) USB Interface
(Type A) NO NO NO YES NO NO

USB1(USB-B) USB Interface
(Mini-B) NO NO NO NO NO YES



WindO/I-NV4 User’s Manual 4-37

3 Project Settings Dialog Box

4

Project Settings

Functions Available with the Serial Interface
The following functions can be used with MICRO/I models equipped with the serial interface.

• Online
 Refer to Chapter 24 “Online Function” on page 24-1.

• Debug
 Refer to Chapter 25 “Monitor Function” on page 25-1.

• Barcode reader connection
 Refer to Chapter 3 “5 User Communication” on page 3-8.

Functions Available with the Ethernet Interface
The following functions can be used with MICRO/I models equipped with the Ethernet interface.

• Online
 Refer to Chapter 24 “Online Function” on page 24-1.

• Debug
 Refer to Chapter 25 “Monitor Function” on page 25-1.

• Web Server
 Refer to Chapter 28 “1 Web Server Function” on page 28-1.

• BACnet Communication*1

 Refer to Chapter 3 “7 BACnet Communication” on page 3-94.

Functions Available with the USB Interface
The following functions can be used with MICRO/I models equipped with a USB interface.

• Online
 Refer to Chapter 24 “Online Function” on page 24-1.

• Debug
 Refer to Chapter 25 “Monitor Function” on page 25-1.

• Printer connection
 Refer to Chapter 32 “Printer” on page 32-1.

• Barcode reader connection
 Refer to Chapter 3 “5 User Communication” on page 3-8.

The functions that can be used with the USB interface vary based on the MICRO/I model.

*1 HG5G/4G/3G/2G-V only

MICRO/I functions
HG5G/4G/3G/2G-V, 
HG4G/3G, HG2G-5F

HG2G-5T, HG1G/1P

Online YES YES

Debug YES YES

Printer connection YES NO

Barcode reader connection YES YES
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■ Interface Settings
The items that can be configured vary based on the communication interface selected under Interface 
Configuration.

When COM1, COM2, COM2(RS232C), or COM2(RS422/485) is selected under Interface Configuration

The items displayed in the Interface vary based on the model.

With multiple communication interfaces, External Device Communication 1 to External Device 
Communication 4 or User Communication 1 to User Communication 3 on the Function cannot be 
configured in multiple settings.

HG5G/4G/3G/2G-V: COM1, COM2(RS232C), COM2(RS422/485)

HG4G/3G, HG2G-5F: COM1, COM2

Function: Selects the function to use with the serial interface from the following.
N/A, External Device Communication 1, External Device Communication 2, External 
Device Communication 3, External Device Communication 4, O/I Link Master, O/I Link 
Slave, User Communication 1, User Communication 2, User Communication 3, Sub Host 
Communication
This communication interface is not used when N/A is selected.
The O/I Link Master and the O/I Link Slave can only be configured when the COM1, the 
COM2 or the COM2(RS422/485) is selected for the Interface under the Interface 
Configuration.

Baud Rate: Selects the communication speed with the external device from the following.
1200, 2400, 4800, 9600, 19200, 38400, 57600, 115200, 187500
The baud rate that can be configured varies based on Function.

Data Bits: Selects the data length as 7 or 8.
This option can only be configured when External Device Communication 1, External Device 
Communication 2, External Device Communication 3, External Device Communication 
4, User Communication 1, User Communication 2, User Communication 3, or Sub Host 
Communication is selected for Function.

Stop Bits: Selects the stop bits as 1 or 2.
This option can only be configured when External Device Communication 1, External Device 
Communication 2, External Device Communication 3, External Device Communication 
4, User Communication 1, User Communication 2, User Communication 3, or Sub Host 
Communication is selected for Function.

Parity: Selects the parity from the following.
None, Odd, Even
This option can only be configured when External Device Communication 1, External Device 
Communication 2, External Device Communication 3, External Device Communication 
4, User Communication 1, User Communication 2, User Communication 3, or Sub Host 
Communication is selected for Function.

Flow Control: Selects the flow control method as None or ER according to the external device being used.
This option can only be configured when External Device Communication 1, External Device 
Communication 2, External Device Communication 3, External Device Communication 4 
or Sub Host Communication is selected for Function.

Serial Interface: Select the interface standard for the serial port. The items that can be displayed vary based on the Interface 
under the Interface Configuration.

COM1, COM2: RS232C, RS422/485 2-wire, RS422/485 4-wire

COM2(RS232C): RS232C

COM2(RS422/485): RS422/485 2-wire, RS422/485 4-wire

This option can only be configured when the External Device Communication 1, the External 
Device Communication 2, the External Device Communication 3, the External Device 
Communication 4, the User Communication 1, the User Communication 2, the User 
Communication 3, or the Sub Host Communication is selected for Function.
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When SERIAL1(RS232C), SERIAL1(RS422/485), COM(RS232C), or COM(RS422/485) is selected under 
Interface Configuration

The items displayed in the Interface vary based on the model.

*1 HG1G only

HG2G-5T: SERIAL1(RS232C), SERIAL1(RS422/485)

HG1G/1P: COM(RS232C)*1, COM(RS422/485)

Function: Selects the function used by Serial Interface from the following.
N/A, External Device Communication 1, External Device Communication 2, External 
Device Communication 3, External Device Communication 4, O/I Link Master, O/I Link 
Slave, User Communication 1, User Communication 2, User Communication 3, Sub Host 
Communication
This communication interface is not used when N/A is selected.
The O/I Link Master and the O/I Link Slave can only be configured when the 
SERIAL1(RS422/485) or the COM(RS422/485) is selected for the Interface under the 
Interface Configuration.

Baud Rate: Selects the communication speed with the external device from the following.
1200, 2400, 4800, 9600, 19200, 38400, 57600, 115200, 187500
The baud rate that can be configured varies based on Protocol.

Data Bits: Selects the data length as 7 or 8.
This option can only be configured when External Device Communication 1, External Device 
Communication 2, External Device Communication 3, External Device Communication 
4, User Communication 1, User Communication 2, User Communication 3, or Sub Host 
Communication is selected for Function.

Stop Bits: Selects the stop bits as 1 or 2.
This option can only be configured when External Device Communication 1, External Device 
Communication 2, External Device Communication 3, External Device Communication 
4, User Communication 1, User Communication 2, User Communication 3, or Sub Host 
Communication is selected for Function.

Parity: Selects the parity from the following.
None, Odd, Even
This option can only be configured when External Device Communication 1, External Device 
Communication 2, External Device Communication 3, External Device Communication 
4, User Communication 1, User Communication 2, User Communication 3, or Sub Host 
Communication is selected for Function.

Flow Control: Selects the flow control method as None or ER according to the external device being used.
This option can only be configured when External Device Communication 1, External Device 
Communication 2, External Device Communication 3, External Device Communication 
4, or Sub Host Communication is selected for Function.

Serial Interface: Select the interface standard for the serial port. The items that can be displayed vary based on the 
Interface under the Interface Configuration.

SERIAL1(RS232C), COM(RS232C)*1: RS232C

SERIAL1(RS422/485), COM(RS422/485): RS422/485 2-wire, RS422/485 4-wire

This option can only be configured when External Device Communication 1, External Device 
Communication 2, External Device Communication 3, External Device Communication 
4, User Communication 1, User Communication 2, User Communication 3, or Sub Host 
Communication is selected for Function.
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When Ethernet is selected under Interface Configuration

Example: To communicate with two MICRO/Is and a computer via Ethernet
Set MICRO/I A, MICRO/I B, and the computer all to the same values: subnet mask 255.255.255.0, default 
gateway 192.168.1.254.
Set the IP addresses to values that do not conflict: MICRO/I A IP address 192.168.1.6, MICRO/I B IP 
address 192.168.1.7, computer IP address 192.168.1.8.

IP Settings
Selects the network setting method.

ComputerEthernet communication

IP address 192.168.1.6
Subnet mask 255.255.255.0
Default gateway 192.168.1.254

192.168.1.7
255.255.255.0
192.168.1.254

192.168.1.8
255.255.255.0
192.168.1.254

External 
device

MICRO/I A
External 
device

MICRO/I B

Local network

• Set the IP address, subnet mask, and default gateway according to the local network environment being 
used. When Automatically obtain the IP address is selected, the network settings are automatically 
assigned from the DHCP server on the local network environment being used. Settings assigned from the 
DHCP server can be checked on the Top Page in the System Mode.

• When Automatically obtain the IP address is selected, note the following points:
- It takes some time to acquire the network settings. If the download fails, increase the timeout time on 

the Home tab, in the Project group, in Comm.Setup. For details, refer to Chapter 24 “1.3 Change 
Communication Settings” on page 24-5.

- According to the DHCP server specifications, the IP address may change by removing and reinserting 
the Ethernet cable.

- After connecting the MICRO/I into a different network, turn the power to MICRO/I off and then on again.

Automatically obtain the IP address (DHCP).: Automatically sets the network when connected to a network.

Use the following IP address: Manually specifies the IP address, subnet mask, and default gateway.

IP Address: Specifies the IP address. (Default: 192.168.1.6)
The format is “xxx.xxx.xxx.xxx”. “xxx” stands for a 
numeric value from 0 to 255.
When connecting multiple devices to the same 
network, make sure to assign each device a unique 
IP address.

Subnet Mask: Specifies the subnet mask. (Default: 255.255.255.0)
The format is “xxx.xxx.xxx.xxx”. “xxx” stands for a 
numeric value from 0 to 255.
This value must be the same for all devices.

Default Gateway: Specifies the default gateway. (Default: 0.0.0.0)
The format is “xxx.xxx.xxx.xxx”. “xxx” stands for a 
numeric value from 0 to 255.
Set this value when using a router. Leave the value 
blank when not required.

Port Number Specifies the TCP port number (1 to 65535) to use for maintenance 
communication. (Default: 2537)

Forbid Maintenance Communication: Select this check box to prohibit access from a web browser terminal and 
to prohibit maintenance communication via Ethernet communication.

:
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DNS Settings
In order to access a DNS server from the MICRO/I, the IP address of the DNS server must be specified.
The setting method of the IP address of the DNS server is determined by the setting method of the network settings 
selected under IP Settings.

Regarding TCP port number of MICRO/I, note the following points.

The numbers that cannot be used: • 2538 (for pass-through)
• 2101 (for FC4A Series MicroSmart direct connection pass-through)

Duplicate numbers cannot be configured in the following functions:

• Maintenance communication 
( refer to “Port Number” on page 4-40)

• Web server function ( refer to “Port Number” on page 4-65)
• FTP server function ( refer to “Port Number” on page 4-66)
• TCP Server is selected for the User Communication 

( refer to “Port No.” on page 4-42)
• Modbus as Manufacture and Modbus TCP Server as 

Communication Driver are selected on the Communication 
Driver tab 
( refer to the WindO/I-NV4 External Device Setup Manual)

• YASKAWA Electric as Manufacture and MP2000(Ethernet) as 
Communication Driver are selected on the Communication 
Driver tab 
( refer to the WindO/I-NV4 External Device Setup Manual)

About Networking Terminology

IP Address: The number allocated to identify devices connected to an IP network such 
as the Internet or an intranet. The IP address is the address of each 
individual device on a network.

Subnet Mask: The subnet mask is used to indicate the position of the division between the 
network address portion and the external device address portion of an IP address.

Default Gateway: The device such as a computer or a router that represents the gateway used 
when connecting devices outside the network to which the device belongs.

Obtain DNS Server Address Automatically (DHCP): Automatically sets the IP address of the DNS server.
This can be selected when Automatically obtain the IP 
address (DHCP) is selected under IP Settings.

Use the Following DNS Server Addresses: Manually specifies the IP address of DNS Server.

Preferred DNS Server: Specifies the IP address of Preferred DNS 
Server. (Default: 0.0.0.0)
The format is “xxx.xxx.xxx.xxx”. “xxx” 
stands for a numeric value from 0 to 255.

Alternate DNS Server: Specifies the IP address of Alternate DNS 
Server. (Default: 0.0.0.0)
The format is “xxx.xxx.xxx.xxx”. “xxx” 
stands for a numeric value from 0 to 255.
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When Protocol1 to Protocol7 is selected for Ethernet under Interface Configuration

*1 HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F only

Function: Selects the user communication to configure for the selected function from the following.
External Device Communication 1, External Device Communication 2, External Device 
Communication 3, External Device Communication 4
User Communication 1, User Communication 2, User Communication 3

Operation Mode:
Selects the operation mode when performing user communication with the Ethernet interface.
This option can only be configured when User Communication 1, User Communication 2, or User 
Communication 3 is selected for Function.
TCP Client: The MICRO/I operates as a TCP/IP client and the external device operates as a TCP server. 

The MICRO/I connects to the TCP server and sends and receives data.
TCP Server: The MICRO/I operates as a TCP/IP server and the external device operates as a TCP client. 

The MICRO/I creates a listening port as a TCP server and waits for connections from TCP 
clients. After a connection, it sends and receives data with the TCP client.

UDP*1: The MICRO/I operates as a UDP server and client.
The MICRO/I sends data to the listening port of the external device. The external device 
also sends data to the MICRO/I's listening port and that data is received by the MICRO/I.

Target: Configures the IP address and port number for the external device.
These options can only be configured when TCP Client or UDP is selected for Operation 
Mode.
IP Address: Specifies the IP address for the target.

The format is “xxx.xxx.xxx.xxx”. “xxx” stands for a numeric value from 0 to 
255.
When connecting multiple devices to the same network, make sure to assign 
each device a unique IP address.

Port No. Specifies the port number for the target (0 to 65535).

Change IP Address and Port Number by Device Address:
Select this check box and specify a word device to change the target's IP 
address and port number during operation. You can only specify an internal 
device. During the start of operation, the MICRO/I writes the values 
configured by IP Address and Port No. to this device address. After the 
start of operation, the value of device address is read and the target is 
changed.

Click  to display the Tag Editor. For the device address configuration 
procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-68.
Example: When IP Address is set to 192.168.1.1, Port No. is 2105, and the 

device address is LDR100

MICRO/I: Configures the MICRO/I listening port number.
These options can only be configured when TCP Server or UDP is selected for Operation 
Mode.
Port No.: Specifies the MICRO/I listening port number (0 to 65535).

:

LDR100
LDR101
LDR102
LDR103
LDR104

2105
192
168
1
1

Port number

IP address
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• When using the MICRO/I as UDP, the MICRO/I cannot automatically identify and reply to the IP address 
and port number of the external device. UDP broadcasting is also not supported.

• For TCP client and TCP server, make a 1:1 connection between the MICRO/I and the external device for 
one user communication setting.

• When the Change IP Address and Port Number by Device Address check box is selected, the 
changed IP address and port number are reflected when data is next sent.

• Regarding TCP port number of MICRO/I, note the following points.

The numbers that cannot be used: - 2538 (for pass-through)
- 2101 (for FC4A Series MicroSmart direct connection pass-through)

Duplicate numbers cannot be configured in the following functions:

- Maintenance communication 
( refer to “Port Number” on page 4-40)

- Web server function ( refer to “Port Number” on page 4-65)
- FTP server function ( refer to “Port Number” on page 4-66)
- TCP Server is selected for the User Communication 

( refer to “Port No.” on page 4-42)
- Modbus as Manufacture and Modbus TCP Server as 

Communication Driver are selected on the Communication 
Driver tab 
( refer to the WindO/I-NV4 External Device Setup Manual)

- YASKAWA Electric as Manufacture and MP2000(Ethernet) 
as Communication Driver are selected on the Communication 
Driver tab 
( refer to the WindO/I-NV4 External Device Setup Manual)

• Duplicate UDP port numbers of MICRO/I cannot be configured in the following functions.
- UDP is selected for the User Communication ( refer to “Port No.” on page 4-42)
- IDEC System as Manufacture and DM LINK Ethernet(UDP) as Communication Driver are 

selected on the Communication Driver tab 
( refer to the WindO/I-NV4 External Device Setup Manual)

- OMRON as Manufacture and SYSMAC CS1/CJ series(Ethernet) as Communication Driver are 
selected on the Communication Driver tab 
( refer to the WindO/I-NV4 External Device Setup Manual)

• The connection status for TCP clients and the TCP server can be checked with the value of the HMI 
Special Data Registers (LSD). The connection is disconnected when 0. The connection is connected when 
1.

LSD67-0: Connection status for User Communication 1 set to Ethernet interface

LSD67-1: Connection status for User Communication 2 set to Ethernet interface

LSD67-2: Connection status for User Communication 3 set to Ethernet interface

• To forcibly disconnect the connection with TCP clients and the TCP server, set the value of the HMI Special 
Data Registers (LSD) from 0 to 1.

LSD68-0: User Communication 1 set to Ethernet interface

LSD68-1: User Communication 2 set to Ethernet interface

LSD68-2: User Communication 3 set to Ethernet interface
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When USB2(USB-A) is selected under Interface Configuration

When USB1(USB-B) or USB(USB-B) is selected under Interface Configuration

The items displayed in the Interface vary based on the model.

■ Default
Returns the configured values to their default values.

*1 HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F only

Function: Selects the function used by the USB interface (Type A) from the following.
N/A, User Communication 1, User Communication 2, User Communication 3
This communication interface is not used when N/A is selected.

HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F, HG1G/1P: USB1(USB-B)

HG2G-5T: USB(USB-B)

Function: Selects the function used by the USB interface (Mini-B) as N/A or Printer.*1

This communication interface is not used when N/A is selected.
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3.3 Communication Driver Tab

The Communication Driver tab is used to configure the communication driver for the external device configured in 
the current project data.

■ (Function)
Select the External Device Communication.

■ Manufacturer
Selects the manufacturer name of the external device to use in External Device Communication selected by 
(Function).

■ Communication Driver
The communication driver list for the selected manufacturer is displayed. Selects the serial interface to use.

■ Connection
The connection of the selected communication driver is displayed.

■ External Device
These options configure the communication driver to use. For details, refer to the WindO/I-NV4 External Device Setup 
Manual.

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

(Function)

1:1: The MICRO/I is connected to a single external device.

1:N: The MICRO/I is connected to multiple external devices.

Transmission Wait (x 10 msec): Specifies the transmission interval for communication commands (0 to 
255).

Time Out (x 100 msec): Specifies the time to wait for a response from the external device (1 to 
255).

Retry Cycles: Specifies the number of times to execute a reconnection when the MICRO/
I cannot communicate with the external device. When the number of 
reconnect attempts reaches the number of times set here, a 
communication error is displayed.
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Storage Method of 32-bit Numerical Data: Selects the handling method for values of external device addresses when 
UBIN32(D), BIN32(L), BCD8(EB), or Float32(F) is selected for Data 
Type from the following.

from Upper word: Values of external device addresses are read from and written to the upper 
order word.
Example: When Data Type for the Numerical Input is UBIN32(D) and 

the numerical value 12345678 (Hex) was entered and written to 
destination device address D100

from Lower word: Values of external device addresses are read from and written to the lower 
order word.
Example: When Data Type for the Numerical Input is UBIN32(D) and 

the numerical value 12345678 (Hex) was entered and written to 
destination device address D100

for MICROSmart, SmartAXIS: The storage method of data varies based on device type when selecting 
the following communication drivers.

• Device types handled as from upper word
Data Register, Timer Current Value, Counter Current Value, Timer Preset 
Value, Counter Preset Value, Special Data Register

• Device types handled as from lower word
Input (Word), Output (Word), Internal Relay (Word), Link Register, 
Special Internal Relay (Word), Shift Register (Word)

When using a communication driver other than those listed above and for 
MICROSmart, SmartAXIS is selected, the values of all device addresses 
are handled as from Upper word.

Enable Pass-Through: Select this check box to use the Pass-Through function.
This option is only displayed for models that can use the Pass-Through 
function. For details, refer to Chapter 27 “1.2 Supported External Devices” 
on page 27-2.

Device address Stored value
D100
D101

Upper word
Lower word

1234 (Hex)
5678 (Hex)

Device address Stored value
D100
D101

Upper word
Lower word1234 (Hex)

5678 (Hex)

Manufacturer Communication driver

IDEC

MICROSmart(FC6A)(RS232C/485)
MICROSmart(FC6A)(Ethernet)
OpenNet, MICROSmart, SmartAXISPro/Lite(RS232C/485)
OpenNet, MICROSmart, SmartAXISPro/Lite(Ethernet)
MICRO3, MICRO3C

The Pass-Through function can only use one of External Device Communication 1 to External Device 
Communication 4.

The Pass-Through Tool is required to use the Pass-Through function when using a version of WindLDR 
before Ver. 6.01, another company's PLC programming software, or an external device other than IDEC's 
external device.

Communication Driver Extension Settings:
This button is displayed when the communication driver extension settings are required.
Click this button to display the Communication Driver Extension Settings dialog box. 
For details, refer to “Communication Driver Extension Settings Dialog Box” on page 4-49.
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■ Ignore communication errors and continue operation
Select this check box to continue MICRO/I operation even when a communication error occurs.

Display error message: Select this check box to display an error message (communication error) when a 
communication error occurs and operation continues. Ack is displayed on the error message 
(communication error).
When the Ignore communication errors and continue operation check box is cleared, 
Ack is not displayed on the error message.

Auto retry: Select this check box to automatically retry communication from the MICRO/I to the station 
number where the communication error occurred when a communication error occurs and 
operation continues.
All other communication stops while retrying.

To manually retry communication, clear the Auto retry check box.
To retry all station numbers, write 1 in bit 1 (initialize) of the device address configured by Batch 
monitoring the communication error information for all Station Numbers.
To individually retry communication, write 1 in bit 0 (connection setting) of the device address configured by 
Monitoring communication error information for each station, individually.

Batch monitoring the communication error information for all Station Numbers:
Specifies the word device that stores communication error information for all station 
numbers. Only an internal device can be configured for this option.

Click  to display the Tag Editor. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-68.
The information stored as error information is as follows. For details, refer to the 
WindO/I-NV4 External Device Setup Manual.
• Initialization
• Conditions under which the error occurred
• Read error history
• Write error history

Monitoring communication error information for each station, individually:
Select this check box to store the error information for each station number in device addresses.
Total number of station being monitored: Specifies the number of station numbers for 

external devices.
Status Device Address: Specifies the word device that stores communication 

error information for each station number. Only an 
internal device can be configured for this option.

Click  to display the Tag Editor. For the device 
address configuration procedure, refer to Chapter 
2 “5.1 Device Address Settings” on page 2-68.
This error information utilizes a maximum of 256 
device addresses. Use caution so that the used 
address numbers do not overlap with other 
addresses.
The information stored as error information is as 
follows. For details, refer to the WindO/I-NV4 
External Device Setup Manual.
• Connection settings
• Conditions under which the error occurred
• Read error history
• Write error history

The station number varies based on the communication interface. The displayed settings are as follows:
Serial interface: 
Ethernet interface: 

Slave Number
External Device ID 
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Communication drivers that cannot be simultaneously used

The following communication driver combinations can only be used in a single (Function). They cannot be configured 
in multiple settings.

■ Communication drivers that cannot be simultaneously used (1)

■ Communication drivers that cannot be simultaneously used (2)*1

■ Communication drivers that cannot be simultaneously used (3)

Example: Communication Driver for External Device Communication 1 is set to Modbus RTU Slave
According to the communication drivers that cannot be simultaneously used (1), External Device 
Communication 2, External Device Communication 3, and External Device Communication 4 
cannot be set to Modbus RTU Master, S7-200(PPI), S7-MPI, or MP920-RTU.
According to the communication drivers that cannot be simultaneously used (3), External Device 
Communication 2, External Device Communication 3, and External Device Communication 4 

cannot be set to DM Link (1:1), DM Link (1:N), DM Link Ethernet(UDP)*1, or Modbus TCP Server.

*1 HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F only

Manufacturer Communication Driver

Modbus
Modbus RTU Master

Modbus RTU Slave

SIEMENS
S7-200(PPI)

S7-MPI

YASKAWA ELECTRIC CORPORATION MP920-RTU

Manufacturer Communication Driver

Allen-Bradley
Logix Controllers(Ethernet)

Logix Native Tag(Ethernet)

Manufacturer Communication Driver

IDEC System

DM Link (1:1)

DM Link (1:N)

DM Link Ethernet(UDP)*1

Modbus
Modbus RTU Slave

Modbus TCP Server
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● Communication Driver Extension Settings Dialog Box
The Communication Driver Extension Settings dialog box is used to configure the communication driver 
extension settings. These settings vary based on the external device. For details, refer to the WindO/I-NV4 External 
Device Setup Manual.
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3.4 Communication Driver Network Tab

The Communication Driver Network tab is used to configure the information for external devices.

■ Settings
Edits the settings for the external devices.

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

External Device ID: Shows the number (0 to 31) that the MICRO/I uses to manage the external devices are displayed.

External Device Name: Shows the name for the external device. The default is the number (0 to 31).
Clicking the cell allows you to edit the name. The maximum number is 20 characters.

You cannot use the following characters and name in the External Device Name.
• The following characters and a space

\ / : ; * ? " < > |
• (blank)
• Full width character
• The same name as another External Device ID

External Device Communication: Shows the function set for the serial interface or the Ethernet interface. 
(Default: Disabled)
Clicking the cell allows you to select the function from the following items.
Disabled, External Device Communication 1, External Device 
Communication 2, External Device Communication 3, External Device 
Communication 4

Function configured in communication drivers with a 1:1 connection in External Device Communication 
cannot be set to multiple External Device ID.
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■ Clear
Returns the settings for the selected External Device ID to the defaults.

■ Specify Slave Number of Modbus RTU Master by Value of Device Address
Select this check box to specify the slave number with the value of a device address.
This check box is displayed only if Manufacturer is Modbus and Communication Driver is Modbus RTU Master 
on the Communication Driver tab. For details, refer to WindO/I-NV4 External Device Setup Manual.

■ Expansion Settings
If extension settings are required for the communication driver set for the selected slave number, those settings are 
displayed. For details, refer to the WindO/I-NV4 External Device Setup Manual.

■ Tag File

Import the Allen-Bradley tag defined in the RSLogix5000 L5K file (*.L5K). Click the  button to display the Open 
dialog box.
This option is only displayed when the Manufacturer on the Communication Driver tab is Allen-Bradley and the 
Communication Driver is Logix Native Tag(Ethernet). For details, refer to the WindO/I-NV4 External Device 
Setup Manual.

Communication Driver: Shows the communication driver for use with the External Device Communication.

Slave Number: Displays the slave number of the external device.
Clicking the cell allows you to change the slave number of the external device.
This option can only be configured when Serial Interface is selected for Interface 
Configuration on Communication Interface tab. For details, refer to “Interface 
Configuration” on page 4-35.

Leaving it blank or the same number as the other External Device IDs cannot be used for Slave Number.

IP Address: Shows the IP address of the external device. (Default: 192.168.0.1)
Clicking the cell allows you to specify the IP address of the external device.
The format is “xxx.xxx.xxx.xxx”. “xxx” stands for a numeric value from 0 to 255.
When connecting multiple devices to the same network, make sure to assign each device a unique IP 
address.
This option can only be configured when Ethernet is selected for Interface Configuration on 
Communication Interface tab.

Port Number: Shows the port number of external device. (Default: 2101)
Clicking the cell allows you to specify the port number of the external device (0 to 65535).
This option can only be configured when Ethernet is selected for Interface Configuration on 
Communication Interface tab.

You can change the IP address of the external devices in the System Mode. Perform the following operation 
on the Main Menu screen.

HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F: Press Initial Setting, Communication I/F, Ext. Device 
IP Address in order.

HG2G-5T, HG1G/1P: Press Initial Setting, Comm. I/F, Ext. IP Address in 
order.

(Top Device Address): Specifies a word device to write the Slave Number. 

Click  to display the Tag Editor. For the device address configuration procedure, refer 
to Chapter 2 “5.1 Device Address Settings” on page 2-68.

If you change the Communication Driver and then click OK on the Project Settings dialog box, a 
confirmation message is displayed. Click Yes on the message to run the conversion for the external device 
addresses. If there are no device addresses that correspond to the external device addresses in the current 
project data after changing the communication driver, the items set with those device addresses are blank.
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Number of external device limitations

• The number of external devices that can be connected to External Device Communication 1 to External 
Device Communication 4 is a total of 32 external devices.

• The number of external devices that can be set varies based on the communication interface.

Communication Interface Number of External Devices

Serial Interface (Connection: 1:1 communication) 1

Serial Interface (Connection: 1:N communication) 31 max.

Ethernet Interface 32 max.
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3.5 O/I Link Tab

The O/I Link tab configures the slave stations to connect to when the MICRO/I is used as the O/I Link 
communication master. It configures the O/I link station when the MICRO/I is used as a slave. For details, refer to 
Chapter 3 “2 O/I Link Communication” on page 3-3. These options can only be configured when O/I Link Master or 
O/I Link Slave is selected for Function under Interface Settings on the Communication Interface tab.

■ O/I Link Station
Selects the slave station (Slave1 to Slave15).
This option can only be configured when O/I Link Slave is selected for Function under Interface Settings on the 
Communication Interface tab.

■ Slave Settings
Select the check boxes for the slave stations to connect to.
This option can only be configured when O/I Link Master is selected for Function under Interface Settings on 
the Communication Interface tab.

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

The slave stations to connect to when the MICRO/I is used as an O/I link communication master are 
enabled after the project is downloaded. The slave station number when the MICRO/I is used as a slave is 
also enabled after the project is downloaded.
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3.6 User Communication Tab

The User Communication tab is used to configure communication with external devices such as barcode readers. 
For details, refer to Chapter 3 “5 User Communication” on page 3-8. This option can only be configured when User 
Communication 1, User Communication 2, or User Communication 3 is selected for Function under 
Interface Settings on the Communication Interface tab.

■ (Protocol List)
Displays the registered user communication protocol.

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

(Protocol List)

(Type)

No.: Displays the number for managing the user communication protocol.

Protocol Name: Enter the name of the user communication protocol. The maximum number for protocol name is 40 
characters.

You cannot use the following characters in the protocol name.
   \ / : , ; * ? " < > |

Receiving Character Time Out (x100 msec)

Specify the time out value (0 to 255) from when 1 frame of data has been received to when the next frame of 
data starts to be received. A frame refers to a data string from the beginning to the end of a command. If the 
Receiving Character Time Out is set to 0, it is not monitored. These setting items are used only with receive 
command.

Example: The received data (1 frame) is 2 bytes, the While ON is selected as the Trigger Type in the Trigger 
Condition and LM100 is set to the Device Address, LM101 is set to the Completed Device 
Address, and LDR110 is set to the Status Device Address
The data of second byte starts to be received before exceeding the Receiving Character Time Out 
duration after the data of first byte is received, and the values of the Completed Device Address and 
Status Device Address when receiving of the data has been successfully completed are as follows.

• The value of the Completed Device Address LM101 changes to 1.
When the Not Clear Completed Device Address automatically check box is not selected, when 
the value of the Trigger Condition device address LM100 changes from 0 to 1, the value of the 
Completed Device Address LM101 changes to 0. 
When the Not Clear Completed Device Address automatically check box is selected, the value 
of Completed Device Address LM101 remains 1, so set 0 if necessary.

:



WindO/I-NV4 User’s Manual 4-55

3 Project Settings Dialog Box

4

Project Settings

*1 HG1P only

• The value of the Receiving Character Time Out (address number+0, bit 15) of the Status Device 
Address LDR110 remains 0.

When the Receiving Character Time Out duration exceeds until the data of second byte starts to be 
received after the data of first byte is received, the value of the Receiving Character Time Out (address 
number+0, bit 15) of the Status Device Address LDR110 changes to 1 and the Completed Device 
Address LM101 remains 0. In addition, when the value of the Trigger Condition device address LM100 
changes from 0 to 1, the value of LDR110 (address number +0, bit 15) changes to 0.

Inching Function*1: Displays whether or not the inching function is used. Double clicking the cell switches between 
the Enable and the Disable. This can only be set for the User Communication 1.
By using the inching function, data is transmitted at the specified execution interval.

Value of Receiving Character Time Out 
(address number+0, bit 15) 

of Status Device Address LDR110

Value of Completed Device Address 
LM101

Receive command

Value of Device Address LM100 when 
Trigger Condition is While ON

1

0

1

0

1

0

Receiving Character Time Out duration

First byte of receive data Second byte of receive data

Value of Receiving Character Time Out  
(address number+0, bit 15) 

of Status Device Address LDR110

Value of Completed Device Address 
LM101

Receive command

1

0

1

0

1

0

Receiving Character Time Out duration

First byte of receive data Second byte of receive data

Value of Device Address LM100 when 
Trigger Condition is While ON

Inching refers to the inching operation of the drive section. It is a general term for drive operations that 
repeatedly start and stop in small increments for each operation, such as starting and stopping the drive 
section when a push button or switch is pushed and released.

Execution Interval (x10 msec)*1: Specifies the interval to send the commands for inching function as 40 to 1000 (20 
ms increments).
This option can only be set when the Enable is selected in the Inching Function.

The command cannot be sent at the specified execution interval if the following conditions occur:
• The transmission processing for a command cannot be completed within the time set by the Execution 

Interval.
⇒ Set the Execution Interval to a time longer than it takes to send the command.

• The inching function was used at the same time as user communication transmission or receive 
processing.

⇒Do not use transmission commands, receive commands and commands for inching function at one 
time.

One frame is transmitted with no character spacing.
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■ Command List
The command settings for the user communication protocol selected in the (Protocol List) are displayed.

*1 HG1P only

Open Protocol Manager: Configures the user communication protocol registered in the Protocol Manager to the user 
communication protocol selected in the (Protocol List).
Click this button to display Protocol Manager. For details, refer to Chapter 3 “Configuring 
registered user communication protocol to another user communication” on page 3-28.

Delete Protocol: Deletes the user communication protocol selected in the (Protocol List).

(Type)*1: Changes the items displayed in the list according to the type of command.

TXD, RXD: Select this check box to display transmission and receive commands.

Inching: Select this check box to display commands for the inching function.

User communication protocol commands are displayed in the order they were created, but commands for 
inching function  are always displayed above the transmission and receive commands in the list.

No.: Shows the number for managing command settings. Double clicking the cell displays the Command 
Settings dialog box.

Type: Shows the type of command. Double clicking the cell displays the Command Settings dialog box.

Key: Shows the function keys (F1 to F12) assigned to the command. Double clicking the cell displays the 
Command Settings dialog box.
This option is only displayed when the Inching check box is selected.

Trigger Type: Shows the trigger type for data transmission or being ready to receive data. Double clicking the cell 
displays the Command Settings dialog box.

Condition: Shows the condition of trigger type for data transmission or being ready to receive data. Double 
clicking the cell displays the Command Settings dialog box. The displayed content varies based on 
the Trigger Type.

Always Enabled: Trigger conditions are not necessary, so nothing is displayed.

Rising-edge, Falling-edge, While ON, or While OFF:
Shows the bit device or the bit of the word device as the condition.

While satisfying the condition or Satisfy the condition:

Shows the conditional expression.

Fixed Period: Shows the period.

Completed: Shows the device address for reporting when transmission or receiving of data is successfully 
completed. Double clicking the cell displays the Command Settings dialog box.

Status: Shows the destination device address for the transmitted or received data size and error 
information. Double clicking the cell displays the Command Settings dialog box.

Comment: Shows the command comment. Double clicking the cell displays the Command Settings dialog box.

Size: Shows the command data size in bytes. The maximum is displayed if there is data that has the 
Variable check box selected on the Data Settings dialog box. Double clicking the cell displays the 
Command Settings dialog box.
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■ Data List
Displays the list of command data selected in the Command List. 

■ Copy to Protocol Manager
Click this button to register the user communication protocol selected in the (Protocol List) to the Protocol Manager. 
For details, refer to Chapter 3 “5.3 Protocol Manager” on page 3-32.

■ Expand/Contract Command List
Shows or hides the Data List. By hiding the Data List, the number of commands displayed in the Command List 
will increase.

Add: Adds a command to the Command List. A maximum of 255 commands may be added.
Click this button, displays the Command Settings dialog box. For details, refer to Chapter 3 
“Command Settings Dialog Box” on page 3-36.

Edit: Edits the command selected in the Command List.
Click this button, displays the Command Settings dialog box. For details, refer to Chapter 3 
“Command Settings Dialog Box” on page 3-36.

Copy: Copies the command selected in the Command List.
Click this button to add a copy of the selected command to the end of the Command List. Inching 
function commands are added above the transmission and receive commands.

Up: Shifts the selected command upward in the list.

Down: Shifts the selected command downward in the list.

Delete: Deletes the selected command from the Command List.

Adding, copying, and shifting up and down happen within the range of the same type of command. There 
are two types of commands: the TXD, the RXD and the Inching.

No.: Displays the number for managing the data. Double clicking the cell displays the Data Settings 
dialog box. For details, refer to Chapter 3 “Data Settings Dialog Box” on page 3-48.

Data: Displays the data settings. Double clicking the cell displays the Data Settings dialog box. For details, 
refer to Chapter 3 “Data Settings Dialog Box” on page 3-48.

Add: Add: Adds a data to the Data List.
Click this button, displays the Data Settings dialog box. For details, refer to Chapter 3 “Data Settings 
Dialog Box” on page 3-48.

Edit: Changes the selected data in the Data List.
Click this button, displays the Data Settings dialog box. For details, refer to Chapter 3 “Data Settings 
Dialog Box” on page 3-48.

Copy: Copies the selected data in the Data List.
Click this button to add a copy of the selected data to the end of the Data List.

Up: Shifts the selected data upward in the list.

Down: Shifts the selected data downward in the list.

Delete: Deletes the selected data from the Data List.
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3.7 Sub Host Communication Tab

The Sub Host Communication tab is used to configure the sub host communication protocol and HMI Link Register 
(LLR) addresses to use. For details, refer to Chapter 3 “6 Sub Host Communication” on page 3-87. This option can 
only be configured when Sub Host Communication is selected for Function under Interface Settings on the 
Communication Interface tab.

■ Protocol
Selects the protocol to use in sub host communication as MicroSmart or Modbus RTU Master.

■ Allocate Address Number of HMI Link Register (LLR)

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

Settings: Lists the device addresses allocated to HMI Link Registers.

Address Number: Shows the LLR address numbers (LLR 0 to LLR 63).

Device Address: Shows the device addresses allocated to LLR address numbers.

B/W: Shows the device type.

B: Bit device

W: Word device

BWORD: Bit device in word

Device Type: Selects the device type of the device address to allocate to the HMI Link Register (LLR). 
Only device types that can be used are shown.

Address Number: Specifies the address number of device address to allocate to the HMI Link Register (LLR). 
The range that can be set varies based on the selected device type.

Bit Number: Specifies the bit number in a word device (0 to 15). This option can only be configured 
when a word device is selected for Device Type.

Slave Number: Specifies the slave number of the external device for the device address to allocate to the 
HMI Link Register (LLR). The range that can be specified varies based on the selected 
communication driver.
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■ Monitor the error information of all Slave Numbers
Select this check box to monitor the error information of all external devices that are being communicated with using 
sub host communication.
For details, refer to Chapter 3 “Monitor the error information of all Slave Numbers” on page 3-92.

■ Monitor the error information of each Slave Number
Select this check box to monitor the error information for each external device that is being communicated with using 
sub host communication.
The information for each slave is stored starting with the allocated internal device and utilizes 256 words of address 
numbers.
The slave numbers are allocated with the starting address as number 0, up to number 255.
For details, refer to Chapter 3 “Monitor the error information of each Slave Number” on page 3-93.

■ Keep running with skipping the Slave Number of Communication Error
Select this check box to temporarily stop communication with the slave number where the communication error 
occurred and connect to the next slave number.
For details, refer to Chapter 3 “Keep running with skipping the Slave Number of communication error” on page 3-93.

Set: Allocates the device address to the HMI Link Register (LLR). When a device address is 
already allocated to an LLR address number, the allocated device address can be changed.
Select an LLR address number and click Set to allocate the settings configured by Device 
Type, Address Number, Bit Number, and Slave Number to the HMI Link Register 
(LLR).

Set with Auto Increment: Allocates sequential device addresses from the device address configured by Device 
Type, Address Number, Bit Number, and Slave Number to the HMI Link Registers 
(LLR) after the selected LLR address number.

Delete: Deletes the device address allocated to the HMI Link Register (LLR) from the list.
Select the LLR address on the list and click Delete.

Up: Shifts the device address allocated to the selected HMI Link Register (LLR) up in the list.

Down: Shifts the device address allocated to the selected HMI Link Register (LLR) down in the list.

Import: Displays the Open dialog box.
Select a file with exported device addresses (CSV file) and click Open to collectively 
overwrite the LLR address numbers under Settings with the device addresses in the 
selected file.

Export: Displays the Save As dialog box.
Select the location to save the file, enter a file name, and then click Save to save the 
device address details as a CSV file.

(Destination device address):Specifies the word device to write the error information to.

Click  to display the Tag Editor. For the device address configuration procedure, refer 
to Chapter 2 “5.1 Device Address Settings” on page 2-68.

(Top device address): Specifies the word device to write the error information to. This option uses 64 words of 
addresses starting with the configured device address.

Click  to display the Tag Editor. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-68.
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3.8 Printer Tab

The Printer tab is used to configure the printer that is connected to the MICRO/I.

■ Form
Selects the paper size to output as A4 or Letter.
If the printer does not support the selected paper size, printing is performed with the paper size specified in the 
printer's settings.

■ Reverse Mode
Select this check box to reverse only black or white when printing.

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

• The color cannot be configured. To print in monochrome, configure the print color on the printer that is 
used. When the edge of the data is not printed, enable No Trimming and Bordered in the printer's 
settings.

• When connecting the MICRO/I to a printer, an error may occur on the printer side as an unsupported 
device. However, data is sent that satisfies the PictBridge standard when printing, so the data can be 
printed correctly.
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3.9 External Memory Device Tab

The External Memory Device tab is used to configure the destination folder on the external memory device*1 
inserted in the MICRO/I.

■ External Memory Device Folder
Enter the folder name for the folder to use on the MICRO/I within 8 alphanumeric characters using upper-case 
alphabetic characters (A to Z) and numbers (0 to 9). (Default: HGDATA01)
All the data sampled with the log functions is saved in this External Memory Device folder. For details on the external 
memory device, refer to Chapter 31 “1 External Memory Devices” on page 31-1.

■ Remove Files
Select this check box to erase the files saved in the External Memory Device folder.

*1 SD memory card for HG5G/4G/3G/2G-V, HG4G/3G and HG2G-5F, USB flash drive for HG2G-5T and HG1G/1P

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

• You cannot use the following characters in the folder name.
   . \ / : * ? “ < > |

• After operation starts, the folders created in the External Memory Device folder and the file names cannot 
be changed.

All Screenshots: Select this check box to erase all the screenshots in the “CAPTURE” folder.

All Alarm Log files: Select this check box to erase all the Alarm Log data saved in the "ALARMLOG" folder. 

All Data Log files: Select this check box to erase all the Data Log data saved in the "DATALOG" folder.

All Operation Log files: Select this check box to erase all the Operation Log data saved in the “OPERATIONLOG” 
folder.

Trigger Device Address: Specifies the bit device or the bit number of the word device to serve as condition to 
delete the files.
Click  to display the Tag Editor. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-68.
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3.10 Autorun Tab

The Autorun tab is used to configure the functions for a USB flash drive inserted in the MICRO/I. For details, refer to 
Chapter 31 “2 USB Autorun Function” on page 31-22.

■ Enable USB Autorun
Select this check box to enable the USB Autorun function.
The USB Autorun function automatically displays a menu screen from which the user can execute predefined 
commands when a USB flash drive is inserted in the MICRO/I.

■ Open Popup Screen when USB Flash Drive is inserted
Select this check box to display a popup screen when a USB flash drive is inserted in the MICRO/I.

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

Screen Number: Specifies the popup screen number (1 to 3015) to display when a USB flash drive 
is inserted in the MICRO/I.

Coordinates X, Y: Specifies the coordinates to display the popup screen.
With the upper-left corner of the screen as the origin, the X and Y coordinates are 
the upper-left corner of the popup screen.
The units and range for the display coordinates are as follows.

Specify the coordinates in 1 dot units.
X: 0 to (base screen horizontal size - 1)
Y: 0 to (base screen vertical size - 1)



WindO/I-NV4 User’s Manual 4-63

3 Project Settings Dialog Box

4

Project Settings

3.11 Expansion Module Tab

The Expansion Module tab is used to configure input and output expansion modules attached to the MICRO/I. For 
details on expansion modules, refer to Chapter 30 “Expansion Modules” on page 30-1.

■ Use Cyclic Script
A Cyclic Script is a script with a trigger condition that is a fixed interval (10 ms increments). When a script is specified 
as a Cyclic Script, it executes at the specified fixed interval independent of the scan time of the screen (processing 
time for parts on the screen).
Select this check box to use a Cyclic Script. Only one Cyclic Script can be configured for the project.

■ Script ID
Specify the script ID to use (1 to 32000) as the Cyclic Script.

Click  to display Script Manager. Select a script from the script list. For details, refer to Chapter 20 “2.2 Script 
Manager” on page 20-7.

■ Script Name
Displays the name of the script specified with Script ID.

■ Execution Interval
Specifies the interval to execute the script as 10 to 1000 (10 ms increments).

■ Module Configuration*1

Displays the Module Configuration dialog box. For details, refer to Chapter 30 “5 Module Configuration Dialog Box” 
on page 30-29.

*1 HG5G/4G/3G/2G-V only

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P
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3.12 Web Server Tab

The Web Server tab configures the MICRO/I's Web Server function. For details, refer to Chapter 28 “1 Web Server 
Function” on page 28-1.

■ Use System Web Page
Select this check box to access the Remote Control page, Remote Monitor page or System Detailed Information page 
of MICRO/I from a web browser terminal.

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

(Data Type)

Remote Control and Monitoring Select the functions allowed when accessing the MICRO/I from a web 
browser terminal from the following.
This option can only be set when Use System Web Page is selected.

Enable Remote Control and Monitor: Displays a screenshot of the screen displayed on the MICRO/I. You can also 
control the MICRO/I being monitored by clicking on the displayed 
screenshot.

Enable Remote Monitor only: Displays a screenshot of the screen displayed on the MICRO/I.

Disable: Displays only the detailed system information page.

Go back to System Information if operation is not performed for the following period:

Select this check box to automatically return to the homepage when no 
action is performed in the Remote Control page or Remote Monitor page for 
a specified time. Specify the time until the page returns to the System 
Information page following the last action performed in the Remote Control 
page or the Remote Monitor page.
This can only be set when Enable Remote Control and Monitor or 
Enable Remote Monitor only is selected.

(Data Type): Select the data type for which the System Information 
page return time is specified. Units are minutes.

Value: Use a constant value (1 to 60).

Device Address: Use a value of device address.

Click  to display the Tag Editor. For the device 
address configuration procedure, refer to Chapter 2 
“5.1 Device Address Settings” on page 2-68.

:
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■ Use Custom Web Page
Select this check box to access the Custom Web Page saved in the external memory device of MICRO/I from a web 
browser terminal. For details, refer to Chapter 28 “1.6 Custom Web Page” on page 28-14.

■ Execution Interval (msec)
Specifies the interval (0 to 5,000 ms) for the MICRO/I to return data. The load that the remote control function and 
the remote monitoring function place on MICRO/I operation can be reduced by increasing this value. However, the 
display update speed in the web browser will become slower.

■ Port Number
Specifies the TCP port number to use for the Web Server function (0 to 65,535).

■ Default Showing Page
Select the web page to display first when accessing the MICRO/I from a web browser terminal from the following.
System Information, Remote Monitor, Remote Control
In (Custom Web Page), the Custom Web page file name is displayed in Web Page Editor of the Project window.
This option can only be set when Use System Web Page or Use Custom Web Page is selected.

If Device Address is selected for (Data Type), note the following points:
• If the value of device address is set to 61 or higher, it will be treated as 60 minutes.
• Once a network connection is established between the web browser and the MICRO/I, the timeout period 

cannot be changed. The timeout period needs to be set in Device Address before a web browser access 
to the MICRO/I.

Regarding TCP port number of MICRO/I, note the following points.

The numbers that cannot be used: • 2538 (for pass-through)
• 2101 (for FC4A Series MicroSmart direct connection pass-through)

Duplicate numbers cannot be configured in the following functions:

• Maintenance communication 
( refer to “Port Number” on page 4-40)

• Web server function
• FTP server function ( refer to “Port Number” on page 4-66)
• TCP Server is selected for the User Communication 

( refer to “Port No.” on page 4-42)
• Modbus as Manufacture and Modbus TCP Server as 

Communication Driver are selected on the Communication 
Driver tab 
( refer to the WindO/I-NV4 External Device Setup Manual)

• YASKAWA Electric as Manufacture and MP2000(Ethernet) as 
Communication Driver are selected on the Communication 
Driver tab 
( refer to the WindO/I-NV4 External Device Setup Manual)
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3.13 FTP Server Tab

The FTP Server tab configures the MICRO/I's FTP Server function. For details, refer to Chapter 28 “2 FTP Server 
Function” on page 28-18.

■ Enable FTP Server function
Select this box to enable FTP Server function.
This allows the FTP client to read or write the file contained in the external memory device inserted in the MICRO/I.

■ Port Number
Specifies the TCP port number to use for the FTP server function (0 to 65535).

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

(Data Type)

Regarding TCP port number of MICRO/I, note the following points.

The numbers that cannot be used: • 2538 (for pass-through)
• 2101 (for FC4A Series MicroSmart direct connection pass-through)

Duplicate numbers cannot be configured in the following functions:

• Maintenance communication 
( refer to “Port Number” on page 4-40)

• Web server function ( refer to “Port Number” on page 4-65)
• FTP server function
• TCP Server is selected for the User Communication 

( refer to “Port No.” on page 4-42)
• Modbus as Manufacture and Modbus TCP Server as 

Communication Driver are selected on the Communication 
Driver tab 
( refer to the WindO/I-NV4 External Device Setup Manual)

• YASKAWA Electric as Manufacture and MP2000(Ethernet) as 
Communication Driver are selected on the Communication 
Driver tab 
( refer to the WindO/I-NV4 External Device Setup Manual)
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■ Inactivity Timeout
Set the timeout period between the MICRO/I and the FTP Client. After log in to the MICRO/I, if there is no 
communication between the MICRO/I and the FTP client for a specified set time, the MICRO/I will automatically 
disconnect the communication. 

■ Specify Target
Select SD Memory Card*1 or USB Flash Drive to specify target folder. When you specify the target folder, you 
cannot access the higher level folders. 

*1 HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F only

(Data Type): Select the data type for the timeout period until the MICRO/I disconnects the FTP client. Units are 
minutes. 

Value: Use a constant value (1 to 60).

Device Address: Use a value of device address.

Click  to display the Tag Editor. For the device address configuration procedure, 
refer to Chapter 2 “5.1 Device Address Settings” on page 2-68.

• The timeout period to login the MICRO/I is 1 minute.
• If Device Address is selected for (Data Type), note the following points:

- When the value of device address is 0, the Inactivity Timeout is 1 minute, and when the value of device 
address is 61 or more, the Inactivity Timeout is regarded as 60 minutes.

- Once a network connection is established between the FTP client and the MICRO/I, the timeout period 
cannot be changed. The timeout period needs to be set in Device Address before connecting the FTP 
client to the MICRO/I.

Location: Specify the location of the target folder path. The maximum number is 247 characters.

Example: Access the “RECIPE” folder under “HGDATA01” folder on the external memory device
HGDATA01\RECIPE

A

B

HGDATA01

/

(The root folder of the SD memory card)

(The root folder of the FTP server)

(The root folder of the USB flash drive)

RECIPE (Folder specified as Target) Subfolders and files contained 
in the specified Target are accessible.
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3.14 E-mail Tab

You can set the outgoing mail server (SMTP) to be used for sending an e-mail from MICRO/I. For details, refer to 
Chapter 28 “4 E-mail Function” on page 28-40.

■ General Setting

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

Outgoing mail server (SMTP): Selects the Outgoing mail server (SMTP) setting method.

Host Name: Specifies the Host Name of the outgoing mail server (SMTP).
The maximum number is 40 characters. Only alphanumeric characters 
and symbols can be used.

IP Address: Specifies the IP address of the outgoing mail server (SMTP).
The format is “xxx.xxx.xxx.xxx”. “xxx” stands for a numeric value from 
0 to 255.

If Host Name is selected, the IP address of the outgoing mail server (SMTP) is looked up and obtained from 
the host name using the DNS server. In order to access a DNS server from the MICRO/I, the IP address of 
the DNS server must be specified. For details, refer to “ When Ethernet is selected under Interface 
Configuration” on page 4-40.
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■ Authentication Setting

■ Advanced Setting

Outgoing mail server (SMTP) port number: Specifies the port number for the outgoing mail server (SMTP) (0 to 
65535).

The outgoing mail server (SMTP) port number to use varies based on the server. For details, contact the 
administrator of the network which the MICRO/I is connected to.

Normally, port number 25 for SMTP, and port number 587 for SMTP-AUTH are used.

Sender E-mail Address: Enter an e-mail address of the sender. The maximum number is 40 characters. 
Only alphanumeric characters and symbols can be used.

For how to judge the validity of e-mail address format, refer to Chapter 2 “Error Check” on page 2-62.

Sender Name: Enter a name of the sender. The maximum number is 40 characters. Only 
alphanumeric characters and symbols can be used.

Use secure connection (SSL): Select this check box to use SSL communications with the outgoing mail server.

Require authentication (LOGIN) to send E-mail: Select this check box to access the outgoing mail server (SMTP) 
protected with an account name and a password.

Account Name: Enter a name of the account. The maximum 
number is 40 characters. Only alphanumeric 
characters and symbols can be used.

Password: Enter a password. The maximum number is 40 
characters. Only alphanumeric characters and 
symbols can be used.

Specify General setting and Authentication setting by Value of Device Address:

Select this check box to set the General Setting and the 
Authentication Setting using the value of the specified 
device address.

Top Device Address: Specify the word device to use. It allocates the settings of the General Setting and the 
Authentication Setting starting at the configured device address. You can only specify an 
internal device.

Click  to display the Tag Editor. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-68.

Copy the settings as default value to Device Address: Select this check box to copy the settings in the General 
Setting and the Authentication Setting to device 
addresses as default.

(Device Address): Specifies the bit device or the bit number of the word device that triggers the copy of the 
settings. 
When the value of device address changes from 0 to 1, the values configured in the General 
Setting and the Authentication Setting are written, beginning from the device address 
set by the Top Device Address.

Click  to display the Tag Editor. For the device address configuration procedure, refer to
Chapter 2 “5.1 Device Address Settings” on page 2-68.

When the Specify General setting and Authentication setting by Value of Device Address check 
box is selected, an e-mail is not sent when the value of the device address allocated as the Sender E-mail 
Address or the Sender Name is 0, and the value of LSD222 changes to 1.
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Device Addresses for General Setting and Authentication Setting

When the Specify General setting and Authentication setting by Value of Device Address check box is 
selected, it allocates the settings of the General Setting and the Authentication Setting starting at the device 
address set in the Top Device Address. The details are shown below.

*1 When IP address is selected, use only four words from the beginning, and the remaining seventeen words are left as a 
reserved area.

*2 The twenty-first word is recognized as a NULL terminating character (0x00) regardless of the value of device address.
*3 Add a NULL terminating character (0x00) as the end of the string data when the string length is less than twenty words.

Settings Address Number Words Data Format

Outgoing mail server (SMTP) +0 to +20 21*1, *2 Host Name is selected: String
IP Address is selected: Decimal

Outgoing mail server (SMTP) port number +21 1 Decimal

Sender E-mail Address +22 to +42 21*2, *3 String

Sender Name +43 to +63 21*2, *3 String

Require authentication (LOGIN) to send E-mail
(0: Not require authentication,
 1: Require authentication)

+64 1 Decimal

Account Name +64 to +85 21*2, *3 String

Password +86 to +106 21*2, *3 String

Use secure connection (SSL)
(0: Disable, 1: Enable)

+107 1 Decimal

String data is stored in the upper byte and lower byte according to the Storage Method of String Data 
setting. For details, refer to “Storage Method of String Data” on page 4-28.
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Example: The Authentication Setting and the General Setting are set as follows:

The value of each device address is listed below.

Settings Preset Value

Outgoing mail server (SMTP), IP Address is selected. 192.168.0.44

Outgoing mail server (SMTP) port number 587

Sender E-mail Address test@example.com

Sender Name Test

Require authentication (LOGIN) to send E-mail Selected

Account Name test_account

Password test_password

Use secure connection (SSL) Selected

Top Device Address LKR 100

Storage Method of String Data from Upper byte

Settings Preset Value

Outgoing mail 
server (SMTP)

Device Address LKR 100 LKR 101 LKR 102 LKR 103 LKR 104 to LKR 120

Value (Decimal) 192 168 0 44 Reserved

Outgoing mail 
server (SMTP) 
port number

Device Address LKR 121

Value (Decimal) 587

Sender E-mail 
Address

Device Address LKR 122 LKR 123 LKR 124 LKR 125 LKR 126 LKR 127 LKR 128 LKR 129 LKR 130
LKR 131

 to 
LKR 142

String (ASCII) ‘t’ ‘e’ ‘s’ ‘t’ ‘@’ ‘e’ ‘x’ ‘a’ ‘m’ ‘p’ ‘l’ ‘e’ ‘.’ ‘c’ ‘o’ ‘m’ ‘\0’ ‘\0’ ‘\0’ ‘\0’

Value 
(Hexadecimal)

7465h 7374h 4065h 7861h 6D70h 6C65h 2E63h 6F6Dh 0000h 0000h

Sender Name

Device Address LKR 143 LKR 144 LKR 145 LKR 146 to LKR 163

String (ASCII) ‘T’ ‘e’ ‘s’ ‘t’ ‘\0’ ‘\0’ ‘\0’ ‘\0’

Value 
(Hexadecimal)

5465h 7374h 0000h 0000h

Require 
authentication 
(LOGIN) to 
send E-mail

Device Address LKR 164

Value (Decimal) 1

Account 
Name

Device Address LKR 165 LKR 166 LKR 167 LKR 168 LKR 169 LKR 170 LKR 171 LKR 172 to LKR 185

String (ASCII) ‘t’ ‘e’ ‘s’ ‘t’ ‘_’ ‘a’ ‘c’ ‘c’ ‘o’ ‘u’ ‘n’ ‘t’ ‘\0’ ‘\0’ ‘\0’ ‘\0’

Value 
(Hexadecimal)

7465h 7374h 5F61h 6363h 6F75h 6E74h 0000h 0000h

LKR 100

LKR 120
LKR 121
LKR 122

LKR 142
LKR 143

LKR 163
LKR 164

LKR 207

LKR 165

LKR 185
LKR 186

LKR 206

（The address number of Top Device Address）+0

～
+20
+21
+22

～

+42
+43

～

+63
+64
+65

～

+85
+86

～

+106
+107

Password

Account Name

Sender Name

Sender E-mail Address

Outgoing mail server (SMTP)

Outgoing mail server (SMTP) port number

Require authentication (LOGIN) to send E-mail

Use secure connection (SSL)
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Password

Device Address LKR 186 LKR 187 LKR 188 LKR 189 LKR 190 LKR 191 LKR 192 LKR 193 to LKR 206

String (ASCII) ‘t’ ‘e’ ‘s’ ‘t’ ‘_’ ‘p’ ‘a’ ‘s’ ‘s’ ‘w’ ‘o’ ‘r’ ‘d’ ‘\0’ ‘\0’ ‘\0’

Value 
(Hexadecimal)

7465h 7374h 5F70h 6173h 7377h 6F72h 6400h 0000h

Use secure 
connection 
(SSL)

Device Address LKR 207

Value (Decimal) 1

Settings Preset Value
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3.15 Project Details Tab

The Project Details tab displays and configures project data information.

■ Project Name
Shows the current project name.

■ Project Folder Size
Shows the total size of the current project data.

■ Download Data Size
Shows the total size of the data and the total size of only the image files when the current project data is downloaded.

■ Location
Shows the save location for the current project data.

■ Created
Shows the date and time the current project data was created.

■ Modified
Shows the date and time the current project data was last saved.

■ Accessed
Shows the date and time the current project data was opened.

■ User
Enter the name of the creator. The maximum number is 40 characters.

■ Comment
Enter a comment for the project data. The maximum number is 40 characters.

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P
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■ Language
Select the language used for outputting alarm log data to the printer*1, and when saving alarm log, data log, and 
operation log data as CSV files:
European, Japanese, Chinese, Taiwanese, Korean, Central European, Baltic, Cyrillic
The display type for dates and times varies based on the selected language.

Japanese: YYYY/MM/DD hh:mm:ss
European, Chinese, Taiwanese, Korean, Central European, Baltic, Cyrillic: MM/DD/YYYY hh:mm:ss

*1 HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F only
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3.16 Font/Kanji Dictionary Data Tab

The Font/Kanji Dictionary Data tab is used to configure the optional fonts and the Kanji dictionary data when 
downloading to the MICRO/I.

■ Optional Fonts to be downloaded
Select the optional fonts for download to the MICRO/I. Select the check boxes for the optional fonts when 
downloading:
Japanese Large Font (First standard), Japanese Large Font (Second Standard), Chinese, Taiwanese, 
Korean, European Large Font, Central European, Baltic, and Cyrillic.

■ Total font size
Shows the total size of the standard fonts and selected optional fonts.
If no optional fonts are selected for download to the MICRO/I, shows the size of the standard fonts.

■ Use Kanji Dictionary Data*1

Select this check box to download the Kanji dictionary data to the MICRO/I.

*1 HG5G/4G/3G/2G-V only

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

• Optional fonts, if left cleared, will be removed from the MICRO/I when the project data is downloaded.
• The check boxes for optional fonts used in drawings, parts, and Text Manager are automatically selected.
 For details about optional fonts, refer to Chapter 2 “Installed Fonts in the MICRO/I” on page 2-7.

Standard font size: Shows the total size of the standard fonts.

Optional font size: Shows the total size of the selected optional fonts.

If the Use Kanji Dictionary Data check box was cleared, will be removed the Kanji dictionary data from 
the MICRO/I when the project data is downloaded.
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3.17 Compatible Tab

The Compatible tab is used to enable the functions in previous versions of WindO/I-NV4 and older MICRO/I series 
(HG1B).
This tab is only displayed when the Use Compatible functions for previous version check box or the Use HG1B 
Compatible functions check box is selected in the WindO/I-NV4 Options dialog box, on the General tab, under 
Compatibility.

■ Compatible with previous version
This option is only displayed when the Use Compatible functions for previous version check box is selected in 
the WindO/I-NV4 Options dialog box, on the General tab, under Compatibility.

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

Script/Trigger Condition:

Calculate 16-bit data with 16-bit:

Select this check box to calculate arithmetic operations (+, -, *, /, modulo) as 16-bit data when 
UBIN16(W), BIN16(I), or BCD4(B) is selected for Data Type. Data that exceeds 16 bits is 
lost.
Clear this check box to calculate as 32 bits. No data will be lost.

Handle Logical operations as Bit operations:

Select this check box to process logical operations (||, &&) by replacing them with bit operations 
(|, &). The priority of the replaced bit operators is the same as the corresponding logical 
operators.

Communication:

Use the same O/I Link Communication as the HG4F/3F/2F/2S/1F:

Select this check box if you will connect the HG5G/4G/3G/2G-V, HG4G/3G or HG2G-5F/-5T, 
HG1G/1P to the O/I Link Communication of the HG4F/3F/2F/2S/1F.
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■ Compatible with HG1B
These options are only displayed when the Use HG1B Compatible functions check box is selected in the 
WindO/I-NV4 Options dialog box, on the General tab, under Compatibility.

Parts:

Expand display area of text for parts placed on the Top Layer:

Select this check box to draw text even when a part of the text is located outside of the part.
However, if the text too far outside the outline of the part, it may not be drawn.

Align the text area (Character Input/Message Display/Numerical Input/Numerical Display):

For characters displayed in Numerical Input, Character Input, Message Display, and Numerical 
Display, select this check box to align characters based on the area of maximum displayable 
character length.

Write NULL terminating character (0x00) as the end of string when string which Digits is maximum is input 
(Character Input):

Select this check box to write a NULL character (0x00) at the end character when a string of the 
maximum length has been input.

Show Arithmetic Error when the Minimum, Maximum or Limits is invalid (Bar Chart, Line Chart, Meter):

Select this check box to display the Processing error when the following values are invalid.

Bar Chart, Line Chart: Minimum, Maximum

Meter: Minimum, Maximum, Limits for the range

Word Button/Word Write Command:

Write the data as 2 words: Select this check box to write the calculated result of arithmetic 
operations (+, -, *, /) as two words when UBIN16(W) or 
BIN16(I) is selected for Data Type. For +, -, *, /, the calculated 
result is written in two words as a 32-bit numeric value. 
For "/" (division), the quotient data is written in the first word, and 
the remainder data is written in the second word.
Clear this check box to write the result of arithmetic operations as 
one word.

Numerical Input/Numerical Display:

Divide Floating data and Integer data: Select this check box to read and display the decimal portion of 
data and the integer portion of data from different device 
addresses when BCD4(B) or BCD8(EB) is selected for Data 
Type.

Message Display:

Ignore LF code in the variable strings: Select this check box to display messages by ignoring the linefeed 
code LF (0Ah) when displaying text according to values of device 
addresses.
Clear this check box to display messages with line breaks using the 
linefeed code LF (0Ah).

Convert NULL code to Space code in the variable strings:

Select this check box to display messages by converting the NULL 
terminating code (00h) to a space (20h) when displaying text 
according to values of device addresses.
Clear this check box to terminate messages with the NULL 
terminating code (00h).

Timer:

Keep Timer status after changing the screen: Select this check box to continue the timer count when switching 
the base screen or when displaying a popup screen.
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3.18 BACnet/IP Settings Tab

Enables the functions of the BACnet communication. For details on the BACnet communication, refer to Chapter 3 “7 
BACnet Communication” on page 3-94.

■ Use BACnet/IP
Select this check box to use the functions of the BACnet communication.
Click Setting to display the BACnet Settings dialog box.

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P
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4.1 Download Restrictions

■ Project Data Size
The size of the project data that can be downloaded to the MICRO/I is as follows.

■ Number of Parts
The number of parts that can be downloaded to the MICRO/I are as follows.

4.2 Maximum Number of External Device Addresses

■ Data Log Settings
A maximum of 128 external device addresses can be used in the Data Log settings.

■ Global Script
A maximum of 256 external device addresses can be used as a trigger condition and in scripts executed as Global 
Script.

■ Scripts
The number of external device addresses which can be used in the script are as follows:

4 Project Restrictions

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

MICRO/I Project data size

HG5G/4G/3G/2G-V Approx. 58 MB max (including additional fonts and Kanji Dictionary Data)

HG4G/3G, HG2G-5F, HG1G/1P Approx. 12 MB max (including additional fonts)

HG2G-5T Approx. 5 MB max (including additional fonts)

• To check the project data size, on the Home tab, in the Project group, click Target Info. The Target 
Information dialog box is displayed. The project data size can be checked with Memory Space (byte) 
under Target Runtime Information.

• The project data size varies based on the fonts downloaded to the MICRO/I. For details, refer to Chapter 
2 “Font Size” on page 2-9.

Parts Number of parts

Total number of Bit Buttons, Word Buttons, Goto Screen Buttons, Key Buttons 32,000 max.

Selector switches 200 max.

If the same device address is used in multiple device address settings, the number of used device addresses 
is counted as 1. It is not counted as 1 device address per device address setting.

If the same device address is used in multiple device address settings, the number of used device addresses 
is counted as 1. It is not counted as 1 device address per device address setting.

Item Number of devices

Destination external device addresses 64 max.

Source external device addresses 64 max.

• If the same device address is used in multiple device address settings, the number of used device 
addresses is counted as 1. It is not counted as 1 device address per device address setting.

• For the Global Script, the maximum number of source external device addresses which can be used as a 
trigger condition and in scripts executed as Global Script is 256.
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■ E-mail Settings
A maximum of 255 external device addresses can be used in the E-mail settings.

■ File Transfer Settings (FTP client function)
A maximum of 240 external device addresses can be used in the File Transfer settings.
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This chapter gives an overview of the MICRO/I screen and describes how to create setup and operate the screen.

  

1.1 Screen Types

The types of screens offered by the MICRO/I and screens that can be created with the WindO/I-NV4 are given below.

1.2 Screen Size

The screen size differs depending on the MICRO/I model selected. The size of the MICRO/I screen is equal the size of 
the Base Screen.

*1 The Keypad that is displayed when operating Numerical and Character Input parts when Standard is selected under Type 
in the Keypad menu for Numerical and Character Input parts.

Chapter 5 Screen

1 Screen Overview

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

Screen Type Screen No. Description

Screens that can 
be created with 
the WindO/I-NV4

Base Screen 1 to 3000
The screen that is displayed when the MICRO/I is in Run Mode. This 
screen places drawing objects and parts on the base and creates a 
screen that is displayed on the MICRO/I.

Popup Screen 1 to 3015

The Popup Screen that is displayed on the Base Screen when the 
MICRO/I is in Run Mode. The size and coordinates of the screen can be 
specified and this screen can also be moved on the Base Screen.

A Popup Screen for the standard Keypad*1 will automatically be created 
in screen numbers 3001 to 3015.

The screen 
provided by the 
MICRO/I

Maintenance 
Screen

–

Using the screen that is displayed when the MICRO/I is in Run Mode, 
you can switch from Run Mode to System Mode and load a screen to 
adjust device monitor and screen brightness.
For details, refer to Chapter 34 “1 Maintenance Screen” on page 34-1.

MICRO/I
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Maintenance

System Mode

Device Monitor

Adjust Brightness

Maintenance

System Mode

Device Monitor

Adjust Brightness

Base Screen

Popup Screen

Maintenance Screen

Model Screen Size (W x H)

HG5G/4G/3G-V 1024 x 768 dots

HG4G/3G 800 x 600 dots

HG2G-V, HG2G-5F 640 x 480 dots

HG2G-5T 320 x 240 dots

HG1G/1P 480 x 272 dots
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2.1 Creating Screens

This section describes how to create Base Screens and Popup Screens.

● Creating a screen

1 On the Home tab, in the Screens group, click ▼ under New.

2 Click Base Screen or Popup Screen.

The Screen Properties dialog box is displayed.

3 Change the settings on each tab as necessary and click the OK button.

2 Creating and Manipulating WindO/I-NV4 Screens

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

To edit the properties for a Base Screen or Popup Screen that has already been created, double click an area 
in the editing window with no objects.
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2.2 Opening Screens

● Opening a screen
You can open a single screen that has already been created.

Double click the screen to open in the Project window.

● Opening specific screens
You can open multiple screens as a group.

1 On the Home tab, in the Screens group, click ▼ to the right of Open.

2 Click the Base Screen or the Popup Screen.

The Open Screens dialog box is displayed.

3 Click the screens to open in Screen List and then click the OK button.

■ Screen Type
Select the type of screen to open from the following items. The selected screen type is displayed in Screen List.
All, Base Screen, Popup Screen

■ Screen List
This list shows screens that have already been created.

If you right click a screen in the Project window, and then click Open Screens, the selected screen opens.

If you right click a screen folder in the Project window and then click Open Screens, the Open Screens 
dialog box is displayed.

To select multiple screens, press and hold SHIFT or CTRL while you click the specific items.
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● Opening the previous or next screen
You can open the screen with the previous screen number or the next screen number of the screen displayed in the 
active editing window.

To open the screen with the previous screen number, click the  (Open Previous Screen) button in the Screens 

group on the Home tab. To open the screen with the next screen number, click the  (Open Next Screen) button.
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2.3 Closing Screens

● Closing the displayed screen
You can close the active editing window.

Click  in the upper-right of the editing window.

● Closing all screens
You can close all the editing windows.

On the View tab, in the Window group, click Close All.

● Closing a specific screen
You can close multiple editing windows as a group.

1 Right click a screen folder in the Project window and click Close Screens.

The Close Screens dialog box is displayed.
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2 Click the screens to close in Screen List and click the OK button.

■ Screen Type
Select the type of screen to close from the following items. The selected screen type is displayed in Screen List.
All, Base Screen, Popup Screen

■ Screen List
This list shows the screens being edited.

■ Select All
Selects all the screens displayed in Screen List.

To select multiple screens, press and hold SHIFT or CTRL while you click the specific items.
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2.4 Duplicating Screens

You can copy a screen that has already been created to create a new screen.

1 Right click a screen folder or screen in the Project window and click Duplicate Screens.

The Duplicate Screens dialog box is displayed.

2 Select the screens to copy in Screen List.

3 Specify Screen Number for the new screen and the Number of copies to duplicate and then click the OK button.

■ Screen Type
Select the type of screen to duplicate from either Base Screen or Popup Screen. The selected screen type is 
displayed in Screen List.

■ Screen List
This list shows screens that have already been created.

■ Screen Number
Specify the screen number (Base Screen: 1 to 3000, Popup Screen: 1 to 3015) for the new screen.

■ Number of copies
Specify the number of screens to copy (Base Screen: 1 to 2999, Popup Screen: 1 to 3014).

To select multiple screens, press and hold SHIFT or CTRL while you click the specific items.
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• If multiple screens are selected in Screen List or if the Number of copies is 2 or more, consecutive 
screen numbers are added to the screens starting with the number specified in Screen Number.
Example: When a screen with screen number of 1 is selected in Screen List, the Number of copies is 

3, and Screen Number is 100 is selected, then the screen numbers after duplication are 
“100”, “101”, “102”.

Example: When screens with screen numbers 3 and 5 are selected in Screen List, the Number of 
copies is 2, and Screen Number is 100 is selected, then the screen numbers after 
duplication are “100” and “102” for the screens duplicated from screen number 3 and “101” and 
“103” for the screens duplicated from screen number 5.

• If a screen number already exists after copying and you click the OK button on the Duplicate Screens 
dialog box, an overwrite confirmation message is displayed.
- Click the Yes button to overwrite the screen with the number displayed in the confirmation message.
- Click the Yes To All button to overwrite all the screens.
- Click the No button to display the next confirmation message without copying the screen with the 

number displayed in the confirmation message.
- Click the Cancel button to stop copying screens and return to the editing window.

Screen List’s numbers: 1
Screen Number: 100
Number of copies: 3

Screen Number: 1 Screen Number: 100

Screen Number: 101

Screen Number: 102

Copy99 99

99

99

Screen List’s numbers: 3,  5
Screen Number: 100
Number of copies: 2

Screen Number: 3

Screen Number: 5

Screen Number: 100

Screen Number: 101

Screen Number: 102

Copy

Screen Number: 103

Copy

99

99

99

Full Full

Full
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2.5 Deleting Screens

● Deleting a screen
You can delete a single screen.

1 Right click the screen to delete in the Project window and click Delete Screens.

A delete confirmation message is displayed.

2 Click the Yes button.

The screen is deleted.
Click the No button to return to the editing window without deleting the screen.

● Deleting specific screens
You can delete multiple screens as a group.

1 On the Home tab, in the Screens group, click Delete.

The Delete Screens dialog box is displayed.

If you right click a screen folder in the Project window and click Delete Screens, the Delete Screens 
dialog box is displayed.
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2 Click the screens to delete in Screen List and click the OK button.

A delete confirmation message is displayed.

■ Screen Type
Select the type of screen to delete from the following items. The selected screen type is displayed in Screen List.
All, Base Screen, Popup Screen

■ Screen List
This list shows screens that have already been created.

■ Select All button
Selects all the screens displayed in Screen List.

3 Click the Yes button or the Yes To All button.

• Click the Yes button to delete the screen with the number displayed in the confirmation message. When deleting 
multiple screens, the next message to confirm deleting a screen is displayed.

• Click the Yes To All button to delete all the screens without displaying the confirmation message.
• Click the No button to display the next message to confirm deleting a screen without deleting the screen with the 

number displayed in the confirmation message. You will return to the editing window when finished confirming all 
the screens.

• Click the Cancel button to stop deleting screens and return to the editing window.

To select multiple screens, press and hold SHIFT or CTRL while you click the specific items.
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2.6 Reusing Screens

You can copy screens from other project data.

1 On the Home tab, in the Screens group, click Reuse.

2 Select project data that includes the screens to copy and click OK.

The Open dialog box is displayed.

If you right click a screen folder or screen in the Project window and click Reuse Screens, the Open 
dialog box is displayed.

If a password has been configured for the project data, the Password Screen will be displayed.
The password to enter varies based on the check box setting of the Use Password to open a Project 
found under the Options tab in the Security dialog box.
When this check box is checked, enter the password for Use Password to open a Project.
When this check box is unchecked, enter the password for the user account assigned to the Administrator 
security group.
For details, refer to Chapter 23 “User Accounts and the Security Function” on page 23-1.
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3 Click the screens to copy in Screen List and click the OK button.

■ Screen Type
Select the type of screen to copy from the following items. The selected screen type is displayed in Screen List.
All, Base Screen, Popup Screen

■ Screen List
This list shows screens included in the source project data.

To select multiple screens, press and hold SHIFT or CTRL while you click the specific items.

If the screen number of the screen to copy, a picture included in the screen, a text ID, or a script ID already 
exists in the project data being edited, an overwrite message is displayed.
• Click the Yes button to overwrite the item displayed in the confirmation message. If there are multiple 

redundant items, a confirmation message is displayed for each of those items.
• Click the Yes To All button to overwrite all of the picture numbers, pictures, text IDs, and script IDs.
• Click the No and a dialog box opens for each setting. Change the item to a unique screen number or ID 

and click the OK button.
• Click the Cancel button to stop overwriting the displayed in the confirmation message. If there are 

multiple redundant items, a confirmation message is displayed for each of those items.
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2.7 Batch Editing of Multiple Screen Settings

You can modify the settings for multiple base screens or popup screens collectively.

1 Selects multiple screens of the same type on the Project window or in the Screen List window, right-click to open a 
popup menu, and then click Properties.
The Screen Properties dialog box is displayed.

2 Configure only the items to modify collectively.

3 Click the OK button.

To select multiple screens, press and hold SHIFT or CTRL while you click the specific items.



3 Base Screen

5-14 WindO/I-NV4 User’s Manual

  

The screen that is displayed when the MICRO/I is in Run Mode. This screen places drawing objects and parts on the 
base and creates a screen that is displayed on the MICRO/I.

3.1 Properties of Base Screen Dialog Box

● General Tab

■ Screen Type
Select Base Screen as the screen type.
You can only select the screen type when creating a new screen.

■ Number
Enter the Base Screen’s screen number (1 to 3000).

■ Title
Enter the Base Screen’s title. Maximum number is 40 characters.

■ Size
Shows the screen size. You cannot change the size of Base Screens.

■ Screen List
This list shows screens that have already been created. It is only displayed when creating a new screen.

3 Base Screen

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P
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● Options Tab

■ Background Color
Select the screen’s background color (color: 256 colors, monochrome: 16 shades). Click this button to open the color 
palette. Select color with the color palette.

■ Overlay with Base Screen
Configure this section to display the Base Screen by overlaying screens.

When Overlay with Base Screen is configured, the background color for the Base Screen specified as the 
background is displayed.

1 to 5: Select these to display the Base Screen by overlaying screens.

No.: Enter the overlay screen’s screen number (1 to 3000).

Coordinates X, Y: Specify the display location of the overlay screen in coordinates. The coordinates can be set 
in the range (Screen size - 1 dot).
The origin is the upper-left corner of the screen and the X- and Y-coordinates correspond to 
the upper-left corner of the overlay window.

(0, 0)
X

Y
Base screen

Overlay screen
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■ Display the Order of Overlapping Screens
You can select the display order of the Base Screen and the overlay screens.
Example: To display the Base Screen being edited as the background

Example: To display the Base Screen being edited above overlay screen: 3

■ Flash
Select one of the following items as the setting when the screen is flashing.

■ Focus Order
Sets the focus order for Numerical Input and Character Input. The focus order is the order the focus moves between 
Numerical Input or Character Input when the user presses the ENT key. Text can be input in Numerical Input or 
Character Input that has focus. The focus order number starts from 0.

Base screen being edited

Overlay screen
(5 screens max)

Base screen being edited

Overlay screen: 3

None: Displays the screen.

Flash (1 sec cycle): The screen display is flashed in one second intervals.

Flash (0.5 sec cycle): The screen display is flashed in half second intervals.

Backlight OFF: Turns off the backlight until the screen is touched or until bit 0 or bit 7 is set to 1 in the 
system area 1’s address number + 1.

Vertical: The focus moves vertically from top to bottom.

Horizontal: The focus moves horizontally from left to right.

Custom: Sets the desired order for moving the focus.
On the View tab, in the Screens group, click Focus Order, and then click the parts in the 
order to move the focus.

The focus moves in the following order when Numerical Input and Character Input on the screen is not 
aligned to the left or top.

1

4

3

2

1

4

3

21234

5

890

67

1234

5
890

67Vertical

X-axis left to right

Y-axis up to down

Horizontal
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● Security Tab
This tab is used to restrict displaying the screen by security groups.
This option can only be set when Use Security functions is selected. The Use Security functions check box is set 
on General tab in the Security dialog box.

■ (Settings)
Displays the list of security groups used on the MICRO/I.

■ Security Settings
The Security Settings dialog box is displayed. If you create a security group in the Security Settings dialog box, you 
can select that created group. For details, refer to Chapter 23 “2.2 Adding and Editing Security Groups” on page 23-
19.

No.: Displays the security group numbers (0 to 15).

Group Name: Displays the name of the security group.

Display: Displays whether or not there is permission to display the screen. Only 
Permitted security groups can open this screen. Double clicking the cell switches 
between Permitted and Prohibited.

You can also switch between Permitted and Prohibited from the right-click menu on a Display cell.

For details about the security function, refer to Chapter 23 “User Accounts and the Security Function” on 
page 23-1.
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3.2 Displaying Layered Base Screens

It is possible to layer and display multiple Base Screens. The coordinates and display order for layered screens can be 
set on the screen that will serve as the base. A maximum of 5 layered screens can be displayed.

■ Coordinates
Using the upper-left corner of the screen as the origin, the upper-left area of the layered screen become the X and Y 
coordinates.

■ Display Order
This allows you to select the order of display for the screen that will serve as the base and layered screens.
Example: Displaying a Base Screen that is currently being edited as the bottom most layer

Example: Displaying a Base Screen currently being edited on the layered screen: 3.

For details about how to configure these settings, refer to “3.1 Properties of Base Screen Dialog Box” on page 5-14.
Example: When Base Screen: 100 which has a clock placed in it, is used as a layered screen, Base Screen:1 which is 

displayed as the base and Base Screen: 2 will be displayed as follows:

(0, 0)
X

Y
Base screen

Overlay screen

Base screen being edited

Overlay screen
(5 screens max)

Base screen being edited

Overlay screen: 3

130
100
120

110

11/Feb./22 Tue. 12:00

11/Feb./22 Tue. 12:0011/Feb./22 Tue. 12:00

130
100
120

110

Base Screen: 1 Base Screen: 100 Base Screen: 2

Display for Base Screen: 1 Display for Base Screen: 2

Layering Layering

Displayed as 
the base

Displayed as 
the base

Layered Screen
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• Layered screens that have been set as layered screens will not be displayed on the screen that is 
displayed as the base.
Example: Layering and displaying Base Screen: 100 on Base Screen: 1

Layering and displaying Base Screen: 101 on Base Screen: 100

• Drawing objects and parts from layered screens may not display properly when placed outside of the 
displayed area.

130
100
120

11/Feb./22 Tue. 12:00

11/Feb./22 Tue. 12:00

130
100
120

Base Screen: 1 Base Screen: 100

Base Screen: 101

Display for Base Screen: 1

Display for Base Screen: 100

Layering

Layering

0

11/Feb./22 Tue. 12:00

130
100
120

0

11/Feb./22 Tue. 12:00

0

Displayed as 
the base

Layered Screen
Layered Screen

Layered Screen (Base Screen: 
101) is displayed.

Layered Screen (Base 
Screen: 101) is not 
displayed.

Outside of the display area

Layered Screen

Displayed as the base

When layering and displaying base screens that have drawings and parts placed on the top layer, they are 
displayed in order of each top layer in front of each base screen.
Example: When layering Base Screen 2 on the of Base Screen 1

For displaying of drawings and parts placed on the top layer, refer to Chapter 6 “4 Drawings and Parts 
Overlapping” on page 6-5.

Base Screen 2

Base Screen 1

Display for Base Screen: 1

Layering

14/07/22 12:00

130

100

120

14/07/22 12:00

130
100

120

14/07/22 12:00
130

100
120

Top layer of Base Screen 2

Top layer of 
Base Screen 2

Top layer of 
Base Screen 1

Base Screen 2

Base Screen 1

Top layer of Base Screen 1
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The Popup Screen that is displayed on the Base Screen when the MICRO/I is in Run Mode. The size and coordinates 
of the screen can be specified and this screen can also be moved on the Base Screen.

4.1 Properties of Popup Screen Dialog Box

● General Tab

■ Screen Type
Select Popup Screen for the screen type.
You can only select the screen type when creating a new screen.

■ Number
Enter the Popup Screen’s screen number (1 to 3015).
However, screen numbers 3001 to 3015 are Popup Screens for standard Keypads for Numerical Input and Character 
Input.

■ Font
Select the font to use for the title from the following items:
Japanese, European, Chinese, Taiwanese, Korean, Central European, Baltic, Cyrillic
This option can only be selected when Use Text Manager is cleared.

■ Use Text Manager
Select this to use text registered in the Text Manager for the screen title.
However, the text color is white, not the color set in the Text Manager.

■ Text ID

Specify the Text Manager ID number (1 to 32000) to use text registered in the Text Manager. Click  to display the 
Text Manager.
This option can only be set when Use Text Manager is selected.

4 Popup Screen

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P
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■ Title
Enter the Popup Screen’s title. Maximum number is 40 characters. This title is displayed in the Popup Screen’s title bar.
This option can only be entered when Use Text Manager is cleared.

■ Size

■ Screen List
This list shows screens that have already been created. It is only displayed when creating a new screen.

● Options Tab

■ Background Color
Select the screen’s background color (color: 256 colors, monochrome: 16 shades). Click this button to open the color 
palette. Select the color with the color palette.

■ Screen Effects

■ Title Bar
Select this to display the title bar on the Popup Screen. The text set in Title on the General tab is displayed in the 
title bar.
The title bar is not displayed if superimpose is set.

Width, Height: Specify the width (40 dots to Base Screen width) and the height (40 dots to Base Screen height) of 
the Popup Screen.

None: Displays the Popup Screen’s background with the color specified in Background Color.

Transparency: Displays the Popup Screen’s background as transparent. The amount of transparency can be selected 
from 10% to 90% in 10% increments.

Superimpose: Displays the Popup Screen’s background as completely transparent. The screen underneath the 
Popup Screen can be seen.

If you select Superimpose, the buttons underneath the Popup Screen set to superimpose are active.

If Superimpose is selected in Screen Effects, magenta (R:255, G:4, B:255) is treated as the transparent 
color. If you place pictures on a Popup Screen set to superimpose that use this color, those areas are 
completely transparent.

Move Button: Select this to display the  (Move) button on the title bar.

Close Button: Select this to display the  (Close) button on the title bar.
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■ Open with Fade In
When opening a Popup Screen, select this to gradually fade in the popup screen from nothing to the transparency 
specified in Transparency.

■ Close while changing Base Screen
Select this to close the displayed popup screen when changing the Base Screen.

■ Focus Order
Sets the focus order for Numerical Input and Character Input. The focus order is the order the focus moves between 
Numerical Input or Character Input when the user presses the ENT key. Text can be input in Numerical Input or 
Character Input that has focus. The focus order number starts from 0.

■ Security Group
Select a security group to restrict displaying the screen.
This option can only be set when Use Security functions is selected. The Use Security functions check box is set 
on General tab in the Security dialog box.

Click  to display the Security Settings dialog box. If you create a security group on the Security Settings 
dialog box, you can select that created group. For details, refer to Chapter 23 “2.2 Adding and Editing Security 
Groups” on page 23-19.

Vertical: The focus moves vertically from top to bottom.

Horizontal: The focus moves horizontally from left to right.

Custom: Sets the desired order for moving the focus.
On the View tab, in the Screens group, click Focus Order, and then click the parts in the order to 
move the focus.

The focus moves in the following order when Numerical Input and Character Input on the screen is not 
aligned to the left or top.

1

4

3

2

1

4

3

21234

5

890

67

1234

5
890

67Vertical

X-axis left to right

Y-axis up to down

Horizontal

None: Any user can open this screen.

Administrator, Operator, 
Reader, (Created security group): Only selected users can open this screen.

For details about the security function, refer to Chapter 23 “User Accounts and the Security Function” on 
page 23-1.
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● Security Tab
This tab is used to restrict displaying the screen by security groups.
This option can only be set when Use Security functions is selected. The Use Security functions check box is set 
on General tab in the Security dialog box.

■ (Settings)
Displays the list of security groups used on the MICRO/I.

■ Security Settings
The Security Settings dialog box is displayed. If you create a security group in the Security Settings dialog box, you 
can select that created group. For details, refer to Chapter 23 “2.2 Adding and Editing Security Groups” on page 23-
19.

No.: Displays the security group numbers (0 to 15).

Group Name: Displays the name of the security group.

Display: Displays whether or not there is permission to display the screen. Only 
Permitted security groups can open this screen. Double clicking the cell switches 
between Permitted and Prohibited.

You can also switch between Permitted and Prohibited from the right-click menu on a Display cell.

For details about the security function, refer to Chapter 23 “User Accounts and the Security Function” on 
page 23-1.
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4.2 Popup Screen Configuration

■ Title Bar
Displays buttons and the title of the Popup Screen.
Pressing the title bar of the screen allows you to move the screen to the front.

■  (Move) Button
Moves the Popup Screen.

Close ButtonMove Button

Title Bar

Screen Display Area

MICRO/I MICRO/I MICRO/I

When there is a title bar on the popup screen, touch switches that are within 20 dots of the title bar will not 
respond.

1 Press 2 Touch the position where the 
screen will be moved to

3 The screen will move the position 
that was touched

MICRO/I MICRO/I MICRO/I

The location that was touched will 
become the location of      .

• The Popup Screen can be moved in the range where the  button can be displayed.

• The Popup Screen will be moved in units of 1 dot.
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■  (Close) Button

Closes the Popup Screen.

■ Screen Display Area
The area where drawing objects and parts are placed.

4.3 Standard Keypad Popup Screen

A Popup Screen that places a regular Keypad used for Numerical Input, Character Input, inputting for E-mail and clock 
settings on screen numbers 3001 to 3015 with the WindO/I-NV4.
Example: HG2G-5T

Decimal (Number Value) Keypad Uppercase (Alphabet) Keypad

• The Keypad Popup Screen will differ depending on the model selected.
• The Keypad Popup Screen can also place drawing objects and parts in the same manner as Popup Screen 

numbers 1 to 3000.
• Screen numbers 3001 to 3015 are screen numbers that are empty when a new project has been created 

and are handled as normal Popup Screens.
• Deleting a Keypad Popup Screen and recreating a new Popup Screen of the same screen number will 

place the same Keypad.
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5.1 Screen Number

The number of screens and layered screens that can be created in a single project and the number of Popup Screens 
that can be displayed on the Base Screen are as follows:

■ Base Screen

■ Popup Screen

5.2 Maximum Number of Parts

■ Number of Parts That Can be Placed on a Single Screen

■ Number of Parts That Can be Displayed on a Single Screen
In addition to the currently displayed Base Screen, this includes layered screens and currently displayed Popup 
Screens.

*1 The maintenance screen is not included.

5 Screen Restrictions

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

Item Number of screens

Number of screens that can be created 3,000 max.

Number of layered screens 5 max.

Item Number of screens

Number of screens that can be created 3,015 max.

Number of screens that can be displayed on the Base Screen 3 max. (Including the Device Monitor*1)

Screen Number of Parts

Base Screen 960 max.

Popup Screen 480 max.

Parts Number of Parts

Alarm List Display, Alarm Log Display Limit to 1. Either one but can't be both.

Numerical Inputs and Character Inputs in a constant state of input Limit to 1. Either one but can't be both.

Potentiometer 32 max.

Numerical Input 256 max.

Character Input 256 max.

Video Display 1 max.
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5.3 Maximum Number of External Device Addresses

The maximum number of Read/Write device addresses of external devices is 512 for base screens (including overlay 
screens) and popup screens.

5.4 Text and Messages

Follow the rules below, otherwise text and messages on the MICRO/I may not be displayed or may be partially 
missing.

5.5 Vertical Installation

Even if you choose for them to be installed and displayed vertically, the screens in the System Mode will be the same 
as horizontal installation and display.

If the same device address is used in multiple device address settings, the used number of device addresses 
will be counted as 1 device address. It will not be counted as 1 point per device address setting.

Popup screen title: Make shorter than the title bar

Text on drawings: Make smaller than the text area

Text and messages used in parts: Make smaller than the size of the parts
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This chapter contains an overview of drawings and parts that are used when creating a screen and a description of 
the types of drawings and parts.

  

Drawings and parts are used by placing them on base screens and popup screens.

Drawings include objects such as straight lines, polygons, circles, pictures, and static text.

Parts are objects that generate a variety of events when triggered by a change in values of device addresses or by 
touch.
 

Chapter 6 Drawings and Parts

1 Overview

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

MICRO/I

Caution

Equilateral Triangle

Polyline

Line
Text

Picture

External device

External device

Parts changed to reflect 
changes in values of 
device addresses

Tank 1

MICRO/I

MICRO/I

D10: 80

D11: 25

D12: 2

D13: 0

D14: 0

D15: 0

D10: 99

D11: 82

D12: 5

D13: 1

D14: 1

D15: 1

0

Tank 1

0

Full

Empty

99
82

5

80
25

2

Pilot Lamp

Numerical Input

Message Display

Line Chart

Selector Switch

Numerical Display

Picture Display
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This section describes the drawing objects that can be drawn in WindO/I-NV4.

2.1 Shapes

2.2 Picture

Loads drawing objects that are registered in the Picture Manager onto the edit screen.

2.3 Text

Draws text. The maximum number is 3,750 characters.
Loads text that is registered in the Text Manager.

2 Drawing objects

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

Shapes Function

Basic Shapes

Line Draws a line.

Polyline Draws a polyline.

Polygon Draws an object that connects two or more vertices with straight lines.

Rectangle Draws a rectangle.

Circle/Ellipse Draws a circle or ellipse.

Arc Draws an elliptical arc.

Pie Draws a pie.

Equilateral Polygon Draws a equilateral polygon. (triangle, diamond, pentagon, hexagon, or octagon)

Paint Paints the closed region of the drawing object.
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This section describes the parts that can be used on the MICRO/I.

3.1 Buttons

3.2 Lamps

3.3 Data Displays

3 Part Types

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

Part Description

Bit Button Writes a 0 or 1 to a bit device.

Word Button Writes a value to a word device. Can be used to indirectly specify the destination address 
number or to perform operations on the written value.

Goto Screen Button Switches to another screen or displays a window.

Print Button Outputs a screenshot to a printer or external memory devices.

Key Button Performs a variety of functions including uploading and downloading, copying files, and 
operating other parts.

Multi-Button Executes multiple commands at once.

Keypad A part comprised of Key Buttons. Enters numbers and characters into numerical or character 
input parts.

Selector Switch Writes a 0 or 1 to a bit device. This is an exclusive control that only writes a single value as 
1 and all other values as 0.

Potentiometer Writes a value selected by pressing a slider button to a word device.

Part Description

Pilot Lamp Displays images. Switches the displayed image according to the value of a bit device.

Multi-State Lamp Displays images. Switches the displayed image according to the value of a word device.

Part Description

Numerical Input Uses either a Keypad or Key Button to write entered numbers.

Character Input Uses either a Keypad or Key Button to write the character code for entered characters.

Picture Display Displays images. Switches, moves or enlarges/reduces the displayed image according to the 
value of a device address, the bit status within a word device or at a fixed period.

Video Display Displays images and plays movie files.

Message Display Loads fixed text strings and word device values as character codes and displays them on the 
screen.

Message Switching Display Switches the displayed fixed text string according to the value of a word device or the bit 
status within a word device.

Alarm List Display Switches the displayed fixed text string according to the value of a device address. Can 
display alarms and multiple fixed text strings.

Alarm Log Display Displays the alarm log stored in the internal memory of the MICRO/I.

Numerical Display Displays the numerical in the specified format.

Calendar Displays the date and time using the MICRO/I's calendar data.
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3.4 Charts

3.5 Commands

Part Description

Bar Chart Displays values of word devices in a Bar Chart.

Line Chart Displays data logs and values of word devices in a Line Chart.

Pie Chart Displays values of word devices in a Pie Chart.

Meter Displays a value of a word device using a needle gauge.

Part Description

Bit Write Command Writes a 0 or 1 to a bit device when certain trigger conditions are satisfied.

Word Write Command
Writes a value to a word device when certain trigger conditions are satisfied. Can be used to 
indirectly specify the destination address number or to perform operations on the written 
value.

Goto Screen Command
Switches to another screen or displays a window when certain trigger conditions are 
satisfied.

Print Command
Outputs a screenshot to a printer or external memory devices when certain trigger 
conditions are satisfied.

Script Command Executes a script when certain trigger conditions are satisfied.

Multi-Command Executes multiple commands at once when certain trigger conditions are satisfied.

Timer
Starts a countdown when certain trigger conditions are satisfied, and writes 1 to an internal 
device (HMI Timer Relay LTC) after the set time has elapsed.
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This section describes when drawing and parts overlap.

4.1 Overview

Place the drawings and parts on the top layer to have precedence when these objects overlap on base screens and 
popup screens.
Configure the Properties dialog box of the drawings or parts if they need to be placed on the top layer. For details, 
refer to the settings for the drawings or part.

4 Drawings and Parts Overlapping

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

Base Screen or Popup Screen

Display for Base Screen or Popup Screen

130
100
120

130
100

120Top Layer
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4.2 Displaying Overlapping Drawings and Parts

The display when drawings and parts overlap on base screens and popup screens varies based on the location where 
they are placed.

● Display order of overlapping parts
•If two parts overlap on a base screen or popup screen, the part last modified is displayed in the front.
Example: A Numerical Display is placed on the base screen and a Bit Button is placed in front of it.

•If two parts are overlapping each other on a base screen or popup screen, the part which is configured in the 
Properties dialog box as a top layer, will keep displaying in the front.
Example: A Numerical Display is placed on the base screen and a Bit Button is placed on the top layer.

•If parts placed on the top layer overlap, the display order of the parts does not change.
Example: A Numerical Display is placed on the top layer and a Bit Button is placed in front of it.

Display for Base Screen: 1

Numerical Display is displayed in front

Changes the value

1234

Numerical Display
Bit Button

Base Screen: 1

1234

9999

Object list

No. Type Layer

1 Numerical Display

2 Bit Button

567

Display for Base Screen: 1

The display order of Numerical Display
and Bit Button is unchanged

Changes the value

1234

Top Layer

Numerical
Display

Bit Button

Base Screen: 1

1234

9999

Object list

No. Type Layer

1 Numerical Display

2 Bit Button Top Layer

567

Display for Base Screen: 1

The display order of Numerical Display
and Bit Button is unchanged

Changes the value

1234
Top Layer

Numerical
Display

Bit Button

Base Screen: 1

1234

9999

Object list

No. Type Layer

1 Numerical Display Top Layer

2 Bit Button Top Layer
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● Display order of drawing and parts overlapping
•If a drawing and part are overlapping with each other on a base screen or popup screen, the drawing or part 
configured in the Properties dialog box as a top layer, then it will be displayed in the front over the other.
Example: An equilateral hexagon is placed on the base screen and a Numerical Display is placed in front of it.

•If a part placed on a base screen or popup screen and a drawing placed on the top layer overlap, the drawing placed 
on the top layer is always displayed in front.
Example: A Numerical Display is placed on the base screen and an equilateral hexagon is placed on the top layer.

Display for Base Screen: 1

The display order of the equilateral hexagon
and Numerical Display is unchanged

1234

9999

Changes the value

1234
Equilateral

Hexagon

Numerical Display

Base Screen: 1

Object list

No. Type Layer

1 Equilateral hexagon

2 Numerical Display

567

Display for Base Screen: 1

The display order of the equilateral hexagon
and Numerical Display is unchanged

1234

9999

Changes the value

1234

Top Layer

Equilateral Hexagon

Numerical Display

Base Screen: 1

Object list

No. Type Layer

1 Numerical Display

2 Equilateral hexagon Top Layer
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● Drawing and Parts are hidden

•When a drawing and another drawing or part placed on a base screen or popup screen overlap, if the drawing or 
part in front becomes hidden, the portion of the background drawing that was overlapped remains missing.
Example: A rectangle is placed on the base screen and a Picture Display is placed in front of it.

•When a drawing placed on a base screen or popup screen and a drawing or part placed on the top layer overlap, if 
the drawing or part placed on the top layer becomes hidden, only the drawing that was placed on the base screen or 
popup screen is displayed.
Example: A rectangle is placed on the base screen and a Picture Display is placed on the top layer.

•When a drawing and another drawing or part placed on the top layer overlap, if the drawing or part in front becomes 
hidden, only the background drawing is displayed.
Example: A rectangle is placed on the top layer and a Picture Display is placed in front of it.

In the following situations, the drawing and the part image type are hidden.
•When the drawing or part is flashing
•When the hidden condition is satisfied in a part configured with display conditions
•When a lamp is off that has its Not Display Image check box selected on the View tab
•When an unregistered state or number is selected for the image type in a Multi-State Lamp or Picture Display
•When moving a Picture Display

Display for Base Screen: 1

Picture Display
is hidden

Overlapping part for the rectangle and Picture Display is the
background for the screen and the rectangle remains missing.

Rectangle

Picture Display

Base Screen: 1

Object list

No. Type Layer

1 Rectangle

2 Picture Display

Display for Base Screen: 1

Picture Display
is hidden

Rectangle remains

Top Layer

Rectangle

Picture Display

Base Screen: 1

Object list

No. Type Layer

1 Rectangle

2 Picture Display Top Layer

Display for Base Screen: 1

Picture Display
is hidden

Rectangle remains

Top Layer
Rectangle

Picture Display

Base Screen: 1

Object list

No. Type Layer

1 Rectangle Top Layer

2 Picture Display Top Layer



WindO/I-NV4 User’s Manual 6-9

4 Drawings and Parts Overlapping

6

D
raw

ings and Parts

● Display order of overlapping parts that have None selected for Image Type
•When a drawing and a part that has None selected for Image Type placed on a base screen or popup screen 
overlap, if the value for the part changes or if the picture for the part changes, the portion of the background 
drawing that was overlapped remains missing.
Example: An equilateral hexagon is placed on the base screen and a Numerical Display is placed in front of it.

•When a drawing placed on a base screen or popup screen and a part that has None selected for Image Type 
placed on the top layer overlap, if the value for the part changes or if the picture for the part changes, no part of the 
drawing on the base screen will be missing.
Example: An equilateral hexagon is placed on the base screen and a Numerical Display is placed on the top layer.

•When a drawing and a part that has None selected for Image Type placed on the top layer overlap, if the value for 
the top layer part changes or if the picture for the part changes, no part of the background drawing will be missing.
Example: An equilateral hexagon is placed on the top layer and a Numerical Display is placed in front of it.

Display for Base Screen: 1

Overlapping part for the equilateral hexagon and Numerical Display is the
background for the screen and the equilateral hexagon remains missing.

1234

9999

Changes the value

1234
Equilateral

Hexagon

Numerical Display

Base Screen: 1

Object list

No. Type Layer

1 Equilateral hexagon

2 Numerical Display

Display for Base Screen: 1

1234

9999

Changes the value

1234

The equilateral hexagon remains 

Top Layer

Equilateral
Hexagon

Numerical Display

Base Screen: 1

Object list

No. Type Layer

1 Equilateral hexagon

2 Numerical Display Top Layer

Display for Base Screen: 1

The equilateral hexagon remains 

1234

9999

Changes the value

1234Top Layer
Equilateral

Hexagon

Numerical Display

Base Screen: 1

Object list

No. Type Layer

1 Equilateral hexagon Top Layer

2 Numerical Display Top Layer
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4.3 Restrictions

•To place overlapping drawings and parts on a screen, we recommend they be placed on the top layer. When the 
amount of data for parts placed on the top layer exceeds the upper limit, the display is the same as when they are 
placed on a base screen or popup screen. At this time, the value of HMI Special Internal Relay LSM33 is 1. For 
details, refer to Chapter 33 “HMI Special Relay (LSM)” on page 33-2.

•When the Message Display, Message Switching Display, and Alarm List Display have their Scroll check box selected 
on the Format tab in the Properties dialog box and they are placed on the top layer, the scrolling speed of the text 
will be slower.

•On the Top Layer, magenta (R:255, G:4, B:255) is treated as the transparent color. If you place pictures used this 
color on a Top Layer, those areas are completely transparent.
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This chapter describes the procedures for drawing with shapes and the procedures for configuring pictures and text.

  

1.1 Line

● Line Drawing Procedure
This section describes the procedure for drawing lines.

1 On the Home tab, in the Drawings group, click Shapes, and then click  (Line) under Basic Shapes.

The mouse cursor changes to  (pencil).

2 Click and hold the mouse button at the location (start point) to start drawing the line on the edit screen.

3 Drag the mouse to the stop point location.

A line is drawn that connects the start point and stop point.

Chapter 7 Drawings

1 Shapes

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

Stop 
point

Start 
point

Drag

To change the style of the drawn line, perform one of the following operations.
• Double click the line to open the Properties dialog box
• Select the line and select the style with Shape Style on the Format tab
• Select the line and open the right click menu
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● Properties of Line Dialog Box
This section describes items and buttons in the Properties dialog box.

■ Line Width
Selects the line width for the line from the following.
1 dot, 2 dots, 3 dots, 5 dots
3 dots and 5 dots can only be configured when Solid is selected for Line Type.

■ Line Type
Selects the line type for the line from the following.
Solid, Dot, Dash, Long Dash, Long Dash Dot, Long Dash Dot Dot
Dot, Dash, Long Dash, Long Dash Dot, and Long Dash Dot Dot can only be configured when 1 dot or 2 dots 
is selected for Line Width.

■ Line Color
Selects the line color for the line (color: 256 colors, monochrome: 16 shades).
Click this button to display the Color Palette. Select a color from the Color Palette.

■ Flash
Select this check box to make the line flash.
The flash interval is specified with Flashing Cycle on the System tab in the Project Settings dialog box.

■ Point1, Point2

■ Place on the Top Layer
Select this check box to display the line on the top layer. The line will have precedence when other drawings and parts 
are overlapping with it. For details, refer to Chapter 6 “4 Drawings and Parts Overlapping” on page 6-5.

X, Y: Specifies the start point and stop point of the line in coordinates.
The upper-left corner of the screen is the origin.

X: 0 to (base screen horizontal size - 1)

Y: 0 to (base screen vertical size - 1)

(0, 0)
X

Y

Screen

Line

Stop 
point

Start 
point



WindO/I-NV4 User’s Manual 7-3

1 Shapes

7

D
raw

ings

1.2 Polyline

● Polyline Drawing Procedure
This section describes the procedure for drawing polylines.

1 On the Home tab, in the Drawings group, click Shapes, and then click  (Polyline) under Basic Shapes.

The mouse cursor changes to  (pencil).

2 Click at the location (start point) to start drawing the polyline on the edit screen.

3 Click the end point locations in order.

A line is drawn that connects the start point and the various end point locations in the order that they were created.

4 Double click at the stop point location.

A line is drawn that connects the last end point and the stop point.

Stop 
point

Start 
point

End 
point

End 
point

The maximum number of end points in a polyline, including the start point and the stop point, is 300 
points.

• To change the style of the drawn polyline, perform one of the following operations.
- Double click the polyline to open the Properties dialog box
- Select the polyline and select the style with Shape Style on the Format tab
- Select the polyline and open the right click menu

• To change the start point, end points, or the stop point of the drawn polyline, select the polyline and right 

click on it, then click Reshape.  is displayed on the polyline. Drag  to the desired location. Double 

click the edit screen or press the  key to finish changing the shape.
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● Properties of Polyline Dialog Box
This section describes items and buttons in the Properties dialog box.

■ Line Width
Selects the line width for the polyline from the following.
1 dot, 2 dots, 3 dots, 5 dots
3 dots and 5 dots can only be configured when Solid is selected for Line Type.

■ Line Type
Selects the line type for the polyline from the following.
Solid, Dot, Dash, Long Dash, Long Dash Dot, Long Dash Dot Dot
Dot, Dash, Long Dash, Long Dash Dot, and Long Dash Dot Dot can only be configured when 1 dot or 2 dots 
is selected for Line Width.

■ Line Color
Selects the line color for the polyline (color: 256 colors, monochrome: 16 shades).
Click this button to display the Color Palette. Select a color from the Color Palette.

■ Flash
Select this check box to make the polyline flash.
The flash interval is specified with Flashing Cycle on the System tab in the Project Settings dialog box.

■ Coordinates

■ Size

■ Place on the Top Layer
Select this check box to display the polyline on the top layer. The polyline will have precedence when other drawings 
and parts are overlapping with it. For details, refer to Chapter 6 “4 Drawings and Parts Overlapping” on page 6-5.

X, Y: Specifies the display position of the polyline in coordinates.
With the upper-left corner of the screen as the origin, the upper-left corner of the rectangle that 
circumscribes the polyline is the X and Y coordinates.
X: 0 to (base screen horizontal size - 1)
Y: 0 to (base screen vertical size - 1)

(0, 0)
X

Y

Screen

Polyline

W, H: Specifies the size of the polyline in width and height.
W: 1 to (base screen horizontal size)
H: 1 to (base screen vertical size)

Width

Height

Screen

Polyline
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1.3 Polygon

● Polygon Drawing Procedure
This section describes the procedure for drawing polygons.

1 On the Home tab, in the Drawings group, click Shapes, and then click  (Polygon) under Basic Shapes.

The mouse cursor changes to  (pencil).

2 Click at the location (start point) to start drawing the polygon on the edit screen.

3 Click the end point locations in order.

A line is drawn that connects the start point and the various end point locations in the order that they were created.

4 Double click at the stop point location.

A polygon is drawn with the start point and stop point connected.

End 
point

Start 
point

Stop 
point

End 
point

The maximum number of end points in the polygon, including the start point and the stop point, is 300 
points.

• To change the style of the drawn polygon, perform one of the following operations.
- Double click the polygon to open the Properties dialog box
- Select the polygon and select the style with Shape Style on the Format tab
- Select the polygon and open the right click menu

• To change the start point, end points, or the stop point of the drawn polygon, select the polygon and right 

click on it, then click Reshape.  is displayed on the polygon. Drag  to the desired location. Double 

click the edit screen or press the  key to finish changing the shape.
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● Properties of Polygon Dialog Box
This section describes items and buttons in the Properties dialog box.

■ Line Width
Selects the line width for the polygon from the following.
1 dot, 2 dots, 3 dots, 5 dots
3 dots and 5 dots can only be configured when Solid is selected for Line Type.

■ Line Type
Selects the line type for the polygon from the following.
Solid, Dot, Dash, Long Dash, Long Dash Dot, Long Dash Dot Dot
Dot, Dash, Long Dash, Long Dash Dot, and Long Dash Dot Dot can only be configured when 1 dot or 2 dots 
is selected for Line Width.

■ Foreground Color, Background Color
Selects the foreground color and the background color to use for the polygon (color: 256 colors, monochrome: 16 
shades).
Click either button to display the Color Palette. Select a color from the Color Palette.

■ Pattern
Selects the pattern or tonal gradation for the polygon.
Click this button to display the Pattern Palette. Select a pattern or tonal gradation from the Pattern Palette.

■ Flash
Select this check box to make the polygon flash.
The flash interval is specified with Flashing Cycle on the System tab in the Project Settings dialog box.

■ Coordinates 

X, Y: Specifies the display position of the polygon in coordinates.
With the upper-left corner of the screen as the origin, the upper-left corner of the rectangle that circumscribes 
the polygon is the X and Y coordinates.
X: 0 to (base screen horizontal size - 1)
Y: 0 to (base screen vertical size - 1)

(0, 0)
X

Y
Screen

Polygon
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■ Size

■ Place on the Top Layer
Select this check box to display the polygon on the top layer. The polygon will have precedence when other drawings 
and parts are overlapping with it. For details, refer to Chapter 6 “4 Drawings and Parts Overlapping” on page 6-5.

W, H: Specifies the size of the polygon in width and height.
W: 1 to (base screen horizontal size)
H: 1 to (base screen vertical size)

Width

Height

Screen

Polygon
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1.4 Rectangle

● Rectangle Drawing Procedure
This section describes the procedure for drawing rectangles.

1 On the Home tab, in the Drawings group, click Shapes, and then click  (Rectangle) under Basic Shapes.

The mouse cursor changes to  (pencil).

2 Click and hold the mouse button at the location (start point) to start drawing the rectangle on the edit screen.

3 Drag the mouse to the stop point location so that location becomes the opposite angle of the rectangle.

A rectangle is drawn with the start point and stop point set to opposite angles.

Stop 
point

Drag

Start 
point

To change the style of the drawn rectangle, perform one of the following operations.
• Double click the rectangle to open the Properties dialog box
• Select the rectangle and select the style with Shape Style on the Format tab
• Select the rectangle and open the right click menu
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● Properties of Rectangle Dialog Box
This section describes items and buttons in the Properties dialog box.

■ Line Width
Selects the line width for the rectangle from the following.
1 dot, 3 dots, 5 dots
3 dots and 5 dots can only be configured when Solid is selected for Line Type.

■ Line Type
Selects the line type for the rectangle from the following.
Solid, Dot, Dash, Long Dash, Long Dash Dot, Long Dash Dot Dot
Dot, Dash, Long Dash, Long Dash Dot, and Long Dash Dot Dot can only be configured when 1 dot is selected 
for Line Width.

■ Foreground Color, Background Color
Selects the foreground color and the background color to use for the rectangle (color: 256 colors, monochrome: 16 
shades).
Click either button to display the Color Palette. Select a color from the Color Palette.

■ Pattern
Selects the pattern or tonal gradation for the rectangle.
Click this button to display the Pattern Palette. Select a pattern or tonal gradation from the Pattern Palette.

■ Flash
Select this check box to make the rectangle flash.
The flash interval is specified with Flashing Cycle on the System tab in the Project Settings dialog box.

■ Round Type
Selects the style of the rectangle's corners from the following.
None, Curve, Straight

Curve StraightNone
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■ Round Radius
Specifies the rounding radius (1 to 200). However, the range that can be configured is where round radius x 2 is a 
value smaller than Size W and Size H.
This option can only be configured when Curve or Straight is selected for Round Type.

■ Shadow
Selects the style of shadow attached to the rectangle from the following. This option draws the rectangle in a three-
dimensional manner.
None, Convex, Concave
This option can only be configured when 1 dot is selected for Line Width and Solid is selected for Line Type.

■ Coordinates 

■ Size

■ Place on the Top Layer
Select this check box to display the rectangle on the top layer. The rectangle will have precedence when other 
drawings and parts are overlapping with it. For details, refer to Chapter 6 “4 Drawings and Parts Overlapping” on page 
6-5.

For Curve For Straight

Round Radius Round Radius

Convex ConcaveNone

X, Y: Specifies the display position of the rectangle in coordinates.
With the upper-left corner of the screen as the origin, the upper-left corner of the rectangle is the X 
and Y coordinates.

X: 0 to (base screen horizontal size - 1)

Y: 0 to (base screen vertical size - 1)

(0, 0)
X

Y
Screen

Rectangle

W, H: Specifies the size of the rectangle in width and height.

W: 1 to (base screen horizontal size)

H: 1 to (base screen vertical size)

Width

Height

Screen

Rectangle
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1.5 Circle/Ellipse

● Circle/Ellipse Drawing Procedure
This section describes the procedure for drawing circles and ellipses.

1 On the Home tab, in the Drawings group, click Shapes, and then click  (Circle/Ellipse) under Basic Shapes.

The mouse cursor changes to  (pencil).

2 Click and hold the mouse button at the location (start point) to start drawing the circle or ellipse on the edit screen.

3 Drag the mouse to the stop point location so that location becomes the opposite angle of the rectangle.

A circle or ellipse is drawn that inscribes the rectangle made from the opposite angles of the start point and the stop 
point.

Stop 
point

Drag

Start 
point

To change the style of the drawn circle or ellipse, perform one of the following operations.
• Double click the circle or ellipse to open the Properties dialog box
• Select the circle or ellipse and select the style with Shape Style on the Format tab
• Select the circle or ellipse and open the right click menu
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● Properties of Circle/Ellipse Dialog Box
This section describes items and buttons in the Properties dialog box.

■ Line Width
Selects the line width for the circle or ellipse from the following.
1 dot, 3 dots, 5 dots
3 dots and 5 dots can only be configured when Solid is selected for Line Type.

■ Line Type
Selects the line type for the circle or ellipse from the following.
Solid, Dot, Dash, Long Dash, Long Dash Dot, Long Dash Dot Dot
Dot, Dash, Long Dash, Long Dash Dot, and Long Dash Dot Dot can only be configured when 1 dot is selected 
for Line Width.

■ Foreground Color, Background Color
Selects the foreground color and the background color to use for the circle or ellipse (color: 256 colors, monochrome: 
16 shades).
Click either button to display the Color Palette. Select a color from the Color Palette.

■ Pattern
Selects the pattern or tonal gradation for the circle or ellipse.
Click this button to display the Pattern Palette. Select a pattern or tonal gradation from the Pattern Palette.

■ Flash
Select this check box to make the circle or ellipse flash.
The flash interval is specified with Flashing Cycle on the System tab in the Project Settings dialog box.

■ Shadow
Selects the style of shadow attached to the circle or ellipse from the following. This option draws the circle or ellipse 
in a three-dimensional manner.
None, Convex, Concave
This option can only be configured when 1 dot is selected for Line Width and Solid is selected for Line Type.

Convex ConcaveConvex
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■ Coordinates 

■ Size

■ Place on the Top Layer
Select this check box to display the circle or ellipse on the top layer. The circle or ellipse will have precedence when 
other drawings and parts are overlapping with it. For details, refer to Chapter 6 “4 Drawings and Parts Overlapping” 
on page 6-5.

X, Y: Specifies the display position of the circle or ellipse in coordinates.
With the upper-left corner of the screen as the origin, the upper-left corner of the rectangle that 
circumscribes the circle or ellipse is the X and Y coordinates.

X: 0 to (base screen horizontal size - 1)

Y: 0 to (base screen vertical size - 1)

(0, 0)
X

Y
Screen

Circle/ellipse

W, H: Specifies the size of the circle or ellipse in width and height.

W: 1 to (base screen horizontal size)

H: 1 to (base screen vertical size)

Width

Height

Screen

Circle/ellipse
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1.6 Arc

● Arc Drawing Procedure
This section describes the procedure for drawing arcs.

1 On the Home tab, in the Drawings group, click Shapes, and then click  (Arc) under Basic Shapes.

The mouse cursor changes to  (pencil).

2 Click and hold the mouse button at the location (start point) to start drawing the arc on the edit screen.

3 Drag the mouse to the stop point location so that location becomes the opposite angle of the rectangle.

An arc is drawn that inscribes the rectangle made from the opposite angles of the start point and the stop point.

Stop 
point

Drag

Start 
point

• To change the style of the drawn arc, perform one of the following operations.
- Double click the arc to open the Properties dialog box
- Select the arc and select the style with Shape Style on the Format tab
- Select the arc and open the right click menu

• To change the start point or the stop point of the drawn arc, select the arc and right click on it, then click 

Reshape.  is displayed on the arc. Drag  to the desired location. Double click the edit screen or press 

the  key to finish changing the shape.
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● Properties of Arc Dialog Box
This section describes items and buttons in the Properties dialog box.

■ Line Width
Selects the line width for the arc from the following.
1 dot, 3 dots, 5 dots
3 dots and 5 dots can only be configured when Solid is selected for Line Type.

■ Line Type
Selects the line type for the arc from the following.
Solid, Dot, Dash, Long Dash, Long Dash Dot, Long Dash Dot Dot
Dot, Dash, Long Dash, Long Dash Dot, and Long Dash Dot Dot can only be configured when 1 dot is selected 
for Line Width.

■ Line Color
Selects the line color for the arc (color: 256 colors, monochrome: 16 shades).
Click this button to display the Color Palette. Select a color from the Color Palette.

■ Flash
Select this check box to make the arc flash.
The flash interval is specified with Flashing Cycle on the System tab in the Project Settings dialog box.

■ Coordinates 

■ Size

■ Place on the Top Layer
Select this check box to display the arc on the top layer. The arc will have precedence when other drawings and parts 
are overlapping with it. For details, refer to Chapter 6 “4 Drawings and Parts Overlapping” on page 6-5.

X, Y: Specifies the display position of the arc in coordinates.
With the upper-left corner of the screen as the origin, the upper-left corner of the rectangle that 
circumscribes the arc is the X and Y coordinates.
X: 0 to (base screen horizontal size - 1)
Y: 0 to (base screen vertical size - 1)

(0, 0)
X

Y
Screen
Arc

W, H: Specifies the size of the arc in width and height.
W: 1 to (base screen horizontal size)
H: 1 to (base screen vertical size)

Width

Height

Screen
Arc
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1.7 Pie

● Pie Drawing Procedure
This section describes the procedure for drawing pies.

1 On the Home tab, in the Drawings group, click Shapes, and then click  (Pie) under Basic Shapes.

The mouse cursor changes to  (pencil).

2 Click and hold the mouse button at the location (start point) to start drawing the pie on the edit screen.

3 Drag the mouse to the stop point location so that location becomes the opposite angle of the rectangle.

A pie is drawn that inscribes the rectangle made from the opposite angles of the start point and the stop point.

Stop 
point

Drag

Start 
point

• To change the style of the drawn pie, perform one of the following operations.
- Double click the pie to open the Properties dialog box
- Select the pie and select the style with Shape Style on the Format tab
- Select the pie and open the right click menu

• To change the central angle of the drawn pie, select the pie and right click on it, then click Reshape.  

is displayed on the pie. Drag  to the desired location. Double click the edit screen or press the  
key to finish changing the shape.
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● Properties of Pie Dialog Box
This section describes items and buttons in the Properties dialog box.

■ Line Width
Selects the line width for the pie from the following.
1 dot, 3 dots, 5 dots
3 dots and 5 dots can only be configured when Solid is selected for Line Type.

■ Line Type
Selects the line type for the pie from the following.
Solid, Dot, Dash, Long Dash, Long Dash Dot, Long Dash Dot Dot
Dot, Dash, Long Dash, Long Dash Dot, and Long Dash Dot Dot can only be configured when 1 dot is selected 
for Line Width.

■ Foreground Color, Background Color
Selects the foreground color and the background color to use for the pie (color: 256 colors, monochrome: 16 shades).
Click either button to display the Color Palette. Select a color from the Color Palette.

■ Pattern
Selects the pattern or tonal gradation for the pie.
Click this button to display the Pattern Palette. Select a pattern or tonal gradation from the Pattern Palette.

■ Flash
Select this check box to make the pie flash.
The flash interval is specified with Flashing Cycle on the System tab in the Project Settings dialog box.

■ Coordinates 

X, Y: Specifies the display position of the pie in coordinates.
With the upper-left corner of the screen as the origin, the upper-left corner of the rectangle that 
circumscribes the circle with the same center as the pie is the X and Y coordinates.

X: 0 to (base screen horizontal size - 1)

Y: 0 to (base screen vertical size - 1)

(0, 0)
X

Y
Screen
Pie
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■ Size

■ Place on the Top Layer
Select this check box to display the pie on the top layer. The pie will have precedence when other drawings and parts 
are overlapping with it. For details, refer to Chapter 6 “4 Drawings and Parts Overlapping” on page 6-5.

W, H: Specifies the size of the pie in width and height.

W: 1 to (base screen horizontal size)

H: 1 to (base screen vertical size)

Width

Height

Screen
Pie
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1.8 Equilateral Polygons

● Equilateral Polygons Drawing Procedure
This section describes the procedure to draw equilateral polygons (equilateral triangle, equilateral diamond, 
equilateral pentagon, equilateral hexagon, equilateral octagon).

1 On the Home tab, in the Drawings group, click Shapes, and then click  (Equilateral Triangle),  (Equilateral 
Diamond),  (Equilateral Pentagon),  (Equilateral Hexagon), or  (Equilateral Octagon) under Equilateral 
Polygons.

The mouse cursor changes to  (pencil).

2 Click and hold the mouse button at the location (start point) on the edit screen to start drawing the square that will 
circumscribe the equilateral polygon.

3 Drag the mouse to the stop point location so that location becomes the opposite angle of the square.

An equilateral polygon is drawn that inscribes the square made from the opposite angles of the start point and the 
stop point.

Stop 
point

Drag

Start 
point

To change the style of the drawn square, perform one of the following operations.
• Double click the square to open the Properties dialog box
• Select the square and select the style with Shape Style on the Format tab
• Select the square and open the right click menu
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● Properties of Equilateral Polygon Dialog Box
This section describes items and buttons in the Properties dialog box.

■ Line Width
Selects the line width for the equilateral polygon from the following.
1 dot, 2 dots, 3 dots, 5 dots
3 dots and 5 dots can only be configured when Solid is selected for Line Type.

■ Line Type
Selects the line type for the equilateral polygon from the following.
Solid, Dot, Dash, Long Dash, Long Dash Dot, Long Dash Dot Dot
Dot, Dash, Long Dash, Long Dash Dot, and Long Dash Dot Dot can only be configured when 1 dot or 2 dots 
is selected for Line Width.

■ Foreground Color, Background Color
Selects the foreground color and the background color to use for the equilateral polygon (color: 256 colors, 
monochrome: 16 shades).
Click either button to display the Color Palette. Select a color from the Color Palette.

■ Pattern
Selects the pattern or tonal gradation for the equilateral polygon.
Click this button to display the Pattern Palette. Select a pattern or tonal gradation from the Pattern Palette.

■ Flash
Select this check box to make the equilateral polygon flash.
The flash interval is specified with Flashing Cycle on the System tab in the Project Settings dialog box.

■ Coordinates 

X, Y: Specifies the display position of the equilateral polygon in coordinates.
With the upper-left corner of the screen as the origin, the upper-left corner of the square that 
circumscribes the equilateral polygon is the X and Y coordinates.

X: 0 to (base screen horizontal size - 1)

Y: 0 to (base screen vertical size - 1)

(0, 0)
X

Y
Screen

Equilateral polygon
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■ Size

■ Place on the Top Layer
Select this check box to display the equilateral polygon on the top layer. The equilateral polygon will have precedence 
when other drawings and parts are overlapping with it. For details, refer to Chapter 6 “4 Drawings and Parts 
Overlapping” on page 6-5.

W: Sets width to define the size of the equilateral polygon. The maxium size varies based on the item 
selected for Installation.

Horizontal: 1 to (base screen vertical size)

Vertical: 1 to (base screen horizontal size)

H: Displays the same as the width.

Width

Height

Screen

Equilateral polygon
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1.9 Fill

● Fill Configuration Procedure
This section describes the fill configuration procedure.

1 On the Home tab, in the Drawings group, click Shapes, and then click  (Fill) under Fill.

The mouse cursor changes to  (pencil).

2 Click on a section where multiple shapes overlap on the edit screen.

The section where multiple shapes overlap is filled with the Foreground Color, Background Color, and Pattern of 
the shape last drawn or the shape that last had its style changed. The clicked location is the fill start point.

Fill start point

• To change the fill style, perform one of the following operations.
- Double click the fill start point to open the Properties dialog box
- Select the fill start point and select the style with Shape Style on the Format tab
- Select the fill start point and open the right click menu

• If you move the fill start point, the closed region where it was moved to is filled.

• To select the fill start point, click  on the edit screen or select Fill on the Object List window.
Fill start point Fill start point
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● Properties of Fill Dialog Box
This section describes items and buttons in the Properties dialog box.

■ Foreground Color, Background Color
Selects the foreground color and the background color to fill with (color: 256 colors, monochrome: 16 shades).
Click either button to display the Color Palette. Select a color from the Color Palette.

■ Pattern
Selects the pattern to fill with.
Click this button to display the Pattern Palette. Select a pattern from the Pattern Palette.

■ Fill Start Point

X, Y: Specifies the display position of the fill start point in coordinates.
The upper-left corner of the screen is the origin.

X: 0 to (base screen horizontal size - 1)

Y: 0 to (base screen vertical size - 1)

(0, 0)
X

Y

Screen

Fill start point

The fill range is not affected by drawing objects placed on the top layer.
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2.1 Picture Configuration Procedure

This section describes the picture configuration procedure.

1 On the Home tab, in the Drawings group, click Picture.

The mouse cursor changes to  (picture).

2 Click the location on the edit screen to place the picture.

Picture Manager is displayed.

3 Select a picture and click Select.

The selected picture is placed on the screen.

2 Picture

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

To change the picture that was placed on the screen, perform one of the following operations.
• Double click the picture to open the Properties dialog box, then click Browse
• Replace the picture in Picture Manager



WindO/I-NV4 User’s Manual 7-25

2 Picture

7

D
raw

ings

2.2 Properties of Picture Dialog Box

This section describes items and buttons in the Properties dialog box.

■ Browse
Changes the picture placed on the screen. Click this button to display Picture Manager.

■ Flash
Select this check box to make the picture flash.
The flash interval is specified with Flashing Cycle on the System tab in the Project Settings dialog box.

■ Coordinates 

■ Size

■ Place on the Top Layer
Select this check box to display the picture on the top layer. The picture will have precedence when other drawings 
and parts are overlapping with it. For details, refer to Chapter 6 “4 Drawings and Parts Overlapping” on page 6-5.

X, Y: Specifies the display position of the picture in coordinates.
With the upper-left corner of the screen as the origin, the upper-left corner of the rectangle that 
circumscribes the picture is the X and Y coordinates.

X: 0 to (base screen horizontal size - 1)

Y: 0 to (base screen vertical size - 1)

(0, 0)
X

Y
Screen

Picture

W, H: Specifies the size of the picture in width and height.

W: 1 to (base screen horizontal size)

H: 1 to (base screen vertical size)

Width

Height

Screen

Picture



3 Text

7-26 WindO/I-NV4 User’s Manual

  

3.1 Text Configuration Procedure

This section describes the configuration procedure for text.

1 On the Home tab, in the Drawings group, click Text.

The mouse cursor changes to  (text).

2 Click the location on the edit screen to place the text.

The Properties of Text dialog box is displayed.

3 Enter the text to display in Text and configure the options as necessary.

The maximum number is 3737 characters.

4 Click OK.

The text is placed on the screen.

3 Text

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

To change the style of the text placed on the screen, perform one of the following operations. You can 
change the entered text in the Properties dialog box.
• Double click the text to open the Properties dialog box
• Select the text and select the style with Text Style on the Format tab
• Select the text and open the right click menu
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3.2 Properties of Text Dialog Box

This section describes items and buttons in the Properties dialog box.

■ Font
Selects the font to use to display text from the following.
Japanese, European, Chinese, Taiwanese, Korean, Central European, Baltic, Cyrillic, Windows, Stroke
This option can only be configured if the Use Text Manager check box is cleared.

■ Style
Selects the style of text from the following.
Regular, Bold, Shadow
This option can only be configured when Japanese, European, Chinese, Taiwanese, Korean, Central 
European, Baltic, or Cyrillic is selected for Font.

■ Align Text Horizontal
Selects text alignment in the horizontal direction.
Left, Center, Right, Center-Left
For details, refer to Appendix “5 Text Alignment” on page A-7.

■ Align Text Vertical
Selects text alignment in the vertical direction.
Top, Center, Bottom
Top when the Vertical Writing check box is selected.
For details, refer to Appendix “5 Text Alignment” on page A-7.
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■ Vertical Writing
Select this check box to display text vertically.
This option can only be configured when Japanese, European, Chinese, Taiwanese, Korean, Central 
European, Baltic, Cyrillic or Windows is selected for Font.

■ Windows Font
Configures the font to use as the Windows Font.
Select Windows for Font to display the current settings. You can specify the character spacing (0 to 100) and the 
line spacing (0 to 100). To change the settings other than the character spacing and line spacing, click Change to 
display the Font Settings dialog box.
This option can only be configured if the Use Text Manager check box is cleared.
For details, refer to Chapter 2 “Windows Font” on page 2-13.

■ Use Text Manager
Select this check box to use text registered in Text Manager.

■ Text ID
Specifies the Text Manager ID number (1 to 32000) when using text registered in Text Manager.

Click  to display Text Manager.
This option can only be configured when the Use Text Manager check box is selected.

■ Text
Enter the text to display. The maximum number is 3737 characters.
The characters that can be entered vary based on the font selected by Font. For details, refer to Chapter 2 “1.2 
Available Text” on page 2-6.
This option can only be configured if the Use Text Manager check box is cleared.

■ Text Color
Selects the color for the displayed text (color: 256 colors, monochrome: 16 shades).
Click this button to display the Color Palette. Select a color from the Color Palette.

■ Magnification

This option can only be configured when Japanese, European, Chinese, Taiwanese, Korean, Central 
European, Baltic, or Cyrillic is selected for Font.

■ Size
Specifies the character size (8 to 128).
This option can only be configured when Stroke is selected for Font.

■ Background Color
Selects the background color for the text (color: 256 colors, monochrome: 16 shades).
Click this button to display the Color Palette. Select a color from the Color Palette.

When the Vertical Writing check box is selected, take care about the following points. This is applicable 
for installations of Windows that support East Asian characters.
• When there is a mixture of double-byte and single-byte characters, the half-width characters are left-

aligned.

• Dashes are displayed horizontally. Symbols representing voiced and semi-voiced sounds of single-byte 
characters are shown as follows.

Aligned to 
le� edge

Horizontal
display

Next
characters

A newline is counted as two characters.

W, H: Selects the zoom factor for characters (0.5, 1 to 8).
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■ Animation
Selects whether or not to make the text flash.

■ Shadow Color
Selects the shadow color for the text (color: 256 colors, monochrome: 16 shades).
Click this button to display the Color Palette. Select a color from the Color Palette.
This option can only be configured when Shadow is selected for Style.

■ Coordinates 

■ Use Text Area
Select this check box to specify a text area and adjust the display position of the text with the specified text area.

■ Place on the Top Layer
Select this check box to display the text on the top layer. The text will have precedence when other drawings and 
parts are overlapping with it. For details, refer to Chapter 6 “4 Drawings and Parts Overlapping” on page 6-5.

Normal: The text does not flash.

Flash: The text flashes.

X, Y: Specifies the display position of the text or the text area in coordinates.
With the upper-left corner of the screen as the origin, the upper-left corner of the rectangle that 
circumscribes the text or the upper-left corner of the text area is the X and Y coordinates.
When the Use Text Area check box is cleared, the coordinates are for the text. When the Use Text 
Area check box is selected, the coordinates are for the text area.

X: 0 to (base screen horizontal size - 1)

Y: 0 to (base screen vertical size - 1)

IDEC IDEC

(0, 0)
X

Y

(0, 0)
X

Y

Screen

Text

Screen

Text area

When Use Text Area is cleared When Use Text Area is selected

W, H: Specifies the size of the text area in width and height.

W: 5 to (base screen horizontal size)

H: 5 to (base screen vertical size)

IDEC

Width

Height

Screen

Text area
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8

Buttons

This chapter describes the setup for the button parts and related MICRO/I operations.

  

1.1 How the Bit Button is Used

Writes a 0 or 1 to a bit device.

■ Set

■ Reset

Chapter 8 Buttons

1 Bit Button

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

MICRO/I

0

1

External device

Pressing the button writes a 1 to the 
bit device. Release

Initial image

Press ReleasePress

1

Operation and 
view

Data written 1

WriteAction Write

Pressing the button writes a 0 to the 
bit device. Release

Initial image

Press ReleasePress

0

Operation and 
view

Data written 0

WriteAction Write
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■ Momentary

■ Alternate

■ Toggle

■ Move

Pressing the button writes a 1 to the 
bit device.
Releasing the button writes a 0 to the 
bit device.

Release

Initial image

Press ReleasePress

1

Operation and 
view

Data written 10 0

WriteAction WriteWrite Write

Pressing and holding the button until the screen changes causes a 0 to be written to the bit device.

Each press of the button alternately 
writes a 1 or 0 to the bit device. Release

Initial image

Press ReleasePress

1

Operation and 
view

Data written 0

WriteAction Write

Pressing the button inverts the value 
of the bit device.
If the value of the bit device is 0 it 
changes to 1, and vice versa.

Release

Initial image

Press ReleasePress

Operation and 
view

ToggleAction Toggle

Pressing the button writes the value 
in the source bit device to the value in 
the destination bit device.

Release

Initial image

Press ReleasePress

Move

Operation and 
view

Action Move



WindO/I-NV4 User’s Manual 8-3

1 Bit Button

8

Buttons

1.2 Bit Button Configuration Procedure

This section describes the configuration procedure for Bit Buttons.

1 On the Home tab, in the Parts group, click Buttons, and then click Bit Button.

2 Click a point on the edit screen where you wish to place the Bit Button.

3 Double-click the dropped Bit Button and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.

The Trigger Condition tab and Options tab only appear in Advanced mode.
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1.3 Properties of Bit Button Dialog Box

This section describes items and buttons in the Properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ >>OFF Text, >>ON Text
Applies the text entered in the Part Name field to the Text field under the OFF or ON fields on the Registration 
Text tab. This is used as the Registration Text when the button is OFF or ON.

■ Action Mode
Select the behavior of the button from the following:

To specify the Registration Text to use when the button is ON, select the Set by State check box on the 
Registration Text tab. If left unchecked, the same Registration Text assigned for the OFF state is 
displayed for the ON state as well.

Set: Pressing the button writes a 1 to the bit device.

Reset: Pressing the button writes a 0 to the bit device.

Release

Initial image

Press ReleasePress

1

Operation and 
view

Data written 1

WriteAction Write

Release

Initial image

Press ReleasePress

0

Operation and 
view

Data written 0

WriteAction Write
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■ Destination Device Address
Specify the destination bit device.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.

Momentary: Pressing the button writes a 1 to the bit device.
Releasing the button writes a 0 to the bit device.

Release

Initial image

Press ReleasePress

1

Operation and 
view

Data written 10 0

WriteAction WriteWrite Write

Pressing and holding the button until the screen changes causes a 0 to be written to the bit device.

Alternate: Each press of the button alternately writes a 1 or 0 to the bit device.

Toggle: Pressing the button inverts the value of the bit device.
If the value of the bit device is 0 it changes to 1, and vice versa.

Move: Pressing the button writes the value in the source bit device to the value in the destination bit device.

Release

Initial image

Press ReleasePress

1

Operation and 
view

Data written 0

WriteAction Write

Release

Initial image

Press ReleasePress

Operation and 
view

ToggleAction Toggle

Release

Initial image

Press ReleasePress

Move

Operation and 
view

Action Move
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■ Write*1

Specify the number of bit devices (1 to 64) at the destination.
This setting is enabled only if Action Mode is set to Set or Reset.

Example: This fills a contiguous block of bit devices with the same value.

If the bit number in a word device is specified, the same value is written to same bit number of contiguous 
word devices.

■ Source Data
Specifies the device address that stores the data to be written.
This setting is enabled only if Action Mode is set to Move.

Example: This button writes the values in a contiguous block of bit devices to a contiguous block of device addresses 
at the destination.

*1 Advanced mode only

1M0

1M1

1M2

1M3

1M4

Action Mode: Set

Write: 5
Destination Device Address: M0

bit bit
15 0

1D0

D1

D2

D3

D4

1

1

1

1

Action Mode: Set

Write: 5
Destination Device Address: D0-15

Device Address: Specify the source bit device.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 
“5.1 Device Address Settings” on page 2-68.

Transfer: Specify the number of bit devices (1 to 64) to transfer.

Device Address: LM0

Transfer: 4

1LM0

0LM1

0LM2

1LM3

Destination Device Address: M0

1M0

0M1

0M2

1M3
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■ View Switching Method*1

Select how to display the ON/OFF status of the button.

*1 Advanced mode only

Button: Pressing the button changes the drawing object displayed.

Device Address: The drawing objects assigned to the OFF and ON states are displayed when the value of the device 
address is 0 and 1, respectively. Specifies the device address used to switch the drawing object 
display.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 
“5.1 Device Address Settings” on page 2-68.

No Image: The button is not displayed on the screen. The button appears as a dashed line frame on the edit 
screen. Pressing the corresponding area on the MICRO/I activates the assigned function. If No 
Image is selected, the settings for View and Registration Text are disabled.

Selecting Device Address in View Switching Method allows you to create an illuminated pushbutton.
The illuminated pushbutton switches state (or image) according to ON or OFF state of the device address, 
allowing you to display the state of a device that is being operated.

Example: When you set an external device address 'M0' as Device Address in View Switching Method, 
if the value of M0 changes, the display image will switch according to the value of M0 even if the 
button is not pressed.

0

M0

1

M0

MICRO/I External device

View Switching Method (Device Address): M0 

OFF image:

ON image:



1 Bit Button

8-8 WindO/I-NV4 User’s Manual

● View Tab
Only Coordinates and Size can be configured when No Image is selected for View Switching Method on the 
General tab.

■ Image Type
Select the type of graphic to be used to represent the part.

■ Browse
Select the type of graphic to be used to represent the part from the list of graphics. Click this button to display the 
View Browser or Picture Manager, depending on the setting for Image Type.

■ OFF button, ON button
Displays the graphic when ON or OFF. Clicking ON or OFF switches the image displayed on the View tab.

■ OFF, ON
Selects the color and pattern of the standard graphic when ON and OFF.

Standard: Uses the default graphics contained within WindO/I-NV4.

Picture: Uses an image file saved in the Picture Manager.
For details about image file restrictions, refer to Chapter 2 “1.4 Available Image Files” on page 2-20.

Foreground Color, Background Color: Selects the foreground and background colors of the standard graphic (color: 
256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

Pattern: Selects a pattern or tonal gradation for the standard graphic.
Click Pattern to display the Pattern Palette. Select a pattern or tonal gradation from the Pattern Palette.



WindO/I-NV4 User’s Manual 8-9

1 Bit Button

8

Buttons

■ Flash
Select this check box if flashing is desired (alternating ON and OFF) when a part is ON.

■ Coordinates

■ Size

Flash

ON image

OFF image

X, Y: Sets the display position of parts using coordinates.
The X and Y coordinates of parts are defined relative to an origin at the top-left corner of the screen.

X: 0 to (base screen horizontal size - 1)

Y: 0 to (base screen vertical size - 1)

(0, 0)
X

Y
Screen

Parts

W, H: Sets width and height to define the size of parts.

W: 20 to (base screen horizontal size)

H: 20 to (base screen vertical size)

Width

Height

Screen

Parts
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● Registration Text Tab
These options can only be configured when Button or Device Address is selected for View Switching Method on 
the General tab.

■ Font
Selects the font used for displaying text from the following.
Japanese, European, Chinese, Taiwanese, Korean, Central European, Baltic, Cyrillic, Windows, Stroke
Can only be set when the Use Text Manager check box is cleared.
The characters that can be displayed depend on the font. For details, refer to Chapter 2 “1.2 Available Text” on page 2-6.

■ Size
Sets the character size (8 to 128).
Can only be set when Stroke is selected.

■ Style
Selects Regular or Bold for text style.
Can only be set when Font is set to Japanese, European, Chinese, Taiwanese, Korean, Central European, 
Baltic or Cyrillic.

■ Magnification

Can only be set when Font is set to Japanese, European, Chinese, Taiwanese, Korean, Central European, 
Baltic or Cyrillic.

■ Align Text Horizontal
Selects text alignment in the horizontal direction.
Left, Center, Right, Center-Left
For details, refer to Appendix “5 Text Alignment” on page A-7.

■ Align Text Vertical
Selects text alignment in the vertical direction.
Top, Center, Bottom
This option can only be configured when Left, Center, or Right is selected for Align Text Horizontal. If Center-
Left is selected for Align Text Horizontal, Center-Top is set as this option.
For details, refer to Appendix “5 Text Alignment” on page A-7.

■ Set by State
Select this check box if displaying different text when ON and OFF.

■ Use Text Manager
Select this check box if using the text registered in Text Manager for text display.

W, H: Selects the magnification (0.5, 1 to 8) for text display.
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■ OFF, ON

Text: Inputs characters to be displayed on parts. The maximum number is 3,750 characters.
The characters that can be entered depend on the font selected using Font. For details, refer to 
Chapter 2 “1.2 Available Text” on page 2-6.

Text ID: Specifies the Text Manager ID No. (1 to 32000) when using the text registered in the Text Manager.

Click  to display Text Manager.

Can only be set when the Use Text Manager check box is selected.

Text Color: Selects the color of the text displayed on the part (color: 256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

Windows Font: Sets the font to be used as the Windows Font.
Select Windows using Font to display the current setting. You can specify the character spacing (0 
to 100) and the line spacing (0 to 100). To change the settings other than the character spacing and 
line spacing, click Change to display the Font Settings dialog box.
Can only be set when the Use Text Manager check box is cleared.
For details, refer to Chapter 2 “Windows Font” on page 2-13.
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● Trigger Condition Tab
The Trigger Condition tab is displayed in Advanced mode.

■ Input Condition
The Button is enabled and operational while the condition is satisfied. The Button is disabled and not operational 
while the condition is not satisfied.
Example: When Trigger Type is While ON and Device Address is LM0

While LM0 is 0, the condition is not satisfied and the Button is not operational.
While LM0 is 1, the condition is satisfied and the Button is operational.

Trigger Type: Selects the condition to enable the Button from the following.

Always enable: The Button is always enabled.

While ON: Enables the Button when the value of device address is 1.

LM0:

MICRO/I

0

LM0: 1

Button
Does not
operate

Button
Operates

Condition 
Not 

satisfied

Condition 
Satisfied

Always enabled

Button state

1

0

Disabled Enabled Disabled DisabledEnabled Enabled

Value of
device address

Button state
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■ Visible Condition
The Button is displayed while the condition is satisfied. The Button is hidden while the condition is not satisfied.
Example: When Trigger Type is While ON and Device Address is LM0

While LM0 is 0, the condition is not satisfied and the Button is hidden.
While LM0 is 1, the condition is satisfied and the Button is displayed.

While OFF: Enables the Button when the value of device address is 0.

While satisfying the condition:

Enables the Button when the condition is satisfied.

Data Type: Selects the type of data handled by the conditional expression for the input condition.
This option can only be configured if While satisfying the condition is selected for Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Device Address: Specifies the bit device or the bit number of the word device to serve as the input condition.
This option can only be configured when While ON or While OFF is selected for Trigger Type.
Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 
“5.1 Device Address Settings” on page 2-68.

Condition: Specifies the conditional expression for the input condition.
This option can only be configured when While satisfying the condition is selected for Trigger 
Type.
Click  to display the Trigger Condition Settings dialog box. For the conditional expression 
configuration procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-71.

Comment: Used for entering a comment for the input condition. The maximum number is 80 characters.

1

0

Enabled Enabled EnabledDisabled Disabled Disabled

Value of
device address

Button state

Satisfied

Not satisfied

Disabled Disabled DisabledEnabled Enabled Enabled

Condition

Button 
state

LM0:

MICRO/I

0

LM0: 1
Show

Condition 
Not 

satisfied

Condition 
Satisfied

Hide

• When Alternate is selected for Action Mode on the General tab, the button remains on when hidden 
in the on state.

• When the ON delay check box is selected on the Options tab, if the button is hidden before the set time 
elapses from when the button begins to be pressed, the on delay is reset and the button does not 
operate.
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Trigger Type: Selects the condition to display the Button from the following.

Always visible: The Button is always displayed.

While ON: Displays the Button when the value of device address is 1.

While OFF: Displays the Button when the value of device address is 0.

While satisfying the condition: Displays the Button when the condition is satisfied.

Data Type: Selects the type of data handled by the conditional expression for the visible condition.
This option can only be configured if While satisfying the condition is selected for Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Device Address: Specifies the bit device or the bit number of the word device to serve as the visible condition.
This option can only be configured when While ON or While OFF is selected for Trigger Type.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 
“5.1 Device Address Settings” on page 2-68.

Condition: Specifies the conditional expression for the visible condition.
This option can only be configured when While satisfying the condition is selected for Trigger 
Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expression 
configuration procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-71.

Comment: Used for entering a comment for the visible condition. The maximum number is 80 characters.

Always show

Button state

1

0

Hide Show Hide HideShow Show

Value of
device address

Button state

1

0

Value of
device address

Show Show ShowHide Hide Hide

Button state

Hide Hide HideShow Show Show

Satisfied

Not satisfied

Condition

Button state
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● Options Tab
The Options tab is displayed in Advanced mode.

■ ON delay
Select this check box to use the ON delay function.

■ No Touch Sound
This function is to disable touch sounds only for specified parts when the MICRO/I makes touch sounds.
Select this check box to display disable touch sounds for this part.

■ Place on the Top Layer
Select this check box to display the parts on the top layer. The parts will have precedence when other drawings and 
parts are overlapping with it. For details, refer to Chapter 6 “4 Drawings and Parts Overlapping” on page 6-5.

Time (x100 msec): Specify the length of time that the button must be held down before activation by selecting a 
value from 0 to 600 (units of 10 ms).
The button activates after it is held down for a specified period of time.

Hold down for 3 secs.

MICRO/I MICRO/I

Button
Does not
operate

Button
Operates

This feature protects against mistaken operation by ensuring that the button will not be activated if touched 
accidentally.

To enable touch sounds on the MICRO/I, select the Enable Touch Sound check box under the System 
tab of the Project Settings dialog box.



1 Bit Button

8-16 WindO/I-NV4 User’s Manual

● Security Tab
This tab is used to restrict displaying and using the part by security groups.
This option can only be set when Use Security functions is selected. The Use Security functions check box is set 
on General tab in the Security dialog box.

■ (Settings)
Displays the list of security groups used on the MICRO/I.

■ Security Settings
The Security Settings dialog box is displayed. If you create a security group in the Security Settings dialog box, you 
can select that created group. For details, refer to Chapter 23 “2.2 Adding and Editing Security Groups” on page 23-
19.

(Settings)

No.: Displays the security group numbers (0 to 15).

Group Name: Displays the name of the security group.

Display: Displays whether or not there is permission to display the part. Only Permitted security groups 
can display this part. If all security groups are set to Permitted, this part will be displayed even 
if no user account has been selected. Double clicking the cell switches between Permitted and 
Prohibited.

Input: Displays whether or not there is permission to use the part. Only Permitted security groups 
can use this part. If all security groups are set to Permitted, this part can be used even if no 
user account has been selected. Double clicking the cell switches between Permitted and 
Prohibited.

• You can also switch between Permitted and Prohibited by right-clicking on a Display or Input cell.
• Restricting the display and use of the part by switching between Permitted and Prohibited in Display 

and Input cells is similar to using the Trigger Condition tab.

For details about security functions, refer to Chapter 23 “User Accounts and the Security Function” on page 
23-1.
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Example: If the user and security group for a part are set as follows:

For User1 in the Reader security group, the parts for which Display has been set to Prohibited for Reader will not 
be displayed.
If the password screen is opened and the user switches to User2 in the Operator security group, the parts for which 
Display has been set to Permitted for Operator will be displayed.

For User2 in Operator, Display has been set to Permitted for Operator, but Input is Prohibited, so the part 
cannot be used.
If the password screen is opened and the user switches to User3 in the Administrator security group, the parts for 
which Display has been set to Permitted for Administrator will be displayed, and the parts for which Input has 
been set to Permitted for Administrator can be used.

User Name

Security Group Reader Operator Administrator
User1 User2 User3

MICRO/I

130

Numerical Display
No. Group Name Display

1 Administrator Permitted

2 Operator Permitted

3 Reader Permitted

Button
No. Group Name Display Input

1 Administrator Permitted Permitted

2 Operator Permitted Prohibited

3 Reader Prohibited Prohibited

Line Chart and Bar Chart
No. Group Name Display

1 Administrator Permitted

2 Operator Permitted

3 Reader Prohibited

Open Password Screen, 
enter password, 
and switch to User2

For User1, 
parts for which Display 
has been set to Prohibited 
for Reader are not displayed

For User2, 
parts for which Display 
has been set to Permitted 
for Operator are displayed

MICRO/I

130

MICRO/I MICRO/I

130

User1 User2

130
CAN

User Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password

Open Password Screen, 
enter password, 
and switch to User3

For User2, 
parts for which Display 
has been set to Permitted 
for Operator are displayed, 
but parts for which Input 
has been set to Prohibited cannot be used

For User3, 
parts for which Display 
has been set to Permitted 
for Administrator are displayed, 
and parts for which Input 
has been set to Permitted can be used

MICRO/I

130

MICRO/I MICRO/I

130130 130

User2 User3

Button
Can operate

CAN

User Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password

Button
Cannot operate
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● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Used for entering comments about parts. The maximum number is 80 characters.
Example: When mousing over the Button on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.
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2.1 How the Word Button is Used

Writes a value to a word device. Can be used to indirectly specify the destination address or to perform operations on 
the written value.

• Pressing the button writes a fixed value to a word device.

• Pressing the button writes the value of device address to a word device.

• Pressing the button performs arithmetic on the value to write before writing it to a word device.

2 Word Button

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

MICRO/I External device

D1= 0

100

D1= 100

Write

Destination word device

100

Value

100→D1

MICRO/I External device
D0= 123

D1= 0

D0= 123

D1= 123

Move

Value in device address

Destination word device

D0→D1

MICRO/I External device
D0= 100

D1= 23

D2= 0

D0= 100

D1= 23

D2= 123

Add

Write

Value to write

Operator value

Destination word device

D0+D1→D2
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■ Set

■ Move

■ Momentary

■ Alternate

Pressing the button writes a fixed 
value to a word device. Release

Initial image

Press ReleasePress

Write

Value

Operation and 
view

Action

Data written

Write

Value

Pressing the button writes the value of 
source device address to the 
destination word device.

ReleasePress ReleasePress

Initial image

Write

Value in
device address

Operation and 
view

Action

Data written

Write

Value in
device address

Pressing the button writes the fixed 
value of ON Data to a word device.
Releasing the button writes the fixed 
value of OFF Data to a word device.

ReleasePress ReleasePress

Initial image

Write

ON data

Operation and 
view

Action

Data written

Write

ON data

Write

OFF data

Write

OFF data

Pressing and holding the button until the screen changes causes the OFF data to be written to the word 
device.

Each press of the button alternately 
writes the fixed value of ON data and 
OFF data to the word device.

ReleasePress ReleasePress

Initial image

Write

ON data

Operation and 
view

Action

Data written

Write

OFF data
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■ Add, Sub, Multi, Div, Mod, OR, AND, XOR
Pressing the button performs 
arithmetic on the value of source 
device address and a fixed value, or a 
value of device address and writes the 
result to a word device.

Example: Add (Addition)
Pressing the button adds the 
value in the Source 1 to the 
Source 2 value and writes 
the sum in the word device.

Release

Initial image

Press ReleasePress

Arithmetic 
operation

↓

Write

Operation and
 view

Action

Data written Result

Arithmetic 
operation

↓

Write

Result

Release

Initial image

Press ReleasePress

Addition

↓

Write

Operation and 
view

Action

Value in reference 
device address

100 200 300 400 500

Data

Value in destination 
device address

240 420

50 40 30 20 10

Addition

↓

Write

0 240 420
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2.2 Word Button Configuration Procedure

This section describes the configuration procedure for Word Buttons.

1 On the Home tab, in the Parts group, click Buttons, and then click Word Button.

2 Click a point on the edit screen where you wish to place the Word Button.

3 Double-click the dropped Word Button and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.

The Trigger Condition tab and Options tab only appear in Advanced mode.
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2.3 Properties of Word Button Dialog Box

This section describes items and buttons in the Properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ >>OFF Text, >>ON Text
Applies the text entered in the Part Name field to the Text field under the OFF or ON fields on the Registration 
Text tab. This is used as the Registration Text when the button is OFF or ON.

■ Action Mode
Select the behavior of the button from the following:

To specify the Registration Text to use when the button is ON, select the Set by State check box on the 
Registration Text tab. If left unchecked, the same Registration Text assigned for the OFF state is 
displayed for the ON state as well.

Set: Pressing the button writes a constant value to a word device.

Move: Pressing the button writes the value in the source device address to the destination word device.

Release

Initial image

Press ReleasePress

Write

Value

Operation and 
view

Action

Data written

Write

Value

ReleasePress ReleasePress

Initial image

Write

Value in
device address

Operation and 
view

Action

Data written

Write

Value in
device address
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Momentary: Pressing the button writes the constant value of ON data to a word device.
Releasing the button writes the constant value of OFF data to a word device.

ReleasePress ReleasePress

Initial image

Write

ON data

Operation and 
view

Action

Data written

Write

ON data

Write

OFF data

Write

OFF data

Pressing and holding the button until the screen changes causes the OFF data to be written to the word 
device.

Alternate: Each press of the button alternately writes the fixed value of ON data and OFF data to the word device.

Add, Sub, Multi, Div, Mod, OR, AND, XOR:

Pressing the button performs arithmetic on a value of source device address and a constant value or 
the value of device address and writes the result to a word device.

Example: Add (Addition)
Pressing the button adds the value in the Source 1 to the Source 2 value and writes the 
sum in the word device.

ReleasePress ReleasePress

Initial image

Write

ON data

Operation and 
view

Action

Data written

Write

OFF data

Release

Initial image

Press ReleasePress

Arithmetic 
operation

↓

Write

Operation and
 view

Action

Data written Result

Arithmetic 
operation

↓

Write

Result

Release

Initial image

Press ReleasePress

Addition

↓

Write

Operation and 
view

Action

Value in reference 
device address

100 200 300 400 500

Data

Value in destination 
device address

240 420

50 40 30 20 10

Addition

↓

Write

0 240 420
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■ Data Type
Select the data type to be handled by the operation selected for Action Mode.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.
UBIN16(W) and UBIN32(D) can only be set if Action Mode is set to OR, AND, or XOR.

■ Source 1
Specify the source word device.
Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.
This setting is enabled only if Action Mode is set to Add, Sub, Multi, Div, Mod, OR, AND, or XOR.

■ Source Data
Select the data to be handled by the operation selected for Action Mode.

*1 Advanced mode only

UBIN16(W) and UBIN32(D) can only be set if Action Mode is set to Move. Because the number of 
device addresses to transfer is specified in Advanced mode, you do not need to set Data Type.

If BCD4(B), BCD8(EB), or Float32(F) is selected and the arithmetic data contains a value inexpressible 
in BCD, a 1 is written to the System Area 2 Processing error bit (address number+2, bit 5) and an error 
message is displayed. For details, refer to Chapter 4 “Processing error” on page 4-32 and Chapter 36 
“Processing error” on page 36-3.

Value: Use a constant value.
Only a Value can be handled if Action Mode is set to Set, Momentary, or Alternate.
If Action Mode is set to Momentary or Alternate, the value in the ON Data is written when the 
button is ON, and the value in the OFF Data is written when the button is OFF.

Hexadecimal: Select this check box to enter the ON Data and OFF Data values in 
hexadecimal.

Device Address: Use a value of device address.
Specify the device address. 
Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 
2 “5.1 Device Address Settings” on page 2-68.

Use Reference Device Address*1:Select this check box and specify a device address to change the 
source word device according to the value of the specified device 
address.
This setting is enabled only if Action Mode is set to Move.
For details, refer to Chapter 2 “Indirect Read and Indirect Write 
Settings” on page 2-5.

Transfer*1 Specify the number of word devices (1 to 64) to transfer.
This setting is enabled only if Action Mode is set to Move.
Example: If Transfer is set to 2 and Write is set to 3, the same data in 

2 continuous word device addresses will be written to the 
destination device address 3 times.

:

Device Address: LDR0

Write: 3

999LDR0

Destination Device: D100

D100

D101

D102

D103

Transfer: 2 1000LDR1

D104

D105

999

1000

999

1000

999

1000
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■ Destination Device Address

*1 Advanced mode only

Destination Device Address: Specify the destination word device.

Click  to display the Tag Editor. For the device address configuration procedure, 
refer to Chapter 2 “5.1 Device Address Settings” on page 2-68.

Use Reference Device Address*1: Select this check box and specify a device address to change the destination word 
device according to the value of the specified device address.
This setting is enabled only if Action Mode is set to Move.
For details, refer to Chapter 2 “Indirect Read and Indirect Write Settings” on page 
2-5.

Write*1 Specify the number of word devices (1 to 64) at the destination.
For Move, specify how many times to write.
This setting is enabled only if Action Mode is set to Set, Momentary, 
Alternate, or Move.
Example: If Data Type is set to UBIN16(W) and Write is set to 5, the same 

data will be written to 5 continuous word addresses.

Example: If Data Type is set to UBIN32(D) and Write is set to 5, the same data 
will be written to a total of 10 word addresses (2 words 5 times).

:

Destination Device Address: LDR10
Write: 5

Data Type: UBIN16(W)
Source Data: 12345

12345LDR10

12345LDR11

12345LDR12

12345LDR13

12345LDR14

5 words

Destination Device Address: LDR10
Write: 5

Data Type: UBIN32(D)
Source Data: 987654

LDR10

987654

LDR11

LDR12

987654

LDR13

LDR14

987654

LDR15

LDR16

987654

LDR17

LDR18

987654

LDR19

10 words
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■ View Switching Method*1

Select how to display the ON/OFF status of the button.

*1 Advanced mode only

Button: Pressing the button changes the drawing object displayed.

Device Address: The drawing objects assigned to the OFF and ON states are displayed when the value of the device 
address is 0 and 1, respectively. Specifies the device address used to switch the drawing object 
display.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 
“5.1 Device Address Settings” on page 2-68.

No Image: The button is not displayed on the screen. The button appears as a dashed line frame on the edit 
screen. Pressing the corresponding area on the MICRO/I activates the assigned function. If No 
Image is selected, the settings for View and Registration Text are disabled.

Selecting Device Address in View Switching Method allows you to create an illuminated pushbutton.
The illuminated pushbutton switches state (or image) according to ON or OFF state of the device address, 
allowing you to display the state of a device that is being operated.

Example: When you set an external device address 'M0' as Device Address in View Switching Method, 
if the value of M0 changes, the display image will switched according to the value of M0 even if 
the button is not pressed.

0

M0

1

M0

MICRO/I External device

View Switching Method (Device Address): M0 

OFF image:

ON image:
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● View Tab
Only Coordinates and Size can be configured when No Image is selected for View Switching Method on the 
General tab.

■ Image Type
Select the type of graphic to be used to represent the part.

■ Browse
Select the type of graphic to be used to represent the part from the list of graphics. Click this button to display the 
View Browser or Picture Manager, depending on the setting for Image Type.

■ OFF button, ON button
Displays the graphic when ON or OFF. Clicking ON or OFF switches the image displayed on the View tab.

■ OFF, ON
Selects the color and pattern of the standard graphic when ON and OFF.

Standard: Uses the default graphics contained within WindO/I-NV4.

Picture: Uses an image file saved in the Picture Manager.
For details about image file restrictions, refer to Chapter 2 “1.4 Available Image Files” on page 2-20.

Foreground Color, Background Color: Selects the foreground and background colors of the standard graphic (color: 
256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

Pattern: Selects a pattern or tonal gradation for the standard graphic.
Click Pattern to display the Pattern Palette. Select a pattern or tonal gradation from the Pattern Palette.



WindO/I-NV4 User’s Manual 8-29

2 Word Button

8

Buttons

■ Flash
Select this check box if flashing is desired (alternating ON and OFF) when a part is ON.

■ Coordinates

■ Size

Flash

ON image

OFF image

X, Y: Sets the display position of parts using coordinates.
The X and Y coordinates of parts are defined relative to an origin at the top-left corner of the screen.

X: 0 to (base screen horizontal size - 1)

Y: 0 to (base screen vertical size - 1)

(0, 0)
X

Y
Screen

Parts

W, H: Sets width and height to define the size of parts.

W: 20 to (base screen horizontal size)

H: 20 to (base screen vertical size)

Width

Height

Screen

Parts
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● Registration Text Tab
These options can only be configured when Button or Device Address is selected for View Switching Method on 
the General tab.

■ Font
Selects the font used for displaying text from the following.
Japanese, European, Chinese, Taiwanese, Korean, Central European, Baltic, Cyrillic, Windows, Stroke
Can only be set when the Use Text Manager check box is cleared.
The characters that can be displayed depend on the font. For details, refer to Chapter 2 “1.2 Available Text” on page 2-6.

■ Size
Sets the character size (8 to 128).
Can only be set when Stroke is selected.

■ Style
Selects Regular or Bold for text style.
Can only be set when Font is set to Japanese, European, Chinese, Taiwanese, Korean, Central European, 
Baltic or Cyrillic.

■ Magnification

Can only be set when Font is set to Japanese, European, Chinese, Taiwanese, Korean, Central European, 
Baltic or Cyrillic.

■ Align Text Horizontal
Selects text alignment in the horizontal direction.
Left, Center, Right, Center-Left
For details, refer to Appendix “5 Text Alignment” on page A-7.

■ Align Text Vertical
Selects text alignment in the vertical direction.
Top, Center, Bottom
For details, refer to Appendix “5 Text Alignment” on page A-7.

■ Set by State
Select this check box if displaying different text when ON and OFF.

■ Use Text Manager
Select this check box if using the text registered in Text Manager for text display.

W, H: Selects the magnification (0.5, 1 to 8) for text display.
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■ OFF, ON

Text: Inputs characters to be displayed on parts. The maximum number is 3,750 characters.
The characters that can be entered depend on the font selected using Font. For details, refer to 
Chapter 2 “1.2 Available Text” on page 2-6.

Text ID: Specifies the Text Manager ID No. (1 to 32000) when using the text registered in the Text Manager.

Click  to display Text Manager.

Can only be set when the Use Text Manager check box is selected.

Text Color: Selects the color of the text displayed on the part (color: 256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

Windows Font: Sets the font to be used as the Windows Font.
Select Windows using Font to display the current setting. You can specify the character spacing (0 
to 100) and the line spacing (0 to 100). To change the settings other than the character spacing and 
line spacing, click Change to display the Font Setting dialog box.
Can only be set when the Use Text Manager check box is cleared.
For details, refer to Chapter 2 “Windows Font” on page 2-13.
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● Trigger Condition Tab
The Trigger Condition tab is displayed in Advanced mode.

■ Input Condition
The Button is enabled and operational while the condition is satisfied. The Button is disabled and not operational 
while the condition is not satisfied.
Example: When Trigger Type is While ON and Device Address is LM0

While LM0 is 0, the condition is not satisfied and the Button is not operational.
While LM0 is 1, the condition is satisfied and the Button is operational.

Trigger Type: Selects the condition to enable the Button from the following.

Always enable: The Button is always enabled.

While ON: Enables the Button when the value of device address is 1.

LM0:

MICRO/I

0

LM0: 1

Button
Does not
operate

Button
Operates

Condition 
Not 

satisfied

Condition 
Satisfied

Always enabled

Button state

1

0

Disabled Enabled Disabled DisabledEnabled Enabled

Value of
device address

Button state



WindO/I-NV4 User’s Manual 8-33

2 Word Button

8

Buttons

■ Visible Condition
The Button is displayed while the condition is satisfied. The Button is hidden while the condition is not satisfied.
Example: When Trigger Type is While ON and Device Address is LM0

While LM0 is 0, the condition is not satisfied and the Button is hidden.
While LM0 is 1, the condition is satisfied and the Button is displayed.

While OFF: Enables the Button when the value of device address is 0.

While satisfying the condition: Enables the Button when the condition is satisfied.

Data Type: Selects the type of data handled by the conditional expression for the input condition.
This option can only be configured if While satisfying the condition is selected for Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Device Address: Specifies the bit device or the bit number of the word device to serve as the input condition.
This option can only be configured when While ON or While OFF is selected for Trigger Type.
Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 
“5.1 Device Address Settings” on page 2-68.

Condition: Specifies the conditional expression for the input condition.
This option can only be configured when While satisfying the condition is selected for Trigger 
Type.
Click  to display the Trigger Condition Settings dialog box. For the conditional expression 
configuration procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-71.

Comment: Used for entering a comment for the input condition. The maximum number is 80 characters.

1

0

Enabled Enabled EnabledDisabled Disabled Disabled

Value of
device address

Button state

Satisfied

Not satisfied

Disabled Disabled DisabledEnabled Enabled Enabled

Condition

Button 
state

LM0:

MICRO/I

0

LM0: 1
Show

Condition 
Not 

satisfied

Condition 
Satisfied

Hide

• When Alternate is selected for Action Mode on the General tab, the button remains on when hidden 
in the on state.

• When the ON delay check box is selected on the Options tab, if the button is hidden before the set time 
elapses from when the button begins to be pressed, the on delay is reset and the button does not 
operate.
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Trigger Type: Selects the condition to display the Button from the following.

Always visible: The Button is always displayed.

While ON: Displays the Button when the value of device address is 1.

While OFF: Displays the Button when the value of device address is 0.

While satisfying the condition: Displays the Button when the condition is satisfied.

Data Type: Selects the type of data handled by the conditional expression for the visible condition.
This option can only be configured if While satisfying the condition is selected for Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Device Address: Specifies the bit device or the bit number of the word device to serve as the visible condition.
This option can only be configured when While ON or While OFF is selected for Trigger Type.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 
“5.1 Device Address Settings” on page 2-68.

Condition: Specifies the conditional expression for the visible condition.
This option can only be configured when While satisfying the condition is selected for Trigger 
Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expression 
configuration procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-71.

Comment: Used for entering a comment for the visible condition. The maximum number is 80 characters.

Always show

Button state

1

0

Hide Show Hide HideShow Show

Value of
device address

Button state

1

0

Value of
device address

Show Show ShowHide Hide Hide

Button state

Hide Hide HideShow Show Show

Satisfied

Not satisfied

Condition

Button state
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● Options Tab
The Options tab is displayed in Advanced mode.

■ ON delay
Select this check box to use the ON delay function.

■ No Touch Sound
This function is to disable touch sounds only for specified parts when the MICRO/I makes touch sounds.
Select this check box to display disable touch sounds for this part.

■ Place on the Top Layer
Select this check box to display the parts on the top layer. The parts will have precedence when other drawings and 
parts are overlapping with it. For details, refer to Chapter 6 “4 Drawings and Parts Overlapping” on page 6-5.

Time (x100 msec): Specify the length of time that the button must be held down before activation by selecting a 
value from 0 to 600 (units of 10 ms).
The button activates after it is held down for a specified period of time.

Hold down for 3 secs.

MICRO/I MICRO/I

Button
Does not
operate

Button
Operates

This feature protects against mistaken operation by ensuring that the button will not be activated if touched 
accidentally.

To enable touch sounds on the MICRO/I, select the Enable Touch Sound check box under the System 
tab of the Project Settings dialog box.
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● Security Tab
This tab is used to restrict displaying and using the part by security groups.
This option can only be set when Use Security functions is selected. The Use Security functions check box is set 
on General tab in the Security dialog box.

■ (Settings)
Displays the list of security groups used on the MICRO/I.

■ Security Settings
The Security Settings dialog box is displayed. If you create a security group in the Security Settings dialog box, you 
can select that created group. For details, refer to Chapter 23 “2.2 Adding and Editing Security Groups” on page 23-
19.

(Settings)

No.: Displays the security group numbers (0 to 15).

Group Name: Displays the name of the security group.

Display: Displays whether or not there is permission to display the part. Only Permitted security groups 
can display this part. If all security groups are set to Permitted, this part will be displayed even 
if no user account has been selected. Double clicking the cell switches between Permitted and 
Prohibited.

Input: Displays whether or not there is permission to use the part. Only Permitted security groups 
can use this part. If all security groups are set to Permitted, this part can be used even if no 
user account has been selected. Double clicking the cell switches between Permitted and 
Prohibited.

• You can also switch between Permitted and Prohibited by right-clicking on a Display or Input cell.
• Restricting the display and use of the part by switching between Permitted and Prohibited in Display 

and Input cells is similar to using the Trigger Condition tab.

For details about security functions, refer to Chapter 23 “User Accounts and the Security Function” on page 
23-1.
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Example: If the user and security group for a part are set as follows:

For User1 in the Reader security group, the parts for which Display has been set to Prohibited for Reader will not 
be displayed.
If the password screen is opened and the user switches to User2 in the Operator security group, the parts for which 
Display has been set to Permitted for Operator will be displayed.

For User2 in Operator, Display has been set to Permitted for Operator, but Input is Prohibited, so the part 
cannot be used.
If the password screen is opened and the user switches to User3 in the Administrator security group, the parts for 
which Display has been set to Permitted for Administrator will be displayed, and the parts for which Input has 
been set to Permitted for Administrator can be used.

User Name

Security Group Reader Operator Administrator
User1 User2 User3

MICRO/I

130

Numerical Display
No. Group Name Display

1 Administrator Permitted

2 Operator Permitted

3 Reader Permitted

Button
No. Group Name Display Input

1 Administrator Permitted Permitted

2 Operator Permitted Prohibited

3 Reader Prohibited Prohibited

Line Chart and Bar Chart
No. Group Name Display

1 Administrator Permitted

2 Operator Permitted

3 Reader Prohibited

Open Password Screen, 
enter password, 
and switch to User2

For User1, 
parts for which Display 
has been set to Prohibited 
for Reader are not displayed

For User2, 
parts for which Display 
has been set to Permitted 
for Operator are displayed

MICRO/I

130

MICRO/I MICRO/I

130

User1 User2

130
CAN

User Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password

Open Password Screen, 
enter password, 
and switch to User3

For User2, 
parts for which Display 
has been set to Permitted 
for Operator are displayed, 
but parts for which Input 
has been set to Prohibited cannot be used

For User3, 
parts for which Display 
has been set to Permitted 
for Administrator are displayed, 
and parts for which Input 
has been set to Permitted can be used

MICRO/I

130

MICRO/I MICRO/I

130130 130

User2 User3

Button
Can operate

CAN

User Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password

Button
Cannot operate
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● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Used for entering comments about parts. The maximum number is 80 characters.
Example: When mousing over the Button on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.
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3.1 How the Goto Screen Button is Used

Switches to another screen or displays a window.

• Pressing the button switches between Base Screens.

• Pressing the button opens and closes other windows (such as the Popup Screen, Device Monitor, Password Screen, 
Adjust Brightness Screen, File Screen, and Open User Account Setting Screen).

• Pressing the button switches to the System Mode.

• Pressing the button resets the current screen.

3 Goto Screen Button

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

MICRO/I MICRO/I

MICRO/I MICRO/I MICRO/I MICRO/I

D51 123

D52 456

D53 0

999

D51 123

D52 456

D53 0

999

MICRO/I MICRO/I

Offline Mein Menu

MICRO/I MICRO/I

130 0
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3.2 Goto Screen Button Configuration Procedure

This section describes the configuration procedure for Goto Screen Buttons.

1 On the Home tab, in the Parts group, click Buttons, and then click Goto Screen Button.

2 Click a point on the edit screen where you wish to place the Goto Screen Button.

3 Double-click the dropped Goto Screen Button and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.

The Trigger Condition tab and Options tab only appear in Advanced mode.
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3.3 Properties of Goto Screen Button Dialog Box

This section describes items and buttons in the Properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ >>OFF Text, >>ON Text
Applies the text entered in the Part Name field to the Text field under the OFF or ON fields on the Registration 
Text tab. This is used as the Registration Text when the button is OFF or ON.

To specify the Registration Text to use when the button is ON, select the Set by State check box on the 
Registration Text tab. If left unchecked, the same Registration Text assigned for the OFF state is 
displayed for the ON state as well.
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■ Action Mode
Select the behavior of the button from the following:

*1 This is applicable for models with a video interface only.

Back to previous Screen: Switches to the previous screen. Returns to up to 16 earlier screens.

Switch to Base Screen: Switches between Base Screen. For details, refer to Chapter 5 “3 Base Screen” 
on page 5-14.

Open Popup Screen: Opens a Popup Screen. For details, refer to Chapter 5 “4 Popup Screen” on 
page 5-20.

Close Popup Screen: Closes a Popup Screen. For details, refer to Chapter 5 “4 Popup Screen” on 
page 5-20.

Open Device Monitor Screen: Opens the Device Monitor Screen. For details, refer to Chapter 25 “2.2 Device 
Monitor” on page 25-21.

Close Device Monitor Screen: Closes the Device Monitor Screen. For details, refer to Chapter 25 “2.2 Device 
Monitor” on page 25-21.

Open Password Screen: Opens the Password Screen. For details, refer to Chapter 23 “4.1 Entering the 
Password on the MICRO/I” on page 23-46.

Close Password Screen: Closes the Password Screen. For details, refer to Chapter 23 “4.1 Entering the 
Password on the MICRO/I” on page 23-46.

Open Adjust Brightness Screen: Opens the Adjust Brightness Screen. For details, refer to Chapter 34 “1.3 
Adjusting Screen Brightness” on page 34-2.

Close Adjust Brightness Screen: Closes the Adjust Brightness Screen. For details, refer to Chapter 34 “1.3 
Adjusting Screen Brightness” on page 34-2.

Open File Screen for movie files*1: Opens the File Screen. For details, refer to Chapter 10 “4.4 File Screen” on 
page 10-92.

Close File Screen for movie files*1: Closes the File Screen. For details, refer to Chapter 10 “4.4 File Screen” on 
page 10-92.

Switch to System Mode: Switches to the Top Page in the System Mode. For details, refer to Chapter 34 
“2 System Mode Overview” on page 34-3.

Reset current screen: Resets the current Base Screen.

Open User Account Setting Screen: Opens the User Account Setting Screen. For details, refer to Chapter 23 “5 
Editing User Accounts on the MICRO/I” on page 23-49.
When User Account Setting Screen is selected, the Configure 
Processing Area of User Account Setting Screen dialog box will be 
displayed. For details, refer to “ Configure Processing Area of User Account 
Setting Screen Dialog Box” on page 8-44.
Specify the word device to use as the processing area of the User Account 
Setting Screen and click OK. When you return to the properties dialog box, 
Edit will be displayed.

Edit: Click this button to display the Configure Processing Area of User 
Account Setting Screen dialog box.

When the current Base Screen is reset using the Reset current screen function, the window and internal 
devices restart as if the Base Screens were switched.
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■ Goto Screen

■ View Switching Method*2

Select how to display the ON/OFF status of the button.

*1 This is applicable for models with a video interface only.

Screen Number: If Action Mode is set to Switch to Base Screen, specify the Base Screen number to switch to 
(from 1 to 3000). If Action Mode is set to Open Popup Screen or Close Popup Screen, 
specify the number of the Popup Screen to open or close (from 1 to 3015).
This setting is enabled only if Action Mode is set to Switch to Base Screen, Open Popup 
Screen, or Close Popup Screen.

Use Reference Device Address*2: Select this check box and specify a device address to specify 
the screen number using the value of the specified device 
address.
Click  to display the Tag Editor. For the device address 
configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.
This setting is enabled only if Action Mode is set to Open 
Popup Screen or Close Popup Screen.

Coordinates X, Y: Specify the coordinates on the Base Screen for displaying a window.
X and Y specify the upper left corner of the window using the upper left corner of the screen as the 
origin.
This setting is enabled only if Action Mode is set to Open Popup Screen, Open Device 
Monitor Screen, Open Password Screen, Open Adjust Brightness Screen, or Open File 
Screen for Movie Files*1.

Use Reference Device Address*2: Select this check box and specify a device address to specify 
the coordinates using the value of the specified device 
address.
Click  to display the Tag Editor. For the
device address configuration procedure, refer to Chapter 2 “5.1 
Device Address Settings” on page 2-68.
This setting is enabled only if Action Mode is set to Open 
Popup Screen.

Button: Pressing the button changes the drawing object displayed.

Device Address: The drawing objects assigned to the OFF and ON states are displayed when the value of the device 
address is 0 and 1, respectively. Specifies the device used to switch the drawing object display.
Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 
2 “5.1 Device Address Settings” on page 2-68.

No Image: The button is not displayed on the screen. The button appears as a dashed line frame on the edit 
screen. Pressing the corresponding area on the MICRO/I activates the assigned function. If No 
Image is selected, the settings for View and Registration Text are disabled.

Selecting Device Address in View Switching Method allows you to create an illuminated pushbutton.
The illuminated pushbutton switches state (or image) according to ON or OFF state of the device address, 
allowing you to display the state of a device that is being operated.

Example: When you set an external device address 'M0' as Device Address in View Switching Method, if 
the value of M0 changes, the display image will switched according to the value of M0 even if the 
button is not pressed.

0

M0

1

M0

MICRO/I External device

View Switching Method (Device Address): M0 

OFF image:

ON image:
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*2 Advanced mode only

Configure Processing Area of User Account Setting Screen Dialog Box

■ Top Device Address
Specifies a word device to use Processing Area of User Account Setting Screen. 152 words are used from the starting 
device address.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.
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● View Tab
Only Coordinates and Size can be configured when No Image is selected for View Switching Method on the 
General tab.

■ Image Type
Select the type of graphic to be used to represent the part.

■ Browse
Select the type of graphic to be used to represent the part from the list of graphics. Click this button to display the 
View Browser or Picture Manager, depending on the setting for Image Type.

■ OFF button, ON button
Displays the graphic when ON or OFF. Clicking ON or OFF switches the image displayed on the View tab.

■ OFF, ON
Selects the color and pattern of the standard graphic when ON and OFF.

Standard: Uses the default graphics contained within WindO/I-NV4.

Picture: Uses an image file saved in the Picture Manager.
For details about image file restrictions, refer to Chapter 2 “1.4 Available Image Files” on page 2-20.

Foreground Color, Background Color: Selects the foreground and background colors of the standard graphic (color: 
256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

Pattern: Selects a pattern or tonal gradation for the standard graphic.
Click Pattern to display the Pattern Palette. Select a pattern or tonal gradation from the Pattern Palette.
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■ Flash
Select this check box if flashing is desired (alternating ON and OFF) when a part is ON.

■ Coordinates

■ Size

Flash

ON image

OFF image

X, Y: Sets the display position of parts using coordinates.
The X and Y coordinates of parts are defined relative to an origin at the top-left corner of the screen.

X: 0 to (base screen horizontal size - 1)

Y: 0 to (base screen vertical size - 1)

(0, 0)
X

Y
Screen

Parts

W, H: Sets width and height to define the size of parts.

W: 20 to (base screen horizontal size)

H: 20 to (base screen vertical size)

Width

Height

Screen

Parts
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● Registration Text Tab
These options can only be configured when Button or Device Address is selected for View Switching Method on 
the General tab.

■ Font
Selects the font used for displaying text from the following.
Japanese, European, Chinese, Taiwanese, Korean, Central European, Baltic, Cyrillic, Windows, Stroke
Can only be set when the Use Text Manager check box is cleared.
The characters that can be displayed depend on the font. For details, refer to Chapter 2 “1.2 Available Text” on page 2-6.

■ Size
Sets the character size (8 to 128).
Can only be set when Stroke is selected.

■ Style
Selects Regular or Bold for text style.
Can only be set when Font is set to Japanese, European, Chinese, Taiwanese, Korean, Central European, 
Baltic or Cyrillic.

■ Magnification

Can only be set when Font is set to Japanese, European, Chinese, Taiwanese, Korean, Central European, 
Baltic or Cyrillic.

■ Align Text Horizontal
Selects text alignment in the horizontal direction.
Left, Center, Right, Center-Left
For details, refer to Appendix “5 Text Alignment” on page A-7.

■ Align Text Vertical
Selects text alignment in the vertical direction.
Top, Center, Bottom
This option can only be configured when Left, Center, or Right is selected for Align Text Horizontal. If Center-
Left is selected for Align Text Horizontal, Center-Top is set as this option.
For details, refer to Appendix “5 Text Alignment” on page A-7.

■ Set by State
Select this check box if displaying different text when ON and OFF.

■ Use Text Manager
Select this check box if using the text registered in Text Manager for text display.

W, H: Selects the magnification (0.5, 1 to 8) for text display.
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■ OFF, ON

Text: Inputs characters to be displayed on parts. The maximum number is 3,750 characters.
The characters that can be entered depend on the font selected using Font. For details, refer to 
Chapter 2 “1.2 Available Text” on page 2-6.

Text ID: Specifies the Text Manager ID No. (1 to 32000) when using the text registered in the Text Manager.

Click  to display Text Manager.

Can only be set when the Use Text Manager check box is selected.

Text Color: Selects the color of the text displayed on the part (color: 256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

Windows Font: Sets the font to be used as the Windows Font.
Select Windows using Font to display the current setting. You can specify the character spacing (0 
to 100) and the line spacing (0 to 100). To change the settings other than the character spacing and 
line spacing, click Change to display the Font Setting dialog box.
Can only be set when the Use Text Manager check box is cleared.
For details, refer to Chapter 2 “Windows Font” on page 2-13.
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● Trigger Condition Tab
The Trigger Condition tab is displayed in Advanced mode.

■ Input Condition
The Button is enabled and operational while the condition is satisfied. The Button is disabled and not operational 
while the condition is not satisfied.
Example: When Trigger Type is While ON and Device Address is LM0

While LM0 is 0, the condition is not satisfied and the Button is not operational.
While LM0 is 1, the condition is satisfied and the Button is operational.

Trigger Type: Selects the condition to enable the Button from the following.

Always enable: The Button is always enabled.

While ON: Enables the Button when the value of device address is 1.

LM0:

MICRO/I

0

LM0: 1

Button
Does not
operate

Button
Operates

Condition 
Not 

satisfied

Condition 
Satisfied

Always enabled

Button state

1

0

Disabled Enabled Disabled DisabledEnabled Enabled

Value of
device address

Button state
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■ Visible Condition
The Button is displayed while the condition is satisfied. The Button is hidden while the condition is not satisfied.
Example: When Trigger Type is While ON and Device Address is LM0

While LM0 is 0, the condition is not satisfied and the Button is hidden.
While LM0 is 1, the condition is satisfied and the Button is displayed.

While OFF: Enables the Button when the value of device address is 0.

While satisfying the condition: Enables the Button when the condition is satisfied.

Data Type: Selects the type of data handled by the conditional expression for the input condition.
This option can only be configured if While satisfying the condition is selected for Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Device Address: Specifies the bit device or the bit number of the word device to serve as the input condition.
This option can only be configured when While ON or While OFF is selected for Trigger Type.
Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 
“5.1 Device Address Settings” on page 2-68.

Condition: Specifies the conditional expression for the input condition.
This option can only be configured when While satisfying the condition is selected for Trigger 
Type.
Click  to display the Trigger Condition Settings dialog box. For the conditional expression 
configuration procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-71.

Comment: Used for entering a comment for the input condition. The maximum number is 80 characters.

1

0

Enabled Enabled EnabledDisabled Disabled Disabled

Value of
device address

Button state

Satisfied

Not satisfied

Disabled Disabled DisabledEnabled Enabled Enabled

Condition

Button 
state

LM0:

MICRO/I

0

LM0: 1
Show

Condition 
Not 

satisfied

Condition 
Satisfied

Hide

When the ON delay check box is selected on the Options tab, if the button is hidden before the set time 
elapses from when the button begins to be pressed, the on delay is reset and the button does not operate.
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Trigger Type: Selects the condition to display the Button from the following.

Always visible: The Button is always displayed.

While ON: Displays the Button when the value of device address is 1.

While OFF: Displays the Button when the value of device address is 0.

While satisfying the condition: Displays the Button when the condition is satisfied.

Data Type: Selects the type of data handled by the conditional expression for the visible condition.
This option can only be configured if While satisfying the condition is selected for Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Device Address: Specifies the bit device or the bit number of the word device to serve as the visible condition.
This option can only be configured when While ON or While OFF is selected for Trigger Type.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 
“5.1 Device Address Settings” on page 2-68.

Condition: Specifies the conditional expression for the visible condition.
This option can only be configured when While satisfying the condition is selected for Trigger 
Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expression 
configuration procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-71.

Comment: Used for entering a comment for the visible condition. The maximum number is 80 characters.

Always show

Button state

1

0

Hide Show Hide HideShow Show

Value of
device address

Button state

1

0

Value of
device address

Show Show ShowHide Hide Hide

Button state

Hide Hide HideShow Show Show

Satisfied

Not satisfied

Condition

Button state
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● Options Tab
The Options tab is displayed in Advanced mode.

■ ON delay
Select this check box to use the ON delay function.

■ No Touch Sound
This function is to disable touch sounds only for specified parts when the MICRO/I makes touch sounds.
Select this check box to display disable touch sounds for this part.

■ Place on the Top Layer
Select this check box to display the parts on the top layer. The parts will have precedence when other drawings and 
parts are overlapping with it. For details, refer to Chapter 6 “4 Drawings and Parts Overlapping” on page 6-5.

Time (x100 msec): Specify the length of time that the button must be held down before activation by selecting a 
value from 0 to 600 (units of 10 ms).
The button activates after it is held down for a specified period of time.

Hold down for 3 secs.

MICRO/I MICRO/I

Button
Does not
operate

Button
Operates

This feature protects against mistaken operation by ensuring that the button will not be activated if touched 
accidentally.

To enable touch sounds on the MICRO/I, select the Enable Touch Sound check box under the System 
tab of the Project Settings dialog box.
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● Security Tab
This tab is used to restrict displaying and using the part by security groups.
This option can only be set when Use Security functions is selected. The Use Security functions check box is set 
on General tab in the Security dialog box.

■ (Settings)
Displays the list of security groups used on the MICRO/I.

■ Security Settings
The Security Settings dialog box is displayed. If you create a security group in the Security Settings dialog box, you 
can select that created group. For details, refer to Chapter 23 “2.2 Adding and Editing Security Groups” on page 23-
19.

(Settings)

No.: Displays the security group numbers (0 to 15).

Group Name: Displays the name of the security group.

Display: Displays whether or not there is permission to display the part. Only Permitted security groups 
can display this part. If all security groups are set to Permitted, this part will be displayed even 
if no user account has been selected. Double clicking the cell switches between Permitted and 
Prohibited.

Input: Displays whether or not there is permission to use the part. Only Permitted security groups 
can use this part. If all security groups are set to Permitted, this part can be used even if no 
user account has been selected. Double clicking the cell switches between Permitted and 
Prohibited.

• You can also switch between Permitted and Prohibited by right-clicking on a Display or Input cell.
• Restricting the display and use of the part by switching between Permitted and Prohibited in Display 

and Input cells is similar to using the Trigger Condition tab.

For details about security functions, refer to Chapter 23 “User Accounts and the Security Function” on page 
23-1.
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Example: If the user and security group for a part are set as follows:

For User1 in the Reader security group, the parts for which Display has been set to Prohibited for Reader will not 
be displayed.
If the password screen is opened and the user switches to User2 in the Operator security group, the parts for which 
Display has been set to Permitted for Operator will be displayed.

For User2 in Operator, Display has been set to Permitted for Operator, but Input is Prohibited, so the part 
cannot be used.
If the password screen is opened and the user switches to User3 in the Administrator security group, the parts for 
which Display has been set to Permitted for Administrator will be displayed, and the parts for which Input has 
been set to Permitted for Administrator can be used.

User Name

Security Group Reader Operator Administrator
User1 User2 User3

MICRO/I

130

Numerical Display
No. Group Name Display

1 Administrator Permitted

2 Operator Permitted

3 Reader Permitted

Button
No. Group Name Display Input

1 Administrator Permitted Permitted

2 Operator Permitted Prohibited

3 Reader Prohibited Prohibited

Line Chart and Bar Chart
No. Group Name Display

1 Administrator Permitted

2 Operator Permitted

3 Reader Prohibited

Open Password Screen, 
enter password, 
and switch to User2

For User1, 
parts for which Display 
has been set to Prohibited 
for Reader are not displayed

For User2, 
parts for which Display 
has been set to Permitted 
for Operator are displayed

MICRO/I

130

MICRO/I MICRO/I

130

User1 User2

130
CAN

User Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password

Open Password Screen, 
enter password, 
and switch to User3

For User2, 
parts for which Display 
has been set to Permitted 
for Operator are displayed, 
but parts for which Input 
has been set to Prohibited cannot be used

For User3, 
parts for which Display 
has been set to Permitted 
for Administrator are displayed, 
and parts for which Input 
has been set to Permitted can be used

MICRO/I

130

MICRO/I MICRO/I

130130 130

User2 User3

Button
Can operate

CAN

User Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password

Button
Cannot operate
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● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Used for entering comments about parts. The maximum number is 80 characters.
Example: When mousing over the Button on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.
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4.1 How the Print Button is Used

Outputs a screenshot to a printer or an external memory device*1.

• Pressing the Print Button outputs a screenshot of the current screen to the printer.

• Pressing the Print Button outputs a screenshot of the current screen to an external memory device*1.

*1 SD memory card for HG5G/4G/3G/2G-V, HG4G/3G and HG2G-5F, USB flash drive for HG2G-5T and HG1G/1P

4 Print Button

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

HG3G HG2G-5FHG4G
HG5G-V HG4G-V HG3G-V HG2G-V

MICRO/I Printer

2011/1/11

Refer to Chapter 32 “1.2 Connecting a Printer to MICRO/I” on page 32-1 for compatible printers and 
instructions on how to connect one to the MICRO/I.

USB flash drive

SD memory card
MICRO/I

Image file

External Memory Device
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4.2 Print Button Configuration Procedure

This section describes the configuration procedure for Print Buttons.

1 On the Home tab, in the Parts group, click Buttons, and then click Print Button.

2 Click a point on the edit screen where you wish to place the Print Button.

3 Double-click the dropped Print Button and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.

The Trigger Condition tab and Options tab only appear in Advanced mode.
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4.3 Properties of Print Button Dialog Box

This section describes items and buttons in the Properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ >>OFF Text, >>ON Text
Applies the text entered in the Part Name field to the Text field under the OFF or ON fields on the Registration 
Text tab. This is used as the Registration Text when the button is OFF or ON.

■ Output to
Select where to direct the screenshot to.

*1 HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F only
*2 SD memory card for HG5G/4G/3G/2G-V, HG4G/3G and HG2G-5F, USB flash drive for HG2G-5T and HG1G/1P

To specify the Registration Text to use when the button is ON, place a check in the Set by State check box 
on the Registration Text tab. If left unchecked, the same Registration Text assigned for the OFF state is 
displayed for the ON state as well.

Printer*1: Outputs the screenshot to the printer connected to the MICRO/I.

Print Time Stamp: Adds the date and time of printing to the screenshot before 
sending it to the printer.
The date and time format depends on the language selected in 
Language. Language is available on the Project Details tab of 
the Project Settings dialog box.
The display formats are shown below:
• Japanese: YYYY/MM/DD hh:mm
• English: MM/DD/YYYY hh:mm
YYYY: year, MM: month, DD: day, hh: hour, mm: minute

External Memory Device*2: Outputs the screenshot as a file to the external memory device inserted in the MICRO/I.
Files are output as follows:

File format File name File size

JPEG
CAP***.JPG (***: date and time when file was output)
Example: A file created at 18:50:25 on June 30, 2011 

will be named “CAP110630_185025.JPG”.

Depends on 
image being 
displayed.
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■ Action Mode
Select the behavior of the button from the following. This option is only displayed when Printer is selected in Output to.

■ View Switching Method*3

Select how to display the ON/OFF status of the button.

*1 HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F only
*3 Advanced mode only

• For details about printers, refer to Chapter 32 “Printer” on page 32-1.
• For details about external memory devices, refer to Chapter 31 “External Memory Devices” on page 31-1.

Print Screen: Outputs a screenshot of the current screen to the printer or the external memory device

Cancel Printing*1: Cancels printout to the printer.

Button: Pressing the button changes the drawing object displayed.

Device Address: The drawing objects assigned to the OFF and ON states are displayed when the value of the device 
address is 0 and 1, respectively. Specifies the device address used to switch the drawing object 
display.
Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 
“5.1 Device Address Settings” on page 2-68.

No Image: The button is not displayed on the screen. The button appears as a dashed line frame on the edit 
screen. Pressing the corresponding area on the MICRO/I activates the assigned function. If No 
Image is selected, the settings for View and Registration Text are disabled.

Selecting Device Address in View Switching Method allows you to create an illuminated pushbutton.
The illuminated pushbutton switches state (or image) according to ON or OFF state of the device address, 
allowing you to display the state of a device that is being operated.

Example: When you set an external device address 'M0' as Device Address in View Switching Method, 
if the value of M0 changes, the display image will switched according to the value of M0 even if 
the button is not pressed.

0

M0

1

M0

MICRO/I External device

View Switching Method (Device Address): M0 

OFF image:

ON image:

• These operations cannot be performed simultaneously.
- Outputting to the external memory device by pressing the Print Button.
- Outputting to the printer by pressing the Print Button*1.
- Printing alarm logs

• It may take some time to output screenshots when copying files using the USB Autorun function or a Key 
Button.

• MICRO/I cannot stop printing in the middle of a page, even when the print job is canceled. Print jobs 
after the current print job are canceled after the current page finishes printing.

The maximum number of screenshots that can be captured (1 to 999) can be set in HMI Special Data 
Registers LSD65. (Default: 99)



4 Print Button

8-60 WindO/I-NV4 User’s Manual

The methods to erase screenshot files saved on the external memory device are as follows.
• To erase files during operation using parts, on the External Memory Device tab on the Project 

Settings dialog box, select the Remove Files check box and the All Screenshot data check box, and 
then configure the trigger device address. Assign that trigger device address to a part.

• To erase files with WindO/I-NV4, click Clear on the Online tab, and then click Stored Data in External 
Memory Device to open the Clear Data dialog box. Select the Screenshot Data check box and click 
OK.

• To erase files on the HG5G/4G/3G/2G-V, HG4G/3G and the HG2G-5F, go to the System Mode - File 
Manager. In the File Manager, select the files to be deleted by pressing DEL.
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● View Tab
Only Coordinates and Size can be configured when No Image is selected for View Switching Method on the 
General tab.

■ Image Type
Select the type of graphic to be used to represent the part.

■ Browse
Select the type of graphic to be used to represent the part from the list of graphics. Click this button to display the 
View Browser or Picture Manager, depending on the setting for Image Type.

■ OFF button, ON button
Displays the graphic when ON or OFF. Clicking ON or OFF switches the image displayed on the View tab.

■ OFF, ON
Selects the color and pattern of the standard graphic when ON and OFF.

Standard: Uses the default graphics contained within WindO/I-NV4.

Picture: Uses an image file saved in the Picture Manager.
For details about image file restrictions, refer to Chapter 2 “1.4 Available Image Files” on page 2-20.

Foreground Color, Background Color: Selects the foreground and background colors of the standard graphic (color: 
256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

Pattern: Selects a pattern or tonal gradation for the standard graphic.
Click Pattern to display the Pattern Palette. Select a pattern or tonal gradation from the Pattern Palette.
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■ Flash
Select this check box if flashing is desired (alternating ON and OFF) when a part is ON.

■ Coordinates

■ Size

Flash

ON image

OFF image

X, Y: Sets the display position of parts using coordinates.
The X and Y coordinates of parts are defined relative to an origin at the top-left corner of the screen.

X: 0 to (base screen horizontal size - 1)

Y: 0 to (base screen vertical size - 1)

(0, 0)
X

Y
Screen

Parts

W, H: Sets width and height to define the size of parts.

W: 20 to (base screen horizontal size)

H: 20 to (base screen vertical size)

Width

Height

Screen

Parts
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● Registration Text Tab
These options can only be configured when Button or Device Address is selected for View Switching Method on 
the General tab.

■ Font
Selects the font used for displaying text from the following.
Japanese, European, Chinese, Taiwanese, Korean, Central European, Baltic, Cyrillic, Windows, Stroke
Can only be set when the Use Text Manager check box is cleared.
The characters that can be displayed depend on the font. For details, refer to Chapter 2 “1.2 Available Text” on page 2-6.

■ Size
Sets the character size (8 to 128).
Can only be set when Stroke is selected.

■ Style
Selects Regular or Bold for text style.
Can only be set when Font is set to Japanese, European, Chinese, Taiwanese, Korean, Central European, 
Baltic or Cyrillic.

■ Magnification

Can only be set when Font is set to Japanese, European, Chinese, Taiwanese, Korean, Central European, 
Baltic or Cyrillic.

■ Align Text Horizontal
Selects text alignment in the horizontal direction.
Left, Center, Right, Center-Left
For details, refer to Appendix “5 Text Alignment” on page A-7.

■ Align Text Vertical
Selects text alignment in the vertical direction.
Top, Center, Bottom
This option can only be configured when Left, Center, or Right is selected for Align Text Horizontal. If Center-
Left is selected for Align Text Horizontal, Center-Top is set as this option.
For details, refer to Appendix “5 Text Alignment” on page A-7.

■ Set by State
Select this check box if displaying different text when ON and OFF.

■ Use Text Manager
Select this check box if using the text registered in Text Manager for text display.

W, H: Selects the magnification (0.5, 1 to 8) for text display.
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■ OFF, ON

Text: Inputs characters to be displayed on parts. The maximum number is 3,750 characters.
The characters that can be entered depend on the font selected using Font. For details, refer to 
Chapter 2 “1.2 Available Text” on page 2-6.

Text ID: Specifies the Text Manager ID No. (1 to 32000) when using the text registered in the Text Manager.

Click  to display Text Manager.

Can only be set when the Use Text Manager check box is selected.

Text Color: Selects the color of the text displayed on the part (color: 256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

Windows Font: Sets the font to be used as the Windows Font.
Select Windows using Font to display the current setting. You can specify the character spacing 
(0 to 100) and the line spacing (0 to 100). To change the settings other than the character spacing 
and line spacing, click Change to display the Font Settings dialog box.
Can only be set when the Use Text Manager check box is cleared.
For details, refer to Chapter 2 “Windows Font” on page 2-13.
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● Trigger Condition Tab
The Trigger Condition tab is displayed in Advanced mode.

■ Input Condition
The Button is enabled and operational while the condition is satisfied. The Button is disabled and not operational 
while the condition is not satisfied.
Example: When Trigger Type is While ON and Device Address is LM0

While LM0 is 0, the condition is not satisfied and the Button is not operational.
While LM0 is 1, the condition is satisfied and the Button is operational.

Trigger Type: Selects the condition to enable the Button from the following.

Always enable: The Button is always enabled.

While ON: Enables the Button when the value of device address is 1.

LM0:

MICRO/I

0

LM0: 1

Button
Does not
operate

Button
Operates

Condition 
Not 

satisfied

Condition 
Satisfied

Always enabled

Button state

1

0

Disabled Enabled Disabled DisabledEnabled Enabled

Value of
device address

Button state
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■ Visible Condition
The Button is displayed while the condition is satisfied. The Button is hidden while the condition is not satisfied.
Example: When Trigger Type is While ON and Device Address is LM0

While LM0 is 0, the condition is not satisfied and the Button is hidden.
While LM0 is 1, the condition is satisfied and the Button is displayed.

While OFF: Enables the Button when the value of device address is 0.

While satisfying the condition: Enables the Button when the condition is satisfied.

Data Type: Selects the type of data handled by the conditional expression for the input condition.
This option can only be configured if While satisfying the condition is selected for Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Device Address: Specifies the bit device or the bit number of the word device to serve as the input condition.
This option can only be configured when While ON or While OFF is selected for Trigger Type.
Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 
“5.1 Device Address Settings” on page 2-68.

Condition: Specifies the conditional expression for the input condition.
This option can only be configured when While satisfying the condition is selected for Trigger 
Type.
Click  to display the Trigger Condition Settings dialog box. For the conditional expression 
configuration procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-71.

Comment: Used for entering a comment for the input condition. The maximum number is 80 characters.

1

0

Enabled Enabled EnabledDisabled Disabled Disabled

Value of
device address

Button state

Satisfied

Not satisfied

Disabled Disabled DisabledEnabled Enabled Enabled

Condition

Button 
state

LM0:

MICRO/I

0

LM0: 1
Show

Condition 
Not 

satisfied

Condition 
Satisfied

Hide

When the ON delay check box is selected on the Options tab, if the button is hidden before the set time 
elapses from when the button begins to be pressed, the on delay is reset and the button does not operate.
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Trigger Type: Selects the condition to display the Button from the following.

Always visible: The Button is always displayed.

While ON: Displays the Button when the value of device address is 1.

While OFF: Displays the Button when the value of device address is 0.

While satisfying the condition: Displays the Button when the condition is satisfied.

Data Type: Selects the type of data handled by the conditional expression for the visible condition.
This option can only be configured if While satisfying the condition is selected for Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Device Address: Specifies the bit device or the bit number of the word device to serve as the visible condition.
This option can only be configured when While ON or While OFF is selected for Trigger Type.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 
“5.1 Device Address Settings” on page 2-68.

Condition: Specifies the conditional expression for the visible condition.
This option can only be configured when While satisfying the condition is selected for Trigger 
Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expression 
configuration procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-71.

Comment: Used for entering a comment for the visible condition. The maximum number is 80 characters.

Always show

Button state

1

0

Hide Show Hide HideShow Show

Value of
device address

Button state

1

0

Value of
device address

Show Show ShowHide Hide Hide

Button state

Hide Hide HideShow Show Show

Satisfied

Not satisfied

Condition

Button state
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● Options Tab
The Options tab is displayed in Advanced mode.

■ ON delay
Select this check box to use the ON delay function.

■ No Touch Sound
This function is to disable touch sounds only for specified parts when the MICRO/I makes touch sounds.
Select this check box to display disable touch sounds for this part.

■ Place on the Top Layer
Select this check box to display the parts on the top layer. The parts will have precedence when other drawings and 
parts are overlapping with it. For details, refer to Chapter 6 “4 Drawings and Parts Overlapping” on page 6-5.

Time (x100 msec): Specify the length of time that the button must be held down before activation by selecting a 
value from 0 to 600 (units of 10 ms).
The button activates after it is held down for a specified period of time.

Hold down for 3 secs.

MICRO/I MICRO/I

Button
Does not
operate

Button
Operates

This feature protects against mistaken operation by ensuring that the button will not be activated if touched 
accidentally.

To enable touch sounds on the MICRO/I, select the Enable Touch Sound check box under the System 
tab of the Project Settings dialog box.
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● Security Tab
This tab is used to restrict displaying and using the part by security groups.
This option can only be set when Use Security functions is selected. The Use Security functions check box is set 
on General tab in the Security dialog box.

■ (Settings)
Displays the list of security groups used on the MICRO/I.

■ Security Settings
The Security Settings dialog box is displayed. If you create a security group in the Security Settings dialog box, you 
can select that created group. For details, refer to Chapter 23 “2.2 Adding and Editing Security Groups” on page 23-
19.

(Settings)

No.: Displays the security group numbers (0 to 15).

Group Name: Displays the name of the security group.

Display: Displays whether or not there is permission to display the part. Only Permitted security groups 
can display this part. If all security groups are set to Permitted, this part will be displayed even 
if no user account has been selected. Double clicking the cell switches between Permitted and 
Prohibited.

Input: Displays whether or not there is permission to use the part. Only Permitted security groups 
can use this part. If all security groups are set to Permitted, this part can be used even if no 
user account has been selected. Double clicking the cell switches between Permitted and 
Prohibited.

• You can also switch between Permitted and Prohibited by right-clicking on a Display or Input cell.
• Restricting the display and use of the part by switching between Permitted and Prohibited in Display 

and Input cells is similar to using the Trigger Condition tab.

For details about security functions, refer to Chapter 23 “User Accounts and the Security Function” on page 
23-1.
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Example: If the user and security group for a part are set as follows:

For User1 in the Reader security group, the parts for which Display has been set to Prohibited for Reader will not 
be displayed.
If the password screen is opened and the user switches to User2 in the Operator security group, the parts for which 
Display has been set to Permitted for Operator will be displayed.

For User2 in Operator, Display has been set to Permitted for Operator, but Input is Prohibited, so the part 
cannot be used.
If the password screen is opened and the user switches to User3 in the Administrator security group, the parts for 
which Display has been set to Permitted for Administrator will be displayed, and the parts for which Input has 
been set to Permitted for Administrator can be used.

User Name

Security Group Reader Operator Administrator
User1 User2 User3

MICRO/I

130

Numerical Display
No. Group Name Display

1 Administrator Permitted

2 Operator Permitted

3 Reader Permitted

Button
No. Group Name Display Input

1 Administrator Permitted Permitted

2 Operator Permitted Prohibited

3 Reader Prohibited Prohibited

Line Chart and Bar Chart
No. Group Name Display

1 Administrator Permitted

2 Operator Permitted

3 Reader Prohibited

Open Password Screen, 
enter password, 
and switch to User2

For User1, 
parts for which Display 
has been set to Prohibited 
for Reader are not displayed

For User2, 
parts for which Display 
has been set to Permitted 
for Operator are displayed

MICRO/I

130

MICRO/I MICRO/I

130

User1 User2

130
CAN

User Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password

Open Password Screen, 
enter password, 
and switch to User3

For User2, 
parts for which Display 
has been set to Permitted 
for Operator are displayed, 
but parts for which Input 
has been set to Prohibited cannot be used

For User3, 
parts for which Display 
has been set to Permitted 
for Administrator are displayed, 
and parts for which Input 
has been set to Permitted can be used

MICRO/I

130

MICRO/I MICRO/I

130130 130

User2 User3

Button
Can operate

CAN

User Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password

Button
Cannot operate
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● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Used for entering comments about parts. The maximum number is 80 characters.
Example: When mousing over the Button on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.
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5.1 How the Key Button is Used

Performs a variety of functions including uploading and downloading, copying files, and operating other parts.

• Entering numbers in the Numerical Input

• Entering characters in the Character Input

• Operating the Alarm List Display or Alarm Log Display

5 Key Button

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

1230

MICRO/I

MICRO/I

Show focus Move focus

Key Bu�on

Display reference screen

Time

09:15   Motor fault

Message

10:02   Pump1 fault

REV

Up

Dwn

Del

Ref.

10:28   High pressure

13:02   Pump 1 fault

Time

09:15   Motor fault

Message

10:02   Pump1 fault

REV

Up

Dwn

Del

Ref.

10:28   High pressure

13:02   Pump 1 fault

Time

09:15   Motor fault

Message

10:02   Pump1 fault

REV

Up

Dwn

Del

Ref.

10:28   High pressure

13:02   Pump 1 fault

Time

09:15   Motor fault

Message

10:02   Pump1 fault

REV

Up

Dwn

Del

Ref.

10:28   High pressure

13:02   Pump 1 fault

Pump 1 faultPump 1 fault
Pump 1 output low

Stop Start

Press Stop, check the air, 
then press Start.

Air Press.

kg/m2
0000

Reference screen
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• Copying and recovering data archived on the SD memory card, inserted in the MICRO/I, to the USB flash drive.

• Operating the Video Display*1

• Record images from a video camera and microphone audio*4 to an external memory device*1

*1 This is applicable for models with a video interface only.
*2 HG5G/4G/3G-V only
*3 HG4G/3G only
*4 Recording sound function is for HG4G/3G only

MICRO/I

Copy files

USB flash drive

SD memory card

HG3G HG2G-5FHG4G
HG5G-V HG4G-V HG3G-V HG2G-V

MICRO/I

Play

Play Stop Back Next

SD memory card

Movie Files
(AVI format)
(MP4 format)

Movie File List
(movie.lst)

HG4G HG3G
HG5G-V HG4G-V HG3G-V *2

*3

Video Camera

Microphone

Images

Audio

Saves

MICRO/I

Recording

SD memory card

Movie Files
(AVI format)
(MP4 format)

HG4G HG3G
HG5G-V HG4G-V HG3G-V

*2
*3

*4
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5.2 Key Button Configuration Procedure

This section describes the configuration procedure for Key Buttons.

1 On the Home tab, in the Parts group, click Buttons, and then click Key Button.

2 Click a point on the edit screen where you wish to place the Key Button.

3 Double-click the dropped Key Button and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.

The Trigger Condition tab and Options tab only appear in Advanced mode.
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5.3 Properties of Key Button Dialog Box

This section describes items and buttons on the properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ >>OFF Text, >>ON Text
Applies the text entered in the Part Name field to the Text field under the OFF or ON fields on the Registration 
Text tab. This is used as the Registration Text when the button is OFF or ON.

■ Key Type
Select the function for the Key Button.

The settings explained below appear depending on the type of key selected.

Displays settings 
applicable to the 
selected key.

(Key)

To specify the Registration Text to use when the button is ON, select the Set by State check box on the 
Registration Text tab. If left unchecked, the same Registration Text assigned for the OFF state is 
displayed for the ON state as well.

Language: Switches the display of the key that is displayed when Keypad is selected in Key Browser. These 
languages are available:
Japanese, European, Central European, Baltic, Cyrillic.

Browse: Opens the Key Browser when clicked. Select a key.
For details, refer to “5.5 Key Browser” on page 8-98.

(Key): Displays the name of the key selected using the Key Browser.

• When you select a key, the label for that key is assigned as the Registration Text.
• The function of Key Button will affect on the next scan when the trigger condition is satisfied.
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■ Popup Screen Number
The Alt key switches the current Popup Screen used as a Keypad when this button is pressed.
Specify the Popup Screen number to open a Keypad for.
This setting is enabled only if Alt was selected using the Key Browser.

■ Scroll Size
Key Buttons Page Up and Page Down scroll the list up and down, respectively. Key Buttons Up and Down move 
the focus up and down, respectively. This settings specifies the number of pages or lines (1 to 1023 lines) to scroll or 
move the focus per each press of the button.
This setting is enabled only if Page Up, Page Down, Up, and Down are selected using the Key Browser.

■ Transfer Setting
Key Buttons Download Project, Upload Project, Copy Files, Download PLC Program, and Upload PLC 
Program, perform the data transfer function specified by their names. These settings specify the source, data to be 
transferred, and destination.
This setting is enabled only if one of these keys is selected after clicking Data Transfer in the Key Browser.

If Download Project is selected.

*1 HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F only

Source: Select the the external memory where the project (ZNV Project File) to be transferred is stored: SD 
Memory Card*1 or USB Flash Drive.

Location: Specify the location of the ZNV Project File (.znv). The maximum number is 247 characters.
Example: “HG3G_DEMO_1.ZNV” is a ZNV Project File saved on the root directory of an SD 

memory card or USB flash drive: 
HG3G_DEMO_1.ZNV

Destination:

Clear Keep Devices:

Select this check box to clear keep devices after the project data is downloaded. However, 
when project data that changes the system software or settings of the data storage area is 
downloaded, the keep devices are always cleared.

When project data is downloaded, the alarm log data, data log data, and operation log data is deleted 
regardless of the state of the Clear Keep Devices check box.
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If Upload Project is selected.

If Copy Files*1 is selected.

*1 HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F only

Destination: Specify where to save the project uploaded from MICRO/I. Select the location:

SD Memory Card*1 or USB Flash Drive.

Location: Specify the location where the uploaded project will be saved. The maximum number is 
247 characters.
Example: To save it to the folder “Uploaded_Project” on an SD memory card or USB flash 

drive: 
Uploaded_Project

A uploaded project using the Data Transfer function is saved as a ZNV Project File(.znv).

Source: Select the source external memory: SD Memory Card or USB Flash Drive.
Location: Specify the location of the file to be transferred. The maximum number is 247 characters.

Example: Copy a file “Error.wav” to the root directory of an SD memory card or USB flash 
drive:
Error.wav

Destination: Select the destination external memory: SD Memory Card or USB Flash Drive.
Location: Specify the location where the file will be transferred. The maximum number is 247 

characters.
Example: Save it to the “SOUND” folder under “HGDATA01” folder on an SD memory card 

or USB flash drive:
HGDATA01 SOUND\

• If a file name is specified as the source location, the specified file is copied.
If a folder name is specified, all of the files and subfolders contained in the folder, and all of the files in 
the subfolders, are copied.

• The subfolders can be copied up to five levels.
• To prevent copying the subfolders and the files contained in the subfolders, HMI Special Internal Relay 

LSM30 must be set to 1 before executing the copy.
• To stop copying files during the copy operation, write 1 to HMI Special Internal Relay LSM31. However, it 

will continue to copy the file until it is finished then it will stop copying.
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If Download PLC Program is selected.

*1 HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F only

Source: Select the the external memory where the PLC program (ZLD Project File) to be transferred is stored: SD 
Memory Card*1 or USB Flash Drive.
Location: Specify the location of the ZLD Project File(.zld). The maximum number is 247 

characters.
Example: “LDR_PROGRAM.ZLD” is a ZLD Project File saved in folder “LDRDATA” of an 

SD memory card or USB flash drive:
LDRDATA\LDR_PROGRAM.ZLD

Destination: Specify the destination PLC connected to the MICRO/I. The PLC type is configured in the Project 
Settings dialog box, on the Communication Driver Network tab. For details, refer to Chapter 4 “3.4 
Communication Driver Network Tab” on page 4-50.
Interface: Select the communication interface in which the MICRO/I is connecting to the 

download destination PLC from serial interface or Ethernet. For details, refer to 
Chapter 4 “Interface Configuration” on page 4-35.

If serial interface is selected for Interface.
Slave Number: Specify the slave number of the download destination PLC (0 to 31).
External Device Name: The name of the specified PLC is displayed here.

If Ethernet is selected for Interface.
Select from the following method:

Specify External Device ID: Specify the External Device ID (0 to 31) of the destination PLC. This is the 
External Device ID number set in the Project Settings dialog box, on the 
Communication Driver Network tab.

External Device Name: The name of the specified PLC is displayed here.
Specify IP Address: Specify the IP address and port number of the destination PLC.
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If Upload PLC Program is selected.

*1 HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F only

Source: Specify the source PLC connected to the MICRO/I. The PLC type is configured in the Project Settings 
dialog box, on the Communication Driver Network tab. For details, refer to Chapter 4 “3.4 
Communication Driver Network Tab” on page 4-50.
Interface: Select the communication interface in which the MICRO/I is connecting to 

the upload source PLC from serial interface or Ethernet.  For details, refer 
to Chapter 4 “Interface Configuration” on page 4-35.

If serial interface is selected for Interface.
Slave Number: Specify the slave number of the upload source PLC (0 to 31).
External Device Name: The name of the specified PLC is displayed here.

If Ethernet is selected for Interface.
Select from the following method:

Specify External Device ID: Specify the External Device ID (0 to 31) of the upload source PLC. This is 
the External Device ID number set in the Project Settings dialog box, on 
the Communication Driver Network tab.

External Device Name: The name of the specified PLC is displayed here.
Specify IP Address: Specify the IP address and port number of the upload source PLC.

Destination: Specify where to save the PLC program uploaded from the PLC connected to the MICRO/I. Select the 
type of external memory: SD Memory Card*1 or USB Flash Drive.
Location: Specify the location of the folder where the uploaded PLC program will be 

saved. The maximum number is 247 characters.
Example:To save it to the folder “Uploaded_Program” on an SD memory 
card or USB flash drive: 
Uploaded_Program

A uploaded PLC program using the Data Transfer function is saved as a ZLD Project File(.zld).
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■ Recording Channel*2

The recording of images starts.
Selects Channel 1 or Channel 2 to record a video only (no audio) out of the signals input from the device. This 
setting is enabled only if Rec. was selected using the Key Browser.

■ Recording Target*3

The recording of images and sound starts. 
Select the target to record out of the signals input from the device. This setting is enabled only if Rec. was selected 
using the Key Browser.

*2 HG5G/4G/3G-V only
*3 This is applicable for HG4G/3G with a video interface only.

• Movie files cannot be recorded during playback.
• While data is being recorded after an event occurs with the event recording function and while data is 

being saved to the external memory device, recording cannot be executed with a Key Button, Multi-
Button, or Multi-Command configured with the recording function. Also, during these situations, the 
value of HMI Special Data Register LSD155-0 changes to 1. For details, refer to Chapter 33 “HMI Special 
Data Register (LSD)” on page 33-7.

Video and Audio: Records images and sound.

Video only (No Audio): Records images only.

• Movie files cannot be recorded during playback.
• While data is being recorded after an event occurs with the event recording function and while data is 

being saved to the external memory device, recording cannot be executed with a Key Button, Multi-
Button, or Multi-Command configured with the recording function. Also, during these situations, the 
value of HMI Special Data Register LSD155-0 changes to 1. For details, refer to Chapter 33 “HMI Special 
Data Register (LSD)” on page 33-7.
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■ View Switching Method*4

Select how to display the ON/OFF status of the button.

*4 Advanced mode only

Button: Pressing the button changes the drawing object displayed.

Device Address: The drawing objects assigned to the OFF and ON states are displayed when the value of the device 
address is 0 and 1, respectively. Specifies the device address used to switch the drawing object 
display.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 
“5.1 Device Address Settings” on page 2-68.

No Image: The button is not displayed on the screen. The button appears as a dashed line frame on the edit 
screen. Pressing the corresponding area on the MICRO/I activates the assigned function. If No 
Image is selected, the settings for View and Registration Text are disabled.

Selecting Device Address in View Switching Method allows you to create an illuminated pushbutton.
The illuminated pushbutton switches state (or image) according to ON or OFF state of the device address, 
allowing you to display the state of a device that is being operated.

Example: When you set an external device address 'M0' as Device Address in View Switching Method, 
if the value of M0 changes, the display image will switched according to the value of M0 even if 
the button is not pressed.

0

M0

1

M0

MICRO/I External device

View Switching Method (Device Address): M0 

OFF image:

ON image:
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● View Tab
Only Coordinates and Size can be configured when No Image is selected for View Switching Method on the 
General tab.

■ Image Type
Select the type of graphic to be used to represent the part.

■ Browse
Select the type of graphic to be used to represent the part from the list of graphics. Click this button to display the 
View Browser or Picture Manager, depending on the setting for Image Type.

■ OFF button, ON button
Displays the graphic when ON or OFF. Clicking ON or OFF switches the image displayed on the View tab.

■ OFF, ON
Selects the color and pattern of the standard graphic when ON and OFF.

Standard: Uses the default graphic for WindO/I-NV4.

Picture: Uses an image file saved using Picture Manager.
For details about image file restrictions, refer to Chapter 2 “1.4 Available Image Files” on page 2-20.

Foreground Color, Background Color: Selects the foreground and background colors of the standard graphic (color: 
256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

Pattern: Selects a pattern or tonal gradation for the standard graphic.
Click Pattern to display the Pattern Palette. Select a pattern or tonal gradation from the Pattern Palette.
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■ Flash
Select this check box if flashing is desired (alternating ON and OFF) when a part is ON.

■ Coordinates

■ Size

Flash

ON image

OFF image

X, Y: Sets the display position of parts using coordinates.
The X and Y coordinates of parts are defined relative to an origin at the top-left corner of the screen.

X: 0 to (base screen horizontal size - 1)

Y: 0 to (base screen vertical size - 1)

(0, 0)
X

Y
Screen

Parts

W, H: Sets width and height to define the size of parts.

W: 20 to (base screen horizontal size)

H: 20 to (base screen vertical size)

Width

Height

Screen

Parts
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● Registration Text Tab
These options can only be configured when Button or Device Address is selected for View Switching Method on 
the General tab.

■ Font
Selects the font used for displaying text from the following.
Japanese, European, Chinese, Taiwanese, Korean, Central European, Baltic, Cyrillic, Windows, Stroke
Can only be set when the Use Text Manager check box is cleared.
The characters that can be displayed depend on the font. For details, refer to Chapter 2 “1.2 Available Text” on page 2-6.

■ Size
Sets the character size (8 to 128).
Can only be set when Stroke is selected.

■ Style
Selects Regular or Bold for text style.
Can only be set when Font is set to Japanese, European, Chinese, Taiwanese, Korean, Central European, 
Baltic or Cyrillic.

■ Magnification

Can only be set when Font is set to Japanese, European, Chinese, Taiwanese, Korean, Central European, 
Baltic or Cyrillic.

■ Align Text Horizontal
Selects text alignment in the horizontal direction.
Left, Center, Right, Center-Left
For details, refer to Appendix “5 Text Alignment” on page A-7.

■ Align Text Vertical
Selects text alignment in the vertical direction.
Top, Center, Bottom
This option can only be configured when Left, Center, or Right is selected for Align Text Horizontal. If Center-
Left is selected for Align Text Horizontal, Center-Top is set as this option.
For details, refer to Appendix “5 Text Alignment” on page A-7.

■ Set by State
Select this check box if displaying different text when ON and OFF.

■ Use Text Manager
Select this check box if using the text registered in Text Manager for text display.

W, H: Selects the magnification (0.5, 1 to 8) for text display.



WindO/I-NV4 User’s Manual 8-85

5 Key Button

8

Buttons

■ OFF, ON

Text: Inputs characters to be displayed on parts. The maximum number is 3,750 characters.
The characters that can be entered depend on the font selected using Font. For details, refer to 
Chapter 2 “1.2 Available Text” on page 2-6.

Text ID: Specifies the Text Manager ID No. (1 to 32000) when using the text registered in the Text Manager.

Click  to display Text Manager.

Can only be set when the Use Text Manager check box is selected.

Text Color: Selects the color of the text displayed on the part (color: 256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

Windows Font: Sets the font to be used as the Windows Font.
Select Windows using Font to display the current setting. You can specify the character spacing (0 
to 100) and the line spacing (0 to 100). To change the settings other than the character spacing and 
line spacing, click Change to display the Font Settings dialog box.
Can only be set when the Use Text Manager check box is cleared.
For details, refer to Chapter 2 “Windows Font” on page 2-13.
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● Trigger Condition Tab
The Trigger Condition tab is displayed in Advanced mode.

■ Input Condition
The Button is enabled and operational while the condition is satisfied. The Button is disabled and not operational 
while the condition is not satisfied.
Example: When Trigger Type is While ON and Device Address is LM0

While LM0 is 0, the condition is not satisfied and the Button is not operational.
While LM0 is 1, the condition is satisfied and the Button is operational.

Trigger Type: Selects the condition to enable the Button from the following.

Always enable: The Button is always enabled.

While ON: Enables the Button when the value of device address is 1.

LM0:

MICRO/I

0

LM0: 1

Button
Does not
operate

Button
Operates

Condition 
Not 

satisfied

Condition 
Satisfied

Always enabled

Button state

1

0

Disabled Enabled Disabled DisabledEnabled Enabled

Value of
device address

Button state
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■ Visible Condition
The Button is displayed while the condition is satisfied. The Button is hidden while the condition is not satisfied.
Example: When Trigger Type is While ON and Device Address is LM0

While LM0 is 0, the condition is not satisfied and the Button is hidden.
While LM0 is 1, the condition is satisfied and the Button is displayed.

While OFF: Enables the Button when the value of device address is 0.

While satisfying the condition: Enables the Button when the condition is satisfied.

Data Type: Selects the type of data handled by the conditional expression for the input condition.
This option can only be configured if While satisfying the condition is selected for Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Device Address: Specifies the bit device or the bit number of the word device to serve as the input condition.
This option can only be configured when While ON or While OFF is selected for Trigger Type.
Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 
“5.1 Device Address Settings” on page 2-68.

Condition: Specifies the conditional expression for the input condition.
This option can only be configured when While satisfying the condition is selected for Trigger 
Type.
Click  to display the Trigger Condition Settings dialog box. For the conditional expression 
configuration procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-71.

Comment: Used for entering a comment for the input condition. The maximum number is 80 characters.

1

0

Enabled Enabled EnabledDisabled Disabled Disabled

Value of
device address

Button state

Satisfied

Not satisfied

Disabled Disabled DisabledEnabled Enabled Enabled

Condition

Button 
state

LM0:

MICRO/I

0

LM0: 1
Show

Condition 
Not 

satisfied

Condition 
Satisfied

Hide

• When Alternate is selected for Action Mode on the General tab, the button remains on when hidden 
in the on state.

• When the ON delay check box is selected on the Options tab, if the button is hidden before the set time 
elapses from when the button begins to be pressed, the on delay is reset and the button does not 
operate.
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Trigger Type: Selects the condition to display the Button from the following.

Always visible: The Button is always displayed.

While ON: Displays the Button when the value of device address is 1.

While OFF: Displays the Button when the value of device address is 0.

While satisfying the condition: Displays the Button when the condition is satisfied.

Data Type: Selects the type of data handled by the conditional expression for the visible condition.
This option can only be configured if While satisfying the condition is selected for Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Device Address: Specifies the bit device or the bit number of the word device to serve as the visible condition.
This option can only be configured when While ON or While OFF is selected for Trigger Type.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 
“5.1 Device Address Settings” on page 2-68.

Condition: Specifies the conditional expression for the visible condition.
This option can only be configured when While satisfying the condition is selected for Trigger 
Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expression 
configuration procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-71.

Comment: Used for entering a comment for the visible condition. The maximum number is 80 characters.

Always show

Button state

1

0

Hide Show Hide HideShow Show

Value of
device address

Button state

1

0

Value of
device address

Show Show ShowHide Hide Hide

Button state

Hide Hide HideShow Show Show

Satisfied

Not satisfied

Condition

Button state
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● Options Tab
The Options tab is displayed in Advanced mode.

■ ON delay
Select this check box to use the ON delay function.

■ No Touch Sound
This function is to disable touch sounds only for specified parts when the MICRO/I makes touch sounds.
Select this check box to display disable touch sounds for this part.

■ Place on the Top Layer
Select this check box to display the parts on the top layer. The parts will have precedence when other drawings and 
parts are overlapping with it. For details, refer to Chapter 6 “4 Drawings and Parts Overlapping” on page 6-5.

Time (x100 msec): Specify the length of time that the button must be held down before activation by selecting a 
value from 0 to 600 (units of 10 ms).
The button activates after it is held down for a specified period of time.

Hold down for 3 secs.

MICRO/I MICRO/I

Button
Does not
operate

Button
Operates

This feature protects against mistaken operation by ensuring that the button will not be activated if touched 
accidentally.

To enable touch sounds on the MICRO/I, select the Enable Touch Sound check box under the System 
tab of the Project Settings dialog box.
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● Security Tab
This tab is used to restrict displaying and using the part by security groups.
This option can only be set when Use Security functions is selected. The Use Security functions check box is set 
on General tab in the Security dialog box.

■ (Settings)
Displays the list of security groups used on the MICRO/I.

■ Security Settings
The Security Settings dialog box is displayed. If you create a security group in the Security Settings dialog box, you 
can select that created group. For details, refer to Chapter 23 “2.2 Adding and Editing Security Groups” on page 23-
19.

(Settings)

No.: Displays the security group numbers (0 to 15).

Group Name: Displays the name of the security group.

Display: Displays whether or not there is permission to display the part. Only Permitted security groups 
can display this part. If all security groups are set to Permitted, this part will be displayed even 
if no user account has been selected. Double clicking the cell switches between Permitted and 
Prohibited.

Input: Displays whether or not there is permission to use the part. Only Permitted security groups 
can use this part. If all security groups are set to Permitted, this part can be used even if no 
user account has been selected. Double clicking the cell switches between Permitted and 
Prohibited.

• You can also switch between Permitted and Prohibited by right-clicking on a Display or Input cell.
• Restricting the display and use of the part by switching between Permitted and Prohibited in Display 

and Input cells is similar to using the Trigger Condition tab.

For details about security functions, refer to Chapter 23 “User Accounts and the Security Function” on page 
23-1.
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Example: If the user and security group for a part are set as follows:

For User1 in the Reader security group, the parts for which Display has been set to Prohibited for Reader will not 
be displayed.
If the password screen is opened and the user switches to User2 in the Operator security group, the parts for which 
Display has been set to Permitted for Operator will be displayed.

For User2 in Operator, Display has been set to Permitted for Operator, but Input is Prohibited, so the part 
cannot be used.
If the password screen is opened and the user switches to User3 in the Administrator security group, the parts for 
which Display has been set to Permitted for Administrator will be displayed, and the parts for which Input has 
been set to Permitted for Administrator can be used.

User Name

Security Group Reader Operator Administrator
User1 User2 User3

MICRO/I

130

Numerical Display
No. Group Name Display

1 Administrator Permitted

2 Operator Permitted

3 Reader Permitted

Button
No. Group Name Display Input

1 Administrator Permitted Permitted

2 Operator Permitted Prohibited

3 Reader Prohibited Prohibited

Line Chart and Bar Chart
No. Group Name Display

1 Administrator Permitted

2 Operator Permitted

3 Reader Prohibited

Open Password Screen, 
enter password, 
and switch to User2

For User1, 
parts for which Display 
has been set to Prohibited 
for Reader are not displayed

For User2, 
parts for which Display 
has been set to Permitted 
for Operator are displayed

MICRO/I

130

MICRO/I MICRO/I

130

User1 User2

130
CAN

User Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password

Open Password Screen, 
enter password, 
and switch to User3

For User2, 
parts for which Display 
has been set to Permitted 
for Operator are displayed, 
but parts for which Input 
has been set to Prohibited cannot be used

For User3, 
parts for which Display 
has been set to Permitted 
for Administrator are displayed, 
and parts for which Input 
has been set to Permitted can be used

MICRO/I

130

MICRO/I MICRO/I

130130 130

User2 User3

Button
Can operate

CAN

User Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password

Button
Cannot operate
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● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Used for entering comments about parts. The maximum number is 80 characters.
Example: When mousing over the Button on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.
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5.4 Key Buttons

● For Keypad(Half-Width Character)
These keys can be used for Numerical Input and Character Input:

■ Numerical Input Keypad

■ Character Input Keypad

Key Operation

. Inputs a decimal point.

0 to 9 Inputs a number from 0 to 9.

A to F Inputs a character from A to F.

+/- Toggles the sign.

CAN
Clears the data input thus far and cancels the input. Closes the Popup Screen that is opened as 
the Keypad, if this key is placed on it.

CLR Clears the data input thus far and stands by for further input.

BS Deletes the character to the left of the character at the cursor position. 

ENT
Writes the characters input as a numeric value to a device address. After the data is written, the 
focus can be moved according to the Focus Order setting. Focus Order can be set on the 
Options tab of the Screen Properties dialog box.

< Fcs.
Moves the focus one item before the current one as per the Focus Order setting. Focus 
Order can be set on the Options tab of the Screen Properties dialog box.

Fcs. >
Moves the focus one item after the current one as per the Focus Order setting. Focus Order 
can be set on the Options tab of the Screen Properties dialog box.

Alt
The Alt key switches the Popup Screen opened as a Keypad. Closes the Popup Screen that is 
opened as the Keypad and opens another Popup Screen as the Keypad.

The Alt key can be used, for instance, to switch between a decimal and a hexadecimal Keypad.

Key Operation

! Inputs a !.

" Inputs a ".

# Inputs a #.

$ Inputs a $.

% Inputs a %.

&. Inputs a &.

' Inputs a '.

( Inputs a (.

) Inputs a ).

* Inputs a *.

+ Inputs a +.

, Inputs a ,.

- Inputs a -.

. Inputs a .

/ Inputs a /.

0 to 9 Inputs a number from 0 to 9.

: Inputs a :.

; Inputs a ;.

< Inputs a <.

= Inputs a =.
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> Inputs a >.

? Inputs a ?.

@ Inputs a @.

A to Z Inputs a character from A to Z.

[ Inputs a [.

\ Inputs a \.

] Inputs a ].

^ Inputs a ^.

_ Inputs a _.

' Inputs a '.

a to z Inputs a character from a to z.

{ Inputs a {.

| Inputs a |.

} Inputs a }.

˜ Inputs a ˜.

(Keys dependent on 
Language setting)

Inputs the text displayed according to the language selected in the Language setting. For a list 
of the characters input using these keys, refer to Chapter 2 “1.2 Available Text” on page 2-6.

CAN
Clears the data input thus far and cancels the input. Closes the Popup Screen if it is opened as 
a Keypad.

CLR Clears the data input thus far and stands by for further input.

DEL Deletes the character at the cursor.

BS Deletes the character to the left the cursor.

ENT
Writes the text input in ASCII code form to a device address. After the data is written, the focus 
can be moved according to the Focus Order setting. Focus Order can be set on the Options 
tab of the Screen Properties dialog box.

SP Inputs a space.

Cur. > Moves the cursor right.

< Cur. Moves the cursor left.

< Fcs.
Moves the focus one item before the current one as per the Focus Order setting. Focus 
Order can be set on the Options tab of the Screen Properties dialog box.

Fcs. >
Moves the focus one item after the current one as per the Focus Order setting. Focus Order 
can be set on the Options tab of the Screen Properties dialog box.

Alt
The Alt key switches the Popup Screen opened as a Keypad. Closes the Popup Screen that is 
opened as the Keypad and opens another Popup Screen as the Keypad.

Key Operation

• Press and hold the < Cur. and Cur. > keys for more than one second to cause it to move repeatedly.
• The Alt key can be used, for instance, to switch between Keypads for lower case and upper case letters.
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● For Keypad(Hiragana)*1

These keys to enter Hiragana and Kanji which can be used for Character Input are as follows.

■ Character Input Keypad

*1 HG5G/4G/3G/2G-V only

Key Operation

あ  to ん Inputs a character from あ  to ん .

、 Inputs a 、 .

。 Inputs a 。 .

ー Inputs a ー .

small ゛ ゜
Change the hiragana that you entered in order of lower case conversion, voiced sound input, 
semi - voiced sound input.

Kanji
Toggles the Direct input mode and Kanji input mode. The default is the Direct input mode.
Direct input mode: Enter a Hiragana.
Kanji input mode: Enter the Kanji that converted the input Hiragana as a reading of Kanji.

Up When displaying conversion candidates for Kanji, select the conversion candidate one before.

Down When displaying conversion candidates for Kanji, select the next conversion candidate.

CAN
Clears the data input thus far and cancels the input. Closes the Popup Screen if it is opened as 
a Keypad.

CLR Clears the data input thus far and stands by for further input.

DEL Deletes the character at the cursor.

BS Deletes the character to the left the cursor.

ENT

Writes the text input in character code form to a device address. After the data is written, the 
focus can be moved according to the Focus Order setting. Focus Order can be set on the 
Options tab of the Screen Properties dialog box.
When displaying conversion candidates for Kanji in Kanji input mode, input the selected Kanji.

SP
Inputs a space.
When reading is entered in Kanji input mode, conversion candidates for Kanji are displayed.

Cur. >
Moves the cursor right.
However, you can not move the cursor when entering characters in Kanji input mode and 
waiting for conversion.

< Cur.
Moves the cursor left.
However, you can not move the cursor when entering characters in Kanji input mode and 
waiting for conversion.

< Fcs.
Moves the focus one item before the current one as per the Focus Order setting. Focus 
Order can be set on the Options tab of the Screen Properties dialog box.

Fcs. >
Moves the focus one item after the current one as per the Focus Order setting. Focus Order 
can be set on the Options tab of the Screen Properties dialog box.

Alt
The Alt key switches the Popup Screen opened as a Keypad. Closes the Popup Screen that is 
opened as the Keypad and opens another Popup Screen as the Keypad.

Press and hold the < Cur. and Cur. > keys for more than one second to cause it to move repeatedly.
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● For Data Transfer Keys
These keys can be used to execute Data Transfer functions. For details about Data Transfer functions, refer to Chapter 
29 “Data Transfer Function” on page 29-1.

● For Alarm Displays
These keys can be used for the Alarm List Display and Alarm Log Display parts.

■ Alarm List Display

■ Alarm Log Display

*1 HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F only
*2 SD memory card for HG5G/4G/3G/2G-V, HG4G/3G and HG2G-5F, USB flash drive for HG2G-5T and HG1G/1P

Key Operation

Download Project Downloads a project (ZNV Project File) saved on an external memory device*2 to the MICRO/I.

Upload Project
Uploads the project used for operation on the MICRO/I and saves the ZNV Project File(.znv) to 

an external memory device*2.

Copy Files*1 Copies files between the SD memory card and USB flash drive inserted in the MICRO/I.
Copy Files can also be used to copy files within the SD memory card or USB flash drive.

Download PLC Program Downloads a PLC program (ZLD Project File) saved on an external memory device*2 to a PLC 
connected to the MICRO/I.

Upload PLC Program
Uploads a PLC program from the PLC connected to the MICRO/I and saves the ZLD Project 

File(.zld) to an external memory device*2

Key Operation

Page Up Scrolls up the number of lines (1 to 1023) specified in Scroll Size.

Page Down Scrolls down the number of lines (1 to 1023) specified in Scroll Size.

Up
Moves the focus the number of lines (1 to 1023) specified in Scroll Size. The current point of 
focus can be shown by pressing Select.

Down
Moves the focus the number of lines (1 to 1023) specified in Scroll Size. The current point of 
focus can be shown by pressing Select.

Select Toggles the focus between show and hide.

Reference The reference screen appears.

Press and hold the Page Up, Page Down, < Cur., and Cur. > keys for more than one second to move the 
focus repeatedly.

Key Operation

Up
Moves the focus the number of lines (1 to 1023) specified in Scroll Size. The current point of 
focus can be shown by pressing Select.

Down
Moves the focus the number of lines (1 to 1023) specified in Scroll Size. The current point of 
focus can be shown by pressing Select.

Select Toggles the focus between show and hide.

Check Shows the date and time the alarm that has focus was confirmed.

All Check Shows the date and time that all alarms were confirmed.

Delete Clears the alarm that has focus.

Delete All Clears all alarms.

Reference Shows the reference screen for the alarm that has focus.

Stop Buzzer and Screen 
Flashing

Stops the sound of the buzzer and screen flashing when an alarm occurs.

Press and hold the Up and Down keys for more than one second to move the focus repeatedly.
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● For the Multimedia Function*1

■ Recording

■ Video Display
The keys that can be used with the Video Display are given below.

*1 This is applicable for models with a video interface only.
*2 Recording sound function is for HG4G/3G only

Key Operation

Stop Stops recording images and sound*2.

Rec. Records images and sound*2. 

Key Operation

Play Play movie file and display images from the video input.

Stop Stops movie file playback.

Pause Pauses playback of a movie file. 

Next When this button is pressed during playback, the next movie file is played.

Back When this button is pressed during playback, the previous movie file is played.

REW
When this button is pressed during playback, the movie file rewinds while being played. Press 
this button during rewind to return to normal playback. This button cannot be used during fast 
forward, slow, or when paused.

FF
When this button is pressed during playback, the movie file fast forwards while being played. 
Press this button during fast forward to return to normal playback. This button cannot be used 
during rewind, slow, or when paused.

Slow
Press this button for slow movie file playback. Press this button during slow playback to return 
to normal playback. This button cannot be used during fast forward, rewind, or when paused.

Frame Fwd
Press this button to play the movie file one frame at a time. After frame forward, the movie file 
is paused. This button cannot be used during fast forward, rewind, or slow playback.

Full Screen Expand the display image to the maximum size of the screen.

Restore Returns Full Screen to its original display.

Repeat ON
Repeats playback from the top of the list when the movie file list or playlist is played until the 
end.

Repeat OFF Stops playback after the movie file list or playlist is played until the end.
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5.5 Key Browser

Select the key using the Key Browser. The Key Browser closes when a key is selected. The name of the key is shown 
in Key Type. Settings that apply to the selected key are displayed.

Select the key type from the following uses:

Keypad(Half-Width Character), Keypad(Hiragana)*1, Data Transfer, Alarm Display, Multimedia 
Function*2

■ Keypad(Half-Width Character)
These buttons are used for Numerical Input and Character Input:

■ Keypad(Hiragana)*1

These buttons are used for Character Input to enter Hiragana and Kanji:

*1 HG5G/4G/3G/2G-V only
*2 This is applicable for models with a video interface only.

When you select a key, the label for that key is assigned as the Registration Text.



WindO/I-NV4 User’s Manual 8-99

5 Key Button

8

Buttons

■ Data Transfer
These buttons are used to execute Data Transfer functions.

■ Alarm Display
These buttons are used to manipulate the Alarm List Display and Alarm Log Display parts.
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■ Multimedia Function*2

These buttons are used to start and stop recording and to operate the Video Display.

*2 This is applicable for models with a video interface only.
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5.6 Key Button Usage Examples

● Recording Images and Sound

This section describes how to record using the Rec. and Stop key buttons.

Configuration Procedure

1 On the Home tab, in the Parts group, click Buttons, and then click Key Button.

2 Click a point on the edit screen where you wish to place the Key Button.

3 Double-click the dropped Key Button and a Properties dialog box will be displayed.

4 On the General tab, under Key Type, click Browse.

Key Browser is displayed.

*1 Recording sound function is for HG4G/3G only

*1

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P
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5 Select Multimedia Function and click Rec.

You are returned to the Properties of Key Button dialog box.

6 Select a recording channel*2 or a recording target*3.

■ Recording Channel*2

Selects Channel 1 or Channel 2 to record a video only (no audio) out of the signals input from the device. This 
setting is enabled only if Rec. was selected using the Key Browser.

■ Recording Target*3

In the signals input from the device, select Video and Audio or Video only (No Audio) as the recording target.

7 Click OK.

Close the Properties of Key Button dialog box.

8 Repeat steps 1 through 4.

*2 HG5G/4G/3G-V only
*3 This is applicable for HG4G/3G with a video interface only.
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9 Select Multimedia Function and click Stop.

You are returned to the Properties of Key Button dialog box.

10 Click OK.

Close the Properties of Key Button dialog box.
This concludes configuring the record function and key buttons.

Operating Procedure

The MICRO/I must be connected to a video camera and microphone*1.

1 Press the Rec. button.

The MICRO/I starts recording images and sound*1.

2 Press the Stop button.

The MICRO/I stops recording images and sound*1.

The recorded images and sound*1 are saved as a file*2 in the following folder on the external memory device.
\External Memory Device folder\RECORD\Year month day (format: YYYYMMDD)

The External Memory Device folder name is configured in the Project Settings dialog box. For details, refer to 
Chapter 31 “1.6 Setting the External Memory Device Folder” on page 31-15.
The “year month day” folder name is the date the file was recorded.
The file name for the recorded file is the time the file was saved.

*1 Recording sound function is for HG4G/3G only
*2 AVI format for HG5G/4G/3G-V, MP4 format for HG4G/3G

Recording stops when the maximum recording time (30 sec.) has elapsed, even if the Stop button is not 
pressed.

• Movie files cannot be recorded during playback.
• While data is being recorded after an event occurs with the event recording function and while recorded 

data is being saved to the external memory device, recording cannot be executed with a Key Button, 
Multi-Button, or Multi-Command configured with the recording function. Also, during these situations, 
the value of HMI Special Data Register LSD155-0 changes to 1. For details, refer to Chapter 33 “HMI 
Special Data Register (LSD)” on page 33-7.

The signal standard for the video camera connected to the MICRO/I is configured in the Multimedia 
Settings dialog box, on the Video Input tab. For details, refer to Chapter 22 “2.3 Configuring the Video 
Input” on page 22-11.
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● Playing Recorded Images and Sound

This section describes how to select a movie file to play with the Movie File Screen and play it on a Video Display.

Configuration Procedure

1 On the Home tab, in the Parts group, click Data Displays, and then click Video Display.

2 Click a point on the edit screen where you wish to place the Video Display.

3 Double-click the dropped Video Display and the Properties dialog box is displayed.

4 On the General tab, under Action, select Play a movie or recorded file from the File Screen.

This option selects and plays movie files using the File Screen.

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P
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5 Click OK.

The Properties of Video Display dialog box closes.

6 Create a button to open the screen to select a recorded images.
On the Home tab, in the Parts group, click Buttons, and then click Goto Screen Button.

7 Click a point on the edit screen where you wish to place the Goto Screen Button.

8 Double-click the dropped Goto Screen Button and a Properties dialog box will be displayed.

9 Select Open File Screen for Movie Files for Action Mode.
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10 Specify the display location in coordinates for the movie file screen to open above the base screen with Coordinates 
X, Y.

With the upper-left corner of the screen as the origin, the upper-left corner of the window is the X and Y coordinates.

11 Click OK.
Close the Properties of Goto Screen Button dialog box.
This concludes configuring playback of recorded images.

Operating Procedure

To play sound, the MICRO/I must be connected to speakers.
This section describes the example of playing the movie file “123000.avi” located in the “20110313” folder under the 
“RECORD” folder when the External Memory Device folder is “HGDATA01”.

1 Press the Goto Screen Button set to Open File Screen for Movie Files.

The File Screen is displayed.

2 Select the folder with the date of the recorded images.

Press  to select 20110313 and then press Select. 
The contents of the “20110313” folder will be displayed.

X: 0 to (base screen horizontal size - 1)

Y: 0 to (base screen vertical size - 1)

Movie files that meet the following specifications can be played with the MICRO/I:

HG5G/4G/3G-V: AVI file (.avi)

HG4G/3G: MP4 file (.mp4)

For details, refer to Chapter 2 “1.6 Available Movie Files” on page 2-37.

Restore RepeatON RepeatOFFFull

REW FF NextBack

Stop PlayPause

MICRO/I

Video DisplayPress the Goto Screen Button

Modified Date: 2011/3/13 13:00:30

Page No.: 1

File Screen
DRIVE: SD Card
\HGDATA01\RECORD

Update Page Up Page Down Select

File name Size
Folder20110312
Folder20110313
Folder20110314
Folder20110315

Folder Up

1 2

Once the File Screen is opened, the “RECORD” folder in the External Memory Device folder will be displayed. 
If the “RECORD” folder does not exist, the External Memory Device folder will be displayed.
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3 Select a movie file.

Press  to select “123000.avi” and then press Select.
The movie file will be selected and the File Screen will close. 

4 Press Play on the Video Display.

The movie file is played.

123000.avi

Modified Date: 2011/3/13 13:00:30

Page No.: 1

File Screen
DRIVE: SD Card
\HGDATA01\RECORD\20110313

File name Size
120000.avi
121500.avi
123000.avi
124500.avi
130000.avi

512,000,000
512,000,000
512,000,000
512,000,000
512,000,000

Folder Up

Update Page Up Page Down Select

1 2

Restore RepeatON RepeatOFFFull

REW FF NestBack

Stop PlayPause

MICRO/I

Video Display

Press Play

While data is being recorded after an event occurs with the event recording function, while data is being 
recorded with a Key Button, Multi-Button, or Multi-Command configured with the recording function, or 
while data is being saved to the external memory device, movie files cannot be played. While data is 
recording after an event occurs and while data is being saved to the external memory device, the value of 
HMI Special Data Register LSD155-0 changes to 1. For details, refer to Chapter 33 “HMI Special Data 
Register (LSD)” on page 33-7.
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6.1 How the Multi-Button is Used

Executes multiple commands at once.
These commands can be assigned to a Multi-Button.

• Pressing the button writes a 1 to a bit device, and the value of word device to another device address.

• Pressing the button outputs a screenshot of the current screen to an external memory device*1, and then switches 
the Base Screen.

*1 SD memory card for HG5G/4G/3G/2G-V, HG4G/3G and HG2G-5F, USB flash drive for HG2G-5T and HG1G/1P

6 Multi-Button

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

Command Description

Bit Write Writes a 0 or 1 to the specified bit device when pressed.

Word Write
Writes a value to a word device when pressed. You can specify the destination address number indirectly, 
and perform arithmetic on the value to be written.

Goto Screen Switches screens and opens other windows when pressed.

Print Outputs a screenshot to the printer or the external memory device*1 when pressed.

Key Performs downloads, uploads, and file copying when pressed. Also used to manipulate other parts.

Script Executes a script when pressed.

MICRO/I

1

External device

0

D0= 123

D1= 0

D0= 123

D1= 123

Move

MICRO/I

USB flash drive

SD memory card

Image file

External Memory Device
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■ Momentary

■ Alternate

The button turns ON when pressed, 
and OFF when released. Release

Initial image

Press ReleasePress

ON

Operation and 
view

Action ONOFF OFF

The button switches between ON and 
OFF each time it is pressed. Release

Initial image

Press ReleasePress

ON

Operation and 
view

Action OFF
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6.2 Multi-Button Configuration Procedure

This section describes the configuration procedure for Multi-Buttons.

1 On the Home tab, in the Parts group, click Buttons, and then click Multi-Button.

2 Click a point on the edit screen where you wish to place the Multi-Button.

3 Double-click the dropped Multi-Button and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.

The Trigger Condition tab and Options tab only appear in Advanced mode.
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6.3 Properties of Multi-Button Dialog Box

This section describes items and buttons in the Properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ >>OFF Text, >>ON Text
Applies the text entered in the Part Name field to the Text field under the OFF or ON fields on the Registration 
Text tab. This is used as the Registration Text when the button is OFF or ON.

■ Action Mode
Select the Action Mode for the Multi-Button: Momentary or Alternate.

To specify the Registration Text to use when the button is ON, select the Set by State check box on the 
Registration Text tab. If left unchecked, the same Registration Text assigned for the OFF state is 
displayed for the ON state as well.

Momentary: The button turns ON when pressed, and OFF when released.

Alternate: The button switches between ON and OFF each time it is pressed.

Release

Initial image

Press ReleasePress

ON

Operation and 
view

Action ONOFF OFF

Release

Initial image

Press ReleasePress

ON

Operation and 
view

Action OFF
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■ Multi-Functions
Use this grid to add or edit commands to execute when the Multi-Button is pressed.

Function List: Lists the commands to be executed.
Command Type: Shows the command type.
Command Name: Shows the command name.
Device Address: Shows the setting when one of the following Command Type is selected.

Shows the destination device address for the Bit Write and Word Write 
commands.
Shows the screen number when Goto Screen is set to Switch to Base 
Screen, Open Popup Screen, or Close Popup Screen.
Shows the script ID for the Script command.

• Executes only the Goto Screen command at the end of the Function List when multiple Switch to Base 
Screen type commands are set for Action Mode.

• Goto Screen commands are not executed from top to bottom as they appear in the Function List. 
Rather, they are executed at the end of the scan when the Multi-Button is pressed.

• If multiple Key commands are set, only the first and second Key commands in the Function List are 
executed. The third and following Key commands are not executed. Also, only the first Key command that 
specifies a Data Transfer function in the Function List is executed if multiple Key commands are set.

• Key commands are executed in the scan that follows a scan that satisfies the trigger condition.

Command Type: Select the command to add.
Bit Write: Writes a 0 or 1 to the bit device or the bit number of the word device. For details, 

refer to “Properties of Bit Write for Multi-Functions Dialog Box” on page 8-114.
Word Write: Writes a value to a word device. Can be used to indirectly specify the destination 

address or to perform operations on the written value. For details, refer to 
“Properties of Word Write for Multi-Functions Dialog Box” on page 8-115.

Goto Screen: Switches to another screen or displays a window. For details, refer to “Properties 
of Goto Screen for Multi-Functions Dialog Box” on page 8-117.

Print: Outputs a screenshot to a printer or an external memory device. For details, refer 
to “Properties of Print for Multi-Functions Dialog Box” on page 8-119.

Key: Performs a variety of functions including uploading and downloading, copying 
files, and operating other parts. For details, refer to “Properties of Key for Multi-
Functions Dialog Box” on page 8-121.

Script: Executes the script. For details, refer to “Properties of Script for Multi-Functions 
Dialog Box” on page 8-127.

Add: Adds a command to the list. A maximum of 32 commands may be added.
Click this button to display the Properties dialog box for the command selected from Command 
Type.

Edit: Changes a command in the list.
Click this button to display the Properties dialog box for the command selected in Function List.

Delete: Deletes a command from the list.
Select the command in the list and click this button.

Copy: Copies a command in the list.
Select a command in the list and click this button. A copy of the selected command is added to the 
end of the list.

Up: Shifts the selected command upward in the list.
Down: Shifts the selected command downward in the list.
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■ View Switching Method*1

Select how to display the ON/OFF status of the button.

*1 Advanced mode only

Button: Pressing the button changes the drawing object displayed.

Device Address: The drawing objects assigned to the OFF and ON states are displayed when the value of the device 
address is 0 and 1, respectively. Specifies the device address used to switch the drawing object 
display.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 
“5.1 Device Address Settings” on page 2-68.

No Image: The button is not displayed on the screen. The button appears as a dashed line frame on the edit 
screen. Pressing the corresponding area on the MICRO/I activates the assigned function. If No 
Image is selected, the settings for View and Registration Text are disabled.

Selecting Device Address in View Switching Method allows you to create an illuminated pushbutton.
The illuminated pushbutton switches state (or image) according to ON or OFF state of the device address, 
allowing you to display the state of a device that is being operated.

Example: When you set an external device address 'M0' as Device Address in View Switching Method, 
if the value of M0 changes, the display image will switched according to the value of M0 even if 
the button is not pressed.

0

M0

1

M0

MICRO/I External device

View Switching Method (Device Address): M0 

OFF image:

ON image:
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Properties of Bit Write for Multi-Functions Dialog Box

Sets the Bit Write command for the Multi-Button.

■ Command Name
Enter a name for the command. The maximum number is 20 characters.

■ Action Mode
Select the behavior of the Multi-Button from the following:

■ Destination Device Address
Specify the destination bit device.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.

■ Write*1

Specify the number of bit devices (1 to 64) at the destination.

This setting is enabled only if Action Mode is set to Set or Reset. For details, refer to “Write*1” on page 8-6.

■ Source Data
Specifies the device address that stores the data to be written.
This setting is enabled only if Action Mode is set to Move. For details, refer to “Source Data” on page 8-6.

*1 Advanced mode only

Set: Pressing the Multi-Button writes a 1 to the bit device.

Reset: Pressing the Multi-Button writes a 0 to the bit device.

Set & Reset: Pressing the Multi-Button writes a 1 to the bit device.
Releasing the Multi-Button writes a 0 to the bit device.

Toggle: Pressing the Multi-Button inverts the value of the bit device.
If the value of the bit device is 0 it changes to 1, and vice versa.

Move: Pressing the Multi-Button writes the value in the source bit device to the value in the destination bit 
device.

For details about the Action Mode, refer to “Action Mode” on page 8-4. However, Set & Reset for the 
Multi-Button has the same function as Momentary for the Bit Button.

Device Address: Specify the source bit device.

Click to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 
“5.1 Device Address Settings” on page 2-68.

Transfer: Specify the number of bit devices (1 to 64) to transfer.
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Properties of Word Write for Multi-Functions Dialog Box

Sets the Word Write command for the Multi-Button.

■ Command Name
Enter a name for the command. The maximum number is 20 characters.

■ Action Mode
Select the behavior of the Multi-Button from the following:

■ Data Type
Select the data type handled by the operation selected for Action Mode.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1
UBIN16(W) and UBIN32(D) can only be set if Action Mode is set to OR, AND, or XOR.

■ Source 1
Specify the source word device.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.
This setting is enabled only if Action Mode is set to Add, Sub, Multi, Div, Mod, OR, AND, or XOR.

Set: Pressing the button writes a fixed value to a word device.

Move: Pressing the button writes a value in a source device address to a destination word device.

Set ON & OFF Data: Pressing the button writes a fixed value of ON Data to a word device.
Releasing the button writes a fixed value of OFF Data to a word device.

Add, Sub, Multi, Div, Mod, OR, AND, XOR: Pressing the button performs arithmetic on a value of source device 
address and a fixed value or a value of device address and writes the 
result to a word device.

For details about the Action Mode, refer to “Action Mode” on page 8-23. However, Set ON & OFF Data for 
the Multi-Button has the same function as Momentary for the Word Button.

UBIN16(W) and UBIN32(D) can only be set if Action Mode is set to Move. Because the number of 
device addresses to transfer is specified in Advanced mode, you do not need to set Data Type.

If BCD4(B), BCD8(EB), or Float32(F) is selected and the arithmetic data contains a value inexpressible 
in BCD, a 1 is written to System Area 2 Processing error bit (address+2, bit 5) and an error message is 
displayed. For details, refer to Chapter 4 “Processing error” on page 4-32 and Chapter 36 “Processing 
error” on page 36-3.
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■ Source Data
Select the data handled by the operation selected for Action Mode.

■ Destination Device Address

*1 Advanced mode only

Value: Use a constant value.
Only a Value can be handled if Action Mode is set to Set or Set ON & OFF Data.
If Action Mode is set to Set ON & OFF Data, the value in the ON Data is written when the 
button is ON, and the value in the OFF Data is written when the button is OFF.
Hexadecimal: Select this check box to enter the ON Data and OFF Data 

values in hexadecimal.
Device Address: Use a value of device address.

Specify the device.

Click  to display the Tag Editor. For the device address configuration
procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-68.
Use Reference Device Address*1: Select this check box and specify a device address to change the 

source word device according to the value of the specified device 
address.
This setting is enabled only if Action Mode is set to Move.
For details, refer to Chapter 2 “Indirect Read and Indirect Write 
Settings” on page 2-5.

Transfer*1: Specify the number of word devices (1 to 64) to transfer.
This setting is enabled only if Action Mode is set to Move.

For details, refer to “Transfer*1” on page 8-25.

Destination Device Address: Specify the destination word device.

Click  to display the Tag Editor. For the device address
configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 
2-68.

Use Reference Device Address*1: Select this check box and specify a device address to change the destination word 
device according
to the value of the specified device address.
This setting is enabled only if Action Mode is set to Move.
For details, refer to Chapter 2 “Indirect Read and Indirect Write Settings” on page 
2-5.

Write*1: Specify the number of word devices (1 to 64) at the destination.
For Move, specify how many times to write.
This setting is enabled only if Action Mode is set to Set, Move, or Set ON & OFF 
Data.

For details, refer to “Write*1” on page 8-26.
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Properties of Goto Screen for Multi-Functions Dialog Box

Sets the Goto Screen command for the Multi-Button.

■ Command Name
Enter a name for the command. The maximum number is 20 characters.

■ Action Mode
Select the behavior of the Multi-Button from the following:

*2 This is applicable for models with a video interface only.

Back to previous Screen: Switches to the previous screen. Returns to up to 16 earlier screens.

Switch to Base Screen: Switches between Base Screen.

Open Popup Screen: Opens a Popup Screen.

Close Popup Screen: Closes a Popup Screen.

Open Device Monitor Screen: Opens the Device Monitor Screen.

Close Device Monitor Screen: Closes the Device Monitor Screen.

Open Password Screen: Opens the Password Screen.

Close Password Screen: Closes the Password Screen.

Open Adjust Brightness Screen: Opens the Adjust Brightness Screen.

Close Adjust Brightness Screen: Closes the Adjust Brightness Screen.

Open File Screen for movie files*2: Opens the File Screen.

Close File Screen for movie files*2: Closes the File Screen.

Switch to System Mode: Switches to the Top Page in the System Mode.

Reset current screen: Resets the current Base Screen.

Open User Account Setting Screen: Opens the User Account Setting Screen. For details, refer to Chapter 23 “5 
Editing User Accounts on the MICRO/I” on page 23-49.
When User Account Setting Screen is selected, the Configure 
Processing Area of User Account Setting Screen dialog box will be 
displayed. For details, refer to “ Configure Processing Area of User Account 
Setting Screen Dialog Box” on page 8-44.
Specify the word device to use as the processing area of the User Account 
Setting Screen and click OK. When you return to the properties dialog box, 
Edit will be displayed.

Edit: Click this button to display the Configure Processing Area of User 
Account Setting Screen dialog box.

When the current Base Screen is reset using the Reset current screen function, the window and internal 
devices restart as if the Base Screens were switched.
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■ Goto Screen

*1 Advanced mode only
*2 This is applicable for models with a video interface only.

Screen Number: If Action Mode is set to Switch to Base Screen, specify the Base Screen number to switch to 
(from 1 to 3000). If Action Mode is set to Open Popup Screen or Close Popup Screen, specify 
the number of the Popup Screen to open or close (from 1 to 3015).
This setting is enabled only if Action Mode is set to Switch to Base Screen, Open Popup 
Screen, or Close Popup Screen.
Use Reference Device Address*1: Select this check box and specify a device address to specify the 

screen number using the value of the specified device address.

Click  to display the Tag Editor. For the device address 
configuration procedure, refer to Chapter 2 “5.1 Device Address 
Settings” on page 2-68.
This setting is enabled only if Action Mode is set to Open 
Popup Screen or Close Popup Screen.

Coordinates X, Y: Specify the coordinates on the Base Screen for displaying a window.
X and Y specify the upper left corner of the window using the upper left corner of the screen as the 
origin.
This setting is enabled only if Action Mode is set to Open Popup Screen, Open Device 
Monitor Screen, Open Password Screen, Open Adjust Brightness Screen, or Open File 
Screen for Movie Files*2.
Use Reference Device Address*1: Select this check box and specify a device address to specify the 

coordinates
using the value of the specified device address.

Click  to display the Tag Editor. For the device address 
configuration procedure, refer to Chapter 2 “5.1 Device Address 
Settings” on page 2-68.
This setting is enabled only if Action Mode is set to Open 
Popup Screen.
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Properties of Print for Multi-Functions Dialog Box

Sets the Print command for the Multi-Button.

■ Command Name
Enter a name for the command. The maximum number is 20 characters.

■ Output to
Select where to direct the screenshot to.

d

■ Action Mode
Select the behavior of the button from the following. This option is only displayed when Printer is selected in Output to.

*1 HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F only
*2 SD memory card for HG5G/4G/3G/2G-V, HG4G/3G and HG2G-5F, USB flash drive for HG2G-5T and HG1G/1P

Printer*1: Outputs the screenshot to the printer connected to the MICRO/I.

Print Time Stamp: Adds the date and time of printing to the screenshot before 
sending it to the printer.
The date and time format depends on the language selected in 
Language. Language is available on the Project Details tab of 
the Project Settings dialog box.
The display formats are shown below:
• Japanese: YYYY/MM/DD hh:mm
• English: MM/DD/YYYY hh:mm
YYYY: year, MM: month, DD: day, hh: hour, mm: minute

External Memory Device*2: Outputs the screenshot as a file to the external memory device inserted in the MICRO/I.
Files are output as follows:

File format File name File size

JPEG
CAP***.JPG (***: date and time when file was output)
Example: A file created at 18:50:25 on June 30, 2011 will be 
named “CAP110630_185025.JPG”.

Depends on image 
being displayed.

• For details about printers, refer to Chapter 32 “Printer” on page 32-1.
• For details about external memory devices, refer to Chapter 31 “External Memory Devices” on page 31-1.

Print Screen: Outputs a screenshot of the current screen to the printer or the external memory device.

Cancel Printing*1: Cancels printout to the printer.



6 Multi-Button

8-120 WindO/I-NV4 User’s Manual

*1 HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F only

• These operations cannot be performed simultaneously.
- Outputting to the external memory device by pressing the Multi-Button.

- Outputting to the printer by pressing the Multi-Button*1.
- Printing alarm logs

• It may take some time to output screenshots when copying files using the USB Autorun function or a Key 
Button.

• MICRO/I cannot stop printing in the middle of a page, even when the print job is canceled. Print jobs 
after the current print job are canceled after the current page finishes printing.

The maximum number of screenshots that can be captured (1 to 999) can be set in HMI Special Data 
Registers LSD65. (Default: 99)

The methods to erase screenshot files saved on the external memory device are as follows.
• To erase files during operation using parts, on the External Memory Device tab on the Project Settings 

dialog box, select the Remove Files check box and the All Screenshot data check box, and then 
configure the trigger device address. Assign that trigger device address to a part.

• To erase files with WindO/I-NV4, click Clear on the Online tab, and then click Stored Data in External 
Memory Device to open the Clear Data dialog box. Select the Screenshot Data check box and click 
OK.

• To erase files on the HG5G/4G/3G/2G-V, HG4G/3G and the HG2G-5F, go to the System Mode - File 
Manager. In the File Manager, select the files to be deleted by pressing DEL.
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Properties of Key for Multi-Functions Dialog Box

Sets the Key command for the Multi-Button.

■ Command Name
Enter a name for the command. The maximum number is 20 characters.

■ Key Type
Select the function for the Key Button.

The settings explained below appear depending on the type of key selected.

■ Popup Screen Number
The Alt key switches the current Popup Screen used as a Keypad when this button is pressed.
Specify the Popup Screen number to open a Keypad for.
This setting is enabled only if Alt was selected using the Key Browser.

Displays settings 
applicable to the 
selected key.

(Key)

Language: Switches the display of the key that is displayed when Keypad is selected in Key Browser. These 
languages are available:
Japanese, European, Central European, Baltic, Cyrillic.

Browse: Opens the Key Browser when clicked. Select a key.
For details, refer to “5.5 Key Browser” on page 8-98.

(Key): Displays the name of the key selected using the Key Browser.

• When you select a key for Multi-Button or Multi-Command, the label for that key is not assigned as the 
Registration Text.

• The function of Key button will affect on the next scan when the trigger condition is satisfied.
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■ Scroll Size
Key Buttons Page Up and Page Down scroll the list up and down, respectively. Key Buttons Up and Down move 
the focus up and down, respectively. This settings specifies the number of pages or lines (1 to 1023 lines) to scroll or 
move the focus per each press of the button.
This setting is enabled only if Page Up, Page Down, Up, and Down are selected using the Key Browser.

■ Transfer Setting
Key Buttons Download Project, Upload Project, Copy Files, Download PLC Program, and Upload PLC 
Program, perform the data transfer function specified by their names. These settings specify the source, data to be 
transferred, and destination.
This setting is enabled only if one of these keys is selected after clicking Data Transfer in the Key Browser.

If Download Project is selected.

*1 HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F only

Source: Select the external memory where the project (ZNV Project File) to be transferred is stored: SD 
Memory Card*1 or USB Flash Drive.

Location: Specify the location of the ZNV Project File(.znv). The maximum number is 247 characters.
Example: Where “HG3G_DEMO_1.ZNV” is a ZNV Project File saved on the root directory of 

an SD memory card or USB flash drive: 
HG3G_DEMO_1.ZNV

Destination:

Clear Keep Devices:

Select this check box to clear keep devices after the project data is downloaded. However, 
when project data that changes the system software or settings of the data storage area is 
downloaded, the keep devices are always cleared.

When project data is downloaded, the alarm log data, data log data, and operation log data is deleted 
regardless of the state of the Clear Keep Devices check box.
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If Upload Project is selected.

If Copy Files*1 is selected.

*1 HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F only

Destination: Specify where to save the project uploaded from MICRO/I. Select the location:

SD Memory Card*1 or USB Flash Drive.

Location: Specify the location of the folder where the uploaded project will be saved. The 
maximum number is 247 characters.
Example: To save it to the folder “Uploaded_Project” on an SD memory card or USB flash 

drive: 
Uploaded_Project

A uploaded project using the Data Transfer function is saved as a ZNV Project File(.znv).

Source: Select the source external memory: SD Memory Card or USB Flash Drive.
Location: Specify the location of the file to be transferred. The maximum number is 247 

characters.
Example: Where “Error.wav” is a sound file saved on the root directory of an SD memory 

card or USB flash drive:
Error.wav

Destination: Select the destination external memory: SD Memory Card or USB Flash Drive.
Location: Specify the location where the file will be transferred. The maximum number is 247 

characters.
Example: To save it to the folder “SOUND” inside “HGDATA01” on an SD memory card or 

USB flash drive:
HGDATA01\SOUND

• If a file name is specified as the source location, the specified file is copied.
If a folder name is specified, all of the files and subfolders contained in the folder, and all of the files in 
the subfolders, are copied.

• The subfolders can be copied up to five levels.
• To prevent copying the subfolders and the files contained in the subfolders, HMI Special Internal Relay 

LSM30 must be set to 1 before executing the copy.
• To stop copying files during the copy operation, write 1 to HMI Special Internal Relay LSM31. However, it 

will continue to copy the file until it is finished then it will stop copying.
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If Download PLC Program is selected.

*1 HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F only

Source: Select the the external memory where the PLC program (ZLD Project File) to be transferred is stored: SD 
Memory Card*1 or USB Flash Drive.
Location: Specify the location of the ZLD Project File(.zld). The maximum number is 247 characters.

Example: “LDR_PROGRAM.ZLD” is a ZLD Project File saved in folder “LDRDATA” of an SD 
memory card or USB flash drive:
LDRDATA\LDR_PROGRAM.ZLD

Destination: Specify the destination PLC connected to the MICRO/I. The PLC type is configured in the Project 
Settings dialog box, on the Communication Driver Network tab. For details, refer to Chapter 4 “3.4 
Communication Driver Network Tab” on page 4-50.
Interface: Select the communication interface in which the MICRO/I is connecting to the download 

destination PLC from serial interface or Ethernet. For details, refer to Chapter 4 “Interface 
Configuration” on page 4-35.

If serial interface is selected for Interface.
Slave Number: Specify the slave number of the download destination PLC (0 to 31).
External Device Name: The name of the specified PLC is displayed here.

If Ethernet is selected for Interface.
Select from the following method:

Specify External Device ID: Specify the External Device ID (0 to 31) of the destination PLC. This is the 
External Device ID number set in the Project Settings dialog box, on 
the Communication Driver Network tab.

External Device Name: The name of the specified PLC is displayed here.
Specify IP Address: Specify the IP address and port number of the destination PLC.
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If Upload PLC Program is selected.

*1 HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F only

Source: Specify the source PLC connected to the MICRO/I. The PLC type is configured in the Project Settings 
dialog box, on the Communication Driver Network tab. For details, refer to Chapter 4 “3.4 
Communication Driver Network Tab” on page 4-50.
Interface: Select the communication interface in which the MICRO/I is connecting to the upload 

source PLC from serial interface or Ethernet. For details, refer to Chapter 4 “Interface 
Configuration” on page 4-35.

If serial interface is selected for Interface.
Slave Number: Specify the slave number of the upload source PLC (0 to 31).
External Device Name: The name of the specified PLC is displayed here.

If Ethernet is selected for Interface.
Select from the following method:

Specify External Device ID: Specify the External Device ID (0 to 31) of the upload source PLC. This is 
the External Device ID number set in the Project Settings dialog box, 
on the Communication Driver Network tab.

External Device Name: The name of the specified PLC is displayed here.
Specify IP Address: Specify the IP address and port number of the upload source PLC.

Destination: Specify where to save the PLC program uploaded from the PLC connected to the MICRO/I. Select the 
type of external memory: SD Memory Card*1 or USB Flash Drive.
Location: Specify the location of the folder where the uploaded PLC program will be saved. The 

maximum number is 247 characters.
Example: To save it to the folder “Uploaded_Program” on an SD memory card or USB flash drive: 

Uploaded_Program

A uploaded PLC program using the Data Transfer function is saved as a ZLD Project File(.zld).
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■ Recording Channel*2

The recording of images starts.
Selects Channel 1 or Channel 2 to record a video only (no audio) out of the signals input from the device. This 
setting is enabled only if Rec. was selected using the Key Browser.

■ Recording Target*3

The recording of images and sound starts. 
Select the target to record out of the signals input from the device. This setting is enabled only if Rec. was selected 
using the Key Browser.

*2 HG5G/4G/3G-V only
*3 This is applicable for HG4G/3G with a video interface only.

• Movie files cannot be recorded during playback.
• While data is being recorded after an event occurs with the event recording function and while data is 

being saved to the external memory device, recording cannot be executed with a Key Button, Multi-
Button, or Multi-Command configured with the recording function. Also, during these situations, the 
value of HMI Special Data Register LSD155-0 changes to 1. For details, refer to Chapter 33 “HMI Special 
Data Register (LSD)” on page 33-7.

Video and Audio: Records images and sound.

Video only (No Audio): Records images only.

• Movie files cannot be recorded during playback.
• While data is being recorded after an event occurs with the event recording function and while data is 

being saved to the external memory device, recording cannot be executed with a Key Button, Multi-
Button, or Multi-Command configured with the recording function. Also, during these situations, the 
value of HMI Special Data Register LSD155-0 changes to 1. For details, refer to Chapter 33 “HMI Special 
Data Register (LSD)” on page 33-7.
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Properties of Script for Multi-Functions Dialog Box

Sets the script for the Multi-Button.

■ Command Name
Enter a name for the command. The maximum number is 20 characters.

■ Script ID
Specify the script ID (1 to 32000) of the script to operate.

Script Manager will open when  is clicked. Select a script from the script list.
For details, refer to Chapter 20 “2.2 Script Manager” on page 20-7.

■ Script Name
Displays the name of the script selected in Script Manager.

■ (Script)
Displays the contents of the script selected in Script Manager.
Once this area is double clicked, the Script Editor will open and editing can be done.
For details, refer to Chapter 20 “2.3 Script Editor” on page 20-12.

(Script)
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● View Tab
Only Coordinates and Size can be configured when No Image is selected for View Switching Method on the 
General tab.

■ Image Type
Select the type of graphic to be used to represent the part.

■ Browse
Select the type of graphic to be used to represent the part from the list of graphics. Click this button to display the 
View Browser or Picture Manager, depending on the setting for Image Type.

■ OFF button, ON button
Displays the graphic when ON or OFF. Clicking ON or OFF switches the image displayed on the View tab.

■ OFF, ON
Selects the color and pattern of the standard graphic when ON and OFF.

Standard: Uses the default graphics contained within WindO/I-NV4.

Picture: Uses an image file saved in the Picture Manager.
For details about image file restrictions, refer to Chapter 2 “1.4 Available Image Files” on page 2-20.

Foreground Color, Background Color: Selects the foreground and background colors of the standard graphic (color: 
256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

Pattern: Selects a pattern or tonal gradation for the standard graphic.
Click Pattern to display the Pattern Palette. Select a pattern or tonal gradation from the Pattern Palette.
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■ Flash
Select this check box if flashing is desired (alternating ON and OFF) when a part is ON.

■ Coordinates

■ Size

Flash

ON image

OFF image

X, Y: Sets the display position of parts using coordinates.
The X and Y coordinates of parts are defined relative to an origin at the top-left corner of the screen.

X: 0 to (base screen horizontal size - 1)

Y: 0 to (base screen vertical size - 1)

(0, 0)
X

Y
Screen

Parts

W, H: Sets width and height to define the size of parts.

W: 20 to (base screen horizontal size)

H: 20 to (base screen vertical size)

Width

Height

Screen

Parts
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● Registration Text Tab
These options can only be configured when Button or Device Address is selected for View Switching Method on 
the General tab.

■ Font
Selects the font used for displaying text from the following.
Japanese, European, Chinese, Taiwanese, Korean, Central European, Baltic, Cyrillic, Windows, Stroke
Can only be set when the Use Text Manager check box is cleared.
The characters that can be displayed depend on the font. For details, refer to Chapter 2 “1.2 Available Text” on page 2-6.

■ Size
Sets the character size (8 to 128).
Can only be set when Stroke is selected.

■ Style
Selects Regular or Bold for text style.
Can only be set when Font is set to Japanese, European, Chinese, Taiwanese, Korean, Central European, 
Baltic or Cyrillic.

■ Magnification

Can only be set when Font is set to Japanese, European, Chinese, Taiwanese, Korean, Central European, 
Baltic or Cyrillic.

■ Align Text Horizontal
Selects text alignment in the horizontal direction.
Left, Center, Right, Center-Left
For details, refer to Appendix “5 Text Alignment” on page A-7.

■ Align Text Vertical
Selects text alignment in the vertical direction.
Top, Center, Bottom
This option can only be configured when Left, Center, or Right is selected for Align Text Horizontal. If Center-
Left is selected for Align Text Horizontal, Center-Top is set as this option.
For details, refer to Appendix “5 Text Alignment” on page A-7.

■ Set by State
Select this check box if displaying different text when ON and OFF.

■ Use Text Manager
Select this check box if using the text registered in Text Manager for text display.

W, H: Selects the magnification (0.5, 1 to 8) for text display.
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■ OFF, ON

Text: Inputs characters to be displayed on parts. The maximum number is 3,750 characters.
The characters that can be entered depend on the font selected using Font. For details, refer to 
Chapter 2 “1.2 Available Text” on page 2-6.

Text ID: Specifies the Text Manager ID No. (1 to 32000) when using the text registered in the Text Manager.

Click  to display Text Manager.

Can only be set when the Use Text Manager check box is selected.

Text Color: Selects the color of the text displayed on the part (color: 256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

Windows Font: Sets the font to be used as the Windows Font.
Select Windows using Font to display the current setting. You can specify the character spacing (0 
to 100) and the line spacing (0 to 100). To change the settings other than the character spacing and 
line spacing, click Change to display the Font Settings dialog box.
Can only be set when the Use Text Manager check box is cleared.
For details, refer to Chapter 2 “Windows Font” on page 2-13.
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● Trigger Condition Tab
The Trigger Condition tab is displayed in Advanced mode.

■ Input Condition
The Button is enabled and operational while the condition is satisfied. The Button is disabled and not operational 
while the condition is not satisfied.
Example: When Trigger Type is While ON and Device Address is LM0

While LM0 is 0, the condition is not satisfied and the Button is not operational.
While LM0 is 1, the condition is satisfied and the Button is operational.

Trigger Type: Selects the condition to enable the Button from the following.

Always enable: The Button is always enabled.

While ON: Enables the Button when the value of device address is 1.

LM0:

MICRO/I

0

LM0: 1

Button
Does not
operate

Button
Operates

Condition 
Not 

satisfied

Condition 
Satisfied

Always enabled

Button state

1

0

Disabled Enabled Disabled DisabledEnabled Enabled

Value of
device address

Button state
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■ Visible Condition
The Button is displayed while the condition is satisfied. The Button is hidden while the condition is not satisfied.
Example: When Trigger Type is While ON and Device Address is LM0

While LM0 is 0, the condition is not satisfied and the Button is hidden.
While LM0 is 1, the condition is satisfied and the Button is displayed.

While OFF: Enables the Button when the value of device address is 0.

While satisfying the condition: Enables the Button when the condition is satisfied.

Data Type: Selects the type of data handled by the conditional expression for the input condition.
This option can only be configured if While satisfying the condition is selected for Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Device Address: Specifies the bit device or the bit number of the word device to serve as the input condition.
This option can only be configured when While ON or While OFF is selected for Trigger Type.
Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 
“5.1 Device Address Settings” on page 2-68.

Condition: Specifies the conditional expression for the input condition.
This option can only be configured when While satisfying the condition is selected for Trigger 
Type.
Click  to display the Trigger Condition Settings dialog box. For the conditional expression 
configuration procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-71.

Comment: Used for entering a comment for the input condition. The maximum number is 80 characters.

1

0

Enabled Enabled EnabledDisabled Disabled Disabled

Value of
device address

Button state

Satisfied

Not satisfied

Disabled Disabled DisabledEnabled Enabled Enabled

Condition

Button 
state

LM0:

MICRO/I

0

LM0: 1
Show

Condition 
Not 

satisfied

Condition 
Satisfied

Hide

• When Alternate is selected for Action Mode on the General tab, the button remains on when hidden 
in the on state.

• When the ON delay check box is selected on the Options tab, if the button is hidden before the set time 
elapses from when the button begins to be pressed, the on delay is reset and the button does not 
operate.
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Trigger Type: Selects the condition to display the Button from the following.

Always visible: The Button is always displayed.

While ON: Displays the Button when the value of device address is 1.

While OFF: Displays the Button when the value of device address is 0.

While satisfying the condition: Displays the Button when the condition is satisfied.

Data Type: Selects the type of data handled by the conditional expression for the visible condition.
This option can only be configured if While satisfying the condition is selected for Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Device Address: Specifies the bit device or the bit number of the word device to serve as the visible condition.
This option can only be configured when While ON or While OFF is selected for Trigger Type.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 
“5.1 Device Address Settings” on page 2-68.

Condition: Specifies the conditional expression for the visible condition.
This option can only be configured when While satisfying the condition is selected for Trigger 
Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expression 
configuration procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-71.

Comment: Used for entering a comment for the visible condition. The maximum number is 80 characters.

Always show

Button state

1

0

Hide Show Hide HideShow Show

Value of
device address

Button state

1

0

Value of
device address

Show Show ShowHide Hide Hide

Button state

Hide Hide HideShow Show Show

Satisfied

Not satisfied

Condition

Button state
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● Options Tab
The Options tab is displayed in Advanced mode.

■ ON delay
Select this check box to use the ON delay function.

■ No Touch Sound
This function is to disable touch sounds only for specified parts when the MICRO/I makes touch sounds.
Select this check box to display disable touch sounds for this part.

■ Place on the Top Layer
Select this check box to display the parts on the top layer. The parts will have precedence when other drawings and 
parts are overlapping with it. For details, refer to Chapter 6 “4 Drawings and Parts Overlapping” on page 6-5.

Time (x100 msec): Specify the length of time that the button must be held down before activation by selecting a 
value from 0 to 600 (units of 10 ms).
The button activates after it is held down for a specified period of time.

Hold down for 3 secs.

MICRO/I MICRO/I

Button
Does not
operate

Button
Operates

This feature protects against mistaken operation by ensuring that the button will not be activated if touched 
accidentally.

To enable touch sounds on the MICRO/I, select the Enable Touch Sound check box under the System 
tab of the Project Settings dialog box.

Even if a Multi-Button is placed on the top layer, drawing objects that are drawn with scripts executed by the 
Multi-Button are not drawn on the top layer. They are drawn on the Base Screen. For details, refer to 
Chapter 6 “4 Drawings and Parts Overlapping” on page 6-5.
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● Security Tab
This tab is used to restrict displaying and using the part by security groups.
This option can only be set when Use Security functions is selected. The Use Security functions check box is set 
on General tab in the Security dialog box.

■ (Settings)
Displays the list of security groups used on the MICRO/I.

■ Security Settings
The Security Settings dialog box is displayed. If you create a security group in the Security Settings dialog box, you 
can select that created group. For details, refer to Chapter 23 “2.2 Adding and Editing Security Groups” on page 23-
19.

(Settings)

No.: Displays the security group numbers (0 to 15).

Group Name: Displays the name of the security group.

Display: Displays whether or not there is permission to display the part. Only Permitted security groups 
can display this part. If all security groups are set to Permitted, this part will be displayed even 
if no user account has been selected. Double clicking the cell switches between Permitted and 
Prohibited.

Input: Displays whether or not there is permission to use the part. Only Permitted security groups 
can use this part. If all security groups are set to Permitted, this part can be used even if no 
user account has been selected. Double clicking the cell switches between Permitted and 
Prohibited.

• You can also switch between Permitted and Prohibited by right-clicking on a Display or Input cell.
• Restricting the display and use of the part by switching between Permitted and Prohibited in Display 

and Input cells is similar to using the Trigger Condition tab.

For details about security functions, refer to Chapter 23 “User Accounts and the Security Function” on page 
23-1.
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Example: If the user and security group for a part are set as follows:

For User1 in the Reader security group, the parts for which Display has been set to Prohibited for Reader will not 
be displayed.
If the password screen is opened and the user switches to User2 in the Operator security group, the parts for which 
Display has been set to Permitted for Operator will be displayed.

For User2 in Operator, Display has been set to Permitted for Operator, but Input is Prohibited, so the part 
cannot be used.
If the password screen is opened and the user switches to User3 in the Administrator security group, the parts for 
which Display has been set to Permitted for Administrator will be displayed, and the parts for which Input has 
been set to Permitted for Administrator can be used.

User Name

Security Group Reader Operator Administrator
User1 User2 User3

MICRO/I

130

Numerical Display
No. Group Name Display

1 Administrator Permitted

2 Operator Permitted

3 Reader Permitted

Button
No. Group Name Display Input

1 Administrator Permitted Permitted

2 Operator Permitted Prohibited

3 Reader Prohibited Prohibited

Line Chart and Bar Chart
No. Group Name Display

1 Administrator Permitted

2 Operator Permitted

3 Reader Prohibited

Open Password Screen, 
enter password, 
and switch to User2

For User1, 
parts for which Display 
has been set to Prohibited 
for Reader are not displayed

For User2, 
parts for which Display 
has been set to Permitted 
for Operator are displayed

MICRO/I

130

MICRO/I MICRO/I

130

User1 User2

130
CAN

User Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password

Open Password Screen, 
enter password, 
and switch to User3

For User2, 
parts for which Display 
has been set to Permitted 
for Operator are displayed, 
but parts for which Input 
has been set to Prohibited cannot be used

For User3, 
parts for which Display 
has been set to Permitted 
for Administrator are displayed, 
and parts for which Input 
has been set to Permitted can be used

MICRO/I

130

MICRO/I MICRO/I

130130 130

User2 User3

Button
Can operate

CAN

User Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password

Button
Cannot operate
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● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Used for entering comments about parts. The maximum number is 80 characters.
Example: When mousing over the Button on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.
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7.1 How the Keypad is Used

A part comprised of Key Buttons. Enters numbers and characters into Numerical or Character Input parts.

• Entering numbers in the Numerical Input

• Entering characters in the Character Input

7 Keypad

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

1230

MICRO/I

Numerical Input

Keypad

MICRO/I

Character Input

Keypad

Do not use the Keypad part with the Goto Screen Button or a combination of Goto Screen Commands. For 
details, refer to “5 Key Button” on page 8-72.
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7.2 Keypad Configuration Procedure

This section describes the configuration procedure for Keypads.

1 On the Home tab, in the Parts group, click Buttons, and then click Keypad.

2 Click a point on the edit screen where you wish to place the Keypad.

3 Double-click the dropped Keypad and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.

The Keypad Properties dialog box is displayed until OK is clicked.
 Refer to “7.3 Properties of Keypad Dialog Box” on page 8-141.

After OK on the Keypad Properties dialog box is clicked, double clicking the Keypad thereafter calls up the 
Properties dialog box for the Key Buttons as a group.
This allows editing of settings common to each button.
• View: “View Tab” on page 8-82
• Registration Text: “Registration Text Tab” on page 8-84
• Options: “Options Tab” on page 8-89

The Options tab only appears in Advanced mode.
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7.3 Properties of Keypad Dialog Box

This section describes items and buttons in the Properties dialog box.

■ Browse
Select a prebuilt Keypad within WindO/I-NV4.
Displays the Standard Browser when clicked. Select numeric keys or character keys registered in the Standard 
Browser.

■ Button

■ Registration Text

■ Place on the Top Layer
Select this check box to display the parts on the top layer. The parts will have precedence when other drawings and 
parts are overlapping with it. For details, refer to Chapter 6 “4 Drawings and Parts Overlapping” on page 6-5.

Foreground Color, Background Color:

Select the foreground and background color to use for the Keypad (color: 256 colors, 
monochrome: 16 shades).
Displays the Color Palette when Color is clicked. Select a color from the Color Palette.

Pattern: Select a pattern to use or tonal gradation for the Keypad.
Displays the Pattern Palette when Pattern is clicked. Select a pattern or tonal gradation from 
the Pattern Palette.

Font: Select one of the following fonts to use for the text on the buttons.
Japanese, European, Chinese, Taiwanese, Korean, Central European, Baltic, Cyrillic, 
Stroke.
The characters that can be displayed depend on the font. For details, refer to Chapter 2 “1.2 
Available Text” on page 2-6.

Style: Select a character style: Regular or Bold.

Magnification W, H: Select the zoom factor (0.5, 1 to 8) to use on the text.
This setting is only enabled when Font is set to Japanese, European, Chinese, Taiwanese, 
Korean, Central European, Baltic or Cyrillic.

Text Color: Select the text color (color: 256 colors, monochrome: 16 shades).
Displays the Color Palette when Color is clicked. Select a color from the Color Palette.
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■ Coordinates

■ Size

X, Y: Specify the display coordinates of the Keypad.
X and Y specify the upper left corner of the Keypad using the upper left corner of the screen as the origin.

X: 0 to (base screen horizontal size - 1)

Y: 0 to (base screen vertical size - 1)

(0, 0)
X

Y
Screen

Keypad

W, H: Specify the size of the Keypad by specifying width and height.

W: 20 to (base screen horizontal size)

H: 20 to (base screen vertical size)

Width

Height

Screen

Keypad
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8.1 How the Selector Switch is Used

Writes a 0 or 1 to a bit device. This is an exclusive control that only writes a single value as 1 and all other values as 0.

• Switching between two Run Modes (Manual and Auto)

• Switching between three Run Modes (Filling - Stop - Discharge)

8 Selector Switch

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

Automatic Manual

Automatic

Auto Manual

Auto Manual Auto Manual

R-button

Ch2Ch1

L-button

Knob

Press L-button to
switch to Auto.

Press R-button to
switch to Manual.

Operate 
manually

F S D F S D F S D

F S D

R-button

Ch3Ch2Ch1

L-button

Knob

Press L-button to
switch to Filling.

Switch to Stop
(the operation differs according 

to the switch type)

Press R-button to 
switch to Discharge.
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8.2 Selector Switch Configuration Procedure

This section describes the configuration procedure for Selector Switch buttons.

1 On the Home tab, in the Parts group, click Buttons, and then click Selector Switch.

2 Click a point on the edit screen where you wish to place the Selector Switch.

3 Double-click the dropped Selector Switch and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.

The Trigger Condition tab and Options tab only appear in Advanced mode.
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8.3 Properties of Selector Switch Dialog Box

This section describes items and buttons in the Properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ Switch Type
The 2-Notch action is as follows.
• When the knob is at Ch1 (left), pressing the right button switches the selector knob to Ch2 (right).

During this action, the device address for Ch1 is set to 0 and Ch2 is set to 1.
• When the knob is at Ch2 (right), pressing the left button switches the selector knob to Ch1 (left).

During this action, the device address for Ch1 is set to 1 and Ch2 is set to 0.

The 3-Notch action is as follows.
• The knob behaves as follows for 3-Notch No-return, 3-Notch R-return, and 3-Notch L-return button:

- Press R-button: knob switches from Ch1 (left) -> Ch2 (middle) -> Ch3 (right), in that order.
- Press L-button: knob switches from Ch3 (right) -> Ch2 (middle) -> Ch1 (left), in that order.

• Switching the knob writes 1 to the device address for the new knob position, and 0 to the device addresses for the 
other two channels.

Whether the knob returns and the direction it returns depends on the switch type.
Select the switch type from the following.

2-Notch No-return: The knob does not return when the operator's finger is released.

Release

Default state

Press R-button ReleasePress L-button

0

1

1

0

Write Write

Ch1

 Ch2

Action

Operation 
and view

Data 
written
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2-Notch R-return: After the knob switches from Ch1 to Ch2, it returns to Ch1 when the R-button is released.

2-Notch L-return: After the knob switches from Ch2 to Ch1, it returns to Ch2 when the L-button is released.

3-Notch No-return: The knob does not return when the operator's finger is released.

3-Notch R-return: • If the knob is switched to Ch3, it returns to Ch2 when the button is released.
• If the knob is switched to Ch1, or from Ch1 to Ch2, it stays where it is even if the button is 

released.

Release

Default state

Press

0

1

1

0

Write Write

Ch1

 Ch2

Action

Operation 
and view

Data 
written

Release

Default state

Press

0

1

1

0

Write Write

Ch1

 Ch2

Action

Operation 
and view

Data 
written

Release

Default state

Press R-button ReleasePress L-buttonReleasePress L-button

0

0

1

Ch1

 Ch2

0

1

0Ch3

1

0

0

WriteAction Write

Operation 
and view

Write

Data 
written

ReleasePress R-button ReleasePress R-buttonReleasePress L-button

Default state

0

0

1

1

0

0

0

1

0

0

1

0

Write Write WriteWrite

Ch1

 Ch2

Ch3

Action

Operation 
and view

Data 
written



WindO/I-NV4 User’s Manual 8-147

8 Selector Switch

8

Buttons

■ Always update the status
Select this check box to change the position of the knob with the values of device addresses.

■ Notch
Register and edit the settings for each notch to each channel.

3-Notch L-return: • If the knob is switched to Ch1, it returns to Ch2 when the button is released.
• If the knob is switched to Ch2, or from Ch3 to Ch2, it stays where it is even if the button is 

released.

3-Notch Both-return: If the knob is switched to Ch1 or Ch3, it returns to Ch2 when the button is released.

Release

Default state

Press L-button ReleasePress L-buttonReleasePress R-button

0

11

0

1

00

1

0

Write Write Write Write

0

0 0

Ch1

 Ch2

Ch3

Action

Operation 
and view

Data 
written

Release

Default state

Press L-buttonReleasePress R-button

0

1

1

01

0

0

1

Write Write Write Write

0 0

0 0

Ch1

 Ch2

Ch3

Action

Operation 
and view

Data 
written

The position of the knob will not be updated when the values of the device addresses set for the Selector 
Switch are the following states.
• When values of multiple device addresses are 1
• When values of all device addresses are 0
• When the value of the device address of the return channel is 1

Use Text Manager: Select this check box to use the text registered in the Text Manager as the Registration Text for 
each channel.

(List of Notch settings): This list shows the notch settings for each channel.

No.: Shows the channel to be output. The number of notches selected in the 
Switch Type determines the number of channels.
Double clicking the cell displays the Notch Settings dialog box where you 
can edit the notch settings. For details, refer to “Notch Settings Dialog Box” 
on page 8-149.

Device Address: Shows the destination bit device or the bit number in the destination word 
device.
Double clicking the cell displays the Tag Editor where you can edit the device 
address. For the device address configuration procedure, refer to Chapter 2 
“5.1 Device Address Settings” on page 2-68.

Text: Shows the Registration Text for the channel.
Double clicking the cell allows you to edit the Registration Text.
Can only be set when the Use Text Manager check box is cleared.
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Text ID: Shows the Text ID.

Double clicking the cell displays the Text Manager where you can change the 
Text ID.
Can only be set when the Use Text Manager check box is selected.

Color: Shows the color of the Registration Text for the channel.
Double clicking the cell displays Color Palette where you can change the Text 
Color

Set: Registers or changes the notch settings. Selecting a number that has already been registered 
changes the existing notch settings.
Clicking Set displays the Notch Settings dialog box where you can configure the notch. For 
details, refer to “Notch Settings Dialog Box” on page 8-149.

Insert: Inserts a notch setting entry above the currently selected position.
Select the channel number from the list where you wish to insert the notch setting and click 
Insert. This displays the Notch Settings dialog box where you can configure the notch. The 
notch settings at the point of insertion shift down one line. Notch settings cannot be inserted if 
all channel numbers have a notch setting.

Remove: Deletes the registered notch setting from the list.
Select the channel number in the list and click Remove.

Default Position: Selects the default position of the knob when the MICRO/I starts operation and the Selector 
Switch is first displayed on the screen.

Ch1: Makes Ch1 the default knob position. Writes 1 to the device address configured for Ch1, 
writes 0 to the device addresses configured for the other channels.

Ch2: Makes Ch2 the default knob position. Writes 1 to the device address configured for Ch2, 
writes 0 to the device addresses configured for the other channels.

Ch3: Makes Ch3 the default knob position. Writes 1 to the device address configured for Ch3, 
writes 0 to the device addresses configured for the other channels.

Read from Destination Device Address: The position of the knob is determined by the value 
of device address.

The default knob position is fixed for these two switch types because of the return functionality.
2-Notch R-return: Ch1
2-Note L-return, 3-Notch Both-return: Ch2

• If Default Position is Ch1, Ch2, or Ch3, the position of the knob does not change even if the 
value in the device address configured for the channel changes, unless the change is caused by 
the buttons on the Selector Switch. If Default Position is Read from Destination Device 
Address, the position of the knob changes according to the value of the device address 
configured for the channel.

• When a Selector Switch is redisplayed immediately after switching the screen or when a hidden 
Selector Switch is redisplayed, values are not written to the destination device addresses for the 
channels.

• If the value in the device address used to determine the default knob position contains an illegal 
value, the knob will be shown as follows:
- 2-Notch No-return: Ch1
- 3-Notch: Ch2
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Notch Settings Dialog Box

This dialog configures a notch for a channel. If the channel has already been set with a notch, the setting is 
overwritten.

■ Destination Device Address
Specify the destination bit device or the bit number in the destination word device.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.

■ Text
Enter the Registration Text for the channel.
The characters that can be entered depends on the font selected for Font on the Format tab. For details, refer to 
Chapter 2 “1.2 Available Text” on page 2-6.

■ Text ID
To use the text registered in the Text Manager as the Registration Text for the channel, specify the ID number from 1 
to 32000.

Click  to display Text Manager.
The text ID setting is only enabled if you select the Use Text Manager check box.

■ Text Color
Select the Registration Text color for the channel (color: 256 colors, monochrome: 16 shades).
Displays the Color Palette when Color is clicked. Select a color from the Color Palette.
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● View Tab

■ Browse
Select the type of graphic to be used to represent the part from the list of graphics. Click this button to display the 
View Browser.

■ Knob Color
Selects the knob color of the Selector Switch (color: 256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

■ Flange

■ Switch

Knob

Foreground Color, Background Color: Selects the foreground and background colors of the flange (color: 256 
colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

Pattern: Selects a pattern for the flange.
Click Pattern to display the Pattern Palette. Select a pattern from the Pattern 
Palette.

Flange

Foreground Color, Background Color: Selects the foreground and background colors of the buttons (color: 256 
colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

Pattern: Selects a pattern or tonal gradation for the button.
Click Pattern to display the Pattern Palette. Select a pattern or tonal 
gradation from the Pattern Palette.

Buttons
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■ Coordinates

■ Size

X, Y: Sets the display position of parts using coordinates.
The X and Y coordinates of parts are defined relative to an origin at the top-left corner of the screen.

X: 0 to (base screen horizontal size - 1)

Y: 0 to (base screen vertical size - 1)

(0, 0)
X

Y
Screen

Parts

W, H: Sets width and height to define the size of parts.

W: 20 to (base screen horizontal size)

H: 20 to (base screen vertical size)

Width

Height

Screen

Parts



8 Selector Switch

8-152 WindO/I-NV4 User’s Manual

● Format Tab

■ Font
Selects the font used for displaying text from the following.
Japanese, European, Chinese, Taiwanese, Korean, Central European, Baltic, Cyrillic, Stroke
Can only be set when the Use Text Manager check box is cleared.
The characters that can be displayed depend on the font. For details, refer to Chapter 2 “1.2 Available Text” on page 
2-6.

■ Size
Sets the character size (8 to 128).
Can only be set when Stroke is selected.

■ Style
Selects Regular or Bold for text style.
Can only be set when Font is set to Japanese, European, Chinese, Taiwanese, Korean, Central European, 
Baltic or Cyrillic.

■ Magnification

Can only be set when Font is set to Japanese, European, Chinese, Taiwanese, Korean, Central European, 
Baltic or Cyrillic.

W, H: Selects the magnification (0.5, 1 to 8) for text display.
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● Trigger Condition Tab
The Trigger Condition tab is displayed in Advanced mode.

■ Input Condition
The Selector Switch is enabled and operational while the condition is satisfied. The Selector Switch is disabled and not 
operational while the condition is not satisfied.
Example: When Trigger Type is While ON and Device Address is LM0

While LM0 is 0, the condition is not satisfied and the Selector Switch is not operational.
While LM0 is 1, the condition is satisfied and the Selector Switch is operational.

Trigger Type: Selects the condition to enable the Selector Switch from the following.

Always enable: The Selector Switch is always enabled.

While ON: Enables the Selector Switch when the value of device address is 1.

LM0:

MICRO/I

0

LM0: 1

Button
Does not
operate

Button
Operates

Condition 
Not 

satisfied

Condition 
Satisfied

Selector Switch 
state

Enabled

1

0

Value of
device address

Disabled

Selector 
Switch state

Disabled DisabledEnabledEnabledEnabled
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■ Visible Condition
The Selector Switch is displayed while the condition is satisfied. The Selector Switch is hidden while the condition is 
not satisfied.
Example: When Trigger Type is While ON and Device Address is LM0

While LM0 is 0, the condition is not satisfied and the Selector Switch is hidden.
While LM0 is 1, the condition is satisfied and the Selector Switch is displayed.

While OFF: Enables the Selector Switch when the value of device address is 0.

While satisfying the condition: Enables the Selector Switch when the condition is satisfied.

Data Type: Selects the type of data handled by the conditional expression for the input condition.
This option can only be configured if While satisfying the condition is selected for Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Device Address: Specifies the bit device or the bit number of the word device to serve as the input condition.
This option can only be configured when While ON or While OFF is selected for Trigger Type.
Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 
“5.1 Device Address Settings” on page 2-68.

Condition: Specifies the conditional expression for the input condition.
This option can only be configured when While satisfying the condition is selected for Trigger 
Type.
Click  to display the Trigger Condition Settings dialog box. For the conditional expression 
configuration procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-71.

Comment: Used for entering a comment for the input condition. The maximum number is 80 characters.

1

0

Enabled Disabled

Value of
device address

Selector 
Switch state

Disabled DisabledEnabled Enabled

Selector 
Switch state

DisabledDisabledDisabled Enabled Enabled Enabled

Satisfied

Not satisfied

Condition

LM0:

MICRO/I

0

LM0: 1
Show

Condition 
Not 

satisfied

Condition 
Satisfied

Hide

If a hidden Selector Switch is redisplayed on the screen when Read from Destination Device Address is 
selected for Default Position on the General tab, the display position of the knob changes according to 
the value of the device address configured for the channel. When Ch1, Ch2, or Ch3 is selected, the knob is 
displayed at the same position as before it was hidden, regardless of the value of device address configured 
for the channel.
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Trigger Type: Selects the condition to display the Selector Switch from the following.

Always visible: The Selector Switch is always displayed.

While ON: Displays the Selector Switch when the value of device address is 1.

While OFF: Displays the Selector Switch when the value of device address is 0.

While satisfying the condition: Displays the Selector Switch when the condition is satisfied.

Data Type: Selects the type of data handled by the conditional expression for the visible condition.
This option can only be configured if While satisfying the condition is selected for Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Device Address: Specifies the bit device or the bit number of the word device to serve as the visible condition.
This option can only be configured when While ON or While OFF is selected for Trigger Type.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 
“5.1 Device Address Settings” on page 2-68.

Condition: Specifies the conditional expression for the visible condition.
This option can only be configured when While satisfying the condition is selected for Trigger 
Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expression 
configuration procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-71.

Comment: Used for entering a comment for the visible condition. The maximum number is 80 characters.

Selector Switch 
state

Always show

1

0

Hide Show Hide HideShow Show

Value of
device address

Selector 
Switch state

Value of
device address

1

0

Show Show ShowHide Hide Hide

Selector 
Switch state

Hide Hide HideShow Show Show

Selector Switch 
state

Satisfied

Not satisfied

Condition
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● Options Tab
The Options tab is displayed in Advanced mode.

■ No Touch Sound
This function is to disable touch sounds only for specified parts when the MICRO/I makes touch sounds.
Select this check box to display disable touch sounds for this part.

■ Place on the Top Layer
Select this check box to display the parts on the top layer. The parts will have precedence when other drawings and 
parts are overlapping with it. For details, refer to Chapter 6 “4 Drawings and Parts Overlapping” on page 6-5.

To enable touch sounds on the MICRO/I, select the Enable Touch Sound check box under the System 
tab of the Project Settings dialog box.
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● Security Tab
This tab is used to restrict displaying and using the part by security groups.
This option can only be set when Use Security functions is selected. The Use Security functions check box is set 
on General tab in the Security dialog box.

■ (Settings)
Displays the list of security groups used on the MICRO/I.

■ Security Settings
The Security Settings dialog box is displayed. If you create a security group in the Security Settings dialog box, you 
can select that created group. For details, refer to Chapter 23 “2.2 Adding and Editing Security Groups” on page 23-
19.

(Settings)

No.: Displays the security group numbers (0 to 15).

Group Name: Displays the name of the security group.

Display: Displays whether or not there is permission to display the part. Only Permitted security groups 
can display this part. If all security groups are set to Permitted, this part will be displayed even 
if no user account has been selected. Double clicking the cell switches between Permitted and 
Prohibited.

Input: Displays whether or not there is permission to use the part. Only Permitted security groups 
can use this part. If all security groups are set to Permitted, this part can be used even if no 
user account has been selected. Double clicking the cell switches between Permitted and 
Prohibited.

• You can also switch between Permitted and Prohibited by right-clicking on a Display or Input cell.
• Restricting the display and use of the part by switching between Permitted and Prohibited in Display 

and Input cells is similar to using the Trigger Condition tab.

For details about security functions, refer to Chapter 23 “User Accounts and the Security Function” on page 
23-1.
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Example: If the user and security group for a part are set as follows:

For User1 in the Reader security group, the parts for which Display has been set to Prohibited for Reader will not 
be displayed.
If the password screen is opened and the user switches to User2 in the Operator security group, the parts for which 
Display has been set to Permitted for Operator will be displayed.

For User2 in Operator, Display has been set to Permitted for Operator, but Input is Prohibited, so the part 
cannot be used.
If the password screen is opened and the user switches to User3 in the Administrator security group, the parts for 
which Display has been set to Permitted for Administrator will be displayed, and the parts for which Input has 
been set to Permitted for Administrator can be used.

User Name

Security Group Reader Operator Administrator
User1 User2 User3

MICRO/I

130

Numerical Display
No. Group Name Display

1 Administrator Permitted

2 Operator Permitted

3 Reader Permitted

Button
No. Group Name Display Input

1 Administrator Permitted Permitted

2 Operator Permitted Prohibited

3 Reader Prohibited Prohibited

Line Chart and Bar Chart
No. Group Name Display

1 Administrator Permitted

2 Operator Permitted

3 Reader Prohibited

Open Password Screen, 
enter password, 
and switch to User2

For User1, 
parts for which Display 
has been set to Prohibited 
for Reader are not displayed

For User2, 
parts for which Display 
has been set to Permitted 
for Operator are displayed

MICRO/I

130

MICRO/I MICRO/I

130

User1 User2

130
CAN

User Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password

Open Password Screen, 
enter password, 
and switch to User3

For User2, 
parts for which Display 
has been set to Permitted 
for Operator are displayed, 
but parts for which Input 
has been set to Prohibited cannot be used

For User3, 
parts for which Display 
has been set to Permitted 
for Administrator are displayed, 
and parts for which Input 
has been set to Permitted can be used

MICRO/I

130

MICRO/I MICRO/I

130130 130

User2 User3

Button
Can operate

CAN

User Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password

Button
Cannot operate
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● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Used for entering comments about parts. The maximum number is 80 characters.
Example: When mousing over the Selector Switch on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.
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9.1 How the Potentiometer is Used

Writes a value to a word device by pressing a slider button.

• The slider display position increases and decreases while the button is depressed. The value of the slider at the 
displayed position is written to the device address when the button is released.

The slider indicates the value written to the device address. When the value is increased or decreased, the slider 
display position also changes.
The slider moves between a user-defined minimum and maximum value.
The input value increases and decreases while the button is depressed. The value of the slider at the displayed 
position is written to the device address when the button is released.

9 Potentiometer

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

D0  : 0

Value of slider at 
displayed position

105

127

Value of slider at 
displayed position

D0  : 127

MICRO/I

D0  :

Value of slider at 
displayed position

0

0

Write to device address

External device

Default state Press R-button Release Press L-button Release

Operation 
and view

Slider StopMoves rightStop StopMoves left

Value Increases Decreases

Action Write Write

The slider display position does not change when the destination device address value changes unless it 
was changed by the Potentiometer buttons. However, immediately after the screen is switched and 
immediately after the part is displayed on the screen, the slider is displayed at the position specified by the 
value of the destination device address.
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9.2 Potentiometer Configuration Procedure

This section describes the configuration procedure for Potentiometer parts.

1 On the Home tab, in the Parts group, click Buttons, and then click Potentiometer.

2 Click a point on the edit screen where you wish to place the Potentiometer.

3 Double-click the dropped Potentiometer and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.

The Trigger Condition tab and Options tab only appear in Advanced mode.
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9.3 Properties of Potentiometer Dialog Box

This section describes items and buttons in the Properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ Data Type
Select the data type to be handled by the Potentiometer.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

■ Minimum
Specify the minimum value that can be entered. The minimum value differs depending on the data type.

■ Maximum
Specify the maximum value that can be entered. The maximum value differs depending on the data type.

■ Destination Device Address
Specify the destination word device.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.
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● View Tab

■ Browse
Select the type of graphic to be used to represent the part from the list of graphics. Click this button to display the 
View Browser.

■ Slider Color
Selects the slider color of the Potentiometer (color: 256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

■ Plate Color
Selects the plate color (color: 256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

■ Flange

Slider

Plate color

Foreground Color, Background Color: Selects the foreground and background colors of the flange (color: 256 
colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

Pattern: Selects a pattern for the flange.
Click Pattern to display the Pattern Palette. Select a pattern from the Pattern 
Palette.

Flange
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■ Switch

■ Coordinates

■ Size

Foreground Color, Background Color: Selects the foreground and background colors of the buttons (color: 256 
colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

Pattern: Selects a pattern or tonal gradation for the button.
Click Pattern to display the Pattern Palette. Select a pattern or tonal 
gradation from the Pattern Palette.

Buttons

X, Y: Sets the display position of parts using coordinates.
The X and Y coordinates of parts are defined relative to an origin at the top-left corner of the screen.

X: 0 to (base screen horizontal size - 1)

Y: 0 to (base screen vertical size - 1)

(0, 0)
X

Y
Screen

Parts

W, H: Sets width and height to define the size of parts.

W: 20 to (base screen horizontal size)

H: 20 to (base screen vertical size)

Width

Height

Screen

Parts
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● Trigger Condition Tab
The Trigger Condition tab is displayed in Advanced mode.

■ Input Condition
The Potentiometer is enabled and operational while the condition is satisfied. The Potentiometer is disabled and not 
operational while the condition is not satisfied.
Example: When Trigger Type is While ON and Device Address is LM0

While LM0 is 0, the condition is not satisfied and the Potentiometer is not operational.
While LM0 is 1, the condition is satisfied and the Potentiometer is operational.

Trigger Type: Selects the condition to enable the Potentiometer from the following.

Always enable: The Potentiometer is always enabled.

While ON: Enables the Potentiometer when the value of device address is 1.

LM0:

MICRO/I

0

LM0: 1

Button
Does not
operate

Button
Operates

Condition 
Not 

satisfied

Condition 
Satisfied

Enabled

Potentiometer 
state

1

0

Value of
device address

Disabled Disabled DisabledEnabledEnabledEnabled

Potentiometer 
state
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■ Visible Condition
The Potentiometer is displayed while the condition is satisfied. The Potentiometer is hidden while the condition is not 
satisfied.
Example: When Trigger Type is While ON and Device Address is LM0

While LM0 is 0, the condition is not satisfied and the Potentiometer is hidden.
While LM0 is 1, the condition is satisfied and the Potentiometer is displayed.

While OFF: Enables the Potentiometer when the value of device address is 0.

While satisfying the condition: Enables the Potentiometer when the condition is satisfied.

Data Type: Selects the type of data handled by the conditional expression for the input condition.
This option can only be configured if While satisfying the condition is selected for Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Device Address: Specifies the bit device or the bit number of the word device to serve as the input condition.
This option can only be configured when While ON or While OFF is selected for Trigger Type.
Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 
“5.1 Device Address Settings” on page 2-68.

Condition: Specifies the conditional expression for the input condition.
This option can only be configured when While satisfying the condition is selected for Trigger 
Type.
Click  to display the Trigger Condition Settings dialog box. For the conditional expression 
configuration procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-71.

Comment: Used for entering a comment for the input condition. The maximum number is 80 characters.

1

0

Enabled Disabled

Value of
device address

Disabled DisabledEnabled Enabled

Potentiometer 
state

DisabledDisabledDisabled Enabled Enabled Enabled

Potentiometer 
state

Satisfied

Not satisfied

Condition

LM0:

MICRO/I

0

LM0: 1
Show

Condition 
Not 

satisfied

Condition 
Satisfied

Hide

When a hidden Potentiometer is redisplayed, the slider is displayed at the position specified by the value of 
device address.
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Trigger Type: Selects the condition to display the Potentiometer from the following.

Always visible: The Potentiometer is always displayed.

While ON: Displays the Potentiometer when the value of device address is 1.

While OFF: Displays the Potentiometer when the value of device address is 0.

While satisfying the condition: Displays the Potentiometer when the condition is satisfied.

Data Type: Selects the type of data handled by the conditional expression for the visible condition.
This option can only be configured if While satisfying the condition is selected for Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Device Address: Specifies the bit device or the bit number of the word device to serve as the visible condition.
This option can only be configured when While ON or While OFF is selected for Trigger Type.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 
“5.1 Device Address Settings” on page 2-68.

Condition: Specifies the conditional expression for the visible condition.
This option can only be configured when While satisfying the condition is selected for Trigger 
Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expression 
configuration procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-71.

Comment: Used for entering a comment for the visible condition. The maximum number is 80 characters.

Always show

Potentiometer 
state

1

0

Hide Show Hide HideShow Show

Value of
device address

Potentiometer 
state

Value of
device address

Potentiometer 
state

1

0

Show Show ShowHide Hide Hide

Hide Hide HideShow Show Show

Potentiometer 
state

Satisfied

Not satisfied

Condition
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● Options Tab
The Options tab is displayed in Advanced mode.

■ No Touch Sound
This function is to disable touch sounds only for specified parts when the MICRO/I makes touch sounds.
Select this check box to display disable touch sounds for this part.

■ Place on the Top Layer
Select this check box to display the parts on the top layer. The parts will have precedence when other drawings and 
parts are overlapping with it. For details, refer to Chapter 6 “4 Drawings and Parts Overlapping” on page 6-5.

To enable touch sounds on the MICRO/I, select the Enable Touch Sound check box under the System 
tab of the Project Settings dialog box.
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● Security Tab
This tab is used to restrict displaying and using the part by security groups.
This option can only be set when Use Security functions is selected. The Use Security functions check box is set 
on General tab in the Security dialog box.

■ (Settings)
Displays the list of security groups used on the MICRO/I.

■ Security Settings
The Security Settings dialog box is displayed. If you create a security group in the Security Settings dialog box, you 
can select that created group. For details, refer to Chapter 23 “2.2 Adding and Editing Security Groups” on page 23-
19.

(Settings)

No.: Displays the security group numbers (0 to 15).

Group Name: Displays the name of the security group.

Display: Displays whether or not there is permission to display the part. Only Permitted security groups 
can display this part. If all security groups are set to Permitted, this part will be displayed even 
if no user account has been selected. Double clicking the cell switches between Permitted and 
Prohibited.

Input: Displays whether or not there is permission to use the part. Only Permitted security groups 
can use this part. If all security groups are set to Permitted, this part can be used even if no 
user account has been selected. Double clicking the cell switches between Permitted and 
Prohibited.

• You can also switch between Permitted and Prohibited by right-clicking on a Display or Input cell.
• Restricting the display and use of the part by switching between Permitted and Prohibited in Display 

and Input cells is similar to using the Trigger Condition tab.

For details about security functions, refer to Chapter 23 “User Accounts and the Security Function” on page 
23-1.
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Example: If the user and security group for a part are set as follows:

For User1 in the Reader security group, the parts for which Display has been set to Prohibited for Reader will not 
be displayed.
If the password screen is opened and the user switches to User2 in the Operator security group, the parts for which 
Display has been set to Permitted for Operator will be displayed.

For User2 in Operator, Display has been set to Permitted for Operator, but Input is Prohibited, so the part 
cannot be used.
If the password screen is opened and the user switches to User3 in the Administrator security group, the parts for 
which Display has been set to Permitted for Administrator will be displayed, and the parts for which Input has 
been set to Permitted for Administrator can be used.

User Name

Security Group Reader Operator Administrator
User1 User2 User3

MICRO/I

130

Numerical Display
No. Group Name Display

1 Administrator Permitted

2 Operator Permitted

3 Reader Permitted

Button
No. Group Name Display Input

1 Administrator Permitted Permitted

2 Operator Permitted Prohibited

3 Reader Prohibited Prohibited

Line Chart and Bar Chart
No. Group Name Display

1 Administrator Permitted

2 Operator Permitted

3 Reader Prohibited

Open Password Screen, 
enter password, 
and switch to User2

For User1, 
parts for which Display 
has been set to Prohibited 
for Reader are not displayed

For User2, 
parts for which Display 
has been set to Permitted 
for Operator are displayed

MICRO/I

130

MICRO/I MICRO/I

130

User1 User2

130
CAN

User Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password

Open Password Screen, 
enter password, 
and switch to User3

For User2, 
parts for which Display 
has been set to Permitted 
for Operator are displayed, 
but parts for which Input 
has been set to Prohibited cannot be used

For User3, 
parts for which Display 
has been set to Permitted 
for Administrator are displayed, 
and parts for which Input 
has been set to Permitted can be used

MICRO/I

130

MICRO/I MICRO/I

130130 130

User2 User3

Button
Can operate

CAN

User Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password

Button
Cannot operate



WindO/I-NV4 User’s Manual 8-171

9 Potentiometer

8

Buttons

● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Used for entering comments about parts. The maximum number is 80 characters.
Example: When mousing over the Potentiometer on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.
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This chapter describes the setup for the lamp parts and related MICRO/I operations.

  

1.1 How the Pilot Lamp is Used

Pilot Lamp parts display drawing objects. The value of a bit device is used to switch the drawing object displayed.

• Switch and display pictures by values of device addresses

Chapter 9 Lamps

1 Pilot Lamp

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

MICRO/I
External device

0

1
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1.2 Pilot Lamp Configuration Procedure

This section describes the configuration procedure for Pilot Lamps.

1 On the Home tab, in the Parts group, click Lamps, and then click Pilot Lamp.

2 Click a point on the Edit screen where you wish to place the Pilot Lamp.

3 Double-click the dropped Pilot Lamp and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.

The Options tab only appears in Advanced mode.
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1.3 Properties of Pilot Lamp Dialog Box

This section describes items and buttons on the properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ >>OFF Text, >>ON Text
Applies the text entered in the Part Name field to the Text field under the OFF or ON fields on the Registration 
Text tab. This is used as the Registration Text when the lamp is OFF or ON.

■ Action Mode
Select the action when the part is ON.

To specify the Registration Text to use when the button is ON, select the Set by State check box on the 
Registration Text tab. If left unchecked, the same Registration Text assigned for the OFF state is 
displayed for the ON state as well.

No Flash (only ON): Displays the drawing object for the ON state when the trigger condition is satisfied.

Flash (ON + Flash): When the condition is satisfied and the value of the trigger device address is 1, the object flashes 
(alternates between the drawing object for the ON and OFF states at fixed intervals). The 
flashing interval can be set with the Flashing Cycle setting on the System tab of the Project 
Settings dialog box.

Flash Trigger Device Address: Specify the bit device to cause the lamp to flash.
The lamp flashes when the value of the device address is 1. The 
action for No Flash (only ON) applies when the value is 0.

Click  to display the Tag Editor. For the device address 
configuration procedure, refer to Chapter 2 “5.1 Device Address 
Settings” on page 2-68.
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Example: When Action Mode is Flash (ON + Flash), Flash Trigger Device Address is M0, and on the Trigger 
Condition tab, Trigger Type is While ON, Device Address is LM0

0

Displayed drawing object

Trigger Condition: Device Address LM0 value 1 1 0

0Action Mode: Value of Flash Trigger Device Address M0 0 1 1

Displays OFF 
drawing object

Action Displays ON 
drawing object Flashing Displays OFF 

drawing object

The lamp will neither turn on or flash if the trigger conditions are not met. Lamp trigger conditions are 
configured on the Trigger Condition tab.
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● View Tab

■ Image Type
Select the type of graphic to be used to represent the part.

■ Browse
Select the type of graphic to be used to represent the part from the list of graphics. Click this button to display the 
View Browser or Picture Manager, depending on the setting for Image Type.

■ OFF button, ON button
Displays the graphic when ON or OFF. Clicking ON or OFF switches the image displayed on the View tab.

■ OFF, ON
Selects the color and pattern of the standard graphic when ON and OFF.

■ Not Display Image*1

Select this check box to display no drawing object in the OFF state.

*1 Advanced mode only

Standard: Uses the default graphic for WindO/I-NV4.

Picture: Uses an image file saved using Picture Manager.
For details about image file restrictions, refer to Chapter 2 “1.4 Available Image Files” on page 2-20.

Foreground Color, Background Color:

Selects the foreground and background colors of the standard graphic (color: 256 colors, 
monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

Pattern: Selects a pattern or tonal gradation for the standard graphic.
Click Pattern to display the Pattern Palette. Select a pattern or tonal gradation from the Pattern 
Palette.

If the Not Display Image check box is selected, Text set as registration text for the OFF state will be 
displayed.
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■ Coordinates

■ Size

X, Y: Sets the display position of parts using coordinates.
The X and Y coordinates of parts is defined relative to an origin at the top-left corner of the screen.

X: 0 to (base screen horizontal size - 1)

Y: 0 to (base screen vertical size - 1)

(0, 0)
X

Y
Screen

Parts

Sets width and height to define the size of parts. The minimum size varies based on the item selected for Image Type.

Standard: The minimum size varies based on the selected item and the maximum size is a base screen size.

Picture: W: 2 to (base screen horizontal size)

H: 2 to (base screen vertical size)

Width

Height

Screen

Parts
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● Registration Text Tab

■ Font
Selects the font used for displaying text from the following.
Japanese, European, Chinese, Taiwanese, Korean, Central European, Baltic, Cyrillic, Windows, Stroke
Can only be set when the Use Text Manager check box is cleared.
The characters that can be displayed depend on the font. For details, refer to Chapter 2 “1.2 Available Text” on page 
2-6.

■ Size
Sets the character size (8 to 128).
Can only be set when Stroke is selected.

■ Style
Selects Regular or Bold for text style.
Can only be set when Font is set to Japanese, European, Chinese, Taiwanese, Korean, Central European, 
Baltic or Cyrillic.

■ Magnification

Can only be set when Font is set to Japanese, European, Chinese, Taiwanese, Korean, Central European, 
Baltic or Cyrillic.

■ Align Text Horizontal
Selects text alignment in the horizontal direction.
Left, Center, Right, Center-Left
For details, refer to Appendix “5 Text Alignment” on page A-7.

■ Align Text Vertical
Selects text alignment in the vertical direction.
Top, Center, Bottom
This option can only be configured when Left, Center, or Right is selected for Align Text Horizontal. If Center-
Left is selected for Align Text Horizontal, Center-Top is set as this option.
For details, refer to Appendix “5 Text Alignment” on page A-7.

■ Set by State
Select this check box if displaying different text when ON and OFF.

■ Use Text Manager
Select this check box if using the text registered in Text Manager for text display.

W, H: Selects the magnification (0.5, 1 to 8) for text display.
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■ OFF, ON

Text: Inputs characters to be displayed on parts. The maximum number is 3,750 characters.
The characters that can be entered depend on the font selected using Font. For details, refer to 
Chapter 2 “1.2 Available Text” on page 2-6.

Text ID: Specifies the Text Manager ID No. (1 to 32000) when using the text registered in the Text Manager.

Click  to display Text Manager.

Can only be set when the Use Text Manager check box is selected.

Text Color: Selects the color of the text displayed on the part (color: 256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

Windows Font: Sets the font to be used as the Windows Font.
Select Windows using Font to display the current setting. You can specify the character spacing (0 
to 100) and the line spacing (0 to 100). To change the settings other than the character spacing and 
line spacing, click Change to display the Font Settings dialog box.
Can only be set when the Use Text Manager check box is cleared.
For details, refer to Chapter 2 “Windows Font” on page 2-13.
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● Trigger Condition Tab

■ Lightning
The Pilot Lamp is on while the condition is satisfied, and it is off while the condition is not satisfied. The Pilot Lamp 
displays the ON graphic when on and it displays the OFF graphic when off.
Example: When Trigger Type is While ON and Device Address is LM0

When LM0 is 0, condition is not satisfied, so Lamp displays OFF graphic.
When LM0 is 1, condition is satisfied, so Lamp displays ON graphic.

Trigger Type: Selects the condition to turn on the Pilot Lamp from the following.

While ON: Turns on the Pilot Lamp when the value of device address is 1.

LM0:

MICRO/I

0

LM0: 1

Condition
Not satisfied

Condition
Satisfied

Lamp
Displays OFF graphic

Lamp
Displays ON graphic

1

0

Value of 
device address

On Off

Pilot Lamp status

Off OffOn On
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■ Visible Condition
The Pilot Lamp is displayed while the condition is satisfied. The Pilot Lamp is hidden while the condition is not 
satisfied.
Example: When Trigger Type is While ON and Device Address is LM0

While LM0 is 0, the condition is not satisfied and the Pilot Lamp is hidden.
While LM0 is 1, the condition is satisfied and the Pilot Lamp is displayed.

While OFF: Turns on the Pilot Lamp when the value of device address is 0.

While satisfying the condition:
Turns on the Pilot Lamp when the condition is satisfied.

Data Type: Selects the type of data handled by the conditional expression for the on condition.
This option can only be configured if While satisfying the condition is selected for Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Device Address: Specifies the bit device or the bit number of the word device to serve as the on condition.
This option can only be configured when While ON or While OFF is selected for Trigger Type.
Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 
“5.1 Device Address Settings” on page 2-68.

Condition: Specifies the conditional expression for the on condition.
This option can only be configured when While satisfying the condition is selected for Trigger 
Type.
Click  to display the Trigger Condition Settings dialog box. For the conditional expression 
configuration procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-71.

Comment: Used for entering a comment for the on condition. The maximum number is 80 characters.

1

0

On On OnOff Off Off

Pilot Lamp status

Value of 
device address

On OffOff OffOn On

Pilot Lamp status

Condition
Satisfied

Not satisfied

LM0:

MICRO/I

0

LM0: 1
Show

Condition 
Not 

satisfied

Condition 
Satisfied

Hide
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Trigger Type: Selects the condition to display the Pilot Lamp from the following.

Always visible: The Pilot Lamp is always displayed.

While ON: Displays the Pilot Lamp when the value of device address is 1.

While OFF: Displays the Pilot Lamp when the value of device address is 0.

While satisfying the condition: Displays the Pilot Lamp when the condition is satisfied.

Data Type: Selects the type of data handled by the conditional expression for the visible condition.
This option can only be configured if While satisfying the condition is selected for Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Device Address: Specifies the bit device or the bit number of the word device to serve as the visible condition.
This option can only be configured when While ON or While OFF is selected for Trigger Type.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 
“5.1 Device Address Settings” on page 2-68.

Condition: Specifies the conditional expression for the visible condition.
This option can only be configured when While satisfying the condition is selected for Trigger 
Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expression 
configuration procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-71.

Comment: Used for entering a comment for the visible condition. The maximum number is 80 characters.

Always show

Pilot Lamp state

1

0

Hide Show Hide HideShow Show

Value of 
device address

Pilot Lamp state

1

0

Show Show ShowHide Hide Hide

Value of 
device address

Pilot Lamp state

Pilot Lamp state

Hide Hide HideShow Show Show

Satisfied

Not satisfied

Condition
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● Options Tab
The Options tab is displayed in Advanced mode.

■ Place on the Top Layer
Select this check box to display the parts on the top layer. The parts will have precedence when other drawings and 
parts are overlapping with it. For details, refer to Chapter 6 “4 Drawings and Parts Overlapping” on page 6-5.
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● Security Tab
This tab is used to restrict displaying and using the part by security groups.
This option can only be set when Use Security functions is selected. The Use Security functions check box is set 
on General tab in the Security dialog box.

■ (Settings)
Displays the list of security groups used on the MICRO/I.

■ Security Settings
The Security Settings dialog box is displayed. If you create a security group in the Security Settings dialog box, you 
can select that created group. For details, refer to Chapter 23 “2.2 Adding and Editing Security Groups” on page 23-
19.

(Settings)

No.: Displays the security group numbers (0 to 15).

Group Name: Displays the name of the security group.

Display: Displays whether or not there is permission to display the part. Only Permitted security groups 
can display this part. If all security groups are set to Permitted, this part will be displayed even 
if no user account has been selected. Double clicking the cell switches between Permitted and 
Prohibited.

You can also switch between Permitted and Prohibited by right-clicking on a Display cell.

For details about security functions, refer to Chapter 23 “User Accounts and the Security Function” on page 
23-1.
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Example: If the user and security group for a part are set as follows:

For User1 in the Reader security group, the parts for which Display has been set to Prohibited for Reader will not 
be displayed.
If the password screen is opened and the user switches to User2 in the Operator security group, the parts for which 
Display has been set to Permitted for Operator will be displayed.

User Name

Security Group Reader Operator
User1 User2

MICRO/I

130

Numerical Display
No. Group Name Display

1 Administrator Permitted

2 Operator Permitted

3 Reader Permitted

Button
No. Group Name Display Input

1 Administrator Permitted Permitted

2 Operator Permitted Prohibited

3 Reader Prohibited Prohibited

Line Chart and Bar Chart
No. Group Name Display

1 Administrator Permitted

2 Operator Permitted

3 Reader Prohibited

Open Password Screen, 
enter password, 
and switch to User2

For User1, 
parts for which Display 
has been set to Prohibited 
for Reader are not displayed

For User2, 
parts for which Display 
has been set to Permitted 
for Operator are displayed

MICRO/I

130

MICRO/I MICRO/I

130

User1 User2

130
CAN

User Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password
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● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Used for entering comments about parts. The maximum number is 80 characters.
Example: When mousing over the Pilot Lamp on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.



2 Multi-State Lamp

9-16 WindO/I-NV4 User’s Manual

  

2.1 How the Multi-State Lamp is Used

Multi-state lamp parts display drawing objects. The value of a specified word device is used to switch the drawing 
object to be displayed.

• Switch and display pictures by values of device addresses

2 Multi-State Lamp

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

External device
MICRO/I

D0

bit15 bit0bit3

D0= 0100

bit0bit3

D0= 0001

bit0bit3

D0= 0010

bit0bit3

D0= 0000

bit0bit3

 State: 0State: 1State: 2 OFF

(None)
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• Display a picture when in the OFF state.

MICRO/I
External device

D0

bit15 bit0bit3

D0= 0100

bit0bit3

D0= 0001

bit0bit3

D0= 0010

bit0bit3

D0= 0000

bit0bit3

OFF State: 0State: 1State: 2

The conditions to display the picture set by the OFF state on the screen are as follows.
• Y is selected under Flash on the State tab and the trigger condition is not satisfied.
• Switching Method on the General tab is Bit Number, and the all bit in the device address are 0 or a 

bit not allocated a picture is 1.
• Switching Method on the General tab is Value, and the value of device address is a number not 

allocated a picture.
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2.2 Multi-State Lamp Configuration Procedure

This section describes the configuration procedure for Multi-State Lamps.

1 On the Home tab, in the Parts group, click Lamps, and then click Multi-State Lamp.

2 Click a point on the edit screen where you wish to place the Multi-State Lamp.

3 Double-click the dropped Multi-State Lamp and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.

The Options tab only appears in Advanced mode.
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2.3 Properties of Multi-State Lamp Dialog Box

This section describes items and buttons on the properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ Switching Method
Specify the method to switch drawing objects from the following:

Bit Number: Switches the drawing object displayed, according to the status of the bits.
Example 1: Bit Number is selected. The bits triggered in device address D0 corresponds to the 

following pictures and the OFF state is None.

Switches the picture to display according to the status of the bits.

bit15 bit0bit3

Value of 
Trigger Device Address D0

Picture

State:  0 State:  1State:  2

(None)

OFF

Display picture 
for bit 0

Display picture 
for bit 1

Display picture 
for bit 2

No picture Display picture 
for bit 1

Display picture 
for bit 2

0001 0010 0100 1000 1110 1100

State:  0 State:  1 State:  1State:  2 State: 2

Picture to display

Bit state of 
Trigger Device Address D0

Action

I f  mu l t ip le  b i t s  a re  1 ,  
display the picture for the 
lowest order bit.

If all bits in the device address are 
0 or if a bit with no associated 
picture becomes 1, display nothing.
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Example 2: Bit Number is selected. The bits of trigger device address D0 and the OFF state are 
allocated to the following pictures.

Switches the picture to display according to the status of the bits.

Value: Switches the drawing object displayed, according to the value of the device address.
Example 3: Value is selected. The value assigned to the trigger device address D0 are allocated to the 

following pictures and the OFF state is None.

Switches the picture to display according to the value of the device address.

Example 4: Value is selected. The values assigned in trigger device address D0 and the OFF state are 
allocated to the following pictures.

Switches the picture to display according to the value of the device address.

bit15 bit0bit3

Value of
Trigger Device Address D0

Picture

State:  0 State:  1State:  2 OFF

OFF

Display picture 
for bit 0

Display picture 
for bit 1

Display picture 
for bit 2

Display picture 
for OFF state

Display picture 
for bit 1

Display picture 
for bit 2

0001 0010 0100 1000 1110 1100

State:  0 State:  1 State:  1State:  2 State: 2

Picture to display

Bit state of
Trigger Device Address D0

Action

I f  mu l t ip le  b i t s  a re  1 ,  
display the picture for the 
lowest order bit.

If all bits in the device address are 0 or if 
a bit with no associated picture becomes 
1, display the picture for OFF state.

0 1 2Value of
Trigger Device Address D0

Picture

State: 2State:  1State:  0

(None)

OFF

Display picture for 0 Display picture for 1 Display picture for 2 No picture

0 1 2 3

State:  0 State:  1 State: 2

Picture to display

Value of
Trigger Device Address D0

Action

If the value of device 
address has no picture 
associated with it, display 
nothing.

OFF

0 1 2Value of
Trigger Device Address D0

Picture

State: 2State:  1State:  0

OFF

Display picture 
for 0

Display picture 
for 1

Display picture 
for 2

Display picture 
for OFF state

0 1 2 3

State:  0 State:  1 State: 2

Picture to display

Value of
Trigger Device Address D0

Action

If the value of device 
address has no picture 
associated with it, display 
the picture for OFF state.
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■ Trigger Device Address
Specifies the word device to use as the condition for switching the drawing object.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.



2 Multi-State Lamp

9-22 WindO/I-NV4 User’s Manual

● View Tab

■ Image Type
Select the type of graphic to be used to represent the part.

■ Coordinates

■ Size

Standard: Uses the default graphic for WindO/I-NV4.

Picture: Uses an image file saved using Picture Manager.
For details about image file restrictions, refer to Chapter 2 “1.4 Available Image Files” on page 2-20.

X, Y: Sets the display position of parts using coordinates.
The X and Y coordinates of parts is defined relative to an origin at the top-left corner of the screen.

X: 0 to (base screen horizontal size - 1)

Y: 0 to (base screen vertical size - 1)

(0, 0)
X

Y
Screen

Parts

Sets width and height to define the size of parts. The minimum size varies based on the item selected for Image Type.

Standard: The minimum size varies based on the selected item and the maximum size is a base screen size.

Picture: W: 2 to (base screen horizontal size)

H: 2 to (base screen vertical size)

Width

Height

Screen

Parts
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● Registration Text Tab

■ Font
Selects the font used for displaying text from the following.
Japanese, European, Chinese, Taiwanese, Korean, Central European, Baltic, Cyrillic, Windows, Stroke
Can only be set when the Use Text Manager check box is cleared.
The characters that can be displayed depend on the font. For details, refer to Chapter 2 “1.2 Available Text” on page 
2-6.

■ Size
Sets the character size (8 to 128).
Can only be set when Stroke is selected.

■ Style
Selects Regular or Bold for text style.
Can only be set when Font is set to Japanese, European, Chinese, Taiwanese, Korean, Central European, 
Baltic or Cyrillic.

■ Magnification

Can only be set when Font is set to Japanese, European, Chinese, Taiwanese, Korean, Central European, 
Baltic or Cyrillic.

■ Align Text Horizontal
Selects text alignment in the horizontal direction.
Left, Center, Right, Center-Left
For details, refer to Appendix “5 Text Alignment” on page A-7.

■ Align Text Vertical
Selects text alignment in the vertical direction.
Top, Center, Bottom
This option can only be configured when Left, Center, or Right is selected for Align Text Horizontal. If Center-
Left is selected for Align Text Horizontal, Center-Top is set as this option.
For details, refer to Appendix “5 Text Alignment” on page A-7.

■ Use Text Manager
Select this check box if using the text registered in Text Manager for text display.

W, H: Selects the magnification (0.5, 1 to 8) for text display.
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● State Tab

■ Number of States
Specify the number of drawing objects (1 to 16) to display by switching.

■ Settings
Lists the state settings. The list shows various settings such as the state number and file name for the drawing object.

State: Shows the OFF state and state number. 
Double clicking the cell displays the State Settings dialog box where you can edit the state 
settings. For details, refer to “State Settings Dialog Box” on page 9-26.

Image: Shows the name or a file name for a drawing object. 
Double clicking the cell opens the View Browser if Standard is selected under Image Type on 
the View tab, or Picture Manager if Picture is selected. This allows you to change the drawing 
object to display.

Text: Shows the registration text. 
Double clicking the cell allows you to edit the Registration Text.
Can only be set when the Use Text Manager check box is cleared.

Text ID: Shows the Text ID.
Double clicking the cell displays the Text Manager where you can change the Text ID.
Can only be set when the Use Text Manager check box is selected.

Fg.Color, Bg.Color: Shows the foreground and background colors for standard images. 
Double clicking the cell opens the Color Palette where you can change the foreground and 
background colors. This setting can only be changed if Image Type is set to Standard on the 
View tab.
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■ Image
Shows the image for the OFF state or state number selected in the Settings list.

■ Copy to next State
Select this check box to register or change all state settings at once.
This option copies the current settings to all state numbers after the selected state number when the settings are set 
or changed. This option can only be set when a state number is selected.

Pattern: Shows the pattern or tonal gradation for standard images. 
Double clicking the cell opens the Pattern Palette where you can change the pattern or tonal 
gradation of the image. This setting can only be changed if Image Type is set to Standard on 
the View tab.

Text Color Shows the color of the registration text. Double clicking the cell opens the Color Palette where 
you can change the color of the text.

Flash: Indicates whether to display the drawing object flashing or constantly lit. Double clicking the cell 
toggles between Y for yes and N for no. If Y is selected, the picture which corresponds to a bit 
state or value of device is alternately shown and hidden at a fixed time interval.
However, if the OFF state is set, the picture that corresponds to a bit state or value of device 
and the picture set for the OFF state are alternately displayed at a fixed time interval.

Windows Font: Shows the currently set Windows Font. Double clicking the cell displays the Font Settings 
dialog box where you can change the Windows Font. This setting can only be changed when 
Windows is selected for Font on the Registration Text tab.

Line Spacing: Shows the line spacing for Windows Font. Double clicking the cell allows you to change the line 
spacing (0 to 100). This setting can only be changed when Windows is selected for Font on 
the Registration Text tab.

Character Pitch: Shows the character spacing for Windows Font. Double clicking the cell allows you to change 
the character spacing (0 to 100). This setting can only be changed when Windows is selected 
for Font on the Registration Text tab.

Set: Registers the state settings to the list. If you select the OFF state or state number that is already 
registered, that number is overwritten with the new settings.
Click this button to display the State Settings dialog box. For details, refer to “State Settings 
Dialog Box” on page 9-26.

Insert: Inserts the settings in the position selected on the list.
Select a state number in the list and click this button to display the State Settings dialog box. 
The settings at the insertion point shift down one line. Settings cannot be inserted if all state 
numbers are configured.

Remove: Deletes the registered settings from the list.
Select the OFF state or state number and click this button to delete the selected settings from 
the list.

When the OFF state is not set

When ON

When OFF

Flash

When the OFF state is set

Flash

No picture is 
shown.

Shows the picture set 
for the OFF state

Shows the picture that 
corresponds to the bit 
state or device value

Shows the picture that 
corresponds to the bit 
state or device value
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State Settings Dialog Box

This dialog box sets the drawing object and registration text to display.

■ Image

■ Text
Enter the text to display. The maximum number is 3,750 characters.
The characters that can be entered depends on the font selected for Font on the Registration Text tab. For details, 
refer to Chapter 2 “1.2 Available Text” on page 2-6.
This setting is only enabled when the Use Text Manager check box is cleared on the Registration Text tab.

■ Text ID
To use the text registered in the Text Manager, specify the ID number from 1 to 32000.
This setting is only enabled when the Use Text Manager check box is selected on the Registration Text tab.

■ Color

■ Windows Font
Specify the Windows Font to use.
The current settings are displayed by selecting Windows in the Font property on the Registration Text tab. You 
can specify the character spacing (0 to 100) and the line spacing (0 to 100). To change the settings other than the 
character spacing and line spacing, click Change to display the Font Settings dialog box.
The text ID setting is only enabled if the Use Text Manager check box is cleared.
For details, refer to Chapter 2 “Windows Font” on page 2-13.

Browse: Select the drawing object to use for the lamp part. Clicking this button opens the View Browser 
if Standard is selected under Image Type on the View tab, or Picture Manager if Picture is 
selected.

Image: Shows the selected drawing object.

Foreground Color, Background Color:

Select the foreground and background color to use for standard images (color: 256 colors, 
monochrome: 16 shades).
Clicking either button opens the Color Palette. Select a color from the Color Palette.

Pattern: Select the pattern or tonal gradation for a standard image. 
Clicking this button opens the Pattern Palette. Select a pattern or tonal gradation from the 
Pattern Palette.

Text Color: Select the text color (color: 256 colors, monochrome: 16 shades) for the registration text.
Clicking this button opens the Color Palette. Select a color from the Color Palette.

Flash: Select this check box to make the picture flash (alternately show and hide the picture that 
corresponds to the bit state or device value at a fixed time interval).
The flashing interval can be set with the Flashing Cycle setting on the System tab of the 
Project Settings dialog box. This option cannot be set for the OFF state.
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● Trigger Condition Tab
The Trigger Condition tab is displayed in Advanced mode.

■ Visible Condition
The Multi-State Lamp is displayed while the condition is satisfied. The Multi-State Lamp is hidden while the condition 
is not satisfied.
Example: When Trigger Type is While ON and Device Address is LM0

While LM0 is 0, the condition is not satisfied and the Multi-State Lamp is hidden.
While LM0 is 1, the condition is satisfied and the Multi-State Lamp is displayed.

Trigger Type: Selects the condition to display the Multi-State Lamp from the following.

Always 
visible:

The Multi-State Lamp is always displayed.

While ON: Displays the Multi-State Lamp when the value of device address is 1.

LM0:

MICRO/I

0

LM0: 1
Show

Condition 
Not 

satisfied

Condition 
Satisfied

Hide

Always show

Multi-State 
Lamp state

1

0

Hide Show Hide HideShow Show

Value of
device address

Multi-State 
Lamp state
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While OFF: Displays the Multi-State Lamp when the value of device address is 0.

While satisfying the condition:

Displays the Multi-State Lamp when the condition is satisfied.

Data Type: Selects the type of data handled by the conditional expression for the visible condition.
This option can only be configured if While satisfying the condition is selected for Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Device Address: Specifies the bit device or the bit number of the word device to serve as the visible condition.
This option can only be configured when While ON or While OFF is selected for Trigger Type.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 
“5.1 Device Address Settings” on page 2-68.

Condition: Specifies the conditional expression for the visible condition.
This option can only be configured when While satisfying the condition is selected for Trigger 
Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expression 
configuration procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-71.

Comment: Used for entering a comment for the visible condition. The maximum number is 80 characters.

1

0

Show Show ShowHide Hide Hide

Multi-State 
Lamp state

Value of
device address

Hide Hide HideShow Show Show

Multi-State 
Lamp state

Satisfied

Not satisfied

Condition
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● Options Tab
The Options tab is displayed in Advanced mode.

■ Place on the Top Layer
Select this check box to display the parts on the top layer. The parts will have precedence when other drawings and 
parts are overlapping with it. For details, refer to Chapter 6 “4 Drawings and Parts Overlapping” on page 6-5.
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● Security Tab
This tab is used to restrict displaying and using the part by security groups.
This option can only be set when Use Security functions is selected. The Use Security functions check box is set 
on General tab in the Security dialog box.

■ (Settings)
Displays the list of security groups used on the MICRO/I.

■ Security Settings
The Security Settings dialog box is displayed. If you create a security group in the Security Settings dialog box, you 
can select that created group. For details, refer to Chapter 23 “2.2 Adding and Editing Security Groups” on page 23-
19.

(Settings)

No.: Displays the security group numbers (0 to 15).

Group Name: Displays the name of the security group.

Display: Displays whether or not there is permission to display the part. Only Permitted security groups 
can display this part. If all security groups are set to Permitted, this part will be displayed even 
if no user account has been selected. Double clicking the cell switches between Permitted and 
Prohibited.

You can also switch between Permitted and Prohibited by right-clicking on a Display cell.

For details about security functions, refer to Chapter 23 “User Accounts and the Security Function” on page 
23-1.
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Example: If the user and security group for a part are set as follows:

For User1 in the Reader security group, the parts for which Display has been set to Prohibited for Reader will not 
be displayed.
If the password screen is opened and the user switches to User2 in the Operator security group, the parts for which 
Display has been set to Permitted for Operator will be displayed.

User Name

Security Group Reader Operator
User1 User2

MICRO/I

130

Numerical Display
No. Group Name Display

1 Administrator Permitted

2 Operator Permitted

3 Reader Permitted

Button
No. Group Name Display Input

1 Administrator Permitted Permitted

2 Operator Permitted Prohibited

3 Reader Prohibited Prohibited

Line Chart and Bar Chart
No. Group Name Display

1 Administrator Permitted

2 Operator Permitted

3 Reader Prohibited

Open Password Screen, 
enter password, 
and switch to User2

For User1, 
parts for which Display 
has been set to Prohibited 
for Reader are not displayed

For User2, 
parts for which Display 
has been set to Permitted 
for Operator are displayed

MICRO/I

130

MICRO/I MICRO/I

130

User1 User2

130
CAN

User Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password
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● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Used for entering comments about parts. The maximum number is 80 characters.
Example: When mousing over the Multi-State Lamp on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.
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This chapter describes how to configure the Data Display parts and their operation on the MICRO/I. 

  

1.1 How the Numerical Input is Used

The Numerical Input features a display mode that displays the current value of a device address and an entry mode 
that enters a value using the keypad or key buttons and writes that value to a device address. When the part is 
displayed on the screen, the Numerical Input is in display mode. To enter a value by pressing the keypad or key 
buttons, touch the Numerical Input to switch it to entry mode. In entry mode, the value of device address is displayed 
until a value is entered.
The Numerical Input can perform the following functions.

• Write a value entered with the keypad or key buttons to a device address

• Display the current value of a device address

• Enter and display decimal numbers

• Display the entered value as * (asterisk)

Chapter 10 Data Displays

1 Numerical Input

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

MICRO/I
External device

999
999 D100: 999

Numerical Input

Standard keypad

External device
MICRO/I

1234 D100: 1234

MICRO/I

12.30
12.3

12.30

External device

MICRO/I

****
****

****

External device
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1.2 Numerical Input Configuration Procedure

This section describes the configuration procedure for Numerical Inputs.

1 On the Home tab, in the Parts group, click Data Displays, and then click Numerical Input.

2 Click a point on the edit screen where you wish to place the Numerical Input.

3 Double-click the dropped Numerical Input and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.

The Data Over tab, Trigger Condition tab and Options tab only appear in Advanced mode.
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1.3 Properties of Numerical Input Dialog Box

This section describes items and buttons on the properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ Methods of using the Numerical Input
Selects how to use the Numerical Input:

Use as Numerical Input: Uses the Numerical Input to enter or display values.

Use as Display for Keypad: Uses the Numerical Input as a part to display the value entered 
with a Keypad.

Display the Minimum value specified with Data Over: Uses the Numerical Input as a part to display the minimum 
value of a Numerical Input switched to input mode.

Display the Maximum value specified with Data Over:Uses the Numerical Input as a part to display the maximum 
value of a Numerical Input switched to input mode.
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■ Keypad
Configures the keypad for entering values in the Numerical Input.

■ Display Type
Selects the display type for the value as Decimal or Hexadecimal.

■ Data Format

Type: According to the location where the keypad is configured, selects the type from the following.
Standard: Uses the standard keypad. The standard keypad is the keypad configured as the 

popup screen for the standard keypad (screen number 3000 to 3015).
This is the keypad for the type configured by Display Type.

Popup: Uses a keypad configured as a popup screen.
Current Screen: Uses the keypad configured on the same screen as the Numerical Input.

Screen Number: Specifies the screen number of the popup screen configured as the keypad (1 to 3015).
This option can only be configured if Popup is selected for Type.

Adjust location automatically: Select this check box to display the popup screen configured as the keypad in a 
location where it will not overlap the Numerical Input.
This option can only be configured if Standard or Popup is selected for Type.

Coordinates X, Y: Specifies the display location of the popup screen configured as the keypad.
With the upper-left corner of the screen as the origin, the X and Y coordinates are 
the upper-left corner of the popup screen.
This option can only be configured when Standard or Popup is selected for Type 
and the Adjust location automatically check box is cleared.
Specify the coordinates in 1 dot units.
X: 0 to (base screen horizontal size - 1)
Y: 0 to (base screen vertical size - 1)

Data Type: Selects the type of data for the value.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Digits: Specifies the digits to display. The range of digits that can be set varies based on the 
display type and data type. The digits that can be set are as follows.

Display Type Data Type Digits

Decimal display

UBIN16(W), BIN16(I) 1 to 5

UBIN32(D), BIN32(L) 1 to 10

BCD4(B) 1 to 4

BCD8(EB) 1 to 8

Float32(F) 1 to 10

Hexadecimal 
display

UBIN16(W) 1 to 4

UBIN32(D) 1 to 8

Display Floating Point: Select this check box to display the decimal point.

If Data Type is UBIN16(W), BIN16(I), UBIN32(D), BIN32(L), BCD4(B), or BCD8(EB) and the 
Display Floating Point check box is selected, a decimal value will be displayed on the Numerical Input 
when a decimal value is entered on the keypad in entry mode, but an integer is written to the device 
address. In display mode, source data is an integer, but the value is displayed with a decimal point added at 
the number of floating digits configured for the Numerical Input.
However, if Float32(F) is selected for Data Type, both the destination data and the source data are 
decimal values.
Example: When Display Type is configured as Decimal, Data Type is UBIN16(W), the Display Floating 

Point check box is selected, Digits is 5, Floating Digits is 3, and Destination Device Address is 
D100

MICRO/I
External device

12.345 D100: 12345
12.345
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*1 Advanced mode only

Floating Digits: Specifies the number of digits for the fractional part of the decimal value out of the 
number of digits specified by Digits.
This option can only be configured when the Display Floating Point check box is selected. 
The range of digits that can be set for the fractional part varies based on the display type 
and data type. The range of digits that can be set for the fractional part is as follows.

Display Type Data Type Floating Digits

Decimal display

UBIN16(W), BIN16(I) 1 to Digits

UBIN32(D), BIN32(L) 1 to Digits

BCD4(B) 1 to Digits

BCD8(EB) 1 to Digits

Float32(F) 1 to Digits or 8

Hexadecimal display
UBIN16(W) --

UBIN32(D) --

Floating Symbol*1: Selects the decimal point symbol from the following.
.(dot), :(colon), ;(semicolon), ,(comma), /(slash)
This option can only be configured when the Display Floating Point check box is selected.
Example: When Digits is 4 and Floating Digits is 2

When Floating Symbol is .(dot) 12.34
When Floating Symbol is /(slash) 12/34

Floating Symbol is not reflected on the standard keypad. To change the decimal point symbol on the 
standard keypad, please change the keypad button.

Suppress Zeros: Select this check box to hide “0” for the upper digits of the integer part.
Example: Suppress Zeros selected: 1234

Suppress Zeros cleared: 00001234
Do not display when the value is zero: Select this check box to show a blank display if the value is "0".

• If the value is zero and it is not displayed, the unit set on the Format tab is also not displayed.
• Even if the Do not display when the value is zero check box is selected, "0" is displayed when the 

value is not 0.

Display the minus sign: Select this check box to display the - (negative) sign when displaying negative values.
This option can only be configured when Decimal is selected for Display Type.

Display the plus sign: Select this check box to display the + (positive) sign when displaying positive values.
This option can only be configured when Decimal is selected for Display Type.

Symbol to show when out of range or Error occurs:
Selects the following symbols to be displayed when a value exceeding the Data Type in 
the General tab or the Range in the Data Over tab is entered, or an error occurs.
"? (question mark)", " (space)", "# (pound)", "% (percent)", "$ (dollar)", "- (minus)", "@ (at 
sign)", "\ (backslash)", "* (asterisk)", "! (exclamation mark)", "+ (plus)"

In the following cases, it is handled as an error and the symbol selected in Symbol to show when out of 
range or Error occurs is displayed.
• If the Data Type is BCD4(B), BCD8(EB), or Float32(F) and the value entered in device address 

doesn't comply with the data type.
• If a value entered in the Numerical Input exceeds the maximum or minimum of the Data Over.
• A value that exceeds the maximum numeric value that can be processed with the data type selected for 

Data Format was entered with the input mode of the Numerical Input.
• If a value divided by zero operation was executed with Display with Arithmetic Operation on the 

Options tab.
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Example: The When input value is out of range, display value near maximum or minimum check box is 
selected, the Value under the Range on the Data Over tab is selected and the Minimum is 0 and the 
Maximum is 10000.

• Enter the value "99999" larger than the maximum

• Enter the value "-1" smaller than the minimum

When input value is out of range, display value near maximum or minimum:

Select this check box to display the nearest value of the minimum or maximum when a value out 
of range is entered.

Press Numerical Input Enter a value Press ENT

Display value of
device address 
(Entry mode)

Write value to
device address 
(Entry mode)

Press ENT

Corrects the value of device 
address to maximum value 

(Entry mode)

Display value of 
device address 
(Display mode)

Display focus
(Entry mode)

Display value of 
device address 
(Display mode)

1234

Operations and display
1234 99999 10000

1234 10000

Value of
Destination Device Address

Numerical Input display

Keypad display

Action

1234

10000

1234 10000

1234

1234

-

1234

1234

1234

1234

1234

99999

10000

10000

10000

1234

1234

10000

10000

10000

-

Numerical Input

Keypad display

Press Numerical Input Enter a value Press ENT

Display value of
device address 
(Entry mode)

Write value to
device address 
(Entry mode)

Display value of 
device address 
(Display mode)

Display focus
(Entry mode)

Display value of 
device address 
(Display mode)

1234

Operations and display
1234 -1 0

1234 0

Value of
Destination Device Address

Numerical Input display

Keypad display

Action

1234 0

1234

1234

-

1234

1234

1234

1234

1234

-1

0

0

0

0

0

-

Numerical Input

Keypad display
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■ Input Method
These options specify the destination for entered values.

■ Always Entry Mode*1

Select this check box to enter values by pressing the keypad and key buttons without touching the Numerical Input 
displayed on the screen.
To display 0 on the Numerical Input until a value is entered, select the Start from 0 in Always Entry Mode of 
Numerical Input check box on the System tab in the Project Settings dialog box. To display the value of device 
address, clear the Start from 0 in Always Entry Mode of Numerical Input check box.
This option can only be configured if Current Screen is selected for Type.
Example: When the Always Entry Mode check box is selected and the Start from 0 in Always Entry Mode of 

Numerical Input check box is selected on the System tab in the Project Settings dialog box

Example: When the Always Entry Mode check box is cleared

*1 Advanced mode only

Destination Device Address: Specifies the word device to write the entered value to.

Click  to display the Tag Editor. For the device address configuration procedure, 
refer to Chapter 2 “5.1 Device Address Settings” on page 2-68.

Use Reference Device Address*1: Select this check box and specify a device address to change the destination word 
device by the value of this device address.

Click  to display the Tag Editor. For the device address configuration procedure, 
refer to Chapter 2 “5.1 Device Address Settings” on page 2-68.
For details on indirect writing, refer to Chapter 2 “Indirect Read and Indirect Write 
Settings” on page 2-5.

Enter a value

Display value being entered
(Entry mode)

Display 0
(Entry mode)

Press ENT

Write value to device address
(Entry mode)

0

Action

Operations and display

999999

Value of
Destination Device Address

99912341234

Not displayed on Numerical Input.

Only one Numerical Input or one Character Input set to Always Entry Mode can be configured for one 
screen.

Press Numerical Input Enter a value

Enter 999

 Press ENT

Display value of 
device address
(Entry mode)

Write value to
device address
(Entry mode)

Display value of 
device address
(Display mode)

Display focus
(Entry mode)

Display value of
device address
(Display mode)

1234

Operations and display

1234 999

Value of 
Destination Device Address

Action

1234 999

999123412341234 999
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■ Focus is moved by ENT button*1

When multiple Numerical Inputs are configured on the screen, select this check box to continue entering values on 
each of the Numerical Inputs.
Each time ENT is pressed, the focus moves between the Numerical Inputs according to Focus Order. On the View 
tab, in the Screens group, click Focus Order, and then click the Numerical Inputs in the order to move the focus.
Example: When Numerical Input A and B are configured and the Focus is moved by ENT button check box for 

Numerical Input A is selected and the Focus is moved by ENT button check box for Numerical Input B is 
cleared

■ Update the display by ENT button*1

Select this check box to display the current value unchanged and update the display when a value is entered and ENT 
is pressed.
When this check box is cleared, the display updates with each press of a number button to display the number being 
entered.

*1 Advanced mode only

Press Numerical Input A Enter a value Press ENT Enter a value Press ENT

Move focus from 

Numerical Input A to B

Write value to 
device address 
(Entry mode)

Display value of 
device address 
(Display mode)

Display value of 
device address 
(Display mode)

Display value of 
device address 
(Entry mode)

Write value to 
device address
(Entry mode)

Display value of 
device address 
(Display mode)

Display value of 
device address 
(Entry mode)

Display focus
(Entry mode)

Display focus
(Entry mode)

Display value of 
device address 
(Display mode)

1234

567

1234

567

1234

567

999

567

999

567

999

567

999

333

999

333

567

1234

Operations 
and display

1234 999 999

567

1234 999

Numerical Input A 
Value of

Destination Device Address

Numerical Input A 
action

Numerical Input B 
action

567

1234A

B

Numerical Input B 
Value of

Destination Device Address

567

999

567 567

333

999

567

333

999

333

999

333

When a value outside the input range is entered and ENT is pressed, the symbol selected under Symbol to 
show when out of range or Error occurs is displayed. The value is not written to the device address.

Press Numerical Input Enter a value Press ENT

Display value of
device address 
(Entry mode)

Write value to
device address 
(Entry mode)

Display value of 
device address 
(Display mode)

Display focus
(Entry mode)

Display value of 
device address 
(Display mode)

1234

Operations and display
1234 999 999

1234 999

Value of
Destination Device Address

Numerical Input display

Keypad display

Action

1234 999

1234

1234

-

1234

1234

1234

1234

1234

999

999

999

999

999

999

-

Numerical Input

Keypad display
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● View Tab

■ Image Type
Select the type of graphic to be used to represent the part.

■ Browse
Select the type of graphic to be used to represent the part from the list of graphics. Click this button to display the 
View Browser or Picture Manager, depending on the setting for Image Type.

■ Plate Color
Selects the plate color of the standard graphic (color: 256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

■ Flange

Standard: Uses the default graphic for WindO/I-NV4.

Picture: Uses an image file saved using Picture Manager.
For details about image file restrictions, refer to Chapter 2 “1.4 Available Image Files” on page 2-20.

None: The plate and the flange of the part are not displayed. Only the text is displayed.

Plate color

Foreground Color, Background Color: Selects the foreground and background colors of the flange of the standard 
graphic (color: 256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

Pattern: Selects a pattern for the flange of the standard graphic.
Click Pattern to display the Pattern Palette. Select a pattern from the Pattern 
Palette.

Flange
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■ Coordinates

■ Size

X, Y: Sets the display position of parts using coordinates.
The X and Y coordinates of parts is defined relative to an origin at the top-left corner of the screen.

X: 0 to (base screen horizontal size - 1)

Y: 0 to (base screen vertical size - 1)

(0, 0)
X

Y
Screen

Parts

W, H: Sets width and height to define the size of parts.

W: 20 to (base screen horizontal size)

H: 20 to (base screen vertical size)

Width

Height

Screen

Parts
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● Format Tab

■ Font
Selects the font used for displaying text from the following.
Standard, Windows, Stroke, 7-Segment
The characters that can be displayed depend on the font. For details, refer to Chapter 2 “1.2 Available Text” on page 2-6.

■ Size
When Standard is selected, selects the text size as 8x16 or 16x16.
When Stroke or 7-Segment is selected, specifies the text size (8 to 128).

■ Style
Selects Regular or Bold for text style.
Can only be set when Standard is selected for Font.

■ Magnification

Can only be set when Standard is selected for Font.

■ Align Text
Selects the text alignment in the horizontal direction from the following.
Left, Center, Right
For details, refer to Appendix “5 Text Alignment” on page A-7.

■ Text Color
Selects the color of displayed text (color: 256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.
This option can configure the text color in display mode and in entry mode. However, for Entry Mode text color can 
be set only when the Reverse check box is cleared.

■ Reverse
Select this check box to reverse the text color and plate color during display mode when in entry mode.
Can only be set when Standard is selected for Image Type under the View tab.

W, H: Selects text magnification (0.5, 1 to 8).
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■ Display Numerical Value with “*” *1

Select this check box to display the entered value as * (asterisks).
Nothing is displayed if the value of device address is 0 when this check box is selected and the Suppress Zeros 
check box is selected on the General tab. When this check box is selected in entry mode, nothing is displayed until a 
value is entered from the key buttons or keypad. If ENT is pressed with nothing displayed, 0 is written to the 
destination device address.

■ With Unit*1

Select this check box to display units or other characters at the end of a number. Displayed characters must be 
registered in Text Manager. The displayed text color will be as set for Text Color under the Format tab.

■ Windows Font
Configures the font to use as the Windows Font.
Select Windows for Font to display the current settings. To change the settings, click Change to display the Font 
dialog box. For details, refer to Chapter 2 “Windows Font” on page 2-13.

■ Change Display Colors
To switch the text and plate colors, select this check box and select the method to the display colors from the 
following.

*1 Advanced mode only

Text ID: Specifies the Text Manager ID No. (1 to 32000).

Click  to display Text Manager.

Text: Displays the characters of the specified Text ID.

• The maximum number that can be displayed with this function is 4 characters. The fifth and subsequent 
characters of a character string are not displayed. However, if Windows Font is set for the specified Text 
ID characters all the characters are displayed.

• If a carriage return (CR) is included the characters after the CR are not displayed.

Trigger Device Address: Specifies the bit device or the bit number of the word device to use as the trigger to switch 
the text and plate colors.

Click  to display the Tag Editor. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-68.
When the value of device address is 0, the color specified in Text Color or in Plate Color 
on the View tab will be displayed.
When the value of device address is 1, the color displayed and specified in Text Color or 
Plate Color under the Change Display Colors.

Text Color: Selects the color (color: 256 colors, monochrome: 16 shades) of the text when switching.
Click this button to display the Color Palette. Select a color from the Color Palette.

Plate Color: Selects the plate color (color: 256 colors, monochrome: 16 shades) when switching.
Click this button to display the Color Palette. Select a color from the Color Palette.
This option can only be configured when Standard is selected for Image Type on the View 
tab.

MICRO/I

1234

1234

0

1

Trigger Device Address

Trigger Device Address

External device

Text Color

Plate Color on the View tab

Text Color under Change Display Colors

Plate Color under Change Display Colors
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■ Flash
Select this check box to make the text and plate colors flash.
The flashing will occur as follows:
• The Change Display Colors check box is cleared, then the colors specified by Text Color and Plate Color on 

the View tab and the colors specified by Text Color and Plate Color under Flash are alternately displayed.

• The Change Display Colors check box is selected and the value of the trigger device address for Change 
Display Colors is 0, then the colors specified by Text Color and Plate Color on the View tab and the colors 
specified by Text Color and Plate Color under Flash are alternately displayed.

• The Change Display Colors check box is selected and the value of the trigger device address for Change 
Display Colors is 1, then the colors specified by Text Color and Plate Color under Change Display Colors 
and the colors specified by Text Color and Plate Color under Flash are alternately displayed.

1234

1234
1234

1234

Flashing

Trigger device address
under Flash

Trigger device address
under Flash

0

1

MICRO/IExternal device

Text Color

Plate Color on the View tab

Text Color

Plate Color on 
the View tab

Text Color under Flash

Plate Color under Flash

1234

1234
1234

1234

Flashing

Trigger device address
under Flash

Trigger device address
under Flash

MICRO/IExternal device

Text Color

Plate Color on the View tab

Text Color

Plate Color on 
the View tab

Text Color under Flash

Plate Color under Flash

Trigger device address under
Change Display Colors

Trigger device address under
Change Display Colors

0

0

1

0

1234

1234
1234

1234

Flashing
1

Trigger device address under 
Change Display Colors

Trigger device address
under Flash

Trigger device address under 
Change Display Colors

Trigger device address
under Flash

0

1

1

MICRO/IExternal device

Text Color under 
Change Display Colors
Plate Color under 
Change Display Colors

Text Color under Change Display Colors

Plate Color under Change Display Colors

Text Color under Flash

Plate Color under Flash
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Trigger Device Address: Specifies the bit device or the bit number of the word device that will be used to trigger 
flash.

Click  to display the Tag Editor. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-68.
Flash intervals are set in the Flashing Cycle on the System tab in the Project Settings 
dialog box.

Text Color: Selects the color (color: 256 colors, monochrome: 16 shades) of text when flashing.
Click this button to display the Color Palette. Select a color from the Color Palette.

Plate Color: Selects the plate color (color: 256 colors, monochrome: 16 shades) when flashing.
Click this button to display the Color Palette. Select a color from the Color Palette.
This option can only be configured when Standard is selected for Image Type on the View 
tab.
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● Data Over Tab
The Data Over tab is displayed in Advanced mode.

■ Range
Select data type.

Specifies the allowable range of values to enter or display.

Value: Specifies the minimum and/or the maximum as a constant.

Device Address: Specifies the minimum and/or the maximum as a value of word device.

Minimum, Maximum: Select these check boxes to specify the minimum and/or maximum.
The minimum and maximum that can be specified when Value is selected vary based on the 
data type selected with Data Format on the General tab. For details on data types, refer to 
Chapter 2 “1.1 Available Data” on page 2-1.
When Device Address is selected, these options specify the source word devices.

Click  to display the Tag Editor. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-68.

• Select UBIN16(W), BIN16(I), UBIN32(D), BIN32(L), BCD4(B), or BCD8(EB) for Data Type 
under the General tab, and to display a fractional number specify the values of Minimum and 
Maximum as an integer.
Example: To set a value of “1.25” for the upper limit, enter “125”.

• If the value of the device address to display exceeds the data range that can be processed for the data 
type selected under Data Format on the General tab, the symbol selected under Symbol to show 
when out of range or Error occurs on the General tab is displayed.

• If the entered value exceeds the allowable range or if it exceeds the data range that can be processed for 
the data type selected under Data Format on the General tab, the symbol selected under Symbol to 
show when out of range or Error occurs on the General tab is displayed and the value is not written 
to the device. However, if the When input value is out of range, display value near maximum or 
minimum check box is selected on the General tab and a value out of range is entered, the nearest 
value of the minimum or maximum is displayed.
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■ When Data Over
These options configure the operation of the part when the value entered with the keypad exceeds the allowable 
range.
These options can only be configured when the Minimum or Maximum check boxes are selected under Range.

Example: If you attempt to enter “140”, which is higher than the maximum of “100”, or “-10”, which is lower than the 
minimum of “0”, the value is not written and the symbol selected under Symbol to show when out of 
range or Error occurs on the General tab is displayed. 1 is written to the Report Device Address LM0 
under When Data Over.

Report: Select this check box to write 1 in the Report Device Address when the entered value or the value of the 
device address to display exceeds the allowable range.

Report Device Address: Specifies the Report Device Address.

Click  to display the Tag Editor. For the device address configuration procedure, 
refer to Chapter 2 “5.1 Device Address Settings” on page 2-68.

Operations 

and 

display

0

0

Entered data

80

80

80

?????

10

10

80

Written data

140

10

?????

10

80 10

-10

Data over notification: LM0 10 0 1

Range: Value

    Minimum: 0

    Maximum: 100

When Data Over

    Report: On

    Report Device Address: LM0

When the When input value is out of range, display value near maximum or minimum check box 
is selected on the General tab and a value out of range is entered, 1 is written to the Report Device 
Address under the When Data Over.
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● Trigger Condition Tab
The Trigger Condition tab is displayed in Advanced mode.

■ Input Condition
The Numerical Input is enabled and operational while the condition is satisfied. The Numerical Input is disabled and 
not operational while the condition is not satisfied.

Example: When Trigger Type is While ON and Device Address is LM0
While LM0 is 0, the condition is not satisfied and the Numerical Input is not operational.
While LM0 is 1, the condition is satisfied and the Numerical Input is operational.

Trigger Type: Selects the condition to enable the Numerical Input from the following.

Always enable: The Numerical Input is always enabled.

While ON: Enables the Numerical Input when the value of device address is 1.

LM0:

MICRO/I

Condition 
Not 

satisfied

0

LM0:
Condition 
Satisfied

1 Operational

123

123

Not 
operational

Always enabled

Numerical 
Input state

123

1

0

Disabled Enabled Disabled DisabledEnabled Enabled

Value of
Device Address

Numerical 
Input state

123 123 123 123123 123
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■ Visible Condition
The Numerical Input is displayed while the condition is satisfied. The Numerical Input is hidden while the condition is 
not satisfied.

While OFF: Enables the Numerical Input when the value of device address is 0.

While satisfying the condition: Enables the Numerical Input when the condition is satisfied.

Data Type: Selects the type of data handled by the conditional expression for the input condition.
This option can only be configured if While satisfying the condition is selected for Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Device Address: Specifies the bit device or the bit number of the word device to serve as the input condition.
This option can only be configured when While ON or While OFF is selected for Trigger Type.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 
“5.1 Device Address Settings” on page 2-68.

Condition: Specifies the conditional expression for the input condition.
This option can only be configured when While satisfying the condition is selected for Trigger 
Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expression 
configuration procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-71.

Comment: Used for entering a comment for the input condition. The maximum number is 80 characters.

1

0

Enabled Enabled EnabledDisabled Disabled Disabled

Value of
Device Address

Numerical 
Input state

123 123 123123 123 123

Satisfied

Not satisfied

Disabled Disabled DisabledEnabled Enabled Enabled

Numerical 
Input state

Condition

123 123 123123 123 123

Example: When Trigger Type is While ON and Device Address is LM0
While LM0 is 0, the condition is not satisfied and the Numerical Input is hidden.
While LM0 is 1, the condition is satisfied and the Numerical Input is displayed.

LM0:

MICRO/I

0

LM0: 1 Show

Condition 
Not 

satisfied

Condition 
Satisfied

123

Hide

• If the Numerical Input is hidden while entering a value, the input is canceled. If a popup screen 
configured as the standard keypad or a keypad is displayed, these screens are closed.

• When multiple Numerical Inputs are arranged on the screen and the Focus is moved by ENT button 
check box is selected, entry mode is canceled if the Numerical Input is hidden while entering a value.
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Trigger Type: Selects the condition to display the Numerical Input from the following.

Always visible: The Numerical Input is always displayed.

While ON: Displays the Numerical Input when the value of device address is 1.

While OFF: Displays the Numerical Input when the value of device address is 0.

While satisfying the condition: Displays the Numerical Input when the condition is satisfied.

Data Type: Selects the type of data handled by the conditional expression for the visible condition.
This option can only be configured if While satisfying the condition is selected for Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Device Address: Specifies the bit device or the bit number of the word device to serve as the visible condition.
This option can only be configured when While ON or While OFF is selected for Trigger Type.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 
“5.1 Device Address Settings” on page 2-68.

Condition: Specifies the conditional expression for the visible condition.
This option can only be configured when While satisfying the condition is selected for Trigger 
Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expression 
configuration procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-71.

Comment: Used for entering a comment for the visible condition. The maximum number is 80 characters.

Always show

Numerical 
Input state

123

1

0

Hide Show Hide HideShow Show

Value of
Device Address

Numerical 
Input state

123 123 123

Value of
Device Address

1

0

Show Show ShowHide Hide Hide

Numerical 
Input state

123 123 123

Numerical 
Input state

Hide Hide HideShow Show Show

Satisfied

Not satisfied

Condition

123 123 123
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● Options Tab
The Options tab is displayed in Advanced mode.

■ Input with Arithmetic Operation
To apply arithmetic operations to values entered using a keypad and writing the results, select this check box and 
input the arithmetic formula.
Example: To divide the value of device address when entered by 60

■ Display with Arithmetic Operation
To apply arithmetic operations to values of device addresses and writing the results, select this check box and input 
the arithmetic formula.
Example: To multiple the value of device address when displayed by 60

Arithmetic Formulas
Arithmetic formulas can be specified by freely combining multiple kinds of data and operators in the following format.

• There is no limit on the number of data items or number of operators. However, the maximum number is 120 
characters.

• Round brackets can be used.

External device MICRO/I

D0 700

42000÷60

Write value of 
entered value 
divided by 60

42000

Numerical Input
Destination Device Address: D0
Input with Arithmetic Operation: @/60

External device MICRO/I

D0 1234

1234×60

Display value multiplied 
by 60 for the value of 

device address

74040

Numerical Input
Destination Device Address: D0
Display with Arithmetic Operation: @•60

...(up to 120 characters)

OperatorData Data

OperatorData Data
to

Operator Data Operator Data Operator Data Operator Data
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Data

Operators
Specify the type of arithmetic operation to be performed on the data. The operator priority is the same as for scripts. 
For details, refer to Chapter 20 “6.3 About the Priority of the Operator” on page 20-59.

Examples of Arithmetic Formula Input

■ No Touch Sound
This function is to disable touch sounds only for specified parts when the MICRO/I makes touch sounds.
Select this check box to display disable touch sounds for this part.

■ Place on the Top Layer
Select this check box to display the parts on the top layer. The parts will have precedence when other drawings and 
parts are overlapping with it. For details, refer to Chapter 6 “4 Drawings and Parts Overlapping” on page 6-5.

Item Description

@
The device address on which the arithmetic operation is performed is specified in the arithmetic 
formula. Only one device address can be set for an arithmetic operation.
The device address is as specified for Destination Device Address under the General tab.

Value
Sets the constant values for the arithmetic formula.
The values that can be set depend on the data type selected using Data Format under the General 
tab. For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Device Address Specifies the bit device or the word device for the arithmetic formula.
Always enter the device address enclosed in square brackets, “[” and “]”.

Item Description

Arithmetic 
operators

Sets the arithmetic operators.

+ Addition Adds  and .

- Subtraction Subtracts  from .

* Multiplication Multiplies  and .

/ Division Divides  by .

% Modulo Calculates remainder after dividing  by .

Bit operator

Sets the bit operator.

& Logical AND Calculates the logical product (AND) of each bit of  and .

| Logical OR Calculates the logical sum (OR) of each bit of  and .

^ Logical XOR 
(exclusive OR)

Calculates the exclusive logical sum (XOR) of each bit of  and 
.

<< Left shift Shifts each bit of  to left by  bit(s).

>> Right shift Shifts each bit of  to right by  bit(s).

Input Examples Description

@ + 1

To perform the arithmetic operation and input the result, add 1 to the value entered 
using the Keypad and write the result to the device address.

To perform the arithmetic operation and display the result, add 1 to the value of device 
address and display the result.

[LDR 0] + @ + 100

To perform the arithmetic operation and input the result, add the value of LDR0 to the 
value entered using the Keypad and add 100, and write the result to the device address.

To perform the arithmetic operation and display the result, add the value of LDR0 to the 
value of device address and add 100, then display the result.

@ & 3

To perform the arithmetic operation and input the result, write the logical product of the 
value entered using the Keypad and 3 to the device address.

To perform the arithmetic operation and display the result, add 3 to the value of device 
address and display the result.

To enable touch sounds on the MICRO/I, select the Enable Touch Sound check box under the System 
tab of the Project Settings dialog box.
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● Security Tab
This tab is used to restrict displaying and using the part by security groups.
This option can only be set when Use Security functions is selected. The Use Security functions check box is set 
on General tab in the Security dialog box.

■ (Settings)
Displays the list of security groups used on the MICRO/I.

■ Security Settings
The Security Settings dialog box is displayed. If you create a security group in the Security Settings dialog box, you 
can select that created group. For details, refer to Chapter 23 “2.2 Adding and Editing Security Groups” on page 23-
19.

(Settings)

No.: Displays the security group numbers (0 to 15).

Group Name: Displays the name of the security group.

Display: Displays whether or not there is permission to display the part. Only Permitted security groups 
can display this part. If all security groups are set to Permitted, this part will be displayed even 
if no user account has been selected. Double clicking the cell switches between Permitted and 
Prohibited.

Input: Displays whether or not there is permission to use the part. Only Permitted security groups 
can use this part. If all security groups are set to Permitted, this part can be used even if no 
user account has been selected. Double clicking the cell switches between Permitted and 
Prohibited.

• You can also switch between Permitted and Prohibited by right-clicking on a Display or Input cell.
• Restricting the display and use of the part by switching between Permitted and Prohibited in Display 

and Input cells is similar to using the Trigger Condition tab.

For details about security functions, refer to Chapter 23 “User Accounts and the Security Function” on page 
23-1.
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Example: If the user and security group for a part are set as follows:

For User1 in the Reader security group, the parts for which Display has been set to Prohibited for Reader will not 
be displayed.
If the password screen is opened and the user switches to User2 in the Operator security group, the parts for which 
Display has been set to Permitted for Operator will be displayed.

For User2 in Operator, Display has been set to Permitted for Operator, but Input is Prohibited, so the part 
cannot be used.
If the password screen is opened and the user switches to User3 in the Administrator security group, the parts for 
which Display has been set to Permitted for Administrator will be displayed, and the parts for which Input has 
been set to Permitted for Administrator can be used.

User Name

Security Group Reader Operator Administrator
User1 User2 User3

MICRO/I

130

999

Numerical Display
No. Group Name Display

1 Administrator Permitted

2 Operator Permitted

3 Reader Permitted

Numerical Input
No. Group Name Display Input

1 Administrator Permitted Permitted

2 Operator Permitted Prohibited

3 Reader Prohibited Prohibited

Line Chart and Bar Chart
No. Group Name Display

1 Administrator Permitted

2 Operator Permitted

3 Reader Prohibited

Open Password Screen, 
enter password, 
and switch to User2

For User1, 
parts for which Display 
has been set to Prohibited 
for Reader are not displayed

For User2, 
parts for which Display 
has been set to Permitted 
for Operator are displayed

MICRO/I

130

MICRO/I MICRO/I

130

User1 User2

130
CAN

User Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password

999

Open Password Screen, 
enter password, 
and switch to User3

For User2, 
parts for which Display 
has been set to Permitted 
for Operator are displayed, 
but parts for which Input 
has been set to Prohibited cannot be used

For User3, 
parts for which Display 
has been set to Permitted 
for Administrator are displayed, 
and parts for which Input 
has been set to Permitted can be use

MICRO/I

130

MICRO/I MICRO/I

130130 130

User2 User3

999999999

999

Button
Can operate

CAN

User Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password

Button
Cannot operate
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● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Used for entering comments about parts. Maximum number is 80 characters.
Example: When mousing over the Numerical Input on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.
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1.4 How to Enter Values

Use the keypad or key buttons to write a value to a device address with the Numerical Input. The input methods are 
as follows.

■ Pressing the Numerical Input and Entering Values from the Standard Keypad
Arrange a Numerical Input on the screen and in its properties dialog box, on the General tab, under Keypad, select 
Standard for Type.

External device
MICRO/I

1234

999

1234
999

999

D100: 1234

D100: 1234

D100: 999

999
D100: 999

Press Numerical Input

Write value 
to device address

Press ENT

Display value of device address
(Entry mode)

Display value of device address
(Entry mode)

Close standard keypad

Display standard keypad

Enter "999"

Display value of device address
(Display mode)

Display value of device address
(Display mode)

When the following operations are performed, entry mode is canceled and the current value of device 
address is displayed in the Numerical Input. To enter a value, press the Numerical Input again to set it to 
entry mode.
• CAN was pressed
• When the Focus is moved by ENT button check box on the General tab is cleared and ENT was 

pressed and a value was written to the device address
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■ Without Pressing the Numerical Input, Directly Entering Values from a Keypad on the Same Screen
Arrange a Numerical Input and a keypad on the same screen. In the properties dialog box for the Numerical Input, on 
the General tab, under Keypad, select Current Screen for Type and select the Always Entry Mode check box.

1.5 Advanced Usage

● Using the System Area
• When finished entering a value by pressing ENT, 1 is written to the System Area 2 Numerical Input Setting 

Complete bit (address number+3, bit 0).

• When CAN is pressed, entry mode is canceled and 1 is written to the System Area 2 Numerical Input Setting 

Cancel bit (address number+3, bit 1). However, if the keypad is closed by pressing  (close) on the popup 
screen's title bar or another Numerical Input is pressed before finished entering the value by pressing ENT, entry 
mode is canceled and 1 is not written to the System Area 2 Numerical Input Setting Cancel bit (address number+3, 
bit 1).

• To clear the System Area 2 numerical input setting complete bit or the numerical input setting cancel bit, write 1 to 
System Area 1 Numerical Input Setting Clear bit (address number+1, bit 10). To automatically clear these bits 
when the Numerical Input keypad is pressed in entry mode, select the Clear Keypad bit in System Area 
automatically check box on the System tab in the Project Settings dialog box.

External device
MICRO/I

999

1234
D100: 1234

D100: 999

999
D100: 999

Write value
 to device address

Press ENT

Display value of device address
(Entry mode)

Display value of device address
(Entry mode)

Display value of device address
(Entry mode)

Enter "999"

If the System Area 2 Numerical Input Setting Complete Bit (address number+3, bit 0) is set to another 
function's execution condition, that function can be executed when ENT is pressed.
Example: To simultaneously close a popup screen when ENT is pressed

In the Properties of Goto Screen Command dialog box, on the General tab, select Close Popup 
Screen for Action Mode. On the Trigger Condition tab, select Rising-edge for Trigger 
Type, and configure Device Address as the System Area 2 Numerical Input Setting Complete bit 
(address number+3, bit 0).
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2.1 How the Character Input is Used

The Character Input features a display mode that displays the character codes in current values of device addresses 
as text and an entry mode that enters text using the keypad or key buttons and writes the character codes for the 
entered text to device addresses. When the part is displayed on the screen, the Character Input is in display mode. To 
enter text by pressing the keypad or key buttons, touch the Character Input to switch it to entry mode.
The Character Input can perform the following functions.

• Write the character codes for text entered with the keypad or key buttons to device addresses

• Display the character codes in current values of device addresses as text

• Display entered text as * (asterisk)

• Enter Kanji characters

2 Character Input

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

D100 : 

D101 : 

4847(Hex)‘H’ ‘G’

2053(Hex)

4552(Hex)

4945(Hex)

5300(Hex)

‘E’ ‘R’D102 : 

D103 : 

D104 : (NULL)‘S’

‘   ’ ‘S’

MICRO/I
External device

HG  SERIES_

HG  SERIES
Character Input

Standard keypad

D100 : 

D101 : 

4847(Hex)‘H’ ‘G’

2053(Hex)

4552(Hex)

4945(Hex)

5300(Hex)

D102 : 

D103 : 

D104 : ‘S’ (NULL)

‘ I ’ ‘E’

‘E’ ‘R’

‘   ’ ‘S’

MICRO/I
External device

HG  SERIES

MICRO/I
External device

****

********

MICRO/I
External device

山田太郎山田太郎
あ

い

う

え

お

か

き

く

け

こ

さ

し

す

せ

そ

た

ち

つ

て

と

な

に

ぬ

ね

の

は

ひ

ふ

へ

ほ

ま

み

む

め

も

や

ゆ

よ

ら

り

る

れ

ろ

ー

、

。

↑ ↓

わ

を

ん

BS

← →

CLR

CAN

ENT
Kanji Alphabet Num&Sign  ゛゜Small

SP

山田太郎
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2.2 Character Input Configuration Procedure

This section describes the configuration procedure for Character Inputs.

1 On the Home tab, in the Parts group, click Data Displays, and then click Character Input.

2 Click a point on the edit screen where you wish to place the Character Input.

3 Double-click the dropped Character Input and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.

The Trigger Condition tab and Options tab only appear in Advanced mode.
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2.3 Properties of Character Input Dialog Box

This section describes items and buttons on the properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ Keypad
Configures the keypad for entering text in the Character Input.

*1 Advanced mode only

Use as Display for Keypad*1: Select this check box to only use the Character Input as a part to display the text 
entered with the keypad.

Type: According to the location where the keypad is configured, selects the type from the 
following.

Standard(Half-Width Character): Uses the standard keypad for entering half-width 
characters. The standard keypad is the keypad 
configured as the popup screen for the standard 
keypad. For details, refer to Chapter 5 “4.3 Standard 
Keypad Popup Screen” on page 5-25.

Standard(Hiragana): Uses the standard keypad for entering full-width 
characters. The standard keypad is the keypad 
configured as the popup screen for the standard 
keypad. For details, refer to Chapter 5 “4.3 Standard 
Keypad Popup Screen” on page 5-25.

Popup: Uses a keypad configured as a popup screen.

Current Screen: Uses the keypad configured on the same screen as 
the Character Input.

Screen Number: Specifies the screen number of the popup screen configured as the keypad (1 to 3015).
This option can only be configured if Popup is selected for Type.

Adjust location automatically: Select this check box to display the popup screen configured as the keypad in a location 
where it will not overlap the Character Input.
This option can only be configured when Standard(Half-Width Character), 
Standard(Hiragana) or Popup is selected for Type.
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■ Data Format
Specifies the digits to display.

■ Input Method
These options configure the destination for the character codes for the entered text.

*1 Advanced mode only

Coordinates X, Y: Specifies the display location of the popup screen configured as the keypad.
With the upper-left corner of the screen as the origin, the X and Y coordinates are the 
upper-left corner of the popup screen.
This option can only be configured when Standard(Half-Width Character), 
Standard(Hiragana) or Popup is selected for Type and the Adjust location 
automatically check box is cleared.

Specify the coordinates in 1 dot units.
X: 0 to (base screen horizontal size - 1)
Y: 0 to (base screen vertical size - 1)

Input Digits: Specifies the number of digits that can be entered with the Character Input (1 to 127). For 
each character to enter, one digit for half-width characters and two digits for full-width 
characters is required.

Display Digits: Specifies the number of digits that can be displayed in the Character Input display (1 to 100). 
Regardless of half-width or full-width, one digit is required per character.

Destination Device Address:

Specifies the destination word device for the character codes for the entered text.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.

Use Reference Device Address*1:

Select this check box and specify a device address to change the destination word device by the value of this 
device address.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.
For details on indirect writing, refer to Chapter 2 “Indirect Read and Indirect Write Settings” on page 2-5.

Write NULL (0x00) after the end of the string:

Select this check box to write NULL (0x00) to all device addresses from the end of the string to the address 
number specified by Input Digits if the length of the input string is less than Input Digits.

Example: If Input Digits is 10 and a string with a length of 5 was input

4847(Hex)‘H’ ‘G’
　 　
　 　
　 　
　 　

2053(Hex)

4552(Hex)

4943(Hex)

5300(Hex)

‘   ’ ‘S’
‘E’ ‘R’
‘ I ’ ‘E’
‘S’ (NULL)

4847(Hex)‘H’ ‘G’
　 　
　 　
　 　
　 　

2053(Hex)

4552(Hex)

4943(Hex)

5300(Hex)

‘   ’ ‘S’
‘E’ ‘R’
‘ I ’ ‘E’
‘S’ (NULL)

4D49(Hex)‘M’ ‘I’
　 　
　 　
　 　
　 　

4352(Hex)

4F00(Hex)

4943(Hex)

5300(Hex)

‘C’ ‘R’
‘O’ (NULL)

‘ I ’ ‘E’
‘S’ (NULL)

4D49(Hex)‘M’ ‘I’
　 　
　 　
　 　
　 　

4352(Hex)

4F00(Hex)

0000(Hex)

0000(Hex)

‘C’ ‘R’
‘O’ (NULL)

(NULL)(NULL)

(NULL)(NULL)

Enter MICRO
(Length of the string is 5)

Check box: Selected Check box: Cleared
Character Input 

display

MICRO_

Value of 
destination 

device address

HG SERIES

MICRO 

MICRO_

HG SERIES

MICRO 
Character Input 

display

Value of 
destination 

device address

Values updated 
to 6th character

NULL (0x00) is written 
from 7th character 
and the values of 
all 10 characters 
are updatedValues are not 

updated
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Example: If Input Digits is 10 and a string with a length of 6 was input

4847(Hex)‘H’ ‘G’
　 　
　 　
　 　
　 　

2053(Hex)

4552(Hex)

4943(Hex)

5300(Hex)

‘   ’ ‘S’
‘E’ ‘R’
‘ I ’ ‘E’
‘S’ (NULL)

4847(Hex)‘H’ ‘G’
　 　
　 　
　 　
　 　

2053(Hex)

4552(Hex)

4943(Hex)

5300(Hex)

‘   ’ ‘S’
‘E’ ‘R’
‘ I ’ ‘E’
‘S’ (NULL)

4D49(Hex)‘M’ ‘I’
　 　
　 　
　 　
　 　

4352(Hex)

4F49(Hex)

0000(Hex)

5300(Hex)

‘C’ ‘R’
‘O’ ‘I’

(NULL)(NULL)

‘S’ (NULL)

4D49(Hex)‘M’ ‘I’
　 　
　 　
　 　
　 　

4352(Hex)

4F49(Hex)

0000(Hex)

0000(Hex)

‘C’ ‘R’
‘O’ ‘I’

(NULL)(NULL)

(NULL)(NULL)

Enter MICROI
(Length of the string is 6)

Check box: Selected Check box: Cleared
Character Input 

display

MICROI_

Value of 
destination 

device address

HG SERIES

MICROI 

MICROI_

HG SERIES

MICROI 
Character Input 

display

Value of 
destination 

device address

Values updated 
to 8th character

NULL (0x00) is written 
from 9th character 
and the values of 
all 10 characters 
are updatedValues are not 

updated



2 Character Input

10-32 WindO/I-NV4 User’s Manual

■ Always Entry Mode*1

Select this check box to enter text by pressing the keypad and key buttons without touching the Character Input 
displayed on the screen.
This option can only be configured if Current Screen is selected for Type.
Example: When the Always Entry mode check box is selected

Example: When the Always Entry Mode check box is cleared

*1 Advanced mode only

Enter textPress CLR Press ENT

4944(Hex)

4543(Hex)

‘ I ’ ‘D’4847(Hex)‘H’ ‘G’ 4847(Hex)‘H’ ‘G’4847(Hex)‘H’ ‘G’

Display text being 
entered (Entry mode)

Display values of
device addresses as text

(Entry mode)

Display only focus
(Entry mode)

Write character codes to 
device addresses

(Entry mode)

Enter IDECDeletes text

‘E’ ‘C’

IDEC_HG_ _ IDEC_

Action

Operations 
and display

Value of
Destination Device Address

Only one Numerical Input or one Character Input set to Always Entry Mode can be configured for one 
screen.

Enter text

Enter IDEC

Press Character Input Press ENT

4944(Hex)

4543(Hex)

‘ I ’ ‘D’

Display text being 
entered (Entry mode)

Display focus
(Entry mode)

Write character codes to 
device addresses

(Entry mode)

4844(Hex)

4543(Hex)

‘ I ’ ‘D’

Display values of
device addresses as text 

(Display mode)

Display values of
device addresses as text 

(Display mode)

4847(Hex)‘H’ ‘G’ 4847(Hex)‘H’ ‘G’ 4847(Hex)‘H’ ‘G’

Press CLR

4847(Hex)‘H’ ‘G’

Display only focus
(Entry mode)

Deletes text

‘C’‘E’‘E’ ‘C’

IDEC_IDEC_HG_ IDECHG

Action

Operations 
and display

Value of
Destination Device Address

_
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■ Focus is moved by ENT button*1

When multiple Character Inputs are configured on the screen, select this check box to continue entering text on each 
of the Character Inputs.
Each time ENT is pressed, the focus moves between the Character Inputs according to Focus Order. On the View 
tab, in the Screens group, click Focus Order, and then click the Character Inputs in the order to move the focus.
Example: When Character Input A and B are configured and the Focus is moved by ENT button check box for 

Character Input A is selected and the Focus is moved by ENT button check box for Character Input B is 
cleared

■ Update the display by ENT button*1

Select this check box to display the current text unchanged and update the display when text is entered and ENT is 
pressed.
When this check box is cleared, the display updates with each press of a character button to display the character 
being entered.

*1 Advanced mode only

Press Character Input Enter text Press ENT

4847(Hex)‘H’ ‘G’
2053(Hex)

4552(Hex)

4945(Hex)

5300(Hex)

4352(Hex)

4F20(Hex)

4D49(Hex)

534D(Hex)

4152(Hex)

5400(Hex)

4847(Hex)‘H’ ‘G’

4352(Hex)

4F00(Hex)

4D49(Hex)‘ I ’
‘R’

‘M’
‘C’

4847(Hex)‘H’ ‘G’

4352(Hex)

4F00(Hex)

4D49(Hex)‘ I ’
‘R’

‘M’
‘C’

4847(Hex)‘H’ ‘G’

4352(Hex)

4F00(Hex)

4D49(Hex)‘ I ’
‘R’

‘M’
‘C’ 4352(Hex)

4F00(Hex)

4D49(Hex)‘ I ’
‘R’

‘M’
‘C’

4847(Hex)

2053(Hex)

4552(Hex)

4945(Hex)

5300(Hex)

4352(Hex)

4F00(Hex)

4D49(Hex)‘ I ’
‘R’

‘M’
‘C’

4847(Hex)

2053(Hex)

4552(Hex)

4945(Hex)

5300(Hex)

4847(Hex)

2053(Hex)

4552(Hex)

4945(Hex)

5300(Hex)

4352(Hex)

4F00(Hex)

4D49(Hex)‘ I ’
‘R’

‘M’
‘C’

Enter text Press ENT

Display values of
device addresses as text 

(Display mode)

Display focus

(Entry mode)

Display focus 

(Entry mode)

Display values of
device addresses as text 

(Display mode)
Display values of

device addresses as text 
(Display mode)

Move focus from 
Character Input A to B

Write character codes to 
device addresses

(Entry mode)

Display text being 
entered (Entry mode)

Write character codes to 
device addresses

(Entry mode)

4352(Hex)

4F20(Hex)

4D49(Hex)

534D(Hex)

4152(Hex)

5400(Hex)

4847(Hex)

2053(Hex)

4552(Hex)

4945(Hex)

5300(Hex)

Press ENT

Display text being 
entered (Entry mode)

Display values of
device addresses as text 

(Display mode)

‘T’

‘ I ’
‘R’

‘M’
‘C’
‘O’ ‘   ’
‘S’
‘A’ ‘R’
‘T’

‘H’ ‘G’
‘   ’ ‘S’
‘E’ ‘R’
‘ I ’ ‘E’
‘S’ (NULL)

‘H’ ‘G’
‘   ’ ‘S’
‘E’ ‘R’
‘ I ’ ‘E’
‘S’ (NULL)

‘H’ ‘G’
‘   ’ ‘S’
‘E’ ‘R’
‘ I ’ ‘E’
‘S’ (NULL)

‘H’ ‘G’
‘   ’ ‘S’
‘E’ ‘R’
‘ I ’ ‘E’
‘S’ (NULL)

(NULL)

‘A’ ‘R’

‘ I ’
‘R’

‘M’
‘C’
‘O’ ‘   ’
‘S’ ‘M’

‘O’ (NULL)‘O’ (NULL)‘O’ (NULL)‘O’ (NULL)‘O’ (NULL)‘O’ (NULL)

‘   ’ ‘S’
‘E’ ‘R’
‘ I ’ ‘E’
‘S’ (NULL)

‘M’

(NULL)

Character Input A
 action

Operations 
and display

HG_ HG  SERIES_ HG  SERIES_ MICRO_ 

A

B MICRO

HG

MICRO

HG_

MICRO

HG_

MICRO

HG SERIES_ HG SERIES

MICRO_

HG SERIES

MICRO_

HG SERIES

MICRO SMART_

MICRO  SMART_ MICRO  SMART_

Character Input B
 action

Character Input A 
destination

device address

Character Input B 
destination

device address

HG SERIES

MICRO SMART

Press Character Input Enter text Press ENT

‘H’ ‘G’ 4847(Hex)

2053(Hex)

4552(Hex)

4943(Hex)

5300(Hex)

4847(Hex)‘H’ ‘G’ 4847(Hex)‘H’ ‘G’ 4847(Hex)‘H’ ‘G’ 4847(Hex)

2053(Hex)

4552(Hex)

4943(Hex)

5300(Hex)

Display values of
device addresses as text 

(Display mode)

Display focus 
(Entry mode)

Display values of
device addresses as text 

(Display mode)

Write character codes to
device addresses

(Entry mode)

Display text being 
entered (Entry mode)

HG

Hide

HG

HG

HG

HG SERIES

HG SERIES

HG SERIES

HG SERIES

Hide

‘S’ (NULL)

‘ I ’ ‘E’
‘E’ ‘R’
‘   ’ ‘S’
‘H’ ‘G’

‘S’ (NULL)

‘ I ’ ‘E’
‘E’ ‘R’
‘   ’ ‘S’

Action

Character Input 
display

Operations and 
display

HG_ HG  SERIES_ HG  SERIES_

Value of 
Destination Device Address

HG HG_ HG_ HG SERIES_ HG SERIES

Keypad display
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● View Tab

■ Image Type
Select the type of graphic to be used to represent the part.

■ Browse
Select the type of graphic to be used to represent the part from the list of graphics. Click this button to display the 
View Browser or Picture Manager, depending on the setting for Image Type.

■ Plate Color
Selects the plate color of the standard graphic (color: 256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

■ Flange

Standard: Uses the default graphic for WindO/I-NV4.

Picture: Uses an image file saved using Picture Manager.
For details about image file restrictions, refer to Chapter 2 “1.4 Available Image Files” on page 2-20.

None: The plate and the flange of the part are not displayed. Only the text is displayed.

Plate color

Foreground Color, Background Color: Selects the foreground and background colors of the flange of the standard 
graphic (color: 256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

Pattern: Selects a pattern for the flange of the standard graphic.
Click Pattern to display the Pattern Palette. Select a pattern from the Pattern 
Palette.

Flange
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■ Coordinates

■ Size

X, Y: Sets the display position of parts using coordinates.
The X and Y coordinates of parts is defined relative to an origin at the top-left corner of the screen.

X: 0 to (base screen horizontal size - 1)

Y: 0 to (base screen vertical size - 1)

(0, 0)
X

Y
Screen

Parts

W, H: Sets width and height to define the size of parts.

W: 20 to (base screen horizontal size)

H: 20 to (base screen vertical size)

Width

Height

Screen

Parts
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● Format Tab

■ Font
Selects the font used for displaying text from the following.
Japanese, European, Central European, Baltic, Cyrillic, Stroke
The characters that can be displayed depend on the font. For details, refer to Chapter 2 “1.2 Available Text” on page 2-6.

■ Size
When Japanese is selected, selects the text size as 8x16 or 16x16.
When Stroke is selected, specifies the text size (8 to 128).
Can only be set when Japanese or Stroke is selected for Font.

■ Style
Selects Regular or Bold for text style.
Can only be set when Japanese, European, Central European, Baltic, or Cyrillic is selected for Font.

■ Magnification

Can only be set when Japanese, European, Central European, Baltic, or Cyrillic is selected for Font.

■ Align Text
Selects the text alignment in the horizontal direction from the following.
Left, Center, Right
For details, refer to Appendix “5 Text Alignment” on page A-7.

■ Text Color
Selects the color of displayed text (color: 256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.
This option can configure the text color in display mode and in entry mode. However, for Entry Mode text color can 
be set only when the Reverse check box is cleared.

■ Reverse
Select this check box to reverse the text color and plate color during display mode when in entry mode.
Can only be set when Standard is selected for Image Type under the View tab.

W, H: Selects text magnification (0.5, 1 to 8).
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■ Display Character with “*”*1

Select this check box to display the entered characters as * (asterisks).
If this check box is selected, nothing is displayed until a value is entered from the key buttons or keypad when the 
Character Input is in entry mode. If ENT is pressed with nothing displayed, 0 is written to the destination device address.

■ Change Font with Device Address*1

Select this check box to change the font used to display the text with a value of device address.
The keypad (popup screen) can also be changed when Standard(Half-Width Character), Standard(Hiragana) 
or Popup is selected for Type under Keypad on the General tab.

■ Change Display Colors
Select this check box to switch the text and plate colors.

*1 Advanced mode only

Trigger Device Address: Specifies the word device (2 words) to use as the condition to change the font.

Click  to display the Tag Editor. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-68.

Example: With Trigger Device Address set to D100, to enter Central European text from 
popup screen 100 using a Character Input for entering European text from the 
standard keypad (popup screen 3003)
Write 6 to D100 and 100 to D101.

Font number Popup screen No.

1st word 3rd word2nd word Font number

1: Japanese
2: European
6: Central European
7: Baltic
8: Cyrillic

Popup screen No. 1 to 3015

Trigger Device Address: Specifies the bit device or the bit number of the word device to use as the trigger to switch 
the text and plate colors.

Click  to display the Tag Editor. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-68.
When the value of device address is 0, the color specified in Text Color or in Plate Color 
on the View tab will be displayed.
When the value of device address is 1, the color displayed and specified in Text Color or 
Plate Color
under the Change Display Colors.

Text Color: Selects the color (color: 256 colors, monochrome: 16 shades) of the text when switching.
Click this button to display the Color Palette. Select a color from the Color Palette.

Plate Color: Selects the plate color (color: 256 colors, monochrome: 16 shades) when switching.
Click this button to display the Color Palette. Select a color from the Color Palette.
This option can only be configured when Standard is selected for Image Type on the View 
tab.

MICRO/I

0

1

Trigger Device Address

Trigger Device Address

External device

HG SERIES

HG SERIES

Text Color

Plate Color on the View tab

Text Color under Change Display Colors

Plate Color under Change Display Colors
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■ Flash
Select this check box to make the text and plate colors flash.
The flashing will occur as follows:
• The Change Display Colors check box is cleared, then the colors specified by Text Color and Plate Color on 

the View tab and the colors specified by Text Color and Plate Color under Flash are alternately displayed.

• The Change Display Colors check box is selected and the value of the trigger device address for Change 
Display Colors is 0, then the colors specified by Text Color and Plate Color on the View tab and the colors 
specified by Text Color and Plate Color under Flash are alternately displayed.

• The Change Display Colors check box is selected and the value of the trigger device for Change Display 
Colors is 1, then the colors specified by Text Color and Plate Color under Change Display Colors and the 
colors specified by Text Color and Plate Color under Flash are alternately displayed.

Flashing

Trigger device address
under Flash

Trigger device address
under Flash

0

1

MICRO/IExternal device

HG SERIES

HG SERIES
HG SERIES

HG SERIES

Text Color

Plate Color on the View tab

Text Color

Plate Color on 
the View tab

Text Color under Flash

Plate Color under Flash

Flashing

Trigger device address
under Flash

Trigger device address
under Flash

MICRO/IExternal device

HG SERIES

HG SERIES
HG SERIES

HG SERIES

Text Color

Plate Color on the View tab

Text Color

Plate Color on 
the View tab

Text Color under Flash

Plate Color under Flash

Trigger device address under
Change Display Colors

Trigger device address under
Change Display Colors

0

0

1

0

Flashing
1

Trigger device address under
Change Display Colors

Trigger device address
under Flash

Trigger device address under
Change Display Colors

Trigger device address
under Flash

0

1

1

MICRO/IExternal device

HG SERIES

HG SERIES
HG SERIES

HG SERIES

Text Color under 
Change Display Colors
Plate Color under 
Change Display Colors

Text Color under Change Display Colors

Plate Color under Change Display Colors

Text Color under Flash

Plate Color under Flash
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Trigger Device Address: Specifies the bit device or the bit number of the word device that will be used to trigger 
flash.

Click  to display the Tag Editor. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-68.
Flash intervals are set in the Flashing Cycle on the System tab in the Project Settings 
dialog box.

Text Color: Selects the color (color: 256 colors, monochrome: 16 shades) of text when flashing.
Click this button to display the Color Palette. Select a color from the Color Palette.

Plate Color: Selects the plate color (color: 256 colors, monochrome: 16 shades) when flashing.
Click this button to display the Color Palette. Select a color from the Color Palette.
This option can only be configured when Standard is selected for Image Type on the View 
tab.
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● Trigger Condition Tab
The Trigger Condition tab is displayed in Advanced mode.

■ Input Condition
The Character Input is enabled and operational while the condition is satisfied. The Character Input is disabled and 
not operational while the condition is not satisfied.
Example: When Trigger Type is While ON and Device Address is LM0

While LM0 is 0, the condition is not satisfied and the Character Input is not operational.
While LM0 is 1, the condition is satisfied and the Character Input is operational.

Trigger Type: Selects the condition to enable the Character Input from the following.

Always enable: The Character Input is always enabled.

While ON: Enables the Character Input when the value of device address is 1.

LM0:

MICRO/I

0

LM0: 1 Operational
Condition 
Satisfied

Condition 
Not 

satisfied

IDEC

IDEC

Not 
operational

Always enabled

Character Input 
state

IDEC

1

0

Disabled Enabled Disabled DisabledEnabled Enabled

Value of
Device Address

Character Input 
state

IDEC IDEC IDEC IDECIDEC IDEC
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■ Visible Condition
The Character Input is displayed while the condition is satisfied. The Character Input is hidden while the condition is 
not satisfied.

While OFF: Enables the Character Input when the value of device address is 0.

While satisfying the condition:

Enables the Character Input when the condition is satisfied.

Data Type: Selects the type of data handled by the conditional expression for the input condition.
This option can only be configured if While satisfying the condition is selected for Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Device Address: Specifies the bit device or the bit number of the word device to serve as the input condition.
This option can only be configured when While ON or While OFF is selected for Trigger Type.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 
“5.1 Device Address Settings” on page 2-68.

Condition: Specifies the conditional expression for the input condition.
This option can only be configured when While satisfying the condition is selected for Trigger 
Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expression 
configuration procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-71.

Comment: Used for entering a comment for the input condition. The maximum number is 80 characters.

1

0

Enabled Enabled EnabledDisabled Disabled Disabled

Value of
Device Address

Character Input 
state

IDEC IDEC IDECIDEC IDEC IDEC

Disabled Disabled DisabledEnabled Enabled Enabled

Satisfied

Not satisfied

Condition

Character Input 
state

IDEC IDEC IDECIDEC IDEC IDEC

Example: When Trigger Type is While ON and Device Address is LM0
While LM0 is 0, the condition is not satisfied and the Character Input is hidden.
While LM0 is 1, the condition is satisfied and the Character Input is displayed.

LM0:

MICRO/I

0

LM0: 1 Show
Condition 
Satisfied

Condition 
Not 

satisfied

IDEC

Hide

• If the Character Input is hidden while entering a value, the input is canceled. If a popup screen 
configured as the standard keypad or a keypad is displayed, these screens are closed.

• When multiple Character Inputs are arranged on the screen and the Focus is moved by ENT button 
check box is selected, entry mode is canceled if the Character Input is hidden while entering a value.
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Trigger Type: Selects the condition to display the Character Input from the following.

Always visible: The Character Input is always displayed.

While ON: Displays the Character Input when the value of device address is 1.

While OFF: Displays the Character Input when the value of device address is 0.

While satisfying the condition: Displays the Character Input when the condition is satisfied.

Data Type: Selects the type of data handled by the conditional expression for the visible condition.
This option can only be configured if While satisfying the condition is selected for Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Device Address: Specifies the bit device or the bit number of the word device to serve as the visible condition.
This option can only be configured when While ON or While OFF is selected for Trigger Type.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 
“5.1 Device Address Settings” on page 2-68.

Condition: Specifies the conditional expression for the visible condition.
This option can only be configured when While satisfying the condition is selected for Trigger 
Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expression 
configuration procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-71.

Comment: Used for entering a comment for the visible condition. The maximum number is 80 characters.

Always show

Character Input 
state

IDEC

1

0

Hide Show Hide HideShow Show

Value of
Device Address

Character Input 
state

IDEC IDEC IDEC

Value of
Device Address

1

0

Show Show ShowHide Hide Hide

Character Input 
state

IDEC IDEC IDEC

Hide Hide HideShow Show Show

Character Input 
state

Satisfied

Not satisfied

Condition

IDEC IDEC IDEC
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● Options Tab
The Options tab is displayed in Advanced mode.

■ No Touch Sound
This function is to disable touch sounds only for specified parts when the MICRO/I makes touch sounds.
Select this check box to display disable touch sounds for this part.

■ Place on the Top Layer
Select this check box to display the parts on the top layer. The parts will have precedence when other drawings and 
parts are overlapping with it. For details, refer to Chapter 6 “4 Drawings and Parts Overlapping” on page 6-5.

To enable touch sounds on the MICRO/I, select the Enable Touch Sound check box under the System 
tab of the Project Settings dialog box.
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● Security Tab
This tab is used to restrict displaying and using the part by security groups.
This option can only be set when Use Security functions is selected. The Use Security functions check box is set 
on General tab in the Security dialog box.

■ (Settings)
Displays the list of security groups used on the MICRO/I.

■ Security Settings
The Security Settings dialog box is displayed. If you create a security group in the Security Settings dialog box, you 
can select that created group. For details, refer to Chapter 23 “2.2 Adding and Editing Security Groups” on page 23-
19.

(Settings)

No.: Displays the security group numbers (0 to 15).

Group Name: Displays the name of the security group.

Display: Displays whether or not there is permission to display the part. Only Permitted security groups 
can display this part. If all security groups are set to Permitted, this part will be displayed even 
if no user account has been selected. Double clicking the cell switches between Permitted and 
Prohibited.

Input: Displays whether or not there is permission to use the part. Only Permitted security groups 
can use this part. If all security groups are set to Permitted, this part can be used even if no 
user account has been selected. Double clicking the cell switches between Permitted and 
Prohibited.

• You can also switch between Permitted and Prohibited by right-clicking on a Display or Input cell.
• Restricting the display and use of the part by switching between Permitted and Prohibited in Display 

and Input cells is similar to using the Trigger Condition tab.

For details about security functions, refer to Chapter 23 “User Accounts and the Security Function” on page 
23-1.
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Example: If the user and security group for a part are set as follows:

For User1 in the Reader security group, the parts for which Display has been set to Prohibited for Reader will not 
be displayed.
If the password screen is opened and the user switches to User2 in the Operator security group, the parts for which 
Display has been set to Permitted for Operator will be displayed.

For User2 in Operator, Display has been set to Permitted for Operator, but Input is Prohibited, so the part 
cannot be used.
If the password screen is opened and the user switches to User3 in the Administrator security group, the parts for 
which Display has been set to Permitted for Administrator will be displayed, and the parts for which Input has 
been set to Permitted for Administrator can be used.

User Name

Security Group Reader Operator Administrator
User1 User2 User3

MICRO/I

130

HG  SERIES

Numerical Display
No. Group Name Display

1 Administrator Permitted

2 Operator Permitted

3 Reader Permitted

Character Input
No. Group Name Display Input

1 Administrator Permitted Permitted

2 Operator Permitted Prohibited

3 Reader Prohibited Prohibited

Line Chart and Bar Chart
No. Group Name Display

1 Administrator Permitted

2 Operator Permitted

3 Reader Prohibited

Open Password Screen, 
enter password, 
and switch to User2

For User1, 
parts for which Display 
has been set to Prohibited 
for Reader are not displayed

For User2, 
parts for which Display 
has been set to Permitted 
for Operator are displayed

MICRO/I

130

MICRO/I MICRO/I

130

User1 User2

130
CAN

User Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password

999

Open Password Screen, 
enter password, 
and switch to User3

For User2, 
parts for which Display 
has been set to Permitted 
for Operator are displayed, 
but parts for which Input 
has been set to Prohibited cannot be used

For User3, 
parts for which Display 
has been set to Permitted 
for Administrator are displayed, 
and parts for which Input 
has been set to Permitted can be use

MICRO/I

130

MICRO/I MICRO/I

130130 130

User2 User3

HG  SERIES_

HG  SERIES_

HG  SERIES HG  SERIES

Button
Can operate

CAN

User Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password

Button
Cannot operate
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● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Used for entering comments about parts. Maximum number is 80 characters.
Example: When mousing over the Character Input on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.
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2.4 How to Enter Text

Use the keypad or key buttons to write character codes to device addresses with the Character Input. The input 
methods are as follows.

■ Pressing the Character Input and Entering Text from the Standard Keypad
Arrange a Character Input on the screen and in its properties dialog box, on the General tab, under Keypad, select 
Standard for Type.

External device
MICRO/I

HG SERIE

HG SERIES_

HG

HG_

HG SERIES_

HG SERIES

D100 : 4847(Hex)‘H’ ‘G’

D100 : 4847(Hex)‘H’ ‘G’

D100 : 

D101 : 

4847(Hex)‘H’ ‘G’

2053(Hex)

4552(Hex)

4945(Hex)

5300(Hex)

‘E’ ‘R’D102 : 

D103 : 

D104 : 

D100 : 

D101 : 

4847(Hex)‘H’ ‘G’

2053(Hex)

4552(Hex)

4945(Hex)

5300(Hex)

‘E’ ‘R’D102 : 

D103 : 

D104 : 

‘S’ (NULL)

‘ I ’ ‘E’

‘   ’ ‘S’

‘ I ’ ‘E’

‘S’ (NULL)

‘   ’ ‘S’

Press Character Input

Write text character 
codes to device addresses

Press ENT

Display values of device addresses as text
(Entry mode)

Display values of device addresses as text
(Entry mode)

Close standard keypad

Display standard keypad

Enter text as
 "HG SERIES"

Display values of device addresses as text
(Display mode)

Display values of device addresses as text
(Display mode)

When the following operations are performed, entry mode is canceled and the current values of device 
addresses are displayed as character codes on the Character Input. To enter text, press the Character Input 
again to select it and set it to entry mode.
• CAN was pressed
• When the Focus is moved by ENT button check box on the General tab is cleared and ENT was 

pressed and a value was written to the device address
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■ Without Pressing the Character Input, Directly Entering Text from a Keypad on the Same Screen
Arrange a Character Input and a keypad on the same screen. In the properties dialog box for the Character Input, on 
the General tab, under Keypad, select Current Screen for Type and select the Always Entry Mode check box.

■ Changing the Language and Entering Text
Select the Change Font with Device Address check box on the Format tab in the properties dialog box.
It is convenient to use this setting together with the text group settings.
The font and popup screen with this setting will change simultaneously with the text group change and text can be 
entered with the same font as the text group.
Specify the same device address in the Change Text Group by Device Address on Text Manager as the Trigger 
Device Address for this setting.

External device
MICRO/I

HG_

HG SERIES_

HG SERIES

D100 : 4847(Hex)‘H’ ‘G’

D100 : 

D101 : 

4847(Hex)‘H’ ‘G’

2053(Hex)

4552(Hex)

4945(Hex)

5300(Hex)

‘E’ ‘R’D102 : 

D103 : 

D104 : 

D100 : 

D101 : 

4847(Hex)‘H’ ‘G’

2053(Hex)

4552(Hex)

4945(Hex)

5300(Hex)

‘E’ ‘R’D102 : 

D103 : 

D104 : 

‘   ’ ‘S’

‘ I ’ ‘E’

‘S’ (NULL)

‘   ’ ‘S’

‘ I ’ ‘E’

‘S’ (NULL)

Write text character 
codes to device addresses

Press ENT

Display values of device addresses as text
(Entry mode)

Display values of device addresses as text
(Entry mode)

Display values of device addresses as text
(Entry mode)

Enter text as 
"HG SERIES"
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2.5 Character Input Usage Examples

● Enter Kanji characters

Using the Standard Keypad Popup Screen (Screen number: 3008) for inputting Kanji characters, enter Kanji 
characters in the Character Input.

Configuration Procedure

1 On the Home tab, in the Parts group, click Data Displays, and then click Character Input.

2 Click a point on the edit screen where you place the Character Input.

3 Double-click the dropped Character Input and a Properties dialog box will be displayed.

4 Select the Standard(Hiragana) as the Type on the General tab.

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P
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5 Click the Format tab, select the Japanese as the Font, and then select the 16x16 as the Size.

6 Click OK.

The Properties of Character Input dialog box closes.

7 On the Configuration tab, in the System Setup group, click Project.

The Project Settings dialog box is displayed.

8 Click the Font/Kanji Dictionary Data tab, and then select the Use Kanji dictionary data check box.

9 Click OK.
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10 On the Home tab, in the Project group, click the Download icon.
The Download dialog box is displayed.

If the project data was changed, a confirmation message to save the project data is displayed.
Click OK to save the project data and display the Download dialog box.
Click Cancel to return to the editing screen without saving the project data.

11 Select the Download Fonts and Kanji Dictionary Data check box.

12 Verify Communication Settings and click Download.
Since the recipe files are downloaded to the external memory device inserted in the MICRO/I, use the same settings 
as when communicating with the MICRO/I.
To change Communication Settings, click Change to display the Communication Settings dialog box. Change 
Communicate with, Port, and Baud Rate. For details, refer to Chapter 24 “1 Communicating with the MICRO/I” 
on page 24-1.

13 On the confirmation message, click Yes.
The Download Project dialog box is displayed and the project files start downloading.
When finished downloading, an information message is displayed.

14 Click OK on the information message.
You are returned to the Download dialog box.

15 Click Close on the Download dialog box.

This concludes configuring the settings to enter Kanji characters to Character Input.

If security is enabled in the MICRO/I project, the Password Screen is displayed. Select the user name and 
enter the password.
For details, refer to Chapter 23 “User Accounts and the Security Function” on page 23-1.
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Operating Procedure

This section describes an example of entering the Kanji characters " 山田太郎 " to the Character Input.

1 Press the Character Input for entering the Kanji characters.

The popup screen for the standard keypad (screen number 3008) will be displayed.

2 Press the Kanji to switch it to Kanji input mode.

3 Enter the reading of Kanji with Hiragana.

The maximum number is 32 characters.

Example: Press " や ", " ま ", " た " and then "Small ゛゜" when you enter " やまだ ".

External device
MICRO/I

あ

い

う

え

お

か

き

く

け

こ

さ

し

す

せ

そ

た

ち

つ

て

と

な

に

ぬ

ね

の

は

ひ

ふ

へ

ほ

ま

み

む

め

も

や

ゆ

よ

ら

り

る

れ

ろ

ー

、

。

↑ ↓

わ

を

ん

BS

← →

CLR

CAN

ENT
Kanji Alphabet Num&Sign  ゛゜Small

SP

あ

い

う

え

お

か

き

く

け

こ

さ

し

す

せ

そ

た

ち

つ

て

と

な

に

ぬ

ね

の

は

ひ

ふ

へ

ほ

ま

み

む

め

も

や

ゆ

よ

ら

り

る

れ

ろ

ー

、

。

↑ ↓

わ

を

ん

BS

← →

CLR

CAN

ENT
Kanji Alphabet Num&Sign  ゛゜Small

SP

やまだ

4

123
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4 Press SP to display conversion candidates.

5 Press SP, ↑ or ↓ to select a conversion candidate.

6 Press ENT to apply the entered characters.

あ

い

う

え

お

か

き

く

け

こ

さ

し

す

せ

そ

た

ち

つ

て

と

な

に

ぬ

ね

の

は

ひ

ふ

へ

ほ

ま

み

む

め

も

や

ゆ

よ

ら

り

る

れ

ろ

ー

、

。

↑ ↓

わ

を

ん

BS

← →

CLR

CAN

ENT
Kanji Alphabet Num&Sign  ゛゜Small

SP

やまだ
山田
ヤマダ
山だ
耶麻だ
ヤマだ

あ

い

う

え

お

か

き

く

け

こ

さ

し

す

せ

そ

た

ち

つ

て

と

な

に

ぬ

ね

の

は

ひ

ふ

へ

ほ

ま

み

む

め

も

や

ゆ

よ

ら

り

る

れ

ろ

ー

、

。

↑ ↓

わ

を

ん

BS

← →

CLR

CAN

ENT
Kanji Alphabet Num&Sign  ゛゜Small

SP

やまだ
山田
ヤマダ
山だ
耶麻だ
ヤマだ

Characters exceeding the number of Input Digits or the number of Display Digits are deleted.

あ

い

う

え

お

か

き

く

け

こ

さ

し

す

せ

そ

た

ち

つ

て

と

な

に

ぬ

ね

の

は

ひ

ふ

へ

ほ

ま

み

む

め

も

や

ゆ

よ

ら

り

る

れ

ろ

ー

、

。

↑ ↓

わ

を

ん

BS

← →

CLR

CAN

ENT
Kanji Alphabet Num&Sign  ゛゜Small

SP

山田
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7 Repeat steps 2 through 6 to enter all the characters.

8 Press ENT to enter characters to the Character Input.

The Shift-JIS code of the entering characters are written to the device address.

This concludes entering Kanji characters to the Character Input.

あ

い

う

え

お

か

き

く

け

こ

さ

し

す

せ

そ

た

ち

つ

て

と

な

に

ぬ

ね

の

は

ひ

ふ

へ

ほ

ま

み

む

め

も

や

ゆ

よ

ら

り

る

れ

ろ

ー

、

。

↑ ↓

わ

を

ん

BS

← →

CLR

CAN

ENT
Kanji Alphabet Num&Sign  ゛゜Small

SP

山田 たろう
太郎
田老
足ろう
たろう
太朗

On the simulator, you can not enter Kanji characters with the Character Input.

あ

い

う

え

お

か

き

く

け

こ

さ

し

す

せ

そ

た

ち

つ

て

と

な

に

ぬ

ね

の

は

ひ

ふ

へ

ほ

ま

み

む

め

も

や

ゆ

よ

ら

り

る

れ

ろ

ー

、

。

↑ ↓

わ

を

ん

BS

← →

CLR

CAN

ENT
Kanji Alphabet Num&Sign  ゛゜Small

SP

山田太郎
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2.6 String Data Storage Method

The entered text is stored in the upper byte and lower byte according to the Storage Method of String Data 
setting. Storage Method of String Data is configured on the System tab in the Project Settings dialog box.
For details, refer to Chapter 4 “3.1 System Tab” on page 4-25.

Example 1:When the destination device address is “LDR100” and the entered text is “ABCDE”

• When from Upper byte is selected for Storage Method of String Data

• When from Lower byte is selected for Storage Method of String Data

Example 2:When the destination device address is “LDR100” and the entered text is “ 完了 ”

• When from Upper byte is selected for Storage Method of String Data

• When from Lower byte is selected for Storage Method of String Data

2.7 Advanced Usage

● Using the System Area
• When finished entering text by pressing ENT, 1 is written to the System Area 2 Character Input Setting Complete 

bit (address number+3, bit 5).
• When CAN is pressed, entry mode is canceled and 1 is written to the System Area 2 Character Input Setting Cancel 

bit (address number+3, bit 6). However, if the keypad is closed by pressing  (close) on the popup screen's title 
bar or another Character Input is pressed and selected before finished entering the text by pressing ENT, entry 
mode is canceled and 1 is not written to the System Area 2 Character Input Setting Cancel bit (address number+3, 
bit 5).

• To clear the System Area 2 character input setting complete bit or the character input setting cancel bit, write 1 to 
System Area 1 Character Input Setting Clear bit (address number+1, bit 11). To automatically clear these bits when 
the Character Input keypad is pressed in entry mode, select the Clear Keypad bit in System Area 
automatically check box on the System tab in the Project Settings dialog box.

Device address
Stored value

Upper byte Lower byte
LDR100 'A' = 41 (Hex) 'B' = 42 (Hex)
LDR101 'C' = 43 (Hex) 'D' = 44 (Hex)
LDR102 'E' = 45 (Hex) 0

NULL terminating character

Device address
Stored value

Upper byte Lower byte
LDR100 'B' = 42 (Hex) 'A' = 41 (Hex)
LDR101 'D' = 44 (Hex) 'C' = 43 (Hex)
LDR102 0 'E' = 45 (Hex)

NULL terminating character

Device address
Stored value

Upper byte Lower byte
LDR100 8A (Hex) AE (Hex) ' 完 '
LDR101 97 (Hex) B9 (Hex) ' 了 '
LDR102 0

NULL terminating character

Device address
Stored value

Upper byte Lower byte
LDR100 AE (Hex) 8A (Hex) ' 完 '
LDR101 B9 (Hex) 97 (Hex) ' 了 '
LDR102 0

NULL terminating character

When handling strings, 0 is written to the device as the NULL terminating character and treated as the end 
of the string.



3 Picture Display

10-56 WindO/I-NV4 User’s Manual

  

3.1 How the Picture Display is Used

The Picture Display displays pictures. It can change, move, or scale the displayed picture according to value of device 
address.

• Switch and display pictures by value of device address

3 Picture Display

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

External device
MICRO/I

D0

bit15 bit0bit3

D0= 0100

bit0bit3

D0= 0001

bit0bit3

D0= 0010

bit0bit3

D0= 0100

bit0bit3

Pic0Pic1Pic2
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• Switch and display pictures at a regular interval

• Move the picture position by values of device addresses

MICRO/I
Picture List

5 x 100 ms

5 x 100 ms

5 x 100 ms

Pic0

Pic1

Pic2

External device
MICRO/I

Display picture at X 0, Y 0

Move picture to X 300, Y 250

Move picture to X 600, Y 500

X-coordinate D100= 0
Y-coordinate D101=

X-coordinate D100=
Y-coordinate D101=

X-coordinate D100=
Y-coordinate D101=

0

300
250

600
500
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• Scale the size of the picture by values of device addresses and display it

• Rotate the picture by values of device addresses and display it
This example shows a 0° start angle of rotation at the minimum value of 0 and a 90° end angle of rotation at the 
maximum value of 100.
The pivot point of rotation is the position at X Point 0 and Y Point 500 from the center of picture.

When the size of pictures to switch differs and the Dynamic Size check box is cleared, all the pictures are 
displayed with the same size as Pic0.

External device
MICRO/I

Shrink picture to 
W 180, H 120

Scale picture to 
W 360, H 240

Scale picture to 
W 720, H 480

Width D100= 180
Height D101=

Width D100=
Height D101=

Width D100=
Height D101=

120

360
240

720
480

External device
MICRO/I

Display picture 
at posi�on where it 
has been rotated 90°

Display picture 
at posi�on where it 
has been rotated 45°

Display picture 
at same posi�on 
as when not rotatedD100= 0

D100= 50

D100= 100
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3.2 Picture Display Configuration Procedure

This section describes the configuration procedure for Picture Displays.

1 On the Home tab, in the Parts group, click Data Displays, and then click Picture Display.

2 Click a point on the edit screen where you wish to place the Picture Display.

3 Double-click the dropped Picture Display and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.

The Trigger Condition tab and Options tab only appear in Advanced mode.
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3.3 Properties of Picture Display Dialog Box

This section describes items and buttons on the properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ Switching Method
Specifies the method for switching pictures to display from the following. Register pictures in Picture List on the 
View tab.

Bit Number: Switches the picture to display according to the status of bits in a device address.
Example: When Bit Number is selected and the bits of trigger device address D0 are allocated to 

the following pictures.

Switches the picture to display according to the status of the bits.

bit15 bit0bit3

Trigger device address D0

Picture

Pic0Pic1Pic2

0001

Picture to display

Trigger device address 
D0 bit state

0010 0100 1000

Display picture 

for bit 0

Display picture 

for bit 1

Display picture 

for bit 2
No picture

Display picture 

for bit 1

Display picture 

for bit 2
Action

1110 1100

Pic 0 Pic 1 Pic 1Pic 2 Pic 2

If all bits in the device address are 0 or if a bit with 
no associated picture becomes 1, display nothing.

If multiple bits are 1, display the 
picture for the lowest order bit.
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Value: Switches the picture to display according to the value of the device address.
Example: When Value is selected and the trigger device addresses D0 are allocated to the 

following pictures.

Switches the picture to display according to the value of the device address.

Trigger Device Address: Specifies the word device to use as the condition for switching pictures.

Click  to display the Tag Editor. For the device address configuration 
procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-68.
This option can only be configured when Bit Number or Value is 
selected.

0 1 2Trigger device address D0 value

Picture

Pic2Pic1Pic0

Pic 1Pic 0 Pic 2

0

Picture to display

Trigger device address                 

D0 value

1 2 3

Display picture for 0Action Display picture for 1 Display picture for 2 No picture

If the value of device 
address has no picture 
associated with it, display 
nothing.

When the size of pictures to switch differs and the Dynamic Size check box is cleared, all the pictures are 
displayed with the same size as Pic0.

Fixed Period: Switches the pictures to display at a regular interval in picture number order on the picture list.
Example: When Fixed Period is selected and the following pictures are allocated to the picture list.

Switches the pictures to display at a regular interval in picture number order on the 
picture list.

Interval: Specifies the interval to switch pictures as 2 to 600 (100 ms units).
This option can only be configured when Fixed Period is selected.

Repeat: Select this check box to repeat displaying pictures from the start of the picture 
list when the picture at the end of the list is displayed.
This option can only be configured when Fixed Period is selected.

Picture

Picture list number Pic2Pic1Pic0

Picture to display

Action

5 x 100 msInterval

Regular interval

5 x 100 ms

Regular interval

5 x 100 ms

Regular interval

Display picture 
for bit 0

Display picture 
for bit 1

Display picture 
for bit 2

Pic 0 Pic 1 Pic 2

If the Repeat check box is cleared, 
stop switching the picture list.

When Fixed Period is selected, the picture may not be displayed when the interval is shorter than the scan 
time for the screen on the MICRO/I. The maximum value for the MICRO/I scan time can be checked by the 
value of HMI Special Data Register LSD4. Refer to Chapter 33 “HMI Special Data Register (LSD)” on page 
33-7.
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■ Flash
Select this check box to flash the displayed pictures. The picture is repeatedly shown and hidden.

■ Dynamic Position*1

Select this check box to move and display the picture by specifying the coordinates of the picture as values of device 
addresses.

■ Dynamic Size*1

Select this check box to scale the picture by specifying the size of the picture as values of device addresses.

*1 Advanced mode only

X Point: Specifies the word device that is the X-coordinate of the picture.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 
Device Address Settings” on page 2-68.

Y Point: Specifies the word device that is the Y-coordinate of the picture.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 
Device Address Settings” on page 2-68.

Example: When a device address for the X-coordinate is D100 and a device address for the Y-coordinate is D101
The picture is moved to the values of D100 and D101.

0
0

300

250

600

500

Position of picture to display

Value of the Y-coordinate 
device address D101

Value of the X-coordinate 
device address D100 0

0

300

250

600

500

Width: Specifies the word device that is the width of the picture.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 
Device Address Settings” on page 2-68.

Height: Specifies the word device that is the height of the picture.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 
Device Address Settings” on page 2-68.

Example: When a device address for the width is D100 and a device address for the height is D101
The picture is displayed with its size scaled to the values of D100 and D101.

The top layer cannot be set when the Dynamic Size check box is selected.

180

120

360

240

720

480

180

120

360

240

720

480

Size of picture to display

Value of 
Height Device Address D101

Value of 
Width Device Address D100
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■ Dynamic Rotation
Select this check box to rotate and display a picture.

Edit: Configures details for rotating and displaying a picture.
Click this button to display the Dynamic Rotation dialog box. For details, refer to “Dynamic Rotation 
Dialog Box” on page 10-64.

Only the top layer is valid if the picture is NMF (NV Metafile).

When the size of pictures to switch differs and the Dynamic Size check box is cleared, all the pictures are 
displayed with the same size as Pic0.

When moving and scaling pictures, set the values of device addresses so the picture is not moved or scaled 
outside the screen's display area.
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Dynamic Rotation Dialog Box

Configures details for rotating and displaying a picture.

■ Source Device Address
Specifies the word device to be read that holds the value of the rotation angle of the picture.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.

■ Data Type
Selects the type of data that will be used to rotate the picture.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

■ Use Custom Settings
Select this check box to configure the range of values to read from the Source Device Address, the range of the 
rotation angle, the coordinate point of the center point that will serve as the pivot point for rotation.
When this check box is cleared, rotate the picture with the minimum value is 0, the maximum value is a fixed value 
specified in the Maximum under the Range of Value, and the Range of Angle to rotate is 0 to 360 degrees.

Maximum
End angle of rotation

Center Point (X Point, Y Point)
Pivot point of rotation

The center of picture

Rotation angle

X

YMinimum
Start angle of rotation
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■ Range of Value
Configures the range of values to read from the Source Device Address with a fixed value or a value of device 
address. 
Converts the read value to the specified angle range, and then rotate the picture.
This option can only be configured when the Use Custom Settings check box is selected. When the Use Custom 
Settings check box is cleared. only the Maximum can be specified with a fixed value.

Specifies the range of values that corresponds to the range of angle.

■ Range of Angle
Configures the range of the rotation angle with a fixed value or a value of device address. This option can only be 
configured when the Use Custom Settings check box is selected.

Specifies the range of angle for rotation.

Value: Specifies as constants.

Device Address: Specifies as the values of word devices.

Minimum, Maximum: Specifies the minimum and maximum values.
If Value is selected, the minimum and maximum values that can be specified will depend on 
the data type selected by Data Type. For details about data types, refer to Chapter 2 “1.1 
Available Data” on page 2-1. 

If Device Address is selected, specify the word device to be read. Click  to display the Tag 
Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device Address 
Settings” on page 2-68.

When the Minimum is bigger than the Maximum, the picture is not rotated.

Value: Specifies as constants.

Device Address: Specifies as the values of word devices.

Start, End: Specifies the start angle of rotation (-360° to 360°) and the end angle of rotation (-360° to 
360°).
If Value is selected, the start and end angles that can be specified will depend on the data 
type selected by Data Type. For details about data types, refer to Chapter 2 “1.1 Available 
Data” on page 2-1. 

If Device Address is selected, specify the word device to be read. Click  to display the Tag 
Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device Address 
Settings” on page 2-68.

The direction of rotation is as follows.
Start angle < End angle: Clockwise
Start angle > End angle: Counterclockwise
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■ Center Point
Configures the coordinate point of the center point that will serve as the pivot point for rotation with a fixed value or 
a value of device address. This option can only be configured when the Use Custom Settings check box is selected.

Specifies the coordinate point of the center point that will serve as the pivot point for rotation. The center point is 
relative coordinate point with the center of picture as the origin.

Value: Specifies as constants.

Specify from Picture: Click this button to display the Specify from Picture dialog box. You can 
specify the coordinates of the center point using the preview that you 
actually rotate a picture. For details, refer to “Specify from Picture dialog 
box” on page 10-67. This option can only be configured when Value is 
selected.

Device Address: Specifies as the value of word devices.

X, Y: Specifies the X Point (-32,768 to 32,767) and the Y Point (-32,768 to 32,767). 
If Value is selected, the coordinate points that can be specified will depend on the data type 
selected by Data Type. For details about data types, refer to Chapter 2 “1.1 Available Data” on 
page 2-1. 

If Device Address is selected, specify the word device to be read. Click  to display the Tag 
Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device Address 
Settings” on page 2-68.

• Coordinate points outside the screen's display area can also be specified as the pivot point of rotation.
• If the size of both the width and height of the pictures is odd, the center of picture is the origin. 

If the width is even, the left side of the center of picture is the origin. If the height is even, the top side of 
the center of picture is the origin.

Width:  Odd
Height: Odd

Center of picture 
is origin

Width:  Even
Height: Odd

Left side of 
center of 
picture is origin

Width:  Odd
Height: Even

Top side of 
center of 
picture is origin

Width:  Even
Height: Even

Top-left side of 
center of 
picture is origin

Example: When the source device address is D100, the minimum value is 0, the maximum value is 100, the start 
angle of rotation is 0°, the end angle of rotation is 90°, the X coordinate point of the center point is 0, and 
the Y coordinate point of the center point is 500
The picture will rotate according to the value of D100 as shown below.

0 (0˚)

( 0, 500)

100
 (90˚)

0 (0˚)

100
 (90˚)

0 (0˚)

100
 (90˚)

Position of picture to display

Source Device Address                 

D100 value
0 50 100

• When the picture is switched after being rotated, the picture after being switched will also be displayed with 
the same settings and in the same rotated state.

• When a picture is rotated and displayed on a popup screen, the portion of the picture that extends past the 
popup screen will not be displayed.

• If the drawing position of the picture changes due to changing the angle or pivot point, parts placed 
underneath the picture will be displayed partially missing on the base screen and popup screen. Parts on the 
top layer will be fully displayed.
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Specify from Picture dialog box

To specify the center point that will serve as the pivot point for rotation, perform one of the following operations. For 
the coordinates, the X-coordinate and Y-coordinate of the center point are displayed with the center of the picture as 
the origin.
• Double-click on the displayed picture.
• Select and drag the mark indicating the center point or move with the cursor key.

Center Point

Point
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● View Tab

■ Settings
Registers the pictures to display on the Picture Display.

■ Image
Displays picture for the Pic number that has been selected in the Picture List.

■ Coordinates

*1 Advanced mode only

(Pic number - File name)

(Pic number - File name): Registers the pictures to display. 
Double clicking the cell displays the Picture Manager where you can specify the picture. 
The picture number (Pic number) and the file name of the registered picture are displayed.

Remove: Deletes the registered picture from the list.

Up: Shifts the selected settings upward in the list.

Down: Shifts the selected settings downward in the list.

X, Y: Sets the display position of parts using coordinates.
The X and Y coordinates of parts is defined relative to an origin at the top-left corner of the screen.

X: 0 to (base screen horizontal size - 1)

Y: 0 to (base screen vertical size - 1)

(0, 0)
X

Y
Screen

Parts
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■ Size

W, H: Sets width and height to define the size of parts.

W: 2 to (base screen horizontal size)

H: 2 to (base screen vertical size)

Width

Height

Screen

Parts
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● Trigger Condition Tab
The Trigger Condition tab is displayed in Advanced mode.

The Picture Display is enabled while the condition is satisfied, and it is disabled while the condition is not satisfied. 
Select the operation when the condition is not satisfied as Not update Picture data or Not show Picture Display 
under While not satisfying the condition.

■ Trigger Type
Selects the condition to enable the Picture Display from the following.

Example: When Trigger Type is While ON, Device Address is LM0, and While not satisfying the 
condition is Not show Picture Display
While LM0 is 0, the condition is not satisfied and the Picture Display does not display the picture.
While LM0 is 1, the condition is satisfied and the Picture Display displays the picture.

LM0:

MICRO/I

0

LM0: 1

Condition 
Not 

satisfied

Condition 
Satisfied

Show 
picture

Hide 
picture

Always visible: The Picture Display is always enabled.

Display

Data Pic0 Pic1 Pic2 Pic0 Pic1 Pic2 Pic0

Update Update Update Update Update Update Update
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■ Data Type
Selects the data type to be handled by the condition formula.
Can only be set if While satisfying the condition is selected as Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

■ Device Address
Specifies the bit device or the bit number of the word device to serve as condition.
Can only be set if While ON or While OFF is selected as Trigger Type.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.

■ Condition
Sets the condition formula.
Can only be set if While satisfying the condition is selected as Trigger Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expression configuration 
procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-71.

■ Comment
Used for entering comments about trigger conditions. Maximum number is 80 characters.

■ While not satisfying the condition
Selects operation of parts when condition is not satisfied. 

While ON: Enables the Picture Display when the value of device address is 1.
Example: When While not satisfying the condition is Not update Picture data

While OFF: Enables the Picture Display when the value of device address is 0.
Example: When While not satisfying the condition is Not update Picture data

While satisfying the condition: Enables the Picture Display when the condition is satisfied.
Example: When While not satisfying the condition is Not update Picture data

Value of 
Device Address

1

0

UpdateDo not update Do not update Do not update

Display

Data Pic0 Pic1 Pic2 Pic0 Pic1 Pic2 Pic0

Update Update Update

Value of 
Device Address

1

0

Update Do not update Do not update Do not update Do not update

Display

Data Pic0 Pic1 Pic2 Pic0 Pic1 Pic2 Pic0

Update Update

UpdateDo not update Do not update Do not update

Display

Data Pic0 Pic1 Pic2 Pic0 Pic1 Pic2 Pic0

Update Update Update

Satisfied

Not satisfied

Condition

Not update Picture data: The last updated graphic is displayed. The graphic does not change.
Not show Picture Display: Graphic is not displayed.
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● Options Tab
The Options tab is displayed in Advanced mode.

■ Place on the Top Layer
Select this check box to display the parts on the top layer. The parts will have precedence when other drawings and 
parts are overlapping with it. For details, refer to Chapter 6 “4 Drawings and Parts Overlapping” on page 6-5.
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● Security Tab
This tab is used to restrict displaying and using the part by security groups.
This option can only be set when Use Security functions is selected. The Use Security functions check box is set 
on General tab in the Security dialog box.

■ (Settings)
Displays the list of security groups used on the MICRO/I.

■ Security Settings
The Security Settings dialog box is displayed. If you create a security group in the Security Settings dialog box, you 
can select that created group. For details, refer to Chapter 23 “2.2 Adding and Editing Security Groups” on page 23-
19.

(Settings)

No.: Displays the security group numbers (0 to 15).

Group Name: Displays the name of the security group.

Display: Displays whether or not there is permission to display the part. Only Permitted security groups 
can display this part. If all security groups are set to Permitted, this part will be displayed even 
if no user account has been selected. Double clicking the cell switches between Permitted and 
Prohibited.

You can also switch between Permitted and Prohibited by right-clicking on a Display cell.

For details about security functions, refer to Chapter 23 “User Accounts and the Security Function” on page 
23-1.



3 Picture Display

10-74 WindO/I-NV4 User’s Manual

Example: If the user and security group for a part are set as follows:

For User1 in the Reader security group, the parts for which Display has been set to Prohibited for Reader will not 
be displayed.
If the password screen is opened and the user switches to User2 in the Operator security group, the parts for which 
Display has been set to Permitted for Operator will be displayed.

User Name

Security Group Reader Operator
User1 User2

MICRO/I

130

Numerical Display
No. Group Name Display

1 Administrator Permitted

2 Operator Permitted

3 Reader Permitted

Button
No. Group Name Display Input

1 Administrator Permitted Permitted

2 Operator Permitted Prohibited

3 Reader Prohibited Prohibited

Line Chart and Bar Chart
No. Group Name Display

1 Administrator Permitted

2 Operator Permitted

3 Reader Prohibited

Open Password Screen, 
enter password, 
and switch to User2

For User1, 
parts for which Display 
has been set to Prohibited 
for Reader are not displayed

For User2, 
parts for which Display 
has been set to Permitted 
for Operator are displayed

MICRO/I

130

MICRO/I MICRO/I

130

User1 User2

130
CAN

User Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password
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● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Used for entering comments about parts. Maximum number is 80 characters.
Example: When mousing over the Picture Display on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.
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3.4 Picture Display Usage Examples

● Rotating and Displaying a Picture
This example shows rotating and displaying a picture by the values of device addresses.

1 On the Home tab, in the Parts group, click Data Displays, and then click Picture Display.

2 Click a point on the edit screen where you wish to place the Picture Display.

3 Double-click the dropped Picture Display and a Properties dialog box will be displayed.

4 Click the View tab.
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5 Registers the pictures to display on the Picture List.

Double click "pic0-Unregistered".
Picture Manager is displayed.

6 Click Import.

Open dialog box is displayed.

7 Specify the image file, and then click Open.

The picture is saved in Picture Manager.
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8 Specify the image file, and then click Select.

The picture is saved in Settings.

9 Repeat steps 5 through 8 and register all pictures for switching.
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10 Click the General tab.

11 Select the Dynamic Rotation check box, and then click Edit.
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12 In Source Device Address, specify the word device to be read that holds the value to rotate and display 
the picture.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.

13 With Data Type, select the data type of the value.
Select the type of data that will be used to rotate and display the picture.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

14 Specify the maximum of the value to read from the Source Device Address in the Maximum under the 
Range of Value. 
Rotate the picture with the minimum value is 0 and the Range of Angle to rotate is 0 to 360 degrees.

15 Click OK.
The Dynamic Rotation dialog box closes.

16 Change the settings on each tab as necessary and click the OK button.
The Properties of Picture Display dialog box closes.
This concludes configuring the settings to rotate and display the Picture Display.
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This function is only supported by models that are equipped with a video interface.

4.1 How the Video Display is Used

• Play movie files

• Display video camera images on the MICRO/I and output microphone audio*3 from a connected speaker

• Display images of two video cameras on the MICRO/I*1

*1 HG5G/4G/3G-V only
*2 This is applicable for HG4G/3G with a video interface only.
*3 Recording sound function is for HG4G/3G only

4 Video Display

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

MICRO/I

Play

Play Stop Back Next

SD memory card

Movie Files
(AVI format)
(MP4 format)

Movie File List
(movie.lst)HG4G HG3G

HG5G-V HG4G-V HG3G-V
*1
*2

Video Camera

Microphone

Images

Audio

MICRO/I

Play Stop Back Next

HG4G HG3G
HG5G-V HG4G-V HG3G-V

*3

Video Camera
Images

Channel 1

Audio
Channel 2

MICRO/I

HG5G-V HG4G-V HG3G-V

再生 停止 前へ 次へ

CH1
再生 停止 前へ 次へ

CH2
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• Using multiple Video Displays is as follows.
- HG5G/4G/3G-V

The maximum number of the Video Display that can be arranged on a single screen is two, you cannot 
arrange three or more Video Displays on a single screen including overlay.
Two Video Displays can display image from video input at the same time, but can not display movie file 
at the same time. However, even while playing a movie file on the Video Display, the video from the 
video input can be displayed on another Video Display.

- HG4G/3G
The maximum number of the Video Display that can be arranged on a single screen is 1. When two or 
more Video Displays are displayed on the screen including overlay, only the Video Display that was 
displayed first will operate.
Example: If the Popup Screen with a Video Display is opened from the Base Screen which also con-

tains a Video Display, only the Video Display on the Base Screen will operate.

• If a portion of the video display is outside the display area of the screen, the video display will not 
display anything. If a video display on a popup screen is moved outside the display area of the screen, 
the movie playback and displayed video will stop.

• Depending on the size of the video display, the displayed image may be shrunk.
• When the frame size of the movie file to be played is less than or equal to half the size of the Video 

Display, the movie file cannot be played.
• While data is being recorded after an event occurs with the event recording function, while data is being 

recorded with a Key Button, Multi-Button, or Multi-Command configured with the recording function, or 
while data is being saved to the external memory device, movie files cannot be played. While data is 
recording after an event occurs and while data is being saved to the external memory device, the value 
of HMI Special Data Register LSD155-0 changes to 1. For details, refer to Chapter 33 “HMI Special Data 
Register (LSD)” on page 33-7.

MICRO/I Popup screen  
video display

Base screen  
video display

Play Stop Back Next

HG3GHG4G

Opera�onalOpera�onalOpera�onal

Play Stop Back Next Non-opera�onalNon-opera�onalNon-opera�onal

Video Display can be operated using the Key Buttons, Multi-Buttons, and Multi-Commands.
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4.2 Video Display Configuration Procedure

This section describes the configuration procedure for the Video Display.

1 On the Home tab, in the Parts group, click Data Displays, and then click Video Display.

2 Click a point on the edit screen where you wish to place the Video Display.

3 Double-click the dropped Video Display and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.

The Options tab only appears in Advanced Mode.
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4.3 Properties of Video Display Dialog Box

This section describes items and buttons on the properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. Maximum number is 20 characters.

■ Action
Select the content to execute on the Video Display from the following.

*1 Recording sound function is for HG4G/3G only
*2 HG5G/4G/3G-V only

Display images from the Video Input: Displays images from the video interface and outputs sound*1 from the audio 
interface.

(Channel)*2: Selects Channel 1 or Channel 2 to display one of the images 
from the video interface.

Play a movie or recorded file from the File Screen: 

Selects and plays files using the File Screen. For details, refer to “4.4 File 
Screen” on page 10-92.

Play the Movie File List: Plays movie files in order of ID number on the movie file list.
It is a list of movie files that have been registered in the Multimedia Function 
settings. You cannot change the order when you play files. For details, refer 
to Chapter 22 “Multimedia Function” on page 22-1.

Default ID: Pressing the play button specifies the ID number (1 to 64) of 
the movie file to be played.

Clicking  displays the Multimedia Settings dialog box. 
Select an ID number from the movie file list.
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■ Show and Play
Set Video Display's display setting and playback setting.

Play the specified movie: Plays movie files by the order of the ID number.

Selects files to be played from the movie file list and then creates a list of files 
to be played.
This can be set only when Play the specified movie is selected.

ID: Displays the movie file list ID.

File Path: Displays the file path of the movie file.

Add: Adds a movie file (1 to 8) to the list.
Clicking this button opens the movie file list. Specify files using 
the movie file list.

Delete: Deletes files from the list.
Select a file from the list and then click this button. Movie files 
deleted from the playlist will not be deleted from the movie file 
list.

Up: Shifts a selected file upward on this list.

Down: Shifts a selected file downward on this list.

Full Screen: The entire screen of MICRO/I is used as the display area of images and movie files.

Set Default to Full Screen: Select the check box to start with a display or playback on full 
screen when the Video Display is displayed.

Change by the value of Device Address: Select the check box and specify the bit number of a bit 
device or word device if you want to switch between display 
in full screen or not using the value of a device address.
Full screen is displayed when the value of a device address is 
changed from 0 to 1. Full screen ends when the value is 
changed from 1 to 0.

Full screen can be ended with a Key Button (Restore). When the full screen ends with the Key Button, the 
value of a device address set by the Change by the value of Device Address check box remains 1.

No Audio: Select this to play movie files without sound.

Repeat: Select this to repeat playback of a movie file.
This can only be set when Play a movie or recorded file from the File Screen, Play the Movie 
File List, or Play the specified movie is selected in Action.

Autoplay: Select this to automatically play movies when a Video Display is shown on the screen. When Display 
images from the Video Input is selected for Action, movie files are always automatically played.
However, while data is being recorded after an event occurs with the event recording function, while 
data is being recorded with a Key Button, Multi-Button, or Multi-Command configured with the 
recording function, or while data is being saved to the external memory device, movie files are not 
automatically played when the Video Display is shown on the screen.
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● View Tab

■ Browse
Select the type of graphic to be used to represent the part from the list of graphics. Click this button to display the 
View Browser.

■ Plate Color
Selects the plate (color: 256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

■ Flange

Plate color

Foreground Color, Background Color: Selects the foreground and background colors of the flange (color: 256 
colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

Pattern: Selects a pattern for the flange.
Click Pattern to display the Pattern Palette. Select a pattern from the Pattern 
Palette.

Flange
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■ Buttons

■ Coordinates

■ Size

Foreground Color, Background Color: Selects the foreground and background colors of the buttons (color: 256 
colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

Pattern: Selects a pattern or tonal gradation for the button.
Click Pattern to display the Pattern Palette. Select a pattern or tonal 
gradation from the Pattern Palette.

ButtonsButtons

Can be set only when there are grouped Key Buttons.

X, Y: Sets the display position of parts using coordinates.
The X and Y coordinates of parts is defined relative to an origin at the top-left corner of the screen.

X: 0 to (base screen horizontal size - 1)

Y: 0 to (base screen vertical size - 1)

(0, 0)
X

Y
Screen

Parts

W, H: Sets width and height to define the size of parts.

W: 20 to (base screen horizontal size)

H: 20 to (base screen vertical size)

Width

Height

Screen

Parts
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● Options Tab
The Options tab is displayed in Advanced mode.

■ Place on the Top Layer
Select this check box to display the parts on the top layer. The parts will have precedence when other drawings and 
parts are overlapping with it. For details, refer to Chapter 6 “4 Drawings and Parts Overlapping” on page 6-5.
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● Security Tab
This tab is used to restrict displaying and using the part by security groups.
This option can only be set when Use Security functions is selected. The Use Security functions check box is set 
on General tab in the Security dialog box.

■ (Settings)
Displays the list of security groups used on the MICRO/I.

■ Security Settings
The Security Settings dialog box is displayed. If you create a security group in the Security Settings dialog box, you 
can select that created group. For details, refer to Chapter 23 “2.2 Adding and Editing Security Groups” on page 23-
19.

(Settings)

No.: Displays the security group numbers (0 to 15).

Group Name: Displays the name of the security group.

Display: Displays whether or not there is permission to display the part. Only Permitted security groups 
can display this part. If all security groups are set to Permitted, this part will be displayed even 
if no user account has been selected. Double clicking the cell switches between Permitted and 
Prohibited.

Input: Displays whether or not there is permission to use the part. Only Permitted security groups 
can use this part. If all security groups are set to Permitted, this part can be used even if no 
user account has been selected. Double clicking the cell switches between Permitted and 
Prohibited.

• You can also switch between Permitted and Prohibited by right-clicking on a Display or Input cell.
• Restricting the display and use of the part by switching between Permitted and Prohibited in Display 

and Input cells is similar to using the Trigger Condition tab.

For details about security functions, refer to Chapter 23 “User Accounts and the Security Function” on page 
23-1.
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Example: If the user and security group for a part are set as follows:

For User1 in the Reader security group, the parts for which Display has been set to Prohibited for Reader will not 
be displayed.
If the password screen is opened and the user switches to User2 in the Operator security group, the parts for which 
Display has been set to Permitted for Operator will be displayed.

For User2 in Operator, Display has been set to Permitted for Operator, but Input is Prohibited, so the part 
cannot be used.
If the password screen is opened and the user switches to User3 in the Administrator security group, the parts for 
which Display has been set to Permitted for Administrator will be displayed, and the parts for which Input has 
been set to Permitted for Administrator can be used.

User Name

Security Group Reader Operator Administrator
User1 User2 User3

MICRO/I

130

Numerical Display
No. Group Name Display

1 Administrator Permitted

2 Operator Permitted

3 Reader Permitted

Button
No. Group Name Display Input

1 Administrator Permitted Permitted

2 Operator Permitted Prohibited

3 Reader Prohibited Prohibited

Line Chart and Bar Chart
No. Group Name Display

1 Administrator Permitted

2 Operator Permitted

3 Reader Prohibited

Open Password Screen, 
enter password, 
and switch to User2

For User1, 
parts for which Display 
has been set to Prohibited 
for Reader are not displayed

For User2, 
parts for which Display 
has been set to Permitted 
for Operator are displayed

MICRO/I

130

MICRO/I MICRO/I

130

User1 User2

130
CAN

User Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password

Open Password Screen, 
enter password, 
and switch to User3

For User2, 
parts for which Display 
has been set to Permitted 
for Operator are displayed, 
but parts for which Input 
has been set to Prohibited cannot be used

For User3, 
parts for which Display 
has been set to Permitted 
for Administrator are displayed, 
and parts for which Input 
has been set to Permitted can be used

MICRO/I

130

MICRO/I MICRO/I

130130 130

User2 User3

Button
Can operate

CAN

User Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password

Button
Cannot operate
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● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Used for entering comments about parts. Maximum number is 80 characters.
Example: When mousing over the Video Display on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.
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4.4 File Screen

With the File Screen, movie files can be selected from an SD memory card and then played on a Video Display.
When Play a movie or recorded file from the File Screen has been selected in Action for the Video Display, 
movie files can be selected with the File Screen and then played. Action is set in the General tab of the Video 
Display properties dialog box.

● File Screen Configuration

■ Title Bar

Displays the Title,  (Move) button, and  (Close) button.

■ (Drive)
Displays the selected drive. Displays as SD Card.

■ (Folder)
Displays the folder path of the currently selected folder.

■ Page No.
Displays the current page number.

■ Folder Up button
Moves to a folder that is 1 level higher in the hierarchy.

123000.avi

Modified Date: 2011/3/13 13:00:30

Page No.: 1

File Screen
DRIVE: SD Card
\HGDATA01\RECORD\20110313

Update Page Up Page Down Select

File Name Size
120000.avi
121500.avi
123000.avi
124500.avi
130000.avi

512,000,000
512,000,000
512,000,000
512,000,000
512,000,000

Folder Up

Close Bu�on
Move Bu�on

(Drive)

(Modified Date)

(File Name)

(Folder)

(File List)

Title Bar

 (Move) button: Moves the File Screen.

 (Close) button: Closes the File Screen.

• When the folder path exceeds 36 characters, up to 35 characters will be displayed.
• Once the File Screen is opened, the “RECORD” folder in the External Memory Device folder will be 

displayed. If the “RECORD” folder does not exist, the External Memory Device folder will be displayed.
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■ (File List)

■ (File Name)
Displays the file name of the selected file. The maximum number for the file name is 120 characters.

■ (Modified Date)
Displays the updated date and time.

■ Update
Updates to the newest file list state.

■ 
Moves the focus up by one level.

■ 
Moves the focus down by one level.

■ Page Up
Moves up by one page.

■ Page Down
Moves down by one page.

■ Select
Selects the file or folder that is in focus.
If a folder has been selected, this will open the folder and display its contents.

File Name: Displays a list of the files and folders in the currently selected folder.

Size: For files, this displays the file size (bytes).
For folders, this is displayed as Folder.

File names should be alphanumeric characters only.

Movie files that meet the following specifications can be played with the MICRO/I:

HG5G/4G/3G-V: AVI file (.avi)

HG4G/3G: MP4 file (.mp4)

For details, refer to Chapter 2 “1.6 Available Movie Files” on page 2-37.
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● Select a Movie File
Display the File Screen on the Base Screen and select a movie file from a Memory Card.

1 Press the Goto Screen Button or Multi-Button that has been set to Open File Screen or execute the Goto Screen 
Command or Multi-Command.
The File Screen will be displayed.

2 Select the movie file to be played.
Example: When selecting the movie file “123000.avi” in the “20110313” folder of the “RECORD” folder located in the 

External Memory Device folder “HGDATA01”:
1. Press  to select “HGDATA01” and then press Select. 

The contents of the “HGDATA01” folder will be displayed.

2. Press  to select “RECORD” and then press Select. 
The contents of the “RECORD” folder will be displayed.

Modified Date: 2011/3/13 13:00:30

Page No.: 1

File Screen
DRIVE: SD Card

Update Page Up Page Down Select

File name Size
FolderHGDATA00
FolderHGDATA01
FolderHGDATA02

0
0
0

Folder Up

1 2

Modified Date: 2011/3/13 13:00:30

Page No.: 1

File Screen
DRIVE: SD Card
\HGDATA01

Update Page Up Page Down Select

File name Size
FolderMOVIE
FolderNVDATA
FolderRECORD
FolderSOUND

3play.lst
ABC.mp4
DEF.mp4

300,000
7,654,321

0
0
0

Folder Up

1 2
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3. Press  to select “20110313” and then press Select. 
The contents of the “20110313” folder will be displayed.

4. Press  to select “123000.avi” and then press Select. 
The movie file will be selected and the File Screen will close. 
When you press a key button or a Multi-Button configured with the play key, or when you execute a Multi-
Command, the movie file plays.

Modified Date: 2011/3/13 13:00:30

Page No.: 1

File Screen
DRIVE: SD Card
\HGDATA01\RECORD

Update Page Up Page Down Select

File name Size
Folder20110312
Folder20110313
Folder20110314
Folder20110315

Folder Up

1 2

123000.avi

Modified Date: 2011/3/13 13:00:30

Page No.: 1

File Screen
DRIVE: SD Card
\HGDATA01\RECORD\20110313

File name Size
120000.avi
121500.avi
123000.avi
124500.avi
130000.avi

512,000,000
512,000,000
512,000,000
512,000,000
512,000,000

Folder Up

Update Page Up Page Down Select

1 2
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5.1 How the Message Display is Used

The Message Display is used to constantly display messages registered in advance and to display text read from 
values of word devices as character codes.
The Message Display can perform the following functions.

• Display messages

• Display text according to values of device addresses

5 Message Display

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

MICRO/I

Goal reached

External device
MICRO/I

Goal

Goal 1234K

Goal 5678K

D100 : 

D101 : 

0031(Hex)

3233(Hex)

D102 : 4B00(Hex)

D100 : 

D101 : 

3132(Hex)‘1’ ‘2’

3334(Hex)

D102 : 4B00(Hex)

D100 : 

D101 : 

3536(Hex)‘5’ ‘6’

3738(Hex)

D102 : 4B00(Hex)

‘4’‘3’

‘K’

‘7’

(NULL) ‘1’

‘3’‘2’

‘8’

(NULL)

‘K’ (NULL)

‘K’ (NULL)

Always show Show according to 

values of device addresses

Goal             \

Message details

Display

D100

D101

D102

Display only always shown text

Do not show if upper byte of the source device 

address starting address number is 00 (NULL)

Value of 
Source Device Address

Action

Display always shown text and text shown 

according to values of device addresses

Display always shown text and text shown 

according to values of device addresses

4B00(Hex)

3233(Hex)

0031(Hex)

4B00(Hex)

3334(Hex)

3132(Hex)

4B00(Hex)

3738(Hex)

3536(Hex)

‘3’ ‘4’

‘1’

‘7’ ‘8’

‘5’

‘2’ ‘3’

(NULL)

‘M’

‘6’‘2’ ‘1’

‘K’ (NULL) ‘K’ (NULL) ‘K’ (NULL)

GoalGoal     1234K Goal   5678K
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• Scroll messages

• Change the message and plate color according to a value of device address

MICRO/I

Line A

A : 1234K pcs.

pcs.        Line B

8K pcs.

Message details

Line A : 1234K pcs.            Line B : 5678K pcs.

External device
MICRO/I

HG SERIES

HG SERIES

D0：

D0：

D0：

D0：

Lower byteUpper byte

0 x 0 0

Lower byteUpper byte

0 x F 7

Lower byteUpper byte

0 x 9 00 x F 7

0 x 0 00 x F 7

Lower byteUpper byte

0 x 9 00 x F 7

Text colorPlate color

Text colorPlate color
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5.2 Message Display Configuration Procedure

This section describes the configuration procedure for Message Displays.

1 On the Home tab, in the Parts group, click Data Displays, and then click Message Display.

2 Click a point on the edit screen where you wish to place the Message Display.

3 Double-click the dropped Message Display and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.

The Trigger Condition tab and Options tab only appear in Advanced mode.
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5.3 Properties of Message Display Dialog Box

This section describes items and buttons on the properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ Use Text Manager
Select this check box to use text registered in Text Manager.

■ Text ID
Specifies the Text Manager ID number (1 to 32000) when using text registered in Text Manager.

Click  to display Text Manager.

This option can only be configured when the Use Text Manager check box is selected.

To read values of word devices as character codes with text registered in Text Manager and display it as 
text, enter “\@” (1 to 8) in Text for the Text ID at the position to display the value of device address as 
text. The channels configured under Data are allocated in order from the first “\@”. The text is displayed 
according to the values of device addresses in order from the first reference device address.
However, in the following situations “\@” is not handled as text to display according to values of device 
addresses and is displayed unchanged.
• When Font is Windows for Text ID configured in Text Manager
• When the number of “\@” configured in Text for Text ID is greater than the number of channels 

configured with device addresses
(Text for the character codes corresponding to the values of device addresses is only displayed for the 
number of channels in order from the beginning.)



5 Message Display

10-100 WindO/I-NV4 User’s Manual

■ Message
Enter the text to display. The maximum number is 610 characters. You can enter multi-line messages by inserting a 
newline. To configure text to display according to values of device addresses, enter “\@” (1 to 8) at the location to 
read the values of word devices as character codes and display them as text. The channels configured under Data 
are allocated in order from the first “\@”. The text is displayed according to the values of device addresses in order 
from the first reference device address.
Example: The device configured in Ch1 is allocated to the first “\@”. The device address configured in Ch2 is allocated 

to the second “\@”.

The characters that can be entered vary based on to the font selected for Font on the Format tab. For details, refer 
to Chapter 2 “1.2 Available Text” on page 2-6.
This option can only be configured if the Use Text Manager check box is cleared.

■ Data
These options are used to register or edit the device addresses with values to read as character codes.

Now     \

Goal     \

Always show Show according to values of device addresses

Ch1

Ch2

To display the backslash (\), enter a backslash (\) before the backslash (\).
Example:\\

(Settings): Lists the settings for the text to display according to values of device addresses.

No.: Shows the channel numbers (Ch1 to Ch8).

Device Address: Specifies the word device that stores the values read as character codes.
Double clicking the cell displays the Tag Editor. For the device address 
configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” 
on page 2-68.
Set the value of device address to the character codes for the language 
used. For details, refer to Chapter 2 “Character Code Table” on page 2-16.

Words: Specifies the number of words for the length of the text to display (1 to 64). 
Double clicking the cell allows you to change the Words.
Values of device addresses for the configured amount of words are read as 
character codes starting from the device address set by Device Address. 2 
single-byte characters can be displayed by 1 word.

Remove: Deletes the registered settings from the list.

Up: Shifts the selected settings upward in the list.

Down: Shifts the selected settings downward in the list.

You can register the settings from arbitrary numbers, they are aligned filled from the beginning after clicking 
OK on the dialog box. Therefore, when the Properties dialog box is closed and reopened, the list is 
displayed filled from the beginning.
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● View Tab

■ Image Type
Select the type of graphic to be used to represent the part.

■ Browse
Select the type of graphic to be used to represent the part from the list of graphics. Click this button to display the 
View Browser or Picture Manager, depending on the setting for Image Type.

■ Plate Color
Selects the plate color of the standard graphic (color: 256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

■ Flange

Standard: Uses the default graphic for WindO/I-NV4.

Picture: Uses an image file saved using Picture Manager.
For details about image file restrictions, refer to Chapter 2 “1.4 Available Image Files” on page 2-20.

None: The plate and the flange of the part are not displayed. Only the text is displayed.

Plate color

Foreground Color, Background Color: Selects the foreground and background colors of the flange of the standard 
graphic (color: 256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

Pattern: Selects a pattern for the flange of the standard graphic.
Click Pattern to display the Pattern Palette. Select a pattern from the Pattern 
Palette.

Flange
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■ Coordinates

■ Size

X, Y: Sets the display position of parts using coordinates.
The X and Y coordinates of parts is defined relative to an origin at the top-left corner of the screen.

X: 0 to (base screen horizontal size - 1)

Y: 0 to (base screen vertical size - 1)

(0, 0)
X

Y
Screen

Parts

W, H: Sets width and height to define the size of parts.

W: 5 to (base screen horizontal size)

H: 5 to (base screen vertical size)

Width

Height

Screen

Parts
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● Format Tab

■ Font
Selects the font used for displaying text from the following.
Japanese, European, Chinese, Taiwanese, Korean, Central European, Baltic, Cyrillic, Stroke
The characters that can be displayed depend on the font. For details, refer to Chapter 2 “1.2 Available Text” on page 
2-6.

■ Size
Sets the character size (8 to 128).
Can only be set when Stroke is selected.

■ Style
Selects Regular or Bold for text style.
Can only be set when Japanese, European, Chinese, Taiwanese, Korean, Central European, Baltic, or 
Cyrillic is selected for Font.

■ Magnification

Can only be set when Japanese, European, Chinese, Taiwanese, Korean, Central European, Baltic, or 
Cyrillic is selected for Font.

■ Align Text Horizontal
Selects the text alignment in the horizontal direction from the following.
Left, Center, Right, Center-Left, Left-Right
If Top, Center or Bottom is selected for Align Text Vertical, Center or Right can be set as this option.
If Center-Top is selected for Align Text Vertical, Center-Left or Left-Right can be set as this option.
For details, refer to Appendix “5 Text Alignment” on page A-7.

■ Align Text Vertical
Selects the text alignment in the vertical direction from the following.
Top, Center, Bottom, Center-Top
Set to Center when the Vertical Writing check box is selected.
For details, refer to Appendix “5 Text Alignment” on page A-7.

W, H: Selects text magnification (0.5, 1 to 8).
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■ Vertical Writing
Select this check box when displaying text vertically.
Can only be set when Font is set to Japanese, European, Chinese, Taiwanese, Korean, Central European, 
Baltic, or Cyrillic.

■ Align Text depending on the length of the displayed message*1

Select this check box to align text as standard to the number of characters that will be displayed.
This option is only displayed when the Align the text area (Character Input/Message Display/Numerical 
Input/Numerical Display) check box is selected in the Project Settings dialog box, on the Compatible tab.
When cleared, the maximum number of characters (set number of words) is always aligned as standard.

■ Text Color
Selects the color of displayed text (color: 256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

*1 Advanced mode only

When the Vertical Writing check box is selected, take care about the following points. This is applicable 
for Windows supports East Asian characters.
• When there is a mixture of double-byte and single-byte characters, the half-width characters are left-

aligned.

• Dashes are displayed horizontally. Symbols representing voiced and semi-voiced sounds of single-byte 
characters are shown as follows.

• When using text displayed according to values of device addresses, the characters are counted as single-
byte characters and the display area for the characters is indicated by dotted lines. Therefore, when the 
text to display according to values of device addresses is double-byte characters, the display area 
actually required differs from the area indicated by the dotted lines.
Example: When 1 word of text to display according to values of device addresses is set to vertical writ-

ing, the vertical size of the dotted lines is displayed as 2 single-byte characters.

Aligned to 
le� edge

Horizontal
display

Next
characters

2 single-byte chars. 1 double-byte char.

Dotted line frame is
2 chars. High

Example: When there are 2 characters of text to always display on the first line, 6 characters of text to always display 
on the second line and 6 characters of text (3 words) to display according to values of device addresses, 
Align Text Horizontal is set to Center, and the text to display according to values of device addresses is 
blank (when only 6 characters are always displayed on the second line)

Check box: ClearedCheck box: Selected

Always show Show according to
values of devices

EFCDAB EFCAB
AB

AB

D EFCAB
AB

D

Characters to show Maximum characters

1st line text :

2nd line text :

Blank
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■ Scroll*1

Select this check box to enable scrolling display displaying of messages.
This option can only be configured when the Flash check box is cleared and Standard is selected for Image Type 
on the View tab.

Speed (1: Fastest): Sets the scrolling speed (1 to 10). 1 is fastest, 10 is slowest.

Start scrolling after displaying message: Select this check box to start scrolling after a message is displayed for 2 
seconds.

This check box is cleared. This check box is selected.

After 2 seconds, 
start scrolling it.

Start scrolling 
a message.

Display a message 
and align left.Voltage abnormal

V

Vo oltage abnormal

Vol ltage abnormal

• When the Scroll check box is selected, the number of parts that can be arranged on a single screen 
decreases. If the MICRO/I displays an error message, clear the Scroll check box, or reduce the number 
of parts on the screen.

• When the scan time for the screen becomes longer, and when the part that has its Scroll check box 
selected is placed on the top layer, the scrolling speed may become slow.

When the Scroll check box is selected operation is follows.
• Messages that include CRs are displayed without the CRs.
• Messages scroll in the direction in which the text is drawn.
• When the text displayed according to values of device addresses, the text color, or the displayed text 

changes, the message is scrolled top the beginning.
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■ Change Display Colors
To switch the text and plate colors, select this check box and select the method to the display colors from the 
following.

*1 Advanced mode only

Specify Color: Switches the text and plate to the specified colors.

Trigger Device Address: Specifies the bit device or the bit number of the word device to use as the trigger to switch 
the text and plate colors.

Click  to display the Tag Editor. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-68.
When the value of device address is 0, the color specified in Text Color or in Plate Color 
on the View tab will be displayed.
When the value of device address is 1, the color displayed and specified in Text Color or 
Plate Color under the Specify Color.

Text Color: Selects the color (color: 256 colors, monochrome: 16 shades) of the text when switching.
Click this button to display the Color Palette. Select a color from the Color Palette.

Plate Color: Selects the plate color (color: 256 colors, monochrome: 16 shades) when switching.
Click this button to display the Color Palette. Select a color from the Color Palette.
This option can only be configured when Standard is selected for Image Type on the View 
tab.

MICRO/I

HG SERIES

HG SERIES

0

1

Trigger Device Address

Trigger Device Address

External device

Text Color

Plate Color on the View tab

Text Color under Specify Color

Plate Color under Specify Color
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Specify Color by Device Address: Specifies the text and plate colors by the value of the device 
address.

Device Address: Specify the word device that stores the color data for the text or plate.

Click  to display the Tag Editor. For the device address configuration 
procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-68.
This uses address number+1 to specify the text and plate colors when the 
Flash check box has been selected.
Color data assignments that are stored to device addresses are given below.

For color data, refer to Appendix “1 Color Number” on page A-1.

D0=

Lower byteUpper byte

0 x 0 0

Lower byteUpper byte

0 x F 7

D0=

Lower byteUpper byte

0 x 1 40 x 1 6

D0 0 x 0 00 x F 7

Lower byteUpper byte

D0 0 x 1 40 x 1 6

HG SERIES

HG SERIES

MICRO/IExternal device

Text colorPlate color

Text colorPlate color

Device Address

bit bit
15 8

bit
7

bit
0Upper byte

Plate color

Device Address
Text color

Plate color when flashingDevice Address+1 Text color when flashing

Lower byte

HG SERIES

HG SERIES

Flashing

Lower byteUpper byte

0 x 1 40 x 1 6

Lower byteUpper byte

0 x F 70 x 2 3

Text colorPlate color

Device Address

Device Address+1

Text color 
when flashing

Plate color
when flashing
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■ Flash
Select this check box to make the text and plate colors flash.
The flashing will occur as follows:
• The Change Display Colors check box is cleared, then the colors specified by Text Color and Plate Color on 

the View tab and the colors specified by Text Color and Plate Color under Flash are alternately displayed.

• The Change Display Colors check box is selected, Specify Color is selected and the value of the trigger device 
address for Specify Color is 0, then the colors specified by Text Color and Plate Color on the View tab and the 
colors specified by Text Color and Plate Color under Flash are alternately displayed.

• The Change Display Colors check box is selected, Specify Color is selected and the value of the trigger device 
address for Specify Color is 1, then the colors specified by Text Color and Plate Color under Specify Color 
and the colors specified by Text Color and Plate Color under Flash are alternately displayed.

Flashing

Trigger device address
under Flash

Trigger device address
under Flash

0

1

MICRO/IExternal device

HG SERIES

HG SERIES
HG SERIES

HG SERIES

Text Color

Plate Color on the View tab

Text Color

Plate Color on 
the View tab

Text Color under Flash

Plate Color under Flash

Flashing

Trigger device address
under Flash

Trigger device address
under Flash

MICRO/IExternal device

HG SERIES

HG SERIES
HG SERIES

HG SERIES

Text Color

Plate Color on the View tab

Text Color

Plate Color on 
the View tab

Text Color under Flash

Plate Color under Flash

Trigger device address under
Specify Color

Trigger device address under
Specify Color

0

0

1

0

Flashing
1

Trigger device address under
Specify Color

Trigger device address
under Flash

Trigger device address under
Specify Color

Trigger device address
under Flash

0

1

1

MICRO/IExternal device

HG SERIES

HG SERIES
HG SERIES

HG SERIES

Text Color under 
Specify Color
Plate Color under 
Specify Color

Text Color under Specify Color

Plate Color under Specify Color

Text Color under Flash

Plate Color under Flash
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• The Change Display Colors check box is selected, Specify Color by Device Address is selected, then the 
colors that correspond to the values stored in the device addresses for Specify Color by Device Address and 
this device address number+1 are alternately displayed.

Trigger Device Address: Specifies the bit device or the bit number of the word device that will be used to trigger 
flash.

Click  to display the Tag Editor. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-68.
Flash intervals are set in the Flashing Cycle on the System tab in the Project Settings 
dialog box.

Text Color: Selects the color (color: 256 colors, monochrome: 16 shades) of text when flashing.
Click this button to display the Color Palette. Select a color from the Color Palette.
This option can only be configured when the Change Display Colors check box is cleared 
or selected and Specify Color is selected.

Plate Color: Selects the plate color (color: 256 colors, monochrome: 16 shades) when flashing.
Click this button to display the Color Palette. Select a color from the Color Palette.
This option can only be configured when the Change Display Colors check box is cleared, 
or the check box and Specify Color are selected, and Standard is selected for Image 
Type on the View tab.

HG SERIES

HG SERIES

Flashing

MICRO/IExternal device

HG SERIES

HG SERIES

Lower byteUpper byte

D0 0 x 1 40 x 1 6

Lower byteUpper byte

D1 0 x F 70 x 2 3

Text colorPlate color

Text color 
when flashing

Plate color
when flashing

0

1

D0=

Lower byteUpper byte

0 x 1 40 x 1 6

D1= 0 x F 70 x 2 3

Trigger device

Device Address for
Specify Color by Device Address

Trigger device address
under Flash

Trigger device address
under Flash

Device Address+1
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● Trigger Condition Tab
The Trigger Condition tab is displayed in Advanced mode.

The Message Display is enabled while the condition is satisfied, and it is disabled while the condition is not satisfied. 
Select the operation when disabled as Not display message or Not show Message Display under While not 
satisfying the condition.

■ Trigger Type
Selects the condition to enable the Message Display from the following.

Example: When Trigger Type is While ON, Device Address is LM0, and While not satisfying the condition is 
Not display message.
While LM0 is 0, the condition is not satisfied and the Message Display does not display the message.
While LM0 is 1, the condition is satisfied and the Message Display displays the message.

LM0:

MICRO/I

0

LM0: 1
HG SERIES

Condition 
Not 

satisfied

Condition 
Satisfied

Show 

Hide

Always visible: The Message Display is always enabled.

Message Display 
state

Always show message

HG SERIES
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Selects the data type to be handled by the condition formula.
Can only be set if While satisfying the condition is selected as Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

■ Device Address
Specifies the bit device or the bit number of the word device to serve as condition.
Can only be set if While ON or While OFF is selected as Trigger Type.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.

■ Condition
Sets the condition formula.
Can only be set if While satisfying the condition is selected as Trigger Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expression configuration 
procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-71.

■ Comment
Used for entering comments about trigger conditions. Maximum number is 80 characters.

■ While not satisfying the condition
Selects the operation of the part when the condition is not satisfied.

While ON: Enables the Message Display when the value of device address is 1.
Example: When While not satisfying the condition is Not display message.

While OFF: Enables the Message Display when the value of device address is 0.
Example: When While not satisfying the condition is Not display message.

While satisfying the condition:
Enables the Message Display when the condition is satisfied.
Example: When While not satisfying the condition is Not display message.

1

0

Show 
message

Hide 
message

Hide 
message

Hide 
message

HG SERIES

Show 
message

HG SERIES

Show 
message

HG SERIES

Show 
message

HG SERIES

Value of
Device Address

Message Display 

state

Value of
Device Address

1

0

Show 
message

Hide 
message

HG SERIES

Show 
message

HG SERIES

Show 
message

HG SERIES

Hide 
message

Hide 
message

Hide 
message

Message 

Switching Display 

state

Show 
message

Hide 
message

Hide 
message

Hide 
message

HG SERIES

Show 
message

HG SERIES

Show 
message

HG SERIES

Show 
message

HG SERIES

Message Display 
state

Satisfied

Not satisfied

Condition

Not display message: The plate and flange are displayed, but the message is not displayed.

Not show Message Display: Hides the Message Display.
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● Options Tab
The Options tab is displayed in Advanced mode.

■ Place on the Top Layer
Select this check box to display the parts on the top layer. The parts will have precedence when other drawings and 
parts are overlapping with it. For details, refer to Chapter 6 “4 Drawings and Parts Overlapping” on page 6-5.
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● Security Tab
This tab is used to restrict displaying and using the part by security groups.
This option can only be set when Use Security functions is selected. The Use Security functions check box is set 
on General tab in the Security dialog box.

■ (Settings)
Displays the list of security groups used on the MICRO/I.

■ Security Settings
The Security Settings dialog box is displayed. If you create a security group in the Security Settings dialog box, you 
can select that created group. For details, refer to Chapter 23 “2.2 Adding and Editing Security Groups” on page 23-
19.

(Settings)

No.: Displays the security group numbers (0 to 15).

Group Name: Displays the name of the security group.

Display: Displays whether or not there is permission to display the part. Only Permitted security groups 
can display this part. If all security groups are set to Permitted, this part will be displayed even 
if no user account has been selected. Double clicking the cell switches between Permitted and 
Prohibited.

You can also switch between Permitted and Prohibited by right-clicking on a Display cell.

For details about security functions, refer to Chapter 23 “User Accounts and the Security Function” on page 
23-1.
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Example: If the user and security group for a part are set as follows:

For User1 in the Reader security group, the parts for which Display has been set to Prohibited for Reader will not 
be displayed.
If the password screen is opened and the user switches to User2 in the Operator security group, the parts for which 
Display has been set to Permitted for Operator will be displayed.

User Name

Security Group Reader Operator
User1 User2

MICRO/I

130

Numerical Display
No. Group Name Display

1 Administrator Permitted

2 Operator Permitted

3 Reader Permitted

Button
No. Group Name Display Input

1 Administrator Permitted Permitted

2 Operator Permitted Prohibited

3 Reader Prohibited Prohibited

Line Chart and Bar Chart
No. Group Name Display

1 Administrator Permitted

2 Operator Permitted

3 Reader Prohibited

Open Password Screen, 
enter password, 
and switch to User2

For User1, 
parts for which Display 
has been set to Prohibited 
for Reader are not displayed

For User2, 
parts for which Display 
has been set to Permitted 
for Operator are displayed

MICRO/I

130

MICRO/I MICRO/I

130

User1 User2

130
CAN

User Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password



WindO/I-NV4 User’s Manual 10-115

5 Message Display

10

D
ata D

isplays

● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Used for entering comments about parts. Maximum number is 80 characters.
Example: When mousing over the Message Display on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.
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5.4 String Data Storage Method

The values of device addresses read as character codes are stored in the upper byte and lower byte of words 
according to the Storage Method of String Data setting. Storage Method of String Data is configured on the 
System tab in the Project Settings dialog box.
For details, refer to Chapter 4 “3.1 System Tab” on page 4-25.

Example: When reference device address D100 = 3132 (Hex), D101 = 3334 (Hex), D102 = 3500 (Hex)

• When from Upper byte is selected for Storage Method of String Data

• When from Lower byte is selected for Storage Method of String Data

NULL terminating character

Device address
Stored value

Displayed string
Upper byte Lower byte

D100 31 (Hex) 32 (Hex) 12
D101 33 (Hex) 34 (Hex) 34
D102 35 (Hex) 0 5

NULL terminating character

Device address
Stored value

Displayed string
Upper byte Lower byte

D100 32 (Hex) 31 (Hex) 21
D101 34 (Hex) 33 (Hex) 43
D102 0 35 (Hex)

When handling values of device addresses as character 

codes, 0 is handled as the NULL terminating character 

to end the string. Therefore, when the upper byte is 0, 

nothing is displayed.

• When handling values of device addresses as character codes, 0 is handled as the NULL terminating 
character to end the string. Therefore, when the upper byte is 0, nothing is displayed.

• To display only a single character, set the lower byte to 0.
Example: To display a single-byte 7

              3700(Hex)‘7’
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6.1 How the Message Switching Display is Used

The Message Switching Display is used to switch the displayed message according to the value of a word device.

6 Message Switching Display

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

MICRO/I
External device

D0= 0001

bit0bit3

D0= 0010

bit0bit3

D0= 0100

bit0bit3

D0

bit15 bit0bit3

Msg0 Drying

Heating

Cooling

Msg1

Msg2

Message details
Drying

Heating

Cooling
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6.2 Message Switching Display Configuration Procedure

This section describes the configuration procedure for Message Switching Displays.

1 On the Home tab, in the Parts group, click Data Displays, and then click Message Switching Display.

2 Click a point on the edit screen where you wish to place the Message Switching Display.

3 Double-click the dropped Message Switching Display and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.

The Trigger Condition tab and Options tab only appear in Advanced mode.
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6.3 Properties of Message Switching Display Dialog Box

This section describes items and buttons on the properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ Switching Method
Selects the method for switching message to display from the following. Messages are registered in Settings on the 
Message tab.

Bit Number: Switches the message to display according to the status of bits in a device address.
Example: When Bit Number is selected and the bits of trigger device address D0 are allocated to the 

following messages.

Switches the message to display according to the status of the bits.

bit15 bit0bit3

Trigger device address D0 

Msg0 Drying

Heating

Cooling

Msg1

Msg2

Message

0001

Message to display

0010 0100 1000

Display Msg0Action Display Msg1 Display Msg2

1110

Display Msg1No message

Msg0 Msg1 Msg2 Msg1

Bit state of 
Trigger Device Address D0

Drying Heating Cooling Heating

If all bits in the device address are 0 or if a 
bit with no associated message becomes 1, 
display nothing.

If multiple bits are 1, display the 
message for the lowest order bit.



6 Message Switching Display

10-120 WindO/I-NV4 User’s Manual

■ Trigger Device Address
Specifies the word device to use as the condition for switching messages.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.

Value: Switches the message to display according to the value of a device address.
Example: When Value is selected and the trigger device addresses D0 are allocated to the following 

messages.

Switches the message to display according to the value of the device address.

0 :

1 :

2 :

Value of Trigger Device Address D0 Msg0 Drying

Heating

Cooling

Msg1

Msg2

Message details

0

Message to display

1 2 3

Display Msg0Action Display Msg1 Display Msg2 No message

Msg0 Msg1 Msg2

Value of 
Trigger Device Address D0

Drying Heating Cooling

If the value of device address has no message
associated with it, display nothing.
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● Message Tab

■ Use Text Manager
Select this check box to use text registered in Text Manager.

■ Settings
Edits the message settings.

No.: Shows the message number (Msg number).
The number of messages that can be registered varies based on Switching Method on the 
General tab.

Bit Number: Msg0 to Msg15

Value: Msg0 to Msg999

Message: Enter the text to display.
Double clicking the cell allows to edit the Message. The maximum number is 3750 characters. You 
can enter multi-line messages by inserting a newline.
The characters that can be entered vary based on the font selected for Font on the Format tab. For 
details, refer to Chapter 2 “1.2 Available Text” on page 2-6.
This option can only be configured if the Use Text Manager check box is cleared.

• To display the backslash (\), enter a backslash (\) before the backslash (\).
• A line feed is added with pressing and holding ALT and ENTER keys.

Change: Selects whether or not to configure Text and Plate per Msg number. For N, the colors are 
configured by Text Color on the Format tab and Plate Color on the View tab.
Double clicking the cell toggles between Y as Yes and N as No.

Text: Selects the text color for the messages when configuring the text color per Msg number (color: 256 
colors, monochrome: 16 shades).
Double clicking the cell displays the Color Palette where you can change the Text Color.

Plate: Selects the plate color for the messages when configuring the plate color per Msg number
(color: 256 colors, monochrome: 16 shades).
Double clicking the cell displays the Color Palette where you can change the Plate Color.
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■ Remove
Deletes the registered settings from the list.

■ Up
Shifts the selected settings upward in the list.

■ Down
Shifts the selected settings downward in the list.
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● View Tab

■ Image Type
Select the type of graphic to be used to represent the part.

■ Browse
Select the type of graphic to be used to represent the part from the list of graphics. Click this button to display the 
View Browser or Picture Manager, depending on the setting for Image Type.

■ Plate Color
Selects the plate color of the standard graphic (color: 256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

■ Flange

Standard: Uses the default graphic for WindO/I-NV4.

Picture: Uses an image file saved using Picture Manager.
For details about image file restrictions, refer to Chapter 2 “1.4 Available Image Files” on page 2-20.

None: The plate and the flange of the part are not displayed. Only the text is displayed.

Plate color

Foreground Color, Background Color: Selects the foreground and background colors of the flange of the standard 
graphic (color: 256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

Pattern: Selects a pattern for the flange of the standard graphic.
Click Pattern to display the Pattern Palette. Select a pattern from the Pattern 
Palette.

Flange
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■ Coordinates

■ Size

X, Y: Sets the display position of parts using coordinates.
The X and Y coordinates of parts is defined relative to an origin at the top-left corner of the screen.

X: 0 to (base screen horizontal size - 1)

Y: 0 to (base screen vertical size - 1)

(0, 0)
X

Y
Screen

Parts

W, H: Sets width and height to define the size of parts.

W: 5 to (base screen horizontal size)

H: 5 to (base screen vertical size)

Width

Height

Screen

Parts
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● Format Tab

■ Font
Selects the font used for displaying text from the following.
Japanese, European, Chinese, Taiwanese, Korean, Central European, Baltic, Cyrillic, Stroke
The characters that can be displayed depend on the font. For details, refer to Chapter 2 “1.2 Available Text” on page 
2-6.

■ Size
Sets the character size (8 to 128).
Can only be set when Stroke is selected.

■ Style
Selects Regular or Bold for text style.
Can only be set when Japanese, European, Chinese, Taiwanese, Korean, Central European, Baltic, or 
Cyrillic is selected for Font.

■ Magnification

Can only be set when Japanese, European, Chinese, Taiwanese, Korean, Central European, Baltic, or 
Cyrillic is selected for Font.

■ Align Text Horizontal
Selects the text alignment in the horizontal direction from the following.
Left, Center, Right, Center-Left, Left-Right
If Top, Center or Bottom is selected for Align Text Vertical, Center or Right can be set as this option.
If Center-Top is selected for Align Text Vertical, Center-Left or Left-Right can be set as this option.
For details, refer to Appendix “5 Text Alignment” on page A-7.

■ Align Text Vertical
Selects the text alignment in the vertical direction from the following.
Top, Center, Bottom, Center-Top
Set to Center when the Vertical Writing check box is selected.
For details, refer to Appendix “5 Text Alignment” on page A-7.

W, H: Selects text magnification (0.5, 1 to 8).
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■ Vertical Writing
Select this check box when displaying text vertically.
Can only be set when Font is set to Japanese, European, Chinese, Taiwanese, Korean, Central European, 
Baltic, or Cyrillic.

■ Text Color
Selects the color of displayed text (color: 256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

■ Scroll*1

Select this check box to enable scrolling display displaying of messages.
This option can only be configured when Standard is selected for Image Type on the View tab and the Flash 
check box is cleared.

*1 Advanced mode only

When the Vertical Writing check box is selected, take care about the following points. This is applicable 
for Windows supports East Asian characters.
• When there is a mixture of double-byte and single-byte characters, the half-width characters are left-

aligned.

• Dashes are displayed horizontally. Symbols representing voiced and semi-voiced sounds of single-byte 
characters are shown as follows.

Aligned to 
le� edge

Horizontal
display

Next
characters

Speed (1: Fastest): Sets the scrolling speed (1 to 10). 1 is fastest, 10 is slowest.

Start scrolling after displaying message: Select this check box to start scrolling after a message is displayed for 2 
seconds.

This check box is cleared. This check box is selected.

After 2 seconds, 
start scrolling it.

Start scrolling 
a message.

Display a message 
and align left.Voltage abnormal

V

Vo oltage abnormal

Vol ltage abnormal

• When the Scroll check box is selected, the number of parts that can be arranged on a single screen 
decreases. If the MICRO/I displays an error message, clear the Scroll check box, or reduce the number 
of parts on the screen.

• When the scan time for the screen becomes longer, and when the part that has its Scroll check box 
selected is placed on the top layer, the scrolling speed may become slow.

When the Scroll check box is selected operation is follows.
• Messages that include CRs are displayed without the CRs.
• Messages scroll in the direction in which the text is drawn.
• When the message is switched, the message is scrolled from the beginning.
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■ Change Display Colors
Select this check box to switch the text and plate colors.

Trigger Device Address: Specifies the bit device or the bit number of the word device to use as the trigger to switch 
the text and plate colors.

Click  to display the Tag Editor. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-68.
When the value of device address is 0, the color specified in Text Color or in Plate Color 
on the View tab will be displayed.
When the value of device address is 1, the color displayed and specified in Text Color or 
Plate Color
under the Change Display Colors.

Text Color: Selects the color (color: 256 colors, monochrome: 16 shades) of the text when switching.
Click this button to display the Color Palette. Select a color from the Color Palette.

Plate Color: Selects the plate color (color: 256 colors, monochrome: 16 shades) when switching.
Click this button to display the Color Palette. Select a color from the Color Palette.
This option can only be configured when Standard is selected for Image Type on the View 
tab.

MICRO/I

0

1

Trigger Device Address

Trigger Device Address

External device

HG SERIES

HG SERIES

Text Color

Plate Color on the View tab

Text Color under Change Display Colors

Plate Color under Change Display Colors
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■ Flash
Select this check box to make the text and plate colors flash.
The flashing will occur as follows:
• The Change Display Colors check box is cleared, then the colors specified by Text Color and Plate Color on 

the View tab and the colors specified by Text Color and Plate Color under Flash are alternately displayed.

• The Change Display Colors check box is selected and the value of the trigger device address for Change 
Display Colors is 0, then the colors specified by Text Color and Plate Color on the View tab and the colors 
specified by Text Color and Plate Color under Flash are alternately displayed.

• The Change Display Colors check box is selected and the value of the trigger device address for Change 
Display Colors is 1, then the colors specified by Text Color and Plate Color under Change Display Colors 
and the colors specified by Text Color and Plate Color under Flash are alternately displayed.

Flashing

Trigger device address
under Flash

Trigger device address
under Flash

0

1

MICRO/IExternal device

HG SERIES

HG SERIES
HG SERIES

HG SERIES

Text Color

Plate Color on the View tab

Text Color

Plate Color on 
the View tab

Text Color under Flash

Plate Color under Flash

Flashing

Trigger device address
under Flash

Trigger device address
under Flash

MICRO/IExternal device

HG SERIES

HG SERIES
HG SERIES

HG SERIES

Text Color

Plate Color on the View tab

Text Color

Plate Color on 
the View tab

Text Color under Flash

Plate Color under Flash

Trigger device address under
Change Display Colors

Trigger device address under
Change Display Colors

0

0

1

0

Flashing
1

Trigger device address under
Change Display Colors

Trigger device address
under Flash

Trigger device address under
Change Display Colors

Trigger device address
under Flash

0

1

1

MICRO/IExternal device

HG SERIES

HG SERIES
HG SERIES

HG SERIES

Text Color under 
Change Display Colors
Plate Color under 
Change Display Colors

Text Color under Change Display Colors

Plate Color under Change Display Colors

Text Color under Flash

Plate Color under Flash
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Trigger Device Address: Specifies the bit device or the bit number of the word device that will be used to trigger 
flash.

Click  to display the Tag Editor. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-68.
Flash intervals are set in the Flashing Cycle on the System tab in the Project Settings 
dialog box.

Text Color: Selects the color (color: 256 colors, monochrome: 16 shades) of text when flashing.
Click this button to display the Color Palette. Select a color from the Color Palette.

Plate Color: Selects the plate color (color: 256 colors, monochrome: 16 shades) when flashing.
Click this button to display the Color Palette. Select a color from the Color Palette.
This option can only be configured when Standard is selected for Image Type on the View 
tab.
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● Trigger Condition Tab
The Trigger Condition tab is displayed in Advanced mode.

■ Visible Condition
The Message Switching Display is displayed while the condition is satisfied. The Message Switching Display is hidden 
while the condition is not satisfied.

Example: When Trigger Type is While ON and Device Address is LM0
While LM0 is 0, the condition is not satisfied and the Message Switching Display is hidden.
While LM0 is 1, the condition is satisfied and the Message Switching Display is displayed.

LM0:

MICRO/I

0

LM0: 1
HG SERIES

Condition 
Not 

satisfied

Condition 
Satisfied

Show 

Hide
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Trigger Type: Selects the condition to display the Message Switching Display from the following.

Always visible: The Message Switching Display is always displayed.

While ON: Displays the Message Switching Display when the value of device address is 1.

While OFF: Displays the Message Switching Display when the value of device address is 0.

While satisfying the condition:

Displays the Message Switching Display when the condition is satisfied.

Data Type: Selects the type of data handled by the conditional expression for the visible condition.
This option can only be configured if While satisfying the condition is selected for Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Device Address: Specifies the bit device or the bit number of the word device to serve as the visible condition.
This option can only be configured when While ON or While OFF is selected for Trigger Type.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 
“5.1 Device Address Settings” on page 2-68.

Condition: Specifies the conditional expression for the visible condition.
This option can only be configured when While satisfying the condition is selected for Trigger 
Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expression 
configuration procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-71.

Comment: Used for entering a comment for the visible condition. The maximum number is 80 characters.

Always show

Message 
Switching Display

state

HG SERIES

HG SERIES HG SERIES HG SERIES

1

0

Hide Show Hide HideShow Show

Value of
Device Address

Message 
Switching 

Display state

HG SERIES HG SERIES HG SERIES

Value of 
Device Address

1

0

Show Show ShowHide Hide Hide

Message 
Switching 

Display state

HG SERIES HG SERIES HG SERIES

Hide Hide HideShow Show Show

Satisfied

Not satisfied

Condition

Message 
Switching Display 

state
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● Options Tab
The Options tab is displayed in Advanced mode.

■ Place on the Top Layer
Select this check box to display the parts on the top layer. The parts will have precedence when other drawings and 
parts are overlapping with it. For details, refer to Chapter 6 “4 Drawings and Parts Overlapping” on page 6-5.
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● Security Tab
This tab is used to restrict displaying and using the part by security groups.
This option can only be set when Use Security functions is selected. The Use Security functions check box is set 
on General tab in the Security dialog box.

■ (Settings)
Displays the list of security groups used on the MICRO/I.

■ Security Settings
The Security Settings dialog box is displayed. If you create a security group in the Security Settings dialog box, you 
can select that created group. For details, refer to Chapter 23 “2.2 Adding and Editing Security Groups” on page 23-
19.

(Settings)

No.: Displays the security group numbers (0 to 15).

Group Name: Displays the name of the security group.

Display: Displays whether or not there is permission to display the part. Only Permitted security groups 
can display this part. If all security groups are set to Permitted, this part will be displayed even 
if no user account has been selected. Double clicking the cell switches between Permitted and 
Prohibited.

You can also switch between Permitted and Prohibited by right-clicking on a Display cell.

For details about security functions, refer to Chapter 23 “User Accounts and the Security Function” on page 
23-1.
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Example: If the user and security group for a part are set as follows:

For User1 in the Reader security group, the parts for which Display has been set to Prohibited for Reader will not 
be displayed.
If the password screen is opened and the user switches to User2 in the Operator security group, the parts for which 
Display has been set to Permitted for Operator will be displayed.

User Name

Security Group Reader Operator
User1 User2

MICRO/I

130

Numerical Display
No. Group Name Display

1 Administrator Permitted

2 Operator Permitted

3 Reader Permitted

Button
No. Group Name Display Input

1 Administrator Permitted Permitted

2 Operator Permitted Prohibited

3 Reader Prohibited Prohibited

Line Chart and Bar Chart
No. Group Name Display

1 Administrator Permitted

2 Operator Permitted

3 Reader Prohibited

Open Password Screen, 
enter password, 
and switch to User2

For User1, 
parts for which Display 
has been set to Prohibited 
for Reader are not displayed

For User2, 
parts for which Display 
has been set to Permitted 
for Operator are displayed

MICRO/I

130

MICRO/I MICRO/I

130

User1 User2

130
CAN

User Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password
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● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Used for entering comments about parts. Maximum number is 80 characters.
Example: When mousing over the Message Switching Display on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.
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7.1 How the Alarm List Display is Used

The Alarm List Display works with the Alarm Log function to display messages for active alarms and to display 
multiple messages according to values of device addresses in a list.

• List currently active alarms out of the alarms configured in the Alarm Log settings

• Display multiple messages according to values of device addresses

7 Alarm List Display

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

• Only one Alarm List Display or Alarm Log Display can be configured on a single screen.
• When the active alarm is displayed on the Alarm List Display, the message disappears from the list when 

the alarm is recovered from regardless of the Lock/Unlock setting. To display the alarm message until it 
can be checked, use the Alarm Log Display. Lock/Unlock is configured on the Channel tab in the 
Alarm Log Settings dialog box.

• For the key buttons used with the Alarm List Display, refer to Chapter 8 “Alarm List Display” on page 8-96.
• The number of the message (channel when using the Alarm function) that has focus on the Alarm List 

Display is stored in HMI Special Data Register LSD50.
• The information about where on the list the message that has focus is displayed, out of all the messages 

displayed on the Alarm List Display, is stored in HMI Special Data Register LSD56.

MICRO/I
External device

Current fault Pg. Up

Pg. Dwn

Pump fault
Low air pressure

Pg. Up

Pg. Dwn

D0-0 : 
D0-1 : 
D0-2 : 
D0-3 : 

ID1 Current fault
ID2

ID3

ID4

Pump fault

High pressure

Low air pressure

Message

D0-0
Alarm occurred

0 1

D0-0

D0-1
Alarm occurred

0 1

D0-1

D0-3
Alarm occurred

0 1

D0-3

MICRO/I
External device

Setting 1 : 100 Pg. Up

Pg. Dwn

Setting 1 : 100
Setting 2 : 200
Setting 3 : 300

Pg. Up

Pg. Dwn

D0= 0001

bit0bit3

D0= 0111

bit0bit3

D0

bit15 bit0bit3

ID1 Setting 1 : 100
ID2

ID3

Setting 2 : 200

Setting 3 : 300

Message
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7.2 Alarm List Display Configuration Procedure

This section describes the configuration procedure for Alarm List Displays.

1 On the Home tab, in the Parts group, click Data Displays, and then click Alarm List Display.

2 Click a point on the edit screen where you wish to place the Alarm List Display.

3 Double-click the dropped Alarm List Display and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.

The Options tab only appears in Advanced mode.
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7.3 Properties of Alarm List Display Dialog Box

This section describes items and buttons on the properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ Message Settings
Selects the method for switching message to display.

The active alarm messages are displayed.

Use Alarm Log Settings: Displays messages for the active alarms. The alarms are configured by the Alarm Log 
settings.

Alarm Log Settings: Displays the Alarm Log Settings dialog box.

New Message List: Displays the messages registered in Text Manager according to the state of bits in the 
trigger device address configured on the List tab.

Example: When Use Alarm Log Settings is selected, the source device address (device address to monitor) 
configured by the Alarm Log function is D0, and the following messages are allocated to the channels

D0-0 : 

D0-1 :  

D0-2 :  

D0-3 :  

ID1 Current fault

ID2

ID3

ID4

Pump fault

High pressure

Low air pressure

Message

Source device address

Message to display

Bit state of Source device address

D0-0

Display ID1Action Display ID2, ID3

1 0 1 1 0

D0-1 0 1 0 1 0

D0-2 0 1 1 1 0

D0-3 0 0 1 1 0

No message
Display ID1, ID2, 

ID3, ID4
Display ID1, ID3, 

ID4

Current fault Pg. Up

Pg. Dwn

Pg. Up

Pg. Dwn

Pump fault
High pressure

Pg. Up

Pg. Dwn

Current fault
High pressure
Low air pressure

Pg. Up

Pg. Dwn

Current fault
Pump fault
High pressure
Low air pressure

Pg. Up

Pg. Dwn

If all bits in the device address are 0 or if a bit with no 
associated message becomes 1, display nothing.
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The messages are displayed according to the state of the bits.

■ Display Type
Selects whether or not to simultaneously display multiple messages.

■ Monitor Number of Displayed messages
Select this check box to count the number of displayed messages.
This option can only be configured when the New Message List check box is selected.

Example: When New Message List is selected and the bits of trigger device address D0 are allocated to the 
following messages.

Trigger device address D0 

bit15 bit0bit3

ID1 Setting 1 : 100
ID2

ID3

Setting 2 : 200

Setting 3 : 300

Message

0001

Message to display

0110 0101 0111 0000

Display ID1 Display ID2, ID3 Display ID1, ID3 No messageAction
Display ID1, ID2, 

ID3

Bit state of Trigger device address D0

Setting 1 : 100 Pg. Up

Pg. Dwn

Pg. Up

Pg. Dwn

Setting 2 : 200
Setting 3 : 300

Pg. Up

Pg. Dwn

Setting 1 : 100
Setting 3 : 300

Pg. Up

Pg. Dwn

Setting 1 : 100
Setting 2 : 200
Setting 3 : 300

Pg. Up

Pg. Dwn

If all bits in the device address are 0 or if a bit with no 
associated message becomes 1, display nothing.

List: Simultaneously displays multiple messages.

Sort: Selects the display order when displaying multiple messages.
Old and New can only be configured when the Use Alarm Log Settings check box is 
selected.

Ascending: Sorts the list in alphabetic order from A to Z.

Descending: Sorts the list in alphabetic order from Z to A.

Old: Sorts the list in order from oldest to newest.

New: Sorts the list in order from newest to oldest.

One Line: Displays only a single message.
When multiple bits are 1, the message for the lowest order bit is displayed.

Message to display

0111

Action
Display ID1, ID2, 

ID3

Bit state of Trigger device address D0

Setting 1 : 100
Setting 2 : 200
Setting 3 : 300

Pg. Up

Pg. Dwn

0111

Message to display

Display ID1Action

Setting 1 : 100 Pg. Up

Pg. Dwn

Bit state of Trigger device address D0

(Destination Device Address): Specifies the word device to write the number of displayed messages to.

Click  to display the Tag Editor. For the device address configuration procedure, 
refer to Chapter 2 “5.1 Device Address Settings” on page 2-68.
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● List Tab
The List tab is only displayed when New Message List is selected for Message Settings on the General tab.

■ Number of Blocks
Configures the device addresses that trigger messages to display and message switching as blocks (1 to 64).

■ Start Text ID
Specifies the Text Manager ID number (1 to 32000) of the message to display. The text ID numbers are sequentially 

configured for all channels from the first block starting with the ID number configured here. Click  to display Text 
Manager.

■ Device Address Setting Method
Selects the trigger device address setting method.

■ (Block settings)
Registers and edits the messages to display for each block channel.

(Block settings)

1 block is composed of 16 channels. 1 device address bit can be monitored for each channel. The maximum 
number of device address bits that can be monitored is 16 for each block.

Serial: The trigger device addresses after the block number selected in the block settings are configured 
with sequential addresses.

Random: Configures trigger device addresses for each block number.

Block No.: Shows the block numbers in the amount specified by Number of Blocks.
Double clicking the cell displays the Individual Settings dialog box. For details, refer to 
“Individual Settings Dialog Box” on page 10-141.

Trigger Device Address: Shows the word device to use as the condition to display messages.
Double clicking the cell displays the Tag Editor. For the device address configuration 
procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-68.
When Serial is selected for Device Address Setting Method, the trigger device 
addresses for block numbers after the selected block number are automatically configured 
with the configured trigger device address as the starting address.

No. of Reg. Text: Shows the number of messages registered to the block.
Double clicking the cell displays the Individual Settings dialog box. For details, refer to 
“Individual Settings Dialog Box” on page 10-141.

Edit: Changes the block settings in list.
Select a block number in the list and click this button to display the Individual Settings 
dialog box. For details, refer to “Individual Settings Dialog Box” on page 10-141.
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Individual Settings Dialog Box

The Individual Settings dialog box is used to configure the conditions to display the messages.

■ Trigger Device Address
Specifies the word device to use as the condition to display messages. The word device bits correspond to the 
message numbers.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.
When Serial is selected for Device Address Setting Method on the List tab, the trigger device addresses for block 
numbers after the block number being registered or edited are automatically changed with the configured trigger 
device address as the starting address.

■ (Settings)

Insert: Inserts the block settings in the position selected on the list.
Select the block number at the position to insert the settings in the list and click this button 
to display the Individual Settings dialog box. For details, refer to “Individual Settings 
Dialog Box” on page 10-141.
The settings at the insertion point shift down one line. Settings cannot be inserted if all 
block numbers are configured.

Delete: Deletes the registered settings from the list.
Select a block number on the list and click this button to delete the selected settings from the list.

(Settings)

Example: When the number of blocks is 1 and D0 is specified as the trigger device address
Message number 1-0 device address bit is D0-0, message number 1-1 device address bit is D0-1, up to 
message number 1-15 device address bit which is D0-15.

D0-0
D0-1
D0-2

D0-14
D0-15

1-0
1-1
1-2

1-14
1-15

Block 1
16 channels

Msg. No. Device bit

Msg. No.: Displayed as (Block No.)-(Message No.).
Alarm function: Selects whether or not to use the alarm function. Double clicking the cell switches between Enable 

and Disable.
Enable: Monitors the state of the device address bit configured for the channel and displays the 

message.
Disable: The device address bit is not monitored and the message is not displayed.

NO/NC: Selects the alarm detection condition. Double clicking the cell switches between NO and NC.
NO: Displays the message when the monitored bit changes from 0 to 1.
NC: Displays the message when the monitored bit changes from 1 to 0.

Text ID: Shows the Text Manager ID number (1 to 32000) to use for the message.
The text ID is sequentially configured starting with the text ID configured by Start Text ID on the 
List tab.

Text: Shows the text for the specified text ID.
Only shows the first line of text when the text registered to the text ID has multiple lines.
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● View Tab

■ Browse
Select the type of graphic to be used to represent the part from the list of graphics. Click this button to display the 
View Browser.

■ Plate Color
Selects the plate (color: 256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

■ Line Color
When lines are displayed, select this check box and select line color (color: 256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

■ Flange

Plate color

Lines

Foreground Color, Background Color: Selects the foreground and background colors of the flange (color: 256 colors, 
monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

Pattern: Selects a pattern for the flange.
Click Pattern to display the Pattern Palette. Select a pattern from the Pattern 
Palette.

Flange
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■ Buttons

■ Coordinates

■ Size

Foreground Color, Background Color: Selects the foreground and background colors of the buttons (color: 256 
colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

Pattern: Selects a pattern or tonal gradation for the button.
Click Pattern to display the Pattern Palette. Select a pattern or tonal gradation 
from the Pattern Palette.

ButtonsButtons

Can be set only when there are grouped Key Buttons.

X, Y: Sets the display position of parts using coordinates.
The X and Y coordinates of parts is defined relative to an origin at the top-left corner of the screen.

X: 0 to (base screen horizontal size - 1)

Y: 0 to (base screen vertical size - 1)

(0, 0)
X

Y
Screen

Parts

W, H: Sets width and height to define the size of parts.

W: 20 to (base screen horizontal size)

H: 20 to (base screen vertical size)

Width

Height

Screen

Parts
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● Format Tab

■ Font
Configures the format of the messages to display.

■ Display with Same Text Color
To set the text color for all messages to the same color, select this check box and select the text color to display 
(color: 256 colors, monochrome: 16 shades).
Click this button to display the Color Palette. Select a color from the Color Palette.
When this check box is cleared, the color for messages is the text color configured in Text Manager.

Style: Selects Regular or Bold for text style.

Magnification: W, H: Selects text magnification (0.5, 1 to 8).
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■ Line Spacing*1

Selects the specification method for line spacing in the list and configures the line spacing.

*1 Advanced mode only
*2 It depends on the base screen vertical size and the Magnification H.

Set with Number of Lines: Specifies the number of lines for the message to display for one alarm line.

Number of Lines: Enter the number of lines*2. To completely display a message that contains 
newlines, a number of lines that is equal to or greater than the number of 
message lines is required.

When you enter a value in Number of Lines, Height (dots) is automatically calculated according 
to the display area.
The relationship between the number of lines and the height (dots) is height (dots) = number of 
lines x magnification H x 16.

Number of Lines Magnification H Height
1 1× × 16 = 16 dots

Current fault 

Current fault 

has occurred
Pump fault 

Pump fault 

has occurred

2 1× × 16 =

Current fault 
has occurred

Pump fault 
has occurred

3 1× × 16 =

Current fault 
has occurred

has occurred
Pump fault 

3 2× × 16 =
Number of Lines Magnification H Height

Number of Lines Magnification H Height

32 dots

48 dots

Number of Lines Magnification H Height

96 dots

When the message is 2 lines, 
2nd line is not shown.

Since the alarm line spacing is adjusted with the number of lines for the message fixed, this option is 
convenient to use when displaying multi-line messages.

Set with Dots: Specifies the line spacing for the message to display for one alarm line in dots.

Height (dots): Enter the height (8 to (base screen vertical size -3)). To completely display a 
message, a height equal to or greater than Magnification H x 16 dots x the 
number of message lines is required.

When Magnification H is 1
To display a one-line message, 1 x 16 = 16 dots, a height of 16 dots or higher is required.

To display a two-line message, 2 x 16 = 32 dots, a height of 32 dots or higher is required.

When Magnification H is 2
To display a one-line message, 1 x 32 = 32 dots, a height of 32 dots or higher is required.

To display a two-line message, 2 x 32 = 64 dots, a height of 64 dots or higher is required.

16 dots
Height

Current fault has occurred
Pump fault has occurred

Height Height
16 dots32 dots Current fault has occurred

has occurred

Pump fault 
Current fault 

Pump fault 

When the message is 2 lines, 
2nd line is not shown.

Height

32 dots Current fault has occurred
Pump fault has occurred

Height

32 dots Current fault Current fault 
Pump fault 

Pump fault 

Height

64 dots

has occurred

has occurred

When the message is 2 lines, 
2nd line is not shown.
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■ Scroll*1

Select this check box to enable scrolling display displaying of messages.
Can only be set when One Line is selected for Display Type under the General tab.
For Alarm List Display, this can only be set if One Line is selected for Display Type under the General tab.

*1 Advanced mode only

Speed (1: Fastest): Sets the scrolling speed (1 to 10). 1 is fastest, 10 is slowest.

Start scrolling after displaying message: Select this check box to start scrolling after a message is displayed for 2 
seconds.

Page
Up

Page
Down

Vo

Page
Up

Page
Down

Vol

This check box is cleared. This check box is selected.

After 2 seconds, 
start scrolling it.

Start scrolling 
a message.

Display a message 
and align left.

Page
Up

Page
Down

Page
Up

Page
Down

Voltage abnormal

Page
Up

Page
Down

V

Page
Up

Page
Down

oltage abnormal

Page
Up

Page
Down

ltage abnormal

• When the Scroll check box is selected, the number of parts that can be arranged on a single screen 
decreases. If the MICRO/I displays an error message, clear the Scroll check box, or reduce the number 
of parts on the screen.

• When the scan time for the screen becomes longer, and when the part that has its Scroll check box 
selected is placed on the top layer, the scrolling speed may become slow.

When the Scroll check box is selected operation is follows.
• Messages that include CRs are displayed without the CRs.
• Messages scroll in the direction in which the text is drawn.
• When the text displayed according to values of device addresses, the text color, the displayed text, or the 

alarm state changes, the message is scrolled from the beginning.
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● Options Tab

The Options tab is displayed in Advanced mode.

■ Reference Screen
The Options tab is used to configure the reference screen. The reference screen is a base screen or popup screen 
associated with each individual message. The reference screen is displayed when the key button Ref. is pressed.

When displaying a reference screen, select either Base Screen or Popup Screen as the reference screen type.
When not displaying a reference, select Not Use.
This can only be set when New Message List has been selected in Message Settings on the General tab. When 
Use Alarm Log Settings has been selected, the screen type will become the one selected in Reference Screen on 
the Channel tab in the Alarm Log Settings dialog box.

■ Coordinates

(Reference screen list)

Motor fault

Pump1 fault

REV

Up

Dwn

Del

Ref.

High pressure

Pump 1 fault

Motor fault

Pump1 fault

REV

Up

Dwn

Del

Ref.

High pressure

Pump 1 fault

Motor fault

Pump1 fault

REV

Up

Dwn

Del

Ref.

High pressure

Pump 1 fault

Key bu�on Ref. Reference screenKey bu�ons Up and Dwn

1. Select a message displayed 
on the Alarm List Display 2. Press the key bu�on Ref. Reference screen opens

Pump 1 faultPump 1 fault
Pump 1 output low

Stop Start

Press Stop, check the air, 
then press Start.

Air Press.

kg/m2
0000

X, Y: Specifies the coordinates to display the reference screen.
With the upper-left corner of the screen as the origin, the X and Y coordinates are the upper-left corner of the 
reference screen.
This option can only be configured when Base Screen or Popup Screen is selected for Reference Screen.

Specify the coordinates in 1 dot units.
X: 0 to (base screen horizontal size - 1)
Y: 0 to (base screen vertical size - 1)
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■ Screen Number Setting Method
Selects the setting method for the screen numbers on the reference screen list.

■ (Reference Screen List)
Displays a list reference screen numbers and screen titles that have been set to messages.

■ Place on the Top Layer
Select this check box to display the parts on the top layer. The parts will have precedence when other drawings and 
parts are overlapping with it. For details, refer to Chapter 6 “4 Drawings and Parts Overlapping” on page 6-5.

Serial: Continuously and automatically specifies screen numbers (1 to 3000) that are at or below the 
selected message number.

Example 1: When screen number “100” has been entered for message number 1-0.

Screen numbers “100”, “101”, “102”....are automatically specified in order from message 
number 1-0.

Example 2: When screen number “200” has been entered for message number 1-5.

Message numbers 1-0 to 1-4 are left unchanged and screen numbers “200”, “201”, 
“202”....are automatically specified in order from message number 1-5.

Random: Specifies a reference screen number (1 to 3000) for each message number.

Message No.: Displays the message number.

Screen No.: Displays the reference screen number.
Double clicking the cell allows you to change the screen number (1 to 3000).

When there is not screen for the specified screen number a message confirming the creation of a new 
screen will appear.
If Yes is clicked, a screen will be created but if No is clicked, you will be returned to the Options screen 
without creating a screen.

Title: Displays the title of a reference screen.
Double clicking the cell allows you to edit the title. The maximum number is 40 characters.
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● Security Tab
This tab is used to restrict displaying and using the part by security groups.
This option can only be set when Use Security functions is selected. The Use Security functions check box is set 
on General tab in the Security dialog box.

■ (Settings)
Displays the list of security groups used on the MICRO/I.

■ Security Settings
The Security Settings dialog box is displayed. If you create a security group in the Security Settings dialog box, you 
can select that created group. For details, refer to Chapter 23 “2.2 Adding and Editing Security Groups” on page 23-
19.

(Settings)

No.: Displays the security group numbers (0 to 15).

Group Name: Displays the name of the security group.

Display: Displays whether or not there is permission to display the part. Only Permitted security groups 
can display this part. If all security groups are set to Permitted, this part will be displayed even 
if no user account has been selected. Double clicking the cell switches between Permitted and 
Prohibited.

Input: Displays whether or not there is permission to use the part. Only Permitted security groups 
can use this part. If all security groups are set to Permitted, this part can be used even if no 
user account has been selected. Double clicking the cell switches between Permitted and 
Prohibited.

• You can also switch between Permitted and Prohibited by right-clicking on a Display or Input cell.
• Restricting the display and use of the part by switching between Permitted and Prohibited in Display 

and Input cells is similar to using the Trigger Condition tab.

For details about security functions, refer to Chapter 23 “User Accounts and the Security Function” on page 
23-1.
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Example: If the user and security group for a part are set as follows:

For User1 in the Reader security group, the parts for which Display has been set to Prohibited for Reader will not 
be displayed.
If the password screen is opened and the user switches to User2 in the Operator security group, the parts for which 
Display has been set to Permitted for Operator will be displayed.

For User2 in Operator, Display has been set to Permitted for Operator, but Input is Prohibited, so the part 
cannot be used.
If the password screen is opened and the user switches to User3 in the Administrator security group, the parts for 
which Display has been set to Permitted for Administrator will be displayed, and the parts for which Input has 
been set to Permitted for Administrator can be used.

User Name

Security Group Reader Operator Administrator
User1 User2 User3

MICRO/I

130

Numerical Display
No. Group Name Display

1 Administrator Permitted

2 Operator Permitted

3 Reader Permitted

Button
No. Group Name Display Input

1 Administrator Permitted Permitted

2 Operator Permitted Prohibited

3 Reader Prohibited Prohibited

Line Chart and Bar Chart
No. Group Name Display

1 Administrator Permitted

2 Operator Permitted

3 Reader Prohibited

Open Password Screen, 
enter password, 
and switch to User2

For User1, 
parts for which Display 
has been set to Prohibited 
for Reader are not displayed

For User2, 
parts for which Display 
has been set to Permitted 
for Operator are displayed

MICRO/I

130

MICRO/I MICRO/I

130

User1 User2

130
CAN

User Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password

Open Password Screen, 
enter password, 
and switch to User3

For User2, 
parts for which Display 
has been set to Permitted 
for Operator are displayed, 
but parts for which Input 
has been set to Prohibited cannot be used

For User3, 
parts for which Display 
has been set to Permitted 
for Administrator are displayed, 
and parts for which Input 
has been set to Permitted can be used

MICRO/I

130

MICRO/I MICRO/I

130130 130

User2 User3

Button
Can operate

CAN

User Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password

Button
Cannot operate
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● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Used for entering comments about parts. Maximum number is 80 characters.
Example: When mousing over the Alarm List Display on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.
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8.1 How the Alarm Log Display is Used

The Alarm Log Display displays Alarm Log data saved in the data storage area.

• List the message, the occurrence time, recovery time, and confirmation time for the alarms that have occurred

• Display the reference screen for alarms that have occurred

8 Alarm Log Display

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

Occurrence    Message   Recovered   Confirmed
12/01 12 : 00     Current fault        12 : 53              12 : 54

MICRO/I

External device

Occurrence    Message   Recovered   Confirmed
12/01 12 : 00     Current fault        12 : 53              12 : 54

Up Down CheckSelect Delete

Up Down CheckSelect Delete

0 1

12 : 00

01

12 : 53

12 : 00
Alarm occurred

12 : 53     Recovered

12 : 54      Confirmed

Recovery time

Confirmation time

Message

Occurrence time

Show focus Move focus

Key Bu�on

Display reference screen

Time

09:15   Motor fault

Message

10:02   Pump1 fault

Slct

Up

Dwn

Del

Ref.

10:28   High pressure

13:02   Pump 1 fault

Time

09:15   Motor fault

Message

10:02   Pump1 fault

Up

Dwn

Del

Ref.

10:28   High pressure

13:02   Pump 1 fault

Time

09:15   Motor fault

Message

10:02   Pump1 fault

Up

Dwn

Del

Ref.

10:28   High pressure

13:02   Pump 1 fault

Time

09:15   Motor fault

Message

10:02   Pump1 fault

Up

Dwn

Del

Ref.

10:28   High pressure

13:02   Pump 1 fault

Slct SlctSlct

Pump 1 faultPump 1 fault
Pump 1 output low

Stop Start

Press Stop, check the air, 
then press Start.

Air Press.

kg/m2
0000

Reference screen

Only one Alarm List Display or Alarm Log Display can be displayed in a screen.

• For the key buttons used with the Alarm Log Display, refer to Chapter 8 “Alarm Log Display” on page 8-
96.

• When the Operate the Alarm on List directly check box on the General tab in the Properties of 
Alarm Log Display dialog box is selected, a displayed alarm can be given focus by pressing it on the list.

• The number of lines from the start line to the selected line of the message displayed on the Alarm Log 
Display is stored in HMI Special Data Register LSD56.
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8.2 Alarm Log Display Configuration Procedure

This section describes the configuration procedure for Alarm Log Displays.

1 On the Home tab, in the Parts group, click Data Displays, and then click Alarm Log Display.

2 Click a point on the edit screen where you wish to place the Alarm Log Display.

3 Double-click the dropped Alarm Log Display and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.

The Options tab only appears in Advanced mode.
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8.3 Properties of Alarm Log Display Dialog Box

This section describes items and buttons on the properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ Alarm Log Settings
Displays the Alarm Log Settings dialog box.

■ Default Settings
These options configure the default settings when the Alarm Log Display is displayed.

■ Displaying Alarms*1

Select these check boxes for alarms to display on the Alarm Log Display.

*1 Advanced mode only

Start Line Number: Specifies what number alarm to display when multiple alarms have occurred.
The range that can be specified varies based on the model type.

HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F: 1 to 11660
HG2G-5T, HG1G/1P: 1 to 5520

Sort: Selects the display order for alarms that have occurred as Old or New.

Display Focus on List after changing Screens or occurring Alarms*1:
Select this check box to automatically display the focus at the first item in the list after 
switching screens and when an alarm occurs.

Display Reference Screen*1: Select this check box to automatically display the reference screen for the alarm that 
has focus under the following conditions.
When the focus is displayed
When the focus moves
When a new alarm occurs

Not Recovered and Unconfirmed Alarm: Displays active alarms that have not been recovered and confirmed.
Not Recovered and Confirmed Alarm: Displays alarms that have not been recovered but the key button CHECK 

has been pressed.
Recovered and Unconfirmed Alarm: Displays alarms that have been recovered but the key button CHECK has 

not been pressed.
Recovered and Confirmed Alarm: Displays alarms that have been recovered and the key button CHECK has 

been pressed.
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■ First Alarm*1

An alarm that occurs in a state where no alarms have occurred is called the first alarm. Select the check boxes for the 
operations to execute when the first alarm occurs.

■ Operate the Alarm on List directly*1

Select this check box to display the focus by pressing an alarm displayed on the list.
When an alarm is pressed with no focus displayed, the focus is displayed on that alarm.
When an alarm is pressed that does not have focus when the focus is displayed, the focus is moved to that alarm. The 
focus is no longer displayed when an alarm with focus is pressed.

*1 Advanced mode only

Display First Alarm to 1st line on List: Always displays the first alarm on the first line of the list.

Change the color of First Alarm: Changes the text color of the first alarm according to the First Alarm 
Color setting. First Alarm Color is configured on the Format tab.
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● Log Tab

■ Show Items
Select these check boxes for the items to display on the Alarm Log Display.

(Show items detailed settings)

Title: Shows the titles on the first line of the list.

Occurrence Time: Shows the time the alarm occurred.

Recovery Time: Shows the time the alarm was recovered from.

Confirmation Time: Shows the time the alarm was confirmed by pressing the key button CHECK.

Occurrence    Message   Recovered   Confirmed
12/01 12 : 00     Current fault         12 : 53              12 : 54

Title

Recovery �me

Confirma�on �me

Message

Occurrence �me

Up Down CheckSelect Delete

You can drag and drop the sub headings to change the order of items to be displayed on the Alarm Log 
Display. This function is not applied to the order of the Alarm Log output data by batch or real time output 
function.

Drag and drop
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■ (Show items detailed settings)
Each of the show items selected by the check boxes under Show Items can be configured in detail here.

■ Title
Select this check box to use text registered in Text Manager for Title in the (Show items detailed settings). The 
Text ID message configured for Occurrence Time, Message, Recovery Time, and Confirmation Time is 
displayed in (Show Items detailed settings).

Title: Double click the cell, and then enter the titles for the items to display. The maximum number is 
100 characters.

Width: Specifies the number of characters to display (0 to 40). 1 is the width of a single-byte character, 
2 is the width of a double-byte character.

Date: Selects the display type of the date from the following.
YY/MM/DD, MM/DD/YY, DD/MM/YY, MM/DD, DD/MM, non-display

Time: Selects the display type of the time from the following.
HH:MM, HH:MM:SS, non-display

• If the title contains a newline, the text after the newline is not displayed. However, if using a Windows 
font for the selected text ID, all the characters are displayed.

• If the title contains a language not supported as standard by the OS, the characters may be garbled 
when displaying the (Show items detailed settings). However, the downloaded data is correctly 
displayed.

• If you change the display format for Date or Time, the number for Width is automatically adjusted.
• The text color for Message changes according to the alarm state. The text color for Message is 

configured by Occurred Color, Recovered Color, and Confirmed Color on the Format tab.

Text ID: Specifies the Text Manager ID number (1 to 32000) when using text registered in Text Manager.

Click  to display Text Manager.

This option can only be configured when the Use Text Manager check box is selected.
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● View Tab

■ Browse
Select the type of graphic to be used to represent the part from the list of graphics. Click this button to display the 
View Browser.

■ Plate Color
Selects the plate (color: 256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

■ Line Color
When lines are displayed, select this check box and select line color (color: 256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

■ Flange

Plate color

Lines

Foreground Color, Background Color:

Selects the foreground and background colors of the flange (color: 256 colors, monochrome: 
16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

Pattern: Selects a pattern for the flange.
Click Pattern to display the Pattern Palette. Select a pattern from the Pattern Palette.

Flange
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■ Buttons

■ Coordinates

■ Size

Foreground Color, Background Color: Selects the foreground and background colors of the buttons (color: 256 
colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

Pattern: Selects a pattern or tonal gradation for the button.
Click Pattern to display the Pattern Palette. Select a pattern or tonal gradation 
from the Pattern Palette.

ButtonsButtons

Can be set only when there are grouped Key Buttons.

X, Y: Sets the display position of parts using coordinates.
The X and Y coordinates of parts is defined relative to an origin at the top-left corner of the screen.

X: 0 to (base screen horizontal size - 1)

Y: 0 to (base screen vertical size - 1)

(0, 0)
X

Y
Screen

Parts

W, H: Sets width and height to define the size of parts.

W: 20 to (base screen horizontal size)

H: 20 to (base screen vertical size)

Width

Height

Screen

Parts
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● Format Tab

■ Style
Selects Regular or Bold for text style.

■ Magnification

■ Title Font
Select the font that will be used for the title from the following options.
Japanese, European, Chinese, Taiwanese, Korean, Central European, Baltic, Cyrillic
The characters that can be displayed depend on the font. For details, refer to Chapter 2 “1.2 Available Text” on page 2-6.

■ Title Color
Select the color (color: 256 colors, monochrome: 16 shades) of the text for titles.
Click this button to display the Color Palette. Select a color from the Color Palette.

■ Occurred Color, Recovered Color, Confirmed Color, First Alarm Color*1

Select the color (color: 256 colors, monochrome: 16 shades) of the occurred alarm, recovered alarm, confirmed alarm 
and first alarm.
Click this button to display the Color Palette. Select a color from the Color Palette.

*1 Advanced mode only

W, H: Selects text magnification (0.5, 1 to 8).

Flash*1: Select this check box to flash alarms that are displayed on the list.
The flash interval is specified in Flashing Cycle on the System tab in the Project Settings dialog box.

Reverse*1: Select this check box to show in reverse, the text color and plate color of alarms that are displayed on the 
list.

Current fault Current faultCurrent fault

Current fault

Flash Reverse Flash and reverse

When the Key Button CHECK is pressed before recovering a triggered alarm, the alarm display will change 
from the Occurred Color to the Confirmed Color. After this, the alarm that has changed to the Confirmed 
Color will remain in that color and will not change to the Recovered Color even when recovered.
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■ Line Spacing*1

Selects the specification method for line spacing in the list and configures the line spacing.

*1 Advanced mode only
*2 It depends on the base screen vertical size and the Magnification H.

Set with Number of Lines:
Specifies the number of lines for the message to display for one alarm line.
Number of Lines: Enter the number of lines*2. To completely display a message that contains 

newlines, a number of lines that is equal to or greater than the number of 
message lines is required.

When you enter a value in Number of Lines, Height (dots) is automatically calculated according 
to the display area.
The relationship between the number of lines and the height (dots) is height (dots) = number of 
lines x magnification H x 16.

Number of Lines Magnification H Height
1 1× × 16 = 16 dots

Current fault 

Current fault 

has occurred
Pump fault 

Pump fault 

has occurred

2 1× × 16 =

Current fault 
has occurred

Pump fault 
has occurred

3 1× × 16 =

Current fault 
has occurred

has occurred
Pump fault 

3 2× × 16 =
Number of Lines Magnification H Height

Number of Lines Magnification H Height

32 dots

48 dots

Number of Lines Magnification H Height

96 dots

When the message is 2 lines, 
2nd line is not shown.

Since the alarm line spacing is adjusted with the number of lines for the message fixed, this option is 
convenient to use when displaying multi-line messages.

Set with Dots: Specifies the line spacing for the message to display for one alarm line in dots.
Height (dots): Enter the height (8 to (base screen vertical size -3)). To completely display a 

message, a height equal to or greater than Magnification H x 16 dots x the 
number of message lines is required.

When Magnification H is 1
To display a one-line message, 1 x 16 = 16 dots, a height of 16 dots or higher is required.

To display a two-line message, 2 x 16 = 32 dots, a height of 32 dots or higher is required.

When Magnification H is 2
To display a one-line message, 1 x 32 = 32 dots, a height of 32 dots or higher is required.

To display a two-line message, 2 x 32 = 64 dots, a height of 64 dots or higher is required.

16 dots
Height

Current fault has occurred
Pump fault has occurred

Height Height
16 dots32 dots Current fault has occurred

has occurred

Pump fault 
Current fault 

Pump fault 

When the message is 2 lines, 
2nd line is not shown.

Height

32 dots Current fault has occurred
Pump fault has occurred

Height

32 dots Current fault Current fault 
Pump fault 

Pump fault 

Height

64 dots

has occurred

has occurred

When the message is 2 lines, 
2nd line is not shown.

Since only one line of the title is displayed, the title line spacing = 1 (number of lines) x Magnification H 
x 16, regardless of the Line Spacing setting.
Example: When Magnification H is 1, the title line spacing = 1 x 1 x 16 = 16 dots

When Magnification H is 2, the title line spacing = 1 x 2 x 16 = 32 dots
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● Options Tab

The Options tab is displayed in Advanced mode.

■ Reference Screen Settings
The Options tab is used to configure the reference screen. The reference screen is a base screen or popup screen 
associated with each individual message. The reference screen is displayed when the key button Ref. is pressed.

Reference Screen: Displays the type of screen selected in Reference Screen on the Channel tab in the Alarm 
Log Settings dialog box.

Click  to display the Alarm Log Settings dialog box.

When displaying a reference screen, select either Base Screen or Popup Screen as the 
reference screen type.
When not displaying a reference, select Not Use.

Coordinates X, Y: Specifies the coordinates to display the reference screen.
With the upper-left corner of the screen as the origin, the X and Y coordinates are the upper-left 
corner of the reference screen.
This option can only be configured when Base Screen or Popup Screen is selected for 
Reference Screen.

Specify the coordinates in 1 dot units.
X: 0 to (base screen horizontal size - 1)
Y: 0 to (base screen vertical size - 1)

Time

09:15   Motor fault

Message

10:02   Pump1 fault

REV

Up

Dwn

Del

Ref.

10:28   High pressure

13:02   Pump 1 fault

Pump 1 faultPump 1 fault
Pump 1 output low

Stop Start

Press Stop, check the air, 
then press Start.

Air Press.

kg/m2
0000

Time

09:15   Motor fault

Message

10:02   Pump1 fault

REV

Up

Dwn

Del

Ref.

10:28   High pressure

13:02   Pump 1 fault

Time

09:15   Motor fault

Message

10:02   Pump1 fault

REV

Up

Dwn

Del

Ref.

10:28   High pressure

13:02   Pump 1 fault

Key bu�on Ref. Reference screen

2. Press the key bu�on Ref. Reference screen opens

Key bu�ons Up and Dwn

1. Select a message displayed on 
the Alarm Log Display

If you overlap the reference screen key button and the move focus key buttons, the reference screen can be 
switched and checked while moving the focus.
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■ Display Block Number
Specifies the range of block numbers that will display the collected alarm log data.

■ Place on the Top Layer
Select this check box to display the parts on the top layer. The parts will have precedence when other drawings and 
parts are overlapping with it. For details, refer to Chapter 6 “4 Drawings and Parts Overlapping” on page 6-5.

All: Displays the data for all blocks.

Block Number: Displays only the data for the specified blocks in the Alarm Log Display. Alarms in unspecified blocks 
are not displayed, even if active.
Individual block numbers can be specified by separating the numbers with “,”, continuous regions 
can be specified with “-”.

Example: When the number of blocks is 6, enter the following.

To specify blocks 1 to 3: 1-3

To specify blocks 1, 3, 6: 1, 3, 6

To specify blocks 1, 4 to 6: 1, 4-6

No. Device address

1-0

1-1

1-2

1-13

1-14

1-15

D100-0

D100-1

D100-2

D100-13

D100-14

D100-15

2-0

2-1

2-2

2-13

2-14

2-15

D101-0

D101-1

D101-2

D101-13

D101-14

D101-15

Block 1

Block 2

5-0

5-1

5-2

5-13

5-14

5-15

D104-0

D104-1

D104-2

D104-13

D104-14

D104-15

Block 5

6-0

6-1

6-2

6-13

6-14

6-15

D105-0

D105-1

D105-2

D105-13

D105-14

D105-15

Block 6

Number of blocks Specified numbers

1-36

Block 1

Block 2

Block  3

Block 4

Block 5

Block 6

Block 1

Block 2

Block 3

Block 4

Block 5

Block 6

Block 1

Block 2

Block 3

Block 4

Block 5

Block 6

1,  3,  6 1,  4-6

Blocks to display Blocks to display Blocks to display

• To display the alarms set in blocks 65 to 128 of the Alarm Log settings, select All under Display Block 
Number. If Block Number is selected, only blocks 1 to 64 can be specified.

• For the number of blocks, refer to Chapter 13 “Number of Blocks” on page 13-16.
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● Security Tab
This tab is used to restrict displaying and using the part by security groups.
This option can only be set when Use Security functions is selected. The Use Security functions check box is set 
on General tab in the Security dialog box.

■ (Settings)
Displays the list of security groups used on the MICRO/I.

■ Security Settings
The Security Settings dialog box is displayed. If you create a security group in the Security Settings dialog box, you 
can select that created group. For details, refer to Chapter 23 “2.2 Adding and Editing Security Groups” on page 23-
19.

(Settings)

No.: Displays the security group numbers (0 to 15).

Group Name: Displays the name of the security group.

Display: Displays whether or not there is permission to display the part. Only Permitted security groups 
can display this part. If all security groups are set to Permitted, this part will be displayed even 
if no user account has been selected. Double clicking the cell switches between Permitted and 
Prohibited.

Input: Displays whether or not there is permission to use the part. Only Permitted security groups 
can use this part. If all security groups are set to Permitted, this part can be used even if no 
user account has been selected. Double clicking the cell switches between Permitted and 
Prohibited.

• You can also switch between Permitted and Prohibited by right-clicking on a Display or Input cell.
• Restricting the display and use of the part by switching between Permitted and Prohibited in Display 

and Input cells is similar to using the Trigger Condition tab.

For details about security functions, refer to Chapter 23 “User Accounts and the Security Function” on page 
23-1.
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Example: If the user and security group for a part are set as follows:

For User1 in the Reader security group, the parts for which Display has been set to Prohibited for Reader will not 
be displayed.
If the password screen is opened and the user switches to User2 in the Operator security group, the parts for which 
Display has been set to Permitted for Operator will be displayed.

For User2 in Operator, Display has been set to Permitted for Operator, but Input is Prohibited, so the part 
cannot be used.
If the password screen is opened and the user switches to User3 in the Administrator security group, the parts for 
which Display has been set to Permitted for Administrator will be displayed, and the parts for which Input has 
been set to Permitted for Administrator can be used.

User Name

Security Group Reader Operator Administrator
User1 User2 User3

MICRO/I

130

Numerical Display
No. Group Name Display

1 Administrator Permitted

2 Operator Permitted

3 Reader Permitted

Button
No. Group Name Display Input

1 Administrator Permitted Permitted

2 Operator Permitted Prohibited

3 Reader Prohibited Prohibited

Line Chart and Bar Chart
No. Group Name Display

1 Administrator Permitted

2 Operator Permitted

3 Reader Prohibited

Open Password Screen, 
enter password, 
and switch to User2

For User1, 
parts for which Display 
has been set to Prohibited 
for Reader are not displayed

For User2, 
parts for which Display 
has been set to Permitted 
for Operator are displayed

MICRO/I

130

MICRO/I MICRO/I

130

User1 User2

130
CAN

User Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password

Open Password Screen, 
enter password, 
and switch to User3

For User2, 
parts for which Display 
has been set to Permitted 
for Operator are displayed, 
but parts for which Input 
has been set to Prohibited cannot be used

For User3, 
parts for which Display 
has been set to Permitted 
for Administrator are displayed, 
and parts for which Input 
has been set to Permitted can be used

MICRO/I

130

MICRO/I MICRO/I

130130 130

User2 User3

Button
Can operate

CAN

User Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password

Button
Cannot operate
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● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Used for entering comments about parts. Maximum number is 80 characters.
Example: When mousing over the Alarm Log Display on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.
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9.1 How the Numerical Display is Used

The Numerical Display is used to display the value of a word device in the specified format.

• Display the current value of a device address

• Display the decimal point

• Display the unit

• Flash a value that exceeds the minimum or the maximum

9 Numerical Display

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

65535

-1

MICRO/I

D100 : FFFF

Display Device Address : D100
Display Type : Decimal
Data Type : UBIN16(W)
Digits : 5

Display Device Address : D100
Display Type : Decimal
Data Type : BIN16(I)
Digits : 5

External device

(Hex)

AD2

?

MICRO/I

D100 : 1234

Display Device Address : D100
Display Type : Hexadecimal
Data Type : UBIN16(W)
Digits : 4

Display Device Address : D100
Display Type : Decimal
Data Type : BCD4(B)
Digits : 4

External device

(Decimal)

123.4

MICRO/I

D100 : 1234

Display Device Address : D100
Display Type : Decimal
Data Type : BIN16(I)
Digits : 4
Display Floating Point : On
Floating Digits : 1

External device

(Decimal)

1234 pcs.

MICRO/I

D100 : 1234

Display Device Address : D100
Display Type : Decimal
Data Type : UBIN16(W)
Digits : 4
With Unit : On
Text ID : 1
Text : pcs.

External device

(Decimal)

120

MICRO/I

D100 : 120

Display Device Address : D100
Display Type : Decimal
Data Type : UBIN16(W)
Digits : 3
Range : Value
    Minimum : 0
    Maximum : 100
When Data Over
    Flash : On

External device

(Decimal)
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9.2 Numerical Display Configuration Procedure

This section describes the configuration procedure for Numerical Displays.

1 On the Home tab, in the Parts group, click Data Displays, and then click Numerical Display.

2 Click a point on the edit screen where you wish to place the Numerical Display.

3 Double-click the dropped Numerical Display and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.

The Data Over tab, Trigger Condition tab and Options tab only appear in Advanced mode.
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9.3 Properties of Numerical Display Dialog Box

This section describes items and buttons on the properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ Display Type
Selects the display type for the value as Decimal or Hexadecimal.

■ Data Format

Data Type: Selects the type of data for the value.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Digits: Specifies the digits to display. The range of digits that can be set varies based on the 
display type and data type. The digits that can be set are as follows.

Display Type Data Type Digits

Decimal display

UBIN16(W), BIN16(I) 1 to 5

UBIN32(D), BIN32(L) 1 to 10

BCD4(B) 1 to 4

BCD8(EB) 1 to 8

Float32(F) 1 to 10

Hexadecimal display
UBIN16(W) 1 to 4

UBIN32(D) 1 to 8

Display Floating Point: Select this check box to display the decimal point.

When the Display Floating Point check box is selected and UBIN16(W), BIN16(I), UBIN32(D), 
BIN32(L), BCD4(B), or BCD8(EB) is selected for Data Type, the source device is an integer, but the 
value is displayed with the decimal point added at the configured floating digits.
However, if Float32(F) is selected for Data Type, the source data is a decimal value.
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*1 Advanced mode only

Floating Digits: Specifies the number of digits for the fractional part of the decimal value out of the 
number of digits specified by Digits.
This option can only be configured when the Display Floating Point check box is selected. 
The range of digits that can be set for the fractional part varies based on the display type and 
data type. The range of digits that can be set for the fractional part is as follows.

Display Type Data Type Floating Digits

Decimal display

UBIN16(W), BIN16(I) 1 to Digits

UBIN32(D), BIN32(L) 1 to Digits

BCD4(B) 1 to Digits

BCD8(EB) 1 to Digits

Float32(F) 1 to Digits or 8

Hexadecimal display
UBIN16(W) --

UBIN32(D) --

Floating Symbol*1: Selects the decimal point symbol from the following.
.(dot), :(colon), ;(semicolon), ,(comma), /(slash)
This option can only be configured when the Display Floating Point check box is selected.
Example: When Digits is 4 and Floating Digits is 2

When Floating Symbol is .(dot) 12.34
When Floating Symbol is /(slash) 12/34

Suppress Zeros: Select this check box to hide “0” for the upper digits of the integer part.
Example: Suppress Zeros selected: 1234

Suppress Zeros cleared: 00001234
Do not display when the value is zero: Select this check box to show a blank display if the value is "0".

• If the value is zero and it is not displayed, the unit set on the Format tab is also not displayed.
• Even if the Do not display when the value is zero check box is selected, "0" is displayed when the value is 

not 0.

Display the minus sign: Select this check box to display the - (negative) sign when displaying negative values.
This option can only be configured when Decimal is selected for Display Type.

Display the plus sign: Select this check box to display the + (positive) sign when displaying positive values.
This option can only be configured when Decimal is selected for Display Type.

Symbol to show when out of range or Error occurs:
Selects the following symbols to be displayed when a value exceeding the Data Type in 
the General tab or the Range in the Data Over tab is entered, or an error occurs.
"? (question mark)", " (space)", "# (pound)", "% (percent)", "$ (dollar)", "- (minus)", 
"@ (at sign)", "\ (backslash)", "* (asterisk)", "! (exclamation mark)", "+ (plus)"

In the following cases, it is handled as an error and the symbol selected in Symbol to show when out of 
range or Error occurs is displayed.
• If the Data Type is BCD4(B), BCD8(EB), or Float32(F) and the value entered in device address 

doesn't comply with the data type.
• If a value divided by zero operation was executed with Display with Arithmetic Operation on the 

Options tab.
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■ Display Method
Specifies the source of the value to display.

Display Device Address: Specifies the word device that stores the value to display.

Click  to display the Tag Editor. For the device address configuration procedure, 
refer to Chapter 2 “5.1 Device Address Settings” on page 2-68.

Use Reference Device Address*1: Select this check box and specify a device address to change the source device 
address by the value of this device address.

Click  to display the Tag Editor. For the device address configuration procedure, 
refer to Chapter 2 “5.1 Device Address Settings” on page 2-68.
For details on indirect reading, refer to Chapter 2 “Indirect Read and Indirect Write 
Settings” on page 2-5.
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● View Tab

■ Image Type
Select the type of graphic to be used to represent the part.

■ Browse
Select the type of graphic to be used to represent the part from the list of graphics. Click this button to display the 
View Browser or Picture Manager, depending on the setting for Image Type.

■ Plate Color
Selects the plate color of the standard graphic (color: 256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

■ Flange

Standard: Uses the default graphic for WindO/I-NV4.

Picture: Uses an image file saved using Picture Manager.
For details about image file restrictions, refer to Chapter 2 “1.4 Available Image Files” on page 2-20.

None: The plate and the flange of the part are not displayed. Only the text is displayed.

Plate color

Foreground Color, Background Color:

Selects the foreground and background colors of the flange of the standard graphic (color: 256 
colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

Pattern: Selects a pattern for the flange of the standard graphic.
Click Pattern to display the Pattern Palette. Select a pattern from the Pattern Palette.

Flange
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■ Coordinates

■ Size

X, Y: Sets the display position of parts using coordinates.
The X and Y coordinates of parts is defined relative to an origin at the top-left corner of the screen.

X: 0 to (base screen horizontal size - 1)

Y: 0 to (base screen vertical size - 1)

(0, 0)
X

Y
Screen

Parts

W, H: Sets width and height to define the size of parts.

W: 5 to (base screen horizontal size)

H: 5 to (base screen vertical size)

Width

Height

Screen

Parts
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● Format Tab

■ Font
Selects the font used for displaying text from the following.
Standard, Windows, Stroke, 7-Segment
The characters that can be displayed depend on the font. For details, refer to Chapter 2 “1.2 Available Text” on page 2-6.

■ Size
When Standard is selected, selects the text size as 8x16 or 16x16.
When Stroke or 7-Segment is selected, specifies the text size (8 to 128).

■ Style
Selects Regular or Bold for text style.
Can only be set when Standard is selected for Font.

■ Magnification

Can only be set when Standard is selected for Font.

■ Align Text
Selects the text alignment in the horizontal direction from the following.
Left, Center, Right
For details, refer to Appendix “5 Text Alignment” on page A-7.

■ Text Color
Selects the color of displayed text (color: 256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

W, H: Selects text magnification (0.5, 1 to 8).
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■ With Unit*1

Select this check box to display units or other characters at the end of a number. Displayed characters must be 
registered in Text Manager. The displayed text color will be as set for Text Color under the Format tab.

■ Windows Font
Configures the font to use as the Windows Font.
Select Windows for Font to display the current settings. To change the settings, click Change to display the Font 
dialog box. For details, refer to Chapter 2 “Windows Font” on page 2-13.

■ Change Display Colors
Select this check box to switch the text and plate colors.

*1 Advanced mode only

Text ID: Specifies the Text Manager ID No. (1 to 32000).

Click  to display Text Manager.

Text: Displays the characters of the specified Text ID.

• The maximum number that can be displayed with this function is 4 characters. The fifth and subsequent 
characters of a character string are not displayed. However, if Windows Font is set for the specified Text 
ID characters all the characters are displayed.

• If a carriage return (CR) is included the characters after the CR are not displayed.

Trigger Device Address: Specifies the bit device or the bit number of the word device to use as the trigger to switch 
the text and plate colors.

Click  to display the Tag Editor. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-68.
When the value of device address is 0, the color specified in Text Color or in Plate Color 
on the View tab will be displayed.
When the value of device address is 1, the color displayed and specified in Text Color or 
Plate Color under the Change Display Colors.

Text Color: Selects the color (color: 256 colors, monochrome: 16 shades) of the text when switching.
Click this button to display the Color Palette. Select a color from the Color Palette.

Plate Color: Selects the plate color (color: 256 colors, monochrome: 16 shades) when switching.
Click this button to display the Color Palette. Select a color from the Color Palette.
This option can only be configured when Standard is selected for Image Type on the View 
tab.

MICRO/I

1234

1234

0

1

Trigger Device Address

Trigger Device Address

External device

Text Color

Plate Color on the View tab

Text Color under Change Display Colors

Plate Color under Change Display Colors
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■ Flash
Select this check box to make the text and plate colors flash.
The flashing will occur as follows:
• The Change Display Colors check box is cleared, then the colors specified by Text Color and Plate Color on 

the View tab and the colors specified by Text Color and Plate Color under Flash are alternately displayed.

• The Change Display Colors check box is selected and the value of the trigger device address for Change 
Display Colors is 0, then the colors specified by Text Color and Plate Color on the View tab and the colors 
specified by Text Color and Plate Color under Flash are alternately displayed.

• The Change Display Colors check box is selected and the value of the trigger device address for Change 
Display Colors is 1, then the colors specified by Text Color and Plate Color under Change Display Colors 
and the colors specified by Text Color and Plate Color under Flash are alternately displayed.

1234

1234
1234

1234

Flashing

Trigger device address
under Flash

Trigger device address
under Flash

0

1

MICRO/IExternal device

Text Color

Plate Color on the View tab

Text Color

Plate Color on 
the View tab

Text Color under Flash

Plate Color under Flash

1234

1234
1234

1234

Flashing

Trigger device address
under Flash

Trigger device address
under Flash

MICRO/IExternal device

Text Color

Plate Color on the View tab

Text Color

Plate Color on 
the View tab

Text Color under Flash

Plate Color under Flash

Trigger device address under
Change Display Colors

Trigger device address under
Change Display Colors

0

0

1

0

1234

1234
1234

1234

Flashing
1

Trigger device address under 
Change Display Colors

Trigger device address
under Flash

Trigger device address under 
Change Display Colors

Trigger device address
under Flash

0

1

1

MICRO/IExternal device

Text Color under 
Change Display Colors
Plate Color under 
Change Display Colors

Text Color under Change Display Colors

Plate Color under Change Display Colors

Text Color under Flash

Plate Color under Flash
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Trigger Device Address: Specifies the bit device or the bit number of the word device that will be used to trigger 
flash.

Click  to display the Tag Editor. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-68.
Flash intervals are set in the Flashing Cycle on the System tab in the Project Settings 
dialog box.

Text Color: Selects the color (color: 256 colors, monochrome: 16 shades) of text when flashing.
Click this button to display the Color Palette. Select a color from the Color Palette.

Plate Color: Selects the plate color (color: 256 colors, monochrome: 16 shades) when flashing.
Click this button to display the Color Palette. Select a color from the Color Palette.
This option can only be configured when Standard is selected for Image Type on the View 
tab.

If the Flash check box is selected and the Flash check box under When Data Over on the Data Over tab 
is also selected, the Data Over display is blinking will be given precedence when both conditions are 
satisfied.
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● Data Over Tab
The Data Over tab is displayed in Advanced mode.

■ Range
Select data type.

Specifies the allowable range of values to display.

Value: Specifies the minimum and/or the maximum as a constant.

Device Address: Specifies the minimum and/or the maximum as a value of word device.

Minimum, Maximum: Select these check boxes to specify the minimum and/or maximum.
The minimum and maximum that can be specified when Value is selected vary based on the 
data type selected with Data Format on the General tab. For details on data types, refer to 
Chapter 2 “1.1 Available Data” on page 2-1.
When Device Address is selected, these options specify the source word devices.

Click  to display the Tag Editor. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-68.

• Select UBIN16(W), BIN16(I), UBIN32(D), BIN32(L), BCD4(B), or BCD8(EB) for Data Type 
under the General tab, and to display a fractional number specify the values of Minimum and 
Maximum as an integer.
Example: To set a value of “1.25” for the upper limit, enter “125”.

• If the value of the device address to display exceeds the data range that can be processed for the data 
type selected under Data Format on the General tab, the symbol selected under Symbol to show 
when out of range or Error occurs on the General tab is displayed.
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■ When Data Over
These options configure the operation of the part when the allowable range is exceeded.
These options can only be configured when the Minimum or Maximum check boxes are selected under Range.

Flash: Select this check box to make the value flash when the displayed data exceeds the allowable range.

Report: Select this check box to write 1 in the Report Device Address when the displayed data exceeds the 
allowable range.

Report Device Address: Specifies the Report Device Address.

Click  to display the Tag Editor. For the device address configuration 
procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-68.

Example: If the value of word device of the reading source is “120,” which is higher than the upper limit of “100,” or 
“-10,” which is below the lower limit of “0,” a value of 1 will be written to LM0 and the displayed numerical 
value will flash.

50 120 90

120

-10

9050 -10

Flashing Flashing

1 10 0

Range: Value
Minimum: 0
Maximum: 100
When Data Over
    • Flash
    • Report
Destination Device Address: LM0

Read data

Display

Data over 
notification: LM0
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● Trigger Condition Tab
The Trigger Condition tab is displayed in Advanced mode.

The Numerical Display is enabled while the condition is satisfied, and it is disabled while the condition is not satisfied. 
Select the operation when the condition is not satisfied as Not display Numerical data, Not update Numerical 
data, or Not show Numerical Display under While not satisfying the condition.

■ Trigger Type
Selects the condition to enable the Numerical Display from the following.

Example: When Trigger Type is While ON, Device Address is LM0, and While not satisfying the condition is 
Not display Numerical data
While LM0 is 0, the condition is not satisfied and the Numerical Display does not display the number.
While LM0 is 1, the condition is satisfied and the Numerical Display displays the number.

LM0:

MICRO/I

0

LM0: 1
1234

Condition 
Not 

satisfied

Condition 
Satisfied

Show 
number

Hide 
number

Data over does not operate for hidden Numerical Displays. Data over is reported if the minimum or 
maximum is exceeded when the Numerical Display changes from hidden to displayed.

Always visible: The Numerical Display is always enabled.

Display

Data 99 100 101 102 103 104 105

Update Update Update Update Update Update Update

99 100 101 102 103 104 105
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■ Data Type
Selects the data type to be handled by the condition formula.
Can only be set if While satisfying the condition is selected as Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

■ Device Address
Specifies the bit device or the bit number of the word device to serve as condition.
Can only be set if While ON or While OFF is selected as Trigger Type.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.

■ Condition
Sets the condition formula.
Can only be set if While satisfying the condition is selected as Trigger Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expression configuration 
procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-71.

■ Comment
Used for entering comments about trigger conditions. Maximum number is 80 characters.

■ While not satisfying the condition
Selects the operation of the Numerical Display when the condition is not satisfied.

While ON: Enables the Numerical Display when the value of device address is 1.
Example: When While not satisfying the condition is Not update Numerical data

While OFF: Enables the Numerical Display when the value of device address is 0.
Example: When While not satisfying the condition is Not update Numerical data

While satisfying the condition: Enables the Numerical Display when the condition is satisfied.

Example: When While not satisfying the condition is Not update Numerical data

Value of
Device Address

1

0

UpdateDo not update Do not update Do not update Do not update

Display

Data 99 100 101 102 103 104 105

Update Update

0 100 100 102 103 103 103

Value of
Device Address

1

0

Update Do not update Do not update Do not update

Display

Data 99 100 101 102 103 104 105

Update Update Update

99 99 101 101 101 104 105

Update Do not update Do not update Do not update
Display

Data 99 100 101 102 103 104 105

Update Update Update

Condition
Satisfied

Not satisfied

99 99 101 101 101 104 105

Not display Numerical data: The plate and flange are displayed, but number is not displayed.
Not update Numerical data: The last updated number is displayed. The number does not change.
Not show Numerical Display: Hides the Numerical Display.
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● Options Tab
The Options tab is displayed in Advanced mode.

■ Display with Arithmetic Operation
To apply arithmetic operations to values of device addresses and writing the results, select this check box and input 
the arithmetic formula.
Example: To multiple the value of device address when displayed by 60

Arithmetic Formulas
Arithmetic formulas can be specified by freely combining multiple kinds of data and operators in the following format.

• There is no limit on the number of data items or number of operators. However, the maximum number is 120 
characters.

• Round brackets can be used.

Data

Item Description

@
The device address on which the arithmetic operation is performed is specified in the arithmetic 
formula. Only one device address can be set for an arithmetic operation.
The device address is as specified for Display Device Address under the General tab.

Value
Sets the constant values for the arithmetic formula.
The values that can be set depend on the data type selected using Data Format under the General 
tab. For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Device Address
Specifies the bit device or the word device for the arithmetic formula.
Always enter the device address enclosed in square brackets, “[” and “]”.

External device MICRO/I

D0 1234

1234×60

Display value multiplied 
by 60 for the value of 

device address

74040 Numerical Input

Destination Device Address: D0

Display with Arithmetic Operation: @*60

...(up to 120 characters)

OperatorData Data

OperatorData Data
to

Operator Data Operator Data Operator Data Operator Data
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Operators
Specify the type of arithmetic operation to be performed on the data. The operator priority is the same as for scripts. 
For details, refer to Chapter 20 “6.3 About the Priority of the Operator” on page 20-59.

Examples of Arithmetic Formula Input

■ Place on the Top Layer
Select this check box to display the parts on the top layer. The parts will have precedence when other drawings and 
parts are overlapping with it. For details, refer to Chapter 6 “4 Drawings and Parts Overlapping” on page 6-5.

Item Description

Arithmetic 
operators

Sets the arithmetic operators.

+ Addition Adds  and .

- Subtraction Subtracts  from .

* Multiplication Multiplies  and .

/ Division Divides  by .

% Modulo Calculates remainder after dividing  by .

Bit operator

Sets the bit operator.

& Logical AND Calculates the logical product (AND) of each bit of  and .

| Logical OR Calculates the logical sum (OR) of each bit of  and .

^ Logical XOR 
(exclusive OR)

Calculates the exclusive logical sum (XOR) of each bit of  and 

.

<< Left shift Shifts each bit of  to left by  bit(s).

>> Right shift Shifts each bit of  to right by  bit(s).

Input Examples Description

@ + 1

To perform the arithmetic operation and input the result, add 1 to the value entered 
using the Keypad and write the result to the device address.

To perform the arithmetic operation and display the result, add 1 to the value of device 
address and display the result.

[LDR 0] + @ + 100

To perform the arithmetic operation and input the result, add the value of LDR0 to the 
value entered using the Keypad and add 100, and write the result to the device address.

To perform the arithmetic operation and display the result, add the value of LDR0 to the 
value of device address and add 100, then display the result.

@ & 3

To perform the arithmetic operation and input the result, write the logical product of the 
value entered using the Keypad and 3 to the device address.

To perform the arithmetic operation and display the result, add 3 to the value of device 
address and display the result.
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● Security Tab
This tab is used to restrict displaying and using the part by security groups.
This option can only be set when Use Security functions is selected. The Use Security functions check box is set 
on General tab in the Security dialog box.

■ (Settings)
Displays the list of security groups used on the MICRO/I.

■ Security Settings
The Security Settings dialog box is displayed. If you create a security group in the Security Settings dialog box, you 
can select that created group. For details, refer to Chapter 23 “2.2 Adding and Editing Security Groups” on page 23-
19.

(Settings)

No.: Displays the security group numbers (0 to 15).

Group Name: Displays the name of the security group.

Display: Displays whether or not there is permission to display the part. Only Permitted security groups 
can display this part. If all security groups are set to Permitted, this part will be displayed even 
if no user account has been selected. Double clicking the cell switches between Permitted and 
Prohibited.

You can also switch between Permitted and Prohibited by right-clicking on a Display cell.

For details about security functions, refer to Chapter 23 “User Accounts and the Security Function” on page 
23-1.
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Example: If the user and security group for a part are set as follows:

For User1 in the Reader security group, the parts for which Display has been set to Prohibited for Reader will not 
be displayed.
If the password screen is opened and the user switches to User2 in the Operator security group, the parts for which 
Display has been set to Permitted for Operator will be displayed.

User Name

Security Group Reader Operator
User1 User2

MICRO/I

130

Numerical Display
No. Group Name Display

1 Administrator Permitted

2 Operator Permitted

3 Reader Permitted

Button
No. Group Name Display Input

1 Administrator Permitted Permitted

2 Operator Permitted Prohibited

3 Reader Prohibited Prohibited

Line Chart and Bar Chart
No. Group Name Display

1 Administrator Permitted

2 Operator Permitted

3 Reader Prohibited

Open Password Screen, 
enter password, 
and switch to User2

For User1, 
parts for which Display 
has been set to Prohibited 
for Reader are not displayed

For User2, 
parts for which Display 
has been set to Permitted 
for Operator are displayed

MICRO/I

130

MICRO/I MICRO/I

130

User1 User2

130
CAN

User Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password
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● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Used for entering comments about parts. Maximum number is 80 characters.
Example: When mousing over the Numerical Display on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.
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10.1 How the Calendar is Used

The Calendar can be used to display the date and time using the MICRO/I's clock data.

• Display the date and time

• Write 0 or 1 to a device address at the configured times

10 Calendar

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

MICRO/I

12/07 13:45

MICRO/I

ON Time : 10:00
OFF Time : 11:00

External device

09:00

10:00

11:00

0 1

10:00

01

11:00

0

09:00

Report Device Address M0

Action

Time 09:00 09:30 10:00 10:30 11:00

Write

Report Device Address 
M0 value

10 0 1 0

Write

ON Time OFF Time

When Alarm is selected for Calendar Type, you can use just the alarm function without displaying the 
clock on the screen.



10 Calendar

10-188 WindO/I-NV4 User’s Manual

10.2 Calendar Configuration Procedure

This section describes the configuration procedure for Calendars.

1 On the Home tab, in the Parts group, click Data Displays, and then click Calendar.

2 Click a point on the edit screen where you wish to place the Calendar.

3 Double-click the dropped Calendar and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.

The Trigger Condition tab and Options tab only appear in Advanced mode.
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10.3 Properties of Calendar Dialog Box

This section describes items and buttons on the properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ Calendar Type
Selects the type of Calendar from the following.

■ Clock
These options configure the type and format of the clock. These options can only be configured when Clock or Clock 
& Alarm is selected for Calendar Type.

Clock: Displays the date and time.

Alarm: Notifies by writing 1 (ON Time) or 0 (OFF Time) to a device address at the configured times without 
displaying the clock.

Clock & Alarm: Displays the clock and notifies by writing 1 (ON Time) or 0 (OFF Time) to a device address at the 
configured times.

Clock Type: Selects the items to display for the clock from the following.
Time, Day of the Week & Time, Date & Time, Date & Day of the Week & Time

Date: Selects the display type of the date from the following.
YY/MM/DD, MM/DD/YY, DD/MM/YY, MM/DD, DD/MM
This option can only be configured when Date & Time or Date & Day of the Week & Time is 
selected for Clock Type.

Year: Selects the display type for the year as Double Figures or Four Figures.
This option can only be configured when Date & Time or Date & Day of the Week & Time is 
selected for Clock Type.

Month: Selects the display type for the month as 1/2/3/... or Jan/Feb/Mar/....
This option can only be configured when Date & Time or Date & Day of the Week & Time is 
selected for Clock Type.

Time: Selects the display type for the time as HH:MM or HH:MM:SS.
HH: hours, MM: minutes, SS: seconds
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● Alarm Tab
These options can only be configured when Alarm or Clock & Alarm is selected for Calendar Type on the 
General tab.

■ Alarm Time
Selects the type of data for the alarm time.

■ (Alarm conditions)
Select the check boxes for the conditions to use as the alarm time.
The Day of the Week check box can only be configured when the Year check box is cleared.

(Alarm conditions)

Value: Specifies the alarm time as values and the day of the week.

Year: Enter the year (0 to 99).

Month: Enter the month (1 to 12).

Day: Enter the day (1 to 31).

Day of the Week: Select the day of the week.

Hour: Enter the hour (0 to 23).

Minute: Enter the minute (0 to 59).

Second: Enter the second (0 to 59).

Device Address: Configures the alarm time as values of word devices.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 
2 “5.1 Device Address Settings” on page 2-68.
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■ ON Time
Configures the time to write 1 to the Report Device Address according to the type of data.

■ OFF Time
Select this check box to configure the time to write 0 to the Report Device Address.
The time is configured according to the type of data.

■ Report Device Address
Specifies the bit device to write the value to at ON Time and OFF Time.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.

• After 1 is written to the Report Device Address with ON Time, that value is retained.

• After a screen configured with the Calendar is displayed, if the time is in between ON Time and OFF 
Time, 1 is written to the Report Device Address.

Value of device address retained after ON Time elapses

1

0

09:00 09:30 10:00 10:30 11:00

Report Device Address
M0 value

Time

ON Time

Turn on MICRO/I power
Open screen

1

0

09:00 09:30 10:00 10:30 11:00

Report Device Address
M0 value

Time

ON Time

Writes 1 to notify that ON Time has already elapsed

OFF Time

• The value of Report Device Address is retained even when the current time exceeds OFF Time.

• After a screen configured with the Calendar is displayed, if the time exceeds OFF Time, 0 is written to 
the Report Device Address.

Value of device address retained after OFF Time elapses1

0

10:00 10:30 11:00 11:30 12:00

Report Device Address
M0 value

Time

OFF Time

Turn on MICRO/I power
Open screen

Report Device Address
M0 value

1

0
Time

10:00 10:30 11:00 11:30 12:00

OFF Time

Writes 0 to notify that OFF Time has already elapsed

ON Time



10 Calendar

10-192 WindO/I-NV4 User’s Manual

● View Tab

■ Image Type
Select the type of graphic to be used to represent the part.

■ Browse
Select the type of graphic to be used to represent the part from the list of graphics. Click this button to display the 
View Browser or Picture Manager, depending on the setting for Image Type.

■ Plate Color
Selects the plate color of the standard graphic (color: 256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

■ Flange

Standard: Uses the default graphic for WindO/I-NV4.

Picture: Uses an image file saved using Picture Manager.
For details about image file restrictions, refer to Chapter 2 “1.4 Available Image Files” on page 2-20.

None: The plate and the flange of the part are not displayed. Only the text is displayed.

Plate color

Foreground Color, Background Color:

Selects the foreground and background colors of the flange of the standard graphic (color: 256 
colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

Pattern: Selects a pattern for the flange of the standard graphic.
Click Pattern to display the Pattern Palette. Select a pattern from the Pattern Palette.

Flange
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■ Coordinates

■ Size

X, Y: Sets the display position of parts using coordinates.
The X and Y coordinates of parts is defined relative to an origin at the top-left corner of the screen.

X: 0 to (base screen horizontal size - 1)

Y: 0 to (base screen vertical size - 1)

(0, 0)
X

Y
Screen

Parts

W, H: Sets width and height to define the size of parts.

W: 5 to (base screen horizontal size)

H: 5 to (base screen vertical size)

Width

Height

Screen

Parts
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● Format Tab

■ Font
Selects the font used for displaying text from the following.
Standard, Stroke, 7-Segment
The characters that can be displayed depend on the font. For details, refer to Chapter 2 “1.2 Available Text” on page 
2-6.

■ Size
When Standard is selected, selects the text size as 8x16 or 16x16.
When Stroke or 7-Segment is selected, specifies the text size (8 to 128).

■ Style
Selects Regular or Bold for text style.
Can only be set when Standard is selected for Font.

■ Magnification

Can only be set when Standard is selected for Font.

■ Align Text
Selects the text alignment in the horizontal direction from the following.
Left, Center, Right
For details, refer to Appendix “5 Text Alignment” on page A-7.

■ Text Color
Selects the color of displayed text (color: 256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

W, H: Selects text magnification (0.5, 1 to 8).
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● Trigger Condition Tab
The Trigger Condition tab is displayed in Advanced mode.

The Calendar is enabled while the condition is satisfied, and it is disabled while the condition is not satisfied. When 
disabled, the plate and flange are displayed, but the time is not displayed. However, if the Not show Calendar check 
box under While not satisfying the condition is selected, the plate and flange are also hidden and the part image 
is not displayed.

■ Trigger Type
Selects the condition to enable the Calendar from the following.

Example: When Trigger Type is While ON, Device Address is LM0, and the Not show Calendar check box 
under While not satisfying the condition is cleared
While LM0 is 0, the condition is not satisfied and the Calendar does not display the time.
While LM0 is 1, the condition is satisfied and the Calendar displays the time.

LM0:

MICRO/I

0

LM0: 1
12/07 13:45

Condition 
Not 

satisfied

Condition 
Satisfied

Show 
time

Hide 
time

Always visible: The Calendar is always enabled.

12/07 13:45

Always show time

Calendar state
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■ Data Type
Selects the data type to be handled by the condition formula.
Can only be set if While satisfying the condition is selected as Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

■ Device Address
Specifies the bit device or the bit number of the word device to serve as condition.
Can only be set if While ON or While OFF is selected as Trigger Type.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.

■ Condition
Sets the condition formula.
Can only be set if While satisfying the condition is selected as Trigger Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expression configuration 
procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-71.

■ Comment
Used for entering comments about trigger conditions. Maximum number is 80 characters.

■ Not show Calendar
When this check box is cleared, the part image is not displayed when the condition is not satisfied.

While ON: Enables the Calendar when the value of device address is 1.
Example: When the Not show Calendar check box is cleared under While not satisfying the 

condition

While OFF: Enables the Calendar when the value of device address is 0.
Example: When the Not show Calendar check box is cleared under While not satisfying the 

condition

While satisfying the condition:

Enables the Calendar when the condition is satisfied.
Example: When the Not show Calendar check box is cleared under While not satisfying the 

condition

12/07 13:45 12/07 13:45 12/07 13:45 12/07 13:45

1

0

Show timeHide time Hide time Hide timeShow time Show time Show time

Value of
Device Address

Calendar state

Value of
Device Address

1

0

Show timeHide timeShow time Show timeHide time Hide time Hide time

Calendar state
12/07 13:45 12/07 13:45 12/07 13:45

Show timeHide time Show time Hide time

12/07 13:45

Show time

12/07 13:45

Show time

12/07 13:45

Show time

12/07 13:45

Condition
Satisfied

Not satisfied

Calendar state
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● Options Tab
The Options tab is displayed in Advanced mode.

■ Place on the Top Layer
Select this check box to place the parts on the top layer. When drawings and parts overlap, those place on the top 
layer are displayed in preference. For details, refer to Chapter 6 “4 Drawings and Parts Overlapping” on page 6-5.
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● Security Tab
This tab is used to restrict displaying and using the part by security groups.
This option can only be set when Use Security functions is selected. The Use Security functions check box is set 
on General tab in the Security dialog box.

■ (Settings)
Displays the list of security groups used on the MICRO/I.

■ Security Settings
The Security Settings dialog box is displayed. If you create a security group in the Security Settings dialog box, you 
can select that created group. For details, refer to Chapter 23 “2.2 Adding and Editing Security Groups” on page 23-
19.

(Settings)

No.: Displays the security group numbers (0 to 15).

Group Name: Displays the name of the security group.

Display: Displays whether or not there is permission to display the part. Only Permitted security groups 
can display this part. If all security groups are set to Permitted, this part will be displayed even 
if no user account has been selected. Double clicking the cell switches between Permitted and 
Prohibited.

You can also switch between Permitted and Prohibited by right-clicking on a Display cell.

For details about security functions, refer to Chapter 23 “User Accounts and the Security Function” on page 
23-1.
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Example: If the user and security group for a part are set as follows:

For User1 in the Reader security group, the parts for which Display has been set to Prohibited for Reader will not 
be displayed.
If the password screen is opened and the user switches to User2 in the Operator security group, the parts for which 
Display has been set to Permitted for Operator will be displayed.

User Name

Security Group Reader Operator
User1 User2

MICRO/I

130

Numerical Display
No. Group Name Display

1 Administrator Permitted

2 Operator Permitted

3 Reader Permitted

Button
No. Group Name Display Input

1 Administrator Permitted Permitted

2 Operator Permitted Prohibited

3 Reader Prohibited Prohibited

Line Chart and Bar Chart
No. Group Name Display

1 Administrator Permitted

2 Operator Permitted

3 Reader Prohibited

Open Password Screen, 
enter password, 
and switch to User2

For User1, 
parts for which Display 
has been set to Prohibited 
for Reader are not displayed

For User2, 
parts for which Display 
has been set to Permitted 
for Operator are displayed

MICRO/I

130

MICRO/I MICRO/I

130

User1 User2

130
CAN

User Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password
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● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Used for entering comments about parts. Maximum number is 80 characters.
Example: When mousing over the Calendar on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.
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This chapter describes how to configure charts and meters and their operation on the MICRO/I.

  

1.1 How the Bar Chart is Used

Bar charts and peak charts can be used to display word device values.

• Display word device values in a bar chart

• Display word device values in a peak chart

• Make the chart flash when the displayed data exceeds the maximum or minimum

Chapter 11 Charts

1 Bar Chart

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

External device
MICRO/I

D100 : -50

D200 : 120

D300 : 40

External device
MICRO/I

D100 : -50

D200 : 120

D300 : 40

External device
MICRO/I

Range: Value
Minimum : 0
Maximum : 100
When Data Over
   Flash: Selected

D100 : 20

D200 : 80

D300 : 40

D100 : -50

D200 : 90

D300 : 120
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1.2 Bar Chart Configuration Procedure

This section describes the configuration procedure for bar charts.

1 On the Home tab, in the Parts group, click Charts, and then click Bar Chart.

2 Click a point on the edit screen where you wish to place the Bar Chart.

3 Double-click the dropped Bar Chart and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.

The Data Over tab, Scale tab, Label tab, Trigger Condition tab and Options tab only appear in 
Advanced mode.
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1.3 Properties of Bar Chart Dialog Box

This section describes items and buttons in the Properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ Chart Type
Selects the type of chart from the following items.
Horizontal Bar, Vertical Bar, Horizontal Peak, Vertical Peak
Peak charts only display the tip of the bar chart.

Horizontal Bar Horizontal Peak
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■ Data Format

■ Reverse axis
Select this check box to flip the axis of the graph.

Horizontal chart (Horizontal Bar, Horizontal Peak):

Vertical chart (Vertical Bar, Vertical Peak):

*1 Advanced mode only

Data Type: Selects the data type handled by the chart from the following.
UBIN16(W), BIN16(I), UBIN32(D), BIN32(L), BCD4(B), BCD8(EB), Float32(F)
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Origin, Minimum, Maximum: Specifies the origin, minimum, and maximum for the chart.

(Data Type)*1: Selects the data type to use for the Origin, Minimum, and Maximum.

Value: Uses a constant value.

Device Address: Uses a value of device address.

The origin, minimum, and maximum that can be specified during Basic mode and when 
Value is selected vary based on the data type. For details, refer to Chapter 2 “1.1 
Available Data” on page 2-1.
When Device Address is selected, these options specify the source word devices.

Click  to display the Tag Editor. For the device address configuration procedure, refer 
to Chapter 2 “5.1 Device Address Settings” on page 2-68.

If the data displayed in the chart is invalid, 1 is written to System Area 2 Processing error bit (address 
number+2, bit 5), and an error message is displayed. For details, refer to Chapter 4 “Processing error” on 
page 4-32 and Chapter 36 “Processing error” on page 36-3. 
An error occurs in the following states:
• The setting of Origin, Minimum, or Maximum are invalid, or the Minimum and Maximum are the 

same values.
• Data Type is BCD4(B), BCD8(EB), or Float32(F) and the value cannot be expressed with the data 

type selected for the read data
The chart cannot be displayed when an error has occurred. 

Even if the value of device address is changed while the trigger condition is not satisfied, the minimum and 
maximum are not updated.

Check box: Cleared Check box: Selected

Direction of graph: From left to right Direction of graph: From right to left

Check box: Cleared Check box: Selected

Direction of graph: From bottom to top Direction of graph: From top to bottom

50 1000 50 0100

50

0

100

50

100

0
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● Data Tab

■ Number of Data
Specifies the number of data to be displayed in the chart(1 to 10).

■ Settings
Lists the chart settings. The list shows the numbers, source device addresses, and colors for the chart.

*1 Advanced mode only

No.: Shows the numbers for the chart (Ch1 to Ch10).
For Horizontal Bar and Horizontal Peak, the numbers are listed in order from top. For Vertical 
Bar and Vertical Peak, the numbers are listed in order from the left.

Device Address: Specifies the source word device for the data to display in the chart.
Double clicking the cell displays the Tag Editor where you can edit the device address. For the device 
address configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-68

Fg. Normal: Selects the foreground color of the chart when normal. (color: 256 colors, monochrome: 16 shades)
Double clicking the cell displays the Color Palette where you can change the foreground color of the 
chart when normal.

Fg. Over*1: Selects the foreground color of the chart when data over. (color: 256 colors, monochrome: 16 shades)
Double clicking the cell displays the Color Palette where you can change the foreground color of the 
chart when data over.

Horizontal Bar

Ver�cal Bar

Ch1

Ch1 Ch2 Ch3

Ch2

Ch3
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■ Remove
Deletes the registered settings from the list.

■ Up
Shifts the selected settings upward in the list.

■ Down
Shifts the selected settings downward in the list.

*1 Advanced mode only

Bg. Normal: Selects the background color of the chart when normal. (color: 256 colors, monochrome: 16 shades)
Double clicking the cell displays the Color Palette where you can change the background color of the 
chart when normal.

Bg. Over*1: Selects the background color of the chart when data over. (color: 256 colors, monochrome: 16 shades)
Double clicking the cell displays the Color Palette where you can change the background color of the 
chart when data over.

Pattern: Selects the chart pattern or tonal gradation.
Double clicking the cell displays the Pattern Palette where you can change the chart pattern or tonal 
gradation.
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● View Tab

■ Image Type
Select the type of graphic to be used to represent the part.

■ Browse
Select the type of graphic to be used to represent the part from the list of graphics. Click this button to display the 
View Browser.

■ Plate Color
Selects the plate color of the standard graphic (color: 256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

■ Flange

Standard: Uses the default graphic for WindO/I-NV4.

None: The plate and the flange of the part are not displayed.

Plate color

Foreground Color, Background Color: Selects the foreground and background colors of the flange of the standard 
graphic (color: 256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

Pattern: Selects a pattern for the flange of the standard graphic.
Click Pattern to display the Pattern Palette. Select a pattern from the Pattern 
Palette.

Flange
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■ Space between Bars*1

Specifies the spacing for the bar chart (0 to 100 dots).

■ Coordinates

■ Size

*1 Advanced mode only

Example: If Space between Bars is 10 If Space between Bars is 0

Chart spacing

Chart spacing

Chart spacing

Chart spacing

Chart spacing

Chart spacing
100 2000

Scale not shown Show scale

10 dots

10 dots

10 dots

X, Y: Sets the display position of parts using coordinates.
The X and Y coordinates of parts are defined relative to an origin at the top-left corner of the screen.

X: 0 to (base screen horizontal size - 1)

Y: 0 to (base screen vertical size - 1)

(0, 0)
X

Y
Screen

Parts

W, H: Sets width and height to define the size of parts.

W: 5 to (base screen horizontal size)

H: 5 to (base screen vertical size)

Width

Height

Screen

Parts
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● Data Over Tab
The Data Over tab is displayed in Advanced mode.

■ Range
Select data type.

Specifies the allowable range of values to display.

Value: Specifies the minimum and/or the maximum as a constant.

Device Address: Specifies the minimum and/or the maximum as a word device value.

Minimum, Maximum: Select these check boxes to specify the minimum and/or maximum.
The minimum and maximum that can be specified when Value is selected vary based on the 
data type selected with Data Format on the General tab. For details on data types, refer to 
Chapter 2 “1.1 Available Data” on page 2-1.
When Device Address is selected, these options specify the source word devices.

Click  to display the Tag Editor. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-68.
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■ When Data Over
These options configure the operation of the part when the allowable range is exceeded.
These options can only be configured when the Minimum or Maximum check boxes are selected under Range.

Example: If the word device value of the reading source is “110” which is higher than the upper limit of “100” ,or 
“-10” which is below the lower limit of “0”, a value of 1 will be written to LM0 and the displayed bar will 
flash.

Flash: Select this check box to make the chart flash when the displayed data exceeds the allowable range.

Report: Select this check box to write 1 in the Report Device Address when the displayed data exceeds the 
allowable range.

Report Device Address: Specifies the Report Device Address.

Click  to display the Tag Editor. For the device address configuration 
procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-68.

Ch1 data 60

Ch2 data

Ch1
Ch2

10

10 0 1

Display

20

110

50

80

10 -10

Flashing Flashing

Range: Value

   Minimum: 0

   Maximum: 100

When Data Over

   Flash: Selected

   Report: Selected

Report Device Address: LM0

Data over notification: LM0

100500 100500 100500 100500
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● Scale Tab
The Scale tab is displayed in Advanced mode.

The options on the Scale tab vary based on the type selected with Chart Type on the General tab.
Horizontal Bar, Horizontal Peak: X-Axis
Vertical Bar, Vertical Peak: Y-Axis

■ Show Ticks
Select this check box to display a scale on a chart.

Major Divisions: Enter the number of major scale divisions (1 to 20).
Minor Divisions: Enter the number of minor scale divisions (1 to 20).
Color: Selects the color of scales (color: 256 colors, monochrome: 16 shades).

Click Color to display the Color Palette. Select a color from the Color Palette.
Show Tick Numbers: Select this check box to display numbers along the scale.

Digits: Sets the number of digits to be displayed (1 to 10).
Can only be set when Float32(F) is selected for Data Type under the 
General tab.

Display Floating Point: Select this check box to display a floating point along the scale.
Can only be set when Float32(F) is selected for Data Type under the 
General tab.

Floating Digits: Sets the number of digits for the fractional parts of numbers (1 to 8) 
from the number of digits specified for Digits.
Can only be set when the Display Floating Point check box is selected.

Font: Selects the font used for displayed text from the following.
Standard, Stroke, 7-Segment
The characters that can be displayed depend on the font. For details, 
refer to Chapter 2 “1.2 Available Text” on page 2-6.

Style: Selects Regular or Bold for the character style to be displayed.
Can only be set when Standard is selected for Font.

Magnification W, H: Selects magnification (0.5, 1 to 8) for the displayed text.
Can only be set when Standard is selected for Font.

Size: Sets character size (8 to 128) for displayed text.
Can only be set when Stroke or 7-Segment is selected for Font.

Color: Selects the color of displayed text (color: 256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

If the area for displaying the scale is small, the scale will not be displayed properly.
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■ Show Gridline
Select this check box to display grid lines on the chart. Grid lines are displayed above the chart. Can only be set when 
the Show Ticks check box is selected.

Display Position: Select from Scale and Data Over to specify the grid line display position.
Scale: Grid lines are displayed according to the number of major scale divisions.

Data Over: Grid lines are displayed at the positions of values specified for Maximum and 
Minimum under the Data Over tab.

Line Type: Selects the type of grid lines from the following.
Solid, Dot, Dash, Long Dash, Long Dash Dot, Long Dash Dot Dot

Color: Specifies grid line color (color: 256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

Grid line

MaximumMinimum
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● Label Tab
The Label tab is only displayed in Advanced mode.

■ Show Label for X-Axis, Show Label for Y-Axis
Select this check box to display a label on X-axis and Y-axis scales.
The options on the Label tab vary based on the type selected with Chart Type on the General tab.
Horizontal Bar, Horizontal Peak: Show Label for X-Axis
Vertical Bar, Vertical Peak: Show Label for Y-Axis

■ Use Text Manager
Select this check box if using the text registered in Text Manager for labels. Can only be set when the Show Label 
for X-Axis or Show Label for Y-Axis check box is selected.

Font: Selects the font for text used in labels from the following.
Japanese, European, Chinese, Taiwanese, Korean, Central European, Baltic, Cyrillic
Can only be set when the Use Text Manager check box is cleared.
The characters that can be displayed depend on the font. For details, refer to Chapter 2 “1.2 Available 
Text” on page 2-6.

Text ID: Specifies the Text Manager ID No. (1 to 32000) when text registered in the Text Manager are used for 
labels.

Click  to display Text Manager.
Can only be set when the Use Text Manager check box is selected.

Text: Inputs characters to be displayed for labels. Maximum number is 40 characters.
The characters that can be entered depend on the font selected using Font. For details, refer to Chapter 2 
“1.2 Available Text” on page 2-6.
Can only be input when the Use Text Manager check box is cleared.

Color: Selects the color of the text used for labels (color: 256 colors, monochrome: 16 shades).
Click Color to open the Color Palette. Select a color from the Color Palette.

If the area for displaying the label is too small, the label will not be displayed properly.

If a carriage return (CR) is included, the characters after the CR are not displayed. However, if Windows 
Font is set for the specified Text ID, all the characters are displayed.
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● Trigger Condition Tab
The Trigger Condition tab is displayed in Advanced mode.

The bar chart is enabled while the condition is satisfied, and it is disabled while the condition is not satisfied. Select 
the operation when the condition is not satisfied as Not display Chart data or Not update Chart data under 
While not satisfying the condition.
Example: When Trigger Type is While ON, Device Address is LM0, and While not satisfying the condition is Not 

display Chart data
While LM0 is 0, the condition is not satisfied and the bar chart is not displayed.
While LM0 is 1, the condition is satisfied and the bar chart is displayed.

■ Trigger Type
Selects the condition to enable the bar chart from the following.

LM0:

MICRO/I

Condi�on 
Not 

sa�sfied

0

LM0:
Condi�on 
Sa�sfied

1
Show chart

Hide chart

100500

100500

Data over does not operate for hidden bar charts. Data over is reported if the minimum or maximum is 
exceeded when the bar chart changes from hidden to displayed.

Always visible: The bar chart is always enabled.

Ch1 data 50

Ch2 data

Display

10

60

30

70

50

80

70

90

90

Update Update Update Update Update

100500 100500 100500 100500 100500
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■ Data Type
Selects the data type to be handled by the condition formula.
Can only be set if While satisfying the condition is selected as Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

■ Device Address
Specifies the bit device or the bit number of the word device to serve as condition.
Can only be set if While ON or While OFF is selected as Trigger Type.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.

■ Condition
Sets the condition formula.
Can only be set if While satisfying the condition is selected as Trigger Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expression configuration 
procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-71.

While ON: Enables the bar chart when the value of device address is 1.
Example: When While not satisfying the condition is Not update Chart data

While OFF: Enables the bar chart when the value of device address is 0.
Example: When While not satisfying the condition is Not update Chart data

While satisfying the condition: Enables the bar chart when the condition is satisfied.
Example: When While not satisfying the condition is Not update Chart data

Value of
device address

1

0

Ch1 data 50

Ch2 data

Display
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Update
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Update

80
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Update

90

90

Do not update Do not update

100500 100500 100500 100500 100500
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Update

Ch1 data 50
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Ch1 data 50
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Not sa�sfied
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■ Comment
Used for entering comments about trigger conditions. Maximum number is 80 characters.

■ While not satisfying the condition
Selects operation of the Bar Chart when condition is not satisfied.

Not display Chart data: The plate and flange are displayed, but Bar Chart is not displayed.

Not update Chart data: The last updated Bar Chart is displayed. The Bar Chart does not change.
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● Options Tab
The Options tab is displayed in Advanced mode.

■ Place on the Top Layer
Select this check box to display the parts on the top layer. The parts will have precedence when other drawings and 
parts are overlapping with it. For details, refer to Chapter 6 “4 Drawings and Parts Overlapping” on page 6-5.
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● Security Tab
This tab is used to restrict displaying and using the part by security groups.
This option can only be set when Use Security functions is selected. The Use Security functions check box is set 
on General tab in the Security dialog box.

■ (Settings)
Displays the list of security groups used on the MICRO/I.

■ Security Settings
The Security Settings dialog box is displayed. If you create a security group in the Security Settings dialog box, you 
can select that created group. For details, refer to Chapter 23 “2.2 Adding and Editing Security Groups” on page 23-
19.

(Settings)

No.: Displays the security group numbers (0 to 15).

Group Name: Displays the name of the security group.

Display: Displays whether or not there is permission to display the part. Only Permitted security groups 
can display this part. If all security groups are set to Permitted, this part will be displayed even 
if no user account has been selected. Double clicking the cell switches between Permitted and 
Prohibited.

You can also switch between Permitted and Prohibited by right-clicking on a Display cell.

For details about security functions, refer to Chapter 23 “User Accounts and the Security Function” on page 
23-1.
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Example: If the user and security group for a part are set as follows:

For User1 in the Reader security group, the parts for which Display has been set to Prohibited for Reader will not 
be displayed.
If the password screen is opened and the user switches to User2 in the Operator security group, the parts for which 
Display has been set to Permitted for Operator will be displayed.

User Name

Security Group Reader Operator
User1 User2

MICRO/I

130

Numerical Display
No. Group Name Display

1 Administrator Permitted

2 Operator Permitted

3 Reader Permitted

Button
No. Group Name Display Input

1 Administrator Permitted Permitted

2 Operator Permitted Prohibited

3 Reader Prohibited Prohibited

Line Chart and Bar Chart
No. Group Name Display

1 Administrator Permitted

2 Operator Permitted

3 Reader Prohibited

Open Password Screen, 
enter password, 
and switch to User2

For User1, 
parts for which Display 
has been set to Prohibited 
for Reader are not displayed

For User2, 
parts for which Display 
has been set to Permitted 
for Operator are displayed

MICRO/I

130

MICRO/I MICRO/I

130

User1 User2

130
CAN

User Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password
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● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Used for entering comments about parts. Maximum number is 80 characters.
Example: When mousing over the bar chart on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.
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2.1 How the Line Chart is Used

The line chart can be used to display values of device addresses sampled with the Data Log function and the values of 
multiple word devices.

• Display the values of device addresses sampled with the Data Log function in a trend chart

• Display the values of multiple, continuous device addresses in a single line chart

• Display the cursor and the date and time at the cursor

2 Line Chart

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

External device
MICRO/I
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70

70

90
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30

40

40

50

70

D102

10

10

20

10

10 0

20

40

60

80

100

-20

0

20

40

60

80

100

-20

• There are two types of trend charts, a normal trend chart and a pen recorder trend chart.
• If the Data Log data displayed in the chart is deleted, the chart display is erased.

External device
MICRO/I

D100 : 1

D101 : 5

D102 : 10

D103 : 50

D104 : 20

D105 : 60

D106 : 10

0

20

40

60

80

100

-20

External device
MICRO/I

11/10/01
12:01:30

Cursor

Date and time 
at the cursor
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2.2 Line Chart Configuration Procedure

This section describes the configuration procedure for Line Charts.

1 On the Home tab, in the Parts group, click Charts, and then click Line Chart.

2 Click a point on the edit screen where you wish to place the Line Chart.

3 Double-click the dropped Line Chart and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.
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2.3 Properties of Line Chart Dialog Box

This section describes items and buttons in the Properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ Chart Type
Selects the type of chart from the following.

Log Trend (Normal): Shows values of device addresses sampled with the Data Log function in a trend 
chart. The displayed chart is updated each time the latest data is sampled and the 
latest data is charted from the left edge. If the sampled data exceeds the number of 
display points, the entire chart is shifted to the left by the configured scroll size and 
the display is updated.
Example: Display Points on the X-Axis tab is 5 and Number of automatic 

scrolls when updating display is 1:
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Ch2 data 10
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Example: When the start address number is D100
The display updates when the value of D100 changes from 0 to 1. The display is erased when the value 
changes to 2. The display is first erased and then updated when the value changes to 3.

Log Trend (Pen Recorder): Shows values of device addresses sampled with the Data Log function in a trend 
chart. The displayed chart is updated each time the latest data is sampled and the 
latest data is always displayed at the right edge. The entire chart shifts to the left 
point by point and the display is updated.
Example: Display Points on the X-Axis tab is 5:

Scroll, 
display point 6Display point 1 Display point 2 Display point 3 Display point 4 Display point 5
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To display multiple items of data, set the sampling conditions and data size for the data to display to the 
same settings. The data cannot be displayed if its sampling conditions or data size is different.

The chart can display a maximum of 20 lines.

Device Address Display: Display the values of multiple, continuous device addresses as a single line chart. The 
data size for the device addresses is 16 bits.
Updating and erasing the display is controlled by the lower 2 bits of the start address 
number value (control status) of the continuous device addresses.
The number of values of device addresses to display is specified by the value of start 
address number + 1.
The values of device addresses from start address number + 2 are displayed on the 
chart.

Number of display 

points changed

Number of display 

points changed

Operation

(Start address number +2) D102 value
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If there are many items of data to display, it may take some time to update the display.
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■ Restart Chart
Select this check box to display the chart from the beginning when switching screens.
This option can only be configured when Log Trend (Normal) or Log Trend (Pen Recorder) is selected for Chart 
Type.

MICRO/I MICRO/I MICRO/I

1234

0
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40
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80

100

-20
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60

80

100

-20

Switch screen Switch screenBase screen 1 Base screen 1Base screen 2

Display chart 
from beginning
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● View Tab

■ Image Type
Select the type of graphic to be used to represent the part.

■ Browse
Select the type of graphic to be used to represent the part from the list of graphics. Click this button to display the 
View Browser.

■ Plate Color
Selects the plate color of the standard graphic (color: 256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

■ Flange

Standard: Uses the default graphic for WindO/I-NV4.

None: The plate and the flange of the part are not displayed.

Plate color

Foreground Color, Background Color: Selects the foreground and background colors of the flange of the standard 
graphic (color: 256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

Pattern: Selects a pattern for the flange of the standard graphic.
Click Pattern to display the Pattern Palette. Select a pattern from the Pattern 
Palette.

Flange
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■ Coordinates

■ Size

X, Y: Sets the display position of parts using coordinates.
The X and Y coordinates of parts are defined relative to an origin at the top-left corner of the screen.
X: 0 to (base screen horizontal size - 1)
Y: 0 to (base screen vertical size - 1)

(0, 0)
X

Y
Screen

Parts

W, H: Sets width and height to define the size of parts.
W: 5 to (base screen horizontal size)
H: 5 to (base screen vertical size)

Width

Height

Screen

Parts
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● X-Axis Tab

■ Display Points
Specifies the maximum number of points of data to display on the chart (2 to 65535).
This option can only be configured when Log Trend (Normal) or Log Trend (Pen Recorder) is selected for Chart 
Type.

(Data Type): Selects the data type to use with the display points.

Value: Uses a constant value.

Device Address: Uses a value of device address.

(Display points): Specifies the maximum number of points (2 to 65535) for the data to be displayed on the chart. 
The handled data type is UBIN16(W) only.
When Device Address is selected for (Data Type), the display points can be specified in the word 
device.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 
2 “5.1 Device Address Settings” on page 2-68.

• The maximum number of data that can be displayed is the number of dots on the X-axis of the graph 
(the horizontal size of the area displaying the graph). When setting the value exceeding the number of 
dots on the X-axis as the Display Points, thinned out data is displayed.

• If the value of the device address is smaller than 2 (minimum value), then the number of data points to 
display remains at 2.

• When the value of device address changes, the chart display is updated. At this time, chart data not 
saved to the data storage area is not displayed.

• Even if the value of device address is changed while the trigger condition is not satisfied, the chart 
display is not updated.
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■ Number of automatic scrolls when updating display

Specifies the number of points of data to scroll when updating the chart display (1 to Screen size (Horizontal)).
This option can only be configured when Log Trend (Normal) is selected for Chart Type.

Example: When Display Points is 5 and Scroll Size is 3

(Data Type): Selects the data type to use with the scroll size.

Value: Uses a constant value.

Device Address: Uses a value of device address.

(Scroll size): Specifies the number of points of data to scroll (1 to Screen size (Horizontal)). The handled data type is 
UBIN16(W) only.
When Device Address is selected for (Data Type), the scroll size can be specified in the word device.

Click  to display the Tag Editor. For the device address
configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-68.

• If the value of the device address is smaller than 1 (minimum value), then the Number of automatic 
scrolls remains at 1. If the value is larger than Display Points, then Scroll Size is the value of Display 
Points.

• When the value of Display Points is larger than the number of dots on the X-axis (the horizontal size of 
the area displaying the graph), scroll the chart by the number of dots specified in Number of 
automatic scrolls when updating display.
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■ Display of the saved data

This option can only be configured when Log Trend (Normal) or Log Trend (Pen Recorder) is selected from 
Chart Type on the General tab. 

Stop updating the display and display the saved data:

To scroll the chart to display past data and to display the cursor, the chart display updating must be stopped. To 
control updating the display, select this check box and specify the bit device or the bit number of the word device 
to control the display.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.
Display updating stops when the value of device address changes from 0 to 1. Display updating restarts when the 
value of device address changes from 1 to 0.

When displaying a line graph using a file (.BIN) saved in external memory, the data on a channel that does 
not have a BIN file will not be displayed. For details about the BIN file, refer to Chapter 14 “Save the data 
of Data Log and display in Line Chart” on page 14-24.

Right Scroll Device Address, Left Scroll Device Address:

The chart can be scrolled to the right or to the left when display updating is stopped. This option specifies the bit 
device or the bit number of the word device to scroll the chart left or right.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.
The chart scrolls right or left one point of data each time the value of device address changes from 0 to 1.
These options can only be configured when the Stop updating the display and display the saved data check 
box is selected.
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Scroll right 
1 data point

Stop updating

Scroll right 
1 data point

Scroll right 
1 data point

Stop updating, 
then scroll right 

3 data points

When the value of Display Points is larger than the number of dots on the X-axis (the horizontal size of 
the area displaying the graph), scroll the chart by the number of dots specified in Number of Scroll.



WindO/I-NV4 User’s Manual 11-31

2 Line Chart

11

Charts

Number of Scroll:

Specifies the number of points of data to scroll the chart left or right (1 to the Screen size (Horizontal)) when 
stopping the chart display.
This option can only be configured when the Stop updating the display and display the saved data check 
box is selected.

Specify by Device Address: Select this check box and specify a source word device to specify the Number of 
Scroll using the value of the specified device address.

Click  to display the Tag Editor. For the device address configuration procedure, 
refer to Chapter 2 “5.1 Device Address Settings” on page 2-68.
When MICRO/I starts operation, it copies the value of Number of Scroll as the 
initial value to the device address.

Display data from specified date: When stopping the chart display, to display the chart with the specified Start 
Date as the left end, select this check box and specify the bit device or the bit 
number of the word device to control the display.

Click  to display the Tag Editor. For the device address configuration procedure, 
refer to Chapter 2 “5.1 Device Address Settings” on page 2-68.
Displays the chart for Display Points with Start Date as the left end when the 
value of device address changes from 0 to 1.

Start Date and Time: Specifies the Start Date as the values of word devices for the data to display in the 
chart.

Click  to display the Tag Editor. For the device address configuration procedure, 
refer to Chapter 2 “5.1 Device Address Settings” on page 2-68.
For address number assignment, refer to “Specifying Date and Time with Values of 
device addresses” on page 11-33.
This option can only be configured when Display data from specified date 
check box is selected.

Specify displaying period: To specify the range of data displayed on the chart, select this check box and 
specify the bit device or the bit number of the word device to control the display.

Click  to display the Tag Editor. For the device address configuration procedure, 
refer to Chapter 2 “5.1 Device Address Settings” on page 2-68.
Displays the chart from Start Date as the left end to End Date when the value of 
device address changes from 0 to 1.
This option can only be configured when Display data from specified date 
check box is selected.

End Date and Time: Specifies the End Date for the data to display in the chart.

Click  to display the Tag Editor. For the device address configuration procedure, 
refer to Chapter 2 “5.1 Device Address Settings” on page 2-68.
For address number assignment, refer to “Specifying Date and Time with Values of 
device addresses” on page 11-33.

• The maximum number of data that can be displayed is the number of dots on the X-axis of the graph 
(the horizontal size of the area displaying the graph). When the number of data from Start Date to End 
Date exceeds the number of dots on the X-axis, thinned out data is displayed.

• If Start Date and End Date are the same or End Date is earlier than Start Date, the chart display 
will not be updated.
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Display cursor: Select this check box and specify the bit device or the bit number of 
the word device to display the cursor.

Click  to display the Tag Editor. For the device address 
configuration procedure, refer to Chapter 2 “5.1 Device Address 
Settings” on page 2-68.
Displays the cursor when the value of device address changes from 0 
to 1.
The functions related to the cursor, such as cursor style and display 
position control, can be set on the Date and Time (Cursor) tab.
This option can only be configured when the Stop updating the 
display and display the saved data check box is selected.

Jump to the specified date and time: To display the cursor and the data of the specified date and time at 
the center of the chart, specify the bit device or the bit number of 
the word device to control the display.

Click  to display the Tag Editor. For the device address 
configuration procedure, refer to Chapter 2 “5.1 Device Address 
Settings” on page 2-68.
Display the chart with the data of the specified date and time as the 
center when the value of device address changes from 0 to 1.

Date and Time: Specify the date and time of the data to display the center of the 
chart.

Click  to display the Tag Editor. For the device address 
configuration procedure, refer to Chapter 2 “5.1 Device Address 
Settings” on page 2-68.
For address number assignment, refer to “Specifying Date and Time 
with Values of device addresses” on page 11-33.

• If there is not enough data to center the data for the specified date and time, the oldest or latest data is 
displayed.

• When the specified date and time is older than the oldest data, the oldest data is displayed on the left 
side of the chart.

• When the specified date and time is newer than the newest data, the newest data is displayed on the 
right side of the chart.

• In the following situations, the cursor does not move to the specified date and time even if the value of 
device address configured in Jump to the specified date and time becomes 1, 
- Trigger Condition is not satisfied.
- The specified date and time are invalid.
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Specifying Date and Time with Values of device addresses
Using this option requires the sequential address number of 6 words starting from the specified device address. The 
data is handled as BCD values   in the order of year, month, day, hour, minute, and second.
Example: Top Device Address is LDR100, and the date and time is October 1 2018 12:01:30.

■ Scale

■ Label

Read source Date and time data

(the address number of Top Device Address) LDR 100 2018 (Year)

+1 LDR 101 10 (Month)

+2 LDR 102 1 (Day)

+3 LDR 103 12 (Hour)

+4 LDR 104 1 (Minute)

+5 LDR 105 30 (Second)

Show Ticks: Select this check box to display a scale on a X-axis.
Major Divisions: Enter the number of major scale divisions (1 to 20).
Minor Divisions: Enter the number of minor scale divisions (1 to 20).
Color: Selects the color of scales (color: 256 colors, monochrome: 16 shades).

Click Color to display the Color Palette. Select a color from the Color 
Palette.

If the area for displaying the scale is small, the scale will not be displayed properly.

Show Label: Select this check box to display a label on X-axis scales.
Use Text Manager: Select this check box if using the text registered in Text Manager for labels. Can 

only be set when the Show Label check box is selected.

If a carriage return (CR) is included in the character displayed on the label, the characters after the CR are 
not displayed. However, if Windows Font is set for the specified Text ID, all the characters are displayed.
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Font: Selects the font for text used in labels from the following.
Japanese, European, Chinese, Taiwanese, Korean, Central European, 
Baltic, Cyrillic
Can only be set when the Use Text Manager check box is cleared.
The characters that can be displayed depend on the font. For details, refer to 
Chapter 2 “1.2 Available Text” on page 2-6.

Text ID: Specifies the Text Manager ID No. (1 to 32000) when text registered in the Text 
Manager are used for labels.

Click  to display Text Manager.

Can only be set when the Use Text Manager check box is selected.
Text: Inputs characters to be displayed for labels. Maximum number is 40 characters.

The characters that can be entered depend on the font selected using Font. For 
details, refer to Chapter 2 “1.2 Available Text” on page 2-6.
Can only be input when the Use Text Manager check box is cleared.

Color: Selects the color of the text used for labels (color: 256 colors, monochrome: 16 
shades).
Click Color to open the Color Palette. Select a color from the Color Palette.

If the area for displaying the label is too small, the label will not be displayed properly.
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● Y-Axis Tab

■ Number of Axes
Specifies the number of Y-axis (1 to 4*1).
Example: Display sample when Number of Axes is configured to 4

■ (Y-Axis)
The number of Y-axis specified by Number of Axes is displayed. Configures the graph displayed on the selected Y-

axis with Data Format, Channel Settings*2, Data*3, Data Over, Scale, Label.

*1 When Chart Type is configured to Device Address Display on the General tab, 1 is configured.
*2 This option can only be configured when Log Trend (Normal) or Log Trend (Pen Recorder) is selected from Chart 

Type on the General tab.
*3 This option can only be configured when Device Address Display is selected from Chart Type on the General tab. 
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No.: Displays the number of Y-axis (1 to 4*1).

Name: Enter the name of Y-axis. The maximum number is 40 characters.

Up: Shifts the selected Y-axis upward in the list.

Down: Shifts the selected Y-axis downward in the list.
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■ Data Format

■ Channel Settings*2

*2 This option can only be configured when Log Trend (Normal) or Log Trend (Pen Recorder) is selected from Chart 
Type on the General tab.

Data Type: Selects the data type handled by the chart from the following.
UBIN16(W), BIN16(I), UBIN32(D), BIN32(L), BCD4(B), BCD8(EB), Float32(F)
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Minimum, Maximum: Specifies the minimum and maximum for the chart.

(Data Type): Selects the data type to use for the minimum and the maximum.

Value: Uses a constant value.

Device Address: Uses a value of device address.

The minimum and maximum vary based on the selected data type. For details, refer to Chapter 
2 “1.1 Available Data” on page 2-1.
When Device Address is selected for (Data Type), the minimum and maximum can be 
specified in the word device.

Click  to display the Tag Editor. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-68.

If the data displayed in the chart is invalid, 1 is written to System Area 2 Processing error bit (address 
number+2, bit 5), and an error message is displayed. If Chart Type is Device Address Display, a 
processing error occurs when the chart is initially displayed, when the display is updated, and when it is 
erased. For details, refer to Chapter 4 “Processing error” on page 4-32 and Chapter 36 “Processing error” 
on page 36-3. 
An error occurs in the following states:
• The setting of Origin, Minimum, or Maximum are invalid, or the Minimum and Maximum are the 

same values.
• Data Type is BCD4(B), BCD8(EB), or Float32(F) and the value cannot be expressed with the data 

type selected for the read data
The chart cannot be displayed when an error has occurred. 

• If the Chart Type is selected as Log Trend (Normal) or Log Trend (Pen Recorder), the chart 
display is updated when a value of device address is changed. At this time, chart data not saved to the 
data storage area is not displayed.

• If the Chart Type is selected as Device Address Display, the minimum and maximum are updated 
when the display is updated or erased.

• Even if the value of device address is changed while the trigger condition is not satisfied, the minimum 
and maximum are not updated.

No.: Shows the numbers for the chart (Ch1 to Ch20).

Channel No.: Specifies the Data Log channel number to display on the chart (1 to 20).
Double clicking the cell allows you to edit the channel number.

If the Condition of Writing to Data Storage Area or the amount of log data saved in the data storage area is 
different from other channels, the chart cannot be displayed. Use the channel data which have the same 
settings of other channels.
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Data No.: Out of the data contained in the selected Data Log channel number, specifies the data number to 
display on the chart (1 to 128).
Double clicking the cell allows you to edit the data number.

Line Type: Selects the type of line from the following.
Solid, Dot, Dash, Long Dash, Long Dash Dot, Long Dash Dot Dot
Double clicking the cell allows you to change the chart line type.

Line Size: Selects the line size from the following.
1 dot, 2 dots, 3 dots, 5 dots
Double clicking the cell allows you to change the chart line size.

Line Color: Selects the line color for the chart (color: 256 colors, monochrome: 16 shades).
Double clicking the cell displays the Color Palette where you can change the chart line color.

You can register the settings from arbitrary numbers, they are aligned filled from the beginning after clicking 
OK on the dialog box. Therefore, when the Properties dialog box is closed and reopened, the list is 
displayed filled from the beginning.

Trigger Type: Always visible: Always display the graph.

While ON: The graph is displayed when the value of device address is 1.

Device Address: Specifies the bit device or the bit number of the word device to serve as condition.
Can only be set if While ON or While OFF is selected as Trigger Type.

Click  to display the Tag Editor. For the device address configuration procedure, 
refer to Chapter 2 “5.1 Device Address Settings” on page 2-68.

Add: Adds a channel to the list. Up to 20 channels total for all Y-axis.

Up: Shifts the selected settings upward in the list.

Down: Shifts the selected settings downward in the list.

Remove: Deletes the selected contents from the list.

Data Log Settings: Displays the Data Log Settings dialog box where you can configure the channel 
while checking the data to display. 
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■ Data*3

*3 This option can only be configured when Device Address Display is selected from Chart Type on the General tab. 

Reference Device Address:

Specifies the start address number of the data to display on the chart.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 
Device Address Settings” on page 2-68.
The data size for the device addresses is 16 bits.
Updating and erasing the display is controlled by the lower 2 bits of the start address number value 
(control status).

The number of values of device addresses to display is specified by the value of start address number + 1.
The values of device addresses from start address number + 2 are displayed on the chart.
Example: If Reference Device Address is set to D100, continuous device addresses are used starting 

from D100. The used device addresses are as follows.

Line Type: Specifies the type of line. You can also specify it using the value of device address.

Value: Selects the type of line from the following.
Solid, Dot, Dash, Long Dash, Long Dash Dot, Long Dash Dot Dot

Device Address: Specifies the line type using the value of device address.

Click  to display the Tag Editor. For the device address configuration procedure, refer 
to Chapter 2 “5.1 Device Address Settings” on page 2-68.
Line type is as follows:

The line will be displayed with Solid when the value of device address is not 1 to 6 or 
when the line width is not 1 (1 dot).

Bit 15 Bit 0Bit 2

0 : Do not update
1 : Update

0 : Do not erase
1 : Erase

Reserved

D100
D101
D102
D103
D104

Control status (display operation)

Number of data to display values of device addresses on chart

Data to display values of device addresses on chart

(Start address number)

+1

+2

+3

+4

D106

D105
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D103
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■ Data Over

Specifies the allowable range of values to display.

Line Size: Specifies the line size. You can also specify it using the value of device address.

Value: Selects the line size from the following.
1 dot, 2 dots, 3 dots, 5 dots

Device Address: Specifies the line size using the value of device address.

Click  to display the Tag Editor. For the device address configuration procedure, refer 
to Chapter 2 “5.1 Device Address Settings” on page 2-68.
Line width is as follows:

The line will be displayed with 1 dot when the value of device address is not 1 to 3 or 5.

Line Type: Specifies the color of line. You can also specify it using the value of device address.

Value: Selects the line color for the chart (color: 256 colors, monochrome: 16 shades).
Click this button to display the Color Palette. Select a color from the Color Palette.

Device Address: Specifies the line color using the value of device address.

Click  to display the Tag Editor. For the device address configuration procedure, refer 
to Chapter 2 “5.1 Device Address Settings” on page 2-68.
Line color is specified by the color data. When the value of device address is other than 
the color number, the graph is displayed in 255 (white).
For color data, refer to Appendix “Color Data Correspondence Table” on page A-1.

Preset Value 1
Line Width 1 dot

2
2 dots

3
3 dots

5
5 dots

Minimum, Maximum: Select these check boxes to specify the minimum and/or maximum.
The minimum and maximum that can be specified differ according to the data type selected 
with Data Format on the General tab. For details on data types, refer to Chapter 2 “1.1 
Available Data” on page 2-1.

When grid lines are displayed for the minimum and maximum, select the Show Gridline check box on the 
Scale and then select Data Over.
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■ Scale Tab

Show Ticks: Select this check box to display a scale on a chart.
Major Divisions: Enter the number of major scale divisions (1 to 20).
Minor Divisions: Enter the number of minor scale divisions (1 to 20).
Color: Selects the color of scales (color: 256 colors, monochrome: 16 shades).

Click Color to display the Color Palette. Select a color from the Color Palette.
Show Tick Numbers: Select this check box to display numbers along the scale. Can only be set for Y-

Axis.
Digits: Sets the number of digits to be displayed (1 to 10).

Can only be set when Float32(F) is selected for Data 
Type under the General tab.

Display Floating Point: Select this check box to display a floating point along the 
scale.
Can only be set when Float32(F) is selected for Data 
Type under the General tab.

Floating Digits: Sets the number of digits for the fractional parts of 
numbers (1 to 8) from the number of digits specified for 
Digits.
Can only be set when the Display Floating Point check 
box is selected.

Font: Selects the font used for displayed text from the following.
Standard, Stroke, 7-Segment
The characters that can be displayed depend on the font. 
For details, refer to Chapter 2 “1.2 Available Text” on page 
2-6.

Style: Selects Regular or Bold for the character style to be 
displayed.
Can only be set when Standard is selected for Font.

Magnification W, H: Selects magnification (0.5, 1 to 4, 8) for the displayed text.
Can only be set when Standard is selected for Font.

Size: Sets character size (8 to 128) for displayed text.
Can only be set when Stroke or 7-Segment is selected 
for Font.

Color: Selects the color of displayed text (color: 256 colors, 
monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the 
Color Palette.

If the area for displaying the scale is small, the scale will not be displayed properly.
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Show Gridline: Select this check box to display grid lines on the chart. The grid lines are displayed on the chart. 
Can only be set when the Show Ticks check box is selected.
Display Position: Select from Scale and Data Over to specify the grid line display position.

Scale: Grid lines are displayed according to the number of major scale 
divisions.

Data Over: Grid lines are displayed at the positions of values specified for 
Maximum and Minimum under the Data Over tab.

Line Type: Selects the type of grid lines from the following.
Solid, Dot, Dash, Long Dash, Long Dash Dot, Long Dash Dot Dot

Color: Specifies grid line color (color: 256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

Grid lines

Maximum

Minimum
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■ Label Tab

Show Label: Select this check box to display a label on Y-axis scales.
Use Text Manager: Select this check box if using the text registered in Text Manager for labels. Can 

only be set when the Show Label check box is selected.

If a carriage return (CR) is included in the character displayed on the label, the characters after the CR are 
not displayed. However, if Windows Font is set for the specified Text ID, all the characters are displayed.

Font: Selects the font for text used in labels from the following.
Japanese, European, Chinese, Taiwanese, Korean, Central European, 
Baltic, Cyrillic
Can only be set when the Use Text Manager check box is cleared.
The characters that can be displayed depend on the font. For details, refer to 
Chapter 2 “1.2 Available Text” on page 2-6.

Text ID: Specifies the Text Manager ID No. (1 to 32000) when text registered in the Text 
Manager are used for labels.

Click  to display Text Manager.

Can only be set when the Use Text Manager check box is selected.
Text: Inputs characters to be displayed for labels. Maximum number is 40 characters.

The characters that can be entered depend on the font selected using Font. For 
details, refer to Chapter 2 “1.2 Available Text” on page 2-6.
Can only be input when the Use Text Manager check box is cleared.

Color: Selects the color of the text used for labels (color: 256 colors, monochrome: 16 
shades).
Click Color to open the Color Palette. Select a color from the Color Palette.

If the area for displaying the label is too small, the label will not be displayed properly.
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● Date and Time (Cursor) Tab
The Date and Time (Cursor) tab is only displayed when Log Trend (Normal) or Log Trend (Pen Recorder) is 
selected for Chart Type on the General tab and the Display cursor check box on the X-Axis tab is selected.

■ Cursor Display Position
This value of device address is the cursor's display position. The cursor is displayed at the position counted from the 
left side of the chart.
This option specifies the word device that is the cursor's display position.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.
If the value of the device address configured by Cursor Display Position is outside the range of points configured 
by Display Points on X-Axis tab, the cursor is displayed at the minimum or the maximum value of the display 
points.
Example: When Display Points is 50 and the value of the device address configured by Cursor Display Position is 

100, the cursor is displayed at the 50 (maximum) position.

Maximum number of display points

Cursor
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■ Cursor Position data

■ Cursor Style

Store numerical data: To store the numerical data at the position indicated by the cursor in internal devices, select 
this check box and specify the destination word device.

Click  to display the Tag Editor. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-68.
The data is stored in continuous device addresses starting from the specified device address 
in order from Ch1 in the amount of charts displayed. The number of used device addresses 
varies based on the data size. If there is no data at the cursor position, 0 is stored in the 
device address.

Example: When specifying LDR10 and storing the numerical data in Ch1 to Ch3

Data size configured in the Data Log: 16 bits

Data size configured in the Data Log: 32 bits

Store date and time data: To store the date and time data at the position indicated by the cursor in internal devices, 
select this check box and specify the destination word device.

Click  to display the Tag Editor. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-68.
The year, month, day, hour, minute, and second are stored in continuous devices in order as 
BCD starting from the specified device address. If there is no data at the cursor position, 0 is 
stored in the device address.

Example: When storing the date and time data for October 1, 2011 12:01:30

Destination Numerical data
LDR10
LDR11
LDR12

Ch1 numerical data
Ch2 numerical data
Ch3 numerical data

Destination Numerical data
LDR10           LDR11            Ch1 numerical data
LDR12           LDR13            Ch2 numerical data
LDR14           LDR15            Ch3 numerical data

Destination Date and time data

LDR10                                2011 (Year)

LDR11                                10 (Month)

LDR12                                1 (Day)

LDR13                                12 (Hour)

LDR14                                1 (Minute)

LDR15                                30 (Second)

Line Type: Selects the cursor line type from the following.
Solid, Dot, Dash, Long Dash, Long Dash Dot, Long Dash Dot Dot

Line Size: Selects the cursor line size from the following.
1 dot, 2 dots, 3 dots, 5 dots

Line Color: Selects the line color for the cursor (color: 256 colors, monochrome: 16 shades).
Click this button to display the Color Palette. Select a color from the Color Palette.
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■ Show date and time data at the cursor position
To show the date and time data at the position indicated by the cursor, select this check box and specify the font and 
display type.

Example: When Display items is configured as Date & Time, Date Type is YY/MM/DD, Month is 1/2/3/..., 
Year is Double Figures, Time is HH:MM:SS

Font: Configures the format to display the date and time data.

Font: Selects the font for displayed characters from the following.
Standard, Stroke, 7-Segment
The characters that can be displayed depend on the font. For details, refer to 
Chapter 2 “1.2 Available Text” on page 2-6.

Style: Selects the character style as Regular or Bold.
This option can only be configured when Standard is selected for Font.

Magnification W, H: Selects the zoom factor for characters (0.5, 1 to 4, 8).
This option can only be configured when Standard is selected for Font.

Size: Specifies the character size (8 to 128).
This option can only be configured when Stroke or 7-Segment is selected for 
Font.

Color: Selects the text color (color: 256 colors, monochrome: 16 shades).
Click this button to display the Color Palette. Select a color from the Color Palette.

Display Type: Configures the display type for the date and time data.

Display items: Selects the items to display for the date and time data from the following.
Time, Date, Date & Time
If Date & Time is selected, the date is displayed centered on the first line and the 
time is displayed centered on the second line.

Date Type: Selects the display type of the date from the following.
YY/MM/DD, MM/DD/YY, DD/MM/YY, MM/DD, DD/MM
This option can only be configured when Date or Date & Time is selected for 
Display items.

Year: Selects the display type for the year as Double Figures or Four Figures.
This option can only be configured when Date or Date & Time is selected for 
Display items.

Month: Selects the display type for the month as 1/2/3/... or Jan/Feb/Mar/....
This option can only be configured when Date or Date & Time is selected for 
Display items.

Time: Selects the display type for the time from the following.
HH:MM, HH:MM:SS, MM:SS
HH: hours, MM: minutes, SS: seconds

11/10/01
12:01:30

Cursor

Cursor posi�on date and �me data

If there is no data at the cursor position, the date and time is displayed as "*".

**/**/**
**:**:**

Cursor
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● Trigger Condition Tab
The Trigger Condition tab is displayed in Advanced mode.

The line chart is enabled while the condition is satisfied, and it is disabled while the condition is not satisfied. When 
disabled, the plate and flange are displayed, but the chart is not displayed.
Example: When Trigger Type is While ON and Device Address is LM0

While LM0 is 0, the condition is not satisfied and the line chart is not displayed.
While LM0 is 1, the condition is satisfied and the line chart is displayed.

■ Trigger Type
Selects the condition to enable the line chart from the following.

LM0:

MICRO/I

Condi�on 
Not 

sa�sfied

0

LM0:
Condi�on 
Sa�sfied

1
Show chart

Hide chart

0

20

40

60

80

100

-20

0

20

40

60

80

100

-20

Always visible: The line chart is always enabled.

Always show chart

Chart state
0

20

40

60

80

100

-20
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■ Data Type
Selects the data type to be handled by the condition formula.
Can only be set if While satisfying the condition is selected as Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

■ Device Address
Specifies the bit device or the bit number of the word device to serve as condition.
Can only be set if While ON or While OFF is selected as Trigger Type.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.

■ Condition
Sets the condition formula.
Can only be set if While satisfying the condition is selected as Trigger Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expression configuration 
procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-71.

■ Comment
Used for entering comments about trigger conditions. Maximum number is 80 characters.

While ON: Enables the line chart when the value of device address is 1.

While OFF: Enables the line chart when the value of device address is 0.

While satisfying the condition: 

Enables the line chart when the condition is satisfied.

1

0

Hide chart Show chart Hide chart Show chart Show chart Show chart Hide chart

Value of
device address

Chart state
0
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80

100

-20
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100

-20
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Value of
device address

1

0

Show chart Hide chart Show chart Hide chart Hide chart Hide chart Show chart
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● Options Tab
The Options tab is displayed in Advanced mode.

■ Place on the Top Layer
Select this check box to display the parts on the top layer. The parts will have precedence when other drawings and 
parts are overlapping with it. For details, refer to Chapter 6 “4 Drawings and Parts Overlapping” on page 6-5.
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● Security Tab
This tab is used to restrict displaying and using the part by security groups.
This option can only be set when Use Security functions is selected. The Use Security functions check box is set 
on General tab in the Security dialog box.

■ (Settings)
Displays the list of security groups used on the MICRO/I.

■ Security Settings
The Security Settings dialog box is displayed. If you create a security group in the Security Settings dialog box, you 
can select that created group. For details, refer to Chapter 23 “2.2 Adding and Editing Security Groups” on page 23-
19.

(Settings)

No.: Displays the security group numbers (0 to 15).

Group Name: Displays the name of the security group.

Display: Displays whether or not there is permission to display the part. Only Permitted security groups 
can display this part. If all security groups are set to Permitted, this part will be displayed even 
if no user account has been selected. Double clicking the cell switches between Permitted and 
Prohibited.

You can also switch between Permitted and Prohibited by right-clicking on a Display cell.

For details about security functions, refer to Chapter 23 “User Accounts and the Security Function” on page 
23-1.
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Example: If the user and security group for a part are set as follows:

For User1 in the Reader security group, the parts for which Display has been set to Prohibited for Reader will not 
be displayed.
If the password screen is opened and the user switches to User2 in the Operator security group, the parts for which 
Display has been set to Permitted for Operator will be displayed.

User Name

Security Group Reader Operator
User1 User2

MICRO/I

130

Numerical Display
No. Group Name Display

1 Administrator Permitted

2 Operator Permitted

3 Reader Permitted

Button
No. Group Name Display Input

1 Administrator Permitted Permitted

2 Operator Permitted Prohibited

3 Reader Prohibited Prohibited

Line Chart and Bar Chart
No. Group Name Display

1 Administrator Permitted

2 Operator Permitted

3 Reader Prohibited

Open Password Screen, 
enter password, 
and switch to User2

For User1, 
parts for which Display 
has been set to Prohibited 
for Reader are not displayed

For User2, 
parts for which Display 
has been set to Permitted 
for Operator are displayed

MICRO/I

130

MICRO/I MICRO/I

130

User1 User2

130
CAN

User Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password
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● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Used for entering comments about parts. Maximum number is 80 characters.
Example: When mousing over the line chart on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.



3 Pie Chart

11-52 WindO/I-NV4 User’s Manual

  

3.1 How the Pie Chart is Used

The stacked bar chart and pie chart are used to show the proportion of individual data to the sum of the data.
They can be used to check the relative change in multiple values of device addresses in real-time.

• Display the proportion of the sum of multiple values of device addresses in a stacked bar chart or a pie chart

3 Pie Chart

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

External device
MICRO/I

1 : 1 : 1

4 : 2 : 1

D100 : 10

D200 : 10

D300 : 10

D100 : 120

D200 : 60

D300 : 30

If the source data is all 0, the chart shows the same proportion for all the data.
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3.2 Pie Chart Configuration Procedure

This section describes the configuration procedure for pie charts.

1 On the Home tab, in the Parts group, click Charts, and then click Pie Chart.

2 Click a point on the edit screen where you wish to place the Pie Chart.

3 Double-click the dropped Pie Chart and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.

The Options tab only appears in Advanced mode.
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3.3 Properties of Pie Chart Dialog Box

This section describes items and buttons in the Properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ Chart Type
Select the type of chart from the following items.

Horizontal Bar: Shows the proportion of the sum of the data as a horizontal stacked bar chart.
Example: When displaying the values for three device addresses

Vertical Bar: Shows the proportion of the sum of the data as a vertical stacked bar chart.
Example: When displaying the values for three device addresses

Horizontal bar 
display

Ch3 data 0

Ch2 data 0

50

100

30

60

10

50

Ch1 data 0 100 120 150

Propor�on 1 : 1 : 1 2 : 2 : 1 4 : 2 : 1 15 : 5 : 1

Ver�cal bar display

Ch3 data 0

Ch2 data 0

50

100

30

60

10

50

Ch1 data 0 100 120 150

Propor�on 1 : 1 : 1 2 : 2 : 1 4 : 2 : 1 15 : 5 : 1
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■ Data Type
Selects the data type handled by the chart from the following.
UBIN16(W), UBIN32(D), BCD4(B), BCD8(EB), Float32(F)
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

■ Number of Data
Specifies the number of items of data to chart (1 to 10).

■ Settings
Lists the chart settings. The list shows the numbers, source device addresses, and colors for the chart.

Pie: Shows the proportion of the sum of the data as a pie chart.
Example: When displaying the values for three device addresses

Ch3 data 0

Ch2 data 0

50

100

30

60

10

50

Ch1 data 0 100 120 300

Propor�on 1 : 1 : 1 2 : 2 : 1 4 : 2 : 1 30 : 5 : 1

Pie chart display

When the BCD4(B), BCD8(EB), or Float32(F) is selected as Data Type and the value cannot be 
expressed with the data type selected for the data that was read, 1 is written to System Area 2 Processing 
Error bit (address number+2, bit 5), and an error message is displayed. For details, refer to Chapter 4 
“Processing error” on page 4-32 and Chapter 36 “Processing error” on page 36-3.

No.: Shows the numbers for the chart (Ch1 to Ch10).
For Horizontal Bar, the numbers are listed in order from the left. For Vertical Bar, the numbers 
are listed in order from the top.

For Pie, the numbers are listed clockwise.

Device Address: Specifies the source word device for the data to display in the chart.
Double clicking the cell displays the Tag Editor where you can edit the device address. For the device 
address configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-68.

Fg. Color: Selects the foreground color of the chart. (color: 256 colors, monochrome: 16 shades)
Double clicking the cell displays the Color Palette where you can change the foreground color of the chart.

Bg. Color: Selects the background color of the chart. (color: 256 colors, monochrome: 16 shades)
Double clicking the cell displays the Color Palette where you can change the background color of the chart.

Pattern: Selects the chart pattern.
Double clicking the cell displays the Pattern Palette where you can change the chart pattern.

Horizontal bar Ver�cal bar

Ch1

Ch1 Ch2 Ch3 Ch2

Ch3

Pie chart

Ch1

Ch2

Ch3



3 Pie Chart

11-56 WindO/I-NV4 User’s Manual

■ Remove
Deletes the registered settings from the list.

■ Up
Shifts the selected settings upward in the list.

■ Down
Shifts the selected settings downward in the list.
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● View Tab

■ Image Type
Select the type of graphic to be used to represent the part.

■ Browse
Select the type of graphic to be used to represent the part from the list of graphics. Click this button to display the 
View Browser.

■ Flange

■ Coordinates

Standard: Uses the default graphic for WindO/I-NV4.

None: The plate and the flange of the part are not displayed.

Foreground Color, Background Color: Selects the foreground and background colors of the flange of the standard 
graphic (color: 256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

Pattern: Selects a pattern for the flange of the standard graphic.
Click Pattern to display the Pattern Palette. Select a pattern from the Pattern 
Palette.

Flange

X, Y: Sets the display position of parts using coordinates.
The X and Y coordinates of parts are defined relative to an origin at the top-left corner of the screen.
X: 0 to (base screen horizontal size - 1)
Y: 0 to (base screen vertical size - 1)

(0, 0)
X

Y
Screen

Parts
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■ Size

W, H: Sets width and height to define the size of parts.
W: 5 to (base screen horizontal size)
H: 5 to (base screen vertical size)

Width

Height

Screen

Parts
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● Options Tab
The Options tab is displayed in Advanced mode.

■ Place on the Top Layer
Select this check box to display the parts on the top layer. The parts will have precedence when other drawings and 
parts are overlapping with it. For details, refer to Chapter 6 “4 Drawings and Parts Overlapping” on page 6-5.



3 Pie Chart

11-60 WindO/I-NV4 User’s Manual

● Security Tab
This tab is used to restrict displaying and using the part by security groups.
This option can only be set when Use Security functions is selected. The Use Security functions check box is set 
on General tab in the Security dialog box.

■ (Settings)
Displays the list of security groups used on the MICRO/I.

■ Security Settings
The Security Settings dialog box is displayed. If you create a security group in the Security Settings dialog box, you 
can select that created group. For details, refer to Chapter 23 “2.2 Adding and Editing Security Groups” on page 23-
19.

(Settings)

No.: Displays the security group numbers (0 to 15).

Group Name: Displays the name of the security group.

Display: Displays whether or not there is permission to display the part. Only Permitted security groups 
can display this part. If all security groups are set to Permitted, this part will be displayed even 
if no user account has been selected. Double clicking the cell switches between Permitted and 
Prohibited.

You can also switch between Permitted and Prohibited by right-clicking on a Display cell.

For details about security functions, refer to Chapter 23 “User Accounts and the Security Function” on page 
23-1.
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Example: If the user and security group for a part are set as follows:

For User1 in the Reader security group, the parts for which Display has been set to Prohibited for Reader will not 
be displayed.
If the password screen is opened and the user switches to User2 in the Operator security group, the parts for which 
Display has been set to Permitted for Operator will be displayed.

User Name

Security Group Reader Operator
User1 User2

MICRO/I

130

Numerical Display
No. Group Name Display

1 Administrator Permitted

2 Operator Permitted

3 Reader Permitted

Button
No. Group Name Display Input

1 Administrator Permitted Permitted

2 Operator Permitted Prohibited

3 Reader Prohibited Prohibited

Line Chart and Bar Chart
No. Group Name Display

1 Administrator Permitted

2 Operator Permitted

3 Reader Prohibited

Open Password Screen, 
enter password, 
and switch to User2

For User1, 
parts for which Display 
has been set to Prohibited 
for Reader are not displayed

For User2, 
parts for which Display 
has been set to Permitted 
for Operator are displayed

MICRO/I

130

MICRO/I MICRO/I

130

User1 User2

130
CAN

User Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password
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● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Used for entering comments about parts. Maximum number is 80 characters.
Example: When mousing over the pie chart on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.
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4.1 How the Meter is Used

The meter displays the value of a word device as the movement of a needle.

• Display the value of a word device in a meter

4 Meter

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

External device
MICRO/I

D100 : 0

D100 : 75

0 100

20 80

40 60

0 100

20 80

40 60
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4.2 Meter Configuration Procedure

This section describes the configuration procedure for meters.

1 On the Home tab, in the Parts group, click Charts, and then click Meter.

2 Click a point on the edit screen where you wish to place the Meter.

3 Double-click the dropped Meter and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.

The Range tab, Scale tab and Options tab only appear in Advanced mode.
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4.3 Properties of Meter Dialog Box

This section describes items and buttons in the Properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ Meter Type
Select the type of meter from the following items.
90 Degree Meter, 180 Degree Meter, 270 Degree Meter

Example: 180 Degree Meter

90-degree meter 180-degree meter 270-degree meter

180-degree meter display

Data 0 10 40 75
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■ Data Format

■ Reference Device Address
Specifies the source word device for the data to display in the meter.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.

Data Type: Selects the data type handled by the meter from the following.
UBIN16(W), BIN16(I), UBIN32(D), BIN32(L), BCD4(B), BCD8(EB), Float32(F)
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Minimum, Maximum: Specifies the minimum and maximum for the data.

(Data Type): Selects the data type to use for the minimum and the maximum.

Value: Uses a constant value.

Device Address: Uses a value of device address.

The minimum and maximum vary based on the selected data type. For details, refer to Chapter 
2 “1.1 Available Data” on page 2-1.
The needle does not move past the left edge when the data value is the minimum or lower.
The needle stops at the right edge when the data value is the maximum or higher.
When Device Address is selected for (Data Type), the minimum and maximum can be 
specified in the word device.

Click  to display the Tag Editor. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-68.

If the data displayed in the meter is invalid, 1 is written to System Area 2 Processing error bit (address 
number+2, bit 5), and an error message is displayed. For details, refer to Chapter 4 “Processing error” on 
page 4-32 and Chapter 36 “Processing error” on page 36-3. 
An error occurs in the following states:
• The setting of Minimum, Maximum, or ranges are invalid, or the Minimum and Maximum are the 

same values.
• Data Type is BCD4(B), BCD8(EB), or Float32(F) and the value cannot be expressed with the data 

type selected for the read data
If an error occurs, only the flange is initially displayed. Then once the meter is displayed, it doesn't show an 
update.
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● View Tab

■ Image Type
Select the type of graphic to be used to represent the part.

■ Browse
Select the type of graphic to be used to represent the part from the list of graphics. Click this button to display the 
View Browser or Picture Manager, depending on the setting for Image Type.

■ Needle Color
Selects the needle color of the Meter (color: 256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

■ Plate Color
Selects the plate color of the standard graphic (color: 256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

■ Flange

Standard: Uses the default graphic for WindO/I-NV4.
Picture: Uses an image file saved using Picture Manager.

For details about image file restrictions, refer to Chapter 2 “1.4 Available Image Files” on page 2-20.
None: The plate and the flange of the part are not displayed.

Needle color

Plate color

Foreground Color, Background Color: Selects the foreground and background colors of the flange of the standard 
graphic (color: 256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

Pattern: Selects a pattern for the flange of the standard graphic.
Click Pattern to display the Pattern Palette. Select a pattern from the Pattern Palette.

Flange
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■ Coordinates

■ Size

X, Y: Sets the display position of parts using coordinates.
The X and Y coordinates of parts are defined relative to an origin at the top-left corner of the screen.

X: 0 to (base screen horizontal size - 1)

Y: 0 to (base screen vertical size - 1)

(0, 0)
X

Y
Screen

Parts

W, H: Sets width and height to define the size of parts.

W: 5 to (base screen horizontal size)

H: 5 to (base screen vertical size)

Width

Height

Screen

Parts
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● Range Tab
The Range tab is only displayed in Advanced mode.

■ Show Range
Select this check box to show ranges on the meter and configure the number of ranges, range colors, and limits.
Ranges can only be configured when Standard or None is selected under Image Type on the View tab.

Number of Ranges: Specifies the number of ranges (1 to 5).

Range Color: Selects the range color (color: 256 colors, monochrome: 16 shades).
Click this button to display the Color Palette. Select a color from the Color Palette.

Limits: Specifies the limit for the range.

(Data Type): Selects the data type to use for the limit.

Value: Uses a constant value.

Device Address: Uses a value of device address.

The limit varies based on the data type selected with Data Format on the General tab. For 
details, refer to Chapter 2 “1.1 Available Data” on page 2-1.
When Device Address is selected for (Data Type), the minimum and maximum can be 
specified in the word device.

Click  to display the Tag Editor. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-68.

If the data displayed in the meter is invalid, 1 is written to System Area 2 Processing error bit (address 
number+2, bit 5), and an error message is displayed. For details, refer to Chapter 4 “Processing error” on 
page 4-32 and Chapter 36 “Processing error” on page 36-3. 
An error occurs in the following states:
• The setting of Minimum, Maximum, or ranges are invalid, or the Minimum and Maximum are the 

same values.
• Data Type is BCD4(B), BCD8(EB), or Float32(F) and the value cannot be expressed with the data 

type selected for the read data
If an error occurs, only the flange is initially displayed. Then once the meter is displayed, it doesn't show an 
update.

Example: 180-degree meter, data minimum is 0, maximum is 100, the number of ranges is set to 5

The limit between range 1 and 2: 20
The limit between range 2 and 3: 40
The limit between range 3 and 4: 60
The limit between range 4 and 5: 80

Range 1

Range 2

Range 3
Range 4

Range 5
0 100

20 80

40 60
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● Scale Tab
The Scale tab is displayed in Advanced mode.

■ Show Ticks
Select this check box to display a scale on a or meter.
Scales can only be configured when Standard or None is selected under Image Type on the View tab.

Major Divisions: Enter the number of major scale divisions (1 to 20).

Minor Divisions: Enter the number of minor scale divisions (1 to 20).

Color: Selects the color of scales (color: 256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

Show Tick Numbers: Select this check box to display numbers along the scale.

Digits: Sets the number of digits to be displayed (1 to 10).
Can only be set when Float32(F) is selected for Data Type under the 
General tab.

Display Floating Point: Select this check box to display a floating point along the scale.
Can only be set when Float32(F) is selected for Data Type under the 
General tab.

Floating Digits: Sets the number of digits for the fractional parts of numbers (1 to 8) 
from the number of digits specified for Digits.
Can only be set when the Display Floating Point check box is selected.

Color: Selects the color of displayed text (color: 256 colors, monochrome: 16 
shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

• If the area for displaying the scale is small, the scale will not be displayed properly.
• When the standard graphic F0001, F0101, or F0201 (no flange) are selected, the scale cannot be 

configured.
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● Options Tab
The Options tab is displayed in Advanced mode.

■ Place on the Top Layer
Select this check box to display the parts on the top layer. The parts will have precedence when other drawings and 
parts are overlapping with it. For details, refer to Chapter 6 “4 Drawings and Parts Overlapping” on page 6-5.
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● Security Tab
This tab is used to restrict displaying and using the part by security groups.
This option can only be set when Use Security functions is selected. The Use Security functions check box is set 
on General tab in the Security dialog box.

■ (Settings)
Displays the list of security groups used on the MICRO/I.

■ Security Settings
The Security Settings dialog box is displayed. If you create a security group in the Security Settings dialog box, you 
can select that created group. For details, refer to Chapter 23 “2.2 Adding and Editing Security Groups” on page 23-
19.

(Settings)

No.: Displays the security group numbers (0 to 15).

Group Name: Displays the name of the security group.

Display: Displays whether or not there is permission to display the part. Only Permitted security groups 
can display this part. If all security groups are set to Permitted, this part will be displayed even 
if no user account has been selected. Double clicking the cell switches between Permitted and 
Prohibited.

You can also switch between Permitted and Prohibited by right-clicking on a Display cell.

For details about security functions, refer to Chapter 23 “User Accounts and the Security Function” on page 
23-1.
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Example: If the user and security group for a part are set as follows:

For User1 in the Reader security group, the parts for which Display has been set to Prohibited for Reader will not 
be displayed.
If the password screen is opened and the user switches to User2 in the Operator security group, the parts for which 
Display has been set to Permitted for Operator will be displayed.

User Name

Security Group Reader Operator
User1 User2

MICRO/I

130

Numerical Display
No. Group Name Display

1 Administrator Permitted

2 Operator Permitted

3 Reader Permitted

Button
No. Group Name Display Input

1 Administrator Permitted Permitted

2 Operator Permitted Prohibited

3 Reader Prohibited Prohibited

Line Chart and Bar Chart
No. Group Name Display

1 Administrator Permitted

2 Operator Permitted

3 Reader Prohibited

Open Password Screen, 
enter password, 
and switch to User2

For User1, 
parts for which Display 
has been set to Prohibited 
for Reader are not displayed

For User2, 
parts for which Display 
has been set to Permitted 
for Operator are displayed

MICRO/I

130

MICRO/I MICRO/I

130

User1 User2

130
CAN

User Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password
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● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Used for entering comments about parts. Maximum number is 80 characters.
Example: When mousing over the meter on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.
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This chapter describes how to setup commands and their operation on the MICRO/I.

  

1.1 How the Bit Write Command is Used

Writes a 0 or 1 to a bit device.

■ Set

■ Reset

■ Momentary

Chapter 12 Commands

1 Bit Write Command

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

MICRO/I External device

0

1

Condition

Condition

Not satisfiedNot satisfiedNot satisfied

SatisfiedSatisfiedSatisfied

Writes a 1 to the specified bit device 
when the trigger condition is 
satisfied.

1

State of condition

Data written 1

Action Write Write

Condition Condition Condition Condition

SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied

Writes a 0 to the specified bit device 
when the trigger condition is 
satisfied.

0

State of condition

Data written 0

Action Write Write

Condition Condition Condition Condition

SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied

Writes a 1 to the specified bit device 
when the trigger condition is 
satisfied.
When the trigger condition is no 
longer satisfied, a 0 is written to the 
specified bit device.

0

State of condition

Data written 1 0 1

Action WriteWrite Write Write

Condition Condition Condition Condition

SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied
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■ Toggle

■ Move

Toggles the value of the specified bit 
device when the trigger condition is 
satisfied.
If the value of the bit device is 0 it 
changes to 1, and vice versa.

State of condition

Action Toggle Toggle

Condition Condition Condition Condition

SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied

This function writes the value in the 
source bit device to the value in the 
destination bit device when the 
trigger condition is satisfied.

State of condition

Action Move Move

Condition Condition Condition Condition

SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied
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1.2 Bit Write Command Configuration Procedure

This section describes the configuration procedure for the Bit Write Command.

1 On the Home tab, in the Parts group, click Commands, and then click Bit Write Command.

2 Click a point on the edit screen where you wish to place the Bit Write Command.

3 Double-click the dropped Bit Write Command and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.
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1.3 Properties of Bit Write Command Dialog Box

This section describes items and buttons in the Properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ Action Mode
Select the action to perform when the trigger condition is satisfied from the following:

Set: Writes a 1 to the specified bit device when the trigger condition is satisfied.

Reset: Writes a 0 to the specified bit device when the trigger condition is satisfied.

Momentary: Writes a 1 to the specified bit device when the trigger condition is satisfied.
When the trigger condition is no longer satisfied, a 0 is written to the specified bit device.

1

State of condition

Data written 1

Action Write Write

Condition Condition Condition Condition

SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied

0

State of condition

Data written 0

Action Write Write

Condition Condition Condition Condition

SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied

0

State of condition

Data written 1 0 1

Action WriteWrite Write Write

Condition Condition Condition Condition

SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied
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■ Destination Device Address
Specify the destination bit device.
Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.

■ Write*1

Specify the number of bit devices (1 to 64) at the destination.
This setting is enabled only if Action Mode is set to Set or Reset.

Example: This fills a contiguous block of bit devices with the same value.

If the bit number in a word device is specified, the same value is written to same bit of contiguous word devices.

■ Source Data
Specifies the device address where the data to be written is stored.
This setting is enabled only if Action Mode is set to Move.

Example: This button writes the values in a contiguous block of bit devices to a contiguous block of device 
addresses at the destination.

*1 Advanced mode only

Toggle: Toggles the value of the specified bit device when the trigger condition is satisfied.
If the value of the bit device is 0 it changes to 1, and vice versa.

Move: This function writes the value in the source bit device to the value in the destination bit device when 
the trigger condition is satisfied.

State of condition

Action Toggle Toggle

Condition Condition Condition Condition

SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied

State of condition

Action Move Move

Condition Condition Condition Condition

SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied

1M0

1M1

1M2

1M3

1M4

Action Mode: Set

Write: 5

Destination Device Address: M0

Condition

SatisfiedSatisfiedSatisfied

Condition

bit bit
15 0

SatisfiedSatisfiedSatisfied

1D0

D1

D2

D3

D4

1

1

1

1

Action Mode: Set

Write: 5

Destination Device Address: D0-15

Device Address: Specify the source bit device.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 
2 “5.1 Device Address Settings” on page 2-68.

Transfer: Specify the number of bit devices (1 to 64) to move.

1LM0

0LM1

0LM2

1LM3

Device Address: LM0

Transfer: 4

Destination Device Address: M0

1M0

0M1

0M2

1M3

Condition

SatisfiedSatisfiedSatisfied
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● Trigger Condition Tab

When the condition has been or is satisfied, the command is executed; when not satisfied, the command is not 
executed.
Example: When Trigger Type is Rising-edge and Device Address is LM0

The command is executed when LM0 changes from 0 to 1.

■ Trigger Type
Selects the condition to execute the command from the following.

LM0:

MICRO/I

0

LM0: 1

Not 
executed

Executed

Condition 
Not 

satisfied

Condition 
Satisfied

Rising-edge: Command is executed when a value of device address changes from 0 to 1.

Falling-edge: Command is executed when a value of device address changes from 1 to 0.

Value of
device address

1

0

Action Execution Execution Execution

Value of
device address

1

0

Action Execution Execution
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■ Data Type
Selects the data type to be handled by the condition formula.
Can only be set if Satisfy the condition or While satisfying the condition is selected as Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

■ Device Address
Specifies the bit device or the bit number of the word device to serve as condition.
Can only be set if Rising-edge or Falling-edge is selected as Trigger Type.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.

■ Condition
Sets the condition formula.
Can only be set if Satisfy the condition or While satisfying the condition is selected as Trigger Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expression configuration 
procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-71.

■ Comment
Used for entering comments about trigger conditions. The maximum number is 80 characters.

Satisfy the condition: Command is executed when condition changes from not satisfied to satisfied.

While satisfying the condition: 
The command continues being executed while the condition is satisfied.

Action

Condition
Satisfied

Not satisfied

Execution Execution Execution

Action

Condition
Satisfied

Not satisfied

Execution ExecutionExecution ExecutionExecution
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● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Used for entering comments about parts. The maximum number is 80 characters.
Example: When mousing over the Bit Write Command on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.
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2.1 How the Word Write Command is Used

Writes a value to a word device. Can be used to indirectly specify the destination address number or to perform 
operations on the written value.

• Writes a fixed value to a word device when the trigger condition is satisfied.

• Writes the value of device address to a word device when the trigger condition is satisfied.

• Performs arithmetic on the value to write before writing it to a word device when the trigger condition is satisfied.

2 Word Write Command

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

MICRO/I External device

D1= 0

100

D1= 100

Write

Destination word device

100

Value

Condition

Condition

SatisfiedSatisfiedSatisfied

Not satisfiedNot satisfiedNot satisfied

MICRO/I External device

D0= 123

D1= 0

D0= 123

D1= 123

Move

Value in device address

Destination word device

Condition

Condition

SatisfiedSatisfiedSatisfied

Not satisfiedNot satisfiedNot satisfied

MICRO/I External device

D0= 100

D1= 23

D2= 0

D0= 100

D1= 23

D2= 123

Add

Write

Value to write

Operator value

Destination word device

Condition

Condition

SatisfiedSatisfiedSatisfied

Not satisfiedNot satisfiedNot satisfied
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■ Set

■ Move

■ Momentary

■ Add, Sub, Multi, Div, Mod, OR, AND, XOR

Writes a fixed value to a word device when the 
trigger condition is satisfied.

State of condition

Data written

WriteAction Write

Value Value

Condition Condition Condition Condition

SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied

Writes the value of source device address to the 
destination word device when the trigger 
condition is satisfied. State of condition

Data written

WriteAction Write

Value in
device address

Value in
device address

Condition Condition Condition Condition

SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied

Writes a fixed value of ON Data to a word device 
when the trigger condition is satisfied.
Writes a fixed value of OFF Data to a word device 
when the trigger condition is no longer satisfied.

State of condition

Data written

WriteAction

OFF Data

Write

ON Data

Write

OFF Data

Write

ON Data

Condition Condition Condition Condition

SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied

Performs arithmetic on the value of source device 
address and a fixed value, or a value of device 
address and writes the result to a word device 
when the trigger condition is satisfied.

Example: Add (Addition)
When the trigger condition is satisfied, 
the value in the Source 1 is added to 
the value in Source 2 and the result is 
written to the word device.

State of condition

Data written

Action

Result

Arithmetic operation
↓

Write

Result

Arithmetic operation
↓

Write

Condition Condition Condition Condition

SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied

State of condition

Data written

Action

Result Result

Addition
↓

Write

Addition
↓

Write

Condition Condition Condition Condition

SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied
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2.2 Word Write Command Configuration Procedure

This section describes the configuration procedure for the Word Write Command.

1 On the Home tab, in the Parts group, click Commands, and then click Word Write Command.

2 Click a point on the edit screen where you wish to place the Word Write Command.

3 Double-click the dropped Word Write Command and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.
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2.3 Properties of Word Write Command Dialog Box

This section describes items and buttons in the Properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ Action Mode
Select the action to perform when the trigger condition is satisfied from the following:

Set: Writes a fixed value to the specified word device when the trigger condition is satisfied.

Move: Writes the value in the source device address to the destination word device when the trigger condition is 
satisfied.

Momentary: Writes the fixed ON Data value to the specified word device when the trigger condition is satisfied.
Writes the fixed OFF Data value to the specified word device when the trigger condition is no longer 
satisfied.

State of condition

Data written

WriteAction Write

Value Value

Condition Condition Condition Condition

SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied

State of condition

Data written

WriteAction Write

Value in
device address

Value in
device address

Condition Condition Condition Condition

SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied

State of condition

Data written

WriteAction

OFF Data

Write

ON Data

Write

OFF Data

Write

ON Data

Condition Condition Condition Condition

SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied
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■ Data Type
Select the data type handled by the operation selected for Action Mode.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.
UBIN16(W) and UBIN32(D) can only be set if Action Mode is set to OR, AND, or XOR.

■ Source 1
Specify the source word device.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.
This setting is enabled only if Action Mode is set to Add, Sub, Multi, Div, Mod, OR, AND, or XOR.

■ Source Data
Select the data handled by the operation selected for Action Mode.

Add, Sub, Multi, Div, Mod, OR, AND, XOR:

Performs arithmetic on the value in a reference device address and a fixed value, or the value at a 
device address and writes the result to a word device when the trigger condition is satisfied.

Example: Add (Addition)
When the trigger condition is satisfied, the value in the Source 1 is added to the value in 
Source 2 and the result is written to the word device.

State of condition

Data written

Action

Result

Arithmetic operation
↓

Write

Result

Arithmetic operation
↓

Write

Condition Condition Condition Condition

SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied

State of condition

Data written

Action

Result Result

Addition
↓

Write

Addition
↓

Write

Condition Condition Condition Condition

SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied

UBIN16(W) and UBIN32(D) can only be set if Action Mode is set to Move. Because the number of 
device addresses to transfer is specified in Advanced mode, you do not need to set Data Type.

If BCD4(B), BCD8(EB), or Float32(F) is selected and the arithmetic data contains a value inexpressible 
in BCD, a 1 is written to System Area 2 Processing error bit (address number+2, bit 5) and an error 
message is displayed. For details, refer to Chapter 4 “Processing error” on page 4-32 and Chapter 36 
“Processing error” on page 36-3.

Value: Use a constant value.
Only a Value can be handled if Action Mode is set to Set or Momentary.
If Action Mode is set to Momentary, the value in the ON Data is written when the trigger 
condition is satisfied, and the value in the OFF Data when the trigger condition is no longer 
satisfied.

Hexadecimal: Select this check box to enter the ON Data and OFF Data values as a 
hexadecimal.
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■ Destination Device Address

*1 Advanced mode only

Device Address: Use a value of device address.
Specify the device address.
Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 
2 “5.1 Device Address Settings” on page 2-68.

Use Reference Device Address*1: Select this check box and specify a device address to change the 
source word device according to the value of the specified device 
address.
This setting is enabled only if Action Mode is set to Move.
For details, refer to Chapter 2 “Indirect Read and Indirect Write 
Settings” on page 2-5.

Transfer*1 Specify the number of word devices (1 to 64) to transfer.
This setting is enabled only if Action Mode is set to Move.
Example: If Transfer is set to 2 and Write is set to 3, the 

same data in 2 continuous word device addresses will 
be written to the destination device address 3 times.

:

Source Data (Device Address): LDR0

Write: 3

999LDR0

Destination Device Address: D100

D100

D101

D102

D103

Transfer: 2 1000LDR1

D104

D105

999

1000

999

1000

999

1000

Condition

SatisfiedSatisfiedSatisfied

Destination Device Address: Specify the destination word device.
Click  to display the Tag Editor. For the device address configuration procedure, 
refer to Chapter 2 “5.1 Device Address Settings” on page 2-68.

Use Reference Device Address*1: Select this check box and specify a device address to change the destination word 
device according to the value of the specified device address.
This setting is enabled only if Action Mode is set to Move.
For details, refer to Chapter 2 “Indirect Read and Indirect Write Settings” on page 
2-5.

Write*1 Specify the number of word devices (1 to 64) at the destination.
For Move, specify how many times to write.
This setting is enabled only if Action Mode is set to Set, Move, or Momentary.
Example: If Data Type is set to UBIN16(W) and Write is set to 5, the same 

data will be written to 5 continuous word addresses.

If Data Type is set to UBIN32(D) and Write is set to 5, the same 
data will be written to a total of 10 word addresses (2 words 5 times).

:

Destination Device Address: LDR10

Write: 5

Data Type: UBIN16(W)

Source Data (Value): 12345
12345LDR10

12345LDR11

12345LDR12

12345LDR13

12345LDR14

5 words
Condition

SatisfiedSatisfiedSatisfied

Destination Device Address: LDR10

Write: 5

Data Type: UBIN32(D)

Source Data (Value): 987654

LDR10

987654

LDR11

LDR12

987654

LDR13

LDR14

987654

LDR15

LDR16

987654

LDR17

LDR18

987654

LDR19

2 words x 5

Condition

SatisfiedSatisfiedSatisfied
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● Trigger Condition Tab

When the condition has been or is satisfied,  the command is executed; when not satisfied, the command is not 
executed.
Example: When Trigger Type is Rising-edge and Device Address is LM0

The command is executed when LM0 changes from 0 to 1.

■ Trigger Type
Selects the condition to execute the command from the following.

LM0:

MICRO/I

0

LM0: 1

Not 
executed

Executed

Condition 
Not 

satisfied

Condition 
Satisfied

Rising-edge: Command is executed when a value of device address changes from 0 to 1.

Falling-edge: Command is executed when a value of device address changes from 1 to 0.

Value of
device address

1

0

Action Execution Execution Execution

Value of
device address

1

0

Action Execution Execution
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■ Data Type
Selects the data type to be handled by the condition formula.
Can only be set if Satisfy the condition or While satisfying the condition is selected as Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

■ Device Address
Specifies the bit device or the bit number of the word device to serve as condition.
Can only be set if Rising-edge or Falling-edge is selected as Trigger Type.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.

■ Condition
Sets the condition formula.
Can only be set if Satisfy the condition or While satisfying the condition is selected as Trigger Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expression configuration 
procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-71.

■ Comment
Used for entering comments about trigger conditions. The maximum number is 80 characters.

Satisfy the condition: Command is executed when condition changes from not satisfied to satisfied.

While satisfying the condition: 

The command continues being executed while the condition is satisfied.

Action

Condition
Satisfied

Not satisfied

Execution Execution Execution

Action

Condition
Satisfied

Not satisfied

Execution ExecutionExecution ExecutionExecution
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● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Used for entering comments about parts. The maximum number is 80 characters.
Example: When mousing over the Word Write Command on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.
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3.1 How the Goto Screen Command is Used

Switches to another screen or displays a window.

• Switches between Base Screens when the trigger condition is satisfied.

• Opens and closes other windows (such as the Popup Screen, Device Monitor, Password Screen, Adjust Brightness 
Screen, File Screen, and Open User Account Setting Screen) when the trigger condition is satisfied.

• Switches to the System Mode when the trigger condition is satisfied.

• Resets the current screen when the trigger condition is satisfied.

3 Goto Screen Command

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

Condition

MICRO/I

SatisfiedSatisfiedSatisfied

MICRO/I

Condition

SatisfiedSatisfiedSatisfied
D51 123

D52 456

D53 0

999

MICRO/I

Condition

SatisfiedSatisfiedSatisfied
D51 123

D52 456

D53 0

999

MICRO/I

Condition

SatisfiedSatisfiedSatisfied OfflineRun Main Menu

MICRO/I

130 00

Condition

SatisfiedSatisfiedSatisfied
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3.2 Goto Screen Command Configuration Procedure

This section describes the configuration procedure for the Goto Screen Command.

1 On the Home tab, in the Parts group, click Commands, and then click Goto Screen Command.

2 Click a point on the edit screen where you wish to place the Goto Screen Command.

3 Double-click the dropped Goto Screen Command and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.
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3.3 Properties of Goto Screen Command Dialog Box

This section describes items and buttons in the Properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ Action Mode
Select the action to perform when the trigger condition is met from the following:

Back to previous Screen: Switches to the previous screen. Returns to up to 16 earlier screens.
Switch to Base Screen: Switches between Base Screen. For details, refer to Chapter 5 “3 Base Screen” 

on page 5-14.
Open Popup Screen: Opens a Popup Screen. For details, refer to Chapter 5 “4 Popup Screen” on page 

5-20.
Close Popup Screen: Closes a Popup Screen. For details, refer to Chapter 5 “4 Popup Screen” on page 

5-20.
Open Device Monitor Screen: Opens the Device Monitor Screen. For details, refer to Chapter 25 “2.2 Device 

Monitor” on page 25-21.
Close Device Monitor Screen: Closes the Device Monitor Screen. For details, refer to Chapter 25 “2.2 Device 

Monitor” on page 25-21.
Open Password Screen: Opens the Password Screen. For details, refer to Chapter 23 “4.1 Entering the 

Password on the MICRO/I” on page 23-46.
Close Password Screen: Closes the Password Screen. For details, refer to Chapter 23 “4.1 Entering the 

Password on the MICRO/I” on page 23-46.
Open Adjust Brightness Screen: Opens the Adjust Brightness Screen. For details, refer to Chapter 34 “1.3 

Adjusting Screen Brightness” on page 34-2.
Close Adjust Brightness Screen: Closes the Adjust Brightness Screen. For details, refer to Chapter 34 “1.3 

Adjusting Screen Brightness” on page 34-2.
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■ Goto Screen

*1 This is applicable for models with a video interface only.
*2 Advanced mode only

Open File Screen for movie files*1: Opens the File Screen. For details, refer to Chapter 10 “4.4 File Screen” on page 
10-92.

Close File Screen for movie files*1: Closes the File Screen. For details, refer to Chapter 10 “4.4 File Screen” on page 10-
92.

Switch to System Mode: Switches to the Top Page in the System Mode. For details, refer to Chapter 34 
“2 System Mode Overview” on page 34-3.

Reset current screen: Resets the current Base Screen.
Open User Account Setting Screen: Opens the User Account Setting Screen. For details, refer to Chapter 23 “5 

Editing User Accounts on the MICRO/I” on page 23-49.
When User Account Setting Screen is selected, the Configure 
Processing Area of User Account Setting Screen dialog box will be 
displayed. For details, refer to Chapter 8 “Configure Processing Area of User 
Account Setting Screen Dialog Box” on page 8-44.
Specify the word device to use as the processing area of the User Account 
Setting Screen and click OK. When you return to the properties dialog box, 
Edit will be displayed.
Edit: Click this button to display the Configure Processing Area of User 

Account Setting Screen dialog box.

When the current Base Screen is reset using the Reset current screen function, the window and internal 
devices restart as if the Base Screens were switched.

Screen Number: If Action Mode is set to Switch to Base Screen, specify the Base Screen number to switch to 
(from 1 to 3000). If Action Mode is set to Open Popup Screen or Close Popup Screen, 
specify the number of the Popup Screen to open or close (from 1 to 3015).
This setting is enabled only if Action Mode is set to Switch to Base Screen, Open Popup 
Screen, or Close Popup Screen.

Use Reference Device Address*2: Select this check box and specify a device address to specify the 
screen number using the value of the specified device address.

Click  to display the Tag Editor. For the device address 
configuration procedure, refer to Chapter 2 “5.1 Device Address 
Settings” on page 2-68.
This setting is enabled only if Action Mode is set to Open 
Popup Screen or Close Popup Screen.

Coordinates X, Y: Specify the coordinates on the Base Screen for displaying a window.
X and Y specify the upper left corner of the window using the upper left corner of the screen as the 
origin.
This setting is enabled only if Action Mode is set to Open Popup Screen, Open Device 
Monitor Screen, Open Password Screen, Open Adjust Brightness Screen, or Open File 
Screen for Movie Files*1.

Use Reference Device Address*2: Select this check box and specify a device address to specify the 
coordinates using the value of the specified device address.

Click  to display the Tag Editor. For the device address 
configuration procedure, refer to Chapter 2 “5.1 Device Address 
Settings” on page 2-68.
This setting is enabled only if Action Mode is set to Open 
Popup Screen.



3 Goto Screen Command

12-22 WindO/I-NV4 User’s Manual

● Trigger Condition Tab

When the condition has been or is satisfied, the command is executed; when not satisfied, the command is not 
executed.
Example: When Trigger Type is Rising-edge and Device Address is LM0

The command is executed when LM0 changes from 0 to 1.

■ Trigger Type
Selects the condition to execute the command from the following.

LM0:

MICRO/I

0

LM0: 1

Not 
executed

Executed

Condition 
Not 

satisfied

Condition 
Satisfied

Rising-edge: Command is executed when a value of device address changes from 0 to 1.

Falling-edge: Command is executed when a value of device address changes from 1 to 0.

Value of
device address

1

0

Action Execution Execution Execution

Value of
device address

1

0

Action Execution Execution
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■ Data Type
Selects the data type to be handled by the condition formula.
Can only be set if Satisfy the condition or While satisfying the condition is selected as Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

■ Device Address
Specifies the bit device or the bit number of the word device to serve as condition.
Can only be set if Rising-edge or Falling-edge is selected as Trigger Type.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.

■ Condition
Sets the condition formula.
Can only be set if Satisfy the condition or While satisfying the condition is selected as Trigger Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expression configuration 
procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-71.

■ Comment
Used for entering comments about trigger conditions. The maximum number is 80 characters.

Satisfy the condition: Command is executed when condition changes from not satisfied to satisfied.

While satisfying the condition: 

The command continues being executed while the condition is satisfied.

Action

Condition
Satisfied

Not satisfied

Execution Execution Execution

Action

Condition
Satisfied

Not satisfied

Execution ExecutionExecution ExecutionExecution
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● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Used for entering comments about parts. The maximum number is 80 characters.
Example: When mousing over the Goto Screen Command on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.
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4.1 How the Print Command is Used

Outputs a screenshot to a printer or an external memory device*1.

• Outputs a screenshot of the current screen to the printer when the trigger condition is satisfied.

• Outputs a screenshot of the current screen to the external memory device*1 when the trigger condition is satisfied.

*1 SD memory card for HG5G/4G/3G/2G-V, HG4G/3G and HG2G-5F, USB flash drive for HG2G-5T and HG1G/1P

4 Print Command

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

HG3G HG2G-5FHG4G
HG5G-V HG4G-V HG3G-V HG2G-V

MICRO/I Printer

2011/1/11

Condition

SatisfiedSatisfiedSatisfied

Refer to Chapter 32 “1.2 Connecting a Printer to MICRO/I” on page 32-1 for compatible printers and 
instructions on how to connect one to the MICRO/I.

MICRO/I

Condition

SatisfiedSatisfiedSatisfied

USB flash drive

SD memory card

External Memory Device

Image file
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4.2 Print Command Configuration Procedure

This section describes the configuration procedure for the Print Command.

1 On the Home tab, in the Parts group, click Commands, and then click Print Command.

2 Click a point on the edit screen where you wish to place the Print Command.

3 Double-click the dropped Print Command and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.
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4.3 Properties of Print Command Dialog Box

This section describes items and buttons in the Properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ Output to
Select where to direct the screenshot to.

■ Action Mode
Select the action to perform when the trigger condition is satisfied from the following. This option is only displayed 
when Printer is selected in Output to.

*1 HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F only
*2 SD memory card for HG5G/4G/3G/2G-V, HG4G/3G and HG2G-5F, USB flash drive for HG2G-5T and HG1G/1P

Printer*1: Outputs the screenshot to the printer connected to the MICRO/I.
Print Time Stamp: Adds the date and time of printing to the screenshot before 

sending it to the printer.
The date and time format depends on the language selected in 
Language. Language is available on the Project Details tab of 
the Project Settings dialog box.
The display formats are shown below:
• Japanese: YYYY/MM/DD hh:mm
• English: MM/DD/YYYY hh:mm
YYYY: year, MM: month, DD: day, hh: hour, mm: minute

External Memory Device*2: Outputs the screenshot as a file to the external memory device inserted in the MICRO/I.
Files are output as follows:

File format File name File size

JPEG
CAP***.JPG (***: date and time when file was output)
Example: A file created at 18:50:25 on June 30, 2011 will 

be named “CAP110630_185025.JPG”.

Depends on image 
being displayed.

• For details about printers, refer to Chapter 32 “Printer” on page 32-1.
• For details about external memory devices, refer to Chapter 31 “External Memory Devices” on page 31-1.

Print Screen: Outputs a screenshot of the current screen to the printer or the external memory device.

Cancel Printing*1: Cancels printout to the printer.
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*1 HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F only

• These operations cannot be performed simultaneously.
- Outputting to the external memory device using the Print Command
- Outputting to the printer using the Print Command*1

- Printing alarm logs
• It may take some time to output screenshots when copying files using the USB Autorun function or a Key 

Button.
• MICRO/I cannot stop printing in the middle of a page, even when the print job is canceled. Print jobs 

after the current print job are canceled after the current page finishes printing.

The maximum number of screenshots that can be captured (1 to 999) can be set in HMI Special Data 
Register LSD65. (Default: 99)

The methods to erase screenshot files saved on the external memory device are as follows.
• To erase files during operation using parts, on the External Memory Device tab on the Project 

Settings dialog box, select the Remove Files check box and the All Screenshot data check box, and 
then configure the trigger device address. Assign that trigger device address to a part.

• To erase files with WindO/I-NV4, click Clear on the Online tab, and then click Stored Data in External 
Memory Device to open the Clear Data dialog box. Select the Screenshot Data check box and click 
OK.

• To erase files on the HG5G/4G/3G/2G-V, HG4G/3G and the HG2G-5F, go to the System Mode - File 
Manager. In the File Manager, select the files to be deleted by pressing DEL.
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● Trigger Condition Tab

When the condition has been or is satisfied, the command is executed; when not satisfied, the command is not 
executed.
Example: When Trigger Type is Rising-edge and Device Address is LM0

The command is executed when LM0 changes from 0 to 1.

■ Trigger Type
Selects the condition to execute the command from the following.

LM0:

MICRO/I

0

LM0: 1

Not 
executed

Executed

Condition 
Not 

satisfied

Condition 
Satisfied

Rising-edge: Command is executed when a value of device address changes from 0 to 1.

Falling-edge: Command is executed when a value of device address changes from 1 to 0.

Value of
device address

1

0

Action Execution Execution Execution

Value of
device address

1

0

Action Execution Execution
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■ Data Type
Selects the data type to be handled by the condition formula.
Can only be set if Satisfy the condition or While satisfying the condition is selected as Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

■ Device Address
Specifies the bit device or the bit number of the word device to serve as condition.
Can only be set if Rising-edge or Falling-edge is selected as Trigger Type.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.

■ Condition
Sets the condition formula.
Can only be set if Satisfy the condition or While satisfying the condition is selected as Trigger Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expression configuration 
procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-71.

■ Comment
Used for entering comments about trigger conditions. The maximum number is 80 characters.

Satisfy the condition: Command is executed when condition changes from not satisfied to satisfied.

While satisfying the condition: 

The command continues being executed while the condition is satisfied.

Action

Condition
Satisfied

Not satisfied

Execution Execution Execution

Action

Condition
Satisfied

Not satisfied

Execution ExecutionExecution ExecutionExecution
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● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Used for entering comments about parts. The maximum number is 80 characters.
Example: When mousing over the Print Command on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.
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5.1 How the Script Command is Used

Executes a script when certain conditions are satisfied.

5 Script Command

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

MICRO/I

// Script A

[D 100] = [D 100] + 1;

if ([D 100] >= 50)

{

     [D 100] = 0;

}

Executes Script

Start Condition

SatisfiedSatisfiedSatisfied

Complex processes such as conditional branching, logical operation, arithmetic operation, function, etc., can 
be programmed in a text format using Scripts. For details, refer to Chapter 20 “Script” on page 20-1.
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5.2 Script Command Configuration Procedure

This section describes the configuration procedure for Script Commands.

1 On the Home tab, in the Parts group, click Commands, and then click Script Command.

2 Click a point on the edit screen where you wish to place the Script Command.

3 Double-click the dropped Script Command and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.
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5.3 Properties of Script Command Dialog Box

This section describes items and buttons in the Properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ Script ID
Specify the script ID (1-32000) of the script to operate.

The Script Manager will open when  is clicked. Select a script from the script list.
For details, refer to Chapter 20 “2.2 Script Manager” on page 20-7.

■ Script Name
Displays the name of the script selected in the Script Manager.

■ (Script)
Displays the contents of the script selected in the Script Manager.
Once this area is double clicked, the Script Editor will open and editing can be done.
For details, refer to Chapter 20 “2.3 Script Editor” on page 20-12.

(Script)
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● Trigger Condition Tab

When the condition has been or is satisfied, the command is executed; when not satisfied, the command is not 
executed.
Example: When Trigger Type is Rising-edge and Device Address is LM0

The command is executed when LM0 changes from 0 to 1.

■ Trigger Type
Selects the condition to execute the command from the following.

LM0:

MICRO/I

0

LM0: 1

Not 
executed

Executed

Condition 
Not 

satisfied

Condition 
Satisfied

Rising-edge: Command is executed when a value of device address changes from 0 to 1.

Falling-edge: Command is executed when a value of device address changes from 1 to 0.

Satisfy the condition: Command is executed when condition changes from not satisfied to satisfied.

Value of
device address

1

0

Action Execution Execution Execution

Value of
device address

1

0

Action Execution Execution

Action

Condition
Satisfied

Not satisfied

Execution Execution Execution
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■ Data Type
Selects the data type to be handled by the condition formula.
Can only be set if Satisfy the condition or While satisfying the condition is selected as Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

■ Device Address
Specifies the bit device or the bit number of the word device to serve as condition.
Can only be set if Rising-edge or Falling-edge is selected as Trigger Type.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.

■ Condition
Sets the condition formula.
Can only be set if Satisfy the condition or While satisfying the condition is selected as Trigger Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expression configuration 
procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-71.

■ Period
Sets the period for command execution from 1 to 3600 (seconds).
Can only be set if Fixed Period is selected as Trigger Type.

■ Comment
Used for entering comments about trigger conditions. The maximum number is 80 characters.

While satisfying the condition: 

The command continues being executed while the condition is satisfied.

Fixed Period: Command executes within a fixed time interval.

Action

Condition
Satisfied

Not satisfied

Execution ExecutionExecution ExecutionExecution

Fixed time interval Fixed time interval Fixed time interval

Action Execution Execution ExecutionExecution
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● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Used for entering comments about parts. The maximum number is 80 characters.
Example: When mousing over the Script Command on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.
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6.1 How the Multi-Command is Used

Executes multiple commands at once.
These commands can be assigned to a Multi-Command.

• Writes a 1 to a bit device, and the value in a word device to another device when the trigger condition is satisfied.

• Outputs a screenshot of the current screen to an external memory device*1, and then switches the Base Screen 
when the trigger condition is satisfied.

*1 SD memory card for HG5G/4G/3G/2G-V, HG4G/3G and HG2G-5F, USB flash drive for HG2G-5T and HG1G/1P

6 Multi-Command

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

Command Description

Bit Write Writes a 0 or 1 to the specified bit device.

Word Write
Writes a value to a word device. You can specify the destination address number indirectly, and perform 
arithmetic on the value to be written.

Goto Screen Switches screens and opens other windows.

Print Outputs a screenshot to the printer or the external memory device*1.

Key Performs downloads, uploads, and file copying. Also used to manipulate other parts.

Script Executes a script.

MICRO/I External device

1

Condition

SatisfiedSatisfiedSatisfied

0

D0= 123

D1= 0

D0= 123

D1= 123

Move

USB flash drive

SD memory card

External Memory Device

MICRO/I

Image file

Condition

SatisfiedSatisfiedSatisfied
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6.2 Multi-Command Configuration Procedure

This section describes the configuration procedure for Multi-Commands.

1 On the Home tab, in the Parts group, click Commands, and then click Multi-Command.

2 Click a point on the edit screen where you wish to place the Multi-Command.

3 Double-click the dropped Multi-Command and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.
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6.3 Properties of Multi-Command Dialog Box

This section describes items and buttons in the Properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ Multi-Functions
Add and edit commands to be executed when the trigger condition is satisfied.

Function List: Lists the commands to be executed.

Command Type: Shows the command type.

Command Name: Shows the command name.

Device Address: Shows the setting when one of the following Command Type is selected.
Shows the destination device address for the Bit Write and Word Write 
commands.
Shows the screen number when Goto Screen is set to Switch to Base 
Screen, Open Popup Screen, or Close Popup Screen.
Shows the script ID for the Script command.

• Executes only the Goto Screen command at the end of the Function List when multiple Switch to Base 
Screen type commands are set for Action Mode.

• Goto Screen commands are not executed from top to bottom as they appear in the Function List. 
Rather, they are executed at the end of the scan when the trigger condition is satisfied.

• Key commands are executed in the scan that follows a scan that satisfies the trigger condition.
• If multiple Key commands are set, only the first and second Key commands in the Function List are 

executed. The third and following Key commands are not executed. Also, only the first Key command that 
specifies a Data Transfer function in the Function List is executed if multiple Key commands are set.

Command Type: Select the command to add.

Bit Write: Writes a 0 or 1 to the bit device or the bit number of the word device. For details, 
refer to “Properties of Bit Write for Multi-Functions Dialog Box” on page 12-42.

Word Write: Writes a value to a word device. Can be used to indirectly specify the destination 
address number or to perform operations on the written value. For details, refer 
to “Properties of Word Write for Multi-Functions Dialog Box” on page 12-43.
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Goto Screen: Switches to another screen or displays a window. For details, refer to “Properties 
of Goto Screen for Multi-Functions Dialog Box” on page 12-45.

Print: Outputs a screenshot to a printer or an external memory device. For details, refer 
to “Properties of Print for Multi-Functions Dialog Box” on page 12-47.

Key: Performs a variety of functions including uploading and downloading, copying
files, and operating other parts. For details, refer to “Properties of Key for Multi-
Functions Dialog Box” on page 12-49.

Script: Executes a script. For details, refer to “Properties of Script for Multi-Functions 
Dialog Box” on page 12-55.

Add: Adds a command to the list. A maximum of 32 commands may be added.
Click this button to display the Properties dialog box for the command selected from Command 
Type.

Edit: Changes a command in the list.
Click this button to display the Properties dialog box for the command selected in Function List.

Delete: Deletes a command from the list.
Select the command in the list and click this button.

Copy: Copies a command in the list.
Select a command in the list and click this button. A copy of the selected command is added to 
the end of the list.

Up: Shifts the selected command upward in the list.

Down: Shifts the selected command downward in the list.
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Properties of Bit Write for Multi-Functions Dialog Box

Sets the Bit Write command for the Multi-Command.

■ Command Name
Enter a name for the command. The maximum number is 20 characters.

■ Action Mode
Select the action to perform when the trigger condition is satisfied from the following:

■ Destination Device Address
Specify the destination bit device.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.

■ Write*1

Specify the number of bit devices (1 to 64) at the destination.

This setting is enabled only if Action Mode is set to Set or Reset. For details, refer to “Write*1” on page 12-5.

■ Source Data
Specifies the device address where the data to be written is stored.
This setting is enabled only if Action Mode is set to Move. For details, refer to “Source Data” on page 12-5.

*1 Advanced mode only

Set: Writes a 1 to the specified bit device when the trigger condition is satisfied.

Reset: Writes a 0 to the specified bit device when the trigger condition is satisfied.

Set & Reset: Writes a 1 to the specified bit device when the trigger condition is satisfied.
When the trigger condition is no longer satisfied, a 0 is written to the specified bit device.

Toggle: Toggles the value of the specified bit device when the trigger condition is satisfied.
If the value of the bit device is 0 it changes to 1, and vice versa.

Move: This function writes the value in the source bit device to the value in the destination bit device 
when the trigger condition is satisfied.

For details about the Action Mode, refer to “Action Mode” on page 12-4. However, Set & Reset for the 
Multi-Command has the same function as Momentary for the Bit Write Command.

Device Address: Specify the source bit device.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 
2 “5.1 Device Address Settings” on page 2-68.

Transfer: Specify the number of bit devices (1 to 64) to move.
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Properties of Word Write for Multi-Functions Dialog Box

Sets the Word Write command for the Multi-Command. 

■ Command Name
Enter a name for the command. The maximum number is 20 characters.

■ Action Mode
Select the action to perform when the trigger condition is satisfied from the following:

■ Data Type
Select the data type handled by the operation selected for Action Mode.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.
UBIN16(W) and UBIN32(D) can only be set if Action Mode is set to OR, AND, or XOR.

■ Source 1
Specify the source word device.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.
This setting is enabled only if Action Mode is set to Add, Sub, Multi, Div, Mod, OR, AND, or XOR.

Set: Writes a fixed value to the specified word device when the trigger condition is satisfied.

Move: Writes the value in the source device address to the destination word device when the trigger 
condition is satisfied.

Set ON & OFF Data: Writes a fixed value of ON Data to the specified word device when the trigger condition is 
satisfied.
Writes a fixed value of OFF Data to the specified word device when the trigger condition is 
no longer satisfied.

Add, Sub, Multi, Div, Mod, OR, AND, XOR: Performs arithmetic on the value of source device address and a fixed 
value or a value of device address and writes the result to a word device 
when the trigger condition is satisfied.

For details about the Action Mode, refer to “Action Mode” on page 12-12. However, Set ON & OFF Data 
for the Multi-Command has the same function as Momentary for the Word Write Command. 

UBIN16(W) and UBIN32(D) can only be set if Action Mode is set to Move. Because the number of 
device addresses to transfer is specified in Advanced mode, you do not need to set Data Type.

If BCD4(B), BCD8(EB), or Float32(F) is selected and the arithmetic data contains a value inexpressible 
in BCD, a 1 is written to System Area 2 Processing error bit (address number+2, bit 5) and an error 
message is displayed. For details, refer to Chapter 4 “Processing error” on page 4-32 and Chapter 36 
“Processing error” on page 36-3.
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■ Source Data
Select the data handled by the operation selected for Action Mode.

■ Destination Device Address

*1 Advanced mode only

Value: Use a constant value.
Only a Value can be handled if Action Mode is set to Set or Set ON & OFF Data.
If Action Mode is set to Set ON & OFF Data, the value in the ON Data is written when the 
trigger condition is satisfied, and the value in the OFF Data when the trigger condition is no longer 
satisfied.

Hexadecimal: Select this check box to enter the ON Data and OFF Data values as a 
hexadecimal.

Device Address: Use a value of device address.
Specify the device address.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 
2 “5.1 Device Address Settings” on page 2-68.

Use Reference Device Address*1: Select this check box and specify a device address to change 
the source word device according to the value of the specified 
device address.
This setting is enabled only if Action Mode is set to Move.
For details, refer to Chapter 2 “Indirect Read and Indirect 
Write Settings” on page 2-5.

Transfer*1: Specify the number of word devices (1 to 64) to transfer.
This setting is enabled only if Action Mode is set to Move.

For details, refer to “Transfer*1” on page 12-14.

Destination Device Address: Specify the destination word device.

Click  to display the Tag Editor. For the device address configuration 
procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-68.

Use Reference Device Address*1: Select this check box and specify a device address to change the destination word 
device according to the value of the specified device address.
This setting is enabled only if Action Mode is set to Move.
For details, refer to Chapter 2 “Indirect Read and Indirect Write Settings” on page 
2-5.

Write*1: Specify the number of word devices (1 to 64) at the destination.
For Move, specify how many times to write.
This setting is enabled only if Action Mode is set to Set, Move, or Set ON & OFF 
Data.

For details, refer to “Write*1” on page 12-14.
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Properties of Goto Screen for Multi-Functions Dialog Box

Sets the Goto Screen command for the Multi-Command. 

■ Command Name
Enter a name for the command. The maximum number is 20 characters.

■ Action Mode
Select the action to perform when the trigger condition is met from the following:

*1 This is applicable for models with a video interface only.

Back to previous Screen: Switches to the previous screen. Returns to up to 16 earlier screens.

Switch to Base Screen: Switches between Base Screen.

Open Popup Screen: Opens a Popup Screen.

Close Popup Screen: Closes a Popup Screen.

Open Device Monitor Screen: Opens the Device Monitor Screen.

Close Device Monitor Screen: Closes the Device Monitor Screen.

Open Password Screen: Opens the Password Screen.

Close Password Screen: Closes the Password Screen.

Open Adjust Brightness Screen: Opens the Adjust Brightness Screen.

Close Adjust Brightness Screen: Closes the Adjust Brightness Screen.

Open File Screen for movie files*1: Opens the File Screen.

Close File Screen for movie files*1: Closes the File Screen.

Switch to System Mode: Switches to the Top Page in the System Mode.

Reset current screen: Resets the current Base Screen.

Open User Account Setting Screen: Opens the User Account Setting Screen. For details, refer to Chapter 23 “5 
Editing User Accounts on the MICRO/I” on page 23-49.
When User Account Setting Screen is selected, the Configure 
Processing Area of User Account Setting Screen dialog box will be 
displayed. For details, refer to Chapter 8 “Configure Processing Area of User 
Account Setting Screen Dialog Box” on page 8-44.
Specify the word device to use as the processing area of the User Account 
Setting Screen and click OK. When you return to the properties dialog box, 
Edit will be displayed.

Edit: Click this button to display the Configure Processing Area of User 
Account Setting Screen dialog box.

When the current Base Screen is reset using the Reset current screen function, the window and internal 
devices restart as if the Base Screens were switched.
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■ Goto Screen

*1 This is applicable for models with a video interface only.
*2 Advanced mode only

Screen Number: If Action Mode is set to Switch to Base Screen, specify the Base Screen number to switch to 
(from 1 to 3000). If Action Mode is set to Open Popup Screen or Close Popup Screen, 
specify the number of the Popup Screen to open or close (from 1 to 3015).
This setting is enabled only if Action Mode is set to Switch to Base Screen, Open Popup
Screen, or Close Popup Screen.

Use Reference Device Address*2: Select this check box and specify a device address to specify 
the screen number using the value of the specified device 
address.

Click  to display the Tag Editor. For the device address 
configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.
This setting is enabled only if Action Mode is set to Open 
Popup Screen or Close Popup Screen.

Coordinates X, Y: Specify the coordinates on the Base Screen for displaying a window.
X and Y specify the upper left corner of the window using the upper left corner of the screen as 
the origin.
This setting is enabled only if Action Mode is set to Open Popup Screen, Open Device 
Monitor Screen, Open Password Screen, Open Adjust Brightness Screen, or Open File 
Screen for Movie Files*1.

Use Reference Device Address*2: Select this check box and specify a device address to specify 
the coordinates using the value of the specified device address.

Click  to display the Tag Editor. For the device address 
configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.
This setting is enabled only if Action Mode is set to Open 
Popup Screen.
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Properties of Print for Multi-Functions Dialog Box

Sets the Print command for the Multi-Command.

■ Command Name
Enter a name for the command. The maximum number is 20 characters.

■ Output to
Select where to direct the screenshot to.

■ Action Mode
Select the behavior of the button from the following. This option is only displayed when Printer is selected in Output to.

*1 HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F only
*2 SD memory card for HG5G/4G/3G/2G-V, HG4G/3G and HG2G-5F, USB flash drive for HG2G-5T and HG1G/1P

Printer*1: Outputs the screenshot to the printer connected to the MICRO/I.

Print Time Stamp: Adds the date and time of printing to the screenshot before 
sending it to the printer.
The date and time format depends on the language selected in 
Language. Language is available on the Project Details tab of 
the Project Settings dialog box.
The display formats are shown below:
• Japanese: YYYY/MM/DD hh:mm
• English: MM/DD/YYYY hh:mm
YYYY: year, MM: month, DD: day, hh: hour, mm: minute

External Memory Device*2: Outputs the screenshot as a file to the external memory device inserted in the MICRO/I.
Files are output as follows:

File format File name File size

JPEG
CAP***.JPG (***: date and time when file was output)
Example: A file created at 18:50:25 on June 30, 2011 

will be named “CAP110630_185025.JPG”.

Depends on image 
being displayed.

• For details about printers, refer to Chapter 32 “Printer” on page 32-1.
• For details about external memory devices, refer to Chapter 31 “External Memory Devices” on page 31-1.

Print Screen: Outputs a screenshot of the current screen to the printer or the external memory device.

Cancel Printing*1: Cancels printout to the printer.
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*1 HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F only

• These operations cannot be performed simultaneously.
- Outputting to the external memory device by pressing the Multi-Command.
- Outputting to the printer by pressing the Multi-Command.*1

- Printing alarm logs
• It may take some time to output screenshots when copying files using the USB Autorun function or a Key 

Button.
• MICRO/I cannot stop printing in the middle of a page, even when the print job is canceled. Print jobs 

after the current print job are canceled after the current page finishes printing.

The maximum number of screenshots that can be captured (1 to 999) can be set in HMI Special Data 
Register LSD65. (Default: 99)

The methods to erase screenshot files saved on the external memory device are as follows.
• To erase files during operation using parts, on the External Memory Device tab on the Project 

Settings dialog box, select the Remove Files check box and the All Screenshot data check box, and 
then configure the trigger device address. Assign that trigger device address to a part.

• To erase files with WindO/I-NV4, click Clear on the Online tab, and then click Stored Data in External 
Memory Device to open the Clear Data dialog box. Select the Screenshot Data check box and click 
OK.

• To erase files on the HG5G/4G/3G/2G-V, HG4G/3G and the HG2G-5F, go to the System Mode - File 
Manager. In the File Manager, select the files to be deleted by pressing DEL.
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Properties of Key for Multi-Functions Dialog Box

Sets the Key command for the Multi-Command. 

■ Command Name
Enter a name for the command. The maximum number is 20 characters.

■ Key Type
Select the function for the Key Button

The settings explained below appear depending on the type of key selected.

■ Popup Screen Number
The Alt key switches the current Popup Screen used as a Keypad when this button is pressed.
Specify the Popup Screen number to open a Keypad for.
This setting is enabled only if Alt was selected using the Key Browser.

Displays settings 
applicable to the 
selected key.

(Key)

Language: Switches the display of the key that is displayed when Keypad is selected in Key Browser. These 
languages are available:
Japanese, European, Central European, Baltic, Cyrillic.

Browse: Opens the Key Browser when clicked. Select a key.
For details, refer to Chapter 8 “5.5 Key Browser” on page 8-98.

(Key): Displays the name of the key selected using the Key Browser.

• When you select a key for Multi-Button or Multi-Command, the label for that key is not assigned as the 
Registration Text.

• The function of Key Button will affect on the next scan when the trigger condition is satisfied.
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■ Scroll Size
Key Buttons Page Up and Page Down scroll the list up and down, respectively. Key Buttons Up and Down move 
the focus up and down, respectively. This settings specifies the number of pages or lines (1 to 1023 lines) to scroll or 
move the focus per each press of the button.
This setting is enabled only if Page Up, Page Down, Up, and Down are selected using the Key Browser.

■ Transfer Setting
Key Buttons Download Project, Upload Project, Copy Files, Download PLC Program, and Upload PLC 
Program, perform the data transfer function specified by their names. These settings specify the source, data to be 
transferred, and destination.
This setting is enabled only if one of these keys is selected after clicking Data Transfer in the Key Browser.

If Download Project is selected.

*1 HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F only

Source: Select the the external memory device where the project (ZNV Project File) to be transferred is stored: 

SD Memory Card*1 or USB Flash Drive.

Location: Specify the location of the ZNV Project File(.znv). The maximum number is 247 characters.
Example: Where “HG3G_DEMO_1.ZNV” is a ZNV Project File saved on the root directory of 

an SD memory card or USB flash drive: 
HG3G_DEMO_1.ZNV

Destination:

Clear Keep Devices:

Select this check box to clear keep devices after the project data is downloaded. However, 
when project data that changes the system software or settings of the data storage area is 
downloaded, the keep devices are always cleared.

When project data is downloaded, the alarm log data, data log data, and operation log data is deleted 
regardless of the state of the Clear Keep Devices check box.
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If Upload Project is selected.

If Copy Files*1 is selected.

*1 HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F only

Destination: Specify where to save the project uploaded from MICRO/I. Select the location:

SD Memory Card*1 or USB Flash Drive.

Location: Specify the location of the folder where the uploaded project will be saved. The 
maximum number is 247 characters.
Example: To save it to the folder “Uploaded_Project” on an SD memory card or USB flash 

drive: 
Uploaded_Project

A uploaded project using the Data Transfer function is saved as a ZNV Project File(.znv).

Source: Select the source external memory device: SD Memory Card or USB Flash Drive.

Location: Specify the location of the file to be transferred. The maximum number is 247 
characters.
Example: Where “Error.wav” is a sound file saved on the root directory of an SD memory 

card or USB flash drive:
Error.wav

Destination: Select the destination external memory device: SD Memory Card or USB Flash Drive.

Location: Specify the location where the file will be transferred. The maximum number is 247 
characters.
Example: To save it to the folder “SOUND” inside “HGDATA01” on an SD memory card or 

USB flash drive:
HGDATA01\SOUND

• If a file name is specified as the source location, the specified file is copied.
If a folder name is specified, all of the files and subfolders contained in the folder, and all of the files in 
the subfolders, are copied.

• The subfolders can be copied up to five levels.
• To prevent copying the subfolders and the files contained in the subfolders, HMI Special Internal Relay 

LSM30 must be set to 1 before executing the copy.
• To stop copying files during the copy operation, write 1 to HMI Special Internal Relay LSM31. However, it 

will continue to copy the file until it is finished then it will stop copying.
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If Download PLC Program is selected.

*1 HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F only

Source: Select the the external memory device where the PLC program (ZLD Project File) to be transferred is 
stored: SD Memory Card*1 or USB Flash Drive.

Location: Specify the location of the ZLD Project File(.zld). The maximum number is 247 characters.
Example: Where “LDR_PROGRAM.ZLD” is a ZLD Project File saved in folder “LDRDATA” of 

an SD memory card or USB flash drive:
LDRDATA\LDR_PROGRAM.ZLD

Destination: Specify the destination PLC connected to the MICRO/I. The PLC type is configured in the Project 
Settings dialog box, on the Communication Driver Network tab. For details, refer to Chapter 4 
“3.4 Communication Driver Network Tab” on page 4-50.

Interface: Select the communication interface in which the MICRO/I is connecting to the download 
destination PLC from serial interface or Ethernet. For details, refer to Chapter 4 “Interface 
Configuration” on page 4-35.

If serial interface is selected for Interface.

Slave Number: Specify the slave number of the download destination PLC (0 to 31).

External Device Name: The name of the specified PLC is displayed here.

If Ethernet is selected for Interface.
Select from the following method:

Specify External Device ID: Specify the External Device ID (0 to 31) of the destination PLC. This is the 
External Device ID number set in the Project Settings dialog box, on the 
Communication Driver Network tab.

External Device Name: The name of the specified PLC is displayed here.

Specify IP Address: Specify the IP address and port number of the destination PLC.
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If Upload PLC Program is selected.

*1 HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F only

Source: Specify the source PLC connected to the MICRO/I. The PLC type is configured in the Project Settings 
dialog box, on the Communication Driver Network tab. For details, refer to Chapter 4 “3.4 
Communication Driver Network Tab” on page 4-50.
Interface: Select the communication interface in which the MICRO/I is connecting to the download 

destination PLC from serial interface or Ethernet. For details, refer to Chapter 4 
“Interface Configuration” on page 4-35.

If serial interface is selected for Interface.
Slave Number: Specify the slave number of the upload source PLC (0 to 31).
External Device Name: The name of the specified PLC is displayed here.

If Ethernet is selected for Interface.
Select from the following method:

Specify External Device ID: Specify the External Device ID (0 to 31) of the upload source PLC. This 
is the External Device ID number set in the Project Settings dialog 
box, on the Communication Driver Network tab.

External Device Name: The name of the specified PLC is displayed here.
Specify IP Address: Specify the IP address and port number of the upload source PLC.

Destination: Specify where to save the PLC program uploaded from the PLC connected to the MICRO/I. Select the 
type of external memory device: SD Memory Card*1 or USB Flash Drive.
Location: Specify the location of the folder where the uploaded PLC program will be saved. The 

maximum number is 247 characters.
Example: To save it to the folder “Uploaded_Program” on an SD memory card or USB flash 

drive: 
Uploaded_Program

A uploaded PLC program using the Data Transfer function is saved as a ZLD Project File(.zld).
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■ Recording Channel*2

The recording of images starts.
Selects Channel 1 or Channel 2 to record a video only (no audio) out of the signals input from the device. This 
setting is enabled only if Rec. was selected using the Key Browser.

■ Recording Target*3

The recording of images and sound starts. 
Select the target to record out of the signals input from the device. This setting is enabled only if Rec. was selected 
using the Key Browser.

*2 HG5G/4G/3G-V only
*3 This is applicable for HG4G/3G with a video interface only.

• Movie files cannot be recorded during playback.
• While data is being recorded after an event occurs with the event recording function and while data is 

being saved to the external memory device, recording cannot be executed with a Key Button, Multi-
Button, or Multi-Command configured with the recording function. Also, during these situations, the 
value of HMI Special Data Register LSD155-0 changes to 1. For details, refer to Chapter 33 “HMI Special 
Data Register (LSD)” on page 33-7.

Video and Audio: Records images and sound.
Video only (No Audio): Records images only.

• Movie files cannot be recorded during playback.
• While data is being recorded after an event occurs with the event recording function and while data is 

being saved to the external memory device, recording cannot be executed with a Key Button, Multi-
Button, or Multi-Command configured with the recording function. Also, during these situations, the 
value of HMI Special Data Register LSD155-0 changes to 1. For details, refer to Chapter 33 “HMI Special 
Data Register (LSD)” on page 33-7.
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Properties of Script for Multi-Functions Dialog Box

Sets the script for the Multi-Command.

■ Command Name
Enter a name for the command. The maximum number is 20 characters.

■ Script ID
Specify the script ID (1 to 32000) of the script to operate.

Script Manager will open when  is clicked. Select a script from the script list.
For details, refer to Chapter 20 “2.2 Script Manager” on page 20-7.

■ Script Name
Displays the name of the script selected in Script Manager.

■ (Script)
Displays the contents of the script selected in Script Manager.
Once this area is double clicked, the Script Editor will open and editing can be done.
For details, refer to Chapter 20 “2.3 Script Editor” on page 20-12.

(Script)
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● Trigger Condition Tab

When the condition has been or is satisfied, the command is executed; when not satisfied, the command is not 
executed.
Example: When Trigger Type is Rising-edge and Device Address is LM0

The command is executed when LM0 changes from 0 to 1.

■ Trigger Type
Selects the condition to execute the command from the following.

LM0:

MICRO/I

0

LM0: 1

Not 
executed

Executed

Condition 
Not 

satisfied

Condition 
Satisfied

Rising-edge: Command is executed when a value of device address changes from 0 to 1.

Falling-edge: Command is executed when a value of device address changes from 1 to 0.

Value of
device address

1

0

Action Execution Execution Execution

Value of
device address

1

0

Action Execution Execution
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■ Data Type
Selects the data type to be handled by the condition formula.
Can only be set if Satisfy the condition or While satisfying the condition is selected as Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

■ Device Address
Specifies the bit device or the bit number of the word device to serve as condition.
Can only be set if Rising-edge or Falling-edge is selected as Trigger Type.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.

■ Condition
Sets the condition formula.
Can only be set if Satisfy the condition or While satisfying the condition is selected as Trigger Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expression configuration 
procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-71.

■ Comment
Used for entering comments about trigger conditions. The maximum number is 80 characters.

Satisfy the condition: Command is executed when condition changes from not satisfied to satisfied.

While satisfying the condition: 

The command continues being executed while the condition is satisfied.

Action

Condition
Satisfied

Not satisfied

Execution Execution Execution

Action

Condition
Satisfied

Not satisfied

Execution ExecutionExecution ExecutionExecution
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● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Used for entering comments about parts. The maximum number is 80 characters.
Example: When mousing over the Multi-Command on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.
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7.1 How the Timer is Used

Starts a countdown when the trigger condition is satisfied, and writes 1 to an internal device (HMI Timer Relay LTC) 
once the set time has elapsed.

7 Timer

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

MICRO/I

LTD0

0

1

LTC0: 0

LTC0: 1

1999 1998 999 1 0
LTD0

Start countdown Set �me 
has elapsed

Condition

SatisfiedSatisfiedSatisfied

Start 
countdown

0 0 1 0

Writes 1 
to LTC0

Writes the 
preset value 

to LTD0 and 0 
to LTC0

State of condition

Action

HMI Timer Relay 
LTC0 value

HMI Timer Current Value 
LTD0 value 19991999 1998 999 1 19990

Condition Condition Condition Condition

Not satisfiedNot satisfiedNot satisfied SatisfiedSatisfiedSatisfied SatisfiedSatisfiedSatisfied Not satisfiedNot satisfiedNot satisfied

• The HMI Timer Relay LTC is an internal device (bit device) that changes to 1 once the time set for the 
timer has elapsed.

• The HMI Timer Current Value LTD is an internal device (word device) that stores current values for the 
timer.

• Once switched to the screen that the timer has been placed in, the following values will be given 
regardless of the whether the trigger condition is satisfied or not satisfied.
- HMI Timer Relay LTC: 0
- HMI Timer Current Value LTD: Preset Value



7 Timer

12-60 WindO/I-NV4 User’s Manual

7.2 Timer Configuration Procedure

This section describes the configuration procedure for Timers.

1 On the Home tab, in the Parts group, click Commands, and then click Timer.

2 Click a point on the edit screen where you wish to place the Timer.

3 Double-click the dropped Timer and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.
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7.3 Properties of Timer Dialog Box

This section describes items and buttons in the Properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ Timer Address Number
Specifies the HMI timer address number (0 to 31).
The device type for the HMI timer relay is LTC. The device type where the current value is stored is LTD.

■ Unit
Select the unit of time from sec or 100 msec.

■ Preset Value
Select the data type to use and the enter the preset value.
The preset value is the time from when the timer starts its countdown until 1 is written to the HMI Timer Relay LTC.

Example: When 0 is specified for Timer Address Number

HMI Timer Relay: LTC0

HMI Timer Current Value: LTD0

Value: When selecting sec in Unit, the preset value is specified with 1 to 65535 (second units) up to a 
maximum of 1092 minutes 15 seconds.
When selecting 100 msec in Unit, the preset value is specified with 1 to 65535 (100 msec units).

Device Address: Uses a value of device address.
Specify the device address.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 
2 “5.1 Device Address Settings” on page 2-68.
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● Trigger Condition Tab

When the condition has been or is satisfied, the command is executed; when not satisfied, the command is not 
executed.
Example: When Trigger Type is Rising-edge and Device Address is LM0

The command is executed when LM0 changes from 0 to 1.

■ Trigger Type
Selects the condition to execute the command from the following.

LM0:

MICRO/I

0

LM0: 1

Not 
executed

Executed

Condition 
Not 

satisfied

Condition 
Satisfied

While ON: Command is executed when a value of device address is 1.

While OFF: Command is executed when a value of device address is 0.

While satisfying the condition: 

The command continues being executed while the condition is satisfied.

1

0

Value of
device address

Action Execution Execution Execution

1

0

Action

Value of
device address

Execution Execution

Action

Condition
Satisfied

Not satisfied

Execution ExecutionExecution ExecutionExecution
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■ Data Type
Selects the data type to be handled by the condition formula.
Can only be set if While satisfying the condition is selected as Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

■ Device Address
Specifies the bit device or the bit number of the word device to serve as condition.
Can only be set if While ON or While OFF is selected as Trigger Type.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.

■ Condition
Sets the condition formula.
Can only be set if While satisfying the condition is selected as Trigger Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expression configuration 
procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-71.

■ Comment
Used for entering comments about trigger conditions. The maximum number is 80 characters.
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● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Used for entering comments about parts. The maximum number is 80 characters.
Example: When mousing over the Timer on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.
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This chapter describes how to configure the Alarm Log function and its operation on the MICRO/I.

  

1.1 How the Alarm Log Function is Used

The Alarm Log function samples the occurrence of alarms and recovery information by monitoring and evaluating the 
state of device addresses.
The Alarm Log function can perform the following functions.

• Monitor states of device addresses and create Alarm Log data

• Monitor states of device addresses and detect alarms

• Display an alarm screen when an alarm occurs

• Make a sound of the buzzer and screen flashing the screen when an alarm occurs

Chapter 13 Alarm Log Function

1 Overview

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

MICRO/I

External device

0 1

12:00

01

12:53

12:00
Alarm occurred

12:53    Recovered

12:54    Confirmed

Alarm Log data

 No. Message  Occurrence Time  Recovery Time Confirmation Time

 1-1 Voltage drop  12/01/2011 12:00:00 12/01 12:53:10 12/01 12:54:30

MICRO/I

External device

0 1 Alarm occurred

MICRO/I

External device

0 1 Voltage 
drop

Alarm screen

Alarm occurred

MICRO/I

External device

0 1
Beep

Alarm occurred
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• Output Alarm Log data to the external memory device*1

• Output Alarm Log data to the printer

*1 SD memory card for HG5G/4G/3G/2G-V, HG4G/3G and HG2G-5F, USB flash drive for HG2G-5T and HG1G/1P

Output to 
External memory device

Alarm Log data (CSV)

External Memory Device

MICRO/I

USB flash drive

SD memory card

Output to printer

PrinterMICRO/I

HG3G HG2G-5FHG4G
HG5G-V HG4G-V HG3G-V HG2G-V

For compatible printers and instructions on how to connect one to the MICRO/I, refer to Chapter 32 “1.2 
Connecting a Printer to MICRO/I” on page 32-1.
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1.2 Alarm States

Alarms have three states: occurred, recovered, and confirmed.

Example: When the source device address (the device address to monitor) is D100-0, the error state (when an alarm 
has occurred) is ON, the channel is set to Unlock, and the used key button is CHECK
When the source device address is ON, the alarm changes to the “Occurred” state. When the source device 
is OFF, the alarm changes to the “Recovered” state. When CHECK is pressed, the alarm changes to the 
“Confirmed” state.

If CHECK is pressed before the source device address changes to OFF, the alarm changes to the “Confirmed” 
state regardless of the state of the source device address.

Alarm state Details

Occurred
Indicates that an alarm has occurred. There are two types of alarms that occur.
First Alarm: The first alarm that occurs in a state where no alarms have occurred.
Second and later: An alarm that has occurred while another alarm is active.

Recovered
Indicates that the alarm that occurred has been recovered from.
However, for channels set to lock, the alarm is not recovered from until a key button is pressed 
(CHECK or All Chk.).

Confirmed Indicates the key button CHECK or All Chk. was pressed.

Record occurrence time D100-0 : ON

D100-0 : OFF

D100-0 : OFF

Source device address state

Occurred

Record recovery time Recovered

Record confirmation time Confirmed

Alarm Log data

Press CHECK

No alarm 
occurring state

NO/NC is NO, so the state is 

“Occurred”

Lock/Unlock is Unlock, so the 

state is “Recovered”

Alarm state

Record occurrence timeD100-0 : ON

D100-0 : OFF

Alarm state

Occurred

Record confirmation time Confirmed

Record recovery time  Recovered

Alarm Log data

Press CHECK

D100-0 : OFF

Source device address state
No alarm 

occurring state

NO/NC is NO, so the state is 

“Occurred”

Lock/Unlock is Unlock, so the 

state is “Recovered”
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1.3 Sampling Data

Data is sampled each time the alarm occurs, is recovered from, or confirmed. 
Example: When the message for channel number 1-1 is “Voltage drop” and the message for channel number 1-2 is 

“Temperature abnormal”

1
Channel No. 1-1: Alarm occurred Ch.No. Message Occurrence Time Recovery Time Confirmation Time

(12:50:00) 1-1 Voltage drop 12/01/2011 12:50:00 ‒ ‒

Channel No. 1-2: No alarm

2

Channel No. 1-1: Alarm Ch.No. Message Occurrence Time Recovery Time Confirmation Time

(12:50:00) 1-1 Voltage drop 12/01/2011 12:50:00 ‒ ‒

Channel No. 1-2: Alarm occurred
1-2

Temperature 
abnormal

12/01/2011 12:50:10 ‒ ‒
(12:50:10)

3

Channel No. 1-1: Recovered from alarm Ch.No. Message Occurrence Time Recovery Time Confirmation Time

(12:50:20) 1-1 Voltage drop 12/01/2011 12:50:00 12/01 12:50:20 ‒

Channel No. 1-2: Alarm
1-2

Temperature 
abnormal

12/01/2011 12:50:10 ‒ ‒
(12:50:10)

4

Channel No. 1-1: CHECK pressed Ch.No. Message Occurrence Time Recovery Time Confirmation Time

(12:50:30) 1-1 Voltage drop 12/01/2011 12:50:00 12/01 12:50:20 12/01 12:50:30

Channel No. 1-2: Alarm
1-2

Temperature 
abnormal

12/01/2011 12:50:10 ‒ ‒
(12:50:10)

5

Channel No. 1-1: Alarm occurred Ch.No. Message Occurrence Time Recovery Time Confirmation Time

(12:51:00) 1-1 Voltage drop 12/01/2011 12:50:00 12/01 12:50:20 12/01 12:50:30

Channel No. 1-2: Alarm
1-2

Temperature 
abnormal

12/01/2011 12:50:10 ‒ ‒
(12:50:10)

1-1 Voltage drop 12/01/2011 12:51:00 ‒ ‒

6

Channel No. 1-1: Alarm Ch.No. Message Occurrence Time Recovery Time Confirmation Time

(12:51:00) 1-1 Voltage drop 12/01/2011 12:50:00 12/01 12:50:20 12/01 12:50:30

Channel No. 1-2: CHECK pressed
1-2

Temperature 
abnormal

12/01/2011 12:50:10 ‒ 12/01 12:52:10
(12:52:10)

1-1 Voltage drop 12/01/2011 12:51:00 ‒ ‒

7

Channel No. 1-1: Alarm Ch.No. Message Occurrence Time Recovery Time Confirmation Time

(12:51:00) 1-1 Voltage drop 12/01/2011 12:50:00 12/01 12:50:20 12/01 12:50:30

Channel No. 1-2: Recovered from alarm
1-2

Temperature 
abnormal

12/01/2011 12:50:10 12/01 12:53:00 12/01 12:52:10
(12:52:10)

1-1 Voltage drop 12/01/2011 12:51:00 ‒ ‒
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1.4 Data Configuration

The sampled data is composed of the channel number, message, alarm state, time, and label.
The relationship between the Alarm Log function settings and the sampled data is as follows.

1. Data storage amount: The amount of data that can be saved in the data storage area. For details, refer to “Data 
Storage Amount” on page 13-8.

2. Channel No.: Composed of (Block No.)-(Channel No.). The device addresses to monitor and the conditions 
for alarm occurrence and recovery are configured in the channels. When the sampled data is 
output as a CSV file, the displayed label is “Ch.No.”.

3. Message: The message displayed when an alarm has occurred.

4. Alarm state and time: The alarm state (occurred, recovered, confirmed) and the time the alarm occurred, was 
recovered from, and confirmed. When the sampled data is output as a CSV file, the 
displayed label varies based on the output method.

5. Label: When the sampled data is output as a CSV file, this is the text displayed in the label row.
This cannot be changed.

 Ch.No. Message Occurrence Time Recovery Time Confirma�on Time

 1-1 Voltage drop 12/01/2011 12:00:05 12/01 12:01:10 12/01 12:01:30

 1-2 Temperature abnormal  12/01/2011 12:01:09 12/01 12:02:21 12/01 12:02:55

 1-1 Voltage drop 12/01/2011 12:02:00 12/01 12:03:11 12/01 12:05:12

 1-3 Overcurrent 12/01/2011 12:30:21 12/01 12:55:15 12/01 13:00:00

 1-1 Voltage drop 12/01/2011 12:45:36 12/01 12:53:12 12/01 12:57:41

1. Data storage amount

2. Channel No.

5. Label

3. Message 4. Alarm state and �me

Alarm Log settings

Sampled data
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For sampled data, the format for displayed items varies based on the output method.

■ Batch
Batch output shows the recovery and confirmation time for an alarm that has occurred on a single line.
The labels displayed in the label row are “Ch.No.”, “Message”, “Occurrence Time”, “Recovery Time”, and “Confirmation 
Time”.
Example: When the message for channel number 1-1 is “Voltage drop” and the message for channel number 1-2 is 

“Temperature abnormal”

■ Real Time
Real time output displays the alarm state and the time the alarm became that state on a single line each time an 
alarm occurs, is recovered from, or is confirmed.
The labels displayed in the label row are “Ch.No.”, “Message”, “State”, and “Time”.
Example: When the message for channel number 1-1 is “Voltage drop” and the message for channel number 1-2 is 

“Temperature abnormal”

Ch.No. Message Occurrence Time Recovery Time Confirmation Time

1-1 Voltage drop 12/01/2011 12:50:00 12/01 12:50:20 12/01 12:50:30

1-2 Temperature abnormal 12/01/2011 12:50:10 -- 12/01 12:52:10

1-1 Voltage drop 12/01/2011 12:51:00 -- --

Ch.No. Message State Time

1-1 Voltage drop Occurred 12/01/2011 12:50:00

1-2 Temperature abnormal Occurred 12/01/2011 12:50:10

1-1 Voltage drop Recovered 12/01/2011 12:50:20
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1.5 Saving and Deleting Data

● Saving Data
You can select whether or not to save the sampled data in the data storage area. The method to save data is 
configured on the Channel tab in the Alarm Log Settings dialog box.

When Saving Data to the Data Storage Area

Select Store under Data in the Auto-Setup dialog box or in the Individual Settings dialog box.

If the number of active alarms exceeds the Alarm Log data storage amount set for the data storage area, the data is 
processed with either of the following methods.

■ Fixed
If the saved data exceeds the Alarm Log data storage amount, the new data is not saved.

■ Rotate
If the saved data exceeds the Alarm Log data storage amount, the oldest data is deleted and the new data is saved.

MICRO/I

External device

0 1

12:00

01

12:53

12:00
Alarm occurred

12:53    Recovered

12:54    Confirmed

Alarm Log data

 No. Message  Occurrence Time  Recovery Time Confirmation Time

 1-1 Voltage drop  12/01/2011 12:00:00 12/01 12:53:10 12/01 12:54:30

Alarm Log data storage amount

New data

Alarm Log data storage amount

Oldest data
(delete)

New data

When the backup battery is depleted, the data in the Alarm Log is erased when the MICRO/I is turned off.
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Data Storage Amount
The maximum amount of data that can be saved in the data storage area is as follows.

When Not Saving Data to the Data Storage Area

Select No Store under Data in the Auto-Setup dialog box or in the Individual Settings dialog box.
Use this option to monitor a state of device address and display only detected active alarms on the Alarm List Display.

● Deleting Data
The method to delete sampled data from the data storage area is as follows.
• On the Online tab in WindO/I-NV4, click the arrow under Clear, and click All or Alarm Log Data. For details, 

refer to Chapter 24 “4 Clear” on page 24-25.
• In the System Mode, on the Main Menu screen, press Initial Setting, Initialize, Alarm Log in order.

Model Maximum amount of data that can be saved in the data storage area

HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F 11,660

HG2G-5T, HG1G/1P 5,520

Alarm List Display

MICRO/I

External device

Voltage drop

0 1 Alarm occurred

Page
Up

Down
Page
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1.6 Using Data and Detected Alarms

The saved data and detected alarms can be used in the following ways.

● Using Saved Data
The saved data can be used in the following ways.

● Using Detected Alarms
• Display alarms with the Alarm List Display

Display detected alarms with the Alarm List Display.
For details, refer to “4.2 Displaying Registered Messages with the Alarm List Display According to the Active Alarm” 
on page 13-33.

*1 SD memory card for HG5G/4G/3G/2G-V, HG4G/3G and HG2G-5F, USB flash drive for HG2G-5T and HG1G/1P
*2 HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F only

• Display data with the Alarm 
Log Display
Display Alarm Log data with the 
Alarm Log Display.
For details, refer to Chapter 10 
“8 Alarm Log Display” on page 
10-152.

• Save to and read from a an 
external memory device*1

Output data from the MICRO/I to 
the external memory device as a 
CSV file and use it on a computer.
For details, refer to “4.4 Saving the 
Data as a CSV File” on page 13-39.

• Print data with the printer*2

Print Alarm Log data with the printer 
connected to the MICRO/I.
For details, refer to Chapter 32 
“Printer” on page 32-1

To use with the MICRO/I To use with devices other than the MICRO/I

Alarm Log data

 Ch.No. Message Occurrence Time Recovery Time Confirma�on Time

 1-1 Voltage drop 12/01/2011 12:00:05 12/01 12:01:10 12/01 12:01:30

 1-2 Temperature abnormal  12/01/2011 12:01:09 12/01 12:02:21 12/01 12:02:55

 1-1 Voltage drop 12/01/2011 12:02:00 12/01 12:03:11 12/01 12:05:12

 1-3 Overcurrent 12/01/2011 12:30:21 12/01 12:55:15 12/01 13:00:00

 1-1 Voltage drop 12/01/2011 12:45:36 12/01 12:53:12 12/01 12:57:41

Select

Occurred Message Recovered Confirmed
12/01 12:51 Temperature abnormal  12:53 12:52
12/01 12:00 Voltage drop 12:53 12:52

Up Down Reference

External
Memory Device

Alarm Log data (CSV)

Book1

Sheet1 Sheet2 Sheet3

No. Occurrence Time Recovery Time Confirma�on Time Message
Pressure sensor fault
Hydraulic pressure low
Pressure sensor fault
Pressure sensor fault
Hydraulic pressure low
Pressure sensor fault

Alarm List Display

MICRO/I

External device

Voltage drop

0 1 Alarm occurred

Page
Up

Down
Page
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This section describes the configuration procedure for the Alarm Log function.

2.1 Configuring the Device Addresses to Monitor and the Alarm Detection Condition

1 On the Configuration tab, in the System Setup group, click Alarm Log.

The Alarm Log Settings dialog box is displayed.

2 Select the type of device address to monitor under Source Device Address Type on the Channel tab.

If you select Word, device addresses are configured per block.
If you select Bit, device addresses are configured per channel.

3 Set the number of blocks to manage in Number of Blocks.

1 channel is used for 1 device address to monitor. 1 block is 16 channels.
The number of blocks that can be set varies based on the Source Device Address Type setting and the model.

4 Select the reference screen type in Reference Screen.

The reference screen is associated with the channel. This screen is displayed when the key button Ref. is pressed.
If a reference screen is not displayed, select Not Use.

5 To batch register all channels, click Auto. To individually register each channel, click Edit.

An example when Auto is clicked is described here.
The Auto-Setup dialog box is displayed.

2 Alarm Log Function Configuration Procedure

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P
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6 Specify the device address to monitor in Source.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.
For the Auto-Setup dialog box, the device addresses are sequentially set starting with the specified device address 
from the highlighted row in Settings.

7 Under Data, select whether or not to save Alarm Log data in the date storage area.

To display Alarm Log data on the MICRO/I or to output the data to a file, select Store.
If you select No Store, Alarm Log data is not created, but states of device addresses are monitored.

8 Under Alarm function, select whether or not to use the alarm function.

For channels with Disable selected, states of device addresses are not monitored and Alarm Log data is not created.

9 Under NO/NC, select the alarm detection condition.

If you select NO, the alarm occurs when the monitored bit changes from 0 to 1. If you select NC, the alarm occurs 
when the monitored bit changes from 1 to 0.

10 Under Lock/Unlock, select whether or not to automatically recover based on the state of the monitored bit.

If you select Unlock, the alarm is automatically recovered from based on the bit state when the monitored bit 
becomes the normal state.
If you select Lock, even if the monitored bit becomes the normal state, the alarm remains active until the key button 
CHECK is pressed.

11 Select the Text ID check box and specify the message to display when the alarm occurs as a Text Manager ID 
number (1 to 32000).

Number of blocks x 16 (number of channels) text IDs are used starting from the set ID number.

12 Specify the screen number (1 to 3000) to display when the key button Ref. is pressed in Reference Screen 
Number.

Number of blocks x 16 (number of channels) screens are used starting from the screen number.
This option can only be configured when Base Screen or Popup Screen is selected in Reference Screen.
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13 Click OK.

The device addresses to monitor and the messages are batch configured and displayed in Settings.

14 Click OK.

The Alarm Log Settings dialog box closes.
This concludes configuring the device addresses to monitor and the alarm detection condition.

Next, configure the functions to execute using saved data and detected alarms.
 “4.1 Displaying Saved Data with the Alarm Log Display” on page 13-31
 “4.2 Displaying Registered Messages with the Alarm List Display According to the Active Alarm” on page 13-33
 “4.3 Make a Sound of the Buzzer and Flash the Screen when an Alarm has Occurred” on page 13-37
 “4.4 Saving the Data as a CSV File” on page 13-39

To use the Alarm Log settings configured on the project on another project, save it as a file, and then import 
it to a project. Right-click the Alarm Log Settings on the Project window to export or import the file.
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This section describes items and buttons on the Alarm Log Settings dialog box.

3.1 Alarm Log Settings Dialog Box

● General Tab
The General tab is used to configure what kind of data to sample when an alarm occurs and the methods for saving 
and deleting the sampled data.

■ Storage Method
Selects the data processing method when the number of active alarms exceeds the Alarm Log data storage amount 
set for the data storage area.

3 Alarm Log Settings Dialog Box

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

Fixed: If the saved data exceeds the Alarm Log data storage amount, the new data is not saved.

Rotate: If the saved data exceeds the Alarm Log data storage amount, the oldest data is deleted and the new data is saved.
Alarm Log data storage amount

New data

Alarm Log data storage amount

Oldest data
(delete)

New data
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■ Monitoring Period (x 100 msec)
Specifies the period to write the state of the monitored device address to the MICRO/I (6 to 500 (100 ms units)).

■ Monitor Number of Active Alarms
Select this check box to count the number of active alarms.

■ Monitor How Many Times Each Alarm has occurred
Select this check box to count the number of alarms that has occurred per channel.

■ Clear Log Data for Recovered Alarms
Select this check box to delete recovered data out of the saved Alarm Log data.

(Destination Device Address): Specifies a word device to write the number of active alarms.
For the device address configuration procedure, refer to Chapter 2 “5.1 Device Address 
Settings” on page 2-68.

(Top Device Address): Specifies a word device to write the number of alarms that has occurred. Number of blocks x 
16 (number of channels) address numbers are used starting from the set device address.
For the device address configuration procedure, refer to Chapter 2 “5.1 Device Address 
Settings” on page 2-68.
Example: When the number of blocks is 2 and LKR100 is specified as the start device address

The number of alarms that has occurred for channel number 1-0 is saved in 
LKR100. The number of alarms that has occurred for channel 1-1 is saved in 
LKR101, and this pattern continues up to LKR131 where the number of alarms that 
has occurred for channel number 2-15 is saved.

Top Device Address

Block 1

16 channels

Block 2

16 channels

Channel No.
LKR100
LKR101
LKR102

LKR114
LKR115
LKR116
LKR117
LKR118

LKR130
LKR131

1-0
1-1
1-2

1-14
1-15
2-0
2-1
2-2

2-14
2-15

• If you specify HMI Keep Registers (LKR) as the destination word device, the number of alarms that has 
occurred is retained even when the MICRO/I power is turned off.

• The amount of Alarm Log data saved in the data storage area with the Alarm Log function is stored in 
HMI Special Data Register LSD57.

• To monitor the number of alarms that has occurred, number of blocks x 16 (number of channels) device 
addresses are required from the set start device address. If the destination device address does not 
exist, “Device range error” occurs on the MICRO/I.

• If the values of the device addresses that are counting the number of alarms that has occurred are 
overwritten by another process, the alarms cannot be accurately counted.

(Trigger Device Address): Specifies the bit device or the bit number of the word device to serve as condition to delete 
data. The recovered data is deleted when the value of the configured device address changes 
from 0 to 1. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.
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■ Monitor the State of Each Alarm
Select this check box to check the alarm state per channel.

The following values are written to the bits depending on the alarm state.

■ Call Popup Screen
These settings configure the popup screen to display when an alarm occurs. The popup screen displayed when an 
alarm occurs is called the alarm screen.

 

■ Number of Stored Data
Specifies the maximum amount of Alarm Log data saved in the data storage area. Data is saved up to the set amount. 
The maximum amount of data that can be saved in the data storage area is as follows.

Click  to open the Data Storage Area Management dialog box. You can change the allocation of data storage area 
memory in the Data Storage Area Management dialog box. For details, refer to Chapter 16 “Data Storage Area” on 
page 16-1.

(Top Device Address): Specifies a word device to write the alarm state. Number of blocks x 16 (number of channels) 
address numbers are used starting from the set device address.
For the device address configuration procedure, refer to Chapter 2 “5.1 Device Address 
Settings” on page 2-68.

Bit 15 Bit 0Bit 3

0: Before alarm/a�er recovery
1: A�er alarm
0: Second and later alarm (Alarm that has occurred again while an alarm is ac�ve)
1: First alarm (First alarm that occurred)
0: A�er confirm
1: Before confirm

Reserved

Call Popup Screen: Select this check box to display the alarm screen when an alarm occurs.

Screen Number: Specifies the alarm screen number (1 to 3015) to display when an alarm occurs.

Coordinates X, Y: Specifies the coordinates to display the alarm screen.
With the upper-left corner of the screen as the origin, the upper-left corner of the alarm screen 
is the X and Y coordinates.
The units and range for the display coordinates is as follows.

Specify the coordinates in 1 dot units.
X: 0 to (base screen horizontal size - 1)
Y: 0 to (base screen vertical size - 1)

HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F: 11,660

HG2G-5T, HG1G/1P: 5,520
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● Channel Tab
The Channel tab is used to configure the device addresses to monitor and the alarm detection condition.

■ Source Device Address Type
Selects the type of device address to monitor.

■ Number of Blocks
Configures the Alarm Log data in block units. The number of blocks that can be set varies based on the Source 
Device Address Type setting.

■ Reference Screen
Select the type of reference screen from the following items.
Base Screen, Popup Screen, Not Use
The reference screen is displayed when a message is selected on the Alarm List Display or the Alarm Log Display and 
the key button Ref. is pressed. It is the base screen or popup screen associated with each channel.

Word: Uses a word device. Device Addresses are configured per block.

Bit: Uses a bit device. Device Addresses are configured per channel.

Word: 0 to 128

Bit: 0 to 8

1 block is composed of 16 channels. 1 device address can be monitored for each channel. The maximum 
number of device addresses that can be monitored is 16 for each block.

Time

09:15   Motor fault

Message

10:02   Pump1 fault

REV

Up

Dwn

Del

Ref.

10:28   High pressure

13:02   Pump 1 fault

Time

09:15   Motor fault

Message

10:02   Pump1 fault

REV

Up

Dwn

Del

Ref.

10:28   High pressure

13:02   Pump 1 fault

Pump 1 faultPump 1 fault
Pump 1 output low

Stop Start

Press Stop, check the air, 
then press Start.

Air Press.

kg/m2
0000

Key Button Ref. 

1. Select a message displayed  
on the Alarm List Display  
or the Alarm Log Display

Reference screen

2. Press the Key Button Ref. The reference screen opens
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■ Settings
The Alarm Log settings for each channel are edited here.

■ Auto
Batch registers or changes the settings for all the channels.
Click this button to open the Auto-Setup dialog box. The Auto-Setup dialog box settings are reflected in all the 
channels.
For details, refer to “Auto-Setup Dialog Box and Individual Settings Dialog Box” on page 13-18.

■ Edit
Registers or changes the settings for the selected channel.
Select a channel and click this button to open the Individual Settings dialog box. The settings for the selected channel 
are reflected in the Individual Settings dialog box.
For details, refer to “Auto-Setup Dialog Box and Individual Settings Dialog Box” on page 13-18.

No.: Displayed as (Block No.)-(Channel No.). Double clicking the cell opens the Individual Settings 
dialog box.

Source: Shows the bit device or the bit number of the word device to monitor. Double clicking the cell 
opens the Tag Editor.
For the device address configuration procedure, refer to Chapter 2 “5.1 Device Address 
Settings” on page 2-68.

Data: Shows whether or not to save Alarm Log data in the date storage area.
Double clicking the cell switches between Store and No Store.
Setting to Store makes the buzzer sound when the value of bit for the channel changes to 1.

Alarm function: Shows whether or not the alarm function is used. Double clicking the cell switches between 
Enable and Disable. Channels switched to Disable cannot be configured. States of device 
addresses are not monitored and Alarm Log data is not created.

NO/NC: Shows the alarm detection condition. Double clicking the cell switches between NO and NC.

Lock/Unlock: Shows whether or not to automatically recover based on the state of the monitored bit. 
Double clicking the cell switches between Lock and Unlock.

Text ID: Shows the Text Manager ID number (1 to 32000) to use for the message displayed when an 
alarm occurs. Double clicking the cell allows you to specify the Text Manager ID number.

Text Message: Shows the text for the specified text ID. Double clicking the cell opens the Text Manager.

Reference Screen No.: Shows the screen number to display when the key button Ref. is pressed. Double clicking the 
cell opens the Individual Settings dialog box.
This option can only be configured when Base Screen or Popup Screen is selected in 
Reference Screen.
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Auto-Setup Dialog Box and Individual Settings Dialog Box

With the Auto-Setup dialog box, the Alarm Log settings for all channels are batch registered or changed.
With the Individual Settings dialog box, the Alarm Log settings for the selected channel are registered or changed.

■ Channel*1

Shows the block number and the channel number for the selected channel.

■ Block Settings
Configures Source and Data in block units.

*1 Individual Settings dialog box only

Block Number: Shows the block number for the channel selected in Settings.

Channel Number: Shows the channel number for the channel selected in Settings.

Source: For the Auto-Setup dialog box, the device addresses are sequentially set from block number 1-channel 
number 1, starting with the specified device address.
For the Individual Settings dialog box, if Source Device Address Type on the Channel tab is Word, 
the 16 channels for the block selected at the start of the specified device address are batch configured. 
For Bit, the selected channel is individually configured.

Click  to open the Tag Editor where you can edit the device address. For the device address 
configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-68.

Data: Selects whether or not to save Alarm Log data in the date storage area.
For the Auto-Setup dialog box, all the channels are batch configured.
For the Individual Settings dialog box, the 16 channels for the selected block are batch configured.

Store: Alarm Log data can be displayed on the MICRO/I or output to file.

No Store: Alarm Log data is not created, but states of device addresses are monitored.
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■ Channel Settings
The trigger condition for the channel is configured here.

Alarm function: Selects whether or not to use the alarm function.

Enable: Monitors the state of the device address configured for the channel and samples 
the alarm information.

Disable: Does not monitor the state of the device address. No Alarm Log data is created.

NO/NC: Selects the alarm detection condition.

NO: The alarm occurs when the monitored bit changes from 0 to 1.

NC: The alarm occurs when the monitored bit changes from 1 to 0.

Lock/Unlock: Selects whether or not to automatically recover based on the state of the monitored bit.

Lock: Even if the monitored bit returns the normal state, the alarm remains active until 
the key button CHECK is pressed.

Unlock: The alarm is automatically recovered from based on the bit state when the 
monitored bit returns the normal state.

Example: NO/NC is NO

Press CHECK Record confirma�on �me

Record recovery �me

Record occurrence �me

Unlock

Record confirma�on �me
Record recovery �me

No opera�on

Record occurrence �me

Lock

0 1

0 1

Monitored bit

Alarm occurred

The display on the Alarm List Display disappears when the alarm is recovered from, regardless of the Lock/
Unlock setting. To keep displaying the alarm until CHECK is pressed, use the Alarm Log Display.

Text ID: To use text registered in Text Manager as the message to display when an alarm occurs, 
select this check box and specify the Text Manager ID number to use as the message. 
Number of blocks x 16 (number of channels) text IDs are used starting from the set ID 
number.

Click  to open Text Manager where you can edit the text.

Text: Shows the text for the specified text ID.

Reference Screen Number: Specifies the screen number (1 to 3000) to display when the key button Ref. is pressed. 
Number of blocks x 16 (number of channels) screens are used starting from the screen 
number.
This option can only be configured when Base Screen or Popup Screen is selected in 
Reference Screen.
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● External Memory Device Tab
The External Memory Device tab is used to configure whether or not to output saved data to the external memory 

device*1.

The output data is stored in the following folder on the external memory device*1.

The default External Memory Device folder name is “HGDATA01”. For details, refer to Chapter 31 “1.6 Setting the 
External Memory Device Folder” on page 31-15.

*1 SD memory card for HG5G/4G/3G/2G-V, HG4G/3G and HG2G-5F, USB flash drive for HG2G-5T and HG1G/1P

\External Memory Device folder\ALARMLOG

Sampled data after starting output to the external memory device is not included in the output data.
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■ Batch
Select this check box to batch output all the sampled data to the external memory device*1.

All the data is saved on the external memory device*1 when the value of the Trigger Device Address changes from 0 

to 1. If a file with the same name already exists on the external memory device*1, that file is overwritten. The 
maximum amount of output data is the amount configured by the data storage area.

*1 SD memory card for HG5G/4G/3G/2G-V, HG4G/3G and HG2G-5F, USB flash drive for HG2G-5T and HG1G/1P

MICRO/I

Alarm Log data (CSV)

Output to 

External memory device 
Alarm Log data

0 1

Trigger Device Address

 Ch.No. Message  Occurrence Time  Recovery Time Confirmation Time

 1-1 Voltage drop  12/01/2011 12:00:05 12/01 12:01:10 12/01 12:01:30

 1-2 Temperature abnormal  12/01/2011 12:01:09 12/01 12:02:21 12/01 12:02:55

 1-1 Voltage drop  12/01/2011 12:02:00 12/01 12:03:11 12/01 12:05:12

 1-3 Overcurrent  12/01/2011 12:30:21 12/01 12:55:15 12/01 13:00:00

 1-1 Voltage drop  12/01/2011 12:45:36 12/01 12:53:12 12/01 12:57:41

Data to be output (all)

External Memory Device

USB flash drive

SD memory card

The storing of data stops if there is insufficient free space on the external memory device. The error 
information is stored in the following HMI Special Data Registers. For details about the error information, 
refer to Chapter 33 “HMI Special Data Register (LSD)” on page 33-7.
SD memory card: 
USB flash drive: 

LSD42
LSD33

Trigger Device Address: Specifies the bit device or the bit number of the word device to serve as condition for batch 
output. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.
Data is output to file when the value of the Trigger Device Address changes from 0 to 1.

File Name: Enter the file name for the output data or shows the file name.

The default is “ALMHTO.CSV”. To change the file name, enter a new file name. The 
maximum number is 120 characters (including the extension).

Specify File Name by Value of Device Address: Select this check box to assign a file name 
for the output data using a value of device 
address specified in the File Name Device 
Address.

(File Name Device Address): Specifies a word device to create a file name. The file 
name is set by reading the values sequentially from 
the starting device specified with the File Name 
Device Address and handling those values as 
character data up to the character before NULL (00).
The maximum number of device addresses is 40 (2 
characters per word device, maximum of 80 single-
byte characters). You can only specify an internal 
device. For the device address configuration 
procedure, refer to Chapter 2 “5.1 Device Address 
Settings” on page 2-68.

Example: When the device address specified by (File Name Device Address) is LDR100 
and the text to set is "IDEC":

The file name at this time becomes "IDEC.CSV".

LDR100
LDR101
LDR102

(File Name Device Address) 4844(Hex)

4543(Hex)

‘ I ’ ‘D’
‘E’ ‘C’

0000(Hex)(NULL)
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Add Device Address data to File Name: Select this check box to add the bottom three digits of 
the value of the device address configured by (File 
Name Device Address) to the end of the file name for 
the output data.

(File Name Device Address): Specifies the word device that is the source for the value to 
add to the file name. For the device address configuration 
procedure, refer to Chapter 2 “5.1 Device Address Settings” on 
page 2-68. This option can only be configured when the Add 
Device Address data to File Name check box is selected.

Example: When File Name is "ALMHTO01" and the value of device address in (File Name 
Device Address) is 123, the file name is "ALMHTO01123.CSV".

Add Time Stamp: Select from the following format for date and time to be added to the file 
name when data is output:
None, YY, YY+MM, YY+MM+DD, YY+MM+DD+HH, 
YY+MM+DD+HH+MM, YY+MM+DD+HH+MM+SS
The format is YYMMDD_hhmmss (YY: year, MM: month, DD: day, hh: hour, 
mm: minute, ss: second).

Example:  File Name is "ALMHTO01" on September 15 2013 at 23:30:50

YY: ALMHTO01_13

YY+MM: ALMHTO01_1309

YY+MM+DD: ALMHTO01_130915

YY+MM+DD+HH: ALMHTO01_130915_23

YY+MM+DD+HH+MM: ALMHTO01_130915_2330

YY+MM+DD+HH+MM+SS: ALMHTO01_130915_233050

Set limit on files: Specifies the upper limit (1 to 100) when limiting the number of files to be 
output.

 When the Set limit on files check box is selected, note the following points.
• If the number of data files saved on the external memory device increases, it may take some time for 

the data output processing, or the output of the next data may not be processed normally.
• When displaying pictures saved on the external memory device and processing the output of data both 

occur simultaneously, the pictures may not be displayed.
• When parts that blink overlap pictures saved to the external memory device, the blinking period may 

slow down when data output processing occurs.

• The following single-byte characters cannot be used in the file name configured by File Name or 
Specify File Name by Value of Device Address.
 \ / :  ; * ? " < > |

• File names that exceed the limits in Specify File Name by Value of Device Address and file names 
configured with characters that cannot be used are as follows.
- When the text of the file name exceeds the maximum number of device addresses (no NULL), the text 

stored in device addresses up to the maximum number of device addresses from the start is 
configured.

- When a character that cannot be used is set, the text is up to that character.
- When the first character is a character that cannot beused, the text is that set for File Name.

• The operation when the Set limit on files check box is selected is as follows.
- The files are output up to the set limit, and then for additional files, the new files are saved by 

discarding the old files in order of the oldest first.
- If the number of files saved on the external memory device already exceeds the limit when operation 

starts, the number of files at that time is the limit. From there the data is discarded in order from the 
oldest data and replaced with new data with each file output.
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■ Real Time
Select this check box to output data to the external memory device*1 in real time.

With real time output, data is saved to the external memory device*1 in three minute intervals after the MICRO/I 
starts running. If the accumulated data reaches 819th item, then the data is forcibly saved to the external memory 
device*1. When there is already data with the same file name on the external memory device*1, data is appended to 
that file. If there was no update to the data during the three minutes, it is not output.
Data is appended to the file until the size of the file reaches the restriction size (256 MB), so the maximum amount of 
output data varies based on the settings for the output channel such as the amount of data, the data size, and the labels.

If the interval to update the Alarm Log is shorter than real time output (the interval for writing to the external memory 
device), that Alarm Log is recorded up to the 1023rd item, and then afterwards, old data is discarded in order and 
replaced with new data.

 

*1 SD memory card for HG5G/4G/3G/2G-V, HG4G/3G and HG2G-5F, USB flash drive for HG2G-5T and HG1G/1P

MICRO/I

Alarm Log data (CSV)

Alarm Log data

 Time State Ch.No. Message

 12/01/2011 12:00:05 Occurred  1-1 Voltage drop

 12/01/2011 12:01:09 Occurred  1-2 Temperature abnormal

 12/01/2011 12:01:10 Recovered 1-1 Voltage drop

 12/01/2011 12:03:30 Confirmed  1-1 Voltage drop

 12/01/2011 12:03:09 Occurred  1-3 Overcurrent

 12/01/2011 12:04:33 Recovered 1-2 Voltage drop

 12/01/2011 12:05:15 Confirmed  1-2 Voltage drop

 12/01/2011 12:08:41 Recovered 1-3 Overcurrent

Data to be output 
3 minutes after 
operation starts

Data to be output 
3 minutes after that

Data to be output after 
another 3 minutes

3 minute interval 
after operation starts

Output to
External memory device 

External Memory Device

USB flash drive

SD memory card

Real time output stops when the file size of the Alarm Log data exceeds 256 MB or when there is 
insufficient space on the external memory device. The error information is stored in the following HMI 
Special Data Registers. For details about the error information, refer to Chapter 33 “HMI Special Data 
Register (LSD)” on page 33-7.
SD memory card: 
USB flash drive: 

LSD42
LSD33

• When the value of the following HMI Special Internal Relays changes from 0 to 1, the data at that time is 
first output in real time to the external memory device, and then access to the external memory device is 
stopped. For details, refer to Chapter 33 “HMI Special Relay (LSM)” on page 33-2.

SD memory card:
USB flash drive: 

LSD20
LSD18

• The amount of free space on the external memory device is saved to the following HMI Special Data 
Registers. For details about the free space on the External Memory Devices, refer to Chapter 33 “HMI 
Special Data Register (LSD)” on page 33-7.

SD memory card:
USB flash drive: 

LSD43, 44
LSD34, 35

Trigger Condition: Select the check boxes for the items that will trigger the output of Alarm Log data to the external memory 
device.
Occurrence: Alarm Log data is output to the external memory device when an alarm has 

occurred.
Recovery: Alarm Log data is output to the external memory device when the alarm is 

recovered from.
Confirmation: Alarm Log data is output to the external memory device when the key button CHECK was 

pressed.

Month/day/year hour:minute:second is output for the trigger condition occurrence time, recovery time, and 
confirmation time.
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File Name: Enter the file name for the output data or shows the file name.
The default is “ALMHTA.CSV”. To change the file name, enter a new file name. The maximum 
number is 120 characters (including the extension).
Specify File Name by Value of Device Address: Select this check box to specify the name of the file 

for the output data with the value of the device 
address configured by (File Name Device Address).

(File Name Device Address): Specifies the word device that is the source of the data to use as 
the file name. The file name is set by reading the values 
sequentially from the starting device address specified with the 
File Name Device Address and handling those values as character 
data up to the character before NULL (00).
The maximum number of device addresses is 40 (80 single-byte 
characters). You can only specify an internal device. For the 
device address configuration procedure, refer to Chapter 2 “5.1 
Device Address Settings” on page 2-68.

Example: When the device address specified by (File Name Device Address) is LDR100 and the 
text to set is "IDEC":

The file name at this time becomes "IDEC.CSV".

Add Device Address data to File Name: Select this check box to add the bottom three digits of the 
value of the device address configured by (File Name Device 
Address) to the end of the file name for the output data.

(File Name Device Address): Specifies the word device that is the source for the value to add to 
the file name. For the device address configuration procedure, refer 
to Chapter 2 “5.1 Device Address Settings” on page 2-68. This 
option can only be configured when the Add Device Address 
data to File Name check box is selected.

Example: File Name is "ALMHTA" and the value of the device address configured by (File Name 
Device Address) is 123, the file name is "ALMHTA123.CSV".

Add Time Stamp: Selects the format of the output date and time to add to the file name for the 
output data.
None, YY, YY+MM, YY+MM+DD
The format is YYMMDD (YY: year, MM: month, DD: day).

Example: File Name is "ALMHTA" on September 15 2013

YY: ALMHTA_13

YY+MM: ALMHTA_1309

YY+MM+DD: ALMHTA_130915

Realtime Output: Select this check box to forcibly output the data and save it to file at the desired 
timing.

(Trigger Device Address): Specifies the bit device or the bit number of the word device to 
serve as the condition to forcibly output the data. You can only 
specify an internal device. For the device address configuration 
procedure, refer to Chapter 2 “5.1 Device Address Settings” on 
page 2-68. 
Data is output to file when the value of Trigger Device Address 
changes from 0 to 1.

Set limit on files: Specifies the upper limit (1 to 100) when limiting the number of files to be 
output.

LDR100
LDR101
LDR102

(File Name Device Address) 4844(Hex)

4543(Hex)

‘ I ’ ‘D’
‘E’ ‘C’

0000(Hex)(NULL)
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When the Set limit on files check box is selected, note the following points.
• If the number of data files saved on the external memory device increases, it may take some time for 

the data output processing, or the output of the next data may not be processed normally.
• When displaying pictures saved on the external memory device and processing the output of data both 

occur simultaneously, the pictures may not be displayed.
• When parts that blink overlap pictures saved to the external memory device, the blinking period may 

slow down when data output processing occurs.

• The following single-byte characters cannot be used in the file name configured by File Name or 
Specify File Name by Value of Device Address.
 \ / :  ; * ? " < > |

• File names that exceed the limits in Specify File Name by Value of Device Address and file names 
configured with characters that cannot be used are as follows.
- When the text of the file name exceeds the maximum number of device addresses (no NULL), the text 

stored in device addresses up to the maximum number of device addresses from the start is 
configured.

- When a character that cannot be used is set, the text is up to that character.
- When the first character is a character that cannot be used, the text is that set for File Name.

• The operation when the Set limit on files check box is selected is as follows.
- The files are output up to the set limit, and then for additional files, the new files are saved by 

discarding the old files in order of the oldest first.
- If the number of files saved on the external memory device already exceeds the limit when operation 

starts, the number of files at that time is the limit. From there the data is discarded in order from the 
oldest data and replaced with new data with each file output.

• The following operations are as follows if the Realtime Output check box is selected.
- Even if the data is outputted forcibly, the real time output period (3 minute interval) is not reset.
- While data is being output with the real time output function, the file is not output when the value of 

the Realtime Output device address is 1.
- Even when output has finished, the value of device does not automatically change to 0.

• The function to sample data operates when Alarm Log data is being saved to the external memory device.
• The batch output or real time output status of the Alarm Log data can be checked with the value of HMI 

Special Internal Relay LSM36. When the data starts to be written to the external memory device, the 
value of device address is 1. When writing is complete, the value is 0.

• The methods to erase Alarm Log files saved on the external memory device are as follows.
- To erase files during operation using parts, on the External Memory Device tab on the Project 

Settings dialog box, select the Remove Files check box and the All Alarm Log data check box, and 
then configure the trigger device address. Assign that trigger device address to a part.

- To erase files with WindO/I-NV4, click Clear on the Online tab, and then click Stored Data in 
External Memory Device to open the Clear Data dialog box. Select the Alarm Log Data check box 
and click OK.

- To erase files on the HG5G/4G/3G/2G-V, HG4G/3G and the HG2G-5F, go to the System Mode - File 
Manager. In the File Manager, select the files to be deleted by pressing DEL.
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Output Data File Name

The file name format is as follows.
File Name Value of Device Address_YYMMDD_hhmmss.CSV

■ Example 1

Result: The file name is "ALMHTO123_1309.CSV".

■ Example 2

Result: The file name is "IDEC123_130915_233050.CSV".

File Name: The text entered in File Name or the text entered according to the value of the 
device address set by Specify File Name by Value of Device Address

Value of Device Address: The lower 3 digits of the value of the device address configured by Add Device 
Address data to File Name

YYMMDD: The year, month, and day of the month set on Add Time Stamp

hhmmss: The hour, minute, and second of the time configured on Add Time Stamp

Item Setting

File Name ALMHTO

Add value of Device Address to File 
Name

(File Name Device Address) is 
LDR200

LDR200 value: 123

Add Time Stamp YY+MM Date when data was output: September 2013

Item Setting

Specify File Name by Value of Device 
Address

(File Name Device Address) is 
LDR100
Text to set is "IDEC"

LDR100 value: 4944 (Hex)
LDR101 value: 4543 (Hex)
LDR102 value: 0000 (Hex)

Add value of Device Address to File 
Name

(File Name Device Address) is 
LDR200

LDR200 value: 123

Add Time Stamp YY+MM+DD+HH+MM+SS
Date and time when data was output: 
September 15 2013 at 23:30:50
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● Printing Tab

The Printing tab is used to configure whether or not to output saved data to the printer.

■ Batch
Select this check box to batch output all the sampled data to the printer.

Printing of all the data starts when the value of the Trigger Device Address changes from 0 to 1. Alarm Log data that 
occurs after the start of printing is not printed.

Batch output example (printing)

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

Trigger Device Address: Specifies the bit device or the bit number of the word device to serve as condition to print.
For the device address configuration procedure, refer to Chapter 2 “5.1 Device Address 
Settings” on page 2-68.
The data prints when the value of the Trigger Device Address changes from 0 to 1.

Output to printer 

Printer

0 1

Trigger Device Address

MICRO/I

Alarm Log data

 Ch.No. Message  Occurrence Time  Recovery Time Confirmation Time

 1-1 Voltage drop  12/01/2011 12:00:05 12/01 12:01:10 12/01 12:01:30

 1-2 Temperature abnormal  12/01/2011 12:01:09 12/01 12:02:21 12/01 12:02:55

 1-1 Voltage drop  12/01/2011 12:02:00 12/01 12:03:11 12/01 12:05:12

 1-3 Overcurrent  12/01/2011 12:30:21 12/01 12:55:15 12/01 13:00:00

 1-1 Voltage drop  12/01/2011 12:45:36 12/01 12:53:12 12/01 12:57:41

Data to be output (all)

HG3G HG2G-5FHG4G
HG5G-V HG4G-V HG3G-V HG2G-V

No.
01-00
01-01
01-00

Occurrence Time
12/31/11 12:00:00
12/31/11 12:10:15
12/31/11 13:00:30

Recovery Time
12/31 12:20:20
12/31 14:00:40
-

Confirma�on Time
12/31 12:30:45
12/31 14:30:50
-

Message
Pressure sensor fault
Hydraulic pressure low
Pressure sensor fault
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Print with Second: Select this check box to print the time including seconds.

Paper Feed Direction: Selects the paper feed direction as either Vertical or Horizontal.

Vertical: Horizontal:

ABC
  ABC

• For A4 size paper, up to 40 items of Alarm Log data are printed on a single sheet.
• The year is not printed for recovery times and confirmation times.

The function to sample data operates when Alarm Log data is printing.
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● Options Tab
The Options tab is used to configure whether or not the MICRO/I’s internal buzzer operates and the screen flashing.

■ Trigger Buzzer when Alarm occurs
Select this check box to sound a beep when an alarm has occurred.

■ Screen flashing when Alarm occurs
Select this check box to have the screen flash when an alarm occurs.

■ Buzzer and Screen Flashing
This item selects the condition for the alarm to sound the buzzer or to flash the screen. This item can only be 
configured when the Buzzer when Alarm occurs or the Screen flashing when Alarms occurs is selected.

■ Stop the Sound of the Buzzer and Screen flashing
Select the check box for the items that will trigger the sound of the buzzer and screen flashing to stop.

*1 The first alarm that has occurred in a state where no alarms are active

All Alarms: The buzzer is triggered and the screen flashing each time an alarm occur.

Only First Alarm: The buzzer is triggered and the screen flashing only when the first alarm*1 occurs.
No beeps will sound and no screen will flash when another alarm is already active.

When touch everywhere on the screen: The sound of the buzzer and screen flashing stops when you touch 
anywhere on the screen.

When press CHECK or All Chk. button: The sound of the buzzer and screen flashing stops when you touch the 
key buttons CHECK or All Chk. on the Alarm Log Display.

When all Alarms are recovered: The sound of the buzzer and screen flashing stops when all the alarms 
are recovered from.
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• While the beep is sounding, System Area 1 (address number+1, bit 6) is 1.
• While the screen is flashing, System Area 1 (address number+1, bit 2) is 1.
• To stop the sound of the buzzer and the screen flashing when an alarm has occurred, use the following 

methods.
- Press the key button Stop the Sound of the Buzzer and Screen flashing
- When a condition selected with the Stop the Sound of the Buzzer and Screen flashing check 

boxes is satisfied
- To stop the sound of the buzzer, set System Area 1 (address number+1, bit 6) to 0
- To stop the screen flashing, set System Area 1 (address number+1, bit 1 to 4) to 0
However, when System Area 1 (address number+1, bit 6) is 1 for a reason other than the occurrence of 
an alarm, the sound of the buzzer does not stop until 0 is written. When System Area 1 (address 
number+1, bit 1 to 4) are 1, the alarm is triggered, however, the screen flashing doesn't stop until 0 is 
written into it.

• If you stop the screen flashing, the backlight turns off when System Area 1 (address number+1, bit 0), 
and the backlight turns on when it is 1.
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4.1 Displaying Saved Data with the Alarm Log Display

1 On the Configuration tab, in the System Setup group, click Alarm Log.

The Alarm Log Settings dialog box is displayed.

2 Select the type of device address to monitor under Source Device Address Type on the Channel tab and specify 
Number of Blocks.

3 Select the channel number to register and click Edit.

The Individual Settings dialog box is displayed.

4 Specify the device address to monitor in Source and select Store under Data.

4 Using Data and Detected Alarms

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P
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5 Select Enable under Alarm function, configure NO/NC and Lock/Unlock, and click OK.

You are returned to the Alarm Log Settings dialog box.

6 Repeat steps 3 through 5 to register all the channels.

7 Click OK.

The Alarm Log Settings dialog box closes.

8 On the Home tab, in the Parts group, click Data Displays, and then click Alarm Log Display.

9 Click a point on the edit screen where you wish to place the Alarm Log Display.

10 Double-click the dropped Alarm Log Display and a Properties dialog box will be displayed.

11 Change the settings on each tab as necessary.

For details, refer to Chapter 10 “8.3 Properties of Alarm Log Display Dialog Box” on page 10-154.

12 Click OK.

The Properties of Alarm Log Display dialog box closes.
This concludes configuring the MICRO/I to display saved data with the Alarm Log Display.
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4.2 Displaying Registered Messages with the Alarm List Display According to the Active Alarm

1 On the Configuration tab, in the System Setup group, click Alarm Log.

The Alarm Log Settings dialog box is displayed.

2 Select the type of device address to monitor under Source Device Address Type on the Channel tab and specify 
Number of Blocks.

3 Select the channel number to register a message to and click Edit.

The Individual Settings dialog box is displayed.



4 Using Data and Detected Alarms

13-34 WindO/I-NV4 User’s Manual

4 Specify the device address to monitor in Source and select No Store under Data.

5 Select Enable under Alarm function and configure NO/NC and Lock/Unlock.

6 Select the Text ID check box and click .

Text Manager opens.

7 Double click the (Text) and enter the message.

8 Click OK.

You are returned to the Individual Settings dialog box.

(Text) 
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9 Click OK.

The registered message is displayed in Settings.

10 Repeat steps 3 through 9 to register messages for all the channels.

11 Click OK.

The Alarm Log Settings dialog box closes.

12 On the Home tab, in the Parts group, click Data Displays, and then click Alarm List Display.

13 Click a point on the edit screen where you wish to place the Alarm List Display.

14 Double-click the dropped Alarm List Display and a Properties dialog box will be displayed.

The messages to use can be registered in advance in Text Manager.
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15 On the General tab, under Message Settings, select Use Alarm Log Settings.

16 Configure the other settings and the settings on each tab as necessary.

For details, refer to Chapter 10 “7.3 Properties of Alarm List Display Dialog Box” on page 10-138.

17 Click OK.

The Properties of Alarm List Display dialog box closes.
This concludes configuring the MICRO/I to display registered messages with the Alarm List Display according to the 
active alarm.
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4.3 Make a Sound of the Buzzer and Flash the Screen when an Alarm has Occurred

1 On the Configuration tab, in the System Setup group, click Alarm Log.

The Alarm Log Settings dialog box is displayed.

2 Select the type of device address to monitor under Source Device Address Type on the Channel tab and specify 
Number of Blocks.

3 Select the channel number to register a message to and click Edit.

The Individual Settings dialog box is displayed.

4 Specify the device address to monitor in Source and select Store under Data.

5 Select Enable under Alarm function, configure NO/NC and Lock/Unlock, and click OK.

You are returned to the Alarm Log Settings dialog box.
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6 Click the Options tab in the Alarm Log Settings dialog box.

7 Select the Trigger Buzzer when Alarm occurs check box to make a sound of the buzzer when an alarm has 
occurred.

8 Select the Screen flashing when Alarm occurs check box to have the screen flashing when an alarm has 
occurred.

9 Click OK.

The Alarm Log Settings dialog box closes.
This concludes configuring the settings to make a sound of the buzzer and the screen flashing when an alarm has 
occurred.
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4.4 Saving the Data as a CSV File

● Saving the Data as a CSV File
The Alarm Log data can be saved to the external memory device*1 as a CSV file or uploaded to a computer.
The procedure to save the data is as follows.
• To save the data to an external memory device, click Alarm Log on the WindO/I-NV4 Configuration tab to open 

the Alarm Log Settings dialog box. Select an output method check box on the External Memory Device tab and 
configure the items. The data can be saved to the External Memory Device folder on the external memory device. 
For details, refer to “External Memory Device Tab” on page 13-20.

• To upload the data to a computer, click on ▼ to the right of (Upload) on the toolbar in Data File Manager, and 
then click the Upload All Log Data or Upload Alarm Log Data to open the Browser For Folder dialog box. 
Specify the location to save the file and click OK to save the file to the specified folder. For details, refer to the Data 
File Manager User's Manual.

● Data Structure and Output Example
The data structure for files output with batch output and real time output is different.

■ Batch
Batch output shows the recovery and confirmation time for an alarm that has occurred on a single line.
The data structure of files output with batch output is as follows. Bold items are replaced by the Alarm Log settings, 
the sampled data, the running project name, and WindO/I-NV4 version number.

*1 SD memory card for HG5G/4G/3G/2G-V, HG4G/3G and HG2G-5F, USB flash drive for HG2G-5T and HG1G/1P

Headers

"Project Name","Project name","Version number"

"File Type","Log type"

Blank row

Title row "Ch.No.","Message","Occurrence Time","Recovery Time","Confirmation Time"

Data row

" Channel number","Message"," MM/DD/YYYY hh:mm:ss"," MM/DD/YYYY hh:mm:ss",
" MM/DD/YYYY hh:mm:ss"

·
·
·

Output example Data size of each row

"Project Name","Dimmer Console","V4.50" - 41 bytes

"File Type","Alarm Log Data" - 30 bytes

- 2 bytes

"Ch.No.","Message","Occurrence Time","Recovery Time","Confirmation Time" - 74 bytes

" 1-0","Voltage drop"," 08/11/2011 14:46:12"," 08/11 14:46:13"," 08/11 
14:46:16"

- 82 bytes

" 1-1","Temperature abnormal"," 08/11/2011 14:47:18"," 08/11 14:47:19",
" 08/11 14:47:20"

- 90 bytes

·
·
·
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■ Real Time
Real time output displays the alarm state and the time the alarm became that state on a single line each time an 
alarm occurs, is recovered from, or is confirmed.
The data structure of files output with real time output is as follows. Bold items are replaced by the Alarm Log 
settings, the sampled data, the running project name, and WindO/I-NV4 version number.

Headers

"Project Name","Project name","Version number"

"File Type","Log type"

Blank row

Title row "Time","State","Ch.No.","Message"

Data row

" MM/DD/YYYY hh:mm:ss","State"," Channel number","Message"

·
·
·

Output example Data size of each row

"Project Name","Dimmer Console","V4.50" - 41 bytes

"File Type","Alarm Log Data" - 30 bytes

- 2 bytes

"Time","State","Ch.No.","Message" - 35 bytes

" 08/11/2011 14:46:12","Occurred"," 1-0","Voltage drop" - 57 bytes

" 08/11/2011 14:46:13","Recovered"," 1-0","Voltage drop" - 58 bytes

" 08/11/2011 14:46:16","Confirmed"," 1-0","Voltage drop" - 58 bytes

" 08/11/2011 14:47:18","Occurred"," 1-1","Temperature abnormal" - 65 bytes

·
·
·

• The data size for each row is counted as 2 bytes for full-width characters, 1 byte for half-width characters, 
and 2 bytes for newlines. The total for each row is the total amount of space for the file.

• A space is inserted before the date in the data row.
• The display type for the date and time varies based on the language configured in Project Settings, on 

the Project Details tab, in Language.
Japanese: YYYY/MM/DD hh:mm:ss
European, Chinese, Taiwanese, Korean, Central European, Baltic, Cyrillic: MM/DD/YYYY hh:mm:ss
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This chapter describes how to configure the Data Log function and its operation on the MICRO/I.

  

1.1 How the Data Log Function is Used

The Data Log function samples values of device addresses with the MICRO/I using the configured sampling condition 
and Condition of Writing to Data Storage Area. The sampled values of device addresses are saved in internal memory 
along with the sampling time.
The Data Log function can perform the following functions.

• Sample values of device addresses at a fixed interval

• Sample values of device addresses when a value of device address changes

• Output Data Log data to the external memory device*1

*1 SD memory card for HG5G/4G/3G/2G-V, HG4G/3G and HG2G-5F, USB flash drive for HG2G-5T and HG1G/1P

Chapter 14 Data Log Function

1 Overview

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

MICRO/I

External device

D100 : 123

D100 : 55

12 : 00

12 : 05

12 : 10

D100 : 0

MICRO/I

External device

D100 : 123
0 1

Output to
External memory device

Data Log data (CSV)

MICRO/I External Memory Device

USB flash drive

SD memory card
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• Copy Data Log data to internal devices

MICRO/I

External device

(Internal device)

124
125
126

Data Log data

 Sampling Time Data001

 01/01/2011 12:00:30 120

 01/01/2011 12:01:30 121

 01/01/2011 12:02:30 122

 01/01/2011 12:03:30 123

 01/01/2011 12:04:30 124

 01/01/2011 12:05:30 125

 01/01/2011 12:06:30 126

LDR10 : 126

LDR11 : 125

LDR12 : 124

Copy
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1.2 Sampling Values of Device Addresses

The MICRO/I samples values of target device addresses at a regular interval or when a value of device address 
changes.

● Sampling Value of Device Addresses at a Regular Interval
When sampling values of device addresses (D100 to D102) at a 5 minute interval (Time: 300 seconds) with the data 
storage amount in the data storage area is set to 3, the MICRO/I samples Data Log data as follows.

1 5 minutes after data sampling starts, the MICRO/I stores the values for device addresses D100 to D102.

2 10 minutes after data sampling starts, the MICRO/I stores the values for device addresses D100 to D102.

3 15 minutes after data sampling starts, the MICRO/I stores the values for device addresses D100 to D102.

4 20 minutes after data sampling starts, the MICRO/I stores the values for device addresses D100 to D102.

Since the data storage amount in the data storage area is set to 3, the oldest data is deleted in order to make room 
for the newest data.

MICRO/I

External device
12 : 05 : 00

12 : 10 : 00

12 : 15 : 00

D100 D101 D102

20  80 2

10  70 3

30  90 1

I/ORCIM eht no derots ataDValues of Device Addresses

Time
Value

Sampling Time
Value

3 ataD2 ataD1 ataD201D101D001D
01/01/2011 12:01:00 10 70 3 01/01/2011 12:05:00 20 80 2
01/01/2011 12:02:00 20 80 2 01/01/2011 12:10:00 10 70 3
01/01/2011 12:03:00 30 90 1 01/01/2011 12:15:00 30 90 1
01/01/2011 12:04:00 10 70 3
01/01/2011 12:05:00 20 80 2
01/01/2011 12:06:00 30 90 1
01/01/2011 12:07:00 10 70 3
01/01/2011 12:08:00 20 80 2
01/01/2011 12:09:00 30 90 1
01/01/2011 12:10:00 10 70 3
01/01/2011 12:11:00 20 80 2
01/01/2011 12:12:00 30 90 1
01/01/2011 12:13:00 10 70 3
01/01/2011 12:14:00 20 80 2
01/01/2011 12:15:00 30 90 1
01/01/2011 12:16:00 10 70 3

1
2

3

I/ORCIM eht no derots ataDValues of Device Addresses

Time
Value

Sampling Time
Value

D100 D101 D102 Data 1 Data 2 Data 3
···

···
···

···

01/01/2011 12:17:00 40 60 2 01/01/2011 12:10:00 10 70 3
01/01/2011 12:18:00 30 60 1 01/01/2011 12:15:00 30 90 1
01/01/2011 12:19:00 10 90 3 01/01/2011 12:20:00 20 80 2
01/01/2011 12:20:00 20 80 2

4

Deleted
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● Sampling Values of Device Addresses when a Value of Device Address Changes
If sample values of device addresses (D100 to D102), when the bit device or the bit number of the word device 
configured as the Condition of Writing to Data Storage Area switches from 0 to 1 and the data storage amount in the 
data storage area is set to 3, the MICRO/I samples Data Log data as follows. (When Sampling Method is While 
satisfying the condition of writing to data storage area)

1 When data sampling starts and the value of device address configured as the Condition of Writing to Data Storage 
Area switches from 0 to 1,the MICRO/I stores the values for device addresses D100 to D102.

2 When the value of device address configured as the Condition of Writing to Data Storage Area switches from 0 to 1 
the second time, the MICRO/I stores the values for device addresses D100 to D102.

3 When the value of device address configured as the Condition of Writing to Data Storage Area switches from 0 to 1 
the third time, the MICRO/I stores the values for device addresses D100 to D102.

4 When the value of device address configured as the Condition of Writing to Data Storage Area switches from 0 to 1 
the fourth time, the MICRO/I stores the values for device addresses D100 to D102.

Since the data storage amount in the data storage area is set to 3, the oldest data is deleted in order to make room 
for the newest data.

MICRO/I

External device
D100 D101 D102
20  80 2

0 1

0 1

0 1

0 1

I/ORCIM eht no derots ataDValues of Device Addresses

Time
Value

Sampling Time
Value

3 ataD2 ataD1 ataD201D101D001D
01/01/2011 12:01:00 10 70 3 01/01/2011 12:05:00 20 80 2
01/01/2011 12:02:00 20 80 2 01/01/2011 12:13:00 10 70 3
01/01/2011 12:03:00 30 90 1 01/01/2011 12:15:00 30 90 1
01/01/2011 12:04:00 10 70 3
01/01/2011 12:05:00 20 80 2
01/01/2011 12:06:00 30 90 1
01/01/2011 12:07:00 10 70 3
01/01/2011 12:08:00 20 80 2
01/01/2011 12:09:00 30 90 1
01/01/2011 12:10:00 10 70 3
01/01/2011 12:11:00 20 80 2
01/01/2011 12:12:00 30 90 1
01/01/2011 12:13:00 10 70 3
01/01/2011 12:14:00 20 80 2
01/01/2011 12:15:00 30 90 1
01/01/2011 12:16:00 10 70 3

1
2

3

0 1

I/ORCIM eht no derots ataDValues of Device Addresses

Time
Value

Sampling Time
Value

3 ataD2 ataD1 ataD201D101D001D
···

···
···

···

01/01/2011 12:17:00 40 60 2 01/01/2011 12:13:00 10 70 3
01/01/2011 12:18:00 30 60 1 01/01/2011 12:15:00 30 90 1
01/01/2011 12:19:00 10 90 3 01/01/2011 12:20:00 20 80 2
01/01/2011 12:20:00 20 80 2

4

Deleted
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1.3 Data Configuration

The sampled data is composed of the sampling time, values of device addresses, and labels.
The relationship between the Data Log function settings and the sampled data is as follows.

1. Channel The sampled data is in channel units. A maximum of 20 channels can be configured.
2. Data storage amount: The amount of sampled data to save. The maximum amount that can be configured per 

device address differs according to the model. For details, refer to “Data Storage 
Amount” on page 14-6.

3. Amount of data: The amount of data registered to a channel. The maximum amount of data that can be 
set will depend on the Sampling Method setting. For details, refer to “Sampling 
Method” on page 14-15.

4. Sampling time label: When the sampled data is output as a CSV file, this label is displayed in the label row 
for the sampling time column.

5. Data label: When the sampled data is output as a CSV file, this label is displayed in the label row 
for the data number columns.

 Sampling Time Data001 Data002 Data003

 01/01/2011 12:00:00 20 120 201

 01/01/2011 12:10:00 21 121 204

 01/01/2011 12:20:00 22 122 206

 01/01/2011 12:30:00 23 123 206

 01/01/2011 12:40:00 24 124 210

Data No. 3 Value of Device Address

3. Amount of data

5. Data label

1. Channel 1 to 20

2. Data storage amount

Data No. 2 Value of Device Address

Data No. 1 Value of Device Address

Time the value of device address was sampled

4. Sampling time label

Data No. 1 settings
Data No. 2 settings
Data No. 3 settings

Data log settings

Sampled data
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1.4 Saving and Deleting Data

● Saving Data
The sampled values of device addresses along with the sampling time are all saved in the data storage area.

If the saved data exceeds the Data Log data storage amount per device address, the old data is deleted and the new data 
is saved.

Data Storage Amount

When saving the sampled data to the data storage area, set the data storage amount per device address. The amount 
of data that can be saved in the data storage area is calculated from the configured data storage amount per device 
address and data amount for each channel.
The maximum amount of data that can be saved in the data storage area is as follows.

● Deleting Data
The method to delete sampled data from the data storage area is as follows.
• On the Online tab in WindO/I-NV4, click the arrow under Clear, and click All or Data Log Data. For details, refer 

to Chapter 24 “4 Clear” on page 24-25.
• In the System Mode, on the Main Menu screen, press Initial Setting, Initialize, Data Log in order.

Sample values of 
device addresses

MICRO/I

External device

Data Log data

 Sampling Time  Data001  Data002  Data003

 01/01/2011 12:00:00  20  120  201

 01/01/2011 12:10:00  21  121  204

 01/01/2011 12:20:00  22  122  206

 01/01/2011 12:30:00  23  123  206

 01/01/2011 12:40:00  24  124  210

 01/01/2011 12:50:00  25  125  218

Data Log data storage amount per device address

Oldest data

(delete)

New data

When the backup battery is depleted, the data in the Data Log is erased when the MICRO/I is turned off.

Model Maximum amount of data that can be saved in the data storage area

HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F 29,165

HG2G-5T, HG1G/1P 13,808
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1.5 Using the Data

The saved data can be used in the following ways.

*1 SD memory card for HG5G/4G/3G/2G-V, HG4G/3G and HG2G-5F, USB flash drive for HG2G-5T and HG1G/1P

• Display the data in the Line 
Chart
Configure the data channel 
numbers and data numbers 
and display the data in the Line 
Chart.
For details, refer to “4.1 
Display the Data in the Line 
Chart” on page 14-34.

• Save to and read from an 
external memory device*1

Output data from the MICRO/I 
to the an external memory 
device as a CSV file and use it 
on a computer.
For details, refer to “4.3 Saving 
the Data as a CSV File” on 
page 14-45.

• Display the data with the 
Numerical Input or the 
Numerical Display
Copy the data to an internal 
device and display it with the 
Numerical Input or the 
Numerical Display.
For details, refer to “4.2 
Displaying Data as Numerical 
Values” on page 14-36.

 Sampling Time Data001 Data002 Data003

 01/01/2011 12:00:00 20 120 201

 01/01/2011 12:10:00 21 121 204

 01/01/2011 12:20:00 22 122 206

 01/01/2011 12:30:00 23 123 206

 01/01/2011 12:40:00 24 124 210

Data Log data

To use with the MICRO/I To use with devices other than the MICRO/I

External Memory Device Book1

Data Log data
(CSV)

Sampling Time Data001 Data002 Data003 Data004

24
124
210

Data001

Data002

Data003
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This section describes the configuration procedure for the Data Log function.

2.1 Configuring the Data Log Function

1 On the Configuration tab, in the System Setup group, click Data Log.

The Data Log Settings dialog box is displayed.

2 Under Sampling Method, select the method that will be used by the MICRO/I to read data.

■ Always
The values of the device addresses set for the data of each channel are always read. When the condition of writing to 
the data storage area is satisfied, the values that were read at that point in time are written to the data storage area.

■ While satisfying the condition of writing to data storage area 
The values of the device addresses set for the data of each channel are read when the condition of writing to the data 
storage area is satisfied, and those values are written to the data storage area.

3 Select the channel number to register the Data Log settings to in Settings, then click Edit.

The Individual Settings dialog box is displayed.

2 Data Log Function Configuration Procedure

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P
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4 On the General tab, under Log function, select Enable.

The channel number selected on the Data Log Settings dialog box is displayed in Channel No.

5 Enter the name of the channel in Channel Name.

6 Under Condition of Writing to Data Storage Area, select the condition that will be used to write the values of the 
sampled device addresses to the data storage area.

■ Fixed Period
Writes the value of source device address at a fixed interval. If Fixed Period is selected, specify Time in seconds.

■ Event Bit
Writes the value of source device address each time the monitored bit device or the bit number of the word device 
changes from 0 to 1. If Event Bit is selected, specify the device address to monitor as the condition for writing data 
in Device Address.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.

■ Event Word
Writes the value of source device address each time the value of monitored word device changes. If Event Word is 
selected, select the data size for the word device to monitor in Data Size, and specify the device address to monitor 
as the condition for Writing data in Device Address.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.
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7 Click the Data tab.

8 Under Output Items, select the items that will be output when data is output as CSV.

Select the check boxes of the items to output.
If the Label check box is selected, enter the label to display in the sampling time column when the data is output as 
CSV.
To use text registered in Text Manager, select the Use Text Manager check box and specify the ID number of the 
text to use as the label.

Click  to open Text Manager where you can edit the text.

9 Click Add in the Output Data.

The Add Data dialog box is displayed.

10 In Number of Data, specify the amount of data to add to the channel.

The configured number of sequential device addresses from the start device address are displayed in Output Data.
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11 In Label, enter the text to display for the label of the data.

The label is used for the label row of the data number columns when the data is output as CSV.
• When Number of Data is 2 or higher, "Data+Number" is automatically entered.

Example: Data001, Data002, Data003
• If the Use Text Manager check box is selected on the Data tab, specify a text ID to use for the label in 

Label(Start Text ID).

12 In Top Device Address, specify the starting device address of the word devices that will be read for sampling data.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.

13 Select the data type of the sampled device value in Data Type.

The data type selected here is the data type for the numerical values when the data is output as CSV.
When String(S) is selected, use Words to specify the number of words of device addresses to read starting from the 
set device address and proceed to step 15. The set number of words of consecutive device addresses from the 
starting device address will be output as CSV.

14 Under Display Type, set the display type for numerical values when data is output as CSV.

■ Counting Method
Select the display type as Decimal or Hexadecimal for numerical values.

■ Digits
Specifies the digits to display. The range of digits that can be set varies based on the display type and data type.

■ Display Floating Point
Select this check box to display the decimal point.

■ Floating Digits
Specifies the number of digits for the fractional part of the decimal value out of the number of digits specified by 
Digits.
This option can only be configured when the Display Floating Point check box is selected.

■ Floating Symbol
Selects the decimal point symbol from the following.
.(dot), :(colon), ;(semicolon), ,(comma), /(slash)
This option can only be configured when the Display Floating Point check box is selected.

15 Click OK to close the Add Data dialog box.

You are returned to the Individual Settings dialog box.

To individually register Data Log settings, repeat steps 9 through 14.
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16 Click OK to close the Individual Settings dialog box.

You are returned to the Data Log Settings dialog box.

17 Repeat steps 3 through 16 to register Data Log settings for all of the channel numbers to use.

18 Click OK.

The Data Log Settings dialog box closes.
This concludes configuring the sampling conditions and device addresses for sampling data.

Next, configure the functions to execute using sampled data.
 “4.1 Display the Data in the Line Chart” on page 14-34
 “4.2 Displaying Data as Numerical Values” on page 14-36
 “4.3 Saving the Data as a CSV File” on page 14-45
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This section describes the items and buttons on the Data Log Settings dialog box and the Individual Settings dialog box.

3.1 Data Log Settings Dialog Box

All the device addresses to sample values from and their sampling conditions and Condition of Writing to Data Storage 
Area are collectively managed in the Data Log Settings dialog box.

■ Settings
Edits the Data Log settings for each channel.

3 Data Log Settings Dialog Box

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

Channel No.: Shows the channel number. Double clicking the cell displays the Individual Settings dialog box 
where you can edit the settings. For details, refer to “3.2 Individual Settings Dialog Box” on page 
14-16.

Log function: Shows whether or not the Data Log function is used. Double clicking the cell switches between 
Enable and Disable. If switched to Disable, that channel’s settings all return to the default 
settings.

Channel Name: Shows the channel name. Double clicking the cell displays the Individual Settings dialog box 
where you can edit the settings. For details, refer to “3.2 Individual Settings Dialog Box” on page 
14-16. This option can only be set when Enable is selected in Log Function.

Condition of Writing: Shows the condition for writing to data storage area. Double clicking the cell switches between 
Fixed Period, Event Bit, and Event Word. This option can only be set when Enable is 
selected in Log Function.

Data Size: Shows the data size for the device address that is the Condition of Writing to Data Storage 
Area. Double clicking the cell switches between 16-bit and 32-bit. This option can only be set 
when Event Word is selected in Condition of Writing to Data Storage Area.
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■ Edit
Registers or changes the settings for the selected channel number.
Select a channel number and click this button to display the Individual Settings dialog box. The settings for the 
selected channel are reflected in the Individual Settings dialog box.
For details, refer to “3.2 Individual Settings Dialog Box” on page 14-16.

■ Up
Shifts the selected settings upward in the list.

■ Down
Shifts the selected settings downward in the list.

■ Clear All Log Data
Select this check box to erase the all log data saved in the data storage area.

■ Number of Stored Data for Data Log per Device Address
Shows the maximum amount of data storage per device address for Data Log data saved in the data storage area. If 
data is saved up the maximum amount and then the maximum is exceeded, the old data is deleted and the new data 
is saved.
The default is 1024.

Click  to display the Data Storage Area Management dialog box where you can change the allocation of data 
storage area memory. For details, refer to Chapter 16 “Data Storage Area” on page 16-1.

Range: Shows the time in seconds (1 to 9999) to sample data in a fixed interval when Fixed Period is 
selected in Condition of Writing to Data Storage Area. Double clicking the cell displays the 
Individual Settings dialog box where you can edit the settings. For details, refer to “3.2 
Individual Settings Dialog Box” on page 14-16.
Shows the device address that is the condition of writing to Data Storage Area when Event Bit 
or Event Word is selected in Condition of Writing to Data Storage Area. Double clicking 
the cell displays the Tag Editor where you can edit the device address. For the device address 
configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-68.

Monitor: Shows the write destination device address when monitor count of writings to Data Storage 
Area. Shows No when not monitoring. Double clicking the cell displays the Individual Settings 
dialog box where you can edit the settings. For details, refer to “3.2 Individual Settings Dialog 
Box” on page 14-16. This option can only be set when Enable is selected in Log Function.

Batch: Shows the trigger device address that triggers batch output when batch outputting all the data 
saved in the data storage area to the external memory device. Shows No when there is no batch 
output. Double clicking the cell displays the Individual Settings dialog box where you can edit 
the settings. For details, refer to “3.2 Individual Settings Dialog Box” on page 14-16.

Real Time: Shows whether or not to perform real time output. Double clicking the cell switches between 
Yes and No. Data is output to the external memory device in 3 minute intervals for Yes 
channels. This option can only be set when Enable is selected in Log Function.

Words: Shows the total number of words of the device addresses that will be sampled by the channel. 
Double clicking the cell displays the Individual Settings dialog box where you can edit the 
settings. For details, refer to “3.2 Individual Settings Dialog Box” on page 14-16. This option can 
only be set when Enable is selected in Log Function.

(Trigger Device Address): Specifies the bit device or the bit number of the word device that triggers the erasure of 
the data. The data for all channels is erased when the value of the configured device 
address changes from 0 to 1. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-68.
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■ Sampling Method
Sets the method that will be used by the MICRO/I to read the values of device addresses.

Always: The values of the device addresses set for the data of 
each channel are always read. When the condition of 
writing to the data storage area is satisfied, the values 
that were read at that point in time are written to the 
data storage area.

While satisfying the condition of writing to data storage area: The values of the device addresses set for the data of 
each channel are read when the condition of writing to 
the data storage area is satisfied, and those values are 
written to the data storage area.

The total number of words of data that can be registered to the data log settings will depend on Sampling 
Method.
• If Sampling Method is Always, the total number of words in all channels is 128 words or less.
• If Sampling Method is While satisfying the condition of writing to data storage area, the total 

number of words per channel is 128 words or less.
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3.2 Individual Settings Dialog Box

Use the Individual Settings dialog box to register or edit the Data Log settings for the selected channel.

■ Channel Number
Shows the channel number selected in Settings in the Data Log Settings dialog box.

● General Tab
Sets the channel name and device address values to write to the data storage area.

■ Log function
Selects whether or not to use the Data Log function.

■ Channel Name
Enter a name of the channel. The maximum number is 40 characters.

Enable: Samples values of device addresses and saves the data along with the sampling time.

Disable: Does not sample values of device addresses.
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■ Condition of Writing to Data Storage Area
Sets the condition to write to the sampled address values to the data storage area.

■ Monitor Count of Writings to Data Storage Area
Select this check box to monitor count of writings to Data Storage Area. The count of writings to Data Storage Area is 
written to the specified device address.

■ Monitor % Space Used in Data Storage Area
Select this check box to monitor the usage of the allocated data storage area as the save destination for Data Log 
data. The usage is calculated from the data storage amount allocated to the data storage area and the amount of 
saved data, and then written to the specified device address.

Usage = Current amount of Data Log data ÷ Data Log data storage amount per device address (omits values after the 
decimal point)

Fixed Period: Writes the value of source device address at a fixed interval. If Fixed Period is selected, specify 
Time in seconds.

Time: Specifies the time in seconds (1 to 9999).
This option can only be set when Fixed Period is selected.

Event Bit: Writes the value of source device address each time the monitored bit device or the bit number of the 
word device changes from 0 to 1.

Event Word: Writes the value of source device address each time the value of monitored word device changes.

Data Size: Selects the data size of the monitored device address as 16-bit or 32-bit.
This option can only be set when Event Word is selected.

Device Address: Specifies the device address to monitor as the condition for Writing data.
For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.
This option can only be set when Event Bit or Event Word is selected.

If this setting is different from other channels, it cannot be displayed in the Line Chart.

(Destination Device Address): Specifies the destination word device.
For the device address configuration procedure, refer to Chapter 2 “5.1 Device Address 
Settings” on page 2-68.

Report when Count of Writings to Data Storage Area has reached or exceeded 
Threshold:

Writes 1 in the Report Device Address when the current 
count of writings to Data Storage Area reaches or exceeds 
the set threshold.

Threshold: Specifies the count of writings to Data Storage Area  that is 
the basis for reporting (1 to 65535).

Report Device Address: Specifies the destination bit device or the bit number of the 
destination word device.
For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-68.

(Destination Device Address): Specifies the destination word device to write the current usage of the amount of Data Log 
data storage.
For the device address configuration procedure, refer to Chapter 2 “5.1 Device Address 
Settings” on page 2-68.

Report when % Space Used has reached or exceeded Threshold:

Writes 1 in the Report Device Address when the current usage 
reaches or exceeds the set threshold.

Threshold: Specifies the usage (1 to 100) that is the basis for reporting.

Report Device Address: Specifies the destination bit device or the bit number of the 
destination word device.
For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-68.
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■ Clear Log Data
Select this check box to erase the Data Log data for the selected channel from the Data Storage Area.

■ Store Status of Sampling
Select this check box to check the reading status of data.

(Trigger Device Address): Specifies the bit device or the bit number of the word device that triggers the erasure of 
the data. The data for selected channels is erased when the value of the configured device 
address changes from 0 to 1. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-68.

If the amount of log data for the channel differs, the Line Chart cannot be displayed.
If differing channels of data were displayed in the same chart, the chart can no longer be displayed if the 
Data Log data is erased by channel units.

(Status Device Address): Specify the word device that will store the reading status. For the device address 
configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-68.

Bit Function Description

0 Reading
This bit is 1 while reading the data from the external device and 0 when reading 
has completed.

1 Read error
This bit is 1 when the condition of writing to the data storage area was satisfied 
again while reading data from the external device and data was lost. To clear 
this bit, write 1 to the Clear error bit (bit 15).

2 to 14 Reserved -

15 Clear error
Write 1 to this bit to clear the read error (bit 1). This bit automatically changes 
to 0 when processing is finished.
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● External Memory Device Tab
The External Memory Device tab is used to configure whether or not to output saved data to the external memory 

device*1.

The output data is stored in the following folder on the external memory device*1.
\External Memory Device folder\DATALOG

The default External Memory Device folder name is “HGDATA01”. For details, refer to Chapter 31 “1.6 Setting the 
External Memory Device Folder” on page 31-15.

*1 SD memory card for HG5G/4G/3G/2G-V, HG4G/3G and HG2G-5F, USB flash drive for HG2G-5T and HG1G/1P

Data that is sampled after starting output to the external memory device is not included in the output data.
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■ Batch
Select this check box to batch output all the sampled data to the external memory device*1.

All the data is saved on the external memory device*1 when the trigger device addresses changes from 0 to 1. If a file 

with the same name already exists on the external memory device*1, that file is overwritten. The maximum amount of 
output data is the amount configured by the data storage area.

*1 SD memory card for HG5G/4G/3G/2G-V, HG4G/3G and HG2G-5F, USB flash drive for HG2G-5T and HG1G/1P

MICRO/I

Data Log data (CSV)

Output to 
External memory device Data Log data

 Sampling Time Data001 Data002 Data003

 01/01/2011 12:00:30 20 120 201

 01/01/2011 12:01:30 21 121 204

 01/01/2011 12:02:30 22 122 206

 01/01/2011 12:03:30 23 123 206

 01/01/2011 12:04:30 24 124 210

 01/01/2011 12:05:30 25 125 210

 01/01/2011 12:06:30 26 126 218 0 1

Trigger Device Address

Data to be output
(all)

External Memory Device

USB flash drive

SD memory card

The storing of data stops if there is insufficient free space on the external memory device. The error 
information is stored in the following HMI Special Data Registers. For details about the error information, 
refer to Chapter 33 “HMI Special Data Register (LSD)” on page 33-7.
SD memory card:
USB flash drive:

LSD42
LSD33

Trigger Device Address: Specifies the bit device or the bit number of the word device to serve as condition for batch 
output. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.
Data is output to file when the value of the Trigger Device Address changes from 0 to 1.

File Name: Enter the file name for the output data or shows the file name.

The default is “LOGOn.CSV”. (n: Data log channel number)
To change the file name, enter a new file name. The maximum number is 120 characters 
(including the extension).

Specify File Name by Value of Device Address: Select this check box to assign a file name 
for the output data using a value of device 
address specified in the File Name Device 
Address.

(File Name Device Address): Specifies a word device to create a file name. The file 
name is set by reading the values sequentially from the 
starting device address specified with the File Name 
Device Address and handling those values as character 
data up to the character before NULL (00).
The maximum number of device addresses is 40 
(2 characters per word device, maximum of 80 single-
byte characters). You can only specify an internal device. 
For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-68.

Example: When the device address specified by (File Name Device Address) is LDR100 
and the text to set is "IDEC":

The file name at this time becomes "IDEC.CSV".

LDR100
LDR101
LDR102

(File Name Device Address) 4844(Hex)

4543(Hex)

‘ I ’ ‘D’
‘E’ ‘C’

0000(Hex)(NULL)
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Add Device Address data to File Name: Select this check box to add the bottom three digits of 
the value of the device address configured by (File 
Name Device Address) to the end of the file name for 
the output data.

(File Name Device Address): Specifies the word device that is the source for the value to 
add to the file name. For the device address configuration 
procedure, refer to Chapter 2 “5.1 Device Address Settings” 
on page 2-68. This option can only be configured when the 
Add Device Address data to File Name check box is 
selected.

Example: When File Name is "LOGO01" and the value of device address in (File Name 
Device Address) is 123, the file name is "LOGO01123.CSV".

Add Time Stamp: Select from the following format for date and time to be added to the file 
name when data is output:
None, YY, YY+MM, YY+MM+DD, YY+MM+DD+HH, 
YY+MM+DD+HH+MM, YY+MM+DD+HH+MM+SS
The format is YYMMDD_hhmmss (YY: year, MM: month, DD: day, hh: hour, 
mm: minute, ss: second).

Example: File Name is "LOGO01" on September 15 2013 at 23:30:50

YY: LOGO01_13
YY+MM: LOGO01_1309
YY+MM+DD: LOGO01_130915
YY+MM+DD+HH: LOGO01_130915_23
YY+MM+DD+HH+MM: LOGO01_130915_2330
YY+MM+DD+HH+MM+SS: LOGO01_130915_233050

Set limit on files: Specifies the upper limit (1 to 100) when limiting the number of files to be 
output.

When the Set limit on files check box is selected, note the following points.
• If the number of data files saved on the external memory device increases, it may take some time for 

the data output processing, or the output of the next data may not be processed normally.
• When displaying pictures saved on the external memory device and processing the output of data both 

occur simultaneously, the pictures may not be displayed.
• When parts that blink overlap pictures saved to the external memory device, the blinking period may 

slow down when data output processing occurs.

• The following single-byte character cannot be used in the file name configured by File Name or Specify 
File Name by Value of Device Address.
 \ / :  ; * ? " < > |

• File names that exceed the limits in Specify File Name by Value of Device Address and file names 
configured with characters that cannot be used are as follows.
- When the text of the file name exceeds the maximum number of device addresses (no NULL), the text 

stored in device addresses up to the maximum number of device addresses from the start is 
configured.

- When a character that cannot be used is set, the text is up to that character.
- When the first character is a character that cannot be used, the text is that set for File Name.

• The operation when the Set limit on files check box is selected is as follows.
- The files are output up to the set limit, and then for additional files, the new files are saved by 

discarding the old files in order of the oldest first.
- If the number of files saved on the external memory device already exceeds the limit when operation 

starts, the number of files at that time is the limit. From there the data is discarded in order from the 
oldest data and replaced with new data with each file output.
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■ Real Time
Select this check box to output data to the external memory device*1 in real time.

With real time output, data is saved to the external memory device*1 in three minute intervals after the MICRO/I starts 
running. If the accumulated data reaches 80% of the amount set in the Data Storage Area, then the data is forcibly 

saved to the external memory device*1. When there is already data with the same file name on the external memory 

device*1, data is appended to that file. If there was no update to the data during the three minutes, it is not output. 
Data is appended to the file until the size of the file reaches the restriction size (256 MB), so the maximum amount of 
output data differs according to the settings for the output channel such as the amount of data, the data size, and the 
labels.

If the sampling interval is shorter than real time output (the interval for writing to the external memory device*1), that Data 
Log is recorded up to the data storage amount - 1, and then afterwards, old data is discarded in order and replaced with new 
data.

*1 SD memory card for HG5G/4G/3G/2G-V, HG4G/3G and HG2G-5F, USB flash drive for HG2G-5T and HG1G/1P

MICRO/I

Data Log data (CSV)

Output to
External memory device 

Data Log data

 Sampling Time Data001 Data002 Data003

 01/01/2011 12:00:30 20 120 201

 01/01/2011 12:01:30 21 121 204

 01/01/2011 12:02:30 22 122 206

 01/01/2011 12:03:30 23 123 206

 01/01/2011 12:04:30 24 124 210

 01/01/2011 12:05:30 25 125 210

 01/01/2011 12:06:30 26 126 218

Data to be output 
3 minutes after 
operation starts

Data to be output 
3 minutes after that
Data to be output 
after another 
3 minutes

3 minute interval 
after operation 

starts

External Memory Device

USB flash drive

SD memory card

Real time output stops when the file size of the Data Log data exceeds 256 MB or when there is insufficient 
space on the external memory device. The error information is stored in the following HMI Special Data 
Registers. For details about the error information, refer to Chapter 33 “HMI Special Data Register (LSD)” on 
page 33-7.
SD memory card:
USB flash drive:

LSD42
LSD33

• When the value of the following HMI Special Internal Relays changes from 0 to 1, the data at that time is 
first output in real time to the external memory device, and then access to the external memory device is 
stopped. For details, refer to Chapter 33 “HMI Special Relay (LSM)” on page 33-2.

SD memory card:
USB flash drive: 

LSD20
LSD18

• The text font configured for the starting device address is output as the label font.
• The amount of free space on the external device is saved to the following HMI Special Data Registers. For 

details about the free space on the External Memory Devices, refer to Chapter 33 “HMI Special Data 
Register (LSD)” on page 33-7.

SD memory card:
USB flash drive:

LSD43, 44
LSD34, 35
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File Name: Enter the file name for the output data or shows the file name.

The default is “LOGOn.CSV”. (n: Data log channel number)
To change the file name, enter a new file name. The maximum number is 120 characters 
(including the extension).

Specify File Name by Value of Device Address: Select this check box to specify the name of the 
file for the output data with the value of the device 
address configured by (File Name Device Address).

(File Name Device Address): Specifies the word device that is the source of the data to use as 
the file name. The file name is set by reading the values 
sequentially from the starting device address specified with the File 
Name Device Address and handling those values as character data 
up to the character before NULL (00).
The maximum number of device addresses is 40 (80 single-byte 
characters). You can only specify an internal device. For the device 
address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.

Example: When the device address specified by (File Name Device Address) is LDR100 and the text 
to set is "IDEC":

The file name at this time becomes "IDEC.CSV".

Add Device Address data to File Name: Select this check box to add the bottom three digits of the 
value of the device address configured by (File Name Device 
Address) to the end of the file name for the output data.

(File Name Device Address): Specifies the word device that is the source for the value to add to 
the file name. For the device address configuration procedure, 
refer to Chapter 2 “5.1 Device Address Settings” on page 2-68. This 
option can only be configured when the Add Device Address 
data to File Name check box is selected.

Example: When File Name is "LOGA01" and the value of the device address configured by (File 
Name Device Address) is 123, the file name is "LOGA01123.CSV".

Add Time Stamp: Selects the format of the output date and time to add to the file name for the 
output data.
None, YY, YY+MM, YY+MM+DD
The format is YYMMDD (YY: year, MM: month, DD: day).

Example: File Name is "LOGA01" on September 15 2013

YY: LOGO01_13

YY+MM: LOGO01_1309

YY+MM+DD: LOGO01_130915

Realtime Output: Select this check box to forcibly output the data and save it to file at the desired 
timing.

(Trigger device address): Specifies the bit device or the bit number of the word device to 
serve as the condition to forcibly output the data. You can only 
specify an internal device. For the device address configuration 
procedure, refer to Chapter 2 “5.1 Device Address Settings” on 
page 2-68. Data is output to file when the trigger device address 
changes from 0 to 1.

Set limit on files: Specifies the upper limit (1 to 100) when limiting the number of files to be output.

LDR100
LDR101
LDR102

(File Name Device Address) 4844(Hex)

4543(Hex)

‘ I ’ ‘D’
‘E’ ‘C’

0000(Hex)(NULL)
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Save the data of Data Log and display in Line Chart

To display a lot of data on a line chart, select this check box to save the Data Log data to the 
external memory device.
Writes the data to the file (.BIN) at the same timing as the real time output. The maximum file 
size is 256 MB. If the file size exceeds 256 MB at writing, the data will be deleted in order from 
the oldest data and replaced with new data.
Creates a "DATA" folder in the "DATALOG" folder of the external memory folder and save files for 
each channel.
Configures the Display of the saved data in the X-Axis tab of the Properties of Line Chart 
dialog box to display the data in the saved file on the Line Chart.For details, refer to Chapter 11 
“Display of the saved data” on page 11-30.

File Name: This is the name (except extension) set in the File Name. 
However, the settings of Specify File Name by Value of Device 
Address, Add Device Address data to File Name and Add 
Time Stamp are not applied.
The default is “LOGAn.BIN”. (n: Data log channel number)

:

When the Set limit on files check box is selected, note the following points.
• If the number of data files saved on the external memory device increases, it may take some time for 

the data output processing, or the output of the next data may not be processed normally.
• When displaying pictures saved on the external memory device and processing the output of data both 

occur simultaneously, the pictures may not be displayed.
• When parts that blink overlap pictures saved to the external memory device, the blinking period may 

slow down when data output processing occurs.

• The following single-byte characters cannot be used in the file name configured by File Name or 
Specify File Name by Value of Device Address.
 \ / :  ; * ? " < > |

• File names that exceed the limits in Specify File Name by Value of Device Address and file names 
configured with characters that cannot be used are as follows.
- When the text of the file name exceeds the maximum number of device addresses (no NULL), the text 

stored in device addresses up to the maximum number of device addresses from the start is 
configured.

- When a character that cannot be used is set, the text is up to that character.
- When the first character is a character that cannot be used, the text is that set for File Name.

•  The operation when the Set limit on files check box is selected is as follows.
- The files are output up to the set limit, and then for additional files, the new files are saved by 

discarding the old files in order of the oldest first.
- If the number of files saved on the external memory device already exceeds the limit when operation 

starts, the number of files at that time is the limit. From there the data is discarded in order from the 
oldest data and replaced with new data with each file output.

• The following operations are as follows if the Realtime Output check box is selected.
- Even if the data is outputted forcibly, the real time output period (3 minute interval) is not reset.
- While data is being output with the real time output function, the file is not output when the value of 

the Realtime Output device address is 1.
- Even when output has finished, the value of device address does not automatically change to 0.

• Deleting the Data Log data in the data storage area deletes the file (.BIN) saved in the external memory. 
For details about the BIN file, refer to “Save the data of Data Log and display in Line Chart”.
- Operations to delete all files (.BIN)

• Click Clear on the Online tab, and then click All or Data Log Data.
• Executes Clear All Log Data configured in the Data Log Settings.
• Clears the Data Log data when the project data is downloaded.

- Operations to delete target files (.BIN)
• Executes Clear Log Data configured in the Individual Settings of the Data Log Settings.
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• The function to sample data operates when Data Log data is being saved to the external memory device.
• The batch output or real time output status of the Data Log data can be checked with the value of HMI 

Special Internal Relay LSM35. When the data starts to be written to the external memory device, the 
value of device address is 1. When writing is complete, the value is 0.

• The methods to erase Data Log files saved on the external memory device are as follows.
- To erase files during operation using parts, on the External Memory Device tab on the Project 

Settings dialog box, select the Remove Files check box and the All Data Log data check boxes, 
and then configure the trigger device address. Assign that trigger device address to a part.

- To erase files with WindO/I-NV4, click Clear on the Online tab, and then click Stored Data in 
External Memory Device to open the Clear Data dialog box.  Select the Data Log Data check box 
and click OK.

- To erase files on the HG5G/4G/3G/2G-V, HG4G/3G and HG2G-5F, go to the System Mode - File Manager. 
In the File Manager, select the files to be deleted by pressing DEL.
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Output Data File Name

The file name format is as follows.
File Name Value of Device Address_YYMMDD_hhmmss.CSV

■ Example 1

Result: The file name is "LOGO01123_1309.CSV".

■ Example 2

Result: The file name is "IDEC123_130915_233050.CSV".

File Name: The text entered in File Name or the text entered according to the value of the device 
address set by Specify File Name by Value of Device Address

Value of Device Address: The lower 3 digits of the value of the device address configured by Add Device 
Address data to File Name

YYMMDD: The year, month, and day of the month set on Add Time Stamp

hhmmss: The hour, minute, and second of the time configured on Add Time Stamp

Item Setting

File Name LOGO01

Add value of Device Address to File 
Name

(File Name Device Address) is 
LDR200

LDR200 value: 123

Add Time Stamp YY+MM Date when data was output: September 2013

Item Setting

Specify File Name by Value of Device 
Address

(File Name Device Address) is 
LDR100
Text to set is "IDEC"

LDR100 value: 4944 (Hex)
LDR101 value: 4543 (Hex)
LDR102 value: 0000 (Hex)

Add value of Device Address to File 
Name

(File Name Device Address) is 
LDR200

LDR200 value: 123

Add Time Stamp YY+MM+DD+HH+MM+SS
Date and time when data was output: 
September 15 2013 at 23:30:50
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● Data Tab
The Data tab is used to configure the data to sample.

■ Use Text Manager
Select this check box to use text registered in the Text Manager for labels when outputting data as CSV.

■ Output Items
Select the output items when data is output as CSV. Select the check boxes of the items to output.
Header, Label, Sampling Time
When Label is selected, specifies the label to display in the sampling time column when outputting data as CSV.

■ Output Data
Output Data is used to configure the details of the data to sample for each data number in the selected channel.

Label(Text ID): Specifies the Text Manager ID number (1 to 32000) when text registered in Text Manager are 
used for labels.

Click  to open Text Manager where you can edit the text.
This option is only enabled if you select the Use Text Manager check box.

Label: Enter the text to display in the label. The maximum number is 40 characters.
Text can only be entered when the Use Text Manager check box is cleared. The registered text 
is displayed when a text ID is specified.

No.: Shows the data numbers for the registered data. Double clicking the cell displays the Edit Data 
dialog box. The data number cannot be edited. For details, refer to “Add Data Dialog Box and 
Edit Data Dialog Box” on page 14-29.

Text ID: Shows the Text Manager ID number when text registered in Text Manager is used for labels. 
Double clicking the cell allows you to edit the text.
Text ID is only displayed when you select the Use Text Manager check box.
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■ Add
Registers the data settings to the selected channel.
Click this button to display the Add Data dialog box. The details configured on the Add Data dialog box are 
registered for all the data.
For details, refer to “Add Data Dialog Box and Edit Data Dialog Box” on page 14-29.

■ Edit
Changes the settings for the selected data.
Select the data and click this button to display the Edit Data dialog box. Change the data with the content set in the 
Edit Data dialog box.
For details, refer to “Add Data Dialog Box and Edit Data Dialog Box” on page 14-29.

■ Delete
Deletes the selected data.
Select a data and click this button.

■ Up
Shifts the selected settings upward in the list.

■ Down
Shifts the selected settings downward in the list.

■ Total: n words (128 words max.)
Shows the total number of words of data that will be sampled. (n: Total number of words)

Label: Shows the text to display as labels when data is output as CSV. 
When the Use Text Manager check box is cleared, double clicking the cell allows you to edit 
the label. The maximum number is 40 characters.
The default label is “Data” and the data number.
Example: Data001
If the Use Text Manager check box is selected, the text of the specified text ID is displayed. 
Double clicking the cell displays Text Manager where you can edit the text.

Top Device Address: Shows the starting device address of the word devices that will be read for sampling data. Double 
clicking the cell displays the Edit Data dialog box where the device address can be edited. For 
details, refer to “Add Data Dialog Box and Edit Data Dialog Box” on page 14-29.

Data Type: Shows the data type for numerical values when data is output as CSV. Double clicking the cell 
displays the Edit Data dialog box where you can edit the data settings. For details, refer to 
“Add Data Dialog Box and Edit Data Dialog Box” on page 14-29.

Words: Shows the number of words of word devices that will be read (1 to 128). Double clicking the cell 
displays the Edit Data dialog box. For details, refer to “Add Data Dialog Box and Edit Data 
Dialog Box” on page 14-29.

Output Example: Shows an output example of the data when data is output as CSV. Double clicking the cell 
displays the Edit Data dialog box. For details, refer to “Add Data Dialog Box and Edit Data 
Dialog Box” on page 14-29.

To edit multiple numbers at one time, press and hold SHIFT or CTRL while you click the specific items to 
select multiple lines and click Edit. The content configured in the Edit Data dialog box is applied to all 
selected data settings.

The maximum number of words that can be configured for one channel is 128 words. However, if Sampling 
Method is Always, the total number of words in all channels is 128 words or less. For details, refer to 
“Sampling Method” on page 14-15.
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Add Data Dialog Box and Edit Data Dialog Box

With the Add Data dialog box, the data is registered to the selected channel.
With the Edit Data dialog box, the selected data for the selected channel is registered or changed.

■ Number of Data*1

Specifies the number of items of data to add to the channel (1 to 128).

■ Data Number*2

Displays the data number for the selected data.

■ Label(Text ID)
Specifies the Text Manager ID number (1 to 32000) when text registered in Text Manager are used for labels. For the 
Add Data dialog box, Text ID is automatically configured sequentially starting with the specified text ID.

Click  to open Text Manager where you can edit the text.
Text ID can only be configured when you select the Use Text Manager check box.

■ Label
Enter the text to display as the label when data is output as CSV. The maximum number is 40 characters.
This is displayed only when the Use Text Manager check box is cleared.

When Number of Data is 2 or higher, "Data+Number" is automatically entered.*1

Example: Data001, Data002, Data003

■ Data Type
Select the data type for numerical values when data is output as CSV. For details, refer to Chapter 2 “1.1 Available 
Data” on page 2-1.
When Float32(F) is selected, the data is output in the floating point type. However, when a value that was read is 8 
digits or larger, it is output in the exponential type.

■ Top Device Address
Specify the starting device address of the word devices that will be read for sampling data.
For the device address configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-68.
You can only specify the bit device when Bit is selected for Data Type. Words for the bit device is counted as one.

*1 Add Data dialog box only
*2 Edit Data dialog box only

Automatically entered labels cannot be edited here. Those labels can be edited by double clicking the cell to 
open the Individual Settings dialog box.
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■ Words
Reads the value of specified number of word device address from Top Device Address and output as CSV. Specifies 
the number of word devices to read (1 to 128).
This is displayed only when String(S) is selected for Data Type.
Example: When Number of Data is 2, Top Device Address of the data to register to Data Number 1 is LDR0000, 

and Words is 3
    Device addresses used in Data Number 1: LDR0000, LDR0001, LDR0002
    Device addresses used in Data Number 2: LDR0003, LDR0004, LDR0005
LDR0003 is registered as the starting device address of Data Number 2.

■ Display Type
Sets the display type for numerical values when data is output as CSV.
This is displayed only when UBIN16(W), BIN16(I), UBIN32(D), BIN32(L), BCD4(B), BCD8(EB), or 
Float32(F) is selected for Data Type.

Counting Method: Select the display type as Decimal or Hexadecimal for numerical values.

Digits: Specifies the digits to display. The range of digits that can be set varies based on the 
display type and data type. The digits that can be set are as follows.

Display Type Data Type Digits

Decimal display

UBIN16(W), BIN16(I) 1 to 5

UBIN32(D), BIN32(L) 1 to 10

BCD4(B) 1 to 4

BCD8(EB) 1 to 8

Float32(F) 1 to 10

Hexadecimal display
UBIN16(W) 1 to 4

UBIN32(D) 1 to 8

Display Floating Point: Select this check box to display the decimal point.

When the Display Floating Point check box is selected and UBIN16(W), BIN16(I), UBIN32(D), 
BIN32(L), BCD4(B), or BCD8(EB) is selected for Data Type, the source device is an integer, but the 
value is output with the decimal point added at the configured floating digits.
However, if Float32(F) is selected for Data Type, the source data is a decimal value.

Floating Digits: Specifies the number of digits for the fractional part of the decimal value out of the 
number of digits specified by Digits.
This option can only be configured when the Display Floating Point check box is selected. 
The range of digits that can be set for the fractional part varies based on the display type and 
data type. The range of digits that can be set for the fractional part is as follows.

Display Type Data Type Floating Digits

Decimal display

UBIN16(W), BIN16(I) 1 to Digits

UBIN32(D), BIN32(L) 1 to Digits

BCD4(B) 1 to Digits

BCD8(EB) 1 to Digits

Float32(F) 1 to Digits or 8

Hexadecimal display
UBIN16(W) --

UBIN32(D) --

Floating Symbol: Selects the decimal point symbol from the following.
.(dot), :(colon), ;(semicolon), ,(comma), /(slash)
This option can only be configured when the Display Floating Point check box is selected.
Example: When Digits is 4 and Floating Digits is 2

When Floating Symbol is .(dot) 12.34
When Floating Symbol is /(slash) 12/34
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● Options Tab
To display the data saved in the data storage area as numerical values on the MICRO/I, copy this data to the specified 
internal device.

■ Copy Data Log Data
Select this check box to copy data to a device address.

Destination Device Address: Specifies the destination device address for copied data. You can only specify an 
internal device.
For the device address configuration procedure, refer to Chapter 2 “5.1 Device Address 
Settings” on page 2-68.
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■ Starting Point
Selects the starting point of the data to copy.

Example: 1. For Newest Data, the starting point is the newest sampling time data.
2. For Oldest Data, the starting point is the oldest sampling time data.
3. For Specify by Value of Device Address and source device address: 3, the starting point is the third 
item of data from the oldest sampling time data.

■ Number of Data
Selects the specification method for the amount of data to copy.

■ Stored Order of Data
Selects the order to copy data.

Example: When Starting Point is Newest Data and Number of Data is 3, data is copied in the following order 
starting from device address LDR10 configured in Destination Device Address.

Newest Data: Sets the starting point as the newest data.

Oldest Data: Sets the starting point as the oldest data.

Specify by Value of Device Address: Specifies which data from the oldest data to set as the starting point by the 
value of device address.

Specifies the source device address. You can only specify an internal device.
For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.

Data log data

Sampling Time Value
2. Oldest Data read starting point → 12/18/2011 17:44:10 20

12/18/2011 18:34:10 21
3. Specify by Value of Device Address  read starting point (source device address: 3) → 12/19/2011 19:24:43 22

12/19/2011 20:01:54 24
12/19/2011 21:39:21 26

1. Newest Data read starting point → 12/20/2011 05:57:06 28

Value: Uses a constant value.
Specifies the amount to copy (1 to 64).

Device Address: Uses a value of device address.
Specifies the source device address. You can only specify an internal device.
For the device address configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” on 
page 2-68.

The maximum amount of data that can be copied to the internal device is 64.

From Newest to Oldest: Of the data to copy, copies from the start point in order of the newest data first.

From Oldest to Newest: Of the data to copy, copies from the start point in order of the oldest data first.

Data log data
Sampling Time Value Destination Device Address Value

12/18/2011 17:44:10 20
Configured
device address → LDR10 28 ←Copy from

newest dataLDR11
LDR12

:: 26
2234:42:91 1102/91/21 24

12/19/2011 20:01:54 24
Newest data 
read starting point→ 

12/19/2011 21:39:21 26
12/20/2011 05:57:06 28

Destination Device Address ValueConfigured
device address → LDR10 24 ←Copy from

oldest dataLDR11 26
LDR12 28

Amount of data: 3
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■ Target Data
Selects the data to copy from the Data Log data.

Example: When Start Number is 2 and End Number is 4, data 2 to 4 is the copy target.

■ Trigger Condition
Selects the condition to start copying.

Sampling Time: Select this check box to copy the sampling time data from the Data Log data. When this 
check box is selected, values of device addresses are copied in order from the data for 
data number 1.

Value of Device Address: Select this check box to copy the value of device address from the Data Log data.

Data Number: Selects the specification method for the data number of the value to copy.

Value: Uses a constant value.

Device Address: Uses a value of device address.

Start Number: Of the data to copy, specifies the data number of the 
data to start copying.
If you select Value, specify the data number (1 to 128).
If you select Device Address, specify the source device 
address. You can only specify an internal device. For the 
device address configuration procedure, refer to Chapter 
2 “5.1 Device Address Settings” on page 2-68.
When the Sampling Time check box is selected, the 
data number is 1. This cannot be changed.

End Number: Of the data to copy, specifies the data number of the 
data to end copying.
If you select Value, specify the data number (1 to 128).
If you select Device Address, specify the source device 
address. You can only specify an internal device. For the 
device address configuration procedure, refer to Chapter 
2 “5.1 Device Address Settings” on page 2-68.

Start No. End No.
Data No.: 1 2 3 4 5

↓ ↓ ↓ ↓ ↓
Sampling Time Data 1 Data 2 Data 3 Data 4 Data 5

10/01/2011 12:34:56 100 60 240 60 240
10/02/2011 03:45:12 200 80 450 80 450

Copy target

Always: Copies each time the data is updated.

Device Address: Specifies the device address that triggers the start of copying the data. Copies the data when 
the value of the specified device address changes from 0 to 1.
For the device address configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” 
on page 2-68.
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4.1 Display the Data in the Line Chart

You can display the sampled data in the Line Chart.

1 On the Home tab, in the Parts group, click Charts, and then click Line Chart.

2 Click a point on the edit screen where you wish to place the Line Chart.

3 Double-click the dropped Line Chart and a Properties dialog box will be displayed.

4 On the General tab, select Chart Type as Log Trend (Normal) or Log Trend (Pen Recorder).

4 Using the Data

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P
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5 Click the Y-Axis tab.

6 Specify the number (1 to 4) of Y-axis in Number of Axes.

7 Selects the Y-axis for to configure in the (Y-Axis) and enters the name of the Y-axis.

The maximum number is 40 characters.

8 Click Add to add a channel to the list.

The total of all the Y-axis is 20 channels maximum.

9 Configures Channel No., Data No., Line Type, Line Size, Line Color and Trigger Type for the data to display on 
the chart.

The channel number and the data number can be checked on the Data Log Settings dialog box.
When While ON is selected as Trigger Type, displays the graph when the value of device address is 1. Specifies the 
bit device or the bit number of the word device in Device Address to serve as condition.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.

The data to display in the chart is registered in the channel number (Ch1 to Ch20) for the chart selected in Channel 
Settings.

10 Repeat steps 7 and 9 to register the data to display in the chart.

11 Click OK.

The Properties dialog box closes.
This concludes configuring the Line Chart.



4 Using the Data

14-36 WindO/I-NV4 User’s Manual

4.2 Displaying Data as Numerical Values

You can display data in the Numerical Display by copying data saved in the data storage area to an internal device 
according to the conditions configured with the Options tab on the Individual Settings dialog box.

● Copying Data to Internal Devices

Copying Sampling Time Data

Sampling time data is copied as a BCD value to the six sequential device addresses starting with the device address 
configured by Destination Device Address.
The sampling time data is copied in year, month, day, hour, minute, second order regardless of the Stored Order of 
Data setting.

■ Example
When the sampling time 10/01/2011 12:01:30 is copied to the destination device address

Data Read Start Position and Copy Order of Data to the Destination Device Address

The data to copy and the order differs according to the Starting Point and the Stored Order for Data settings.

■ Example 1
Copying three items of the newest data in the Data Log to the destination device address

Data log data

Sampling Time Value Destination Device Address Value

10/01/2011 12:01:30 20
Configured
device address → LDR10 2011 ←Year

LDR11 10 ←Month

LDR12 1 ←Day

LDR13 12 ←Hour

LDR14 1 ←Minute

LDR15 30 ←Second

Item Setting

Destination Device Address LDR10

Starting Point Newest Data

Number of Data 3

Stored Order of Data From Newest to Oldest

Data log data

Sampling Time Value Destination Device Address Value

12/18/2011 17:44:10 20
Configured
device address → LDR10

LDR11
LDR12

28 ←Copy from
newest data:: 26

12/19/2011 19:24:43 22 24
12/19/2011 20:01:54 24

Newest data 
read starting point →

12/19/2011 21:39:21 26
12/20/2011 05:57:06 28

Amount of data: 3
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■ Example 2
Copying three items of the newest data in the Data Log in order from the oldest to the destination device address

■ Example 3
Setting the starting point to the fourth item of the oldest data in the Data Log and copying three items of data from 
the newest to the destination device address

Item Setting

Destination Device Address LDR10

Starting Point Newest Data

Number of Data 3

Stored Order of Data From Oldest to Newest

Data log data

Sampling Time Value Destination Device Address Value

12/18/2011 17:44:10 20
Configured
device address→ LDR10

LDR11
LDR12

24 ←Copy from
oldest data:: 26

12/19/2011 19:24:43 22 28
12/19/2011 20:01:54 24

Newest data 
read starting point→

12/19/2011 21:39:21 26
12/20/2011 05:57:06 28

Amount of data: 

Item Setting

Destination Device Address LDR10

Starting Point Specify by Value of Device Address (value is 4)

Number of Data 3

Stored Order of Data From Newest to Oldest

Data log data

Sampling Time Value Destination Device Address Value
Specify by Value of 
Device Address
read starting point

12/18/2011 17:44:10 20
Configured
device address → LDR10

LDR11
LDR12

28 ←Copy from
newest data12/19/2011 07:24:09 12 26

12/19/2011 19:24:43 22 24(Source 
device address: 4) → 12/19/2011 20:01:54 24

12/19/2011 21:39:21 26
12/20/2011 05:57:06 28
12/20/2011 15:26:17 29
12/21/2011 06:46:57 31

Amount of data: 3
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Copying Data when UBIN32(D), BIN32(L), BCD8(EB) or Float32(F) is Selected as the Data Type

When one of UBIN32(D), BIN32(L), BCD8(EB) or Float32(F) is selected for Data Type on the Data tab in the 
Individual Settings dialog box, two destination device addresses are required for a single item of data.

■ Example
Copying the newest data in the Data Log with the Data Type selected as UBIN32(D) to the destination device 
address LDR10.

Item Setting

Destination Device Address LDR10

Starting Point Newest Data

Number of Data 2

Stored Order of Data From Newest to Oldest

Data log data

Sampling Time Value Destination Device Address Value

12/18/2011 17:44:10
87654321 

(Hex)

Configured
device address→ LDR10 3344 ←Copy from

newest dataLDR11
LDR12

1122
:: 7788

12/19/2011 19:24:43
12345678 

(Hex)
LDR13 5566

12/19/2011 20:01:54
55667788 

(Hex)

Newest data 
read starting point → 12/19/2011 21:39:21

11223344 
(Hex)

Amount of data: 2

The data copy order for the device address selected with UBIN32(D), BIN32(L), BCD8(EB) or 
Float32(F) as Data Type is configured with Storage Method of 32-bit Numerical Data on the 
System tab in the Project Settings dialog box. For details, refer to Chapter 4 “3.1 System Tab” on page 
4-25.
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Copying Multiple Items of Data

When copying multiple items of data, first all the sampling times for the data are copied in order starting with the 
device address configured as the destination device address, then the values of device addresses for all the data are 
copied in order.
For example, data is copied in this order: first sampling time → second sampling time → ... → first data 1 value of 
device address → first data 2 value of device address → second data 1 value of device address → second data 2 value 
of device address and so on.

■ Example
The sampling time and values of device addresses from data start number 1 to end number 3 are copied to the 
destination device address as two items of data.

Item Setting

Destination Device Address LDR10

Starting Point Newest Data

Number of Data 2

Stored Order of Data From Oldest to Newest

Target Data
Sampling Time, Value of Device Address

Data No.: Start No. 1, End No. 3

When writing with the following settings, “Device range error” is displayed.
• Starting Point is 0 or a value larger than the amount of saved data
• Start Number is 0 or a value larger than Data Number
• End Number is 0 or a value larger than Data Number
• Start Number is a value larger than End Number

Data log data

Sampling Time Data 1 Data 2 Data 3 Data 4 Data 5

10/01/2011 12:00:30 10 40 100 20 120
10/01/2011 12:34:56 100 60 240 30 200

10/02/2011 03:45:12 200 80 450 70 400 ←Newest Data read starting point

Destination Device Address Value
Configured device address → 2011 ←Copy from oldest data

10

←First sampling time
01
12
34
56

2011

←Second sampling time

10
02
03
45
12

100 ←First data 1 value

200 ←Second data 1 value

60 ←First data 2 value

80 ←Second data 2 value

240 ←First data 3 value

450

LDR10

LDR11
LDR12
LDR13
LDR14
LDR15
LDR16
LDR17
LDR18
LDR19
LDR20
LDR21

LDR22

LDR23

LDR24

LDR25

LDR26

LDR27 ←Second data 3 value

1.

2.

3. 4.   5.

1.

2.

3.

4.

5.
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● Displaying Data on the Numerical Display
You can copy sampled data to an internal device and display it with the Numerical Display.

1 On the Configuration tab, in the System Setup group, click Data Log.

The Data Log Settings dialog box is displayed.

2 Under Sampling Method, select the condition that will be used by the MICRO/I to read data.

■ Always
The values of the device addresses set for the data of each channel are always read. When the condition of writing to 
the data storage area is satisfied, the values that were read at that point in time are written to the data storage area.

■ While satisfying the condition of writing to data storage area 
The values of the device addresses set for the data of each channel are read when the condition of writing to the data 
storage area is satisfied, and those values are written to the data storage area.

3 Under Settings, select the channel number for the data to display numerical values of on the Numerical Display, then 
click Edit.

The Individual Settings dialog box is displayed.

4 Select Enable for Log function on the General tab and configure Channel Name, and Condition of Writing to 
Data Storage Area.

5 Under Output Data on the Data tab, set Top Device Address, Data Type, and the other settings for each item of 
data.
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6 Click the Options tab.

7 Select the Copy Data Log Data check box.

8 Specify the destination device address for the copied data in Destination Device Address.

You can only specify an internal device.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.

9 Select the data that is the start point for copying data in Starting Point.

■ Newest Data
Set the starting point to read as the newest data.

■ Oldest Data
Set the starting point to read as the oldest data.

■ Specify by Value of Device Address
Specifies which data from the oldest data to set as the starting point to read by value of device address, and sets that 
data as the starting point to read.
Specifies the source device address. You can only specify an internal device.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.
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10 Select the specification method for the amount of data to copy in Number of Data.

■ Value
Use a constant.
Specifies the amount to copy (1 to 64).

■ Device Address
Use a word device.
Specifies the source device address. You can only specify an internal device.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.

11 Select the order to copy data in Stored Order of Data.

■ From Newest to Oldest
Of the data to copy, copies from the start point in order of the newest data first.

■ From Oldest to Newest
Of the data to copy, copies from the start point in order of the oldest data first.

12 Select the data to copy from the data in Target Data.

Select the Sampling Time check box to copy the sampling time data from the data.
Select the Value of Device Address check box to copy the value of device address from the data. When not copying 
the value of device address, proceed to step 16.

13 Select the specification method for the data number to copy the value in Data Number.

■ Value
Use a constant.

■ Device Address
Use a word device.

14 Specify the data number of the data to start copying out of the data to copy with Start Number.

If you select Value, specify the data number (1 to 128).

If you select Device Address, specify the source device address. You can only specify an internal device. Click  to 
display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device Address 
Settings” on page 2-68.
When the Sampling Time check box is selected, the data number is 1. This cannot be changed.

15 Specify the data number of the data to end copying out of the data to copy with End Number.

If you select Value, specify the data number (1 to 128).

If you select Device Address, specify the source device address. You can only specify an internal device. Click  to 
display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device Address 
Settings” on page 2-68.

16 Select the condition to start copying in Trigger Condition.

■ Always
Copies each time the data is updated.

■ Device Address
Specifies the device address that triggers the start of copying the data. Copies the data when the value of the 

specified device address changes from 0 to 1. Click  to display the Tag Editor. For the device address configuration 
procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-68.

17 Click OK to close the Individual Settings dialog box.

You are returned to the Data Log Settings dialog box.

The maximum amount of data that can be copied to the internal device is 64.
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18 Click OK.

The Data Log Settings dialog box closes.

19 On the Home tab, in the Parts group, click Data Displays, and then click Numerical Display.

20 Click a point on the edit screen where you wish to place the Numerical Display.

21 Double-click the dropped Numerical Display and a Properties dialog box will be displayed.

22 Select the display type for the copied data with Display Type on the General tab.

23 Select the data type for the copied data in Data Type under Data Format.

24 Specify the number of digits to display in Digits under Data Format.

The range of digits that can be set differs according to the display type and data type.
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25 Specify the source device address for the copied data in Display Device Address under Display Method.

For sequential device addresses of the amount of data to copy starting with Destination Device Address 
configured on the Options tab on the Data Log Settings Individual Settings dialog box, set Display Device 
Address for each Numerical Display to those device addresses.
Example: When Destination Device Address is LDR10, Number of Data is 3

Specify three Numerical Displays with Display Device Address specified as LDR10, LDR11, LDR12

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.

26 Click OK.

The Properties dialog box closes.

27 Repeat step 19 through 26 to configure the Numerical Displays for the amount of data to copy.

This concludes configuring the Numerical Display.

MICRO/I

External device

(Internal device)

124
125
126

Data Log data

 Sampling Time Data001

 01/01/2011 12:00:30 120

 01/01/2011 12:01:30 121

 01/01/2011 12:02:30 122

 01/01/2011 12:03:30 123

 01/01/2011 12:04:30 124

 01/01/2011 12:05:30 125

 01/01/2011 12:06:30 126

LDR10 : 126

LDR11 : 125

LDR12 : 124

Copy
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4.3 Saving the Data as a CSV File

● Saving the Data as a CSV File
The Data Log data can be saved to the external memory device*1 as a CSV file or uploaded to a computer.
The procedure to save the data is as follows.
• To save the data to an external memory device, click Data Log on the WindO/I-NV4 Configuration tab to display 

the Data Log Settings dialog box. Select a channel number to save to the external memory device and click Edit 
to display the Individual Settings dialog box. Select an output method check box on the External Memory 
Device tab and configure the items. The data can be saved to the External Memory Device folder on the external 
memory device. For details, refer to “External Memory Device Tab” on page 14-19.

• To upload the data to a computer, click on ▼ to the right of (Upload) on the toolbar in Data File Manager, and 
then click the Upload All Log Data or Upload Data Log Data to open the Browser For Folder dialog box. Specify 
the location to save the file and click OK to save the file to the specified folder. For details, refer to the Data File 
Manager User's Manual.

● Data Structure and Output Example
The data structure of the output file is as follows. The data structure for files output with batch output and real time 
output is the same.
Bold items are replaced by the Data Log settings, the sampled data, the running project name, and WindO/I-NV4 
version number.

*1 SD memory card for HG5G/4G/3G/2G-V, HG4G/3G and HG2G-5F, USB flash drive for HG2G-5T and HG1G/1P
*2 Only when the Header check box is selected on the Data tab in the Individual Settings dialog box
*3 Only when the Label check box is selected on the Data tab in the Individual Settings dialog box
*4 Only when the Sampling Time check box is selected on the Data tab in the Individual Settings dialog box

Headers*2

“Project Name”,”Project name”,”Version number”
“File Type”,”Log type”
“Channel No.”,”Channel number”
“Source”,”Top Device Address (data number 1)”
“Sampling Method”,”Condition of Writing to Data Storage Area (type)”
“Condition of Writing to Data Storage Area (label)”,”Condition of Writing to Data Storage 
Area (configuration details)”
Blank row

Label row*3 “Label (sampling time)*4”,”Label (data number 1)”,”Label (data number 2)”... times the amount 
of data

Data row

“MM/DD/YYYY hh:mm:ss*4”,Data number 1 data value,Data number 2 data value... times the 
amount of data

·
·
·

Output example Data size of each row
“Project Name”,”Dimmer Console”,”1.7.0.0” - 41 bytes
“File Type”,”Data Log Data” - 29 bytes
“Channel No.”,”1” - 19 bytes
“Source”,”LDR100” - 20 bytes
“Sampling Method”,”Fixed Period” - 34 bytes
“Time[Sec]”,”1” - 17 bytes

- 2 bytes
“Sampling Time”,”Data001”,”Data002” - 37 bytes
“08/23/2011 18:32:04”,171,234 - 32 bytes

·
·
·
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• The data size for each row is counted as 2 bytes for full-width characters, 1 byte for half-width characters, 
and 2 bytes for newlines. The total for each row is the total amount of space for the file.

• A space is inserted before the year in the data row.
• The display type for the date and time differs according to the language configured in Project Settings, 

on the Project Details tab, in Language.
Japanese: YYYY/MM/DD hh:mm:ss
European, Chinese, Taiwanese, Korean, Central European, Baltic, Cyrillic: MM/DD/YYYY hh:mm:ss

•  The output values of the data row will depend on Data Type of the data.
- When Data Type of the data is String(S)

The values of the set amount of words of device addresses stored from Top Device Address are 
converted to a string and output.
However, if 0x00 (NULL) appears in the string, the characters after 0x00 (NULL) are not output.
The order of characters output to the CSV file is set according to Storage Method of String Data on 
the System tab in Project Settings.
Example: Starting device address: LDR0, number of words: 3

Stored values: LDR0=0x3132, LDR1=0x3334, LDR2=0x3536 => Output value: 123456
Stored values: LDR0=0x3132, LDR1=0x3300, LDR2=0x3435 => Output value: 123

If the string contains the following codes, the entire string will be enclosed with double quotation 
marks (") and output.

Comma (,)
Newline codes (CR, LF, and CR+LF)
Double quotation mark (")

If the string contains a double quotation mark ("), a double quotation mark (") will be added in front of 
it.
Example: Starting device address: LDR0, number of words: 3

Stored values: LDR0=0x312C, LDR1=0x3334, LDR2=0x0000 => Output value: "1,34"
Stored values: LDR0=0x310D, LDR1=0x3334, LDR2=0x0000 => Output value: "1[CR]34"
Stored values: LDR0=0x3122, LDR1=0x3334, LDR2=0x0000 => Output value: "1""34"

- When Data Type is UBIN16(W), BIN16(I), UBIN32(D), BIN32(L), BCD4(B), BCD8(EB), or 
Float32(F)
The value is output according to the setting of Display Type.
The zeros in the value are suppressed.
If the stored value exceeds the number of display digits, the upper portion of the value is cut and only 
the lower portion of the value is output for data types other than Float32(F) (source data: integer 
value). For Float32(F) (source data: decimal value), the upper value of the integer part and lower 
value of the decimal part are cut and the value is output in the number of display digits.
If an invalid number has been stored, #N/A is output.
If a comma (,) is used as the decimal point, the entire string is enclosed with double quotation marks 
(") and output.
Example: Starting device address: LDR0, number of words: 1

Stored value: LDR0=0x04D2
Data Type is UBIN16(W), Display Digits is 5 => Output value: 1234
Data Type is UBIN16(W), Display Digits is 2 => Output value: 34
Data Type is UBIN16(W), Display Digits is 2, Floating Digits is 1, Floating Symbol 
is . (dot) => Output value: 3.4
Data Type is UBIN16(W), Display Digits is 2, Floating Digits is 1, Floating Symbol 
is , (comma) => Output value: "3,4"
Data Type is BCD4(B), Display Digits is 4 => Output value: #N/A

Example: Starting device address: LDR0, number of words: 2
Stored values: LDR0=0xA000, LDR1=0x0000
Data Type is BIN16(I), Display Digits is 5 => Output value: -24576
Data Type is BIN16(I), Display Digits is 2 => Output value: -76
Data Type is BIN16(I), Display Digits is 2, Floating Digits is 1, Floating Symbol is . 
(dot) => Output value: -7.6
Data Type is Float32(F), Display Digits is 10 => Output value: #N/A
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This chapter describes how to configure the Operation Log function and its operation on the MICRO/I.

  

1.1 How the Operation Log Function is Used

The Operation Log function records events that have occurred on the MICRO/I, including user operations such as 
pressing a button or changing the operation mode.
You can perform the following actions using the Operation Log function.

• Record turning on the MICRO/I power

• Record switching the base screen

• Record changing the user

• Record changing the operation mode

Chapter 15 Operation Log Function

1 Overview

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

MICRO/I

Power ON

MICRO/I

130

12:00
Run Mode

MICRO/I MICRO/I

130 Switch to Base Screen
Full

Tank 1

Base screen 1
12:01
Base screen 2

MICRO/I

130

MICRO/I

130 Change Users

User1

Group parts not displayed on User2 screen

12:02
User2

MICRO/I MICRO/I

130 Change Operation Modes

Run Mode
12:03
System Mode

Run Offline Main Menu

MAC Address  00:03:7B:F0:12:A8
IP Address 192.168.0.1(DHCP)
2010/OCT/14/THU   14:56:44
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• Record pressing a touch switch

• Record writing a value to a device address by pressing a touch switch

• Output Operation Log data to the external memory device*1

*1 SD memory card for HG5G/4G/3G/2G-V, HG4G/3G and HG2G-5F, USB flash drive for HG2G-5T and HG1G/1P

MICRO/I

130

12:04
Press touch switch

MICRO/I

100

100
100

D1= 100

Write 100

ValueExternal device

12:05
Press touch switch

100     D1

Output to
External memory device

Operation Log data
(CSV)

MICRO/I External memory device

USB flash drive

SD memory card
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1.2 Recorded Events

The recorded events are as follows.

■ Power ON
This operation is recorded when the MICRO/I power is turned on.

■ Switch to Base Screen
This operation is recorded by the following events.
• Switched the base screen by pressing the Goto Screen Button or a Multi-Button
• Switched the base screen by pressing the key button Ref. on the Alarm List Display or the Alarm Log Display
• Switched the base screen by executing the Goto Screen Command or a Multi-Command
• Switched the base screen by writing a screen number to System Area 1 address number + 0 (displayed screen 

number)

■ Change Users
This operation is recorded by the following events.
• Switched the user by entering a password on the Password Screen
• Switched the user by writing a value of device address
• Switched to the default user

■ Change Operation Modes
This operation is recorded by the following events.
• Switched to System Mode by pressing the Goto Screen Button or a Multi-Button
• Switched to System Mode by executing the Goto Screen Command or a Multi-Command
• Switched to System Mode by pressing System Mode on the Maintenance screen
• Switched to Run Mode from System Mode by pressing Run on the Top Page in the System Mode
• Switched to Monitor Mode from Run Mode by clicking Start Monitor on the WindO/I-NV4 Online tab
• Switched to Run Mode from Monitor Mode by clicking Stop Monitor on the WindO/I-NV4 Online tab
• Switched to Offline Mode from Monitor Mode by clicking Go Offline on the WindO/I-NV4 Online tab
• Switched to Monitor Mode from Offline Mode by clicking Go Online on the WindO/I-NV4 Online tab

■ Press buttons
This operation is recorded by the following events.
• Pressing a Bit Button, Word Button, Goto Screen Button, Multi-Button, Selector Switch, Potentiometer, Numerical 

Input, Character Input
• Pressing the key buttons ENT, Download Project, Upload Project, Copy Files, Download PLC Program, 

Upload PLC Program, All Chk., Del. All, Ref., Stop Buzzer and Screen Flashing, Record

■ Write Data to any Device Addresses
This operation is recorded by the following event.
Writing a value to a device address by pressing a Bit Button, Word Button, Multi-Button, Selector Switch, 
Potentiometer, Numerical Input, Character Input

• If User is selected in Default User in the Security dialog box, a Change Users event occurs when the 
power is turned on and when the operation mode is changed.

• If the Switch to Base Screen check box is selected, a Switch to Base Screen event also occurs when 
a Change Users event occurs.

The Operation Log is only recorded during Run Mode.
Switching from Run Mode to System Mode and switching from System Mode to Run Mode is recorded. 
Switching from System Mode to Data Transfer Mode and switching from Data Transfer Mode to System 
Mode is not recorded.

The Operation Log only records button presses for parts created in WindO/I-NV4.
Operations for the buttons displayed in the System Mode, the Password Screen, the System Error Message 
and the title bar of Popup Screen are not recorded.
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1.3 Data Configuration

The recorded data is composed of a label, time, user name, screen number, event name, part name, device address, 
and content after the change.
The relationship between the Operation Log function settings and the recorded data is as follows.

1. Event: Events that occur on the MICRO/I due to operations including user operations. Only the 
checked events are recorded.

2. Data storage amount: The amount of data to record. For details, refer to “Data Storage Amount” on page 15-6.
3. Label: When the recorded data is output as a CSV file, this is the text displayed in the label row.
4. Sampling Time: The time the event occurred.

The display type for the date and time varies based on the language configured in Project 
Settings, on the Project Details tab, in Language.
YYYY/MM/DD hh:mm:ss: Japanese
MM/DD/YYYY hh:mm:ss: European, Chinese, Taiwanese, Korean, Central 

European, Baltic, Cyrillic
5. User Name: The user name when the event occurred.

The user name is only recorded when the Use Security functions check box is selected on 
the General tab in the Security dialog box.

6. Screen No.: The screen type and number that was displayed when the event occurred.
Base n: Base screen (n: screen number)

Example: Base 1
Popup n: Popup screen (n: screen number)

Example: Popup 10

Sampling Time User Screen No. Event Name Part Name Details Changed to

12/01/2011 12:00:10 - Base1 Power ON - - -

12/01/2011 12:01:23 User1 Base1 Switch to Base Screen - - Base2

12/01/2011 12:02:45 User1 Base2 Change Users - - User2

12/01/2011 12:03:06 User2 Base2 Change Operation Modes - - System Mode

12/01/2011 12:04:11 User2 Base2 Press buttons BitSwitch - -

12/01/2011 12:04:11 User2 Base2 Write Data to any Device Addresses - LDR0 55

2. Data storage amount

3. Labels

4. Sampling Time

1. Event

5. User Name 6. Screen No. 10. Changed to7. Event Name 8. Part Name 9. Device Address

Operation Log settings

Recorded data
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7. Event Name: When the recorded data is output as a CSV file, this is the text displayed as a label to 
describe the event that occurred. This item is configured in the Data Labels dialog box.

8. Part Name: The part name for the pressed touch switch when the Press buttons event occurs.
9. Device Address: The destination device address when the Write Data to any Device Addresses event 

occurs.
When an indirect write is used, the device address specified by the indirect value is 
recorded.
Example: When the device address configured as the destination for the value 100 is 

LDR100 and the indirect value is 3

10. Changed to: The result produced from the event that occurred. The recorded content varies based on the 
event that occurred.
Switch to Base Screen: The screen type and number after switching.

Base n: Base screen (n: screen number)
Example: Base 1

Change Users: The user name after the change.
Change Operation Modes: The operation mode after the change.

Run Mode: Run Mode
System Mode: System Mode
Monitor Mode: Monitor Mode
Offline Mode: Offline Mode

Write Data to any Device Addresses: The value written to the device address by pressing the 
touch switch. This value is handled as UBIN16(W). For 
details, refer to Chapter 2 “1.1 Available Data” on page 
2-1.
The value written to the device address is recorded as 
UBIN16(W) regardless of the data type.
Example: When -10 (0xFFF6) is written to device 

address D0

If the written value is 2 words (32 bits), each word is 
recorded (16 bits). For the storage order for 32-bit 
device address data, the upper word and lower word 
are stored following the Storage Method of 32-bit 
Numerical Data setting. Storage Method of 32-bit 
Numerical Data is configured on the System tab in 
the Project Settings dialog box. For details, refer to 
Chapter 4 “3.1 System Tab” on page 4-25.
Example: When Storage Method of 32-bit 

Numerical Data is from Lower word and 
12345678 (0xBC614E) is written to device 
address D0 with the data type UBIN32(D)

Event Name Part Name Details Changed to
Press buttons WordSwitch1 ‒ ‒

Write Data to any Device Addresses ‒ LDR103 100

Changed toDetailsPart Name
Press buttons WordSwitch1
Write Data to 

any Device Addresses ‒

‒ ‒

D0 65526 (0xFFF6)

Event Name

Event Name
Press buttons WordSwitch1
Write Data to 

any Device Addresses ‒ D0 24910 (0x614E)

Write Data to
any Device Addresses ‒ D1 188 (0xBC)

Changed toDetailsPart Name
‒ ‒
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1.4 Saving and Deleting Data

● Saving Data
The recorded data is saved in the data storage area.

If the saved data exceeds the Operation Log data storage amount, the oldest data is deleted and the new data is 
saved.

Data Storage Amount

The maximum amount of data that can be saved in the data storage area is as follows.

● Deleting Data
The method to delete recorded data from the data storage area is as follows.
• On the Online tab in WindO/I-NV4, click the arrow under Clear, and click All or Operation Log Data. For details, 

refer to Chapter 24 “4 Clear” on page 24-25.
• In the System Mode, on the Main Menu screen, perform the following operation;

 

MICRO/I

130

Operation Log data

Sampling Time User Screen No. Event Name Part Name Details Changed to

12/01/2011 12:00:10 - Base1 Power ON - - -

12/01/2011 12:01:23 User1 Base1 Switch to Base Screen - - Base2

12/01/2011 12:02:45 User1 Base2 Change Users - - User2

12/01/2011 12:03:06 User2 Base2 Change Operation Modes - - System Mode

12/01/2011 12:04:11 User2 Base2 Press buttons BitSwitch - -

12/01/2011 12:04:11 User2 Base2 Write Data to any Device Addresses - LDR0 55

Opera�on Log data storage amount

Oldest data
(delete)

New data

When there is no remaining battery power, the data in the Operation Log is erased when the MICRO/I is 
turned off.

Model Maximum amount of data that can be saved in the data storage area

HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F 8,330

HG2G-5T, HG1G/1P 3,945

The maximum amount of data that can be recorded by a single operation is 150 items. When writing to 
multiple device addresses in a single operation using the Multi-Button or other part, data over 150 items 
cannot be recorded. If the data to be recorded in a single operation exceeds 150 items, HMI Special Internal 
Relay LSM22 is set to 1. For details, refer to Chapter 33 “HMI Special Relay (LSM)” on page 33-2.

HG5G/4G/3G/2G-V, HG4G/3G, HG2F-5F: Press Initial Setting, Initialize, Operation Log in order. 
HG2G-5T, HG1G/1P: Press Initial Setting, Initialize, Op. Log in order.
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1.5 Using the Data

The saved data can be used in the following ways.

*1 SD memory card for HG5G/4G/3G/2G-V, HG4G/3G and HG2G-5F, USB flash drive for HG2G-5T and HG1G/1P

• Save to and read from an external memory device *1

Output data from the MICRO/I to the external memory device as 
a CSV file and use it on a computer.
For details, refer to “4.1 Saving the Data as a CSV File” on page 
15-21.

Operation Log data

Sampling Time User Screen No. Event Name Part Name Details Changed to

12/01/2011 12:00:10 - Base1 Power ON - - -

12/01/2011 12:01:23 User1 Base1 Switch to Base Screen - - Base2

12/01/2011 12:02:45 User1 Base2 Change Users - - User2

12/01/2011 12:03:06 User2 Base2 Change Operation Modes - - System Mode

12/01/2011 12:04:11 User2 Base2 Press buttons BitSwitch - -

12/01/2011 12:04:11 User2 Base2 Write Data to any Device Addresses - LDR0 55

External
memory device

Operation Log data
(CSV)

Book1

Sheet1 Sheet2 Sheet3

Sampling Time User Screen No. Event Name Part Name Details Changed to

12/01/2011 12:00:10 - Base1 Power ON - - -

12/01/2011 12:01:23 User1 Base1 Switch to Base Screen - - Base2

12/01/2011 12:02:45 User1 Base2 Change Users - - User2

12/01/2011 12:03:06 User2 Base2 Change Operation Modes - - System Mode

12/01/2011 12:04:11 User2 Base2 Press buttons BitSwitch - -

12/01/2011 12:04:11 User2 Base2 Write Data to any Devices - LDR0 55
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This section describes the configuration procedure for the Operation Log function.

2.1 Configuring the Events and the Condition for Recording

1 On the Configuration tab, in the System Setup group, click Operation Log.

The Operation Log Settings dialog box is displayed.

2 Select the Enable Operation Log Settings check box.

3 Select the check boxes for the events to record under Target Events to record.

2 Operation Log Function Configuration Procedure

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

Power ON: The following items are recorded when the MICRO/I power is turned on.
Time, Screen Number, Event Name

Switch to Base Screen: The following items are recorded when the base screen is switched.
Time, User Name, Screen Number, Event Name, Changed to

Change Users: The following items are recorded when the user is changed.
Time, User Name, Screen Number, Event Name, Changed to

Change Operation Modes: The following items are recorded when the operation mode is changed.
Time, User Name, Screen Number, Event Name, Changed to

Press buttons: The following items are recorded when a touch switch is pressed.
Time, User Name, Screen Number, Event Name, Part Name

Write Data to any Device Addresses: The following items are recorded when a value is written to a device address 
by pressing a touch switch.
Time, User Name, Screen Number, Event Name, Device Address, Changed to



WindO/I-NV4 User’s Manual 15-9

2 Operation Log Function Configuration Procedure

15

O
peration Log Function

4 Configure the Operation Log data storage amount in Number of Stored Data.

Click  to display the Data Storage Area Management dialog box.
Specify the Operation Log data storage amount in Number of Stored Data for Operation Log and click OK.
The Data Storage Area Management dialog box closes.

5 Select the condition to record events in Trigger condition.

■ Always
Always records events.

■ Device Address
Records events when the specified device address is 1. You can only specify an internal device.
For the device address configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-68.

6 Click OK.

The Operation Log Settings dialog box closes.
This concludes configuring the events and the condition for recording.
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This section describes items and buttons on the Operation Log Settings dialog box.

3.1 Operation Log Settings Dialog Box

● General Tab
The General tab is used to configure the events and the condition for recording.

■ Enable Operation Log Settings
Select this check box to use the Operation Log function.

■ Target Events to record
Selects the events to record. Select the check boxes for the events to record.

3 Operation Log Settings Dialog Box

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

Power ON: The following items are recorded when the MICRO/I power is turned on.
Time, screen number, event name

Switch to Base Screen: The following items are recorded when the base screen is switched.
Time, user name, screen number, event name, changed to

Change Users: The following items are recorded when the user is changed.
Time, user name, screen number, event name, changed to

Change Operation Modes: The following items are recorded when the operation mode is changed.
Time, user name, screen number, event name, changed to

Press buttons: The following items are recorded when a touch switch is pressed.
Time, user name, screen number, event name, part name

Write Data to any Device Addresses: The following items are recorded when a value is written to a device address 
by pressing a touch switch.
Time, user name, screen number, event name, device address, changed to

Edit Data Labels: Displays the Data Labels dialog box.
The Data Labels dialog box is used to edit the text displayed in the label row 
and the event names displayed in the data rows when the recorded data is 
output as a CSV file.
For details, refer to “Data Labels Dialog Box” on page 15-12.
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■ Monitor Count of Records
Select this check box to count the number of stored data. The number of stored data is written to the specified device 
address.

■ Monitor % Space Used in Data Storage Area
Select this check box to monitor the usage of the data storage area allocated as the save destination for Operation 
Log data. The usage is calculated from the data storage amount allocated to the data storage area and the amount of 
saved data, and then written to the specified device address.

Usage = Current amount of Operation Log data ÷ Operation Log data storage amount (omits values after the decimal point)

■ Clear Log Data
Select this check box to erase the Operation Log data saved in the data storage area.

■ Number of Stored Data
Shows the maximum amount of Operation Log data to save in the data storage area. Data is saved up to the set 
amount. The maximum amount of data that can be saved in the data storage area is listed next.

■ Trigger Condition
Selects the trigger condition for the Operation Log function.

(Destination Device Address): Specifies the destination word device.
For the device address configuration procedure, refer to Chapter 2 “5.1 Device Address 
Settings” on page 2-68.
Report when Count of Records has reached or exceeded Threshold:

Writes 1 to the Report Device Address when the number of 
record count reaches or exceeds the set threshold.

Threshold: Specifies the number of stored data (1 to 65535) that is the 
basis for reporting.

Report Device Address: Specifies the destination bit device or the bit number of the 
destination word device.
For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-68.

(Destination Device Address): Specifies the destination word device to write the current usage of the amount of 
Operation Log data storage.
For the device address configuration procedure, refer to Chapter 2 “5.1 Device Address 
Settings” on page 2-68.
Report when % Space Used has reached or exceeded Threshold:

Writes 1 in the Report Device Address when the current usage 
reaches or exceeds the set threshold.

Threshold: Specifies the usage (1 to 100) that is the basis for reporting.
Report Device Address: Specifies the destination bit device or the bit number of the 

destination word device.
For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-68.

(Trigger Device Address): Specifies the bit device that triggers the erasure of the data. The saved data is erased 
when the value of the configured device address changes from 0 to 1. For the device 
address configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 
2-68.

HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F: 8,330
HG2G-5T, HG1G/1P: 3,945

Click  to open the Data Storage Area Management dialog box where you can change the allocation of data storage 
area memory. For details, refer to Chapter 16 “Data Storage Area” on page 16-1.

Always: Always records events.
Device Address: Records events when the value of the specified device address is 1. 

For the device address configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” 
on page 2-68.
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Data Labels Dialog Box

The Data Labels dialog box is where you can edit labels for recorded data and event names when saving data as a 
CSV file.

Label of Recorded Data

■ Use Text Manager
Select this check box to use text registered in Text Manager for recorded data labels when saving data as a CSV file.

■ Label of Recorded Data
Specifies the text to display in the label row in Text or Text ID.

The details for each label row label is as follows.

Text: Double click the cell to enter the text to display as the label. The maximum number is 40 
characters.
Text can only be entered when the Use Text Manager check box is cleared.

Text ID: Double click the cell to specify the Text Manager ID number (1 to 32000) when using text registered 
in Text Manager as the label.
This option is only enabled if you select the Use Text Manager check box.

Sampling Time: The label for the column to display the time the event occurred.

User Name: The label for the column to display the user name when the event occurred.

Screen No.: The label for the column to display the screen type and number that was displayed when the event 
occurred.

Event Name: The label for the column to display the name of the event that occurred on the MICRO/I by an 
operation including a user operation.

Part Name: The label for the column to display the part name for the pressed touch switch when the Press 
buttons event occurs.

Device Address: The label for the column to display the destination device address when the Write Data to any 
Device Addresses event occurs.

Changed to: The label for the column to display the result produced from the event that occurred. The recorded 
content varies based on the event that occurred.
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Event Name

■ Use Text Manager
Select this check box to use text registered in Text Manager for the event names when saving data as a CSV file.

■ Event Name
Specifies the text to display in Event Name in Text or Text ID.

Event name details are as follows.

Text: Double click the cell to enter the text to display as the event name. The maximum number is 40 
characters.
Text can only be entered when the Use Text Manager check box is cleared.

Text ID: Double click the cell to specify the Text Manager ID number (1 to 32000) when using text registered in 
Text Manager as the event name.
This option is only enabled if you select the Use Text Manager check box.

Power ON: The event name when the MICRO/I power is turned on.

Switch to Base Screens: The event name when the base screen is switched.

Change Users: The event name when the user is changed.

Change Operation Modes: The event name when the MICRO/I operation mode is changed.

Press buttons: The event name when a touch switch is pressed.

Write Data to any Device Addresses: The event name when a value is written to a device address by pressing a 
touch switch.
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● External Memory Device Tab
The External Memory Device tab is used to configure whether or not to output saved data to the external memory 

device*1.

The output data is stored in the following folder on the external memory device*1.
\External Memory Device folder\OPERATIONLOG

The default External Memory Device folder name is “HGDATA01”. For details, refer to Chapter 31 “1.6 Setting the 
External Memory Device Folder” on page 31-15.

*1 SD memory card for HG5G/4G/3G/2G-V, HG4G/3G and HG2G-5F, USB flash drive for HG2G-5T and HG1G/1P

Data recorded after starting output to the external memory device is not included in the output data.
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■ Batch
Select this check box to batch output all the sampled data to the external memory device*1.

All the data is saved on the external memory device*1 when the value of the trigger device address changes from 0 to 
1. If a file with the same name already exists on the external memory device*1, that file is overwritten. The maximum 
amount of output data is the amount configured by the data storage area.

*1 SD memory card for HG5G/4G/3G/2G-V, HG4G/3G and HG2G-5F, USB flash drive for HG2G-5T and HG1G/1P

MICRO/I

Operation Log data
(CSV)

Output to
External memory device

Operation Log data

0 1
Trigger Device Address

Data to be output
(all)

Sampling Time User Screen No. Event Name Part Name Details Changed to

12/01/2011 12:00:10 - Base1 Power ON - - -

12/01/2011 12:01:23 User1 Base1 Switch to Base Screen - - Base2

12/01/2011 12:02:45 User1 Base2 Change Users - - User2

12/01/2011 12:03:06 User2 Base2 Change Operation Modes - - System Mode

12/01/2011 12:04:11 User2 Base2 Press buttons BitSwitch - -

12/01/2011 12:04:11 User2 Base2 Write Data to any Device Addresses - LDR0 55

12/01/2011 12:07:30 User2 Base2 Switch to Base Screen - - Base3

External memory device

USB flash drive

SD memory card

The storing of data stops if there is insufficient free space on the external memory device. The error 
information is stored in the following HMI Special Data Registers. For details about the error information, 
refer to Chapter 33 “HMI Special Data Register (LSD)” on page 33-7.
SD memory card:
USB flash drive:

LSD42
LSD33

Trigger Device Address: Specifies the bit device or the bit number of the word device to serve as condition for batch 
output. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.
Data is output to file when the value of the trigger device address changes from 0 to 1.

File Name: Enter the file name for the output data or shows the file name.
The default is “OPLOGO.CSV”.
To change the file name, enter a new file name. The maximum number is 120 characters 
(including the extension).

Specify File Name by Value of Device Address: Select this check box to assign a file name 
for the output data using a value of device 
address specified in the File Name Device 
Address.

(File Name Device Address): Specifies a word device to create a file name. The file 
name is set by reading the values sequentially from the 
starting device address specified with the File Name 
Device Address and handling those values as character 
data up to the character before NULL (00).
The maximum number of device addresses is 40 
(2 characters per word device, maximum of 80 single-
byte characters). You can only specify an internal device. 
For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-68.

Example: When the device address specified by (File Name Device Address) is LDR100 
and the text to set is "IDEC":

The file name at this time becomes "IDEC.CSV".

LDR100
LDR101
LDR102

(File Name Device Address) 4844(Hex)

4543(Hex)

‘ I ’ ‘D’
‘E’ ‘C’

0000(Hex)(NULL)
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Add Device Address data to File Name: Select this check box to add the bottom three 
digits of the value of the device address 
configured by (File Name Device Address) to the 
end of the file name for the output data.

(File Name Device Address): Specifies the word device that is the source for the value 
to add to the file name. For the device address 
configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68. This option can only be 
configured when the Add Device Address data to File 
Name check box is selected.

Example: File Name is "OPLOGO" and the value of device address in (File Name Device 
Address) is 123, the file name is "OPLOGO123.CSV".

Add Time Stamp: Select from the following format for date and time to be added to the 
file name when data is output:
None, YY, YY+MM, YY+MM+DD, YY+MM+DD+HH, 
YY+MM+DD+HH+MM, YY+MM+DD+HH+MM+SS
The format is YYMMDD_hhmmss (YY: year, MM: month, DD: day, hh: 
hour, mm: minute, ss: second).

Example: File Name is "OPLOGO" on September 15 2013 at 23:30:50
YY: OPLOGO_13
YY+MM: OPLOGO_1309
YY+MM+DD: OPLOGO_130915
YY+MM+DD+HH: OPLOGO_130915_23
YY+MM+DD+HH+MM: OPLOGO_130915_2330
YY+MM+DD+HH+MM+SS: OPLOGO_130915_233050

Set limit on files: Specifies the upper limit (1 to 100) when limiting the number of files to 
be output.

When the Set limit on files check box is selected, note the following points.
• If the number of data files saved on the external memory device increases, it may take some time for 

the data output processing, or the output of the next data may not be processed normally.
• When displaying pictures saved on the external memory device and processing the output of data both 

occur simultaneously, the pictures may not be displayed.
• When parts that blink overlap pictures saved to the external memory device, the blinking period may 

slow down when data output processing occurs.

• The following single-byte characters cannot be used in the file name configured by File Name or 
Specify File Name by Value of Device Address.
 \ / :  ; * ? " < > |

• File names that exceed the limits in Specify File Name by Value of Device Address and file names 
configured with characters that cannot be used are as follows.
- When the text of the file name exceeds the maximum number of device addresses (no NULL), the text 

stored in device addresses up to the maximum number of device addresses from the start is 
configured.

- When a character that cannot be used is set, the text is up to that character.
- When the first character is a character that cannot be used, the text is that set for File Name.

• The operation when the Set limit on files check box is selected is as follows.
- The files are output up to the set limit, and then for additional files, the new files are saved by 

discarding the old files in order of the oldest first.
- If the number of files saved on the external memory device already exceeds the limit when operation 

starts, the number of files at that time is the limit. From there the data is discarded in order from the 
oldest data and replaced with new data with each file output.
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■ Real Time
Select this check box to output data to the external memory device*1 in real time.

With real time output, data is saved to the external memory device*1 in three minute intervals after the MICRO/I starts 
running. If the accumulated data reaches 80% of the amount set in the Data Storage Area, then the data is forcibly 
saved to the external memory device*1. When there is already data with the same file name on the external memory 
device*1, data is appended to that file. If there was no update to the data during the three minutes, it is not output.
Data is appended to the file until the size of the file reaches the restriction size (256 MB), so the maximum amount of 
output data varies based on the settings for the output channel such as the amount of data, the data size, and the labels.
If the interval events occur more quickly than the time it takes to accomplish the real time output (the interval for writing 
to the external memory device*1), the Operation Log is recorded up to the data storage amount - 1, and then 
afterwards, old data is discarded in order and replaced with new data.

*1 SD memory card for HG5G/4G/3G/2G-V, HG4G/3G and HG2G-5F, USB flash drive for HG2G-5T and HG1G/1P

MICRO/I

Operation Log data
(CSV)

Output to
External memory device

Operation Log data

Sampling Time User Screen No. Event Name Part Name Details Changed to

12/01/2011 12:00:10 - Base1 Power ON - - -

12/01/2011 12:01:23 User1 Base1 Switch to Base Screen - - Base2

12/01/2011 12:02:45 User1 Base2 Change Users - - User2

12/01/2011 12:03:06 User2 Base2 Change Operation Modes - - System Mode

12/01/2011 12:04:11 User2 Base2 Press buttons BitSwitch - -

12/01/2011 12:04:11 User2 Base2 Write Data to any Device Addresses - LDR0 55

12/01/2011 12:07:30 User2 Base2 Switch to Base Screen - - Base3

3 minute interval 

after operation starts

Data to be output 
3 minutes after 
operation starts

Data to be output
3 minutes 
after that

Data to be output 
after another 
3 minutes

External memory device

USB flash drive

SD memory card

Real time output stops when the file size of the Operation Log data exceeds 256 MB or when there is 
insufficient space on the external memory device. The error information is stored in the following HMI 
Special Data Registers. For details about the error information, refer to Chapter 33 “HMI Special Data 
Register (LSD)” on page 33-7.
SD memory card:
USB flash drive:

LSD42
LSD33

• When the value of the following HMI Special Internal Relays changes from 0 to 1, the data at that time is 
first output in real time to the external memory device, and then access to the external memory device is 
stopped. For details, refer to Chapter 33 “HMI Special Relay (LSM)” on page 33-2.

SD memory card:
USB flash drive: 

LSD20
LSD18

• The amount of free space on the external memory device is saved to the following HMI Special Data 
Registers. For details about the free space on the External Memory Devices, refer to Chapter 33 “HMI 
Special Data Register (LSD)” on page 33-7.

SD memory card:
USB flash drive:

LSD43, 44
LSD34, 35



3 Operation Log Settings Dialog Box

15-18 WindO/I-NV4 User’s Manual

File Name: Enter the file name for the output data or shows the file name.
The default is “OPLOGA.CSV”.
To change the file name, enter a new file name. The maximum number is 120 characters (including the 
extension).
Specify File Name by Value of Device Address: Select this check box to specify the name of the file for 

the output data with the value of the device address 
configured by (File Name Device Address).

(File Name Device Address): Specifies the word device that is the source of the data to use as the 
file name. The file name is set by reading the values sequentially from 
the starting device address specified with the File Name Device 
Address and handling those values as character data up to the 
character before NULL (00).
The maximum number of device addresses is 40 (80 single-byte 
characters). You can only specify an internal device. For the device 
address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.

Example: When the device address specified by (File Name Device Address) is LDR100 and the text 
to set is "IDEC":

The file name at this time becomes "IDEC.CSV".
Add Device Address data to File Name: Select this check box to add the bottom three digits of the value 

of the device address configured by (File Name Device Address) 
to the end of the file name for the output data.

(File Name Device Address): Specifies the word device that is the source for the value to add to the 
file name. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-68. This option can 
only be configured when the Add Device Address data to File 
Name check box is selected.

Example: When File Name is "OPLOGA" and the value of the device address configured by (File 
Name Device Address) is 123, the file name is "OPLOGA123.CSV".

Add Time Stamp: Selects the format of the output date and time to add to the file name for the output 
data.
None, YY, YY+MM, YY+MM+DD
The format is YYMMDD (YY: year, MM: month, DD: day).

Example: File Name is "OPLOGA" on September 15 2013
YY: OPLOGA_13
YY+MM: OPLOGA_1309
YY+MM+DD: OPLOGA_130915

Realtime Output: Select this check box to forcibly output the data and save it to file at the desired 
timing.

(Trigger device address): Specifies the bit device or the bit number of the word device to serve 
as the condition to forcibly output the data. You can only specify an 
internal device. For the device address configuration procedure, refer 
to Chapter 2 “5.1 Device Address Settings” on page 2-68. 
Data is output to file when the trigger device address changes from 0 
to 1.

Set limit on files: Specifies the upper limit (1 to 100) when limiting the number of files to be output.

LDR100
LDR101
LDR102

(File Name Device Address) 4844(Hex)

4543(Hex)

‘ I ’ ‘D’
‘E’ ‘C’

0000(Hex)(NULL)
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 When the Set limit on files check box is selected, note the following points.
• If the number of data files saved on the external memory device increases, it may take some time for 

the data output processing, or the output of the next data may not be processed normally.
• When displaying pictures saved on the external memory device and processing the output of data both 

occur simultaneously, the pictures may not be displayed.
• When parts that blink overlap pictures saved to the external memory device, the blinking period may 

slow down when data output processing occurs.

• The following single-byte characters cannot be used in the file name configured by File Name or 
Specify File Name by Value of Device Address.
 \ / :  ; * ? " < > |

• File names that exceed the limits in Specify File Name by Value of Device Address and file names 
configured with characters that cannot be used are as follows.
- When the text of the file name exceeds the maximum number of device addresses (no NULL), the text 

stored in device addresses up to the maximum number of device addresses from the start is 
configured.

- When a character that cannot be used is set, the text is up to that character.
- When the first character is a character that cannot be used, the text is that set for File Name.

• The operation when the Set limit on files check box is selected is as follows.
- The files are output up to the set limit, and then for additional files, the new files are saved by 

discarding the old files in order of the oldest first.
- If the number of files saved on the external memory device already exceeds the limit when operation 

starts, the number of files at that time is the limit. From there the data is discarded in order from the 
oldest data and replaced with new data with each file output.

• The following operations are as follows if the Realtime Output check box is selected.
- Even if the data is outputted forcibly, the real time output period (3 minute interval) is not reset.
- While data is being output with the real time output function, the file is not output when the value of 

the Realtime Output device address is 1.
- Even when output has finished, the value of device address does not automatically change to 0.

• The function to record data operates when Operation Log data is being saved to the external memory 
device.

• The batch output or real time output status of the Operation Log data can be checked with the value of 
HMI Special Internal Relay LSM37. When the data starts to be written to the external memory device, the 
value of device is 1. When writing is complete, the value is 0.

• The methods to erase Operation Log files saved on the external memory device are as follows.
- To erase files during operation using parts, on the External Memory Device tab in the Project 

Settings dialog box, select the Remove Files stored in External Memory Device check box and the 
All Operation Log data check box, and then configure the trigger device address. Assign that trigger 
device address to a part.

- To erase files with WindO/I-NV4, click Clear on the Online tab, and then click Stored Data in 
External Memory Device to open the Clear Data dialog box. Select the Operation Log Data check 
box and click OK.

- To erase files on the HG5G/4G/3G/2G-V, HG4G/3G and HG2G-5F, go to the System Mode - File Manager. 
In the File Manager, select the files to be deleted by pressing DEL.
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Output Data File Name

The file name format is as follows.
File Name Value of Device Address_YYMMDD_hhmmss.CSV

■ Example 1

Result: The file name is "OPLOGA123_1309.CSV".

■ Example 2

Result: The file name is "IDEC123_130915_233050.CSV".

File Name: The text entered in File Name or the text entered according to the value of the device 
address set by Specify File Name by Value of Device Address

Value of Device Address: The lower 3 digits of the value of the device address configured by Add Device 
Address data to File Name

YYMMDD: The year, month, and day of the month set on Add Time Stamp

hhmmss: The hour, minute, and second of the time configured on Add Time Stamp

Item Setting

File Name OPLOGA

Add value of Device Address to File 
Name

(File Name Device Address) is 
LDR200

LDR200 value: 123

Add Time Stamp YY+MM Date when data was output: September 2013

Item Setting

Specify File Name by Value of Device 
Address

(File Name Device Address) is 
LDR100
Text to set is "IDEC"

LDR100 value: 4944 (Hex)
LDR101 value: 4543 (Hex)
LDR102 value: 0000 (Hex)

Add value of Device Address to File 
Name

(File Name Device Address) is 
LDR200

LDR200 value: 123

Add Time Stamp YY+MM+DD+HH+MM+SS
Date and time when data was output: 
September 15 2013 at 23:30:50
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4.1 Saving the Data as a CSV File

● Saving the Data as a CSV File
The Operation Log data can be saved to the external memory device*1 as a CSV file or uploaded to a computer.
The procedure to save the data is as follows.
• To save the data to an external memory device, click Operation Log on the WindO/I-NV4 Configuration tab to 

open the Operation Log Settings dialog box. Select an output method check box on the External Memory Device 
tab and configure the items. The Operation Log data is saved to the External Memory Device folder on the external 
memory device according to the External Memory Device tab settings. For details, refer to “External Memory 
Device Tab” on page 15-14.

• To upload the data to a computer, click on ▼ to the right of (Upload) on the toolbar in Data File Manager, and 
then click the Upload All Log Data or Upload Data Operation Log Data to open the Browser For Folder dialog 
box. Specify the location to save the file and click OK to save the file to the specified folder. For details, refer to the 
Data File Manager User's Manual.

● Data Structure and Output Example
The data structure of the output file is as follows. The data structure for files output with batch output and real time 
output is the same.
Bold items are replaced by the Operation Log settings, the recorded data, the running project name, and WindO/I-
NV4 version number.

*1 SD memory card for HG5G/4G/3G/2G-V, HG4G/3G and HG2G-5F, USB flash drive for HG2G-5T and HG1G/1P

4 Using the Data

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

Headers

"Project Name","Project name","Version number"

"File Type","Log type"

Blank row

Label row
"Sampling Time","User Name","Screen No.","Event Name","Part Name","Device 
Address","Changed to"

Data row

" MM/DD/YYYY hh:mm:ss","User Name","Screen Type & No.","Event","Part 
Name","Device Address", "Changed to"

···

Output example Data size of each row

"Project Name","Dimmer Console","V4.50" - 41 bytes

"File Type","Operation Log Data" - 34 bytes

- 2 bytes

"Sampling Time","User","Screen No.","Operation","Part Name","Details",
"Changed to"

- 85 bytes

" 12/01/2011 12:00:10","-","Base 1","Power ON","-","-","-" - 60 bytes

" 12/01/2011 12:01:23","User1","Base 1","Switch to Base Screen","-","-", 
"Base2"

- 81 bytes

···

• The data size for each row is counted as 2 bytes for full-width characters, 1 byte for half-width characters, 
and 2 bytes for newlines. The total for each row is the total amount of space for the file.

• A space is inserted before the date in the data row.
• The display type for the date and time varies based on the language configured in Project Settings, on 

the Project Details tab, in Language.
Japanese: YYYY/MM/DD hh:mm:ss
European, Chinese, Taiwanese, Korean, Central European, Baltic, Cyrillic: MM/DD/YYYY hh:mm:ss
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This chapter describes how to configure the data storage area and its operation on the MICRO/I.

  

1.1 What is the Data Storage Area?

The data storage area is the area in the MICRO/I’s internal memory where saved data is not erased even when the 
power is turned off.
The following data can be saved in the data storage area.

• Alarm Log data
 Chapter 13 “Alarm Log Function” on page 13-1

• Data Log data
 Chapter 14 “Data Log Function” on page 14-1

• Operation Log data
 Chapter 15 “Operation Log Function” on page 15-1

Chapter 16 Data Storage Area

1 Overview

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

• When there is no remaining battery, the data in the data storage area is erased when the MICRO/I is 
turned off.

• If you download the project data from WindO/I-NV4, Alarm Log data, Operation Log data, and Data Log 
data is erased. The data saved in the HMI Keep Register (LKR) and the HMI Keep Relay (LK) is saved.
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1.2 Data Storage Area

The capacity of the data storage area and the types and sizes of data that can be saved there differ according to the 
MICRO/I model.

● Data Storage Area Capacity and Types of Storable Data
You can allocate areas to save Alarm Log data, Operation Log data, and Data Log data, as well as areas to use as HMI 
Keep Register (LKR) and HMI Keep Relay (LK). The unallocated leftover area is free space.

HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F

HG2G-5T, HG1G/1P

● Minimum and Maximum Amount of Data Storage and Number of Addresses
The minimum and maximum amount of data storage and the minimum and maximum number of addresses that can 
be configured for the data storage area is as follows.

Alarm Log data Operation Log 
data

Data Log data HMI Keep Registers 
(LKR)

HMI Keep Relays 
(LK) Free space

Data storage area (235,520 bytes)

Alarm Log data Operation Log 
data

Data Log data HMI Keep Registers 
(LKR)

HMI Keep Relays 
(LK) Free space

Data storage area (112,640 bytes)

Data type

HG5G/4G/3G/2G-V, 
HG4G/3G, HG2G-5F

HG2G-5T, HG1G/1P

Minimum Maximum Minimum Maximum

Number of Stored Data for Alarm Log 0 11660 0 5520

Number of Stored Data for Operation Log 0 8330 0 3945

Number of Stored Data for Data Log per 
Device Address

0 29165 0 13808

Number of HMI Keep Register (LKR) 1024 8192 1024 8192

Number of HMI Keep Relay (LK) 1024 8192 1024 8192
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This section describes the configuration procedure for the data storage area.

1 On the Configuration tab, in the System Setup group, click Data Storage Area.

The Data Storage Area Management dialog box is displayed.

2 Specify the amount of Alarm Log data to save in the data storage area in Number of Stored Data for Alarm Log 
(HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F: 0 to 11660, HG2G-5T, HG1G/1P: 0 to 5520).

3 Specify the amount of Operation Log data to save in the data storage area in Number of Stored Data for 
Operation Log (HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F: 0 to 8330, HG2G-5T, HG1G/1P: 0 to 3945).

4 Specify the amount of Data Log data per device address to save in the data storage area in Number of Stored Data 
for Data Log per Device Address (HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F: 0 to 29165, HG2G-5T, HG1G/1P: 0 to 
13808).

5 Specify the number of HMI Keep Register (LKR) addresses in Number of HMI Keep Register (LKR) (1024 to 
8192).

6 Specify the number of HMI Keep Relay (LK) addresses in Number of HMI Keep Relay (LK) (1024 to 8192).

7 Click OK.

The Data Storage Area Management dialog box closes.
This concludes configuring the data storage area.

2 Data Storage Area Configuration Procedure

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P
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This section describes items and buttons on the Data Storage Area Management dialog box.

■ Number of Stored Data for Alarm Log
Specifies the amount of Alarm Log data to save in the data storage area (HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F: 0 
to 11660, HG2G-5T, HG1G/1P: 0 to 5520).
Alarm Log data is only saved in the data storage area when Store is selected under Block Settings, Data in the 
Auto-Setup dialog box or in the Individual Settings dialog box for Alarm Log Settings.

■ Number of Stored Data for Operation Log
Specifies the amount of Operation Log data to save in the data storage area (HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F: 
0 to 8330, HG2G-5T, HG1G/1P: 0 to 3945).

■ Number of Stored Data for Data Log per Device Address
Specifies the amount of Data Log data per device address to save in the data storage area (HG5G/4G/3G/2G-V, 
HG4G/3G, HG2G-5F: 0 to 29165, HG2G-5T, HG1G/1P: 0 to 13808).
Data Log data is only saved in the data storage area when Enable is selected under Log function on the General 
Tab in the Individual Settings dialog box for Data Log Settings.

■ Number of HMI Keep Register (LKR)
Specifies the number of HMI Keep Register (LKR) addresses (1024 to 8192).

■ Number of HMI Keep Relay (LK)
Specifies the number of HMI Keep Relay (LK) addresses (1024 to 8192).

■ Free Space
Shows the amount of free space in the data storage area (in bytes).

■ Default
Returns the configured values to their default values.

3 Data Storage Area Management Dialog Box

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P
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This chapter describes how to configure the Preventive Maintenance function and its operation on the MICRO/I.

  

1.1 How the Preventive Maintenance Function is Used

The Preventive Maintenance function monitors the state of device addresses and counts the time the monitored 
device addresses are 1, as well as the number of times the values of monitored device addresses change to 1.
The Preventive Maintenance function can perform the following functions.

• Monitor device addresses that turn on lighting or warning lights and count the operation time

• Report the replacement time for lighting and warning lights by the counted operation time

• Monitor device addresses connected to buttons and relays and count the operation count

• Report the inspection time for buttons and relays by the counted operation count

Chapter 17 Preventive Maintenance Function

1 Overview
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1.2 Counting the Operation Time and Operation Count

The operation time and operation count are counted up to the set maximum value. The counted operation time and 
operation count are saved in HMI Keep Registers (LKR) and the values are retained until they are reset. To reset a 
counted value, set the value of the configured HMI Keep Register (LKR) to 0.
The maximum value that can be configured varies based on the data type of the destination device address for the 
operation time and operation count.

● Counting the Operation Time
While the value of the monitored device address is 1, 1 is added to the value of the device address (Operation Time 
Device Address) configured in Measure Operation Time for each second that elapses. The operation time is not 
counted when it is less than one second.
The counted operation time is written to the device address configured in Measure Operation Time.

Example: When the value of monitored device address M0 is 1, 1 is added to the value of Operation Time Device 
Address LKR0.

● Counting the Operation Count
When the value of the monitored device address changes from 0 to 1, 1 is added to the value of the device address 
(operation count device address) configured in Measure Operation Count.
The counted operation count is written to the device address configured in Measure Operation Count.

Example: When the value of monitored device address M0 changes from 0 to 1, 1 is added to the value of operation 
count device address LKR0.

3 sec.

1 sec. 1 sec. 1 sec.

3.4 sec.

1 sec. 1 sec. 1 sec.

0.5 sec. 0.5 sec.

Monitored device address

M0 value

Operation Time Device Address

LKR value

1

0

Operation time

0.4 sec.

0 1 2 3 3 3 3 3 3 3 3 4 5 6 6

Not counted Not counted

If the value of monitored device addresses changes from 0 to 1 in an interval shorter than the MICRO/I 
scan time and the communication cycle with external devices, the operation time and operation count is 
not counted normally. You can check the maximum MICRO/I scan time (x 1 ms) with the value of HMI 
Special Data Register LSD4. You can check the communication cycle with external devices (x 1 ms) with the 
value of HMI Special Data Register LSD6. For details, refer to Chapter 33 “HMI Special Data Register (LSD)” 
on page 33-7.

1

0

Monitored device address

M0 value

Operation count device address

LKR value

Operation count

0 1 1 1 1 1 2 2 3 3 3 4 4 4 4

1 2 3 4
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1.3 Thresholds

The threshold is a value that is the criterion for reporting to a configured device address (Report Device Address) 
when the value counted for the operation time or operation count (a value of Operation Time Device Address or 
Operation Count Device Address) has reached the threshold value. 1 is written to the configured device address when 
the operation time and operation count reach the threshold.

Example: When the value of Operation Time Device Address LKR0 reaches the threshold set for level 1 through level 
3, 1 is written to the Report Device Address configured for each level, LM1 through LM3.

Level Threshold Report Device Address

Level 1 10 LM1

Level 2 15 LM2

Level 3 20 LM3

1

0

1

0

1

0

Operation Time Device Address

LKR0 value
9 10 11 12 13 14 15 16 17 18 19 20 21 22

Level 1 threshold Level 2 threshold Level 3 threshold

Level 1 Report Device Address

LM1 value

Level 2 Report Device Address

LM2 value

Level 3 Report Device Address

LM3 value
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This section describes the configuration procedure for the Preventive Maintenance function.

2.1 Counting Operation Time and Operation Count

1 On the Configuration tab, in the System Setup group, click Preventive Maintenance.
The Preventive Maintenance Settings dialog box is displayed.

2 Specify the number of device addresses to monitor in Number of Items.

3 Select the item to display in Settings with Display Options.
Select Operation Time + Operation Count.
The Operation Time and Operation Count settings are displayed in Settings.

4 Select the number to register the Preventive Maintenance settings to in Settings, then click Edit.
The Individual Settings dialog box is displayed.

5 Specify the bit device or the bit number of the word device to monitor with Monitor Device Address.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.

2 Preventive Maintenance Function Configuration Procedure

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P
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6 Select the Measure Operation Time check box on the Operation Time tab.

If you are not counting the operation time, leave the Measure Operation Time check box cleared and proceed to 
step 9.

7 Specify the destination device address for the counted operation time.

You can only specify an HMI Keep Register (LKR).

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.

8 Select the data type for the value of Measure Operation Time device address with Data Type.

This concludes configuring operation time counting.

9 Click the Operation Count tab.

10 Select the Measure Operation Count check box.

If you are not counting the operation count, leave the Measure Operation Count check box cleared and proceed to 
step 13.

11 Specify the destination device address for the counted operation count.

You can only specify an HMI Keep Register (LKR).

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.

12 Select the data type for the value of Measure Operation Count device address with Data Type.

This concludes configuring operation count counting.

13 Click OK to close the Individual Settings dialog box.

You are returned to the Preventive Maintenance Settings dialog box.

14 Repeat steps 2 to 13 to register settings to count the operation time and operation count in all the used numbers.

This concludes configuring operation time and operation count counting.

Next, configure the functions to execute using counted data.
 “4.1 Displaying the Counted Operation Count on a Numerical Display” on page 17-11
 “4.2 Notifying with a Beep when the Counted Operation Time Reaches the Threshold” on page 17-14
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This section describes the items and buttons on the Preventive Maintenance Settings dialog box and the 
Individual Settings dialog box.

3.1 Preventive Maintenance Settings Dialog Box

The Preventive Maintenance Settings dialog box is used to manage the preventive maintenance settings for each 
monitored device address.

■ Number of Items
Specifies the number of device addresses (1 to 256) to monitor. The numbers for the amount of configured devices is 
displayed in Settings.

■ Display Options
Select the item to display in Settings from the following:

■ Settings
Edits the settings for each number.

3 Preventive Maintenance Settings Dialog Box

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

Operation Time: Operation time settings are displayed in Settings.
Operation Count: Operation count settings are displayed in Settings.
Operation Time + Operation Count: Operation time and operation count settings are displayed in Settings.

No.: Shows the number of the preventive maintenance settings to manage. Double 
clicking the cell displays the Individual Settings dialog box. For details, refer 
to “3.2 Individual Settings Dialog Box” on page 17-8.

Monitor Device Address: Shows the bit device or the bit number of the word device to count the operation time 
or operation count.
Double clicking the cell displays the Tag Editor. For the device address configuration 
procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-68.

Operation Time Device Address: Shows the destination device address for the counted operation time. You can 
only specify an HMI Keep Register (LKR).
Double clicking the cell displays the Tag Editor. For the device address configuration 
procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-68.
This option is only displayed when Operation Time or Operation Time + 
Operation Count is selected in Display Options.

Data Type: Shows the date type of the Operation Time Device Address. Double clicking the cell 
displays the Individual Settings dialog box. For details, refer to “3.2 Individual 
Settings Dialog Box” on page 17-8.
This option is only displayed when Operation Time or Operation Time + 
Operation Count is selected in Display Options.
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■ Edit
Registers or changes the settings for the selected number.
Select a number and click this button to display the Individual Settings dialog box. The configured content for the 
selected number is reflected in the Individual Settings dialog box. For details, refer to “3.2 Individual Settings 
Dialog Box” on page 17-8.

■ Remove
Deletes the settings for the selected number.
Select a number and click this button.

■ Up
Shifts the selected settings upward in the list.

■ Down
Shifts the selected settings downward in the list.

Level 1 to 3 Threshold: Shows the time as a constant or a device address that is the criterion for reporting 
at level 1 through level 3. For a constant, double clicking the cell displays the 
Individual Settings dialog box. For details, refer to “3.2 Individual Settings 
Dialog Box” on page 17-8. For a device address, the Tag Editor is displayed. For 
the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.
This option is only displayed when Operation Time or Operation Time + 
Operation Count is selected in Display Options.

Level 1 to 3 Report Device Address: Shows the bit device or the bit number of the word device for reporting when 
the operation time reaches or exceeds the level 1 through level 3 thresholds.
Double clicking the cell displays the Tag Editor. For the device address 
configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” on 
page 2-68.
This option is only displayed when Operation Time or Operation Time + 
Operation Count is selected in Display Options.

Operation Count Device Address: Shows the destination device address for the counted operation count. You can 
only specify an HMI Keep Register (LKR).
Double clicking the cell displays the Tag Editor. For the device address 
configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” on 
page 2-68.
This option is only displayed when Operation Count or Operation Time + 
Operation Count is selected in Display Options.

Data Type: Shows the date type of the operation count device address. Double clicking the 
cell displays the Individual Settings dialog box. For details, refer to “3.2 
Individual Settings Dialog Box” on page 17-8.
This option is only displayed when Operation Count or Operation Time + 
Operation Count is selected in Display Options.

Level 1 to 3 Threshold: Shows the count as a constant or a device address that is the criterion for 
reporting at level 1 through level 3. For a constant, double clicking the cell displays 
the Individual Settings dialog box. For details, refer to “3.2 Individual Settings 
Dialog Box” on page 17-8. For a device address, the Tag Editor is displayed. For 
the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.
This option is only displayed when Operation Count or Operation Time + 
Operation Count is selected in Display Options.

Level 1 to 3 Report Device Address: Shows the bit device or the bit number of the word device for reporting when 
the operation count reaches or exceeds the level 1 through level 3 thresholds.
Double clicking the cell displays the Tag Editor. For the device address 
configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” on 
page 2-68.
This option is only displayed when Operation Count or Operation Time + 
Operation Count is selected in Display Options.
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3.2 Individual Settings Dialog Box

The Individual Settings dialog box is used to configure the operation time and operation count settings for each 
monitored device address.

● Operation Time Tab
The Operation Time tab is used to configure the destination device address for the counted operation time and the 
report conditions when the threshold is reached or exceeded.

■ Measure Operation Time
Select this check box to count the operation time.

■ Data Type
Select the data type for the Operation Time Device Address as UBIN16(W) or UBIN32(D). For details, refer to 
Chapter 2 “1.1 Available Data” on page 2-1.

■ Report when Operation Time has reached or exceeded Threshold level
Select this check box to report when the counted operation time reaches or exceeds the threshold. 

■ (Data Type)
Selects the type of data for the threshold.

■ Level 1
Configures the level 1 threshold and Report Device Address.

Number: Shows the number selected in Settings in the Preventive Maintenance Settings dialog 
box. To change the set number, specify a number (1 to 256).
You can only specify a number of the amount of devices configured by Number of Items 
in the Preventive Maintenance Settings dialog box.

Monitor Device Address: Specifies the bit device or the bit number of the word device to count the operation time or 
operation count.

Click  to display the Tag Editor. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-68.

(Operation Time Device Address): Specifies the destination device address for the counted operation time. You can 
only specify an HMI Keep Register (LKR).

Click  to display the Tag Editor. For the device address configuration procedure, 
refer to Chapter 2 “5.1 Device Address Settings” on page 2-68.

If you specify the same device address as the Operation Time Device Address for multiple numbers, the 
counted operation time is added in total by all the monitored device addresses for each number and the 
function will not be able to count normally.

Value: Uses a constant as the threshold.
Device Address: Uses a value of device address as the threshold.

Threshold Specifies the time as a constant or a device address that is the criterion for reporting at 
level 1. For a constant, the range that can be set varies based on the data type. For a device 

address, click  to display the Tag Editor. For the device address configuration procedure, 
refer to Chapter 2 “5.1 Device Address Settings” on page 2-68.
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■ Level 2
Select this check box to configure the level 2 threshold and Report Device Address.

■ Level 3
Select this check box to configure the level 3 threshold and Report Device Address.

● Operation Count Tab
The Operation Count tab is used to configure the destination device address for the counted operation count and 
the report conditions when the threshold is reached or exceeded.

■ Measure Operation Count
Select this check box to count the operation count.

Report Device Address: Specifies the bit device or the bit number of the word device for reporting when the 
operation time reaches or exceeds the level 1 threshold.

Click  to display the Tag Editor. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-68.

Threshold Specifies the time as a constant or a device address that is the criterion for reporting at 
level 2. For a constant, the range that can be set varies based on the data type. For a device 

address, click  to display the Tag Editor. For the device address configuration procedure, 
refer to Chapter 2 “5.1 Device Address Settings” on page 2-68.

Report Device Address: Specifies the bit device or the bit number of the word device for reporting when the 
operation time reaches or exceeds the level 2 threshold.

Click  to display the Tag Editor. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-68.

Threshold Specifies the time as a constant or a device address that is the criterion for reporting at 
level 3. For a constant, the range that can be set varies based on the data type. For a device 

address, click  to display the Tag Editor. For the device address configuration procedure, 
refer to Chapter 2 “5.1 Device Address Settings” on page 2-68.

Report Device Address: Specifies the bit device or the bit number of the word device for reporting when the 
operation time reaches or exceeds the level 3 threshold.

Click  to display the Tag Editor. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-68.

(Operation Count Device Address): Specifies the destination device address for the counted operation count. You can 
only specify an HMI Keep Register (LKR).

Click  to display the Tag Editor. For the device address configuration procedure, 
refer to Chapter 2 “5.1 Device Address Settings” on page 2-68.

If you specify the same device address as the operation count device address for multiple numbers, the 
counted operation count is added in total by all the monitored device addresses for each number and the 
function will not be able to count normally.
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■ Data Type
Select the data type for the operation count device address as UBIN16(W) or UBIN32(D). For details, refer to 
Chapter 2 “1.1 Available Data” on page 2-1.

■ Report when Operation Count has reached or exceeded Threshold level
Select this check box to report when the counted operation count reaches or exceeds the threshold.

■ (Data Type)
Selects the type of data for the threshold.

■ Level 1
Configures the level 1 threshold and Report Device Address.

■ Level 2
Select this check box to configure the level 2 threshold and Report Device Address.

■ Level 3
Select this check box to configure the level 3 threshold and Report Device Address.

Value: Uses a constant as the threshold.

Device Address: Uses a value of device address as the threshold.

Threshold Specifies the count as a constant or a device address that is the criterion for reporting at 
level 1. For a constant, the range that can be set varies based on the data type. For a device 

address, click  to display the Tag Editor. For the device address configuration procedure, 
refer to Chapter 2 “5.1 Device Address Settings” on page 2-68.

Report Device Address: Specifies the bit device or the bit number of the word device for reporting when the 
operation count reaches or exceeds the level 1 threshold.

Click  to display the Tag Editor. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-68.

Threshold Specifies the count as a constant or a device address that is the criterion for reporting at 
level 2. For a constant, the range that can be set varies based on the data type. For a device 

address, click  to display the Tag Editor. For the device address configuration procedure, 
refer to Chapter 2 “5.1 Device Address Settings” on page 2-68.

Report Device Address: Specifies the bit device or the bit number of the word device for reporting when the 
operation count reaches or exceeds the level 2 threshold.

Click  to display the Tag Editor. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-68.

Threshold Specifies the count as a constant or a device address that is the criterion for reporting at 
level 3. For a constant, the range that can be set varies based on the data type. For a device 

address, click  to display the Tag Editor. For the device address configuration procedure, 
refer to Chapter 2 “5.1 Device Address Settings” on page 2-68.

Report Device Address: Specifies the bit device or the bit number of the word device for reporting when the 
operation count reaches or exceeds the level 3 threshold.

Click  to display the Tag Editor. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-68.
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4.1 Displaying the Counted Operation Count on a Numerical Display

1 On the Configuration tab, in the System Setup group, click Preventive Maintenance.

The Preventive Maintenance Settings dialog box is displayed.

2 Specify the number of device addresses to monitor in Number of Items.

3 Select the item to display in Settings with Display Options.
Select Operation Count.
Operation count settings are displayed in Settings.

4 Select the number to register the Preventive Maintenance settings to in Settings, then click Edit.
The Individual Settings dialog box is displayed.

5 Specify the bit device or the bit number of the word device to monitor with Monitor Device Address.

4 Using the Data

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P
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6 Click the Operation Count tab.

7 Select the Measure Operation Count check box and specify the destination device address for the counted 
operation count.

8 Select the data type for the value of Measure Operation Count device address with Data Type.

9 On the Home tab, in the Parts group, click Data Displays, and then click Numerical Display.

10 Click a point on the edit screen where you wish to place the Numerical Display.

11 Double-click the dropped Numerical Display and the Properties dialog box is displayed.
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12 On the General tab, under Display Type, click Decimal.

13 Under Data Format, in Data Type, select the data type for the value to display.

Select the same data type as the data type selected on the Operation Count tab in the Preventive Maintenance 
settings Individual Settings dialog box.

14 Specify Digits for the value to display.

The digits that can be set varies based on the display type or data type.

15 Under Display Method, in Display Device Address, specify the destination device address for the counted 
operation count.

Select the same device address as the device configured with Measure Operation Count on the Operation Count 
tab in the Preventive Maintenance settings Individual Settings dialog box.

16 Click OK.

The properties dialog box closes.
This concludes the configuration to display the counted operation count on a Numerical Display.
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4.2 Notifying with a Beep when the Counted Operation Time Reaches the Threshold

1 On the Configuration tab, in the System Setup group, click Preventive Maintenance.

The Preventive Maintenance Settings dialog box is displayed.

2 Specify the number of device addresses to monitor in Number of Items.

3 Select the number to register the Preventive Maintenance settings to in Settings, then click Edit.

The Individual Settings dialog box is displayed.

4 Specify the bit device or the bit number of the word device to monitor with Monitor Device Address.

5 Select the Measure Operation Time check box on the Operation Time tab and specify the destination device 
address for the counted operation time.

6 Select the data type for the value of Measure Operation Time device address with Data Type.
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7 Select the Report when Operation Time has reached or exceeded Threshold level check box.

8 Select the type of data for the threshold.

If you select Value, specify the threshold as a constant.
If you select Device Address, specify the threshold as a value of device address.

9 Configure Threshold for level 1.

When you select Value as the threshold data type, specify the threshold as a constant. The range for the constant 
that can be set varies based on the data type.
When you select Device Address as the threshold data type, specify the threshold as a value of device address. Click 

 to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device Address 
Settings” on page 2-68.

10 Configure Report Device Address for level 1.

Specify the bit device or the bit number of the word device for reporting when the threshold is reached or exceeded. 

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.
You can only specify an internal device.

11 Click OK to close the Individual Settings dialog box.

You are returned to the Preventive Maintenance Settings dialog box.

12 Click OK.

The Preventive Maintenance Settings dialog box closes.

13 On the Configuration tab, in the System Setup group, click Alarm Log.

The Alarm Log Settings dialog box is displayed.
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14 On the Channel tab, under Source Device Address Type, select Bit and specify Number of Blocks.

15 Select the channel number to register the level 1 Report Device Address to and click Edit.

The Individual Settings dialog box is displayed.

16 Specify the level 1 Report Device Address in Source and select Store under Data.

Set Source to the level 1 Report Device Address configured on the Operation Time tab in the Preventive 
Maintenance settings Individual Settings dialog box.

17 Select Enable under Alarm function, select NO under NO/NC, and click OK.
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18 On the Alarm Log Settings dialog box, switch the alarm function for all the unused channel numbers to Disable.

Select all the unused channels with the  key + click or the  key + click and click Edit.
The Individual Settings dialog box is displayed.

Under Channel Settings - Alarm function, select Disable and click OK.
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19 Click the Options tab in the Alarm Log Settings dialog box.

20 Select the Trigger Buzzer when Alarm occurs check box.

21 Click OK.

The Alarm Log Settings dialog box closes.
This concludes the configuration to notify with a beep when the counted operation time reaches the threshold.
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This chapter describes how to configure the Recipe function and its operation on the MICRO/I.

  

1.1 How the Recipe Function is Used

The Recipe function batch writes values prepared in advanced to specified device addresses and batch reads the values 
for specified device addresses according to the state of a device address. Use this function for situations such as 
configuring the initial values of an external device when the MICRO/I starts running. The data used by the Recipe 
function is called recipe data for the data saved in internal memory, a recipe file for data saved to the external memory 
device, and recipe values for the values written to device addresses that were saved in recipe data and recipe files.
The Recipe function can perform the following functions.

• Batch write the recipe values saved in internal memory to device addresses when a value of device address 
changes from 0 to 1

• Batch write the recipe values saved on the external memory device*1 to device addresses when a value of device address 
changes from 0 to 1

• Batch read values of device addresses and save them to the external memory device*1 as a recipe file when a value of 
device address changes from 0 to 1

*1 SD memory card for HG5G/4G/3G/2G-V, HG4G/3G and HG2G-5F, USB flash drive for HG2G-5T and HG1G/1P

Chapter 18 Recipe Function

1 Overview

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P
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0 1
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150

200

Write

100
150
200

Recipe Data

External device
MICRO/I

0 1

D100= 0

D101= 0

D102= 0
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150

200

Write

External Memory Device

USB flash drive

SD memory card

100,
150,
200,

Recipe File

External device

MICRO/I

0 1

D100= 100

D101= 150

D102= 200

Output to 
External memory device

External Memory Device

USB flash drive

SD memory card

100,
150,
200,

Recipe File

The values of device addresses can be retained when the power is turned off by reading values of device 
addresses to the external memory device and saving them as a recipe file and then writing those values the 
next time the power is turned on.



1 Overview

18-2 WindO/I-NV4 User’s Manual

1.2 Data for Recipes

The data handled by the Recipe function is based on the top device address and the amount of data selected.
Example: The top device address is D100 and the amount of data is 10.

Value of Device Address
D100 1111

D101 2222

D102 3333

D103 4444

D104 5555

D105 6666

D106 7777

D107 8888

D108 9999

D109 11111
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1.3 Data Configuration

The relationship between the Recipe function settings and the data for recipes is as follows.

1. Number of blocks: The operation using the data for recipes is configured in blocks (0 to 64). 1 block is 16 channels.

2. Channels: Destination device addresses and recipe values are configured in channels. 1 channel is used 
for 1 item of data for the recipe.

3. Amount of data: The amount of data configured for one channel. The maximum amount of data that can be 
configured is 8192.

4. Top Device Address: The start address of the destination device addresses for recipe values and the source device 
addresses for values of device addresses.

5. Data: The values to write to the device addresses.

6666

7777

8888

9999

11111

1111

2222

3333

4444

5555

D105

D106

D107

D108

D109

D100

D101

D102

D103

D104

600

700

800

900

1000

100

200

300

400

500

106

107

108

109

110

101

102

103

104

105

5. Data4. Top Device Address

1. Number of blocks

2. Channel 0 to 15

3. Amount of data

Recipe settings

Data for recipes

If there are many word devices for the data for the recipe, it will take time to read and write them. For 
example, when using the Recipe function to configure initial values, if other processes are executed before 
the function is finished writing all the settings, you may experience unexpected results. Monitor System 
Area 2 Transferring recipe bit (address number+3, bit4) while the recipe is transferring and wait until 
reading and writing the data for the recipe is finished before executing other processes. For details, refer to 
Chapter 4 “System Area” on page 4-30.

If Float32(F) is selected for Data Type on the Channel tab, the values of device addresses that were 
read are saved to the recipe file in the floating point type. However, when a value that was read is 8 digits or 
larger, it is saved in the exponential type.
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This section describes the configuration procedure for the Recipe function.

2.1 Configuring Recipe Function Operations and Device Addresses

1 On the Configuration tab, in the System Setup group, click Recipe.

The Recipe Settings dialog box is displayed.

2 Specify the number of blocks to use as data for the recipe in Number of Blocks.

The operation using the data for the recipe is configured in blocks (0 to 64). 1 channel is used for 1 item of data for 
the recipe. 1 block is 16 channels.
The maximum number of blocks that can be configured is 64 blocks. The maximum number of device addresses that 
can be configured for 1 channel is 8192 devices.

3 Select the number of the data for the recipe to configure in Settings, then click Edit.

The Individual Settings dialog box is displayed.

2 Recipe Function Configuration Procedure

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P
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4 On the Channel tab, under Recipe function, select Enable.

The channel for the block number displayed in Channel is enabled.

5 Enter the name for the Recipe function in Recipe Name.

The maximum number is 40 characters.

6 Specify the destination device address for the Recipe values in Top Device Address.

To read values of device addresses and save them as a recipe file, specify the source device address of the values.

Click  to display the Tag Editor.
For the device address configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-68.
The specified device addresses are configured sequentially from the number 1 in Data List on the Data tab.

7 Select the data type for the values to write with Data Type.

To read values of device addresses and save them as a recipe file, specify the type of data for the read values.

8 With Number of Data, specify the number of destination device addresses starting with the device address 
configured by Top Device Address.

To read values of device addresses and save them as a recipe file, specify the number of source device addresses.
The sequential device addresses from the start address for the number of configured device addresses are displayed 
in Settings on the Data tab.
The amount of data that can be set varies based on the data type. When UBIN16(W), BIN16(I), or BCD4(B) is 
selected for Data Type, up to 8192 items of data can be configured. When UBIN32(D), BIN32(L), BCD8(EB), or 
Float32(F) is selected, up to 4096 items of data can be configured.

9 With Display Type, select the display type for Data to configure in Data List on the Data tab.

To save data to a recipe file, the display type is decimal for all.
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10 Click the Data tab.

The data for the recipe in the amount specified by Number of Data on the Channel tab is configured in Data List. 
In Device Address, the devices are sequentially configured starting from the device address specified by Top 
Device Address.

11 Double click the data cell for each number in Data List to enter the value to write to the device address.

The value for the device address that can be configured varies based on Data Type and Display Type configured on 
the Channel tab.
When Read-only is selected under Trigger Setting on the Block tab, entering values of device addresses is 
unnecessary.

12 Click the Block tab.

13 Select the destination to save recipe data to under Access to.

This option is set by block.

■ External Memory Device*1

Use a recipe file saved to the external memory device.

■ Internal Memory
Use recipe data saved to internal memory.

If you selected Internal Memory, proceed to step 17.

*1 SD memory card for HG5G/4G/3G/2G-V, HG4G/3G and HG2G-5F, USB flash drive for HG2G-5T and HG1G/1P
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14 Enter the file name for the recipe file in File Name.

The default file name is “RCPn.CSV”. (n: 4 digit sequential number)
To change the file name, enter a new file name. The maximum number is 120 characters (including the extension).
The file is overwritten when there is a recipe file with the same name on the external memory device.

15 Select the operation using the data for the recipe under Trigger Setting.

This option is set by block.

■ Read/Write 
Save batch read values of device addresses to the external memory device as a recipe file or write them to device 
addresses as recipe values.
This option can only be configured when External Memory Device is selected under Access to.

■ Read-only
Save batch read values of device addresses to the external memory device as a recipe file.
This option can only be configured when External Memory Device is selected under Access to.

■ Write-only
Write recipe values to device addresses.

If you select Write-only, proceed to step 17.

16 Specify the device address that triggers batch reading values of device addresses and saving them to the external 
memory device as a recipe file in Read Trigger.

This option is set by block.

Click  to display the Tag Editor.
For the device address configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-68.
This option can only be configured when Read/Write or Read-only is selected under Trigger Setting.

If you selected Read-only, proceed to step 18.

17 Specify the device address that triggers batch writing recipe values to device addresses in Write Trigger.

This option is set by block.

Click  to display the Tag Editor.
For the device address configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-68.
This option can only be configured when Read/Write or Write-only is selected under Trigger Setting.

18 Click OK to close the Individual Settings dialog box.

You are returned to the Recipe Settings dialog box.

19 Repeat steps 3 through 18 to register data for the recipe to all the used channels.

20 Click OK.

The Recipe Settings dialog box closes.

For details on how to create and edit the data for recipes, refer to “4 Creating and Deleting Data for Recipes” on page 
18-14.
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This section describes the items and buttons on the Recipe Settings dialog box and the Individual Settings dialog 
box.

3.1 Recipe Settings Dialog Box

Use the Recipe Settings dialog box to collectively manage the save destination of data for recipes, the device 
addresses for writing recipe values and reading values of device addresses, and those execution conditions.

■ Number of Blocks
The operation using the data for the recipe is configured in blocks (0 to 64). 1 channel is used for 1 item of data for 
the recipe. 1 block is 16 channels.
The maximum number of blocks that can be configured is 64 blocks. The maximum number of device addresses that 
can be configured for 1 channel is 8192 devices.

■ Settings
Edits the recipe settings for each channel.

3 Recipe Settings Dialog Box

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

No.: Displayed as (Block No.)-(Channel No.). Double clicking the cell displays the Individual 
Settings dialog box. For details, refer to “3.2 Individual Settings Dialog Box” on page 18-10.

Access to: Shows the save destination for the data for the recipe. Double clicking the cell switches between 
Internal Memory and External Memory Device.

Trigger Setting: Shows the operation using the data for the recipe. When External Memory Device is selected 
for Access to, double clicking the cell switches between Write-only, Read/Write, and Read-
only. Shows Write-only when Internal Memory is selected for Access to.

Read Trigger: Shows the device address that triggers saving the recipe file. Double clicking the cell displays 
the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.
This option can only be configured when Read/Write or Read-only is selected under Trigger 
Setting.

Write Trigger: Shows the device address that triggers writing recipe values to device addresses. Double 
clicking the cell displays the Tag Editor. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-68.
This option can only be configured when Read/Write or Write-only is selected under 
Trigger Setting.

Recipe function: Shows whether or not to use the Recipe function. Double clicking the cell switches between 
Enable and Disable.
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■ Edit
Registers or changes the settings for the selected number.
Select a number in Settings and click this button to display the Individual Settings dialog box. The settings for the 
selected channel are reflected in the Individual Settings dialog box.
For details, refer to “3.2 Individual Settings Dialog Box” on page 18-10.

■ Save Recipe Files to External Memory Device
Saves all the settings in every channel on the Recipe Settings dialog box to the external memory device as a recipe 
file.
Click this button to display the Select Drive dialog box.
Only saves channels configured with Access to set to External Memory Device and Recipe Function set to 
Enable.

Recipe Name: Shows the name of the Recipe function for each channel. Double clicking the cell displays the 
Individual Settings dialog box. For details, refer to “3.2 Individual Settings Dialog Box” on 
page 18-10.

Top Device Address: Shows the start device of the destination device addresses for recipe values and the source 
device addresses for values of device addresses. Double clicking the cell displays the Tag Editor. 
For the device address configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” 
on page 2-68.
This option can only be configured when Recipe function is Enable.

Data Type: Shows the data type of the values of source or destination device addresses. Double clicking the 
cell displays the Individual Settings dialog box. For details, refer to “3.2 Individual Settings 
Dialog Box” on page 18-10.

No. of Data: Shows the number of source or destination device addresses starting with the device address 
configured by Top Device Address. Double clicking the cell displays the Individual Settings 
dialog box. For details, refer to “3.2 Individual Settings Dialog Box” on page 18-10.

Display Type: Shows the display type of Data in Data List configured on the Data tab in the Individual 
Settings dialog box. Double clicking the cell displays the Individual Settings dialog box. For 
details, refer to “3.2 Individual Settings Dialog Box” on page 18-10.

To register or edit multiple numbers as a group, press and hold SHIFT or CTRL while you click the specific 
items to select multiple lines and click Edit. The details configured on the Individual Settings dialog box 
are collectively configured.
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3.2 Individual Settings Dialog Box

Use the Individual Settings dialog box to register or edit the recipe settings for the selected channel.

● Block Tab
The Block tab is used to configure settings that are managed by blocks such as the save destination for the data for 
the recipe to use, the Recipe function operation, and the operation trigger.

■ Access to
Selects the save destination for data for the recipe to use when writing values to device addresses.

■ File Name
Enter the file name of the recipe file to save on the external memory device.
The default file name is “RCPn.CSV”. (n: 4 digit sequential number)
To change the file name, enter a new file name. The maximum number is 120 characters (including the extension).
The file is overwritten when there is a recipe file with the same name on the external memory device.

*1 SD memory card for HG5G/4G/3G/2G-V, HG4G/3G and HG2G-5F, USB flash drive for HG2G-5T and HG1G/1P

External Memory Device*1: Uses a recipe file saved to the external memory device.
Requires an external memory device with a saved recipe file. For details, refer to “4.2 
Creating Recipe Files” on page 18-17.

Internal Memory: Uses recipe data saved to internal memory.
Since recipe data is handled as a portion of project data, it may put pressure on the 
volume of project data that can be downloaded. One item of recipe data uses 2 bytes 
when the top device address data type is 16 bits and it uses 4 bytes when the top device 
address data type is 32 bits.
Example: When the top device address data type is 16 bits and using 1 block of 16 

channels of recipe data with a data amount of 10
2 x 10 x 1 x 16 = 320 bytes
When the top device address data type is 32 bits and using 64 blocks of 16 
channels of recipe data with a data amount of 100
4 x 100 x 64 x 16 = 409.6 kilobytes
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■ Trigger Setting
Selects the operation using the data for the recipe.

■ Read Trigger
Specifies the device address that triggers batch reading values of device addresses and saving them to the external 
memory device as a recipe file.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.
This option can only be configured when Read/Write or Read-only is selected under Trigger Setting.

■ Write Trigger
Specifies the device address that triggers batch writing recipe values to device addresses by block.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.
This option can only be configured when Read/Write or Write-only is selected under Trigger Setting.

■ Monitoring Period
Shows the period to monitor the write trigger device address and the read trigger device address. This period is for 
detecting alarms so it is the same as the period to monitor states of device addresses. This option is configured on the 
General tab in the Alarm Log Settings dialog box.

Read/Write: Saves batch read values of device addresses to the external memory device as a recipe file and 
writes them to device addresses as recipe values.
This option can only be configured when External Memory Device is selected under Access to.

Read-only: Saves batch read values of device addresses to the external memory device as a recipe file.
This option can only be configured when External Memory Device is selected under Access to.

Write-only: Writes recipe values to device addresses.

If Float32(F) is selected for Data Type on the Channel tab, the values of device addresses that were 
read are saved to the recipe file in the floating point type. However, when a value that was read is 8 digits or 
larger, it is saved in the exponential type.

Each bit of the word device configured by the read trigger device address corresponds to a channel.
When a bit changes from 0 to 1, a read to the device address is executed.
Example: When the block 1 read trigger device address is specified as LDR0000

LDR0000-0 corresponds to channel 1-0, LDR0000-1 to channel 1-1, through to LDR0000-15 which 
corresponds to channel 1-15.

bit bit

Channel 1-0

15 0

LDR0000

Channel 1-15

Each bit of the word device configured by the write trigger device address and the read trigger device 
address corresponds to a channel.
When a bit changes from 0 to 1, a write to the device address is executed.
Example: When the block 1 write trigger device address is specified as LDR0000

LDR0000-0 corresponds to channel 1-0, LDR0000-1 to channel 1-1, through to LDR0000-15 which 
corresponds to channel 1-15.

bit bit

Channel 1-0

15 0

LDR0000

Channel 1-15

• If Access to is set to External Memory Device and no recipe file exists in the "RECIPE" folder located in 
the External Memory Device folder on the external memory device, the recipe values are not written to the 
device addresses.

• If value of device address reads and recipe value writes occur simultaneously, first the values of device 
addresses are read, then the recipe values are written.
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● Channel Tab
The Channel tab is used to configure the recipe name for the selected channel and the device addresses to read and 
write values to.

■ Channel
Shows the block number and the channel number for the selected channel.

■ Recipe function
Selects whether or not to use the Recipe function.

■ Recipe Name
Enter the name for the Recipe function to differentiate the channel. The maximum number is 40 characters. The 
default is “Recipen”. (n: 4 digit sequential number)

■ Top Device Address
Specifies the start device address of the destination device addresses for recipe values and the source device 
addresses for values of device addresses.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.
The specified device addresses are configured sequentially from the number 1 in Data List on the Data tab.

■ Data Type
Selects the type of data for recipe values to write and values of device addresses that are read. For details, refer to 
Chapter 2 “1.1 Available Data” on page 2-1.

■ Number of Data
Specifies the number of source or destination device addresses starting with the device address configured by Top 
Device Address.
The sequential device addresses from the start address for the number of configured device addresses is displayed in 
Settings on the Data tab.
The amount of data that can be set varies based on the data type. When UBIN16(W), BIN16(I), or BCD4(B) is 
selected for Data Type, up to 8192 items of data can be configured. When UBIN32(D), BIN32(L), BCD8(EB), or 
Float32(F) is selected, up to 4096 items of data can be configured.

■ Display Type
Selects the display type for Data in Data List configured on the Data tab as Decimal or Hexadecimal.
Values when saving data to a recipe file are decimal.

Block Number: Shows the block number for the channel selected in Settings.

Channel Number: Shows the channel number for the channel selected in Settings.

Enable: Writes recipe values to device addresses, reads values of device addresses and saves them to 
the external memory device as a recipe file.

Disable: The Recipe function is not used.
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● Data Tab
The Data tab is used to configure recipe values written to device addresses.

■ Channel
Shows the block number and the channel number for the selected channel.

■ Data List
Enter the recipe values to write to device addresses for each number in the selected channel.

■ Import
Displays the Open dialog box.
Select a recipe file and click Open to overwrite the data in Data List with the selected recipe file.

■ Export
Displays the Save As dialog box.
Select the location to save the recipe file, enter a file name, and then click Save to save the recipe file for the selected 
channel.
The saved recipe file can be edited using Notepad, commercially available text editors, and spreadsheet software.

Block Number: Shows the block number for the channel selected in Settings.

Channel Number: Shows the channel number for the channel selected in Settings.

No.: Shows the data numbers for the amount of data specified by Number of Data.

Device Address: Devices are sequentially configured starting from the device address specified by Top Device 
Address on the Channel tab.

Data: Double click a cell to enter a recipe value. The value that can be configured varies based on 
Data Type and Display Type configured on the Channel tab.
When Read-only is selected under Trigger Setting on the Block tab, entering recipe values 
is unnecessary.
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4.1 Editing Recipe Data

You can export recipe data for the selected channel, edit the recipe values in a saved file, and import a recipe file back 
into WindO/I-NV4.

1 On the Configuration tab, in the System Setup group, click Recipe.

The Recipe Settings dialog box is displayed.

2 Select the channel number to export its recipe data in Settings, then click Edit.

The Individual Settings dialog box is displayed.

3 Click the Data tab, then click Export.

The Save As dialog box is displayed.

4 Creating and Deleting Data for Recipes

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P
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4 Specify the save location and click Save.

The file name specified on the Block tab in the Individual Settings dialog box is entered in File name.

5 Open the exported recipe data file.

Use Notepad, a commercially available text editor, or spreadsheet software.

6 Edit the values and save the file.

7 Return to the Data tab in the Individual Settings dialog box and click Import.

The Open dialog box is displayed.
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8 Specify the file and click Open.

The recipe data is imported.

9 Click OK.

The Individual Settings dialog box closes.

10 Click OK.

The Recipe Settings dialog box closes.
This concludes editing recipe data.
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4.2 Creating Recipe Files

Recipe files can be created on the external memory device*1 with the following procedure. The recipe values 
configured on the  Data tab in the Individual Settings dialog box are saved in recipe files.
 “Creating Recipe Files in the Recipe Settings Dialog Box” on page 18-17
 “Creating Recipe Files when Downloading Project Data” on page 18-19
 “Creating Recipe Files with a Text Editor” on page 18-20

● Creating Recipe Files in the Recipe Settings Dialog Box

1 Insert an external memory device in the computer.

To use an SD memory card, insert it into the computer's memory card slot or use it via a memory card reader/writer.
To use a USB flash drive, insert it into the computer's USB port.

2 On the Configuration tab, in the System Setup group, click Recipe.

The Recipe Settings dialog box is displayed.

3 Click Save Recipe Files to External Memory Device.

The Select Drive dialog box is displayed.

*1 SD memory card for HG5G/4G/3G/2G-V, HG4G/3G and HG2G-5F, USB flash drive for HG2G-5T and HG1G/1P

Computer

Through a memory card 
reader/writer

SD memory card

SD memory card
In SD memory card slot

In USB portUSB flash drive
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4 Specify the drive for the external memory device, then click OK.

■ Drive
Specifies the drive assigned to the external memory device.

■ Network
Displays the Map Network Drive dialog box. This dialog box allows you to specify a drive on the network.

■ External Memory Device Folder
Specifies the folder to save the created recipe file.

Click  to display the Project Settings dialog box. You can specify the External Memory Device folder used as the 
save destination.

5 Click OK.

The Recipe Settings dialog box closes.
The “RECIPE” folder is created in the External Memory Device folder used as the save destination, and the recipe files 
for the channels configured with Access to set to External Memory Device and Recipe Function set to Enable 
in the Recipe Settings dialog box are created.
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● Creating Recipe Files when Downloading Project Data
When a project download is executed, the “RECIPE” folder is created in the External Memory Device folder on the 

external memory device*1 inserted in the MICRO/I and the recipe files are created. The recipe files are only created 
for channels configured with Access to set to External Memory Device and Recipe Function set to Enable in 
the Recipe Settings dialog box.

1 Insert an external memory device into the MICRO/I.

2 On the Home tab, in the Project group, click the Download icon.

The Download dialog box is displayed.

If the project data was changed, a confirmation message to save the project data is displayed.
Click OK to save the project data and display the Download dialog box.
Click Cancel to return to the editing screen without saving the project data.

3 Select the Recipe Files check box under Download following files to External Memory Device.

*1 SD memory card for HG5G/4G/3G/2G-V, HG4G/3G and HG2G-5F, USB flash drive for HG2G-5T and HG1G/1P

The External Memory Device folder is configured in the Project Settings dialog box. For details, refer to 
Chapter 31 “1.6 Setting the External Memory Device Folder” on page 31-15.

MICRO/I

USB flash drive

SD memory card
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4 Verify Communication Settings and click Download.
Since the recipe files are downloaded to the external memory device inserted in the MICRO/I, use the same settings 
as when communicating with the MICRO/I.
To change Communication Settings, click Change to display the Communication Settings dialog box. Change 
Communicate with, Port, and Baud Rate. For details, refer to Chapter 24 “1 Communicating with the MICRO/I” 
on page 24-1.

5 Click Yes.
The Download Project dialog box is displayed and the project files start downloading.
When finished downloading, a completion message is displayed.

6 Click OK.
You are returned to the Download Project dialog box.

7 Click Close.

● Creating Recipe Files with a Text Editor
You can edit recipe files using Notepad, commercially available text editors, or spreadsheet software.

1 Write the data for the amount of data in “value of device address” comma (,) new line order.

If the amount of data in the recipe file is lower than the amount of data for the top device address configured on the 
Channel tab in the Individual Settings dialog box, 0 is written in the rest of the device addresses.

2 Save the file with the “.csv” extension.

Give the file the file name configured on the Block tab in the Individual Settings dialog box. If the file name is 
different, 0 is written to all the device addresses.

3 Copy the edited recipe files to the “RECIPE” folder in the External Memory Device folder on the external memory device.

If security is enabled in the MICRO/I project, the Password Screen is displayed. Select the user name and 
enter the password.
For details, refer to Chapter 23 “User Accounts and the Security Function” on page 23-1.



WindO/I-NV4 User’s Manual 18-21

4 Creating and Deleting Data for Recipes

18

Recipe Function

4.3 Editing Recipe Files

The recipe file that was read can be edited using Notepad, commercially available text editors, or spreadsheet 
software.

*1 SD memory card for HG5G/4G/3G/2G-V, HG4G/3G and HG2G-5F, USB flash drive for HG2G-5T and HG1G/1P

You can read and display the data saved from the MICRO/I to the 

external memory device*1 as a recipe file on a computer.

External Memory Device
Book1

Recipe File

100
150
200

You can upload recipe files from the external memory device using WindO/I-NV4.
On the Online tab, click the arrow under Upload, and click Stored Data in External Memory Device to 
display the Upload Data from External Memory Device dialog box. Select the Recipe Files check box, 
specify the location to save the recipe files in Location, and click OK to be able to save the recipe files in 
the specified folder.
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4.4 Deleting Recipe Files

The methods to delete recipe files saved on the external memory device*1 are as follows.
• To delete files with WindO/I-NV4, on the Online tab, in the MICRO/I group, click Clear, and then click Stored 

Data in External Memory Device to display the Clear Data dialog box. Select the Recipe Files check box and 
click OK.

• To delete files on the HG5G/4G/3G/2G-V, HG4G/3G and HG2G-5F, go to the System Mode - File Manager. In the File 
Manager, select the files to be deleted by pressing DEL.

*1 SD memory card for HG5G/4G/3G/2G-V, HG4G/3G and HG2G-5F, USB flash drive for HG2G-5T and HG1G/1P
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This chapter describes the Text Group function and how to configure text groups and text.

  

1.1 How to Create the Text Groups and Text Registrations

Text groups are a function where the text used for such purposes as registration text, messages for parts, chart 
labels, and titles for Popup Screens are registered in advance. The registered text is loaded and displayed when 
displaying parts and screens. The text can be managed collectively including editing the registered text and adding or 
deleting text.
Text groups can perform the following functions.

• Switch the displayed language by value of device address.

• Use common text for parts.

Chapter 19 Text Group

1 Overview

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

External device
MICRO/I

目標達成

D100 : 1

D100 : 2

D100 : 3

Text ID: 1 目標達成

Group 1: English Group 2: Chinese Group 3: Japanese

Goal reached

Goal reached

MICRO/I

RUN STOP

Base Screen 1

Base Screen 2

RUN STOP

Text ID: 1 RUN
Text ID: 2 STOP

Group 1: English
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1.2 Functions that Support Text Groups

The functions that support text groups are as follows.

Item Setting

Screen Popup Screen Title

Drawings Text Text

Buttons

Bit Button Registration Text

Word Button Registration Text

Goto Screen Button Registration Text

Print Button Registration Text

Key Button Registration Text

Multi-Button Registration Text

Selector Switch Registration Text

Lamps
Pilot Lamp Registration Text

Multi-State Lamp Registration Text

Data 
Displays

Numerical Input Unit

Message Display Message

Message Switching 
Display

Message

Alarm List Display Message

Alarm Log Display Message, Title

Numerical Display Unit

Charts
Bar Chart X-axis and Y-axis scale labels

Line Chart X-axis and Y-axis scale labels

Alarm Log Messages displayed in data output as CSV

Data Log Labels displayed in data output as CSV

Operation Log Recorded item labels and event names displayed in data output as CSV

When the text group is switched, the displayed Base Screen is reset. Popup Screens and internal devices 
have the same behavior as when the Base Screen is switched. If the Close while changing Base Screen 
check box is selected on the Options tab in the properties dialog box for the Popup Screen, the displayed 
Popup Screen is closed. The behavior of the internal devices differs according to the internal devices. For 
details, refer to Chapter 33 “Internal Devices” on page 33-1.
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This section describes the configuration procedure for text groups and text.

2.1 How to Create the Text Groups and Text Registrations

1 On the Configuration tab, in the Manager group, click Text Manager.

Text Manager is displayed.

2 In Number of Text Groups, specify the number of text groups to create (1 to 32).

The configured number of text groups are enabled.

3 Double click (Text Group Name).

The Text Group Settings dialog box is displayed.

2 Text Groups and Text Configuration Procedure

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

(Text Group Name)
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4 Under Text Group Name, enter the name for the text group.

The maximum number for the Text Group Name is 20 characters.

5 Click OK.

The Text Group Settings dialog box closes.

For one text group, proceed to step 8.

6 Repeat steps 3 through 5 to create the necessary text group.

7 With Change Text Group by Device Address, specify the word device as the condition to switch the text group.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.
These options can only be configured when Number of Text Groups is specified as two or more.

8 With (Font), select the font to use for the text to register from the following.

European, Japanese, Chinese, Taiwanese, Korean, Central European, Baltic, Cyrillic, Windows

9 With (Text Color), select the color of the text to register (color: 256 colors, monochrome: 16 shades).

Click Color to display the Color Palette. Select a color from the Color Palette.

To use when the MICRO/I power is turned on or switched to Run Mode, select the Use this Text Group as 
Default check box.

The text group displayed with  in Text Manager is the default.

When the value of device address is 0, the text group switches to the text group set as the default.
If the value of device address is invalid, the text group is not switched.

When Windows is selected, all the fonts installed on the computer can be used. This allows you to display 
fonts and languages that are not installed on the MICRO/I.
Click Change to display the Font Settings dialog box. Configure the details such as the font, style, and size. 
For details, refer to Chapter 2 “Windows Font” on page 2-13.

(Font)

(Text Color)



WindO/I-NV4 User’s Manual 19-5

2 Text Groups and Text Configuration Procedure

19

Text G
roup

10 To register the text, double click the cell and enter the text in the Text Manager.

The maximum number is 3750 characters.
The characters that can be entered vary based on the font selected. For details, refer to Chapter 2 “1.2 Available Text” 
on page 2-6.

11 Repeat steps 8 through 10 to create the necessary text in each text group.

12 Click OK.

This concludes creating text groups and registering text.

You can enter multi-line text by inserting a newline. The newline is counted as two characters.

(Text)
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● Saving Registered Text as a CSV File
To use registered text in another project, save the text as a CSV file or as a text file. This file is called a text list.

1 On the Configuration tab, in the Manager group, click Text Manager.

Text Manager is displayed.

2 Select the (Text) of the Text Group to export.

3 Click  (Export).

The Export dialog box is displayed.

4 Enter the location to Location, and then select the file format (*.csv or *.txt) as the Save as type.

The file name becomes "TextGroup**". (** is the same number as the group, 01 to 32)
Example: Save the text for text group 1 and text group 2 as a CSV file

TextGroup01.csv and TextGroup02.csv files are saved in the specified location.

5 Click OK.

This concludes saving a text list.

(Text)

To export multiple text groups, select all of (Text) for the text groups to export. To select multiple items of 
(Text), press and hold SHIFT or CTRL while you click the specific items.



WindO/I-NV4 User’s Manual 19-7

2 Text Groups and Text Configuration Procedure

19

Text G
roup

● Importing Text from a Text List
A text list saved as a CSV file or as a text file can be imported into Text Manager for the project being edited.

1 On the Configuration tab, in the Manager group, click Text Manager.

Text Manager is displayed.

2 Select the (Text) of the Text Group to import.

3 Click  (Import).

The Open dialog box is displayed.

4 Select a saved text list and click Open.

To import multiple text lists, select all of the text lists to import. To select multiple text lists, press and hold 
SHIFT or CTRL while you click the specific items.
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An Import dialog box is displayed if a text ID is included in the text list however it has already been registered on the 
Text Manager. Here are your options: 
• Click Yes to overwrite the text in the text list with the text of the displayed text ID, and then to display confirmation 

to overwrite the next text ID.
• Click Yes To All to overwrite all the text in the text list without displaying the Import dialog box subsequently.
• Click No to display the next confirmation to overwrite without overwriting the text with the displayed Text Manager 

ID.
• Click Cancel to stop importing text.

The imported text is displayed in the Text Manager.

This concludes importing text from a text list.
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2.2 Switching the Displayed Language by Value of Device Address

When multiple text groups have been created, the text group can be switched with a value of device address to 
display a different language.
This section describes an example when the registration text for a button changes between English, Chinese, and 
Japanese.

1 Following the steps in “2.1 How to Create the Text Groups and Text Registrations” on page 19-3, specify Number of 
Text Groups as 3, and under Text Group Name, enter “English” for Group 1, “Chinese” for Group 2, and 
“Japanese” for Group 3. Set Change Text Group by Device Address to D100.
Register the following text.

2 Create a Bit Button.
On the Home tab, in the Parts group, click Buttons, and then click Bit Button.

3 Click a point on the edit screen where you want to place the Bit Button.

External device
MICRO/I

RUN STOP

Bit Button 2 (Text ID: 2)

Bit Button 1 (Text ID: 1)

D100 :

D100 :

D100 :

1

2

3

Text ID: 1

Group 1: English Group 2: Chinese

Text ID: 2

Group 3: Japanese

RUN
STOP

運転
停止

運転 停止

Text ID: 1 運転
Group 1: English Group 2: Chinese

Text ID: 2 停止

Group 3: Japanese

RUN
STOP
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4 Double-click the dropped Bit Button and the properties dialog box is displayed.

5 Click the Registration Text tab, and then select the Use Text Manager check box.

6 Specify 1 for the Text ID under OFF.

7 Configure the settings on each tab as necessary, and then click OK.

The Properties of Bit Button dialog box closes.

8 Repeat steps 2 through 7 and create a Bit Button to use text ID 2 for the registration text.

This concludes configuring the settings to switch the displayed language by a value of device address.
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This section describes items and buttons in Text Manager.

3.1 Text Manager

The text that is loaded and displayed when objects and Popup Screens are displayed is collectively managed with Text 
Manager.

■  (Copy)

Select (Text) and click  to copy the text and its attributes to the clipboard.

■  (Paste)

Select (Text) and click  to paste the clipboard contents to that cell.

■  (Delete Unused Texts)
Deletes the text with Text ID numbers that are registered in the Text Manager but are not used in the project.

3 Text Manager

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

(Text Messages 
List)

(Text ID)

(Font)

(Text Color)

(Windows Font)

(Text)

(Text Group Name)

• To select multiple items of (Text), press and hold SHIFT or CTRL while you click the specific items.
• Click (Text ID) to select the entire row.

• To select multiple items of (Text), press and hold SHIFT or CTRL while you click the specific items.
• Click (Text ID) to select the entire row.
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■  (Find)
Displays the Find dialog box.
The text entered in Find what is searched for in (Text) in the (Text Messages List).

■  (Replace)
Displays the Replace dialog box.
The text entered in Find what is searched for in (Text) in the (Text Messages List) and that text is replaced with the 
text entered in Replace with.

■  (Destination)
Specifies the text ID to move the focus (1 to 32,000).

■ Go to
Moves the focus to the text ID specified in (Destination).

■  (Import)
Imports text in a text list saved as a CSV file or as a text file.
Click this button to display the Open dialog box. For details, refer to “Importing Text from a Text List” on page 19-7.

■  (Export)
Saves the text for the text group being edited as a CSV file or as a text file. This file is called a text list. The types of 
files that can be saved are as follows.
• CSV file (comma delimited) (*.csv)
• CSV file (semicolon delimited) (*.csv)
• Unicode text file (tab delimited) (*.txt)

Click this button to display the Save As dialog box. For details, refer to “Saving Registered Text as a CSV File” on page 
19-6.

The saved text list can be imported with  (Import).

When Unicode text file (tab delimited) (*.txt) is selected, the file can handle multiple languages by 
using a commercially available text editor or spreadsheet software that supports Unicode.
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■ Number of Text Groups
Specifies the number of text groups (1 to 32).

■ Change Text Group by Device Address
Switches the text group according to the value of device address. Specify the word device to use as the condition to 
switch the text group.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.
These options can only be configured when Number of Text Groups is specified as two or more.

■ (Font)
Selects the font used for displaying text from the following.
European, Japanese, Chinese, Taiwanese, Korean, Central European, Baltic, Cyrillic, Windows

■ (Text Color)
Selects the color of the text to register (color: 256 colors, monochrome: 16 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

■ (Windows Font)
Sets the font to be used as the Windows Font.
Select Windows using (Font) to display the current setting. You can specify the character spacing (0 to 100) and the 
line spacing (0 to 100). To change the settings other than the character spacing and line spacing, click Change to 
display the Font Settings dialog box.
For details, refer to Chapter 2 “Windows Font” on page 2-13.

■ (Text Messages List)
The attributes for the registered text are displayed in this list. 

When the value of device address is 0, the text group switches to the text group set as the default.
If the value of device address is invalid, the text group is not switched.

(Text Group Name): Double clicking this item displays the Text Group Settings dialog box. For details, refer to “Text 
Group Settings Dialog Box” on page 19-14.

(Text ID): Displays the ID number (1 to 32,000).

(Text): Displays the registered text.

When registering text, double click the cell for the text group and text ID (1 to 32,000) to 
register, and then enter the text.
The maximum number is 3,750 characters.
The characters that can be entered depend on the font selected font. For details, refer to
Chapter 2 “1.2 Available Text” on page 2-6.

A line feed will be added with pressing and holding ALT and ENTER keys. You can enter multi-line text by 
inserting a newline. The newline is displayed as \n and is counted as two characters.
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● Text Group Settings Dialog Box
This dialog box is used to configure the Text Group Name and the default.

■ Text Group Name
Enters the names of the text groups.
The maximum number for the Text Group Name is 20 characters.

■ Use this Text Group as Default
Select this check box to setup the group to use when the MICRO/I power is turned on and when switching to run 
mode.

The text group set as the default is displayed with  next to (Text Group Name).
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This chapter explains the script function, editing and management of the script, definition method, and definition 
sample.

  

1.1 Overview of the Script Function

● What is the script function?
Complex processes such as conditional branching, logical operation, arithmetic operation, functions, etc., can be 
programmed in a text format using Script Function.

As an example, the logical product (AND) calculation described as  in a ladder diagram is described as 

[LM 100] & [LM 101] in text format in the script.

■ Description and management of the script
The script is programmed by WindO/I-NV4 script editor, and managed by Script Manager.

■ Example of using the script
As an example, when reading the data from the external device and displaying on the MICRO/I, the load on the 
external device can be reduced for processes such as conditional branching or function calculation, which apply a 
heavy load on the external device, by processing it with a script on the MICRO/I.

Chapter 20 Script

1 About the Script Function

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

LM100 LM101

• By using the Script Editor, conditional expressions, operators, and functions can be described by selecting 
them from a list, and an error in the script can also be determined. The script can also be exported as a 
text file, so the script can be edited by a text editor such as Notepad, and the edited script can be 
imported back into the Script Editor by saving it as a text file. For details, refer to “2.3 Script Editor” on 
page 20-12.

• Script Manager can manage the script collectively by adding, deleting, organizing, importing, exporting, 
etc., the script created by the Script Editor. For details, refer to “2.2 Script Manager” on page 20-7.

// Change the additional value 
// depending on the value of D10  
if ([D 10] <= 9) 
{ [D 10] = [D 10] + 10; } 
else 
{ [D 10] = [D 10] + 20; } 
// Change the additional value 
// depending on the value of D11 
if ([D 11] <= 19) 
{ [D 11] = [D 11] + 20; } 
else 
{ [D 11] = [D 11] + 40; } 
// Change the additional value 
// depending on the value of D12 
if ([D 12] <= 29) 
{ [D 12] = [D 12] + 30; } 
else 
{ [D 12] = [D 12] + 60; } 
// Change the additional value 
// depending on the value of D13 
if ([D 13] <= 39) 
{ [D 13] = [D 13] + 40; } 
else 
{ [D 13] = [D 13] + 80; }

MICRO/I
External device

Get the result by processing with script 

D10 0 → 10
D11 10 → 30
D12 30 → 90
D13 50 → 130

D10 0
D11 10
D12 30
D13 50

Read the data not processed

Write the result

Process with script to decrease 
the load of external device.

D10 10
D11 30
D12 90
D13 130
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1.2 Types and Trigger Conditions of the Script

● Types of scripts
There are 3 types of scripts used.

■ Script Command
This is a script that executes in accordance with trigger conditions in the same way as other parts, such as switches or 
lamps, for each screen.
• It is executed only in the screens where it is placed.
• Multiple scripts can be set for each screen.
For details, refer to Chapter 12 “5 Script Command” on page 12-32.

■ Global Script
This is a script that operates within the whole project. This script is executed at the end of MICRO/I scan process in 
accordance with the trigger condition. The amount of Global Scripts which can be used in a project is maximum of 16 
scripts. For details about setup, refer to “3 Global Script” on page 20-16.

■ Cyclic Script*1

This is a script that can be repeated in fixed intervals independent of the scan process of the MICRO/I. Input delay 
and output delay of the expansion module can be kept to a minimum by this script.
Only one cyclic script can be set to a project.
For details, refer to Chapter 30 “4 Cyclic Script” on page 30-28.

● Trigger condition of the script
Trigger conditions that can be set for the script are as follows:

■ Rising-edge
Script is executed when trigger device address changes from 0 to 1.

■ Falling-edge
Script is executed when trigger device address changes from 1 to 0.

■ Satisfy the condition
Script is executed when the set condition is met.
This can only be set for the Script Command.

■ While satisfying the condition
Script is executed while the set condition is met.
This can only be set for the Script Command.

■ Fixed Period
Script is executed at set intervals.

■ Always Enabled
Script is executed on every scan of the MICRO/I.
This can only be set for the Global Script.

*1 HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F only

Script

Trigger Condition

Rising-edge Falling-edge
Satisfy the 
condition

While 
satisfying the 

condition
Fixed Period Always ON

Script Command YES YES YES YES YES NO

Global Script YES YES NO NO YES YES

Fixed interval script*1 NO NO NO NO YES NO
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1.3 Data Type of the Script

It is required to set the data type appropriate for the range of data to be used, such as the maximum and minimum 
values of the data used in the script, negative numbers or real numbers required, etc., considering what is to be 
processed with the script.

● Data Types
There are 7 types of data that can be processed by the script function.
For details about the data types, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Data type is set by the Script Editor.
For the setting method, refer to “2.3 Script Editor” on page 20-12.

Types of the data type Required word count Range that can be processed

UBIN16(W) 1 0 to 65,535

BIN16(I) 1 -32,768 to 32,767

UBIN32(D) 2 0 to 4,294,967,295

BIN32(L) 2 -2,147,483,648 to 2,147,483,647

BCD4(B) 1 -999 to 9,999

BCD8(EB) 2 -9,999,999 to 99,999,999

Float32(F) 2

-3.4×1038 to -1.18×10-38

0

1.18×10-38 to 3.4×1038

There are functions that cannot be used when the data types are different. Please refer to the format list.
 For details, refer to “4 Script Definition Method” on page 20-21.
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1.4 Script Error

This section describes the types, cause, and information of script errors.

● Error information
Script error information is stored in the following locations. An error message is displayed on the screen when a script 
error has occurred.

● Types and causes of script errors
Script will stop running when an error occurs.

Category Storage location Stored value

Existence of a script error
Bit 10 of the System Area address 
number +2

0 No error

1 Error

Script ID of the script with an error HMI Special Data Register LSD52
1 to 

32,000
Script ID

Types of script errors HMI Special Data Register LSD53

1 Processing error

2 Execution time over error

3 Writing count error

4 Indirect device error

5 Parameter error

6 Fixed Interval Script execution time over

7 Fixed interval execution error

If there is a script error, bit 10 (11th bit) of the beginning device address +2 (third word from the beginning) 
of the System Area will be 1.

Beginning device address of the System Area is set in the System tab of the Project Settings dialog box.
For details about the System Area, refer to Chapter 4 “System Area” on page 4-30.

Beginning 
device address +1 +2 +3 +4 +5 +6 +7

System Area 1 System Area 2 System Area 3 System Area 4

+8 +9

0123456789101112131415

1st word 2nd word

11th bit

3rd word 4th word 5th word 6th word 8th word7th word 10th word9th word

Types of script error Cause

Processing error

Dividend was divided by 0 for division and residue calculation.

Data types are BCD4(B), BCD8(EB), Float32(F) and value out of range is 
specified.

Execution time over error
The execution time for one script exceeded 3,000 milliseconds.

Fixed Interval Script execution time over

Writing count error Data count written to the external device address in one script has exceeded 64.

Indirect device error

During the indirect read of external device address, the value of external device 
address was read.

Indirect read or indirect write of external device address is performed with the 
Global Script.

Parameter error

Value out of range was specified as argument for LINE function, RECTANGLE 
function, or CIRCLE function.

Executed the LINE function, RECTANGLE function, and CIRCLE function in a Cyclic 
Script.

Fixed interval execution error
Execution interval is automatically adjusted since the execution of the Fixed 
Interval Script has taken more time than half of the execution interval specified 
in the Fixed Interval Script.
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2.1 Script Registration Procedure

This section describes the procedure to create a script and register it in the project.
The registered script can be used in a Multi-Button, Script Command, Multi-Command, Global Script, and Cyclic Script.

1 On the Configuration tab, in the Manager group, click Script Manager.

Script Manager opens.

2 Click Add.

Script Editor opens.

3 Specify Script ID.

When creating a new script, enter the script ID (1 to 32000).

2 Editing and Management of the Script

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P
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4 Enter Script Name.

Maximum number for the script name is 40 characters.

5 Select Data Type.

6 Code a program in Script.

7 When the script is finished, click OK.

The created script is shown in Script List.

8 Click Close.

The scripts are saved in the project data and Script Manager closes.

Be sure to match the Data Type of the script with the types of data being used within the script.
For example, if a fractional value is contained in a script, select Float32(F) for the Data Type of the script. 
If there are only integer values from 0 to 65,535, select UBIN16(W).

To create a script using the samples provided by WindO/I-NV4, under Function List, select Category and 
Function, and then click Insert Format. The sample shown in Format is inserted at the cursor position in 
Script.

When you are in the following dialog boxes, clicking  will open the Script Manager. When you close the 
Script Manager, you will be taken back to the original dialog box.
• Global Script General tab
• Script Command properties General tab
• Multi-function script properties for Multi-Buttons and Multi-Commands
• Project Settings Expansion Module tab
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2.2 Script Manager

Script Manager can add, delete and manage the script created by Script Editor.

■ Script List
Displays a list of registered scripts.

■ Script
Displays the contents of the script selected in the script list.

■ Add
Displays the Script Editor dialog box to add a script.
For details, refer to “2.3 Script Editor” on page 20-12.

■ Edit
Displays the Script Editor dialog box to allow editing of the selected script. For details, refer to “2.3 Script Editor” on 
page 20-12.

■ Delete
Deletes the script selected in the script list.
If a script is used in a project or parts, it cannot be deleted.

■ Reduce
Deletes the scripts that are registered in the script list but are not used in the project.

■ Import
Imports a saved script file with Export. Click this button to display the Open dialog box. For details, refer to 
“Importing script” on page 20-10.

■ Export
Saves a selected script in Script List as a file.
Click this button to display the Browse For Folder dialog box. For details, refer to “Saving registered script as a file” 
on page 20-8.
The saved script file can be imported using Import.

Script ID: Displays the script ID (1-32000) of the registered scripts.

Error: OK is displayed when there is no error in the registered script and NG is displayed when there is an error.

Script Name: Displays the script name of the registered scripts.

Used: Displays how many times the registered script has used.
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■ Select
The highlighted script in the script list is selected and the Script Manager is closed.

● Using registered script on another project
To use the script registered in Script Manager on another project, save it as a file, and then import it to a project.

Saving registered script as a file

1 On the Configuration tab, in the Manager group, click Script Manager.

Script Manager opens.

2 Select the script in Script List, and then click Export.

The Browse For Folder dialog box is displayed.

The operation of the script used in the project can be checked with the debug function of the simulator. For 
details, refer to Chapter 26 “3.5 Script Debugger” on page 26-15.

To export multiple scripts, select all scripts to export. To select multiple scripts, press and hold SHIFT or 
CTRL while you click the specific items.
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3 Specify a save location and click OK.

The script file is output.

The file name of the exported script is 

“Script”(fixed text) + “{Script ID}” + “_”(underscore) + “{Script Name}” + “.txt”(file extension).

If the number of the script ID is less than 5 digits, 0 is written in the rest of the digits. It is omitted if the script name 
is not configured.

Example 1: In Script List on the Script Manager dialog box, {Script ID} is "12345" and {Script Name} is "sample".
Script12345_sample.txt

Example 2: In Script List on the Script Manager dialog box, {Script ID} is "6" and {Script Name} is blank.
Script00006_.txt

4 Click OK.

This concludes exporting script.
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Importing script

1 On the Configuration tab, in the Manager group, click Script Manager.

Script Manager opens.

2 Click Import.

Open dialog box is displayed.

3 Select a file for the Script, and then click Open.

The script is added to the Script Manager.

If there is a script with a script ID already registered on the Script Manager, an overwrite confirmation 
message is displayed.
• Click Yes to overwrite the script displayed in the confirmation message.
• Click Yes To All to overwrite all the scripts.
• Click No to display the next confirmation message without overwriting the script displayed in the 

confirmation message.
• Click Cancel to stop importing scripts.

To import multiple scripts, select all of the script files to import. To select multiple script files, press and hold 
SHIFT or CTRL while you click the specific items.
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4 Click OK.

The imported script is displayed on the Script Manager.

This concludes importing script.



2 Editing and Management of the Script

20-12 WindO/I-NV4 User’s Manual

2.3 Script Editor

A new script can be created or the script selected in the Script Manager can be edited using Script Editor.

■ Script ID
To create a new script, enter the script ID (1-32000).
To edit an existing script, the set script ID is displayed.

■ Script Name
Enter the script name. Maximum number for script name is 40 characters.

■ Data Type
Select the data type to be processed by the script.
For details about the data type, refer to “1.3 Data Type of the Script” on page 20-3.

■ Script
Enter the script.
Single script limitation is 240 characters per line with up to 1024 lines.

■ Error Check
The script being edited is checked for errors.

(Description)

When you add a descriptive text to the written script or invalidate it, add "//" at the beginning of the line to 
comment out it.
To select multiple lines in Script, press and hold SHIFT or CTRL while you click the specific items, or drag 
them.
The keyboard shortcuts are as follows.
• Ctrl+.(period): Comment out the selected line.
• Ctrl+,(comma): Uncomment the cursor position.
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■ Import
The Open dialog box is displayed.
By selecting a script saved (exported) in a text format (*.txt) and clicking on the Open button, the imported script is 
inserted at the cursor position of the script being edited.

■ Export
The Save As dialog box is displayed.
By selecting a save location and clicking on the Save button, the script being edited is saved in text format (*.txt). A 
saved script can be inserted in the script using the Import button.

■ Options
The Options dialog box is displayed.
The fonts and color of the text, tab indents, etc., used in the Script text box are set in the Options dialog box. For 
details, refer to “Options Dialog Box” on page 20-15.

■ Find
The Find dialog box is displayed.
Enter the text to be searched for in the Find What box.

When the Find button is clicked after selecting a range in the Script text box, it will only search within the 
selected range.
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■ Replace
The Replace dialog box is displayed.
Text entered in Find what will be replaced with the text entered in Replace with.

■ Show/Hide Function List
Switches between showing and not showing the Function List and Script Compilation Output.

■ Cursor
Displays the current position of the cursor in the Script text box by line number and column number.

■ Function List

■ Script Compilation Output
The contents of any errors found when using error check are displayed.
By double-clicking on the comment displayed in the Script Compilation Output, the part corresponding to the error 
is highlighted in the Script text box.

• This is useful when replacing device addresses.
• When the Replace button is clicked after selecting a range in the Script text box, it will only search and 

replace within the selected range.

The size of the script edit box can be changed by dragging the right bottom corner of the Script Editor. By 
hiding the Function List and Script Compilation Output, the script editing area (text box) will become 
larger, making the editing of script easier.

Category: Lists the categories of the functions.

Function: Lists the functions of the selected category.

Format: Displays the definition example of the selected function.

(description): Displays the description of the selected function.

Insert Format: Contents displayed in the selected Format are inserted at the cursor position.

Insert Device Address: The Tag Editor is displayed.
By specifying the device address and clicking on the OK button, specified device address is 
inserted at the cursor position.

Depending on the error, there may be an error in the line that is different from the line displayed in the 
Script Compilation Output, or multiple errors may be displayed.
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● Options Dialog Box
Font, Size, and Color used in the Script text box of the Script Editor can be specified.

■ Font
The font name for the text displayed in the Script is entered or selected.

■ Size
The font size (dots) for the text displayed in the Script is entered or selected.

■ Sample
Displays a sample of the text with the Font and Size as specified in the Script text box.

■ Color
Displays each of the text colors for Comment, Keyword, and Device Address.
To change the text color, click  on the right of the color to display the Color Palette and select the color.

Text other than comment, keyword, or device address is displayed in black.
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A Global Script operates for the entire project. The scripts are executed in order on the list and in accordance with the trigger 
conditions after the parts on the MICRO/I screen are processed. A maximum of 16 Global Scripts can be set to a project.

3.1 Setting procedures for Global Script

Global Script is setup using the following procedures.

1 On the Configuration tab, in the System Setup group, click Global Script.
The Global Script Settings dialog box is displayed.

2 Under Settings, select the script ID to configure, and then click Edit.
The Global Script dialog box is displayed.

3 On the General tab, select the Use Global Script check box.

3 Global Script

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

With Global Script, you cannot do indirect read and indirect write of the external device address.
For details about the indirect read and indirect write, refer to Chapter 2 “Indirect Read and Indirect Write 
Settings” on page 2-5.
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4 Specify the script ID (1 to 32,000) of the script to execute.

The Script Manager is displayed when the  button is clicked. The script can be selected from the script list of the 
Script Manager. For details, refer to “2.2 Script Manager” on page 20-7.

5 Click Trigger Condition tab.

6 With Trigger Type, select the condition to execute the script.

■ Rising-edge
Script is executed when trigger device address changes from 0 to 1. Specify the bit device or the bit number of the 
word device for Device Address.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.

■ Falling-edge
Script is executed when trigger device address changes from 1 to 0. Specify the bit device or the bit number of the 
word device for Device Address.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.

■ Always Enabled
The script is executed on every scan of the MICRO/I.

■ Fixed Period
Script is executed at set intervals. Specify Period in seconds.

7 Click OK to close the Global Script dialog box.

8 Click Close on the Global Script Settings dialog box.
This concludes the Global Script configuration.
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3.2 Global Script Settings Dialog Box

This section describes items and buttons on the Global Script Settings dialog box.
Global Script is managed as a group in the Global Script Settings dialog box.

■ Settings
This area is for editing the Global Script settings.

■ Edit
Registers or changes the Global Script settings for the selected line.
Click this button to display the Global Script dialog box. 
The Global Script dialog box settings are reflected on the selected line.
For details, refer to “3.3 Global Script Dialog Box” on page 20-19.

■ Up
Shifts the selected Global Script settings up the list.

■ Down
Shifts the selected Global Script settings down the list.

■ Delete
Deletes the registered settings from the list.

Order: Displays the number (1 to 16) for the order to execute the Global Script.

Script: Displays whether or not to use the Global Script. Double clicking the cell switches between 
Enable and Disable.

Script ID: Specify the script ID (1 to 32,000) of the script to execute.

Script Name: Displays the name of the script specified by the script ID.

Trigger Type: Specify the condition to execute the script.

Trigger Condition: Displays details about the condition to execute the script. The displayed content varies based on 
Trigger Type.

Rising-edge, Falling-edge: Displays the bit device or the bit number of the word device to serve 
as condition.

Always Enabled: Nothing is displayed.

Fixed Period: Displays the specified period.
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3.3 Global Script Dialog Box

This section describes items and buttons on the Global Script dialog box.

● General Tab

■ Use Global Script n
To use the Global Script, select the Use Global Script n (n : Order number) check box.

■ Script ID
Specify the script ID (1 to 32,000) of the script to execute.

The Script Manager is displayed when the  button is clicked. The script can be selected from the script list of the 
Script Manager. For details, refer to “2.2 Script Manager” on page 20-7.

■ Script Name
Displays the name of the script specified by the script ID.

■ Script
Displays the contents of the script specified by the script ID.

With Global Script, you cannot do indirect read and indirect write of the external device address.
For details about the indirect read and indirect write, refer to Chapter 2 “Indirect Read and Indirect Write 
Settings” on page 2-5.
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● Trigger Condition Tab

■ Trigger Type
Specify the condition to execute the script.

■ Device Address
Specify the bit device or the bit number of the word device.
This is enabled only when Rising-edge or Falling-edge is selected in Trigger Type.

■ Period (sec)
Specify the scan frequency in seconds (1 to 3,600).
This is enabled only when Fixed Period is selected in Trigger Type.

Rising-edge: Script is executed when trigger device address changes from 0 to 1.

Falling-edge: Script is executed when trigger device address changes from 1 to 0.

Always Enabled:The script is executed on every scan of the MICRO/I.

Fixed Period: Script is executed at set intervals.
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4.1 Format List

This section describes the format and operation of control statements, operators, functions, etc.
Enter everything except comments in single-byte. For specific definition examples, refer to “5 Script Coding Examples” 
on page 20-30.

● Control statements
Conditional expressions are described as , ,  here. Execution lines are described as 

, ,  ...

■ Conditional branching

■ Repeat

4 Script Definition Method

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

Cond. expr. Cond. expr. 1 Cond. expr. 2

Exe. line Exe. line 1 Exe. line 2

Format Description

if
   else
   else if

if ( )
{ ; }

Execution line is executed if the conditional expression is satisfied.

if ( )
{ ; }
else
{ ; }

Execution line 1 is executed if the conditional expression is satisfied.
Execution line 2 is executed if it is not satisfied.

if ( )
{ ; }
else if ( )
{ ; }
else
{ ; }

Execution line 1 is executed if the conditional expression 1 is satisfied.
Conditional expression 2 is determined if conditional expression 1 is not 
satisfied, and execution line 2 is executed if conditional expression 2 is 
satisfied.
Execution line 3 is executed if conditional expression 2 is not satisfied too.

switch
   case
   default

switch ( )
{
  case constant 1:
    ;
    break;
  case constant2:
    ;
    break;
  default:
    :
    break;
}

Execution line 1 is executed if the value of conditional expression matches 
constant 1.
Execution line 2 is executed if the value of conditional expression matches 
constant 2.
Execution line 3 is executed if the value of conditional expression does not 
match constant 1 nor constant 2.

Cond. expr.
Exe. line

Cond. expr.
Exe. line 1

Exe. line 2

Cond. expr. 1
Exe. line 1

Cond. expr. 2
Exe. line 2

Exe. line 3

Cond. expr.

Exe. line 1

Exe. line 2

Exe. line 3

Format Description

while

while ( )
{
  ;
}

Execution line is repeatedly executed while the conditional expression is 
satisfied.

• It will go into an infinite loop when the conditional expression is always satisfied, 
so do not set fixed values or device addresses that do not change as the 
conditional expression.

• Do not write a value to the external device address in the while definition.

Cond. expr.

Exe. line
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■ Halt and exit

● Operator
Device address, constant, and temporary device are described as ,  here, and expression is described as 

, , .

■ Relational operator

■ Logical operator

■ Arithmetic operator

Format Description

break

while ( )
{
  if ( )
  {
    ;
    break;
  }
 ;
}

;

Process will be as follows while the conditional expression 1 is satisfied.
• Execution line 2 is continuously executed while the conditional expression 2 is not 

satisfied.
• Once the conditional expression is satisfied, it will go out of the loop by break (not 

executing execution line 2), and execution line 3 is executed.

switch ( )
{
  case constant 1:
    ;
    break;
  case constant 2:
    ;
    break;
}

;

When the conditional expression 2 matches the constant 1, it will halt the 
determination of constant 2 by break after executing execution line 1, and 
process will move to execution line 3.

return return; It will exit the script, and execute the next parts or script.

Cond. expr. 1

Cond. expr. 2

Exe. line 1

Exe. line 2

Exe. line 3

Cond. expr.

Exe. line 1

Exe. line 2

Exe. line 3

a b
Expr. Expr. 1 Expr. 2

Operator Format Description

==  == Compares if  is equal to .

!=  != Compares if  is not equal to .

<  < Compares if  is less than .

<=  <= Compares if  is equal or less than .

>  > Compares if  is greater than .

>=  >= Compares if  is equal or greater than .

a b a b

a b a b

a b a b

a b a b

a b a b

a b a b

Operator Format Description

&& ( ) && ( ) Calculates the logical product (AND) of  and .

|| ( ) || ( ) Calculates the logical sum (OR) of  and .

! !( ) Reverses the logic of .

Expr. 1 Expr. 2 Expr. 1 Expr. 2

Expr. 1 Expr. 2 Expr. 1 Expr. 2

Expr. Expr.

Operator Format Description

+  + Adds  and .

-  - Subtracts  from .

*  * Multiplies  and .

/  / Divides  by .

%  % Calculates remainder after dividing  by .

a b a b

a b b a

a b a b

a b a b

a b a b
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■ Bit operator

● Function
Device address, constant, and temporary device are described as , , , ... here.

■ Bit function

■ Word function

Arithmetic operation

(Continued to next page)

Operator Format Description

&  & Calculates the logical product (AND) of each bit of  and .

|  | Calculates the logical sum (OR) of each bit of  and .

^  ^ Calculates the exclusive logical sum (XOR) of each bit of  and .

~ ~
Reverses the logic of each bits of .
For word device and fixed values, 0 will be 65535, and 65535 will be 0.
For bit device, 0 will be 1, and 1 will be 0.

<<  << Shifts each bit of  to left for  bit(s).

>>  >> Shifts each bit of  to right for  bit(s).

a b a b

a b a b

a b a b

a
a

a b a b

a b a b

a b c d

Function Format Description

Bit set SET( );
Turns bit device  to 1.

It will be same result as  = 1;.

Bit reset RST( );
Turns bit device  to 0.

It will be same result as  = 0;.

Bit reverse REV( );
Reverses the 1 and 0 of bit device .

It will be same result as  = ~ ;.

a a
a

a a
a

a a
a a

Function Format Description

Maximum 
value MAX( , , )

Maximum value out of , ,  is returned.

• This can be used for all data types.
• Up to 15 arguments can be defined.

Minimum 
value MIN( , , )

Minimum value out of , ,  is returned.

• This can be used for all data types.
• Up to 15 arguments can be defined.

Exponential 
function EXP( )

Exponential function of  is returned.

• This can only be used for data type Float32(F).

Natural 
logarithm
(Base: e)

LOGE( )
Natural logarithm (base is e) for  is returned.

• This can only be used for data type Float32(F).
• Set a value larger than 0 for argument.

Common 
logarithm
(Base: 10)

LOG10( )
Common logarithm (base is 10) for  is returned.

• This can only be used for data type Float32(F).
• Set a value larger than 0 for argument.

Exponentiation POW( , )
 to the  power is returned.

• This can only be used for data type Float32(F).

a b c
a b c

a b c
a b c

a
a

a
a

a
a

a b
a b
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Arithmetic operation (Continued)

Data type conversion

Function Format Description

Square root ROOT( )
Square root of  is returned.

• This can only be used for data type Float32(F).

Sine SIN( )

Sine of  (-1 - +1) is returned. Specify arbitrary formula to represent 

angle (units in radian) for argument .

• This can only be used for data type Float32(F).

Cosine COS( )

Cosine of  (-1 - +1) is returned. Specify arbitrary formula to 

represent angle (units in radian) for argument .

• This can only be used for data type Float32(F).

Tangent TAN( )

Tangent of  (-1 - +1) is returned. Specify arbitrary formula to 

represent angle (units in radian) for argument .

• This can only be used for data type Float32(F).

Arcsine ASIN( )

Arcsine of  (-1 - +1) in radian value (-π/2 - +π/2) is returned. 

Specify arbitrary formula for argument .

• This can only be used for data type Float32(F).

Arccosine ACOS( )

Arccosine of  (-1 - +1) in radian value (0 - π) is returned. 

Specify arbitrary formula for argument .

• This can only be used for data type Float32(F).

Arctangent ATAN( );

Arctangent of  (-1 - +1) in radian value (-π/2 - +π/2) is returned. 

Specify arbitrary formula for argument .

• This can only be used for data type Float32(F).

Conversion 
from Angle to 

Radian
RAD( );

Value of  is converted from degree (°) to radian, and the value is 
returned.

• This can only be used for data type Float32(F).

Conversion 
from Radian 

to Angle
DEG( );

Value of  is converted from radian to degree (°), and the value is 
returned.

• This can only be used for data type Float32(F).

Function Format Description

Conversion 
from BCD to 

Binary
BCD2BIN( )

BCD value of  is returned in binary value.

• This can be used with data types UBIN16(W), BIN16(I), UBIN32(D), and 
BIN32(L).

Conversion 
from Binary to 

BCD
BIN2BCD( )

Binary value of  is returned in BCD value.

• This can be used with data types UBIN16(W), BIN16(I), UBIN32(D), and 
BIN32(L).

Conversion 
from Floating 
point to Binary

FLOAT2BIN( )
Float32 value of  is returned in floating point value.
Values under the decimal point is truncated.

• This can be used with data types UBIN32(D) and BIN32(L).

Conversion 
from Binary to 
Floating point

BIN2FLOAT( )
Binary value of  is returned in floating point value.

• This can be used with data types UBIN32(D) and BIN32(L).

Conversion 
from Decimal 

to String 
character

DEC2ASCII( , )

Decimal number value  is converted to a character string, and store 

in order with  as a beginning device address.

• This can be used with data types UBIN16(W), BIN16(I), UBIN32(D), 
BIN32(L), BCD4(B), or BCD8(EB).

Conversion 
from String 
character to 

Decimal

ASCII2DEC( )

Character string  is returned as decimal number value.

• This can be used with data types UBIN16(W), BIN16(I), UBIN32(D), 
BIN32(L), BCD4(B), or BCD8(EB).

a a

a
a

a

a
a

a

a
a

a

a
a

a

a
a

a

a
a

a

a
a

a
a

a
a

a
a

a
a

a
a

a b

b
a

a
a
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Data comparison and copy

Character string operation
Only internal devices can be specified as an argument for character string operation function.
Termination character NULL (0x00) is treated as end of character string when character string is handled. Also, 
termination character NULL is not included in the length of the character string.

Function Format Description

Data 
comparison MEMCMP( , , )

: Beginning device address of comparison target 1

: Beginning device address of comparison target 2

: Range of comparison (in words)

Values of device address  for  words and values of device 

address  for  words are compared.
1 is returned if all the values of device addresses match, and 0 is 
returned if any of the value does not match.

• Specified range is compared in word unit, and result is returned.
• Up to 64 words can be compared.

Data copy MEMCPY( , , )

: Beginning device address of copy source

: Beginning device address of copy target

: Range of copy (in words)

Values of device address from  for  words are copied to 

 for  words respectively.

• Specified range is copied in word unit.
• Up to 64 words can be copied.

Function Format Description

Character 
string copy

STRCUT( , , , )

: Beginning device address of copy target

: Beginning device address containing copy source 
character string

: Start location of copy (0-127)

: Number of characters to copy (1-128)

From the character string starting from , character string 

from  bytes forward for  characters are stored into 

 for  characters.

Character 
number count STRLEN( ) Number of characters for character string starting from  is 

returned.

Character 
string 
concatenation

STRCAT( , )
To the character string starting from , the character string 

starting from  is concatenated, and  is returned to 
beginning.

Character 
string search STRSTR( , )

From the character string starting from , character string 

starting from  is searched, and location found (number of 
characters from beginning -1) is returned.
• Maximum number for character string to search is 128 

characters.

a b c

a
b
c

a c
b c

a b c

a
b
c

a c
b c

a b c d

a
b

c
d

b
c d

a d

a a

a b
a

b a

a b

a
b
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Draw
• This is a function to draw an object on the screen. Top left corner of the screen is coordinates X=0 and Y=0.
• When a device address is used as an argument, an object is drawn with the changed value when the value is 

changed. However, the object that is already drawn is not erased. To erase the drawn object, overwrite it with the 
background color.

• When an out-of-range value is used as an argument, 5 is stored in the HMI Special Data Register LSD53 and script 
is halted.

• Objects that are drawn with scripts for parts placed on the top layer are not drawn on the top layer.
Example: The Multi-Button is placed on the top layer of a base screen and the script CIRCLE is executed to draw a 

circle or ellipse by pressing the Multi-Button
The settings of the script CIRCLE: center coordinate X is 80, center coordinate Y is 120, X-axis radius is 
60, Y-axis radius is 60, line width is 1, line type is 1, foreground color is 20, background color is 0, and the 
pattern is 2

(Continued to next page)

Function Format Description

Drawing of 
straight 
line

LINE( , , , ,
     , , )

Straight line connecting the start coordinate and end coordinate is drawn.
: Start coordinate X, : Start coordinate Y, : End 

coordinate X, : End coordinate Y, : Line width, : 
Line type, : Line color
• : Line width, : Line type, : Line color can be 

omitted.
• Specification of : Line width is as follows:

It will be set to 1 (1 dot) when omitted.
• Specification of : Line type is as follows.

It will be set to 1 (Solid) when omitted or when the line width is 
set to anything other than 1 (1 dot).

• : Line color is specified by the color data. It will be set to 
255 (white) when omitted. 
For color data, refer to Appendix “Color Data Correspondence 
Table” on page A-1.

LINE( , , , )

Display for Base Screen: 1

Draws a circle on the base screen

// Script A
CIRCLE(80, 120, 60, 60, 1, 1, 20, 0, 2);

Execute script

Top Layer

Multi-Button

Base Screen: 1

Top Layer

Circle

Base Screen: 1

Draws a circle

Object List

No. Type Layer

1 Multi-Button Top Layer

No. Type Layer

1 Circle

2 Multi-Button Top Layer

a b c d
e f g

a b c
d e f

g
e f g

e
Preset Value 1
Line Width 1 dot

2
2 dots

3
3 dots

5
5 dots

f
Preset Value 1 2 3 4 5 6

Line Type Solid Dot Dash Long Dash Long Dash 
Dot

Long Dash 
Dot Dot

g
a b c d
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Draw (Continued)

(Continued to next page)

Function Format Description

Drawing of 
Rectangle

RECTANGLE( , , ,
          , , ,
          , , ,
          , )

Rectangle with left top corner as start coordinate and bottom right 
corner as end coordinate is drawn.

: Start coordinate X, : Start coordinate Y, : End 
coordinate X, : End coordinate Y, : Line width, : Line 
type, : Foreground color, : Background color, : 
Pattern, : Rounded corner type, : Rounded corner radius
• : Line width, : Line type, : Foreground color, 

: Background color, : Pattern, : Rounded 
corner type, : Rounded corner radius can be omitted.

• Specification of : Line width is as follows:

It will be set to 1 (1 dot) when omitted.
• Specification of : Line type is as follows.

It will be set to 1 (Solid) when omitted or when the line width is 
set to anything other than 1 (1 dot).

• : Foreground color, : Background color is specified 
by the color data. It will be set to 255 (white) when omitted. 
For color data, refer to Appendix “Color Data Correspondence 
Table” on page A-1.

• Specification of : Pattern is as follows.

It will be set to 0 (None) when omitted.
• Specification of : Rounded corner type is as follows.

It will be set to 0 (None) when omitted.
• : Rounded corner radius is specified with number of dots (0 - 200). 

It will be set to 0 (0 dot) when omitted.

RECTANGLE( , , ,
          )

a b c
d e f
g h i
j k

a b c
d e f

g h i
j k

e f g
h i j

k
e

Preset Value 1
Line Width 1 dot

2
2 dots

3
3 dots

5
5 dots

f
Preset Value 1 2 3 4 5 6

Line Type Solid Dot Dash Long Dash Long Dash 
Dot

Long Dash 
Dot Dot

g h

i
Preset Value 0 2 3 4 7

9 10 11 12 13

8

Line Type None Foreground
100%

Foreground 
25%

Foreground 
50%

Background 
100%

Horizontal 
lines

Preset Value

Line Type Vertical
lines

Slant 
Upwards

Slant 
Down-wards Cross-hatch Tint

j
Preset Value 0
Line Type None

1
Straight

2
Curve

k

a b c
d
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Draw (Continued)

Offset

Function Format Description

Drawing 
of circle 
and ellipse

CIRCLE( , , , ,
       , , , ,
       )

A circle with specified radius from center coordinate is drawn.
: Center coordinate X, : Center coordinate Y,
: X axis radius, : Y axis radius, : Line width, 
: Line type, : Foreground color, 
: Background color, : Pattern

• : Line width, : Line type, : Foreground color, 
: Background color, : Pattern can be omitted.

• Specification of : Line width is as follows:

It will be set to 1 (1 dot) when omitted.
• Specification of : Line type is as follows.

It will be set to 1 (Solid) when omitted or when the line width is 
set to anything other than 1 (1 dot).

• : Foreground color, : Background color is specified 
by the color data. It will be set to 255 (white) when omitted.
For color data, refer to Appendix “Color Data Correspondence 
Table” on page A-1.

• Specification of : Pattern is as follows.

It will be set to 0 (none) when omitted.

CIRCLE( , , , )

Function Format Description

Indirect 
specification OFFSET( , )

: Reference device address
: Device address to store the indirect value (0 to 32767)

Specify the device address  words from .
Indirect read
Specify OFFSET function to the right of the assignment statement.

Format example:  = OFFSET( , )
Operation: Stores the value of device address in  

words from  into .
Indirect write
Specify OFFSET function to the left of the assignment statement.

Format example:OFFSET( , ) = 
Operation: Stores the value of  into the device 

address  words from .
• Store the value appropriate for the data type as the indirect 

value. As an example, when the data type is BCD4(B), store the 
indirect value of BCD4(B) into the device address.
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● Other
This section provides definitions for constant, device address, temporary device, and comment.

■ Constant
Constant can be defined as decimal or hexadecimal numbers.

Sample definition of decimal numbers

There are 2 ways to define hexadecimal numbers.

Sample definition of hexadecimal numbers

■ Device Address
Device Address is defined with the device type and address within “[” and “]”.

Definition of the device address

Sample definition

■ Temporary Device
Temporary device is a device address that can be used only with the script. It can store a value and can be used as a 
variable.
It is defined with a device type “@” followed by address number (1 - 16).

Definition of the temporary device

Sample definition

■ Comment
A note defined in the script is called a comment. The line with “//” defined at the beginning of a line will become a comment.
“//” is defined with a single-byte. Double-byte characters can be used after “//”.

Definition of comment

Sample definition

1234 Define the numeric value directly.

-1234 Define the negative number with a “-” (minus) symbol at the 
beginning.

12.34 Decimal number can be defined for real numbers (Float32(F)).
Define a “.” (period) between the whole numbers and decimal numbers.

0x12AB Define “0” (zero) and “x” (lower case x) at the beginning of the value.

12ABh Append “h” at the tail of the value.

[Device type address number] (“ ” represents a space.)

[LDR 100]

@Address number (Space between the device type “@” and address number is not required.)

@2 Temporary device number 2

All the values for temporary devices are set to “0” when the execution of the script is started.

// Arbitrary note

// Store the initial value to calculation 
data [LDR 100] for process A
[LDR 100] = 1234;
:
:

←This line is not executed.

• It will be useful to use comments to explain the contents of the script (especially when the editor of the 
script has changed or some time has passed since editing).

• Comments are ignored (not executed) when the script is executed, so they can be defined freely without 
worrying about the execution time.
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This section provides script coding examples for control statements, arithmetic operators, and functions, as well as 
the descriptions of their operations.

5.1 Control Statements

Script

Operation description
If the value of LDR100 is not 0, then 100 is stored in LDR200.

Script

Operation description
If the value of LM100 is not 0, then LDR300, LDR400, and LDR500 are added and that value is stored in LDR200.

Script

Operation description
If the value of LDR100 is not 0 and the value of LDR200 is also not 0, then 0x1234 is stored in LDR300.
If the value of LDR100 is not 0 and the value of LDR200 is 0, then nothing is executed.
If the value of LDR100 is 0, then nothing is executed regardless of the value of LDR200.

5 Script Coding Examples
HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

■ Example 5.1.1 Conditional branch

if ([LDR 100])
{

[LDR 200] = 100;
}

■ Example 5.1.2 Conditional branching

if ([LM 100])
{

[LDR 200] = [LDR 300] + [LDR 400] + [LDR 500];
}

■ Example 5.1.3 Conditional branching

if (0 != [LDR 100])
{

if (0 != [LDR 200])
{

[LDR 300] = 0x1234;
}

}
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Script

Operation description
If either the value of LDR100 or the value of LDR200 is not 0, then 100 is stored in LDR300.
If the value of both LDR100 and LDR200 is 0, 100 is added to LDR500 and that value is stored in LDR400.

Script

Operation description
If the value of LDR100 is 0, then 0x1234 is stored in LDR200.
If the value of LDR100 is 1, then 0x5678 is stored in LDR200.
If the value of LDR100 is not 0 or 1, then 0x9999 is stored in LDR200.

Script

Operation description
If the values of LDR100, LDR200, and LDR300 are all not 0, then 100 is stored in LDR400.
If the values of LDR100 and LDR200 are not 0 and the value of LDR300 is 0, then 200 is stored in LDR400.
If either the value of LDR100 or LDR200 is 0, then nothing is executed regardless of the value of LDR300.

■ Example 5.1.4 Conditional branching

if ((0 != [LDR 100]) || (0 != [LDR 200]))
{

[LDR 300] = 100;
}
else
{

[LDR 400] = [LDR 500] + 100;
}

■ Example 5.1.5 Conditional branching

if ([LDR 100] == 0)
{

[LDR 200] = 0x1234;
}
else if ([LDR 100] == 1)
{

[LDR 200] = 0x5678;
}
else
{

[LDR 200] = 0x9999;
}

■ Example 5.1.6 Conditional branching

if ([LDR 100])
{

if ([LDR 200])
{

if ([LDR300])
{

[LDR 400] = 100;
}
else
{

[LDR 400] = 200;
}

}
}
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Script

Operation description
If the value of LDR100 is larger than 0, then 1 is repeatedly added to the value of LDR200 and 1 is repeatedly 
subtracted from the value of LDR100.
In the script example above, when the while statement repeats ten times, the value of LDR100 becomes 0 and the 
while statement ends.
After this script executes, the value of LDR100 is 0 and the value of LDR200 is 20.

Script

Operation description
While the value of LDR100 is 0, the while statement repeats.
Inside the while statement, if the values of LDR200 and LDR300 are equal, the while statement will terminate, and 
after [LM 0] changes to 1, execution breaks out of the while statement.
In the script example above, the values of LDR200 and LDR300 are equal when the while statement repeats twice, 
and after LM0 changes to 1, execution breaks out of the while statement loop. After execution, the value of LDR100 is 
0, the value of LDR200 is 5, the value of LDR300 is 5, and LM0 is 1.

■ Example 5.1.7 Iteration

[LDR 100] = 10;
[LDR 200] = 10;

while (0 < [LDR 100])
{

[LDR 200] = [LDR 200] + 1;
[LDR 100] = [LDR 100] - 1;

}

■ Example 5.1.8 Iteration

[LDR 100] = 0;
[LDR 200] = 3;
[LDR 300] = 5;

while ([LDR 100] == 0)
{

[LDR 200] = [LDR 200] + 1;

if ([LDR 300] = [LDR 200)
{

SET([LM 0]);
break;

}
}
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Script

This script stores the values of LDR10 through LDR19 in LDR100 through LDR109.
It operates as follows.
First, the indirect value LDR0 is initialized and set to 0.
First iteration (loop): The value of LDR0 is 0, so the condition “[LDR 0] < 10” is true and the statements inside while 
are executed.

• The value of LDR10, 0 words from LDR10, is stored in LDR100, 0 words from LDR100.
• 1 is added to the value of the indirect value LDR0 so that it becomes 1.

Second iteration (loop): The value of LDR0 is 1, so the condition “[LDR 0] < 10” is true and the statements inside 
while are executed.

• The value of LDR11, 1 word from LDR10, is stored in LDR101, 1 word from LDR100.
• 1 is added to the value of the indirect value LDR0 so that it becomes 2.

:
(Repeats in this manner for the third to ninth iterations)

:
Tenth iteration (loop): The value of LDR0 is 9, so the condition “[LDR 0] < 10” is true and the statements inside while 
are executed.

• The value of LDR19, 9 words from LDR10, is stored in LDR109, 9 words from LDR100.
• 1 is added to the value of the indirect value LDR0 so that it becomes 10.

The value of LDR0 is 10, so the condition “[LDR 0] < 10” is false and execution breaks out of the while loop.
After execution, the values of LDR100 through LDR109 are the values of LDR10 through LDR19.

■ Example 5.1.9 Indirect write and indirect read using iteration (while statement)

// Transfer LDR10 through LDR19 to LDR100 through LDR109

// Initialize the indirect value
[LDR 0] = 0;

// Loop ten times
while ([LDR 0] < 10)
{

// Transfer 1 word by indirect assignment
OFFSET([LDR 100], [LDR 0]) = OFFSET([LDR 10], [LDR 0]);
// Increment indirect value
[LDR 0] = [LDR 0] + 1

}
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Script

Operation description
This example converts a decimal value to octal using a while statement.
By repeating the process to divide the original decimal data by 8 and converting each digit to octal in a while 
statement, the conversion is implemented up to four digits.
The unconverted decimal value is stored in LDR100. After the script is executed, the converted octal value is stored in 
LDR200.

■ Example 5.1.10 Decimal to octal conversion using a while statement

// Convert a decimal value to octal
// - For example, convert 10 (Dec) to 12 (Oct), 16 (Dec) to 20 (Oct)
// - Convert a value to octal up to 4 digits max

@1 = 0; // while counter
@2 = [LDR 100]; // gets original data
@3 = 1; // decimal base
@4 = 0; // calculation results

// repeat four times
while (@1 < 4)
{

// Extract 1st octal digit from original data. Store working result in @10.
@10 = @2 % 8;
// Convert the extracted results to decimal and add to results
@4 = @4 + (@10 * @3);

// Increase the decimal base by one digit
@3 = @3 * 10;
// Reduce the original data by one digit
@2 = @2 / 8;
// If @2 is 0, terminate the while statement
if (0 == @2)
{

break;
}

// Increment while counter by 1
@1 = @1 + 1;

}

// Store the calculation result in LDR200
[LDR 200] = @4;
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Operation description
If the value of LDR100 is 10, then 0x1234 is stored in LDR200.
If the value of LDR100 is 999, then 0x5678 is stored in LDR200 and LM10 turns on.
If the value of LDR100 is not 10 or 999, then nothing is executed.

Script

Operation description
If the value of LDR100 is 0, then 0x1234 is stored in LDR200.
If the value of LDR100 is 1, then 0x5678 is stored in LDR200.
If the value of LDR100 is not 0 or 1, then 0x9999 is stored in LDR200.

Script

Operation description
If the value of LDR100 is not 0x1234, then 0 is stored in LDR300.
If the value of LDR100 is 0x1234, then 0x5678 is stored in LDR200 and the script terminates.
The return statement does not break out of a function like the break statement, it terminates the script and executes 
the next part or script.

■ Example 5.1.11 Conditional branching with switch

switch ([LDR 100])
{

case 10:
[LDR 200] = 0x1234;
break;

case 999:
[LDR 200] = 0x5678;
SET([LM 10]);
break;

}

■ Example 5.1.12 Conditional branching with switch using the default statement

switch ([LDR 100])
{

case 0:
[LDR 200] = 0x1234;
break;

case 1:
[LDR 200] = 0x5678;
break;

default:
[LDR 200] = 0x9999;
break;

}

■ Example 5.1.13 Terminate the script with the return statement

if (0x1234 == [LDR 100])
{

[LDR 200] = 0x5678;
return;

}
[LDR 300] = 0;
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Script

Operation description
While the value of LDR100 is 0, the while statement repeats until LDR200 and LDR300 are equal.
Inside the while statement, if the values of LDR200 and LDR300 are equal, the while statement will end and execution 
breaks out of the while statement.
In the script example above, the values of LDR200 and LDR300 are equal when the while statement repeats twice, 
and after LM0 changes to 1, the while statement ends. After execution, the value of LDR100 is 0, the value of LDR200 
is 5, the value of LDR300 is 5, and the value of LM0 is 1.

5.2 Relational Operators

Script

Operation description
If the value of LDR100 is equal to the value of LDR200, then 0x100 is stored in LDR300.

Script

Operation description
If the value of LDR100 is not equal to the value of LDR200, then 0x100 is stored in LDR300.

Script

Operation description
If the value of LDR100 is less than the value of LDR200, then 0x100 is stored in LDR300.

■ Example 5.1.14 Break out of a loop with the break statement

[LDR 100] = 0;
[LDR 200] = 3;
[LDR 300] = 5;

while ([LDR 100] == 0)
{

[LDR 200] = [LDR 200] + 1;

if ([LDR 200] == [LDR 300)
{

SET([LM 0]);
break;

}
}

■ Example 5.2.1 Equal to

if ([LDR 100] == [LDR 200])
{

[LDR 300] = 0x100;
}

■ Example 5.2.2 Not equal to

if ([LDR 100] != [LDR 200])
{

[LDR 300] = 0x100;
}

■ Example 5.2.3 Less than

if ([LDR 100] < [LDR 200])
{

[LDR 300] = 0xl00;
}
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Operation description
If the value of LDR100 is less than or equal to the value of LDR200, then 0x100 is stored in LDR300.

Script

Operation description
If the value of LDR100 is greater than the value of LDR200, then 0x100 is stored in LDR300.

Script

Operation description
If the value of LDR100 is greater than or equal to the value of LDR200, then 0x100 is stored in LDR300.

■ Example 5.2.4 Less than or equal to

if ([LDR 100] <= [LDR 200])
{

[LDR 300] = 0xl00;
}

■ Example 5.2.5 Greater than

if ([LDR 100] > [LDR 200])
{

[LDR 300] = 0xl00;
}

■ Example 5.2.6 Greater than or equal to

if ([LDR 100] > [LDR 200])
{

[LDR 300] = 0xl00;
}
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5.3 Logical Operators

Script

Operation description
If the value of LDR100 is equal to the value of LDR200, and if the value of LDR300 is equal to the value of LDR400 
and LDR500 added together, then 100 is stored in LDR600.
If either ([LDR 100] == [LDR 200]) or ([LDR 300] == [LDR 400] + [LDR 500]) is false, the processing in the brackets 
“{ }” is not executed.

Script

Operation description
If the value of LDR100 is not 0 or the value of LDR200 is not 0, then 100 is stored in LDR300.
If either is true, the processing in the brackets “{ }” is executed.

Script

Operation description
If the value of LDR100 is not equal to 0x1234, then 100 is stored in LDR300.

Script

Operation description
If the value of LDR100 is 0, then 100 is stored in LDR300.
This is the same as the code “if (0==[LDR 100]))”.

■ Example 5.3.1 Logical AND

if (([LDR 100] == [LDR 200]) && ([LDR 300] == [LDR 400] + [LDR 500]))
{

[LDR 600] = 100;
}

■ Example 5.3.2 Logical OR

if ((0 != [LDR 100]) || (0 != [LDR 200]))
{

[LDR 300] = 100;
}

■ Example 5.3.3 Logical inversion

if (!([LDR 100] == 0x1234))
{

[LDR 300] = 100;
}

■ Example 5.3.4 Logical inversion

if (!(0 !=[LDR 100]))
{

[LDR 300] = 100 ;
}
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5.4 Arithmetic Operators

Script

Operation description
The values of LDR100 and LDR200 are added together and the result is stored in LDR300.

Script

Operation description
The value of LDR200 is subtracted from the value of LDR100 and the result is stored in LDR300.

Script

Operation description
The values of LDR100 and LDR200 are multiplied together and the result is stored in LDR300.

Script

Operation description
The value of LDR100 is divided into the value of LDR200 and the result is stored in LDR300.

Script

Operation description
The value of LDR100 is divided into the value of LDR200 and the remainder is stored in LDR300.

■ Example 5.4.1 Addition

[LDR 300] = [LDR 100] + [LDR 200];

■ Example 5.4.2 Subtraction

[LDR 300] = [LDR 100] - [LDR 200];

■ Example 5.4.3 Multiplication

[LDR 300] = [LDR 100] * [LDR 200];

■ Example 5.4.4 Division

[LDR 300] = [LDR 100] / [LDR 200];

■ Example 5.4.5 Modulo

[LDR 300] = [LDR 100] % [LDR 200];
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5.5 Bitwise Operators

Script

Operation description
If the bitwise logical AND operation on the values of LM100 and LM101 is 1, LM200 changes to 1.
If the bitwise logical AND operation on the values of LM100 and LM101 is 0, LM200 changes to 0.
The operation is the same as the following ladder diagram.

Script

Operation description
If the bitwise logical OR operation on the values of LM100 and LM101 is 1, LM200 changes to 1.
If the bitwise logical OR operation on the values of LM100 and LM101 is 0, LM200 changes to 0.
The operation is the same as the following ladder diagram.

Script

Operation description
The logical XOR operation on the value of LDR100 and each bit in 0xFF is stored in LDR200.
For example, if the value of LDR100 is 15 (0x0F), then LDR200 is 240 (0xF0).

■ Example 5.5.1 Logical AND

if ([LM 100] & [LM 101])
{

SET([LM 200)]);
}
else
{

RST([LM 200]);
}

LM100 LM101 LM200

■ Example 5.5.2 Logical OR

if ([LM 100] | [LM 101])
{

SET([LM 200]);
}
else
{

RST([LM 200]);
}

LM100

LM101

LM200

■ Example 5.5.3 Logical XOR (exclusive OR)

[LDR 200] = [LDR 100] ^ 0xFF;
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Operation description
The bits in the value of LDR100 are flipped and stored in LDR200.
For example, if the value of LDR100 is 0, then LDR200 is 65535.

Script

Operation description
If the bitwise logical OR operation on the value of LM102 and the result of the bitwise logical AND operation on the 
value of LM100 and the inverted result of the value of LM101 is 1, then LM200 changes to 1.
If the bitwise logical OR operation on the value of LM102 and the result of the bitwise logical AND operation on the 
value of LM100 and the inverted result of the value of LM101 is 0, then LM200 changes to 0.
The operation is the same as the following ladder diagram.

Script

Operation description
The value of LDR100 is shifted left by only the amount of the value of LDR200 and the result is stored in LDR300.
For example, if the value of LDR100 is 1 and the value of LDR200 is 3, 1 is shifted 3 bits to the left and the result 8 is 
stored in LDR300.

Script

Operation description
The value of LDR100 is shifted right by only the amount of the value of LDR200 and the result is stored in LDR300.
For example, if the value of LDR100 is 8 and the value of LDR200 is 3, 8 is shifted 3 bits to the right and the result 1 
is stored in LDR300.

■ Example 5.5.4 Inversion

[LDR 200] = ~[LDR 100];

■ Example 5.5.5 Inversion

if (([LM 100] & ~ [LM 101]) | [LM 102])
{

SET([LM 200]);
}
else
{

RST([LM 200]);
}

LM100

LM102

LM200LM101

■ Example 5.5.6 Left shift

[LDR 300] = [LDR 100] << [LDR 200];

■ Example 5.5.7 Right shift

[LDR 300] = [LDR 100] >> [LDR 200];
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5.6 Bit Functions

Script

Operation description
Turns LM100 to 1. The result is the same as [LM 100] = 1.

Script

Operation description
Turns LM100 to 0. The result is the same as [LM 100] = 0.

Script

Operation description
Flips LM100 1 and 0. The result is the same as [LM 100] = ~[LM 100].

■ Example 5.6.1 Set a bit

SET([LM 100]);

■ Example 5.6.2 Reset a bit

RST([LM 100]);

■ Example 5.6.3 Invert a bit

REV([LM 100]);
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5.7 Word Functions

● Arithmetic operations

Script

Operation description
Out of the values stored in LDR100, LDR110, LDR120, LDR130, and LDR140, stores the maximum value in LDR200.
Up to 15 arguments can be used.

Script

Operation description
Out of the values stored in LDR100, LDR110, LDR120, LDR130, and LDR140, stores the minimum value in LDR200.
Up to 15 arguments can be used.

Script

Operation description
Calculates the exponential function of the value of D20 and the result is stored in D10.
Only the data type Float32(F) can be used.

Script

Operation description
Calculates the natural logarithm of the value of D20 and the result is stored in D10.
Only the data type Float32(F) can be used.

Script

Operation description
Calculates the logarithm of the value of D20 with 10 as the base and the result is stored in D10.
Only the data type Float32(F) can be used.

Script

Operation description
Calculates the power of a value.
For example, when the value of D20 is 10 and the value of D30 is 5, the function calculates 10 to the power of 5 and 
stores the result in D10.
Only the data type Float32(F) can be used.

■ Example 5.7.1 Maximum value

[LDR 200] = MAX([LDR 100], [LDR 110], [LDR 120], [LDR 130], [LDR 140]);

■ Example 5.7.2 Minimum value

[LDR 200] = MIN([LDR 100], [LDR 110], [LDR 120], [LDR 130], [LDR 140]);

■ Example 5.7.3 Exponential function

[D 10] = EXP([D 20]);

■ Example 5.7.4 Natural logarithm

[D 10] = LOGE([D 20]);

■ Example 5.7.5 Common logarithm

[D 10] = LOG10([D 20]);

■ Example 5.7.6 Power

[D 10] = POW([D 20],[D 30]);
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Script

Operation description
Calculates the square root of the value of [D 20] and the result is stored in [D 10].
Only the data type Float32(F) can be used.

Script

Operation description
Calculates the sine of the radian value of D20 and stores the result in D10.
Only the data type Float32(F) can be used.

Script

Operation description
Calculates the cosine of the radian value of D20 and stores the result in D10.
Only the data type Float32(F) can be used.

Script

Operation description
Calculates the tangent of the radian value of D20 and stores the result in D10.
Only the data type Float32(F) can be used.

Script

Operation description
Calculates the arcsine of the value of D20 and stores the result as radians in D10.
Only the data type Float32(F) can be used.

Script

Operation description
Calculates the arccosine of the value of D20 and stores the result as radians in D10.
Only the data type Float32(F) can be used.

■ Example 5.7.7 Square root

[D 10] = ROOT([D 20]);

■ Example 5.7.8 Sine

[D 10] = SIN([D 20]);

■ Example 5.7.9 Cosine

[D 10] = COS([D 20]);

■ Example 5.7.10 Tangent

[D 10] = TAN([D 20]);

■ Example 5.7.11 Arcsine

[D 10] = ASIN([D 20]);

■ Example 5.7.12 Arccosine

[D 10] = ACOS([D 20]);
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Script

Operation description
Calculates the arctangent of the value of D20 and stores the result as radians in D10.
Only the data type Float32(F) can be used.

Script

Operation description
Converts the value of D20 from degrees (°) to radians and stores the result in D10.
Only the data type Float32(F) can be used.

Script

Operation description
Converts the value of D20 from radians to  degrees (°) and stores the result in D10.
Only the data type Float32(F) can be used.

■ Example 5.7.13 Arctangent

[D 10] = ATAN([D 20]);

■ Example 5.7.14 Convert angle to radians

[D 10] = RAD([D 20]);

■ Example 5.7.15 Convert radians to angle

[D 10] = DEG([D 20]);
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● Data type conversions

Script

Operation description
Converts the BCD value in LDR100 to a binary value and stores it in LDR200.
For example, if the BCD value 10 (16 as a binary value) is stored in LDR100, 10 (binary value) is stored in LDR200.

Script

Operation description
Converts the binary value in LDR100 to a BCD value and stores it in LDR200.
For example, if the binary value 16 (10 as a BCD value) is stored in LDR100, 16 (BCD value) is stored in LDR200.

Script

Operation description
Converts the floating point value in LDR100 to a binary value and stores it in LDR200.
For example, if the floating point value 1234 (0x449A4000 as a binary value) is stored in LDR100, 1234 (binary value) 
is stored in LDR200. If the floating point value 1234.56 (0x449A51EC as a binary value) is stored in LDR100, the value 
after the decimal point is discarded and 1234 (binary value) is stored in LDR200.

Script

Operation description
Converts the binary value in LDR100 to a floating point value and stores it in LDR200.
For example, if the binary value 1234 is stored in LDR100, the floating point value 1234 (0x449A4000 as a binary 
value) is stored in LDR200.

■ Example 5.7.16 Convert BCD to binary

[LDR 200] = BCD2BIN([LDR 100]);

■ Example 5.7.17 Convert binary to BCD

[LDR 200] = BIN2BCD([LDR 100]);

■ Example 5.7.18 Convert floating point to binary

[LDR 200] = FLOAT2BIN([LDR 100]);

■ Example 5.7.19 Convert binary to floating point

[LDR 200] = BIN2FLOAT([LDR 100]);
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Operation description
Converts the decimal numeric value in LDR200 to a string and stores it in order with LDR100 as the starting address number.

Converting 1234 (when the data type is UBIN16(W))

Converting -12345 (when the data type is BIN16(I))

Converting 1234567890 (when the data type is UBIN32(D))

Converting -1234567890 (when the data type is BIN32(L))

■ Example 5.7.20 Convert decimal to string

DEC2ASCII([LDR 100], [LDR 200]);

• This function can be used with data types UBIN16(W), BIN16(I), UBIN32(D), BIN32(L), BCD4(B), and 
BCD8(EB).

• Only internal devices can be used.
• When using functions that handle strings, check the Storage Method of string data setting on the 

System tab in the Project Settings dialog box. Depending on the setting, the upper and lower bytes 
are stored in the reverse of the following explanation.
For details, refer to Chapter 4 “3.1 System Tab” on page 4-25.

• A NULL terminating character (0x00) is added to the end of the string.

Device address
Stored value

Device address Stored value Upper byte Lower byte
23x0 = '2'13x0 = '1'LDR1004321LDR200

LDR101             '3' = 0x33 '4' = 0x34
LDR102                 0x00 0x00

Terminating characterTerminating character

Device address
Stored value

Device address Stored value Upper byte Lower byte
13x0 = '1'D2x0 = '-' LDR10054321-LDR200

LDR101 '2' = 0x32 '3' = 0x33
LDR102 '4' = 0x34 '5' = 0x35
LDR103                 0x00 0x00

Terminating character

Device address
Stored value

Device address Stored value Upper byte Lower byte
LDR200
LDR201

1234567890
LDR100 '1' = 0x31 '2' = 0x32

43x0 = '4'33x0 = '3'LDR101
LDR102 '5' = 0x35 '6' = 0x36
LDR103 '7' = 0x37 '8' = 0x38
LDR104 '9' = 0x39 '0' = 0x30
LDR105                 0x00 0x00

Terminating characterTerminating character

Device address
Stored value

Device address Stored value Upper byte Lower byte
LDR200

-1234567890
LDR100 '-' = 0x2D '1' = 0x31

33x0 = '3'23x0 = '2'LDR101LDR201
LDR102 '4' = 0x34 '5' = 0x35
LDR103 '6' = 0x36 '7' = 0x37
LDR104 '8' = 0x38 '9' = 0x39
LDR105 '0' = 0x30 0x00

Terminating characterTerminating character
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Operation description
Converts the stored string starting at LDR200 to a decimal and stores the result in LDR100.
The number of digits that can be converted is the maximum number of digits for each data type with added sign.
If the string to convert contains NULL or characters that cannot be converted to numeric values, the string is 
converted up to that character.

Setting the string “1234” (when the data type is UBIN16(W))

Setting the string “1234567” (when the data type is UBIN16(W))

Setting the string “-12345” (when the data type is BIN16(I))

String “1234567890” (when the data type is UBIN32(D))

■ Example 5.7.21 Convert string to decimal

[LDR 100] = ASCII2DEC([LDR 200]);

• This function can be used with data types UBIN16(W), BIN16(I), UBIN32(D), BIN32(L), BCD4(B), and 
BCD8(EB).

• Only internal devices can be used.
• When using functions that handle strings, check the Storage Method of string data setting on the 

System tab in the Project Settings dialog box. Depending on the setting, the upper and lower bytes 
are stored in the reverse of the following explanation.
For details, refer to Chapter 4 “3.1 System Tab” on page 4-25.

Device address
Stored value

Upper byte Lower byte Device address Stored value
4321LDR10023x0 = '2'13x0 = '1'LDR200

LDR201 '3' = 0x33 '4' = 0x34
LDR202                 0x00 0x00

Terminating characterTerminating character

Device address
Stored value

Upper byte Lower byte Device address Stored value
54321LDR10023x0 = '2'13x0 = '1'LDR200

LDR201 '3' = 0x33 '4' = 0x34
LDR202 '5' = 0x35 '6' = 0x36
LDR203 '7' = 0x37 0x00

Terminating characterTerminating character

Device address
Stored value

Upper byte Lower byte Device address Stored value
54321-LDR10013x0 = '1'D2x0 = '-'LDR200

LDR201 '2' = 0x32 '3' = 0x33
LDR202 '4' = 0x34 '5' = 0x35
LDR203                 0x00 0x00

Terminating characterTerminating character

Device address
Stored value

Upper byte Lower byte Device address Stored value
0987654321LDR100 - 10123x0 = '2'13x0 = '1'LDR200

LDR201 '3' = 0x33 '4' = 0x34
LDR202 '5' = 0x35 '6' = 0x36
LDR203 '7' = 0x37 '8' = 0x38
LDR204 '9' = 0x39 '0' = 0x30
LDR205                 0x00 0x00

Terminating characterTerminating character
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● Data comparison and copying

Script

Operation description
Compares the value of 10 words from LDR100 (up to LDR109) with the value of 10 words from LDR200 (up to 
LDR209).
If the value for each is entirely equal, 1 is stored in LDR0. If even a single one is not equal, 0 is stored.

Script

Operation description
Compares the third bit of LDR100 through the third bit of LDR109 with the state of the bits from LM0 to LM9.
If the value for each is entirely equal, 1 is stored in LDR0. If even a single one is not equal, 0 is stored.

■ Example 5.7.22 Word-unit data comparison

[LDR 0] = MEMCMP([LDR 100], [LDR 200], 10);

LDR100
LDR101
LDR102

LDR108
LDR109

LDR200
LDR201
LDR202

LDR208
LDR209

Compare each

LDR107 LDR207

Even if the data type is set to UBIN32(D), BIN32(L), BCD8(EB), or Float32(F), the comparison is performed 
from the start device address in word units.

■ Example 5.7.23 Bit-unit data comparison

[LDR 0] = MEMCMP([LDR 100-2], [LM 0], 10);

3rd bit of LDR100
3rd bit of LDR101
3rd bit of LDR102

3rd bit of LDR108
3rd bit of LDR109

LM0
LM1
LM2

LM8
LM9

Compare each

3rd bit of LDR107 LM7

Even if the data type is set to UBIN32(D), BIN32(L), BCD8(EB), or Float32(F), the comparison is performed 
from the start device address in bit units.
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Operation description
Copies the value of 10 word device addresses from LDR200 (up to LDR209) to 10 word device addresses from 
LDR100 (up to LDR109).

Script

Operation description
Copies the third bit of 10 words from LDR100 (up to LDR109) to the bit state for 10 of device addresses from LM0 (up to 
LM9).

■ Example 5.7.24 Word-unit data copy

MEMCPY([LDR 100], [LDR 200], 10);

LDR100
LDR101
LDR102

LDR108
LDR109

LDR200
LDR201
LDR202

LDR208
LDR209

Copy each

LDR107 LDR207

Even if the data type is set to UBIN32(D), BIN32(L), BCD8(EB), or Float32(F), the data is copied from the 
start device address in word units.

■ Example 5.7.25 Bit-unit data copy

MEMCPY([LM 0], [LDR 100-2], 10);

3rd bit of LDR100
3rd bit of LDR101
3rd bit of LDR102

3rd bit of LDR108
3rd bit of LDR109

LM0
LM1
LM2

LM8
LM9

3rd bit of LDR107LM7

Copy each

Even if the data type is set to UBIN32(D), BIN32(L), BCD8(EB), or Float32(F), the bits are copied from the 
start device address in bit units.



WindO/I-NV4 User’s Manual 20-51

5 Script Coding Examples

20

Script

● String operations
When using functions that handle string data, check the Storage Method of string data setting in the project 
settings.
For details, refer to Chapter 4 “3.1 System Tab” on page 4-25.

Script

Operation description
Stores in order from LDR100 character count 3 (3 characters worth) from start position 2 (starting from 0, so the 3rd 
character) of the string “ABCDEFG” that starts from LDR200.

Copy from string “ABCDEFG” at start position 2, character count 3

Script

Copy from string “ABCDEFG” at start position 1, character count 4

■ Example 5.7.26 Copy a string

STRCUT([LDR 100], [LDR 200], 2, 3);

The start position can be specified in the range from 0 to 127, the character count can be specified in the 
range from 1 to 128.

STRCUT([LDR 100], [LDR 200], 1, 4);

Device address Stored value Start 
position Character count Device address Stored value

LDR200
Upper byte 'A' = 0x41 0

LDR100
Upper byte 'C' = 0x43

Lower byte 'B' = 0x42 1 Lower byte 'D' = 0x44

LDR201
Upper byte 'C' = 0x43 ←2

LDR101
Upper byte 'E' = 0x45

Lower byte 'D' = 0x44 3 Lower byte 0x00 Terminating character

LDR202
Upper byte 'E' = 0x45 4

Lower byte 'F' = 0x46 5

LDR203
Upper byte 'G' = 0x47 :

Lower byte 0x00 Terminating character

3 characters

Device address Stored value Start 
position Character count Device address Stored value

LDR200
Upper byte 'A' = 0x41 0

LDR100
Upper byte 'B' = 0x42

Lower byte 'B' = 0x42 ←1 Lower byte 'C' = 0x43

LDR201
Upper byte 'C' = 0x43 ←2

LDR101
Upper byte 'D' = 0x44

Lower byte 'D' = 0x44 3 Lower byte 'E' = 0x45

LDR202
Upper byte 'E' = 0x45 4

LDR102
Upper byte 0x00 Terminating character

Lower byte 'F' = 0x46 5 Lower byte 0x00

LDR203
Upper byte 'G' = 0x47 :

Lower byte 0x00 Terminating character

4 characters
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Operation description
Finds the length (character count) of the string starting from LDR200 and stores that in LDR100.

■ Example 5.7.27 Count a string

[LDR 100] = STRLEN([LDR 200]);

• The only device addresses that can be specified as function arguments in string operations are internal 
devices.

• The NULL terminating character (0x00) is the end of the string. (The terminating character is not included 
in the string length.)

Device address   Stored value Device address Stored value

LDR200
Upper byte 'A' = 0x41

LDR100 7
Lower byte 'B' = 0x42

LDR201
Upper byte 'C' = 0x43

Lower byte 'D' = 0x44

LDR202
Upper byte 'E' = 0x45

Lower byte 'F' = 0x46

LDR203
Upper byte 'G' = 0x47

Lower byte 0x00

Device address Stored value Device address Stored value

LDR200
Upper byte 'A' = 0x41

LDR100 3
Lower byte 'B' = 0x42

LDR201
Upper byte 'C' = 0x43

Lower byte 0x00

LDR202
Upper byte 'E' = 0x45

Lower byte 'F' = 0x46

LDR203
Upper byte 'G' = 0x47

Lower byte 0x00

Character 
count

Terminating character

Character 
count

Terminating character
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Operation description
Concatenates the string starting from LDR200 to the string starting from LDR100.

■ Example 5.7.28 Concatenate strings

STRCAT([LDR 100], [LDR 200]);

• The only device addresses that can be specified as function arguments in string operations are internal 
devices.

• The NULL terminating character (0x00) is the end of the string. (The terminating character is not included 
in the string length.)

Device address Stored value Device address Stored value

LDR100
Upper byte 'A' = 0x41

LDR100
Upper byte 'A' = 0x41

Lower byte 'B' = 0x42 Lower byte 'B' = 0x42

LDR101
Upper byte 'C' = 0x43

LDR101
Upper byte 'C' = 0x43

Lower byte 0x00 Lower byte 'D' = 0x44

LDR102
Upper byte 'E' = 0x45

Device address Stored value Lower byte 'F' = 0x46

LDR200
Upper byte 'D' = 0x44

LDR103
Upper byte 'G' = 0x47

Lower byte 'E' = 0x45 Lower byte 0x00 Terminating character

LDR201
Upper byte 'F' = 0x46

Lower byte 'G' = 0x47

LDR202
Upper byte 0x00

Lower byte 0x00

Concatenate
Terminating 
character

Terminating character



5 Script Coding Examples

20-54 WindO/I-NV4 User’s Manual

Script

Operation description
Searches for the search string “DEFG” that starts from LDR200 in the string to be searched “ABCDEFGHIJKLMNO” that 
starts from LDR100 and stores the position of the occurrence of the string in LDR0. If not found, -1 is stored in LDR0.

If “?” is specified as a character to search for, it is handled as an arbitrary single-byte character.
When specifying “?” (0x3F) as a character, specify it as “~?” (0x7E3F) in two bytes.
When specifying “~” (0x7E) as a character, specify it as “~~” (0x7E7E) in two bytes.

When searching for “DEFG” and the string was found

When searching for “WXYZ” and the string was not found

■ Example 5.7.29 Search a string

[LDR 0] = STRSTR([LDR 100], [LDR 200]);

• The maximum number for the search string is 128 characters.
• The only device addresses that can be specified in all arguments are internal devices.

tluser hcraeSdehcraes eb ot gnirtSgnirts hcraeS
Device address Stored value Device address Stored value Device address Stored value

LDR200
Upper byte 'D' = 0x44

LDR100
Upper byte 'A' = 0x41 0

LDR0 3
Lower byte 'E' = 0x45 Lower byte 'B' = 0x42 1

LDR201
Upper byte 'F' = 0x46

LDR101
Upper byte 'C' = 0x43 2

Lower byte 'G' = 0x47 Lower byte 'D' = 0x44 ←3

LDR202
Upper byte 0x00 Terminating 

character LDR102
Upper byte 'E' = 0x45 4

Lower byte 0x00 Lower byte 'F' = 0x46 5

LDR103
Upper byte 'G' = 0x47 6
Lower byte 'H' = 0x48 7

LDR104
Upper byte 'I' = 0x49 8
Lower byte 'J' = 0x4A 9

LDR105
Upper byte 'K' = 0x47 10
Lower byte 'L' = 0x4C 11

LDR106
Upper byte 'M' = 0x4D 12
Lower byte 'N' = 0x4E 13

LDR107
Upper byte 'O' = 0x4F 14
Lower byte 0x00 Terminating character

Position

Search string String to be searched Search result
Device address Stored value Device address Stored value Device address Stored value

LDR200
Upper byte 'W' = 0x57

LDR100
Upper byte 'A' = 0x41 0

LDR0 -1
Lower byte 'X' = 0x58 Lower byte 'B' = 0x42 1

LDR201
Upper byte 'Y' = 0x59

LDR101
Upper byte 'C' = 0x43 2

Lower byte 'Z' = 0x5A Lower byte 'D' = 0x44 3

LDR202
Upper byte 0x00 Terminating 

character LDR102
Upper byte 'E' = 0x45 4

Lower byte 0x00 Lower byte 'F' = 0x46 5

LDR103
Upper byte 'G' = 0x47 6
Lower byte 'H' = 0x48 7

LDR104
Upper byte 'I' = 0x49 8
Lower byte 'J' = 0x4A 9

LDR105
Upper byte 'K' = 0x47 10
Lower byte 'L' = 0x4C 11

LDR106
Upper byte 'M' = 0x4D 12
Lower byte 'N' = 0x4E 13

LDR107
Upper byte 'O' = 0x4F 14
Lower byte 0x00 Terminating character

Position



WindO/I-NV4 User’s Manual 20-55

5 Script Coding Examples

20

Script

When searching for “?” as an arbitrary single-byte character

When searching for “?” as a character

When searching for “~” as a character

tluser hcraeSdehcraes eb ot gnirtSgnirts hcraeS
Device address Stored value Device address Stored value Position Stored value

LDR200
Upper byte 'E' = 0x45

LDR100
Upper byte 'A' = 0x41 0

LDR0 4
Lower byte '?' = 0x3F Lower byte 'B' = 0x42 1

LDR201
Upper byte 'G' = 0x47

LDR101
Upper byte 'C' = 0x43 2

Lower byte 'H' = 0x48 Lower byte 'D' = 0x44 3

LDR202
Upper byte 0x00 Terminating 

character LDR102
Upper byte 'E' = 0x45 ←4

Lower byte 0x00 Lower byte 'F' = 0x46 5

LDR103
Upper byte 'G' = 0x47 6
Lower byte 'H' = 0x48 7

LDR104
Upper byte 'I' = 0x49 8
Lower byte 'J' = 0x4A 9

LDR105
Upper byte 'K' = 0x47 10
Lower byte 'L' = 0x4C 11

LDR106
Upper byte 'M' = 0x4D 12
Lower byte 'N' = 0x4E 13

LDR107
Upper byte 'O' = 0x4F 14
Lower byte 0x00 Terminating character

Device address

tluser hcraeSdehcraes eb ot gnirtSgnirts hcraeS
Device address Stored value Device address Stored value Position Stored value

LDR200
Upper byte 'E' = 0x45

LDR100
Upper byte 'A' = 0x41 0

LDR0 4
Lower byte '~' = 0x7E Lower byte 'B' = 0x42 1

LDR201
Upper byte '?' = 0x3F

LDR101
Upper byte 'C' = 0x43 2

Lower byte 'G' = 0x47 Lower byte 'D' = 0x44 3

LDR202
Upper byte 'H' = 0x48

LDR102
Upper byte 'E' = 0x45 ←4

Lower byte 0x00 Terminating 
character Lower byte '?' = 0x3F 5

LDR103
Upper byte 'G' = 0x47 6
Lower byte 'H' = 0x48 7

LDR104
Upper byte 'I' = 0x49 8
Lower byte 'J' = 0x4A 9

LDR105
Upper byte 'K' = 0x47 10
Lower byte 'L' = 0x4C 11

LDR106
Upper byte 'M' = 0x4D 12
Lower byte 'N' = 0x4E 13

LDR107
Upper byte 'O' = 0x4F 14
Lower byte 0x00 Terminating character

Device address

tluser hcraeSdehcraes eb ot gnirtSgnirts hcraeS
Stored value Stored value Position Stored value

LDR200
Upper byte 'E' = 0x45 Upper byte 'A' = 0x41 0

LDR0 4
Lower byte '~' = 0x7E Lower byte 'B' = 0x42 1

LDR201
Upper byte '~' = 0x7E Upper byte 'C' = 0x43 2
Lower byte 'G' = 0x47 Lower byte 'D' = 0x44 3

LDR202
Upper byte 'H' = 0x48 Upper byte 'E' = 0x45 ←4
Lower byte 0x00 Terminating 

character Lower byte '~' = 0x7E 5
Upper byte 'G' = 0x47 6
Lower byte 'H' = 0x48 7
Upper byte 'I' = 0x49 8
Lower byte 'J' = 0x4A 9
Upper byte 'K' = 0x47 10
Lower byte 'L' = 0x4C 11
Upper byte 'M' = 0x4D 12
Lower byte 'N' = 0x4E 13
Upper byte 'O' = 0x4F 14
Lower byte 0x00 Terminating character

Device address Device address Device address

LDR100

LDR101

LDR102

LDR103

LDR104

LDR105

LDR106

LDR107
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● Drawing

Script

Operation description
Draws a line connecting the start coordinates X=20, Y=20 and the end coordinates X=60, Y=60 on the screen where 
the script is running. The line has a line width of 3 (3 pixels), line type of 1 (solid line), and line color of 20 (red).

Script

Operation description
Draws a line connecting the start coordinates X=0, Y=0 and the end coordinates X=150, Y=100 on the screen where 
the script is running. The line width, line type, and line color have been omitted, so the line's line width is 1 (1 pixel), 
the line type is 1 (solid line), and the line color is 255 (white).

Script

Operation description
Draws a rectangle with the start coordinates (the coordinates of the rectangle's upper-left corner) X=20, Y=20 and 
the end coordinates (the coordinates of the rectangle's lower-right corner) X=100, Y=60 on the screen where the 
script is running. The rectangle's line width is 1 (1 pixel), line type is 2 (dotted line), foreground color is 24 (green), 
background color is 22 (yellow), pattern is 13 (tint), rounding type is 2 (curve), and rounding radius is 5 (5 pixels).

Script

Operation description
Draws a rectangle with the start coordinates (the coordinates of the rectangle's upper-left corner) X=0, Y=0 and the end 
coordinates (the coordinates of the rectangle's lower-right corner) X=150, Y=100 on the screen where the script is 
running. The line width, line type, foreground color, background color, pattern, rounding type, and rounding radius are 
omitted, so the rectangle's line width is 1 (1 pixel), line type is 1 (solid line), foreground color and background color is 
255 (white), pattern is 0 (none), rounding type is 0 (none), and rounding radius is 0 (0 pixels).

Script

Operation description
Draws a circle with the center coordinate X=100, Y=100, the X-axis radius 60 pixels, and the Y-axis radius 60 pixels. 
The circle's line width is 1 (1 pixel), line type is 2 (dotted line), foreground color is 26 (light blue), background color is 
0 (black), and pattern is 4 (foreground 50%).

Script

Operation description
Draws an ellipse with the center coordinate X=100, Y=100, the X-axis radius 80 pixels, and the Y-axis radius 40 pixels. 
The line width, line type, foreground color, background color, and pattern are omitted, so the ellipse's line width is 1 (1 
pixel), line type is 1 (solid line), foreground color and background color is 255 (white), and pattern is 0 (none).

■ Example 5.7.30 Draw a line

LINE(20, 20, 60, 60, 3, 1, 20);

■ Example 5.7.31 Draw a line (omitting arguments)

LINE(0, 0, 150, 100);

■ Example 5.7.32 Draw a rectangle

RECTANGLE(20, 20, 100, 60, 1, 2, 24, 22, 13, 2, 5);

■ Example 5.7.33 Draw a rectangle (omitting arguments)

RECTANGLE(0, 0, 150, 100);

■ Example 5.7.34 Draw a circle or ellipse

CIRCLE(100, 100, 60, 60, 1, 2, 26, 0, 4);

■ Example 5.7.35 Draw a circle or ellipse (omitting arguments)

CIRCLE(100, 100, 80, 40);
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● Indirect assignment

Script

Operation description
When the value of D20 is 8, the value of LDR18, the device address 8 words from LDR10, is read and stored in 
LDR200.

Script

Operation description
When the value of D20 is 3, the constant 1234 is stored in LDR13, the device address 3 words from LDR10.

■ Example 5.7.36 Indirect read

[LDR 200] = OFFSET([LDR 10],[D 20]);

Read

0000LDR10 0008D20

+8

1234LDR181234LDR200

■ Example 5.7.37 Indirect write

OFFSET([LDR 10],[D 20]) = 1234;

Write

0000LDR10 0003D20

+3

1234LDR131234
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This section describes important notes when defining a script.

6.1 Important Notes Regarding the While Definition

■ Define so it will not go into an infinite loop.
The execution expression is repeatedly executed while the conditional expression is satisfied.
However, it will go into an infinite loop when the conditional expression is satisfied continually.

In the conditional expression of the while definition, it states to exit the loop when the value of LDR100 turns 0. However, the 
value stored in the LDR100 is not changed after storing 10 in the first line of the script, so it will go into an infinite loop.

When using the while definition, define it so it will not go into an infinite loop.
The value of LDR100 will become 0 when the while definition is repeated 10 times in the next example, and it will get 
out of the while definition.

■ Define it so it will not continue the process for longer than the time limit.
When the processing of a single script continues for more than the time limit due to a while definition, etc., an 
execution time over error occurs and that script will be halted. Define the script so the execution time for one script 
does not exceed 3,000 milliseconds.
For details, refer to “1.4 Script Error” on page 20-4.

■ Do not write into the external device address.
When it is written into an external device address in the while definition, a script error will occur.

6.2 Number of Device Addresses That Can Be Used
The number of external device addresses that can be used in the script are as follows:

6 Important Notes

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

[LDR 100] = 10;

while (0 != [LDR 100])
{

[LDR 200] = [LDR 200] + 1;
} 

[LDR 100] = 10;

while (0 != [LDR 100])
{

[LDR 200] = [LDR 200] + 1;
[LDR 100] = [LDR 100] - 1;

}

Item Number of devices

Destination external device addresses 64 max.

Source external device addresses 64 max.

• The maximum number of source external device addresses which can be used as a trigger condition and 
in scripts executed as Grobal Script is 256.

• When the total number of write data to an external device address exceeds 64 in a single script while 
executing a script with MICRO/I, that script will be halted with an error.
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6.3 About the Priority of the Operator

As a basic rule, operators are calculated in order from left of the line, but when multiple calculations are combined, 
they are calculated in following priority.

Priority Operator

High ()

! ~ -(Negative number)

* / %

+ -(Subtraction)

<< >>

&

^

|

< <= > >=

== !=

&&

||

Low =
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This chapter describes the setup for the sound function and related MICRO/I operations.

  

1.1 Overview - How the Sound Function is Used

MICRO/Is that have an audio interface (AUDIO OUT) can be connected to external speakers with built-in amplifiers 
and use the following functions.

• Play a sound file when an arbitrary Device Address changes to 1

• Play a sound file when the screen is pressed instead of a beep

1.2 Supported Sound Files

Sound files that meet the following specifications can be played with MICRO/I:

Chapter 21 Sound Function

1 Function and Settings

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

LM0000

LM0000

0

1
MICRO/I

HG4G HG3G
HG5G-V HG4G-V HG3G-V

MICRO/I

HG4G HG3G
HG5G-V HG4G-V HG3G-V

Item Description

File format WAVE file (*.WAV)

Data format PCM

Sampling rate 8000, 11025, 12000, 16000, 24000, 22050, 32000, 44100 Hz

Quantization bit rate 16-bit

Audio type Mono or stereo

File size Max. 512 kB
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This section describes the configuration procedure for the Sound function.

2.1 Configuring Sound Files & Trigger Conditions

● To play a sound file when a value of device address changes from 0 to 1

1 On the Configuration tab, in the System Setup group, click Sound.
The Sound Settings dialog box is displayed.

2 Double-click the cell in the File Name column to register a sound file.
The Open dialog box is displayed.

3 Specify the sound file to register and click Open.

2 Sound Function Configuration Procedure

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P
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4 Double click the cell under Save To and select the save destination for the sound file.

■ Int. Memory
Saves the sound file to internal memory.

■ External Memory Device
Saves the sound file to external memory device inserted in the MICRO/I. The external memory device to be saved is 
the SD memory card.

5 Double click the cell under Trigger Condition and select Device Address.

6 Specify the device address that will trigger playing the sound file in Trigger Device Address.

Double-click the cell or click the cell and then click  in the Trigger Device Address column to select a device 
address from the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device Address 
Settings” on page 2-68.

7 Configure Repeat, Change Volume Level, and any other options, and then click OK.

The Sound Settings dialog box closes.
This concludes the configuration to play a sound file when a value of device address changes to 1.

● To play a sound file as a touch sound instead of a beep.

1 On the Configuration tab, in the System Setup group, click Sound.
The Sound Settings dialog box is displayed.

2 Double-click the cell in the File Name column to register a sound file.
The Open dialog box is displayed.

The procedures to save the sound file to the external memory device are as follows.
• On the Home tab, click the arrow under Download, and click Project Data to display the Download 

dialog box. Select the Sound Files check box of Download following files to External Memory 
Device, and click OK.

• On the Home tab, click the arrow under Download, and click Files to External Memory Device to 
display the Open dialog box. Specify a sound file and click Open.
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3 Specify the sound file to register and click Open.

4 Double click the cell under Save To and select the save destination for the sound file.

■ Int. Memory
Saves the sound file to internal memory.

■ External Memory Device
Saves the sound file to external memory device inserted in the MICRO/I. The external memory device to be saved is 
the SD memory card.

5 Double click the cell under Trigger Condition and select None.

6 Click OK.

The Sound Settings dialog box closes.

7 On the Configuration tab, in the System Setup group, click Project.

The Project Settings dialog box is displayed.

The procedures to save the sound file to the external memory device are as follows.
• On the Home tab, click the arrow under Download, and click Project Data to display the Download 

dialog box. Select the Sound Files check box of Download following files to External Memory 
Device, and click OK.

• On the Home tab, click the arrow under Download, and click Files to External Memory Device to 
display the Open dialog box. Specify a sound file and click Open.
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8 Select the Enable Touch Sound check box.

9 Select Sound File and specify the ID of the sound file to play in Sound ID.

Enter a sound ID number or click  to specify the sound ID number with the displayed Sound Settings dialog box.

10 Click the OK button.

The Sound Settings dialog box closes.
This concludes the configuration to play a sound file as the touch sound.
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This section describes items and buttons in the Sound Settings dialog box.

3.1 Sound Settings Dialog Box

All the sound files used with the MICRO/I and their trigger conditions are managed in the Sound Settings dialog box.

■  (Copy)

Select an ID and click the  button to copy the contents of that row to the clipboard.

■  (Paste)

Select an ID and click the  button to paste the contents of the clipboard to that row.

■  (Delete)

Select an ID and click the  button to delete the contents of that row.

■  (Sound file play)

Select an ID and click the  button to play that row's sound file.

■  (Sound file stop)
Stops playing the sound file.

3 Sound Settings Dialog Box

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

For HMI Special Data Register and HMI Special Internal Relay related to the sound function, refer to Chapter 
33 “Internal Devices” on page 33-1.

(Settings)

If the contents of multiple IDs are on the clipboard, the contents are pasted in ascending order from the 
initially selected ID.
Pasting stops when the ID reaches 1024.

If you select multiple IDs, only the sound file of the first selected ID will play. The sound files will not play 
continuously.
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■ (Settings)
Displays a list of the settings for sound files used by MICRO/I.

■ Edit
Edit the settings of the selected ID.
Select an ID and click this button to display the Individual Settings dialog box. The settings that configure in the 
Individual Settings dialog box are applied to the selected ID only. For details, refer to “Individual Settings Dialog Box” 
on page 21-8.

■ Up
Shifts the selected settings upward in the list.

■ Down
Shifts the selected settings downward in the list.

You can edit the (Settings) cell by using the right click menu.

ID: Shows the sound ID (1 to 1024) of the sound file to play.
Double clicking the cell displays the Individual Settings dialog box. For details, refer to “Individual 
Settings Dialog Box” on page 21-8.

To select multiple IDs, press and hold SHIFT or CTRL while you click the specific items. 

Multiple IDs cannot be selected when the Sound Settings dialog box has been displayed by clicking  in 
Sound ID on the Project Settings dialog box.

File Name: Shows the sound file name that was set.
Double clicking the cell displays the Open dialog box. Then specify a sound file with the 
Open dialog box.

If the specified sound file does not exist, the file name will appear in red.

Save To: Select the location to save the sound file to as Int. Memory or External Memory Device.
Double click the cell to change. The external memory device to be saved is the SD memory 
card.

Trigger Condition: Select Device Address or None for the condition to play the sound file.
Double click the cell to change.

Device Address: Plays the sound file according to the value of device address.

None: Select when playing a sound file as a touch sound.

Trigger Device Address: When Trigger Condition is Device Address, specify the Device Address that will be used 
as the condition to play the sound file.

Double-click the cell or click the cell and then click  in the Trigger Device Address 
column to select a device address from the Tag Editor. For the device address configuration 
procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-68.
The address cannot be specified when Trigger Condition is None.

The maximum number of external device addresses that can be used as trigger device addresses is 128. 
However, when the bit numbers of a word device are specified, if those bits are in the same word device, it 
counts as one device even when multiple bits are used.

Repeat: Select this check box to play the sound file repeatedly. The file will play repeatedly until the Trigger 
Condition is no longer met.
When this check box is cleared, the file only plays once.

To edit the settings of multiple IDs at once, press and hold SHIFT or CTRL while you click the specific rows, 
and then click Edit. The settings configured in the Individual Settings dialog box are applied to all 
selected IDs.



3 Sound Settings Dialog Box

21-8 WindO/I-NV4 User’s Manual

■ Change Volume Level
Adjust the volume (0 to 31) of the sound file played by the MICRO/I.
The volume changes according to the value of the specified Device Address.
The sound is muted when the Device Address value is 0, and the volume is maximum when the value is 31 or out of range.

Enter the Device Address in the text box or click  to specify the address in the displayed Tag Editor. For the device 
address configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-68.

■ Enable Mute
Mute the volume of the sound file played by the MICRO/I.
When the value of the specified Device Address is 1, the sound is muted.
When the sound is muted while a sound file is playing, it continues playing without making a sound.

Enter the Device Address in the text box or click  to specify the address in the displayed Tag Editor. For the device 
address configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-68.

● Individual Settings Dialog Box
Register or change the settings of the selected ID.

■ ID
Shows the Sound ID (1 to 1024) of the sound file to be played.
If the Individual Settings dialog box is opened with multiple IDs selected in Settings, ID number will not be 
displayed. 

■ File Name
Specify the sound file.

Click the  button to display the Open dialog box. Then specify a sound file with the Open dialog box. 

If the Individual Settings dialog box is opened with multiple IDs selected in Settings, File Name will not be 
displayed.

■ Save To
Select the location to save the sound file to as Internal Memory or External Memory Device.
The file is saved on an SD memory card if External Memory Device is selected.
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■ Trigger Condition
Select None or Device Address for the condition for playing the sound file.

● Exporting sound files
The sound file can be exported by the steps below.

1 Select and right-click the ID of the sound file to be exported, and click Export Sound Files.

The Browse For Folder dialog box is displayed.

2 Specify a save location and click OK.

None: Select to play the sound file as a touch sound.

Device Address: Play the sound file according to the value of device address.

(Trigger Device Address): Specify the device address that will be the condition for playing 

the sound file. Click  to display Tag Editor and specify the 
device address. For the device address configuration 
procedure, refer to Chapter 2 “5.1 Device Address Settings” on 
page 2-68.

Repeat: Select this check box to play the sound file repeatedly. The file 
will play repeatedly until the Trigger Condition is no longer met.
When this check box is cleared, the file only plays once.

The maximum number of external device addresses that can be used as trigger device addresses is 128. 
However, when the bit numbers of a word device are specified, if those bits are in the same word device, it 
counts as one device even when multiple bits are used.

The sound file is exported using the current file name.
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The MICRO/I only plays a single sound file at a time. It cannot simultaneously play multiple sound files. Therefore, if 
multiple trigger device addresses simultaneously change to 1 or if a sound file is set as the touch sound, the sound 
file played changes according to the trigger conditions.

■ Touch sound (beep) and sound file by trigger device addresses
The touch sound’s beep and a sound file can be played simultaneously.

■ When touch panel is touched twice (before sound from first touch has finished playing)
For the same touch sound file, the one played later has priority.
If the touch panel is pressed twice (before the sound has finished playing from the first touch), playback of the sound 
file stops and the same sound file plays again from the beginning.

4 Operation

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

Touch Panel

Sound

ON

OFF

Trigger Device Address
1

0

Touch Sound

Sound

Beep

Touch Panel
ON

OFF

Touch Sound Sound

Sound
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■ Touch sound (sound file) and sound file by trigger device address
When both a touch sound file and sound file set by the trigger device address are programmed, the sound file set by 
the trigger device address is given priority.

• As soon as the touch panel is pressed the sound file is played. However, if the trigger device address changes to 1, 
the touch sound file stops and the trigger device address sound file plays.

• If a sound file is playing because it was turned on by a trigger device address, the touch sound file will not play 
even if the touch panel is pressed.

■ Sound file set by 2 triggering device addresses
For sound files set by trigger device addresses, the one played first has priority. If both change to 1 simultaneously, 
the smaller sound ID has priority.

• When multiple trigger device addresses change to 1 simultaneously, the smaller sound ID has priority and the 
sound files play in order.
For example, when playing sound ID1 when trigger device address 1 is 1 and sound ID2 when trigger device 
address 2 is 1, if trigger device address 1 and trigger device address 2 change to 1 simultaneously, sound ID1 
playback starts and after it finishes, if trigger device address 2 is 1, sound ID2 playback starts.

Touch Panel
ON

OFF

Trigger Device Address
1

0

Touch Sound

Sound Sound

Sound

Touch Panel
ON

OFF

Trigger Device Address
1

0

Touch Sound

Sound Sound

Sound

Trigger Device Address 1
1

0

Trigger Device Address 2
1

0

Sound

Sound

Sound ID1

Sound ID2
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• While a sound file is playing, the sound ID for the trigger device address that changed to 1 is put into a queue for 
playback.
For example, when playing sound ID1 when trigger device address 1 is 1 and sound ID2 when trigger device 
address 2 is 1, if trigger device address 2 changes to 1 while sound ID1 is playing, then sound ID2 playback starts 
if trigger device address 2 is 1 when sound ID1 finishes playing.

However, if the trigger device address for sound ID2 is 0 when sound ID1 finishes playing, sound ID2 does not play.

• When the sound ID currently playing is set to Repeat: Enabled, no other sound IDs will play until the trigger 
condition for this sound ID is no longer satisfied.
For example, when playing sound ID1 when trigger device address 1 is 1 and sound ID2 when trigger device 
address 2 is 1, even if sound ID2’s trigger device address changes to 1 while sound ID1 is set to Repeat: Enabled 
and repeatedly playing, sound ID1 playback continues. When sound ID1's trigger device address changes to 0, 
sound ID2 playback starts if trigger device address 2 is 1.

Trigger Device Address 1
1

0

Trigger Device Address 2
1

0

Sound

Sound

Sound ID1

Sound ID2Sound ID2

Trigger Device Address 1
1

0

Trigger Device Address 2
1

0

Sound

Sound

Sound ID1

Sound ID2 Sound ID2

Trigger Device Address 1
1

0

Trigger Device Address 2
1

0

Sound

Sound

Repeat: Enabled

Sound ID1Sound ID1 Sound ID1

Sound ID2 Sound ID2
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This chapter describes how to register and play movie files played on the Video Display, how to save video and audio 
to the external memory device before and after an event occurs, how to play saved video and audio, and how to 
configure the video input.
This function is only supported by models that are equipped with a video interface.

  

1.1 How the Multimedia Function is Used

With its built-in video interface (VIDEO IN/OUT) and audio interface (AUDIO IN*1/OUT), a video camera or 

microphone*1 can be connected to the MICRO/I and used in the following ways. Multimedia function uses the SD 
memory card as the external memory device.

• Register movie files to play with the MICRO/I and play the movie files on the Video Display

• Save video camera images and microphone audio*1 to the external memory device before and after an event occurs.

*1 Recording sound function is for HG4G/3G only
*2 HG5G/4G/3G-V only
*3 This is applicable for HG4G/3G with a video interface only.

Chapter 22 Multimedia Function

1 Function and Settings

HG3G HG2G-5F HG2G-5THG4G HG1GHG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

MICRO/I

Play

Play Stop Back Next

SD memory card

Movie Files
(avi format)

(mp4 format)

Movie File List
(movie.lst)

HG4G HG3G
HG5G-V HG4G-V HG3G-V *2

*3

Video
Camera

Microphone

Images

Audio

MICRO/I

Saves SD memory card

Movie Files

(avi format)
(mp4 format)HG4G HG3G

HG5G-V HG4G-V HG3G-V

Video and audio since the 

recording time before the event 

has passed is discarded

Images and sound to save to the SD memory card

Retained video and audio Record from here

Before event occurs After event occurs

Event Occurs

0 1

*1

*2
*3
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• Configure the video input for the device connected to the MICRO/I

• Input images from two video cameras*2

1.2 Supported Movie Files

Movie files that meet the following specifications can be played with the MICRO/I:

The MICRO/I may not be able to play the formats above correctly depending on the minimum system requirements.
In this situation, shrink the size of the file by lowering the frame rate or the resolution of the file or by lowering the bit 
rate of the audio. If audio is unnecessary, set to a file without sound.

*2 HG5G/4G/3G-V only

Video Camera
Images

MICRO/I

Play Stop Back Next

HG4G HG3G
HG5G-V HG4G-V HG3G-V

Video Camera
Images

Channel 1

Images
Channel 2

MICRO/I

HG5G-V HG4G-V HG3G-V

再生 停止 前へ 次へ

CH1
再生 停止 前へ 次へ

CH2

• The MICRO/I can play movie files, display video, and output audio using the Video Display.
 Chapter 10 “4 Video Display” on page 10-81

• The MICRO/I can record and play video and audio using the key buttons.
 Chapter 8 “Recording Images and Sound” on page 8-101
 Chapter 8 “Playing Recorded Images and Sound” on page 8-104

Item Description

File format
HG5G/4G/3G-V: AVI file (.avi)

HG4G/3G: MP4 file (.mp4)

Movie
HG5G/4G/3G-V: Motion JPEG

HG4G/3G: MPEG-4 Simple Profile

Audio
HG5G/4G/3G-V: PMC (Sampling rate 8000, 11025, 12000, 16000, 24000, 22050, 32000, 44100Hz)

HG4G/3G: AAC-LC (Bit rate 32 kbps or less recommended)

Frame rate 30 fps or less (15 fps or less recommended)

Resolution 720 x 480 dots or less (640 x 480 dots or less recommended)

File size 64 Mbyte or less (32 Mbyte or less recommended)
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This section describes the configuration procedure for the Multimedia function.

2.1 Registering Movie Files

1 On the Configuration tab, in the System Setup group, click Multimedia.

The Multimedia Settings dialog box is displayed.

2 Select the ID to be used to register the movie file in Movie File List on the Movie tab. Click the File Path cell and 
enter the file path of the movie file.

The maximum number is 250 alphanumeric characters.
Example: When specifying the movie file “sample01.mp4” that has been saved to the “MOVIE” folder in the External 

Memory Device folder “HGDATA01”
Enter "sample01".

3 Repeat steps 2 to add all the movie files to play (1 to 64).

4 Click OK.
The Multimedia Settings dialog box closes.
This concludes the configuration to register movie files.

2 Multimedia Function Configuration Procedure

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

To specify in the Open dialog box, double-click the cell or click the cell and click  to open the Open 
dialog box. 
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● Playing a Movie File List on the Video Display

1 Following the procedure in “2.1 Registering Movie Files” on page 22-3, register the movie files to play on the Video 
Display.

2 On the Home tab, in the Parts group, click Data Displays, and then click Video Display.

3 Click a point on the edit screen where you wish to place the Video Display.

4 Double-click the dropped Video Display and the Properties dialog box is displayed.

5 On the General tab, under Action, select Play the Movie File List.

This option plays all the movies registered in Movie File List in the Multimedia Settings dialog box.
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6 In Default ID, specify the ID number (1 to 64) of the movie file to play when the Play button is pressed.

Click  to display the Multimedia Settings dialog box. Select the ID number from the movie file list. The movie 
files registered in the movie file list are played in order from the specified ID number.

7 Click OK.

The Properties of Video Display dialog box closes.
This concludes the configuration to play a movie file list on the Video Display.
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2.2 Configuring the Event Recording Function

1 On the Configuration tab, in the System Setup group, click Multimedia.

The Multimedia Settings dialog box is displayed.

2 Click the Record tab.

3 Select the Use Event Recording check box.

4 Select a recording channel*1 or a recording target*2.

■ Recording Channel*1

Selects Channel 1 or Channel 2 to record a video only (no audio) out of the signals input from the device. 

■ Recording Target*2

In the signals input from the device, select Video and Audio or Video only (No Audio) as the recording target.

5 Specify the bit device that will trigger the start of recording in Trigger Device Address.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.

6 Specify the recording time before and after the event occurs.

■ Recording Time Before Event
With the point in time when the value of device address changes from 0 to 1 as the start point, this setting specifies 
how many seconds to record before the start point (1 to 15 sec.).

■ Recording Time After Event
Specifies the time (1 to 15 sec.) until recording stops from when the value of device address changed from 0 to 1.

7 Click OK.

The Multimedia Settings dialog box closes.
This concludes configuring the Record function.

*1 HG5G/4G/3G-V only
*2 This is applicable for HG4G/3G with a video interface only.
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● Playing Images Recorded with the Event Recording Function
Play the recorded movie file on the Video Display.

Configuration Procedure

1 Create the Video Display to play the recorded images.
On the Home tab, in the Parts group, click Data Displays, and then click Video Display.

2 Click a point on the edit screen where you wish to place the Video Display.

3 Double-click the dropped Video Display and the Properties dialog box is displayed.

4 On the General tab, under Action, select Play a movie or recorded file from the File Screen.

This option selects and plays movie files using the File Screen.
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5 Click OK.

The Properties of Video Display dialog box closes.

6 Create a button to open the screen to select a recorded images.
On the Home tab, in the Parts group, click Buttons, and then click Goto Screen Button.

7 Click a point on the edit screen where you wish to place the Goto Screen Button.

8 Double-click the dropped Goto Screen Button and a Properties dialog box will be displayed.

9 On the General tab, select Open File Screen for Movie Files for Action Mode.

10 Specify the display location in coordinates for the movie file screen to open above the base screen with Coordinates 
X, Y.

With the upper-left corner of the screen as the origin, the upper-left corner of the window is the X and Y coordinates.

X: 0 to (base screen horizontal size - 1)

Y: 0 to (base screen vertical size - 1)
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11 Click OK.

Close the Properties of Goto Screen Button dialog box.
This concludes configuring playback of recorded images.

Operating Procedure

To play sound, the MICRO/I must be connected to speakers.
This section describes the example of playing the movie file “123000.avi” located in the “20110313” folder under the 
“RECORD” folder when the External Memory Device folder is “HGDATA01”.

1 Press the Goto Screen Button set to Open File Screen for Movie Files.

The File Screen is displayed.

2 Select the folder with the date of the recorded images.

Press  to select “20110313” and then press Select. 
The contents of the “20110313” folder will be displayed.

Movie files that meet the following specifications can be played with the MICRO/I:

HG5G/4G/3G-V: AVI file (.avi)

HG4G/3G: MP4 file (.mp4)

For details, refer to Chapter 2 “1.6 Available Movie Files” on page 2-37.

Restore RepeatON RepeatOFFFull

REW FF NextBack

Stop PlayPause

MICRO/I

Video DisplayPress the Goto Screen Button

Modified Date: 2011/3/13 13:00:30

Page No.: 1

File Screen
DRIVE: SD Card
\HGDATA01\RECORD

Update Page Up Page Down Select

File name Size
Folder20110312
Folder20110313
Folder20110314
Folder20110315

Folder Up

1 2

Once the File Screen is opened, the “RECORD” folder in the External Memory Device folder will be displayed. 
If the “RECORD” folder does not exist, the External Memory Device folder will be displayed.
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3 Select a movie file.

Press  to select “123000.avi” and then press Select.
The movie file will be selected and the File Screen will close. 

4 Press Play on the Video Display.

The movie file is played.

123000.avi

Modified Date: 2011/3/13 13:00:30

Page No.: 1

File Screen
DRIVE: SD Card
\HGDATA01\RECORD\20110313

File name Size
120000.avi
121500.avi
123000.avi
124500.avi
130000.avi

512,000,000
512,000,000
512,000,000
512,000,000
512,000,000

Folder Up

Update Page Up Page Down Select

1 2

Restore RepeatON RepeatOFFFull

REW FF NextBack

Stop PlayPause

MICRO/I

Video Display

Press Play

While data is being recorded after an event occurs with the event recording function, while data is being 
recorded with a Key Button, Multi-Button, or Multi-Command configured with the recording function, or 
while data is being saved to the external memory device, movie files cannot be played. While data is 
recording after an event occurs and while data is being saved to the external memory device, the value of 
HMI Special Data Register LSD155-0 changes to 1. For details, refer to Chapter 33 “HMI Special Data 
Register (LSD)” on page 33-7.
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2.3 Configuring the Video Input

1 On the Configuration tab, in the System Setup group, click Multimedia.

The Multimedia Settings dialog box is displayed.

2 Click the Video Input tab.

3 Select NTSC or PAL for the signal standard of the device connected to the MICRO/I.

4 Click OK.

The Multimedia Settings dialog box closes.
This concludes configuring the video input.

The adopted format for the signal standard differs according to the country or region.
NTSC: Japan, Korea, Taiwan, North America, Central America, South America, others
PAL: Europe, China, the Middle East, South East Asia, others
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This section describes items and buttons on the Multimedia Settings dialog box.

3.1 Multimedia Settings Dialog Box

● Movie Tab
Create and edit a list of movie files to be used with project data.
Based on the contents that have been set a movie file list, “movie.lst”, is automatically created in the root folder of the 
External Memory Device folder in the external memory device.

■ Movie File List:
Displays a list of movie files to be used with project data.

*1 avi for HG5G/4G/3G-V, mp4 for HG4G/3G

3 Multimedia Settings Dialog Box

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

ID: Displays the movie file list ID.

File Path: Displays the file path of the movie file. 
Click the cell, and then enter the file path of a movie file. Maximum number is 250 alphanumeric 
characters.
To specify a movie file saved in the "MOVIE" folder in the External Memory Device folder 
configured on the External Memory Device tab in the Project Settings dialog box, only 
enter the file name.
Example: When the name of the External Memory Device folder is "HGDATA01" 

Enter "sample01" and the file name is: 

A: HGDATA01 MOVIE sample01.file extension\ \ \ *1

Click the cell, and then click  to display the Open dialog box. Then specify a movie file with 
the Open dialog box.

You cannot use the following characters in the file path.
 / : , ; * ? " < > |
However, a colon (:) can be used to indicate a drive letter, such as "A:".  
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■ Delete
Deletes movie files from the movie file list.
Select a movie file from the movie file list and then click this button.

■ Up
Shifts the selected movie file upward on this list.

■ Down
Shifts the selected movie file downward on this list.

■ Import
Imports an exported movie file list.
Existing movie file lists will be overwritten.

■ Export
Exports a movie file list with the file name “movie.lst”.

Even if the file path of a movie file is deleted from the movie file list, the movie file itself will not be deleted.
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● Record Tab

■ Use Event Recording
Select this check box to use the event recording function.
The event recording function has the MICRO/I monitor the state of a trigger device address. When the value of device 
address changes from 0 to 1 (when an event occurs), the function records the video and audio before and after the 
event. 

■ Recording Channel*1

Selects Channel 1 or Channel 2 to record a video only (no audio) out of the signals input from the device. 

■ Recording Target*2

Select the target to record out of the signals input from the device.

■ Trigger Device Address
Specifies the bit device that will trigger the start of recording. This option can only be set when Use Event 
Recording is selected.

Click  to display the Tag Editor. For details, refer to Chapter 2 “5.1 Device Address Settings” on page 2-68.

■ Recording Time Before Event
Specifies the amount of time (1 to 15 sec.) to record before the value of trigger device address changes from 0 to 1. 
This option can only be set when Use Event Recording is selected.

■ Recording Time After Event
Specifies the amount of time (1 to 15 sec.) to record after the value of trigger device address changes from 0 to 1. 
This option can only be set when Use Event Recording is selected.

*1 HG5G/4G/3G-V only
*2 This is applicable for HG4G/3G with a video interface only.

Video and Audio: Records images and sound.

Video only (No Audio): Records images only.

While data is being recorded after an event occurs with the event recording function and while recorded 
data is being saved to the external memory device, data cannot be recorded with a Key Button, Multi-
Button, or Multi-Command configured with the recording function and movie files cannot be played. Also, 
during these situations, the value of HMI Special Data Register LSD155-0 changes to 1. For details, refer to 
Chapter 33 “HMI Special Data Register (LSD)” on page 33-7.
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● Video Input Tab
Set the signal standard for the device that will connect to the MICRO/I.

■ Input Signal
Select from NTSC or PAL for the signal standard of the device connected with the MICRO/I.

The adopted format for signal standards will differ depending on the country or region.
NTSC: Japan, Korea, Taiwan, North America, Central America, South America, etc.
PAL: Europe, China, The Middle East, South East Asia, etc.
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You can check various kinds of information for the multimedia function through the values of the HMI Special Data 
Register. Details on HMI Special Data Register are given below:

■ LSD 155: Event Recording Function Status Information

■ LSD 165: Error Information

4 Checking the Status of the Function

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

Bit position Description

0
While data is recording after an event occurs and while recorded data is being saved to the external 
memory device, the value changes to 1.

1 to 15 Reserved

Function name Description Parameters

Multimedia Function Error Information
Stores error information for the 
multimedia function.

0: Normal
1: Specified file does not exist
2: File format is incorrect
3: Specified parameter value is out 

of range
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• When you have a movie file (.mp4) and a sound file (.WAV), you cannot play both of them at the same time.

• Movie files and sound files cannot be played while recording.
Sound files cannot be played if the event recording function is enabled.

• Movie files cannot be played and video cannot be displayed while the Maintenance Screen is being displayed.

• If the zoom magnification for the movie file is greater than 2x, the zoom magnification is adjusted to 2x and the 
movie is centered and displayed.

• If SIEMENS S7-MPI is selected in Communication Driver, the speed of the MICRO/I scan process decreases by 
playing movie files and by displaying or recording video from video input.

• When using the Cyclic Script, movie file playback and displaying or recording video from video input may be 
interrupted.

• If the MICRO/I Installation direction is set to Vertical installation, movie file playback and displayed video is 
performed in the same direction as the Horizontal installation.
To play movie files on a Vertical installation MICRO/I, use movie files with the display orientation rotated to match 
the installation direction.

• When using the event recording function, the event recording function is paused if you record with a Key Button, 
Multi-Button, or Multi-Command configured with the recording function or play movie files, so take note of the 
following.
- While recording with parts and while playing movie files, nothing is recorded if an event occurs.
- When data was recorded with a part, it takes approximately 1 second after the data is finished being saved to the 

external memory device until the event recording function resumes operating.
- When a movie file was played, it takes approximately 1 second from stopping playback until the event recording 

function resumes operating.

• While data is being recorded after an event occurs with the event recording function and while recorded data is 
being saved to the external memory device, data cannot be recorded with a Key Button, Multi-Button, or Multi-
Command configured with the recording function and movie files cannot be played. Also, during these situations, 
the value of HMI Special Data Register LSD155-0 changes to 1. For details, refer to Chapter 33 “HMI Special Data 
Register (LSD)” on page 33-7.

• Movie files which allow to use the FF key and the REW key in the Video Display are as follows
- If the playback time is 10 minutes or less, files with 1 or more I-frames every 2 seconds
- If the playback time is 10 minutes or more, files with 1 or more I-frames every 5 seconds

• If a popup screen is moved that has a Video Display showing a video or playing a movie file, the display may briefly 
remain in the position before being moved.

• If it takes a long time to recognize the SD memory card, movie files cannot be played directly after starting 
operation. In this case, play the movie file after HMI Special Internal Relay LSM21 changes to 1. For details, refer to 
Chapter 33 “HMI Special Relay (LSM)” on page 33-2.

5 Restrictions

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

The time to save data to the external memory device varies based on the write speed of the external 
memory device used.
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This chapter outlines user accounts and the Security function, how to configure them, and their operation on the 
MICRO/I and in WindO/I-NV4.

  

1.1 User Accounts

The Security function protects access to data and MICRO/I displays and operations using accounts. Accounts are the 
privileges to use the MICRO/I and data. By assigning accounts to users, you can protect the MICRO/I from being 
inappropriately operated and protect project data from alterations and misuse.
Accounts assigned to users are called user accounts.

In WindO/I-NV4, security groups are used as accounts.
There are two types of security groups: provided security groups (Administrator, Operator, and Reader) and user-
created security groups. One or more of these security groups can be assigned to users.
One or more users must always be assigned to Administrator.

A user name and password are associated with a user account and up to 15 user accounts can be created.

Chapter 23 User Accounts and the Security Function

1 Overview

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

User

Assign

Account

User account

Privileges to operate the MICRO/I

Privileges to access data

Assign Assign Assign

Provided 
security groups

User-created 
security groups 
(12 max)

Administrator

Operator

Reader

GroupA

GroupB GroupB

Administrator

User account: User account: User account:

User4User3 User15User2User1

11111111 22222222 33333333 44444444 EEEEEEEEPassword:

User name:

User account:
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If you configure a password for a user account assigned to a security group, access to data and MICRO/I displays and 
operations are password protected.
For password protected operations, users are prompted to enter their user name and password as necessary on the 
MICRO/I Password screen or the WindO/I-NV4 Enter Password dialog box.

Password screen Enter Password dialog box

CAN

User

A B C D E F

G H I J K L

CLR

M N O P Q R

S T U V W X

ENT

Y Z 0 1 2 3

4 5 6 7 8 9

Password

• You can set a dedicated password when opening the project. In the Security dialog box, on the Options 
tab, select the Use Password to open a Project check box, and then set the password.

• If a password is not configured for a user account, access to data and MICRO/I displays and operations 
cannot be protected.
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1.2 Protecting Data

● Protecting Access to Data
Security groups that protect access to data can perform the following functions.

• Protect from changes by editing project data

• Protect from alterations or misuse by downloading data

*1 SD memory card for HG5G/4G/3G/2G-V, HG4G/3G and HG2G-5F, USB flash drive for HG2G-5T and HG1G/1P
*2 This is applicable for models with a audio interface only.
*3 This is applicable for models with a video interface only.

The Enter Password dialog box is displayed

Opening project data

Computer MICRO/I

The Enter Password dialog box is displayed

Download

Download

Project data

Recipe files

Picture files

Sound files

Custom Web Page files

Movie files

Movie file list

USB flash drive

SD memory card

External memory device

*2

*3
*3

*1

The Password screen is displayed

CAN

User

Enter the appropriate password 
for Data Transfer Function

Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password

USB flash drive

SD memory card

MICRO/I

External device

Download

PLC programs

External memory device
*1
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• Protect from the loss of data by upload

• Protect from data erasures and formatting external memory device*1 by unauthorized access

*1 SD memory card for HG5G/4G/3G/2G-V, HG4G/3G and HG2G-5F, USB flash drive for HG2G-5T and HG1G/1P
*2 This is applicable for models with a audio interface only.
*3 This is applicable for models with a video interface only.

Computer MICRO/I

The Enter Password dialog box is displayed

Upload

Upload

Screenshot data

Alarm Log data

Data Log data

Operation Log data

Recipe files

Picture files

Sound files

Movie files

Movie file list

Project data

USB flash drive

SD memory card

External memory device
*1

*3
*2

*3

The Password screen is displayed

CAN

User Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Enter the appropriate password 
for Data Transfer Function

Password

USB flash drive

SD memory card

MICRO/I

External device

Upload

PLC programs

External memory device
*1

Computer MICRO/IDeleting data

The Enter Password dialog box is displayed

Deleting data
Formatting

USB flash drive

SD memory card

External memory device*1
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• Protect from alterations and misuse by operating the MICRO/I under the System Mode

• Protect from unauthorized browsing by displaying Device Monitor

• Protect from the loss of data by copying files*4 between USB flash drives and SD memory cards

• Protect from the loss of data or alterations by the execution of the USB Autorun function

*4 HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F only

The Password screen is displayed

Maintenance
System Mode

Device Monitor

Adjust Brightness

CAN

User Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password

MICRO/IMICRO/I

The Password screen is displayed

Device Monitor CAN

User Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

System Mode

Adjust Brightness

Maintenance Password

MICRO/IMICRO/I

The Password screen is displayed

CAN

User Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

USB flash drive

File

SD memory card

Copy

Password

MICRO/I

The Password screen is displayed

USB flash drive

CAN

User Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password

MICRO/IMICRO/I
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• Protect from remote unauthorized browsing and unauthorized operations using a web browser terminal on a 
computer or PDA

● Provided security groups
There are three types of provided security groups with different security levels: Administrator, Operator, and Reader.

■ Administrator
The Administrator group possesses complete access rights to project data. This security group can execute all 
necessary operations including editing project data and changing MICRO/I project data. One or more users must be 
assigned to this group.

■ Operator
The Operator group can partially change project data by changing values of device addresses. This security group 
download data to external memory device and copy files from USB flash drives to SD memory cards.

■ Reader
The Reader group can read data stored on external memory device, copy files from SD memory cards to USB flash 
drives, and read values of device addresses with the Web Server function.

Web Browser Terminal

(computer, PDA, etc.)

Local Network

Ethernet Communication (TCP/IP)

The Password screen is displayed

The provided user account has the security groups Administrator, Operator, and Reader allocated to it. 
Passwords have not been configured for this user account. To protect access to data, a password must be 
configured for the user account.

User1

Provided security groups

Administrator

Operator

Reader
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● Operations Subject to Password Protection
If you configure a password for a user account assigned to a security group to protect access to data, access to data 
is password protected. The operations that are subject to password protection and the security group that the 
password is valid for are as follows.

*1 Switch between Permitted and Prohibited in the Security Settings dialog box.
*2 Inserted into the MICRO/I
*3 HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F only
*4 It depends on the settings in Security Settings dialog box. For details, refer to “Web Page Tab” on page 23-42.

Operations subject to password protection
Security group that the password is valid for

Administrator Operator Reader User-created

Data editing Opening projects YES NO NO YES*1

Modifying 
data

Downloading a project data YES NO NO YES*1

Deleting all data YES NO NO YES*1

Uploading a project data YES NO NO NO

Downloading files to an external memory device*2 YES NO NO NO

Uploading files from an external memory device*2 YES YES YES NO

Downloading files to an external memory device*2 
while the MICRO/I is running

YES YES NO NO

Downloading PLC programs from an external 

memory device*2 to external devices
YES NO NO NO

Uploading PLC programs from external devices to an 

external memory device*2 YES NO NO NO

Deleting files in external memory device*2 YES NO NO NO

Formatting external memory device*2 YES NO NO NO

Copying files to an SD memory card*3 YES YES NO NO

Copying files to a USB flash drive*3 YES YES YES NO

Switching to the System Mode YES NO NO NO

Use Device Monitor YES YES NO NO

Remotely monitoring the MICRO/I state from a 
web browser terminal

YES YES YES NO

Remotely operating the MICRO/I state from a web 
browser terminal

YES YES NO NO

Displaying and operating the Custom Web page of 
the MICRO/I from a web browser terminal

*4 *4 *4 *4

• You can set a dedicated password. In the Security dialog box, on the Options tab, select the Use 
Password to open a Project check box, and then set the password. The dedicated password is 
applicable to the following operations:
- Opening projects
- Reusing screens
- Opening projects after uploading project data

• To password protect operations, the lowest level security group out of the security groups enabled with a 
password must be assigned to a user account.
The security levels, from highest to lowest, are Administrator > Operator > Reader.
Example: To password protect the operation to display Device Monitor, assign the Operator security 

group to a user account. If a user account assigned to the Operator security group does not 
exist, the operation is not password protected.

• The commands that the USB Autorun function can execute vary based on the enabled security group. For 
details, refer to Chapter 31 “2.4 USB Autorun Function Security” on page 31-36.
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1.3 Protecting Displays and Operations

● Displays and Operations that can be Protected with the Security Function
Security groups can be assigned to users to protect MICRO/I displays and operations. These groups are capable of 
the following actions.

• Protecting the display of screens

• Protecting the display of parts

• Protecting the operation of parts

Switch user accountGoto Screen Button 
(Switch to base screen 2)

No user

The Password 
screen is displayed

Base screen 2 is 
displayed

Full

Tank 1
Base screen 1

User2
User2

CAN

User2 Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password

MICRO/IMICRO/IMICRO/I

Base screen 2 
Cannot be 
displayed

Base screen 2 
Can be displayed

Switch user account

The Password 
screen is displayed

Line Chart is 
displayed

Goto Screen Button
(Open password screen)

Line Chart that can only be displayed with User2

User2
User2

No user

CAN

User2 Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password

MICRO/IMICRO/IMICRO/I

Line Chart
Can be displayed

Line Chart
Cannot be 
displayed

Switch user account

The Password screen 
is displayed

The Numerical Input 
can be operated

Goto Screen Button
(Open password screen)

Numerical Input that can only be operated by User2

User2
User2

999999 999

999

No user

CAN

User2 Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password

MICRO/IMICRO/IMICRO/I

Numerical Input
Can be operated

Numerical Input
Can be operated
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● Protect MICRO/I Displays and Operations
The user accounts that can display and operation screens and parts are only those assigned to the same security 
group as the security group to which Permitted privileges have been set for the display and operation of screens and 
parts.
Privileges to display and operation screens and parts are configured on the Security tab in the properties dialog box 
of those screens and parts.
Usage privileges can be configured only for parts with an input function.

Example: If the user and security group for the part are set as follows:

If no user account has been selected, the parts that can be displayed and used are only those for which all security 
groups have been set to Permitted.
If the password screen is opened and the user switches to User2 in GroupA, the parts for which Display has been set 
to Permitted for GroupA are displayed. The parts for which Input has been set to Prohibited for GroupA cannot be 
used.

User Name

Security Group GroupA Administrator, GroupA Administrator

User2 User3 User4

999

MICRO/I

Default user: None

Goto Screen Button (Open password screen)
No. Group Name Display Input

1 Administrator Permitted Permitted

2 Operator Permitted Permitted

3 Reader Permitted Permitted

4 GroupA Permitted Permitted

Line Chart and Bar Chart
No. Group Name Display

1 Administrator Prohibited

2 Operator Permitted

3 Reader Permitted

4 GroupA Permitted

Button
No. Group Name Display Input

1 Administrator Prohibited Permitted

2 Operator Permitted Permitted

3 Reader Permitted Permitted

4 GroupA Permitted Prohibited

Numerical Input
No. Group Name Display Input

1 Administrator Permitted Permitted

2 Operator Permitted Permitted

3 Reader Permitted Permitted

4 GroupA Permitted Prohibited

MICRO/I MICRO/I MICRO/I

User2

Open the password screen with 
the Goto Screen Button, enter 
the password, and switch to 
User2

If no user is selected, only parts 
for which Display has been set 
to Permitted for all security 
groups are displayed and only 
parts for which Input has been 
set to Permitted for all security 
groups can be used

For User2, parts for which Display 
has been set to Permitted for 
GroupA are displayed, but parts for 
which Input has been set to 
Prohibited for GroupA cannot be 
used

999 999 999
CAN

User Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password

Cannot be 
operated

Cannot be 
operated

Displayed
Not 

displayed
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If the password screen is opened and the user switches to User3 in Administrator and GroupA, the parts for which 
Display has been set to Permitted for GroupA will be displayed, and the parts for which Input has been set to 
Permitted for Administrator can be used.

If the password screen is opened and the user switches to User4 in Administrator, the displayed parts for which Input 
has been set to Permitted for Administrator can be used. Parts for which Display has been set to Prohibited for 
Administrator are not displayed.

MICRO/I MICRO/I MICRO/I

For User3, parts for which Display 
has been set to Permitted for 
GroupA are displayed, and parts 
for which Input has been set to 
Permitted for Administrator can 
be used

User3

If no user is selected, only parts 
for which Display has been set to 
Permitted for all security groups 
are displayed and only parts for 
which Input has been set to 
Permitted for all security groups 
can be used

Open the password screen with 
the Goto Screen Button, enter the 
password, and switch to User3

999 999 999
CAN

User Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password

999

Cannot be 
operated

Can be 
operated

DisplayedNot 
displayed

Parts that are not displayed on the screen cannot be operated regardless of the input security group.

MICRO/I MICRO/I MICRO/I

User4

For User4, parts for which Display 
has been set to Prohibited for 
Administrator are not displayed, 
and displayed parts for which 
Input has been set to Permitted 
for Administrator can be used

If no user is selected, only parts 
for which Display has been set 
to Permitted for all security 
groups are displayed and only 
parts for which Input has been 
set to Permitted for all security 
groups can be used

Open the password screen with 
the Goto Screen Button, enter 
the password, and switch to 
User4

999 999 999
CAN

User Up Down

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password

999

Can be 
operated

Not 
displayed

Cannot be 
operated

Not 
displayed

GroupA is not configured for User4, so the button in the lower right of the screen is not displayed. Parts that 
are not displayed on the screen cannot be used, even by users in a security group for which Input has been 
set to Permitted.
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This section describes the configuration procedure for the Security function.

2.1 Creating and Editing User Accounts

● Creating a User Account

1 On the Configuration tab, in the Protect group, click User Accounts.

The Security dialog box is displayed.

2 Select the Use Security functions check box.

The settings related to user accounts are displayed.
The user account already provided with WindO/I-NV4 is as follows.

3 Click Add.
The New User Account dialog box is displayed.

2 Security Function Configuration Procedure

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

No.: 1
User Name: User
Password: (blank)
Security Group: Administrator, Operator, Reader
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4 Specify the user number (1 to 15) in Number
This number is used when switching the user account via the value of device address.

5 Enter the name for the new user in User Name.
The maximum number for the user name is 8 characters. Only alphanumeric characters and symbols can be used.

6 Enter the password in New Password.
The number for the password is 4 to 15. Only uppercase alphabetic characters and numbers can be used.

7 Enter the password in Confirm Password that was entered in step 6.

8 Click the Group Membership tab.
Assign the security groups to the user being created.
Administrator, Operator, and Reader have already been provided in Security Group.

If you will not add a new security group, proceed to step 17.
If you will not assign a security group, proceed to step 18.

You cannot use the following characters in the user name.
   \ / : * ? “ < > |

Write down the password so you do not forget it and save that note in a safe place. 

To display the content of the password for New Password and Confirm Password, select the Show 
Passwords check box in the Security dialog box.

User3User2User1

Administrator AdministratorOperator

Operator

Reader
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9 Click Add.
The Security Settings dialog box is displayed.

10 Click Add.
The New Security Group dialog box is displayed.

11 Specify the Security Group number (4 to 15) in Number.

12 Enter the name for the new group in Group Name.
The maximum number for the group name is 15 characters.

“ ” (Japanese), “None” (English), and “ ” (Chinese) cannot be used for the group name.
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13 Under Permission, set whether or not to permit the operations subject to password protection in No. 1 to 3.
Double clicking the Permission cells switches between Permitted and Prohibited.

14 Click OK.
The group added is displayed in Security Group.

15 Repeat steps 10 to 14 and create all of the necessary user accounts.

16 Click OK.
The group added is displayed in Security Group.

Permitted and Prohibited cannot be changed for the operations subject to password protection in No. 4 
to 15.
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17 Select the security groups in Security Group on the New User Account dialog box to assign to the user being 
created, and then click << Copy.

The security groups are copied to To.
The security groups that you create can be used in multiple user accounts.

To delete the security groups assigned to the user, select the security groups to delete in To, and then click Delete.

18 Click OK.

If you will not continue creating a user account, proceed to step 20.

19 Repeat steps 3 to 18 and create all of the necessary user accounts.

20 Click OK.

The Security dialog box closes.
This concludes creating a user account.

User3 User4User2User1

Created security 
groups (12 max)

GroupA

GroupB

GroupC

GroupC

GroupB GroupB GroupC

Multiple user accounts can use the same security groups

• To select multiple security groups, press and hold SHIFT or CTRL while you click the specific items.
• Select the security groups in Security Group and click Delete to delete the security groups. However, 

security groups configured for user accounts, screens, and parts cannot be deleted.

You can configure a user account to be enabled when the MICRO/I power is turned on and when switching 
the operation mode in Default User.
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● Editing a User Account

1 On the Configuration tab, in the Protect group, click User Accounts.

The Security dialog box is displayed.

2 Select the user account to edit and click Edit.

The Change User Account dialog box is displayed.

3 On the General tab, change User Name and New Password.

4 Enter the password in Confirm Password that was entered in step 3.

To display the content of the password for New Password and Confirm Password, select the Show 
Passwords check box in the Security dialog box.
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5 Click the Group Membership tab.

Change the security groups assigned to the user.

If you will not assign a security group or you will not delete a security group, proceed to step 7.

6 Select the security groups in Security Group to assign to the user being edited and click << Copy.

The security groups are copied to To.

If you will not delete a security group, proceed to step 8.

7 Select the security groups assigned to the user to delete in To and click Delete.

The security groups are deleted from To.

To select multiple security groups, press and hold SHIFT or CTRL while you click the specific items.

• To select multiple security groups, press and hold SHIFT or CTRL while you click the specific items.
• Select the security groups in Security Group and click Delete to delete the security groups. However, 

security groups configured for user accounts, screens, and parts cannot be deleted.
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8 Click OK.

9 Click OK to close the Security dialog box.

This concludes editing a user account.

● Deleting a User Account

1 On the Configuration tab, in the Protect group, click User Accounts.

The Security dialog box is displayed.

2 Select the user account to delete and click Remove.

The user account is deleted.

3 Click OK.

The Security dialog box closes.
This concludes deleting a user account.
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2.2 Adding and Editing Security Groups

● Adding a Security Group

1 On the Project window, double click Security Settings.

The Security Settings dialog box is displayed.

2 Click Add.

The New Security Group dialog box is displayed.

3 Specify the Security Group number (4 to 15) in Number.
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4 Enter the name for the new group in Group Name.

The maximum number for the group name is 15 characters.

5 Under Permission, set whether or not to permit the operations subject to password protection in No. 1 to 3.

Double clicking the Permission cells switches between Permitted and Prohibited.

“ ” (Japanese), “None” (English), and “ ” (Chinese) cannot be used for the group name.

Permitted and Prohibited cannot be changed for the operations subject to password protection in No. 4 
to 15.
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6 Click OK.

The group added is displayed in Security Group.

7 Click OK.

The Security Settings dialog box closes.
This concludes adding a security group.
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● Changing the Name of a Security Group

1 On the Project window, double click Security Settings.

The Security Settings dialog box is displayed.

2 Select the security group in Security Group to change the name of and click Rename.

The Change Security Group Name dialog box is displayed.

3 Change the name of the security group to the new group name in New Name.

The maximum number for the group name is 15 characters.

4 Click OK.

The Change Security Group Name dialog box closes.

5 Click OK.

The Security Settings dialog box closes.
This concludes changing the name of a security group.

The group name for Administrator, Operator, and Reader cannot be changed.

“ ” (Japanese), “None” (English), and “ ” (Chinese) cannot be used for the group name.
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● Changing the Operation Privileges of a Security Group

1 On the Project window, double click Security Settings.

The Security Settings dialog box is displayed.

2 Under Security Group, select the security group for which the operation privileges will be changed, and under 
Permission, set whether or not to permit the operations subject to password protection in No. 1 to 3.

Double clicking the Permission cells switches between Permitted and Prohibited.

3 Click OK.

The Security Settings dialog box closes.
This concludes creating a user account.

Permitted and Prohibited cannot be changed for the operations subject to password protection in No. 4 
to 15.
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● Deleting a Security Group

1 On the Project window, double click Security Settings.

The Security Settings dialog box is displayed.

2 Select the security group in Security Group to delete and click Delete.

The security group is deleted.

3 Click OK.

The Security Settings dialog box closes.
This concludes deleting a security group.

To select multiple security groups, press and hold SHIFT or CTRL while you click the specific items.

• Security groups configured for user accounts, screens, and parts cannot be deleted.
• Administrator, Operator, and Reader cannot be deleted.
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2.3 Protecting the Display and Operation of Screens and Parts

● Protecting the Display of Screens
Here you will configure the security group for a screen to protect the display of that screen.
This section describes an example where the display of base screen 2 is protected when switching to base screen 2 by 
pressing the Goto Screen Button.

Configuration Procedure

1 Following the procedure in “Creating a User Account” on page 23-11, create the following user account.

To automatically display the Password screen when the user attempts to switch to a base screen they cannot access 
with the current user account using the Goto Screen button, select the Change Screen check box and the Change 
Screen automatically after entering Password check box in Open Password Screen automatically by the 
following operations on the Options tab of the Security dialog box. For displaying the Password screen, refer to 
“4.1 Entering the Password on the MICRO/I” on page 23-46.

User2

Goto Screen Button
(Switch to base screen 2) Full

Tank 1
Base screen 1 Base screen 2

No user

MICRO/IMICRO/I

Base screen 2
Can be displayed

Base screen 2
Cannot be 
displayed

To change the user account, a button or command is required to open the Password screen.

User Name

Security Group GroupA
User2



2 Security Function Configuration Procedure

23-26 WindO/I-NV4 User’s Manual

2 Place a Goto Screen Button on base screen 1.
On the Home tab, in the Parts group, click Buttons, and then click Goto Screen Button.

3 Click a point on the edit screen where you wish to place the Goto Screen Button.

4 Double-click the dropped Goto Screen Button and the Properties dialog box is displayed.

5 Select Switch to Base Screen for Action Mode.

6 Specify the screen number of the base screen to switch to with Screen Number under Goto Screen.

2 is specified here.

7 Click OK.

Close the Properties of Goto Screen Button dialog box.
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8 Create the base screen to switch to and configure the security group.
On the Home tab, in the Screens group, click the arrow under New, and then click Base Screen.
The Screen Properties dialog box is displayed.

9 Specify the screen number of the base screen to switch to with Number on the General tab.
This is the same screen number as the screen number specified in step 6. 2 is specified here.

10 Click the Security tab.

11 Change Display to Permitted for the security group that will be permitted to display the base screen.
Set Display to Permitted for GroupA.

12 Configure the settings on each tab as necessary and click OK.
The Screen Properties dialog box closes.
This concludes configuring the project to protect the display of screens.
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Operating Procedure

This section describes an example when the current user account has no default user.

1 Press the Goto Screen Button configured with Switch to Base Screen.

The Password screen is displayed.

2 Press Down and select User2.

3 Enter the password and press ENT.

If the correct password is entered, the user account changes to User2 and the Password screen closes.
Base screen 2 is displayed.

Press the Goto Screen Button
Base screen 1

No user

MICRO/I

CAN

User2

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password

CAN

User2

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password

1
2

User2

Full

Tank 1
Base screen 2

MICRO/I
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● Protecting the Display of Parts
Here you will configure the security group for a part to protect the display of that part.
This section describes an example where the display of the Line Chart is protected.

Configuration Procedure

1 Following the procedure in “Creating a User Account” on page 23-11, create the following user account.

2 Create a Line Chart and configure the display security group.
On the Home tab, in the Parts group, click Charts, and then click Line Chart.

3 Click a point on the edit screen where you wish to place the Line Chart.

4 Double-click the dropped Line Chart and the Properties dialog box is displayed.

Goto Screen Button
(Open password screen)

User2
No user

MICRO/IMICRO/I

Line Chart
Can be displayed

Line Chart
Cannot 

be displayed

To change the user account, a button or command is required to open the Password screen.

User Name

Security Group GroupA

User2
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5 Click the Security tab.

6 Change Display to Permitted for the security group that will be permitted to display the Line Chart.

Set Display to Permitted for GroupA.

7 Configure the settings on each tab as necessary and click OK.

The Properties of Line Chart dialog box closes.

8 Place a Goto Screen Button to display the password screen on the base screen.
On the Home tab, in the Parts group, click Buttons, and then click Goto Screen Button.

9 Click a point on the edit screen where you wish to place the Goto Screen Button.
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10 Double-click the dropped Goto Screen Button and the Properties dialog box is displayed.

11 Select Open Password Screen for Action Mode.

12 Specify the display location in coordinates for the password screen to open above the base screen with Coordinates 
X, Y.
With the upper-left corner of the screen as the origin, the upper-left corner of the window is the X and Y coordinates.

13 Click OK.
The Properties of Goto Screen Button dialog box closes.
This concludes configuring the project to protect the display of a part.

X: 0 to (base screen horizontal size - 1)

Y: 0 to (base screen vertical size - 1)
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Operating Procedure

This section describes an example when the current user account has no default user.

1 Press the Goto Screen Button configured with Open Password Screen.

The Password screen is displayed.

2 Press Down and select User2.

3 Enter the password and press ENT.

If the correct password is entered, the user account changes to User2 from no default user and the Password screen 
closes.
The Line Chart is displayed.

Press the Goto Screen Button

No user

MICRO/I

CAN

User2

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password

CAN

User2

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password

1
2

User2

MICRO/I
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● Protecting the Operation of Parts
Here you will configure the security group for a part to protect the operation of that part.
This section describes an example where the operation of the Numerical Input is protected.

Configuration Procedure

1 Following the procedure in “Creating a User Account” on page 23-11, create the following user account.

2 Create a Numerical Input and configure the input security group.
On the Home tab, in the Parts group, click Data Displays, and then click Numerical Input.

3 Click a point on the edit screen where you wish to place the Numerical Input.

4 Double-click the dropped Numerical Input and the Properties dialog box is displayed.

Goto Screen Button
(Open password screen)

User2
No user

999999 999

MICRO/IMICRO/I

Numerical Input
Can be operated

Numerical Input
Cannot be 
operated

The keypad is not displayed, 
nothing can be operated

To change the user account, a button or command is required to open the Password screen.

User Name

Security Group GroupA
User2
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5 Click the Security tab.

6 Change Input to Permitted for the security group that will be permitted to use the Numerical Input.

Set Input to Permitted for GroupA.

7 Configure the settings on each tab as necessary and click OK.

The Properties of Numerical Input dialog box closes.

8 Place a Goto Screen Button to display the password screen on the base screen.
On the Home tab, in the Parts group, click Buttons, and then click Goto Screen Button.

9 Click a point on the edit screen where you wish to place the Goto Screen Button.
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10 Double-click the dropped Goto Screen Button and the Properties dialog box is displayed.

11 Select Open Password Screen for Action Mode.

12 Specify the display location in coordinates for the password screen to open above the base screen with Coordinates 
X, Y.

With the upper-left corner of the screen as the origin, the upper-left corner of the window is the X and Y coordinates.

13 Click OK.

The Properties of Goto Screen Button dialog box closes.
This concludes configuring the project to protect the operation of a part.

X: 0 to (base screen horizontal size - 1)

Y: 0 to (base screen vertical size - 1)



2 Security Function Configuration Procedure

23-36 WindO/I-NV4 User’s Manual

Operating Procedure

This section describes an example when the current user account has no default user.

1 Press the Goto Screen Button configured with Open Password Screen.
The Password screen is displayed.

2 Press Down and select User2.

3 Enter the password and press ENT.

If the correct password is entered, the user account changes to User2 from no default user and the Password screen 
closes.
The Numerical Input can be operated.

Press the Goto Screen Button

No user

999

MICRO/I

CAN

User2

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password

CAN

User2

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password

1
2

User2

999999

MICRO/I
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This section describes items and buttons on the Security dialog box.

3.1 Security Dialog Box

The passwords and security groups assigned to user accounts are collectively managed in the Security dialog box.

■ Show Passwords
Select this check box to display the characters of the password entered in Password under Users for this project. 
When this check box is cleared, the passwords are displayed with * (asterisk).

● General Tab

■ Use Security functions
Select this check box to protect access to data and to protect MICRO/I displays and operations by accounts. The 
settings related to user accounts are displayed.

When this check box is cleared, the switching to the System Mode, monitor display, or downloading or uploading data 
are protected by a single password. Note, the MICRO/I is not password protected if Password is left blank.

3 Security Dialog Box

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

User Name: Enter the name for the user account.
The maximum number for the user name is 8 characters. Only alphanumeric characters and 
symbols can be used.

You cannot use the following characters in the user name.
   \ / : * ? “ < > |

Password: Enter the password.
The number of characters for the password is 4 to 15. Only uppercase alphabetic characters 
and numbers can be used.

Write down the password so you do not forget it and save that note in a safe place.
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■ Users for this project

■ Add
This button adds a user account. You can create a maximum of 15. Click this button to display the New User 
Account dialog box. In the New User Account dialog box, the user name, password, and security groups are 
assigned to the user account. For details, refer to “New User Account Dialog Box and Change User Account Dialog 
Box” on page 23-39.

■ Edit
Select a number in Users for this project and click this button to display the Change User Account dialog box. In 
the Change User Account dialog box, the user name, password, and security groups are changed. For details, refer 
to “New User Account Dialog Box and Change User Account Dialog Box” on page 23-39.

■ Remove
This button deletes the user account with the selected number. Select a number and click this button.

■ Default User
Select the user account to be enabled when the MICRO/I power is turned on and when switching the operation mode.
If None is selected, no user account is selected when the MICRO/I power is turned on and when the operation mode 
is changed. Screens and parts cannot be displayed or operated that are protected by a security group.

Confirm Password: Re-enter the same password.
This option is only displayed when the Show Passwords check box is cleared.

No.: Displays the number (1 to 15) used when switching the user account via the value of device 
address. Double clicking the cell displays the Change User Account dialog box. For details, 
refer to “New User Account Dialog Box and Change User Account Dialog Box” on page 23-39.

User Name: Displays the name for the user account. Double clicking the cell displays the Change User 
Account dialog box. For details, refer to “New User Account Dialog Box and Change User 
Account Dialog Box” on page 23-39.

Password: Displays the password for the user account with asterisk(*). Double clicking the cell displays 
the Change User Account dialog box. For details, refer to “New User Account Dialog Box and 
Change User Account Dialog Box” on page 23-39.
To display the password characters, select the Show Passwords check box.

Security Group: Displays all of the security groups for user accounts. Double clicking the cell displays the 
Change User Account dialog box. For details, refer to “New User Account Dialog Box and 
Change User Account Dialog Box” on page 23-39.
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New User Account Dialog Box and Change User Account Dialog Box

In the New User Account dialog box, the user name, password, and security groups are assigned to an account and 
that user account is added.
In the Change User Account dialog box, the user name, password, and security groups for the selected user 
account are changed.

General Tab

■ Number
In the New User Account dialog box, this setting specifies the number (1 to 15) when switching the account via the 
value of device address.
When Edit was clicked and the Change User Account dialog box was displayed, this item displays the selected user 
account number.

■ User Name
Enter the name for the user account.
The maximum number is 8 characters. Only alphanumeric characters and symbols can be used.

■ New Password
Enter the password.
The number of characters for the password is 4 to 15. Only uppercase alphabetic characters and numbers can be 
used.

■ Confirm Password
Re-enter the same password.

You cannot use the following characters in the user name.
   \ / : * ? “ < > |

Write down the password so you do not forget it and save that note in a safe place.

To display the content of the password for New Password and Confirm Password, select the Show 
Passwords check box in the Security dialog box.
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Group Membership Tab

■ To: (user name being configured)
Displays the user name and the list of security groups assigned to the user.

■ << Copy
This button assigns the security groups to the user displayed in To.
Select the security groups in Security Group and click this button to add them to To.

■ Delete
This button deletes the security groups assigned to the user.
Select the security groups in To and click this button.

■ Security Group
This item displays a list of all the security groups. The provided security groups (Administrator, Operator, and Reader) 
are grayed out if assigned to another user account.

■ Add
This button adds a security group. You can create a maximum of 12.
Click this button to display the Security Settings dialog box. New security groups are added in the Security 
Settings dialog box. For details, refer to “Adding a Security Group” on page 23-19.

■ Rename
Select a security group in Security Group and click this button to display the Change Security Group Name 
dialog box. Change the name of the security group in the Change Security Group Name dialog box. For details, 
refer to “Changing the Name of a Security Group” on page 23-22.
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Security Settings Dialog Box

On the Group tab in the Security Settings dialog box, the security group can be managed collectively including 
configuring for the parts and adding or deleting security groups. Access permission for Custom Web Page can be set 
for each Security Group in the Web Page tab.

Group Tab

■ Security Group
Displays the list of security groups used on the MICRO/I.

■ Operation Authority Setting
Displays a list of privilege settings for operations subject to password protection in the security group selected under 
Security Group.

■ Add
This button adds a security group. You can create a maximum of 12.
Click this button to display the New Security Group dialog box. Set the details of the security group in the New 
Security Group dialog box. For details, refer to “Adding a Security Group” on page 23-19.

■ Delete
Deletes the security groups selected for Security Group. For details, refer to “Deleting a Security Group” on page 
23-24.

■ Rename
Select a security group in Security Group and click this button to display the Change Security Group Name 
dialog box. Change the name of the security group in the Change Security Group Name dialog box. For details, 
refer to “Changing the Name of a Security Group” on page 23-22.

Number: Displays the number (0 to 15) of the Security Group.

Security Group Name: Displays the name of the security group.

No.: Displays the number of the operations subject to password protection (1 to 17).

Operation: Displays details about the operations subject to password protection.

Permission: Displays whether or not there is permission to use the operation. Only operations set to 
Permitted can be used with the selected security group.
Only operation privilege settings (1 to 3) can be changed for user-created security groups (4 to 
15). Double clicking the cell switches between Permitted and Prohibited.

You can also switch between Permitted and Prohibited by right-clicking on a Permission cell.



3 Security Dialog Box

23-42 WindO/I-NV4 User’s Manual

Web Page Tab

■ Custom Web Page Access Management
Permissions for display and operation of Custom Web Page are set for each Security Group.

(Security Group Name)
(Access Permission)

File Name: Displays the file name of the Custom Web Page created by the Web Page Editor. For 
details about the Web Page Editor, refer to Chapter 28 “Web Page Editor” on page 28-14.

Security Group Name: Displays the name of the security group.

Access Permission: Displays whether or not to permit the display and operation of the Custom Web Page of 
the MICRO/I from the web browser. Double clicking the cell switches between Permitted 
and Prohibited.
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New Security Group Dialog Box

■ Number
Specify the number (4 to 15) for the Security Group.

■ Group Name:
Enter the name of the new group. The maximum number for the group name is 15 characters.

■ (Operation Authority Setting)
Displays a list of privilege settings for operations subject to password protection in the security group selected under 
Security Group.

“ ” (Japanese), “None” (English), and “ ” (Chinese) cannot be used for the group name.

No.: Displays the number of the operations subject to password protection (1 to 17).

Operation: Displays details about the operations subject to password protection.

Permission: Displays whether or not there is permission to use the operation. Only operations set to 
Permitted can be used.
Only operation privilege settings (1 to 3) can be changed. Double clicking the cell switches 
between Permitted and Prohibited.

You can also switch between Permitted and Prohibited by right-clicking on a Permission cell.
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● Options Tab

■ Use Password to open a Project
Select this check box and enter a password to protect the project with a dedicated password when opening it.
The number for the password is 4 to 15 characters. Only uppercase alphabetic characters and numbers can be used.
The operations subject to password protection are as follows.
• Opening projects
• Reusing screens
• Opening projects after uploading project data

■ Change User by Device Address
Select this check box to switch the user account according to the value of device address.
The user account is specified by using the number on the General tab.

Example: When the trigger device address is D0 and the default user is selected as User1

The user account switches according to the value of device address.

Confirm Password: Re-enter the password that was entered in Use Password to open Project.

Write down the password so you do not forget it and save that note in a safe place.

(Trigger Device Address): Specifies the word device to write the number.

Click to display the Tag Editor. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-68.

1 2 3No.

User Name User3User2User1
(Default user)

0

User account

Trigger device address 
D0 value

Switch to default 
user account

1

Switch to user 
account no. 1

2

Switch to user 
account no. 2

3

Switch to user 
account no. 3

4

NoneAction

User3 User3User2User1 User1

The user account is not switched when the value of 

device address is a number not configured to a user 

account or an invalid number.

If the value of device address is 

0, the user is switched to the 

default user.
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■ Store current logging-in User Name to Device Address
Select this check box to store the user name to Device Address currently logged in to the MICRO/I.

■ Back to Default User
Select this check box to automatically switch to the default user when the MICRO/I is unused for an extended period 
of time.

■ Check the Status of Password Entry
Select this check box to check the entry status of the password on the Password screen. 

The following bits change to 1 depending on the password input status. These bits become 0 when the Password 
screen opens or when a button other than ENT or CAN is pressed on the Password screen.

■ Open Password Screen automatically by the following operations

■ Report when Not Authorized User operates

(Top Device Address): Top Device Address: Specify the word device to use. This option uses 6 words of 
address numbers starting from the address number of the specified device address. 
You can only specify an internal device.

Click to display the Tag Editor. For the device address configuration procedure, 
refer to Chapter 2 “5.1 Device Address Settings” on page 2-68.

After: Specify the time (0 to 60 minutes) to switch to the default user after the MICRO/I is last used.
If 0 is set, the MICRO/I switches back to the default user immediately, even if the user account was changed.

(Destination Device Address): Specifies a word device to write the password entry status.

Click to display the Tag Editor. For the device address configuration procedure, 
refer to Chapter 2 “5.1 Device Address Settings” on page 2-68.

Bit position Function Parameters

0
This bit stores the information when the correct password was 
entered on the Password screen and ENT was pressed.

0: Password being entered
1: Correct password entered

1
This bit stores the information when an incorrect password was 
entered on the Password screen and ENT was pressed.

0: Password being entered
1: Incorrect password entered

2
This bit stores the information when CAN was pressed on the 
Password screen.

0: Password being entered
1: Password entry canceled

3 to 7 Reserved -

Operate Part Object: Select this check box to automatically display the Password screen when an unauthorized 
user presses the password protected object.

Change Screen: Select this check box to automatically display the Password screen when an unauthorized 
user attempts to change a screen that is password protected. 

Change Screen automatically after entering Password: Select this check box to close the Password 
screen and automatically change the screen when 
the entered password is correct.

Select this check box to write 1 in the report device address when the current user attempts to perform one of the 
following actions.
• Switching to a base screen that the current user account is not allowed to display.
• Opening a popup that the current user account is not allowed to display.
• Manipulating a part set to a security group that the current user account is not allowed to manipulate.

(Report Device Address): Specifies the report device address.

Click to display the Tag Editor. For the device address configuration procedure, refer 
to Chapter 2 “5.1 Device Address Settings” on page 2-68.
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When a password is configured for a user account, the user is prompted to enter their password with the following 
operations.
• Accessing password protected data
• Executing password protected displays and operations

4.1 Entering the Password on the MICRO/I

To execute password protected operations, the user must open the Password screen and switch the user account.
The Password screen is opened with a Goto Screen Button or Goto Screen Command configured with Password 
Screen. The Password screen is also automatically displayed on the MICRO/I when the following operations are 
executed.
• When the Change Screen check box is selected under Open Password Screen automatically by the 

following operations on the Options tab in the Security dialog box
• Switching to the System Mode or displaying the Device Monitor with the Maintenance screen, Goto Screen Button, 

Multi-Button, Goto Screen Command, or Multi-Command
• Downloading or uploading project data or PLC programs with a Key Button, Multi-Button, or Multi-Command
• Executing the USB Autorun function

4 Password Input

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

• Operations where the Password screen is not displayed are as follows.
- Switching the base screen using the System Area
- Displaying the alarm screen for the alarm log
- Opening the keypad with the Numerical Input or Character Input
- Opening the Ref. screen with the Alarm Log Display
- For screens that are already open when the user account was switched by opening the Password 

screen with the Goto Screen Button or Goto Screen Command
• When the user account is switched, the displayed base screen is reset. Popup screens and internal 

devices have the same behavior as when the base screen is switched. However, if the Close while 
changing Base Screen check box is selected on the Options tab in the Properties dialog box for the 
popup screen, the popup screen is closed when the base screen is switched. The behavior of the internal 
devices varies based on the internal devices. For details, refer to Chapter 33 “Internal Devices” on page 
33-1.
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● Password Screen Configuration

■ User Name
Displays the selected user name.

■ , 
Switches the user name.

■ Password
The entered password is displayed as “*”.

■ A to Z, 0 to 9
Enters A to Z, 0 to 9 in Password.

■ CAN
Clears the entered password and cancels input. The Password screen closes.

■ CLR
Clears the entered password and continues input.

■ ENT
Confirms the entered password and starts verifying the user name and password.
If the entered password is correct, the Password screen closes.
If the entered password was incorrect, the password entered on the Password screen is deleted and the screen 
returns to input mode.

CAN

User

A B C D E F

G H I J K L

CLR

M N O P Q R

S T U V W X

ENT

Y Z 0 1 2 3

4 5 6 7 8 9

Password

User Name Password
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4.2 Entering the Password in WindO/I-NV4

When a user account assigned with Administrator is configured with a password, or when a dedicated password for 
opening the project has been set, the Enter Password dialog box is displayed in WindO/I-NV4 as required and the 
user is prompted to enter their password.
The operations that display the Enter Password dialog box are as follows.
• Opening projects
• Reusing screens

• Downloading a project data

• Downloading data to an external memory device*1

• Downloading data to an external memory device*1 while the MICRO/I is running

• Uploading a project data

• Uploading data from an external memory device*1

• Deleting all data

• Deleting data in external memory device*1

• Formatting external memory device*1

● Enter Password Dialog Box

■ User Name
Selects the user name. This item can only be selected when multiple user accounts are registered.

■ Password
Enter the password. The entered password is displayed as “*”.

*1 External memory device inserted into the MICRO/I

If Administrator or Other Operation password is 
required, the following dialog box appears.

If dedicated password for opening project is required, 
the following dialog box appears.
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On the screen of the MICRO/I, you can open the User Account Setting Screen. Use this screen to edit, add, and 
delete user accounts.

5.1 Opening the User Account Setting Screen

To open the User Account Setting Screen, use the Goto Screen Button, Multi-Button, Goto Screen Command, or Multi-
Command that has been set to Open User Account Setting Screen.

5 Editing User Accounts on the MICRO/I

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

MICRO/I

Edit Add Delete

X

Detail
Reader
Operator
Admin

Security
Group

Password ******

User1

1

User Name

User ID

User Account Setting Screen

Edit Add Delete

X

Detail
Reader
Operator
Admin

Security
Group

Password ******

User1

1

User Name

User ID

• Allocate a Key Button, Multi-Button, or Multi-Command configured with the User Account Setting 
Screen to the MICRO/I.
 For details, refer to Chapter 8 “3 Goto Screen Button” on page 8-39.
 For details, refer to Chapter 8 “6 Multi-Button” on page 8-108.
 For details, refer to Chapter 12 “3 Goto Screen Command” on page 12-18.
 For details, refer to Chapter 12 “6 Multi-Command” on page 12-38.

• An Administrator user account is required to open the User Account Setting Screen.
• When opening the User Account Setting Screen, the displayed Popup Screens are closed.
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5.2 Editing a User Account

● Checking User Account Information
You can load user accounts configured in the project data and edit their information.

1 Press the Goto Screen Button or Multi-Button that has been set to Open User Account Setting Screen or execute 
the Goto Screen Command or Multi-Command.

The User Account Setting Screen will be displayed.

2 Press ▲ or ▼ to change the user number of the user account to edit.

3 Press Edit.

4 Change the user name.

If you will not change the user name, proceed to step 5.

1. Press the User Name input frame.

Edit Add Delete

X

Detail
Reader
Operator
Admin

Security
Group

Password ******

User1

1

User Name

User ID

X

GroupA

******

User2

2

Edit Add Delete

DetailSecurity
Group

Password

User Name

User ID

編集 追加

X

Change

GroupA

******

User2

2

削除

Security
Group

Password

User Name

User ID

CANCELOK
Edit
User.
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2. Enter the user name and press ENT.

5 Changes the password.

If you will not change the password, proceed to step 6.

1. Press the Password input frame.

2. Enter the password and press ENT.

CAN

→←

CLR

BS

*

%

9

4

)

$

8

3

(

#

7

2
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5
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ENT

Test02_

Sign
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bet 1

2

編集 追加 削除

X

GroupA

******

Test02

2

ChangeSecurity
Group

Password

User Name

User ID

CANCELOK
Edit
User.
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6 Change the security group assignments.

If you will not change the security group assignments, proceed to step 7.

1. Press Change.

2. Select security groups to assign and clear security groups to remove.

3. Press Close.

編集 追加 削除

X

GroupA

Password02

Test02

2

ChangeSecurity
Group

Password

User Name

User ID

CANCELOK
Edit
User.

• Security groups are selected and cleared each time the names are pressed.
• Press Gr. 1~5, Gr. 6~10, and Gr. 11~15 to switch between the different sets of five security groups.

Close

AdministratorGr. 1

OperatorGr. 2

ReaderGr. 3

GroupAGr. 4

GroupBGr. 5

Gr.
1~5

Gr.
6~10

Gr.
11~15

Close

AdministratorGr. 1

OperatorGr. 2

ReaderGr. 3

GroupAGr. 4

GroupBGr. 5

Gr.
1~5

Gr.
6~10

Gr.
11~15
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7 Press OK.

8 Press OK.

The user name, password, and security group assignments will be changed.

This concludes editing a user account.

編集 追加 削除

X

GroupA
Admin

Password02

Test02

2

ChangeSecurity
Group

Password

User Name

User ID

CANCELOK
Edit
User.

編集 追加 削除

X

変更GroupA
Admin

セキュリティ
グループ

Password02

Test02

2

Password

User Name

User ID

OK

Succeed

X

GroupA
Admin

**********

Test02

2

Edit Add Delete

DetailSecurity
Group

Password

User Name

User ID
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● Adding a user accounts
Adding a user accounts.

1 Press the Goto Screen Button or Multi-Button that has been set to Open User Account Setting Screen or execute 
the Goto Screen Command or Multi-Command.

The User Account Setting Screen will be displayed.

2 Press Add.

3 Enter the User Name.

1. Press the User Name input frame.

2. Enter the user name and press ENT.

X

Reader
Operator
Admin

******

User1

1

Edit Add Delete

DetailSecurity
Group

Password

User Name

User ID

編集 追加 削除

X5

ChangeSecurity
Group

Password

User Name

User ID

Add
User. CANCELOK

User ID displays the lowest user number (1 to 15) of all free numbers.
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9

4

)

$

8

3

(

#

7

2

‘

“

6

1

&

SP+

!

5

0

ENT

User5_

Sign

Alpha
bet

1

2



WindO/I-NV4 User’s Manual 23-55

5 Editing User Accounts on the MICRO/I

23

U
ser Accounts and the Security Function

4 Enter the password.

1. Press the Password input frame.

2. Enter the password and press ENT.

5 Assign the security groups.

1. Press Change.

編集 追加 削除

X

User5

5

ChangeSecurity
Group

Password

User Name

User ID

Add
User. CANCELOK

CAN

→←

CLR

BS

*

%

9

4

)

$

8

3

(

#

7

2

‘

“

6

1

&

SP+

!

5

0

ENT

Pass05_

Sign

Alpha
bet

1

2

編集 追加 削除

X
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Password
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User ID

Add
User. CANCELOK
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2. Select security groups to assign and clear security groups to remove.

3. Press Close.

6 Press OK.

7 Press OK.

• Security groups are selected and cleared each time the names are pressed.
• Press Gr. 1~5, Gr. 6~10, and Gr. 11~15 to switch between the different sets of five security groups.

Close

AdministratorGr. 1

OperatorGr. 2

ReaderGr. 3

GroupAGr. 4

GroupBGr. 5

Gr.
1~5

Gr.
6~10

Gr.
11~15

Close

AdministratorGr. 1

OperatorGr. 2

ReaderGr. 3

GroupAGr. 4

GroupBGr. 5

Gr.
1~5

Gr.
6~10

Gr.
11~15

編集 追加 削除

X

GroupB

Pass05

User5

5

ChangeSecurity
Group

Password

User Name

User ID

Add
User. CANCELOK

編集 追加 削除

X

変更GroupA
Admin

セキュリティ
グループ

Pass05

User5

5

Password

User Name

User ID

OK

Succeed
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The user account will be added.

This concludes adding the User Account.

● Deleting a User Account
The loaded user account can be deleted.

1 Press the Goto Screen Button or Multi-Button that has been set to Open User Account Setting Screen or execute 
the Goto Screen Command or Multi-Command.

The User Account Setting Screen will be displayed.

2 Press ▲ or ▼ to change the user number of the user account to delete.

3 Press Delete.

X

GroupB

******

User5

5

Edit Add Delete

DetailSecurity
Group

Password

User Name

User ID

Edit Add Delete

X
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Operator
Admin
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Password ******

User1
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X
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Edit Add Delete

DetailSecurity
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Password

User Name
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4 Press OK.

5 Press OK.

The user account will be deleted.

This concludes deleting the User Account.

編集 追加 削除

X

GroupB

******

User5

5

ChangeSecurity
Group

Password

User Name

User ID

Delete
User. CANCELOK

編集 追加 削除

X

変更GroupA
Admin

セキュリティ
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5
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User Name

User ID

OK

Succeed

X5

Edit Add Delete

DetailSecurity
Group

Password

User Name

User ID
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5.3 User Account Setting Screen Configuration

■ User ID
Displays the user number of the loaded account.

■ User Name
Displays the user name of the loaded account.
When editing or adding a user account, press the user name input field, and then enter the user name with the 
displayed keyboard.

■ Password
Displays the password of the loaded account.
When editing or adding a user account, press the password input field, and then enter the password with the 
displayed keyboard.

■ Security Group
Displays the security groups assigned to the loaded user account.

■ Detail / Change
Detail is displayed when the user account is loaded. Press Detail to display the security group details screen 
where you can check details about the assigned security groups.
Change is displayed when the user account is edited or added. Press Change to display the change security 
groups screen. You can change the security group assignments.

■ , 
Changes the user number and loads the corresponding user account.

■ Edit
Used to change the user name, password, and security group assignments of the loaded user account.

■ Add
Adds a user account.

■ Delete
Deleting a read user account.

■ (Close)
Closes User Account Setting Screen.

X
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******

User1

1

Edit Add Delete

DetailSecurity
Group

Password

User Name

User ID
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This chapter describes in detail on how to setup the online function and the operation of the MICRO/I.

  

1.1 How the Online Function is Used

The online function enables communication with the MICRO/I in WindO/I-NV4. This communication between 
WindO/I-NV4 and the MICRO/I, implemented using an exclusive protocol called maintenance communication.
The online function enables the following.

•  Write a project data into the MICRO/I.

• Write files to an external memory device*1 inserted in the MICRO/I.

*1 SD memory card for HG5G/4G/3G/2G-V, HG4G/3G and HG2G-5F, USB flash drive for HG2G-5T and HG1G/1P
*2 This is applicable for models with an audio interface only.
*3 This is applicable for models with a video interface only.

Chapter 24 Online Function

1 Communicating with the MICRO/I

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

Computer

Download

MICRO/I

Project data

When project data is downloaded using the online function, the Alarm Log data, Data Log data, and 
Operation Log data in the data storage area are deleted. All internal devices except for the HMI Keep 
Register (LKR) and HMI Keep Relay (LK) are cleared.

• The following functions can be executed with downloading of project data.
- Download optional fonts and Kanji dictionary data.
- Download the runtime system.
- Download recipe files, picture files, sound files*1 and Custom Web Page files to the External Memory 

Device folder in the external memory device inserted into the MICRO/I.
- Clear the HMI Keep Register (LKR) and HMI Keep Relay (LK) after download.
- Clear the HMI Keep Register (LKR), HMI Keep Relay (LK), Alarm Log Data, Data Log Data and 

Operation Log Data after download.
• For details on writing project data to an external memory device inserted in the computer, refer to 

Chapter 31 “Downloading” on page 31-10.

Computer
MICRO/I

Download

Recipe file

Picture file

Sound file

Custom Web Page file

Movie file

Movie file list

USB flash drive

SD memory card

External memory device

*2

*3

*3

*1
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• Read the project data downloaded to the MICRO/I and then save it to a computer.

• Delete the data stored in the internal memory or the external memory device*1 inserted in the MICRO/I and format 
the external memory device inserted in the MICRO/I.

• Display the information about the runtime system and project data of the MICRO/I.

*1 SD memory card for HG5G/4G/3G/2G-V, HG4G/3G and HG2G-5F, USB flash drive for HG2G-5T and HG1G/1P
*2 This is applicable for models with an audio interface only.

Computer

Upload

MICRO/I

Project data

• It is possible to upload recipe files, picture files, sound files*2 and Custom Web Page files from the 
External Memory Device folder in the external memory device inserted in the MICRO/I, together with 
uploading of project data.

• For details on reading project data saved on an external memory device using WindO/I-NV4, refer to 
Chapter 31 “Uploading” on page 31-12.

MICRO/I

Computer
Deleting data

Deleting data
Formatting

External memory device

USB flash drive

SD memory card

*1

Computer MICRO/I

System 
Information
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• Edit a project data in WindO/I-NV4 while checking MICRO/I operation by displaying and changing values of device 
addresses and switching screens using the monitor function.

Computer External device

Screen monitor

LDR1= 0 130

MICRO/I

130

Computer

Switches to Base Screen 2.

MICRO/I

Full
Tank 1

130

External device

External device

Base Screen 1

Base Screen 2

For details about monitor function, refer to Chapter 25 “1 Monitoring with WindO/I-NV4” on page 25-1.
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1.2 Connect MICRO/I to a Computer

Connection type varies based on the interface between the MICRO/I and computer.

● USB cable connection
The computer must be running Windows XP/Vista (32-bit edition only), or Windows 7/8/10 (64-bit and 32-bit 
versions), and must have a USB 1.1/2.0 port.

● Ethernet cable connection
The computer must be equipped with an Ethernet port.

MICRO/IComputer

USB cableA plug Mini-B plug

To USB port To USB interface

A USB driver must be installed when connecting the MICRO/I to a computer with a USB cable. 
Install the USB driver when making the connection for the first time. For details, open Automation Organizer 
V2 from the Start Screen or Start Menu and refer to "How to install USB driver".
The USB driver does not have to be installed for subsequent connections. Note, the connection must use the 
same USB port that was connected to when installing the USB driver. The computer will not recognize the 
MICRO/I immediately if the USB cable is connected to a different USB port.

• Multiple MICRO/I connections using different USB ports on the same computer are not supported.
• The computer cannot be connected to the MICRO/I via a USB hub.

Computer

Ethernet cable

To Ethernet port To Ethernet interface

MICRO/I

It is necessary to configure the MICRO/I according to the local network that is used.
On the Communication Interface tab in the Project Settings dialog box, specify the IP address, subnet 
mask, and default gateway, and clear the Forbid Maintenance Communication check box. For details, 
refer to Chapter 4 “3.2 Communication Interface Tab” on page 4-35.
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1.3 Change Communication Settings

To communicate with the MICRO/I in WindO/I-NV4, configure the settings such as communication speed and port 
used to match the connection method for the MICRO/I.

1 On the Home tab, in the Project group, click Comm.Setup.

The Communication Settings dialog box is displayed.

2 Change the settings on each tab as necessary and then click OK.

■ Communicate with
Select the device to communicate with from the following items.

MICRO/I: Communicate with the MICRO/I connected to the computer.
For details, refer to “Using the online function for Ethernet communication” on page 24-7.

External Memory Device: Read or write data to the external memory device inserted in the computer.
For details, refer to Chapter 31 “1.5 Reading/Writing Data” on page 31-4.

MICRO/IComputer

USB cable

Ethernet cable
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■ Port
Select the communication port on the computer from the following items.

■ Time Out (min)
Specify the time to wait for a response from the MICRO/I (0 minute to 20 minutes).

USB: Connect the USB port on the computer to the USB interface on the MICRO/I.

Ethernet: Connect the Ethernet port on the computer to the Ethernet interface on the MICRO/I.

• The port number is 2537 when connecting from WindO/I-NV4 to the MICRO/I via Ethernet.
• The default network settings configured on the MICRO/I are as follows.

IP Address: 192.168.0.1
Subnet Mask: 255.255.255.0
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● Using the online function for Ethernet communication
Select Ethernet under Port on the Communication Settings dialog box.

To download project data

Click Download in the Download dialog box to display the Target IP Address dialog box. 
Specify the Ethernet settings (IP address, subnet mask, default gateway, and port number) for the MICRO/I.
Select the MICRO/I IP addresses and you can batch download project data to multiple MICRO/I.
It is also possible to change the Ethernet settings (IP address, subnet mask, default gateway, and port number) for 
the MICRO/I to which you are downloading after project data is downloaded.

■ Target List

■ Add
Adds a download destination for project data to the Target List. Click this button to open the Target IP Address 
dialog box. Using the Target IP Address dialog box, specify the Ethernet settings for the MICRO/I to which you are 
downloading.

■ Edit
Changes the settings of the Target List.
Select a download destination from the Target List, and then click this button to open the Target IP Address dialog 
box. Using the Target IP Address dialog box, change the Ethernet settings for the MICRO/I to which you are 
downloading.

■ Delete
Deletes download destinations from the Target List.

■ Browse
Open IP Address Manager. Specify the IP address for the target MICRO/I with IP Address Manager. For details, refer to 
“IP Address Manager” on page 24-11.

It is necessary to configure the MICRO/I according to the local network that is used.
On the Communication Interface tab in the Project Settings dialog box, configure the IP address, subnet 
mask, default gateway, and port number, and clear the Forbid Maintenance Communication check box. 
For details, refer to Chapter 4 “3.2 Communication Interface Tab” on page 4-35.

Target IP Address: Displays the current IP address for the MICRO/I to download the project data to.

Target Port Number: Displays the current port number for the MICRO/I to download the project data to.

Set IP Address: Displays the IP address for the MICRO/I after downloading the project data.

Set Subnet Mask: Displays the subnet mask for the MICRO/I after downloading the project data.

Set Default Gateway: Displays the default gateway for the MICRO/I after downloading the project data.

Port Number: Displays the port number for the MICRO/I after downloading the project data.

Even if the Ethernet settings of the MICRO/I are changed by using the Target IP Address dialog box when 
downloading a project, the Ethernet settings in the editing project data are not changed.
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■ Search
Search for MICRO/I on the same network that can be connected to a computer via Ethernet communication.
Click this button to display the Search MICRO/I dialog box. For details, refer to “The Search MICRO/I dialog box” on 
page 24-9.

Target IP Address Settings dialog box
Specifies the IP address of the MICRO/I used for communication.

■ Target IP Address
Specify the IP address for the target MICRO/I to execute this function.

■ Target Port Number
Specify the port number for the target MICRO/I to execute this function.

■ Change the network settings to following after downloading the project data
Select the check boxes to change the Ethernet settings of the target MICRO/I after project data is downloaded.

IP Address: Enter the IP address to register in the project data. 

Subnet Mask: Enter the subnet mask to register in the project data.

Default Gateway: Enter the default gateway to register in the project data.

Port Number: Enter the port number to register in the project data.

Regarding TCP port number of MICRO/I, note the following points.

The numbers that cannot be used: • 2538 (for pass-through)
• 2101 (for FC4A Series MicroSmart direct connection pass-through)

Duplicate numbers cannot be configured in the following functions:

• Maintenance communication 
( refer to Chapter 4 “Port Number” on page 4-40)

• Web server function 
( refer to Chapter 4 “Port Number” on page 4-65)

• FTP server function 
( refer to Chapter 4 “Port Number” on page 4-66)

• TCP Server is selected for the User Communication 
( refer to Chapter 4 “Port No.” on page 4-42)

• Modbus as Manufacture and Modbus TCP Server as 
Communication Driver are selected on the Communication 
Driver tab 
( refer to the WindO/I-NV4 External Device Setup Manual)

• YASKAWA Electric as Manufacture and MP2000(Ethernet) as 
Communication Driver are selected on the Communication 
Driver tab 
( refer to the WindO/I-NV4 External Device Setup Manual)
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The Search MICRO/I dialog box
The result of the search performed by clicking the Search in the Target IP Address dialog box is displayed.

■ (Results List)
Displays the information of MICRO/I as search results. Selects the MICRO/I to register in the Target List on the 
Target IP Address dialog box.

■ Re-search
Search again for MICRO/I on the same network

■ Select
Closes the Search MICRO/I dialog box, and then registers the MICRO/I selected from the (Results List).

■ Close
Closes the Search MICRO/I dialog box.

IP Address: Displays the IP address of the MICRO/I.

MAC Address: Displays the MAC address of the MICRO/I.

Type Number: Displays the part number of the MICRO/I.

Port Number: Displays the port number of the MICRO/I.

If there is a MICRO/I of the IP address already registered in the Target List on the Target IP Address 
dialog box, an overwrite confirmation message is displayed.
• Click Yes to overwrite and save the MICRO/I of the IP address displayed in the confirmation message.
• Click Yes To All to overwrite and save the MICRO/Is of all IP addresses.
• Click No to display the next confirmation message without overwriting the MICRO/I of the IP address 

displayed in the confirmation message.
• Click Cancel to stop importing the MICRO/I of the IP address.
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To execute any function except project data download

The Target IP Address dialog box will be displayed when any of the following functions are executed.
• Upload a project data.
• Upload data from an external memory device inserted in the MICRO/I.
• Delete data stored in the internal memory.
• Delete data from or formatting an external memory device inserted in the MICRO/I.
• Display information about runtime system and project data.
• Monitor the MICRO/I.
Specifies the IP address of the MICRO/I used for communication.

■ Target IP Address
Specify the IP address for the target MICRO/I to execute this function.

Click  to display IP Address Manager. Specify the IP address for the target MICRO/I with IP Address Manager.

■ Target Port Number
Specify the port number for the target MICRO/I to execute this function.
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● IP Address Manager
You can register target Ethernet settings for performing online function via Ethernet communication to the project 
data.

■ IP Address List
Ethernet settings registered in the project data are displayed in this list.

■ IP Address
Enter the IP address to register in the project data.

■ Subnet Mask
Enter the subnet mask to register in the project data.

■ Default Gateway
Enter the default gateway to register in the project data.

■ Port Number
Enter the port number to register in the project data.

■ Comment
Enter comment to register in the project data.

■ Add New
Adds IP Address, Subnet Mask, Default Gateway, Port Number, and Comment to the list.

■ Delete
Deletes the selected IP address from the list.

■ Select
Closes IP Address Manager, and apply the Ethernet settings selected from the list.

IP Address: Displays the IP address.

Subnet Mask: Displays the subnet mask.

Default Gateway: Displays the default gateway.

Port Number: Displays the port number.

Comment: Displays comment.
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2.1 Downloading Project Data to the MICRO/I

1 Change communication settings according to the connection method between the computer and the MICRO/I.
In the Communication Settings dialog box, select MICRO/I from Communicate with. For details, refer to “1.3 
Change Communication Settings” on page 24-5.

2 Open a project to download.

3 On the Home tab, in the Project group, click the Download icon.

The Download dialog box is displayed.

4 Select data for download under Download Data.

■ All
Download the entire project data.

■ Modified Data Only
Downloads files modified since the previous download.
If download fails, select All to download.

2 Downloading

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

To download a project without opening it, on the Home tab, in the Project group, click the Download 
icon. The Open dialog box is displayed. Select a file then click Open. The Download dialog box is displayed. 
Proceed to Step 4.

When project data is downloaded to the MICRO/I, the MICRO/I screen data is overwritten.

If the project data was changed, a confirmation message to save the project data is displayed.
• Click OK to save the project data and display the Download dialog box.
• Click Cancel to return to the editing screen without saving the project data.
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5 Click Download.

• When Communicate with is set to MICRO/I and Port to USB, the project data starts downloading.
• When Communicate with is set to MICRO/I and Port to Ethernet, the Target IP Address dialog box is 

displayed. Specify the IP address of the MICRO/I, and then click OK to start the download. For details, refer to “To 
download project data” on page 24-7.

6 Click Yes.

The Download Project dialog box is displayed and downloads the project.
When finished downloading, a completion message is displayed.

7 Click OK.

8 Click Close on the Download Project dialog box.

This concludes downloading project data.

If security is enabled in the MICRO/I project, the Enter Password dialog box is displayed. Enter the 
password.
For details, refer to Chapter 23 “User Accounts and the Security Function” on page 23-1.

• Do not turn off the MICRO/I while project data is downloading.
• Turn the power of the MICRO/I off and on and download the project data once again if the following 

conditions occur:
- The project data downloading failed, then WindO/I-NV4 cannot communicate with the MICRO/I.
- The cable was disconnected or the power was turned off while WindO/I-NV4 and the MICRO/I were 

communicating, and MICRO/I no longer responds
• If project data is repeatedly downloaded with Modified Data Only, the free space in the MICRO/I's 

internal memory will be used up and the download will fail. In this case, select All and attempt the 
download again.

For details on writing project data to an external memory device inserted in the computer, refer to Chapter 
31 “Downloading” on page 31-10.
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2.2 Download Dialog Box

This section describes items and buttons of the Download dialog box.

■ Communication Settings

■ Download Data
Selects data to be downloaded.

■ Download Runtime system
Select this check box to force download runtime system, irrespective of the runtime system version of the MICRO/I, 
when downloading project data. Normally this option should not be used.

■ Download Fonts and Kanji Dictionary Data
Select this check box to download the following fonts and the dictionary data to the MICRO/I, when downloading 
project data.
• Standard Fonts
• optional fonts are selected on the Font/Kanji Dictionary Data tab in the Project Settings dialog box
• Kanji Dictionary Data

For details, refer to Chapter 4 “3.16 Font/Kanji Dictionary Data Tab” on page 4-75.

Communicate with: Available computer devices are displayed.

Port: Available communication ports on the computer are displayed.

Change: Changes communication settings. Click this button to display the Communication Settings dialog 
box. For details, refer to “1.3 Change Communication Settings” on page 24-5.

All: All project data is downloaded.

Modified Data Only: Only files that were updated since the previous download are downloaded.
If an upload fails, select All to download.

When the Use Kanji dictionary data check box on the Font/Kanji Dictionary Data tab in the Project 
Settings dialog box is not selected, the Kanji dictionary data is not downloaded even if this check box is 
selected. When this check box is cleared and a project download is executed, deletes the Kanji dictionary 
data stored in the download destination.
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■ Clear the following data
Select the values and data to clear after you download project data from the following.
Values of Keep Devices, Alarm Log Data, Data Log Data, Operation Log Data

■ Download following files to External Memory Device

■ Download
• When Communicate with is set to MICRO/I and Port to USB, the project data starts downloading.
• When Communicate with is set to MICRO/I and Port is set to Ethernet, the Target IP Address dialog box is 

displayed. Specify the IP address of the MICRO/I, and then click OK to start the download. For details, refer to “To 
download project data” on page 24-7.

• When Communicate with is set to External Memory Device, the Select Drive dialog box is displayed. Select 
the external memory device drive, then click OK to start the download. For details, refer to “2.3 Downloading Files 
to an External Memory Device Inserted in the MICRO/I” on page 24-16.

*1 This is applicable for models with an audio interface only.

• When project data that changes the settings of the data storage area or the system software is 
downloaded, all of the values of Keep Devices and log data are cleared.

• When project data that changes the settings of the Alarm Log Settings, the Data Log Settings or the 
Operation Log Settings is downloaded, all of the log data are deleted.

Recipe Files: Select this check box to create a RECIPE folder or recipe files in the External Memory 
Device folder on an external memory device inserted in the MICRO/I when downloading 
projects. Only on channels for which Save to in the Recipe Settings dialog box is set to 
External Memory Device, and Recipe Function is set to Use.
• When Download Data is set to All, recipe files are created for all channels for which 

recipe data is set.
• When Download Data is set to Modified Data Only, only recipe files on channels 

where recipe data has changed are created.

Picture Files: Select this check box to create the PICTURE folder under the External Memory Device 
folder on the external memory device inserted in the MICRO/I and to save the picture files 
when downloading project. Out of the pictures registered in Picture Manager, the picture 
files that are saved are those picture files that have been selected with the check box on the 
picture list.

Sound Files*1: Select this check box to create the SOUND folder under the External Memory Device folder 
on the external memory device inserted in the MICRO/I and to save the sound files when 
downloading project. The sound files that are saved are those with Save To set to External 
Memory Device under settings in the Sound Settings dialog box.

Custom Web Page Files: Select this check box to create the WEBPAGE folder under the External Memory Device 
folder on the external memory device inserted in the MICRO/I and to save the Custom Web 
Page files when downloading project. The Cutom Web Page files that are displayed in the 
Web Page Editor on the Project window.

Do not turn off the MICRO/I while project data is downloading.

If project data downloading fails and communication is not possible, turn the MICRO/I off and on then 
download the data once again.
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2.3 Downloading Files to an External Memory Device Inserted in the MICRO/I

Specified files can be downloaded to an external memory device*1 inserted in the MICRO/I. The files are downloaded 
to External Memory Device folder specified in the Project Settings dialog box for the current project.

1 Insert the external memory device into the MICRO/I.

2 Change communication settings according to the connection method between the computer and the MICRO/I.

In the Communication Settings dialog box, select MICRO/I from Communicate with. For details, refer to “1.3 
Change Communication Settings” on page 24-5.

3 On the Home tab, in the Project group, click the arrow under Download.

4 Select the method for downloading the file to the external memory device.

The Open dialog box is displayed.

■ Files to External Memory Device
Stops operation of the MICRO/I and downloads the file to the external memory device inserted in the MICRO/I. When 
the file download is complete, operation resumes.

■ Files to External Memory Device while running
Downloads the file to the external memory device inserted in the MICRO/I without stopping operation of the MICRO/I.

*1 SD memory card for HG5G/4G/3G/2G-V, HG4G/3G and HG2G-5F, USB flash drive for HG2G-5T and HG1G/1P

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

MICRO/I

External memory device

USB flash drive

SD memory card

While editing project data, even if you click the arrow under Download in the Transfer group on the 
Online tab, the download menu will be displayed.
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5 Select the file, and then click Open.

• When Communicate with is set to MICRO/I and Port to USB, the file starts downloading.
• When Communicate with is set to MICRO/I and Port to Ethernet, the Target IP Address dialog box is 

displayed. Specify the IP address of the MICRO/I, and then click OK to start the download. For details, refer to “To 
execute any function except project data download” on page 24-10.

6 Click Yes.

The Download dialog box is displayed and downloads the file.

When finished downloading, a completion message is displayed.

7 Click OK.

If security is enabled in the MICRO/I project, the Password Screen is displayed. Select the user name and 
enter the password.
For details, refer to Chapter 23 “User Accounts and the Security Function” on page 23-1.



2 Downloading

24-18 WindO/I-NV4 User’s Manual

8 Click Close in the External Memory Device Maintenance dialog box.

To create a recipe file on an external memory device inserted in the computer, use Save Recipe Files in 
External Memory Device in the Recipe Settings dialog box. For details, refer to Chapter 18 “Creating 
Recipe Files in the Recipe Settings Dialog Box” on page 18-17.
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Project data in the MICRO/I or in an external memory device inserted in a computer can be read using WindO/I-NV2 
and saved to the computer.

3.1 Upload Project Data from the MICRO/I

1 Change communication settings according to the connection method between the computer and the MICRO/I.

In the Communication Settings dialog box, select MICRO/I from Communicate with. For details, refer to “1.3 
Change Communication Settings” on page 24-5.

2 On the Home tab, in the Project group, click the Upload icon.

• When Communicate with is set to MICRO/I and Port is set to USB, the Upload dialog box is displayed.
• When Communicate with is set to MICRO/I and Port is set to Ethernet, the Target IP Address dialog box is 

displayed. Specify the IP address of the MICRO/I, and then click OK to start the upload. For details, refer to “To 
execute any function except project data download” on page 24-10.

3 Uploading

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

While editing project data, project data can be uploaded from the MICRO/I even by clicking the Upload 
icon in the Transfer group on the Online tab.

If project data is being edited, project data will be closed. If the project data was changed, a confirmation 
message to save the project data is displayed.
• Click Yes to save the project data and display a dialog box corresponding to the communication settings.
• Click No to close the project data without saving changes and display a dialog box corresponding to the 

communication settings.
• Click Cancel to stop uploading and return to the editing screen without saving the project data.

If security is enabled in the MICRO/I project, the Password Screen is displayed. Enter the password.
For details, refer to Chapter 23 “User Accounts and the Security Function” on page 23-1.
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3 Check the project data details, and then click Upload.

If there is a project file with the same file name in the upload folder, an overwrite confirmation message is displayed.
• Click Yes to start uploading the project data.
• Click Cancel to stop uploading the project data.
When finished uploading, a completion message is displayed.

■ Project Name
The project is saved with the currently displayed name. To change the project name, enter a new name for the file. 
The maximum number is 50 characters.

■ Location
The uploaded project file is saved to the currently displayed location. To change the location of the saved file, 

click . The Browse folders dialog box is displayed. Select a location, and then click OK.

4 Click OK.

5 Click Close on the Upload dialog box.

A confirmation message to open the project is displayed.

You cannot use the following characters in the project name.
   \ / : * ? " < > |
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6 Click OK.

The uploaded project opens.
This concludes uploading of project data.

If a password has been configured for the project data, the Enter Password screen will be displayed. 
The password to enter varies based on the check box setting of the Use Password to open a Project 
found under the Options tab in the Security dialog box.
When this check box is selected, enter the password for Use Password to open a Project.
When this check box is cleared, enter the password for the user account assigned to the Administrator 
security group.
For details, refer to Chapter 23 “User Accounts and the Security Function” on page 23-1.

For details on reading project data saved on an external memory device using WindO/I-NV4, refer to 
Chapter 31 “Uploading” on page 31-12.
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3.2 Upload Dialog Box

This section describes the settings and buttons of the Upload dialog box.

■ Project Name
The project is saved with the currently displayed name. To change the project name, enter a new name for the file. 
The maximum number is 50 characters.

■ Type Number
Displays the type number selected in project data downloaded to the MICRO/I.

■ Modified
Displays the time that project data downloaded to the MICRO/I was last saved in WindO/I-NV4.

■ Location
Specifies the location for saving uploaded project files.

Click  to display the Browse folders dialog box. Select the location for saving, then click OK.

■ Upload files used in this project from the External Memory Device
To upload files located on an external memory device inserted in the MICRO/I that are used by the project together 
with project data, select the file to be uploaded from the following.

Recipe Files, Picture Files, Sound Files*1, Custom Web Page Files

■ Upload
Starts uploading of project data.

■ Cancel
Stops uploading of project data.

*1 This is applicable for models with an audio interface only.

You cannot use the following characters in the project name.
   \ / : * ? " < > |
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3.3 Uploading Files from an External Memory Device Inserted in the MICRO/I

Specified data can be uploaded from the External Memory Device folder on the external memory device for the 
currently running project.

1 Insert the external memory device into the MICRO/I.

2 Change communication settings according to the connection method between the computer and the MICRO/I.

In the Communication Settings dialog box, select MICRO/I from Communicate with. For details, refer to “1.3 
Change Communication Settings” on page 24-5.

3 On the Home tab, in the Project group, click the arrow next to Upload.

4 Click Stored Data in External Memory Device.

The Upload from External Memory Device dialog box appears.

5 Select the items to be uploaded, and then specify the destination folder in the Location box.

MICRO/I

External memory device

USB flash drive

SD memory card

Even if you click the arrow under Upload in the Transfer group on the Online tab, the upload menu will 
be displayed.
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Uploadable data is as follows.
• Screenshots
• Alarm Log Files
• Data Log Files
• Operation Log Files
• Recipe Files
• Picture Files

• Sound Files*1

• Movie File List*2

• Movie Files*2

6 Click OK.

The External Memory Device Maintenance dialog box appears and the data upload begins.
A message box appears when the data upload is complete.

7 Click OK.

8 Click Close on the External Memory Device Maintenance dialog box.

*1 This is applicable for models with an audio interface only.
*2 This is applicable for models with a video interface only.

If security is enabled for the project on MICRO/I, a dialog appears for you to enter a user name and 
password. For details, refer to Chapter 23 “User Accounts and the Security Function” on page 23-1.

• Click  to call up the Select a Folder dialog box and specify the destination folder for uploading.
• After starting WindO/I-NV4, screen shots, alarm log data, data log data, and recipe files can be uploaded 

from an External Memory Device folder without opening project data.
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Deletes data from the MICRO/I or from an external memory device*1 inserted in the MICRO/I.

4.1 Clear Data from the MICRO/I

1 Change communication settings according to the connection method between the computer and the MICRO/I.
In the Communication Settings dialog box, select MICRO/I from Communicate with. For details, refer to “1.3 
Change Communication Settings” on page 24-5.

2 Open project data.

3 On the Online tab, in the MICRO/I group, click Clear, then click the data to be deleted.

■ All
Deletes project data, Alarm Log data, Data Log data, and Operation Log data. It also clears the values from all device 
addresses.

■ Alarm Log Data
Deletes the data collected by the Alarm Log function.

■ Data Log Data
Deletes the data collected by the Data Log function.

■ Operation Log Data
Deletes the data collected by the Operation Log function.

■ Values of All Device Addresses
Clears the values of all device addresses.

■ Stored Data in External Memory Device
After stopping operation, deletes data saved to the External Memory Device folder on an external memory device.
Click this to display the Clear Data dialog box. For details, refer to “4.2 Deleting Data from an External Memory Device 
Inserted in the MICRO/I” on page 24-27.

• When Communicate with is set to MICRO/I and Port to USB, deletion of the data starts.
• When Communicate with is set to MICRO/I and Port is set to Ethernet, the Target IP Address dialog box is 

displayed. Specify the IP address of the MICRO/I, and then click OK to start deletion of the data. For details, refer 
to “To execute any function except project data download” on page 24-10.

*1 SD memory card for HG5G/4G/3G/2G-V, HG4G/3G and HG2G-5F, USB flash drive for HG2G-5T and HG1G/1P

4 Clear

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

If security is enabled in the MICRO/I project, the Password Screen is displayed. Enter the password.
For details, refer to Chapter 23 “User Accounts and the Security Function” on page 23-1.
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4 Click Yes.

5 Click Close.

This concludes clearing data.
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4.2 Deleting Data from an External Memory Device Inserted in the MICRO/I

1 Change communication settings according to the connection method between the computer and the MICRO/I.

In the Communication Settings dialog box, select MICRO/I from Communicate with. For details, refer to “1.3 
Change Communication Settings” on page 24-5.

2 Open project data.

3 On the Online tab, in the MICRO/I group, click Clear, then click Stored Data in External Memory Device.

The Clear Data dialog box is displayed.

4 Select the check box for the data items to be deleted from the External Memory Device folder.

Screenshot, Alarm Log files, Data Log files, Operation Log files, and Recipe Files

5 Click OK.

• When Communicate with is set to MICRO/I and Port to USB, deletion of the data starts.
• When Communicate with is set to MICRO/I and Port is set to Ethernet, the Target IP Address dialog box is 

displayed. Specify the IP address of the MICRO/I, and then click OK to start deletion of the data. For details, refer 
to “To execute any function except project data download” on page 24-10.

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

If security is enabled in the MICRO/I project, the Password Screen is displayed. Enter the password.
For details, refer to Chapter 23 “User Accounts and the Security Function” on page 23-1.
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6 Click Yes.

7 Click Close.

This concludes clearing data on the external memory device.
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Stops operation of the MICRO/I and formats an external memory device*1 inserted in the MICRO/I.

5.1 Formatting an External Memory Device Inserted in the MICRO/I

1 Change communication settings according to the connection method between the computer and the MICRO/I.

If communicating with a MICRO/I inserted in a computer, in the Communication Settings dialog box, select MICRO/I 
from Communicate with. For details, refer to “1.3 Change Communication Settings” on page 24-5.

2 Open project data.

3 On the Online tab, in the MICRO/I group, click Format.

• When Communicate with is set to MICRO/I and Port is set to USB, a formatting confirmation message is 
displayed.

• When Communicate with is set to MICRO/I and Port is set to Ethernet, the Target IP Address dialog box is 
displayed. Specify the IP address of the MICRO/I, and then click OK to display the formatting confirmation 
message. For details, refer to “To execute any function except project data download” on page 24-10.

4 Click Yes.

5 Click Close.

This concludes formatting the external memory device.

*1 SD memory card for HG5G/4G/3G/2G-V, HG4G/3G and HG2G-5F, USB flash drive for HG2G-5T and HG1G/1P

5 Formatting

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

If security is enabled in the MICRO/I project, the Password Screen is displayed. Enter the password.
For details, refer to Chapter 23 “User Accounts and the Security Function” on page 23-1.
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Displays information about the runtime system and downloaded project data of the MICRO/I.
This function can be used to show information about project data during editing and to simultaneously check details 
of project data downloaded to the MICRO/I.

6.1 Displaying System Information

1 Change communication settings according to the connection method between the computer and the MICRO/I.

If communicating with a MICRO/I inserted in a computer, in the Communication Settings dialog box, select MICRO/I 
from Communicate with. For details, refer to “1.3 Change Communication Settings” on page 24-5.

2 On the Home tab, in the Project group, click Target Info..

• When Communicate with is set to MICRO/I and Port is set to USB, the System Information dialog box is 
displayed.

• When Communicate with is set to MICRO/I and Port is set to Ethernet, the Target IP Address dialog box is 
displayed. Specify the IP address of the MICRO/I, and then click OK to display the System Information dialog box. 
For details, refer to “To execute any function except project data download” on page 24-10.

6 System Information

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

While editing project data, information about runtime system and project data can be displayed even by 
clicking Target Info. in the MICRO/I group on the Online tab.
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3 Check information about the runtime system and project data.

4 When you have finished checking the information, click OK.

5 Click Close.

This concludes checking system information.

• To check the optional fonts installed on the MICRO/I and the Kanji dictionary data, click Font/Kanji 
Dictionary Data Information. The Font Information dialog box is displayed. For details, refer to “Font/
Kanji Dictionary Data Information Dialog Box” on page 24-33.

• To check information about the external memory device inserted in the MICRO/I, click External Memory 
Device Information. The External Memory Device Information dialog box is displayed. For details, refer 
to “External Memory Device Information Dialog Box” on page 24-33.

• To check the communication driver set for the project that is downloaded to the MICRO/I, click 
Communication Driver Information. The Communication Driver Information dialog box is displayed. 
For details, refer to “Communication Driver Information Dialog Box” on page 24-34.
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6.2 Target Information Dialog Box

This section describes the settings and buttons of the Target Information dialog box.

■ Target Runtime Information

■ Target Project Information

■ Opened Project Information

Type Number: Shows the type number of MICRO/I

Runtime Version: Shows the runtime system version of the MICRO/I.

Memory Space (byte): Shows the maximum amount of project data (bytes) that can be downloaded to the MICRO/I.

Font/Kanji Dictionary Data Information:Checks the optional fonts and the Kanji dictionary data currently installed on 
the MICRO/I. Click this button to display the Font Information dialog box. For 
details, refer to “Font/Kanji Dictionary Data Information Dialog Box” on page 
24-33.

External Memory Device Information: Checks the state of an external memory device inserted in the MICRO/I, its 
total capacity, available capacity, and used capacity. Click this button to display 
the External Memory Device Information dialog box. For details, refer to 
“External Memory Device Information Dialog Box” on page 24-33.

Project Name: Shows the project name of projects downloaded to the MICRO/I.

Modified: Displays the time that project data downloaded to the MICRO/I was last saved in 
WindO/I-NV4.

Project Version: Displays the version of WindO/I-NV4 used to create the project data downloaded to the 
MICRO/I.

Communication Driver Information: Checks the communication driver configured in the project downloaded to the 
MICRO/I.
Click this button to display the Target Communication Driver Information dialog 
box. For details, refer to “Communication Driver Information Dialog Box” on 
page 24-34.

Project Name: Shows the project name of the project being edited.

Modified: Displays the time that the project being edited was last saved in WindO/I-NV4.

Project Version: Displays the version of WindO/I-NV4 used to create the project being edited.

This function can be used to show information about a project that is being edited and simultaneously check 
information about project data downloaded to the MICRO/I.
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Font/Kanji Dictionary Data Information Dialog Box

This dialog box is used to check the state of installed optional fonts and the Kanji dictionary data.

The installation status of each optional font and the Kanji dictionary data are shown to the right of the font.
The following additional fonts can be installed.
• Japanese Large Font (First standard)
• Japanese Large Font (Second standard)
• Chinese
• Taiwanese
• Korean
• European Large Font
• Central European
• Baltic
• Cyrillic

External Memory Device Information Dialog Box

Checks the state of an external memory device*1 inserted in the MICRO/I, its total capacity, used capacity, and 
available capacity.

*1 SD memory card for HG5G/4G/3G/2G-V, HG4G/3G and HG2G-5F, USB flash drive for HG2G-5T and HG1G/1P

Status: Shows the state of the external memory device inserted in the MICRO/I.

Memory Capacity: Shows the total capacity of the external memory device inserted in the MICRO/I.

Used Space: Shows how much of the capacity of the external memory device inserted in the MICRO/I is 
currently in use.

Free Space: Shows how much of the capacity of the external memory device inserted in the MICRO/I is 
currently available for use.
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Communication Driver Information Dialog Box

Checks the communication driver configured in the project downloaded to the MICRO/I.

■ External Device Communication 1 to 4

Manufacturer: Displays the manufacturer of the external device.

Communication Driver: Displays the communication driver.

Communicate Driver Version: Displays the communication driver version.
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This chapter describes the monitor function that checks operation of the created project data.
Monitor function enables the values of internal devices and the values of the external device addresses to be checked 
and changed. This can be done in two ways: using WindO/I-NV4 on a computer connected to the MICRO/I, or directly 
on the screen of the MICRO/I.

  

1.1 How the Monitor Function in WindO/I-NV4 is Used

Monitor function in WindO/I-NV4 can be performed as follows.

• Checking values of device addresses used on the screen of the MICRO/I

• Checking values of specified device addresses

• Checking values of device addresses of sequential address numbers

Chapter 25 Monitor Function

1 Monitoring with WindO/I-NV4

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

Computer
MICRO/I

130

External device

Screen Monitor

LDR1

LM0

Displays device addresses used in a screen.

LDR1

LM0

Computer
MICRO/I

130

External device

Custom Monitor

Select device address

Computer
MICRO/I

130

External device
Batch Monitor

Sequential address numbers
LM0
LM1
LM2

Length: 3
(Starting address number)
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• Checking the state of external devices connected to the MICRO/I

• Displaying the value of device address in a popup

• Highlighting objects while satisfying conditions

Object List window Script Editor

Computer
MICRO/I

130

Disconnect

Connect
External device

External device

External Device Monitor

External Device ID: 0

External Device ID: 1

External Device ID: 0

External Device ID: 1

Popup 

Popup

Highlighted

Trigger Condition
  While satisfying the condition: LM0==1

LM0 = 0 1

Condition

Condition

Not satisfiedNot satisfiedNot satisfied

SatisfiedSatisfiedSatisfied
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• Switching to the screen of the MICRO/I

• Opening current screen

• Change values of device addresses and check the operation of project data offline

Computer
MICRO/I

Switches to Base Screen 2.

Full

Tank 1

External device

External device

Base Screen 1

Base Screen 2

130

Computer
MICRO/I

Opens 
Base Screen 2.
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Tank 1
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Tank 1

External device

External device

Base Screen 2

Base Screen 2

Click

Computer
MICRO/I

100
150
200

Disconnect External device
Custom Monitor in the Offline mode

D100
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D101

D100= 0

D101= 0

D102= 0

100

150

200
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1.2 Debugging in WindO/I-NV4

This section describes the procedure for monitoring values of device addresses and debugging in WindO/I-NV4.

1 Change the communication setting to match the connection method between computer and MICRO/I.

For details, refer to Chapter 24 “1.3 Change Communication Settings” on page 24-5.

2 On the Online tab, in the Monitors group, click Start Monitor.

The MICRO/I switches to monitor mode and Monitor Mode is displayed at the bottom left of the screen.

3 On the Online tab, in the Monitors group, click the following button or enter the number to the text box to switch 
the screen displayed on the MICRO/I to the Monitor screen.

■  (Back)
You are returned to the Base Screen that was displayed immediately before the screen was switched.

■  (Forward)

Advances to the Base Screen that was displayed immediately before the screen was switched using  (Back).

■  (First Screen)
Switches to the Base Screen of the lowest screen number in the project data.

■  (Previous Screen)
Switches to the Base Screen of screen number one lower than the Base Screen currently displayed. If the screen 
numbers are not sequential, switches to the screen of next lowest number.

■  (Specified Screen)
Switches to the Base Screen with the specified number.

■  (Next Screen)
Switches to the screen with screen number one higher than the Base Screen currently displayed. If the screen 
numbers are not consecutive, switches to the screen of next highest number.

■  (Last Screen)
Switches to the Base Screen of highest screen number in the project data.

If a password has been configured for the project data, the Enter Password screen will be displayed. Enter 
the password. For details, refer to Chapter 23 “User Accounts and the Security Function” on page 23-1.

To change values of device addresses and check the operation of project data offline, first switch to monitor 
mode, and then on the Online tab, in the Monitors group, click Go Offline.
The MICRO/I switches to offline mode and Offline mode is displayed at the bottom left of the screen.
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4 On the Online tab, in the Monitors group, click Open Current Screens.

 The screen displayed on MICRO/I opens in the editing window.

5 On the Online tab, in the Monitors group, select the monitor being used.

When monitoring starts, the screen monitor is displayed.

■ Screens
Automatically checks device addresses used on the screen displayed on the MICRO/I. For details, refer to “Screen 
Monitor” on page 25-6.

■ Object List
Displays values of device addresses in a popup on the Object List window. It also highlights objects while satisfying 
conditions. For details, refer to “1.3 Display the Value of Device Address in Popup” on page 25-18, and “1.4 
Highlighting Objects While Satisfying Conditions” on page 25-18.

■ Custom
Registers monitored device addresses individually and displays the value of device addresses. For details, refer to 
“Custom Monitor” on page 25-7.

■ Batch
Registers monitored device address as a batch for sequential address numbers and displays the value of device 
addresses. For details, refer to “Batch Monitor” on page 25-15.

■ External Devices
Displays the state of external devices connected to the MICRO/I. For details, refer to “External Device Monitor” on 
page 25-17.

6 Check operation of project data by monitoring and changing values of device addresses, and edit project data if there 
is an error.

If the monitored screen is switches, repeat steps 3 through 4.

7 Download the edited project data to the MICRO/I.

8 On the Online tab, in the Monitors group, click Stop Monitor.

To reflect edits made during debugging, it is necessary to perform a download.

To switch from offline mode to monitor mode, on the Online tab, in the Monitors group, click Go Online.
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● Screen Monitor
Automatically displays device addresses used on the screen displayed on the MICRO/I. Enables values of device 
addresses to be monitored and changed.

■ Device Address
Displays the device addresses used on the screen displayed on the MICRO/I.

 next to Comment toggles between showing and hiding comments. When comments are displayed, click  to 
display a popup menu, then click Comment and select the check box.

■ Comment
Displays comments on device addresses saved in Tag Editor. Comments are displayed only after you click  next to 
Device Address to display a popup menu, then click Comment and select the check box. 

■ Data Type
Selects the data format of the displayed value. For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

■ Words
Specify the number of word devices (1 to 16) stored the display value. 2 single-byte characters can be displayed by 1 
word.
This option can only be configured String(European), String(Japanese), String(Chinese), 
String(Taiwanese), String(Korean), String(Central European), String(Baltic) or String(Cyrillic) is selected 
as Data Type.
The storage order for word device address data is set according to Storage Method of String Data on the System 
tab in the Project Settings. For details, refer to Chapter 4 “Storage Method of String Data” on page 4-28.

■ Value
Enables values of device addresses to be display and changed. The value range depends on the data type. For details, 
refer to Chapter 2 “1.1 Available Data” on page 2-1.

■ Hexadecimal, Binary
Displays the current value of device address in hexadecimal and binary format. To change a value, double-click a cell 
and then specify a value.
The value range depends on the data type. For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Comments are displayed only after you click  next to Value to display a popup menu and then select the HEX and 
BIN check box.

UBIN16(W), BIN16(I), UBIN32(D), BIN32(L), BCD4(B), BCD8(EB), Float32(F):

Displays the current value of device address in decimal format. To change a value, double-click a cell and then 
enter a value.
The value range depends on the data type. For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Click  to toggle display of HEX and BIN format. To display HEX and BIN values, click  to display a popup 
menu, then click HEX and BIN and select the check box.

String(European), String(Japanese), String(Chinese), String(Taiwanese), String(Korean), 
String(Central European), String(Baltic), String(Cyrillic):

Displays the current value of device address in string. To change a value, double-click a cell and then enter the 
messages in the language selected.
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● Custom Monitor
Enables the values of registered device addresses to be monitored and changed.

■ Add to List
Saves device addresses registered in Monitor to project data as a device address list. A saved lists can be monitored 
by selecting it from the List.
Click this button to display the Device Address List Name Setting dialog box. For details, refer to “Saving Registered 
Device Addresses to Project Data as a Device Address List” on page 25-11.

■ Device Address
Registers the device addresses to monitor individually.
Click this button to display the Tag Editor. For details, refer to “Registering the device addresses to monitor 
individually” on page 25-9.

■ Script
Batch saves all device addresses used in a script.
Click this button to display Script Manager. For details, refer to “Batch Saving Device Addresses Used in Scripts” on 
page 25-9.

■ Import
Imports the device addresses from a device address list saved as a CSV text file.
Click this button to display the Device Address List dialog box. For details, refer to “Importing Device Addresses from 
a Device Address List” on page 25-13.

■ Export
Saves the device addresses displayed in Monitor as a CSV text file. This file is called a Device Address List.
Click this button to display the Save As dialog box. For details, refer to “Saving a Device Address List as a CSV File” on 
page 25-12.
The saved device address list can be imported using Import.

■ Clear
Deletes all the device addresses displayed in Monitor.

■ List
Displays a device address list saved with the project data.
Select a list to clear the device addresses shown in Monitor and display the device addresses in the list.
Double-click a cell to display the Device Address List Name Setting dialog box. The name of the device address list can 
be edited.
Select a list and press DELETE to delete it from the List.



1 Monitoring with WindO/I-NV4

25-8 WindO/I-NV4 User’s Manual

■ Monitor
The registered device addresses are displayed in a list.
Select the device address list from the List to show the device addresses registered in the list.

Device Address: The registered device addresses are displayed.

Double-click a cell to register or change a device address. Click  to display the Tag Editor. 
For details on how to configure device address settings, refer to Chapter 2 “5.1 Device Address 
Settings” on page 2-68.

 toggles between showing and hiding comments. When comments are displayed, click  to 
display a popup menu, then click Comment and select the check box.

Comment: Displays comments on device addresses saved in Tag Editor. Comments are displayed only 
after you click  next to Device Address to display a popup menu, then click Comment and 
select the check box.

Data Type: Selects the data format of the displayed value. For details, refer to Chapter 2 “1.1 Available 
Data” on page 2-1.

Words: Specify the number of word devices (1 to 16) stored the display value. 2 single-byte characters 
can be displayed by 1 word.
This option can only be configured String(European), String(Japanese), 
String(Chinese), String(Taiwanese), String(Korean), String(Central European), 
String(Baltic) or String(Cyrillic) is selected as Data Type.
The storage order for word device address data is set according to Storage Method of 
String Data on the System tab in the Project Settings. For details, refer to Chapter 4 
“Storage Method of String Data” on page 4-28.

Value: Enables values of device addresses to be display and changed. The value range depends on 
the data type. For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

UBIN16(W), BIN16(I), UBIN32(D), BIN32(L), BCD4(B), BCD8(EB), Float32(F):

Displays the current value of device address in decimal format. To change a value, double-
click a cell and then enter a value.
The value range depends on the data type. For details, refer to Chapter 2 “1.1 Available 
Data” on page 2-1.

Click  to toggle display of HEX and BIN format. To display HEX and BIN values, click  
to display a popup menu, then click HEX and BIN and select the check box.

String(European), String(Japanese), String(Chinese), String(Taiwanese), 
String(Korean), String(Central European), String(Baltic), String(Cyrillic):

Displays the current value of device address in string. To change a value, double-click a cell 
and then enter the messages in the language selected.

Hexadecimal, Binary: Displays the current value of device address in hexadecimal and binary format. To change a 
value, double-click a cell and then specify a value.
The value range depends on the data type. For details, refer to Chapter 2 “1.1 Available Data” 
on page 2-1.
Comments are displayed only after you click  next to Value to display a popup menu and 
then select the HEX and BIN check box.
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Registering the device addresses to monitor

Registering the device addresses to monitor individually

Click Device Address. Or, double-click a cell under Device Address in Monitor, and then click .
The Tag Editor is displayed. For details on configuring device address settings, refer to Chapter 2 “5.1 Device Address 
Settings” on page 2-68.

Batch Saving Device Addresses Used in Scripts

1 Click Script.

Script Manager is displayed.
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2 Select the script ID of the script for the device address to be batch-saved, and then click Select.

All the device addresses used by the script are registered.
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Saving Registered Device Addresses to Project Data as a Device Address List

If registered device addresses are saved with project data as a list, then even when the project data is later reopened, 
the device addresses can be called from the List to be reutilized.

1 Click Add to List.

The Device Address List Name Setting dialog box is displayed.

2 Enter a name for the device address list.

The maximum number is 40 characters. 

3 Click OK.

The device address list is added to the List.

4 Saving project data.

The following characters cannot be used for names of device address list.
 \ / : ; * ? " < > |

If a project file is closed without saving, device address lists will not be saved with the project data.



1 Monitoring with WindO/I-NV4

25-12 WindO/I-NV4 User’s Manual

Saving a Device Address List as a CSV File

To use a device address list (registered device addresses list) in another project, save it as a CSV text file. This file is 
called a Device Address List.

1 Click Export.

The Save As dialog box is displayed.

2 Select the save location, enter a File name, and then click Save.

This concludes saving device address list.
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Importing Device Addresses from a Device Address List

Imports the device addresses from a device address list saved as a CSV text file into custom monitor.

1 Click Import.

The Device Address List dialog box is displayed.

2 Click . 

The Open dialog box is displayed. 

3 Select a saved device address list, and then click Open.

The device addresses are listed.
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4 Click the device address to import.

5 Click OK.

If there is an already registered device address on the Custom Monitor, an overwrite confirmation message is 
displayed.
• Click Yes to overwrite the device address displayed in the confirmation message.
• Click Yes To All to overwrite all the device addresses.
• Click No to display the next confirmation message without overwriting the device address displayed in the 

confirmation message.
• Click Cancel to stop importing device addresses.

The device address is added to Monitor.

To select multiple items of text, press and hold SHIFT or CTRL while you click the specific items.
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● Batch Monitor
Displays sequential addresses as a batch.

■ Target
Select the device that includes the device address that will be set from MICRO/I or External Device (External 
Device ID): (External Device Name).
You can configure the External Device ID and the external device name in the Communications Driver Network 
tab on the Project Settings dialog box. For details, refer to Chapter 4 “3.4 Communication Driver Network Tab” on 
page 4-50.

■ Device Type
Selects the device type.
The list only shows device types that can be used.

■ Address Number
Specify the address. The range that can be set varies based on the device type selected.

■ Bit Number
Specify the bit (0 to 15) of the word device when a word device is selected in Device.

■ Length
Specifies the number of device addresses displayed in the list (Bit number of the word device: 1 to 16, Bit Device or 
Word Device: 1 to 1000).

■ Data Type
Selects the data format of the displayed value. For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

(Monitor)
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■ (Monitor)
Automatically displays the selected device addresses, in the number specified under Length, from top to bottom, 
consecutively.

Device Address: The specified device addresses are displayed.

Words: Specify the number of word devices (1 to 16) stored the display value. 2 single-byte characters 
can be displayed by 1 word.
This option can only be configured String(European), String(Japanese), 
String(Chinese), String(Taiwanese), String(Korean), String(Central European), 
String(Baltic) or String(Cyrillic) is selected as Data Type.
The storage order for word device address data is set according to Storage Method of 
String Data on the System tab in the Project Settings. For details, refer to Chapter 4 
“Storage Method of String Data” on page 4-28.

Value: Enables values of device addresses to be display and changed. The value range depends on 
the data type. For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

UBIN16(W), BIN16(I), UBIN32(D), BIN32(L), BCD4(B), BCD8(EB), Float32(F):

Displays the current value of device address in decimal format. To change a value, double-
click a cell and then enter a value.
The value range depends on the data type. For details, refer to Chapter 2 “1.1 Available 
Data” on page 2-1.

Click  to toggle display of HEX and BIN format. To display HEX and BIN values, click  
to display a popup menu, then click HEX and BIN and select the check box.

String(European), String(Japanese), String(Chinese), String(Taiwanese), 
String(Korean), String(Central European), String(Baltic), String(Cyrillic):

Displays the current value of device address in string. To change a value, double-click a cell 
and then enter the messages in the language selected.

Hexadecimal, Binary: Displays the current value of device address in hexadecimal and binary format. To change a 
value, double-click a cell and then specify a value.
The value range depends on the data type. For details, refer to Chapter 2 “1.1 Available Data” 
on page 2-1.
Comments are displayed only after you click  next to Value to display a popup menu and 
then select the HEX and BIN check box.



WindO/I-NV4 User’s Manual 25-17

1 Monitoring with WindO/I-NV4

25

M
onitor Function

● External Device Monitor
Displays the state of external devices connected to the MICRO/I.

■ (Connection status)
Displays the state of external devices connected to the MICRO/I. If a red cross appears over the icon of an external 
device, communication is stopped.
Clicking the External Device icon enables switching between connection and disconnection.

■ (External Device ID)
Displays the External Device ID of all external device addresses used in the project.

■ (External Device Name)
Displays the name of external devices used in the project.

(Connection status)

(External Device ID)

(External Device Name)
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1.3 Display the Value of Device Address in Popup

During monitoring, mousing over device addresses displayed in the Object List window or device addresses in a 
script opened in Script Editor displays the current value in a popup window.

• Object List window

• Script Editor

1.4 Highlighting Objects While Satisfying Conditions

When the Trigger Condition is satisfied during monitoring, the objects for which conditions are being satisfied are 
highlighted in the Object List window.

• Popup viewing of values of device addresses in the Object List window works only if the screen 
displayed in the Object List window matches the screen displayed on the MICRO/I.

• Popup viewing of values of device addresses in Script Editor works only if the script during editing is being 
used by a global script command or a script command on the screen displayed on the MICRO/I.

• The maximum number for popup window is 80 characters. Any characters entered after the 80th will not 
be displayed.

• If 65 or more device addresses are displayed in the Object List window, monitor refreshing and popup 
message will slow down.
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1.5 Switching the Screen of the MICRO/I

During monitoring, it is possible to switch to the screen displayed on the MICRO/I using a WindO/I-NV4 command.

■  (Back)
You are returned to the Base Screen that was displayed immediately before the screen was switched.

■  (Forward)

Advances to the Base Screen that was displayed immediately before the screen was switched using the  (Back).

■  (First Screen)
Switches to the Base Screen with the lowest screen number in the project data.

■  (Previous Screen)
Switches to the Base Screen of screen number one lower than the Base Screen currently displayed. If the screen 
numbers are not consecutive numbers, this command switches to the closest number.

■  (Specified Screen)
Switches to the Base Screen of a specified number.

■  (Next Screen)
Switches to the Base Screen of screen number one higher than the Base Screen currently displayed. If the screen 
numbers are not consecutive numbers, switches to the closest number.

■  (Last Screen)
Switches to the Base Screen of highest screen number in the project data.

1.6 Open Current Screens

The screen displayed on MICRO/I opens in the editing window.

1.7 Change Values of Device Addresses and Check the Operation of Project Data Offline

To change values of device addresses and check the operation of project data on the MICRO/I unit, first switch to 
monitor mode, and then click Go Offline.

The MICRO/I switches to offline mode and “Offline Mode” flashes at the bottom left of the screen.



2 Monitoring on the MICRO/I

25-20 WindO/I-NV4 User’s Manual

  

It is possible to change values of device addresses and check the operation on the MICRO/I.

2.1 How the Monitoring Function is Used

Monitoring in the MICRO/I can perform the following functions.

• Checking and changing the value of specified device address

2 Monitoring on the MICRO/I

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

MICRO/I
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Device
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Data Del Select

0
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0
1

Device Monitor

Dec/Hex

Device
LM
LDR

Data Del Select

0
00000

0
1

Device Monitor

Dec/Hex

Device Monitor can be used in offline mode. The values of the external device addresses can be checked 
and changed with the MICRO/I alone.
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2.2 Device Monitor

By registering device addresses in Run Mode, both data monitoring and changing can be conducted. Registered 
device addresses are listed in Device Monitor in ascending order (A to Z, 0 to 9). Registered device addresses are 
saved until power to the MICRO/I is turned OFF, or the mode is changed.

● Displaying Device Monitor

1 Press the upper-left corner of the screen on the MICRO/I for three seconds or more.

The Maintenance Screen is displayed.

2 Press Device Monitor.

Device Monitor is displayed.

• Available device address range depends on types and settings of external devices. Selecting unavailable 
device address, “Communication error” happens and it can not be back in without reboot. For details, 
refer to Chapter 36 “1.1 Errors Displayed on the Screen” on page 36-1.

• If three Popup Screens are displayed on the screen (or if two Popup Screens are displayed in the Alarm 
Log Settings), in order to use Device Monitor in the same way on Popup Screens, the Device Monitor 
cannot be used. 

Press and hold 
3 or more seconds

MICRO/I

Maintenance

System Mode

Device Monitor

Adjust Back Light

If a password has been configured for the project data, the Enter Password screen will be displayed. Select 
a user name and then enter a password. For details, refer to Chapter 23 “User Accounts and the Security 
Function” on page 23-1.



2 Monitoring on the MICRO/I

25-22 WindO/I-NV4 User’s Manual

● Device Address Registration

1 Press Select on Device Monitor.

The Select Device Address screen is displayed.

2 Press  or  to select the device type.

For Internal Device, proceed to step 4.

3 Enter the External Device ID as a hexadecimal value and press .

Device

Data Del Select

0

Device Monitor

Dec/Hex

LM           (bit) 0

Select Device Address

0 CLR CAN
ENT

1 2 3

4 5 6 F

7 8 9 E

A B C D

ID

The next address of the device address entered previously is automatically displayed in the Select Device 
Address screen.

ID
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4 Enter the address number and then press ENT.

• Press CLR to clear all values entered for the address number.
• Press CAN to stop registering device addresses.

The device address is registered to Device Monitor.

5 Repeat steps 1 through 4 to register all device addresses to be monitored.

LM           (bit) 1

Select Device Address

0 CLR CAN
ENT

1 2 3

4 5 6 F

7 8 9 E

A B C D

ID

1

2

If a device address is invalid, pressing ENT will not return to Device Monitor.

LM

Data Del Select

01

Device Monitor

Dec/HexDevice
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● Changing Value of Device Address

1 Press  or  to select the device address to be changed the value.

2 Press Data on Device Monitor.

The Write Data screen is displayed.

LM
LDR

Data Del Select

0
00000

1
2

Device Monitor

Dec/HexDevice

LM
LDR

Data Del Select

0
00000

1
2

Device Monitor

Dec/HexDevice
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3 Enter the value of device address and press ENT.

• Press Dec or Hex to change the display type for the value to enter.
• Press CLR to delete the entered value of device address.
• Press CAN to stop entering the value of device address.

The value of device address is changed.

Write Data

0 CLR CAN
ENT

1 2 3

4 5 6 F

7 8 9 E

A B C DDec Hex

Current
(word)

       0
/      0H

LDR 12

1

2

• If a value of device is invalid, pressing ENT will not return you to Device Monitor.
• If the display type is decimal, A to F cannot be used.

LM
LDR

Data Del Select

0
00001

1
2

Device Monitor

Dec/HexDevice
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● Device Monitor Configuration

■ Title Bar

Displays the title,  (Move) button, and (Close) button.

■

Switches the display type for the current value of device address. Switches between DEC and HEX.

■ (Device Address)
The registered device address is displayed.

■ (Value)
The current value of device address is displayed.

■ (Focus)
Highlights the selected device address.

■ 
Moves the focus up by one line.

■ 
Moves the focus down by one line.

■ Data
Changes the value of the selected device address. Press to display the Write Data Screen. For details, refer to 
“Changing Value of Device Address” on page 25-24.

■ Del
Deletes the selected device address.

■ Select
Registers a selected device address. Press to display the Select Device Address screen. For details, refer to “Device 
Address Registration” on page 25-22.

Device
LM
LM

Data Del Select

0
1

1
2

Device Monitor

Dec/Hex

Close button

(Value)

Move button

(Device Address)

(Focus)

Title bar

 (Move) button: Moves the Device Monitor.

 (Close) button: Closes the Device Monitor.

Dec/Hex
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2.3 Change Values of Device Addresses and Check the Operation of Project Data Offline

Offline mode allows you to change values of device addresses and to check the operation of project data on the 
MICRO/I unit only. By possessing virtualized external device addresses inside the MICRO/I, you can efficiently debug 
using the Device Monitor function.

● Switching to Offline Mode

1 Press the upper-left corner of the screen on the MICRO/I for three seconds or more.

The Maintenance Screen is displayed.

2 Press System Mode.

The MICRO/I switches to the Top Page of the System Mode.

3 Press Offline.

The MICRO/I switches to offline mode and “Offline Mode” is displayed at the bottom left of the screen.

4 Monitor and change the values of device addresses with Device Monitor to check the operation of project data.

If there are any errors, edit the project data with WindO/I-NV4, and then download the edited project data to the 
MICRO/I.

To exit offline mode, switch to System Mode with the operations in steps 1 and 2, and then press Run on the Top 
Page.

Press and hold 3
or more seconds

MICRO/I

Maintenance

System Mode

Device Monitor

Adjust Brightness

If a password has been configured for the project data, the Enter Password screen will be displayed. Select 
a user name and then enter a password. For details, refer to Chapter 23 “User Accounts and the Security 
Function” on page 23-1.

Run Offline Main Menu

<< >>BRIGHTNESS 31

MAC Address  00:03:7B:F0:12:A8
IP Address 192.168.0.1(DHCP)
2010/OCT/14/THU   14:56:44

IDEC HG G SERIES
SYSTEM MODE TOP PAGE

ENG/JPN
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This chapter describes the simulator function, which can be used to check operation of the project data in WindO/I-
NV4 before the created project data is downloaded to a MICRO/I.
The simulator function can be used to check and change the values of internal devices and device addresses of 
external devices.

  

1.1 How the Simulator Function is Used

Simulator function in WindO/I-NV4 can be performed as follows.

• Check the operation of parts

• Save the screen displayed in the simulator as an image

• Check the values of device addresses used on screens displayed

Chapter 26 Simulator Function

1 Overview

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

Computer
Simulator

Computer
Simulator

Save as image

Image Files (png image)

Computer
Screen Monitor Simulator

View device addresses used on screens 
displayed in the simulator

LSD8
LSD12
LSD11
LSD10
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• Checking values of specified device addresses

• Checking values of device addresses of sequential address numbers

• Change the screen displayed in the simulator

• Check the operation of Script

Computer
Custom Monitor Simulator

Select device address

Computer
SimulatorBatch Monitor

Sequential address numbers
LSD10
LSD11
LSD12

Length: 3
(Starting address number)

Computer

Computer

Base Screen 1

Base Screen 2

Simulator

Simulator

Switches to Base Screen 2.

Computer
Script Debugger

LSD8
LSD9
LSD10
LSD11
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2.1 Starting the Simulator

● Starting the Simulator

1 Open the project data on which to perform the operation check.

2 On the Online tab, in the Simulator group, click the Simulator icon.

The project data being edited will be loaded and the simulator will start.

● Starting the Simulator by Loading or Clearing Device Addresses
If the Save Value of Device Address (External Device, LK, LKR) check box is selected and the simulator is 
terminated, the loading method of the project data can be selected when the simulator is next started.

1 Open the project data on which to perform the operation check.

2 On the Online tab, in the Simulator group, click the ▼ arrow under Simulator.

3 Select the loading method of the project data.

The project data being edited will be loaded and the simulator will start.

■ Load Value of Device Address (External Device, LK, LKR) and Run
The saved values of device addresses on the external device, HMI keep relays (LK), and HMI keep registers (LKR) will 
be loaded when the project data is loaded.

■ Clear Value of Device Address (External Device, LK, LKR) and Run
The saved values of device addresses on the external device, HMI keep relays (LK), and HMI keep registers (LKR) will 
be cleared when the project data is loaded.

2 Using the Simulator

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

If the project data was changed before the simulator is started, a save confirmation message will be 
displayed.
• Click OK to save the project data and start the simulator.
• Click Cancel to cancel starting the simulator. You will be returned to the editing screen and the project 

data will not be saved.

The simulator cannot load project data that cannot be downloaded to the MICRO/I.

If the project data was changed, a confirmation message to save the project data is displayed.
• Click OK to save the project data and start the simulator.
• Click Cancel to cancel starting the simulator. You will be returned to the editing screen and the project 

data will not be saved.

The simulator cannot load project data that cannot be downloaded to the MICRO/I.
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2.2 Debugging in Simulator

This section describes the procedure for monitoring values of device addresses and debugging in Simulator.

1 In the simulator, use the following buttons and the text box to change the monitored screen.

■  (Back)
You are returned to the Base Screen that was displayed immediately before the screen was switched.

■  (Forward)

Advances to the Base Screen that was displayed immediately before the screen was switched using  (Back).

■  (First Screen)
Switches to the Base Screen of the lowest screen number in the project data.

■  (Previous Screen)
Switches to the Base Screen of screen number one lower than the Base Screen currently displayed. If the screen 
numbers are not sequential, switches to the screen of next lowest number.

■  (Specified Screen)
Switches to the Base Screen with the specified number.

■  (Next Screen)
Switches to the screen with screen number one higher than the Base Screen currently displayed. If the screen 
numbers are not consecutive, switches to the screen of next highest number.

■  (Last Screen)
Switches to the Base Screen of highest screen number in the project data.
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2 Select the monitor being used.

When monitoring starts, the screen monitor is displayed.

■ Screens
Automatically checks device addresses used on the screen displayed on the Simulator. For details, refer to “3.2 Screen 
Monitor” on page 26-10.

■ Custom
Registers monitored device addresses individually and displays the value of device addresses. For details, refer to “3.3 
Custom Monitor” on page 26-11.

■ Batch
Registers monitored device address as a batch for sequential address numbers and displays the value of device 
addresses. For details, refer to “3.4 Batch Monitor” on page 26-13.

■ Script Debugger
Check the operation of the script used in the project. For details, refer to “3.5 Script Debugger” on page 26-15.

3 Check operation of project data by monitoring and changing values of device addresses, and edit project data if there 
is an error.

If the monitored screen is switches, repeat steps 1.

4 If you have edited the project data, click Reload project data to update the project displayed in the simulator.

The Reload Project dialog box is displayed.

If the Save Value of Device Address (External Device, LK, LKR) check box is cleared, proceed to step 6.

Click Settings to save the values of device addresses on the external device, HMI keep relays (LK), and 
HMI keep registers (LKR) that were input in the simulator.
The Simulator Settings dialog box is displayed.

After the Simulator Settings dialog box is displayed, select the Save Value of Device Address 
(External Device, LK, LKR) check box, and then click OK.
The values of device addresses that are saved are the values when the simulator is terminated or when 
Reload project data is clicked.

If the project data was changed, a confirmation message to save the project data is displayed.
• Click OK to save and load the project data.
• Click Cancel to return to the editing screen without saving the project data.
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5 Select the loading method of the project data and click OK.

■ Load Saved Value of Device Address (External Device, LK, LKR)
The saved values of device addresses on the external device, HMI keep relays (LK), and HMI keep registers (LKR) will 
be loaded when the project data is loaded.

■ Clear Saved Value of Device Address (External Device, LK, LKR)
The saved values of device addresses on the external device, HMI keep relays (LK), and HMI keep registers (LKR) will 
be cleared when the project data is loaded.

6 Repeat steps 1 to 5, and click  when you have finished debugging.

This terminates the simulator.

2.3 Saving the Displayed Screen as an Image

You can save the screen displayed on the simulator as an image.

1 Click Capture.

The Save As dialog box is displayed.

2 Select the save location, enter a File name, and then click Save.
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This section describes items and buttons on the Simulator.

3.1 Simulator

It is possible to change values of device addresses and check the operation on the screen of Simulator.

■ Capture
Saves the screen displayed on the simulator as an image.
Click this button to display the Save As dialog box. For details, refer to “2.3 Saving the Displayed Screen as an Image” 
on page 26-6.

■ Screens
Automatically displays the device addresses used on the screen displayed in the simulator. For details, refer to “3.2 
Screen Monitor” on page 26-10.

■ Custom
Registers monitored device addresses individually and displays the value of device addresses. For details, refer to “3.3 
Custom Monitor” on page 26-11.

■ Batch
Registers monitored device address as a batch for sequential address numbers and displays the value of device 
addresses. For details, refer to “3.4 Batch Monitor” on page 26-13.

■  (Back)
You are returned to the Base Screen that was displayed immediately before the screen was switched.

■  (Forward)

Advances to the Base Screen that was displayed immediately before the screen was switched using  (Back).

■  (First Screen)
Switches to the Base Screen of the lowest screen number in the project data.

■  (Previous Screen)
Switches to the Base Screen of screen number one lower than the Base Screen currently displayed. If the screen 
numbers are not sequential, switches to the screen of next lowest number.

3 Simulator

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P
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■  (Specified Screen)
Switches to the Base Screen with the specified number.

■  (Next Screen)
Switches to the screen with screen number one higher than the Base Screen currently displayed. If the screen 
numbers are not consecutive, switches to the screen of next highest number.

■  (Last Screen)
Switches to the Base Screen of highest screen number in the project data.

■ Script Debugger
Check the operation of the script used in the project. For details, refer to“3.5 Script Debugger” on page 26-15.

■ Reload project data
Reloads the edited project data.

■ Settings
Click this button to display the Simulator Settings dialog box. For details, refer to “Simulator Settings Dialog Box” on 
page 26-9.

■ Function key*1

Check the operation of the switches (F1 to F12) on both sides of the display of the HG1P unit.

*1 HG1P only
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● Simulator Settings Dialog Box

■ Save Value of Device Address (External Device, LK, LKR)
Select this check box to save the values of device addresses on the external device, HMI keep relays (LK), and HMI 
keep registers (LKR) that were input in the simulator. The values of device addresses will be saved in the project data. 
The Reload Project dialog box will be displayed when the simulator is next started or when the project is reloaded. 
For details, refer to “2.2 Debugging in Simulator” on page 26-4.

■ Screen Size
Select 100% or 200% for the screen size magnification in the simulator.
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3.2 Screen Monitor

Automatically checks device addresses used on the screen displayed on the Simulator. Enables values of device 
addresses to be monitored and changed.

■ Device Address
Displays the device addresses used on the screen displayed on the Simulator.

 next to Comment toggles between showing and hiding comments. When comments are displayed, click  to 
display a popup menu, then click Comment and select the check box.

■ Comment
Displays comments on device addresses saved in Tag Editor. Comments are displayed only after you click  next to 
Device Address to display a popup menu, then click Comment and select the check box. 

■ Data Type
Selects the data format of the displayed value. For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

■ Words
Specify the number of word devices (1 to 16) stored the display value. 2 single-byte characters can be displayed by 1 
word.
This option can only be configured String(European), String(Japanese), String(Chinese), 
String(Taiwanese), String(Korean), String(Central European), String(Baltic) or String(Cyrillic) is selected 
as Data Type.
The storage order for word device address data is set according to Storage Method of String Data on the System 
tab in the Project Settings. For details, refer to Chapter 4 “Storage Method of String Data” on page 4-28.

■ Value
Enables values of device addresses to be display and changed. The value range depends on the data type. For details, 
refer to Chapter 2 “1.1 Available Data” on page 2-1.

■ Hexadecimal, Binary
Displays the current value of device address in hexadecimal and binary format. To change a value, double-click a cell 
and then specify a value.
The value range depends on the data type. For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Comments are displayed only after you click  next to Value to display a popup menu and then select the HEX and 
BIN check box.

UBIN16(W), BIN16(I), UBIN32(D), BIN32(L), BCD4(B), BCD8(EB), Float32(F):

Displays the current value of device address in decimal format. To change a value, double-click a cell and then 
enter a value.
The value range depends on the data type. For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Click  to toggle display of HEX and BIN format. To display HEX and BIN values, click  to display a popup 
menu, then click HEX and BIN and select the check box.

String(European), String(Japanese), String(Chinese), String(Taiwanese), String(Korean), 
String(Central European), String(Baltic), String(Cyrillic):

Displays the current value of device address in string. To change a value, double-click a cell and then enter the 
messages in the language selected.
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3.3 Custom Monitor

Enables the values of registered device addresses to be monitored and changed.

■ Add to List
Saves device addresses registered in Monitor to project data as a device address list. A saved lists can be monitored 
by selecting it from the List.
Click this button to display the Device Address List Name Setting dialog box. For details, refer to Chapter 25 “Saving 
Registered Device Addresses to Project Data as a Device Address List” on page 25-11.

■ Device Address
Registers the device addresses to monitor individually.
Click this button to display the Tag Editor. For details, refer to Chapter 25 “Registering the device addresses to 
monitor” on page 25-9.

■ Script
Batch saves all device addresses used in a script.
Click this button to display Script Manager. For details, refer to Chapter 25 “Batch Saving Device Addresses Used in 
Scripts” on page 25-9.

■ Import
Imports the device addresses from a device address list saved as a CSV text file.
Click this button to display the Device Address List dialog box. For details, refer to Chapter 25 “Importing Device 
Addresses from a Device Address List” on page 25-13.

■ Export
Saves the device addresses displayed in Monitor as a CSV text file. This file is called a Device Address List.
Click this button to display the Save As dialog box. For details, refer to Chapter 25 “Saving a Device Address List as a 
CSV File” on page 25-12.
The saved device address list can be imported using Import.

■ Clear
Deletes all the device addresses displayed in Monitor.

■ List
Displays a device address list saved with the project data.
Select a list to clear the device addresses shown in Monitor and display the device addresses in the list.
Double-click a cell to display the Device Address List Name Setting dialog box. The name of the device address list can 
be edited.
Select a list and press DELETE to delete it from the List.
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■ Monitor
The registered device addresses are displayed in a list.
Select the device address list from the List to show the device addresses registered in the list.

Device Address: The registered device addresses are displayed.

Double-click a cell to register or change a device address. Click  to display the Tag Editor. 
For details on how to configure device address settings, refer to Chapter 2 “5.1 Device Address 
Settings” on page 2-68.

 toggles between showing and hiding comments. When comments are displayed, click  to 
display a popup menu, then click Comment and select the check box.

Comment: Displays comments on device addresses saved in Tag Editor. Comments are displayed only 
after you click  next to Device Address to display a popup menu, then click Comment and 
select the check box.

Data Type: Selects the data format of the displayed value. For details, refer to Chapter 2 “1.1 Available 
Data” on page 2-1.

Words: Specify the number of word devices (1 to 16) stored the display value. 2 single-byte characters 
can be displayed by 1 word.
This option can only be configured String(European), String(Japanese), 
String(Chinese), String(Taiwanese), String(Korean), String(Central European), 
String(Baltic) or String(Cyrillic) is selected as Data Type.
The storage order for word device address data is set according to Storage Method of 
String Data on the System tab in the Project Settings. For details, refer to Chapter 4 
“Storage Method of String Data” on page 4-28.

Value: Enables values of device addresses to be display and changed. The value range depends on 
the data type. For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

UBIN16(W), BIN16(I), UBIN32(D), BIN32(L), BCD4(B), BCD8(EB), Float32(F):

Displays the current value of device address in decimal format. To change a value, double-
click a cell and then enter a value.
The value range depends on the data type. For details, refer to Chapter 2 “1.1 Available 
Data” on page 2-1.

Click  to toggle display of HEX and BIN format. To display HEX and BIN values, click  
to display a popup menu, then click HEX and BIN and select the check box.

String(European), String(Japanese), String(Chinese), String(Taiwanese), 
String(Korean), String(Central European), String(Baltic), String(Cyrillic):

Displays the current value of device address in string. To change a value, double-click a cell 
and then enter the messages in the language selected.

Hexadecimal, Binary: Displays the current value of device address in hexadecimal and binary format. To change a 
value, double-click a cell and then specify a value.
The value range depends on the data type. For details, refer to Chapter 2 “1.1 Available Data” 
on page 2-1.
Comments are displayed only after you click  next to Value to display a popup menu and 
then select the HEX and BIN check box.

For details about how to register device addresses to monitor in the Custom Monitor and how to reuse 
registered device addresses, refer to Chapter 25 “Custom Monitor” on page 25-7.
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3.4 Batch Monitor

Displays sequential addresses as a batch.

■ Target
Select the device that includes the device address that will be set from MICRO/I or External Device (External 
Device ID): (External Device Name).
You can configure the External Device ID and the external device name in the Communications Driver Network 
tab on the Project Settings dialog box. For details, refer to Chapter 4 “3.4 Communication Driver Network Tab” on 
page 4-50.

■ Device Type
Selects the device type.
The list only shows device types that can be used.

■ Address Number
Specify the address. The range that can be set varies based on the device type selected.

■ Bit Number
Specify the bit (0 to 15) of the word device when a word device is selected in Device.

■ Length
Specifies the number of device addresses displayed in the list (Bit number of the word device: 1 to 16, Bit Device or 
Word Device: 1 to 1000).

■ Data Type
Selects the data format of the displayed value. For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

(Monitor)
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■ (Monitor)
Automatically displays the selected device addresses, in the number specified under Length, from top to bottom, 
consecutively.

Device Address: The specified device addresses are displayed.

Comment: Displays comments on device addresses saved in Tag Editor. Comments are displayed only 
after you click  next to Device Address to display a popup menu, then click Comment and 
select the check box.

Data Type: Selects the data format of the displayed value. For details, refer to Chapter 2 “1.1 Available 
Data” on page 2-1.

Words: Specify the number of word devices (1 to 16) stored the display value. 2 single-byte characters 
can be displayed by 1 word.
This option can only be configured String(European), String(Japanese), 
String(Chinese), String(Taiwanese), String(Korean), String(Central European), 
String(Baltic) or String(Cyrillic) is selected as Data Type.
The storage order for word device address data is set according to Storage Method of 
String Data on the System tab in the Project Settings. For details, refer to Chapter 4 
“Storage Method of String Data” on page 4-28.

Value: Enables values of device addresses to be display and changed. The value range depends on 
the data type. For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

UBIN16(W), BIN16(I), UBIN32(D), BIN32(L), BCD4(B), BCD8(EB), Float32(F):

Displays the current value of device address in decimal format. To change a value, double-
click a cell and then enter a value.
The value range depends on the data type. For details, refer to Chapter 2 “1.1 Available 
Data” on page 2-1.

Click  to toggle display of HEX and BIN format. To display HEX and BIN values, click  
to display a popup menu, then click HEX and BIN and select the check box.

String(European), String(Japanese), String(Chinese), String(Taiwanese), 
String(Korean), String(Central European), String(Baltic), String(Cyrillic):

Displays the current value of device address in string. To change a value, double-click a cell 
and then enter the messages in the language selected.

Hexadecimal, Binary: Displays the current value of device address in hexadecimal and binary format. To change a 
value, double-click a cell and then specify a value.
The value range depends on the data type. For details, refer to Chapter 2 “1.1 Available Data” 
on page 2-1.
Comments are displayed only after you click  next to Value to display a popup menu and 
then select the HEX and BIN check box.
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3.5 Script Debugger

You can check the operation of script configured in the project.

■ Script List
Displays the list of script used on the project.

■ Script Name
Displays the name of the script selected in the Script List.

■ Data Type
Displays the data type configured to the script selected in the Script List.
For details about the data type, refer to Chapter 20 “1.3 Data Type of the Script” on page 20-3.

■ Continue
Executes the script paused at the breakpoint up to the next breakpoint. If there is no next breakpoint, execute the 
script to the end and exit.

■ Step Over 
Executes the script while pausing each step (one line) at a time. If there is no next step, the script execution is 
terminated.

(Script)

(Breakpoint)

Script ID: Displays the script ID (1 to 32000) of the registered scripts.

Script Name: Displays the script name of the registered scripts.

Debug: Selects whether or not to debug the script. Double clicking the cell switches between Enable 
and Disable. The maximum number of scripts that can be configured to Enable is 16.

The keyboard shortcut is F5 key.

The keyboard shortcut is F6 key.
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■ (Breakpoint)
When the script is executed, it pauses when the processing reaches the breakpoint. You can check the value of the 
device address at the time of stopping on the Device Address List.
The maximum number of breakpoints that can be configured for one script is 20.

■ (Script)
Displays the contents of the script selected in Script List.

Click inside the frame on the left side of (Script) to configure a breakpoint. (red circle) is displayed, and the text on 
the line configured the breakpoint is highlighted.

■ Device Address List
Displays the device addresses that are used in the script suspended at breakpoint and the values of them.

• The trigger condition for the script is satisfied and the script is executed, and then the processing of the 
script is stopped when the configured breakpoint is reached.

• When you save the project, the setting of the breakpoint is also saved. However, the project data to be 
downloaded does not include the setting of the breakpoint, so there is no breakpoint setting after 
uploading the project.

Device Address: Displays the device addresses used on the script.
 next to Comment toggles between showing and hiding comments. When comments are 

displayed, click  to display a popup menu, then click Comment and select the check box.

Comment: Displays comments on device addresses saved in Tag Editor. Comments are displayed only 
after you click  next to Device Address to display a popup menu, then click Comment and 
select the check box.

Data Type: Selects the data format of the displayed value. For details, refer to Chapter 2 “1.1 Available 
Data” on page 2-1.

Words: Specify the number of word devices (1 to 16) stored the display value. 2 single-byte characters 
can be displayed by 1 word.
This option can only be configured String(European), String(Japanese), 
String(Chinese), String(Taiwanese), String(Korean), String(Central European), 
String(Baltic) or String(Cyrillic) is selected as Data Type.
The storage order for word device address data is set according to Storage Method of 
String Data on the System tab in the Project Settings. For details, refer to Chapter 4 
“Storage Method of String Data” on page 4-28.

Value: Enables values of device addresses to be display and changed. The value range depends on 
the data type. For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

UBIN16(W), BIN16(I), UBIN32(D), BIN32(L), BCD4(B), BCD8(EB), Float32(F):

Displays the current value of device address in decimal format. To change a value, double-
click a cell and then enter a value.
The value range depends on the data type. For details, refer to Chapter 2 “1.1 Available 
Data” on page 2-1.

Click  to toggle display of HEX and BIN format. To display HEX and BIN values, click  
to display a popup menu, then click HEX and BIN and select the check box.

String(European), String(Japanese), String(Chinese), String(Taiwanese), 
String(Korean), String(Central European), String(Baltic), String(Cyrillic):

Displays the current value of device address in string. To change a value, double-click a cell 
and then enter the messages in the language selected.
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Hexadecimal, Binary: Displays the current value of device address in hexadecimal and binary format. To change a 
value, double-click a cell and then specify a value.
The value range depends on the data type. For details, refer to Chapter 2 “1.1 Available Data” 
on page 2-1.
Comments are displayed only after you click  next to Value to display a popup menu and 
then select the HEX and BIN check box.
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The simulator runs a MICRO/I equivalent to offline mode on the computer to simulate the operation and display of 
parts laid out on screens. However, the following functions can not be checked with the simulator.

• Sound Function
• Multimedia Function
• Pass-Through Function
• Web Server Function
• FTP Server Function
• FTP Client Function
• E-mail Function
• Data Transfer Function
• Printer
• External Device Communication, O/I Link Communication, User Communication, Sub Host Communication and 

BACnet Communication functions
• Displaying the Maintenance Screen
• The function to save log data of the Alarm Log Function to the external memory as a CSV file
• The function to save log data of the Data Log Function to the external memory as a CSV file
• The function to save log data of the Operation Log Function to the external memory as a CSV file
• The function to save values of device addresses for the Recipe Function to the external memory as a recipe file 

(CSV file)
• Entering Hiragana and Kanji to the Character Input using Key Buttons or Keypad

4 Monitoring on the MICRO/I

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

The clock function uses the date and time data of the computer on which the simulator is running.
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This chapter describes the overview of the Pass-through function, it's configuration and other important details.

   

1.1 How the Pass-Through Function is Used

The Pass-through function downloads or uploads a PLC program from a computer or an external device via the 
MICRO/I.

Chapter 27 Pass-Through Function

1 Overview

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

Computer
MICRO/I

130

External device

Device Link Communication

Pass-Through Communication

Read

Write

Read

WritePLC programming 
software
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1.2 Supported External Devices

This Pass-through function can be used with the following PLCs:

When the IDEC PLC is used, the supported function varies based on the port.

*1 We tested by GX Developer Version 8
*2 User program only
*3 Use WindLDR Ver.8.6.1 or higher

Manufacturer Series Name Model Communication Driver

IDEC

OpenNet Controller FC3A
OpenNet,MICROSmart,SmartAXIS Pro/
Lite(RS232C/485)

MICROSmart

FC4A

FC5A

FC6A MICROSmart(FC6A)(RS232C/485)

Mitsubishi*1
FX Series

FX0, FX0N, FX1, FX1S, FX2, FX2C MELSEC-FX (CPU)

FX2N, FX2NC, FX1N, FX1NC MELSEC-FX2N (CPU)

FX3U, FX3UC MELSEC-FX3UC (CPU)

QCPU Q02CPU, Q02HCPU MELSEC-Q (CPU)

The corresponding device type differs depending on the communication driver which be used.
For FC6A type, please select MICROSmart (FC6A) (RS232C / 485) driver.
If use OpenNet, MICROSmart, SmartAXIS Pro / Lite (RS232C485) driver, the device type is partially 
different. For details, refer to the WindO/I-NV4 External Device Setup Manual.

Series Name Model Serial port Device Monitor
Download, 

Upload*2

OpenNet Controller FC3A
Port 1 YES YES

Port 2 YES YES

MICROSmart

FC4A
Port 1 YES YES

Port 2 YES YES

FC5A

Port 1 YES YES

Port 2 YES YES

Port 3 to 7 YES NO

FC6A
(FC6A-C*****E/-C*****EJ only)

Port 1 (Internal) YES YES*3

Port 2 to 9 YES YES*3

FC6A
(FC6A-D****CEE only)

Port 1 to 33 YES YES

SmartAXIS Pro/Lite FT1A
Port 2 YES NO

Port 3 YES NO
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1.3 How to Connect when Using the Pass-Through Function

Connect the computer and MICRO/I with an Ethernet cable or a USB cable, and connect the MICRO/I and external 
device with a serial cable.

1.4 Use the Pass-Through Function

The Pass-through function operates under the following conditions:

• The MICRO/I is in the Run mode or Monitor mode.

• A communication driver that supports the Pass-through operation.

• In the Project Settings dialog box, on the Communication Driver tab, the Enable Pass-Through check box is 
selected.

MICRO/IComputer

USB cable

Ethernet cable

Serial cable

External device

Use the WindO/I-NV2 Utility software Pass-through Tool if you have the following:
• A compertitor's PLC.
• Currently using WindLDR Ver. 5.0* - 6.0*.
For details on Pass-through Tool, see the WindO/I-NV2 Utility software Pass-through Tool Manual.
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This section describes the settings procedure for the Pass-through function. The Pass-through function can be 
configured with WindO/I-NV4 or in System Mode.

2.1 How to Enable the Pass-Through Function in WindO/I-NV4

1 On the Configuration tab, in the System Setup group, click Project.

The Project Settings dialog box is displayed.

2 Click the Communication Driver tab.

3 Select the external device communication from the (Function) to make the Pass-through function is enabled.

4 Under External Device, select the Enable Pass-Through check box.

This option is accessible if the Communication Driver is supported. For details, refer to “1.2 Supported External 
Devices” on page 27-2.

5 Click OK.

This concludes the configuration to enable the Pass-through function.

2 Pass-Through Function Settings Procedure

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

(Function)
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2.2 How to Enable the Pass-Through Function in MICRO/I System Mode

1 Press the upper-left corner of the MICRO/I screen for three or more seconds.

The Maintenance Screen is displayed.

2 Press System Mode.

The screen changes to the Top Page in the System Mode.

3 Press Main Menu.

The Main Menu screen is displayed.

Press and hold 3
or more seconds

MICRO/I

Maintenance

System Mode

Device Monitor

Adjust Brightness

If a password has been configured for the project data, the Password Screen is displayed. Select user name 
and enter password. For details, refer to Chapter 23 “User Accounts and the Security Function” on page 23-
1.

<< >>BRIGHTNESS 31

MAC Address  00:03:7B:F0:12:A8
IP Address  192.168.0.1(DHCP)

2010/OCT/14/THU   14:56:44

IDEC HG G SERIES
SYSTEM MODE TOP PAGE

ENG/JPN

Offline Main MenuRun
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4 Press Initial Setting.

5 Press External Device Communication (HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F) or press Ext. Device (HG2G-5T, 
HG1G/1P).

6 Press External Device Communication 1 to External Device Communication 4 (HG5G/4G/3G/2G-V, HG4G/3G, 
HG2G-5F) or press Ext. Device 1 to Ext. Device 4 (HG2G-5T, HG1G/1P).

------ ---

2010/OCT/14/THU   14:56:44

Main
Menu

Offline Run

Initial
Setting

Clock
Setting

Top Page
Self

Diagnosis

System
Information

File
Manager

Initial
Setting ---

Main
Menu ---

Ext. Device O/I Link

System Op. Initialize

------- -------

-------Communication I/F

Ext. 
Device ---

Ext. Device 3 Ext. Device 4

Ext. Device 1 Ext. Device 2

------- -------

--------------

Initial
Setting

Main
Menu
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7 Press Pass-Through Setting (HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F) or press Pass Through (HG2G-5T, HG1G/
1P).

8 Select the Enable PassThrough check box and press Save (HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F) or SAVE 
(HG2G-5T, HG1G/1P).

When the setting is saved, "The value was updated." is displayed.

This concludes the configuration to enable the Pass-through function.

Trans. Wait Pass-Through

Retry Cycles Time Out

Parameter3 Parameter4

Parameter2Parameter1

Ext. 
Device 1

Ext. 
Device

Initial
Setting

Main
Menu

Save Cancel

Enable PassThrough

The value was updated.

Ext. 
Device 1

Ext. 
Device

Initial
Setting

Main
Menu
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• When sending and receiving data with an external device from PLC programming software using the Pass-through 
function, MICRO/I Device Link Communication and Pass-through function communication are performed at the 
same time, so the data transfer speed of each will decrease.
In this case, if Device Link Communication between the MICRO/I and the external device is stopped by the Pass-
through Tool, the data transfer speed of downloading or uploading the PLC program via MICRO/I will be improved. 
However, "Communication Error" will be displayed on the MICRO/I screen.

• Do not use communication with WindO/I-NV4 and Programming software at the same time.

• If the communication via Pass-through fails, change the settings such as Baud Rate, Timeout, Transfer Mode etc on 
PLC programming software.

• If one of the following problems occurs while using the Pass-through function and a communication error is 
displayed, turn power off and on to the MICRO/I again.
- The communication cable between the computer and MICRO/I was disconnected after stopping communication 

of the MICRO/I and the external device using the Pass-through Tool.
- The computer was forcibly shut down due to a power loss or other problem

• The Pass-through function can only use one of "External Device Communication 1" through "External Device 
Communication 4".

3 Important Notes

Example: WindLDR

Transfer Mode: ASCII

Baud Rate: 9600 bps

Timeout: 5000 msec.

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P
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This chapter describes the web server function and the FTP server function used during maintenance and 
Downloader.

  

1.1 Web Server Function Overview

The web server function remotely performs the MICRO/I maintenance using a web browser terminal such as a 
computer or PDA.

•  Monitoring
•  Remote Control
•  Remote Monitoring
•  Displaying Custom Web Page

1.2 System Composition

An example system configuration for using the web server function is shown below.
Configure the MICRO/I Ethernet settings (IP address, subnet mask, default gateway) and connect to a local network.

*1 SD memory card for HG5G/4G/3G/2G-V, HG4G/3G and HG2G-5F, USB flash drive for HG2G-5T and HG1G/1P

Chapter 28 Maintenance

1 Web Server Function

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

Custom web pages are downloaded to external memory*1. The external memory*1 must be inserted before 
downloading.

(1) Access the MICRO/I from a web browser connected to the local network to use the web server function.

(2) When the local network is connected to an external network, configure the web browser connected to the remote 
network with the local network’s gateway, router, and other settings. Access the MICRO/I from the remote web 
browser to use the web server function.

Web Browser Terminal
(Computer, PDA, etc.)

Web Browser Terminal
(Computer, PDA, etc.)

Local Network Ethernet Communication (TCP/IP)

Remote Network

(1)

(2)

External Network

External device

MICRO/I

External device

MICRO/I

For gateway, router, and other settings, contact the administrator of the network which the MICRO/I is 
connected to.



1 Web Server Function

28-2 WindO/I-NV4 User’s Manual

1.3 Minimum System Requirements

Use of the following web browsers is recommended with the web server function.

1.4 Settings and Connection Method

Follow the procedure below to display the MICRO/I web page on a web browser.

1 Connect the MICRO/I to a local network.

Connect the MICRO/I’s Ethernet interface to the Ethernet port of the local network’s router or hub with a LAN cable.

2 Configure the MICRO/I.

• Ethernet settings
 Refer to Chapter 4 “When Ethernet is selected under Interface Configuration” on page 4-40.

• User account settings
 Refer to Chapter 23 “3 Security Dialog Box” on page 23-37.

• Remote operation & monitoring function settings
 Refer to “Web Server Function Configuration Procedure” on page 28-4.

3 Connect the MICRO/I.

Start the web browser on the web browser terminal and connect the following URL.

http://(MICRO/I IP address)/

In the example above, the web page configured by Default Showing Page on Web Server tab in Project Settings 
dialog box is displayed.

OS Recommended Web Browsers

Windows 10/8/7/Vista/XP
Google Chrome 47 or higher
Mozilla Firefox 42 or higher
Microsoft Internet Explorer 11

Android Google Chrome 47 or higher

iOS Safari 8 or higher

Web browsers other than those recommended can use the web server function, but problems may occur 
with features such as automatic updates and displaying images.

Example 1: When the MICRO/I’s IP address is 192.168.0.1
http://192.168.0.1/

Example 2: When the MICRO/I’s IP address is 192.168.0.1 and the web server's port number is 8080
http://192.168.0.1:8080/
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To open other pages, go to the following URL.

4 Enter the user name and password configured in the running project.

Enter the user name and password for a user in the “Administrator”, “Operator”, or “Reader” security group.

When the user name and password are successfully verified, the MICRO/I web page is displayed.

Name Recommended Web Browsers

System Information page
http://MICRO/I IP address:Port number/top.html
Example: The MICRO/I’s IP address is 192.168.0.1.

http://192.168.0.1/top.html

Remote Monitor page
http://MICRO/I IP address:Port number/remote_monitor.html
Example: The MICRO/I’s IP address is 192.168.0.1.

http://192.168.0.1/remote_monitor.html

Remote Control page
http://MICRO/I IP address:Port number/remote_control.html
Example: The MICRO/I’s IP address is 192.168.0.1.

http://192.168.0.1/remote_control.html

Custom Web Page
http://MICRO/I IP address:Port number/viewer/view.htm?pagepath= File name
Example: The MICRO/I’s IP address is 192.168.0.1 and the Page1.page is displayed.

http://192.168.0.1/viewer/view.htm?pagepath=Page1.page

User name: The user name configured in the running project. (Default: User)

Password: The alphanumeric password of 4 to 15 characters long configured in the running project. If a password 
is not set, leave the password blank.

• An “Administrator” or “Operator” user account is required to open the remote operation page.
• If you do not access the MICRO/I for 5 minutes or more after accessing it, you will be required to reenter 

your user name and password.
Some web browsers will remember the user name and password you entered and automatically reenter 
them when required until the browser is closed. With this kind of web browser, you are not required to 
reenter your user name and password after 5 minutes or more have elapsed since accessing the MICRO/I.

• The MICRO/I can be accessed simultaneously from multiple web browser terminals. However, the 
maximum number of web browsers that can simultaneously access it is five.
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● Web Server Function Configuration Procedure

1 On the Configuration tab, in the System Setup group, click Project.

The Project Settings dialog box is displayed.

2 Configure the items on the Web Server tab.

■ Use System Web Page
The Remote Control page, Remote Monitor page or System Detailed Information page of MICRO/I can be accessd 
from a web browser terminal. (Default: Selected)

■ Use Custom Web Page
The Custom Web Page saved in the external memory device of MICRO/I can be accessd from a web browser terminal. 
(Default: Selected)
Refer to “1.6 Custom Web Page” on page 28-14.

■ Execution Interval (msec)
Specifies the interval (0 to 5000 msec) for the MICRO/I to return data.
When the remote control function and the remote monitoring function place a load on MICRO/I operation, that load 
can be reduced by increasing this value.

However, the display update speed in the web browser will become slower. (Default: 5*1, 100*2 msec) Change this 
value if the display speed of custom web pages is slow.

■ Port Number
Specifies the port number to use for the web server function. (Default: 80)

■ Default Showing Page
Select the web page to display first when accessing the MICRO/I from a web browser terminal. (Default: System 
Information)

3 Click the OK button.

*1 HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F only
*2 HG2G-5T, HG1G/1P only

(Data Type)

Remote Control and Monitoring: Select the functions that are allowed when MICRO/I is accessed from a web browser 
terminal. (Default: Disabled)
When the remote control or remote monitoring function is enabled, you can have the 
screen automatically change to the System Information page if no operations are 
performed in the Remote Control page or Remote Monitor page for the specified 
time. Refer to Chapter 4 “Remote Control and Monitoring” on page 4-64.

If Device Address is selected for (Data Type), note the following points:
• If the value of device address is set to 61 or higher, it will be treated as 60 minutes.
• Once a network connection is established between the web browser and the MICRO/I, the timeout period 

cannot be changed. The timeout period needs to be set in Device Address before a web browser access 
to the MICRO/I.
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1.5 System Web Page

The System Web Page is the provided web pages that can display the system information and support the remote 
functions. Accesses the MICRO/I from a web browser terminal to browse it.

● Page configuration
The MICRO/I web pages have the following page configuration.
There are links to each page from the homepage (http://(IP address of MICRO/I)/).

System Information Page http://MICRO/I IP address:Port number/top.html

System Detailed Information Page

Remote Functions Page

Remote Monitoring Page

Remote Operation Page
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● Screen configuration
Each page can be displayed in either English or Japanese. When the web browser's preferred language is set to 
Japanese, the pages are displayed in Japanese. When the web browser's preferred language is set to a language 
other than Japanese, the pages are displayed in English.

All pages are displayed in a right-left two frame configuration on web browsers that support frames.
See example below.

■ Left frame
Links to each page are shown in this menu frame.

■ Right frame
Shows the function page.
Except for the full screen remote monitoring screen and remote operation screen, all of the pages shown in the right 
frame have a Maximize link, Menu link, and Home link.

When using a web browser that does not support frames, the display position of items changes, but the content is the 
same.

Left Frame Right Frame

[Maximize] Link

Menu Link
Home Link

[Maximize]: Disables the frame display and shows the page in the full web browser screen.

Menu: Shows the menu page.
The content of the menu page is the same as the left frame (menu frame) when showing the frame.

Home: Goes to the System Information page. When going to the System Information page, frames are always 
shown.
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● System Information Page
If you successfully access the MICRO/I, the System Information page is displayed.
See example below.

The MICRO/I information shown on the System Information page is listed below.

Display item Description

Mode

Shows the system’s current mode.
• Run Mode
• System Mode
• Monitor Mode
• Offline Mode
• Data Transfer Mode

Error

Shows the following errors.
• Communication Error
• No Screen Data
• Waiting for Default Screen No.
• Processing Error
• Backup Data Lost
• Network Off Line
• Device Range Error
• Script Error

System

Type Number Shows the MICRO/I model number.

Project Name
Shows the project name.
(When characters other than alphanumeric characters are included on the 
English page, the project name is shown as “-Wrong Strings-”.)

System Version Shows the MICRO/I system software version.

System Time (m/d/y h:m:s) Shows the date and time of the MICRO/I's internal clock when the page was acquired.
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External 
Device 
Communi-
cation 1 to 
4

Interface Shows the communication interface.

Manufacturer Shows the external device manufacturer name.

Communication Driver Name Shows the communication driver name.

Communication Driver Version Shows the communication driver version.

O/I Link

Baud Rate [bps] Shows the O/I link communication speed.

O/I Link Station Shows the O/I link master station or slave station number.

Slave Registration Settings Shows the slave registration setting register for the O/I link communication master.

Slave Online Status Shows the slave online information register for the O/I link communication master.

Display item Description

• For details about error messages, refer to Chapter 36 “1.1 Errors Displayed on the Screen” on page 36-1.
• For details on O/I Link, refer to Chapter 3 “O/I Link Communication Interface” in the WindO/I-NV4 External 

Device Setup Manual.
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● System Detailed Information Page
Click the System Detailed Information link in the left frame or the More Information link in the System 
Information page's right frame to show the system detailed information page.
See example below.

The MICRO/I information shown on the system detailed information page is listed below.

Display item Description

Mode

Shows the system's current mode.
• Run Mode
• System Mode
• Monitor Mode
• Offline Mode
• Data Transfer Mode

Error

Shows the following errors.
• Communication Error
• No Screen Data
• Waiting for Default Screen No.
• Processing Error
• Backup Data Lost
• Network Off Line
• Device Range Error
• Script Error

System

Type Number Shows the MICRO/I type model number.

System Version Shows the MICRO/I system software version.

System Time (m/d/y h:m:s)
Shows the date and time of the MICRO/I's internal clock when the 
page was acquired.



1 Web Server Function

28-10 WindO/I-NV4 User’s Manual

Project 
Information

Project Name
Shows the project name.
(When characters other than alphanumeric characters are included on 
the English page, the project name is shown as “-Wrong Strings-”.)

Author Shows the project author.

Date Modified (m/d/y h:m:s)
Shows the project’s last modified date/time. The displayed date/
time is Greenwich Mean Time (GMT).

Installed Font Shows the extension fonts installed in the MICRO/I.

External 
Device 
Communi-
cation 1 to 4

Interface Shows the communication interface.

Manufacturer Shows the external device manufacturer name.

Communication Driver Name Shows the communication driver name.

Communication Driver Version Shows the communication driver version.

(Parameter unique to driver - 1)

The four items below the driver version show each driver’s unique 
settings. The item names differ according to the drivers.

(Parameter unique to driver - 2)
(Parameter unique to driver - 3)
(Parameter unique to driver - 4)
Serial Interface Shows the serial interface used as the External Device Communication 1 to 4.

Baud Rate [bps] Shows the speed of the External Device Communication 1 to 4.

Data Bits Shows the data length of the External Device Communication 1 to 4.

Stop Bits Shows the stop bits of the External Device Communication 1 to 4.

Parity Shows the parity of the External Device Communication 1 to 4.

Flow Control
Shows the flow control method of the External Device Communication 
1 to 4.

Retry Cycles
Shows the number of times to retry communication before 
displaying a communication error of the External Device 
Communication 1 to 4.

Time Out [msec]
Shows the response waiting time from the External Device 
Communication 1 to 4.

Transmission Wait [msec]
Shows the transmission interval for a communication command of 
the External Device Communication 1 to 4.

O/I Link

Baud Rate [bps] Shows the O/I link communication speed.

O/I Link Station Shows the O/I link master station or slave station number.

Slave Registration Settings
Shows the slave registration setting register for the O/I link 
communication master.

Slave Online Status
Shows the slave online information register for the O/I link 
communication master.

Ethernet

IP Address Shows the IP address.

Netmask Shows the subnet mask.

Gateway Shows the default gateway address.

MAC Address Shows the Ethernet MAC address.

System 
Operation

Default Screen Number Shows the screen number displayed when MICRO/I starts running.

Screen Number Format Shows the depiction method for the displayed screen number.

Start Time [sec] Shows the time until starting communication with the external device.

Auto Backlight OFF [min] Shows the time for the backlight to turn off automatically.

Flashing Cycle [sec]
Shows the flashing speed for parts and draw objects with the 
blinking attribute.

Touch Sound Shows On or Off for the touch panel confirmation sound.

Menu Language Shows the system screen’s display language.

Display item Description

• The contents of the display items on the system detailed information page are the values set on the 
Project Settings dialog box displayed by clicking Project under System Setup on the Configuration tab in 
WindO/I-NV4.

• For details on the item of the External Device Communication 1 to 4, refer to the WindO/I-NV4 External 
Device Setup Manual.
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● Remote monitoring page
You can remotely monitor the MICRO/I from a web browser. When the left frame is displayed, click the Monitor link 
in the left frame to display the remote monitoring page.
A screen image of the screen displayed on the MICRO/I is shown.
See example below.

The following items can be specified on the remote monitoring page.

■ Picture Format
Specify the image format to use in remote monitoring.

• On the remote monitoring page, the MICRO/I cannot be controlled even when the screen image 
displayed in the web browser is clicked. To control the MICRO/I, please open the remote control page.

• For the HG5G/4G/3G/2G-V, HG4G/3G and the HG2G-5F, when the MICRO/I display is off by the backlight 
auto off function or the System Area 1 screen display (address number+1, bit 7), the screen image is not 
displayed in a web browser.

• If JavaScript is prohibited in the web browser settings, the web page will not operate correctly. Please 
enable JavaScript.

• The screen image cannot be displayed on web browsers that do not support the bitmap or JPEG format.
• The display may not be updated depending on the web browser's cache settings.

65536 Color JPEG Format (Slow): Capable of showing the screen image displayed on the MICRO/I in the web 
browser without degradation. However, the update speed of the web browser 
display is slower than 256 Color Bitmap Format (Fast) and the MICRO/I 
screen update speed also slows down.

256 Color Bitmap Format (Fast): Shows the screen image displayed on the MICRO/I reduced to 256 colors. The 
screen image displayed on the MICRO/I is somewhat degraded, but the 
update speed of the display on the web browser speeds up and the impact on 
the MICRO/I screen update speed is reduced. (The screen update speed of 
the 256 color bitmap format tends to be faster than the 65536 color JPEG 
format, but it may be slower depending on the screen’s displayed content.)
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■ [Maximize] link
Hides the left frame, page title, and screen format settings, and shows only the MICRO/I screen image. The screen 
format settings are the same as before clicking the [Maximize] link.
These screens are examples.

● Remote control page
You can remotely control the MICRO/I from a web browser. When the left frame is displayed, click the Control link in 
the left frame to display the remote control page.
An image of the screen displayed on the MICRO/I is shown. You can also control the MICRO/I by clicking on the 
displayed screen image.
This screen is an example.

• If JavaScript is prohibited in the web browser settings, the web page will not operate correctly. Please 
enable JavaScript.

• The screen image cannot be displayed on web browsers that do not support the bitmap or JPEG format.
• The display may not be updated depending on the web browser's cache settings.
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The following items can be specified on the remote operation page.

■ Picture Format
Specify the image format to use in remote operation.

■ Control Options
Operation restrictions prohibit operation from other computers or the touch panel of the MICRO/I while the MICRO/I 
is being remotely controlled.

■ [Maximize]
Hides the left frame, page title, and screen format settings, and shows only the MICRO/I screen image. The screen 
format settings are the same as before clicking the [Maximize] link.

65536 Color JPEG Format (Slow): Capable of showing the screen image displayed on the MICRO/I in the web 
browser without degradation. However, the update speed of the web browser 
display is slower than 256 Color Bitmap Format (Fast) and the MICRO/I 
screen update speed also slows down.

256 Color Bitmap Format (Fast): Shows the screen image displayed on the MICRO/I reduced to 256 colors. The 
screen image displayed on the MICRO/I is somewhat degraded, but the 
update speed of the display on the web browser speeds up and the impact on 
the MICRO/I screen update speed is reduced. (The screen update speed of 
the 256 color bitmap format tends to be faster than the 65536 color JPEG 
format, but it may be slower depending on the screen's displayed content.)

Disable Control From Other Clients: Check to prohibit remote control from other computers. When this function is 
enabled, if a web browser is already accessing the MICRO/I, the message 
Remote Control is disabled by other client will be displayed on the other 
browser and access is denied. When disabled, the MICRO/I can be accessed 
from multiple web browsers.

Disable Control From Touch Panel: Check to prohibit control with the MICRO/I touch panel. When this function is 
enabled, if a web browser is already accessing the MICRO/I, the message 
Touch panel is disabled by Remote Control Function will be displayed 
on MICRO/I and operation by the MICRO/I touch panel is not possible. When 
disabled, control by the MICRO/I touch panel is possible.
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1.6 Custom Web Page

The Custom Web Page is the web page which you create by the Web Page Editor. Downloads the created web page 
file to the external memory device inserted in the MICRO/I, and accesses the MICRO/I from a web browser terminal 
to browse it.

● Web Page Editor
Use the Web Page Editor to create a Custom Web Page.

Works on the Web Page Editor

The Web Page Editor works on an web browser. The recommended web browser is as follows:
• Google Chrome 47 or later
• Mozilla Firefox 42 or later
• Microsoft Internet Explorer 11

● Creating Custom Web Page
This example describes the case of pressing the Switch 1 turns on the Lamp 1. In this case, the HMI Internal Relay 
LM0 have been used in the current project.

To browse the Custom Web Page on the web terminal, select the Use Custom Web Page check box under 
the Web Server tab of the Project Settings dialog box. If the display speed of custom web pages is slow, 
change the value of Execute Interval on the Web Server tab in the Project Settings dialog box.

• The recommended web browser must be set for default web browser before using the Web Page Editor.
• We confirm that up to 100 pages of the Custom Web Page can be created by using the Web Page Editor.

Press

Press

Switch 1 Lamp1

When LM0 is 1, Lamp displays ON graphic.Pressing the switch sets LM0 to 1.

Initial image (Displays OFF graphic)Initial image

When LM0 is 0, Lamp displays OFF graphic.Pressing the switch sets LM0 to 0.
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1 On the Configuration tab, in the Editor group, click Web Page Editor.

Web Page Editor starts.

2 Configures a Switch 1.

Select Switch in the Components list, and drag and drop it on the editing area.
The switch will be placed on the area with the predefined size.

3 Click the switch placed on the work area and on the Property tab, for Link Box, click .

The Device Tree dialog box is displayed.

If the Windows Security Alert dialog box is displayed, click Allow access.

To place a switch on the area with the desired size, click Switch in the Components list, and then drag the 
cross hair cursor on the editing area.



1 Web Server Function

28-16 WindO/I-NV4 User’s Manual

4 Click the device address to configure for the Switch 1 and click OK.

This configures LM0 for the Switch 1.

5 Repeat step 2 through 4 to configure the Lamp 1 in the same procedure with the Switch 1.

6 Click File on the menu bar and click Save page as.

The Save Page dialog box is displayed.

The internal devices of the MICRO/I are displayed in the Device Tree dialog box.
To display an address number, it needs to be configured in the project being edited before Web Page Editor 
opens.
For device addresses not displayed in the Device Tree dialog box, input them directly into the text box 
below Link Box of the Property tab.
The format of the device address to edit directly in text box is as follows:

Example: Device Type is LDR(HMI Data Register), Address Number is 100, and Data Type is UBIN16(W)
IDEC:LDR:LDR0100.UBIN16(W)

Device type :IDEC: Device Address . Data Type
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7 Enter the file name in Save Name, and click OK.

A confirmation message is displayed.

8 Click OK.

This concludes creating the Custom Web Page.

The saved file name is displayed in Web Page Editor on the Project window.

• For details on Web Page Editor, refer to the Web Page Editor help that is displayed by clicking Help of 
Help on the menu bar.

• The image files and movie files that have been added with the Web Page Editor are displayed in Web 
Page Editor on the Project window.

• To edit the Custom Web Page, double-clicking a file name displayed in Web Page Editor on the Project 
window.
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2.1 What Can Be Done with the FTP Server Function

The FTP server function enables communication from MICRO/I (FTP server) to a computer (FTP client). From the FTP 
client, the followings are enabled.

• Reading files from the external memory device inserted in the MICRO/I
• Writing files to the external memory device inserted in the MICRO/I

2.2 System Composition

An example system configuration for using the FTP server function is shown below.
Configure the MICRO/I Ethernet settings (IP address, subnet mask, default gateway) and connect to a local network.

*1 Only USB flash drive for HG2G-5T and HG1G/1P

2 FTP Server Function

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

(1) Access the MICRO/I from a FTP client connected to the local network to use the FTP server function, and read or 
write the file contained in the external memory device inserted in the MICRO/I.

(2) When the local network is connected to an external network, configure the FTP client connected to the remote 
network with the local network’s gateway, router, and other settings. Access the MICRO/I from the remote FTP 
client to read or write the files contained in the external memory device inserted in the MICRO/I.

FTP Server

FTP Client
(Computer)

FTP Client
(Computer)

Local Network Ethernet Communication (TCP/IP)

Remote Network

(1)

(2)

External device

MICRO/I External Memory Device

USB flash drive

SD memory card

File File
External Network

*1

For gateway, router, and other settings, contact the administrator of the network which the MICRO/I is 
connected to.
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2.3 Hierarchy of the FTP Server

The hierarchy of the FTP server is as follows:

2.4 Supported Commands and Transfer modes

• Commands defined by RFC959
• Active mode and Passive mode

2.5 Verified FTP Client

With the FTP server function, the operation has been checked by using the following FTP client. (As of January 2019 
now)
• FFFTP
• FileZilla
• Core FTP Lite
• MICRO/I (FTP client function)
• IDEC PLC (FTP client function)

Example: 

A

B

HGDATA01

/

(The root folder of the SD memory card)

(The root folder of hte FTP server)

(The root folder of the USB flash drive)

RECIPE

When no external memory device is inserted in the MICRO/I or when no folder is specified to Target, the 
root folder of the FTP server is displayed.

SFTP and FTPS are not supported.

• For the settings and how to use the FTP client software, please check the help and manual of each 
software.

• Depending on the FTP client software, including subfolders may not be able to write in batch. In this 
case, please write data each one level.
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2.6 Settings and Connection Method

Follow the procedure below to access the external memory device inserted in the MICRO/I from the FTP client.
Here describes an example where a web browser is used as a FTP client software.

1 Connect the MICRO/I to a local network.

Connect the MICRO/I’s Ethernet interface to the Ethernet port of the local network’s router or hub with a LAN cable.

2 Configure the MICRO/I.

• Ethernet settings
 Refer to Chapter 4 “When Ethernet is selected under Interface Configuration” on page 4-40.

• User account settings
 Refer to Chapter 23 “3 Security Dialog Box” on page 23-37.

• FTP server settings
 Refer to “FTP Server Function Configuration Procedure” on page 28-21.

3 Login to the MICRO/I.

Start the web browser and go to the following URL. After the user name and password are successfully verified, the 
folder of external memory device inserted in the MICRO/I is displayed.

ftp://(User Name):(Password)@(MICRO/I IP address)/

4 Read or write the file.

An “Administrator” or “Operator” user account is required to login the MICRO/I.

Example 1: The MICRO/I’s IP address is 192.168.0.1, the User Name is User1 and the Password is 1234.
ftp://User1:1234@192.168.0.1/

Example 2: The MICRO/I’s IP address is 192.168.0.1, the User Name is User2 and the Password is not set.
ftp://User2@192.168.0.1/

• Connection from anonymous user is not accepted.
• The MICRO/I can be accessed simultaneously from one FTP client only.
• For the available file paths and file names, follow the specification of the external memory device. For 

details, refer to Chapter 31 “1.3 Specifications of External Memory Devices” on page 31-2.
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● FTP Server Function Configuration Procedure

1 On the Configuration tab, in the System Setup group, click Project.

The Project Settings dialog box is displayed.

2 Configure the items on the FTP Server tab.

■ Enable FTP Server function
When the Enable FTP Server function check box is not selected, you cannot access the folder of the external 
memory device inserted in the MICRO/I even when the connection from the FTP client to the IP address of the 
MICRO/I has been established.(Default: Off)

■ Port Number
Specifies the port number to use for the FTP server function (0 to 65535). (Default: 21)

■ Connection Timeout
Set the timeout period. After you login MICRO/I, MICRO/I will keep monitoring for its traffic. If there is no traffic at all 
for a specified period of time, the MICRO/I will disconnect the FTP client. (Default: 15 minutes)

■ Specify Target
Specify the folder and the external memory device inserted in the MICRO/I to be accessed from the FTP client. When 
the Target is specified, you cannot access the level higher than the specified folder. 

3 Click the OK button.

(Data Type)

• The timeout period to login the MICRO/I is 1 minute.
• If Device Address is selected for (Data Type), note the following points:

- When the value of device address is 0, the Connection Timeout is 1 minute, and when the value of 
device address is 61 or more, the Connection Timeout is regarded as 60 minutes.

- Once a network connection is established between the FTP client and the MICRO/I, the timeout period 
cannot be changed. The timeout period needs to be set in Device Address before connecting the FTP 
client to the MICRO/I.

When you access a file during its reading or writing operation, the reading or writing operation for the file 
accessed is performed after the first processing is completed. 
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3.1 What Can Be Done with the FTP Client Function

The FTP client function enables copy or move files between FTP servers with external memory device inserted in 
MICRO/I (FTP client). The host name of the FTP server can also be specified.
When MICRO/I operates as the FTP client, the followings are enabled.

•  Copying or moving files from the external memory device inserted in the MICRO/I to the FTP server
•  Copying files from the FTP server to the external memory device inserted in the MICRO/I

3.2 System Composition

An example system configuration for using the FTP client function is shown below.
Configure the MICRO/I Ethernet settings (IP address, subnet mask, default gateway) and connect to a local network.
Configures the target FTP server to the MICRO/I.

When the trigger condition for the FTP client function (File Transfer Settings) is satisfied, the following prosess is 
executed.
• Copying or moving files from the external memory device inserted in the MICRO/I to the FTP server
• Copying files from the FTP server to the external memory device inserted in the MICRO/I

*1 Only USB flash drive for HG2G-5T and HG1G/1P

3 FTP Client Function

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

FTP Server

FTP Client

FTP Server

FTP Server

Local Network

Ethernet Communication (TCP/IP)

Remote Network

External device

MICRO/I

External device

MICRO/I

External Memory Device

USB flash drive

SD memory card

External Memory Device

USB flash drive

SD memory card

File File
File

External Network

*1

*1

For gateway, router, and other settings, contact the administrator of the network which the MICRO/I is 
connected to.
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3.3 Supported Commands and Transfer modes

• Commands defined by RFC959
• Active mode and Passive mode

3.4 Verified FTP Server

With the FTP client function, the operation has been checked by using the following FTP server. (As of May 2018 now)
• Microsoft Internet Information Services
• FileZilla
• Very Secure FTP Daemon
• MICRO/I (FTP server function)
• IDEC PLC (FTP server function)

3.5 FTP Client Function Configuration Procedure

This section describes the configuration procedure for the FTP server and the FTP client function.

● Configure the FTP Server
Configures the target FTP server.

1 On the Configuration tab, in the Manager group, click FTP Server Manager.

The FTP Server Manager is displayed.

2 Select the number to configure the FTP server in (FTP Server List), then click Edit.

The Individual Settings dialog box for the selected number is displayed.

SFTP and FTPS are not supported.

FTP Server List
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3 Configure each items of the FTP server.

■ FTP server settings

■ Advanced Setting
Specifies the FTP server settings by the values of the device addresses. The settings for the FTP server settings can 
be used as initial values. For details, refer to “Individual Settings Dialog Box” on page 28-30.

4 Click OK to close the Individual Settings dialog box.

You are returned to the FTP Server Manager.

5 Repeat steps 2 through 4 to configure the necessary FTP server.

6 Click OK.

This concludes the FTP server configuration.

Server Name: Enter a name of the FTP server. The maximum number is 40 characters.
The default is "FTPServern". (n: The number in the FTP Server Manager)

Host Name: Select this option and enter the host name when specifying the FTP server with a host name.
The maximum number is 40 characters. Only alphanumeric characters and symbols can be 
used.

IP Address: Select this option and enter the IP address when specifying the FTP server with an IP address.
The format is “xxx.xxx.xxx.xxx”. “xxx” stands for a numeric value from 0 to 255.

User Name: Enter the name of the user account for the FTP server.
The maximum number for the user name is 40 characters. Only alphanumeric characters and
symbols can be used.

Password: Enter the password for the FTP server.
The maximum number for the user name is 40 characters. Only alphanumeric characters and
symbols can be used.

Port Number: Specifies the port number for the FTP server (0 to 65535).

Transfer Mode: Selects the transfer mode of the FTP server.

Pasv: Uses passive mode for the data connection.

Active: Uses active mode for the data connection.

Connection Timeout: Specifies the timeout period (10 to 300 seconds) until the connection to server is automatically 
aborted. After the Trigger Condition in the File Transfer Settings is satisfied, if there is no 
response from the FTP server which is tried to connect, the MICRO/I will automatically cancel 
to connect.

Transfer Timeout: Specifies the timeout period (10 to 300 seconds) until the process of transferring files is 
automatically canceled. After the Trigger Condition in the File Transfer Settings is satisfied 
and the data connection is available, if there is no response from the FTP server, the MICRO/I 
will automatically cancel to transfer files.
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● Configuring the Files to copy or move and the Trigger Condition

1 On the Configuration tab, in the System Setup group, click File Transfer.

The File Transfer Settings dialog box is displayed.

2 Select the number to configure the File Transfer Settings in (Settings), then click Edit.

The Individual Settings dialog box for the selected number is displayed.

3 Configure the items on the General tab.

(Settings)
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■ Source
Select the source external memory device or the FTP server where the files to be copied or moved are stored from the 
following items.

SD Memory Card*1, USB Flash Drive, (FTP server)
The No.+.(period)+Server Name of the FTP server specified in the FTP Server Manager is displayed.
Example: No. is 1 and Server Name is TestServer1

1.TestServer1

*1 HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F only

Location: Selects the method to specify the save location of source files to copy or move.

Fixed: Specify the save location of the target folder or file path as a string. The maximum number is 
247 characters.
Example: Copy or move files to the “ALARMLOG” folder under “HGDATA01” folder on the 

external memory device
HGDATA01\ALARMLOG

Click on the External Memory Device Folder button or click on ▼ to the right on it, and then 
select the item on the list.

Specify the Location by Value of Device Address:

Specifies a word device to specify a folder or file path of the files to copy or move. The path is 
set by reading the values sequentially from the starting device specified and handling those 
values as character data up to the character before NULL (0x00). The maximum number of 
device addresses is 124 (2 characters per word device, maximum of 247 singlebyte characters). 

Click  to display the Tag Editor. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-68.

• Files cannot be copied or moved from the FTP server to the FTP server.
• When transferring files from external memory to external memory and HMI special internal relay LSM67 is 

0, subfolders can be copied and moved up to five folders deep. When HMI special internal relay LSM67 is 
changed from 0 to 1, subfolders cannot be copied or moved.

• The following single-byte characters cannot be used in the folder or file path configured by Fixed or 
Specify the Location by Value of Device Address.
; : * ? " < > |

• Folder or File path that exceed the limits in Specify the Location by Value of Device Address and 
folder or file path configured with characters that cannot be used are as follows.
- When the text of the folder or file path exceeds the maximum number of device addresses (no NULL), 

the text stored in device addresses up to the maximum number of device addresses from the start is 
configured.

- When a character that cannot be used is set, the text is up to that character.
• If the transfer source is a MICRO/I configured as an FTP server, “A\” or “B\” must be specified at the 

beginning of the path for each type of external memory.
Example 1: If the transfer source is the “ALARMLOG” folder in the “HGDATA01” folder on the SD 

memory card:
A\HGDATA01\ALARMLOG

Example 2: If the transfer source is the “ALARMLOG” folder in the “HGDATA01” folder on the USB flash 
drive:
B\HGDATA01\ALARMLOG
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■ Destination
Select the target external memory device or the FTP server where the files to be copied or moved are stored from the 
following items.

SD Memory Card*1, USB Flash Drive, (FTP server)
The No.+.(period)+Server Name of the FTP server specified in the FTP Server Manager is displayed.
Example: No. is 1 and Server Name is TestServer1

1.TestServer1

■ Operation
Selects Copy or Move for the procedure to transfer the files. Can only be set Copy when Source is set to (FTP 
server).

*1 HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F only

Location: Selects the method to specify the target save location of files to copy or move.

Fixed: Specify the save location of the target folder path as a string. The maximum number is 247 
characters.
Example: Save the copied or moved files to the “ALARMLOG” folder under “HGDATA01” folder 

on the external memory device
HGDATA01\ALARMLOG

Click on the External Memory Device Folder button or click on ▼ to the right on it, and then 
select the item on the list.

Specify the Location by Value of Device Address:

Specifies a word device to specify a folder path of the copied or moved files. The path is set by 
reading the values sequentially from the starting device specified and handling those values as 
character data up to the character before NULL (0x00). The maximum number of device 
addresses is 124 (2 characters per word device, maximum of 247 singlebyte characters). Click 

 to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 
“5.1 Device Address Settings” on page 2-68.

• Files cannot be copied or moved from the FTP server to the FTP server.
• When transferring files from external memory to external memory and HMI special internal relay LSM67 is 

0, subfolders can be copied and moved up to five folders deep. When HMI special internal relay LSM67 is 
changed from 0 to 1, subfolders cannot be copied or moved.

• The following single-byte characters cannot be used in the folder or file path configured by Fixed or 
Specify the Location by Value of Device Address.
; : * ? " < > |

• Folder or File path that exceed the limits in Specify the Location by Value of Device Address and 
folder or file path configured with characters that cannot be used are as follows.
- When the text of the folder or file path exceeds the maximum number of device addresses (no NULL), 

the text stored in device addresses up to the maximum number of device addresses from the start is 
configured.

- When a character that cannot be used is set, the text is up to that character.
• If the transfer destination is a MICRO/I configured as an FTP server, “A\” or “B\” must be specified at the 

beginning of the path for each type of external memory.
Example 1: If the transfer destination is the “ALARMLOG” folder in the “HGDATA01” folder on the SD 

memory card:
A\HGDATA01\ALARMLOG

Example 2: If the transfer destination is the “ALARMLOG” folder in the “HGDATA01” folder on the USB 
flash drive:
B\HGDATA01\ALARMLOG

If the destination file exists: Selects Skip or Overwrite for the processing method when there is the same file 
name in the destination.
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■ Store the Error Information when the Transfer is failed
Select this check box to store the error information in device addresses when an error occurs during file copying or 
moving and specifies the word device to write the error information to.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.

■ Report when the Transfer ends
Select this check box to report when files have been copied or moved and specifies the destination bit device or the 
bit number in the destination word device.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.

4 Configures the trigger condition on the Trigger Condition tab.

■ Trigger Type
Selects the condition to copy or move the files from the following.

■ Data Type
Select the data type handled by the conditional expression.
Can only be set if While satisfying the condition is selected as Trigger Type. For details, refer to Chapter 2 “1.1 
Available Data” on page 2-1.

■ Device Address
Specifies the bit device or the bit number of the word device to serve as condition. 

Can only be set if While ON or While OFF is selected as Trigger Type. Click  to display the Tag Editor. For the 
device address configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-68.

■ Condition
Sets the condition formula.

Can only be set if While satisfying the condition is selected as Trigger Type. Click  to display the Trigger 
Condition Settings dialog box. For the conditional expressions configuration procedure, refer to Chapter 2 “5.2 Setting 
Conditional Expressions” on page 2-71.

5 Click OK to close the Individual Settings dialog box.

You are returned to the File Transfer Settings dialog box.

6 Repeat steps 2 through 5 to configure the necessary File Transfer settings.

7 Click OK.

This concludes configuring the files to copy or move and the trigger condition.

Rising-edge: Copy or move the files when a value of device address changes from 0 to 1.

Falling-edge: Copy or move the files when a value of device address changes from 1 to 0.

Satisfy the condition: Copy or move the files when condition changes from not satisfied to satisfied.



WindO/I-NV4 User’s Manual 28-29

3 FTP Client Function

28

M
aintenance

3.6 FTP Server Manager

This section describes items and buttons on the FTP Server Manager.

● FTP Server Manager
The FTP server settings are collectively managed in FTP Server Manager.

■ (Settings)
Displays a list of the FTP server settings for each number. Double clicking the cell displays the Individual Settings 
dialog box where you can edit the settings. For details, refer to “Individual Settings Dialog Box” on page 28-30.

■ Edit
Registers or changes the settings for the selected number.
Select a number from the (Settings) and click this button to display the Individual Settings dialog box. The 
configured content for the selected number is reflected in the Individual Settings dialog box.
For details, refer to “Individual Settings Dialog Box” on page 28-30.

■ Delete
Deletes the settings for the selected number from the (Settings).

■ Select*1

Returned to the File Transfer Settings dialog box, and then configures the selected FTP server from the (Settings)

*1 Select is only displayed when this dialog box is opened from File Transfer Settings dialog box

(Settings)

No.: Displays the number (1 to 16) for managing the FTP server settings.

Server Name: Displays the name of the FTP server.

Host Name/IP Address: Displays the Host Name or IP address of the FTP server.

User Name: Displays the user name of the FTP server.

Password: Displays the password of the FTP server as * (asterisks).

Port Number: Displays the port number of the FTP server.

Transfer Mode: Displays the transfer mode of the FTP server.

Connection Timeout: Displays the timeout period until the connection to server is automatically aborted. After the 
Trigger Condition in the File Transfer Settings is satisfied, if there is no response from 
the FTP server which is tried to connect, the MICRO/I will automatically cancel to connect.

Transfer Timeout: Displays the timeout period until the process of transferring files is automatically canceled.
After the Trigger Condition in the File Transfer Settings is satisfied and the data connec-
tion is available, if there is no response from the FTP server, the MICRO/I will automatically
cancel to transfer files.

Top Device Address: Displays the top device address when the settings of FTP servers are specified with the value 
of the device address.

Copy the settings as default value to Device Address:

Displays the bit device or the bit number of the word device that triggers the copy of the 
settings for FTP servers to device addresses as default.
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● Individual Settings Dialog Box
Use the Individual Settings dialog box to register or edit the FTP server settings for the selected number.

■ FTP Server Settings

Server Name: Enter a name of the FTP server. The maximum number is 40 characters.
The default is "FTPServern". (n: The number in the FTP Server Manager)

Host Name: Select this option and enter the host name when specifying the FTP server with a host name.
The maximum number is 40 characters. Only alphanumeric characters and symbols can be 
used.

IP Address: Select this option and enter the IP address when specifying the FTP server with an IP address.
The format is “xxx.xxx.xxx.xxx”. “xxx” stands for a numeric value from 0 to 255.

If Host Name is selected, the IP address of the FTP server is looked up and obtained from the host name 
using the DNS server. In order to access a DNS server from the MICRO/I, the IP address of the DNS server 
must be specified. For details, refer to “When Ethernet is selected under Interface Configuration” on page 4-
40.

User Name: Enter the name of the user account for the FTP server.
The maximum number for the user name is 40 characters. Only alphanumeric characters and
symbols can be used.

Password: Enter the password for the FTP server.
The maximum number for the user name is 40 characters. Only alphanumeric characters and
symbols can be used.

Port Number: Specifies the port number for the FTP server (0 to 65535).

Transfer Mode: Selects the transfer mode of the FTP server.

Pasv: Uses passive mode for the data connection.

Active: Uses active mode for the data connection.

Connection Timeout: Specifies the timeout period (10 to 300 seconds) until the connection to server is automatically 
aborted. After the Trigger Condition in the File Transfer Settings is satisfied, if there is no 
response from the FTP server which is tried to connect, the MICRO/I will automatically cancel 
to connect.

Transfer Timeout Specifies the timeout period (10 to 300 seconds) until the process of transferring files is 
automatically canceled. After the Trigger Condition in the File Transfer Settings is satisfied 
and the data connection is available, if there is no response from the FTP server, the MICRO/I 
will automatically cancel to transfer files.
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■ Advanced Setting

Allocation of Address Number when the FTP Server Settings are specified by Value of Device Address
When the Specify FTP Server Settings by Value of Device Address check box is selected, it allocates the 
settings of the FTP Server Settings starting at the device address set in the Top Device Address. The details are 
shown below.

*1 When IP address is selected, use only four words from the beginning, and the remaining seventeen words are left as a 
reserved area.

*2 The twenty-first word is recognized as a NULL terminating character (0x00) regardless of the value of device address.
*3 Add a NULL terminating character (0x00) as the end of the string data when the string length is less than twenty words.

Specify FTP Server Settings by Value of Device Address: Select this check box to set the FTP Server Settings 
using the value of the specified device address.

Top Device Address: Specify the word device to use. It allocates the settings of the FTP Server Settings starting 
at the configured device address. You can only specify an internal device.

Click  to display the Tag Editor. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-68.

Copy the settings as default value to Device Address: Select this check box to copy the settings in the FTP 
Server Settings to device addresses as default.

(Device Address): Specifies the bit device or the bit number of the word device that triggers the copy of the 
settings. 
When the value of device address changes from 0 to 1, the values configured in the FTP 
Server Settings are written, beginning from the device address set by the Top Device 
Address.

Click  to display the Tag Editor. For the device address configuration procedure, refer to
Chapter 2 “5.1 Device Address Settings” on page 2-68.

Settings Address Number Words Data Format

FTP Server +0 to +20 21*1,*2 Host Name is selected: String
IP Address is selected: Decimal

User Name +21 to +41 21*2, *3 String

Password +42 to +62 21*2, *3 String

Port Number +63 1 Decimal

Transfer Mode +64 1 Decimal

Connection Timeout (second units) +65 1 Decimal

Transfer Timeout (second units) +66 1 Decimal

String data is stored in the upper byte and lower byte according to the Storage Method of String Data 
setting. For details, refer to Chapter 4 “Storage Method of String Data” on page 4-28.
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Example: The FTP Server Settings are set as follows:

The value of each device address is listed below.

Settings Preset Value

Outgoing FTP Server, IP Address is selected. 192.168.0.44

User Name test_user001

Password test password

Port Number 587

Transfer Mode (0: Pasv, 1: Active) Pasv

Connection Timeout 30

Transfer Timeout 60

Top Device Address LKR 100

Storage Method of String Data from Upper byte

Settings Preset Value

FTP Server

Device 
Address

LKR 100 LKR 101 LKR 102 LKR 103 LKR 104 to LKR 120

Value 
(Decimal)

192 168 0 44 Reserved

User Name

Device 
Address LKR 122 LKR 123 LKR 124 LKR 125 LKR 126 LKR 127 LKR 128 LKR 129 to LKR 141

String (ASCII) ‘t’ ‘e’ ‘s’ ‘t’ ‘_’ ‘u’ ‘s’ ‘e’ ‘r’ ‘0’ ‘0’ ‘1’ ‘\0’ ‘\0’ ‘\0’ ‘\0’

Value 
(Hexadecimal)

7465h 7374h 5F75h 7365h 7230h 3031h 0000h 0000h

Password

Device 
Address LKR 142 LKR 143 LKR 144 LKR 145 LKR 146 LKR 147 LKR 148 LKR 149 to LKR162

String (ASCII) ‘t’ ‘e’ ‘s’ ‘t’ ‘_’ ‘p’ ‘a’ ‘s’ ‘s’ ‘w’ ‘o’ ‘r’ ‘d’ ‘\0’ ‘\0’ ‘\0’

Value 
(Hexadecimal)

7465h 7374h 5F70h 6173h 7377h 6F72h 6400h 0000h

Port Number

Device 
Address LKR 163

Value 
(Decimal) 587

Transfer Mode

Device 
Address LKR 164

Value 
(Decimal) 0

Connection Timeout

Device 
Address LKR 165

Value 
(Decimal) 30

Transfer Timeout

Device 
Address LKR 166

Value 
(Decimal) 60

LKR 100

LKR 120

LKR 163
LKR 164
LKR 165
LKR 166

LKR 121

LKR 141
LKR 142

LKR 162

(The address number of Top Device Address)  +0

～
+20
+21

～

+41
+42

～

+62
+63
+64
+65
+66

Password

User Name 

FTP Server

Port Number
Transfer Mode
Connection Timeout
Transfer Timeout
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3.7 File Transfer Settings Dialog Box

This section describes the items and buttons on the File Transfer Settings dialog box.

● File Transfer Settings Dialog Box
Use the File Transfer Settings dialog box to collectively manage the trigger condition for copying or moving files 
between the FTP server and an external memory device inserted in the MICRO/I.

■ (Settings)
Displays a list of the settings of the File Transfer function. Double clicking the cell displays the Individual Settings 
dialog box where you can edit the settings. For details, refer to “Individual Settings Dialog Box” on page 28-34.

■ Edit
Registers or changes the settings for the selected number.
Select a number from the (Settings) and click this button to display the Individual Settings dialog box. The 
configured content for the selected number is reflected in the Individual Settings dialog box.
For details, refer to “Individual Settings Dialog Box” on page 28-34.

■ Delete
Deletes the settings for the selected number from the (Settings).

■ Up
Shifts the selected settings upward in the list.

■ Down
Shifts the selected settings downward in the list.

(Settings)

No.: Displays the number for managing File Transfer Settings.

Source: Displays the source external memory device or the FTP server where the files to be copied or 
moved are stored.

Destination: Displays the target external memory device or the FTP server where the files to be copied or 
moved are stored.

Trigger Type: Displays the trigger type for copying or moving files.

Trigger Condition: Displays the trigger condition of trigger type for copying or moving files. The displayed content 
varies based on Trigger Type.

Rising-edge, Falling-edge: Displays the bit device or the bit number of the word device to 
serve as condition.

Satisfy the condition: Displays the conditional expression.
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● Individual Settings Dialog Box
Registers or changes the settings for the selected number.

General Tab

■ Source
Select the source external memory device or the FTP server where the files to be copied or moved are stored from the 
following items.

SD Memory Card*1, USB Flash Drive, (FTP server)
The No.+.(period)+Server Name of the FTP server specified in the FTP Server Manager is displayed.
Example: No. is 1 and Server Name is TestServer1

1.TestServer1

*1 HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F only

FTP Server Manager: The settings of FTP server can be added or changed. Click this button to display the FTP 
Server Manager. For details, refer to “FTP Server Manager” on page 28-29.

Location: Selects the method to specify the save location of source files to copy or move.

Fixed: Specify the save location of the target folder or file path as a string. The maximum number is 247 
characters.
Example: Copy or move files to the “ALARMLOG” folder under “HGDATA01” folder on the external 

memory device
HGDATA01\ALARMLOG

External Memory Device Folder: Click this button to enter the configured content of the External 
Memory Device Folder in the External Memory Device tab 
on the Project Settings dialog box.

Click on ▼ to the right on the External Memory Device 
Folder button, and then select the item on the list to enter the 
subfolder.
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Example: The External Memory Device Folder in the 
External Memory Device tab on the Project 
Settings dialog box is "HGDATA01"

Selection Entered Text

Alarm Log Files HGDATA01\ALARMLOG

Data Log Files HGDATA01\DATALOG

Operation Log Files HGDATA01\OPERATIONLOG

Screenshots HGDATA01\CAPTURE

Recipe Files HGDATA01\RECIPE

Picture Files used by 
MICRO/I

HGDATA01\PICTURE

Sound Files used by 
MICRO/I

HGDATA01\SOUND

ZNV Project Files HGDATA01\NVDATA

ZLD Project Files HGDATA01\LDRDATA

Movie Files HGDATA01\MOVIE

Recorded Movie Files HGDATA01\RECORD

Specify the Location by Value of Device Address:

Specifies a word device to specify a folder or file path of the files to copy or move. The path is set by 
reading the values sequentially from the starting device specified and handling those values as 
character data up to the character before NULL (0x00). The maximum number of device addresses 

is 124 (2 characters per word device, maximum of 247 singlebyte characters). Click  to display 
the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.

• Files cannot be copied or moved from the FTP server to the FTP server.
• When transferring files from external memory to external memory and HMI special internal relay LSM67 is 

0, subfolders can be copied and moved up to five folders deep. When HMI special internal relay LSM67 is 
changed from 0 to 1, subfolders cannot be copied or moved.

• The following single-byte characters cannot be used in the folder or file path configured by Fixed or 
Specify the Location by Value of Device Address.
; : * ? " < > |

• Folder or File path that exceed the limits in Specify the Location by Value of Device Address and 
folder or file path configured with characters that cannot be used are as follows.
- When the text of the folder or file path exceeds the maximum number of device addresses (no NULL), 

the text stored in device addresses up to the maximum number of device addresses from the start is 
configured.

- When a character that cannot be used is set, the text is up to that character.
• If the transfer source is a MICRO/I configured as an FTP server, “A\” or “B\” must be specified at the 

beginning of the path for each type of external memory.
Example 1: If the transfer source is the “ALARMLOG” folder in the “HGDATA01” folder on the SD 

memory card:
A\HGDATA01\ALARMLOG

Example 2: If the transfer source is the “ALARMLOG” folder in the “HGDATA01” folder on the USB flash 
drive:
B\HGDATA01\ALARMLOG
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■ Destination
Select the target external memory device or the FTP server where the files to be copied or moved are stored from the 
following items.

SD Memory Card*1, USB Flash Drive, (FTP server)
The No.+.(period)+Server Name of the FTP server specified in the FTP Server Manager is displayed.
Example: No. is 1 and Server Name is TestServer1

1.TestServer1

*1 HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F only

FTP Server Manager: The settings of FTP server can be added or changed. Click this button to display the FTP 
Server Manager. For details, refer to “FTP Server Manager” on page 28-29.

Location: Selects the method to specify the target save location of files to copy or move.

Fixed: Specify the save location of the target folder path as a string. The maximum number is 247 
characters.
Example: Save the copied or moved files to the “ALARMLOG” folder under “HGDATA01” folder on 

the external memory device
HGDATA01\ALARMLOG

External Memory Device Folder: Click this button to enter the configured content of the External 
Memory Device Folder in the External Memory Device tab 
on the Project Settings dialog box.

Click on ▼ to the right on the External Memory Device 
Folder button, and then select the item on the list to enter the 
subfolder.

Example: The External Memory Device Folder in the 
External Memory Device tab on the Project 
Settings dialog box is "HGDATA01"

Selection Entered Text

Alarm Log Files HGDATA01\ALARMLOG

Data Log Files HGDATA01\DATALOG

Operation Log Files HGDATA01\OPERATIONLOG

Screenshots HGDATA01\CAPTURE

Recipe Files HGDATA01\RECIPE

Picture Files used by 
MICRO/I

HGDATA01\PICTURE

Sound Files used by 
MICRO/I

HGDATA01\SOUND

ZNV Project Files HGDATA01\NVDATA

ZLD Project Files HGDATA01\LDRDATA

Movie Files HGDATA01\MOVIE

Recorded Movie Files HGDATA01\RECORD

Specify the Location by Value of Device Address:

Specifies a word device to specify a folder path of the copied or moved files. The path is set by 
reading the values sequentially from the starting device specified and handling those values as 
character data up to the character before NULL (0x00). The maximum number of device addresses 

is 124 (2 characters per word device, maximum of 247 singlebyte characters). Click  to display 
the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.
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• Files cannot be copied or moved from the FTP server to the FTP server.
• When transferring files from external memory to external memory and HMI special internal relay LSM67 is 

0, subfolders can be copied and moved up to five folders deep. When HMI special internal relay LSM67 is 
changed from 0 to 1, subfolders cannot be copied or moved.

• The following single-byte characters cannot be used in the folder or file path configured by Fixed or 
Specify the Location by Value of Device Address.
; : * ? " < > |

• Folder or File path that exceed the limits in Specify the Location by Value of Device Address and 
folder or file path configured with characters that cannot be used are as follows.
- When the text of the folder or file path exceeds the maximum number of device addresses (no NULL), 

the text stored in device addresses up to the maximum number of device addresses from the start is 
configured.

- When a character that cannot be used is set, the text is up to that character.
• If the transfer destination is a MICRO/I configured as an FTP server, “A\” or “B\” must be specified at the 

beginning of the path for each type of external memory.
Example 1: If the transfer destination is the “ALARMLOG” folder in the “HGDATA01” folder on the SD 

memory card:
A\HGDATA01\ALARMLOG

Example 2: If the transfer destination is the “ALARMLOG” folder in the “HGDATA01” folder on the USB 
flash drive:
B\HGDATA01\ALARMLOG
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■ Operation
Selects Copy or Move for the procedure to transfer the files. Can only be set Copy when Source is set to (FTP 
server).

■ Store the Error Information when the Transfer is failed
Select this check box to store the error information in device addresses when an error occurs during file copying or 
moving and specifies the word device to write the error information to.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.
0 is written to the device address when the copy or move process starts, 1 is written to the corresponding bit when an 
error occurs.

■ Report when the Transfer ends
Select this check box to report when files have been copied or moved and specifies the destination bit device or the 
bit number in the destination word device.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.

If the destination file exists: Selects Skip or Overwrite for the processing method when there is the same file 
name in the destination.

Bit 
position

Function Cause Solution

0
External Memory Device 
Access Error

• No external memory device specified 
as the source or the destination is 
inserted.

• The external memory device specified 
as the source or the destination 
cannot be accessed.

•Insert an accessible external memory 
device.

•Mount the external memory device.

1
External Memory Device 
Reading or Writing Error

• The folders and files in the external 
memory device specified as the 
source or the destination cannot be 
read.

• Creating folders, writing to files and 
deleting files in the external memory 
device specified as the source or the 
destination cannot be executed.

• Insert an external memory device 
read or write.

• Insert an external memory device 
which has sufficient space.

2
FTP Server Connection 
Error

• The FTP server specified as the 
source or the destination cannot be 
accessed when the interval specified 
in Connection Timeout elapses.

• When Host Name is selected with the 
radio button in the FTP server 
settings, the Preferred DNS Server 
or Alternate DNS Server setting is 
incorrect.

• The host name of the FTP server 
could not be resolved.

• Connect a LAN cable.
• Change the network settings 

configured on the MICRO/I.
• Change the IP address or the port 

number of the FTP server.
• Change the Preferred DNS Server, 

Alternate DNS Server settings.
• Change the Host Name of the FTP 

server.

3
FTP Server Authentication 
Error

The user name or the password is 
incorrect.

Change the user name or the password.

4
FTP Server Command 
Error 

An error for the command transmitted 
to the FTP server was returned.

Contact the administrator of the FTP 
server.

5 FTP Server Transfer Error
The FTP server does not return a 
response when the interval specified in 
Transfer Timeout elapses.

Contact the administrator of the FTP 
server.

6
FTP Server Force 
Terminate

The process of the file transfer stopped 
by using the HMI Special Relay LSM65.

-

7 to 15 Reserved - -
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Trigger Condition Tab

■ Trigger Type
Selects the condition to copy or move the files from the following.

■ Data Type
Select the data type handled by the conditional expression.
Can only be set if While satisfying the condition is selected as Trigger Type. For details, refer to Chapter 2 “1.1 
Available Data” on page 2-1.

■ Device Address
Specifies the bit device or the bit number of the word device to serve as condition. You can only specify the internal 
device.

Can only be set if While ON or While OFF is selected as Trigger Type. Click  to display the Tag Editor. For the 
device address configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-68.

■ Condition
Sets the condition formula.

Can only be set if While satisfying the condition is selected as Trigger Type. Click  to display the Trigger 
Condition Settings dialog box. For the conditional expressions configuration procedure, refer to Chapter 2 “5.2 Setting 
Conditional Expressions” on page 2-71.

Rising-edge: Copy or move the files when a value of device address changes from 0 to 1.

Falling-edge: Copy or move the files when a value of device address changes from 1 to 0.

Satisfy the condition: Copy or move the files when condition changes from not satisfied to satisfied.

Value of Device Address
1

0

Action Execution Execution Execution

1

0

Value of Device Address

Action Execution Execution

Action Execution

Condition
Satisfied

Not satisfied

Execution Execution
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4.1 What Can Be Done with the E-mail Function

The E-mail function enables sending e-mail from the MICRO/I to smartphone, mobile device, computer, etc when a 
specified trigger condition is satisfied. The host name of the outgoing mail server (SMTP) can also be specified.

4.2 System Composition

An example system configuration for using the E-mail function is shown below.
Configure the MICRO/I Ethernet settings (IP address, subnet mask, default gateway) and connect to a local network.
Configure the MICRO/I with the outgoing mail server (SMTP).

4.3 Supported Protocols and Authentication methods

• Protocols defined by RFC2821 and RFC2822
• LOGIN for the SMTP Authentication
• SMTPs (SSL communications)

4 E-mail Function

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

(1) When the trigger condition for the E-mail function is satisfied, MICRO/I connected to the local network sends the 
e-mail to the outgoing mail server (SMTP). 

(2) The outgoing mail server (SMTP) sends the e-mail received from MICRO/I to the incoming mail server of the 
destination address. 

(3) The e-mail is received by a smartphone, mobile device and computer etc.

Outgoing mail server 
(SMTP)

Incoming Mail Server

Local Network

Ethernet Communication (TCP/IP)

Remote Network

(1)

(3) (2)

Computer

Smartphone, 
Mobile device Send

Receive

Receive

External device

MICRO/I

E-mailE-mail

E-mail

External Network

For the outgoing mail server (SMTP) and the local network settings, contact the administrator of the 
network which the MICRO/I is connected to.
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4.4 Verified SMTP Servers

The e-mail function has been verified to work with the following SMTP servers. (As of October 2017)

4.5 E-mail Sending Operation

The MICRO/I cannot simultaneously send multiple e-mails. Accordingly, when there are multiple e-mail sending 
events, such as multiple trigger conditions to send an e-mail are the same or multiple trigger conditions are satisfied 
at the same time, the e-mails are sent in the order described below.

■ Multiple trigger conditions to send an e-mail are the same or the different trigger conditions are 
satisfied at the same time
When multiple trigger conditions to send an e-mail are the same or when the different trigger conditions are satisfied 
at the same time (the values of multiple trigger device addresses change to 1 at the same time), e-mails are sent in 
the order of smaller number. Triggered e-mails will be in "Waiting" status while sending another e-mail is in progress.
For example, if the trigger conditions for e-mail number 1 and e-mail number 2 are the same, once the trigger 
conditions are satisfied, e-mail number 1 starts to be sent, and e-mail number 2 is in "Waiting" status. After the e-mail 
number 1 has been sent, the e-mail number 2 starts to be sent. 

■ When the trigger condition is satisfied during the other e-mail is being sent
When sending an e-mail is in progress and the trigger condition to send another e-mail is satisfied, triggered e-mail 
will be in "Waiting" status. Such e-mail is sent after all the e-mails in sending or waiting status have been sent.
For example, if the trigger condition for the e-mail number 2 is satisfied during the e-mail number 1 is sending, 
number 2 is in "Waiting" status. After the e-mail number 1 has been sent, the e-mail number 2 starts to be sent.

■ When the trigger condition is satisfied again during the e-mail is being sent
While sending an e-mail is in progress or an e-mail is in "Waiting" status, if the trigger condition to send such e-mail 
is satisfied, such trigger condition is disregarded.
For example, if the trigger condition for the e-mail number 1 is satisfied again during which it is being sent, the e-mail 
will be not "Waiting" status so the same e-mail is not going to be sent twice.

Mail Server Host Name

Gmail smtp.gmail.com

Yahoo mail (USA) plus.smtp.mail.yahoo.com

Yahoo mail (JAPAN) smtp.mail.yahoo.co.jp

Condition
(No.1, 2)

E-mail
(No.1)

E-mail
(No.2)

Satisfied

Not satisfied

Sending

SendingWaiting

Condition
(No.1)

E-mail
(No.1)

E-mail
(No.2)

Satisfied

Not satisfied

Condition
(No.2)

Satisfied

Not satisfied

Sending

SendingWaiting

Condition
(No.1)

E-mail
(No.1)

Satisfied

Not satisfied

Sending
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4.6 Operating E-mail function and checking sending status

● Operating E-mail function
Enables to cancel or pause the e-mail sending by the HMI Special Internal Relay.

■ LSM55: Cancelling the e-mail sending
When a value of this bit changes from 0 to 1, the MICRO/I cancels sending of all the e-mails in "Waiting" status. If 
sending an e-mail is in progress, the send process will be cancelled after such e-mail has been sent.

■ LSM56: Pausing the e-mail sending
While a value of this bit is 1, the MICRO/I pauses sending of all the e-mails in "Waiting" status. If sending an e-mail is 
in progress, the send process will be paused after such e-mail has been sent.

● Checking the e-mail sending state
You can check the e-mail sending state through the values of the HMI Special Data Register.

■ LSD221: Number of e-mail in "Waiting" status
The number of e-mail that are waiting to be sent is stored.

■ LSD222: Result of e-mail sending
The sending result of the e-mail last sent is stored.

■ LSD223: E-mail Number which has been sent
The e-mail number which has been sent is stored. Only the latest e-mail number is stored.

Parameter Cause

0: Successfully Completed -

1: Parameter error

• The value of the device address allocated to the following setting is 0
- IP address of the Outgoing mail server (SMTP) 
- Sender E-mail Address
- Sender Name 
- Account Name and Password (When the Required authentication (LOGIN) 

to send E-mail check box is selected)
• The preferred DNS server and alternate DNS server settings remain the 

default settings.

2: Timeout error

• An Ethernet cable is disconnected.
• Host Name of the Outgoing mail server (SMTP) is incorrect.
• IP address of the Outgoing mail server (SMTP) is incorrect.
• Port number of the Outgoing mail server (SMTP) is incorrect.
• A connection cannot be made to the preferred DNS server and alternate DNS 

server.

3: Authentication error • The authenticating account name is incorrect.
• The authenticating account password is incorrect.

4: None of the above The connection is disconnected from the outgoing mail server (SMTP).

After the value of the device address specified in the Report when E-mail has been sent on the E-mail 
Settings dialog box changes to 1, the result of the e-mail sending is stored in LSD222. 

Even when an error occurs during sending, the MICRO/I handles the send process is completed and the e-
mail number is stored in LSD223.
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4.7 Restrictions of each E-mail

■ Number of destination addresses
The total number of To, Cc and Bcc data  is 100 maximum.

■ Data size*1

■ Attachment
The maximum number of attachments is 23 total for Screenshot, Alarm Log files, Data Log files, and Operation Log 
files.
However, the number of files that can be attached varies based on the file.

*1 Data size before encoding by Base64

• When an E-mail Group is set, the number of e-mail addresses in the E-mail Group is counted.
• If the same e-mail address is used in multiple destination, the number of destination addresses will be 

counted for each destination.

Subject: 256 bytes

Body: 4,096 bytes

Screenshot: 1 max.

Alarm Log file: 1 max.

Data Log file: 20 max.

Operation Log file: 1 max.

• If a period of time or the maximum number of items are not set in the Attach Files dialog box, the entire 
history data stored in the internal memory will be attached.

• The attachment size limit varies based on the mail server. For details, contact the administrator of the 
mail server that is used.
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4.8 E-mail Function Configuration Procedure

This section describes the configuration procedure for the outgoing mail server (SMTP) and the e-mail.

● Outgoing Mail Server (SMTP) Settings

1 On the Configuration tab, in the System Setup group, click Project.

The Project Settings dialog box is displayed.

2 Configure the items on the E-mail tab.

■ General Setting

Outgoing mail server (SMTP): Selects the Outgoing mail server (SMTP) setting method.

Host Name: Specifies the Host Name of the outgoing mail server 
(SMTP).
The maximum number is 40 characters. Only 
alphanumeric characters and symbols can be used.

IP Address: Specifies the IP address of the outgoing mail server 
(SMTP).
The format is “xxx.xxx.xxx.xxx”. “xxx” stands for a 
numeric value from 0 to 255.

Outgoing mail server (SMTP) port number: Specifies the port number for the outgoing mail server (SMTP) (0 to 
65535).

Sender E-mail Address: Enter an e-mail address of the sender. The maximum number is 40 
characters. Only alphanumeric characters and symbols can be used.

Sender Name: Enter a name of the sender. The maximum number is 40 characters. 
Only alphanumeric characters and symbols can be used.

Use secure connection (SSL): Select this check box to use SSL communications with the outgoing mail 
server.
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■ Authentication Setting
When the outgoing mail server (SMTP) is protected by the account authentication, enter the account information. For 
details, refer to Chapter 4 “Authentication Setting” on page 4-69.

■ Advanced Setting
Specifies the General Setting and the Authentication Setting by the values of the device addresses. The settings 
for both the General Setting and the Authentication Setting can be used as initial values. For details, refer to 
Chapter 4 “Advanced Setting” on page 4-69.

3 Click OK.

This concludes configuring the outgoing mail server (SMTP).
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● Configuring the E-mail

1 On the Configuration tab, in the System Setup group, click E-mail.

The E-mail Settings dialog box is displayed.

2 Select the number to use the E-mail function in (Settings).

The settings for the selected number are displayed in to the right of the list. 

3 Selects the language to use with the Subject and the (Body) under the E-mail content as the Character Set from 
the following.

ASCII, Japanese(Shift-JIS), Chinese(GB2312), European(ISO 8859-1)

4 Select the condition to send an e-mail in Trigger Type under Trigger Condition from the following.

■ Rising-edge
An e-mail is sent when the value of device address changes from 0 to 1.
Specify the bit device or the bit number of the word device as the condition.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.

■ Falling-edge
An e-mail is sent when the value of device address changes from 1 to 0.
Specify the bit device or the bit number of the word device as the condition.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.

(Settings)

(Body)

Japanese(Shift-JIS), Chinese(GB2312), and European(ISO 8859-1) are encoded by Base64.
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■ Satisfy the condition
An e-mail is sent when the condition changes from not satisfied to satisfied.
Specify the conditional expression in Condition and select the data type handled by the conditional expression in 
Data Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expressions configuration 
procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-71.
For details on data types, refer to Chapter 2 “1.1 Available Data” on page 2-1.

5 Click To under the E-mail content.

The E-mail Address Book dialog box is displayed.

6 Configures an e-mail address. Click (New E-mail Address).

The E-mail Address dialog box is displayed.

If you will not configure an e-mail address, proceed to step 11.

7 Enter an e-mail address in the E-mail Address. 

The maximum number is 60 characters. Only alphanumeric characters and symbols can be used.
Select the Use Reference Device Address check box to specify the e-mail address with the value of the device 
address, and then specifies the word device to use it. The e-mail addresses are sequentially configured starting from 
the specified device address. You can only specify an internal device.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.

8 Enter a comment for the e-mail address in the Comment.

The maximum number is 80 characters.

9 Click OK to close the E-mail Address dialog box.

The created e-mail address is added to the (E-mail Address List) on the E-mail Address Book dialog box.

10 Repeat steps 6 through 9 to register the necessary e-mail addresses.

(E-mail Address List)

You can register multiple e-mail addresses as an E-mail Group which can be used as a contact. For details, 
refer to “Creating an E-mail Group” on page 28-49.
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11 Select the e-mail address or the E-mail Group as the destination, and then click >> under the To.

Set Cc and Bcc in the same procedure with To as necessary.

12 Click OK to close the E-mail Address Book dialog box.

You are returned to the E-mail Settings dialog box.

13 Enter Subject.

14 Enter (Body).

15 Repeat steps 2 through 14 to configure the necessary e-mails.

• To attach the screenshots, the Alarm Log files, the Data Log files and the Operation Log files to an e-mail, configure 
them in the Attach Files dialog box displayed by clicking Attach Files. For details, refer to “Attach Files Dialog Box” 
on page 28-62.

• To insert the value of the device address in the body text of the e-mail, configure it in the Insert Value of Device 
Address dialog box displayed by clicking Insert Value of Device Address. For details, refer to “Insert Value of 
Device Address Dialog Box” on page 28-64.

16 Click OK to close the E-mail Settings dialog box.

This concludes configuring the e-mail.

To select multiple e-mail addresses or E-mail Groups, press and hold SHIFT or CTRL while you click the 
specific items.
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● Creating an E-mail Group
You can register multiple e-mail addresses together into one contact as an E-mail Group.

1 On the Configuration tab, in the Manager group, click E-mail Address Book.

The E-mail Address Book dialog box is displayed.

2 click the arrow to the right of (New E-mail Address), then click New E-mail Group.

The New E-mail Group dialog box is displayed.

3 Enter the name for the E-mail Group in the Group Name.

The maximum number is 60 characters. Only alphanumeric characters and symbols can be used.

4 Enter the comment for the E-mail Group in the Comment.

The maximum number is 80 characters.

5 Select the e-mail address as the member from the E-mail address list, and then click >>.

To select multiple e-mail addresses, press and hold SHIFT or CTRL while you click the specific items.
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6 Click OK to close the E-mail Group dialog box.

The created E-mail Group is added to the (E-mail Address List) on the E-mail Address Book dialog box.

7 Repeat steps 2 through 6 to create the necessary E-mail Groups.

8 Click OK to close the E-mail Address Book dialog box.
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● How to use the E-mail Address Book in another project
To use the e-mail addresses and the comments registered to the E-mail Address Book in another project, save the 
settings of the E-mail Address Book as a file, and then import it to a project. Note, the E-mail Groups and the device 
addresses to specify the e-mail address are not supported.

Save the E-mail Address Book settings as a file

1 On the Configuration tab, in the Manager group, click E-mail Address Book.

The E-mail Address Book dialog box is displayed.

2 Click (Export).

The Save As dialog box is displayed.

3 Select the save location, enter a File name, and then click Save.
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Importing the E-mail Address Book settings

1 On the Configuration tab, in the Manager group, click E-mail Address Book.

The E-mail Address Book dialog box is displayed.

2 Click (Import).

The Open dialog box is displayed.

3 Select a file for the E-mail Address Book, and then click Open.

The e-mail addresses are added to the E-mail Address Book dialog box.
The e-mail address is overwritten when there is the same one.

• When the e-mail address exceeds 60 characters, it is not imported.
• When the comment exceeds 80 characters, it is not imported and only the e-mail address is imported.
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● Creating an E-mail Address Book file with a Text Editor
You can edit the E-mail Address Book files using Notepad, Microsoft Excel, commercially available text editors, or 
spreadsheet software.

1 Defines the E-mail Address settings in the following formats.

2 Saves the file with a new name.

The save options are as follows.

Notepad Microsoft Excel

E-mail Address Comment

Tab Line Feed

E-mail Address Comment

• The maximum number for the e-mail address is 60 characters.
• The maximum number for the comment is 80 characters.

Notepad: Save as type: Text Documents (*.txt)

Encoding: Unicode

Microsoft Excel: Save as type: Unicode Text (*.txt)

The format of the text file (.txt) that can be imported by the E-mail Address Book is UTF-16 (Little Endian 
with BOM).

Saving the file in the above-mentioned setting by using a Notepad or Microsoft Excel saves the file in the 
format of UTF-16 (Little Endian with BOM).



4 E-mail Function

28-54 WindO/I-NV4 User’s Manual

4.9 E-mail Settings Dialog Box

This section describes items and buttons on the E-mail Settings dialog box.

● E-mail Settings Dialog Box
The e-mail sent from MICRO/I and its trigger conditions are collectively managed in the E-mail Setting dialog box.

■ (Copy)
Select a number and click this button to copy the contents of that row to the clipboard.

■ (Paste)
Select a number and click this button to paste the contents of the clipboard to that row.

■ (Delete)
Select a number and click this button to delete the contents of that row.

■ (Settings)
Displays a list of the E-mail settings.

■ Number
Displays the number of the e-mail selected from (Settings).

(Settings)

(Body)

No.: Displays the number of the E-mail.

E-mail Function: Displays whether or not the e-mail function is used.

Subject: Displays the subject of the e-mail.

Trigger Type: Displays the trigger type for sending an e-mail.

Trigger Condition: Displays the trigger condition of trigger type for sending an e-mail. The displayed content varies 
based on Trigger Type.

Rising-edge, Falling-edge: Displays the bit device or the bit number of the word device to 
serve as condition.

Satisfy the condition: Displays the conditional expression.
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■ E-mail Function
Selects whether or not to use the e-mail function.

Example: The Number of the e-mail is 1, Rising-edge is selected as Trigger Type in Trigger Condition and 
LM100 is set to Device Address, LM101 is set to (Report Device Address).
When the value of the device address LM100 set as the trigger condition changes to 1, the e-mail number 1 
is in "Waiting" status. The value of the Report Device Address LM101 changes to 0 when the send process 
starts, and the value of the Report Device Address LM101 changes to 1 when the send process completes.

Enable: Sends an e-mail when the trigger condition is satisfied.

Disable: E-mail is not sent.

Report when E-mail has been sent: Select this check box to report when the e-mail has been sent.

(Report Device Address): Specifies the bit device or the bit number of the word 
device for reporting when the e-mail has been sent.

Click  to display the Tag Editor. For the device 
address configuration procedure, refer to Chapter 2 
“5.1 Device Address Settings” on page 2-68.

Trigger Condition is satisfied

Value of Device Address LM100 
when Trigger Condition is Rising-edge

1

0

Value of Report Device Address
LM101

1

0

E-mails cannot be sent E-mails can be sent

Waiting for sending

Waiting for sending error check
Waiting for sending/sending completion

E-mail
(No.1)

Sending
Sending

completion
Sending

start

Even when an error occurs during sending, the system regards the sending is completed, and the value of 
the Report Device Address changes to 1.

Character Set: Selects the language to use with the Subject and the (Body) under the E-mail content from the 
following.
ASCII, Japanese(Shift-JIS), Chinese(GB2312), European(ISO 8859-1)

Japanese(Shift-JIS), Chinese(GB2312), and European(ISO 8859-1) are encoded by Base64.
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■ Trigger Condition
Set the trigger conditions for sending e-mail.

Trigger Type: A condition for sending e-mail is selected from the following.
Rising-edge: An e-mail is sent when the value of device address changes from 0 to 1.

Falling-edge: An e-mail is sent when the value of device address changes from 1 to 0.

Satisfy the condition:
An e-mail is sent when the condition changes from not satisfied to satisfied.

Data Type: Select the data type handled by the conditional expression.
Can only be set if Satisfy the condition is selected as Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Device Address: Specifies the bit device or the bit number of the word device to serve as condition. You can only 
specify the internal device.

Can only be set if Rising-edge or Falling-edge is selected as Trigger Type. Click  to display 
the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.

Condition: Sets the condition formula.

Can only be set if Satisfy the condition is selected as Trigger Type. Click  to display the 
Trigger Condition Settings dialog box. For the conditional expressions configuration procedure, refer 
to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-71.

Value of Device Address
1

0

Action Execution Execution Execution

1

0

Value of Device Address

Action Execution Execution

Action Execution

Condition
Satisfied

Not satisfied

Execution Execution
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■ E-mail content
Specify the e-mail sending destination, and enter the title and the message.

To: Specify the original sending destination of the e-mail. Click this button to 
display the E-mail Address Book dialog box. For details, refer to “E-mail Address 
Book Dialog Box” on page 28-58.

(E-mail address for To): Displays the e-mail addresses and the E-mail Groups 
assigned to the To in the E-mail Address Book dialog box. 
When multiple e-mail addresses and E-mail Groups are 
allocated, they are separated by semicolons (;).

Cc: Specify the sending destination to which the duplication needs to be sent 
other than the original sending destination specified by To. Click this button 
to display the E-mail Address Book dialog box. For details, refer to “E-mail Address 
Book Dialog Box” on page 28-58.

(E-mail address for Cc): Displays the e-mail addresses and the E-mail Groups 
assigned to the Cc in the E-mail Address Book dialog box. 
When multiple e-mail addresses and E-mail Groups are 
allocated, they are separated by semicolons (;).

Bcc: Specify the sending destination which is not to be known by the destinations 
specified as To and Cc. Click this button to display the E-mail Address Book dialog 
box. For details, refer to “E-mail Address Book Dialog Box” on page 28-58.

(E-mail address for Bcc): Displays the e-mail addresses and the E-mail Groups 
assigned to the Bcc in the E-mail Address Book dialog 
box. When multiple e-mail addresses and E-mail Groups 
are allocated, they are separated by semicolons (;).

Subject: Enter a subject of an e-mail. The maximum size is 256 bytes.

(Body): Enter a body text of an e-mail. The maximum size is 4,096 bytes.

Attach Files: Attach files to an e-mail. Click this button to display the Attach Files dialog box. For 
details, refer to “Attach Files Dialog Box” on page 28-62.

Insert Value of Device Address: Insert a device address in the body text of an e-mail. Click this button to display the 
Insert Value of Device Address dialog box. For details, refer to “Insert Value of 
Device Address Dialog Box” on page 28-64.
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● E-mail Address Book Dialog Box
The e-mail addresses used by the E-mail function are collectively managed in the E-mail Address Book dialog box.

■ (New E-mail Address)
Adds an e-mail address or an E-mail Group.
Click this button to display the E-mail Address dialog box. For details, refer to “E-mail Address Dialog Box” on page 
28-60.
To create an E-mail Group, click the arrow to the right of this button and then click New E-mail Group.

■ (Edit)
Changes the selected e-mail address or E-mail Group.
Select an e-mail address in People, and then click this button to display the E-mail Address dialog box. For details, 
refer to “E-mail Address Dialog Box” on page 28-60. 
Select an E-mail Group in People, and then click this button to display the E-mail Group dialog box. For details, refer 
to “E-mail Group Dialog Box” on page 28-61.

■ (Delete)
Deletes the selected e-mail address and E-mail Group in People.

■ (Import)
Imports the file in the E-mail Address Book saved by the Unicode text format (*.txt). Click this button to display the 
Open dialog box. For details, refer to “Importing the E-mail Address Book settings” on page 28-52.

■ (Export)
Export and saves the E-mail Address Book settings as an Unicode Text (*.txt) file.
Click this button to display the Save As dialog box. For details, refer to “Save the E-mail Address Book settings as a 
file” on page 28-51.

The saved E-mail Address Book file can be imported with (Import).

■ Find
The entered text is searched for in the People in the (People List).

(People List) (Destination Address)
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■ (People List)
The registered e-mail addresses are displayed in a list.

■ (Destination Address)*1

Configures a destination address for an e-mail.

*1 Destination Address is only displayed when this dialog box is opened from E-mail Setting dialog box

People: Displays the registered e-mail addresses and E-mail Groups.
Double clicking the cell of the e-mail address displays the E-mail Address dialog box. For details, 
refer to “E-mail Address Dialog Box” on page 28-60.
Double clicking the cell of the E-mail Group displays the E-mail Group dialog box. For details, refer 
to “E-mail Group Dialog Box” on page 28-61.

To select multiple e-mail addresses and E-mail Groups, press and hold SHIFT or CTRL while you click the 
specific items.

Comment: Displays the comment for the e-mail address or E-mail Group.
Double clicking the cell of the e-mail address displays the E-mail Address dialog box. For details, 
refer to “E-mail Address Dialog Box” on page 28-60.
Double clicking the cell of the E-mail Group displays the E-mail Group dialog box. For details, refer 
to “E-mail Group Dialog Box” on page 28-61.

>>: Assigns e-mail address and the E-mail Group displayed in the (People List) to the To, the Cc or the Bcc.

<<: Deletes the e-mail addresses and the E-mail Groups assigned to the To, the Cc or the Bcc.

To: Displays the e-mail addresses and the E-mail Groups assigned to the To. Specify the original sending 
destination of the e-mail.

Cc: Displays e-mail addresses and the E-mail Groups assigned to the Cc. Specify the sending destination to 
which the duplication needs to be sent other than the original sending destination specified by To.

Bcc: Displays e-mail addresses and the E-mail Groups assigned to the Bcc. Specify the sending destination 
which is not to be known by the destinations specified as To and Cc. The sending destination 
specified as Bcc is not displayed to the destinations set as To and Cc.
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E-mail Address Dialog Box

Registers an e-mail address or edits an existing e-mail address.

■ E-mail Address
Enter a destination e-mail address. The maximum number is 60 characters. Only alphanumeric characters and 
symbols can be used.

■ Comment
Enter a comment for the e-mail address. The maximum number is 80 characters.

Use Reference Device Address: Select this check box to specify the e-mail address with the value of the device 
address.

Top Device Address: Specifies a word device to use an e-mail address. The e-mail address is set by 
reading the values sequentially from the starting device address specified with the 
Top Device Address and handling those values as character data up to the 
character before NULL (0x00). The maximum number of device addresses is 30 
(maximum of 60 characters). You can only specify an internal device.

Click  to display the Tag Editor. For the device address configuration procedure, 
refer to Chapter 2 “5.1 Device Address Settings” on page 2-68.
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E-mail Group Dialog Box

Creates an E-mail Group or edits an existing E-mail Group.

■ Group Name
Enter a name of the E-mail Group. The maximum number is 60 characters. Only alphanumeric characters and 
symbols can be used.

■ Comment
Enter a comment for the E-mail Group. The maximum number is 80 characters.

■ E-mail address list

■ >>
Assigns the e-mail address displayed in the E-mail address list to the Members.

■ <<
Deletes the e-mail addresses assigned to the Members.

■ Members

Find: The text entered is searched for People in the E-mail address list.

People: The e-mail addresses registered in the E-mail Address Book dialog box are displayed in this list.

To select multiple e-mail addresses, press and hold SHIFT or CTRL while you click the specific items.

Comment: Displays the comment for the e-mail address.

Find: The text entered is searched for People in the Members.

People: The e-mail addresses assigned to a member of E-mail Group are displayed in this list.

To select multiple e-mail addresses, press and hold SHIFT or CTRL while you click the specific items.

Comment: Displays the comment for the e-mail address.



4 E-mail Function

28-62 WindO/I-NV4 User’s Manual

● Attach Files Dialog Box
Files attached to an e-mail is configured in the Attach Files dialog box.

■ Screenshot
Select this check box to attach a screenshot of the current screen to an e-mail.
The file format is JPEG and the file name becomes "Image.JPG".

■ Alarm Log Files
Select this check box to attach a specified alarm log data to an e-mail.
The file format is CSV and the file name becomes "ALMLOG.CSV".
Specifies the output format and the range of the alarm log data.

Output Format: Specifies the items of the alarm log data attached to an e-mail.

Output Channel Number, Message, Occurrence Time, Recovery Time and Confirmaton Time:

The output data is the same format as the Alarm Log function batch outputs to the 
external memory device. For details, refer to Chapter 13 “Batch” on page 13-39.

Output Channel Number, Message, State and Time:

The output data is the same format as the Alarm Log function outputs to the external 
memory device in real time. For details, refer to Chapter 13 “Real Time” on page 13-40.

Range of Blocks: Specifies the range of block numbers that will output in the collected alarm log data.

All: Outputs the data for all blocks.

Specify block number: Outputs only the data for the specified blocks.
Individual block numbers can be specified by separating the num-
bers with “,”, continuous regions can be specified with “-”.

Example: When the number of blocks is 6, enter the following.

To specify blocks 1 to 3: 1-3

To specify blocks 1, 3, 6: 1, 3, 6

To specify blocks 1, 4 to 6: 1, 4-6

Specify a period of time: Select this check box to specify the period of alarm log output data. Outputs the specified 
period of the alarm log data after the Trigger Condition is satisfied.

Specify the maximum number of items:

Select this check box to specify the maximum amount of alarm log output data. Outputs the 
specified number of the alarm log data after the Trigger Condition is satisfied.

When the Specify a period of time check box and the Specify the maximum number of items check 
box are selected, the output range is until either is satisfied.
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■ Data Log Files
Select this check box to attach a specified data log data to an e-mail.
The file format is CSV and the file name becomes "DATALOG**.CSV (**: Channel Number)".
Specifies the range of the data log data.

■ Operation Log Files
Select this check box to attach a specified operation log data to an e-mail.
The file format is CSV and the file name becomes "OPLOG.CSV".
Specifies the range of the operation log data.

Channel Number: Specifies the range of channel numbers that will output in the collected data 
log data.
Individual channel numbers can be specified by separating the numbers 
with “,”, continuous regions can be specified with “-”.

Example: When the channel number is 1 to 6, enter the following.

To specify channel numbers 1 to 3: 1-3

To specify channel numbers 1, 3, 6: 1, 3, 6

To specify channel numbers 1, 4 to 6: 1, 4-6

Specify a period of time: Select this check box to specify the period of data log output data. Outputs 
the specified period of the data log data after the Trigger Condition is 
satisfied.

Specify the maximum number of items: Select this check box to specify the maximum amount of data log output 
data. Outputs the specified number of the data log data after the Trigger 
Condition is satisfied.

When the Specify a period of time check box and the Specify the maximum number of items check 
box are selected, the output range is until either is satisfied.

Specify a period of time: Select this check box to specify the period of operation log output data. 
Outputs the specified period of the operation log data after the Trigger 
Condition is satisfied.

Specify the maximum number of items: Select this check box to specify the maximum amount of operation log 
output data. Outputs the specified number of the operation log data after 
the Trigger Condition is satisfied.

When the Specify a period of time check box and the Specify the maximum number of items check 
box are selected, the output range is until either is satisfied.
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● Insert Value of Device Address Dialog Box
To enter a value of device address in the body text of the e-mail, configures the settings om the Insert Value of Device 
Address dialog box.

■ Reference Device Address
Specify the source word device.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.

■ Display Type
Selects the display type of the value from the following.
Decimal, Hexadecimal, Character

■ Data Format

Data Type: Selects the type of data for the value.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.
This setting can only be configured when Decimal or Hexadecimal is selected for 
Display Type.

Digits: Specifies the digits to display. The range of digits that can be set varies based on the 
display type and data type. The digits that can be set are as follows.

Display Type Data Type Digits

Decimal display

UBIN16(W), BIN16(I) 1 to 5

UBIN32(D), BIN32(L) 1 to 10

BCD4(B) 1 to 4

BCD8(EB) 1 to 8

Float32(F) 1 to 10

Hexadecimal display
UBIN16(W) 1 to 4

UBIN32(D) 1 to 8

Display Floating Point: Select this check box to display the decimal point.
This setting can only be configured when Decimal is selected for Display Type.

When the Display Floating Point check box is selected and UBIN16(W), BIN16(I), UBIN32(D), 
BIN32(L), BCD4(B), or BCD8(EB) is selected for Data Type, the source device is an integer, but the 
value is displayed with the decimal point added at the configured floating digits.
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■ Words
Specify the number of source word devices (1 to 64).
This setting can only be configured when Character is selected for Display Type.

Floating Digits: Specifies the number of digits for the fractional part of the decimal value out of the 
number of digits specified by Digits.
This option can only be configured when the Display Floating Point check box is selected. 
The range of digits that can be set for the fractional part varies based on the display type and 
data type. The range of digits that can be set is as follows.

Display Type Data Type Floating Digits

Decimal display

UBIN16(W), BIN16(I) 1 to Digits

UBIN32(D), BIN32(L) 1 to Digits

BCD4(B) 1 to Digits

BCD8(EB) 1 to Digits

Float32(F) 1 to Digits or 8

Hexadecimal display
UBIN16(W) --

UBIN32(D) --
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This chapter describes the project transfer function to upload and download project data to the MICRO/I, to upload 
and download PLC program to a PLC connected to the MICRO/I using an external memory device, as well as the 
function to copy files between an SD memory card and a USB flash drive.
These three functions for exchanging data using an external memory device are collectively called data transfer 
functions.

  

1.1 What Can Be Done with the Project Transfer Function

The project transfer function uploads or downloads project (ZNV Project File) between the MICRO/I and an external 
memory device inserted in the MICRO/I.

● Downloading the project (ZNV Project File)
Create a project (ZNV Project File) for project transfer and save it on an external memory device*1. And then, 
download the ZNV Project File saved on the external memory device to the MICRO/I.

● Uploading a project
Uploads the project used to operate the MICRO/I and saves it to an external memory device*1.

*1 Only USB flash drive for HG2G-5T and HG1G/1P

Chapter 29 Data Transfer Function

1 Project Transfer Function

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

The Project Transfer function supports the project which name is used alphanumeric characters only.

Create Project
for Transfer Download

MICRO/IComputer

ZNV Project File
(.znv)

ZNV Project File
(.znv)

USB flash drive

SD memory card

External Memory Device

Upload

MICRO/I

ZNV Project File
(.znv)

USB flash drive

SD memory card

External Memory Device

When using the project transfer function and a project is uploaded, the project name is “project name + file 
extension (.znv)”.
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1.2 Project Transfer Procedures

The following methods can be used to upload or download project between the MICRO/I and an external memory 
device inserted in the MICRO/I.

• Using the USB Autorun function
 For details, refer to Chapter 31 “2 USB Autorun Function” on page 31-22.

• Using Key Buttons, Multi-Buttons, or Multi-Commands
 For details, refer to “1.4 Using Key Buttons, Multi-Buttons, or Multi-Commands to Transfer Project Data” on 

page 29-6.

• Using the File Manager in the System Mode on the MICRO/I*1

 For details, refer to “1.5 Using File Manager on the MICRO/I to Transfer Project Data” on page 29-7.

*1 HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F only
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1.3 Converting Project for Transfer

Project must be converted to dedicated data for transfer in order to download project to the MICRO/I using the 
project transfer function.

Use the following procedure to create project data for transfer using an external memory device*1.

1 Insert an external memory device*1 in the computer.
When using an SD memory card, insert it into the computer's memory card slot or via a memory card reader/writer.
When using a USB flash drive, insert the USB flash drive in the computer’s USB port.

2 Open the project to transfer using WindO/I-NV4.

3 On the Home tab, in the Project group, click the Download icon.
The Download dialog box is displayed.

*1 Only USB flash drive for HG2G-5T and HG1G/1P

The Project Transfer function supports the project which name is used alphanumeric characters only.

Computer

Through an external 
memory card reader/writer

SD memory card

USB flash drive

SD memory card

To USB port

To SD memory card slot

To use the Project Transfer function, select the project which name is used alphanumeric characters only.

When the project has not been saved after it was opened, a save confirmation message is displayed.
Click the OK button to save the project and display the Download dialog box.
Click on the Cancel button to return to the editing screen without saving the project.
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4 Check that Communication Settings is External Memory Device, and then click the Download button.
The Select Drive dialog box is displayed.

5 Specify the drive for the external memory device and click the OK button.

A confirmation message is displayed.

■ Drive
Specify the drive of the computer assigned to the external memory device.

■ Network
Displays the Network Drive Assignment dialog box. You can specify a drive on the network.

■ External Memory Device Folder
Specify the folder where the project data is to be downloaded.

Click the  button to display the Project Settings dialog box. You can specify an External Memory Device folder as 
the download destination.

6 Click the Yes button.

A Download dialog box is displayed and the project data is now being saved.
When this process is complete, a message is displayed.

1. If Communication Settings is not External Memory Device, click the Change button.
The Communication Settings dialog box is displayed.

2. Select External Memory Device for Communicate with, and then click the OK button.
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7 Click the OK button.

8 Click the Close button in the Download dialog box.

The project data for transfer is created in the External Memory Device folder on an external memory device.

For details about the created data folder and file structure, refer to Chapter 31 “External Memory Devices” 
on page 31-1.

If the folder or file structure on the External Memory Device folder is modified, the MICRO/I and 
WindO/I-NV4 will not be usable.
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1.4 Using Key Buttons, Multi-Buttons, or Multi-Commands to Transfer Project Data

● Download

1 Create a project (ZNV Project File) for project transfer and save it on an external memory device*1.

For details, refer to “1.3 Converting Project for Transfer” on page 29-3.

2 Insert an external memory device*1 in the MICRO/I.

3 Press the Key Button or Multi-Button or execute the Multi-Command configured with Download Project under Data 
Transfer on the Key Browser dialog box.

● Upload

1 Insert an external memory device*1 in the MICRO/I.

2 Press the Key Button or Multi-Button or execute the Multi-Command configured with Upload Project under Data 
Transfer on the Key Browser dialog box.

*1 Only USB flash drive for HG2G-5T and HG1G/1P

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

Allocate a Key Button, Multi-Button, or Multi-Command configured with the project transfer function to the 
MICRO/I.
 For details, refer to Chapter 8 “5 Key Button” on page 8-72.
 For details, refer to Chapter 8 “6 Multi-Button” on page 8-108.
 For details, refer to Chapter 12 “6 Multi-Command” on page 12-38.

MICRO/I

USB flash drive

SD memory card

External Memory Device

MICRO/I

USB flash drive

SD memory card

External Memory Device
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1.5 Using File Manager on the MICRO/I to Transfer Project Data

● Download

1 Create a project (ZNV Project File) for project transfer and save it on an external memory device.

For details, refer to “1.3 Converting Project for Transfer” on page 29-3.

2 Insert an external memory device in the MICRO/I.

3 Press the upper-left edge of the MICRO/I screen for three seconds or more.

The maintenance screen is now displayed.

4 Press System Mode.

MICRO/I displays the Top Page in the System Mode.

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

HG3G HG2G-5FHG4G

HG5G-V HG4G-V HG3G-V HG2G-V

MICRO/I

USB flash drive

SD memory card

External Memory Device

Press and hold 
3 or more seconds

HG3G HG2G-5FHG4G

HG5G-V HG4G-V HG3G-V HG2G-V

MICRO/I

Maintenance

System Mode

Device Monitor

Adjust Brightness

When downloading a project configured with security to the MICRO/I, the password screen is displayed. 
Select a user name and enter its password. For details, refer to Chapter 23 “User Accounts and the Security 
Function” on page 23-1.
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5 Press Main Menu.

The main menu is displayed.

6 Press File Manager.

The file manager is displayed.

7 Press DRIVE: for the transfer source and select the external memory device inserted in the MICRO/I.

This example screen shows when an SD memory card is selected.

Run Offline Main Menu

<< >>BRIGHTNESS 31

MAC Address  00:03:7B:F0:12:A8
IP Address 192.168.0.1(DHCP)
2010/OCT/14/THU   14:56:44

IDEC HG G SERIES
SYSTEM MODE TOP PAGE

ENG/JPN

Main
Menu ------ ---

Offline Run

Initial
Setting

Clock
Setting

Top Page
Self

Diagnosis

System
Information

File
Manager

2010/OCT/14/THU  14:57:17

Main
Menu ---

File
Manager ---

▲ DEL▼ ▲

▲

RELOAD ENT COPY

DIRECTION▲

FILTER

ALL
FILTERS

DRIVE:
SD  card

FORMAT DRIVE:
MICRO/I

FORMAT

HGDATA00 <DIR>
HGDATA01 <DIR>
HGDATA02 <DIR>

MICROI.ZNV
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8 Select the ZNV Project File to download.

This example screen shows when the ZNV Project File is “HG3G_DEMO_1.ZNV” that has been saved in the External 
Memory Device folder “HGDATA01”.

1. Press ▼ to select HGDATA01 and then press ENT.

2. Press ▼ to select NVDATA and then press ENT.

3. Press ▼ to select HG3G_DEMO_1.ZNV.

Main
Menu ---

File
Manager ---

▲ DEL▼ ▲

▲

RELOAD ENT COPY

DIRECTION▲

FILTER

ALL
FILTERS

DRIVE:
SD  card

FORMAT DRIVE:
MICRO/I

FORMAT

HGDATA00 <DIR>
HGDATA01 <DIR>
HGDATA02 <DIR>

MICROI.ZNV

1 2

Main
Menu ---

File
Manager ---

▲ DEL▼ ▲

▲

RELOAD ENT COPY

DIRECTION▲

FILTER

ALL
FILTERS

DRIVE:
SD  card

FORMAT DRIVE:
MICRO/I

FORMAT

. <DIR>

.. <DIR>
NVDATA <DIR>
PICTURE <DIR>
SOUND <DIR>
 

MICROI.ZNV

1 2

The NVDATA folder is automatically created when the External Memory Device folder is created. For 
details, refer to Chapter 31 “1.4 File structure” on page 31-3.

Main
Menu ---

File
Manager ---

▲ DEL▼ ▲

▲

RELOAD ENT COPY

DIRECTION▲

FILTER

ALL
FILTERS

DRIVE:
SD  card

FORMAT DRIVE:
MICRO/I

FORMAT

. <DIR>

.. <DIR>
HG3G_DEMO_1.ZNV 

MICROI.ZNV
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9 Press DRIVE: for the transfer destination and select MICRO/I.

10 Press COPY.
A process confirmation message is displayed.

11 Press YES.
ZNV Project File(.znv) download starts.
When the download finishes, the results are displayed.

Main
Menu ---

File
Manager ---

▲ DEL▼ ▲

▲

RELOAD ENT COPY

DIRECTION▲

FILTER

ALL
FILTERS

DRIVE:
SD  card

FORMAT DRIVE:
MICRO/I

FORMAT

. <DIR>

.. <DIR>
HG3G_DEMO_1.ZNV 

MICROI.ZNV

When MICRO/I is selected with DRIVE: in the file manager, MICROI.ZNV is always displayed. This is not 
the project name downloaded to the MICRO/I.

Main
Menu ---

File
Manager ---

▲ DEL▼ ▲

▲

RELOAD ENT COPY

DIRECTION▲

FILTER

ALL
FILTERS

DRIVE:
SD  card

FORMAT DRIVE:
MICRO/I

FORMAT

. <DIR>

.. <DIR>
HG3G_DEMO_1.ZNV 

MICROI.ZNV

YES NO

Copy This File ?

HG3G_DEMO_1.ZNV

Clear Keep Devices

Select the Clear Keep Devices check box to clear keep devices after the project data is downloaded. 
However, when project data that changes the system software or settings of the data storage area is 
downloaded, the keep devices are always cleared.

If you download the project data, Alarm Log data, Operation Log data, and Data Log data is erased 
regardless of the Clear Keep Devices check box.
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12 Press Ack to close the results screen.
You are returned to the Top Page of System Mode.

● Upload

1 Insert the external memory device in the MICRO/I.

2 Press the upper-left edge and the upper-right edge of the MICRO/I screen simultaneously.

The maintenance screen is displayed.

3 Press System Mode.

MICRO/I displays the Top Page in the System Mode.

When the ZNV Project File to download is configured with security, the password screen is displayed. Select 
a user name and enter its password. For details, refer to Chapter 23 “User Accounts and the Security 
Function” on page 23-1.

Download MICRO/I ProjectFunction

The following function completed
Result

Ack

MICRO/I

USB flash drive

SD memory card

External Memory Device

HG3G HG2G-5FHG4G

HG5G-V HG4G-V HG3G-V HG2G-V

HG3G HG2G-5FHG4G

HG5G-V HG4G-V HG3G-V HG2G-V

Press and hold 3 
or more seconds

MICRO/I

Maintenance

System Mode

Device Monitor

Adjust Brightness

When downloading a project configured with security to the MICRO/I, the password screen is displayed. 
Select a user name and enter its password. For details, refer to Chapter 23 “User Accounts and the Security 
Function” on page 23-1.
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4 Press Main Menu.

The main menu is displayed.

5 Press File Manager.

The file manager is displayed.

6 Press DRIVE: for the transfer source and select MICRO/I.

Run Offline Main Menu

<< >>BRIGHTNESS 31

MAC Address  00:03:7B:F0:12:A8
IP Address 192.168.0.1(DHCP)
2010/OCT/14/THU   14:56:44

IDEC HG G SERIES
SYSTEM MODE TOP PAGE

ENG/JPN

Main
Menu ------ ---

Offline Run

Initial
Setting

Clock
Setting

Top Page
Self

Diagnosis

System
Information

File
Manager

2010/OCT/14/THU  14:57:17

Main
Menu ---

File
Manager ---

▲ DEL▼ ▲

▲

RELOAD ENT COPY

DIRECTION▲

FILTER

ALL
FILTERS

DRIVE:
MICRO/I

FORMAT DRIVE:
SD  card

FORMAT

MICROI.ZNV HGDATA01 <DIR>
001 <DIR>
002 <DIR>

When MICRO/I is selected with DRIVE: in the file manager, MICROI.ZNV is always displayed. This is not 
the project name downloaded to the MICRO/I.
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7 Press DRIVE: for the transfer destination and select the external memory device inserted in the MICRO/I.

This example screen shows when an SD memory card is selected.

8 Select the save destination for the project to upload.

Folder (001) is selected in this example.

1. Press  to move the cursor to the transfer destination on the SD memory card.

2. Press ▼ to select 001 and then press ENT.

Main
Menu ---

File
Manager ---

▲ DEL▼ ▲

▲

RELOAD ENT COPY

DIRECTION▲

FILTER

ALL
FILTERS

DRIVE:
MICRO/I

FORMAT DRIVE:
SD  card

FORMAT

MICROI.ZNV HGDATA01 <DIR>
001 <DIR>
002 <DIR>

▼

Main
Menu ---

File
Manager ---

▲ DEL▼ ▲

▲

RELOAD ENT COPY

DIRECTION▲

FILTER

ALL
FILTERS

DRIVE:
MICRO/I

FORMAT DRIVE:
SD  card

FORMAT

MICROI.ZNV HGDATA01 <DIR>
001 <DIR>
002 <DIR>

Main
Menu ---

File
Manager ---

▲ DEL▼ ▲

▲

RELOAD ENT COPY

DIRECTION▲

FILTER

ALL
FILTERS

DRIVE:
MICRO/I

FORMAT DRIVE:
SD  card

FORMAT

MICROI.ZNV HGDATA01 <DIR>
001 <DIR>
002 <DIR>

1 2
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9 Press COPY.

A process confirmation message is displayed.

10 Press YES.
The project upload starts.
When the upload finishes, the results are displayed.

11 Press Ack to close the results screen.
You are returned to the Top Page of System Mode.

Main
Menu ---

File
Manager ---

▲ DEL▼ ▲

▲

RELOAD ENT COPY

DIRECTION▲

FILTER

ALL
FILTERS

DRIVE:
MICRO/I

FORMAT DRIVE:
SD  card

FORMAT

. <DIR>

.. <DIR>
MICROI.ZNV

YES NO

Copy This File ?

MICROI.ZNV

MICROI.ZNV is shown on the confirmation message, but the project file name after uploading is “Project 
name + Extension (.znv)”.

Upload MICRO/I ProjectFunction

The following function completed
Result

Ack
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1.6 Precautions

• An error message is displayed if the project upload or download fails.
For details, refer to Chapter 36 “1.1 Errors Displayed on the Screen” on page 36-1.

• While the project transfer function is running, the MICRO/I stops processing other functions.

• When project data is downloaded using the project transfer function, the HMI Keep Registers and the HMI Keep 
Relays are cleared.

• If a file exists with the same name in the save destination when uploading a project, the file is overwritten with the 
uploaded file without displaying an overwrite confirmation message.

• When using the project transfer function, make the project name alphanumeric characters. Note, the file name 
must not contain the following characters:
\ / : * ? " < > |

• While running the project transfer function using a Key Button, Multi-Button, or Multi-Command, if a data transfer 
function (project transfer, PLC program transfer, or file copy) is initiated, the only function that will work is the 
currently running function. If two or more data transfer functions are configured to a Multi-Button or Multi-
Command, only the data transfer function displayed at the top of the function list on the parts property dialog box 
will run.

• When running the project transfer function, the external memory device must have enough free space equivalent 
to the size of the ZNV Project File(.znv). Check that there is sufficient free space on the external memory device 
that will be used with the project transfer function. If the device does not have sufficient free space, the project 
upload or download may fail.
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2.1 Supported PLCs

PLCs that support the PLC program transfer function are listed below.

The ports and functions supported are as follows.

*1 User program only

2 PLC Program Transfer Function

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

Manufacturer Series name
Supported system

(CPU unit)
Communication driver

IDEC

OpenNet Controller FC3A • Serial Interface:
OpenNet, MICROSmart, SmartAXIS Pro/Lite (RS232C/485)

• Ethernet Interface:
OpenNet, MICROSmart, SmartAXIS Pro/Lite (Ethernet)

MICROSmart

FC4A

FC5A

FC6A
(FC6A-C*****E/
-C*****EJ only)

• Serial Interface:
MICROSmart(FC6A)(RS232C/485)

• Ethernet Interface:
MICROSmart(FC6A)(Ethernet)

FC6A
(FC6A-D****CEE 
only)

MICROSmart(FC6A)(Ethernet)

SmartAXIS Pro/Lite FT1A OpenNet, MICROSmart, SmartAXIS Pro/Lite (Ethernet)

The corresponding device type differs depending on the communication driver which be used.
For FC6A type, please select MICROSmart (FC6A) (RS232C / 485), MICROSmart (FC6A) (Ethernet) 
driver.
If use OpenNet, MICROSmart, SmartAXIS Pro / Lite (RS232C485), OpenNet, MICROSmart, 
SmartAXIS Pro / Lite (Ethernet) driver, the device type is partially different. For details, refer to the 
WindO/I-NV4 External Device Setup Manual.

Series Name Model Serial port Download, Upload*1

OpenNet Controller FC3A
Serial port 1 YES

Serial port 2 YES

MICROSmart

FC4A
Serial port 1 YES

Serial port 2 YES

FC5A

Ethernet port YES

Serial port 1 YES

Serial port 2 YES

Serial port 3 to 7 NO

FC6A
(FC6A-C*****E/-C*****EJ only)

Ethernet port 1 YES

FC6A-PH1 (HMI-Ethernet port) YES

Serial port 1 YES

Serial port 2 to 9 NO

FC6A
(FC6A-D****CEE only)

Ethernet port 1 YES

Ethernet port 2 YES

FC6A-PH1 (HMI-Ethernet port) YES

Serial port 1 to 33 NO

SmartAXIS Pro/Lite FT1A

Ethernet port YES

Serial port 2 NO

Serial port 3 NO
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2.2 What Can Be Done using the PLC Program Transfer Function

The PLC program transfer function is used to upload or download PLC program (ZLD Project File) between a PLC 
connected to the MICRO/I and an external memory device inserted in the MICRO/I.

● Downloading a PLC program
Download a PLC program (ZLD Project File) saved on an external memory device*1 to a PLC connected to the MICRO/I.
You must create a ZLD Project File(.znv) for transfer.

● Uploading a PLC program
Upload a PLC program from the PLC connected to the MICRO/I and save the ZLD Project File(.zld) to an external 
memory device*1.

2.3 PLC Program Transfer Procedures

The following methods can be used to upload or download a PLC program between a PLC connected to the MICRO/I 
and an external memory device inserted in the MICRO/I.

• Using the USB Autorun function
 For details, refer to Chapter 31 “2 USB Autorun Function” on page 31-22.

• Using Key Buttons, Multi-Buttons, or Multi-Commands
 For details, refer to “2.5 Using Key Buttons, Multi-Buttons, or Multi-Commands to Transfer PLC Programs” on 

page 29-19.

• Using the File Manager in the System Mode on the MICRO/I*2

 For details, refer to “2.6 Using File Manager on the MICRO/I to Transfer PLC Programs” on page 29-21.

*1 Only USB flash drive for HG2G-5T and HG1G/1P
*2 HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F only

ZLD Project File
(.zld)

DownloadCreate PLC Program 
for Transfer

PLCMICRO/IComputer

ZLD Project File
(.zld)

USB flash drive

SD memory card

External Memory Device

Upload

PLCMICRO/I

Save

ZLD Project File
(.zld)

USB flash drive

SD memory card

External Memory Device

When a PLC program is uploaded using the PLC program transfer function, the file name is “Model 
name_Port number_Station number_Year month day hours minutes seconds + File extension (.zld)”. 
The port number varies based on the interface used to upload with HG2G-5T, HG1G/1P. The displayed item is 
as follows:
  SERIAL1(RS232C): C1   SERIAL1(RS422/485): C2   Ethernet: ET
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2.4 Creating ZLD Project File

Before transferring a PLC program, using the PLC Program Transfer Function, it must be converted to a ZLD Project 
File(.zld).

1 Open the PLC program to to be transferred using WindLDR.

2 Click  to the right of Save As on the application menu and click PLC Program.

The Save As dialog box is displayed.

3 Enter a file name and click Save.

▼

When using a PLC program with the PLC program transfer function, always enter the file name as 
alphanumeric characters.
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2.5 Using Key Buttons, Multi-Buttons, or Multi-Commands to Transfer PLC Programs

● Download

1 Convert a PLC program file for PLC program transfer.

For details, refer to “2.4 Creating ZLD Project File” on page 29-18.

2 Save it to an external memory device*1.

3 Insert an external memory device*1 in the MICRO/I.

4 Press the Key Button or Multi-Button or execute the Multi-Command configured with Download PLC Program 
under Data Transfer on the Key Browser dialog box.

*1 Only USB flash drive for HG2G-5T and HG1G/1P

Allocate a Key Button, Multi-Button, or Multi-Command configured with the PLC program transfer function to 
the MICRO/I.
 For details, refer to Chapter 8 “5 Key Button” on page 8-72.
 For details, refer to Chapter 8 “6 Multi-Button” on page 8-108.
 For details, refer to Chapter 12 “6 Multi-Command” on page 12-38.

Save

Computer

ZLD Project File
(.zld)

USB flash drive

SD memory card

External Memory Device

PLCMICRO/I

USB flash drive

SD memory card

External Memory Device
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● Upload

1 Insert an external memory device*1 in the MICRO/I.

2 Press the Key Button or Multi-Button or execute the Multi-Command configured with Upload PLC Program under 
Data Transfer on the Key Browser dialog box.

*1 Only USB flash drive for HG2G-5T and HG1G/1P

PLCMICRO/I

USB flash drive

SD memory card

External Memory Device
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2.6 Using File Manager on the MICRO/I to Transfer PLC Programs

● Download

1 Convert a PLC program file for PLC program transfer.

For details, refer to “2.4 Creating ZLD Project File” on page 29-18.

2 Save it to an external memory device.

3 Insert an external memory device in the MICRO/I.

4 Press the upper-left edge of the MICRO/I screen for three seconds or more.

The maintenance screen is displayed.

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

Save

Computer

ZLD Project File
(.zld)

USB flash drive

SD memory card

External Memory Device

HG3G HG2G-5FHG4G

HG5G-V HG4G-V HG3G-V HG2G-V

PLCMICRO/I

USB flash drive

SD memory card

External Memory Device

Press and hold 
3 or more seconds

HG3G HG2G-5FHG4G

HG5G-V HG4G-V HG3G-V HG2G-V

MICRO/I
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5 Press System Mode.

MICRO/I displays the Top Page in the System Mode.

6 Press Main Menu.

The main menu is displayed.

7 Press File Manager.

The file manager is displayed.

Maintenance

System Mode

Device Monitor

Adjust Brightness

When downloading a project configured with security to the MICRO/I, the password screen is displayed. 
Select a user name and enter its password. For details, refer to Chapter 23 “User Accounts and the Security 
Function” on page 23-1.

Run Offline Main Menu

<< >>BRIGHTNESS 31

MAC Address  00:03:7B:F0:12:A8
IP Address 192.168.0.1(DHCP)
2010/OCT/14/THU   14:56:44

IDEC HG G SERIES
SYSTEM MODE TOP PAGE

ENG/JPN

Main
Menu ------ ---

Offline Run

Initial
Setting

Clock
Setting

Top Page
Self

Diagnosis

System
Information

File
Manager

2010/OCT/14/THU  14:57:17
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8 Press DRIVE: for the transfer source and select the external memory device inserted in the MICRO/I.

This example screen shows when an SD memory card is selected.

9 Select the ZLD Project File to download.

This example screen shows when the ZLD Project File is “PLOGRAM01.ZLD”.

Press ▼ to select “PLOGRAM01.ZLD”.

10 Press DRIVE: for the transfer destination and select PLC.

Main
Menu ---

File
Manager ---

▲ DEL▼ ▲

▲

RELOAD ENT COPY

DIRECTION▲

FILTER

ALL
FILTERS

DRIVE:
SD  card

FORMAT DRIVE:
MICRO/I

FORMAT

HGDATA01 <DIR>
PLOGRAM01.zld

MICROI.ZNV

Main
Menu ---

File
Manager ---

▲ DEL▼ ▲

▲

RELOAD ENT COPY

DIRECTION▲

FILTER

ALL
FILTERS

DRIVE:
SD  card

FORMAT DRIVE:
MICRO/I

FORMAT

HGDATA01 <DIR>
PLOGRAM01.zld 

MICROI.ZNV

Main
Menu ---

File
Manager ---

▲ DEL▼ ▲

▲

RELOAD ENT COPY

DIRECTION▲

FILTER

ALL
FILTERS

DRIVE:
SD  card

FORMAT DRIVE:
PLC

FORMAT

HGDATA01 <DIR>
PLOGRAM01.zld 

PLC.ZLD

When PLC is selected with DRIVE: in the file manager, “PLC.ZLD” is always displayed. This is not the 
program file name for the PLC connected to the MICRO/I.
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11 Press COPY.
A process confirmation message is displayed.

12 Specify the MICRO/I communication port and the slave number or the External Device ID, and then press YES. 
Specify the Slave Number when selecting serial interface as the MICRO/I communication port, and specify the 
External Device ID when selecting Ethernet interface.
The ZLD Project File download starts.
When the download finishes, the results are displayed.

13 Press Ack to close the results screen.
You are returned to the Top Page of System Mode.

Main
Menu ---

File
Manager ---

▲ DEL▼ ▲

▲

RELOAD ENT COPY

DIRECTION▲

FILTER

ALL
FILTERS

DRIVE:
SD  card

FORMAT DRIVE:
PLC

FORMAT

HGDATA01 <DIR>
PLOGRAM01.zld 

PLC.ZLD

YES NO

Copy This File ?

PLOGRAM01.zld

Comm.I/F:

Slave Number:

Communication port

Slave number or 
External Device ID

0 0 0

SERIAL  1

When downloading a ZLD Project File to a PLC configured with a password, the PLC password screen is 
displayed. Enter the password.

Download PLC ProgramFunction

The following function completed
Result

Ack
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● Upload

1 Insert an external memory device in the MICRO/I.

2 Press the upper-left edge of the MICRO/I screen for three seconds or more.

The maintenance screen is displayed.

3 Press System Mode.

MICRO/I displays the Top Page in the System Mode.

4 Press Main Menu.

The main menu is displayed.

HG3G HG2G-5FHG4G

HG5G-V HG4G-V HG3G-V HG2G-V

PLCMICRO/I

USB flash drive

SD memory card

External Memory Device

Press and hold 
3 or more seconds

HG3G HG2G-5FHG4G

HG5G-V HG4G-V HG3G-V HG2G-V

MICRO/I

Maintenance

System Mode

Device Monitor

Adjust Brightness

When downloading a project configured with security to the MICRO/I, the password screen is displayed. 
Select a user name and enter its password. For details, refer to Chapter 23 “User Accounts and the Security 
Function” on page 23-1.

Run Offline Main Menu

<< >>BRIGHTNESS 31

MAC Address  00:03:7B:F0:12:A8
IP Address 192.168.0.1(DHCP)
2010/OCT/14/THU   14:56:44

IDEC HG G SERIES
SYSTEM MODE TOP PAGE

ENG/JPN
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5 Press File Manager.

The file manager is displayed.

6 Press DRIVE: for the transfer source and select PLC.

7 Press DRIVE: for the transfer destination and select the external memory device inserted in the MICRO/I.

This example screen shows when an SD memory card is selected.

Main
Menu ------ ---

Offline Run

Initial
Setting

Clock
Setting

Top Page
Self

Diagnosis

System
Information

File
Manager

2010/OCT/14/THU  14:57:17

Main
Menu ---

File
Manager ---

▲ DEL▼ ▲

▲

RELOAD ENT COPY

DIRECTION▲

FILTER

ALL
FILTERS

DRIVE:
PLC

FORMAT DRIVE:
SD  card

FORMAT

PLC.ZLD HGDATA01 <DIR>
001 <DIR>
002 <DIR>

When PLC is selected with DRIVE: in the file manager, “PLC.ZLD” is always displayed. This is not the 
program file name for the PLC connected to the MICRO/I.

Main
Menu ---

File
Manager ---

▲ DEL▼ ▲

▲

RELOAD ENT COPY

DIRECTION▲

FILTER

ALL
FILTERS

DRIVE:
PLC

FORMAT DRIVE:
SD  card

FORMAT

PLC.ZLD HGDATA01 <DIR>
001 <DIR>
002 <DIR>
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8 Select the save destination for the PLC program to upload.

Folder (001) is selected in this example.

1. Press  to move the cursor to the transfer destination on the SD memory card.

2. Press ▼ to select “001” and then press ENT.

9 Press COPY.

A process confirmation message is displayed.

▼
Main
Menu ---

File
Manager ---

▲ DEL▼ ▲

▲

RELOAD ENT COPY

DIRECTION▲

FILTER

ALL
FILTERS

DRIVE:
PLC

FORMAT DRIVE:
SD  card

FORMAT

PLC.ZLD HGDATA01 <DIR>
001 <DIR>
002 <DIR>

Main
Menu ---

File
Manager ---

▲ DEL▼ ▲

▲

RELOAD ENT COPY

DIRECTION▲

FILTER

ALL
FILTERS

DRIVE:
PLC

FORMAT DRIVE:
SD  card

FORMAT

PLC.ZLD HGDATA01 <DIR>
001 <DIR>
002 <DIR>

1 2

Main
Menu ---

File
Manager ---

▲ DEL▼ ▲

▲

RELOAD ENT COPY

DIRECTION▲

FILTER

ALL
FILTERS

DRIVE:
PLC

FORMAT DRIVE:
SD  card

FORMAT

. <DIR>

.. <DIR>
PLC.ZLD
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10 Specify the MICRO/I communication port and the slave number or the External Device ID, and then press YES. 
Specify the Slave Number when selecting serial interface as the MICRO/I communication port, and specify the 
External Device ID when selecting Ethernet interface.
The PLC program upload starts.
When the upload finishes, the results are displayed.

11 Press Ack to close the screen.
You are returned to the Top Page of System Mode.

YES NO

Copy This File ?

PLC.ZLD

Comm.I/F:

Slave Number:

Communication port

Slave number or 
External Device ID

0 0 0

SERIAL  1

• “PLC.ZLD” is displayed in the confirmation message, but the ZLD Project File name after uploading is 
“Model name_Port number_Station number_Year month day hours minutes seconds + File extension 
(.zld)”.

• When downloading a ZLD Project File to a PLC configured with a password, the PLC password screen is 
displayed. Enter the password.

Upload PLC ProgramFunction

The following function completed
Result

Ack
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2.7 Precautions

• An error message is displayed if the PLC program upload or download fails.
For details, refer to Chapter 36 “1.1 Errors Displayed on the Screen” on page 36-1.

• To create a ZLD Project File, the following version of WindLDR is required.

• MICRO/I operation and PLC operation stops while the PLC program transfer function is running. After the PLC 
program upload or download is completed, the MICRO/I returns to the mode immediately before running the PLC 
program transfer function and the PLC automatically starts running.

• Only passwords containing uppercase alphanumeric characters can be entered from the MICRO/I. When the PLC 
password is configured with characters other than uppercase alphanumeric characters, the password cannot be 
cleared.

• The PLC program transfer function cannot be run when the MICRO/I is in Offline Mode. Switch to Run Mode, 
Monitor Mode, or System Mode before running the PLC program transfer function.

• If a file exists with the same name in the save destination when uploading a PLC program, the file is overwritten 
with the uploaded file without displaying an overwrite confirmation message.

• While running the PLC program transfer function using a Key Button, Multi-Button, or Multi-Command, if a data 
transfer function (project transfer, PLC program transfer, or file copy) is initiated, the only function that will work is 
the currently running function. If two or more data transfer functions are configured to a Multi-Button or Multi-
Command, only the data transfer function displayed at the top of the function list on the parts property dialog box 
is run.

Manufacturer Series name Supported system (CPU unit) WindLDR version

IDEC

OpenNet Controller
FC3A

Ver.6.30 or laterFC4A

MICROSmart

FC5A

FC6A (FC6A-C*****E/-C*****EJ only) Ver.8.0.0 or later

FC6A (FC6A-D****CEE only) Ver.8.6.0 or later

SmartAXIS Pro/Lite FT1A Ver.8.0.0 or later
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3.1 What Can Be Done with the File Copy Function

The file copy function is used to copy files between an SD memory card and a USB flash drive inserted in the MICRO/I 
or to internally copy files on an SD memory card or on a USB flash drive.

Copying from SD memory card to USB flash drive, or from USB flash drive to SD memory card
Copy files between an SD memory card and a USB flash drive inserted in the MICRO/I.

Internally copy files on an SD memory card
Internally copy files on an SD memory card inserted in the MICRO/I.

Internally copy files on a USB flash drive
Internally copy files on a USB flash drive inserted in the MICRO/I.

3 File Copy Function

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

HG3G HG2G-5FHG4G

HG5G-V HG4G-V HG3G-V HG2G-V

Copy

USB flash drive

File

SD memory card
MICRO/I

HG3G HG2G-5FHG4G

HG5G-V HG4G-V HG3G-V HG2G-V

Copy

FileFile

SD memory card

MICRO/I

HG3G HG2G-5FHG4G

HG5G-V HG4G-V HG3G-V HG2G-V

Copy

FileFile

USB flash drive

MICRO/I

When the MICRO/I is under the Run Mode, HMI Special Internal Relay LSM23 is 1 while the File Copy 
function is executed.
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3.2 File Copy Operating Procedures

The following methods can be used to copy files between an SD memory card and a USB flash drive inserted in the 
MICRO/I or to internally copy files on an SD memory card or on a USB flash drive.

• Using the USB Autorun function
 For details, refer to Chapter 31 “2 USB Autorun Function” on page 31-22.

• Using Key Buttons, Multi-Buttons, or Multi-Commands
 For details, refer to “3.3 Using Key Buttons, Multi-Buttons, or Multi-Commands to Copy Files” on page 29-32.

• Using the File Manager in the System Mode on the MICRO/I
 For details, refer to “3.4 Using File Manager on the MICRO/I to Transfer Project Data” on page 29-33.
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3.3 Using Key Buttons, Multi-Buttons, or Multi-Commands to Copy Files

1 Insert an external memory device in the MICRO/I.

2 Press the Key Button or Multi-Button or execute the Multi-Command configured with File Copy under Data Transfer 
in the Key Browser dialog box.

Allocate a Key Button, Multi-Button, or Multi-Command configured with the file copy function to the MICRO/I.
 For details, refer to Chapter 8 “5 Key Button” on page 8-72.
 For details, refer to Chapter 8 “6 Multi-Button” on page 8-108.
 For details, refer to Chapter 12 “6 Multi-Command” on page 12-38.

HG3G HG2G-5FHG4G

HG5G-V HG4G-V HG3G-V HG2G-V

MICRO/I

USB flash drive

SD memory card

External Memory Device



WindO/I-NV4 User’s Manual 29-33

3 File Copy Function

29

D
ata Transfer Function

3.4 Using File Manager on the MICRO/I to Transfer Project Data

1 Insert an external memory device in the MICRO/I.

2 Press the upper-left edge of the MICRO/I screen for three seconds or more.

The maintenance screen is displayed.

3 Press System Mode.

MICRO/I displays the Top Page in the System Mode.

4 Press Main Menu.

The main menu is displayed.

HG3G HG2G-5FHG4G

HG5G-V HG4G-V HG3G-V HG2G-V

MICRO/I

USB flash drive

SD memory card

External Memory Device

Press and hold 
3 or more seconds

HG3G HG2G-5FHG4G

HG5G-V HG4G-V HG3G-V HG2G-V

MICRO/I

Maintenance

System Mode

Device Monitor

Adjust Brightness

When downloading a project configured with security to the MICRO/I, the password screen is displayed. 
Select a user name and enter its password. For details, refer to Chapter 23 “User Accounts and the Security 
Function” on page 23-1.

Run Offline Main Menu

<< >>BRIGHTNESS 31

MAC Address  00:03:7B:F0:12:A8
IP Address 192.168.0.1(DHCP)
2010/OCT/14/THU   14:56:44

IDEC HG G SERIES
SYSTEM MODE TOP PAGE

ENG/JPN
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5 Press File Manager.

The file manager is displayed.

6 Press DRIVE: for the copy source and select the external memory device inserted in the MICRO/I.

This example screen shows when an SD memory card is selected.

7 Select the file to copy.

In this example, the sound file (AUDIO1.WAV) saved in the External Memory Device folder (HGDATA01) is selected.

1. Press ▼ to select “HGDATA01” and then press ENT.

Main
Menu ------ ---

Offline Run

Initial
Setting

Clock
Setting

Top Page
Self

Diagnosis

System
Information

File
Manager

2010/OCT/14/THU  14:57:17

Main
Menu ---

File
Manager ---

▲ DEL▼ ▲

▲

RELOAD ENT COPY

DIRECTION▲

FILTER

ALL
FILTERS

DRIVE:
SD  card

FORMAT DRIVE:
MICRO/I

FORMAT

HGDATA01 <DIR> MICROI.ZNV

Main
Menu ---

File
Manager ---

▲ DEL▼ ▲

▲

RELOAD ENT COPY

DIRECTION▲

FILTER

ALL
FILTERS

DRIVE:
SD  card

FORMAT DRIVE:
MICRO/I

FORMAT

HGDATA00 <DIR>
HGDATA01 <DIR>
HGDATA02 <DIR>

MICROI.ZNV

1 2
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2. Press ▼ to select “SOUND” and then press ENT.

3. Press ▼ to select “AUDIO1.WAV”.

8 Press DRIVE: for the transfer destination and select the external memory device inserted in the MICRO/I.

This example screen shows when a USB flash drive is selected.

Main
Menu ---

File
Manager ---

▲ DEL▼ ▲

▲

RELOAD ENT COPY

DIRECTION▲

FILTER

ALL
FILTERS

DRIVE:
SD  card

FORMAT DRIVE:
MICRO/I

FORMAT

. <DIR>

.. <DIR>
NVDATA <DIR>
PICTURE <DIR>
SOUND <DIR>
 

MICROI.ZNV

1 2

Main
Menu ---

File
Manager ---

▲ DEL▼ ▲

▲

RELOAD ENT COPY

DIRECTION▲

FILTER

ALL
FILTERS

DRIVE:
SD  card

FORMAT DRIVE:
MICRO/I

FORMAT

. <DIR>

.. <DIR>
AUDIO2.WAV 
AUDIO1.WAV

MICROI.ZNV

Main
Menu ---

File
Manager ---

▲ DEL▼ ▲

▲

RELOAD ENT COPY

DIRECTION▲

FILTER

ALL
FILTERS

DRIVE:
SD  card

FORMAT DRIVE:
USB memory

FORMAT

. <DIR>

.. <DIR>
AUDIO2.WAV 
AUDIO1.WAV

001 <DIR>
002 <DIR>
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9 Select the save destination for the file to copy.

Folder (002) is selected in this example.

1. Press  to move the cursor to the copy destination on the USB flash drive.

2. Press ▼ to select “002” and then press ENT.

10 Press COPY.
A process confirmation message is displayed.

▼

Main
Menu ---

File
Manager ---

▲ DEL▼ ▲

▲

RELOAD ENT COPY

DIRECTION▲

FILTER

ALL
FILTERS

DRIVE:
SD  card

FORMAT DRIVE:
USB memory

FORMAT

. <DIR>

.. <DIR>
AUDIO2.WAV 
AUDIO1.WAV

001 <DIR>
002 <DIR>

Main
Menu ---

File
Manager ---

▲ DEL▼ ▲

▲

RELOAD ENT COPY

DIRECTION▲

FILTER

ALL
FILTERS

DRIVE:
SD  card

FORMAT DRIVE:
USB memory

FORMAT

. <DIR>

.. <DIR>
AUDIO2.WAV 
AUDIO1.WAV

001 <DIR>
002 <DIR>

1 2

Main
Menu ---

File
Manager ---

▲ DEL▼ ▲

▲

RELOAD ENT COPY

DIRECTION▲

FILTER

ALL
FILTERS

DRIVE:
SD  card

FORMAT DRIVE:
USB memory

FORMAT

. <DIR>

.. <DIR>
AUDIO2.WAV 
AUDIO1.WAV

. <DIR>

.. <DIR>
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11 Press YES.
The file is being copied.

When complete, the file is shown in the save destination.

YES NO

Copy This File ?

AUDIO1.WAV

Main
Menu ---

File
Manager ---

▲ DEL▼ ▲

▲

RELOAD ENT COPY

DIRECTION▲
FILTER

ALL
FILTERS

DRIVE:
SD  card

FORMAT DRIVE:
USB memory

FORMAT

. <DIR>

.. <DIR>
AUDIO2.WAV 
AUDIO1.WAV

. <DIR>

.. <DIR>
AUDIO1.WAV
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3.5 Precautions

• When the MICRO/I is under the Run Mode, the maximum size per single file that can be read or written with the 
File Copy function is 256 MB.

• Access to the file being copied is not allowed while the file copy function is running. Therefore, data may be 
missing when copying files used by the running project such as log data. When copying a file used by the running 
project, use File Manager on the MICRO/I under the System Mode.

• While running the file copy function using a Key Button, Multi-Button, or Multi-Command, if a data transfer function 
(project transfer, PLC program transfer, or file copy) is initiated, the only function that will work is the currently 
running function. If two or more data transfer functions are configured to a Multi-Button or Multi-Command, only 
the data transfer function displayed at the top of the function list on the parts property dialog box is run.



WindO/I-NV4 User’s Manual 30-1

30

Expansion M
odules

This chapter describes how to use or operate the expansion modules, how to write a Cyclic Script and the basic 
operations of the Module Configuration dialog box.

  

1.1 Overview of Expansion Modules

The MICRO/I has an expansion interface which allows you to add input and output functionality by adding expansion 
modules.
For the HG5G/4G/3G-V, HG4G/3G, up to four IDEC MICROSmart PLC expansion I/O modules may be installed. For the 
HG2G-V, HG2G-5F, up to two IDEC MICROSmart PLC expansion I/O modules may be installed.

Expansion I/O modules can be used to configure a display and I/O control system for small equipment with only a few 
I/O, or for applications with simple I/O control requirements.

Chapter 30 Expansion Modules

1 Overview

HG3G HG2G-5F HG2G-5THG4G HG1GHG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

HG3G HG2G-5FHG4G
HG5G-V HG4G-V HG3G-V HG2G-V

Expansion module

Slot 1

Expansion module

Slot 2

MICRO/I

Attached expansion modules are referred to as Slot 1 and Slot 2 in order from the module closest to the 
MICRO/I.
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1.2 Applicable Expansion Modules

● Digital I/O Module

IDEC MicroSmart PLC Digital I/O module that can be attached as expansion modules are indicated below.

■ Digital Input Modules

■ Digital Output Modules

HG3G HG2G-5F HG2G-5THG4G HG1GHG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

Type Model No. Connector
Dimensions 

(L x W x H (mm))

Consumption 
Current (mA)

HG5G/
4G/3G/

2G-V

HG4G/
3G

HG2G-
5F

5 V 24 V

8 points/AC Input FC4A-N08A11
Removable 
Terminal Block

90.0×23.5×70.0 25 0 NO YES YES

8 points/DC Input FC4A-N08B1 90.0×23.5×70.0 25 0 NO YES YES

16 points/DC Input FC4A-N16B1 90.0×23.5×70.0 40 0 NO YES YES

16 points/DC Input FC4A-N16B3
MIL Connector

90.0×17.6×70.0 35 0 NO YES YES

32 points/DC Input FC4A-N32B3 90.0×29.7×70.0 65 0 NO YES YES

8 points/AC Input FC6A-N08A11
Removable 
Terminal Block

90.0×23.6×73.0 40 0 YES YES YES

8 points/DC Input FC6A-N08B1 90.0×23.6×73.0 30 0 YES YES YES

16 points/DC Input FC6A-N16B1 90.0×23.6×73.0 40 0 YES YES YES

16 points/DC Input FC6A-N16B3
MIL Connector

90.0×17.6×73.0 40 0 YES YES YES

32 points/DC Input FC6A-N32B3 90.0×30.2×73.0 65 0 YES YES YES

Type Model No. Connector
Dimensions 

(L x W x H (mm))

Consumption 
Current (mA) HG5G-

V

HG4G/
3G/2G

-V

HG4G/
3G

HG2G-
5F

5 V 24 V

8 points/Relay Output FC4A-R081
Removable 
Terminal 
Block

90.0×23.5×70.0 30 40 NO NO YES YES

16 points/Relay Output FC4A-R161 90.0×23.5×70.0 45 75 NO NO YES YES

8 points/Transistor Sink Output FC4A-T08K1 90.0×23.5×70.0 10 20 NO NO YES YES

8 points/Transistor Source Output FC4A-T08S1 90.0×23.5×70.0 10 20 NO NO YES YES

16 points/Transistor Sink Output FC4A-T16K3

MIL 
Connector

90.0×17.6×70.0 10 40 NO NO YES YES

16 points/Transistor Source Output FC4A-T16S3 90.0×17.6×70.0 10 40 NO NO YES YES

32 points/Transistor Sink Output FC4A-T32K3 90.0×29.7×70.0 20 70 NO NO YES YES

32 points/Transistor Source Output FC4A-T32S3 90.0×29.7×70.0 20 70 NO NO YES YES

8 points/Relay Output FC6A-R081

Removable 
Terminal 
Block

90.0×23.6×73.0 35 50 YES YES YES YES

16 points/Relay Output FC6A-R161 90.0×23.6×73.0 50 100 NO YES YES YES

8 points/Transistor Sink Output FC6A-T08K1 90.0×23.6×73.0 25 15 YES YES YES YES

8 points/Transistor Source Output FC6A-T08S1 90.0×23.6×73.0 25 15 YES YES YES YES

16 points/Transistor Sink Output FC6A-T16K1 90.0×23.6×73.0 30 25 YES YES YES YES

16 points/Transistor Source Output FC6A-P16K1 90.0×23.6×73.0 30 25 YES YES YES YES

16 points/Transistor Sink Output FC6A-T16K3

MIL 
Connector

90.0×17.6×73.0 30 25 YES YES YES YES

16 points/Transistor Source Output FC6A-P16S3 90.0×17.6×73.0 30 25 YES YES YES YES

32 points/Transistor Sink Output FC6A-T32K3 90.0×30.2×73.0 45 50 YES YES YES YES

32 points/Transistor Source Output FC6A-P32S3 90.0×30.2×73.0 45 50 YES YES YES YES
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■ Digital Combination I/O Modules

● Analog I/O Module

IDEC MicroSmart PLC Analog I/O modules that can be attached as expansion modules are indicated below.

■ Analog Input Module

■ Analog Output Module

■ Mixed Analog I/O Module

Type Model No. Connector
Dimensions 

(L x W x H (mm))

Consumption 
Current (mA)

HG5G/
4G/3G/

2G-V

HG4G/
3G

HG2G-
5F

5 V 24 V

4 points/DC Input, 
4 points/Relay Output

FC4A-M08BR1
Removable 
Terminal Block

90.0×23.5×70.0 25 20 NO YES YES

16 points/DC Input, 
8 points/Relay Output

FC4A-M24BR2
Non-removable 
Terminal Block

90.0×39.1×70.0 65 45 NO YES YES

4 points/DC Input, 
4 points/Relay Output

FC6A-M08BR1
Removable 
Terminal Block

90.0×23.6×73.0 30 25 YES YES YES

16 points/DC Input, 
8 points/Relay Output

FC6A-M24BR1 90.0×39.2×73.0 55 50 YES YES YES

HG3G HG2G-5F HG2G-5THG4G HG1GHG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

Type Model No.

Input Type

Voltage Current Thermocouple
Resistance 

Thermometer
Thermistor

2 points Input FC6A-J2C1
0 to 10 V/

-10 to +10 V
0 to 20 mA/
4 to 20 mA

― ― ―

4 points Input FC6A-J4A1
0 to 10 V/

-10 to +10 V
0 to 20 mA/
4 to 20 mA

― ― ―

8 points Input FC6A-J8A1
0 to 10 V/

-10 to +10 V
0 to 20 mA/
4 to 20 mA

― ― ―

4 points Input FC6A-J4CN1
0 to 10 V/

-10 to +10 V
0 to 20 mA/
4 to 20 mA

K/ J/ R/ S/ B/ E/ 
T/ N/ C

Pt100/Pt1000/
Ni100/Ni1000

―

4 points Input FC6A-J4CH1Y ― ―
K/ J/ R/ S/ B/ E/ 

T/ N/ C
― ―

8 points Input FC6A-J8CU1 ― ―
K/ J/ R/ S/ B/ E/ 

T/ N/ C
― NTC/PTC 

Type Model No.
Output Type

Voltage Current

2 points Output FC6A-K2A1 0 to 10V/-10 to +10V 0 to 20mA/4 to 20mA

4 points Output FC6A-K4A1 0 to 10 V/-10 to +10 V 0 to 20 mA/4 to 20 mA

Type Model No.

Input Type Output Type

Voltage Current Thermocouple
Resistance 

Thermometer
Voltage Current

4 points 
Input, 
2 points 
Output

FC6A-L06A1

0 to 10 V/
-10 to +10 V

0 to 20 mA/
4 to 20 mA

― ― ― ―

― ― ― ―
0 to 10 V/

-10 to +10 V
0 to 20 mA/
4 to 20 mA

2 points 
Input, 
1 points 
Output

FC6A-L03CN1

0 to 10 V/
-10 to +10 V

0 to 20 mA/
4 to 20 mA

K/ J/ R/ S/ B/ E/ 
T/ N/ C

Pt100/Pt1000/
Ni100/Ni1000

― ―

― ― ― ―
0 to 10 V/

-10 to +10 V
0 to 20 mA/
4 to 20 mA
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Checking the Hardware Version Number

The analog I/O module hardware version number is printed on the side of the analog I/O module. The performance 
and functionality of the analog I/O module will differ by its version, so check the version number before use.

● Restrictions when connecting the expansion modules

• The expansion module for FC4A and the expansion module for FC6A cannot be used together.
• Always turn the MICRO/I and the expansion module off before attaching or detaching an expansion module.
• Use the expansion module clamp (sold separately) when using expansion modules. 

Order the module clamp by referring to the width of the module shown in the dimensions of each module.
• When connecting more than 2 expansion modules, note the limits shown below.

S/N:XXXXX-XXXXX V100 

Version Number

Type No.
Quantity of 

Applicable Analog 
I/O Modules

Total width when 
connecting more 
than 2 expansion 

modules

Current flow rate 
at 5V

Current flow rate 
at 24V

HG5G-V 4 93.0 mm max. 130 mA max. 50 mA max.

HG4G/3G-V, HG4G/3G 2 93.0 mm max. 130 mA max. 150 mA max.

HG2G-V, HG2G-5F 2 70.0 mm max. 130 mA max. 150 mA max.

HG3G HG2G-5F HG2G-5THG4G HG1GHG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P
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● Expansion Module Slot Information

Expansion module type information is written to HMI Special Data Registers (LSD270 to 277). The details are shown 
below.

■ Status

■ Type ID

■ System Software Version
Displays the version of the system software written to the device.

Upper Lower Description

LSD270 LSD271 Expansion Module Slot 1 Information

LSD272 LSD273 Expansion Module Slot 2 Information

LSD274 LSD275 Expansion Module Slot 3 Information

LSD276 LSD277 Expansion Module Slot 4 Information

HG3G HG2G-5F HG2G-5THG4G HG1GHG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

Status Type IDUpper

Position Information System Software VersionLower

Slot Number (1 to 4)

Bit
15

Bit
0

Bit
7

Bit
8

 
12

 
34

 
5

 
6

 
910

 
1112

 
13

 
14

Status
Description

Hexadecimal Binary

0x00 0000 0000 Normal

0x81 1000 0001
Communication error (An error has occurred in the communication between MICRO/I and 
an expansion module.)

0x82 1000 0010 Unknown device detected

0x83 1000 0011
Device setting error (No device is connected or the connected device is different from that 
set in the project.)

0x84 1000 0100 Device writing error (The attempt to set the operation of the device failed.)

Type ID
Type No.

Hexadecimal Binary

0x00 0000 0000 FC6A-N16B1, FC6A-N16B3

0x01 0000 0001 FC6A-R161, FC6A-T16K1, FC6A-T16P1, FC6A-T16K3, FC6A-T16P3

0x02 0000 0010 FC6A-N32B3

0x03 0000 0011 FC6A-T32K3, FC6A-T32P3

0x04 0000 0100 FC6A-N08B1, FC6A-N08A11

0x05 0000 0101 FC6A-R081, FC6A-T08K1, FC6A-T08P1

0x06 0000 0110 FC6A-M08BR1

0x07 0000 0111 FC6A-M24BR1

0x20 0010 0000 FC6A-J2C1

0x21 0010 0001 FC6A-J4A1

0x22 0010 0010 FC6A-J8A1

0x23 0010 0011 FC6A-K2A1

0x24 0010 0100 FC6A-K4A1

0x25 0010 0101 FC6A-L06A1

0x26 0010 0110 FC6A-L03CN1

0x27 0010 0111 FC6A-J4CN1

0x28 0010 1000 FC6A-J8CU1

0x2B 0010 1011 FC6A-J4CH1Y
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1.3 The Expansion Module Operation

The Expansion modules can be controlled by switch parts, command parts and scripts. Processing priority should be 
determined based on the application.

■ Priority to display processing
In this mode, priority is given to the display and parts processing.
This mode can be used for applications where the priority is on the processing speed of screen parts operation and 
screen switching.
Read and write to the Input (#I, #D and LEX) and Output (#Q, #D and LEY) using the parts and the functions except 
the Cyclic Script such as switch parts, command parts, and scripts.
Users should understand that the processing time for drawing objects and communicating (the scan time of the 
screen) affects the control timing of the expansion module.
This means a time-consuming display process will slow the control time down and result in delayed input response.

■ Priority on control processing
This mode places priority on control processing speed.
It can be used for screens where parts operation is minimal but have many data processing parts.
Use the Cyclic Script to read and write to the Input (#I, #D and LEX) and Output (#Q, #D and LEY).
Refer to “4 Cyclic Script” on page 30-28 for programming information.
Use the Cyclic Script, which executes in conjunction with the expansion module, to provide I/O control at fixed 
intervals independent of the scan time of the screen.

When the MICRO/I is switched from operation mode to another mode, the state of the output terminal of 
the expansion module is as follows.
Digital I/O Module: Output OFF
Analog I/O Module: High impedance

Input and output processing set in the periodic script captures input at fixed intervals, and inputs other than 
fixed-period scripts take inputs at the scan end. If the same device address is used, take input at each 
timing and update the output.
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● Operation with priority on display processing

When an external input occurs

■ Display processing
Parts placed on the screen are processed in order from the top down. This process constitutes a single scan.
When processing reaches the end, it returns to the beginning and starts the next scan.
The time for one scan depends on the number and type of parts used, as well as how they are configured.

■ Input refresh
Inputs are refreshed every 10 ms independent of the screen scan.
However, inputs at the expansion module are not reflected in the Input (#I, #D and LEX) until the screens scan ends.

■ Input delay
When an external input occurs on the expansion module, the delay time until that input is reflected to the Input (#I, 
#D and LEX) is as follows.
Minimum: 5 milliseconds
Maximum: 15 milliseconds + the scan time (HMI Special Data Register LSD4)
The longer display processing takes, the longer the delay.

Control processing
Expansion module input

Input 
refresh

Input

External 
input

External 
input

10 ms

Input 
refresh 10 ms

Input 
refresh 10 ms

Scan time

Input delay

Input 
delay

Start of scan

Display 
processing

1 scan

 (#I, #D, LEX)

End of scan

When the input refresh is executed immediately after starting the
scan, since the input of the expansion module is reflected at the
end of the scan of the screen, a wait time of about 1 scan occurs
and the input delay is maximized.

Input

External 
input

Input 
refresh

Display 
processing

1 scan

(#I, #D, LEX)

Input delay 
(maximum)
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Writing to an external output

■ Output refresh
Outputs are refreshed every 10 ms independent of the screen scan.
The Output (#Q, #D and LEY) are reflected in the expansion module.

■ Output delay
The delay time from output (# Q, # D, LEY) to output from the expansion module is as follows.
Minimum: 1 millisecond
Maximum: 11 milliseconds
This does not affect the display processing

Control processing
Expansion module output

Output 
refresh

Output

Output

External
output

External
output

10 ms

Output 
refresh 10 ms

Output 
refresh 10 ms

Scan time

Output 
delay

Output 
delay

Start of scan

Display 
processing

1 scan

(#Q, #D, LEY)

(#Q, #D, LEY)

End of scan

The maximum output delay is 11 ms, which is the operating time 
of the output refresh. Output

External
output

Output 
refreshOutput delay 

(maximum)
(#Q, #D, LEY)
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● Operation with priority on control processing

■ Input refresh
Inputs on the expansion module are reflected in the Input (#I, #D and LEX).

■ Input delay
There is a delay between the expansion module input and the Input (#I, #D and LEX). 
The delay time is as follows.
Minimum: 5 milliseconds
Maximum: 5 milliseconds + the execution period

■ I/O control
The script specified as the Cyclic Script executes during I/O control.

■ Output refresh
The Output (#Q, #D and LEY) are output to the expansion module.

Cyclic 
Script

Display 
processing

Input refresh

Output refresh

Input

Output

External 
input

I/O control

Sleep 
(Display 

processing 
executed)

End of processing 
for part at bottom 

of screen

Start of processing 
for part at top 

of screen

Execution Period

Execution 
Period

External
output

 (#I, #D, LEX)

(#Q, #D, LEY)

Input delay

Output 
delay

Execution Period

The HG5G/4G/3G/2G-V also performs output refresh when input refreshing.

When an input occurs in the expansion module immediately after the 
input refresh ends, the input delay will be the longest because the
processor waits for the input refresh in the next scan before reflecting 
the input to the Input (#I, #D and LEX).

Input

Input refresh

Output refresh

I/O control

Sleep 
(Display 

processing 
executed)

Input refresh

Output refresh

I/O control

Input delay 
(maximum)

(#I, #D, LEX)

External 
input
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■ Output delay
The min-to-max delay time for the Output (#Q, #D and LEY) to fire from the expansion module is 1 millisecond to 1 
millisecond + the Execution Period.

■ Cyclic Script
A Cyclic Script refers to three processes: input refresh, I/O control (the specified script), and output refresh.
Refer to “4 Cyclic Script” on page 30-28 for programming information.

■ Sleep
Sleep refers to the time used by the Cyclic Script subtracted from the Execution Period. This is when the processor 
executes display processing.

■ Execution Period
The Execution Period refers to one scan of the Cyclic Script (input refresh + I/O control + output refresh) and display 
processing time (sleep).
The Cyclic Script is executed once every specified execution interval.

■ Display processing
Parts laid out on the screen are processed from top to bottom only when the Cyclic Script is in sleep mode.
Display processing pauses when execution of the next Cyclic Script begins, and resumes when the script goes to sleep 
again.
When processing reaches the bottom of the screen, processing returns to the top of the screen.

When an output is sent to the expansion module immediately after the 
output refresh ends, the output delay will be the longest because the 
processor waits for the output refresh in the next scan before 
reflecting the output to the Output (#Q, #D and LEY).

Output

External
output

Input refresh

Output refresh

I/O control

Sleep 
(Display 

processing 
executed)

Input refresh

Output refresh

I/O control

Output delay 
(maximum)

(#Q, #D, LEY)

• Only internal devices can be used in the Cyclic Script.
• The actual execution time of the Cyclic Script is stored in HMI Special Data Register LSD38 (current value 

x ms), LSD39 (max value x ms), and LSD40 (min value x ms).
• Cannot use the LINE function, RECTANGLE function, CIRCLE function in the Cyclic Script.

• If execution of the Cyclic Script takes more than half of the time specified for the Execution Period, the 
processor automatically extends the Execution Period so that the Cyclic Script completes within 1/2 of the 
Execution Period. In this instance, error number 7 will be stored in HMI Special Data Register LSD53.

• If the execution time of the Cyclic Script exceeds 3,000 milliseconds, it pauses to allow the output refresh 
to be executed. Thereafter, the script goes to sleep and the Cyclic Script executes on the next scan. In 
this instance, error number 6 will be stored in HMI Special Data Register LSD53.

There is a delay in the I/O control. Take this delay time into consideration when specifying the Execution 
Period. For instance, if it is necessary to capture external inputs within 100 ms, set the Execution Period to 
80 ms.
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Operation Example

Where,

• Execution interval: 100 ms

• Input refresh: 1 ms

• I/O control: 10 ms

• Output refresh: 1 ms

The execution time of the Cyclic Script is 1 + 10 + 1 = 12 ms, so the script executes normally.
The input delay can be from 5 to 105 ms, and the output delay can be from 1 to 101 ms.
Since the sleep time is 100 - 12 = 88 ms, display processing takes place every 88 ms of each scan.

Cyclic 
Script

Display 
processing
(88 ms)

Input refresh (1 ms)

Output refresh (1 ms)

Input

Output

I/O control
(10 ms)

Sleep 
(Display 

processing 
executed)

Execution interval (100 ms)

Execution 
interval

(100 ms)

 (#I, #D, LEX)

(#Q, #D, LEY)

Input delay
(5 to 105 ms)

Output delay
(1 to 101 ms)

Execution interval (100 ms)

External 
input

External
output
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2.1 Using Digital I/O Modules

The inputs and outputs on the digital I/O modules are mapped to following device address locations within the 
MICRO/I. The device name and symbol vary based on the model.

To monitor the inputs and control the outputs, the Expansion Inputs(#I),  Expansion Outputs(#Q), Digital Input(LEX) 
and Digital Output (LEY) are used.

The Expansion Inputs(#I), Expansion Outputs(#Q), Digital Input(LEX) and Digital Output(LEY) are octal-based, 
meaning that only numbers 0 to 7 are used in their addresses.
Address numbers are assigned in ascending order from Slot 1. However, if a unit has four input/output ports, address 
numbers 0 to 3 are assigned to each, and address numbers 4 to 7 cannot be used.

2 Digital I/O Modules

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

Type No. Device Name Symbol

HG5G/4G/3G/2G-V
Expansion Inputs #I

Expansion Outputs #Q

HG4G/3G, HG2G-5F
Digital Input LEX

Digital Output LEY

When entering the control device, inputs "#" before the symbol (device type). In addition, on the Device 
Monitor a "#" is displayed before the symbol.

Example: I100 is configured.

#I100

Inputs and outputs of Digital I/O modules can also be controlled and monitored using the word devices 
#WI, #WQ, WLEX and WLEY. #WI, #WQ, WLEX and WLEY are useful for batch control of inputs and 
outputs. For details about allocation of address number, refer to Chapter 33 “Internal Devices” on page 33-
1.
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3.1 Using Analog I/O Modules

Analog I/O modules are available that allow the MICRO/I to directly handle analog data such as voltage, current, and 
temperature. There are ten types of analog I/O modules that differ by the number of analog inputs and outputs and 
the operation mode. These analog I/O modules can be used by connecting them to the back of the MICRO/I. 
Analog I/O module inputs support voltage, current, thermocouples, resistance thermometers, and thermistors. Analog 
I/O module outputs support voltage and current.
To use Analog I/O modules, configures the settings on the Module Configuration dialog box. For details on 
configuration methods, refer to “5 Module Configuration Dialog Box” on page 30-29. For details on the analog I/O 
module parameter settings, refer to “3.2 Analog I/O Module Parameter Settings” on page 30-14.

3 Analog I/O Modules

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P
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3.2 Analog I/O Module Parameter Settings

Analog I/O Module Parameter Settings are configured for each channel. The parameters to configure differ according 
to the analog I/O module type and I/O type. In the Analog Module Configuration dialog box, configures the 
parameter settings according the application.
For details on configuration methods, refer to “5 Module Configuration Dialog Box” on page 30-29

● Analog Input Type
The following parameters are for configuring the analog inputs on the analog input modules and the mixed analog I/
O modules.
YES: Parameters, NO: No parameters

Parameter
FC6A-
J2C1

FC6A-
J4A1

FC6A-
J8A1

FC6A-
J4CN1

FC6A-
J4CH1Y

FC6A-
J8CU1

FC6A-
L06A1

FC6A-
L03CN1

Signal Type YES YES YES YES YES YES YES YES

Data Type YES YES YES YES YES YES YES YES

Minimum and 
maximum values
(Data type)

YES YES YES YES YES YES YES YES

Filter YES YES YES YES YES YES YES YES

Sample Time YES YES YES YES YES YES YES YES

Thermistor 
Settings

NO NO NO NO NO YES NO NO

Data YES YES YES YES YES YES YES YES

Status YES YES YES YES YES YES YES YES
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■ Signal Type
The signal type that can be set differs according to the analog I/O module model. Select the analog I/O module that 
corresponds to the user application and set the signal type. The signal type is the type of analog input to measure. 
There are 24 signal types for the analog inputs, which are detailed as follows.

YES: Supported, NO: Not supported

*1 Channels that are set to unused are not scanned.
The circuit is setup the same as when signal type: 0 to 10 V is selected.
0 is always stored in the analog data storage data registers for channels that are set to unused.

Signal Type
FC6A-
J2C1

FC6A-
J4A1

FC6A-
J8A1

FC6A-
J4CN1

FC6A-
J4CH1Y

FC6A-
J8CU1

FC6A-
L06A1

FC6A-
L03CN1

Unused*1 YES YES YES YES YES YES YES YES

0 to 10 V YES YES YES YES NO NO YES YES

-10 to +10 V YES YES YES YES NO NO YES YES

0 to 20 mA YES YES YES YES NO NO YES YES

4 to 20 mA YES YES YES YES NO NO YES YES

Type K thermocouple NO NO NO YES YES YES NO YES

Type J thermocouple NO NO NO YES YES YES NO YES

Type R thermocouple NO NO NO YES YES YES NO YES

Type S thermocouple NO NO NO YES YES YES NO YES

Type B thermocouple NO NO NO YES YES YES NO YES

Type E thermocouple NO NO NO YES YES YES NO YES

Type T thermocouple NO NO NO YES YES YES NO YES

Type N thermocouple NO NO NO YES YES YES NO YES

Type C thermocouple NO NO NO YES YES YES NO YES

Pt100 NO NO NO YES NO NO NO YES

Pt1000 NO NO NO YES NO NO NO YES

Ni100 NO NO NO YES NO NO NO YES

Ni1000 NO NO NO YES NO NO NO YES

NTC thermistor NO NO NO NO NO YES NO NO

PTC thermistor NO NO NO NO NO YES NO NO

PTC thermistor
(threshold)

NO NO NO NO NO YES NO NO

Resistance 
measurement

NO NO NO NO NO YES NO NO

Expansion 0 to 20 mA NO NO YES NO NO NO NO NO

Expansion 4 to 20 mA NO NO YES NO NO NO NO NO
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■ Data Type
The analog input value can be handled as the set data type. There are seven data types for the analog inputs.

YES: Supported, NO: Not supported

*1 For only the FC6A-J8A1, binary data (12 bits) and optional range (12 bits) are displayed.
*2 Can only be set when the signal type is thermocouple, resistance thermometer or NTC thermistor.
*3 Resistance when using the FC6A-J8CU1 and the signal type is set to PTC thermistor or Resistance measurement.
*4 Binary data (16 bits) and optional range (16 bits) can be used with the following versions.

FC6A-J8A1: Hardware version 200 or later (Refer to “ Checking the Hardware Version Number” on page 30-4.)
If a FC6A-J8A1 that does not correspond to the above version numbers is set to binary data (16 bits) or optional range (16 
bits), an error will occur and the module will operate as binary data (12 bits).

Data Type
FC6A-
J2C1

FC6A-
J4A1

FC6A-
J8A1

FC6A-
J4CN1

FC6A-
J4CH1Y

FC6A-
J8CU1

FC6A-
L06A1

FC6A-
L03CN1

Binary data*1 YES YES YES YES YES YES YES YES

Optional range*1 YES YES YES YES YES YES YES YES

Celsius*2 NO NO NO YES YES YES NO YES

Fahrenheit*2 NO NO NO YES YES YES NO YES

Resistance*3 NO NO NO NO NO YES NO NO

Binary data
(16 bits)

NO NO YES*4 NO NO NO NO NO

Optional range
(16 bits)

NO NO YES*4 NO NO NO NO NO
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■ Minimum and maximum values
The analog input values are stored in data registers. The stored minimum and maximum values are determined by 
the set signal type and data type. A parameter setting error occurs when a value is set that exceeds the minimum or 
maximum value.
The minimum and maximum values that correspond to the signal type and data types are as follows.

*1 For only the FC6A-J8A1, binary data (12 bits) and optional range (12 bits).
*2 The minimum and maximum values can be set only when the data type is set to optional range. Set the minimum and 

maximum values between -32,768 and 32,767.

Signal Type

Data Type

Binary 
Data 

(12 Bits)*1

Optional 
Range

(12 Bits)*1*2
Celsius Fahrenheit Resistance

Binary 
Data 

(16 Bits)

Optional 
Range

(16 Bits)

0 to 10 V 0 to 65,535 -32,768 to 32,767 ― ― ― 0 to 65,535 -32,768 to 32,767

-10 to +10 V -32,768 to 32,767 -32,768 to 32,767 ― ― ― -32,768 to 32,767 -32,768 to 32,767

0 to 20 mA 0 to 65,535 -32,768 to 32,767 ― ― ― 0 to 65,535 -32,768 to 32,767

4 to 20 mA 0 to 65,535 -32,768 to 32,767 ― ― ― 0 to 65,535 -32,768 to 32,767

Type K thermocouple 0 to 65,535 -32,768 to 32,767 -2,000 to 13,000 -3,280 to 23,720 ― ― ―

Type J thermocouple 0 to 65,535 -32,768 to 32,767 -2,000 to 10,000 -3,280 to 18,320 ― ― ―

Type R thermocouple 0 to 65,535 -32,768 to 32,767 0 to 17,600 320 to 32,000 ― ― ―

Type S thermocouple 0 to 65,535 -32,768 to 32,767 0 to 17,600 320 to 32,000 ― ― ―

Type B thermocouple 0 to 65,535 -32,768 to 32,767 0 to 18,200 320 to 33,080 ― ― ―

Type E thermocouple 0 to 65,535 -32,768 to 32,767 -2,000 to 8,000 -3,280 to 14,720 ― ― ―

Type T thermocouple 0 to 65,535 -32,768 to 32,767 -2,000 to 4,000 -3,280 to 7,520 ― ― ―

Type N thermocouple 0 to 65,535 -32,768 to 32,767 -2,000 to 13,000 -3,280 to 23,720 ― ― ―

Type C thermocouple 0 to 65,535 -32,768 to 32,767 0 to 23,150 320 to 41,990 ― ― ―

Pt100 0 to 65,535 -32,768 to 32,767 -2,000 to 8,500 -3,280 to 15,620 ― ― ―

Pt1000 0 to 65,535 -32,768 to 32,767 -2,000 to 6,000 -3,280 to 11,120 ― ― ―

Ni100 0 to 65,535 -32,768 to 32,767 -600 to 1,800 -760 to 3,560 ― ― ―

Ni1000 0 to 65,535 -32,768 to 32,767 -600 to 1,800 -760 to 3,560 ― ― ―

NTC thermistor 0 to 65,535 -32,768 to 32,767 -900 to 1,500 -1,300 to 3,020 ― ― ―

PTC thermistor 0 to 65,535 -32,768 to 32,767 ― ― 100 to 10,000 ― ―

PTC thermistor 
(threshold)

1/2/4 ― ― ― ― ― ―

Resistance 
measurement

0 to 65,535 -32,768 to 32,767 ― ― 100 to 32,000 ― ―

Expansion 0 to 20 
mA

0 to 4,095 -32,768 to 32,767 ― ― ― 0 to 65,535 -32,768 to 32,767

Expansion 4 to 20 
mA

0 to 4,095 -32,768 to 32,767 ― ― ― 0 to 65,535 -32,768 to 32,767
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■ Filter
The analog input is filtered so it reaches approximately 99% of the analog input in the set time. Rapid fluctuations in 
the analog input can be reduced by setting the filter, but increasing the filter slows down the tracking of fluctuations 
in the analog input. The filter must be set for each channel.

Input filter example

■ Sampling Time
Analog values are converted to digital values at the interval of the sampling time. Depending on the analog I/O 
module, you may be able to change the sampling time setting.

Filter (ms) Description

0 The value is not filtered.

50 to 50,000
The analog input filter can be set in 50 ms increments.
The analog input is filtered so that approximately 99% of the analog input is reached in the 
specified filter.

-20
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Elapsed time (ms)

Filter: 100 ms
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Reaches approximately 99% of the analog 
input in the set filter (100 ms).

Type Signal Type Sample Time

FC6A-J2C1

0 to 10 V 1 ms

-10 to +10 V 1 ms

0 to 20 mA 1 ms

4 to 20 mA 1 ms

FC6A-J4A1

0 to 10 V 1 ms/10 ms

-10 to +10 V 1 ms/10 ms

0 to 20 mA 1 ms/10 ms

4 to 20 mA 1 ms/10 ms

FC6A-J8A1

0 to 10 V 1 ms/10 ms

-10 to +10 V 1 ms/10 ms

0 to 20 mA 1 ms/10 ms

4 to 20 mA 1 ms/10 ms

Expansion 0 to 20 mA 1 ms/10 ms

Expansion 4 to 20 mA 1 ms/10 ms
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■ Thermistor settings
When NTC thermistor is selected for the FC6A-J8CU1 signal type, the following parameters must be set.

The characteristic of NTC thermistor is that the resistance decreases as the temperature rises. The analog modules 
measure the resistance of the thermistor and calculate the temperature based on above three parameters.
The measurable range of the resistance of NTC thermistor is 100 Ω to 200,000 Ω. The range of temperature that can 
be calculated is -90°C to 150°C. Select NTC thermistor that functions within those ranges.

■ Data
Data refers to the input analog values converted to digital values at the interval of the sampling time.
The data is not guaranteed when the Satus is a value other than "0".

*1 When the sampling time is set to 30 ms, the modules may be more easily affected by commercial power supply noise (50/60 
Hz noise) and fluctuations in input values may become larger. If there are large fluctuations in input values, change the 
sampling time to 120 ms.

*2 Information are described in the instruction sheet for the thermistor to use.

FC6A-J4CN1

0 to 10 V 100 ms/10 ms

-10 to +10 V 100 ms/10 ms

0 to 20 mA 100 ms/10 ms

4 to 20 mA 100 ms/10 ms

Thermocouple 104 ms

Resistance thermometer 104 ms

FC6A-J4CH1Y Thermocouple 120 ms/30 ms*1

FC6A-J8CU1

Thermocouple 104 ms

NTC/PTC thermistor 104 ms

PTC thermistor (threshold) 104 ms

Resistance measurement 104 ms

FC6A-L06A1

0 to 10 V 1 ms/10 ms

-10 to +10 V 1 ms/10 ms

0 to 20 mA 1 ms/10 ms

4 to 20 mA 1 ms/10 ms

FC6A-L03CN1

0 to 10 V 100 ms/10 ms

-10 to +10 V 100 ms/10 ms

0 to 20 mA 100 ms/10 ms

4 to 20 mA 100 ms/10 ms

Thermocouple 104 ms

Resistance thermometer 104 ms

Type Signal Type Sample Time

Parameter Description Range

R0 The thermistor resistance in "T0" °C (Ω)*2 0 to 65,535

T0 Temperature (°C)*2 -32,768 to 32,767

B Thermistor B constant*2 -32,768 to 32,767
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■ Status
The status of the analog input Data is stored in data registers.

Out of range error for Analog Input Value
When the analog input value reaches or exceeds the following upper limit, the out of maximum range error occurs. 
When the analog input valuefalls below the following lower limit, the out of minimum range error occurs.

*1 Expansion 0 to 20 mA or expansion 4 to 20 mA only
*2 Expansion 4 to 20 mA only
*3 Out of minimum range error occurs when a resistance of 200 kΩ or higher is connected.
*4 Out of maximum range error occurs when a resistance of 100 Ω or lower is connected.

Status Description

0 Operating normally

1 Converting data

2 Initializing

3 Parameter setting error

4 Hardware fault (external power supply error)

5 Wiring fault (out of maximum range error) 

6 Wiring fault (out of minimum range error)

7 Reserved

8 When the analog input value is greater than 20 mA and less than the upper limit value*1

9 When the analog input value is greater than the lower limit value and less than 4 mA*2

10 to 65,535 Reserved

Signal Type Lower Limit Value Upper Limit Value

0 to 10 V -0.2 V 10.2 V

-10 to +10 V -10.4 V 10.4 V

0 to 20 mA -0.4 mA 20.4 mA

4 to 20 mA 3.68 mA 20.32 mA

Type K thermocouple -200.0°C 1,300.0°C

Type J thermocouple -200.0°C 1,000.0°C

Type R thermocouple 0.0°C 1,760.0°C

Type S thermocouple 0.0°C 1,760.0°C

Type B thermocouple 0.0°C 1,820.0°C

Type E thermocouple -200.0°C 800.0°C

Type T thermocouple -200.0°C 400.0°C

Type N thermocouple -200.0°C 1,300.0°C

Type C thermocouple 0.0°C 2,315.0°C

Pt100 -200.0°C 850.0°C

Pt1000 -200.0°C 600.0°C

Ni100 -60.0°C 180.0°C

Ni1000 -60.0°C 180.0°C

NTC thermistor -90.0°C or 200 kΩ*3 150.0°C or 100 Ω*4

PTC thermistor 100 Ω 10 kΩ

PTC thermistor (threshold) 100 Ω 10 kΩ

Resistance measurement 100 Ω 32 kΩ

Expansion 0 to 20 mA -0.4 mA 23.54 mA

Expansion 4 to 20 mA 1.20 mA 23.17 mA
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● Analog Output Type
The following parameters are for configuring the analog outputs on the analog output modules and the mixed analog 
I/O modules.

YES: Supported, NO: Not supported

■ Signal Type

The signal type that can be set differs according to the analog I/O module model. Select the analog I/O module that 
corresponds to the user application and set the signal type. There are five types of signal types for the analog 
outputs, which are detailed as follows.

YES: Supported, NO: Not supported

*1 Channels that are set to unused are not scanned. A channel set to unused always outputs 0 V.
The circuit is setup the same as when signal type is selected 0 to 10 V.

Parameter FC6A-K2A1 FC6A-K4A1 FC6A-L06A1 FC6A-L03CN1

Signal Type YES YES YES YES

Data Type YES YES YES YES

Minimum and Maximum values YES YES YES YES

Data YES YES YES YES

Status YES YES YES YES

  CAUTION

The device connected to the analog I/O module may be damaged if the analog output signal type is 
mistakenly set and used. Please use caution when setting the analog output signal type.

Signal Type FC6A-K2A1 FC6A-K4A1 FC6A-L06A1 FC6A-L03CN1

Unused*1 YES YES YES YES

0 to 10 V YES YES YES YES

-10 to +10 V YES YES YES YES

0 to 20 mA YES YES YES YES

4 to 20 mA YES YES YES YES
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■ Data Type
The analog output value can be handled as the set data type. There are two data types for the analog outputs.

YES: Supported, NO: Not supported

■ Minimum and Maximum values
The value written to the data register is output from the analog output. The minimum and maximum values that can 
be written are determined by the set signal type and data type. A parameter setting error occurs when a value is set 
that exceeds the minimum or maximum value.
The minimum and maximum values that correspond to the signal types and data types are as follows.

■ Data
The analog output data for the analog output set with the Signal Type, the Data Type, the Min. and the Max. is 
stored in the data registers in the END progressing of each scan. The actual analog output data is not guaranteed 
when the analog output Status is a value other than "0". 

■ Status
The status of the analog output Data is stored in data registers.

*1 The minimum and maximum values can be set only when the data type is set to optional range. Set the minimum and 
maximum values between -32,768 and 32,767.

Data Type FC6A-K2A1 FC6A-K4A1 FC6A-L06A1 FC6A-L03CN1

Binary data YES YES YES YES

Optional range YES YES YES YES

Signal Type
Data Type

Binary Data Optional Range*1

0 to 10 V 0 to 4,095 -32,768 to 32,767

-10 to +10 V -2,048 to 2,047 -32,768 to 32,767

0 to 20 mA 0 to 4,095 -32,768 to 32,767

4 to 20 mA 0 to 4,095 -32,768 to 32,767

Status Description

0 Operating normally

1 Reserved

2 Initializing

3 Parameter setting error

4 Hardware fault (external power supply error)

5 to 65,535 Reserved
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● Control Registers
For the DR Allocation, configures the data register as the device to which each parameter of the analog I/O module 
is written.

Multiple words are used starting from the configured data register. The number of words of data registers that are 
used varies based on the analog I/O module model.

Used Data Registers (words)

FC6A-
J2C1

FC6A-
J4A1

FC6A-
J8A1

FC6A-
J4CN1

FC6A-
J4CH1Y

FC6A-
J8CU1

FC6A-
K2A1

FC6A-
K4A1

FC6A-
L06A1

FC6A-
L03CN1

4 8 16 8 8 16 4 8 12 6
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3.3 Device Allocation

● Analog Input Module
Allocation of device address for the analog input module is shown below.
For details about the parameter setting values, refer to “ Analog Input Parameter Setting Values” on page 30-24.

Analog Input Parameter Setting Values

The parameter setting values are as follows.

■ Signal type

Channel

Parameter R/W

FC6A-
J2C1

FC6A-
J4A1

FC6A-
J8A1

FC6A-
J4CN1

FC6A-
J4CH1Y

FC6A-
J8CU1

No.
Address 
Number

Address 
Number

Address 
Number

Address 
Number

Address 
Number

Address 
Number

CH0
Analog input data R +0 +0 +0 +0 +0 +0

Analog input status R +1 +1 +1 +1 +1 +1

CH1
Analog input data R +2 +2 +2 +2 +2 +2

Analog input status R +3 +3 +3 +3 +3 +3

CH2
Analog input data R ― +4 +4 +4 +4 +4

Analog input status R ― +5 +5 +5 +5 +5

CH3
Analog input data R ― +6 +6 +6 +6 +6

Analog input status R ― +7 +7 +7 +7 +7

CH4
Analog input data R ― ― +8 ― ― +8

Analog input status R ― ― +9 ― ― +9

CH5
Analog input data R ― ― +10 ― ― +10

Analog input status R ― ― +11 ― ― +11

CH6
Analog input data R ― ― +12 ― ― +12

Analog input status R ― ― +13 ― ― +13

CH7
Analog input data R ― ― +14 ― ― +14

Analog input status R ― ― +15 ― ― +15

Setting Value Signal Type

0 Unused

1 0 to 10 V

2 -10 to +10 V

3 0 to 20 mA

4 4 to 20 mA

5 Type K thermocouple

6 Type J thermocouple

7 Type R thermocouple

8 Type S thermocouple

9 Type B thermocouple

10 Type E thermocouple

11 Type T thermocouple

12 Type N thermocouple

13 Type C thermocouple

14 Pt100

15 Pt1000

16 Ni100
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If the setting value is outside the range, a parameter setting error will occur.

■ Data type

If the setting value is 4 to 65,535, a parameter setting error will occur.

■ Minimum and maximum values
The minimum and maximum values can be set only when the data type is set to optional range. Set the minimum and 
maximum values between -32,768 and 32,767. However, when signal type is set to PTC thermistor (threshold), set it 
1, 2, or 4.

■ Filter

The setting value is rounded by 50.
When 50,001 to 65,535 is stored for the setting value, the filter operates as the maximum value of 50,000 ms.

■ Thermistor constant

17 Ni1000

18 NTC thermistor

19 PTC thermistor

20 PTC thermistor (threshold)

21 Resistance measurement

22 Expansion 0 to 20 mA

23 Expansion 4 to 20 mA

Setting Value Signal Type

Setting Value Data type

0 Binary data/Binary data (12 bits)

1 Optional range/Optional range (12 bits)

2 Celsius/resistance/Binary data (16 bits)

3 Fahrenheit/Optional range (16 bits)

Setting Value Filter

0 0 ms

50 50 ms

100 100 ms

150 150 ms

… …

50,000 50,000 ms

Range Thermistor Constant

0 to 65,535 R0

-32,768 to 32,767 T0

-32,768 to 32,767 B
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● Analog Output Module
Allocation of device address for the analog output module is shown below.
For details about the parameter setting values, refer to “ Analog Output Parameter Setting Values” on page 30-26.

Analog Output Parameter Setting Values

The parameter setting values are as follows.

■ Signal type

If the setting value is outside the range, a parameter setting error will occur.

■ Data type

If the setting value is 2 to 65,535, a parameter setting error will occur.

■ Minimum and maximum values
The minimum and maximum values can be set only when the data type is set to optional range. Set the minimum and 
maximum values between -32,768 and 32,767.

Channel
Parameter R/W

FC6A-K2A1 FC6A-K4A1

No. Address Number Address Number

CH0
Analog output data R +0 +0

Analog output status R +1 +1

CH1
Analog output data R +2 +2

Analog output status R +3 +3

CH2
Analog output data R ― +4

Analog output status R ― +5

CH3
Analog output data R ― +6

Analog output status R ― +7

Setting Value Signal Type

0 Unused

1 0 to 10 V

2 -10 to +10 V

3 0 to 20 mA

4 4 to 20 mA

Setting Value Data type

0 Binary data

1 Optional range
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● Mixed Analog I/O Module
Allocation of device address for the mixed analog I/O module is shown below.
For details about the parameter setting values for analog inputs, refer to “ Analog Input Parameter Setting Values” on 
page 30-24. For analog outputs, refer to “ Analog Output Parameter Setting Values” on page 30-26.

Channel
Parameter R/W

FC6A-L06A1 FC6A-L03CN1

No. I/O Address Number I/O Address Number

CH0
Analog data R

Input

+0

Input

+0

Analog status R +1 +1

CH1
Analog data R +2 +2

Analog status R +3 +3

CH2
Analog data R +4

Output
+4

Analog status R +5 +5

CH3
Analog data R +6 ― ―

Analog status R +7 ― ―

CH4
Analog data R

Output

+8 ― ―

Analog status R +9 ― ―

CH5
Analog data R +10 ― ―

Analog status R +11 ― ―
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A Cyclic Script is a script whose trigger condition can be set to a fixed interval (in increments of 10 ms). Only one 
Cyclic Script can be assigned to the project.
When a script is specified as a Cyclic Script, it executes at the specified fixed intervals independent of the scan time of 
the screen (processing time for parts on the screen).

4.1 Setting Procedures for Cyclic Script

Follow these steps to program a Cyclic Script.

1 On the Configuration tab, in the System Setup group, click Project.

The Project Settings dialog box appears.

2 On the Expansion Module tab, select the Use Cyclic Script check box.

3 Specify the Script ID and Execution Interval.

■ Script ID
Specify the script ID to use (from 1 to 32000) as the Cyclic Script.

■ Execution Interval(x 10msec)
Specify the interval at which the script should execute from 1 to 100 (10 ms increments).
The specified script will execute at the specified intervals.

4 Click OK.

4 Cyclic Script

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P
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This section describes the Module Configuration dialog box to configure the settings for the expansion module.

5.1 Overview

The MICRO/I is capable of using the expansion modules described in “1.2 Applicable Expansion Modules” on page 30-
2. To use an expansion module, insert the expansion module to be connected to MICRO/I on the Module 
Configuration dialog box.

● Module Configuration Dialog Box

The module configuration can be created by selecting the expansion modules to use in the expansion modules list and 
dragging and dropping them to the module configuration area.

5 Module Configuration Dialog Box

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

Module Configuration Area: Displays the configuration of connected expansion modules.

Expansion Module List: Displays a list of expansion modules that can be connected to the MICRO/I.

Parameter Reference Area: Displays the parameters that are configured for the expansion modules.

Parameter Reference Area Expansion Module ListModule Configuration Area
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5.2 Basic Operations for Module Configuration Dialog Box

● Open the Module Configuration dialog box

1 On the Configuration tab, in the System Setup group, click Project.

The Project Settings dialog box is displayed.

2 Click the Expansion Module tab in the Project Settings dialog box, and then click Module Configuration.

The Module Configuration dialog box is displayed.
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● Inserting Expansion Modules

1 Select the expansion module to insert in the Expansion Module List, and then drag and drop it to the Module 
Configuration Area.

2 Click the inserted expansion module in the Module Configuration Area, and then click Configure.

The configuration dialog box that corresponds to the expansion module is displayed.

Expansion Module ListModule Configuration Area

Inserted expansion module
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3 In the configuration dialog box, configure the parameters for the expansion module.
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● Deleting Expansion Module

1 Click the expansion module to remove in the Module Configuration Area.

2 Right-click the expansion module to delete, and then click Remove.

The selected expansion module is deleted and all of the extension modules placed on the right side of the deleted 
extension module are automatically shifted to the left.

Module Configuration Area

Expansion module to delete
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● Swapping Expansion Module

1 Select the expansion module to be moved, and then drag and drop it at the destination.

If you change the position of the digital I/O module, the device address is automatically reassigned. 
However, the device addresses configured in the editing project are not changed.
Example: When swapping the digital input modules, reassign the device addresses as follows.

However, the device address of the part (Pilot Lamp) configured in the project is not changed.

Input Module (1)
Quantity of Inputs: 8
(#I0030 to #I0037)

Part (Pilot Lamp)

Part (Pilot Lamp)

Input Module (2)
Quantity of Inputs: 16
(#I0040 to #I0057)

Input Module (1)
Quantity of Inputs: 8
(#I0050 to #I0057)

Input Module (2)
Quantity of Inputs: 16
(#I0030 to #I0047)

MICRO/I

MICRO/I

#I0030

#I0030
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This chapter describes the specifications, functions, and notes to observe when using external memory devices with 
the MICRO/I.

   

1.1 Supported External Memory Devices

External memory device such as the SD memory card and the USB flash drive are used on the MICRO/I interface. The 
supported external memory device is different for each MICRO/I model.

1.2 What Can Be Done Using an External Memory Device

The following functions are available when an external memory device is inserted in the MICRO/I.

*1 USB2.0
*2 This is applicable for models with an audio interface only.
*3 This is applicable for models with a video interface only.
*4 Recording sound function is for HG4G/3G only
*5 The File Copy function is not supported
*6 SD memory card for HG5G/4G/3G/2G-V, HG4G/3G and HG2G-5F, USB flash drive for HG2G-5T and HG1G/1P

Chapter 31 External Memory Devices

1 External Memory Devices

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

External Memory Device
HG5G/4G/3G/2G-V, 
HG4G/3G, HG2G-5F

HG2G-5T, HG1G/1P

SD memory card YES NO

USB flash drive*1 YES YES

Functions

HG5G/4G/3G/2G-V, 
HG4G/3G, HG2G-5F

HG2G-5T, 
HG1G/1P Reference

SD memory card USB flash drive USB flash drive

Screenshot YES NO YES
Page 8-58
Page 12-27

Alarm Log output YES NO YES Page 13-20

Data Log output YES NO YES Page 14-19

Reading/writing recipe data YES NO YES Page 18-10

Displaying picture files YES NO YES Page 2-29

Playing sound files*2 YES NO NO Page 21-7

Recording video camera images and microphone 

sounds*4.*3 YES NO NO Page 22-1

Playing movie files*3 YES NO NO Page 22-1

Transferring projects and PLC programs, copying 
files

YES YES YES*5 Page 29-1

USB Autorun function NO YES YES Page 31-22

USB Popup Screen function NO YES YES Page 31-37

Displaying Custom Web Page*6 YES YES YES Page 28-14
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1.3 Specifications of External Memory Devices

● SD memory card
Models support SD memory cards with the following specifications:

• SD memory cards: max capacity 2 GB. SDHC memory cards: 2 GB to 32 GB.

• Compatible with FAT16 or FAT32 formatting.
Note, SD memory cards with less than 2 GB of capacity must be FAT16 formatted. FAT32 formatted cards cannot 
be recognized.

• The maximum size of files that can be read and written is 256 MB.

• Character set support only for alphanumeric characters.

• File names may be up to 120 characters long. (Includes file extensions.)

• File paths may be up to 250 characters long. (Includes file extensions and drive letters.)

• Drive letters must not contain the following characters:
\ " & ( ) * + , . / : ; < > [ ]  = | ^

• File and directory names must not contain the following characters:
\ / : * ? " < > |

● USB flash drive
Models support USB flash drives with the following specifications:

• Max capacity 32 GB.

• Compatible with FAT16 or FAT32 formatted USB flash drives.

• The maximum file size that can be read and written is 256 MB.

• Character set support only for alphanumeric characters.

• File names may be up to 120 characters long. (Includes file extensions.)

• File paths may be up to 250 characters long. (Includes file extensions and drive characters.)

• Drive letters cannot contain the following characters:
\ " & ( ) * + , . / : ; < > [ ]  = | ^

• File and directory names cannot contain the following characters:
\ / : * ? " < > |

Use of IDEC, HG9Z-XMS2 SD memory card (2 GB capacity) is recommended.
Check the IDEC web site for more information about compatible SD memory cards.

Check the IDEC web site for more information about compatible USB flash drives.
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1.4 File structure

When downloading or uploading data using the System Mode on the MICRO/I, or WindO/I-NV4, the following files 
and folders are accessible. This folder is called the External Memory Device folder. For the HG5G/4G/3G/2G-V, HG4G/3G 
and HG2G-5F, the External Memory Device folder is created on the SD memory card. And for the HG2G-5T, HG1G/1P, it is 
created on the USB flash drive. By default, the External Memory Device folder name is "HGDATA01". For details, refer 
to “1.6 Setting the External Memory Device Folder” on page 31-15.

*1 This is applicable for models with an audio interface only.
*2 This is applicable for models with a video interface only.
*3 HG5G/4G/3G-V only
*4 HG4G/3G only
*5 This is possible if uploaded using the File Manager

HGDATA01 (External Memory Device folder)

HGDATA02

External Memory Device

SD memory card USB flash drive

Folder name File name Description

CAPTURE CAP[date/time].JPGs
Date/time format: YYMMDD_hhmmss

Screenshot data
(file name is assigned 
automatically)

ALARMLOG

[user-defined].CSV
Default file name

Batch: ALMHTO.CSV
Real time: ALMHTA.CSV

Alarm Log data

DATALOG

[user-defined].CSV
Default file name

Batch: LOGO**.CSV
Real time: LOGA**.CSV

Data Log data
(** corresponds to the data 
number)

OPERATIONLOG

[user-defined].CSV
Default file name

Batch: OPLOGO.CSV
Real time: OPLOGA.CSV

Operation Log data

RECIPE [user-defined].CSV
Default: RCP****.CSV

Recipe data
(*** corresponds to the recipe 
number)

PICTURE [user-defined].bmp/jpg Picture files

SOUND*1 [user-defined].wav Sound files

WEBPAGE Folders and files are created according to the file structure specified in Web 
Page Editor.

RECORD*2
[Date]  [Time].avi\ *3, [Date] \ [Time].mp4*4

Date format: YYYYMMDD
Time format: hhmmss

Movie file saved to dated folder
(Folder and file name included 
automatically)

MOVIE*2 [Custom].avi*3, [Custom].mp4*4 Movie Files

NVDATA*5 [Project name].znv ZNV Project File

LDRDATA*5 [Model + port + Station No. + date/time].zld ZLD Project File

Users can create multiple External Memory Device folders for different projects on a single external memory 
device. Note, the External Memory Device folder on the external memory device must reside on the root 
directory.

Do not alter a ZNV Project File(.znv) and a ZLD Project File(.zld). Altered files cannot be used with MICRO/
I or PLCs.
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1.5 Reading/Writing Data

● Using WindO/I-NV4 to read and write to an external memory device inserted in the MICRO/I
This procedure shows how to read and write data to the External Memory Device folder*1 specified for the project 
currently running on the MICRO/I.
Use either method below to make the connection.
• Connect a USB cable to the USB port on the computer and the USB interface on the MICRO/I.
• Connect an Ethernet cable to the Ethernet port on the computer and the Ethernet interface on the MICRO/I.

Communication settings

Follow these procedures to configure the communication device and port to allow reading and writing to the external 
memory device inserted in the MICRO/I.

1 On the Home tab, in the Project group, click Comm. Setup.

The Communication Settings dialog box appears.

2 Select MICRO/I under Communicate with.

3 Select the type of connection under Port, then click OK.

*1 SD memory card for HG5G/4G/3G/2G-V, HG4G/3G and HG2G-5F, USB flash drive for HG2G-5T and HG1G/1P

External Memory Device

MICRO/I

USB flash drive

SD memory cardComputer

USB Cable

Ethernet Cable

To USB Port To USB Interface

Mini-B PlugA Plug

To Ethernet Port To Ethernet Interface



WindO/I-NV4 User’s Manual 31-5

1 External Memory Devices

31

External M
em

ory D
evices

Downloading

This procedure shows how to download a specified file into a folder on the external memory device for the currently 
running project.

1 On the Home tab, in the Project group, click the arrow under Download.

2 Click Files to External Memory Device or Files to External Memory Device while running.

The Open dialog box appears.

■ Files to External Memory Device
This function temporarily stops the MICRO/I and then downloads files to the external memory device inserted in the 
MICRO/I. MICRO/I resumes running when files have been downloaded.

■ Files to External Memory Device while running
This function downloads files to the external memory device inserted in the MICRO/I without stopping the MICRO/I.

3 Specify the file name and click Open.

A confirmation message appears.

4 Click Yes.

The External Memory Device Maintenance dialog box appears and the file download begins.
When the download is complete, a message box appears.

If security is enabled for the project on MICRO/I, a dialog appears for you to enter a user name and 
password.
For details, refer to Chapter 23 “User Accounts and the Security Function” on page 23-1.
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5 Click OK.

6 Click Close on the External Memory Device Maintenance dialog box.
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Uploading

This procedure shows how to upload specified data from the External Memory Device folder on the external memory 
device for the currently running project.

1 On the Home tab, in the Project group, click the arrow next to Upload.

2 Click Stored Data in External Memory Device.

The Upload Data from External Memory Device dialog box appears.

3 Select the items to be uploaded, and then specify the destination folder in the Location box.

Uploadable data is as follows.
• Screenshots
• Alarm Log Files
• Data Log Files
• Operation Log Files
• Recipe Files
• Picture Files

• Sound Files*1

• Movie File List*2

• Movie Files*2

4 Click OK.

The External Memory Device Maintenance dialog box appears and the data upload begins.
A message box appears when the data upload is complete.

*1 This is applicable for models with an audio interface only.
*2 This is applicable for models with a video interface only.

If security is enabled for the project on MICRO/I, a dialog appears for you to enter a user name and 
password. For details, refer to Chapter 23 “User Accounts and the Security Function” on page 23-1.

• Click  to call up the Select a Folder dialog box and specify the destination folder for uploading.
• After starting WindO/I-NV4, screen shots, alarm log data, data log data, and recipe files can be uploaded 

from an External Memory Device folder without opening project data.
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5 Click OK.

6 Click Close on the External Memory Device Maintenance dialog box.
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● Using WindO/I-NV4 to read and write to an external memory device inserted in the computer
When using an SD memory card*1, insert it into the computer's memory card slot or via a memory card reader/writer.

When using a USB flash drive*2, insert the USB flash drive in the computer’s USB port.

Communication settings

To read and write to the external memory device inserted in the computer using WindO/I-NV4, the external memory 
device must be specified as the communication device. Configure the communication settings as follows before 
downloading or uploading.

1 On the Home tab, in the Project group, click Comm. Setup.

The Communication Settings dialog box appears.

2 Under Communicate with, select External Memory Device, then click OK.

*1 HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F only
*2 HG2G-5T, HG1G/1P only

Computer

Through an external 
memory card reader/writer

SD memory card

USB flash drive

SD memory card

To USB port

To SD memory card slot
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Downloading

This procedure shows how to download the project data to the External Memory Device folder on the external 
memory device using WindO/I-NV4.

1 Open the project data to download using WindO/I-NV4.

2 On the Home tab, in the Project group, click the icon above Download.

The Download dialog box appears.

3 Click Download.

The Select Drive dialog box appears.

4 Select the external memory device drive, then click OK.

A confirmation message appears.

■ Drive
Specify the computer's drive assigned as the external memory device drive.

■ Network
Displays the Network Drive Assignment dialog box. This dialog allows you to specify a drive on the network.

■ External Memory Device Folder
Specify the destination folder for downloading project data.

Click  to call up the Project Settings dialog box. This procedure allows you to change the External Memory Device 
folder on the external memory device where the download will be stored.
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5 Click Yes.

The Download dialog box appears and the file download begins.
When the download is complete, a message box appears.

6 Click OK.

7 Click Close on the Download dialog box.
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Uploading

This procedure shows how to upload the project data from the External Memory Device folder on the external 
memory device inserted in the computer, to the computer using WindO/I-NV4.

1 On the Home tab, in the Project group, click Upload.

The Select External Memory Device folder dialog box appears.

2 Select the external memory device drive, then click OK.

The Upload dialog box appears.

■ External Memory Device folder
Displays the folder specified in the Folder tree described next.

■ Folder
Specify the source folder for uploading the project data.

■ Drive
Specify the computer's drive assigned as the external memory device drive.

■ Network
Displays the Network Drive Assignment dialog box. This dialog allows you to specify a drive on the network.

3 Enter the location to Location, and then click Upload.

The Upload dialog box appears and the file upload begins.
When the upload is complete, a message box appears.
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4 Click OK.

5 Click Close on the Upload dialog box.

A confirmation message appears indicating the project will be opened.

6 Click OK.

The uploaded project opens.

● Manipulating files using the file management functions provided with the OS
It is possible to use Explorer or any other program provided with the Windows OS to replace the recipe data, picture 
and sound files that MICRO/I uses.
Insert the external memory device into the computer and save the new file(s) using the same name as the existing 
files in each folder under the External Memory Device folder.
For the picture files that can be used with the MICRO/I, refer to Chapter 2 “1.4 Available Image Files” on page 2-20. 
For the sound files that can be used with the MICRO/I, refer to Chapter 2 “1.5 Available Sound Files” on page 2-37.

If a password has been configured for the project data, the Enter Password screen will be displayed. 
The password to enter varies based on the check box setting of the Use Password to open a Project 
found under the Options tab in the Security dialog box.
When this check box is selected, enter the password for Use Password to open a Project.
When this check box is cleared, enter the password for the user account assigned to the Administrator 
security group.
For details, refer to Chapter 23 “User Accounts and the Security Function” on page 23-1.
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● External memory device writing timing
If the write timing setting for Alarm Log, Data Log, and Operation Log data is set to Real Time, the data is stored in 
the file output buffer once.
The writing timing from the file output buffer to the external memory device is as follows.
• Within 3 minutes of an output event to the external memory device.
• When the HMI Special Relay LSM20 for SD memory card or the HMI Special Relay LSM18 for USB flash drive or 

changes to 1.
• When switching to the System Mode.
• When downloading/uploading project data.

● SD memory card access status

Models HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F have an SD Memory Card Access Lamp (LED).
The SD Memory Card Access Lamp (LED) indicates the access status to the SD memory card. This status can also be 
read by monitoring HMI Special Internal Relay LSM21.
The SD Memory Card Access Lamp states and status descriptions of the HMI Special Internal Relay LSM21 are as 
follows.

SD Memory Card Access Lamp states

In the following events, MICRO/I writes the data in the file output buffer to the external memory device 
once, and then moves on to the next process. This creates a processing delay which can cause WindO/I-
NV4 to raise a communication error when downloading or uploading a project. If a communication error 
occurs, try downloading or uploading the project again.
• When data exists in the file output buffer
• When attempting to switch to the System Mode while reading/writing to the external memory device.
• When downloading or uploading project data.

SD memory 
card access 

status

SD Memory 
Card Access 
Lamp state

LSM21 
state

Status generation conditions Operation

Read/write access 
stopped

OFF 0
No SD memory card is inserted.
The inserted SD memory card is not supported.
The inserted SD memory card is unformatted.

The SD 
memory card 
can be 
removed.Recognizing SD 

memory card Slow blink
(ON/OFF every 
0.5 seconds)

0
When an SD memory card is inserted.
When the power is switched ON with an SD memory 
card inserted (slow blink -> ON).

Read/write access 
standing by.

1
When HMI Special Internal Relay LSM20 changes to 1.
(slow blink -> OFF)

Do not remove 
the SD 
memory card.

Read/write in 
progress

Rapid blink
(ON/OFF every 
0.2 seconds)

1

Reading/writing data to the inserted SD memory card.
(Note, the LED stays lit when reading or writing to the 
SD memory card while using the project transfer 
function, or waiting for the operating mode to 
change.)

Standby ON 1
A usable SD memory card is inserted and can be read 
or written to.

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

Operation State

At power up
OFF -> slow blink -> Lit

SD memory card is inserted.

HMI Special Internal Relay LSM20 changed to 1. Lit -> slow blink -> OFF

Data is read/written to the SD memory card
(screenshot data, etc.)

Lit -> rapid blink -> Lit (reading/writing completed)
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1.6 Setting the External Memory Device Folder

The External Memory Device folder*1 on the external memory device can be renamed using WindO/I-NV4.

1 On the Configuration tab, in the System Setup group, click Project.

The Project Settings dialog box appears.

2 On the External Memory Device tab, enter the desired name in the External Memory Device Folder text box.

Use only alphabetic characters (A to Z) and numbers (0 to 9) and the maximum is 8 characters.

3 Click OK.

*1 SD memory card for HG5G/4G/3G/2G-V, HG4G/3G and HG2G-5F, USB flash drive for HG2G-5T and HG1G/1P

It is not possible to change folder names and file names other than the External Memory Device folder.

The External Memory Device folder is named “HGDATA01” if project data has never been downloaded to the 
MICRO/I.
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1.7 Deleting Files on the External Memory Device

Files in the External Memory Device folder of the external memory device*1 inserted in the MICRO/I during operation 
can be deleted using WindO/I-NV4.

1 On the Configuration tab, in the System Setup group, click Project.
The Project Settings dialog box appears.

2 On the External Memory Device tab, select the Remove Files check box.

3 Specify the range of files to delete by checking the appropriate items.

■ All Screenshots
Deletes all files in the CAPTURE folder.

■ All Alarm Log files
Deletes all files in the ALARMLOG folder.

■ All Data Log files
Deletes all files in the DATALOG folder.

■ All Operation Log files
Deletes all files in the OPERATIONLOG folder.

4 In Trigger Device Address, specify the bit device or the bit number of the word device to serve as the condition for 
deleting files.

Click  to display the Tag Editor. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-68.

5 Click OK.

*1 SD memory card for HG5G/4G/3G/2G-V, HG4G/3G and HG2G-5F, USB flash drive for HG2G-5T and HG1G/1P

The online function in WindO/I-NV4 can also be used to delete files on the external memory device. For 
details, refer to Chapter 24 “4 Clear” on page 24-25.
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1.8 Formatting the External Memory Device

● Formatting an external memory device using the Online Function in WindO/I-NV4
The external memory device inserted in the MICRO/I can be formatted with the WindO/I-NV4 online function.
Using the WindO/I-NV4, the following external memory devices are accessible.

1 On the Online tab, in the MICRO/I group, click Format.

A confirmation message appears warning that existing data will be deleted.

2 Click Yes.

The External Memory Maintenance dialog box appears and formatting begins.

3 Click Close.

Always format the external memory device before using it.

HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F: SD memory card

HG2G-5T, HG1G/1P: USB flash drive

• In Communication Settings, Communicate with must be set to MICRO/I in advance, and Port 
must be set to USB in advance. For details on how to configure these settings, refer to “Communication 
settings” on page 31-4.

• If a project has been saved on the external memory device with security enabled, a dialog appears for 
you to enter a user name and password. For details, refer to Chapter 23 “User Accounts and the Security 
Function” on page 23-1.

After completing a format of the external memory device, the External Memory Device folder is 
automatically created when going to the Run Mode.
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● Formatting external memory device under the System Mode on the MICRO/I
External memory device inserted in MICRO/I can be formatted by using the menu in the System Mode on the MICRO/I.

1 Insert the external memory device into the MICRO/I.

2 Press and hold the upper left corner of the MICRO/I screen for 3 or more seconds.

The Maintenance Screen appears.

3 Press the System Mode.

MICRO/I switches to the Top Page in the System Mode.

4 Press the Main Menu.

The Main Menu appears.

MICRO/I

USB flash drive

SD memory card

External memory device

Press and hold 3 
or more seconds

MICRO/I

Maintenance

System Mode

Device Monitor

Adjust Brightness

If security is enabled for the project on MICRO/I, a dialog appears for you to enter a user name and 
password.
For details, refer to Chapter 23 “User Accounts and the Security Function” on page 23-1.

Run Offline Main Menu

<< >>BRIGHTNESS 31

IDEC HG G SERIES
SYSTEM MODE TOP PAGE

ENG/JPN

MAC Address  00:03:7B:F0:12:A8
IP Address  192.168.0.1(DHCP)

2010/OCT/14/THU   14:56:44
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5 Press the File Manager (HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F) or Ext.Mem.Device (HG2G-5T, HG1G/1P).

For the HG5G/4G/3G/2G-V, HG4G/3G and the HG2G-5F, File Manager appears.

For the HG2G-5T, HG1G/1P, proceed to step 7.

6 Press the source DRIVE: and select an external memory device.

Select SD Card for an SD memory card and USB memory for a USB flash drive.

7 Press FORMAT.

A confirmation message appears.

Main
Menu ------ ---

Offline Run

Initial
Setting

Clock
Setting

Top Page
Self

Diagnosis

System
Information

File
Manager

2010/OCT/14/THU  14:57:17

Main
Menu ---

File
Manager ---

▲ DEL▼ ▲

▲

RELOAD ENT COPY

DIRECTION▲

FILTER

ALL
FILTERS

DRIVE:
USB  memory

FORMAT DRIVE:
MICRO/I

FORMAT

MICROI.ZNVHGDATA01 ＜DIR＞

Main
Menu ---

File
Manager ---

▲ DEL▼ ▲

▲

RELOAD ENT COPY

DIRECTION▲

FILTER

ALL
FILTERS

DRIVE:
USB  memory

FORMAT DRIVE:
MICRO/I

FORMAT

MICROI.ZNVHGDATA01 ＜DIR＞

For the HG2G-5T, HG1G/1P, only FORMAT is displayed in the center of the screen.
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8 Press YES.

MICRO/I starts formatting the external memory device.
When formatting is completed, “The format completed.” is displayed.

YES NO

Format USB Flash Drive ?
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1.9 Precautions

• For projects that use external memory devices, always insert the external memory device before turning the 
MICRO/I on.

• The maximum number of screenshots that can be captured can be set in HMI Special Data Register LSD65.

• External memory devices have a limitation on the number of writes allowed. 
Regularly backup data on the external memory device.

• Never turn the power off to the MICRO/I or remove the external memory device while reading/writing to it. 
Otherwise, the data on the external memory device may be destroyed. Should this occur, reformat the external 
memory device.

• When external memory device is inserted into the MICRO/I, first perform the following operations, and then turn 
off the power to the MICRO/I or remove the external memory device.

• When a read or write failure occurs with the external memory device, HMI Special Data Register LSD42 for an SD 
memory card and HMI Special Data Register LSD33 for a USB flash drive are set with the error status. For details 
about the error, refer to Chapter 33 “HMI Special Data Register (LSD)” on page 33-7. Manually delete the files by 
using a computer or the File Manager function.

•  If an unusable external memory device is inserted, the following error message appears.

• If your computer does not have an SD memory card slot, an external memory card reader is required to read/write 
to the SD memory card.

• Multiple USB flash drives cannot be used at the same time.

• Do not connect the USB flash drive to the MICRO/I through a USB hub.

• The message “Stopping external memory” appears while reading or until writing stops.
To resume reading or writing to the external memory device, re-insert it.

• Altering folders and files in the External Memory Device folder on the external memory device will make the 
external memory device unusable in MICRO/I and WindO/I-NV4.

SD memory card: After setting HMI Special Relay LSM20 to 1, check that HMI Special Relay LSM21 is 0.

USB flash drive: After setting HMI Special Relay LSM18 to 1, check that HMI Special Relay LSM19 is 0.

SD memory card: This SD memory card not available.

USB flash drive: This USB isn't available.
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2.1 Overview of the USB Autorun Function

The USB Autorun function automatically displays a menu screen from which the user can execute predefined 
commands when a USB flash drive is inserted into the MICRO/I.

The commands that can be executed with the USB Autorun function are as follows.

● Downloading a project (ZNV Project File)
Downloads a ZNV Project File(.znv) saved on a USB flash drive or an SD memory card*1 to the MICRO/I.

When the download is complete, the MICRO/I will reset and start running from the beginning of the project that was 
just downloaded.

*1 HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F only

2 USB Autorun Function

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

USB Autorun Function Menu Screen

USB flash drive

Production line A - replace 
MICRO/I program

Copy MICRO/I program to USB 
flash drive

Replace sound data Copy PLC program to USB 
flash drive

Production line A - replace 
PLC program Run All Cancel

Confirmation

Press the command to execute.USB Autorun 
definition file
(hgauto.ini)

MICRO/I

• This allows operators to change project and PLC programs without using a computer.
• These defined processes are called commands, and the file that contains the details of the command and 

menu screen is called the USB Autorun definition file (hgauto.ini).
• A USB Autorun definition file (hgauto.ini) must be stored on the USB flash drive to use the USB Autorun 

function.
• For the HG5G/4G/3G/2G-V, HG4G/3G and the HG2G-5F, an SD memory card can be used as the 

destination for saving ZNV Project File(.znv), ZLD Project File(.zld), and for copying files.

Save

Save

Download

Computer

SD memory card

USB flash drive
MICRO/I

USB Autorun 
definition file
(hgauto.ini)

ZNV Project File
(.znv) ZNV Project File

(.znv)

Refer to Chapter 29 “1 Project Transfer Function” on page 29-1 for important notes and limitations.



WindO/I-NV4 User’s Manual 31-23

2 USB Autorun Function

31

External M
em

ory D
evices

● Uploading a project
Uploads the project used to operate the MICRO/I and saves it to a USB flash drive or an SD memory card*1.

When the upload is complete, the MICRO/I will reset and start over at the beginning of the project.

● Downloading a PLC program (ZLD Project File)
Downloads a ZLD Project File(.zld) saved on a USB flash drive or an SD memory card*1 to the PLC connected to the 
MICRO/I.

● Uploading a PLC program
Uploads the PLC program from the PLC connected to the MICRO/I and saves it as ZLD Project File(.zld) to a USB flash 

drive or an SD memory card*1.

*1 HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F only

Save Upload

Computer

ZNV Project File
(.znv)

USB Autorun 
definition file
(hgauto.ini)

SD memory card

USB flash drive
MICRO/I

Refer to Chapter 29 “1 Project Transfer Function” on page 29-1 for important notes and limitations.

Save

Save

Download

PLCComputer

SD memory card

USB flash drive
MICRO/I

ZLD Project File
(.zld)

ZLD Project File
(.zld)

USB Autorun 
definition file
(hgauto.ini)

Refer to Chapter 29 “2 PLC Program Transfer Function” on page 29-16 for compatible PLCs, important notes, 
and limitations.

Save Save Upload
PLCComputer

ZLD Project File
(.zld)

USB Autorun 
definition file
(hgauto.ini)

SD memory card

USB flash drive
MICRO/I

Refer to Chapter 29 “2 PLC Program Transfer Function” on page 29-16 for compatible PLCs, important notes, 
and limitations.
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● Copy files

Copies files between the USB flash drive and SD memory card inserted in the MICRO/I.
Files can be copied in the USB flash drive or the SD memory card.

USB flash drive -> SD memory card
Copies files saved on the USB flash drive to the SD memory card inserted in the MICRO/I.

SD memory card -> USB flash drive
Copies files saved on the SD memory card inserted in the MICRO/I to the USB flash drive.

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

HG3G HG2G-5FHG4G
HG5G-V HG4G-V HG3G-V HG2G-V

Save Copy

Computer

USB Autorun 
definition file
(hgauto.ini)

File File

SD memory cardUSB flash drive MICRO/I

HG3G HG2G-5FHG4G
HG5G-V HG4G-V HG3G-V HG2G-V

Save Copy

Computer

USB Autorun 
definition file
(hgauto.ini)

SD memory cardUSB flash drive MICRO/I

File

Refer to Chapter 29 “3 File Copy Function” on page 29-30 for important notes and limitations.
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2.2 USB Autorun Function Configuration Procedure

● Executing commands using the USB Autorun function

Configuration Procedure

1 On the Configuration tab, in the System Setup group, click Project.

The Project Settings dialog box appears.

2 On the Autorun tab, select the Enable USB Autorun check box and click OK.

For details, refer to Chapter 4 “3.10 Autorun Tab” on page 4-62.

3 Create a USB Autorun definition file (hgauto.ini) and save it on the USB flash drive.

For details, refer to “2.3 Creating a USB Autorun Definition File” on page 31-28.

• If the USB Autorun function of the MICRO/I is not enabled, the menu screen will not be displayed, even if 
a USB flash drive is inserted into the MICRO/I.

• Once the USB Autorun function of the MICRO/I is enabled, the function will remain enabled until either a 
project with the Enable USB Autorun check box unchecked is downloaded, or the function is disabled 
via the System Mode.

When enabling the USB Autorun function using the MICRO/I, on the Top Page in the System Mode, press 
Main Menu, Initial Setting, System Operation (for HG4G/3G/2G-5F) or System Op. (for HG2G-5T, 
HG1G), and then press Autorun.

Save

Computer
USB flash drive

USB Autorun 
definition file
(hgauto.ini)
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4 Prepare the necessary files and store them on the USB flash drive or SD memory card.

If the necessary files are stored on an SD memory card, make sure to insert it into the MICRO/I before using it for 
uploading or copying.

The necessary files are as follows.

• To download a project (ZNV Project File)
Create a ZNV Project File(.znv).
For details, refer to Chapter 29 “1.3 Converting Project for Transfer” on page 29-3.

• To download an IDEC PLC program
Create a ZLD Project File(.zld).
For details, refer to Chapter 29 “2.4 Creating ZLD Project File” on page 29-18.

• To copy files
Create the file to be copied.

Operating Procedure

1 Insert the USB flash drive into the MICRO/I.

The menu for the USB Autorun function appears.

Save

Computer

ZNV Project File
(.znv)

ZLD Project File
(.zld)

File

Copy filesOnly when downloading

SD memory card

USB flash drive

USB flash drive MICRO/I

If the menu screen does not appear, follow these troubleshooting tips. Correct the problem and re-insert 
the USB flash drive.

Cause: USB Autorun definition file (hgauto.ini) does not exist on the USB flash drive.

Correction: Create a USB Autorun definition file and save it on the USB flash drive. For details, refer to 
“2.3 Creating a USB Autorun Definition File” on page 31-28.

Cause: The USB Autorun definition file (hgauto.ini) contains an error.

Correction: For details, refer to “2.3 Creating a USB Autorun Definition File” on page 31-28.

Cause: The USB Autorun function is disabled in the MICRO/I settings.

Correction: Enable the USB Autorun function by referring to Steps 1 and 2 on page 31-25.
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2 Press the command to execute.

The command executes.

3 When the command finishes executing, a screen appears indicating the execution result.

Press Ack to close the execution result screen and display the menu screen.

Production line A - replace 
MICRO/I program

Copy MICRO/I program to USB 
flash drive

Replace sound data Copy PLC program to USB 
flash drive

Production line A - replace 
PLC program Run All Cancel

Confirmation

Press the command to execute.

• Pressing Run All causes all commands defined in the USB Autorun definition file (hgauto.ini) to execute 
one by one.

• If security is enabled for the project on MICRO/I, a dialog appears for you to enter a user name and 
password.
For details, refer to “2.4 USB Autorun Function Security” on page 31-36.

• When uploading or downloading IDEC PLC program to a password-protected PLC, a dialog appears for 
you to enter the password.

Do not remove the USB flash drive or SD memory card while command is executing.

Production line A - replace 
MICRO/I programFunction

The following function completed

Ack

Result

If a command executes with a button (except the Run All), the menu screen is displayed after pressing Ack 
on the execution result dialog.
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2.3 Creating a USB Autorun Definition File

The menu screen that appears when a USB flash drive inserted in the MICRO/I is defined in the USB Autorun 
definition file.
The USB Autorun definition file is created using the following methods.

• Created with the USB Autorun definition file creation tool
 Refer to USB Autorun Definition File Creation Tool manual.

• Created with the text editor
 Refer to “Created using the text editor” on page 31-28.

● Created using the text editor
You create this file using Notepad or any commercially available text editor. Fill in the items in each section and save 
the file with the name “hgauto.ini”.

The USB Autorun definition file has these 3 sections.
Enter the items and definitions for each section.

[AUTORUN] section (required)
Specify the number of command items, enable/
disable the buttons, and the display language to use.

[AUTORUN]
item = 5
button_command = Enable
button_runall = Enable
language = English

[COMMAND] section (required)
Specify the command to execute and its parameters.
Create buttons to execute the number of commands 
specified in the [AUTORUN]: section from 
[COMMAND_1] to [COMMAND_5], in that order.

[COMMAND_1]
command = PRO_DOWNLOAD
src_path = "B:\NV4DATA\HG_PROJECT.ZNV"
reset_keep_device = Enable
title = "Production line A - replace MICRO/I program"
······
[COMMAND_5]
command = LDR_UPLOAD
dst_path = "B:\Uploaded_Program"
src_port = COM1
src_net_no = 0
title = "Copy PLC program to USB flash drive"

[COMMENT] section
Enter text to display, as necessary, at the bottom of 
the menu screen.

[COMMENT]
comment = "Press the command to execute."

Production line A - replace 
MICRO/I program

Copy MICRO/I program to USB 
flash drive

Replace sound data Copy PLC program to USB 
flash drive

Production line A - replace 
PLC program Run All Cancel

Confirmation

Press the command to execute.

[COMMAND_1] 
execution button

[COMMAND_4] 
execution button

[COMMAND_5] 
execution button

Button to close 
the menu screen

Execution button for all commands

[COMMAND_2] 
execution button

[COMMAND_3] 
execution button

Displays text entered 
in [COMMENT]
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[AUTORUN] section

■ item (required)
Specify the number of commands used from 1 to 5. The USB Autorun function will fail to execute if a value other than 
1 to 5 is specified.

■ button_command

■ button_runall

■ language

[COMMAND] section

■ command (required)

Specify whether to enable/disable the execution buttons for [COMMAND_1] to [COMMAND_5].
Enable: enables the button.
Disable: disables the button.

If this item is left blank or contains an illegal value, the MICRO/I assumes “Enable”.

Specify whether to enable/disable the execution buttons for Run All.
Enable: enables the button.
Disable: disables the button.

If this item is left blank or contains an illegal value, the MICRO/I assumes “Enable”.

Specify the language to use for the button labels and messages.
Japanese: Shift-JIS
European: English
Chinese: GB2312
Taiwanese: BIG5
Korean
Central European
Baltic
Cyrillic

If this item is left blank or contains an illegal value, the MICRO/I assumes “Japanese”.

For the HG2G-5T, HG1G, only the USB flash drive is available.

Specify the command to execute.
PRO_DOWNLOAD: Download a project (ZNV Project File)
PRO_UPLOAD: Upload a project
LDR_DOWNLOAD: Download a PLC program (ZLD Project File)
LDR_UPLOAD: Upload a PLC program
FILE_COPY: Copy a file
The items required differ for each command except for the “title” item.
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command = PRO_DOWNLOAD

■ src_path (required)
Specify the path (250 or less characters) where the project file is to be downloaded.
Use “A:\” for an SD memory card and “B:\” for a USB flash drive.

■ reset_keep_device
Specify whether to initialize the keep devices or not when the project file is downloaded. However, when project data 
that changes the settings of the data storage area is downloaded, the keep devices are always initialized.

command = PRO_UPLOAD

■ dst_path (required)
Specify the path to the folder (250 or less characters) where the uploaded project will be saved.
Use “A:\” for an SD memory card and “B:\” for a USB flash drive.

command = LDR_DOWNLOAD

■ src_path (required)
Specify the path (250 or less characters) where the ZLD Project File is to be downloaded.
Use “A:\” for an SD memory card and “B:\” for a USB flash drive.

■ dst_port (required)
Specify the name of the MICRO/I port to which the PLC to download from is connected. For details about the port 
name, refer to Chapter 4 “Interface Configuration” on page 4-35.

■ dst_net_no (required when specifying the destination as a slave number or External Device ID)
If the communication interface that connects the PLC for downloading is the serial interface, specify the slave number. 
If the communication interface is the Ethernet interface, specify the External Device ID. Specify the same number set 
as the slave number or External Device ID for the PLC.

■ dst_plc_ip (required when specifying the destination as an IP address)
Specify the IP address of the download destination PLC.
Example: dst_plc_ip = 192.168.0.1

Enable: Initializes the keep devices.
Disable: Does not initialize the keep devices.

If you download the project data, Alarm Log data, Operation Log data, and Data Log data is erased 
regardless of the reset_keep_device.

If this item is left blank or contains an illegal value, the MICRO/I assumes "Enable".

COM1: The name of the serial interface varies based on the model.
HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F: COM1
HG2G-5T: SERIAL1(RS232C)
HG1G: COM(RS232C)

COM2: The name of the serial interface varies based on the model.
HG5G/4G/3G/2G-V: COM2(RS232C) or COM2(RS422/485)
HG4G/3G, HG2G-5F: COM2
HG2G-5T: SERIAL1(RS422/485)
HG1G/1P: COM(RS422/485)

ETHER: Ethernet interface (LAN)
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■ dst_plc_port
Specify the port number of the download destination PLC.
Example: dst_plc_port = 2101

command = LDR_UPLOAD

■ dst_path (required)
Specify the path to the folder (250 or less characters) where the uploaded PLC program will be saved.
Use “A:\” for an SD memory card and “B:\” for a USB flash drive.

■ src_port (required)
Specify the name of the MICRO/I port to which the PLC to upload from is connected. For details about the port name, 
refer to Chapter 4 “Interface Configuration” on page 4-35.

■ src_net_no (required when specifying the destination as a slave number or External Device ID)
If the communication interface that connects the PLC for uploading is the serial interface, specify the slave number. If 
the communication interface is the Ethernet interface, specify the External Device ID. Specify the same number set as 
the slave number or External Device ID for the PLC.

■ src_plc_ip (required when specifying the destination as an IP address)
Specify the IP address of the upload source PLC.
Example: src_plc_ip = 192.168.0.1

■ src_plc_port
Specify the port number of the upload source PLC.
Example: src_plc_port = 2101

When specifying the destination as an IP address and this item is left blank or contains an illegal value, the 
MICRO/I assumes that the value is "2101". This item is not required when specifying the destination as a 
slave number or External Device ID.

COM1: The name of the serial interface varies based on the model.
HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F: COM1
HG2G-5T: SERIAL1(RS232C)
HG1G: COM(RS232C)

COM2: The name of the serial interface varies based on the model.
HG5G/4G/3G/2G-V: COM2(RS232C) or COM2(RS422/485)
HG4G/3G, HG2G-5F: COM2
HG2G-5T: SERIAL1(RS422/485)
HG1G/1P: COM(RS422/485)

ETHER: Ethernet interface (LAN)

When specifying the destination as an IP address and this item is left blank or contains an illegal value, the 
MICRO/I assumes that the value is "2101". This item is not required when specifying the destination as a 
slave number or External Device ID.
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command = FILE_COPY

■ src_path (required)
Specify the path (250 or less characters) of a source file or folder to copy.
Use “A:\” for an SD memory card and “B:\” for a USB flash drive.

■ dst_path (required)
Specify the destination path in 250 or less characters.
Use “A:\” for an SD memory card and “B:\” for a USB flash drive.

Common items

■ title
Enter a title for the button label. The maximum number is as follows.

• A line feed will automatically be added and it can be added where desired. When added in a desired location, \n will 
be inserted automatically and is thus calculated as 2 single-byte characters.

• When using a semicolon (;), backslash (\), or double quotations ("), an escape character (\) will be automatically 
inserted before those characters and will thus be calculated as 2 single-byte characters.

[COMMENT] section

■ comment
Enter a message shown at bottom of the menu screen. The maximum number is as follows.

• A line feed will automatically be added but can be added where desired. When added in a desired location, \n will 
be inserted automatically and is thus calculated as 2 single-byte characters.

• When using a semicolon (;), backslash (\), or double quotations ("), an escape character (\) will be automatically 
inserted before those characters and will thus be calculated as 2 single-byte characters.

Notes on comments

To add comments to the USB Autorun definition file, use a semicolon (;).
All text after the semicolon (;) and up to the line feed will be treated as a non-executable comments.

Restrictions

• The maximum number of characters per line is 512 single-byte characters including line feed codes.
All the text on the line will be ignored if there are more than 512 single-byte characters on the line.

• Each item must be described as a single line. If a line feed occurs before the end of the description, all characters 
after the line feed are ignored.

• The maximum size of the USB Autorun definition file (hgauto.ini) is 512 KB. The file cannot be used if it exceeds 
this limit.

• Only line feed codes of the format generally supported by Windows (CR+LF) are supported. If any other format is 
used, the USB Autorun definition file (hgauto.ini) will fail to run properly.

• If a file name is specified as the source path name, the specified file is copied.
If a folder name is specified, all of the files and subfolders contained in the folder, and all of the files in 
the subfolders, are copied.

• The subfolders can be copied up to five levels.
• To prevent copying the subfolders and the files contained in the subfolders, HMI Special Internal Relay 

LSM30 must be set to 1 before executing the copy.
• To stop copying files during the copy operation, write 1 to HMI Special Internal Relay LSM31. However, it 

will continue to copy the file until it is finished then it will stop copying.

HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F: 2 lines of 26 characters (total 52 characters)
HG2G-5T, HG1G/1P: 2 lines of 14 characters (total 28 characters)

HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F: 6 lines of 54 characters (total 324 characters)
HG2G-5T, HG1G/1P: 3 lines of 29 characters (total 87 characters)
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Sample definition file and explanation

Sample definition

; sample hgauto.ini

(1)

[AUTORUN]
item = 5 ; number of items
button_command = Enable ; enable individual command buttons
button_runall = Enable : enable the "Run All" button.
language =English ; use English

(2)

[COMMAND_1]
command = PRO_DOWNLOAD ; download a ZNV Project File
src_path = "B:\HG3G_DEMO_1.ZNV" ; source path
reset_keep_device = Enable ; initialize the keep devices
title = "Production line A - replace MICRO/I program" ; button label

(3)

[COMMAND_2]
command = FILE_COPY ; copy a file
src_path = "B:\Error.wav" ; source path
dst_path = "A:\HGDATA01\SOUND" ; destination path
title = "Replace sound data" ; button label

(4)

[COMMAND_3]
command = LDR_DOWNLOAD ; download a ZLD Project File
src_path = "B:\LDRDATA\LDR_PROGRAM.ZLD" ; source path
dst_port = COM1 ; destination port number
dst_net_no = 0 ; destination slave number
title = "Production line A - replace PLC program" ; button label

(5)

[COMMAND_4]
command = PRO_UPLOAD ; upload a project
dst_path = "B:\Uploaded_Project" ; destination path
title = "Copy MICRO/I program to USB flash drive" ; button label

(6)

[COMMAND_5]
command = LDR_UPLOAD ; Upload a PLC program
dst_path = "B:\Uploaded_Program" ; destnation path
src_port = COM1 ; source port number
src_net_no = 0 ; source slave number
title = "Copy PLC program to USB flash drive" ; button label

(7)
[COMMENT]
comment = " Press the command to execute." ; Message shown at bottom of screen.
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Explanation

(1) This definition file displays five command execution buttons on the menu screen displayed by the USB Autorun 
function. It also enables the Run All button. All button labels and messages are displayed in English.

(2) Downloading a ZNV Project File from a USB flash drive to the MICRO/I.

(3) Copying a sound file from a USB flash drive to an SD memory card.

(4) Downloading a ZLD Project File from the USB flash drive to the PLC connected to the MICRO/I.

(5) Uploading a project to a USB flash drive.

[AUTORUN]
Defines the number of commands to use and details about the menu 
screen.

item = 5 Specifies that five commands will be used.

button_command = Enable
Enables execution buttons for each command from [COMMAND_1] 
to [COMMAND_5].

button_runall = Enable Enables the Run All button.

language = English Displays all button labels and messages in English.

[COMMAND_1]
Defines the command assigned to execution button [COMMAND_1]. 
This is the first command that executes when Run All is pressed.

command = PRO_DOWNLOAD Executes “Download a project (ZNV Project File)”.

src_path = "B:\HG3G_DEMO_1.ZNV"
Downloads the ZNV Project File “HG3G_DEMO_1.ZNV” saved on the 
USB flash drive (B:) to the MICRO/I.

reset_keep_device = Enable Initializes the keep devices.

title = "Production line A - replace MICRO/I 
program"

Displays the text “Production line A - replace MICRO/I program” as 
the button label.

[COMMAND_2]
Defines the command assigned to execution button [COMMAND_2]. 
This is the second command that executes when Run All is 
pressed.

command = FILE_COPY Executes “File Copy”.

src_path = "B:\Error.wav" Copies the sound file “Error.wav”, saved on the root directory of the 
USB flash drive (B:), to the “SOUND” folder under “HGDATA01” on 
the SD memory card (A:) inserted in the MICRO/I.dst_path = "A:\HGDATA01\SOUND"

title = "Replace sound data" Displays the text “Replace sound data” as the button label.

[COMMAND_3]
Defines the command assigned to execution button [COMMAND_3]. 
This is the third command that executes when Run All is pressed.

command = LDR_DOWNLOAD Executes “Download a PLC program (ZLD Project File)”.

src_path = "B:\LDRDATA\LDR_PROGRAM.ZLD"
Downloads the ZLD Project File “LDR_PROGRAM.ZLD” stored in the 
“LDRDATA” folder of the USB flash drive (B:) to the PLC (slave 
number 0) connected to the MICRO/I's COM1 port.

dst_port = COM1

dst_net_no = 0

title = "Production line A - replace PLC program"
Displays the text “Production line A - replace PLC program” as the 
button label.

[COMMAND_4]
Defines the command assigned to execution button [COMMAND_4]. 
This is the fourth command that executes when Run All is pressed.

command = PRO_UPLOAD Executes “Upload a project”.

dst_path = "B:\Uploaded_Project"
Uploads the project used to operate the MICRO/I and saves it as the 
ZNV Project File in the folder “Uploaded_Project” on the USB flash 
drive (B:).

title = "Copy MICRO/I program to USB flash 
drive"

Displays the text “Copy MICRO/I program to USB flash drive” as the 
button label.
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(6) Uploading a PLC program to a USB flash drive.

(7) Displays messages below the menu screen for the USB Autorun function.

[COMMAND_5]
Defines the command assigned to execution button [COMMAND_5].
This is the fifth command that executes when Run All is pressed.

command = LDR_UPLOAD Executes “Upload a PLC program”.

dst_path = "B:\Uploaded_Program" Uploads the PLC program running on the PLC (slave number 0) 
connected to the MICRO/I's COM1 port, and saves it as the ZLD 
Project File in the folder “Uploaded_Program” on the USB flash drive 
(B:).

src_port = COM1

src_net_no = 0

title = "Copy PLC program to USB flash drive"
Displays the text “Copy PLC program to USB flash drive” as the 
button label.

[COMMENT]
Defines the number of commands to use and details about the 
menu screen.

comment = "Press the command to execute."
Displays the text “Press the command to execute.” below the menu 
screen.
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2.4 USB Autorun Function Security

If security has been enabled for the MICRO/I project, MICRO/I displays a password entry dialog box when the USB 
Autorun function runs.

Select the user name from the security group that has command execution permissions, enter the password, and 
press ENT.

● Execution privileges by security groups
The commands that can be executed differ depending on the security group.

■ Example 1: If these two commands are used in the USB Autorun definition file (hgauto.ini).
Downloading a project (ZNV Project File)
Copying files (SD memory card to USB flash drive)
The types of user accounts required to execute these commands is given below.

■ Example 2: If the USB Autorun definition file (hgauto.ini) only contains the file copy command (SD 
memory card -> USB flash drive)

A user account from the Administrator, Operator, or Reader security group is required.

Enter the appropriate password
for Data Transfer Function

CAN

User

A B C D E F

G H I J K L

CLR
M N O P Q R

S T U V W X

ENT
Y Z 0 1 2 3

4 5 6 7 8 9

Password

Command
Security Group

Administrator Operator Reader

Downloading a project (ZNV Project File) YES NO NO

Uploading a project YES NO NO

Downloading a PLC program (ZLD Project File) YES NO NO

Uploading a PLC program YES NO NO

Copying files (USB flash drive to SD memory card) YES YES NO

Copying files (SD memory card to USB flash drive) YES YES YES

Downloading a project: Administrator

File copying (SD memory card to USB flash drive): Administrator, Operator, or Reader

Pressing the Run All button: Administrator

The password for the command with the highest security level listed in the USB Autorun definition file 
(hgauto.ini) must be entered to execute all commands by pressing the Run All button. In the example 
above, a user account from the Administrator security group is required.

If operator presses CAN instead of entering a password, no commands are executed and the menu screen 
closes. To re-execute the USB Autorun function, insert the USB flash drive again.
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The USB Popup Screen function displays a specific screen by simply inserting a USB flash drive in the MICRO/I.
This provides an easy way to display a message when the operator inserts a USB flash drive.

3.1 Automatically Displaying a Popup Screen when a USB Flash Drive is Inserted

● Configuration Procedure

1 On the Configuration tab, in the System Setup group, click the Project.

The Project Settings dialog box appears.

2 On the Autorun tab, select the Open Popup Screen when USB flash drive is inserted check box.

3 Specify the Screen Number of the Popup Screen to display, and the Coordinates, then click OK.

For details, refer to Chapter 4 “3.10 Autorun Tab” on page 4-62.

3 USB Popup Screen Function

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P
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● Operating Procedure
Insert the USB flash drive into the MICRO/I.

The Popup Screen appears.

USB flash drive MICRO/I

MICRO/I

USB flash drive was inserted.Popup Screen

If security is enabled for the Popup Screen that is displayed by the USB Popup Screen function, a dialog 
appears for you to enter a user name and password.
For details, refer to “2.4 USB Autorun Function Security” on page 31-36.

When the USB Popup Screen function is enabled, if the USB flash drive contains a definition file (hgauto.ini) 
for use with the USB Autorun function, both functions will appear on the menu screen.
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This chapter describes the functions of the MICRO/I when using a printer, and how to connect it.

  

1.1 Functions Available with the Printer

These functions are available when a printer is connected to the MICRO/I.

• Printing screenshots
 Refer to Chapter 8 “4 Print Button” on page 8-56, and Chapter 12 “4 Print Command” on page 12-25.

• Printing alarm logs (Batch)
 Refer to Chapter 13 “Alarm Log Function” on page 13-1.

1.2 Connecting a Printer to MICRO/I

Connect the USB interface (USB1) on the MICRO/I and the USB port on the printer with a USB cable.

1.3 Supported Printers

The following printers can be used.

Chapter 32 Printer

1 Functions and Connections

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

HG3G HG2G-5FHG4G

HG5G-V HG4G-V HG3G-V HG2G-V

(USB1)

Printer

USB cable

To USB portTo USB interface

Mini-B plug A plug

MICRO/I

• Do not disconnect the cable between the MICRO/I and printer while printing.
• Do not use a USB hub when connecting to the printer with a USB cable.
• Printed images may appear differently depending on the printer used. Always check the image by 

printing an actual image.

Control codes/Manufacturer/Standard Supported printers

PictBridge Printers certified with the PictBridge logo

Always test any printer not listed in the above chart before using it.
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2.1 Setting the Printer

When printing, specify printer settings such as; paper size and ink color on the Printer tab of the Project Settings 
dialog box.
For details, refer to Chapter 4 “3.8 Printer Tab” on page 4-60.

2.2 Monitoring the Printer

To monitor the status of the printer, use the System Area.
For details, refer to Chapter 4 “System Area 2” on page 4-31.

■ Printer busy
When the printer is printing, bit 3 at the system area address number +3 will turn ON.

■ Printer timeout error
If an error occurs while the printer is printing, bit 9 at the system area address number +2 will turn ON.

2 Setting and Monitoring the Printer

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

• If the printer does not support the paper size selected on the Printer tab in the Project Settings dialog 
box, printing is performed with the paper size selected in the printer's settings.
When the edge of the data is not printed, enable No Trimming and Bordered in the printer's settings.
The color cannot be configured. To print in monochrome, configure the print color on the printer that is 
used.

• When connecting the MICRO/I to a printer, an error may occur on the printer side as an unsupported 
device, but data is sent that satisfies the PictBridge standard when printing, so it can be printed correctly.
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This chapter describes internal devices.

The MICRO/I includes an internal HMI device to control HMI functions, and control device*1 for control functions.

    

1.1 HMI Device Addresses

■ HMI Internal Relay (LM)
This is a bit-unit device. It can store 2,048 addresses.

■ HMI Keep Relay (LK)
This is a bit-unit device that holds the values of device. The value of this device can be set to 0 by clearing the project 
data download option or online function, or it becomes 0 if the backup battery is drained. The maximum number of 
HMI Keep Register depends upon the number set in WindO/I-NV4. For details, refer to Chapter 16 “Minimum and 
Maximum Amount of Data Storage and Number of Addresses” on page 16-2.

■ HMI Timer Relay (LTC)
The HMI Timer is a bit-unit device that can be changed to 1 in value of device switched by the Timer from Parts. It 
can store 32 addresses.

■ Digital Input (LEX), Digital Output (LEY)
Digital input/output relay for expansion module connected to HG4G/3G and HG2G-5F.
For details, refer to Chapter 30 “2.1 Using Digital I/O Modules” on page 30-12.

■ HMI Temporary Relay (LBM)
This is a bit-unit device for temporarily storing values. The value of this device switches between screens and text 
groups and user accounts, and it becomes 0 if the screen is reset. It can store 128 addresses.

■ HMI Expansion Input (LI), HMI Expansion Output (LQ)
Input or output bit devices used with HG1P. For details, refer to Chapter 35 “Function Keys” on page 35-
63. LIC to LID and LQ0 to LQ1 are reserved areas.

*1 HG5G/4G/3G/2G-V only
*2 HG4G/3G, HG2G-5F only
*3 HG1P only

Chapter 33 Internal Devices

1 Bit Devices

Internal Device Name Symbol R/W Address Range Base

HMI Internal Relay LM R/W 0 to 2047 10

HMI Keep Relay LK R/W Variable 10

HMI Timer Relay LTC R 0 to 31 10

Digital Input (Bit)*2 LEX R 0 to 77 8

Digital Output (Bit)*2 LEY R/W 0 to 77 8

HMI Temporary Relay LBM R/W 0 to 127 10

HMI Expansion Input (Bit)*3 LI R 0 to D 16

HMI Expansion Output (Bit)*3 LQ R/W 0 to 1 16

HMI Special Internal Relay LSM R/W 0 to 95 10

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

R/W is an abbreviation of Read/Write. R/W indicate that both reading and writing are possible, while R 
indicates that only reading is possible.
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■ HMI Special Relay (LSM)
A specific function is assigned for each of the 96 special internal relay (LSM0 to LSM95). 

*1 HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F only
*2 HG2G-5T, HG1G/1P only
*3 This is applicable for models with an audio interface only.

Device Address Function/Part
LSM0 Normally set to 1.

LSM1
When Base Screen is switched, a value of this bit is 1 only on the second scan.
It also operates when switching text group or user account, or resetting the display screen.

LSM2
When Base Screen is switched, a value of this bit is 1 only on the first scan.
It also operates when switching text group or user account, or resetting the display screen.

LSM3
When Base Screen is switched, the value of this bit is 0 only on the first scan.
It also operates when switching text group or user account, or resetting the display screen.

LSM4 Alternates between 0 and 1 with each scan.
LSM5 When Popup Screen is opened, a value of this bit is 1 only on the first scan.
LSM6 While touch panel is pressed, a value of this bit is 1.

LSM7
Alternates between 0 and 1 each time data is read (read scan) from all external device addresses being 
used by External Device Communication 1.

LSM8
When the power is turned ON, then a value of this bit is 1. When switching to another screen from the 
default screen or when switching text group or user account, then the value is 0.

LSM9
When value changes from 0 to 1, the backup data stored in flash memory is restored.
When it becomes 1 value does not become 0 until the Touch is reset or 0 is written.

LSM10
When switched from 0 to 1, the current backlight setting and the data for Keep Relays and Keep Register 
configured in the Data Storage Area are transferred to the flash memory.
Once LSM10 switches to 1, it does not change to 0 until MICRO/I recycles power or 0 is written to LSM10.

LSM11
Changes from 0 to 1 when the Base Screen is switched, after the values of all external device addresses 
being used are read, and remains 1 until there is a switch to another screen.
It also operates when switching text group or user account, or resetting the display screen.

LSM12 When Popup Screen is closed, a value of this bit is 1 only on the first scan.

LSM13
Value becomes 0 when Popup Screen is opened, and then changes from 0 to 1 after the values of all 
external device addresses being used by that Popup Screen are read. 

LSM14 to 17 Reserved

LSM18
When value changes from 0 to 1, access to USB flash drive is stopped. The access state can be checked 
with the value of LSM19.
When it becomes 1 value does not become 0 until the MICRO/I is reset or 0 is written.

LSM19 Bit is 1 during USB flash access. When 0, the USB flash can be removed.

LSM20*1 Access to the SD memory card stops when this bit is switched from 0 to 1. The access state can be 
checked with the value of LSM21.

LSM21*1 Bit is 1 during SD memory card access. When 0, the SD memory card can be removed.

LSM22
This is the Operation Log function. When data in excess of the amount that can be recorded in one 
operation occurs, the value becomes 1. 
When it becomes 1 value does not become 0 until the MICRO/I is reset or 0 is written.

LSM23*1 This bit is 1 while copied.

LSM24*1 This bit is 1 while writing the data to the SD memory card.

LSM25*2 This bit is 1 while writing the data to the USB flash drive.

LSM26 Reserved

LSM27*3 Stops playing the sound file when this bit is turned from 0 to 1.

LSM28 to 29 Reserved

LSM30
If a value of this bit is 0, all files (including the subfolders with files) under the source folder will be copied 
to the destination folder. If the value is 1, only the files (excluding the subfolders with files) under the 
source folder will be copied to the destination folder.

LSM31
If a value of this bit changes from 0 to 1, file copy process is terminated. If a value of this bit changes 
from 0 to 1 while copying the files, MICRO/I will stop the file copy function after copying the current file. 
If this value is 1, file copy function is not executed.

LSM32 Reserved



WindO/I-NV4 User’s Manual 33-3

1 Bit Devices

33

Internal D
evices

*4 HG5G/4G/3G/2G-V only

Device Address Function/Part

LSM33
When the amount of data for parts placed on the top layer exceeds the upper limit, then the value of this 
bit is 1. This bit remains at a value of 1 until the MICRO/I is reset or 0 is written, then the value is 0.

LSM34 to 41 Reserved

LSM42
Alternates between 0 and 1 each time data is read (read scan) from all external device addresses being 
used by External Device Communication 2.

LSM43
Alternates between 0 and 1 each time data is read (read scan) from all external device addresses being 
used by External Device Communication 3.

LSM44
Alternates between 0 and 1 each time data is read (read scan) from all external device addresses being 
used by External Device Communication 4.

LSM45 to 47 Reserved
LSM48 200 millisecond clock (alternates between 0 and 1 every 100 milliseconds)
LSM49 1 second clock (alternates between 0 and 1 every 500 milliseconds)

LSM50
When switched to 1, limits the External Device Communication and gives priority to the communications 
between the computer and PLC. (Enabled only when using the Pass-Through function.)

LSM51 Reserved

LSM52
While in remote monitor or control, a value of this bit changes from 0 to 1 in just one scan. This bit can be 
used to check if the touchscreen is being controlled by the remote computer. You may also use this bit as 
a trigger condition in a button to forbid the control from the remote computer.

LSM53
When the value changes to 1, the preset values for IP address, subnet mask, and default gateway 
(LSD192 to 203), and port number for maintenance communication (LSD213) are written to the MICRO/I, 
then it automatically resets. After the MICRO/I is reset, the value becomes 0.

LSM54
When the value changes to 1, the preset values for External Device ID, IP address and port number 
(LSD204 to 209) are written to the MICRO/I, then it automatically resets. After the MICRO/I is reset, 
value becomes 0.

LSM55
When a value of this bit changes from 0 to 1, it cancels sending of all the e-mails in "Waiting" status. Even 
if the value of LSM56 is 1, this function can be executed.

LSM56
While a value of this bit is 1, it pauses sending of all the e-mails in "Waiting" status. If the value changes 
from 0 to 1 while sending an e-mail is in progress, it will pause after such e-mail has been sent.

LSM57 Reserved
LSM58 Value is 1 while there is a connection with an FTP client.

LSM59
If a value of this bit changes from 0 to 1, the connections for the FTP client and the MICRO/I is forcibly 
disconnected.
When it becomes 1 value does not become 0 until the MICRO/I is reset or 0 is written.

LSM60 to 63 Reserved
LSM64 Value is 1 while transferring a file.

LSM65
When the value of this bit changes from 0 to 1, file transfers are prohibited. When the value of this bit 
changes to 1 during a file transfer, the file transfer is completed, and then file transfers are prohibited 
from the next transfer.

LSM66 Reserved

LSM67

When the value of this bit changes from 0 to 1, copying and moving subfolders and files included in 
subfolders is prohibited when transferring files from external memory to external memory. When the 
value of this bit changes to 1 during a file transfer, the file transfer is completed, and then copying and 
moving subfolders and files included in subfolders is prohibited.

LSM68, 69 Reserved

LSM70*4

When the value of this bit changes from 0 to 1, BACnet communication is enabled.
When the value of this bit changes from 1 to 0, BACnet communication is prohibited.
When the BACnet communication is stopped by error and restarts the BACnet communication, set 0 to 
the value of LSM70, and then set 1 to the value of LSM70 after the status of the BACnet communication is 
stopped. The status of the BACnet communication can be checked with the value of LSD260.

LSM71 to 95 Reserved
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This operation of this relay is illustrated in the timing chart below.

• Transfer of the LSM10 Keep Relay and Keep Register to the flash memory can take an excess of one 
second. Writing to the Flash Memory can be repeated a maximum of 100,000 times. Keep writing to the 
Flash Memory to a minimum.

• When there is no remaining battery power, data transferred with LSM10 will be restored once the power 
to the MICRO/I has been turned on.

• LSM1, 2, 3 and 11 also operates when switches the Text Group.
• Once a value of LSM18, 20 and 22 changes from 0 to 1, it remains at a value of 1 until MICRO/I is reset 

or 0 is written, then the value is 0.

A scan refers to a period during which all parts placed on a screen are processed. It is not related to the 
period of reading values of external device addresses.

ON

OFF
LSM0

ON

OFF
LSM1

ON

OFF
LSM2

ON

OFF
LSM3

ON

OFF
LSM4

ON

OFF
LSM8

Operation 
processing

1st scan

ON

OFF
LSM5

ON

OFF
LSM12

2nd scan 3rd scan 4th scan 1st scan 2nd scan 3rd scan

Popup Screen open
↓

Popup Screen open
↓

Power on
↓

Basescreen switch 
↓
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1.2 Control Device Addresses

■ Expansion Inputs (#I)
Device addresses that input on/off information from external devices to the MICRO/I. Input Relay for digital I/O 
module connected to HG5G/4G/3G/2G-V and BACnet communication. 
For details, refer to Chapter 30 “2.1 Using Digital I/O Modules” on page 30-12 and Chapter 3 “7 BACnet 
Communication” on page 3-94.

■ Expansion Outputs (#Q)
Device addresses that output on/off information from the MICRO/I to external devices. Output Relay for digital I/O 
module connected to HG5G/4G/3G/2G-V and BACnet communication.
For details, refer to Chapter 30 “2.1 Using Digital I/O Modules” on page 30-12 and Chapter 3 “7 BACnet 
Communication” on page 3-94.

■ Internal relays (#M)
This is a bit-unit device for the BACnet communication.
For details, refer to Chapter 3 “7 BACnet Communication” on page 3-94.

*1 The last digit of the address number is 0 to 7 in octal notation.

Device Name Symbol R/W Address Range Base

Expansion Inputs #I R 30 to 107 10*1

Expansion Outputs #Q R/W 30 to 127 10*1

Internal relays #M R/W 0 to 797 10*1

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

R/W is an abbreviation of Read/Write. R/W indicate that both reading and writing are possible, while R 
indicates that only reading is possible.

All values of the control device addresses becomes 0 at the start of operation.

When entering the control device, inputs "#" before the symbol (device type). In addition, on the Device 
Monitor a "#" is displayed before the symbol.

Example: I100 is configured.

#I100
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2.1 HMI Device Addresses

■ HMI Data Register (LDR)
8192 points are available.

■ HMI Keep Register (LKR)
The value in these registers is retained during power OFF. The maximum number of HMI Keep Register depends upon 
the number set in WindO/I-NV4. For details, refer to Chapter 16 “Minimum and Maximum Amount of Data Storage 
and Number of Addresses” on page 16-2.

■ HMI Timer Current Value (LTD)
This register stores the current value of Timer from the parts. 32 points are available.

■ Digital Input (Word) (WLEX), Digital Output Word (WLEY)
These registers handle the relays for digital inputs (words) and digital outputs (words) of expansion modules 
connected to the HG4G/3G and HG2G-5F in word units. For details, refer to Chapter 30 “2.1 Using Digital I/O 
Modules” on page 30-12.

■ HMI Temporary Register (LBR)
This register can be used to store value as temporary. This register value will be cleared to 0 when a text
group or user account is changed, when a screen is reset or the screen is changed. 128 points are available.

■ HMI Link Register (LLR)
An area that stores the data of the registered device addresses for the external device during Sub Host 
Communication.
64 points are available.
This register can also be used as an internal register like LDR when Sub Host Communication is not used.

■ HMI Expansion Input (Word) (WLI), HMI Expansion Output (Word) (WLQ)
These registers handle the expansion input or the expansion output used with HG1P in word unit. WLQ is 
a reserved area.

*1 HG4G/3G, HG2G-5F only
*2 HG1P only
*3 HG5G/4G/3G/2G-V only

2 Word Devices

Internal Device Name Symbol R/W Address Range Base

HMI Data Register LDR R/W 0 to 8191 10

HMI Keep Register LKR R/W Variable 10

HMI Timer Current Value LTD R 0 to 31 10

Digital Input (Word)*1 WLEX R 0, 20, 40, 60 10

Digital Output (Word)*1 WLEY R/W 0, 20, 40, 60 10

HMI Temporary Register LBR R/W 0 to 127 10

HMI Link Register LLR R/W 0 to 63 10

HMI Expansion Input (Word)*2 WLI R 0 16

HMI Expansion Output (Word)*2 WLQ R/W 0 16

HMI Special Data Register LSD R/W
0 to 383*3

0 to 255*1
10

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

R/W is an abbreviation of Read/Write. R/W indicate that both reading and writing are possible, while R 
indicates that only reading is possible.
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■ HMI Special Data Register (LSD)
These registers (384*3 or 256*2 points) perform the following special operations.

*3 HG5G/4G/3G/2G-V only
*4 HG4G/3G, HG2G-5F/-5T, HG1G/1P only
*5 HG2G-5T, HG1G/1P only

Device Address Function/Part

LSD0 to 3 Reserved

LSD4 Scan time Maximum value (msec.)

LSD5 Screen switch response time (msec.)

LSD6 Read scan communication time of External Device Communication 1 (msec.)

LSD7 Scan counter (incremented at each scan)

LSD8 1 second counter (incremented each second)

LSD9 10 msec. counter (increments every 10 msec.)

LSD10 100 msec. counter (incremented every 100 msec.)

LSD11 200 msec. counter (incremented every 200 msec.)

LSD12 500 msec. counter (incremented every 500 msec.)

LSD13 Stores the current Year data from the MICRO/I. “Year” (4 BCD digits)

LSD14 Stores current time data from MICRO/I. “Month” (2 BCD digits)

LSD15 Stores current time data from MICRO/I. “Day” (2 BCD digits)

LSD16 Stores current time data from MICRO/I. “Hour” (2 BCD digits)

LSD17 Stores current time data from MICRO/I. “Minute” (2 BCD digits)

LSD18 Stores current time data from MICRO/I. “Second” (2 BCD digits)

LSD19

Stores current time data from MICRO/I. “Day-of-week” (1 BCD digit)
0: Sunday
1: Monday
2: Tuesday
3: Wednesday
4: Thursday
5: Friday
6: Saturday

LSD20 When a value of “1” is written into this special register, the Internal clock in MICRO/I is updated 
according to the data stored in LSD21-26. It automatically resets to “0” after the update.

LSD21 Write a “Year” value to store in the MICRO/I internal clock. (2 BCD digits)

LSD22 Stores set value for “Month” in MICRO/I internal clock. (2 BCD digits)

LSD23 Stores set value for “Day” in MICRO/I internal clock. (2 BCD digits)

LSD24 Stores set value for “Hour” in MICRO/I internal clock. (2 BCD digits)

LSD25 Stores set value for “Minute” in MICRO/I internal clock. (2 BCD digits)

LSD26 Stores set value for “Second” in MICRO/I internal clock. (2 BCD digits)

LSD27 Scan time Current value (msec.)

LSD28 Scan time Minimum value (msec.)

LSD29, 30 Reserved

LSD31 Stores the currently displayed screen number.

LSD32
Set a value ( in reference to a Base Screen number you want to switch to) and it will automatically 
switch to a specified Base Screen number.
Note, after switching to a Base Screen, the value stored automatically resets to 0.

LSD33*5

USB flash drive error status
0: Normal
1: A write occurred when the USB flash drive was not inserted or when an incompatible USB flash 

drive was inserted
2: Format error
3: Access error, Insufficient memory in USB flash drive or Reading or writing failure
4: Unsuccessful read of picture data
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*5 HG2G-5T, HG1G/1P only
*6 HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F only

Device Address Function/Part

LSD34 USB flash drive free memory capacity Lower word (Kbytes)

LSD35 USB flash drive free memory capacity Upper word (Kbytes)

LSD36 USB flash drive total memory capacity Lower word (Kbytes)

LSD37 USB flash drive total memory capacity Upper word (Kbytes)

LSD38*6 Execution time of the Cyclic Script (Current value) (msec.)

LSD39*6 Execution time of the Cyclic Script (Maximum value) (msec.)

LSD40*6 Execution time of the Cyclic Script (Minimum value) (msec.)

LSD41 Reserved

LSD42*6

SD memory card error status
0: Normal
1: A write occurred when the USB flash drive was not inserted or when an incompatible USB flash 

drive was inserted
2: Format error
3: Access error, Insufficient memory in Memory card or Reading or writing failure.
4: Unsuccessful read of picture data

LSD43*6 SD memory card free memory capacity Lower word (Kbytes)

LSD44*6 SD memory card free memory capacity Upper word (Kbytes)

LSD45*6 SD memory card total memory capacity Lower word (Kbytes)

LSD46*6 SD memory card total memory capacity Upper word (Kbytes)

LSD47 Reserved (for Communication drivers)

LSD48 Reserved

LSD49 Stores the O/I Link slave station number. (Read-only)

LSD50

The sequence value of the message number (or channel number if the alarm function is being 
used) selected by the cursor in the Alarm List Display is stored.
A value of between 1 and 1024 (allocated using ((Block No. - 1) x 16 + bit position + 1)) is stored 
for the number.

LSD51 Brightness level: -16 to 31*6, 0 to 31*5

LSD52 The ID number of the script for which the error occurred.

LSD53 Script error status

LSD54 Reserved (for Script)

LSD55 Reserved

LSD56
The number of lines of data from the start line to the line currently selected with the cursor 
displayed in the Alarm List Display/Alarm Log Display is stored.

LSD57
The number of log data pieces stored in the Data Storage Area by the alarm log function is stored. 
(0 to 1024)

LSD58*5

USB flash drive download status
The following bit becomes to 1 while downloading to USB flash drive by WindO/I-NV4.
The bit switched to 0 after downloading.
Bit 2:  Recipe file
Bit 4:  ZNV Project File
Bit 5:  Picture file
Bit 9:  ZLD Project File
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*5 HG2G-5T, HG1G/1P only
*6 HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F only
*7 This is applicable for models with an audio interface only.

Device Address Function/Part

LSD59*6

SD memory card download status
The following bit becomes to 1 while downloading to SD memory card by WindO/I-NV4.
The bit switched to 0 after downloading.
Bit 2:  Recipe file
Bit 4:  ZNV Project File
Bit 5:  Picture file

Bit 8:  Sound file*7

Bit 9:  ZLD Project File

LSD60 Reserved (for Line Chart)

LSD61 Reserved (for Trigger Condition)

LSD62 Reserved (for TCP/IP)

LSD63 to 64 Reserved

LSD65 The maximum number of screenshots in the in the SD memory card*6 or the USB flash drive*5.

LSD66 Reserved

LSD67

Stores the connection status for TCP clients and the TCP server for the User Communication set to 
the Ethernet interface.
Bit 0: User Communication 1
Bit 1: User Communication 2
Bit 2: User Communication 3

LSD68

When the value changes from 0 to 1, the connections for the TCP clients and the TCP server for the 
User Communication set to the Ethernet interface are forcibly disconnected.
Bit 0: User Communication 1
Bit 1: User Communication 2
Bit 2: User Communication 3

LSD69 to 71 Reserved

LSD72*7 Stores the currently played sound file number.

LSD73*7 Stores the sound ID which could not be played by any errors.

LSD74 to 78 Reserved

LSD79 Quantity of Expansion I/O Modules

LSD80 to 96 Reserved

LSD97 Read scan communication time of External Device Communication 2 (msec.)

LSD98 Read scan communication time of External Device Communication 3 (msec.)

LSD99 Read scan communication time of External Device Communication 4 (msec.)

LSD100 Reserved (for O/I Link Communication)

LSD101 Polling period register for the O/I Link Slave

LSD102 Slave registration setting register for O/I Link Master

LSD103 Reserved (for O/I Link communication)

LSD104 Slave online information register for O/I Link Master

LSD105 Reserved (for O/I Link communication)

LSD106 Slave error information register for O/I Link Master

LSD107 Reserved (for O/I Link communication)

LSD108, 109 Reserved

LSD110, 111 Reserved (for Communication drivers)

LSD112 to 119
Register for Communication drivers
For details, refer to the WindO/I-NV4 External Device Setup Manual.
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*8 This is applicable for models with a video interface only.

Device Address Function/Part

LSD120 to 123

The preset value for Preferred DNS Server. When the value of LSM53 changes from 0 to 1, the 
values of these device addresses are written to the MICRO/I. When the power is turned on, the set 
values of the project are read to these device addresses.
Example: When the IP address is 192.168.0.11

LSD120=192, LSD121=168, LSD122=0, LSD123=11

LSD124 to 127

The preset value for Alternate DNS Server. When the value of LSM53 changes from 0 to 1, the 
values of these device addresses are written to the MICRO/I. When the power is turned on, the set 
values of the project are read to these device addresses.
Example: When the IP address is 192.168.0.12

LSD124=192, LSD125=168, LSD126=0, LSD127=12
LSD128 to 154 Reserved

LSD155*8

Event Recording Function Status Information
While data is being recorded after an event occurs with the event recording function or while 
recorded data is being saved to the external memory device, the value of bit 0 changes to 1. It 
changes to 0 when the saving operation completes.

LSD156 to 164 Reserved

LSD165*8

Multimedia Function Error Information
0: Normal
1: Specified file does not exist
2: File format is incorrect
3: Specified parameter value is out of range

LSD166 to 191 Reserved

LSD192 to 195

The preset value for IP address of the MICRO/I. When the value of LSM53 changes from 0 to 1, the 
values of these device addresses are written to the MICRO/I. When the power is turned on, the set 
values of the project are read to these device addresses.
Example: When the IP address is 192.168.0.1

LSD192=192, LSD193=168, LSD194=0, LSD195=1

LSD196 to 199

The preset value for subnet mask of the MICRO/I. When the value of LSM53 changes from 0 to 1, 
the values of these device addresses are written to the MICRO/I. When the power is turned on, the 
set values of the project are read to these device addresses.
Example: When the subnet mask is 255.255.254.0

LSD196=255, LSD197=255, LSD198=254, LSD199=0

LSD200 to 203

The preset value for default gateway of the MICRO/I. When the value of LSM53 changes from 0 to 
1, the values of these device addresses are written to the MICRO/I. When the power is turned on, 
the set values of the project are read to these device addresses.
Example: When the default gateway is 192.168.0.24

LSD200=192, LSD201=168, LSD202=0, LSD203=24
LSD204 The External Device ID to change the IP address and the port number

LSD205 to 208

The preset value for IP address of external device. When the LSM54 changes from 0 to 1, the 
values of these device addresses are written to the MICRO/I. When the value of LSD204 changes, 
the set values of the project are read to these device addresses.
Example: The IP address is 192.168.0.2

LSD205=192, LSD206=168, LSD207=0, LSD208=2

LSD209
The preset value for the port number of the external device. When the value of LSM54 is changed 
to 1, the value of this device address is addresses are written to the MICRO/I. When the value of 
LSD204 changes, the set value of the project is read to this device address.

LSD210 to 212 Reserved

LSD213
The preset value for port number for maintenance communication of the MICRO/I. When the value 
of LSM53 changes from 0 to 1, the value of this device address is written to the MICRO/I. When the 
power is turned on, the set value of the project is read to this device address.

LSD214 to 219 Reserved
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*7 This is applicable for models with an audio interface only.
*8 This is applicable for models with a video interface only.

Device Address Function/Part

LSD220

Ethernet port configuration error information
The following bits change to 1 when allocating the port numbers used by the various Ethernet 
communications functions has failed.
The bits are 0 when allocating the port numbers was successful or a function is not used.
Bit 0: Maintenance Communication
Bit 1: Pass-Through
Bit 2: FC4A Series MicroSmart direct connection pass-through
Bit 3: User Communication
Bit 4: Web Server Function
Bit 5: FTP Server Function
Bit 6: FTP Client Function
Bit 7: E-mail Function
Bit 8: External Device Communication 1
Bit 9: External Device Communication 2
Bit 10: External Device Communication 3
Bit 11: External Device Communication 4
Bit 12: BACnet communication

LSD221 Number of e-mail in "Waiting" status

LSD222

Result of e-mail sending
0: Successfully Completed
1: Parameter error
2: Timeout error
3: Authentication error
4: None of the above

LSD223 E-mail Number which has been sent
LSD224 to 229 Reserved
LSD230 Number of the FTP server connected to using the FTP client function

LSD231
Number of file transfer successes
The register is set to 0 at the start of file transfers. 1 is added to the register when a file transfer 
ends without any errors.

LSD232
Number of file transfer failures
The register is set to 0 at the start of file transfers. 1 is added to the register when any error occurs 
in the file transfer.

LSD233 to 239 Reserved

LSD240, 241
Version number of the runtime system
Example: The version number of the runtime system is version 4.38.

LSD240=0438(Hex), LSD241=0000(Hex)

LSD242, 243
Version number of WindO/I-NV4
Example: The version number of WindO/I-NV4 is version 1.2.3.

LSD242=0102(Hex), LSD243=0300(Hex)
LSD244 to 247 Reserved

LSD248

File transfer status to the USB flash drive by using the FTP server function.
The following bit becomes to 1 while trasfering files to USB flash drive inserted into the MICRO/I 
from an FTP client.
The bit becomes to 0 after transfering.
Bit 2: Recipe file
Bit 4: ZNV Project File
Bit 5: Picture file
Bit 8: Sound file*7

Bit 9: ZLD Project File
Bit 10: Movie file*8

Bit 15: None of the above
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*3 HG5G/4G/3G/2G-V only
*6 HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F only
*7 This is applicable for models with an audio interface only.
*8 This is applicable for models with a video interface only.

Device Address Function/Part

LSD249*6

File transfer status to the SD memory card by using the FTP server function.
The following bit becomes to 1 while transferring files to SD memory card inserted into the MICRO/
I from an FTP client.
The bit becomes to 0 after transferring.
Bit 2: Recipe file
Bit 4: ZNV Project File
Bit 5: Picture file
Bit 8: Sound file*7

Bit 9: ZLD Project File
Bit 10: Movie file*8

Bit 15: None of the above
LSD250 to 255 Reserved

LSD256*3

Input mode of Character Input
Stores the input method from the keypad for the Character Input.
0: Direct input mode
1: Kanji input mode

LSD257 to 259*3 Reserved

LSD260*3

BACnet communication status
Stores the status for BACnet communication.
Bit 0: Stopped
Bit 1: Ready
Bit 2: Operating
Bit 3: Stopped by error

LSD261*3

BACnet Communication Error Information
Stores the last error information that has occurred in BACnet communication.
Bit 0: Normal
Bit 1: Invalid device ID
Bit 2: Invalid IP address
Bit 3: Invalid BBMD IP address
Bit 4: BBDM registration failure

LSD262 to 269*3 Reserved

LSD270*3 Expansion Module Slot 1 Information (Type ID and Status)

LSD271*3 Expansion Module Slot 1 Information (System Software Version and Position Information)

LSD272*3 Expansion Module Slot 2 Information (Type ID and Status)

LSD273*3 Expansion Module Slot 2 Information (System Software Version and Position Information)

LSD274*3 Expansion Module Slot 3 Information (Type ID and Status)

LSD275*3 Expansion Module Slot 3 Information (System Software Version and Position Information)

LSD276*3 Expansion Module Slot 4 Information (Type ID and Status)

LSD277*3 Expansion Module Slot 4 Information (System Software Version and Position Information)

LSD278 to 383*3 Reserved
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*9 SD memory card for HG5G/4G/3G/2G-V, HG4G/3G and HG2G-5F, USB flash drive for HG2G-5T and HG1G/1P

• LSD4 and 6 store the maximum value, and when the Base Screen is switched, they are reset.
• The values of LSD4 to 6 are included errors of +/- 10 msec.
• The values of LSD38 to 40 are included errors of +/- 10 msec.
• When registers LSD7, 8, 9, 10, 11 or 12 contain FFFF (H) and are incremented, the value becomes 0.
• When you reckon time by using LSD9, the time difference (in 10ms units) from the previous value can be 

calculated.
• The range for the “Year” in LSD13 is 2000 to 2099, and reverts to 2000 after 2099.
• When “1” is written to LSD20, internal clock is updated by the contents of LSD21-26. After setting the 

year, month, day, hour, minute, and second data in LSD21 to 26, writes a “1” to LSD20.
• The display format for LSD31 is set under “Screen No. Format” in Project Settings. (BCD, BIN)
• This data format for LSD32 is the same as “Screen No. Format” in Project Settings. (BCD, BIN)

If the screen number is not exist in the project, “No Screen Data” message will appear.
If 0xFFFF(Hex) is written to LSD32, MICRO/I will display the Top Page of System Mode .
In case that the current screen is changed by System Area1 and LSD32 at the same instant, the screen 
number of the System Area1 will be displayed.

• The data stored in LSD34 to 37, 43 to 46 are stored in kilobytes. 1 K byte is 1024 bytes. Values of less 
than 1 K byte are rounded up.

• By using the LSD50 value in the Message Switch Display you can display the message that corresponds to 
the cursor in the Alarm List Display.

• Refer to Chapter 20 “1.4 Script Error” on page 20-4 for details regarding LSD52 and LSD53.
• LSM7 and LSD6, 102 to 107 are not available for Slave units when using O/I link communication.

• The maximum number of the Screen Captures stored in the external memory device*9 is set in LSD65. 
The value in LSD65 can be anywhere from 1 to 999. (The default value is 99.)
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2.2 Control Device Addresses

■ Expansion Inputs (#WI)
This is a device address for handling bit device Extension Input (#I) used with digital I/O module and BACnet 
communication in word unit.

■ Expansion Outputs (#WQ)
This is a device address for handling bit device Extension Output (#Q) used with digital I/O module and BACnet 
communication in word unit.

■ Internal relays (#WM)
This is a device address for handling bit device Internal Relay (#M) in word unit.

■ Data register (#D)
This is a word device used for analog I/O module and BACnet communication. 

*1 Multiples of 20 only

Device Name Symbol R/W Address Range Base

Expansion Inputs #WI R 30, 50, 70, 90 10

Expansion Outputs #WQ R/W 30, 50, 70, 90, 110 10

Internal relays #WM R/W 0 to 780*1 10

Data register #D R/W 0000 to 2999 10

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

R/W is an abbreviation of Read/Write. R/W indicate that both reading and writing are possible, while R 
indicates that only reading is possible.

All values of the control device addresses becomes 0 at the start of operation.

When entering the control device, inputs "#" before the symbol (device type). In addition, on the Device 
Monitor a "#" is displayed before the symbol.

Example: D100 is configured.

#D100
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This chapter describes the MICRO/I setup screen and how to perform setup.

  

1.1 Maintenance Screen Overview

Using the screen that is displayed when the MICRO/I is in Run Mode, you can switch from Run Mode to System Mode 
and load a screen to adjust device monitor and screen brightness.

Maintenance screen functions are indicated below:

1.2 Displaying the Maintenance Screen

Press the upper-left corner of the MICRO/I screen for three seconds or more.
If the Base Screen is switched before three seconds have elapsed, the load operation for the maintenance screen will 
be canceled. Please press it again.

Chapter 34 MICRO/I Setup

1 Maintenance Screen

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

Button Description

System Mode
Switch the MICRO/I to System Mode. In System Mode, the MICRO/I can be changed to its initial 
settings and data can be initialized.
For details, refer to “2 System Mode Overview” on page 34-3.

Device Monitor
Shows the Device Monitor. This screen can be used to register device addresses and monitor and 
change values of device addresses. For details, refer to Chapter 25 “2.2 Device Monitor” on page 
25-21.

Adjust Brightness Shows the adjust brightness screen. This screen is used to adjust the brightness of the MICRO/I.

Maintenance

System Mode

Device Monitor

Adjust Brightness

If a password has been configured for the project data and press System Mode or Device Monitor, the Enter 
Password screen will be displayed. Select a user name and then enter a password. For details, refer to 
Chapter 23 “User Accounts and the Security Function” on page 23-1.

Press and hold 
3 or more seconds

MICRO/I

• To display the maintenance screen, select the Enable Maintenance check box under the System tab 
in the Project Settings dialog box.

• If a touch switch is placed in the upper-left corner of the screen, switching to the maintenance screen 
will not be possible.
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1.3 Adjusting Screen Brightness

1 On the maintenance screen, press Adjust Brightness.

The Adjust Brightness screen is displayed.

Also, press  or  to adjust to your preferred brightness.

Maintenance

System Mode

Device Monitor

Adjust Brightness

×Maintenance

＜＜ ＞＞
Adjust Brightness

Screen brightness can be adjusted using methods other than the ones listed above.

•  or   buttons on the Top Page in System Mode
• Changing the values for HMI Special Data Register LSD51.
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The System Mode allows you to access the internal MICRO/I initial settings, self diagnosis, and clearing logged data. 
In this mode, the project in the MICRO/I will not be running.

2.1 System Mode Screens

In the System Mode, the Top Page appears (as shown below).

The Top Page and the Main Menu screen display a symbol of Battery Level Status.

■ Battery Level Status

2 System Mode Overview

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

Top Page Main Menu screen

Press Main Menu to display the Main Menu screen 
shown in the right figure.

Run Simulate Offline

<< >> Save
BRIGHTNESS 31

SYSTEM MODE TOP PAGE

ENG/JPN

MAC Address  00:03:7B:F0:12:A8
IP Address  192.168.0.1(DHCP)
2010/OCT/14/THU   14:56:44

Offline

For information on accessing the MICRO/I System Mode, refer to “1.2 Displaying the Maintenance Screen” 
on page 34-1. Design may change slightly depending on model.

Full Battery level is full.

Battery level is running low. (The “Battery Level Low” message appears at the top of the screen.)

Empty
Battery level is almost empty, or not inserted. (The “Replace Battery. Battery Level Low” message 
appears at the top of the screen.)

The Symbols depend on MICRO/I model.
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The Top Page and Main Menu screen have the items shown below. Pressing each button switches to the 
corresponding setting or operation screen.

■ Top Page

■ Main Menu screen

Item Descriptions See page

Run Switches to Run Mode. Page 34-11

Offline Switches to Offline mode. Page 34-11

Main Menu Switches to Main Menu screen. Page 34-4

Item

Descriptions See pageHG5G/4G/3G/2G-V, 
HG4G/3G, HG2G-5F

HG2G-5T, HG1G/1P

Initial Setting Initial Setting
•Setup the settings relating to operation and 
communication parameters of the MICRO/I.

•Initialize the log data.
Page 34-7

Clock Setting Clock Setting Allows setting of the internal clock of the MICRO/I. Page 34-11

Offline Offline Goes to Offline mode. Page 34-11

Run Run Goes to Run mode Page 34-11

System Information System Info.
Displays information relating to the type No., projects, as 
well as system software of the current MICRO/I.

Page 34-12

File Manager ―
Manage the files saved in SD memory cards, USB flash 
drives, and the internal memory of the MICRO/I.

Page 34-13

― Ext.Mem.Device Format USB flash drive. Page 34-13

Top Page Top Page Switches to Top Page. Page 34-13

Self Diagnosis Self Diag.
Executes self diagnosis of memory, the clock, the touch 
panel, display, communication, expansion interface and 
others.

Page 34-13

For the HG5G/4G/3G/2G-V, HG4G/3G and the HG2G-5F, you can change the display language by pressing 

. HG2G-5T and HG1G/1P can only display the screens of the System Mode in English.ENG/JPN
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2.2 Names and Layout of Setup Menus

■ HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F

External Device IP Address

Autorun

Communication I/F

Communication Communication 1

Communication 2

External Device 1

External Device 2

External Device 3

External Device 4

External Device Retry Cycles

Time Out

Trans. Wait

Parameter1

Pass Through Setting

Parameter2

Parameter3

Parameter4

Retry Cycles

Time Out

Trans. Wait

Parameter1

Pass Through Setting

Parameter2

Parameter3

Parameter4

Retry Cycles

Time Out

Trans. Wait

Parameter1

Pass Through Setting

Parameter2

Parameter3

Parameter4

Retry Cycles

Time Out

Trans. Wait

Parameter1

Pass Through Setting

Parameter2

Parameter3

Parameter4

Offline
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■ HG2G-5T, HG1G/1P

*1 HG1P only

Ext. Device 1

Ext. Device 2

System Op. Backlight

Default Scr. No.

Autorun

O/I Link Set1

O/I Link Set2

Brightness

Comm. I/F

I/O

Seq. Check

Offline

Op. Log

TP Adjust

Ext. Device 3

Ext. Device 4

Ext. Device Retry Cycles

Time Out

Trans. Wait

Parameter1

Pass Through

Parameter2

Parameter3

Parameter4

Retry Cycles

Time Out

Trans. Wait

Parameter1

Pass Through

Parameter2

Parameter3

Parameter4

Retry Cycles

Time Out

Trans. Wait

Parameter1

Pass Through

Parameter2

Parameter3

Parameter4

Retry Cycles

Time Out

Trans. Wait

Parameter1

Pass Through

Parameter2

Parameter3

Parameter4

RS232C

IP Address

RS422/485

Default Gateway

Misc Setting

Ext. IP Address

Backlight

Sequent

Trace

System Info.

Self Diag.

Ext.Mem.Device

Fixed Points
Comm.

*1
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The followings are displayed in the HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F. Description between the parentheses are 
displayed in the HG2G-5T, HG1G/1P.

3.1 Initial Setting (Initial Setting)

Pressing Initial Setting in the Main Menu screen displays the setup screen. 
You can use this screen to input the settings for MICRO/I operation and communication parameters, and to clear the logs. 
To return to the Main Menu screen, press Main Menu at the top of the screen.

● System Operation (System Op.)
From the Main Menu screen, press Initial Setting (Initial Setting), and then System Operation (System Op.) 
to display the system operation menu screen. 
You can use this screen to set the items below. Press the button for each item to set it.

■ Backlight (Backlight)

Backlight Control
Set the amount of time (in minutes) until the backlight brightness is reduced automatically when the screen is not 
touched or switched.

Auto Backlight OFF
Set the amount of time (in minutes) until the backlight turns off automatically when the screen is not touched or 
switched.
Procedure

1 From the Main Menu screen, press Initial Setting (Initial Setting), System Operation (System Op.), and then 
Backlight (Backlight).

2 Press the left/right buttons to select the item, and then enter the time until the backlight brightness is reduced 
automatically with the numeric keys.

3 Press the left/right buttons to select the item, and then enter the time until the backlight automatically turns off with 
the numeric keys.

4 Press SAVE (SAVE) button to save the settings.

■ Start Time (Start Time)
This item sets the amount of time (in minutes) until communication with the external device starts after MICRO/I 
power ON. This can be used to synchronize boot times with the external device.
From the Main Menu screen, press Initial Setting (Initial Setting), System Operation (System Op.), and then 
Start Time (Start Time).
Enter the time with the keypad.
Press SAVE (ENT) to apply the entered value. 
Press CAN (CAN) to cancel the entered value and display the currently set value.

3 Settings

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

• To return to the initial settings screen, press Init Set (Init Set) at the top of the screen.
• To return to the system operation menu screen from any of the settings screens below, press System 

Operation (System Op.) at the top of the screen.

• If you switch to another screen or change the value before pressing SAVE (SAVE), the settings are not 
saved.

• Functions with the time set to 0 are disabled.

The setting is not updated if you display another screen before applying the setting.
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■ Details (Details)
The following items can be set.
• Whether or not to have a sound made when a touch switch is pressed.
• Select the screen number to be displayed as a binary number or BCD (binary coded decimal).
• To set blink cycle.
• Display the error message in Japanese or English.
From the Main Menu screen, press Initial Setting (Initial Setting), System Operation (System Op.), and then 
Details (Details).

Select the item to change using the  or  . The selected item is highlighted. Each press of the  (CHG) 
button changes the property of the selected item. Repeat this procedure until the desired properties are displayed. 
Press ENT (ENT) to apply the entered value.

■ Default Screen No. (Default Scr. No.)
This item sets the No. (as a decimal value) of the screen to display after power ON. 
From the Main Menu screen, press Initial Setting (Initial Setting), System Operation (System Op.), and then 
Default Screen No. (Default Scr. No.).
Use the Keypad to enter the value. 
Press SAVE (ENT) to apply the entered value.
Press CAN (CAN) to cancel the entered value and display the currently set value.

■ Password (Password)
Changes the password set for the user account.
If  security function is used, you will be able to change the password for the selected user account (either as an 
administrator or other users registered in the security group) from the touchscreen.
From the Main Menu screen, press Initial Setting (Initial Setting), System Operation (System Op.), and then 
Password (Password). 

Press  (CHG) to change the user account.

Press Change Password (Change Password) to display the password input screen. 
Use the password input keys to enter a password from 4 to 15 characters. 
Pressing ENTER (ENT) applies the entered password and closes the password input screen.
Pressing CLR (CLR) clears the password input field.

■ Autorun (Autorun)
Enables or disables the USB Autorun function.
When this option is enabled, Autorun function will be executed when a USB flash drive is inserted to MICRO/I.
From the Main Menu screen, press Initial Setting (Initial Setting), System Operation (System Op.), and then 
Autorun (Autorun).

The setting is not updated if you display another screen before applying the setting.

• The setting is not updated if you display another screen before applying the setting.
• If the Default Screen No. is set to 0, MICRO/I will display the screen set in the external device instead of 

the internal initial screen. For details, refer to Chapter 4 “System Area 1” on page 4-30.

• If you press CAN (CAN) on the Password Screen, the setting is not updated and you return to the 
Password Screen.

• Pressing ENTER (ENT) without entering a password disables the password function.

When you do not assign a password to a project data, the Password is blank.

The setting is not updated if you display another screen before applying the setting.
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● Initialize (Initialize)
From the Main Menu screen, press Initial Setting (Initial Setting), and then Initialize (Initialize) to display the 
initialization menu screen.
You can use this screen to set the following items. Press the button for each item to set it.

■ Alarm Log (Alarm Log)
Clears all the alarm log data.
From the Main Menu screen, press Initial Setting (Initial Setting), Initialize (Initialize), and then Alarm Log 
(Alarm Log).
Press Yes to clear the Alarm Log data.

■ Data Log (Data Log)
Clears all the data logged from Data Log. 
From the Main Menu screen, press Initial Setting (Initial Setting), Initialize (Initialize), and then Data Log 
(Data Log).
Press Yes to clear the Data Log data.

■ Operation Log (Op. Log)
Clears all the operation log data.
From the Main Menu screen, press Initial Setting (Initial Setting), Initialize (Initialize), and then Operation 
Log (Op. Log).
Press Yes to clear the Operation Log data.

■ Touch Panel Adjust (TP Adjust)
Adjusts the analog touch panel.
From the Main Menu screen, press Initial Setting (Initial Setting), Initialize (Initialize), and then Touch 
Panel Adjust (TP Adjust). The position of the analog touch panel is properly adjusted and set.
Press Yes and adjust the touch panel according to the instructions on the screen.

● External Device (Ext. Device)
From the Main Menu screen, press Initial Setting (Initial Setting), External Device (Ext.Device), and then 
External Device 1 (Ext.Device 1), External Device 2 (Ext.Device 2), External Device 3(Ext.Device 3) or 
External Device 4 (Ext.Device 4) to display the menu screen for the external device communication.
To specify settings, press the button to select a choice. External Device Communication setting items vary based on 
the currently connected hardware. For details about settings, refer to the WindO/I-NV4 External Device Setup Manual.
If Not Use are selected from the Communication Driver, you cannot select this option.

● O/I Link (O/I Link)
From the Main Menu, press Initial Setting (Initial Setting), and then O/I Link (O/I Link) to display the O/I link 
menu screen.
This screen presents information on the O/I Link.
Various settings can be made by pressing O/I Link Setting1 (O/I Link Set1) or O/I Link Setting 2 (O/I Link Set2).

• To return to the initial settings screen, press Init Set (Init Set) at the top of the screen.
• To return to the initialization menu screen from any of the settings screens below, press Init (Init) at the 

top of the screen.

HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F HG2G-5T, HG1G/1P

Press the center of each  symbol displayed on the screen, in 
the following order: upper-left corner, upper-right corner, lower-
right corner, lower-left corner of the MICRO/I screen.

Press the center of each  symbol displayed on the screen, in 
the following order: lower-left corner, lower-right corner, upper-
right corner, upper-left corner of the MICRO/I screen.

Press the center of the symbol. Press the center of the symbol.

To return to the initial settings screen, press Init Set at the top of the screen.

• To return to the initial settings screen, press Init Set (Init Set) at the top of the screen.
• For details about settings, refer to the WindO/I-NV4 External Device Setup Manual.
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● Communication I/F (Comm. I/F)
From the Main Menu screen, press Initial Setting (Initial Setting), and then Communication I/F (Comm. I/F) 
to display the communication interface settings menu screen.
You can use this screen to set the items below. Press the button for each item to set.

■ Serial 1

Allows the setting of communication parameters for the Serial Interface 1.
From the Main Menu screen, press Initial Setting, Communication I/F, and then Serial 1.

■ Serial 2

Allows the setting of communication parameters for the Serial Interface 2. For the HG5G/4G/3G/2G-V, RS232C and 
RS422/485 can be set individually.
From the Main Menu screen, press Initial Setting, Communication I/F, and then Serial 2.

■ (RS232C)

Allows the setting of communication parameters for the Serial Interface (SERIAL1) (RS232C).
From the Main Menu screen, press (Initial Setting), (Comm. I/F), and then (RS232C).

■ (RS422/485)

Allows the setting of communication parameters for the Serial Interface (SERIAL1) (RS422/485).
From the Main Menu screen, press (Initial Setting), (Comm. I/F), and then (RS422/485).

■ Ethernet IP Address (IP Address)
Use the following procedure to set the IP address and Subnet mask settings.
From the Main Menu screen, press Initial Setting (Initial Setting), Communication I/F (Comm. I/F), and 
then Ethernet IP Address (IP Address).
Press the left/right buttons to select an item, then use the Keypad to enter the IP address and subnet mask values. 
Press SAVE (SAVE) to save the settings.

■ Ethernet Default Gateway (Default Gateway)
Specify the default gateway.
From the Main Menu screen, press Initial Setting (Initial Setting), Communication I/F (Comm. I/F), and 
then Ethernet Default Gateway (Default Gateway).
Press the left/right buttons to select an item, then use the Keypad to enter the default gateway value.
Press SAVE (SAVE) to save the settings.

• To return to the initial settings screen, press Init Set (Init Set) at the top of the screen.
• Press Comm. I/F (Comm. I/F) at the top of the screen to return to the communication interface 

settings menu.

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

The setting is not updated if you display another screen before applying the setting.

The setting is not updated if you display another screen before applying the setting.
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■ Ethernet Misc Setting (Misc Setting)
Specify whether to allow or prohibit Maintenance Communication via TCP/IP (refer to Chapter 24 “Using the online 
function for Ethernet communication” on page 24-7).
From the Main Menu screen, press Initial Setting (Initial Setting), Communication I/F (Comm. I/F), and 
then Ethernet Misc Setting (Misc Setting).

Select the item to set using  or  . The selected item is highlighted. 

Each press of  or  changes the property of the selected item. Repeat this procedure until the desired 
properties are displayed. 
Press ENT (ENT) to apply the entered value.

■ Ext. Device IP Address (Ext. IP Address)
Change the IP addresses of the External Device IDs for external devices.
From the Main Menu screen, press Initial Setting (Initial Setting), Communication I/F (Comm. I/F), and 
then Ext. Device IP Address (Ext. IP Address).

Procedure
1 Press the left/right arrow buttons to select the External Device ID, and then enter a value of the External Device ID 

with the numeric keys.

2 Press the left/right arrow buttons to select the item, and then enter the IP address with the numeric keys.

3 Press SAVE (SAVE) to save the settings.

3.2 Clock Setting

Press Clock Setting (Clock Setting) in the Main Menu screen to display the clock settings screen. 
Use this screen to set MICRO/I’s internal clock. 
To return to the Main Menu screen, press Main Menu (Main Menu) at the top of the screen.

Procedure

1 Press the left/right buttons to select an item, then use the Keypad to enter the date or time.

2 Press SAVE (SAVE) to save the date/time setting.

3.3 Offline (Offline)

This mode allows you to change values of device addresses and to check the operation of project data on the MICRO/I. 
To return to the Main Menu screen, press Main Menu (Main Menu) at the top of the screen.

Press Offline (Offline) in the Main Menu screen to run under the offline mode.

3.4 Run

Switches to run mode and executes the project.

The setting is not updated if you display another screen before applying the setting.

The settings are not saved if you display another screen or change the External Device ID before pressing 
SAVE (SAVE).

The setting is not updated if you display another screen before applying the setting.

Under offline mode, values of the external device addresses may be cleared by zero when the Base Screen 
changes.

Using the Device Monitor Function in conjunction with the Monitor function is a more efficient means of 
debugging. For details, refer to Chapter 25 “2.2 Device Monitor” on page 25-21.
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3.5 System Information (System Info.)

From the Main Menu screen, press System Information (System Info.), and then press System (System) or 
System 2 (System 2) to display the system information screen. This screen displays information such as the 
MICRO/I type No., stored system software type and version No. 
To return to the Main Menu screen, press Main Menu (Main Menu) at the top of the screen.

● System (System)
From the Main Menu screen, press System Information (System Info.), and then press System (System).
Displays the following settings:
• MICRO/I type No.
• MAC address
• Boot software version
• System software version
To return to the system information screen, press System Info. (System Info.) at the top of the screen.

● System 2
From the Main Menu screen, press System Information (System Info.), and then press System 2 (System 2).
Displays the following settings:
• Project name
• External Device Communication 1 to 4 and Communication Interface

- External device manufacturer
- Communication driver name
- Communication driver version

To return to the system information screen, press System Info. (System Info.) at the top of the screen

● Font (Font)
From the Main Menu screen, press System Information (System Info.), and then press Font (Font).
Displays the font type stored in MICRO/I.
To return to the system information screen, press System Info. (System Info.) at the top of the screen.

Only the first 15 characters of the project name are displayed.
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3.6 File Manager

File Manager manages files stored on SD memory cards, USB flash drives, and MICRO/I internal memory. 
It can format external memory devices, copy and delete files, and run associated applications. 
To return to the Main Menu screen, press Main Menu at the top of the screen.

• Format
Select the drive you want to format, and then press FORMAT.

• Copy
Select the file you want to copy, and then press COPY.
If USB Flash Drive or SD Memory Card is selected as the source and the destination device, the selected file will be 
copied to the device. If the source or the destination device is MICRO/I, “Project Data Transfer” function will be 
executed and MICRO/I project will be downloaded or uploaded. If the source or the destination device is PLC, “PLC 
Program Data Transfer” function will be executed and PLC Program will be downloaded or uploaded. (Refer to 
Chapter 29 “1 Project Transfer Function” on page 29-1.)

• Delete
Select the files you want to delete, and then press DEL.

3.7 Ext.Mem.Device

From the Main Menu screen, press (Ext.Mem.Device), and then (Format) to format the USB flash drive.
To return to the Main Menu screen, press (Main Menu) at the top of the screen.

3.8 Top Page

Press Top Page (Top Page) in the Main Menu screen to return to the Top Page.

3.9 Self Diagnosis (Self Diag.)

Pressing the Self Diagnosis (Self Diag.) in the Main Menu screen displays the self-diagnosis screen. 
Use this screen to run MICRO/I internal self-diagnosis. To execute an operation, press the corresponding button. 
To return to the Main Menu screen, press Main Menu (Main Menu) at the top of the screen.

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

If the external memory device is not recognized correctly, press RELOAD to reload it.

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

• You need inspection jigs to run self-diagnosis.
• Self Diagnosis is a special screen for factory inspections. Do not use without due reason.
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1.1 Packing content

Before installing the HG5G/4G/3G/2G-V, make sure that the model you have received is what you actually ordered, 
and no parts are damaged to accidents during shipping.

1.2 Type No.

Chapter 35 MICRO/I Specifications

1 HG5G/4G/3G/2G-V

Name HG5G-V HG4G/3G-V HG2G-V

HG5G/4G/3G/2G-V Unit

Instruction Sheet x 1 x 1

Mounting clips

Communication plug for external devices
(Attached to the HG5G/4G/3G/2G-V)

USB Cable Lock Pin

USB Clamp Band

Screw lock bracket
Metric Screw Thread
M2.6 x 0.45

x 1 x 1

x 6 x 4 x 4

x 1 x 1

x 1 x 1

x 1 x 1

x 2 x 2

LCD size AUDIO IN/VIDEO IN Bezel color Type No.

15.0 inch With Black HG5G-VFXT22MF-B

12.1 inch With Black HG4G-VCXT22MF-B

10.4 inch With
Light gray HG3G-VAXT22MF-W

Black HG3G-VAXT22MF-B

8.4 inch With
Light gray HG3G-V8XT22MF-W

Black HG3G-V8XT22MF-B

5.7 inch Without
Light gray HG2G-V5FT22TF-W

Black HG2G-V5FT22TF-B
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1.3 Part Names

■ HG5G-V (15.0inch)

■ HG4G-V (12.1inch)

■ HG3G-VA (10.4inch)

(2)

(1)

(3)
(11)
(10)
(9)
(8)

(12) (13)(14)

(4)(5)(6)(7) (16) (17)

(15)

(2)

(1)

(3)
(11)
(10)
(9)
(8)

(12) (13)(14)

(4)(5)(6)(7)(16) (17)

(15)

(2)

(1)

(3)

(11)
(10)
(9)
(8)

(12) (13) (14)

(4)(5)(6)(7)(16) (17)

(15)
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■ HG3G-V8 (8.4inch)

■ HG2G-V (5.7inch)

(2)

(1)

(3)

(11)
(10)
(9)
(8)

(12) (13) (14)

(4)(5)(6)(7)(16)(17)

(15)

No. Name Description

(1) POWER LED
Green (lit) : Normal Operation (Power is ON.)
Not lit : Power is off.

(2) Display

(3) Touch Panel

(4) Power Supply Terminal

(5) Serial Interface (COM2) RS232C, RS422/485 Connector : Terminal Block 9-pin

(6) Serial Interface (COM1) RS232C, RS422/485 Connector : D-sub 9-pin

(7) Audio Interface (AUDIO OUT)
LINE OUT (Stereo) Connector : Mini Jack (φ3.5mm)
(Except for HG2G-V)

(8) Ethernet Interface (LAN)
IEEE802.3u 10BASE-T/100BASE-TX Connector : RJ-45
(With Auto MDI/MDI-X function)

(9) USB Interface (USB1) USB2.0 (Device) Connector : Mini-B

(10) USB Interface (USB2) USB2.0 (Host) Connector : Type A  Output current : 5V 500mA

(11) Memory Card Interface (SD) For SD memory card

(12) SD Memory Card Access Lamp

(13) Expansion Module Interface (EXT) For IDEC MICROSmart Expansion Modules

(14) Battery Cover

(15) Terminating Resistor Selector Switch For COM2 RS422/485 interface

(16) Video Interface (VIDEO IN1) NTSC/PAL Connector : Pin Jack (Except for HG2G-V)

(17) Video Interface (VIDEO IN2) NTSC/PAL Connector : Pin Jack (Except for HG2G-V)

(2)

(1)

(3)

(11)

(10) (9)

(8)

(12) (13)(14)

(4)(5)(6)(15)
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1.4 External Interfaces

● Serial Interface (COM1)

  CAUTION

• Make sure to turn off the power to the HG5G/4G/3G/2G-V before wiring each interface or 
switching the terminating resistor selector switch.

• The serial interface (COM 1) is used only for the interface of RS232C or RS422 / 485. Wiring both 
interfaces will result in failure of the HG5G/4G/3G/2G-V. Wire only the interface used.

• Note that the serial interface (COM2) can be used as the RS232C and RS422/485 interfaces at one 
time.

Interface Specification RS232C, RS422/485

Connector D-sub 9-pin (Plug)

Screw lock bracket Inch Screw Thread #4-40 UNC

No. Name I/O Function Communication type

1 RDA IN Receive Data (+) RS422/485

2 RD IN Receive Data RS232C

3 SD OUT Send Data RS232C

4 SDA OUT Send Data (+) RS422/485

5 SG - Signal Ground -

6 RDB IN Receive Data (-) RS422/485

7 RS OUT Request to Send RS232C

8 CS IN Clear to Send RS232C

9 SDB OUT Send Data (-) RS422/485

1 5

6 9
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● Serial Interface (COM2)
Use applicable cables for wiring and recommended ferrules (made by Phoenix Contact) as follows.

• Terminating Resistor Selector Switch (for RS422/485 interface)

When using RS422/485 interface, set the Terminating Resistor Selector Switch to the ON side. This will connect the 
internal terminating resistor (120Ω) between RDA and RDB.

● Expansion Module Interface (EXT)
IDEC MICROSmart expansion modules can be connected to the HG5G/4G/3G/2G-V.
Refer to Chapter 30 “1.2 Applicable Expansion Modules” on page 30-2 for the number, the types and the combination 
of the expansion modules that can be installed.

Interface Specification RS232C, RS422/485

Connector Detachable Terminal Block 9-pin

Applicable cable AWG20 to AWG22

Recommended Pressure Terminal

AI 0,34-8 TQ
AI 0,5-8 WH
AI-TWIN 2 x 0,5-8 WH
(Phoenix Contact)

Tightening Torque 0.22 to 0.25 N•m

No. Name I/O Function Communication type

1 SD OUT Send Data

RS232C

2 RD IN Receive Data

3 RS OUT Request to Send

4 CS IN Clear to Send

5 SG ― Signal Ground

RS422/485

6 SDA OUT Send Data (+) 

7 SDB OUT Send Data (-)

8 RDA IN Receive Data (+)

9 RDB IN Receive Data (-) 

No.9No.1

Only one crimp terminal can be inserted into a terminal hole.
Please set another terminal block in the vicinity of MICRO/I and connect SG when using "RS232C" and 
"RS422/485" requiring crossover wiring at the same time.
Separate the communication cables so that they do not affect each communication waveform when using 
RS232C and RS422/485 at the same time.

ON OFF 
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1.5 Specifications

■ Applicable Standards

■ Environmental Specifications

■ Electrical Specifications

■ Construction Specifications

Safety Standard

UL61010-1, UL61010-2-201, UL121201
CSA C22.2 No.61010-1-12 (c-UL)
CSA C22.2 No.61010-2-201 (c-UL)
CSA C22.2 No.213 (c-UL)

EMC Standard IEC/EN 61131-2

Operating Temperature -20 to 60°C

Operating Humidity 10 to 90% RH (no condensation)

Storage Temperature -20 to +70°C

Storage Humidity 10 to 90% RH (no condensation)

Altitude 0 to 2000m

Pollution Degree 2

Corrosion Immunity Free from corrosive gases

Type No. HG5G-V HG4G-V HG3G-VA HG3G-V8 HG2G-V

Rated Voltage 24V DC

Power Consumption 27W maximum 25W maximum 22W maximum 18W maximum

When not using USB Interface 
(USB2) and Expansion Module 
Interface (EXT)

20W maximum 15W maximum 12W maximum 8W maximum

When backlight is turned off 7W maximum 4W maximum

Power Voltage Range 20.4 to 28.8V DC

Allowable Momentary Power 
Interruption

10 ms maximum

Inrush Current 30A maximum

Dielectric Withstand Voltage AC1000V, 10mA, 1 minute (between power and earth terminals)

Vibration 5 to 8.4Hz amplitude 3.5mm, 8.4 to 150Hz acceleration 9.8m/s2

10 times on each of three mutually perpendicular axes (100 minutes)    (IEC61131-2)

Shock 147m/s2, 11ms (5 shocks on each of three mutually perpendicular axes)    
(IEC61131-2)
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■ Performance Specifications

■ EMC Specifications

*1 Please be aware that small black and bright dots might show up on LCD Screen: it is not a failure or malfunction.
*2 The time until brightness becomes 50% of the initial value.

The life of the LCD itself at an ambient temperature of 25°C. This is not a guaranteed value. The actual life depends on the 
environment and conditions of use.

*3 It is a protection structure for the operating surface of HMI, which is attached to a panel. Although protection structure 
suffices every test conditions, it does not guarantee to operate under all of the environmental condition.
As for IP66F/IP67F oilproof structure, it suffices oilproof test conditions. Conditions are listed in the document that comes 
with Japanese Industrial Standard JIS C 0920.
Protection structure do not gurantee usage under long exposure to oil or usage of oil that is not prescribed in the document. 
Please test/check beforehand to avoid trouble.

Type No. HG5G-V HG4G-V HG3G-VA HG3G-V8 HG2G-V

Display

LCD Type*1 TFT color LCD
(TN Type)

TFT color LCD (IPS Type)
TFT color LCD
(TN Type)

Display Colors 65536 Colors

Effective Display Area 
(W × H)

304.1 × 228.1 mm
245.76 × 
184.32 mm

210.4 × 157.8 
mm

170.496 × 
127.872 mm

115.2 × 86.4 
mm

Display Resolution 
(W × H)

1024 × 768 dots 640 × 480 dots

View angle
Left/Right/Bottom: 
80°, Top: 60°

Left/Right/Top/Bottom: 85°
Left/Right/Top/
Bottom: 80°

Brightness of LCD only 650 cd/m2 600 cd/m2 700 cd/m2 800 cd/m2 800 cd/m2

Brightness Adjustment 48 levels

Backlight LED

Backlight Life*2 Approx. 100,000 hours

Touch 
Panel

Switch Type Analog Resistive Film

Operating Force 3N maximum

Multiple Operations Impossible

Life 1,000,000 operations

User Memory Approx. 58 MB

Backup Battery
Coin type lithium manganese dioxide battery CR2032W
Guarantee Period: 1 Year (Operating Temperature at 25°C)
Recommended Replacement Span: Every 5 Years (Operating Temperature at 25°C)

Backup Data Calendar, Log Data, HMI Keep Relays, HMI Keep Registers

Buzzer output Single tone (tone length is adjustable)

Degree of Protection*3 IP66, IP67 (IEC60529) 
TYPE 4X

Weight (approx.) 3.2kg 2.1kg 1.65 kg 1.25 kg 0.65 kg

Radiated Emission
Class A : 10m
40dBµV/m quasi-peak (30M to 230MHz)
47dBµV/m quasi-peak (230M to 1GHz)

Electrostatic Discharge Contact : ±6kV  Air : ±8kV

Electromagnetic Field

10V/m (80 to 1000 MHz)
3V/m (1.4 to 2.0 GHz)
1V/m (2.0 to 2.7 GHz)
80% AM (1kHz)

Fast Transient Burst Power : ±2kV  Communication cable : ±1kV

Surge Immunity ±500V (between +24V and   0V)  ±1kV (between +24V and FE, 0 and FE)

Conducted Radio
Frequency Immunity

3V (Power, Communication cable)  (150kHz to 80MHz)
80% AM (1kHz)
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1.6 Dimensions

■ HG5G-V (15.0inch)
Unit: mm

# The size to the expansion module installation side

<Cable Attached Dimensions>

Depending on the type of connection cable used the dimensions shown above will change.
The dimensions given here are representative values and are intended for reference only.

＃33.0

6.0 48.8
54.8

351.5

27
8.

5
69.5 11

.4

29
1.

5

364.5

27
8.

5

351.5

50

30

55
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■ HG4G-V (12.1inch)
Unit: mm

# The size to the expansion module installation side

<Cable Attached Dimensions>

Depending on the type of connection cable used the dimensions shown above will change.
The dimensions given here are representative values and are intended for reference only.

11
.4

44.4

22
7.

0

6.0 48.1
54.1

＃32.3

314.0

24
0.

0

301.0
22

7.
0

301.010

50

30

55
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■ HG3G-VA (10.4inch)
Unit: mm

# The size to the expansion module installation side

<Cable Attached Dimensions>

Depending on the type of connection cable used the dimensions shown above will change.
The dimensions given here are representative values and are intended for reference only.

44.4 11
.4

19
9.

5

6.0 46.7
52.7

21
2.

0

270.0

257.5

#30.9

21
2.

0

257.5

50 30 55

10
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■ HG3G-V8 (8.4inch)
Unit: mm

# The size to the expansion module installation side

<Cable Attached Dimensions>

Depending on the type of connection cable used the dimensions shown above will change. 
The dimensions given here are representative values and are intended for reference only.

#32.6

17
6.

0

231.0

218.5

15.2

11
.4

54.4
48.46.0

16
3.

5

16
3.

5

218.5

20

40

30
35

50 30 55
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■ HG2G-V (5.7inch)
Unit: mm

# The size to the expansion module installation side

<Cable Attached Dimensions>

Depending on the type of connection cable used the dimensions shown above will change. 
The dimensions given here are representative values and are intended for reference only.

13
4.

7

167.2

152.5

#33.6

12
0.

0

5.0 49.4
54.4

50
12

0.
0

152.54049.4

40
35

55

40
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1.7 Installation

● Operating Environment
For designed performance and safety of the HG5G/4G/3G/2G-V, do not install the HG5G/4G/3G/2G-V in the following 
environments:
• Where dust, briny air, or iron particles exist.
• Where oil or chemical splashes for a long time.
• Where oil mist is filled.
• Where direct sunlight falls on the HG5G/4G/3G/2G-V
• Where strong ultraviolet rays fall on the HG5G/4G/3G/2G-V
• Where corrosive or combustible gasses exist.
• Where the HG5G/4G/3G/2G-V is subjected to shocks or vibrations.
• Where condensation occurs due to rapid temperature change.
• Where high-voltage or arc-generating equipment (electromagnetic contactors or circuit protectors) exists in the vicinity.

● Ambient Temperature
• Allow sufficient space for ventilation, and install the equipment away from heat sources.
• Allow at least 100mm between the HG5G/4G/3G/2G-V and walls or other equipment.
• Do not install the HG5G/4G/3G/2G-V where the ambient temperature exceeds the rated operating ambient 

temperature range. When mounting the HG5G/4G/3G/2G-V in such locations, provide a forced air-cooling fan or 
air-conditioner to keep the ambient temperature within the rated temperature range.

• The HG5G/4G/3G/2G-V is designed to install on a vertical plane so that natural air-cooling is provided. If you install 
it using any other orientation, use forced-air cooling, or lower the ambient operating temperature.

● About Derating
HG5G/4G/3G/2G-V suppresses the temperature rise inside the product by reducing the backlight brightness when the  
ambient operating temperature becomes high.
Relationship between the ambient operating temperature and brightness is as follows.

Depending on each product the values shown above will change. The values given here are representative values are 
intended for reference only.

Operating Temperature
60°C50°C-20°C

40%

0%

Brightness

100%
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● HG5G/4G/3G/2G-V Installation
• Make a panel cut-out on the panel with the dimensions shown below.

• Install the HG5G/4G/3G/2G-V in a panel cut per the chart above. As it is the following figure, fasten the mounting 
clips on the top, bottom, and sides of the unit to secure to the panel.

When mounting  the HG5G/4G/3G/2G-V was installed in the part besides the following figure, it may not satisfy 
product specifications such as waterproof performance, shock resistance and vibration resistance performance.

Mounting Clip Position

  CAUTION

• Do not tighten with excessive force, otherwise the HG5G/4G/3G/2G-V may warp and cause 
wrinkle on the display, or impair the waterproof characteristics.

• If the mounting clips are tightened obliquely to the panel, the HG5G/4G/3G/2G-V may fall off the 
panel.

• When installing the HG5G/4G/3G/2G-V into a panel cut-out, make sure that the gasket is not 
twisted. Especially when re-installing, take special care because any twists in the gasket will 
impair the waterproof characteristics.

B 

A 

Unit: mm

Type No. A B Panel Thickness

HG5G-V 279.0 +2.0
  0 352.0 +2.0

  0 2.0 to 5.0

HG4G-V 227.5 +2.0
  0 301.5 +2.0

  0 2.0 to 5.0

HG3G-VA 200.0 +2.0
  0 258.0 +2.0

  0 2.0 to 5.0

HG3G-V8 164.0 +2.0
  0 219.0 +2.0

  0 2.0 to 5.0

HG2G-V 121.0 +2.0
  0 153.0 +2.0

  0 1.6 to 5.0

TOP

BOTTOM

LEFT RIGHT

Unit : N·m

Type Specified Torque

HG5G-V 0.5 to 0.6

HG4G-V 0.5 to 0.6

HG3G-VA 0.5 to 0.6

HG3G-V8 0.5 to 0.6

HG2G-V 0.2 to 0.3

HG5G-V

BOTTOM

TOP

HG4G/3G-V

BOTTOM

TOP

HG2G-V

Mounting
Clip 

Panel 
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● HG5G/4G/3G/2G-V Orientation
The HG5G/4G/3G/2G-V is designed to install on a vertical landscape. If you install it using any other orientation, 
confirm the limitations about operating temperature and the use of MICROSmart expansion modules.

Orientation
Operating Temperature

w/o expansion modules w/ expansion modules

Vertical

Portrait (Counter Clockwise)

HG5G-V

-20 to 60°C -10 to 50°C
HG4G-V

HG3G-V

HG2G-V

Portrait (Clockwise)

HG5G-V

-20 to 60°C unavailable
HG4G-V

HG3G-V

HG2G-V

Landscape

HG5G-V

-20 to 60°C unavailable
HG4G-V

HG3G-V

HG2G-V

Horizontal

HG5G-V

-20 to 60°C unavailable
HG4G-V

HG3G-V

HG2G-V

• When installing the HG5G/4G/3G/2G-V in a diagonal, the limitations are same as a horizontal.
• Confirm the visibility of the display in a final installation.
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1.8 Wiring

● Power Supply Terminal
• Pin assignment is shown in the following table.

• Use applicable cables for wiring and recommended ferrules (made by Phoenix Contact) as follows.

● Grounding Cautions
If you decide to use a single power supply for the HG5G/4G/3G/2G-V with more than one external device, take extra 
precautions. Some external devices may produce electrical noise and short circuit the entire system setup, therefore, 
damaging the communication circuit of the HG5G/4G/3G/2G-V and non-isolated Communication Device (i.e. PLC).
To prevent such damage, choose a proper solution depending on your system setup.
• Use a separate earth ground from the external noise source device.
• The wire for grounding should be thick and short in order to direct the noise from the noise source device to the 

earth ground.
• Use a separate power supply from the external noise source device.
• Insert an isolator on the communication line of the HG5G/4G/3G/2G-V and the non-isolated communication device 

(i.e. PLC) to prevent damage.

  CAUTION

• Turn off the power supply before wiring.
• Make the wiring as short as possible and run all wires as far away as possible from high-voltage 

and large-current cables. Follow all the procedures and precautions when wiring the HG5G/4G/
3G/2G-V.

• Separate the HG5G/4G/3G/2G-V power supply wiring from the power lines of I/O devices and 
motor equipment.

• Ground the functional earth terminal to make sure of correct operation.

+ Power supply 24V DC (+24V)

- Power supply 0V (0V)

Functional Earth (FE)

Type No. HG5G/4G/3G-V HG2G-V

Applicable cable AWG18 to AWG22 AWG14 to AWG22

Recommended 
Pressure Terminal

AI 0,34-8 TQ
AI 0,5-8 WH
AI 0,75-8 GY
AI 1-8 RD
AI-TWIN 2 x 0,5-8 WH
AI-TWIN 2 x 0,75-8 GY
AI-TWIN 2 x 1-8 RD
(Phoenix Contact)

AI 0,34-12 TQ
AI 0,5-12 WH
AI 0,75-12 GY
AI 1-12 RD
AI 1,5-12 BK
AI 2,5-12 BU
AI-TWIN 2 x 1,5-12 BK
(Phoenix Contact)

Tightening Torque 0.5 to 0.6 N·m 0.5 to 0.6 N·m
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1.9 USB Cable Lock Pin Attachment

When using the USB device, attach the USB Cable Lock Pin to prevent disconnecting the USB cable from the HG5G/4G/
3G/2G-V.

1 Insert the USB cable into the USB2 port.

2 Strain the [Edge part] of the USB Cable Lock Pin, and insert the [Edge part] to the 2 holes upper the USB2 port.

3 Fasten the USB Clamp Band around the USB cable and the [Clamp part], secure them tightly.

Clamp partEdge part

HG5G/4G/3G-V HG2G-V
Upper Holes 

        Upper Holes 

HG5G/4G/3G-V HG2G-V

Fasten the USB Clamp Band without the space between the [Clamp part] and it, and the inclination.

OK

NG NG

With a gap Slanted Slanted

NG
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1.10 Maintenance and Inspection

Maintain and inspect the HG5G/4G/3G/2G-V periodically to ensure the best performance. Do not disassemble, repair, 
or modify the HG5G/4G/3G/2G-V during inspection.

● Replacing the Backup Battery
A backup battery is built into the HG5G/4G/3G/2G-V to retain the internal backup data (log data, keep resister, and 
keep relay) and clock data. 
When the “Replace the battery” message is displayed, replace the backup battery by following the procedure below.
When the “Battery level LOW” message is displayed, replace the battery immediately; otherwise, the backup data and 
clock data may be lost. 
Whether or not to display the reminder message for battery replacement can be specified with the configuration 
software. Refer to Chapter 4 “3.1 System Tab” on page 4-25 for details.

1 Remove the battery holder cover.

2 Turn on the power to the HG5G/4G/3G/2G-V, wait for approximately one minute, and then turn off the power again.

3 Remove the battery from the battery holder.

4 Install a replacement battery into the battery holder. Ensure that the orientation of the battery is correct.

5 With the new batter installed correctly, reverse the instruction the procedure described in item #1 above to secure the 
cover.

• The operating life of the internal battery is approximately five years. It is recommended to replace the battery 
every five years even before the reminder message for battery replacement is displayed.

• IDEC provides replacement service for the battery (at customer’s expense). Contact your vendor or IDEC 
Corporation.

Display
Wipe any stain of the display using a soft cloth slightly dampened with neutral detergent or alcoholic 
solvent. Do not use solvents such as thinner, ammonia, strong acid, and strong alkaline.

Terminals, Connectors
Check the terminals and connectors to make sure of no loose screws, incomplete insertion, or 
disconnected lines.

Mounting Clips
Make sure that all mounting clips and screws are tightened sufficiently. If the mounting clips are 
loose, tighten the screw to the recommended tightening torque.

Backlight
The HG5G/4G/3G/2G-V’s backlight cannot be replaced by the customer. When the backlight 
needs to be replaced. Contact your vendor or IDEC Corporation.

Backup Battery
The operating life of the internal battery is approximately five years. It is recommended to replace 
the battery every five years even before the reminder message for battery replacement is displayed.

Touch Panel

A gap may be caused in the operation accuracy of the touch panel by the secular distortion, etc. 
Readjust the touch panel in the System Mode according to the following procedure when there is 
a gap in the operation of the touch panel. Refer to “Adjusting the Touch Panel” on page 35-21 
for details.

After turning off the power to the HG5G/4G/3G/2G-V in step 2, complete the steps through 4 within 30 
seconds to replace the battery without losing the backup data and clock data. However, it is recommended 
that the backup data be transferred to flash memory as a precautionary measure. For the procedure to 
transfer the data to flash memory, refer to Chapter 33 “Internal Devices” on page 33-1. If it is not necessary 
to save the data, step 2 can be skipped.

(+) side 
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Handling of Batteries and Devices with Built-in Batteries in EU Member States

Note) The following symbol mark is for EU countries only and is according to the directive 2006/66/EC Article 20 
information for end-users and Annex II.

This symbol mark means that batteries and accumulators, at their end-of life, should be disposed of separately from 
your household waste.

If a chemical symbol is printed beneath the symbol shown above, this chemical symbol means that the battery or 
accumulator contains a heavy metal at a certain concentration. This will be indicated as follows :
Hg : mercury (0.0005%), Cd : cadmium (0.002%), Pd : lead (0.004%)

In the European Union there are separate collection systems for used batteries and accumulators.
Please dispose of batteries and accumulators correctly in accordance with each country or local regulation.

● Maintenance Screen
Turn on the power to the HG5G/4G/3G/2G-V, then press and hold the touch panel on the upper-left corner of the 
screen for three seconds or longer. The Maintenance Screen appears on the screen.

• Permission to show the Maintenance Screen can be set using the configuration software. Refer to Chapter 4 “3.1 
System Tab” on page 4-25 for details.

• The Maintenance Screen is not displayed in the System Mode.

 WARNING

The battery may be regulated by national or local regulation. Observe the instructions of proper 
regulation. As electric capacity is left in a discarded battery and it comes into contact with other 
metals, it could lead to distortion, leakage, overheating, or explosion, so make sure to cover the (+) 
and (-) terminals with insulating tape before disposal.

  CAUTION

When replacing the battery, use the specified battery only. Note that any problems and failures 
arising from or in connection with the use of a battery other than the specified battery is not 
guaranteed.

Maintenance Screen 

Maintenance

System Mode

Device Monitor

Adjust Brightness
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● System Mode
Press the [System Mode] at the top of the Maintenance Screen. The Top Page Screen appears.

Initial Setting, Self Diagnosis and Initialization of the data, etc can be executed in the System Mode.

● Adjusting the Brightness
The brightness of the HG5G/4G/3G/2G-V display can be adjusted on the Adjust Brightness Screen.

1 Press the [Adjust Brightness] at the bottom of the Maintenance Screen. The Adjust Brightness Screen appears.

2 Press the [<<] and [>>] at the bottom the Adjust Brightness Screen to adjust the contrast to the optimal setting.

3 Press the [X] to close the Adjust Brightness Screen.

Run Offline Main Menu

BRIGHTNESS 31

MAC Address  00:03:7B:F0:12:A8
IP Address  192.168.0.1(DHCP)

2010/OCT/14/THU   14:56:44

IDEC HG G SERIES
SYSTEM MODE TOP PAGE

ENG/JPN

Maintenance

System Mode

Device Monitor

Adjust Brightness

Maintenance

Adjust Brightness

To adjust the brightness in the System Mode, use the [<<] and [>>] buttons located at the bottom of the 
Top Page.

BRIGHTNESS 31

MAC Address  00:03:7B:F0:12:A8
IP Address  192.168.0.1(DHCP)

2010/OCT/14/THU   14:56:44

IDEC HG G SERIES
SYSTEM MODE TOP PAGE

ENG/JPN

Run Offline Main Menu
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● Adjusting the Touch Panel
A gap may be caused in the operation accuracy of the touch panel by the secular distortion, etc. Adjust the touch 
panel according to the following procedure when there is a gap in the operation of the touch panel.

1 Press the Main Menu on the Top Page in System Mode. The Main Menu Screen appears.

2 Press in order of Initial Setting, Initialize, Touch Panel Adjust. The confirmation screen appears and asks 
“Adjust Touch Panel setting?”. Press Yes, then the Touch Panel Adjust screen appears.

3 Press the center of the X mark, then the position of the mark changes one after another. Press five marks 
sequentially.

4 When normally recognized, the confirmation screen of 2 is restored.

At procedure 3, when pressing a point away from the center of the X mark, a recognition error will result. Then the X 
mark returns to the initial position, then repeat the procedure of 3 again.

BRIGHTNESS 31

MAC Address  00:03:7B:F0:12:A8
IP Address  192.168.0.1(DHCP)

2010/OCT/14/THU   14:56:44

IDEC HG G SERIES
SYSTEM MODE TOP PAGE

ENG/JPN

Run Offline Main Menu

Press the center of the X mark. 
This will ensure the accuracy of the touch panel operation.
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2.1 Packing content

Before installing the HG4G/3G, HG2G-5F, make sure that the specifications of the product conform to your 
requirements, and that no parts are missing or damaged due to accidents during transportation.

2.2 Type No.

2 HG4G/3G, HG2G-5F

Name HG4G/3G HG2G-5F

HG4G/3G, HG2G-5F Unit

Instruction Sheet x 1 x 1

Mounting clips

Communication plug for external devices
(Attached to the HG4G/3G, HG2G-5F)

USB Cable Lock Pin

USB Clamp Band

Screw lock bracket
Metric Screw Thread
M2.6 x 0.45

x 1 x 1

x 4 x 4

x 1 x 1

x 1 x 1

x 1 x 1

x 2 x 2

LCD size AUDIO IN/VIDEO IN Bezel color Type No.

12.1 inch
Without Dark gray HG4G-CJT22TF-B

With Dark gray HG4G-CJT22MF-B

10.4 inch

Without
Light gray HG3G-AJT22TF-W

Dark gray HG3G-AJT22TF-B

With
Light gray HG3G-AJT22MF-W

Dark gray HG3G-AJT22MF-B

8.4 inch

Without
Light gray HG3G-8JT22TF-W

Dark gray HG3G-8JT22TF-B

With
Light gray HG3G-8JT22MF-W

Dark gray HG3G-8JT22MF-B

5.7 inch Without

Light gray HG2G-5FT22TF-W

Dark gray HG2G-5FT22TF-B

Silver HG2G-5FT22TF-S
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2.3 Part Names

■ HG4G (12.1inch)

■ HG3G-A (10.4inch)

■ HG3G-8 (8.4inch)

(2)
(3)

(1)

(11)
(10)
(9)
(8)

(12) (13)(14)

(4)(5)(6)(7)(16)(17)

(15)

(1)

(11)
(10)
(9)
(8)

(12) (13)(14)

(4) (5)(6)(7)(16)(17)

(15)

(2)
(3)

(1)

(11)
(10)
(9)
(8)

(12) (13)(14)

(4) (5) (6)(7)(16)(17)

(15)

(2)
(3)
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■ HG2G-5F (5.7inch)

No. Name Description

(1) POWER LED
Green (lit) : Normal Operation (Power is ON.)
Not lit : Power is off.

(2) Display

(3) Touch Panel

(4) Power Supply Terminal

(5) Serial Interface (COM2) RS232C, RS422/485 Connector : Terminal Block 9-pin

(6) Serial Interface (COM1) RS232C, RS422/485 Connector : D-sub 9-pin

(7) Audio Interface (AUDIO OUT)
LINE OUT (Stereo) Connector : Mini Jack (φ3.5mm)
(Except for HG2G-5F)

(8) Ethernet Interface (LAN)
IEEE802.3u 10BASE-T/100BASE-TX Connector : RJ-45
(With Auto MDI/MDI-X function)

(9) USB Interface (USB1) USB2.0 (Device) Connector : Mini-B

(10) USB Interface (USB2) USB2.0 (Host) Connector : Type A  Output current : 5V 500mA

(11) Memory Card Interface (SD) For SD memory card

(12) SD Memory Card Access Lamp

(13) Expansion Module Interface (EXT) For IDEC MICROSmart Expansion Modules

(14) Battery Cover

(15) Terminating Resistor Selector Switch For COM2 RS422/485 interface

(16) Audio Interface (AUDIO IN)
LINE IN (Stereo) Connector : Mini Jack (φ3.5mm)
(Except for HG2G-5F)

(17) Video Interface (VIDEO IN) NTSC/PAL Connector : Pin Jack (Except for HG2G-5F)

(2)
(3)

(1)

(11)

(8)

(12)

(13)(14)

(15)
(5) (6)(10)(9) (4)
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2.4 External Interfaces

● Serial Interface (COM1)

  CAUTION

• Make sure to turn off the power to the HG4G/3G, HG2G-5F before wiring each interface or 
switching the terminating resistor selector switch.

• Note that only one of the RS232C or RS422/485 interfaces can be used at one time. Wiring both 
interfaces will result in failure of the HG4G/3G, HG2G-5F. Wire only the interface used.

Interface Specification RS232C, RS422/485

Connector D-sub 9-pin (Plug)

Screw lock bracket Inch Screw Thread #4-40 UNC

No. Name I/O Function Communication type

1 4W-RDA/2W-A IN/INOUT Receive Data (+) [4W]/ Send and Receive Data (+) [2W] RS422/485

2 RD IN Receive Data RS232C

3 SD OUT Send Data RS232C

4 4W-SDA OUT Send Data (+) [4W] RS422/485

5 SG - Signal Ground -

6 4W-RDB/2W-B IN/INOUT Receive Data (-) [4W]/ Send and Receive Data (-) [2W] RS422/485

7 RS OUT Request to Send RS232C

8 CS IN Clear to Send RS232C

9 4W-SDB OUT Send Data (-) [4W] RS422/485

1 5

6 9
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● Serial Interface (COM2)
Use applicable cables for wiring and recommended ferrules (made by Phoenix Contact) as follows.

• Terminating Resistor Selector Switch (for RS422/485 interface)

When using RS422/485 interface, set the Terminating Resistor Selector Switch to the ON side. This will connect the 
internal terminating resistor (120Ω) between RDA and RDB.

● Expansion Module Interface (EXT)
IDEC MICROSmart expansion modules can be connected to the HG4G/3G, HG2G-5F.
Refer to Chapter 30 “1.2 Applicable Expansion Modules” on page 30-2 for the number, the types and the combination 
of the expansion modules that can be installed.

Interface Specification RS232C, RS422/485

Connector Detachable Terminal Block 9-pin

Applicable cable AWG20 to AWG22

Recommended Pressure Terminal

AI 0,34-8 TQ
AI 0,5-8 WH
AI-TWIN 2 x 0,5-8 WH
(Phoenix Contact)

Tightening Torque 0.22 to 0.25 N•m

No. Name I/O Function Communication type

1 SD OUT Send Data

RS232C

2 RD IN Receive Data

3 RS OUT Request to Send

4 CS IN Clear to Send

5 SG ― Signal Ground

RS422/485

6 4W-SDA OUT Send Data (+) [4W]

7 4W-SDB OUT Send Data (-) [4W]

8 4W-RDA/2W-A IN/INOUT
Receive Data (+) [4W]/ Send and Receive Data 
(+) [2W]

9 4W-RDB/2W-B IN/INOUT
Receive Data (-) [4W]/ Send and Receive Data (-) 
[2W]

No.9No.1

ON OFF 
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2.5 Specifications

■ Applicable Standards

■ Environmental Specifications

■ Electrical Specifications

■ Construction Specifications

*1 When using the HG4G/3G, HG2G-5F as the EMC Standard Approved Products, or when using the HG4G/3G, HG2G-5F as the 
Ship Classification Standard Approved Products, attach a ferrite core (ZCAT3035-1330 manufactured by TDK Corporation) to 
the power cables and the communication cables.

Safety Standard
UL508, ANSI/ISA-12.12.01
CSA C22.2 No.142 (c-UL)
CSA C22.2 No.213 (c-UL)

EMC Standard*1 IEC/EN 61131-2

Ship Classification Standard *1 ABS, DNV, LR, NK

Ferrite Core：ZCAT3035-1330（TDK）

Operating Temperature 0 to 50°C

Operating Humidity 10 to 90% RH (no condensation)

Storage Temperature -20 to +60°C

Storage Humidity 10 to 90% RH (no condensation)

Altitude 0 to 2000m

Pollution Degree 2

Corrosion Immunity Free from corrosive gases

Type No. HG4G HG3G-A HG3G-8 HG2G-5F

Rated Voltage 24V DC

Power Consumption 27W maximum 25W maximum 19W maximum

When not using USB Interface 
(USB2) and Expansion Module 
Interface (EXT)

18W maximum 15W maximum 10W maximum

Power Voltage Range 20.4 to 28.8V DC

Allowable Momentary Power 
Interruption

10 ms maximum

Inrush Current 30A maximum

Dielectric Withstand Voltage AC1000V, 10mA, 1 minute (between power and earth terminals)

Vibration 5 to 8.4Hz amplitude 3.5mm, 8.4 to 150Hz acceleration 9.8m/s2

10 times on each of three mutually perpendicular axes (100 minutes)    (IEC61131-2)

Shock 147m/s2, 11ms (5 shocks on each of three mutually perpendicular axes)    
(IEC61131-2)
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■ Performance Specifications

■ EMC Specifications

*2 Please be aware that small black and bright dots might show up on LCD Screen: it is not a failure or malfunction.
*3 The time until brightness becomes 50% of the initial value.

The life of the LCD itself at an ambient temperature of 25°C. This is not a guaranteed value. The actual life depends on the 
environment and conditions of use.

*4 The degree of protection for the operating section after the panel is attached. The compliance test has been passed, but this 
is not a guarantee of operation in all environments. Not a guarantee in all usage environments with oil materials.

Type No. HG4G HG3G-A HG3G-8 HG2G-5F

Display

LCD Type*2 TFT color LCD (TN Type)

Display Colors 65536 Colors

Effective Display Area (W × H) 246.0 × 184.5 mm 211.2 × 158.4 mm 170.4 × 127.8 mm 115.2 × 86.4 mm

Display Resolution (W × H) 800 × 600 dots 640 × 480 dots

View angle Left/Right: 80°, Top: 80°, Bottom: 60°
Left/Right/Top/
Bottom: 80°

Brightness of LCD only 550 cd/m2 700 cd/m2 600 cd/m2 800 cd/m2

Brightness Adjustment 48 levels

Backlight LED

Backlight Life*3 Approx. 100,000 hours Approx. 50,000 hours

Touch 
Panel

Switch Type Analog Resistive Film

Operating Force 3N maximum 0.55 to 2.3 N 3N maximum

Multiple Operations Impossible

Life 1,000,000 operations

User Memory Approx. 12 MB

Backup Battery

Coin type lithium manganese dioxide battery CR2032
Guarantee Period: 1 Year (Operating Temperature at 25°C)
Recommended Replacement Span: Every 5 Years (Operating Temperature at 
25°C)

Backup Data Calendar, Log Data, HMI Keep Relays, HMI Keep Registers

Buzzer output Single tone (tone length is adjustable)

Degree of Protection*4
IP66 (IEC60529) 
TYPE 4X
TYPE 13

Weight (approx.) 2.1kg 1.65 kg 1.25 kg 0.65 kg

Radiated Emission
Class A : 10m
40dBµV/m quasi-peak (30M to 230MHz)
47dBµV/m quasi-peak (230M to 1GHz)

Electrostatic Discharge
Contact : ±6kV
Air : ±8kV

Electromagnetic Field

10V/m (80 to 1000 MHz)
3V/m (1.4 to 2.0 GHz)
1V/m (2.0 to 2.7 GHz)
80% AM (1kHz)

Fast Transient Burst
Power : ±2kV
Communication cable : ±1kV

Surge Immunity
±500V (between +24V and 0V)
±1kV (between +24V and FE, 0 and FE)

Conducted Radio
Frequency Immunity

3V (Power, Communication cable)
(150kHz to 80MHz)
80% AM (1kHz)
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2.6 Dimensions

■ HG4G (12.1inch)
Unit: mm

# The size to the expansion module installation side

<Cable Attached Dimensions>

Depending on the type of connection cable used the dimensions shown above will change.
The dimensions given here are representative values and are intended for reference only.

32.3 #

44.4

54.1

48.1

22
7.

0

24
0.

0

11
.4

37
.9

6.0

314.0

301.0

10 301.0

22
7.

0

5550

30
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■ HG3G-A (10.4inch)
Unit: mm

# The size to the expansion module installation side

<Cable Attached Dimensions>

Depending on the type of connection cable used the dimensions shown above will change.
The dimensions given here are representative values and are intended for reference only.

30.9 #

44.4

52.7

46.7

19
9.

5

21
2.

0

11
.4

36
.5

6.0

270.0

257.5

10 257.5

19
9.

5

5550

30



WindO/I-NV4 User’s Manual 35-31

2 HG4G/3G, HG2G-5F

35

M
ICRO

/I Specifications

■ HG3G-8 (8.4inch)
Unit: mm

# The size to the expansion module installation side

<Cable Attached Dimensions>

Depending on the type of connection cable used the dimensions shown above will change. 
The dimensions given here are representative values and are intended for reference only.

32.6 #

15.2

54.4

48.4

16
3.

5

17
6.

0

11
.4

38
.2

6.0

231.0

218.5

20

40

30

35

218.5

16
3.

5

5550

30
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■ HG2G-5F (5.7inch)
Unit: mm

# The size to the expansion module installation side

<Cable Attached Dimensions>

Depending on the type of connection cable used the dimensions shown above will change. 
The dimensions given here are representative values and are intended for reference only.

33.6 #

12
0.

0

13
4.

7

54
.4

5.
0

167.2

152.5

55

40

4049.4

35

152.5

40

12
0.

0
50
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2.7 Installation

● Operating Environment
For designed performance and safety of the HG4G/3G, HG2G-5F, do not install the HG4G/3G, HG2G-5F in the 
following environments:
• Where dust, briny air, or iron particles exist.
• Where oil or chemical splashes for a long time.
• Where oil mist is filled.
• Where direct sunlight falls on the HG4G/3G, HG2G-5F.
• Where strong ultraviolet rays fall on the HG4G/3G, HG2G-5F.
• Where corrosive or combustible gasses exist.
• Where the HG4G/3G, HG2G-5F is subjected to shocks or vibrations.
• Where condensation occurs due to rapid temperature change.
• Where high-voltage or arc-generating equipment (electromagnetic contactors or circuit protectors) exists in the vicinity.

● Ambient Temperature
• Allow sufficient space for ventilation, and install the equipment away from heat sources.
• Allow at least 100mm between the HG4G/3G, HG2G-5F and walls or other equipment.
• Do not install the HG4G/3G, HG2G-5F where the ambient temperature exceeds the rated operating ambient 

temperature range. When mounting the HG4G/3G, HG2G-5F in such locations, provide a forced air-cooling fan or 
air-conditioner to keep the ambient temperature within the rated temperature range.

• The HG4G/3G, HG2G-5F is designed to install on a vertical plane so that natural air-cooling is provided. If you 
install it using any other orientation, use forced-air cooling, or lower the ambient operating temperature.

● HG4G/3G, HG2G-5F Installation
• Make a panel cut-out on the panel with the dimensions shown below.

• Use the attached mounting clips to tighten the screws evenly to mount panel: screws must be applied on total of 
four places on top and bottom with the specified torque.
Mounting clips can be attached to the left and right sides of HG4G and HG2G-5F. However, if they are  attached in 
such way, there is a risk of not satisfying product specifications such as waterproof performance, shock resistance, 
and vibration resistance performance.

Mounting Clip Position  ex) HG3G-8 (8.4 inch)

  CAUTION

• Do not tighten with excessive force, otherwise the HG4G/3G, HG2G-5F may warp and cause 
wrinkle on the display, or impair the waterproof characteristics.

• If the mounting clips are tightened obliquely to the panel, the HG4G/3G, HG2G-5F may fall off the 
panel.

• When installing the HG4G/3G, HG2G-5F into a panel cut-out, make sure that the gasket is not 
twisted. Especially when re-installing, take special care because any twists in the gasket will 
impair the waterproof characteristics.

B 

A 

Unit: mm

Type No. A B Panel Thickness

HG4G 227.5 +2.0
  0 301.5 +2.0

  0 2.0 to 5.0

HG3G-A 200.0 +2.0
  0 258.0 +2.0

  0 2.0 to 5.0

HG3G-8 164.0 +2.0
  0 219.0 +2.0

  0 2.0 to 5.0

HG2G-5F 121.0 +2.0
  0 153.0 +2.0

  0 1.6 to 5.0

 

TOP 

Panel 

BOTTOM 

Mounting 
Clip 

Unit : N·m

Type Specified Torque

HG4G 0.5 to 0.6

HG3G-A 0.5 to 0.6

HG3G-8 0.5 to 0.6

HG2G-5F 0.2 to 0.3
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● HG4G/3G, HG2G-5F Orientation
The HG4G/3G, HG2G-5F is designed to install on a vertical landscape. If you install it using any other orientation, 
confirm the limitations about operating temperature and the use of MICROSmart expansion modules.

*1 When I/O Simultaneous ON Ratio is 50% or less, the Ambient Temperature is 0 to 45°C.

Orientation
Operating Temperature

w/o expansion modules w/ expansion modules

Vertical

Landscape

HG4G

0 to 50°C

0 to 50°C

HG3G 0 to 45°C

HG2G-5F 0 to 40°C*1

Portrait (Clockwise)

HG4G

0 to 50°C unavailableHG3G

HG2G-5F

Portrait (Counter Clockwise)

HG4G 0 to 50°C 0 to 45°C

HG3G
0 to 45°C

0 to 40°C*1

HG2G-5F 0 to 35°C

Horizontal

HG4G 0 to 50°C

unavailableHG3G
0 to 45°C

HG2G-5F

• When installing the HG4G/3G, HG2G-5F in a diagonal, the limitations are same as a horizontal.
• Confirm the visibility of the display in a final installation.



WindO/I-NV4 User’s Manual 35-35

2 HG4G/3G, HG2G-5F

35

M
ICRO

/I Specifications

2.8 Wiring

● Power Supply Terminal
• Pin assignment is shown in the following table.

• Use applicable cables for wiring and recommended ferrules (made by Phoenix Contact) as follows.

● Grounding Cautions
If you decide to use a single power supply for the HG4G/3G, HG2G-5F with more than one external device, take extra 
precautions. Some external devices may produce electrical noise and short circuit the entire system setup, therefore, 
damaging the communication circuit of the HG4G/3G, HG2G-5F and non-isolated Communication Device (i.e. PLC).
To prevent such damage, choose a proper solution depending on your system setup.
• Use a separate earth ground from the external noise source device.
• The wire for grounding should be thick and short in order to direct the noise from the noise source device to the 

earth ground.
• Use a separate power supply from the external noise source device.
• Insert an isolator on the communication line of the HG4G/3G, HG2G-5F and the non-isolated communication device 

(i.e. PLC) to prevent damage.

● Cautions for using the HG4G/3G, HG2G-5F connected to a personal computer
When connecting the HG4G/3G, HG2G-5F to a personal computer via the Serial Interface(COM1) or USB Interface, 
the HG4G/3G, HG2G-5F or the personal computer may break down depending on the conditions of the personal 
computer. Make sure of the following cautions, in order to prevent an accident.
• If the personal computer has a 3-pin power plug or power plug with a ground lead type. make sure to use a plug 

socket including a ground input electrode or ground the earth lead, respectively.
• If the personal computer has a 2-pin power plug without ground lead, follow the procedure below when connect 

the HG4G/3G, HG2G-5F to the personal computer.
(1) Pull out the power plug of the personal computer from the AC outlet.
(2) Connect the HG4G/3G, HG2G-5F to the personal computer.
(3) Insert the power plug of the personal computer into the AC outlet.

  CAUTION

• Turn off the power supply before wiring.
• Make the wiring as short as possible and run all wires as far away as possible from high-voltage 

and large-current cables. Follow all the procedures and precautions when wiring the HG4G/3G, 
HG2G-5F.

• Separate the HG4G/3G, HG2G-5F power supply wiring from the power lines of I/O devices and 
motor equipment.

• Ground the functional earth terminal to make sure of correct operation.

+ Power supply 24V DC (+24V)

- Power supply 0V (0V)

Functional Earth (FE)

Type No. HG4G/3G HG2G-5F

Applicable cable AWG18 to AWG22 AWG14 to AWG22

Recommended 
Pressure Terminal

AI 0,34-8 TQ
AI 0,5-8 WH
AI 0,75-8 GY
AI 1-8 RD
AI-TWIN 2 x 0,5-8 WH
AI-TWIN 2 x 0,75-8 GY
AI-TWIN 2 x 1-8 RD
(Phoenix Contact)

AI 0,34-12 TQ
AI 0,5-12 WH
AI 0,75-12 GY
AI 1-12 RD
AI 1,5-12 BK
AI 2,5-12 BU
AI-TWIN 2 x 1,5-12 BK
(Phoenix Contact)

Tightening Torque 0.5 to 0.6 N·m 0.5 to 0.6 N·m
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2.9 USB Cable Lock Pin Attachment

When using the USB device, attach the USB Cable Lock Pin to prevent disconnecting the USB cable from the HG4G/3G, 
HG2G-5F.

1 Insert the USB cable into the USB2 port.

2 Strain the [Edge part] of the USB Cable Lock Pin, and insert the [Edge part] to the 2 holes upper the USB2 port.

3 Fasten the USB Clamp Band around the USB cable and the [Clamp part], secure them tightly.

Clamp partEdge part

HG4G/3G HG2G-5F
Upper Holes 

        Upper Holes 

HG4G/3G HG2G-5F

Fasten the USB Clamp Band without the space between the [Clamp part] and it, and the inclination.

OK

NG NG

With a gap Slanted Slanted

NG
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2.10 Maintenance and Inspection

Maintain and inspect the HG4G/3G, HG2G-5F periodically to ensure the best performance. Do not disassemble, repair, 
or modify the HG4G/3G, HG2G-5F during inspection.

● Replacing the Backup Battery
A backup battery is built into the HG4G/3G, HG2G-5F to retain the internal backup data (log data, keep resister, and 
keep relay) and clock data. 
When the “Replace the battery” message is displayed, replace the backup battery by following the procedure below.
When the “Battery level LOW” message is displayed, replace the battery immediately; otherwise, the backup data and 
clock data may be lost. 
Whether or not to display the reminder message for battery replacement can be specified with the configuration 
software. Refer to Chapter 4 “3.1 System Tab” on page 4-25 for details.

1 Remove the battery holder cover.

2 Turn on the power to the HG4G/3G, HG2G-5F, wait for approximately one minute, and then turn off the power again.

3 Remove the battery from the battery holder.

4 Install a replacement battery into the battery holder. Ensure that the orientation of the battery is correct.

5 With the new batter installed correctly, reverse the instruction the procedure described in item #1 above to secure the 
cover.

• The operating life of the internal battery is approximately five years. It is recommended to replace the battery 
every five years even before the reminder message for battery replacement is displayed.

Display
Wipe any stain of the display using a soft cloth slightly dampened with neutral detergent or alcoholic 
solvent. Do not use solvents such as thinner, ammonia, strong acid, and strong alkaline.

Terminals, Connectors
Check the terminals and connectors to make sure of no loose screws, incomplete insertion, or 
disconnected lines.

Mounting Clips
Make sure that all mounting clips and screws are tightened sufficiently. If the mounting clips are 
loose, tighten the screw to the recommended tightening torque.

Backlight
The HG4G/3G, HG2G-5F’s backlight cannot be replaced by the customer. When the backlight 
needs to be replaced. Contact your vendor or IDEC Corporation.

Backup Battery
The operating life of the internal battery is approximately five years. It is recommended to replace 
the battery every five years even before the reminder message for battery replacement is displayed.

Touch Panel

A gap may be caused in the operation accuracy of the touch panel by the secular distortion, etc. 
Readjust the touch panel in the System Mode according to the following procedure when there is 
a gap in the operation of the touch panel. Refer to “Adjusting the Touch Panel” on page 35-40 
for details.

After turning off the power to the HG4G/3G, HG2G-5F in step 2, complete the steps through 4 within 30 
seconds to replace the battery without losing the backup data and clock data. However, it is recommended 
that the backup data be transferred to flash memory as a precautionary measure. For the procedure to 
transfer the data to flash memory, refer to Chapter 33 “Internal Devices” on page 33-1. If it is not necessary 
to save the data, step 2 can be skipped.

 

(+) side 
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• IDEC provides replacement service for the battery (at customer’s expense). Contact your vendor or IDEC 
Corporation.

Handling of Batteries and Devices with Built-in Batteries in EU Member States

Note) The following symbol mark is for EU countries only and is according to the directive 2006/66/EC Article 20 
information for end-users and Annex II.

This symbol mark means that batteries and accumulators, at their end-of life, should be disposed of separately from 
your household waste.

If a chemical symbol is printed beneath the symbol shown above, this chemical symbol means that the battery or 
accumulator contains a heavy metal at a certain concentration. This will be indicated as follows :
Hg : mercury (0.0005%), Cd : cadmium (0.002%), Pd : lead (0.004%)

In the European Union there are separate collection systems for used batteries and accumulators.
Please dispose of batteries and accumulators correctly in accordance with each country or local regulation.

● Maintenance Screen
Turn on the power to the HG4G/3G, HG2G-5F, then press and hold the touch panel on the upper-left corner of the 
screen for three seconds or longer. The Maintenance Screen appears on the screen.

• Permission to show the Maintenance Screen can be set using the configuration software. Refer to Chapter 4 “3.1 
System Tab” on page 4-25 for details.

• The Maintenance Screen is not displayed in the System Mode.

 WARNING

The battery may be regulated by national or local regulation. Observe the instructions of proper 
regulation. As electric capacity is left in a discarded battery and it comes into contact with other 
metals, it could lead to distortion, leakage, overheating, or explosion, so make sure to cover the (+) 
and (-) terminals with insulating tape before disposal.

  CAUTION

When replacing the battery, use the specified battery only. Note that any problems and failures 
arising from or in connection with the use of a battery other than the specified battery is not 
guaranteed.

Maintenance Screen 

Maintenance

System Mode

Device Monitor

Adjust Brightness
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● System Mode
Press the [System Mode] at the top of the Maintenance Screen. The Top Page Screen appears.

Initial Setting, Self Diagnosis and Initialization of the data, etc can be executed in the System Mode.

● Adjusting the Brightness
The brightness of the HG4G/3G, HG2G-5F display can be adjusted on the Adjust Brightness Screen.

1 Press the [Adjust Brightness] at the bottom of the Maintenance Screen. The Adjust Brightness Screen appears.

2 Press the [<<] and [>>] at the bottom the Adjust Brightness Screen to adjust the contrast to the optimal setting.

3 Press the [X] to close the Adjust Brightness Screen.

Run Offline Main Menu

BRIGHTNESS 31

MAC Address  00:03:7B:F0:12:A8
IP Address  192.168.0.1(DHCP)

2010/OCT/14/THU   14:56:44

IDEC HG G SERIES
SYSTEM MODE TOP PAGE

ENG/JPN

Maintenance

System Mode

Device Monitor

Adjust Brightness

Maintenance

Adjust Brightness

To adjust the brightness in the System Mode, use the [<<] and [>>] buttons located at the bottom of the 
Top Page.

BRIGHTNESS 31

MAC Address  00:03:7B:F0:12:A8
IP Address  192.168.0.1(DHCP)

2010/OCT/14/THU   14:56:44

IDEC HG G SERIES
SYSTEM MODE TOP PAGE

ENG/JPN

Run Offline Main Menu
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● Adjusting the Touch Panel
A gap may be caused in the operation accuracy of the touch panel by the secular distortion, etc. Adjust the touch 
panel according to the following procedure when there is a gap in the operation of the touch panel.

1 Press the Main Menu on the Top Page in System Mode. The Main Menu Screen appears.

2 Press in order of Initial Setting, Initialize, Touch Panel Adjust. The confirmation screen appears and asks 
“Adjust Touch Panel setting?”. Press Yes, then the Touch Panel Adjust screen appears.

3 Press the center of the X mark, then the position of the mark changes one after another. Press five marks 
sequentially.

4 When normally recognized, the confirmation screen of 2 is restored.

At procedure 3, when pressing a point away from the center of the X mark, a recognition error will result. Then the X 
mark returns to the initial position, then repeat the procedure of 3 again.

BRIGHTNESS 31

MAC Address  00:03:7B:F0:12:A8
IP Address  192.168.0.1(DHCP)

2010/OCT/14/THU   14:56:44

IDEC HG G SERIES
SYSTEM MODE TOP PAGE

ENG/JPN

Run Offline Main Menu

Press the center of the X mark. 
This will ensure the accuracy of the touch panel operation.
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3.1 Packing content

Before installing the HG2G-5T, HG1G, make sure that the specifications of the product conform to your requirements, 
and that no parts are missing or damaged due to accidents during transportation.

3.2 Type No.

3 HG2G-5T, HG1G

Name HG2G-5T HG1G

HG2G-5T, HG1G Unit

Instruction Sheet
 (Japanese/English/Simplified Chinese)

x 1 x 1

Mounting clips

Communication plug for external devices
 (Attached to the HG2G-5T, HG1G)

USB Cable Lock Pin

USB Clamp Band

x 1 x 1

x 4 x 2

x 1 x 1

x 1 x 2

x 1 x 2

LCD size Bezel color Type No.

5.7 inch TFT Monochrome LCD

Light gray HG2G-5TN22TF-W

Dark gray HG2G-5TN22TF-B

Silver HG2G-5TN22TF-S

5.7 inch TFT Color LCD

Light gray HG2G-5TT22TF-W

Dark gray HG2G-5TT22TF-B

Silver HG2G-5TT22TF-S

4.3 inch TFT Color LCD
Black HG1G-4VT22TF-B

Silver HG1G-4VT22TF-S
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3.3 Part Names

■ HG2G-5T

No. Name Description

(1) POWER LED
Green (lit) : Normal Operation (Power is ON.)
Not lit : Power is off.

(2) Display

(3) Touch Panel

(4) Power Supply Terminal

(5) Serial Interface (SERIAL1) RS232C, RS422/485 Connector : Terminal Block 9-pin

(6) Ethernet Interface (LAN)
IEEE802.3u 10BASE-T/100BASE-TX Connector : RJ-45
(With Auto MDI/MDI-X function)

(7) Battery Cover

(8) Terminating Resistor Selector Switch For RS422/485 interface

(9) Mounting Clip Position 

(10) USB Interface (USB) USB2.0 (Device) Connector : Mini-B

(11) USB Interface (USB2) USB2.0 (Host) Connector: Type A  Output current : 5V 500mA

(2) (3) (7)(9)(9)

(1)(6) (4) (9) (8) (5) (9) (10) (11)
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■ HG1G

*1 Operating temperature range will be -20 to +50 ° C if USB interface is used with 151 mA or more.

No. Name Description

(1) Display

(2) Touch Panel

(3) Power Supply Terminal

(4) Serial Interface (COM) RS232C, RS422/485 Connector : Terminal Block 9-pin

(5) Ethernet Interface (LAN)
IEEE802.3u 10BASE-T/100BASE-TX Connector : RJ-45
(With Auto MDI/MDI-X function)

(6) Battery Cover

(7) Mounting Clip Position 

(8) USB Interface (USB1) USB2.0 (Device) Connector : Mini-B

(9) USB Interface (USB2) USB2.0 (Host) Connector: Type A  Output current : 5V 500mA*1 

(1) (2) (3) (7) (6) (8)(9)(5)

(4) (7)
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3.4 External Interfaces

● Serial Interface
Use applicable cables for wiring and recommended ferrules (made by Phoenix Contact) as follows.

Using RS422/485 interface

• For HG2G-5T, if you set the Terminating Resistor Selector Switch to the ON side, this will connect the internal 
terminating resistor (100Ω) between RDA and RDB.
Terminating Resistor Selector Switch

• HG1G is not equipped with terminating resistor. Insert a terminating resistor of an appropriate value (about 100 to 
120 Ohm, 1/2 W minimum) between terminal number 8 (RDA) and terminal number 9 (RDB), if necessary.

  CAUTION

Make sure to turn off the power to the HG2G-5T, HG1G before wiring each interface or switching the
terminating resistor selector switch.

Interface Specification RS232C, RS422/485

Connector Detachable Terminal Block 9-pin

Applicable cable AWG20 to AWG22

Recommended Pressure Terminal

AI 0,34-8 TQ
AI 0,5-8 WH
AI-TWIN 2 x 0,5-8 WH
(Phoenix Contact)

Tightening Torque 0.22 to 0.25 N·m

No. Name I/O Function Communication type

1 SD OUT Send Data

RS232C

2 RD IN Receive Data

3 RS OUT Request to Send

4 CS IN Clear to Send

5 SG - Signal Ground

RS422/485

6 SDA OUT Send Data (+)

7 SDB OUT Send Data (-)

8 RDA IN Receive Data (+)

9 RDB IN Receive Data (-)

No.9No.1

ON OFF 

Terminal Number 8 (RDA)

Terminal Number 9 (RDB)
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3.5 Specifications

■ Applicable Standards

■ Environmental Specifications

■ Electrical Specifications

■ Construction Specifications

*1 When using the HG2G-5T, HG1G as the EMC Standard Approved Products, refer to the precautions on the emission. 
*2 When using a USB interface(USB2) by 151mA or more, operating temperature will be -20 to +50°C.

Safety Standard
UL508, ANSI/ISA 12.12.01,
CSA C22.2 No.142 (c-UL),
CSA C22.2 No.213 (c-UL)

EMC Standard*1 IEC/EN 61131-2

Type No. HG2G-5T HG1G

Operating Temperature -20 to +60°C -20 to +55°C*2

Operating Humidity 10 to 90% RH (no condensation)

Storage Temperature -20 to +70°C

Storage Humidity 10 to 90% RH (no condensation)

Altitude 0 to 2000m

Pollution Degree 2

Corrosion Immunity Free from corrosive gases

Rated Voltage 12V DC / 24V DC

Power Consumption
8W maximum
When not using USB Interface (USB2): 4W maximum

Power Voltage Range 10.2V DC to 28.8V DC

Allowable Momentary Power 
Interruption

10 ms maximum (Power supply: 20.4V DC to 28.8V DC)
1 ms maximum (Power supply: 10.2V DC to 20.4V DC)

Inrush Current 40A maximum

Dielectric Withstand Voltage 1000V AC, 10mA, 1 minute (between power and earth terminals)

Vibration

5 to 8.4Hz amplitude 3.5mm,

8.4 to 150Hz acceleration 9.8m/s2

10 times on each of three mutually perpendicular axes (100 minutes)
(IEC61131-2)

Shock 147m/s2, 11ms (5 shocks on each of three mutually perpendicular axes)   
 (IEC61131-2)
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■ Performance Specifications

■ EMC Specifications

*3 Please be aware that small black and bright dots might show up on LCD Screen: it is not a failure or malfunction.
*4 The time until brightness becomes 50% of the initial value.

The life of the LCD itself at an ambient temperature of 25°C. This is not a guaranteed value. The actual life depends on the 
environment and conditions of use.

*5 It is a protection structure for the operating surface of HMI, which is attached to a panel. Although protection structure 
suffices every test conditions, it does not guarantee to operate under all of the environmental condition.
As for IP65F/IP66F/IP67F oilproof structure, it suffices oilproof test conditions. Conditions are listed in the document that 
comes with Japanese Industrial Standard JIS C 0920.
Protection structure do not gurantee usage under long exposure to oil or usage of oil that is not prescribed in the document. 
Please test/check beforehand to avoid trouble.

Type No. HG2G-5TN HG2G-5TT HG1G

Display

LCD Type*3 TFT Monochrome LCD (TN Type) TFT Color LCD (TN Type)

Display Colors 2 Colors (16 tones) 65536 Colors

Effective Display Area 
(W × H)

115.2 × 86.4 mm 95.04 × 53.856 mm

Display Resolution 
(W × H)

320 × 240 dots 480 × 272 dots

View angle
Left/Right: 65°, 
Top: 80°, Bottom: 60°

Left/Right: 80°, 
Top: 80°, Bottom: 80°

Left/Right: 70°, 
Top: 60°, Bottom: 65°

Brightness of LCD only 1100 cd/m2 500 cd/m2 800 cd/m2

Brightness Adjustment 32 levels

Backlight LED

Backlight Life*4 Approx. 100,000 hours Approx. 70,000 hours

Touch 
Panel

Switch Type Analog Resistive Film

Operating Force 3N maximum

Multiple Operations Impossible

Life 1,000,000 operations

User Memory Approx. 5 MB Approx. 12 MB

Backup Battery
Coin type lithium manganese dioxide battery CR2032
Guarantee Period: 1 Year (operating temperature at 25°C)
Recommended Replacement Span: Every 5 Years (operating temperature at 25°C)

Backup Data Calendar, Log Data, HMI Keep Relays, HMI Keep Registers

Buzzer output Single tone (tone length is adjustable)

Degree of Protection*5

IP66F(IEC60529)
When the panel thickness is less than 1.5 mm: IP65F
TYPE 4X
TYPE 13

IP66F/
IP67F(IEC60529)
When the panel 
thickness is less than 
1.5 mm: IP65F/IP67F
TYPE 4X
TYPE 13

Weight (approx.) 500g 300g

Radiated Emission
Class A : 10m
40dBµV/m quasi-peak (30M to 230MHz)
47dBµV/m quasi-peak (230M to 1GHz)

Electrostatic Discharge
Contact : ±6kV
Air : ±8kV

Electromagnetic Field

10V/m (80 to 1000 MHz)
3V/m (1.4 to 2.0 GHz)
1V/m (2.0 to 2.7 GHz)
80% AM (1kHz)

Fast Transient Burst Power : ±2kV  Communication cable : ±1kV

Surge Immunity ±500V (between +24V and 0V)  ±1kV (between +24V and FE, 0V and FE)

Conducted Radio
Frequency Immunity

3V (Power, Communication cable)  (150kHz to 80MHz)
80% AM (1kHz)
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Notes related to emissions
In order to meet the emission specifications for the HG2G-5T, HG1G, attach a ferrite core to the power cables and 
communication cables.
   Recommended ferrite core: ZCAT3035-1330 manufactured by TDK Corporation

Power supply
section

+ - FE

Communication
section

External device

MICRO/I

DC power supply

Attach the ferrite core near the 
power supply section of the power 
cables connected to the MICRO/I 
unit.

Attach the ferrite cores according to 
the usage conditions of the external 
devices, surrounding environment, and 
the cables.
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3.6 Dimensions

■ HG2G-5T
Unit: mm

<Cable Attached Dimensions>

Depending on the type of connection cable used the dimensions shown above will change. 
The dimensions given here are representative values and are intended for reference only.
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■ HG1G
Unit: mm

<Cable Attached Dimensions>

Depending on the type of connection cable used the dimensions shown above will change. 
The dimensions given here are representative values and are intended for reference only.
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3.7 Installation

● Operating Environment
For designed performance and safety of the HG2G-5T, HG1G, do not install the HG2G-5T, HG1G in the following 
environments:

• Where dust, briny air, or iron particles exist.
• Where oil or chemical splashes for long time.
• Where oil mist is filled.
• Where direct sunlight falls on the HG2G-5T, HG1G.
• Where strong ultraviolet rays fall on the HG2G-5T, HG1G.
• Where corrosive or combustible gasses exist.
• Where the HG2G-5T, HG1G is subjected to shocks or vibrations.
• Where condensation occurs due to rapid temperature change.
• Where high-voltage or arc-generating equipment (electromagnetic contactors or circuit protectors) exists in the vicinity.

● Ambient Temperature
• Allow sufficient space for ventilation, and install the equipment away from heat sources.
• Allow at least 100mm between the HG2G-5T, HG1G and walls or other equipment.
• Do not install the HG2G-5T, HG1G where the ambient temperature exceeds the rated operating ambient 

temperature range. When mounting the HG2G-5T, HG1G in such locations, provide a forced air-cooling fan or air-
conditioner to keep the ambient temperature within the rated temperature range.

● HG2G-5T, HG1G Installation
• Make a panel cut-out on the panel with the dimensions shown below.

• Use the attached mounting clips to tighten the screws evenly to mount panel: screws must be applied on total of 
four places on top and bottom with the specified torque.
Mounting clips can be attached to the left and right sides of HG4G and HG2G-5F. However, if they are attached in 
such way, there is a risk of not satisfying product specifications such as waterproof performance, shock resistance, 
and vibration resistance performance.

  CAUTION

• Do not tighten with excessive force, otherwise the HG2G-5T, HG1G may warp and cause wrinkle 
on the display, or impair the waterproof characteristics.

• If the mounting clips are tightened obliquely to the panel, the HG2G-5T, HG1G may fall off the panel.
• When installing the HG2G-5T, HG1G into a panel cut-out, make sure that the gasket is not twisted. 

Especially when re-installing, take special care because any twists in the gasket will impair the 
waterproof characteristics.

 Unit: mm

Type No. A B Panel Thickness

HG2G-5T 121.0
+2.0
  0

153.0
+2.0
  0

1.0 to 5.0

HG1G 92.0
+1.0
  0

118.0
+1.0
  0

B 

A 

Mounting Clip

Mounting Clip

Panel  Unit: mm

Type No. Specified Torque

HG2G-5T 0.2 to 0.3

HG1G 0.3 to 0.35
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3.8 Wiring

● Power Supply Terminal
• Pin assignment is shown in the following table.

• Use applicable cables for wiring and recommended ferrules (made by Phoenix Contact) as follows.

● Cautions for using the HG2G-5T, HG1G connected to a personal computer
When connecting the HG2G-5T, HG1G to a personal computer via the USB Interfaces, the HG2G-5T, HG1G or the 
personal computer may break down depending on the conditions of the personal computer. Make sure of the 
following cautions, in order to prevent an accident.
• If the personal computer has a 3-pin power plug or power plug with a ground lead type, make sure to use a plug 

socket including a ground input electrode or ground the earth lead, respectively.
• If the personal computer has a 2-pin power plug without ground lead, follow the procedure below when connect 

the HG2G-5T, HG1G to the personal computer.
(1) Pull out the power plug of the personal computer from the AC outlet.
(2) Connect the HG2G-5T, HG1G to the personal computer.
(3) Insert the power plug of the personal computer into the AC outlet.

*1 HG2G-5T only

  CAUTION

• Turn off the power supply before wiring.
• Make the wiring as short as possible and run all wires as far away as possible from high-voltage 

and large-current cables. Follow all the procedures and precautions when wiring the HG2G-5T, 
HG1G.

• Separate the HG2G-5T, HG1G power supply wiring from the power lines of I/O devices and motor 
equipment.

• Ground the functional earth terminal to make sure of correct operation.

+ Power supply 12V DC / 24V DC

- Power supply 0V 

Functional Earth (FE)

Applicable cable AWG18 to AWG22

Recommended 
Pressure Terminal

AI 0,34-8 TQ
AI 0,5-8 WH
AI 0,75-8 GY
AI 1-8 RD
AI-TWIN 2 x 0,5-8 WH
AI-TWIN 2 x 0,75-8 GY
AI-TWIN 2 x 1-8 RD*1

(Phoenix Contact)

Tightening Torque 0.5 to 0.6 N·m

HG1GHG2G-5T
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3.9 USB Cable Lock Pin Attachment

When using the USB device, attach the USB Cable Lock Pin to prevent disconnecting the USB cable from the HG2G-5T*1, 
HG1G.

1 Insert the USB cable into the USB2 port.

2 Strain the [Edge part] of the USB Cable Lock Pin, and insert the [Edge part] to the 2 holes lower the USB2 port.

3 Fasten the USB Clamp Band around the USB cable and the [Clamp part], secure them tightly.

*1 Only USB2 for HG2G-5T

Clamp partEdge part

Lower holes Lower holes

HG2G-5T HG1G

HG2G-5T HG1G

Fasten the USB Clamp Band without the space between the [Clamp part] and it, and the inclination.

OK

NG NG

With a gap Slanted Slanted

NG
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3.10 Maintenance and Inspection

Maintain and inspect the HG2G-5T, HG1G periodically to ensure the best performance. Do not disassemble, repair, or 
modify the HG2G-5T, HG1G during inspection.

● Replacing the Backup Battery
A backup battery is built into the HG2G-5T, HG1G to retain the internal backup data (log data, keep resister, and keep 
relay) and clock data.
When the “Replace the battery” message is displayed, replace the backup battery by following the procedure below.
When the “Battery level LOW” message is displayed, replace the battery immediately; otherwise, the backup data and 
clock data may be lost. 
Whether or not to display the reminder message for battery replacement can be specified with the configuration 
software. Refer to Chapter 4 “3.1 System Tab” on page 4-25 for details.

1 Follow the procedure below to remove the battery holder cover.

2 Turn on the power to the HG2G-5T, HG1G, wait for approximately one minute, and then turn off the power again.

3 Insert a flat head screwdriver into the battery holder, as shown in the figure below, and remove the battery.

The battery may pop out from the battery holder.

Display
Wipe any stain of the display using a soft cloth slightly dampened with neutral detergent or alcoholic 
solvent. Do not use solvents such as thinner, ammonia, strong acid, and strong alkaline.

Terminals, 
Connectors

Check the terminals and connectors to make sure of no loose screws, incomplete insertion, or 
disconnected lines.

Mounting Clips
Make sure that all mounting clips and screws are tightened sufficiently. If the mounting clips are loose, 
tighten the screw to the recommended tightening torque.

Backlight
The HG2G-5T, HG1G’s backlight cannot be replaced by the customer. When the backlight needs to be 
replaced. Contact your vendor or IDEC Corporation.

Backup Battery
The operating life of the internal battery is approximately five years. It is recommended to replace the 
battery every five years even before the reminder message for battery replacement is displayed.

Touch Panel
A gap may be caused in the operation accuracy of the touch panel by the secular distortion, etc. 
Readjust the touch panel in the System Mode according to the following procedure when there is a gap 
in the operation of the touch panel. Refer to “Adjusting the Touch Panel” on page 35-56 for details.

HG2G-5T HG1G
Turn the cover counterclockwise using a coin. Use a flat head screwdriver.

After turning off the power to the HG2G-5T, HG1G in step 2, complete the steps through 4 within 30 
seconds to replace the battery without losing the backup data and clock data. However, it is recommended 
that the backup data be transferred to flash memory as a precautionary measure. For the procedure to 
transfer the data to flash memory, refer to Chapter 33 “Internal Devices” on page 33-1. If it is not necessary 
to save the data, step 2 can be skipped.

HG2G-5T HG1G

Enlarged view
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4 Install a replacement battery into the battery holder.  Ensure that the orientation of the battery is correct.

5 With the new batter installed correctly, reverse the instruction the procedure described in item #1 above to secure the 
cover.

• The operating life of the internal battery is approximately five years. It is recommended to replace the battery 
every five years even before the reminder message for battery replacement is displayed.

• IDEC provides replacement service for the battery (at customer’s expense). Contact your vendor or IDEC Corporation.

Handling of Batteries and Devices with Built-in Batteries in EU Member States

Note) The following symbol mark is for EU countries only and is according to the directive 2006/66/EC Article 20 
information for end-users and Annex II.

This symbol mark means that batteries and accumulators, at their end-of life, should be disposed of separately from 
your household waste.

If a chemical symbol is printed beneath the symbol shown above, this chemical symbol means that the battery or 
accumulator contains a heavy metal at a certain concentration. This will be indicated as follows :
Hg : mercury (0.0005%), Cd : cadmium (0.002%), Pd : lead (0.004%)

In the European Union there are separate collection systems for used batteries and accumulators.
Please dispose of batteries and accumulators correctly in accordance with each country or local regulation.

HG2G-5T HG1G

HG2G-5T HG1G
Set the battery holder cover to the original 
position, and turn it clockwise using a coin.

Set the battery holder cover, as shown in the figure below.

 WARNING

The battery may be regulated by national or local regulation. Observe the instructions of proper 
regulation. As electric capacity is left in a discarded battery and it comes into contact with other 
metals, it could lead to distortion, leakage, overheating, or explosion, so make sure to cover the (+) 
and (-) terminals with insulating tape before disposal.

 CAUTION

When replacing the battery, use the specified battery only. Note that any problems and failures 
arising from or in connection with the use of a battery other than the specified battery is not 
guaranteed.
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● Maintenance Screen
Turn on the power to the HG2G-5T, HG1G, then press and hold the touch panel on the upper-left corner of the screen 
for three seconds or longer. The Maintenance Screen appears on the screen.

• Permission to show the Maintenance Screen can be set using the WindO/I-NV4. Refer to Chapter 4 “3.1 System 
Tab” on page 4-25 for details.

• The Maintenance Screen is not displayed in the System Mode.

● System Mode
Press the [System Mode] at the top of the Maintenance Screen. The Top Page Screen appears.

Initial Setting, Self Diagnosis and Initialization of the data, etc can be executed in the System Mode.

● Adjusting the Brightness
The brightness of the HG2G-5T, HG1G display can be adjusted on the Adjust Brightness Screen.

1 Press the [Adjust Brightness] at the bottom of the Maintenance Screen. 
The Adjust Brightness Screen appears.

2 Press the [<<] and [>>] at the bottom of the Adjust Brightness Screen to adjust the brightness to the optimal 
setting. 

Maintenance Screen 

Maintenance

System Mode

Device Monitor

Adjust Brightness

Run Offline Main Menu

<< >>

SYSTEM MODE TOP PAGE

2010/OCT/14/THU   14:56:44

IP Address  192.168.0.1(DHCP)

BRIGHTNESS  16BRIGHTNESS  16

Maintenance

System Mode

Device Monitor

Adjust Brightness

Maintenance

Adjust Brightness



3 HG2G-5T, HG1G

35-56 WindO/I-NV4 User’s Manual

3 Press the [X] to close the Adjust Brightness Screen.

● Adjusting the Touch Panel
A gap may be caused in the operation accuracy of the touch panel by the secular distortion, etc. Adjust the touch 
panel according to the following procedure when there is a gap in the operation of the touch panel.

1 Press the Main Menu on the Top Page in System Mode. The Main Menu Screen appears.

2 Press in order of Initial Setting, Initialize, TP Adjust. The confirmation screen appears and asks “Adjust Touch 
Panel setting?”. Press Yes, then the Touch Panel Adjust screen appears.

3 Press the center of the X mark, then the position of the mark changes one after another. Press five marks 
sequentially.

4 When normally recognized, the confirmation screen of 2 is restored.

At procedure 3, when pressing a point away from the center of the X mark, a recognition error will result. Then the X 
mark returns to the initial position, then repeat the procedure of 3 again.

To adjust the brightness in the System Mode, use the [<<] and [>>] buttons located at the bottom of the 
Top Page.

Run Offline Main Menu

<< >>

SYSTEM MODE TOP PAGE

2010/OCT/14/THU   14:56:44

IP Address  192.168.0.1(DHCP)

BRIGHTNESS  16BRIGHTNESS  16

Run Offline Main Menu

<< >>

SYSTEM MODE TOP PAGE

2010/OCT/14/THU   14:56:44

IP Address  192.168.0.1(DHCP)

BRIGHTNESS  16BRIGHTNESS  16

Press the center of the symbol.

Press the center of the X mark. 
This will ensure the accuracy of the touch panel operation.



WindO/I-NV4 User’s Manual 35-57

4 HG1P

35

M
ICRO

/I Specifications

4.1 Packing content

Before installing the HG1P, make sure that the model you have received is what you actually ordered, and no parts 
are damaged to accidents during shipping.

4.2 Part Numbers

4 HG1P

Name HG1P

HG1P Unit

Instruction Sheet (Japanese/English) x1

Instruction Sheet (Chinese) x1

×1

Communication Interface Part No.

Serial Interface (RS422/485) HG1P-ST32YBFH-B0

Ethernet Interface HG1P-ST32ZBFH-B0
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4.3 Part Names

■ HG1P

*1 USB flash drive only

No. Name Description

(1) Emergency Stop Switch 1 (external wiring)

(2) Selector Switch 1 (external wiring)

(3) Function Key 12 (internal wiring)

(4) Display TFT color LCD

(5) Touch Panel Analog Resistive Film

(6) POWER LED
Green (lit) : Normal Operation (Power is on.)
Not lit : Power is off.

(7) Connector Removable 19-pin Female Connector

(8) Mounting Hole For Wall-Mounted Hook Wall-mounted hook screw mounting part (2)

(9) Nameplate
Label printed with Part number, Serial Number and 
Consumption Current

(10) Enabling Switch 1 (external wiring)

(11) Hand Strap Mounting Part -

(12) USB Port Cover -

(13) USB Port Cover Mounting Part USB port cover screw mounting part (1)

(14) USB Interface (USB2)*1 USB2.0 (Host) Connector : Type A

(15) USB Interface (USB1) USB2.0 (Device) Connector : Mini-B

①

⑦

②

③

⑪

⑧

⑫ ⑬ ⑭ ⑮

⑤
⑥

⑩

⑨

④
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4.4 External Interfaces

  CAUTION

• Make sure to turn off the power to the HG1P before inserting or pulling the cable into or out of the 
connector.

• Communication interface specifications vary based on the model number.

Communication Interface Specifications
HG1P-ST32YBFH-B0 : Serial Interface (RS422/485)
HG1P-ST32ZBFH-B0 : Ethernet Interface 

Connector Removable 19-pin Female Connector

Part Number (Manufacturer) CA-19P1N126Y00 (PHOENIX CONTACT)

No. Name Function

1 C_NC1 Selector Switch Contact 1 (NC)

2 C_NO1 Selector Switch Contact 1 (NO)

3 B_C1 Enabling Switch Contact 1 (COM)

4 B_C2 Enabling Switch Contact 2 (COM)

5 B_NO2 Enabling Switch Contact 2 (NO)

6 FG Frame Ground

7 RDA+/TPI+ Receive Data (+)

8 RDB-/TPI- Receive Data (-)

9 SDB-/TPO- Send Data (-)

10 A_NC21 Emergency Stop Switch Contact 2 (NC)

11 A_NC22 Emergency Stop Switch Contact 2 (NC)

12 DC24V- HG1P 24V DC Power Supply (-)

13 C_C1 Selector Switch Contact 1 (COM)

14 B_NO1 Enabling Switch Contact 1 (NO)

15 SG Communication Signal Ground

16 SDA+/TPO+ Send Data (+)

17 A_NC11 Emergency Stop Switch Contact 1 (NC)

18 A_NC12 Emergency Stop Switch Contact 1 (NC)

19 DC24V+ HG1P 24V DC Power Supply (+)

View of mating surface of the removable connector

1
2

3

4

5
6

7

8

9
10

11
12

13

14
15

16

17
18

19
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4.5 Specifications

■ Applicable Standards

■ Environmental Specifications

■ Electrical Specifications

■ Construction Specifications

  CAUTION

The following specifications are when the HG1P optional cable, specified by IDEC, is attached.

Safety Standards

UL61010-1
UL61010-2-201
CSA C22.2 No.61010-1 (c-UL)
CSA C22.2 No.61010-2-201 (c-UL)

EMC Standards
IEC/EN 61131-2
FCC

Operating Temperature 0 to +45°C

Operating Humidity 10 to 90% RH (no condensation)

Storage Temperature -10 to +60°C

Storage Humidity 10 to 90% RH (no condensation)

Altitude and Atmospheric Pressure
Up to 2000m (RUN)
750 to 1060hPa

Pollution Degree 2

Corrosion Immunity Free from corrosive gases

Rated Voltage 24V DC

Power Consumption
3W maximum
When not using USB Interface (USB2): 2W maximum

Power Voltage Range 20.4 to 28.8V DC

Allowable Momentary Power 
Interruption

10 ms maximum

Inrush Current 20A maximum

Dielectric Withstand Voltage AC500V, 10mA, 1 minute (between power and ground terminals)

Vibration

5 to 8.4Hz amplitude 3.5mm,

8.4 to 150Hz acceleration 9.8m/s2

1 octave 10 minutes
10 times on each of three mutually perpendicular axes (100 minutes)
(IEC61131-2)

Shock 147m/s2, 11ms (5 shocks on each of three mutually perpendicular axes) 
 (IEC61131-2)

Dropping 1.5 m, 6 directions, 1 time

Connector Insertion Life
HG1P Optional Cable: 100 times
USB1: 5000 times
USB2: 1500 times
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■ Performance Specifications

■ Communication Specifications

*1 The time until brightness becomes 50% of the initial value.
The life of the LCD is specified an ambient temperature of 25°C. This is not a guaranteed value. The actual life depends on 
the environment and conditions of use.

*2 The HG1P has no backup battery, therefore, time data is deleted when the HG1P is turned off.
*3 The connector for the external device is not guaranteed.

Display

LCD Type TFT color LCD

Display Colors 65536 Colors

Effective Display 
Area

95.04 (W) × 53.856 (H) mm

Display Resolution 480 (W) × 272 (H) dots

View angle Left/Right: 80°, Top: 65°, Bottom: 55°

Brightness of LCD 
only 400 cd/m2

Brightness 
Adjustment

32 levels

Backlight White LED (It cannot be replaced)

Backlight Life*1 Approx. 30,000 hours

Touch Panel

Switch Type Analog Resistive Film

Operating Force 3N maximum

Multiple Operations Impossible

Life 1,000,000 operations

User Memory 12MB

Clock Function*2 Year, Month, Day, Hour, Minute, Second, Day-of-week
±90 seconds per month

Buzzer output Single tone (tone length is adjustable)

Degree of Protection IP54 (When HG1P optional cable is attached*3)

Weight Approx. 500g (without HG1P optional cable)

Housing color Dark gray

Serial Interface (RS422/485)

Communication Speed
187500, 115200, 57600, 38400, 19200, 9600, 4800, 
2400, 1200 bps

Communication Distance 20m maximum

Synchronization Asynchronous

Ethernet Interface
Interface Specification IEEE802.3i

Baud Rate 10M
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■ EMC Specifications

Radiated Emission

Class A : 10m
•IEC 61000-6-4 Class A
40dBμV/m quasi-peak (30M to 230MHz)
47dBμV/m quasi-peak (230M to 1GHz)

•FCC Class A
39dBμV/m quasi-peak (30M to 88MHz)
43.5dBμV/m quasi-peak (88M to 216MHz)
46.4dBμV/m quasi-peak (216M to 960MHz)
49.5dBμV/m quasi-peak (960M to 1GHz)

Electrostatic Discharge
Contact : ±4kV
Air : ±8kV

Electromagnetic Field

10V/m (80 to 1000 MHz)
3V/m (1.4 to 2.0 GHz)
1V/m (2.0 to 2.7 GHz)
80% AM (1kHz)

Fast Transient Burst
Power : ±2kV
Communication cable : ±1kV

Surge Immunity
±500V (+24V and 0V)
±1kV (+24V and FE, 0V and FE)

Conducted Radio
Frequency Immunity

3V (Power, Communication cable)
(150kHz to 80MHz)
80% AM (1kHz)
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■ Switch Specifications

Function Keys

The function keys are written to HMI Expansion Inputs (LI) as momentary switches with normally open contacts.
• Momentary

Pressing the button writes a 1 to the HMI Expansion Input (LI).
Pressing the button writes a 0 to the HMI Expansion Input (LI).

Model Tactile Switch

Number Equipped 12

Contact Normally open contact

Damage Limits 500,000 operations minimum

Internal Devices

Device Name HMI Expansion Input (Bit)

Symbol LI

R/W R

R/W is an abbreviation of Read/Write. R/W indicate that both reading and writing are possible, while R 
indicates that only reading is possible.

No. Name HMI Expansion Input (Bit) Assignment

1 F1 LI0

2 F2 LI1

3 F3 LI2

4 F4 LI3

5 F5 LI4

6 F6 LI5

7 F7 LI6

8 F8 LI7

9 F9 LI8

10 F10 LI9

11 F11 LIA

12 F12 LIB

(1) (7)
(2) (8)
(3) (9)
(4) (10)
(5) (11)
(6) (12)

Release

Initial image

Press ReleasePress

1

Operation and 
view

Data written 10 0

WriteAction WriteWrite Write
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• Reading the State of Function Keys
The HG1P reads the state of the function keys once approximately every 20 ms, and those states are applied to the 
HMI Expansion Inputs (LI). 
When the state of a function key is ON two consecutive times, the HG1P recognizes that the key has been pressed, 
and it processes the read result and makes an ON judgment. When the state of a function key is OFF even once, the 
HG1P recognizes that the key has been released, and it processes the read result and makes an OFF judgment.

Time to judge the state of the function key
The time from reading the state of the function key to when the result is judged is as follows.

Time to apply the read results to HMI Expansion Inputs (LI)
For function key inputs, the latest read results when the scan for the screen ends are applied to HMI Expansion 
Inputs (LI) at that time. 
When there is a change in the state of a function key, the time until the read result is applied to the HMI Expansion 
Input (LI) is as follows.

Minimum: 21 ms
Maximum: 39 ms + Scan time (HMI Special Data Register LSD4)

Emergency Stop Switch

OFF→ON ON→OFF

Maximum 41 ms 20 ms

ON

20ms

OFF

ON OFFOFFOFF ON

State of 
the function key

Reading the state of 
the function key

Read result of 
the function key

While executing transmitting and receiving processing for user communications, the time required for the 
HG1P to process the read result and make an ON judgment will increase because the read processing for 
function keys is executed after communication processing has completed.

The longer it takes for display processing and part processing, the longer it will take to apply the read 
results to the HMI Expansion Inputs (LI).

  CAUTION

• Use the emergency stop switch through the HG1P optional cable as a control signal for external 
devices.

• Consider counter-measures for switch bouncing because bouncing will occur during reset 
operation.

• Be careful with the switch. If the switch is subjected to excessive shocks or vibrations, it may 
deform or become damaged, chattering may occur, operation may fail, or performance may 
become degraded.

Part Number (Manufacturer) AB6E-3BV02PRM (IDEC)

Number Mounted 1

Contact 2NC (external wiring)

Contact Rating 1A/DC30V

Damage Limits
Mechanical: 100,000 operations minimum
Electrical: 100,000 operations minimum

Reset Operation Pull or Turn reset

17 (A_NC11)

10 (A_NC21)

18 (A_NC12)

11 (A_NC22)

Removable Connector
Pin Number (Name)
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Enabling Switch

  CAUTION

• Use the enabling switch through the HG1P optional cable as a control signal for external devices.
• Build the system so that the machine operates only in position 2.
• Use the two contacts of the enabling switch as inputs for a mismatch detection circuit (safety 

relay module, etc.).
• The two contacts have been constructed to work independently of each other. For this reason, a 

time lag may occur in the operation of the two contacts when the button is pressed to the edge. 
When wiring the contacts to two inputs so that they are monitored mutually, design the sequence 
control to take into consideration this time difference.

Part Number (Manufacturer) HE6B-M200Y (IDEC)

Number Mounted 1

Contact 2 contacts (external wiring)

Contact Rating 0.7A/DC30V

Monitoring Contact None

Damage Limits
Mechanical: Position 1→2→1: 1,000,000 operations minimum

Position 1→2→3→1: 100,000 operations minimum
Electrical: 100,000 operations minimum

3 Positions

 (OFF-ON-OFF) 

B1 

B2 
14 (B_NO1)

5 (B_NO2)

3 (B_C1)

4 (B_C2)

Removable Connector
Pin Number (Name) Position 1

3 Positions Enabling Switch

When the button 
is not pressed

Push Lightly Release

Movable Contact
Contact Terminal

Push Further
Release

Position 2

When the button 
is lightly pressed

Position 3

When the button 
is firmly pressed

OFF

ON

OFF
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Selector Switch (φ16 or Non-Illuminated model)

When at position (1), pin 1 (C_NC1) and pin 13 (C_C1) are connected.
When at position (2), pin 2 (C_NO1) and pin 13 (C_C1) are connected.

  CAUTION

Use the selector switch through the HG1P optional cable as a control signal for external devices.

Part Number (Manufacturer) LB6S-2T1 (IDEC)

Number Mounted 1

Contact SPDT (external wiring)

Contact Rating 0.1A/DC30V (resistance load)

LED Non-Illuminated

Damage Limits
Mechanical: 250,000 operations minimum
Electrical: 100,000 operations minimum

Switching detent 90° - 2-positions

Specification Stops at all positions (manual)

1 (C_NC1)

2 (C_NO1)

13 (C_C1)

Removable Connector
Pin Number (Name)

(1) (2)
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4.6 Dimensions

Unit: mm

<Cable Dimensions>

191.0

16
8.

9
56

.070
.6

51
.0

55
.7
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4.7 Installation

● Operating Environment
• For designed performance and safety of the HG1P, do not install the HG1P in the following environments:

- Where dust, briny air, or iron particles exist.
- Where oil or chemical splashes for a long time.
- Where oil mist is present.
- Where direct sunlight falls on the HG1P.
- Where strong ultraviolet rays fall on the HG1P.
- Where corrosive or combustible gasses exist.
- Where shocks or vibrations are transmitted.
- Where condensation occurs due to rapid temperature change.
- Where high-voltage or arc-generating equipment (electromagnetic contactors or circuit protectors) exists in close 

proximity.
- Near devices that generate a lot of heat. Such as a boiler.

• Use the wall-mounted hook (optional item) for wall mounting.

● HG1P Installation

Attaching the Optional Cable (HG9Z-XCP13/-XCP15/-XCP17) to the HG1P

1 Turn the connector cap.

2 Pull off the connector cap.

3 Turn the connector at the end of the HG1P optional cable to align the "open" text with the logo.

4 Align the connector at the end of the HG1P optional cable with the mating positioning mark, and then push it straight 
on until the rubber (black) is completely covered.

  CAUTION

• Make sure to turn off the HG1P's power before inserting or pulling the cable into or out of the 
connector.

• After locking the connector, gently tug on the cable to make sure that the connector does not 
come off.

• Do not apply an excessive tensile load to the cable, otherwise damage of the connector will result.

Connector Cap

1

2

Mating Positioning Mark

Logo

"open"

Rubber (Black)

4

3
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5 Turn the shaded portion of the connector clockwise 90°.

Removing and Installing the USB Port Cover

■ Removing the USB Port Cover
Unscrew the USB port cover screw with a Phillips screwdriver, and then pull the USB port cover outward to open it.

■ Installing the USB Port Cover
Recommend tightening torque while keeping it from lifting up from the case.

Before locking the connector After locking the connector

The connector will stop turning at 90°. Do not try to turn it past 90°.

  CAUTION

• When attaching the cover, tighten the screw to the recommended tightening torque (0.6 N·m).
• When installing the HG1P, make sure that the gasket is not twisted. Because any twisting in the 

gasket will impair the waterproof characteristics.

Phillips Screwdriver

USB Port Cover ScrewUSB Port Cover

Only one side of the USB port cover opens.
Be careful when opening the USB port cover because the part that opens may be damaged if excessive force 
is used. 
Do not remove the USB port cover screw from the USB port cover.

Press with your finger
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Installing the Hand Strap (HG9Z-PS4)

1 Pass the hand strap through the hand strap mounting part.

2 Pass the end of the strap through the loop, keep holding the end, and pull it tight.

Installing the Wall-Mounting Hook (HG9Z-PK3)

1 Fit the indented surface of the wall-mounted hook into the HG1P.

2 Use the wall-mounted hook screws (M3×10), and tighten in two locations to the recommended tightening torque (0.6 
N·m).

Hand Strap

Hand Strap Hole

The End of the Strap

The Loop of the Strap

Be careful when pulling the strap tight because the strap may be damaged if excessive force is used.

Wall-Mounted Hook Screw

Wall-Mounted Hook

Mounting Hole for Wall-Mounted Hook
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4.8 Wiring

● HG1P Optional Cable (HG9Z-XCP13/-XCP15/-XCP17)
This cable connects the HG1P and external devices.

■ Specifications

■ Outline Drawing

■ Connector Wiring Table

  CAUTION

• Turn off the power supply before wiring.
• Make the wiring as short as possible and run all wires as far away as possible from high-voltage 

and large-current cables. Follow all the procedures and precautions when wiring the HG1P.
• Separate the HG1P power supply wiring from the power lines of I/O devices and motor 

equipment.
• Connect the functional ground terminal to make sure of correct operation.

Communication Interface Serial Interface (RS422/485) or Ethernet Interface

Connector for the External Devices D-sub 25-pin Male Connector (Jackscrew M2.6)

Length 3m, 5m, 7m

Cable Length 3m, 5m, 7m

1 13

2514

Connector for the External Devices

(View of mating surface of the removable connector)

No. Name Function No. Name Function

1 FG Frame Ground 14 NC -

2 RDB-/TPI- Receive Data (-) 15 NC -

3 RDA+/TPI+ Receive Data (+) 16 NC -

4 SDB-/TPO- Send Data (-) 17 NC -

5 SDA+/TPO+ Send Data (+) 18 C_NC1 Selector Switch Contact 1 (NC)

6 SG Communication Signal Ground 19 C_NO1 Selector Switch Contact 1 (NO)

7 NC - 20 C_C1 Selector Switch Contact 1 (COM)

8 NC - 21 B_NO2 Enabling Switch Contact 2 (NO)

9 B_NO1 Enabling Switch Contact 1 (NO) 22 B_C2 Enabling Switch Contact 2 (COM)

10 B_C1 Enabling Switch Contact 1 (COM) 23 A_NC21 Emergency Stop Switch Contact 2 (NC)

11 A_NC11 Emergency Stop Switch Contact 1 (NC) 24 A_NC22 Emergency Stop Switch Contact 2 (NC)

12 A_NC12 Emergency Stop Switch Contact 1 (NC) 25 DC24V+ HG1P 24V DC Power Supply (+)

13 DC24V- HG1P 24V DC Power Supply (-)
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● HG1P Debug Cable (HG9Z-PX12)
This cable is the debug cable. Use this cable only for debugging.

■ Cable Specification

■ Outline Drawing

■ Sectional View

■ Wiring Table

Structure Double shield cable

Configuration
AWG25 x 2 Pair
AWG23 x 5 Cores

Conductor Configuration 40N/0.08mm(Pair), 60N/0.08mm(Cores)

Insulator

Material PVC

Thickness 0.16mm(Pair), 0.145mm(Cores)

Outer Diameter 0.9mm(Pair), 1.0mm(Cores)

Sheath Outer Diameter 7.0 mm

Cable Length 2m

Stripped Wires

Shield

White Black

Black Red

GreenOrange

Blue

Brown

Yellow

Shield

Sheath

Wire pair 2

Single wire 1

Single wire 5

Single wire 4

Single wire 3

Single wire 2

Wire pair 1

No. Name Function Cable Color

1 RDA+/TPI+ Receive Data (+) Wire pair 1 : Black

2 RDB-/TPI- Receive Data (-) Wire pair 1 : Red

3 SDA+/TPO+ Send Data (+) Wire pair 2 : Black

4 SDB-/TPO- Send Data (-) Wire pair 2 : White

5 FG Frame Ground Single wire 1 : Green

6 SG Communication Signal Ground Single wire 2 : Yellow

7 DC24V+ HG1P 24V DC Power Supply (+) Single wire 3 : Brown

8 NC - Single wire 4 : Blue

9 DC24V- HG1P 24V DC Power Supply (-) Single wire 5 : Orange
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4.9 Maintenance and Inspection

Maintain and inspect the HG1P periodically to ensure it is in peak condition. Do not disassemble, repair, or modify the 
HG1P during inspection.

● Maintenance Screen
Turn on the power to the HG1P, then press and hold the touch panel on the upper-left corner of the screen for three 
seconds or longer. The Maintenance Screen appears on the screen.

• Permission to show the Maintenance Screen can be set using the WindO/I-NV4. Refer to Chapter 4 “3.1 System 
Tab” on page 4-25 for details.

• The Maintenance Screen is not displayed in the System Mode.

● System Mode
Press the [System Mode] at the top of the Maintenance Screen. The Top page Screen appears.

Initial Setting, Self Diagnosis and Initialization of the data, etc can be executed in the System mode.

Maintenance and 
Inspection Parts

Description

Display
Wipe any stain of the display using a soft cloth slightly dampened with neutral detergent or 
alcoholic solvent. Do not use solvents such as thinner, ammonia, strong acid, and strong 
alkaline.

Removable Connector Check the terminals and connectors to make sure of incomplete insertion or disconnected lines.

USB Port Cover Make sure of no loose screws, or no twisted gasket.

Wall-Mounted Hook Make sure of no loose screws.

Backlight The HG1P’s backlight cannot be replaced.

Touch Panel

A gap may be caused in the operation accuracy of the touch panel by the secular distortion, 
etc. Readjust the touch panel in the System Mode according to the following procedure when 
there is a gap in the operation of the touch panel. Refer to “Adjusting the Touch Panel” on 
page 35-75 for details.

Maintenance Screen 

Maintenance

System Mode

Device Monitor

Adjust Brightness

Run Offline Main Menu

<< >>

SYSTEM MODE TOP PAGE

2010/OCT/14/THU   14:56:44

IP Address  192.168.0.1(DHCP)

BRIGHTNESS  16BRIGHTNESS  16
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● Adjusting the Brightness
The brightness of the HG1P display can be adjusted on the Adjust Brightness Screen.

1 Press the [Adjust Brightness] at the bottom of the Maintenance Screen. The Adjust Brightness Screen appears.

2 Press the [<<] and [>>] at the bottom the Adjust Brightness Screen to adjust the brightness to the optimal setting.

3 Press the [X] to close the Adjust Brightness Screen.

Maintenance

System Mode

Device Monitor

Adjust Brightness

Maintenance

Adjust Brightness

To adjust the brightness in the System Mode, use the [<<] and [>>] buttons located at the bottom of the 
Top Page.

Run Offline Main Menu

<< >>

SYSTEM MODE TOP PAGE

2010/OCT/14/THU   14:56:44

IP Address  192.168.0.1(DHCP)

BRIGHTNESS  16BRIGHTNESS  16
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● Adjusting the Touch Panel
A gap may be caused in the operation accuracy of the touch panel by the secular distortion, etc. Adjust the touch 
panel according to the following procedure when there is a gap in the operation of the touch panel.

1 Press the [Main Menu] on the Top Page in System Mode. The Main Menu Screen appears.

2 Press in order of Initial Setting, Initialize, TP Adjust. The confirmation screen appears and asks “Adjust Touch 
Panel setting?”. Press Yes, then the Touch Panel Adjust screen appears.

3 Press the center of the X mark, then the position of the mark changes one after another. Press five marks 
sequentially.

4 When recognized, confirmation screen 2 is restored.

At procedure 3, when pressing a point away from the center the X mark, a recognition error will result. Then the X 
mark returns to the initial position, then repeat the procedure of 3 again.

Run Offline Main Menu

<< >>

SYSTEM MODE TOP PAGE

2010/OCT/14/THU   14:56:44

IP Address  192.168.0.1(DHCP)

BRIGHTNESS  16BRIGHTNESS  16

Press the center of the symbol.

Press the center of the X mark.
This will ensure the accuracy of the touch panel operation.
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5.1 Optional items

● HG5G/4G/3G/2G-V

5 Options

Name Type No. Description HG5G-V HG4G-V HG3G-V HG2G-V

Maintenance 
Cable

HG9Z-XCM42

USB cable to connect to a computer
Length: 2m
<Connector>
MICRO/I: USB Mini-B
Computer: USB Type-A

YES YES YES YES

USB Panel-
Mount 
Extension 
Cable

HG9Z-XCE11
Extension cable for attaching to USB2 
(Type-A) port on front panel
Length: 1m

YES YES YES YES

HG9Z-XCE21
Extension cable for attaching to USB1 
(Mini-B) port on front panel
Length: 1m

YES YES YES YES

PLC 
Connection 
Cable

FC2A-KP1C

For IDEC FC4A/5A MICROSmart
Length: 2.4m
<Connector>
MICRO/I: Parted Wire
Host: Mini DIN 8-pin

YES YES YES YES

HG9Z-XC275

For IDEC FC4A/5A MICROSmart
Length: 5m
<Connector>
MICRO/I: Parted Wire
Host: Mini DIN 8-pin

YES YES YES YES

HG9Z-XC295

For IDEC FC4A/5A MICROSmart
Communication Mode: RS232C
Length: 5m
<Connector>
MICRO/I: D-sub 9-pin
Host: Mini DIN 8-pin

YES YES YES YES

FC6A-KC1C

For IDEC FC6A MICROSmart 
(FC6A-C*****E only)
Length: 5m
<Connector>
MICRO/I: Parted Wire
Host: RJ45

YES YES YES YES

FC6A-KC2C

For IDEC FC6A MICROSmart
(FC6A-C*****E only)
Communication Mode: RS232C
Length: 5m
<Connector>
MICRO/I: D-sub 9-pin
Host: RJ45

YES YES YES YES

HG9Z-XC305

For Mitsubishi FX series direct connection
Communication Mode: RS422
Length: 5m
<Connector>
MICRO/I: D-sub 9-pin
Host: Mini DIN 8-pin

YES YES YES YES

HG9Z-XC315

For Mitsubishi Q series direct connection
Communication Mode: RS232C
Length: 5m
<Connector>
MICRO/I: D-sub 9-pin
Host: Mini DIN 6-pin

YES YES YES YES
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● HG4G/3G, HG2G-5F/-5T, HG1G

*1 The protective sheet is UV resistant, however, resistance against direct sunlight in outdoor usage is not guaranteed.

Protective 

Sheet *1

HG9Z-5DFPN01
For HG5G-V 
2 pcs/pack

YES NO NO NO

HG9Z-4DCPN02
For HG4G-V
2 pcs/pack

NO YES NO NO

HG9Z-3DA2PN02
For HG3G-VA
2 pcs/pack

NO NO YES NO

HG9Z-3D8PN02
For HG3G-V8
2 pcs/pack

NO NO YES NO

HG9Z-2D5PN05
For HG2G-V
5 pcs/pack

NO NO NO YES

Protective 
Cover

HG9Z-2E2PN03
For HG2G-V
To Cover the front of MICRO/I
3 pcs/pack

NO NO NO YES

Expansion 
Module Clamp

HG9Z-XJ3PN05

For installing the expansion modules on 
the back of the MICRO/I (Short).
5 pcs/pack
For total width 17.6 to 41.1 mm.

YES YES YES YES

HG9Z-XJ4PN05

For installing the expansion modules on 
the back of the MICRO/I (Long).
5 pcs/pack
For total width 47.0 to 69.4 mm.

YES YES YES YES

HG9Z-XJ5PN05

For installing the expansion modules on 
the back of the MICRO/I (Extra-Long).
5 pcs/pack
For total width 70.5 to 93.0 mm.

YES YES YES NO

Name Type No. Description HG5G-V HG4G-V HG3G-V HG2G-V

Name Type No. Description HG4G HG3G
HG2G

-5F
HG2G

-5T
HG1G

Maintenance 
Cable

HG9Z-XCM42

USB cable to connect to a computer
Length: 2m
<Connector>
MICRO/I: USB Mini-B
Computer: USB Type-A

YES YES YES YES YES

USB Panel-
Mount 
Extension 
Cable

HG9Z-XCE11
Extension cable for attaching to USB2 
(Type-A) port on front panel
Length: 1m

YES YES YES YES YES

HG9Z-XCE21
Extension cable for attaching to USB1 
(Mini-B) port on front panel
Length: 1m

YES YES YES YES YES

PLC Connection 
Cable

FC2A-KP1C

For IDEC FC4A/5A MICROSmart
Length: 2.4m
<Connector>
MICRO/I: Parted Wire
Host: Mini DIN 8-pin

YES YES YES YES YES

HG9Z-XC275

For IDEC FC4A/5A MICROSmart
Length: 5m
<Connector>
MICRO/I: Parted Wire
Host: Mini DIN 8-pin

YES YES YES YES YES
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*1 The protective sheet is UV resistant, however, resistance against direct sunlight in outdoor usage is not guaranteed.

Name Type No. Description HG4G HG3G
HG2G

-5F
HG2G

-5T
HG1G

PLC Connection 
Cable

HG9Z-XC295

For IDEC FC4A/5A MICROSmart
Communication Mode: RS232C
Length: 5m
<Connector>
MICRO/I: D-sub 9-pin
Host: Mini DIN 8-pin

YES YES YES NO NO

FC6A-KC1C

For IDEC FC6A MICROSmart
(FC6A-C*****E only)
Length: 5m
<Connector>
MICRO/I: Parted Wire
Host: RJ45

YES YES YES YES YES

FC6A-KC2C

For IDEC FC6A MICROSmart
(FC6A-C*****E only)
Communication Mode: RS232C
Length: 5m
<Connector>
MICRO/I: D-sub 9-pin
Host: RJ45

YES YES YES NO NO

HG9Z-XC305

For Mitsubishi FX series direct connection
Communication Mode: RS422
Length: 5m
<Connector>
MICRO/I: D-sub 9-pin
Host: Mini DIN 8-pin

YES YES YES NO NO

HG9Z-XC315

For Mitsubishi Q series direct connection
Communication Mode: RS232C
Length: 5m
<Connector>
MICRO/I: D-sub 9-pin
Host: Mini DIN 6-pin

YES YES YES NO NO

Connector 
Conversion 
Cable

HG9Z-XCT11

To convert from D-sub 25-pin to 9-pin 
(used when replacing from HG4F/3F/2F 
to HG4G/3G, HG2G-5F)
Length: 16cm

YES YES YES NO NO

Protective 

Sheet *1

HG9Z-4DCPN02
For HG4G
2 pcs/pack

YES NO NO NO NO

HG9Z-3DA2PN02
For HG3G-A
2 pcs/pack

NO YES NO NO NO

HG9Z-3D8PN02
For HG3G-8
2 pcs/pack

NO YES NO NO NO

HG9Z-2D5PN05
For HG2G-5F/-5T
5 pcs/pack

NO NO YES YES NO

HG9Z-1D4PN05
For HG1G
5 pcs/pack

NO NO NO NO YES

Protective 
Cover

HG9Z-2E2PN03
For HG2G-5F/-5T
To Cover the front of MICRO/I
3 pcs/pack

NO NO YES YES NO

Memory Card HG9Z-XMS2 SD memory card (2GB, Class6) YES YES YES NO NO
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● HG1P

Name Type No. Description HG4G HG3G
HG2G

-5F
HG2G

-5T
HG1G

Expansion 
Module Clamp

HG9Z-XJ3PN05

For installing the expansion modules on 
the back of the MICRO/I (Short).
5 pcs/pack
For total width 17.6 to 41.1 mm.

YES YES YES NO NO

HG9Z-XJ4PN05

For installing the expansion modules on 
the back of the MICRO/I (Long).
5 pcs/pack
For total width 47.0 to 69.4 mm.

YES YES YES NO NO

HG9Z-XJ5PN05

For installing the expansion modules on 
the back of the MICRO/I (Extra-Long).
5 pcs/pack
For total width 70.5 to 93.0 mm.

YES YES NO NO NO

L-shaped 
Terminal Block 
Connector for 
I/O Module

HG9Z-PMT10LPN02
For MicroSmart I/O Module (10-pole)
2 pcs/pack

YES YES YES NO NO

HG9Z-PMT11LPN02
For MicroSmart I/O Module (11-pole)
2 pcs/pack

YES YES YES NO NO

Name Type No. Description

Maintenance Cable HG9Z-XCM42

USB cable to connect to a computer
Length: 2m
<Connector>
HG1P: USB Mini-B
Computer: USB Type-A

HG1P Optional Cable

HG9Z-XCP13

Communication Mode: RS422/485 or Ethernet
Length: 3m
<Connector>
HG1P: CA-19S1N128007S
Host: D-sub 25-pin Male Connector

HG9Z-XCP15

Communication Mode: RS422/485 or Ethernet
Length: 5m
<Connector>
HG1P: CA-19S1N128007S
Host: D-sub 25-pin Male Connector

HG9Z-XCP17

Communication Mode: RS422/485 or Ethernet
Length: 7m
<Connector>
HG1P: CA-19S1N128007S
Host: D-sub 25-pin Male Connector

HG1P Debug Cable HG9Z-PX12

Length: 2m
<Connector>
HG1P: CA-19S1N128007S
Host: Twisted Wire

Hand Strap HG9Z-PS4
Wrist strap
1 pc/pack

Wall-Mounted Hook HG9Z-PK3
Hook attached to the rear of the case
1 pc/pack
Includes two installation screws
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External Dimensions

■ Hand Strap (HG9Z-PS4)
Unit: mm

■ Wall-Mounted Hook (HG9Z-PK3)
Unit: mm

Length Adjuster (Black)

50.0205.0 1.
5

9.
0

16.0

54
.5

39.6

44.1

21.0

68.0 6.5

1.2

35
.0

48
.0
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5.2 Replacement Parts

● HG5G/4G/3G/2G-V

● HG4G/3G, HG2G-5F/-5T, HG1G

● HG1P
There are no replacement parts.

*1 USB1(Mini-B) can be used for HG1G only.

Name Type No. Description HG5G-V HG4G-V HG3G-V HG2G-V

Mounting Clip

HG9Z-4K2PN06
For HG5G-V
6 pcs/pack

YES NO NO NO

HG9Z-4K2PN04
For HG4G/3G-V
4 pcs/pack

NO YES YES NO

SLD-K02PN10
For HG2G-V
10 pcs/pack

NO NO NO YES

Replacement 
Battery

HG9Z-XR1
Coin type lithium manganese 
dioxide battery CR2032W

YES YES YES YES

Communication 
Plug for external 
devices

HG9Z-XT09 Right angle type YES YES YES NO

HG9Z-XT09V Vertical type NO NO NO YES

USB Cable Lock 
Pin

HG9Z-XU1PN05
For USB2 (Type A) port
5 pcs/pack

YES YES YES YES

Name Type No. Description HG4G HG3G
HG2G-

5F
HG2G-

5T
HG1G

Mounting Clip

HG9Z-4KPN04
For HG4G/3G, HG1G
4 pcs/pack

YES YES NO NO YES

SLD-K02PN10
For HG2G-5F/-5T
10 pcs/pack

NO NO YES YES NO

Replacement 
Battery

HG9Z-XR1
Coin type lithium manganese 
dioxide battery CR2032

YES YES YES YES YES

Communication 
Plug for external 
devices

HG9Z-XT09 Right angle type YES YES NO NO NO

HG9Z-XT09V Vertical type NO NO YES YES YES

USB Cable Lock 
Pin

HG9Z-XU1PN05 For USB2 (Type A)*1 port
5 pcs/pack

YES YES YES YES YES
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6.1 Warranty Period

The Products are warranted for 3 years from the date of purchase, or from the date of delivery completion.
* Consumable/maintenance parts such as batteries and relays if the operation exceeds 100,000 times are excluded 

from the 3 year warranty.

6.2 Extent of warranty

IDEC CORPORATION is responsible for failures or defects of the Products during the above warranty period, either a 
replacement part will be provided or the defective parts of the Products will be repaired free of charge. If such failure 
or defects should occur, please offer them to the distributor, dealer or IDEC CORPORATION with the materials in 
which the date of purchase is specified.
* The expenses for installation and construction at the time of repair will not be borne.

6.3 Start

May 1, 2017. The Products which were produced after June 1, 2014 and purchased in last three years will also be 
warranted.

6.4 Indemnification

IDEC CORPURATION will not be liable under this Warranty and be indemnified and held harmless from any and all 
demands, suits, expenses, claims, damages and liabilities in the following event that:
1) The Products are used or operated beyond the conditions or environment range as described in catalog, 

specifications or instruction; or
2) The failure or defects of the Products arise from the cause other than the Products; or
3) The Products are improved, modified or altered by the party other than IDEC; or
4) The failure or defects and damages of the Products arise from the usage of the Product in the way that is not 

intended; or
5) The failure or defects and damages of the Products arise from the cause beyond IDEC’s control including, but not 

limited to, fire, earthquake, flood, lightning, other natural disasters, and acts of God; or
6) The failure or defects and damages of the Products arise from the relocation, transportation or drop after you 

purchase the Products; or
7) The failure or defects and damages of the Products arise from improper installation; or
8) Maintenance and inspection are not carried out in accordance with instruction.

IDEC CORPORATION DISCLAIMS ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND/OR FITTNESS FOR A 
PARTICULAR USE OR PURPOSE, AS WELL AS LIABILITY FOR INCIDENTAL, SPECIAL, INDIRECT, CONSEQUENTIAL OR 
OTHER DAMAGES RELATING TO THE PRODUCTS

6.5 Extent of service

The price of the Products will not include the fee for any service such as sending technicians and engineers, IDEC 
CORPORATION will charge you the fee for the following:
1) Instruction for installment and visiting for test operation, including, but not limited to creating application software 

and operation tests; and
2) Maintenance and inspection, arrangement and repair; and
3) Technical assistance and technical education; and
4) Product test and inspection based on you request.

6 About the Warranty of the products
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36

Troubleshooting

This chapter describes the errors that may occur with the MICRO/I and the measures necessary to correct these 
errors.

  

The MICRO/I displays a variety of error messages in order to assist you in quickly analyze and resolve problems with 
the hardware, communications system, and user screen data.

1.1 Errors Displayed on the Screen

The following error messages are displayed in the event of communication system problems and problems with user 
screen data. When an error occurs, take the appropriate indicated action. If an error persists despite your attempts to 
correct it, contact your vendor or IDEC Corporation.

Chapter 36 Troubleshooting

1 Error Messages

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

Error Message Cause Solution
Waiting for default screen No. The default screen number is set at 0. Either write the screen number to the 

System Area display screen number 
region, or set the initial screen number 
to a number other than 0.

No screen data The specified Base Screen does not exist. Set the Base Screen and download it to 
the MICRO/I.

No SD memory card exists No SD memory card inserted when the unit attempted 
to access the SD memory card.

Insert a SD memory card.

No USB flash drive exists No USB flash drive inserted when the unit attempted to 
access the USB flash drive.

Insert a USB flash drive.

This SD memory card not 
available

• The type of inserted SD memory card is not 
recognized.

• The SD memory card is broken.

Please use a new recommended SD 
memory card.

This USB flash is not available • The type of USB flash drive is not recognized.
• The USB flash drive is broken.

Please use a new recommended USB 
flash drive.

SD memory card Access Error When the unit attempted to access the SD memory 
card:
• The SD memory card did not have enough free 

space.
• The SD memory card was removed partway 

through.
• The SD memory card was broken.

Create some free space on the SD 
memory card or get a new one.

USB flash Drive Access Error When the unit attempted to access the USB flash drive:
• The USB flash drive did not have enough free space.
• The USB flash drive was removed partway through.
• The USB flash drive was broken.

Create some free space on the USB 
flash drive or get a new one.

ZNV file is not found The ZNV Project File was not in the specified location on 
the external memory device when a download was 
made using the Project Data Transfer function.

Check whether or not the file is in the 
specified location on the external 
memory device.

ZLD file is not found The ZLD Project File was not in the specified location on 
the external memory device when a download was 
made using the PLC Program Transfer function.

Check whether or not the file is in the 
specified location on the external 
memory device.

ZNV file format Error When a download was made using the Project Data 
Transfer function:
• The ZNV Project File format is invalid.
• The file is corrupt.

Remake the ZNV Project File.

ZLD file format Error When a download was made using the PLC Program 
Transfer function:
• The ZLD Project File format is invalid.
• The file is corrupt.

Remake the ZLD Project File.

Product Series is not correct When a download was made using the Project Data 
Transfer function, the model of the downloaded project 
and the model of the destination MICRO/I were 
different

Check that the model name that is set in 
the file you want to download is the 
same as the model name of the 
destination MICRO/I.
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PLC Type is not correct When a download or upload was made using the PLC 
Program Transfer function:
• The model of the downloaded PLC Program and the 

model of the destination PLC were different.
• The runtime program version using the downloaded 

PLC Program and the one of the destination PLC 
were different.

Check PLC models and runtime program 
versions.

PLC Password is not valid When a download or upload was made using the PLC 
Program Transfer function, the password you entered 
was incorrect.

Enter the correct password.

PLC communication Error When a download or upload was made using the PLC 
Program Transfer function, a communication problem 
with the PLC occurred.

It is possible that there is a problem 
with the connection with the PLC. Check 
the connection between MICRO/I and 
the PLC.

The specified files are not 
found

The specified files were not in the specified location on 
the external memory device when the File Copy 
function was executed.

Check whether or not the file is in the 
specified location on the external 
memory device.

File Size Error The size of the source file exceeded the limit when the 
File Copy function was executed.

Check the source file size. For the 
maximum file size that can be copied, 
refer to Chapter 29 “3.5 Precautions” on 
page 29-38.

Insufficient memory error The resource memory of the HG is insufficient because 
of the use of a large number of the following parts.
• Pilot Lamps, Multi-State Lamps, and Picture 

Displays.
• Message Display, Message Switching Display, and 

Alarm List Display with the Scroll checkbox is 
selected.

• Line Chart with the Display cursor checkbox is 
selected.

• Parts over the number limit of parts that can be set 
per screen by overlapping Base Screen.

Clear the Scroll or Display cursor 
checkbox, or delete parts to reduce 
memory resource utilization.

Device write error The script generated a lot of write data, and the write 
operation failed.

Reduce the number of write operations 
to be performed at the same time.

Communication error: READ

Illegal reply from Ext.device.
Confirm PLC, Device Address.

The external device returned an error for a read request 
of a device address from the MICRO/I.

Check the following.
• The ID and name of the external 

device for which the communications 
error occurred will be displayed. 
Check if an error has occurred on the 
corresponding external device.

• An error may have occurred 
internally on the external device. 
Check the manual of the external 
device.

• Check the address range of the 
external device to see if a non-
existent address is being accessed.

Communication error: WRITE

Illegal reply from Ext.device.
Confirm PLC, Device Address.

The external device returned an error for a write 
request of a device address from the MICRO/I.

Communication error: INIT

Illegal reply from Ext.device.
Confirm PLC, Device Address.

The external device returned an error for an 
initialization request to start communications from the 
MICRO/I.

Communication error: READ

No reply from Ext.device.Con-
firm PLC,Cable,Com.settings.

There was no response from the external device for a 
read request of a device address from the MICRO/I.

Check the following.
• The ID and name of the external 

device for which the communications 
error occurred will be displayed. 
Check if an error has occurred on the 
corresponding external device.

• Check for problems with the cables, 
such as incorrect wiring and loose 
connection.

• The power supply to the external 
device may be turned off or the 
external device may have been 
reset. Check the manual of the 
external device. 

• Check the communications settings 
to determine if the communications 
settings of the HMI and external 
device are the same.

Communication error: WRITE

No reply from Ext.device.Con-
firm PLC,Cable,Com.settings.

There was no response from the external device for a 
write request of a device address from the MICRO/I.

Communication error: INIT

No reply from Ext.device.Con-
firm PLC,Cable,Com.settings.

There was no response from the external device for an 
initialization request to start communications from the 
MICRO/I.

Error Message Cause Solution
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1 Error Messages

36

Troubleshooting

Processing error • A value is divided by 0.
• There is data which cannot be handled with the 

specified data type; BCD4(B), BCD8(EB), or 
Float32(E).

• The setting of Origin, Minimum, or Maximum for the 
Bar Chart or Line Chart are invalid, or the Minimum 
and Maximum are the same values.

• The setting of Minimum, Maximum, or ranges for 
the Meter are invalid, or the Minimum and Maximum 
are the same values.

• There is invalid clock data which is used in Calendar 
parts.

Check the calculation or settings.

Device range error • The data is written to the device with the address out of 
the range.

• The number of device addresses exceeds the 
limitation.

Check the device address settings.

Script error An error occurred for a process in execution of the 
script.

Check the value of HMI Special Data 
Registers LSD52 and LSD53, and correct 
the script. For details, refer to Chapter 
20 “Script” on page 20-1.

Network off-line This error message is only displayed when O/I Link is 
being used.

For details, refer to the WindO/I-NV4 
External Device Setup Manual.

Error Message Cause Solution
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1.2 Low Battery Voltage

An internal battery maintains clock settings and log data in the MICRO/I. When the battery runs out, keep register 
data, log data and other backup data will be cleared, and the contrast is reset to the default value. If this happens, 
the following message is displayed when the MICRO/I is powered up, so take the indicated action.

In this case, Bit 14 (backup data error) of address number + 2 in System Area 2 is set, and it is reset when MICRO/I 
is powered on.

The following warning messages will be displayed before the battery is dead.
In this case, the Bit 12 (Replace battery error) or Bit 13 (Replace battery error) of address number + 2 in the System 
Area 2 is set, and it is set whenever the MICRO/I is powered on.

To display the warning message, in the Project Settings dialog box, on the System Settings tab, select the 
Battery warning message check box.

Message Description

Backup data lost Replace the battery.
The Log Data and Calendar Data are lost. Set the clock again. 

In case of storing Keep Memory and Keep Relay to the flash memory using HMI Special Internal Relay 
LSM10, stored data is transferred to the memory automatically when Backup data is lost.

Message Description

Replace battery The remaining battery revel is low. Replace the battery in a short time.

Replace battery
(Battery level LOW)

The remaining battery revel is lowest. Replace the battery immediately, otherwise backup 
data will be lost.



WindO/I-NV4 User’s Manual 36-5

2 Handling Problems

36

Troubleshooting

  

2.1 When You Cannot Download Project Data

If you are unable to download project data from the WindO/I-NV4, press the top left corner of the panel for three 
seconds or longer while at the same time turning the power off and back on again.

The screen in the System Mode is displayed, and then MICRO/I becomes downloadable status. If you download via 
Ethernet, check again the setting of TCP/IP before executing the download.
Also, when MICRO/I does not show the System Mode screen and continues a blackout having a bleep each second, 
be sure to download using Serial Interface 2 or port for USB.

2.2 If the backlight is OFF and the buzzer sounds

If you fail to download the runtime program to MICRO/I, the backlight may turn to OFF and a beep may sound 
continuously every second, even after the power has been turned off and on again. Rectify the situation by 
downloading the project using WindO/I-NV4 via USB cable.

2.3 Touch Panel Does Not Respond Correctly

If the touch panel needs to be readjusted, then go to the System Mode to readjust the touch panel. For details about 
adjusting method, refer to Chapter 34 “Touch Panel Adjust (TP Adjust)” on page 34-9.

2.4 Power LED light is OFF

If the LED on the front of MICRO/I does not light up when power is turned ON, it may indicate a problem exists in the 
main unit. Contact your vendor or IDEC Corporation.

2 Handling Problems

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

MICRO/I

When the backlight is OFF and the buzzer sounds, you cannot download the project to MICRO/I via Ethernet 
or using an external memory.
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Appendix

This chapter contains the color number, and describes details about the Color Palette and other settings used in 
WindO/I-NV4.

  

● Color Data Correspondence Table
This table is used when using Message Display and Script. Select a value from the Data column of the table and you 
can change the display color of an object by values of device addresses.

Appendix

1 Color Number

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

Color No. Data Color No. Data Color No. Data Color No. Data Color No. Data Color No. Data
000 0x00 045 0x2D 086 0x56 127 0x7F 167 0xA7 207 0xCF
001 0x01 046 0x2E 087 0x57 128 0x80 168 0xA8 208 0xD0
002 0x02 047 0x2F 088 0x58 129 0x81 169 0xA9 209 0xD1
003 0x03 048 0x30 089 0x59 130 0x82 170 0xAA 210 0xD2
004 0x04 049 0x31 090 0x5A 131 0x83 171 0xAB 211 0xD3
005 0x05 050 0x32 091 0x5B 132 0x84 172 0xAC 212 0xD4
006 0x06 051 0x33 092 0x5C 133 0x85 173 0xAD 213 0xD5
007 0x07 052 0x34 093 0x5D 134 0x86 174 0xAE 214 0xD6
008 0x08 053 0x35 094 0x5E 135 0x87 175 0xAF 215 0xD7
009 0x09 054 0x36 095 0x5F 136 0x88 176 0xB0 216 0xD8
010 0x0A 055 0x37 096 0x60 137 0x89 177 0xB1 218 0xDA
011 0x0B 056 0x38 097 0x61 138 0x8A 178 0xB2 219 0xDB
012 0x0C 057 0x39 098 0x62 139 0x8B 179 0xB3 220 0xDC
013 0x0D 058 0x3A 099 0x63 140 0x8C 180 0xB4 221 0xDD
014 0x0E 059 0x3B 100 0x64 141 0x8D 181 0xB5 223 0xDF
019 0x13 060 0x3C 102 0x66 142 0x8E 182 0xB6 224 0xE0
020 0x14 062 0x3E 103 0x67 143 0x8F 183 0xB7 225 0xE1
021 0x15 063 0x3F 104 0x68 144 0x90 184 0xB8 226 0xE2
022 0x16 064 0x40 105 0x69 145 0x91 185 0xB9 227 0xE3
023 0x17 065 0x41 106 0x6A 146 0x92 186 0xBA 228 0xE4
024 0x18 067 0x43 107 0x6B 147 0x93 187 0xBB 229 0xE5
025 0x19 068 0x44 108 0x6C 148 0x94 188 0xBC 230 0xE6
026 0x1A 069 0x45 109 0x6D 149 0x95 189 0xBD 231 0xE7
027 0x1B 070 0x46 110 0x6E 150 0x96 190 0xBE 232 0xE8
028 0x1C 071 0x47 111 0x6F 151 0x97 191 0xBF 233 0xE9
029 0x1D 072 0x48 112 0x70 152 0x98 192 0xC0 234 0xEA
030 0x1E 073 0x49 113 0x71 153 0x99 193 0xC1 236 0xEC
032 0x20 074 0x4A 114 0x72 154 0x9A 194 0xC2 237 0xED
033 0x21 075 0x4B 115 0x73 155 0x9B 195 0xC3 238 0xEE
034 0x22 076 0x4C 116 0x74 156 0x9C 196 0xC4 239 0xEF
035 0x23 077 0x4D 118 0x76 157 0x9D 197 0xC5 241 0xF1
037 0x25 078 0x4E 119 0x77 158 0x9E 198 0xC6 242 0xF2
038 0x26 079 0x4F 120 0x78 160 0xA0 199 0xC7 243 0xF3
039 0x27 080 0x50 121 0x79 161 0xA1 200 0xC8 244 0xF4
040 0x28 081 0x51 122 0x7A 162 0xA2 201 0xC9 245 0xF5
041 0x29 082 0x52 123 0x7B 163 0xA3 202 0xCA 246 0xF6
042 0x2A 083 0x53 124 0x7C 164 0xA4 204 0xCC 255 0xF7
043 0x2B 084 0x54 125 0x7D 165 0xA5 205 0xCD
044 0x2C 085 0x55 126 0x7E 166 0xA6 206 0xCE
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● Windows RGB Value Correspondence Table
The color numbers correspond to the following Windows RGB values.

Color 
No.

Windows 
RGB value

Color 
No.

Windows 
RGB value

Color 
No.

Windows 
RGB value

Color 
No.

Windows 
RGB value

Color 
No.

Windows 
RGB value

Color 
No.

Windows 
RGB value

000 000000 045 006666 086 3399CC 127 66CC00 167 9900CC 207 CCFF99

001 111111 046 006699 087 339999 128 66CC33 168 9900FF 208 CCFF66

002 222222 047 0066CC 088 339966 129 66CC66 169 9933FF 209 CCFF33

003 333333 048 0066FF 089 339933 130 66CC99 170 9933CC 210 CCFF00

004 444444 049 0099FF 090 339900 131 66CCCC 171 993399 211 FFCC00

005 555555 050 0099CC 091 330000 132 66CCFF 172 993366 212 FFCC33

006 666666 051 009999 092 330033 133 66FFFF 173 993333 213 FFCC66

007 777777 052 009966 093 330066 134 66FFCC 174 993300 214 FFCC99

008 888888 053 009933 094 330099 135 66FF99 175 CC0000 215 FFCCCC

009 999999 054 009900 095 3300CC 136 66FF66 176 CC0033 216 FFCCFF

010 AAAAAA 055 00CC00 096 3300FF 137 66FF33 177 CC0066 218 FFFFCC

011 BBBBBB 056 00CC33 097 3333FF 138 66FF00 178 CC0099 219 FFFF99

012 CCCCCC 057 00CC66 098 3333CC 139 99CC00 179 CC00CC 220 FFFF66

013 DDDDDD 058 00CC99 099 333399 140 99CC33 180 CC00FF 221 FFFF33

014 EEEEEE 059 00CCCC 100 333366 141 99CC66 181 CC33FF 223 FF6600

019 880000 060 00CCFF 102 333300 142 99CC99 182 CC33CC 224 FF6633

020 FF0000 062 00FFCC 103 660000 143 99CCCC 183 CC3399 225 FF6666

021 888800 063 00FF99 104 660033 144 99CCFF 184 CC3366 226 FF6699

022 FFFF00 064 00FF66 105 660066 145 99FFFF 185 CC3333 227 FF66CC

023 008800 065 00FF33 106 660099 146 99FFCC 186 CC3300 228 FF66FF

024 00FF00 067 33CC00 107 6600CC 147 99FF99 187 CC6600 229 FF99FF

025 008888 068 33CC33 108 6600FF 148 99FF66 188 CC6633 230 FF99CC

026 00FFFF 069 33CC66 109 6633FF 149 99FF33 189 CC6666 231 FF9999

027 000088 070 33CC99 110 6633CC 150 99FF00 190 CC6699 232 FF9966

028 0000FF 071 33CCCC 111 663399 151 996600 191 CC66CC 233 FF9933

029 880088 072 33CCFF 112 663366 152 996633 192 CC66FF 234 FF9900

030 FF00FF 073 33FFFF 113 663333 153 996666 193 CC99FF 236 FF0033

032 000033 074 33FFCC 114 663300 154 996699 194 CC99CC 237 FF0066

033 000066 075 33FF99 115 666600 155 9966CC 195 CC9999 238 FF0099

034 000099 076 33FF66 116 666633 156 9966FF 196 CC9966 239 FF00CC

035 0000CC 077 33FF33 118 666699 157 9999FF 197 CC9933 241 FF33FF

037 0033FF 078 33FF00 119 6666CC 158 9999CC 198 CC9900 242 FF33CC

038 0033CC 079 336600 120 6666FF 160 999966 199 CCCC00 243 FF3399

039 003399 080 336633 121 6699FF 161 999933 200 CCCC33 244 FF3366

040 003366 081 336666 122 6699CC 162 999900 201 CCCC66 245 FF3333

041 003333 082 336699 123 669999 163 990000 202 CCCC99 246 FF3300

042 003300 083 3366CC 124 669966 164 990033 204 CCCCFF 255 FFFFFF

043 006600 084 3366FF 125 669933 165 990066 205 CCFFFF

044 006633 085 3399FF 126 669900 166 990099 206 CCFFCC
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2 View Browser
Appendix

  

The View Browser displays the list of graphics that have been prepared in advance in WindO/I-NV4. The settings 
displayed on View Browser vary based on the parts.
These graphics can be used as the outline of parts.
Example: Bit Button

■ Type
Selects the category of graphics.

■ OFF, ON
Displays the graphic when OFF or ON. Click ON or OFF to switch the graphics displayed on the list.

■ Picture List
Displays the list of registered graphics. Select the graphic to use as the outline of the part.

2 View Browser

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P
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The Color Palette is used to select colors for drawing objects, text on parts, outlines, flanges, plates and other objects.
Display the Color Palette by clicking a color in the Properties dialog box and then select the color.
The type of color palette shown depends on the models being used.

■ 256 Color Palette*1

■ 16-level Monochrome Palette*2

■ More Colors, Close
Switches the palette display. Clicking More Colors shows all the colors assignable to the Color button. Close shows 
only the basic colors assignable to the Color button.

■ Text Manager Color
This feature allows use of the text color specified in the Text Manager. Click here to use the text color specified in the 
Text Manager. This option can only be set when the Use Text Manager check box is selected.

■ Transparent Color
Converts the color in the imported picture to be transparent. This option can only be selected when Picture Manager 
was used.

■ None
This option is no fill color. This can only be set for Background Color in drawing object text.

*1 HG5G/4G/3G/2G-V, HG4G/3G, HG2G-5F/5T* only (*Color LCD models), HG1G/1P
*2 HG2G-5T* only (*Monochrome LCD models)

3 Color Palette

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

(Color)

(Color)
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4 Pattern Palette
Appendix

  

The Pattern Palette is used to select patterns or tonal gradations for drawing and part objects.
The Pattern Palette appears when you click Pattern in the object’s Properties dialog box.
Click Pattern and select a pattern or tonal gradations.

Drawings

Parts

● Foreground and Background Colors
Drawing and part objects are formed by foreground and background colors.

■ Pattern
The selected pattern is applied to the foreground color.

The background color is visible through the unpainted parts of the foreground color.

■ Gradation
The selected gradation is applied to the foreground color.

The background color is visible through the unpainted parts of the foreground color.

4 Pattern Palette

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

Pattern image

Gradation image

Pattern image

Gradation image

Foreground color
Background color

Foreground color
Background color
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● Patterns and gradations
These patterns and gradations are available on WindO/I-NV4. When 024 on the Foreground Color and 000 on the 
Background Color are selected for the Rectangle, the display images are as follows:

■ Patterns

■ Gradation

*1 None can only be applied to drawing objects. Selecting None is the same as not applying any color at all.

Pattern name None*1 Foreground 
100%

Foreground 
25%

Foreground 
50%

Background 
100%

Pattern buttons

Display sample

Pattern name
Horizontal 

lines
Vertical lines

Slant 
Upwards

Slant 
Downwards

Crosshatch Tint

Pattern buttons

Display sample

Gradation name Diagonal up 1 Horizontal 1
Diagonal 
down 1

Vertical 1 Diagonal up 2 Horizontal 2 

Gradation buttons

Display sample

Gradation name
Diagonal 
down 2

Vertical 2 Central 1 Central 2 Vertical 3 Vertical 4

Gradation buttons

Display sample

Gradation name Horizontal 3 Horizontal 4

Gradation buttons

Display sample
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5 Text Alignment
Appendix

  

Text Alignment is used to adjust the way text appears on Drawing Objects and Parts.

● Horizontal Writing
These examples show how text appears using different combinations of the Align Text Horizontal and Align Text 
Vertical properties.

■ Align Text Horizontal

5 Text Alignment

HG3G HG2G-5FHG5G-V HG4G-V HG3G-V HG2G-V HG2G-5THG4G HG1G HG1P

Align Text Horizontal
Left Center Right Center-Left

Align Text 
Vertical

Top ---

Center
(Center-Top)

Bottom ---

Left: Aligns the text along the left edge.

Center: Centers the text horizontally in the center.

Right: Aligns the text along the right edge.

Center-Left: Centers the line containing the most number of characters, and then aligns the other lines 
to the left end of that line.

Aligns along left edge

Centers text in the middle

Aligns along right edge

Aligns to left end of line with most characters

Centers line with most characters

If Align Text Horizontal is set to Center-Left, Align Text Vertical will automatically be set to Center-
Top. Center-Top results in the same display as Center.
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■ Align Text Vertical

● Vertical Writing
These examples show how text appears for Align Text Horizontal.
Align Text Vertical defaults to Top.

Top: Aligns the text along the top edge.

Center (Center-Top): Centers the text vertically in the center.

Bottom: Aligns the text along the bottom edge.

Aligns text along top edge

Centers text in the middle

Aligns text along bottom edge

Align Text Horizontal
Left Center Right

Align 
Text 

Vertical
Top
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5 Text Alignment
Appendix

■ Align Text Horizontal

Left: Aligns the text along the left edge.

Center: Centers the text horizontally in the center.

Right: Aligns the text along the right edge.

Aligns along left edge

Centers text in the middle

Aligns along right edge

• Vertical text cannot be set if Font is set to Stroke.
• Take note of these points when the Vertical Writing check box is selected:

- When there is a mixture of double-byte and single-byte characters, the half-width characters are 
leftaligned.

- Dashes are displayed horizontally. Symbols representing voiced and semi-voiced sounds of single-byte 
characters are shown as follows.

Aligned to 
left edge

Horizontal
display

Next
characters
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